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Nouveautés



Récapitulatif des nouvelles fonctionnalités
InDesign CC version 2015

Adobe InDesign CC 2015 comprend de nouvelles fonctionnalités et améliorations visant à
rendre votre expérience de conception et de publication plus performante que jamais. Dans
cette version, plusieurs améliorations ont été apportées aux Bibliothèques Creative Cloud.
Maintenant, lorsque vous importez une image dans un tableau, InDesign considère la cellule
comme étant un bloc d’image. La nouvelle fonctionnalité Ombrage de paragraphe permet
d’ajouter des mises en surbrillance colorées qui se déplacent avec le texte sur la page. Les
tâches quotidiennes (zoom, panoramique et défilement) sont plus rapides grâce à
l’amélioration des performances dans InDesign. Avec Publish Online, les utilisateurs
d’InDesign publient en toute simplicité les documents InDesign en ligne. Téléchargez dès
maintenant des images et des graphiques vectoriels Adobe Stock libres de droits d’auteur
directement vers vos bibliothèques Creative Cloud. Vos ressources sont désormais
disponibles à l’endroit exact où vous en aurez besoin.

Ci-dessous figurent une présentation rapide des nouvelles fonctionnalités de la dernière mise
à jour d’Adobe InDesign ainsi que des liens vers des ressources supplémentaires.

Remarque : la fonction Publish Online (aperçu technologique) est uniquement
disponible dans les versions destinées à l’Amérique du Nord (en_US) et au
Royaume-Uni (en_GB).
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Améliorations apportées à Mercury Performance System

Les tâches quotidiennes sont plus rapides grâce à l’amélioration des performances dans InDesign. Vous remarquerez une
différence lorsque vous agrandirez ou ferez défiler vos documents, et lorsqu’InDesign génère des vignettes de page dans le
panneau Pages.

Publish Online (aperçu technologique)



Remarque :

Cette fonction est uniquement disponible dans les versions destinées à l’Amérique du Nord (en_US)
et au Royaume-Uni (en_GB).

Nouveauté de cette version d’InDesign CC  

Publish Online est un nouvel aperçu technologique pour les membres CC. Avec Publish Online, vous pouvez réutiliser vos
documents en les publiant facilement en ligne. En un seul clic, vous pouvez publier une version numérique qui fonctionne sur
tous les appareils, dans n’importe quel navigateur récent, sans installer de module externe. Il vous suffit de spécifier l’URL du
document à un utilisateur pour qu’il puisse visualiser le document dans une expérience en ligne élégante et simple, sur
n’importe quel appareil et n’importe quelle plate-forme. Vous pouvez même partager le document en ligne sur Facebook.

Ces documents publiés peuvent être fidèlement affichés directement sur le navigateur Web d’une tablette ou d’un poste de
travail pour une expérience de visionnage agréable, sans nécessiter aucun module externe.

Pour une expérience utilisateur encore plus enrichissante, vous pouvez également ajouter des boutons, des
diaporamas, des animations, du son et des vidéos à l’aide des fonctions de création interactives
d’InDesign CC.

Pour plus d’informations, consultez l’article Publish Online.

Améliorations apportées aux Bibliothèques Creative Cloud

Vous pouvez maintenant ajouter les catégories InDesign suivantes à vos bibliothèques CC :

 styles de caractère
Styles de paragraphe
Thèmes de couleur

dans les versions précédentes d’InDesign, la fonction Bibliothèques CC comprenait la catégorie

http://idiom-q-win-1/fr/indesign/using/publish-online.html


Styles de texte. Cette catégorie est maintenant renommée Styles de caractère. Ainsi, si vous avez créé des
styles de texte dans une bibliothèque CC, ils seront désormais disponibles sous la catégorie Styles de
caractère.

Styles de paragraphe et de caractère

Vous pouvez désormais ajouter les styles de paragraphe et de caractère de vos documents aux nouvelles
catégories Styles de paragraphe et Styles de caractère des Bibliothèques CC.

Pour cela, sélectionnez simplement le texte de votre document sur lequel le style de paragraphe ou de
caractère est appliqué et cliquez sur les icônes Ajouter un style de paragraphe ou Ajouter un style de
caractère dans le panneau Bibliothèques CC.

Ajoutez ensuite un ou plusieurs styles de paragraphe ou de caractère du panneau Styles de paragraphe ou
Styles de caractère à la bibliothèque CC actuelle. Pour ce faire, sélectionnez les styles et cliquez sur la
nouvelle icône Ajouter aux bibliothèques CC.

Lorsque vous créez un nouveau style de paragraphe ou de caractère dans InDesign, vous pouvez l’ajouter
directement à une bibliothèque CC. Pour ce faire, cochez l’option Ajouter à la bibliothèque CC et sélectionnez
la bibliothèque CC.

si vous utilisez un style de paragraphe ou de caractère issu d’une bibliothèque CC dans un document, le
style est alors disponible dans le panneau Styles de paragraphe ou Styles de caractère.



Vous pouvez maintenant ajouter un ou plusieurs
nuanciers du panneau Nuanciers vers la
bibliothèque CC sélectionnée. Pour ce faire,
sélectionnez les couleurs et cliquez sur la nouvelle
icône Ajouter aux bibliothèques CC.

Lorsque vous créez un
nouveau nuancier dans
InDesign, vous pouvez
l’ajouter directement à
une bibliothèque CC.
Cochez l’option Ajouter à
la bibliothèque CC et
sélectionnez la
bibliothèque CC.

Les fichiers d’images des Bibliothèques CC (créés
dans d’autres applications telles qu’Illustrator ou
Photoshop) peuvent désormais être importés comme
des objets liés ou copiés dans InDesign.

Si un objet lié est mis à jour dans la Bibliothèque
CC, la mise à jour est répercutée dans le document
InDesign. Toutefois, dans le cas d’objets copiés, les
mises à jour des objets dans la Bibliothèque CC ne
sont pas répercutées dans le document.

Les liens vers ces
images importées depuis
les Bibliothèques CC
seront affichés dans le
panneau Liens.

Thèmes de couleur

Les thèmes de couleur sélectionnés à l’aide de l’outil Thèmes de couleur peuvent désormais être directement
ajoutés à la catégorie Thèmes de couleur des Bibliothèques CC.

Nuanciers

Ressources liées des Bibliothèques CC



Vous pouvez même créer
une ombre sur des
paragraphes dans les
blocs de texte non
rectangulaires.

Pour plus d’informations, consultez l’article Bibliothèques Creative Cloud.

Ombrage de paragraphe

Nouveauté de cette version d’InDesign CC  

Ajoutez des mises en évidence colorées qui se déplacent avec le texte sur la page. La nouvelle fonctionnalité Ombrage de
paragraphe d’InDesign vous permet de créer une ombre (ou couleur) derrière un paragraphe.

Utilisez l’ombrage de paragraphe dans le document final pour attirer l’attention du lecteur sur un paragraphe. Ou dans les flux
de production de révision de documents pour mettre en évidence un paragraphe spécifique.

L’ombrage de paragraphe présente un avantage : appliqué au texte, l’ombrage se déplace ou est
redimensionné lorsque le texte est lui-même déplacé ou redimensionné.

Pour plus d’informations, consultez l’article Création d’une ombre (ou couleur) derrière un paragraphe.

Images dans des cellules de tableau

Nouveauté de cette version d’InDesign CC  

Maintenant, lorsque vous importez une image dans un tableau, InDesign considère la cellule comme étant un bloc d’image.
Toutes les options d’ajustement et de bloc s’appliquent, afin de faciliter la création de tableaux contenant du texte et des
graphiques. Vous pouvez déplacer des images dans des cellules de tableau par glisser-déposer ou les importer à l’aide de l’outil
Récupération de contenu.

http://idiom-q-win-1/fr/indesign/using/creative-cloud-libraries-sync-share-assets.html
http://idiom-q-win-1/fr/indesign/using/formatting-paragraphs.html#paragraph_shading


Les images peuvent être importées dans des cellules vides. Pour ce faire, déposez-les simplement dans les
cellules à l’aide du curseur d’importation ou de l’outil Récupération de contenu.

Pour plus d’informations, consultez l’article Ajout d’images à un tableau.

Adobe Stock

Nouveauté de cette version d’InDesign CC  

Adobe Stock est un nouveau service qui vend des millions de photos, d’illustrations et d’images de grande
qualité, libres de droits d’auteur.

Vous pouvez lancer Adobe Stock depuis InDesign et rechercher des photos, des illustrations et des vecteurs.

Lorsque vous avez trouvé la ressource dont vous avez besoin, vous pouvez alors la télécharger vers votre
bureau ou une bibliothèque CC InDesign sélectionnée.

Lorsque la bibliothèque CC est synchronisée avec les nouvelles ressources Adobe Stock, vous pouvez alors
les intégrer dans vos documents InDesign.

Pour plus d’informations, consultez l’article Utilisation d’Adobe Stock.

Options d’affichage de la boîte de dialogue Imprimer exportation PDF

http://idiom-q-win-1/fr/indesign/using/creating-tables.html#add_graphics_to_a_table
https://helpx.adobe.com/fr/stock/help/using-adobe-stock.html


  Les publications Twitter™ et Facebook ne sont pas couvertes par les dispositions Creative Commons.

Mentions légales   |   Politique de confidentialité en ligne

Dans la liste déroulante Affichage,
sélectionnez les options
d’affichage PDF :

Remarque :

La boîte de dialogue Exporter au format Adobe PDF comprend désormais l’affichage et la mise en page par
défaut suivants pour les documents PDF exportés depuis InDesign :

jusqu’à la version 2014 d’InDesign CC, ces options d’affichage n’étaient disponibles que dans
la boîte de dialogue Exporter au format PDF interactif.

Pour plus d’informations, consultez l’article Options générales appliquées aux fichiers PDF.

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
https://www.adobe.com/go/gffooter_online_privacy_policy_fr
http://idiom-q-win-1/fr/indesign/using/pdf-options.html#general_options_for_pdfs
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OBTENIR DE L’AIDE > ASSISTANCE CREATIVE CLOUD

Utilisation de l’application de bureau Creative Cloud pour gérer
vos applications et services
S’applique à Creative Cloud
Sommaire
Téléchargez des applications, partagez des fichiers, recherchez des polices et des images stockées, et bien plus encore depuis l’application de
bureau Creative Cloud.
Sur cette page

Téléchargement et installation d’applications

L’application de bureau Adobe Creative Cloud est un emplacement central qui vous permet de gérer les dizaines d’applications et de services inclus
dans votre abonnement Creative Cloud. Vous pouvez également synchroniser et partager des fichiers, gérer des milliers de polices de caractères,
accéder à des bibliothèques d’images et de photos ou encore présenter et découvrir des projets créatifs au sein de la communauté. L’application
de bureau Creative Cloud est votre fenêtre sur tout cela.

Voici comment procéder pour télécharger, installer et mettre à jour vos applications à l’aide de l’application de bureau Creative Cloud. Pour
découvrir des nouveautés, vous pouvez également parcourir les applications par popularité, catégorie ou version.

L’application de bureau Creative Cloud est automatiquement installée lorsque vous téléchargez votre premier produit Creative Cloud. Si vous avez
déjà installé Adobe Application Manager, il se met automatiquement à jour vers l’application de bureau Creative Cloud.

Dans le cas contraire, vous pouvez télécharger manuellement l’application depuis la page Application de bureau Creative Cloud.

Conseil :

pour télécharger des applications sur votre appareil mobile, consultez le Catalogue des applications mobiles.

1. Pour accéder à l’application de bureau Creative Cloud, cliquez sur l’icône Creative Cloud, située dans la barre des tâches (Windows) ou
dans la barre de menus (Mac OS).

Conseil :

par défaut, l’application de bureau Adobe Creative Cloud se lance lorsque vous vous connectez à votre ordinateur. Si l’icône Creative Cloud
n’est pas affichée, vous devrez sûrement quitter puis relancer l’application. Voici comment procéder :

https://helpx.adobe.com/fr/support.html
https://helpx.adobe.com/fr/creative-cloud.html
https://creative.adobe.com/fr/products/creative-cloud
http://www.adobe.com/fr/creativecloud/catalog/mobile.html


Windows : cliquez sur Démarrer > Programmes > Adobe Creative Cloud.
Mac OS : cliquez sur Aller > Applications > Adobe Creative Cloud > Adobe Creative Cloud.

2. S’il n’est pas déjà sélectionné, cliquez sur l’onglet Apps. Les applications récemment installées sur votre ordinateur s’affichent dans la partie
supérieure du panneau. La liste peut inclure des versions précédemment installées.

3. Faites défiler la liste vers le bas pour découvrir d’autres applications. Vous pouvez également filtrer la liste par catégorie ou par version de
logiciel.



4. Cliquez sur Installer ou Mettre à jour.

5. Pour télécharger et installer une version antérieure d’une application, sélectionnez Version précédente, puis choisissez une version dans le
menu Installer.

Conseil :

le téléchargement de l’application peut prendre un certain temps, en fonction de votre connexion Internet et de l’ordinateur utilisé.

Pour obtenir des informations détaillées, par exemple pour savoir comment lancer une application, reportez-vous à la page Téléchargement et
installation d’applications Creative Cloud.

Synchronisation et partage de fichiers

Synchronisez les fichiers stockés sur votre ordinateur vers Creative Cloud, afin qu’ils soient accessibles où que vous soyez. Ainsi, les fichiers
deviennent instantanément disponibles sur l’ensemble de vos appareils et ordinateurs connectés, ainsi que sur votre page Creative Cloud
Files. Pour synchroniser des fichiers, téléchargez et installez l’application de bureau Creative Cloud sur tous vos ordinateurs.

http://idiom-q-win-1/fr/creative-cloud/help/download-install-app.html
http://idiom-q-win-1/fr/creative-cloud/help/download-install-app.html
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Pour synchroniser des fichiers, utilisez l’une des méthodes suivantes :

Copiez, collez ou déplacez vos fichiers vers le dossier ou répertoire Creative Cloud Files de l’ordinateur.

Vous pouvez ouvrir ce dossier ou répertoire Creative Cloud Files depuis l’application de bureau Creative Cloud, en cliquant sur l’onglet Actifs
puis sur le panneau Fichiers et enfin sur Ouvrir le dossier.

Au sein d’une application, sélectionnez Fichier > Enregistrer ou Fichier > Enregistrer sous, puis accédez au dossier ou répertoire
Creative Cloud Files de l’ordinateur.

Les fichiers originaux sont toujours sur votre ordinateur ou périphérique. Les fichiers sont synchronisés via Creative Cloud vers tous les
périphériques connectés.

Vous pouvez consulter vos fichiers en ligne sur la page Actifs Creative Cloud. Une fois les fichiers synchronisés, vous n’avez pas besoin d’être en
ligne et vous pouvez les consulter à partir du dossier ou répertoire Creative Cloud Files sur votre ordinateur.

Pour savoir comment utiliser les fichiers chargés sur Creative Cloud, reportez-vous à la page Gestion des actifs et des fichiers.

Ajout de polices depuis Typekit

Vous pouvez utiliser les polices Typekit dans toutes vos applications Creative Cloud ainsi que dans d’autres programmes logiciels.

Choisissez une police de caractères créée par l’un des nombreux partenaires Typekit, puis synchronisez-la sur votre ordinateur via Creative Cloud.
Les polices synchronisées peuvent être utilisées dans toutes les applications Creative Cloud ainsi que dans d’autres logiciels de bureautique.

https://assets.adobe.com/files
https://helpx.adobe.com/fr/creative-cloud/help/sync-files.html


Vous devez disposer d’un abonnement payant à Creative Cloud ou d’un compte Typekit admissible pour synchroniser des polices sur votre
ordinateur de bureau.

Le panneau Polices présente les polices synchronisées sur votre ordinateur. Pour synchroniser des polices, effectuez les opérations suivantes :

1. Dans l’application de bureau Creative Cloud, cliquez sur l’onglet Actifs puis sur le panneau Polices.

2. Cliquez sur Ajouter des polices depuis Typekit. Une fenêtre Typekit s’ouvre dans le navigateur.

Si vous utilisez Typekit pour la première fois, cliquez sur Je débute sur Typekit et suivez les invites qui s’affichent pour configurer votre
compte.

3. Dans la fenêtre Typekit, placez la souris sur la fiche d’une police et cliquez sur + Utiliser les polices.

4. Sélectionnez les polices de la famille choisie et cliquez sur Synchroniser les polices sélectionnées.

Des questions sur la synchronisation des polices ? Retrouvez la procédure détaillée ici.

 

Recherche d’éléments sur Adobe Stock

Vous pouvez rechercher des images sur Adobe Stock directement depuis l’application de bureau Creative Cloud.

Adobe Stock est un service qui propose aux designers et aux entreprises près de 40 millions de photos, illustrations et images vectorielles
certifiées de grande qualité et libres de droits, pour tous leurs projets créatifs. Vous pouvez acheter des images à l’unité, quand le besoin se
présente, ou opter pour un abonnement incluant un certain nombre d’images.

https://helpx.adobe.com/fr/creative-cloud/help/add-fonts-typekit.html


1. Dans l’onglet Stock, entrez les mots-clés souhaités et cliquez sur OK.

2. Si le site vous y invite, indiquez votre date de naissance et cliquez sur Mettre à jour.

Vous accédez alors à une page du site web Adobe Stock sur laquelle figurent toutes les images correspondant à votre recherche.

Adobe Stock et Bibliothèques Creative Cloud



Vous pouvez sélectionner une image sur le site web Adobe Stock et ajouter son aperçu avec tatouage numérique à toutes vos bibliothèques. Dans
les applications Creative Cloud prenant en charge les bibliothèques (Photoshop, Illustrator, InDesign, Premiere Pro et After Effects), il vous suffit
ensuite de faire glisser cette image marquée depuis le panneau Bibliothèques vers votre projet. Quand vous le souhaitez, vous pouvez également
acheter les droits de l’image directement depuis le panneau Bibliothèques de l’application de bureau Creative Cloud.

Lorsque vous achetez les droits d’une image, les applications Creative Cloud compatibles avec les actifs liés aux bibliothèques (Photoshop,
Illustrator et InDesign) mettent automatiquement à jour toutes les instances liées de cette image pour les remplacer par la version haute
résolution, sans le tatouage numérique.

Pour plus d’informations, reportez-vous à la page Utilisation d’Adobe Stock.

Recherche de ressources de création avec Market

Creative Cloud Market est un ensemble de ressources certifiées de haute qualité, mises au point par des créatifs, pour des créatifs. Les abonnés
Creative Cloud peuvent accéder gratuitement aux actifs depuis le portail Market, aussi bien depuis un ordinateur de bureau qu’un appareil mobile
(via les applications connectées Creative Cloud), et faire leur choix parmi une sélection exceptionnelle d’illustrations vectorielles, d’icônes, de
motifs, de kits d’interface utilisateur, et bien plus encore. Chaque mois, un abonné Creative Cloud peut télécharger jusqu’à 500 actifs exclusifs et
libres de droits. Ce nouveau service performant permet aux créatifs de trouver très facilement les ressources qu’il leur faut, puis de les améliorer,
les manipuler et les modifier afin de lancer leur processus de création.

http://idiom-q-win-1/fr/creative-cloud/how-to/creative-cloud-libraries-stock-linked-assets.html


Pour plus d’informations, reportez-vous à la page Actifs Creative Cloud Market.

Partage et découverte de projets avec Behance

Présentez et découvrez des projets créatifs sur Behance. En tant que membre, vous pouvez créer un portfolio regroupant vos travaux et le diffuser
à grande échelle de manière efficace. Vous pouvez également découvrir les derniers travaux de designers du monde entier en parcourant les
œuvres mises en avant ou les plus populaires dans tous les domaines de création.

Connectez-vous ou créez-vous un compte pour accéder à votre fil d’actualité ainsi qu’à votre portfolio Behance et partager ou découvrir de
nouveaux travaux. Si vous possédez déjà un compte, vous serez invité à vous connecter. Si vous ne possédez pas encore de compte, vous
pouvez en créer un de manière simple et rapide.
Même si vous ne possédez pas de compte Behance, vous pouvez parcourir les projets et les travaux en cours depuis l’application de bureau
Creative Cloud, à partir du panneau Communauté.

https://helpx.adobe.com/fr/creative-cloud/help/market.html
http://www.behance.net/


Pour plus d’informations, reportez-vous à la page Partage sur Behance ou rendez-vous sur le forum de la communauté Adobe Behance.

Accueil et fil d’actualité

Le fil d’actualité figurant sur le panneau Accueil de l’application de bureau Creative Cloud présente vos interactions avec Creative Cloud. Il vous
informe sur les différents événements et activités, tels que la sortie de nouvelles applications, les mises à jour ou encore le statut des installations.

https://helpx.adobe.com/fr/creative-cloud/kb/publish-behance.html
http://forums.adobe.com/community/behance


Connexion pour activer Creative Cloud

Activation et désactivation de Creative Cloud

Pour activer Creative Cloud, connectez-vous simplement à l’application avec votre Adobe ID. Quand vous vous identifiez, vous activez la licence
Creative Cloud ainsi que l’ensemble des applications et services associés à votre Adobe ID. Vous pouvez ensuite utiliser vos applications et services
normalement.

Pour vous connecter, cliquez sur l’icône Creative Cloud, située dans la barre des tâches (Windows) ou dans la barre de menus (Mac OS),
afin d’ouvrir l’application de bureau Adobe Creative Cloud.
Entrez votre Adobe ID (généralement votre adresse e-mail) et votre mot de passe, puis cliquez sur Se connecter. (Si l’application de
bureau Creative Cloud s’ouvre, cela signifie que vous êtes déjà connecté.)

Vous pouvez maintenant faire appel aux services Creative Cloud, installer des applications Creative Cloud et lancer des applications Creative
Cloud précédemment installées.

Pour désactiver Creative Cloud, vous devez vous déconnecter. Quand vous vous déconnectez, l’ensemble des applications installées et services
Creative Cloud associés à votre Adobe ID sur cet ordinateur sont désactivés. Les applications restent installées mais ne sont plus connectées à une
licence valide. Reconnectez-vous pour réactiver la licence et utiliser à nouveau les applications et services.

Pour vous déconnecter, ouvrez l’application de bureau Creative Cloud, cliquez sur la roue dentée et sélectionnez Préférences. Cliquez sur
Général puis sur Se déconnecter.

L’ensemble des applications et services Creative Cloud associés à votre Adobe ID sont alors désactivés sur cet ordinateur.

Pour obtenir des instructions détaillées, reportez-vous à la page Connexion et déconnexion pour activer des applications Creative Cloud.

Préférences

Pour ouvrir la boîte de dialogue Préférences de l’application de bureau Creative Cloud, cliquez sur la roue dentée et sélectionnez Préférences.

http://idiom-q-win-1/fr/creative-cloud/help/sign-in-out-activate-apps.html


La boîte de dialogue Préférences propose différentes options permettant de personnaliser et d’adapter Creative Cloud, notamment pour changer la
langue d’installation des logiciels, régler les paramètres des services Creative Cloud ou encore vous déconnecter, si vous avez besoin de désactiver
temporairement votre compte.

Pour désactiver l’ensemble des applications et services Creative Cloud associés à votre Adobe ID, cliquez sur Général puis sur
Se déconnecter. Quand vous vous déconnectez, l’ensemble des applications installées et services Creative Cloud associés à votre Adobe ID
sont désactivés.
Pour activer les mises à jour automatiques, sélectionnez Toujours appliquer les mises à jour de Creative Cloud pour bureau.
Pour changer la langue d’installation des logiciels ou leur emplacement d’installation, cliquez sur Préférences > Creative Cloud > Apps.
Pour obtenir des instructions détaillées, reportez-vous à la page Modification du paramètre de langue de vos applications Creative Cloud.
Pour connecter vos travaux avec le référentiels Adobe Experience Manager (AEM) Assets, sélectionnez Se connecter à AEM Assets. Pour
plus d’informations, reportez-vous à la page AEM Assets.
Utilisez les onglets Fichiers, Polices et Behance pour modifier les différents paramètres.
Pour afficher les notifications envoyées par Adobe, activez l’option Afficher les notifications OS dans chaque onglet.

Was this helpful?
Yes   No 

By clicking Submit, you accept the Adobe Terms of Use.
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Articles connexes

Téléchargement et installation d’applications Creative Cloud
Mise à jour d’applications Creative Cloud
Désinstallation ou suppression d’applications Creative Cloud
Connexion et déconnexion pour activer des applications Creative Cloud

Assistance Creative Cloud

Consultez le manuel en ligne, regardez des tutoriels ou demandez de l’aide. En savoir plus.

 

Encore besoin d’aide ?

Interroger la communauté

Posez vos questions et obtenez des réponses des experts.

Solliciter la communauté
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Nous contacter

Notre équipe de support se tient à votre disposition pour vous aider.

Obtenir de l’aide

 Choisir une autre régionFrance (Modifier)
Choisissez votre région

La langue et/ou le contenu du site Adobe.com varient en fonction de la région sélectionnée.

Americas Brasil Canada - English Canada - Français Latinoamérica México United States Europe, Middle East and Africa Africa -
English België Belgique Belgium - English Česká republika Cyprus - English Danmark Deutschland Eastern Europe -
English Eesti España France Greece - English Hrvatska Ireland Israel - English Italia Latvija Lietuva Luxembourg - Deutsch Luxembourg -
English Luxembourg - Français Magyarország Malta - English Middle East and North Africa - English Moyen-Orient et Afrique du Nord -
Français Nederland Norge Österreich Polska Portugal România Schweiz Slovenija Slovensko Srbija Suisse Suomi Sverige Svizzera Türkiye
United Kingdom България Россия Україна ישראל - עברית Asia - Pacific Australia Hong Kong S.A.R. of China India - English New
Zealand Southeast Asia (Includes Indonesia, Malaysia, Philippines, Singapore, Thailand, and Vietnam) - English 中国 中國香港特別行政
區 台灣 日本 한국 Commonwealth of Independent States Includes Armenia, Azerbaijan, Belarus, Georgia, Kazakhstan, Kyrgyzstan,
Moldova, Tajikistan, Turkmenistan, Ukraine, Uzbekistan

Produits Téléchargements Support et formation Société
Copyright © 2015 Adobe Systems Software Ireland Ltd. All rights reserved.
Politique de confidentialité Conditions d'utilisation Cookies ChoixdePub

https://helpx.adobe.com/fr/contact.html?step=CCSN
http://idiom-q-win-1/br/
http://idiom-q-win-1/ca/
http://idiom-q-win-1/ca_fr/
http://idiom-q-win-1/la/
http://idiom-q-win-1/mx/
http://idiom-q-win-1/us/
http://idiom-q-win-1/africa/
http://idiom-q-win-1/africa/
http://idiom-q-win-1/be_nl/
http://idiom-q-win-1/be_fr/
http://idiom-q-win-1/be_en/
http://idiom-q-win-1/cz/
http://idiom-q-win-1/eeurope/
http://idiom-q-win-1/dk/
http://idiom-q-win-1/de/
http://idiom-q-win-1/eeurope/
http://idiom-q-win-1/eeurope/
http://idiom-q-win-1/ee/
http://idiom-q-win-1/es/
http://idiom-q-win-1/fr/
http://idiom-q-win-1/eeurope/
http://idiom-q-win-1/hr/
http://idiom-q-win-1/ie/
http://idiom-q-win-1/il_en/
http://idiom-q-win-1/it/
http://idiom-q-win-1/lv/
http://idiom-q-win-1/lt/
http://idiom-q-win-1/lu_de/
http://idiom-q-win-1/lu_en/
http://idiom-q-win-1/lu_en/
http://idiom-q-win-1/lu_fr/
http://idiom-q-win-1/hu/
http://idiom-q-win-1/eeurope/
http://idiom-q-win-1/mena_en/
http://idiom-q-win-1/mena_fr/
http://idiom-q-win-1/mena_fr/
http://idiom-q-win-1/nl/
http://idiom-q-win-1/no/
http://idiom-q-win-1/at/
http://idiom-q-win-1/pl/
http://idiom-q-win-1/pt/
http://idiom-q-win-1/ro/
http://idiom-q-win-1/ch_de/
http://idiom-q-win-1/si/
http://idiom-q-win-1/sk/
http://idiom-q-win-1/rs/
http://idiom-q-win-1/ch_fr/
http://idiom-q-win-1/fi/
http://idiom-q-win-1/se/
http://idiom-q-win-1/ch_it/
http://idiom-q-win-1/tr/
http://idiom-q-win-1/uk/
http://idiom-q-win-1/bg/
http://idiom-q-win-1/ru/
http://idiom-q-win-1/ua/
http://idiom-q-win-1/il_he/
http://idiom-q-win-1/mena_ar/
http://idiom-q-win-1/au/
http://idiom-q-win-1/hk_en/
http://idiom-q-win-1/in/
http://idiom-q-win-1/nz/
http://idiom-q-win-1/nz/
http://idiom-q-win-1/sea/
http://idiom-q-win-1/cn/
http://idiom-q-win-1/hk_zh/
http://idiom-q-win-1/hk_zh/
http://idiom-q-win-1/tw/
http://idiom-q-win-1/tw/
http://idiom-q-win-1/jp/
http://idiom-q-win-1/kr/
http://idiom-q-win-1/cis/
http://idiom-q-win-1/cis/
http://www.adobe.com/fr/products/catalog/software.html
http://www.adobe.com/fr/downloads.html
http://helpx.adobe.com/fr/support.html
http://www.adobe.com/fr/company.html
http://www.adobe.com/fr/privacy.html
http://www.adobe.com/fr/legal/general-terms.html
http://www.adobe.com/fr/privacy/cookies.html


Exploration, synchronisation et gestion d’actifs

Haut de la page

Fichiers :

Créations mobiles :

Bibliothèques :

Remarque :

Exploration d’actifs
Synchronisation ou chargement de fichiers
Suppression de fichiers
Formules et quota de stockage
Résolution des problèmes

Votre compte Adobe Creative Cloud est fourni avec un espace de stockage en ligne pour que vous puissiez
accéder à vos fichiers partout et à partir de n’importe quel périphérique ou ordinateur. Vous pouvez
prévisualiser de nombreux types de fichiers de création directement dans un navigateur web, sur votre
ordinateur, votre tablette ou votre smartphone. Il s’agit notamment des types de fichiers suivants : PSD, AI,
INDD, JPG, PDF, GIF, PNG, Photoshop Touch et Ideas.

Avec l’application de bureau Adobe Creative Cloud, tous les fichiers restent synchronisés : chaque ajout,
modification ou suppression est répercuté sur tous les ordinateurs et périphériques connectés. Par exemple,
si vous chargez un fichier .ai via la page Actifs Creative Cloud, celui-ci est automatiquement téléchargé sur
tous les ordinateurs connectés.

Exploration d’actifs

Vos actifs Creative Cloud comprennent les fichiers synchronisés avec votre poste de travail, les actifs créés
avec les applications mobiles connectées à Creative Cloud et les actifs du service Bibliothèques Creative
Cloud. Vous pouvez parcourir tous ces éléments via la page Actifs Creative Cloud, dans laquelle ils sont
classés de la façon suivante :

présente les actifs synchronisés avec le répertoire Creative Cloud Files sur votre bureau.

présente les actifs créés à partir des applications mobiles connectées à Creative Cloud.

présente les bibliothèques de conception que vous avez vous-même créées.

les actifs de bureau (sous Fichiers) permettent diverses opérations : renommer, partager,
télécharger, remplacer ou encore archiver. En revanche, sur la page Actifs Creative Cloud, vous ne pouvez
que consulter les actifs qui se trouvent sous Créations mobiles et Bibliothèques.

http://idiom-q-win-1/fr/creative-cloud/help/creative-cloud-desktop.html
http://assets.adobe.com/
http://assets.adobe.com/


Tout : présente tous les fichiers synchronisés avec le répertoire Creative Cloud
Files.

Partagés : présente les fichiers partagés entre vous et d’autres utilisateurs de
Creative Cloud.

Archivés : présente les fichiers supprimés.

De même, vous pouvez parcourir les actifs créés à l’aide des applications
mobiles Creative Cloud dans la section Créations mobiles, où ils sont répartis
selon l’application utilisée.

Pour plus d’informations sur les bibliothèques, reportez-vous à la section
Bibliothèques Creative Cloud.

Haut de la page

Quand vous cliquez sur une catégorie d’actifs, celle-ci se développe pour présenter ses sous-catégories (le
cas échéant). Par exemple, les actifs situés sous Fichiers sont classés selon les sous-catégories Tout,
Partagés et Archivés.
 

Synchronisation ou chargement de fichiers

Pour synchroniser des fichiers depuis votre ordinateur, effectuez l’une des opérations suivantes :

Copiez, collez ou déplacez vos fichiers vers le répertoire Creative Cloud Files sur votre
poste de travail.
Au sein d’une application, sélectionnez Fichier > Enregistrer ou Fichier >
Enregistrer sous, puis accédez au répertoire Creative Cloud Files.

Pour ouvrir le répertoire Creative Cloud Files depuis l’application de bureau Creative Cloud, sélectionnez
Actifs > Fichiers et cliquez sur Ouvrir le dossier.

http://idiom-q-win-1/fr/creative-cloud/help/libraries.html


Remarque :

Chargez et gérez vos fichiers sur Creative Cloud en
utilisant le menu Actions de la page Actifs Creative
Cloud.

Faites glisser des actifs depuis le bureau vers la
page Actifs Creative Cloud.

les fichiers dont le nom contient des caractères spéciaux tels que | " ? < > / * ou : ne sont pas
synchronisés, de même que les fichiers portant un nom réservé comme AUX ou Com1. En cas d’erreur,
renommez le fichier avant de le synchroniser vers Creative Cloud. Pour plus d’informations, reportez-vous à
la page Erreur : Impossible de synchroniser les fichiers.

Vous pouvez également charger des fichiers directement sur la page Actifs Creative Cloud en appliquant
l’une des méthodes suivantes.

Remplacement d’un fichier

Lorsque vous chargez à nouveau un fichier, une nouvelle version est créée et remplace la précédente.

http://assets.adobe.com/
http://assets.adobe.com/
http://assets.adobe.com/
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Creative Cloud conserve également une copie de chacune des modifications apportées aux fichiers et
synchronisées via Photoshop Touch, Adobe Ideas ou l’application de bureau Creative Cloud.

Pour remplacer un fichier via la page Actifs Creative Cloud, procédez comme suit :

Remarque : le type de fichier doit être identique à celui du fichier à remplacer. Ainsi, vous ne pouvez pas
remplacer un fichier .PSD par un fichier .AI.
 
Pour plus d’informations sur le contrôle des versions, reportez-vous à la page FAQ sur le contrôle des
versions.

1. Recherchez le fichier concerné et ouvrez-le.
2. Sélectionnez Actions > Remplacer ou faites glisser le fichier depuis le dossier vers la

fenêtre du navigateur.

Suppression de fichiers

Vous pouvez supprimer des fichiers du site web de Creative Cloud ou des Adobe Touch Apps. Vous avez
également la possibilité d’utiliser les commandes du système d’exploitation pour supprimer des fichiers du
répertoire Creative Cloud Files sur votre bureau. Toutes les suppressions de fichiers sont synchronisées avec
votre compte, et les fichiers sont archivés dans Creative Cloud. Les fichiers d’origine sont toujours présents
sur votre ordinateur, tandis qu’une copie reste disponible dans Creative Cloud pour que vous puissiez y
accéder où que vous soyez.

Les fichiers archivés continuent à occuper l’espace de stockage en ligne. Vous pouvez supprimer
définitivement ou restaurer les fichiers du dossier Archive. Toute suppression définitive permet de libérer de
la capacité de stockage.

Suppression définitive ou restauration de fichiers

La suppression définitive d’actifs s’effectue en deux étapes :

Vous pouvez également restaurer un fichier archivé :

1. Archivez un fichier de votre répertoire Fichiers Creative Cloud sur votre poste de travail,
dans les applications tactiles compatibles avec Creative Cloud ou sur la page Actifs
Creative Cloud. Les fichiers archivés sont envoyés dans la catégorie Archivés de la
section Mes actifs > Fichiers.

2. Sur la page Archivés, sélectionnez les fichiers à éliminer et cliquez sur Supprimer
définitivement.

3. Dans la boîte de dialogue de confirmation, cliquez sur Supprimer définitivement.

1. Sur la page Archivés, sélectionnez les fichiers à récupérer et cliquez sur Restaurer.
2. Dans la boîte de dialogue de confirmation, cliquez sur Restaurer.

http://idiom-q-win-1/fr/creative-cloud/help/versioning-faq.html
http://idiom-q-win-1/fr/creative-cloud/help/versioning-faq.html
http://assets.adobe.com/
http://assets.adobe.com/
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Capacité de stockage dans l’application de bureau
Creative Cloud

Capacité de stockage sur la page Paramètres

Remarque :

Haut de la page

Solliciter la communauté

Publiez des messages,
discutez avec les autres
utilisateurs et faites
partie de notre

Contact

Accédez à cette page
pour entrer en relation
avec nos experts.

Voir aussi

Prise en main du service
Actifs Creative Cloud
Partage de fichiers et dossiers

Formules et quota de stockage

Votre quota de stockage dépend de votre abonnement à Creative Cloud.

Formule d’abonnement Quota de stockage
disponible

Gratuite 2 Go

Creative Cloud (Photographie) 2 Go

Creative Cloud (Formule mono-applicative ou Pack
complet) 20 Go

Creative Cloud abonnement Équipe 100 Go

Pour connaître l’espace de stockage dont vous disposez, ouvrez l’onglet Fichiers dans le panneau Actifs de
l’application de bureau Creative Cloud ou consultez la section Paramètres de la page Activité Creative Cloud.

Creative Cloud peut synchroniser jusqu’à 1 Go d’excédent depuis n’importe quel périphérique. Passé ce
seuil, l’application de bureau arrête de synchroniser les nouveaux fichiers et affiche une notification indiquant
que le quota est dépassé. Un point d’exclamation rouge signale tous les fichiers qui n’ont pas pu être
chargés. Vous pouvez toujours déplacer, renommer ou supprimer des fichiers. Pour que la synchronisation
puisse reprendre, supprimez quelques fichiers de manière définitive afin de libérer de l’espace.

une petite partie de l’espace total est utilisée à des fins administratives, par conséquent
l’espace de stockage réellement disponible sera légèrement réduit. Cela varie de 100 à 500 Ko en fonction
du nombre de fichiers utilisateur.

Résolution des problèmes

http://forums.adobe.com/community/creative_cloud
http://helpx.adobe.com/fr/contact.html?product=creative-cloud
http://idiom-q-win-1/fr/creative-cloud/how-to/assets-get-started.html
http://idiom-q-win-1/fr/creative-cloud/how-to/assets-get-started.html
http://idiom-q-win-1/fr/creative-cloud/help/share.html
https://assets.adobe.com/fr/activity
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exceptionnelle
communauté.

Collaboration par partage de
dossiers
Synchronisation et partage de
fichiers avec des
collaborateurs (vidéo, 10 min)
Etat d’Adobe Creative Cloud
Erreur : Impossible de
synchroniser les fichiers
FAQ sur le contrôle des
versions

 

http://creativecommons.org/licenses/by-nc-sa/3.0/
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https://www.adobe.com/go/gffooter_online_privacy_policy_fr
http://idiom-q-win-1/fr/creative-cloud/help/collaboration.html
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http://status.creativecloud.com/
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Ajout de polices depuis Typekit

Typekit est un service avec abonnement qui permet d’accéder
à une immense bibliothèque de polices utilisables dans des
applications de bureau et sur des sites web.

Une formule Typekit Portfolio est incluse dans votre abonnement
Creative Cloud. Quant aux titulaires d’un abonnement gratuit à
Creative Cloud, ils ont accès à une sélection de polices Typekit
utilisables sur le web et sur leur poste de travail.

Abonnez-vous à Creative Cloud
(formule complète, mono-
applicative ou gratuite) ou à une
formule Typekit autonome pour
synchroniser des polices avec
votre ordinateur de bureau. Pour
plus d’informations, reportez-vous
à la page de présentation de
Typekit et prenez connaissance
des formules Typekit. 

Haut de la page

Haut de la page

Depuis l’application de bureau
Creative Cloud :

Depuis une application avec
fonctionnalité Typekit intégrée :

Directement sur le site web
Typekit.com :

Prise en main
Recherche et ajout de polices depuis Typekit
Utilisation de polices synchronisées
Gestion des polices synchronisées

Prise en main

Vous pouvez choisir une police de caractères créée par l’un des nombreux partenaires Typekit, puis la
synchroniser avec votre ordinateur via Creative Cloud (ou l’utiliser sur le web). Les polices synchronisées
peuvent être utilisées au sein de toutes les applications Creative Cloud, parmi lesquelles Photoshop et
InDesign, ainsi que dans d’autres applications de bureau telles que MS Word.

L’application de bureau Creative Cloud doit être installée sur votre ordinateur pour que vous puissiez
synchroniser les polices. Si tel n’est pas le cas, vous devez la télécharger et l’installer. Pour plus
d’informations, reportez-vous à la page Creative Cloud sur votre bureau.

Par défaut, Typekit est activé, afin de pouvoir synchroniser les polices et les rendre disponibles dans vos
applications de bureau.

À ce stade, si vous avez déjà sélectionné des polices à synchroniser dans votre navigateur web, elles
commencent automatiquement à se synchroniser avec votre ordinateur. 

Recherche et ajout de polices depuis Typekit

Vous pouvez accéder à la bibliothèque Typekit depuis plusieurs endroits. Utilisez une ou plusieurs des
méthodes suivantes pour intégrer au mieux la sélection de nouvelles polices dans votre workflow

existant.

http://creative.adobe.com/fr/join
https://typekit.com/plans
http://creative.adobe.com/fr/products/typekit
http://creative.adobe.com/fr/products/typekit
http://typekit.com/plans
https://helpx.adobe.com/fr/creative-cloud/help/creative-cloud-desktop.html


Dans l’onglet Polices, cliquez sur
Ajouter des polices depuis
Typekit. Une fenêtre de
navigateur s’ouvre et vous êtes
connecté à Typekit.com.

Dans le menu de polices de
l’application, cliquez sur Ajouter
des polices depuis Typekit. Une
fenêtre de navigation s’ouvre
directement dans l’application.

À l’aide de votre Adobe ID et de
votre mot de passe, connectez-
vous à Typekit.com.
 

 

Vous pouvez rechercher les polices souhaitées ou y accéder en utilisant des filtres. La disponibilité d’une
police donnée est indiquée sur sa fiche.

Disponibilité indiquée sur la fiche de chaque police

A. Web et poste de travail B. Web 

Cliquez sur une fiche de police individuelle pour en savoir plus sur la police en question et voir des
exemples de caractères dans tous les styles et toutes les épaisseurs disponibles.

https://typekit.com/


Cliquez sur Utiliser les polices. Dans la fenêtre Utiliser cette famille, indiquez l’emplacement sur le
bureau où vous souhaitez synchroniser la police ou ajoutez-la dans un kit en vue de l’utiliser sur le web.

Sélectionnez les styles dont vous avez besoin dans la famille de polices, puis cliquez sur Synchroniser
les polices sélectionnées.

Les polices sont synchronisées vers tous les ordinateurs sur lesquels vous avez installé l’application Creative
Cloud. Pour voir ces polices, ouvrez l’application Creative Cloud, puis cliquez sur le panneau Polices.
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Utilisation de polices
Typekit dans
InDesign CC

Utilisation de polices
Typekit dans Premiere

Utilisation de polices
Typekit dans
Illustrator CC

Utilisation de polices
Typekit dans After

Utilisation de polices
Typekit dans
Photoshop CC

Utilisation de polices synchronisées

Pour utiliser les polices que vous avez synchronisées, ouvrez simplement l’application de bureau de votre
choix et accédez au menu de polices. Les polices synchronisées apparaissent dans la liste des options.
Certaines applications de bureau telles que Microsoft Office peuvent nécessiter un redémarrage après la
synchronisation d’une nouvelle police.

Affichage des polices synchronisées depuis Typekit dans le menu de polices d’InDesign

Pour plus d’informations sur l’utilisation de polices Typekit dans une application Creative Cloud, reportez-
vous aux pages suivantes :

http://idiom-q-win-1/fr/indesign/using/working-with-typekit-fonts-indesign.html
http://idiom-q-win-1/fr/indesign/using/working-with-typekit-fonts-indesign.html
http://idiom-q-win-1/fr/indesign/using/working-with-typekit-fonts-indesign.html
http://idiom-q-win-1/fr/premiere-pro/using/whats-new.html#Support%20for%20fonts%20from%20Typekit
http://idiom-q-win-1/fr/premiere-pro/using/whats-new.html#Support%20for%20fonts%20from%20Typekit
http://idiom-q-win-1/fr/illustrator/using/typekit-fonts.html
http://idiom-q-win-1/fr/illustrator/using/typekit-fonts.html
http://idiom-q-win-1/fr/illustrator/using/typekit-fonts.html
http://idiom-q-win-1/fr/after-effects/using/whats-new.html#typekit-desktop-ae
http://idiom-q-win-1/fr/after-effects/using/whats-new.html#typekit-desktop-ae
http://idiom-q-win-1/fr/photoshop/using/fonts-typekit.html
http://idiom-q-win-1/fr/photoshop/using/fonts-typekit.html
http://idiom-q-win-1/fr/photoshop/using/fonts-typekit.html


Pro CC Effects CC
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Gestion des polices synchronisées

Vous pouvez afficher les polices synchronisées sur votre ordinateur à l’aide du panneau Polices de
l’application Adobe Creative Cloud ou à partir de votre compte Typekit.com.

Suppression de polices synchronisées

Pour supprimer des polices synchronisées de votre ordinateur :

1. Dans le panneau Polices d’Adobe Creative Cloud, cliquez sur Gérer les polices. La page
Polices synchronisées s’ouvre dans une fenêtre de navigateur. Vous pouvez aussi vous
connecter à Typekit.com et accéder directement à la page Polices synchronisées.

2. Sur la droite de toutes les polices que vous ne souhaitez plus utiliser, cliquez sur
Supprimer.

Désactivation de Typekit

Vous pouvez choisir d’activer ou de désactiver la synchronisation des polices. Si vous choisissez de la
désactiver, les polices ne sont plus synchronisées, et toutes les polices synchronisées précédemment sont
supprimées de votre ordinateur.

1. Dans l’application de bureau Creative Cloud, cliquez sur  > Préférences > Creative
Cloud.

2. Cliquez sur Polices.

3. Pour activer ou désactiver la synchronisation des polices, sélectionnez On ou Off dans
les paramètres Typekit.

Utilisation de Typekit hors ligne

Si vous passez hors ligne pendant que l’application Creative Cloud est en cours d’exécution et que vous êtes

http://idiom-q-win-1/fr/premiere-pro/using/whats-new.html#Support%20for%20fonts%20from%20Typekit
http://idiom-q-win-1/fr/after-effects/using/whats-new.html#typekit-desktop-ae
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connecté, les polices synchronisées pourront toujours être utilisées. Toute modification apportée à la
sélection de synchronisation de polices sur Typekit.com ne s’effectuera qu’une fois la connexion rétablie.

Si vous lancez l’application Creative Cloud alors que vous êtes hors ligne, les polices ne seront pas
disponibles et ne seront pas affichées dans les menus de polices standard.

Articles connexes
Synchronisation de polices sur le bureau | Typekit.com
Ajout de polices dans les applications de bureau via Creative Cloud

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
https://www.adobe.com/go/gffooter_online_privacy_policy_fr
http://help.typekit.com/customer/portal/topics/514077-syncing-fonts-to-the-desktop/articles
http://helpx.adobe.com/fr/creative-cloud/how-to/cc-add-fonts-to-desktop.html


Creative Cloud Market
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Creative Cloud Market est un ensemble de ressources certifiées de haute qualité, mises au point par des
créatifs, pour des créatifs. Le service est accessible pour tous les titulaires d’un abonnement Creative Cloud
payant, à l’exception des clients ayant opté pour une formule spéciale photo. Les membres Creative Cloud
peuvent accéder gratuitement aux actifs depuis le portail Market, aussi bien depuis un ordinateur de bureau
qu’un appareil mobile (via les applications connectées Creative Cloud), et faire leur choix parmi une sélection
exceptionnelle d’illustrations vectorielles, d’icônes, de motifs, de kits d’interface utilisateur, et bien plus encore.
Chaque mois, un abonné Creative Cloud peut télécharger jusqu’à 500 actifs exclusifs et libres de droits. Ce
nouveau service performant vous permet de trouver très facilement les ressources qu’il vous faut, puis de les
améliorer, les manipuler et les modifier afin de lancer votre processus de création.

Pour accéder à Market, vous devez d’abord installer l’application de bureau Creative Cloud ou une
application mobile prise en charge telle que Adobe Photoshop Sketch. Pour savoir comment la télécharger,
reportez-vous à la page Application de bureau Creative Cloud. Regardez ce bref tutoriel vidéo pour en savoir
plus : Accès aux ressources de conception Creative Cloud Market.

Recherche et téléchargement de ressources de création

Depuis l’application de bureau Creative Cloud, vous pouvez accéder à des milliers d’actifs de haute qualité.
Cliquez sur Actifs > Market. Vous pouvez également développer la liste déroulante pour effectuer une
recherche par catégorie, ou bien lancer une recherche par mots-clés pour trouver les actifs les mieux
adaptés à votre projet.

1. Dans l’application de bureau Creative Cloud, cliquez sur Actifs > Market.

2. Creative Cloud Market comprend une sélection de ressources certifiées de haute qualité,
couvrant les catégories suivantes :

Pour positionnement : modèles photo et numériques avec calques organisés et
masquage professionnel (fichiers PSD)
Interfaces utilisateur : fichiers PSD avec calques, comprenant des kits complets,
des formulaires, des graphiques, des éléments de navigation et des widgets pour le
web et les appareils mobiles (fichiers PSD)
Formes vectorielles : formes et objets évolutifs qui s’intègrent à Photoshop,
InDesign et Illustrator (fichiers SVG)
Icônes : série de symboles plats, en 3D, de glyphes et de contours destinés à
l’impression, au web et à la signalisation (fichiers PNG/SVG)
Motifs : motifs et arrière-plans géométriques, illustrés et texturés qui se répètent à
l’infini (fichiers PNG/SVG)
Formes : supports naturels de haute qualité et formes Photoshop abstraites
(fichiers ABR/TPL)

Pour filtrer les actifs, sélectionnez une catégorie dans le menu contextuel Market.

https://helpx.adobe.com/fr/creative-cloud/help/creative-cloud-desktop.html


3. Pour rechercher des actifs en particulier, cliquez sur  et entrez un terme de recherche.

Vous pouvez filtrer et trier les résultats de la recherche.

4. Cliquez sur la vignette d’un actif pour obtenir des informations complémentaires et des
détails à son sujet.

5. Cliquez sur Télécharger et choisissez une bibliothèque dans laquelle télécharger l’actif.
Vous pouvez également créer une nouvelle bibliothèque. Pour plus d’informations,
reportez-vous à la section Bibliothèques Creative Cloud.

En plus de la bibliothèque, les actifs sont également téléchargés automatiquement dans
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le sous-dossier Téléchargements Market de votre dossier principal Creative Cloud Files. 

FAQ

Comment bénéficier de Creative Cloud Market ?

Creative Cloud Market est accessible pour tous les titulaires d’un abonnement Creative Cloud payant, à
l’exception des clients ayant opté pour une formule spéciale photo (Photographie Photoshop ou
Photographie Creative Cloud). Pendant une période limitée, Adobe Creative Cloud Market est accessible
pour tous les membres de Creative Cloud par le biais de l’application Adobe Sketch pour iPad. Les
titulaires d’un abonnement Creative Cloud gratuit ou d’une formule spéciale photo peuvent parcourir
Market via l’application de bureau Creative Cloud mais ne peuvent pas télécharger son contenu. Pour
télécharger et utiliser le contenu de Creative Cloud Market, passez à une formule supérieure avec un
abonnement mono-applicatif ou complet Creative Cloud.

Pourquoi les clients ayant souscrit un abonnement spécial photo n’ont-ils pas accès à Creative
Cloud Market ?

Creative Cloud Market est un nouvel avantage disponible dans le cadre de certains abonnements
Creative Cloud payants ; il n’est pas accessible aux clients ayant opté pour une formule spéciale photo.
Certains services Creative Cloud, tels que Creative Cloud Market, TypeKit et ProSite, sont uniquement
disponibles dans le cadre des abonnements mono-applicatifs ou complets Creative Cloud. Pour
télécharger et utiliser le contenu de Creative Cloud Market, passez à une formule supérieure avec un
abonnement mono-applicatif ou complet Creative Cloud.

Dois-je impérativement disposer d’un abonnement à Creative Cloud ?

Creative Cloud Market est accessible pour tous les titulaires d’un abonnement Creative Cloud payant.
Cela concerne aussi bien les titulaires d’un abonnement mono-applicatif que complet (quelle que soit la
formule : utilisateur individuel, Équipe, Éducation ou Entreprise). Pour accéder à Creative Cloud Market,
les utilisateurs doivent passer par l’application de bureau Creative Cloud.

Les titulaires d’une formule Creative Cloud spéciale photo ne peuvent pas du tout accéder à Market via
l’application de bureau Creative Cloud. Les titulaires d’un abonnement gratuit peuvent parcourir les actifs
Market via l’application de bureau Creative Cloud mais ne peuvent pas les télécharger.

 

Les actifs téléchargés sont-ils comptabilisés dans mon quota de stockage ?

Oui. Les actifs téléchargés sont stockés dans votre dossier Creative Cloud Files et sont comptabilisés
dans votre capacité de stockage. Si vous dépassez le quota fixé, vous ne pourrez plus télécharger aucun
actif tant que vous n’aurez pas supprimé d’anciens fichiers pour libérer un peu d’espace. Reportez-vous à

http://sketch.adobe.com/fr
https://creative.adobe.com/fr/plans
https://creative.adobe.com/fr/plans
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la page Gestion et synchronisation des fichiers.

Puis-je utiliser ces actifs dans mes projets ?

Oui. Ces actifs exclusifs et libres de droits sont utilisables au sein de vos projets.

Puis-je copier ou sauvegarder ces actifs afin de les réutiliser ultérieurement ?

Oui, vous pouvez effectuer une sauvegarde des actifs téléchargés depuis Creative Cloud Market en vue
d’une utilisation ultérieure.

Après avoir téléchargé des actifs, puis-je les partager ?

Non. Même si les actifs sont libres de droits pour tous les abonnés Creative Cloud éligibles qui peuvent
les utiliser dans leurs publications, productions et projets, il n’est pas possible de les partager ni de les
redistribuer.

Comment Adobe obtient-elle le contenu proposé sur Creative Cloud Market ?

Adobe se procure ce contenu auprès des meilleurs créatifs du secteur directement sur Behance, première
plate-forme en ligne gratuite pour la présentation et la découverte de projets créatifs.  

Comment faire pour que mes travaux soient proposés dans Creative Cloud Market ?

Pour attirer l’attention sur leur travail, Adobe recommande à tous les artistes potentiels de publier leurs
créations sur Behance. Adobe recherche constamment de nouvelles œuvres sur Behance avant de les
certifier.

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
https://www.adobe.com/go/gffooter_online_privacy_policy_fr
http://idiom-q-win-1/fr/creative-cloud/help/sync-files.html
http://www.behance.net/


Creative Cloud Extract

Utilisez le module Extraction Creative Cloud pour transformer encore plus facilement
vos conceptions Photoshop en code. Avec Extraction, les designers et développeurs
Web peuvent convertir des conceptions Web en code exploitable et ce, de manière
bien plus simple et plus efficace.

Les compositions Photoshop sont couramment utilisées pour partager des spécifications de projet avec des
développeurs Web ; ceux-ci doivent alors convertir la conception originale en code HTML et CSS. Un projet
se déroule généralement de la manière suivante : les designers créent des compositions Photoshop pour des
pages Web ou mobiles. Les concepteurs préparent ensuite le fichier PSD destiné aux développeurs, en
créant des actifs et des spécifications détaillées. Les développeurs Web doivent alors transformer ces actifs
et éléments de conception en code.

Le module Extraction permet de repenser totalement ce processus : les designers Web peuvent exporter des
actifs optimisés en un temps record dans Photoshop CC, mais aussi partager leurs fichiers PSD via le
service Actifs Creative Cloud pour que les développeurs soient en mesure d’obtenir des informations de
conception clés et de télécharger des actifs depuis le navigateur. Les développeurs peuvent ensuite accéder
à ces informations dans Dreamweaver CC et les appliquer au fur et à mesure qu’ils rédigent leur code.

Le module Extraction est une fonctionnalité Creative Cloud qui peut être utilisée à différents stades du
processus de transformation des compositions PSD en code. Avec Extraction, vous êtes libre d’utiliser les
outils et les technologies que vous maîtrisez le mieux pour transformer de simples idées en résultats
concrets.

Les designers peuvent ainsi utiliser l’environnement familier de Photoshop CC pour définir
et extraire des actifs d’images à partir de calques ou de groupes de calques.
Les développeurs Web peuvent accéder aux fichiers PSD via le service Actifs Creative
Cloud et utiliser le module Extraction pour exporter des actifs d’images, des mesures et
des styles CSS. Ces actifs et styles CSS peuvent ensuite être utilisés pour transformer



Extraction d’actifs dans
Photoshop

Les designers qui créent des
compositions Photoshop peuvent
rapidement définir et regrouper des
actifs d’images à partir de calques ou
de groupes de calques grâce à une
interface visuelle simple, développée
sur la base d’Adobe Generator. Les
délais de production sont ainsi
largement réduits, ce qui laisse plus
de temps pour la conception en elle-
même.  

Extraction dans Dreamweaver

Les designers et développeurs Web
peuvent désormais consulter des
fichiers PSD dans Dreamweaver et
avoir recours à des indications de
code contextuelles pour définir
facilement les polices, couleurs et
dégradés dans le code CSS. Ils
peuvent également faire glisser des
images optimisées dans la zone
d’aperçu en direct, copier du texte, et
plus encore.

Extraction dans le service Actifs
Creative Cloud

Les designers Web peuvent partager
des fichiers PSD directement via le
service Actifs Creative Cloud,
accessible dans le navigateur. Ainsi,
les développeurs peuvent rapidement
extraire des informations de
conception (couleurs, dégradés,
polices, texte, code CSS...) qui
faciliteront le passage de la
composition au code. En outre, il est
possible d’exporter des images PNG,
SVG et JPG optimisées pour le Web.

Extract for Brackets (Preview)

L’intégration de la fonction
d’extraction dans Brackets permet de
bénéficier de toute la puissance du
module dans un éditeur de code
simple et moderne. Extract for
Brackets (Preview) permet d’extraire
les informations de conception d’un
PSD en tant que CSS minimum et
propre via des conseils de code
contextuels. Vous pouvez également
extraire des calques en tant
qu’images, utiliser les informations du
PSD pour définir des variables de
préprocesseur et calculer très
facilement des dimensions ou la
distance entre deux objets.

Synchronisation de fichiers

Synchronisez et stockez des
fichiers PSD et des images
extraites dans le service Actifs
Creative Cloud pour y avoir accès
sur tous vos périphériques.

Partage de dossiers

Utilisez le service Actifs Creative
Cloud pour partager des dossiers
et permettre à toute l’équipe de
travailler sur les mêmes fichiers.
Vous pouvez également réviser
des fichiers et y ajouter des
commentaires. Le service Actifs
Creative Cloud inclut par ailleurs
des fonctions de base de contrôle
des versions.

Synchronisation de polices

Les titulaires d’un abonnement
Creative Cloud peuvent accéder
aux polices Typekit et télécharger
celles qui conviennent le mieux à
leurs conceptions.

des compositions en code. 
Designers comme développeurs peuvent utiliser le module Extraction à partir de
Dreamweaver, afin de bénéficier d’une solution autonome complète incluant des
indications de code contextuelles, la possibilité d’extraire des actifs et bien d’autres
fonctionnalités, et ce, directement dans l’environnement de codage.

Vous pouvez rendre vos processus de création encore plus simples en utilisant d’autres services Creative
Cloud pour synchroniser vos fichiers, polices et couleurs. Vous avez ainsi la certitude que chaque utilisateur a
accès aux dernières versions existantes.

http://helpx.adobe.com/fr/photoshop/using/extract-layers-image-assets.html
http://helpx.adobe.com/fr/photoshop/using/extract-layers-image-assets.html
http://helpx.adobe.com/fr/dreamweaver/using/dreamweaver-integration-extract.html
http://helpx.adobe.com/fr/creative-cloud/help/extract-css-images-psd-files.html
http://helpx.adobe.com/fr/creative-cloud/help/extract-css-images-psd-files.html
http://helpx.adobe.com/fr/creative-cloud/help/extract-for-brackets.html
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Plus d’informations Solliciter la
communauté Nous contacter

Didacticiel Extraction
Creative Cloud 

Publiez des messages,
discutez avec les autres

utilisateurs et faites partie
de notre exceptionnelle

communauté.

Accédez à cette page pour
entrer en relation
avec nos experts.

 Regarder maintenant > Poser vos questions
maintenant >

Commencer maintenant >
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Capturer Gérer Réutiliser et créer

Tout ce que vous pouvez faire avec les bibliothèques
Prise en charge du service Bibliothèques dans les applications Creative Cloud
Présentation : Utilisation du service Bibliothèques Creative Cloud

Ajouter un élément à une bibliothèque
Réutiliser et créer
Partager et collaborer
Adobe Stock et Bibliothèques Creative Cloud

FAQ

Avec le service Bibliothèques Creative Cloud, doté de la technologie Adobe
CreativeSync, toutes vos ressources préférées sont toujours à portée de main, où que
vous soyez. Créez des images, des couleurs, des styles de texte et de nombreux
autres éléments dans diverses applications mobiles et de bureau Creative Cloud, puis
retrouvez-les facilement dans d’autres applications mobiles et de bureau, pour un flux
de création tout en fluidité.

Pour découvrir la fonctionnalité, regardez le tutoriel Prise en main du service
Bibliothèques Creative Cloud.

Tout ce que vous pouvez faire avec les bibliothèques

http://idiom-q-win-1/fr/creative-cloud/how-to/creative-cloud-libraries.html
http://idiom-q-win-1/fr/creative-cloud/how-to/creative-cloud-libraries.html


Le service Bibliothèques Creative
Cloud permet de capturer des
actifs de conception dans un large
éventail d’applications (et pas
seulement des applications de
bureau). Ainsi, dès qu’une source
d’inspiration attire votre attention,
vous pouvez la capturer en
utilisant la gamme d’applications
mobiles Creative Cloud, et même
télécharger des actifs depuis
Adobe Stock ou Creative Cloud
Market.

Vous pouvez classer les actifs de
conception dans plusieurs
bibliothèques Creative Cloud.
Celles-ci peuvent être organisées
par projet, type d’actifs ou encore
selon vos propres éléments
préférés, qui constituent la base
de votre style, votre « signature ».

Réutilisez et créez des dessins et
des illustrations à partir d’objets
contenus dans le service
Bibliothèques Creative Cloud.

Haut de la page

Prise en charge du service Bibliothèques dans les applications
Creative Cloud

Applications mobiles

Application

Prise en charge
de
l’enregistrement
des actifs dans
les
bibliothèques

Prise en
charge de
l’utilisation des
actifs contenus
dans les
bibliothèques

Ressource offrant plus
d’informations

Shape CC Formes
vectorielles N/A FAQ Adobe Shape CC

Color CC Thèmes de
couleurs N/A FAQ Adobe Color CC

Brush CC Formes N/A FAQ Adobe Brush CC

Illustrator
Draw N/A Images et

formes FAQ Adobe Illustrator Draw

Photoshop
Sketch N/A Formes FAQ Adobe Photoshop Sketch

Illustrator
Line N/A Couleur et

graphiques FAQ Adobe Illustrator Line CC

Hue CC N/A FAQ Adobe Hue CC

Comp CC N/A FAQ Adobe Comp CC

Premiere Clip N/A FAQ Adobe Premiere Clip

Photoshop
Mix N/A FAQ sur Adobe Photoshop

Mix

Application
de bureau
Creative
Cloud

N/A Creative Cloud | Questions
fréquentes

Applications de bureau et de navigateur

http://idiom-q-win-1/fr/mobile-apps/help/shape-faq.html
http://idiom-q-win-1/fr/mobile-apps/help/color-faq.html
http://idiom-q-win-1/fr/mobile-apps/help/brush-faq.html
http://idiom-q-win-1/fr/mobile-apps/help/draw-faq.html
http://idiom-q-win-1/fr/mobile-apps/help/sketch-faq.html
http://idiom-q-win-1/fr/mobile-apps/help/line-faq.html
http://idiom-q-win-1/fr/mobile-apps/help/hue-faq.html
http://idiom-q-win-1/fr/mobile-apps/help/comp-faq.html
http://idiom-q-win-1/fr/mobile-apps/help/clip-faq.html
http://idiom-q-win-1/fr/mobile-apps/help/mix-faq.html
http://idiom-q-win-1/fr/mobile-apps/help/mix-faq.html
http://idiom-q-win-1/fr/creative-cloud/faq.html
http://idiom-q-win-1/fr/creative-cloud/faq.html


Haut de la page

Applications mobiles

Vous pouvez ajouter des actifs à
votre bibliothèque via un nombre
croissant d’applications mobiles
Adobe. Consultez les supports de
formation pour votre application
mobile pour en savoir plus.

Bureau

Ajoutez des actifs au service
Bibliothèques Creative Cloud sur
votre ordinateur à l’aide d’une
application de bureau Creative
Cloud. Faites glisser ces actifs
vers le panneau Bibliothèques
dans l’application de bureau. Vous
pouvez également consulter et
parcourir les bibliothèques sur la
page Actifs Creative Cloud.

Creative Cloud Market

Découvrez de nouveaux actifs et
ajoutez-les à vos bibliothèques
depuis Creative Cloud Market.
Utilisez l’application de bureau
Creative Cloud pour parcourir les
actifs disponibles et en ajouter
depuis Creative Cloud Market.
Vous pouvez également ajouter
des actifs à une bibliothèque à
l’aide des applications mobiles de

Application ou
service

Prise en charge
de
l’enregistrement
des actifs dans
les
bibliothèques

Prise en
charge de
l’utilisation
des actifs
contenus
dans les
bibliothèques

Ressource offrant plus
d’informations

Applications de bureau

Photoshop Bibliothèques Creative Cloud
dans Photoshop

Illustrator Bibliothèques Creative Cloud
dans Illustrator

InDesign Bibliothèques Creative Cloud
dans InDesign

Premiere Pro Bibliothèques Creative Cloud
dans Premiere Pro

After Effects Bibliothèques Creative Cloud
dans After Effects

Creative Cloud
Market (via
l’application de
bureau
Creative Cloud)

N/A Creative Cloud Market

Navigateur

Actifs Creative
Cloud

Uniquement pour consulter et gérer
(renommer, supprimer)

Actifs Creative Cloud | Stocker
et partager du contenu

Présentation : Utilisation du service Bibliothèques Creative Cloud

Ajouter un élément à une bibliothèque

Le service Bibliothèques Creative Cloud permet de capturer des actifs de conception dans un large éventail
d’applications (et pas seulement des applications de bureau). Ainsi, dès qu’une source d’inspiration attire
votre attention, vous pouvez la capturer en utilisant la gamme d’applications mobiles Creative Cloud, et
même télécharger des actifs depuis Adobe Stock ou Creative Cloud Market.

http://assets.adobe.com/
http://idiom-q-win-1/fr/creative-cloud/help/market.html
http://idiom-q-win-1/fr/photoshop/using/cc-libraries-in-photoshop.html
http://idiom-q-win-1/fr/photoshop/using/cc-libraries-in-photoshop.html
http://idiom-q-win-1/fr/illustrator/using/creative-cloud-libraries-sync-share-assets.html
http://idiom-q-win-1/fr/illustrator/using/creative-cloud-libraries-sync-share-assets.html
http://idiom-q-win-1/fr/indesign/using/creative-cloud-libraries-sync-share-assets.html
http://idiom-q-win-1/fr/indesign/using/creative-cloud-libraries-sync-share-assets.html
http://idiom-q-win-1/fr/premiere-pro/using/creative-cloud-libraries.html
http://idiom-q-win-1/fr/premiere-pro/using/creative-cloud-libraries.html
http://idiom-q-win-1/fr/after-effects/using/creative-cloud-libraries.html
http://idiom-q-win-1/fr/after-effects/using/creative-cloud-libraries.html
http://idiom-q-win-1/fr/creative-cloud/help/market.html
http://idiom-q-win-1/fr/creative-cloud/how-to/assets-get-started.html
http://idiom-q-win-1/fr/creative-cloud/how-to/assets-get-started.html


Consultez les supports de
formation pour votre application
de bureau Creative Cloud pour
obtenir plus d’informations sur
l’utilisation avec les bibliothèques.

création.

Bureau

Dans une application de bureau
prenant en charge les
bibliothèques, ouvrez le panneau
Bibliothèques (Fenêtres >
Bibliothèques), puis faites glisser
des objets vers la zone de dessin.

Applications mobiles

Sélectionnez un objet dans la
bibliothèque pour l’insérer dans
votre projet à l’aide d’applications
mobiles.

Navigateur

Parcourez et consultez les
bibliothèques disponibles sur la
page Actifs Creative Cloud. Vous
pouvez également supprimer une
bibliothèque.

Bureau 

Ouvrez le panneau Bibliothèques (Fenêtres >
Bibliothèques) dans une application de bureau
prenant en charge le service Bibliothèques Creative
Cloud. Ensuite, dans le menu déroulant du panneau,
choisissez Partager le lien ou Collaborer.

Navigateur

Dans le volet de gauche Actifs Creative Cloud,
cliquez sur Bibliothèques. Ensuite, dans le menu de
la bibliothèque, sélectionnez Partager le lien
ou Collaborer.

Réutiliser et créer

Partager et collaborer

Adobe Stock et Bibliothèques Creative Cloud

Adobe Stock s’intègre parfaitement au service Bibliothèques Creative Cloud. Vous pouvez sélectionner une
image en stock et ajouter son aperçu avec tatouage numérique à toutes vos bibliothèques, directement
depuis le site web d’Adobe Stock. Ensuite, dans les applications Creative Cloud prenant en charge les
bibliothèques (Photoshop, lllustrator, InDesign, Premiere Pro et After Effects), vous pouvez faire glisser cette
image marquée depuis le panneau Bibliothèques vers votre projet de création. Si le résultat vous convient,
vous pouvez acheter la licence de l’image directement depuis le panneau Bibliothèques.

Les applications Creative Cloud qui utilisent des éléments en liaison avec les bibliothèques (Photoshop,
Illustrator et InDesign) vont encore plus loin dans ce processus d’intégration. Lorsque vous achetez une
licence pour l’image en stock, toutes les instances liées de cette image dans vos documents ouverts sont
automatiquement remplacées par l’image haute résolution, sans le tatouage numérique.

https://assets.adobe.com/assets/libraries/
http://idiom-q-win-1/fr/creative-cloud/help/share.html
http://idiom-q-win-1/fr/creative-cloud/help/collaboration.html
https://assets.adobe.com/assets/libraries/
http://idiom-q-win-1/fr/creative-cloud/help/share.html
http://idiom-q-win-1/fr/creative-cloud/help/collaboration.html
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Pour plus d’informations, consultez la page Utilisation d’Adobe Stock.

FAQ

Combien d’éléments puis-je ajouter dans une bibliothèque ?

Chaque bibliothèque peut contenir jusqu’à 1 000 actifs.

Le nombre de bibliothèques que je peux créer est-il limité ?

Non, vous pouvez créer autant de bibliothèques que vous le souhaitez. 

Tous les actifs stockés dans des bibliothèques peuvent-ils être utilisés dans l’ensemble des
applications prises en charge ?

Pendant que vous travaillez dans une application, vous pouvez consulter et sélectionner le contenu des
bibliothèques pertinent pour cette application. Par exemple, bien qu’il soit possible d’ajouter des styles de
calque à une bibliothèque, ces styles sont uniquement utilisables dans Photoshop.

Quels types d’informations relatives aux couleurs sont pris en charge ?

Les bibliothèques acceptent les données correspondant à une nuance unique ou à des thèmes de
couleurs. Les bibliothèques ne prennent en charge que les couleurs quadrichromiques. Les tons directs
ne sont pas pris en charge et sont ajoutés en tant que couleurs quadrichromiques aux bibliothèques.

Puis-je réutiliser les actifs stockés dans les bibliothèques dans différentes applications de bureau
Creative Cloud ?

La plupart des actifs peuvent être réutilisés dans les différentes applications de bureau. Les styles de
calque de Photoshop sont une exception notable. Ils ne sont actuellement réutilisables que dans
Photoshop.

Si vous utilisez un style de texte InDesign dans Illustrator ou Photoshop, ces applications vont tenter de
mapper les propriétés de l’actif avec les propriétés pour les styles de texte disponibles dans l’application
hôte. Toutes les propriétés non trouvées dans l’application hôte sont ignorées.

Où les actifs sont-ils stockés ?

Vos actifs sont stockés en local sur votre appareil et synchronisés avec Creative Cloud.

Puis-je partager une bibliothèque avec d’autres utilisateurs ?

Oui. Reportez-vous à la section Collaboration sur des bibliothèques.

Certaines applications mobiles intégrées au service Bibliothèques Creative Cloud (Brush, Color et Shape,
etc.) ne prennent pas en charge la collaboration sur des bibliothèques. En outre, toutes les bibliothèques
partagées avec vous ne sont pas disponibles lorsque vous travaillez dans ces applications mobiles.
Toutefois, si vous avez partagé une bibliothèque avec d’autres utilisateurs, cette bibliothèque est
disponible pour vous dans les applications de bureau Creative Cloud ainsi que dans les applications
mobiles.

Dois-je impérativement disposer d’un abonnement à Creative Cloud ?

Pour pouvoir utiliser le service Bibliothèques Creative Cloud, vous aurez besoin d’un abonnement payant
ou gratuit à Creative Cloud.

Où trouver des informations sur le service Bibliothèques Creative Cloud ?

Pour en savoir plus sur les bibliothèques, consultez les ressources suivantes :

Tutoriels vidéo

Prise en main du service Bibliothèques Creative Cloud (présentation)
Bibliothèques Creative Cloud dans Illustrator et les applications mobiles
Bibliothèques Creative Cloud dans Photoshop et les applications mobiles

Tutoriels vidéo qui expliquent comment utiliser le service Bibliothèques Creative Cloud dans les
applications mobiles :

Shape CC
Brush CC
Color CC
Illustrator Draw

http://idiom-q-win-1/fr/stock/help/using-adobe-stock.html
http://idiom-q-win-1/fr/creative-cloud/help/collaboration.html#collaborate_libraries
https://helpx.adobe.com/fr/creative-cloud/how-to/creative-cloud-libraries.html
https://helpx.adobe.com/fr/illustrator/how-to/illustrator-creative-cloud-libraries.html
https://helpx.adobe.com/fr/photoshop/how-to/photoshop-creative-cloud-libraries.html
http://helpx.adobe.com/fr/mobile-apps/how-to/shape-get-started.html
http://helpx.adobe.com/fr/mobile-apps/how-to/adobe-brush-create-brushes.html?set=mobile-apps--fundamentals--adobe-brush-cc
http://helpx.adobe.com/fr/mobile-apps/how-to/adobe-color-get-started.html?set=mobile-apps--fundamentals--adobe-color-cc
http://helpx.adobe.com/fr/mobile-apps/how-to/illustrator-draw-get-started.html?set=mobile-apps--fundamentals--adobe-illustrator-draw
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Espace de travail et flux de travaux

Création et enregistrement votre propre espace de travail
Jeff Witchel  (15 octobre 2012)
Didacticiel - vidéo
Découvrez comment personnaliser l’espace de travail

Utiliser les outils
Kelly McCathran  (15 mai 2012)
Didacticiel - vidéo
La barre d’outils InDesign comporte un grand nombre d’outils dont la plupart sont masqués ou "imbriqués" sous les outils qui s’affichent
initialement. Cette vidéo présente l’utilisation des outils principaux afin de sélectionner, faire pivoter et redimensionner les objets. Vous
découvrirez également comment utiliser l’outil Texte pour modifier du texte et créer des images avec ou sans bordures, changer d’outils à l’aide
de votre clavier, et la navigation avec les outils Main et zoom.

http://www.infiniteskills.com/demos/movie-player.php?h=565&w=970&sku=01710&movie=http://infiniteskills.bc.cdn.bitgravity.com/iskills-media/indesigncs6-demo/0207.mp4
http://tv.adobe.com/watch/learn-indesign-cs6/working-with-tools/


Création de nouveaux documents

Haut de la page

Haut de la page

Paramètre prédéfini de document

Mode

Nombre de pages

N° de la 1re page

Création de nouveaux documents
Création d’un nouveau document
Options de nouveau document
Présentation de la fenêtre de document
Création de formats de page personnalisés
Définition de paramètres prédéfinis de document
Création d’un document à partir d’un paramètre prédéfini

La conception d’une page débute par des opérations de base : création d’un nouveau document, configuration des pages et positionnement des
marges et des colonnes ou modification des paramètres de grille.

Création d’un nouveau document

1. Choisissez Fichier > Nouveau > Document.

La boîte de dialogue Nouveau document combine les boîtes de dialogue Format de document et Marges et colonnes. Ainsi
vous pouvez définir dans un même emplacement les dimensions de la page, ses marges et ses colonnes. Vous pouvez
modifier ces paramètres à tout moment.

2. Définissez les options de format de document. (Voir la section Options de nouveau document.)

Pour spécifier les zones de fond perdu et de ligne-bloc, cliquez sur le bouton fléchéavant l’étiquette Fond perdu et Ligne-bloc.
Ces zones s’étendent au-delà des bords du format de page défini. Pour que les zones s’étendent uniformément sur tous les
côtés, cliquez sur l’icône Uniformiser tous les paramètres .

3. (Uniquement dans InDesign CC) Cochez la case Aperçu pour vérifier l’apparence du nouveau document. Apportez les
modifications éventuelles nécessaires.

4. Cliquez sur OK pour ouvrir le nouveau document avec les paramètres que vous avez définis.

Pour définir les paramètres de mise en page de tous les nouveaux documents, choisissez Fichier > Format de document ou Mise en page >
Marges et colonnes, puis définissez les options lorsqu’aucun document n’est ouvert.

Options de nouveau document

Choisissez un paramètre déjà enregistré.

Si vous créez un document à exporter au format PDF ou SWF en vue de son utilisation sur le Web, la sélection de l’option Web entraîne la
modification de plusieurs options de la boîte de dialogue, notamment la désactivation de l’option Pages en vis-à-vis, le remplacement de
l’orientation Portrait par Paysage et l’utilisation d’un format de page basé sur la résolution du moniteur. Vous pouvez modifier ces paramètres
après avoir créé le document.
CS6 et versions suivantes : le mode Publication numérique a été ajouté pour les publications destinées à Digital Publishing Suite. Vous pouvez
également modifier le rendu du document après l’avoir créé.

Indiquez le nombre de pages à créer dans le nouveau document.

Indiquez le numéro de page de la première page du document. Si vous définissez un nombre pair (2, par exemple) et que
vous sélectionnez Pages en vis-à-vis, la première planche du document comporte une planche de deux pages Voir Créer un document avec une
planche de deux pages.

http://idiom-q-win-1/fr/indesign/using/create-new-documents.html#new_document_options
http://idiom-q-win-1/fr/indesign/using/pages-spreads-1.html
http://idiom-q-win-1/fr/indesign/using/pages-spreads-1.html


Pages en vis-à-vis

Bloc de texte type

Bloc de texte principal

Format de page

Orientation

Fond perdu

Ligne-bloc

Aperçu

Remarque :

Haut de la page

Sélectionnez cette option pour présenter en regard les pages de gauche et de droite d’une planche de deux pages, comme
pour les livres et les magazines. Désélectionnez-la pour disposer toutes les pages indépendamment les unes des autres, comme si vous
imprimiez des feuillets ou des affiches ou que vous vouliez que les objets débordent dans la zone de reliure.
Après avoir créé un document, vous pouvez utiliser le panneau Pages pour créer des planches de plus de deux pages ou forcer les deux
premières à s’ouvrir dans une planche. (voir Contrôle de la pagination des planches).

CS5.5 et versions antérieures : sélectionnez cette option pour créer un bloc de texte de la taille de la zone délimitée par les
repères de marge, selon les paramètres de colonnes spécifiés. Le bloc de texte type est ajouté au gabarit A. (voir Utilisation des blocs de texte sur
les gabarits).
L’option Bloc de texte type est disponible uniquement lorsque vous choisissez Fichier > Nouveau > Document.

CS6  et versions suivantes : sélectionnez cette option pour ajouter un bloc de texte principal sur le gabarit. Lorsque vous
appliquez un nouveau gabarit, l’article contenu dans le bloc de texte principal se poursuit automatiquement dans le bloc de texte principal du
nouveau gabarit.

Choisissez un format de page dans le menu ou tapez une largeur et une hauteur. Le format de page représente les dimensions
définitives que vous obtiendrez après rognage des fonds perdus et autres repères situés en dehors de la page.

Cliquez sur Portrait  (sens de la hauteur) ou Paysage  (sens de la largeur). Ces icônes interagissent dynamiquement avec les
dimensions de format de page que vous entrez. Si la hauteur est la dimension la plus grande, l’icône Portrait est sélectionnée. Si la largeur est la
dimension la plus grande, l’icône Paysage est sélectionnée. Pour permuter la hauteur et la largeur, cliquez sur l’icône désélectionnée.
Conseil : pour spécifier les dimensions des zones du fond perdu et de la ligne de bloc, cliquez sur le bouton fléché avant l’étiquette du fond perdu
et de la ligne-bloc dans la boîte de dialogue Nouveau document. Pour que le fond perdu et la ligne-bloc s’étendent uniformément sur tous les
côtés, cliquez sur l’icône Uniformiser tous les paramètres .

La zone de fond perdu permet d’imprimer des objets disposés sur le bord externe du format de page défini. Si un objet est placé
contre le bord d’une page aux dimensions requises, il est possible que du blanc apparaisse au bord de la zone d’impression en raison d’un léger
décalage d’alignement au cours de l’impression ou du rognage. Pour cette raison, il est recommandé d’éloigner légèrement l’objet du bord de la
page aux dimensions requises et de rogner une fois l’impression effectuée. La zone de fond perdu est indiquée par une ligne rouge sur le
document. Vous pouvez définir les paramètres de la zone de fond perdu depuis Fond perdu dans la boîte de dialogue Imprimer.

Cette zone est éliminée lorsque le document est rogné à sa taille finale. La zone de ligne-bloc contient les informations sur
l’impression et la gamme de couleurs personnalisées et affiche d’autres instructions et descriptions relatives à d’autres informations dans le
document. Les objets (y compris les blocs de texte) situés dans la zone de ligne-bloc sont imprimés mais disparaissent une fois le document
rogné à sa taille finale.
Les objets situés en dehors de la zone de fond perdu ou de ligne-bloc (selon celle qui s’étend le plus loin) ne seront pas imprimés.

(Uniquement dans InDesign CC) Cochez cette case pour vérifier l’apparence du nouveau document. Apportez les modifications
nécessaires aux options si l’aperçu ne vous convient pas.

vous pouvez également cliquer sur l’icône Enregistrer le paramètre prédéfini de document pour enregistrer les paramètres du
document afin de les réutiliser ultérieurement.

Présentation de la fenêtre de document

Chaque page ou planche dans le document dispose de ses propres table de montage et repères qui sont visibles en mode Affichage standard.
(Pour passer en mode Affichage standard, choisissez Affichage > Mode Ecran > Normal.) La table de montage est remplacée par un arrière-plan
grisé lorsque le document est affiché dans l’un des modes d’aperçu. (voir Aperçu des documents). Vous pouvez changer la couleur de l’arrière-
plan et des repères de l’aperçu dans les préférences Repères et tables de montage.

http://idiom-q-win-1/fr/indesign/using/pages-spreads-1.html#control_spread_pagination
http://idiom-q-win-1/fr/indesign/using/creating-text-text-frames.html#using_text_frames_on_master_pages
http://idiom-q-win-1/fr/indesign/using/creating-text-text-frames.html#using_text_frames_on_master_pages
http://idiom-q-win-1/fr/indesign/using/printing-documents.html#preview_documents
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Document et repères en mode Affichage standard

A. Planche (lignes noires) B. Page (lignes noires) C. Repères de marge (lignes magenta) D. Repères de colonne (lignes violettes) E. Zone de fond
perdu (lignes rouges) F. Ligne-bloc (lignes bleues) 

Notes de fenêtre de document :

Les autres filets de couleur caractérisent les repères de règle, lesquels s’affichent dans la couleur du calque actif. Voir
Calques.

Les repères de colonne s’affichent devant les repères de marge. Par conséquent, lorsqu’un repère de colonne se superpose à
un repère de marge, il masque ce dernier.

Création de formats de page personnalisés

Vous pouvez créer des formats de pages personnalisés qui seront inclus dans le menu Format de page de la boîte de dialogue Nouveau
document.

1. Choisissez Fichier > Nouveau > Document.

2. Choisissez Format de page personnalisé dans le menu Format de page.

3. Saisissez le nom du format de page, définissez ses paramètres et cliquez sur Ajouter.

Le fichier New Doc Sizes.txt qui permet de créer des formats de page personnalisés dans les versions précédentes d’InDesign n’est pas
disponible dans InDesign CS5 et les versions suivantes.

Définition de paramètres prédéfinis de document

Vous pouvez enregistrer des paramètres de document pour le format de page, les colonnes, les marges et les zones de fond perdu et de ligne-
bloc dans un fichier de paramètres prédéfinis pour gagner du temps et assurer une cohérence dans la création de documents similaires.

1. Choisissez Fichier > Paramètres prédéfinis de document > Définir.

2. Cliquez sur Nouveau dans la boîte de dialogue qui s’affiche.

3. Définissez le nom du paramètre prédéfini et sélectionnez des options de mise en page de base dans la boîte de dialogue
Nouveau paramètre prédéfini de document. (Voir Options de nouveau document qui décrit chaque option.)

4. Cliquez deux fois sur OK.

Vous pouvez enregistrer un paramètre prédéfini de document dans un fichier séparé et le distribuer aux autres utilisateurs. Pour enregistrer et
charger des fichiers de paramètres prédéfinis de document, utilisez les boutons Enregistrer et Charger dans la boîte de dialogue Paramètres
prédéfinis de document.

Création d’un document à partir d’un paramètre prédéfini

http://idiom-q-win-1/fr/indesign/using/layers.html
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1. Utilisez l’une des méthodes suivantes :

Choisissez Fichier > Paramètre prédéfini de document > [nom du paramètre prédéfini]. (Maintenez la touche Maj enfoncée
tout en choisissant le paramètre prédéfini pour créer un document basé sur le paramètre prédéfini dans ouvrir la boîte de
dialogue Nouveau document.)

Choisissez Fichier > Nouveau > Document, puis un paramètre prédéfini dans le menu Paramètre prédéfini de document
de la boîte de dialogue Nouveau document.

La boîte de dialogue Nouveau document affiche les options de mise en page du paramètre prédéfini.

2. Si nécessaire, modifiez les options et cliquez sur OK.

Pour ignorer la boîte de dialogue Nouveau document, appuyez sur la touche Maj tout en sélectionnant un paramètre prédéfini dans le menu
Paramètre prédéfini de document.

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr
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Sommaire
Introduction
Synchroniser les paramètres au premier lancement
Utilisation de la fonction de synchronisation des paramètres
Synchroniser les paramètres sur les lancements successifs
Gestion de la synchronisation
Ce qui n’est pas pris en charge

Introduction

Lorsque vous travaillez sur plusieurs ordinateurs, la gestion et la synchronisation des jeux de glyphes, des menus personnalisés, des raccourcis
clavier, des espaces de travail personnalisés et des paramètres prédéfinis PDF entre les ordinateurs peuvent devenir une véritable corvée.

La nouvelle fonction Synchroniser les paramètres permet aux utilisateurs de synchroniser leurs paramètres à l’aide de Creative Cloud. Si vous
utilisez deux ordinateurs, par exemple un à votre domicile et l’autre au bureau, la fonction Synchroniser les paramètres vous permet de conserver
facilement les paramètres synchronisés sur les deux ordinateurs. En outre, si vous avez remplacé votre ancien ordinateur par un nouveau et que
vous avez réinstallé InDesign, vous pouvez configurer rapidement l’application avec tous vos paramètres en place, d’un simple clic sur un bouton.

Remarque : à tout moment donné, vous pouvez activer InDesign sur deux ordinateurs uniquement.

La synchronisation se produit via votre compte Adobe Creative Cloud. Tous les paramètres sont chargés sur Creative Cloud, puis sont téléchargés
et appliqués sur l’autre ordinateur.

Toutes les opérations de synchronisation sont lancées par les utilisateurs. Elles ne peuvent pas être planifiées ni effectuées automatiquement
(comme au lancement ou à l’arrêt).

Conditions préalables à l’utilisation de cette fonction :

Les ordinateurs doivent être connectés à Internet.
Vous devez être connecté à votre compte Adobe Creative Cloud sur les deux ordinateurs.

Synchroniser les paramètres au premier lancement

Après l’installation, lorsque vous lancez l’application et créez un document ou ouvrez un document existant pour la première fois, une invite vous
demande si vous souhaitez lancer la synchronisation.

Cliquez sur Synchroniser les paramètres maintenant pour lancer la synchronisation.
Cliquez sur Désactiver la synchronisation des paramètres pour désactiver la fonction.
Cliquez sur Avancé pour ouvrir la boîte de dialogue Préférences dans laquelle vous pouvez choisir et personnaliser les
éléments à synchroniser.
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Utilisation de la fonction de synchronisation des paramètres

Utilisez l’une des méthodes suivantes :

[Recommandé] Cliquez sur l’icône Synchroniser les paramètres ( ) dans le coin inférieur gauche de la fenêtre du document
InDesign, puis cliquez sur Synchroniser les paramètres maintenant.
Cliquez sur Edition (Mac : InDesign) > {Connecté avec l’ID Adobe} > Synchroniser les paramètres maintenant.

Synchroniser les paramètres sur les lancements successifs

Lorsque vous lancez InDesign et que vous disposez d’informations d’une synchronisation précédente, et que vous créez un document ou ouvrez
un document existant pour la première fois, une invite vous demande si vous souhaitez synchroniser le paramètre à partir du nuage. Pour lancer la
synchronisation, cliquez sur Synchroniser les paramètres maintenant.

Les paramètres sont téléchargés sur vos ordinateurs locaux et sont mis à jour dans l’application. Si vous modifiez les jeux de glyphes, les
raccourcis clavier, les espaces de travail personnalisés ou les paramètres prédéfinis d’un document PDF, vous devez lancer la synchronisation
avant de fermer l’application. Vous pouvez voir l’état de synchronisation dans le coin en bas à gauche de la barre d’état du document. Cliquez sur
l’icône Synchroniser les paramètres ( ) dans la barre d’état, puis cliquez sur Synchroniser les paramètres maintenant.

Gestion de la synchronisation

Ce qui est synchronisé

Espaces de travail
Ensembles de menus
Paramètres PDF prédéfinis
Raccourcis clavier
Jeux de glyphes

Sélectionnez ce que vous souhaitez synchroniser

Accédez à l’onglet Préférences > Synchroniser les paramètres :

Cliquez sur Edition (Mac : InDesign) > {Connecté avec l’ID Adobe} > Gérer les paramètres de synchronisation.
ou 
Cliquez sur Edition (Mac : InDesign) > Préférences > Synchroniser les paramètres.
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Sélectionnez les cases à cocher pour les paramètres que vous souhaitez synchroniser. Vous pouvez également choisir comment procéder en cas
de conflit.

pour synchroniser vos paramètres avec succès, vous devez modifier les paramètres via l’application, uniquement. La fonction de
synchronisation des paramètres ne s’applique pas aux fichiers qui ont été placés manuellement dans un dossier.

Choisir une option en cas de conflit

Il existe des situations dans lesquelles le système détecte des conflits de synchronisation. Un conflit de synchronisation se produit lorsque le
système ne parvient pas à déterminer si vous souhaitez conserver un paramètre de Creative Cloud ou de votre ordinateur local car les deux
paramètres ont été modifiés après la dernière opération de synchronisation.

Supposons que vous modifiez les paramètres PDF prédéfinis sur votre ordinateur du bureau et synchronisez les paramètres sur le cloud. Vous
rentrez ensuite chez vous et vous modifiez les mêmes paramètres prédéfinis sur votre ordinateur personnel sans les synchroniser auparavant
avec le nuage. Maintenant, étant donné que les paramètres du nuage et ceux de votre ordinateur personnel sont tous les deux mis à jour, un
conflit se produit lorsque vous essayez d’effectuer la synchronisation. Si vous essayez de synchroniser dans cet état, une invite de conflit s’affiche.

Synchroniser les paramètres locaux : synchronisation des paramètres locaux de cet ordinateur sur le cloud ; remplacement de
la version du cloud par la version locale des paramètres.
Synchroniser les paramètres de cloud : synchronisation à partir du cloud vers l’ordinateur local ; ignorer les modifications
apportées aux paramètres locaux et les remplacer par les paramètres du cloud.

Ce qui n’est pas pris en charge

Les raccourcis clavier créés pour Windows ne pourront être synchronisés qu’avec un ordinateur Windows. Les raccourcis
clavier Mac ne pourront être synchronisés qu’avec un ordinateur Mac.
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Les éléments enregistrés dans un emplacement personnalisé ne sont pas synchronisés.
Les éventuelles modifications (par exemple : réorganisation du panneau) effectuées après la création de l’espace de travail ne
seront pas synchronisées. Pour la synchronisation de l’espace de travail, vous devez d’abord configurer votre environnement
de travail, puis créer un espace de travail et lancer le processus de synchronisation.

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr
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Présentation du panneau Outils
Présentation des outils
Galerie d’outils de sélection
Galerie d’outils de dessin et de texte
Galerie d’outils de transformation
Galerie d’outils de modification et de navigation

Présentation du panneau Outils
Certains outils du panneau Outils permettent de sélectionner, modifier et créer des éléments de page. D’autres permettent de choisir un type, une
forme, une ligne ou un dégradé. Vous pouvez modifier la disposition du panneau Outils pour mieux l’adapter à la configuration de la fenêtre
principale et des autres panneaux. Par défaut, le panneau Outils s’affiche sur une seule colonne. Vous pouvez aussi le présenter sur deux
colonnes ou sur une rangée. Il est toutefois impossible de réorganiser les outils à l’intérieur du panneau Outils. Pour déplacer le panneau, faites-le
glisser en plaçant le pointeur sur sa partie supérieure.

Pour sélectionner un outil dans le panneau Outils par défaut, il suffit de cliquer dessus. Le panneau Outils contient également plusieurs outils
masqués liés aux outils visibles. Ces outils masqués sont signalés par une flèche à droite de l’icône de l’outil. Pour sélectionner un outil masqué,
cliquez sur l’outil actif dans le panneau Outils sans relâcher le bouton de la souris, puis choisissez l’outil souhaité.

Le nom de l’outil ainsi que son raccourci clavier apparaissent lorsque vous placez le pointeur sur l’outil : ce texte est appelé info-bulle. Vous
pouvez désactiver les info-bulles en sélectionnant l’option Sans dans le menu Description d’outils des préférences relatives à l’interface.

Ouvrez le panneau Info-bulles des outils (choisissez la commande Fenêtre > Utilitaires > Info-bulles des outils) pour afficher les touches de
raccourci et de modification compatibles avec l’outil sélectionné.

Remarque : les outils Récupérateur de contenu et Importation de contenu ne sont pas accessibles dans CS5.5 ou les versions antérieures.
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Pour afficher le panneau Outils
 Choisissez Fenêtre > Outils.

Pour afficher les options des outils
 Cliquez deux fois sur un outil du panneau Outils.

Cette procédure fonctionne uniquement pour certains outils, comme les outils Pipette, Crayon et Polygone.

Pour afficher et sélectionner un outil masqué
1. Dans le panneau Outils, cliquez sur un outil associé à des outils masqués sans relâcher le bouton de la souris.

2. Lorsque les outils masqués s’affichent, sélectionnez-en un.

Pour sélectionner temporairement des outils
1. Lorsqu’un outil est sélectionné, appuyez sur la touche de raccourci d’un autre outil.
2. Tout en maintenant la touche de raccourci enfoncée, effectuez une action.
3. Relâchez la touche de raccourci pour revenir à l’outil précédent.

Par exemple, si l’outil Espace est sélectionné, maintenez la touche de raccourci V enfoncée pour utiliser temporairement l’outil Sélection. Lorsque
vous relâchez la touche V, l’outil Espace est de nouveau actif.

Pour afficher des info-bulles d’outils
Le panneau Info-bulles des outils décrit le fonctionnement des touches de modification avec l’outil sélectionné.

1. Choisissez la commande Fenêtre > Utilitaires > Info-bulles des outils pour afficher le panneau du même nom.

2. Dans le panneau Outils, sélectionnez un outil afin d’afficher sa description, ainsi que les touches de modification et les
raccourcis qui lui sont associés.

Pour modifier la disposition du panneau Outils
1. Choisissez la commande Edition > Préférences > Interface (Windows) ou InDesign > Préférences > Interface (Mac OS).

2. Choisissez une option de disposition dans le menu Panneau d’outils flottant, puis cliquez sur le bouton OK.

Pour modifier la disposition du panneau Outils, vous pouvez également cliquer sur l’icône de la double flèche située en haut du panneau.

Présentation des outils
Outils Texte Créez et mettez en forme des blocs ou des tracés standard ou personnalisés (voir la section Création de blocs de texte.)
Outils de dessin Dessinez et concevez des objets simples et complexes, comme des rectangles, des ellipses, des polygones ou des formes
libres (voir la section Dessin).
Outils de sélection Sélectionnez (activez) des objets, des points ou des lignes (voir la section Sélection d’objets).
Outils de transformation Modifiez la forme, réorientez et redimensionnez des objets (voir la section Transformation d’objets).
Outils de navigation Déplacez-vous dans les documents, contrôlez leur affichage et mesurez des distances (voir les sections Zoom avant ou
arrière et Règles et unités de mesure).
Outil Ciseaux Scinde les tracés et les blocs (voir la section Fractionnement d’un tracé.)

Galerie d’outils de sélection

L’outil Sélection vous L’outil Sélection directe L’outil Page vous permet de L’outil Espace vous permet
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permet de sélectionner des
objets entiers.

vous permet de sélectionner
des points sur un tracé ou
du contenu dans un bloc.

définir plusieurs formats de
page au sein d’un
document.

de régler l’espacement des
objets.

Galerie d’outils de dessin et de texte

L’outil Plume vous permet
de dessiner des tracés
droits et incurvés.

L’outil Ajout de point
d’ancrage vous permet
d’ajouter des points
d’ancrage à un tracé.

L’outil Suppression de point
d’ancrage vous permet de
supprimer des points
d’ancrage d’un tracé.

L’outil Conversion de point
directeur vous permet de
convertir des sommets et
des arrondis.

L’outil Texte vous permet
de créer des blocs de texte
et de sélectionner du texte.

L’outil Texte curviligne vous
permet de créer et de
modifier du texte sur des
tracés.

L’outil Crayon vous permet
de dessiner une forme libre.

L’outil Arrondi vous permet
de supprimer les angles
superflus sur un tracé.

L’outil Gomme vous permet
de supprimer des points sur
un tracé.

L’outil Trait vous permet de
dessiner un segment de
ligne.

L’outil Bloc rectangulaire
vous permet de créer un
bloc de réservation carré ou
rectangle.

L’outil Bloc elliptique vous
permet de créer un bloc de
réservation circulaire ou
ovale.
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L’outil Bloc polygonal vous
permet de créer un bloc de
réservation à plusieurs
côtés.

L’outil Rectangle vous
permet de créer un carré ou
un rectangle.

L’outil Ellipse vous permet
de créer un cercle ou un
ovale.

L’outil Polygone vous
permet de créer une forme
à plusieurs côtés.

Galerie d’outils de transformation

L’outil Transformation
manuelle vous permet de
faire pivoter, mettre à
l’échelle ou déformer un
objet.

L’outil Rotation vous permet
de faire pivoter des objets
autour d’un point fixe.

L’outil Mise à l’échelle vous
permet de redimensionner
des objets autour d’un point
fixe.

L’outil Déformation vous
permet de déformer des
objets autour d’un point fixe.

Galerie d’outils de modification et de navigation

L’outil Pipette vous permet de
prélever un échantillon de
couleur ou d’attribut de texte à
partir d’un objet et de
l’appliquer à un autre objet.

L’outil Mesure vous permet
de mesurer la distance
entre deux points.

L’outil Nuance de dégradé
vous permet d’ajuster les
points de départ et d’arrivée
ainsi que l’angle des
dégradés dans les objets.

L’outil Contour
progressif dégradé
vous permet de faire
disparaître un objet
dans l’arrière-plan.



L’outil Ciseaux coupe les tracés
à différents points spécifiés.

L’outil Main déplace la page
dans la fenêtre de
document.

L’outil Zoom agrandit et
réduit la fenêtre de
document.

L’outil Note vous
permet d’ajouter des
commentaires.

Voir aussi

Informations juridiques   |   Politique de confidentialité en ligne
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Exportation du contenu à partir d’InDesign
Présentation du panneau Affectations
Fichiers d’affectation
Création d’affectations et ajout de contenu (InDesign)
Exportation du contenu dans des fichiers InCopy distincts (InDesign)

Exportation du contenu à partir d’InDesign
Lorsque vous exportez du contenu d’InDesign vers InCopy, un lien est établi entre ces applications. Pour exporter les blocs de texte, les blocs
graphiques InDesign et leur contenu vers InCopy, utilisez l’une des deux méthodes suivantes :

Créez un fichier conteneur (*.icma), appelé affectation et ajoutez les regroupements d’éléments de document associés (tels
que le texte et les graphiques d’un article) à l’affectation afin qu’ils puissent être utilisés simultanément. Le contenu des
affectations est exporté sous forme de fichiers *.icml.

Exportez les blocs de texte et les blocs graphiques séparément (y compris les blocs de substitution) à l’aide des commandes
du menu Edition > InCopy > Exporter. Le contenu exporté est enregistré sous forme de fichiers *.icml.

Une fois le contenu exporté, des petites icônes apparaissent dans la partie supérieure gauche des blocs exportés dans InDesign et InCopy, et
dans le panneau Affectations. Un lien vers le fichier exporté s’affiche dans le panneau Liens. Ces icônes indiquent l’état des blocs gérés et
distinguent les blocs gérés des blocs qui n’appartiennent pas au flux de production. Tout le contenu exporté s’affiche dans le panneau Affectations.
Le contenu exporté à l’aide des commandes de menu Exporter s’affiche dans la section Contenu InCopy non affecté de la liste du panneau
Affectations. Même si les deux méthodes établissent une connexion contrôlée entre le contenu InCopy et un document InDesign, la première
méthode doit être utilisée pour les fichiers d’affectation.

Après son exportation, le contenu est accessible à tous les utilisateurs pour extraction. Il conserve toujours un lien vers le document d’origine
InDesign. Ce lien est établi à partir d’InDesign ; vous ne pouvez pas le créer à partir d’InCopy.

Une fois le contenu exporté, l’utilisateur InCopy peut afficher (sans les modifier) les mises en page, styles et autres éléments de la page, tels qu’ils
apparaissent dans le document InDesign.

Remarque : vous pouvez également créer du texte ou des images ancrées dans InCopy, puis les importer dans InDesign.

Présentation du panneau Affectations
Le panneau Affectations (Fenêtre > Affectations dans InCopy ou Fenêtre > Editorial > Affectations dans InDesign) constitue l’outil de base pour
l’utilisation des affectations. Le panneau Affectations affiche les fichiers exportés à partir du document InDesign actif. Une icône indique l’état de
ces fichiers. Le menu du panneau Affectations contient également des commandes contrôlant les fonctions d’importation de version et de gestion
des fichiers entre InCopy et InDesign. Lorsque vous ouvrez une affectation dans InCopy, le nom de l’affectation et son contenu s’affichent dans le
panneau Affectations. Dans le panneau Affectations, cliquez deux fois dans les blocs de texte et les blocs graphiques pour les sélectionner dans la
fenêtre de document.
Remarque : le panneau Liens contient également la totalité du contenu exporté vers InCopy ou ajouté à une affectation. Même si ce panneau
permet d’effectuer certaines tâches de gestion du flux de production, telles que l’extraction et l’archivage de contenu, le panneau Affectations est le
plus approprié pour effectuer ces tâches.
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Panneau Affectations d’InDesign
A.  Noms de contenu InCopy B.  Nom de document InDesign C.  Etat Affectation obsolète D.  Etats Disponible et Contenu textuel à jour E.
Etats En cours d’utilisation et Contenu textuel obsolète F.  Etats Modification et A jour G.  Contenu non attribué H.  Nom d’utilisateur I.  Bouton
Mettre à jour le contenu J.  Bouton Extraire/Archiver la sélection K.  Bouton Nouvelle affectation L.  Bouton Supprimer les affectations
sélectionnées/Supprimer

Panneau Affectations d’InCopy
A.  Noms de contenu InCopy B.  Etat Affectation obsolète C.  Nom d’affectation D.  Etats Disponible et Contenu textuel à jour E.  Etats En
cours d’utilisation et Contenu textuel obsolète F.  Etats Modification et A jour G.  Nom d’utilisateur H.  Bouton Mettre à jour la mise en page I.
Bouton Mettre à jour le contenu J.  Bouton Extraire/Archiver la sélection

Fichiers d’affectation
Dans InDesign, les fichiers d’affectation sont des conteneurs permettant d’organiser des ensembles d’éléments de pages. Par exemple, vous
pouvez sélectionner tous les éléments d’un article (titre, signature, copie, graphiques et légendes), puis les affecter à un utilisateur InCopy. L’ajout
de ces éléments à une affectation permet aux utilisateurs d’InCopy d’accéder uniquement au contenu dont ils sont responsables. Les fichiers
d’affectation (*.icma) s’affichent dans le système de fichiers, dans la barre d’articles InCopy et dans les messages d’état. Seuls les utilisateurs
InDesign peuvent créer des fichiers d’affectation ; seuls les utilisateurs d’InCopy peuvent les ouvrir.

Lorsque vous créez une affectation, un dossier est créé par défaut au même emplacement que le document InDesign. Ce dossier d’affectation
inclut les fichiers d’affectation *.icma et un sous-dossier de contenu comprenant tous les fichiers d’article InCopy exportés (au format .icml) qui font
partie d’images ou de toute autre ressource. Une fois l’affectation créée, stockez le dossier du projet à un emplacement accessible à tous les
utilisateurs, ou créez et distribuez un assemblage d’affectation. Si le contenu est exporté avant d’être ajouté à une affectation, les fichiers se
trouvant sur le disque ne sont pas déplacés vers le dossier de contenu du fichier d’affectation.

Les fichiers d’affectation comprennent les éléments suivants :

Liens ou pointeurs vers les éléments de pages associés, notamment les blocs de substitution. Ces éléments permettent aux
utilisateurs d’InCopy d’ouvrir un seul fichier InCopy tout en disposant d’un accès éditorial à plusieurs éléments de pages.

Toutes les transformations des graphiques comprises dans l’affectation, telles que le déplacement, la mise à l’échelle, la
rotation ou la déformation.

Géométrie de page qui permet aux utilisateurs d’InCopy d’afficher la mise en page du bloc dont ils modifient le contenu sans
ouvrir le fichier InDesign.

Codes couleur des blocs réservés dans le document.
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Illustration d’une page dans InCopy affichant la géométrie de page et le code couleur

Création d’affectations et ajout de contenu (InDesign)
Seuls les utilisateurs d’InDesign peuvent créer des affectations et leur ajouter du contenu. Plusieurs méthodes permettent de créer des
affectations. En général, la méthode choisie est différente selon que vous disposez de contenu à ajouter lors de la création de l’affectation.

Créez des fichiers d’affectation vides. Dans votre document InDesign, vous pouvez créer plusieurs affectations vides qui
serviront de modèles pour le contenu futur.

Créez des affectations et ajoutez du contenu en même temps.

Ajoutez du contenu à un fichier d’affectation existant. Vous pouvez ajouter du contenu lié (du texte et des graphiques qui ont
déjà été exportés en tant que contenu InCopy) ou des éléments de pages sélectionnés afin de les utiliser comme contenu lié
dans InCopy. Si un ou plusieurs des blocs sélectionnés contiennent déjà des fichiers de contenu InCopy et qu’aucun
n’appartient à une affectation, vous pouvez les ajouter à un fichier d’affectation nouveau ou existant.

Par défaut, le dossier d’affectation que vous créez est enregistré dans le même dossier que le document InDesign. Vous pouvez alors placer ce
dossier sur un serveur ou créer et envoyer un assemblage.

Remarque : si vous ne souhaitez pas que les utilisateurs d’InCopy importent et ajustent des graphiques, n’ajoutez pas de blocs graphiques à
l’affectation.

Pour créer des fichiers d’affectation vides (InDesign)
1. Dans InDesign, enregistrez le document.
2. Dans le menu du panneau Affectations, choisissez l’option Nouvelle affectation.
3. Dans la boîte de dialogue Nouvelle affectation, sélectionnez les options du fichier d’affectation et cliquez sur OK.

Pour créer des affectations et ajouter du contenu simultanément (InDesign)
1. Dans InDesign, créez un document comprenant un ou plusieurs blocs de texte, blocs graphiques ou balises d’emplacement,

puis enregistrez le document.
2. Sélectionnez les blocs de texte et les blocs graphiques que vous souhaitez ajouter.
3. Utilisez l’une des méthodes suivantes :

Dans le menu du panneau Affectations, choisissez Ajouter à l’affectation, puis sélectionnez Nouveau.

Choisissez Edition > InCopy > Ajouter [option] à l’affectation > Nouveau.

4. Dans la boîte de dialogue Nouvelle affectation, sélectionnez les options du fichier d’affectation et cliquez sur OK.

Le fichier d’affectation créé comprend tous les blocs sélectionnés dans la fenêtre du document.

Pour ajouter du contenu à des affectations existantes (InDesign)
1. Enregistrez le document InDesign.
2. Sélectionnez les blocs de texte et les blocs graphiques que vous souhaitez ajouter.
3. Utilisez l’une des méthodes suivantes :

Dans le menu du panneau Affectations, choisissez Ajouter à l’affectation, puis sélectionnez l’affectation.

Faites glisser le contenu depuis la section Contenu InCopy non affecté du panneau Affectations vers une affectation
existante.

Sélectionnez des éléments de page à l’aide de l’outil Sélection, faites-les glisser et déposez-les sur une affectation
existante dans le panneau Affectations.

Choisissez Edition > InCopy > Ajouter [option] à l’affectation, puis sélectionnez l’affectation.
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4. Dans le menu du panneau Affectations, choisissez Mettre à jour toutes les affectations pour que les utilisateurs d’InCopy aient
accès au fichier de contenu.

Remarque : vous ne pouvez ajouter du contenu qu’aux affectations figurant dans le même document. Toutefois, vous pouvez importer le même
contenu dans plusieurs documents et l’ajouter à une affectation de chacun de ces documents.

Options du fichier d’affectation (InDesign)
Lorsque vous créez ou modifiez un fichier d’affectation, vous pouvez définir les options suivantes :

Nom d’affectation Identifiant unique de l’affectation dans le panneau Affectations, par exemple « Article océan ». Ce nom doit être conforme aux
conventions de nom de fichier du système d’exploitation.
Affecté à Identifiant unique de l’utilisateur affecté aux fichiers. Le nom de l’utilisateur s’affiche entre parenthèses après le nom d’affectation dans
le panneau Affectations. Le nom saisi à cet endroit n’est fournit qu’à titre d’information ; il ne confère aucun droit ni aucune autorisation particuliers
à l’utilisateur.
Couleur Affiche la liste des couleurs pour l’ajout d’une mise en surbrillance distincte aux blocs de l’affectation actuelle dans la fenêtre de
document et aux noms d’affectation dans le panneau Affectations. Ce code couleur permet de différencier les blocs appartenant à une affectation
des blocs appartenant à une autre, ainsi que des blocs non affectés. Pour afficher ou masquer le code couleur, choisissez la commande
Affichage > Extras > Afficher les blocs affectés ou Masquer les blocs affectés, respectivement. Dans InCopy, le code couleur est visible
uniquement en mode Mise en page.
Remarque : si afficher/masquer les blocs assignés produit des résultats inattendus, cela signifie que ces blocs sont peut-être balisés en XML et
que la fonction Affichage > Structure > Afficher les blocs balisés est peut-être activée. Vous ne pouvez pas afficher les blocs affectés et les blocs
balisés simultanément.
Modifier Cliquez sur le bouton Modifier pour spécifier l’emplacement du dossier d’affectations. Par défaut, le dossier d’affectations est créé au
même emplacement que le fichier InDesign.
Blocs de substitution Permet aux utilisateurs d’InCopy d’afficher le texte et les blocs graphiques dans l’affectation ainsi que les zones (ou les
autres formes) représentant tous les autres blocs sur les pages InDesign. Tous les blocs et balises d’emplacement reproduisent fidèlement la taille,
la forme et l’emplacement des originaux InDesign. Les blocs de substitution sont des formes vides qui n’affichent pas de contenu dans le
document InDesign. L’option Blocs de substitution offre le résultat le moins fidèle, mais elle présente des performances optimales en termes de
rapidité. Dans InCopy, les blocs de substitution sont visibles uniquement en mode Mise en page. Les utilisateurs InCopy ne peuvent pas extraire
ou modifier les blocs de substitution.
Planches affectées Permet aux utilisateurs d’InCopy d’afficher tous les blocs affectés, ainsi que la totalité du contenu des autres blocs qui
n’appartiennent pas à l’affectation sur la même planche. Dans InCopy, le contenu des blocs situés en dehors d’une affectation n’est pas modifiable
et n’est visible qu’en mode Mise en page.
Toutes Exporte tout le contenu du document InDesign vers le fichier d’affectation. Cette option offre la meilleure fidélité ; elle donne aussi les plus
faibles performances car le fichier d’affectation affiche la conception et la mise en page de chaque page, y compris les pages sans rapport avec la
section que l’utilisateur modifie.
Fichiers image liés lors de l’assemblage Inclut une copie des images liées dans l’assemblage d’affectation. Lorsqu’elle est activée, cette option
permet aux utilisateurs InCopy d’accéder aux images, mais elle augmente la taille de fichier de l’assemblage. Les utilisateurs InCopy peuvent
inclure des images lorsqu’ils renvoient un assemblage.

Exportation du contenu dans des fichiers InCopy distincts (InDesign)
Si votre groupe de travail préfère travailler sur des fichiers séparés plutôt que d’utiliser des affectations, vous pouvez exporter le contenu InCopy
sans utiliser de fichier d’affectations. Contrairement à la méthode de création d’un fichier d’affectation unique comportant des références à
plusieurs fichiers de contenu et à des informations de mise en page, cette méthode crée un fichier distinct (.icml) pour chaque bloc de texte ou
bloc graphique spécifié dans le document. Pour afficher le contexte du contenu que vous modifiez, vous devez également ouvrir le document
InDesign associé (.indd).

Préparez le document InDesign selon les besoins de votre flux de production. Par exemple, si vous voulez que tous les commentaires de l’éditeur
soient exportés dans un seul et même fichier, créez un calque permettant à l’éditeur d’insérer des commentaires. Vous pouvez alors exporter tout
le contenu du calque sélectionné.

Remarque : pour exporter rapidement du contenu en tant que fichier InCopy indépendant, à l’aide de l’outil Sélection, faites glisser et déposez les
blocs sélectionnés dans la section Contenu InCopy non affecté du panneau Affectations.

1. Dans InDesign, créez un document comprenant un ou plusieurs blocs de texte, blocs graphiques ou balises d’emplacement.
2. Utilisez l’une des méthodes suivantes :

Sélectionnez le bloc de texte ou le bloc graphique d’un article ou cliquez en maintenant la touche Maj enfoncée pour
sélectionner plusieurs blocs.

Cliquez sur un point d’insertion dans un article ou sélectionnez du texte dans un bloc de texte.

3. Sélectionnez Edition > InCopy > Exporter et choisissez l’une des commandes suivantes :
Sélection Exporte tous les blocs de texte et blocs graphiques sélectionnés.

Calque Exporte tout le contenu du calque sélectionné.

Tous les articles Exporte tous les articles qui n’ont pas encore été exportés.



 

Tous les graphiques Exporte tous les graphiques qui n’ont pas encore été exportés.

Tous les graphiques et articles Exporte tous les articles et graphiques qui n’ont pas encore été exportés.

Si, après avoir exporté tout le contenu d’un document, vous ajoutez d’autres blocs de texte ou blocs graphiques à ce
même document, vous pouvez exporter tous les nouveaux articles en choisissant de nouveau la commande Exporter >
Tous les articles (ou Tous les graphiques ou Tous les graphiques et articles). InDesign exporte uniquement le nouveau
contenu.

4. Entrez un nom et un emplacement pour le fichier, puis cliquez sur Enregistrer.

Le nom de fichier sélectionné est utilisé comme préfixe permettant d’identifier chaque fichier de contenu exporté dans le
système de fichiers. Si vous exportez plusieurs blocs de texte, les premiers caractères du texte sont automatiquement ajoutés
au nom de fichier ; par exemple, « monarticle.Tour de France des é.icml ». Lorsqu’il existe plusieurs blocs graphiques, les
noms de fichiers sont au format suivant : « monarticle-graphic », « monarticle-graphic-1 », etc. Le nom de fichier est affiché
dans le système de fichiers, dans la barre d’articles InCopy et dans les messages d’état.

5. Dès l’affichage du message, enregistrez votre fichier InDesign.

Le contenu InCopy est à présent géré. D’autres utilisateurs du flux de production peuvent désormais l’extraire et le modifier.

Le contenu partagé s’affiche dans le panneau Liens comme tout graphique importé. Si vous déplacez un fichier partagé manuellement, vous
pouvez utiliser le panneau Liens pour mettre à jour son lien.

Lorsque vous exportez du contenu, l’icône Disponible  s’affiche dans le bloc de texte (InDesign et InCopy) et dans le panneau Affectations
(InCopy). La mention [Modification en cours] s’affiche dans la barre d’articles (InCopy).

Voir aussi

Informations juridiques   |   Politique de confidentialité en ligne

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://helpx.adobe.com/fr/legal/legal-notices.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr
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Enregistrement de documents
Enregistrement au format de versions précédentes d’InDesign
Utilisation de métadonnées

Enregistrement de documents

La commande d’enregistrement permet d’enregistrer la composition active et les références aux fichiers source, mais aussi de garder en mémoire
la page en cours d’affichage et le niveau de zoom. Enregistrez régulièrement vos documents pour éviter toute perte de données. Vous pouvez
enregistrer un fichier sous trois formes différentes :

Document standard.

Copie de document. Dans ce cas, vous créez une copie du document sous un nom différent, sans désactiver le document
original.

Modèle. Un modèle contient des paramètres, du texte et des graphiques prédéfinis qui peuvent être utilisés comme point de
départ pour la création de documents. Il s’ouvre généralement sous la forme d’un document sans titre.

L’enregistrement d’un document permet également de mettre à jour les métadonnées (informations sur les fichiers) d’un
document InDesign. Ces métadonnées comprennent un aperçu sous forme de vignette, les polices utilisées dans le document,
les nuances de couleur et toutes les métadonnées de la boîte de dialogue Informations, facilitant ainsi les recherches.
Supposons que vous souhaitez rechercher tous les documents utilisant une couleur particulière.

Vous pouvez afficher ces métadonnées dans Bridge et dans la zone Avancé de la boîte de dialogue Informations. Vous
pouvez décider de la mise à jour de l’aperçu lorsque vous effectuez un enregistrement en le spécifiant dans vos préférences.
Les autres métadonnées (polices, couleurs et liens) sont mises à jour lorsque vous enregistrez un document.

Les commandes Enregistrer, Enregistrer sous et Enregistrer une copie enregistrent les fichiers au format de fichier InDesign.
Pour plus de détails sur l’enregistrement de documents dans d’autres formats de fichier, reportez-vous à l’index.

Si vous enregistrez le document pour le transmettre à un prestataire de services prépresse en vue de son impression finale,
vous pouvez effectuer un regroupement automatique de tous les fichiers nécessaires (graphiques et polices liés, etc.) dans un
même dossier (Voir Assemblage de fichiers.)

Les informations saisies dans la boîte de dialogue Fichier > Informations sont mises à jour dans l’onglet Métadonnées lorsque vous
exportez un fichier EPUB dans les formats suivants :

Mise en page fixe EPUB
EPUB redistribuable

Utilisez l’une des méthodes suivantes :

Pour enregistrer un document sous un nouveau nom, choisissez Fichier > Enregistrer sous, indiquez un emplacement et
un nom de fichier, puis cliquez sur Enregistrer. Le nouveau fichier devient le document actif. L’utilisation de la commande
Enregistrer sous peut réduire la taille du fichier.

Pour enregistrer un document existant sous le même nom, sélectionnez Fichier > Enregistrer.

Pour enregistrer tous les documents ouverts sous leur nom de fichier et à leur emplacement, appuyez sur les touches
Ctrl+Alt+Maj+S (Windows) ou Commande+Option+Maj+S (Mac OS).

Pour enregistrer une copie du document sous un nouveau nom, sélectionnez Fichier > Enregistrer une copie, indiquez un
emplacement et un nom de fichier et cliquez sur Enregistrer. La copie enregistrée ne devient pas le document actif.

pour éviter tout problème, n’utilisez pas de caractères réservés ayant des significations spéciales dans certains systèmes
d’exploitation. Par exemple, évitez d’insérer dans les noms de fichier des espaces, des tabulations, des points ou les caractères / \ : ; * ? < > , $
%. De même, veillez à ne pas utiliser de caractères accentués (ü, ñ ou é par exemple), même lorsque vous utilisez une version non anglophone
d’InDesign. Des problèmes sont susceptibles de se produire si le fichier est ouvert sur une autre plate-forme.

http://idiom-q-win-1/fr/indesign/using/preflighting-files-handoff.html#package_files
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Si vous travaillez souvent sur plusieurs documents ouverts simultanément et que vous voulez les enregistrer en une seule opération, utilisez un
raccourci clavier. Choisissez la commande Edition > Raccourcis clavier, puis dans le menu Zone du produit, choisissez la commande Vues,
Navigation. Cela fait, sélectionnez la commande Tout enregistrer dans la liste Commandes. Vous avez alors la possibilité de modifier ou
d’ajouter un raccourci. Vous pouvez sélectionner l’option Application rapide pour définir la commande Tout enregistrer.

Inclusion d’aperçus dans les documents enregistrés

Les aperçus des documents et des modèles sous forme de vignettes facilitent l’identification de ces fichiers dans Adobe Bridge et
Adobe Mini Bridge. Un aperçu est créé lorsque vous enregistrez un document ou un modèle. Un aperçu de document comprend une image JPEG
de la première planche uniquement ; un aperçu de modèle comprend une image JPEG de chaque page du modèle. Vous pouvez contrôler la taille
de l’aperçu, ainsi que le nombre de pages, selon vos besoins. Par exemple, le format Très grand 1024x1024 vous permet de parcourir rapidement
le contenu d’une page à une haute résolution avant d’ouvrir le fichier.

Vous pouvez activer cette option dans les boîtes de dialogues Préférences ou Enregistrer sous. Etant donné que les aperçus augmentent à la fois
la taille du fichier et le temps d’enregistrement du document, il est préférable d’activer cette option de façon ponctuelle dans la boîte de dialogue
Enregistrer sous.

1. Utilisez l’une des méthodes suivantes :

Pour inclure l’aperçu à chaque enregistrement d’un document, choisissez la commande Edition > Préférences > Gestion
des fichiers (Windows) ou InDesign > Préférences > Gestion des fichiers (Mac OS).

Pour inclure l’aperçu d’un document spécifique, choisissez Fichier > Enregistrer sous.

Pour inclure l’aperçu d’un document spécifique, choisissez la commande Fichier > Enregistrer le contenu sous.

2. Sélectionnez Toujours enregistrer les images d’aperçu avec les documents.

3. Si vous définissez l’aperçu au moyen de la boîte de dialogue Préférences, choisissez le nombre de pages de l’aperçu dans le
menu Pages, puis une option dans le menu Taille de l’aperçu.

en sélectionnant l’option d’aperçu dans la boîte de dialogue Enregistrer sous, vous sélectionnez également cette
option dans la boîte de dialogue Préférences, selon les paramètres par défaut Pages et Taille de l’aperçu.

Enregistrement d’un document InDesign Markup (IDML)

Dans certains cas, il peut être utile d’enregistrer un document au format d’échange InDesign. Ce format est particulièrement pratique lorsque vous
désirez ouvrir une composition QuarkXPress ou PageMaker dans InDesign, ou exploiter un document créé dans une version antérieure
d’InDesign. Vous en aurez également besoin en cas de problème avec un document, par exemple, si vous ne parvenez pas à éliminer des
nuances de couleur.

1. Choisissez Fichier > Enregistrer (CS6) ou Fichier > Exporter (CS5).

2. Dans le menu Type (Windows) ou Format (Mac OS) de la boîte de dialogue Enregistrer sous, choisissez InDesign Markup
(IDML).

3. Cliquez sur Enregistrer.

Vous pouvez ouvrir le fichier IDML dans InDesign CS5 et InDesign CS4, mais pas dans les versions antérieures du programme.

Pour plus de détails sur l’utilisation du format IDML à des fins de développement, consultez le site Web d’Adobe à l’adresse
www.adobe.com/go/learn_id_indesignmarkup_cs4_fr.

Enregistrement au format de versions précédentes d’InDesign

Pour ouvrir un document InDesign CS6 dans InDesign CS5, allez dans InDesign CS6 et enregistrez (Fichier > Enregistrer) le document au
format IDML (InDesign Markup Language). Le format IDML remplace le format Interchange INX utilisé précédemment pour l’enregistrement au
format de versions précédentes.

Pour ouvrir un document InDesign CS5 dans InDesign CS4, allez dans InDesign CS5 et exportez (Fichier > Exporter) le document au format IDML
(InDesign Markup Language). (Le format IDML remplace le format Interchange INX utilisé précédemment pour l’enregistrement au format de
versions précédentes.)

http://www.adobe.com/go/learn_id_indesignmarkup_cs4_fr
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Vérifiez que les modules externes nécessaires à l’ouverture du fichier IDML exporté sont bien installés sur l’ordinateur exécutant la version
antérieure d’InDesign. L’utilisateur exécutant la version antérieure d’InDesign peut obtenir les modules externes de compatibilité en choisissant la
commande Aide > Mises à jour et en suivant les invites. Des modules externes peuvent également être installés à partir du site Web d’Adobe :
rendez-vous sur la page Mises à niveau de produits du site Web d’Adobe et choisissez InDesign dans la liste de produits.

L’ouverture d’un document dans une version précédente d’InDesign est également appelée « Sauvegarde dans une version précédente ».

Le contenu créé à l’aide des fonctions spécifiques à la version ultérieure d’InDesign peut être modifié ou omis lors de l’ouverture du
document dans une version précédente d’InDesign.

1. Choisissez > Enregistrer (CS6) ou Fichier > Exporter (CS5).

2. Dans le menu Type de fichier (Windows) ou Format (Mac OS), choisissez l’option InDesign Markup (IDML).

3. Cliquez sur Save.

Vous pouvez ouvrir le fichier .idml dans une version antérieure d’InDesign afin de le convertir en document InDesign sans titre.

pour ouvrir le document InDesign CS5 dans InDesign CS3, commencez par ouvrir le fichier IDML exporté dans InDesign CS4,
enregistrez-le, exportez-le au format InDesign CS3 Interchange (INX), puis ouvrez le fichier INX exporté dans InDesign CS3. Assurez-vous que
toutes les versions d’InDesign sont à jour.

Utilisation de métadonnées

Les métadonnées désignent un ensemble d’informations standardisées relatives à un fichier, telles que le nom de l’auteur, la résolution, l’espace
colorimétrique, les informations de copyright et autres mots-clés qui lui sont appliqués. Vous pouvez utiliser les métadonnées pour rationaliser
votre flux de production et organiser vos fichiers.

A propos de la norme XMP

Les informations de métadonnées sont stockées à l’aide de la norme XMP (eXtensible Metadata Platform) sur laquelle reposent Adobe Bridge,
Adobe Illustrator, Adobe InDesign et Adobe Photoshop. XMP repose sur le format XML. Dans la plupart des cas, les métadonnées sont stockées
dans le fichier. Lorsqu’il n’est pas possible de stocker les informations dans le fichier, les métadonnées sont conservées dans un fichier distinct
appelé fichier annexe. XMP facilite les échanges de métadonnées entre les applications Adobe et les flux d’édition. Par exemple, il est possible
d’enregistrer les métadonnées d’un fichier comme modèle et d’importer ensuite ces métadonnées dans d’autres fichiers.

Les métadonnées stockées dans d’autres formats, tels que Exif, IPTC (IIM), GPS ou TIFF, sont synchronisées et décrites à l’aide de la
norme XMP pour faciliter leur visualisation et leur gestion. D’autres applications et fonctions utilisent également la norme XMP pour communiquer
et stocker des informations telles que les commentaires de version, sur lesquelles vous pouvez effectuer une recherche avec Adobe Bridge.

Dans la plupart des cas, les métadonnées sont conservées dans leur fichier, même si le format du fichier change (de PSD à JPG, par exemple).
Les métadonnées sont également conservées lorsque les fichiers sont importés dans un document ou projet Adobe.

Vous pouvez utiliser le kit de développement logiciel XMP (SDK XMP) pour personnaliser la création, le traitement et l’échange des
métadonnées. Vous pouvez, par exemple, utiliser le SDK XMP pour ajouter des champs à la boîte de dialogue Informations. Pour plus de
détails sur XMP et le kit SDK XMP, rendez-vous sur le site Web d’Adobe.

Utilisation des métadonnées dans Adobe Bridge et dans les composants Adobe Creative Suite

Parmi les puissantes fonctions d’Adobe Bridge qui vous permettent d’organiser, de rechercher et de suivre vos fichiers et versions, beaucoup
dépendent des métadonnées XMP contenues dans les fichiers. Adobe Bridge permet de travailler avec les métadonnées de deux manières
différentes : avec le panneau Métadonnées et avec la boîte de dialogue Informations (InDesign) ou Informations sur le fichier (InCopy).

Dans certains cas, il peut y avoir plusieurs vues pour la même propriété de métadonnées. Une propriété peut, par exemple, être étiquetée Auteur
dans une vue et Créateur dans une autre, mais faire référence à la même propriété sous-jacente. Même si vous personnalisez ces vues pour des
flux de production particuliers, elles restent normalisées via XMP.

Ajout de métadonnées via la boîte de dialogue Informations

La boîte de dialogue Informations présente les données de l’appareil photo, les propriétés du fichier, un historique des modifications, le copyright

http://www.adobe.com/fr/downloads/updates/


Description

IPTC

Données de l’appareil photo

Données vidéo

Données audio

SWF mobile

Catégories

Origine

DICOM

Historique

Illustrator

Avancé

Données brutes

et d’autres détails concernant l’auteur du document actuel. Elle contient également des panneaux de métadonnées personnalisés. Vous pouvez
ajouter des métadonnées aux fichiers directement à partir de la boîte de dialogue Informations. Les informations que vous saisissez dans un
champ remplacent les métadonnées existantes et ce, dans tous les fichiers sélectionnés.

1. Choisissez Fichier > Informations (InDesign) ou Fichier > Informations sur le fichier (InCopy).

2. Sélectionnez l’une des propositions suivantes dans les onglets situés en haut de la boîte de dialogue :

Faites défiler les onglets à l’aide des touches fléchées Droite et Gauche, ou cliquez sur la flèche pointant vers le bas, puis
choisissez une catégorie dans la liste.

Vous permet de saisir les informations de document sur le fichier, telles que le titre du document, son auteur,
une description et les mots-clés qui peuvent être utilisés pour rechercher le document. Pour spécifier des informations de
copyright, sélectionnez l’option Protégé par copyright dans le menu déroulant Etat du copyright. Entrez ensuite le nom du
détenteur du copyright, le texte de l’avis et l’URL de la personne ou de la société propriétaire du copyright.

Comporte quatre zones : Contenu IPTC décrit le contenu visuel de l’image ; Contact IPTC spécifie les coordonnées du
photographe ; Image IPTC répertorie des informations descriptives de l’image ; Etat IPTC répertorie des informations de flux
de production et de copyright.

Comporte deux zones : Données de l’appareil photo 1 affiche des informations en lecture
seule sur l’appareil photo et les réglages utilisés lors de la prise de vue, comme par exemple la marque, le modèle, la vitesse
d’obturation et l’ouverture du diaphragme. Données de l’appareil photo 2 répertorie les informations de fichier en lecture seule
sur la photo, y compris les dimensions en pixels et la résolution.

Répertorie des informations sur le fichier vidéo, y compris la largeur et la hauteur de l’image vidéo, et vous
permet d’entrer des informations sur le fichier vidéo, notamment le nom de la bande et le nom de la scène.

Permet de saisir des informations sur le fichier audio, notamment le titre, l’artiste, le débit et les réglages de
boucle.

Présente des informations relatives aux fichiers multimédia mobiles, notamment leur titre, auteur, description et
type de contenu.

Permet d’entrer des informations basées sur les catégories Associated Press.

Vous permet de saisir les informations de fichier utiles pour les nouvelles sorties, y compris la date et le lieu de la
création du fichier, les informations de transmission, les instructions spéciales et les informations de titre.

Répertorie le patient, l’étude, les séries et les informations sur l’équipement pour les images DICOM.

Affiche les informations du journal d’historique pour les images enregistrées avec Photoshop. L’onglet Historique
apparaît uniquement si Adobe Photoshop est installé.

Vous permet d’appliquer un profil de document pour l’impression, la publication sur le Web ou la sortie sur un
périphérique mobile.

Affiche les champs et structures de stockage des métadonnées en utilisant les espaces de nom et les propriétés,
telles que le format de fichier et les propriétés XMP, Exif et PDF.

Affiche des informations de texte XMP concernant le fichier.

3. Tapez les informations à ajouter dans un champ affiché.

4. Cliquez sur OK pour appliquer les modifications.
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Exportation de métadonnées dans un fichier XMP

Vous pouvez enregistrer les métadonnées dans un fichier XMP afin de les partager avec d’autres utilisateurs. Ces fichiers XMP peuvent servir de
modèle pour remplir des documents InDesign ou d’autres documents créés à l’aide d’applications compatibles XMP. Les modèles exportés sont
stockés dans un emplacement partagé accessible à toutes les applications compatibles XMP. Elles figurent également dans le menu déroulant
situé en bas de la boîte de dialogue Informations.

1. Choisissez Fichier > Informations (InDesign) ou Fichier > Informations sur le fichier (InCopy).

2. Choisissez la commande Exporter dans le menu déroulant situé en bas de la boîte de dialogue.

3. Saisissez un nom de fichier, choisissez un emplacement pour le fichier, et cliquez sur le bouton Enregistrer.

Pour visualiser les modèles de métadonnées dans l’Explorateur (Windows) ou dans le Finder (Mac OS), cliquez sur le
menu déroulant situé en bas de la boîte de dialogue Informations, puis choisissez Afficher le dossier de modèles.

Importation de métadonnées à partir d’un fichier XMP

Lorsque vous importez des métadonnées dans un document à partir d’un fichier de modèle XMP exporté, vous pouvez préciser si vous désirez
effacer toutes les métadonnées du document actuel et y insérer les nouvelles, garder uniquement les métadonnées correspondantes ou ajouter les
métadonnées correspondantes à celles qui existent déjà.

Choisissez Fichier > Informations (InDesign) ou Fichier > Informations sur le fichier (InCopy).

Choisissez un fichier XMP dans le menu déroulant situé en bas de la boîte de dialogue, sélectionnez une option
d’importation, et cliquez sur le bouton OK.

Choisissez la commande Importer dans le menu déroulant situé en bas de la boîte de dialogue, sélectionnez une option
d’importation, et cliquez sur le bouton OK. Cliquez deux fois sur le fichier de modèle XMP à importer.

Modification des métadonnées dans des fichiers image

Les légendes des images importées dans InDesign sont créées à partir des métadonnées de ces images. Bien que vous puissiez modifier les
métadonnées des documents InDesign, vous ne pouvez pas changer celles des fichiers importés dans InDesign. Cette opération doit être
effectuée dans l’application d’origine des images importées, au moyen du Finder, de l’Explorateur, d’Adobe Bridge ou d’Adobe Mini Bridge.

1. Dans InDesign, cliquez sur l’image avec le bouton droit de la souris (Windows) ou en maintenant la touche Contrôle enfoncée
(Mac OS), puis choisissez la commande Modifier l’original.

Vous pouvez également choisir la commande Modifier avec, puis sélectionner une application telle qu’Adobe Illustrator ou
Adobe Photoshop.

2. Dans l’application d’origine, choisissez Fichier > Informations.

3. Modifiez les métadonnées à votre convenance, puis cliquez sur OK.

Vous pouvez également sélectionner une image dans Adobe Bridge puis choisir Fichier > Informations, afin de modifier les métadonnées de
l’image. Voir Ajout de métadonnées via la boîte de dialogue Informations.

Adobe recommande également
Utilisation des métadonnées dans Adobe

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr
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Pour plus d’informations et d’instructions, cliquez sur les liens ci-dessous.

Partage de contenu
Les modules externes Adobe InCopy LiveEdit Workflow permettent aux rédacteurs et correcteurs de composer leur document dans InCopy tandis
que les concepteurs graphiques préparent la mise en page dans Adobe InDesign. Ce flux de production inclut des fichiers conteneurs, appelés
affectations, permettant de regrouper des contenus connexes ainsi que des outils de notification et de verrouillage de fichiers pour partager et
mettre à jour des fichiers dans InCopy ou InDesign sur un réseau partagé ou dans des assemblages compressés pouvant être distribués par
courrier électronique.

Dans ce flux de production du réseau partagé, les utilisateurs InDesign exportent le texte et les graphiques vers un emplacement partagé d’un
système de fichiers, dans lequel les fichiers sont mis à la disposition des utilisateurs InCopy qui rédigent et modifient le contenu. Les blocs de
texte et les blocs graphiques sélectionnés sont exportés vers l’affectation ou exportés en tant que fichiers InCopy distincts. Ils font ensuite partie
du processus géré et sont liés au document InDesign. Ces fichiers partagés sont appelés fichiers gérés. Lorsque les utilisateurs travaillent sur le
fichier d’affectation ou le fichier InDesign sur un serveur local, les modifications apportées au contenu ou à la mise en page associés sont
signalées à tous les utilisateurs concernés qui appartiennent au flux de production de ce document.

Plusieurs utilisateurs d’InCopy ou d’InDesign peuvent ouvrir le même fichier de contenu simultanément ; de même, plusieurs utilisateurs d’InCopy
peuvent ouvrir le même fichier d’affectation simultanément. Toutefois, un seul utilisateur peut extraire le fichier InCopy pour le modifier. Les autres
utilisateurs peuvent accéder à ce fichier en lecture seule. L’utilisateur qui extrait un fichier InCopy géré peut partager son travail avec d’autres
utilisateurs en enregistrant le fichier sur le serveur partagé ou en le renvoyant à l’utilisateur InDesign. Cependant, les autres utilisateurs peuvent
modifier ce fichier uniquement lorsque ce dernier a été de nouveau archivé. Ce système permet à plusieurs utilisateurs d’accéder au même fichier
sans risque de suppression des modifications de chacun.

Pour plus de détails, reportez-vous au guide relatif au flux de production InCopy LiveEdit Workflow (PDF) à l’adresse suivante :
www.adobe.com/go/learn_liveedit_fr.

Gestion de contenu dans InCopy
Le contenu est soit un corps de texte qui est réparti dans un ou plusieurs blocs, soit un graphique importé. Il existe cinq méthodes pour travailler
sur du contenu dans InCopy : en ouvrant un fichier d’affectation, un assemblage d’affectation, un fichier InCopy lié, un fichier InDesign comprenant
des fichiers InCopy liés ou bien en composant du contenu entièrement dans InCopy.

Ouverture de fichiers d’affectation créés dans InDesign
Les utilisateurs InDesign peuvent créer un fichier d’affectation et définir le contenu à partager. Cette méthode permet à l’utilisateur InDesign
d’associer des composants connexes (en-tête, corps, graphiques, légendes, etc.), puis de les affecter à différents utilisateurs InCopy pour l’écriture
et la modification. Les utilisateurs InCopy ouvrent le fichier d’affectation et travaillent uniquement sur les composants qui leur ont été assignés. Le
mode Mise en page affiche la manière dont la copie modifiée est reliée à la mise en page InDesign, sans ouvrir le document InDesign
entièrement. Toutefois, si la mise en page est modifiée, l’utilisateur InDesign doit mettre à jour les affectations afin de notifier les utilisateurs
InCopy des modifications apportées. Vous pouvez partager des fichiers d’affectation sur un serveur ou par l’intermédiaire des assemblages
d’affectation.

http://www.adobe.com/go/learn_liveedit_fr


Document InDesign (.indd) avec fichier d’affectation (.icml) composé de trois fichiers de contenu liés (.incx). L’affectation et ses composants sont
répertoriés dans le panneau Affectations et sont ouverts dans InCopy.

Ouverture des assemblages d’affectation
Le flux de production des assemblages d’affectation est particulièrement utile lorsque les concepteurs et les rédacteurs travaillent sur le même
projet, mais qu’ils n’ont pas accès à un serveur local. Dans ces cas-là, l’utilisateur InDesign peut créer un ou plusieurs assemblages et envoyer
par courrier électronique les fichiers compressés aux utilisateurs InCopy auxquels ils ont été affectés. Les utilisateurs InCopy peuvent ouvrir les
assemblages d’affectation, modifier les contenus et renvoyer les assemblages à l’utilisateur d’InDesign, qui peut ensuite mettre à jour le document.

Ouverture de fichiers InCopy liés exportés à partir d’InDesign
Dans certains flux de production, les utilisateurs InDesign doivent exporter le texte et les graphiques sous forme de fichiers séparés plutôt que les
inclure dans un fichier d’affectation. L’exportation de fichiers séparés est utile si vous travaillez sur des graphiques ou des corps de texte non
associés. Toutefois, les utilisateurs InCopy ne peuvent pas voir comment le contenu s’intègre à la mise en page InDesign.
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Document InDesign (.indd) avec trois fichiers de contenu liés mais non attribués (.icml) ouverts dans InCopy

Ouverture de documents InDesign comprenant des fichiers InCopy liés
Les utilisateurs InCopy peuvent ouvrir et modifier le document InDesign dans InCopy pour visualiser tous les éléments de page dans le contexte
de la mise en page complète. Cette approche peut se révéler utile lors de l’édition et du calibrage, où la visualisation de la mise en page globale
est souvent importante, ou lors de la modification d’un grand nombre d’articles dans un document. Lorsque l’utilisateur InCopy a modifié les
articles, l’utilisateur InDesign peut mettre à jour les liens vers les fichiers modifiés. Si l’utilisateur d’InDesign modifie la mise en page, l’utilisateur
InCopy en est informé lors de l’enregistrement du document InDesign.

Composition de l’ensemble du contenu dans InCopy
Vous pouvez créer du contenu dans InCopy qui ne soit pas associé à un fichier InDesign. Dans ces documents autonomes, vous pouvez saisir du
texte, attribuer des polices et des styles et importer des graphiques depuis d’autres applications (telles qu’Adobe Illustrator et Adobe Photoshop)
pour mettre le texte en valeur. Vous pouvez également attribuer des balises en vue d’une utilisation XML. Cette approche est très utile dans un
flux de production éditorial, où le contenu précède la mise en page. Vous pouvez également définir et modifier la zone de texte, la taille et
l’orientation de la page pour les documents InCopy autonomes. Si l’article est lié par la suite à une composition InDesign, les paramètres InDesign
remplacent ceux définis dans InCopy.

Fichiers gérés
Pour qu’un fichier soit géré, il doit être ajouté à un fichier d’affectation, exporté à partir d’InDesign en tant que contenu InCopy, ou importé dans
InDesign en tant que contenu InCopy. Les fichiers gérés communiquent à la fois l’état du contenu et les autorisations. Les fichiers gérés
permettent de :

verrouiller et déverrouiller des articles afin de contribuer à préserver l’intégrité des fichiers ;

notifier les utilisateurs InCopy lorsque la mise en page InDesign associée est obsolète ;

identifier l’utilisateur travaillant sur un fichier ;

notifier tout utilisateur du caractère obsolète d’un fichier InCopy, de son utilisation par un autre collaborateur ou de sa
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disponibilité pour modification. Les méthodes de notification comprennent les messages d’alerte, les icônes de bloc, les icônes
d’état du panneau Liens et celles du panneau Affectations.

Fichiers en lecture seule
Une fois qu’un fichier de contenu devient un fichier géré, il est toujours « en lecture seule » pour tous les utilisateurs du flux de production, sauf
pour la personne qui l’a extrait. Le logiciel crée un fichier de verrouillage (*.idlk) lorsqu’un utilisateur extrait un fichier de contenu, donnant ainsi à
cet utilisateur un contrôle exclusif sur sa modification. Un fichier en lecture seule possède les caractéristiques suivantes :

Un utilisateur InCopy ne peut pas manuellement mettre en forme le texte qu’il contient. Toutefois, si des styles de caractère ou
de paragraphe ont été affectés au texte, un utilisateur d’InDesign peut modifier la définition de ces styles et, par conséquent,
modifier la mise en forme du texte même lorsque le fichier est extrait pour une autre personne. Ces modifications de définition
de style sont répercutées dans le texte lorsque l’utilisateur d’InDesign met à jour le fichier.

En général, ni les utilisateurs d’InCopy ni ceux d’InDesign ne peuvent modifier les objets, tels que le texte et les styles
appliqués dans le contenu InCopy verrouillé. Certains objets comme les styles de caractères et de paragraphes sont utilisés
exclusivement par le contenu. Il est impossible de modifier l’application d’un style de caractère dans un contenu verrouillé, par
exemple, mais il est possible de modifier le style lui-même modifiant ainsi l’aspect du texte.

Les utilisateurs d’InDesign peuvent modifier les marges et colonnes du contenu du texte, ainsi que la forme, l’emplacement et
le nombre de blocs de texte contenant cet article.

Les utilisateurs d’InDesign peuvent modifier la géométrie et la mise en forme d’un bloc graphique sans extraire le graphique.
Les utilisateurs d’InCopy ne peuvent pas modifier le bloc graphique ou la mise en forme du bloc. Toutefois, les utilisateurs
d’InDesign et d’InCopy doivent extraire le bloc graphique pour pouvoir modifier le graphique (par exemple, pour le faire pivoter
ou le redimensionner).

Méthodes recommandées pour l’utilisation des fichiers gérés
Utilisez l’une des méthodes suivantes pour vérifier que vous utilisez le dernier contenu et que vous n’écrasez pas le travail d’un autre utilisateur :

Enregistrez les fichiers d’affectation sur un serveur auquel tous les membres d’équipe ont accès. Si les membres d’équipe
n’ont pas accès à un serveur, vous pouvez créer et distribuer des assemblages d’affectation.

Lorsque vous créez une affectation, un dossier spécial est créé dans lequel le fichier d’affectation et le contenu sont
enregistrés. Utilisez ces dossiers d’affectation pour conserver les fichiers d’affectation et de contenu. Ces dossiers ont pour but
de simplifier la gestion des dossiers partagés au sein d’un groupe de travail et de faire en sorte que les utilisateurs ouvrent les
fichiers appropriés.

Dans InCopy, ouvrez le fichier d’affectation à la place d’un article InCopy. Ainsi, vous pouvez consulter les informations de
calibrage et de mise en page en modes Epreuve en placard et Mise en page. Si vous exportez le contenu sans utiliser les
fichiers d’affectation, il vous suffit d’ouvrir le fichier InDesign pour consulter les informations de calibrage et de mise en page.

Dès que vous ouvrez un fichier d’affectation ou un document InDesign ou que vous extrayez un contenu dans InDesign
ou InCopy, assurez-vous que les contours des blocs sont affichés (Affichage > Extras > Afficher les contours du bloc) afin de
voir les icônes de bloc.

Dans InDesign, si vous souhaitez supprimer des fichiers du flux de production (en raison d’un délai de production, par
exemple), vous pouvez rompre leur lien ou annuler un assemblage d’affectation.

Exemples de flux de production avec gestion des fichiers
Dans le cadre d’une gestion du flux de production entre InCopy et InDesign, les rédacteurs et correcteurs peuvent composer, récrire, augmenter et
modifier les documents pendant que les concepteurs préparent la mise en page. Les flux de production les plus courants incluent la gestion des
fichiers sur un serveur local, le partage des fichiers par courrier électronique ou une combinaison des deux méthodes.

Ces flux de production supposent que vous disposiez d’un modèle InDesign de base avec une géométrie de mise en page, des styles et du texte
de substitution. La géométrie de mise en page comprend les dimensions de page, les blocs de texte et les blocs graphiques. InCopy utilise ces
éléments pour afficher des informations de calibrage correctes.

Flux de production de serveur local

1. Dans InDesign, créez des affectations et ajoutez-leur du contenu.
Les blocs de texte et les blocs graphiques sont incorporés dans le processus géré, dans lequel ils sont mis à la disposition des utilisateurs
d’InCopy pour la rédaction et la modification.

2. Rendez les fichiers d’affectation disponibles à tous les utilisateurs InCopy.
Enregistrez les fichiers sur un serveur auquel tous les utilisateurs du flux de production ont accès.

3. Dans InCopy, ouvrez le fichier d’affectation pour extraire ou modifier un article ou une image.
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Dans InCopy, les fichiers comportant du texte qui vous est affecté s’affichent dans le panneau Affectations. Lorsque vous enregistrez le fichier sur
un serveur local, les modifications sont enregistrées sur le système de fichier et toute personne travaillant sur ce document (la mise en page
InDesign ou un autre fichier de contenu géré dans le document) reçoit une notification des modifications apportées. Ces utilisateurs peuvent mettre
à jour le contenu afin d’afficher les dernières modifications. L’extraction du contenu reste valide jusqu’à son nouvel archivage par vos soins.

4. Dans InDesign, travaillez sur la mise en page.
Quels que soient les fichiers de contenu en cours de modification dans InCopy, les utilisateurs d’InDesign peuvent travailler sur la mise en page du
document sans devoir extraire ce dernier. Lorsque l’utilisateur d’InCopy enregistre le contenu extrait, l’utilisateur d’InDesign peut mettre à jour le
contenu avec la mise en page pour afficher les dernières révisions.

5. Dans InCopy, continuez votre travail.
Une fois les modifications effectuées, archivez le contenu. Les autres utilisateurs peuvent alors extraire le contenu et l’exploiter. Lorsqu’un
utilisateur modifie la mise en page en même temps dans InDesign, vous pouvez mettre à jour et afficher la géométrie de mise en page pendant
que vous travaillez.

6. Dans InDesign, vérifiez que le contenu a bien été archivé.
Le flux de production géré permet de savoir qui a extrait les fichiers. Une fois les fichiers de contenu archivés, les utilisateurs InDesign peuvent
extraire les fichiers afin d’apporter les modifications nécessaires à la mise en page.

Flux de production d’assemblage de courriers électroniques

1. Dans InDesign, créez et envoyez des assemblages d’affectation.
Créez des assemblages d’affectation et affectez le contenu aux utilisateurs d’InCopy appropriés, puis envoyez les assemblages aux utilisateurs
d’InCopy. Les fichiers assemblés sont automatiquement extraits afin d’éviter les conflits de modification.

2. Dans InCopy, ouvrez l’assemblage d’affectation pour extraire ou modifier un article ou une image.
Si vous recevez un assemblage d’affectation par courrier électronique, cliquez deux fois dessus pour l’ouvrir dans InCopy. Les modifications que
vous apportez au fichier ne sont enregistrées que localement. Les autres utilisateurs ne sont pas informés des modifications que vous effectuez.

3. Dans InDesign, travaillez sur la mise en page.
Quels que soient les fichiers de contenu en cours d’assemblage, les utilisateurs d’InDesign peuvent travailler sur la mise en page du document
sans devoir extraire ce dernier. Si vous devez mettre à jour la mise en page ou les affectations, vous pouvez envoyer un assemblage mis à jour
aux utilisateurs d’InCopy.

4. Dans InCopy, renvoyez l’assemblage modifié.
Une fois les modifications terminées, archivez le contenu puis renvoyez l’assemblage modifié. Les autres utilisateurs ont alors la possibilité
d’extraire le contenu, de visualiser les dernières révisions et de travailler sur le fichier.

5. Dans InDesign, vérifiez que le contenu a bien été archivé.
Le flux de production géré permet de savoir qui a extrait les fichiers. Une fois les assemblages d’affectation renvoyés, les articles qu’ils contiennent
sont archivés. Les utilisateurs d’InDesign peuvent extraire les fichiers afin de finaliser la mise en page, si nécessaire.

Saisie de l’identifiant utilisateur
Tous les utilisateurs du flux de production doivent posséder un nom d’utilisateur. Cet identifiant indique qui a extrait un fichier particulier et rend
ces informations disponibles aux autres utilisateurs. Elle est aussi requise lors de l’extraction d’un fichier pour modification.

Si vous avez déjà indiqué un nom d’utilisateur et que vous souhaitez le modifier, vous devez archiver le contenu que vous avez extrait. Si vous
changez d’identifiant pendant une session d’édition, vous risquez de ne plus pouvoir modifier le contenu extrait sous votre identifiant précédent.

L’identifiant utilisateur est spécifique à chaque application ; un même utilisateur ne peut avoir plusieurs identifiants par application.

Remarque : les fonctions Notes et Suivi des modifications d’InCopy utilisent également le nom spécifié pour identifier l’auteur d’une note ou d’un
suivi de modifications.

1. Utilisez l’une des méthodes suivantes :

Choisissez Fichier > Utilisateur.

Choisissez l’option Utilisateur dans le menu du panneau Affectations.

2. Saisissez un nom unique, puis cliquez sur OK.

Si vous n’avez pas spécifié de nom d’utilisateur à l’aide de cette méthode, vous êtes invité à en entrer un lors de votre première action de flux de
production.

Remarque : le menu déroulant Couleur de la boîte de dialogue Utilisateur permet d’identifier les notes éditoriales et les modifications de suivi. Vous
pouvez définir la couleur, mais cela n’affecte pas les opérations effectuées dans un flux de production géré.



 

Icônes de flux de production
Les icônes peuvent être affichées sur les blocs de texte et les blocs graphiques, dans le panneau Affectations, ainsi que dans la barre d’articles
(InCopy seulement). Les icônes d’état d’édition s’affichent en regard de chaque fichier géré dans les panneaux Liens et Affectations. Elles
indiquent l’état du contenu correspondant. Les icônes figurent aussi sur les blocs contenant des articles InCopy liés (en mode Mise en page dans
InDesign et InCopy). Ces icônes indiquent également l’état du contenu et peuvent être utilisées pour distinguer le contenu géré du contenu non
géré. L’info-bulle associée indique l’état de modification et les autorisations. Pour afficher les icônes de bloc, vérifiez que les contours des blocs
s’affichent dans InDesign et InCopy (Affichage > Extras > Afficher les contours du bloc).

Remarque : (InDesign) la fenêtre du document InDesign doit être en mode Normal pour que les contours des blocs s’affichent (cliquez sur le
bouton du mode Normal  en bas à gauche du panneau Outils).

Icône Nom Emplacement

Disponible Panneau Affectations (InDesign et InCopy), blocs de texte et blocs
graphiques

En cours d’utilisation par [nom] Panneau Affectations, blocs de texte et blocs graphiques

Modification Panneau Affectations, blocs de texte et blocs graphiques

Disponible et Obsolète Blocs de texte et blocs graphiques

En cours d’utilisation par [nom] et
Obsolète

Blocs de texte et blocs graphiques

Modification et Obsolète Blocs de texte et blocs graphiques

Obsolète Panneau Affectations

Le contenu textuel est obsolète Panneau Affectations et blocs de texte

Le contenu textuel est à jour Panneau Affectations et blocs de texte

Le contenu graphique est obsolète Panneau Affectations et blocs graphiques

Le contenu graphique est à jour Panneau Affectations et blocs graphiques

Contenu assemblé Panneau Affectations

Remarque : l’icône Obsolète superposée aux icônes Disponible, En cours d’utilisation, Modification, Contenu textuel et Contenu graphique indique
que le contenu est obsolète, c’est-à-dire que la version située sur le système de fichiers est plus récente que la version affichée sur votre
ordinateur.
Voir aussi

Informations juridiques   |   Politique de confidentialité en ligne

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://helpx.adobe.com/fr/legal/legal-notices.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr
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Présentation de l’espace de travail
Gestion des fenêtres et des panneaux
Enregistrement et basculement d’un espace de travail à l’autre
A propos des modes d’affichage
Utilisation de la barre d’état
Présentation du panneau Contrôle
A propos du panneau Navigation
Utilisation des menus contextuels
Modification des préférences de l’interface

Cliquez sur les liens suivants pour plus d’informations.

Présentation de l’espace de travail

Vous pouvez créer et manipuler vos documents et fichiers à l’aide de divers éléments tels que des panneaux, barres et fenêtres. Un espace de
travail désigne l’organisation de ces éléments. Les espaces de travail des différentes applications de la suite Adobe® Creative Suite® 5 ont le
même aspect, ce qui facilite le passage d’une application à une autre. Vous pouvez également adapter chaque application aux exigences de votre
travail, en créant votre propre espace de travail ou en effectuant une sélection parmi ceux prédéfinis.

Bien que la disposition de l’espace de travail par défaut varie selon les applications, la manipulation des éléments est pratiquement identique dans
chacune d’elles.

La barre d’application occupe la partie supérieure et contient un sélecteur permettant de basculer vers un autre espace de
travail, des menus (sous Windows uniquement), ainsi que d’autres commandes d’application. Sous Mac et pour certains
produits, vous pouvez l’afficher ou la masquer à l’aide du menu Fenêtre.

Le panneau Outils contient des outils permettant de créer et de modifier des images, des illustrations, des éléments de page,
etc. Les outils connexes sont regroupés.

Le panneau Contrôle affiche des options relatives à l’outil sélectionné. Dans Illustrator, le panneau Contrôle affiche des options
relatives à l’objet sélectionné. (Il est appelé Barre d’options dans Adobe Photoshop®. Dans Adobe Flash®, Adobe
Dreamweaver® et Adobe Fireworks®, il est appelé Inspecteur de propriétés et inclut les propriétés relatives à l’élément
actuellement sélectionné.)

La fenêtre de document affiche le fichier sur lequel vous travaillez. Les fenêtres de document peuvent présenter un onglet et,
dans certains cas, être regroupées et ancrées.

Les panneaux vous permettent de contrôler et de modifier votre travail. Citons notamment le panneau Montage dans Adobe
Flash, le panneau Pinceau dans Adobe Illustrator, le panneau Calques dans Adobe Photoshop® et le panneau Styles CSS
dans Adobe Dreamweaver. Ils peuvent être regroupés, empilés ou ancrés.

Le Cadre de l’application regroupe tous les éléments des espaces de travail dans une seule et même fenêtre uniforme, ce qui
permet de manipuler toutes les applications comme s’il s’agissait d’une seule entité. Lorsque vous déplacez ou que vous
redimensionnez le Cadre de l’application ou l’un de ses éléments, tous les éléments qu’il contient sont réagencés pour éviter
tout chevauchement. Les panneaux ne disparaissent pas lorsque vous changez d’application ou lorsque vous cliquez par
erreur à côté de l’application. Si vous utilisez plusieurs applications, vous pouvez les placer côte à côte à l’écran ou sur
plusieurs moniteurs.

Si vous préférez l’interface utilisateur Mac classique que vous pouvez personnaliser à votre convenance, il vous suffit de
désactiver le Cadre de l’application. Dans Adobe Illustrator®, par exemple, sélectionnez la commande Fenêtre > Cadre de
l’application pour l’activer ou le désactiver. (Dans Flash, le Cadre de l'application est activé en permanence pour Mac et
Dreamweaver pour Mac n'en utilise pas.)



Espace de travail Illustrator par défaut

A. Documents sous forme d’onglets B. Barre d’application C. Sélecteur d’espace de travail D. Barre de titre de panneau E. Panneau Contrôle F.
Panneau Outils G. Bouton Réduire en icônes H. Quatre groupes de panneaux en ancrage vertical 

Affichage et masquage de tous les panneaux

(Illustrator, Adobe InCopy®, Adobe InDesign®, Photoshop, Fireworks) Pour afficher ou masquer tous les panneaux, y compris
les panneaux Outils et Contrôle, appuyez sur la touche de tabulation.

(Illustrator, InCopy, InDesign, Photoshop) Pour afficher ou masquer tous les panneaux, à l’exception des panneaux Outils et
Contrôle, appuyez sur les touches Maj+tabulation.

Vous pouvez afficher temporairement les panneaux masqués si l’option Afficher automatiquement les panneaux masqués est sélectionnée
dans les préférences Interface. Cette option est toujours activée dans Illustrator. Déplacez le pointeur vers le bord de la fenêtre de l’application
(Windows®) ou vers le bord de l’écran (Mac OS®) et laissez le pointeur au-dessus de la bande qui s’affiche.

(Flash, Dreamweaver, Fireworks) Pour afficher ou masquer tous les panneaux, appuyez sur la touche F4.

Affichage des options de panneau

Cliquez sur l’icône de menu de panneau  dans le coin supérieur droit du panneau.

L’ouverture d’un menu est possible même lorsque le panneau est réduit.

Dans Photoshop, vous pouvez modifier le corps de la police du texte des panneaux et des info-bulles. Dans les préférences
d’interface, choisissez une option dans le menu Corps de la police de l’interface utilisateur.

Réglage de la luminosité du panneau (Illustrator)

Faites glisser le curseur Luminosité dans les préférences de l’interface utilisateur. Cette commande affecte tous les panneaux,
y compris le panneau Contrôle.

Reconfiguration du panneau Outils
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Remarque :

Remarque :

Remarque :

Remarque :

Remarque :

Vous pouvez afficher les outils du panneau Outils dans une seule colonne ou côte à côte dans deux colonnes. (Cette fonction n’est pas disponible
dans le panneau Outils de Fireworks et Flash.)

Dans InDesign et InCopy, une option des préférences d’interface vous permet également de basculer d’un affichage en une colonne vers un
affichage en deux colonnes.

Cliquez sur la double flèche dans la partie supérieure du panneau Outils.

Gestion des fenêtres et des panneaux

Pour créer un espace de travail personnalisé, vous déplacez et manipulez les fenêtres de document et les panneaux. Vous pouvez également
enregistrer des espaces de travail, puis passer de l’un à l’autre. Dans Fireworks, renommer les espaces de travail personnalisés peut provoquer
un comportement inattendu.

les exemples suivants sont basés sur Photoshop. L’espace de travail est le même dans tous les produits.

Réorganisation, ancrage ou déplacement des fenêtres de document

Les fenêtres de document comportent des onglets lorsque plusieurs fichiers sont ouverts.

Pour modifier l’ordre des onglets de la fenêtre de document, faites glisser un onglet de la fenêtre à l’emplacement voulu dans
le groupe.
Pour annuler l’ancrage d’une fenêtre de document à un groupe de fenêtres, faites glisser l’onglet de cette fenêtre hors du
groupe.

dans Photoshop, vous pouvez également sélectionner Fenêtre > Disposition > Fenêtre flottante pour afficher une seule fenêtre
flottante de document ou Fenêtre > Disposition > Tout faire flotter dans les fenêtres pour afficher simultanément toutes les fenêtres
flottantes de document. Consultez les notes techniques kb405298 pour plus d’informations.

Dreamweaver ne permet pas d’ancrer des fenêtres de document ni d’annuler l’ancrage de ces fenêtres. Utilisez le bouton Réduire de
la fenêtre de document pour créer des fenêtres flottantes (sous Windows), ou Fenêtre > Mosaïque verticale pour créer des fenêtres de
document côte à côte. Pour plus d’informations sur cette rubrique, recherchez « Mosaïque verticale » dans l’aide de Dreamweaver. Le flux
de travaux diffère légèrement pour les utilisateurs Macintosh.

Pour ancrer une fenêtre de document à un groupe de fenêtres de document distinct, faites glisser cette fenêtre dans le groupe.

Pour créer des groupes de documents empilés ou juxtaposés, faites glisser la fenêtre vers l’une des zones de largage situées
en haut, en bas ou sur les côtés d’une autre fenêtre. Vous pouvez également sélectionner une disposition pour le groupe en
utilisant le bouton Disposition de la barre d’application.

certains produits ne prennent pas en charge cette fonctionnalité. Cependant, votre produit peut présenter des commandes Cascade
et Mosaïque (ou Juxtaposer), sous le menu Fenêtre, pour vous permettre d’organiser vos documents.

Dans un groupe à onglets, pour passer à un autre document lors du glissement d’une sélection, faites glisser et maintenez
cette sélection sur l’onglet du document souhaité pendant un moment.

certains produits ne prennent pas en charge cette fonctionnalité.

Ancrage et annulation d’ancrage de panneaux

Un dock est un ensemble de panneaux ou de groupes de panneaux affichés ensemble, généralement en position verticale. Pour ancrer et annuler
l’ancrage des panneaux, insérez-les dans le dock et déplacez-les hors du dock.

Pour ancrer un panneau, cliquez sur l’onglet correspondant et faites-le glisser dans le dock, au-dessus, sous ou entre d’autres
panneaux.

http://helpx.adobe.com/fr/photoshop/kb/un-tab-image-windows-photoshop.html


Remarque :

Pour ancrer un groupe de panneaux, cliquez sur sa barre de titre (barre vide de couleur unie située au-dessus des onglets) et
faites-le glisser dans le dock.

Pour supprimer un panneau ou un groupe de panneaux, faites-le glisser en dehors du dock en cliquant sur l’onglet ou la barre
de titre. Vous pouvez faire glisser l’élément vers un autre dock ou le rendre flottant.

Déplacement du panneau Navigation vers un nouveau dock ; cette opération est indiquée par une surbrillance verticale bleue.

Panneau Navigation dans son propre dock

Vous pouvez faire en sorte que les panneaux n’occupent pas la totalité de l’espace disponible dans un dock. Faites glisser le bord inférieur du
dock vers le haut de sorte qu’il ne coïncide plus avec le bord de l’espace de travail.

Déplacement de panneaux

Lorsque vous déplacez des panneaux, des zones de largage en surbrillance bleue apparaissent : il s’agit des zones dans lesquelles vous pouvez
déplacer le panneau. Vous pouvez, par exemple, déplacer un panneau vers le haut ou vers le bas en le faisant glisser sur la fine zone de largage
bleue située au-dessus ou sous un autre panneau. Si vous faites glisser le panneau vers un emplacement autre qu’une zone de largage, ce
dernier flotte dans l’espace de travail.

la position de la souris active la zone de largage (au lieu de la position du panneau). Si la zone de largage ne s’affiche pas, faites
glisser la souris à l’emplacement où devrait se situer la zone de largage.

Pour déplacer un panneau, faites-le glisser en cliquant sur son onglet.

Pour déplacer un groupe de panneaux, faites glisser la barre de titre.

La fine zone de largage bleue indique que le panneau Couleur va être ancré seul au-dessus du groupe de panneaux Calques.

A. Barre de titre B. Tabulation C. Zone de largage 

Pour empêcher l’ancrage d’un panneau, appuyez sur la touche Ctrl (Windows) ou Commande (Mac OS) lors de son déplacement. Pour annuler
l’opération, appuyez sur la touche Echap lors du déplacement du panneau.



Remarque :

Ajout et suppression de panneaux

Lorsque vous supprimez tous les panneaux d’un dock, ce dernier disparaît. Vous pouvez créer un dock en déplaçant les panneaux vers le bord
droit de l’espace de travail jusqu’à ce qu’une zone de largage soit visible.

Pour supprimer un panneau, cliquez sur son onglet avec le bouton droit de la souris (Windows) ou en appuyant sur la touche
Contrôle (Mac), puis sélectionnez l’option Fermer ; vous pouvez également le désélectionner dans le menu Fenêtre.

Pour ajouter un panneau, sélectionnez-le dans le menu Fenêtre et ancrez-le à l’emplacement de votre choix.

Manipulation de groupes de panneaux

Pour déplacer un panneau dans un groupe, faites glisser son onglet vers la zone de largage en surbrillance située dans le
groupe.

Ajout d’un panneau à un groupe

Pour réorganiser les panneaux d’un groupe, faites glisser l’onglet du panneau de votre choix vers son nouvel emplacement.

Pour rendre un panneau flottant, faites-le glisser en dehors du groupe au moyen de son onglet.

Pour déplacer un groupe, faites glisser la barre de titre (zone située au-dessus des onglets).

Empilage de panneaux flottants

Lorsque vous faites sortir un panneau de son dock et que vous le placez en dehors de toute zone de largage, ce panneau flotte dans l’espace de
travail. Un panneau flottant peut être placé à n’importe quel endroit dans l’espace de travail. Vous pouvez empiler des panneaux ou groupes de
panneaux flottants de sorte qu’ils se comportent comme une seule entité lorsque vous faites glisser la barre de titre supérieure.

Panneaux empilés flottants

Pour empiler des panneaux flottants, cliquez sur un onglet pour faire glisser le panneau correspondant vers la zone de largage
située au bas d’un autre panneau.

Pour modifier l’ordre d’empilage, cliquez sur un onglet afin de faire glisser le panneau correspondant vers le haut ou vers le
bas.

prenez soin de « déposer » l’onglet sur la zone de largage étroite située entre les panneaux, plutôt que sur la zone de largage large
située dans une barre de titre.

Pour rendre un panneau ou groupe de panneaux de la pile flottant, déplacez-le hors de la pile au moyen de son onglet ou de
sa barre de titre.

Redimensionnement des panneaux
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Pour réduire ou agrandir un panneau, un groupe de panneaux ou une pile de panneaux, cliquez deux fois sur un onglet. Vous
pouvez également double-cliquer sur la zone d’onglets (l’espace vide situé à côté des onglets).

Pour redimensionner un panneau, faites glisser l’un de ses côtés. Cette méthode de redimensionnement ne fonctionne pas
toujours, notamment avec le panneau Couleur de Photoshop.

Réduction et développement des icônes de panneaux

Vous pouvez réduire des panneaux à la taille d’icônes afin de limiter l’encombrement de l’espace de travail. Dans certains cas, les panneaux sont
réduits de la sorte dans l’espace de travail par défaut.

Panneaux réduits à la taille d’icônes

Panneaux agrandis

Pour réduire ou développer toutes les icônes de panneau d’une colonne, cliquez sur la double flèche située dans la partie
supérieure du dock.
Pour développer une seule icône de panneau, cliquez sur cette dernière.
Pour redimensionner les icônes de panneau afin de voir les icônes uniquement (et non les libellés), réglez la largeur du dock
jusqu’à ce que le texte ne soit plus visible. Pour afficher à nouveau le texte, augmentez la largeur du dock.
Pour réduire à la taille d’une icône un panneau qui a été développé, cliquez sur son onglet, sur son icône ou sur la double
flèche affichée dans sa barre de titre.

Dans certaines applications, si vous sélectionnez l’option Réduire automatiquement les panneaux d’icônes dans les préférences d’interface ou
les options d’interface utilisateur, une icône de panneau développée est réduite automatiquement lorsque vous cliquez en dehors de cette
dernière.

Pour ajouter un panneau flottant ou un groupe de panneaux à un dock d’icônes, faites-le glisser au moyen de son onglet ou
de sa barre de titre (les panneaux sont réduits automatiquement à la taille d’icônes lorsque vous les ajoutez à un dock
d’icônes).

Pour déplacer une icône de panneau (ou un groupe d’icônes de panneau), faites-la glisser. Vous pouvez déplacer des icônes
de panneau vers le haut et vers le bas dans le dock, dans d’autres docks (elles apparaissent dans le style du panneau de ce
dock) ou en dehors du dock (elles apparaissent sous la forme d'icônes flottantes).

Enregistrement et basculement d’un espace de travail à l’autre

En enregistrant la taille et la position actuelles des panneaux comme espace de travail nommé, vous gardez la possibilité de restaurer cet espace
par la suite, et ce, même si vous avez déplacé ou fermé un panneau. Les noms des espaces de travail enregistrés sont visibles dans le sélecteur
d’espace de travail de la barre d’application.



Position des panneaux

Raccourcis clavier

Menus ou Personnalisation des menus

Remarque :

Enregistrement d’un espace de travail personnalisé

1. Lorsque l’espace de travail se trouve dans la configuration que vous souhaitez enregistrer, utilisez l’une des méthodes
suivantes :

(Illustrator) Choisissez la commande Fenêtre > Espace de travail > Enregistrer l’espace de travail.

(Photoshop, Illustrator, InCopy) Choisissez la commande Fenêtre > Espace de travail > Nouvel espace de travail.

(Dreamweaver) Choisissez la commande Fenêtre > Présentation de l’espace de travail > Nouvel espace de travail.

(Flash) Choisissez la commande Nouvel espace de travail dans le sélecteur d’espace de travail de la barre d’application.

(Fireworks) Choisissez la commande Enregistrer la présentation active dans le sélecteur d’espace de travail de la barre
d’application.

2. Attribuez un nom à l’espace de travail.

3. (Photoshop, InDesign) Sélectionnez ensuite une ou plusieurs options dans la section Capture :

Enregistre la position actuelle des panneaux (InDesign uniquement).

Enregistre l’ensemble de raccourcis clavier actuel (Photoshop seulement).

Enregistre l’ensemble de menus actuels.

Affichage de l’espace de travail ou basculement d’un espace de travail à l’autre

Sélectionnez un espace de travail dans le sélecteur d’espace de travail de la barre d’application.

Dans Photoshop, vous pouvez attribuer un raccourci clavier à chacun des espaces de travail pour pouvoir passer de l’un à l’autre plus
rapidement.

Suppression d’un espace de travail personnalisé

Choisissez l’option Gérer les espaces de travail dans le sélecteur d’espace de travail de la barre d’application, sélectionnez
l’espace de travail, puis cliquez sur la commande Supprimer. (Cette option n’est pas disponible dans Fireworks.)

(Photoshop, InDesign, InCopy) Sélectionnez la commande Supprimer l’espace de travail dans le sélecteur d’espace de travail.

(Illustrator) Choisissez la commande Fenêtre > Espace de travail > Gérer les espaces de travail, sélectionnez l’espace de
travail, puis cliquez sur l’icône Supprimer.

(Photoshop, InDesign) Choisissez la commande Fenêtre > Espace de travail > Supprimer l’espace de travail, sélectionnez
l’espace de travail, puis cliquez sur le bouton Supprimer.

Restauration de l’espace de travail par défaut

1. Sélectionnez l’espace de travail de base ou par défaut à l’aide du sélecteur situé dans la barre d’application. Pour Fireworks,
consultez l’article http://www.adobe.com/devnet/fireworks/articles/workspace_manager_panel.html.

dans Dreamweaver, Designer correspond à l’espace de travail par défaut.

2. Pour Fireworks (Windows), supprimez les dossiers suivants :

Windows Vista

\\utilisateur\<nom utilisateur>\AppData\Roaming\Adobe\Fireworks CS4\

Windows XP

\\Documents and Settings\<nom utilisateur>\Application Data\Adobe\Fireworks CS4

http://www.adobe.com/devnet/fireworks/articles/workspace_manager_panel.html
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Mode de présentation 
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3. (PhotoShop, InDesign, InCopy) Choisissez la commande Fenêtre > Espace de travail > Réinitialiser [Nom de l’espace de
travail].

(Photoshop) Restauration d'une disposition d’espace de travail enregistrée

Dans Photoshop, les espaces de travail s’affichent automatiquement en fonction de leur dernière disposition, mais vous pouvez restaurer la
disposition d’origine des panneaux.

Pour restaurer un espace de travail individuel, sélectionnez Fenêtre > Espace de travail > Réinitialiser Nom de l’espace de
travail.

Pour restaurer tous les espaces de travail installés avec Photoshop, cliquez sur Restaurer les espaces de travail par défaut
dans les préférences d’interface.

Pour réorganiser l’ordre des espaces de travail de la barre d’application, faites-les glisser.

A propos des modes d’affichage

Vous pouvez modifier le mode d’affichage de la fenêtre de document à l’aide des boutons Mode situés en bas du panneau Outils ou à l’aide des
commandes du menu Affichage > Mode écran. Lorsque le panneau Outils s’affiche sur une seule colonne, vous pouvez changer le mode
d’affichage en cliquant sur le bouton correspondant au mode actif, puis en sélectionnant un autre mode dans le menu qui s’affiche.

Affiche les illustrations dans une fenêtre standard faisant apparaître l’ensemble des repères et des grilles visibles, les objets non
imprimables et une table de montage blanche.

Affiche les illustrations dans leur version finale : les éléments non imprimables (repères, grilles et objets non imprimables) sont
masqués et la couleur de l’arrière-plan pour l’aperçu de la table de montage est celle définie dans la boîte de dialogue Préférences.

Affiche les illustrations dans leur version finale : les éléments non imprimables (repères, grilles et objets non imprimables)
sont masqués, la couleur de l’arrière-plan pour l’aperçu de la table de montage est celle définie dans la boîte de dialogue Préférences et tous les
éléments imprimables de la zone de fond perdu du document (définie dans la boîte de dialogue Format de document) s’affichent.

Affiche les illustrations dans leur version finale : les éléments non imprimables (repères, grilles et objets non imprimables) sont
masqués, la couleur de la table de montage correspond à la couleur d’arrière-plan pour l’aperçu définie dans la boîte de dialogue Préférences, et
tous les éléments imprimables de la zone de ligne-bloc du document (définie dans la boîte de dialogue Format de document) sont affichés.

Affiche les illustrations à la manière d’une présentation de type diaporama, sans menus, panneaux, ni outils. Voir la
section Utilisation du mode de présentation.

Utilisation de la barre d’état

La barre d’état (en bas à gauche de la fenêtre de document) affiche des informations sur l’état d’un fichier et vous permet de changer de page.
Cliquez sur le menu de la barre d’état pour effectuer les opérations suivantes :

Afficher le fichier actif dans le système de fichiers en choisissant l’option Faire apparaître dans l’Explorateur (Windows®) ou
Faire apparaître dans le Finder (Mac OS®).

http://idiom-q-win-1/fr/indesign/using/dynamic-pdf-documents.html#use_presentation_mode
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Afficher le fichier actuel dans Adobe® Bridge® en choisissant Révéler dans Bridge.

Afficher le fichier actuel dans Adobe Mini Bridge en choisissant Faire apparaître dans Mini Bridge.

Sous Mac OS, vous pouvez afficher le facteur de zoom dans la barre d’état en masquant la barre de l’application (commande Fenêtre > Barre
de l’application). Sous Windows, il est impossible de masquer la barre de l’application.

Présentation du panneau Contrôle

Le panneau Contrôle (Fenêtre > Contrôle) propose un accès rapide aux options, commandes et autres panneaux liés à l’élément ou à l’objet de
page sélectionné. Par défaut, ce panneau est ancré en haut de la fenêtre de document. Vous pouvez toutefois l’ancrer au bas de la fenêtre, le
convertir en un panneau flottant ou encore le masquer.

Les options s’affichant dans le panneau Contrôle varient selon le type d’objet sélectionné :

Lorsque vous sélectionnez un bloc, le panneau Contrôle affiche les options relatives au redimensionnement, au
repositionnement, à l’inclinaison et à la rotation du bloc ou les options d’application d’un style d’objet.

Lorsque vous sélectionnez du texte à l’intérieur d’un bloc, le panneau Contrôle affiche des options de paragraphe ou de
caractère. Cliquez sur les icônes de paragraphe ou de caractère situées sur la partie gauche du panneau Contrôle pour
afficher les options correspondantes. Si la taille et la résolution de votre moniteur le permettent, le panneau Contrôle affiche
des options supplémentaires. Par exemple, si l’icône des caractères est sélectionnée, toutes les options de caractère
s’affichent et certaines options de paragraphe apparaissent sur la partie droite du panneau Contrôle. Si vous cliquez sur l’icône
des paragraphes, toutes les options de paragraphe s’affichent et certaines options de caractère apparaissent sur la droite.

Lorsque vous sélectionnez une cellule de tableau, le panneau Contrôle affiche les options de redimensionnement des lignes et
des colonnes, de fusion des cellules, d’alignement de texte et d’ajout de contours.

A mesure que les options apparaissent dans le panneau Contrôle, vous obtenez des informations complémentaires sur chaque option grâce aux
info-bulles (descriptions succinctes qui s’affichent lorsque vous vous attardez avec le pointeur sur une icône ou sur un nom d’option).

Panneau Contrôle et info-bulle

Menu du panneau Contrôle

Pour ouvrir les boîtes de dialogues associées au panneau Contrôle, maintenez enfoncée la touche Alt (Windows) ou Option (Mac OS) tout en
cliquant sur une icône du panneau Contrôle. Par exemple, lorsque vous avez sélectionné un bloc, maintenez enfoncée la touche Alt ou Option et
cliquez sur l’icône Angle de rotation  pour ouvrir la boîte de dialogue Rotation.

Pour afficher le menu du panneau

Cliquez sur l’icône  située à droite du panneau Contrôle.
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Info-bulles

Afficher les vignettes à l’importation

Afficher les valeurs de transformation

Activer le mouvement tactile multipoint

Pour ancrer le panneau Contrôle ou le transformer en panneau flottant

Utilisez l’une des méthodes suivantes :

Faites glisser la barre verticale à gauche du panneau Contrôle jusqu’à ce qu’il soit ancré en haut ou en bas de la fenêtre
d’application (Windows) ou de l’écran (Mac OS).

Choisissez la commande Ancrer en haut, Ancrer en bas ou Flottant dans le menu du panneau Contrôle.

Pour personnaliser le panneau Contrôle

1. Choisissez la commande Personnaliser dans le menu situé sur le côté droit du panneau Contrôle.

2. Définissez les options à afficher ou à masquer, puis cliquez sur le bouton OK.

A propos du panneau Navigation

Si les versions précédentes d’InDesign vous sont familières, vous serez peut-être étonné de ne pas trouver le panneau Navigation. Sachez que le
panneau Navigation ne figure pas dans InDesign CS5. Il est désormais remplacé par une fonction de zoom très efficace Voir la section Pour
utiliser le zoom .

Utilisation des menus contextuels

A la différence des menus qui s’affichent dans la partie supérieure de l’écran, les menus contextuels se composent de commandes liées à l’outil
actif ou à la sélection. Vous pouvez les utiliser pour accéder rapidement aux commandes les plus courantes.

1. Placez le pointeur sur le document, l’objet ou le panneau.

2. Cliquez avec le bouton droit de la souris.

(Mas OS) si vous ne disposez pas d’une souris à deux boutons, vous pouvez afficher les menus contextuels en appuyant sur la
touche Contrôle et en cliquant avec la souris.

Modification des préférences de l’interface

1. Choisissez la commande Edition > Préférences > Interface (Windows) ou InDesign > Préférences > Interface (Mac OS).

2. Choisissez les paramètres qui vous intéressent et cliquez sur le bouton OK.

Les info-bulles apparaissent lorsque vous placez le pointeur de la souris sur des éléments d’interface tels que les outils de la barre
d’outils ou les options du panneau Contrôle. Choisissez l’option Sans pour désactiver les info-bulles.

Lorsque vous importez un graphique, une vignette représentant l’image apparaît dans le curseur de
graphique chargé. De la même façon, le curseur de texte chargé contient une vignette représentant les premières lignes de texte. Si vous ne
voulez pas afficher ces vignettes lors de l’importation de graphiques ou de texte, désélectionnez cette option.

Lorsque vous créez, redimensionnez ou faites pivoter un objet, le curseur affiche les coordonnées [x,y]
et d’autres détails tels que la largeur, la hauteur ou la rotation.

Sélectionnez cette option pour faire en sorte que les entrées tactiles multipoints à l’aide de la souris
mises en œuvre sous Windows  et Mac OS fonctionnent dans InDesign. Par exemple, avec la souris Magic Mouse (Mac OS), un mouvement de
balayage permet de faire défiler l’affichage vers le haut ou vers le bas, d’afficher la page ou planche suivante ou précédente, tandis qu’un
mouvement de rotation fait pivoter la planche.

http://idiom-q-win-1/fr/indesign/using/viewing-workspace.html#use_power_zoom
http://idiom-q-win-1/fr/indesign/using/viewing-workspace.html#use_power_zoom
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Mettre en surbrillance l’objet sélectionné par l’outil Sélection

Panneau d’outils flottant

Réduire automatiquement les panneaux d’icônes

Afficher automatiquement les panneaux masqués

Ouvrir les documents en tant qu’onglets

Activer l’ancrage des fenêtres de document flottantes

Outil Main

Régénération dynamique de l’écran

Sélectionnez cette option pour mettre en surbrillance les contours des objets
lorsqu’ils sont survolés par l’outil Sélection directe.

Cette option permet de préciser si la barre d’outils doit se présenter comme une seule colonne, deux colonnes
accolées ou une seule ligne.

Lorsque cette option est sélectionnée, il suffit de cliquer dans la fenêtre du document pour
fermer automatiquement le panneau ouvert.

Lorsque vous masquez des panneaux en appuyant sur la touche de tabulation, vous pouvez
les réafficher de façon temporaire en maintenant le pointeur de la souris sur le côté de la fenêtre du document. En revanche, si cette option n’est
pas sélectionnée, vous devez appuyer à nouveau sur la touche de tabulation pour afficher les panneaux.

Lorsque cette option est désélectionnée, les documents que vous créez ou ouvrez apparaissent
comme des fenêtres flottantes et non comme des fenêtres à onglets.

Si vous sélectionnez cette option, vous pouvez ancrer ensemble des documents
flottants sous forme de fenêtres à onglets. Lorsque cette option est désélectionnée, les fenêtres de document flottantes ne sont pas ancrées les
unes aux autres, à moins que vous ne mainteniez la touche Ctrl (Windows) ou Commande (Mac OS) enfoncée lorsque vous les faites glisser.

Pour savoir s’il faut créer du faux texte et de fausses images lorsque vous faites défiler un document, faites glisser le curseur de
l’outil Main vers le niveau de performance souhaité par opposition à la qualité.

Sélectionnez une option pour déterminer si l’image est régénérée ou non lorsque vous faites glisser un
objet. Si vous choisissez l’option Immédiatement, l’image est régénérée lors du glissement. En revanche, si vous choisissez l’option Jamais, seul
le bloc est déplacé lorsque vous faites glisser une image. L’image ne l’est qu’au moment où vous relâchez le bouton de la souris. L’option En
différé permet, quant à elle, de régénérer l’image uniquement lors d’une pause avant le glissement. Cette option fonctionne de la même manière
que dans InDesign CS4.

Adobe recommande également

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr
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A propos des préférences et des paramètres par défaut
Définition des préférences générales
Définition de paramètres par défaut
Rétablissement de l’ensemble des préférences et des paramètres par défaut
A propos des styles et des paramètres prédéfinis InDesign

A propos des préférences et des paramètres par défaut
Les préférences se composent de paramètres tels que l’emplacement des panneaux, les options de mesure et les options d’affichage des
graphiques et des caractères typographiques. Vous pouvez définir les paramètres des documents et des objets InDesign en modifiant les
préférences.

Définition des préférences générales
Cette section décrit les paramètres de préférence de l’onglet Général de la boîte de dialogue Préférences. Pour plus de détails sur les autres
préférences, recherchez le paramètre approprié.

1. Choisissez la commande Edition > Préférences > Général (Windows) ou InDesign > Préférences > Général (Mac OS), puis
sélectionnez le type de préférences que vous souhaitez définir.

2. Choisissez une méthode de numérotation de pages dans le menu Affichage de la section Numérotation des pages (voir la
section Pour afficher une numérotation absolue ou par section dans le panneau Pages).

3. Dans la section Téléchargement et incorporation de polices, spécifiez un seuil pour créer un jeu de polices partiel d’après le
nombre de glyphes dans la police. Ce paramètre agit sur les options de téléchargement des polices dans les boîtes de
dialogue d’impression et d’exportation.

4. Dans la section Lors de la mise à l’échelle, vous pouvez spécifier le mode de présentation des objets mis à l’échelle dans les
panneaux et le comportement du contenu des blocs ainsi redimensionnés.

Sélectionnez l’option Appliquer au contenu si vous souhaitez que le corps soit modifié lors de la mise à l’échelle du bloc
de texte (voir la section Mise à l’échelle du texte). Si cette option est activée lorsqu’un bloc graphique est mis à l’échelle,
le pourcentage de taille de l’image change, mais celui du bloc revient à 100 % (voir la section Mise à l’échelle d’objets).

Sélectionnez Ajuster le pourcentage de mise à l’échelle pour faire apparaître le corps d’origine avec le nouveau corps
entre parenthèses lorsque vous mettez le texte à l’échelle. Si cette option est sélectionnée lorsque vous mettez à l’échelle
les blocs graphiques, le pourcentage de taille du bloc et de l’image sont tous les deux modifiés.

5. Cliquez sur Réinitialiser tous les messages d’avertissement pour afficher tous les avertissements, y compris ceux que vous
avez déjà choisis de ne pas afficher (un message d’avertissement s’affiche. Activez la case à cocher pour éviter que ce
message ne réapparaisse).

Définition de paramètres par défaut
Si vous modifiez des paramètres alors qu’aucun document n’est ouvert, les nouveaux paramètres deviennent les paramètres par défaut des
nouveaux documents. Si vous modifiez des paramètres alors qu’un document est ouvert, les modifications s’appliquent uniquement à ce
document.

De la même façon, si vous modifiez des paramètres alors qu’aucun objet n’est sélectionné, les nouveaux paramètres deviennent les paramètres
par défaut des nouveaux objets.

Pour modifier les paramètres par défaut des nouveaux documents
1. Fermez tous les documents.
2. Modifiez les paramètres souhaités au niveau des options de menu, des panneaux et des boîtes de dialogue.

Si vous utilisez le même format de page ou la même langue pour la plupart de vos documents, vous pouvez modifier les paramètres par défaut
correspondants en vous assurant qu’aucun document n’est ouvert. Par exemple, pour modifier le format de page par défaut, fermez tous les
documents, choisissez Fichier > Format de document, puis sélectionnez le format souhaité. Pour définir un dictionnaire par défaut, fermez tous
les documents, choisissez Edition > Préférences > Dictionnaire (Windows) ou InDesign > Préférences > Dictionnaire (Mac OS) et sélectionnez
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une option dans le menu Langue.

Pour définir les paramètres par défaut des nouveaux objets dans un document
1. Vérifiez qu’un document est ouvert, puis choisissez Edition > Tout désélectionner.
2. Modifiez les paramètres souhaités au niveau des options de menu, des panneaux et des boîtes de dialogue.

Rétablissement de l’ensemble des préférences et des paramètres par défaut
Dans les cas où InDesign se comporte de façon imprévisible, la suppression des préférences est souvent un bon moyen de résoudre le problème.

Il est judicieux d’effectuer une copie de sauvegarde des fichiers de préférences nommés InDesign Defaults et InDesign SavedData. Ainsi, plutôt
que de supprimer vos préférences, vous pouvez copier ces fichiers de sauvegarde sur les fichiers de préférences erronés sans perdre vos
paramètres personnalisés.

Mike Witherell propose une liste détaillée des fichiers affectés par la restauration des préférences ; cette liste figure dans le document au
format PDF intitulé Adobe InDesign Presets (en anglais uniquement).

 Utilisez l’une des méthodes suivantes :

(Windows) Lancez InDesign et appuyez sur les touches Maj+Ctrl+Alt. Cliquez sur le bouton Oui lorsque vous êtes invité à
supprimer vos fichiers de préférences.

(Mac OS) Lancez InDesign tout en appuyant sur les touches Maj+Option+Commande+Contrôle. Cliquez sur le bouton Oui
lorsque vous êtes invité à supprimer vos fichiers de préférences.

Un grand nombre de préférences et de paramètres par défaut de programme sont stockés dans les fichiers de préférences Adobe InDesign. Ces
fichiers, y compris le fichier InDesign Defaults, sont sauvegardés à chaque fois que vous quittez InDesign. Pour une suppression manuelle ou un
changement de nom, les emplacements des fichiers de préférences sont les suivants :

Mac OS

InDesign SavedData Users/[utilisateur]/Library/Caches/Adobe InDesign/Version [version]/InDesign SavedData

InDesign Defaults Users/[utilisateur]/Library/Preferences/Adobe InDesign/Version [version]/InDesign Defaults

Windows XP

InDesign SavedData \Documents and Settings\[nom d’utilisateur]\Local Settings\Application Data\Adobe\InDesign\Version
[version]\Caches

InDesign Defaults \Documents and Settings\[nom d’utilisateur]\Application Data\Adobe\InDesign\Version [version]

Windows Vista ou Windows 7

InDesign SavedData Users\[nom d’utilisateur]\AppData\Roaming\Adobe\InDesign\Version [version]\Caches\InDesign
SavedData

InDesign Defaults C:\Users\[nom d’utilisateur]\AppData\Roaming\Adobe\InDesign\Version [version]\InDesign Defaults

A propos des styles et des paramètres prédéfinis InDesign
Il est possible d’enregistrer des paramètres pour les réutiliser ultérieurement. Vous pouvez notamment enregistrer les paramètres définis lors des
procédures suivantes :

Création de styles de paragraphe et de caractère (voir la section Ajout de styles de paragraphe et de caractère).

Création de styles d’objets (voir la section Styles d’objet).

Création de styles de tableau et de cellule (voir la section Styles de tableau et de cellule).

Création de paramètres d’exportation PDF prédéfinis (voir la section Personnalisation des paramètres prédéfinis Adobe PDF).

Création de paramètres d’impression prédéfinis. Tous les attributs de la boîte de dialogue d’impression figurent dans un style
d’impression (voir la section Impression d’un document ou d’un livre).

Création de paramètres de recouvrement prédéfinis (voir la section Recouvrement des couleurs).

Création de paramètres d’aplatissement des transparences prédéfinis (voir la section Aplatissement d’une illustration avec
transparence).

Création de styles de tables des matières (voir la section Création de styles de tables des matières pour plusieurs listes).

Enregistrement de la configuration de l’espace de travail.

Création de paramètres prédéfinis de document (voir la section Définition de paramètres prédéfinis de document).

Création de styles de contour (voir la section Définition de styles de contour personnalisés).

http://www.indesignusergroup.com/chapters/washingtondc/files/729/21_presets-Mike_Witherell.pdf


 

En général, il suffit de modifier les paramètres de la fonction dans la boîte de dialogue correspondante et de les enregistrer. Les styles et les
paramètres prédéfinis sont enregistrés dans le document dans lequel ils ont été créés. Vous pouvez utiliser les paramètres d’un autre document
en important ou en chargeant les styles et les paramètres prédéfinis de ce document. En outre, vous pouvez exporter ou enregistrer la plupart des
paramètres prédéfinis dans un fichier séparé et les distribuer sur d’autres ordinateurs.

Mike Witherell propose une liste détaillée de paramètres prédéfinis dans le document au format PDF intitulé Adobe InDesign Presets (en anglais
uniquement).

De même, vous pouvez partager les styles et les paramètres prédéfinis dans les documents d’un livre. Pour plus de détails, voir la section
Synchronisation des documents de livre.
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Flux de production recommandé pour les documents InDesign
Ouverture de documents InDesign
Conversion de documents InDesign créés à l’aide de versions antérieures
Utilisation d’Adobe Bridge avec InDesign
Adobe Version Cue
Utilisation de modèles de document
Révision des documents InDesign
Création de calendriers et de cartes de visite à partir de modèles

Flux de production recommandé pour les documents InDesign

Vous pouvez améliorer vos performances et prévenir tout problème en mettant en œuvre un bon flux de production à utiliser avec Adobe
InDesign.

Pour conserver un système informatique en bon état

Avec le temps, des modifications affectent les logiciels et le matériel de votre système et peuvent entraîner des pertes de performances et des
défaillances. La défragmentation de disque dur, la suppression des anciennes versions de logiciels, la mise à jour des pilotes de périphériques,
l’optimisation de la mémoire, l’exécution des utilitaires de protection contre les virus, ainsi que d’autres tâches de maintenance courantes sont
autant d’opérations permettant d’éviter que vos applications et vos fichiers ne soient endommagés. L’exécution régulière de ces tâches garantit
une ouverture, un affichage et une impression correcte des documents sous InDesign.

Pour créer un dossier de projet

Lorsque vous débutez un projet, déterminez de quels fichiers vous allez avoir besoin et comment vous allez les stocker. Pour éviter tout problème
d’interruption des liens, il peut s’avérer judicieux de garder les fichiers liés dans le même dossier que le document. En effet, InDesign conserve les
liens vers les fichiers que vous importez dans un document, mais si un lien est rompu, InDesign recherche le fichier dans le dossier du document.
En stockant un document et ses fichiers liés dans un même dossier, vous facilitez leur transfert d’un ordinateur vers un autre. En stockant les
fichiers dans un seul dossier, vous vous assurez également qu’InDesign trouve les éléments graphiques d’origine lors de l’impression d’un
document. Si InDesign ne peut pas localiser un graphique lié, les modifications apportées au graphique d’origine seront perdues et l’impression du
graphique risque d’être insuffisante voire impossible.

Si votre projet comprend plusieurs documents (par exemple, les chapitres d’un livre), il pourra être utile de créer un dossier de projet contenant un
dossier pour chaque document et ses fichiers liés.

Pour utiliser un modèle

Utilisez un modèle si vous créez fréquemment des projets similaires. Les modèles vous permettent de créer des documents homogènes plus
rapidement tout en assurant la protection de votre fichier d’origine. Par exemple, si vous créez une lettre d’informations mensuelle, votre modèle
pourrait inclure des repères de règle, des numéros de page, l’en-tête de votre lettre et les styles que vous voulez utiliser à chaque nouvelle
parution. (Voir Utilisation de modèles de document.)

Pour ouvrir les documents en local

Avant d’ouvrir un document stocké sur un volume réseau ou sur un support amovible, copiez le document et tout graphique lié sur votre disque
dur local. Le taux de transfert des données et les temps d’accès plus lents d’un volume réseau ou d’un support amovible peuvent occasionner la
perte de données ou leur corruption, endommageant ainsi le document. Vous devez toutefois garder à l’esprit que vous risquez d’écraser le travail
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effectué par l’un de vos collègues lorsque vous copiez à nouveau les fichiers locaux sur le serveur de réseau.

Pour résoudre les problèmes avant de convertir un fichier

Généralement, des fichiers Adobe PageMaker ou QuarkXPress® endommagés le restent lorsqu’ils sont ouverts dans InDesign. Si une erreur ou
un autre événement inopiné se produit avec un fichier converti, ouvrez le fichier d’origine dans l’application source et tentez de réparer tous les
problèmes qu’il peut contenir.

Si le fichier converti pose problème, exportez-le au format IDML, ouvrez le fichier IDML, puis enregistrez-le au format de document InDesign.

Pour enregistrer des documents

Enregistrez vos documents fréquemment et créez des copies de sauvegarde des fichiers importants. Vous pouvez effacer toutes les données
inutiles d’un document à l’aide de la commande Enregistrer sous. Lorsque vous utilisez la commande Enregistrer, InDesign ajoute de nouvelles
informations au document mais ne supprime pas les données obsolètes, telles que les informations sur les graphiques supprimés, par exemple.
Toutefois, lorsque vous utilisez la commande Enregistrer sous, InDesign réécrit totalement le document, en incluant uniquement les informations
sur les objets et les pages qui figurent actuellement dans le document. Un document ne contenant que les données nécessaires occupe moins
d’espace sur le disque dur ; il s’ouvre, s’actualise et s’imprime plus rapidement.

Pour adopter de bonnes méthodes de conception

Créez des styles dans un document. La création de styles sans document ouvert peut provoquer l’apparition de doublons de
styles lorsque vous créez un nouveau document. Pour partager des styles entre plusieurs documents, enregistrez les styles et
chargez-les.

Utilisez des polices adéquates. Lorsque vous choisissez des polices pour un document, pensez à la façon dont vous voulez
mettre en forme et imprimer le texte. InDesign donne de bons résultats avec les polices OpenType®, Type 1 (également
appelées PostScript) et TrueType. Les polices corrompues ou incomplètes peuvent endommager un document InDesign ou
produire une impression incorrecte. Il est donc conseillé d’utiliser des polices fiables créées par des éditeurs de renom. Si vous
travaillez avec un prestataire de services, vérifiez quelles polices il utilise.

Essayez de ne pas utiliser trop de blocs de texte. Utilisez aussi peu de blocs de texte que possible afin de conserver une taille
de fichier de document réduite et une mise en page simple à gérer.

Pour utiliser les meilleurs formats graphiques

Utilisez le format de fichier graphique le plus approprié. Lorsque vous créez des graphiques pour un projet, pensez à la façon
dont vous allez imprimer le document. Si vous envisagez de faire imprimer votre document auprès d’un prestataire,
demandez-lui quels formats graphiques sont compatibles avec les périphériques de sortie qu’il utilise. Le prestataire de
services d’impression peut également vous conseiller sur la meilleure résolution d’images à adopter.

Stockez vos fichiers graphiques en externe. Lorsque vous importez un fichier graphique, InDesign créé un lien vers celui-ci par
défaut. La création de lien contribue à minimiser la taille de fichier du document, améliorant ainsi les performances d’InDesign.
Lorsque vous imprimez le document, le fichier graphique d’origine doit être disponible et le lien non rompu. Si InDesign ne peut
pas trouver le fichier d’origine, le graphique s’imprimera sous forme d’aperçu en faible résolution ou de zone grisée.

Pour vérifier les liens et les polices avant d’imprimer

Pour vous assurer qu’un document s’imprimera correctement, vérifiez que tous les liens sont intacts et que toutes les polices sont disponibles. Un
lien est rompu lorsque vous supprimez, déplacez ou renommez le fichier graphique d’origine. Utilisez les fonctions Contrôle en amont et
Assemblage avant d’envoyer vos fichiers à votre prestataire de services d’impression.

Ouverture de documents InDesign

La méthode d’ouverture de documents et de modèles est généralement identique à celle utilisée dans les autres applications. Lorsque vous ouvrez
un modèle InDesign, celui-ci s’ouvre par défaut sous la forme d’un nouveau document sans titre. Les extensions des différents types de fichiers
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sont les suivantes : .indd pour les documents, .indt pour les modèles, .idms pour les extraits, .indl pour les bibliothèques, .inx pour les fichiers
d’échange, .idml pour les fichiers de balisage et .indb pour les livres.

Vous pouvez également utiliser la commande Fichier > Ouvrir pour consulter les fichiers créés à l’aide de versions antérieures d’InDesign, les
fichiers InDesign Interchange (.inx), les fichiers InDesign Markup (.idml), les fichiers Adobe PageMaker 6.0 et versions ultérieures, les fichiers
QuarkXPress 3.3 et 4.1, ainsi que les fichiers QuarkXPress Passport 4.1. De plus, il est probable que d’autres fournisseurs de logiciels proposent
des modules externes reconnaissant divers autres formats de fichiers.

Pour afficher des informations supplémentaires à propos d’un document InDesign, choisissez la commande Aide > A propos d’InDesign tout en
maintenant la touche Ctrl enfoncée (Windows) ou choisissez la commande InDesign > A propos d’InDesign tout en maintenant la
touche Commande enfoncée (Mac OS).

Utilisation de la commande Ouvrir

1. Choisissez Fichier > Ouvrir et sélectionnez un ou plusieurs documents.

2. Utilisez l’une des méthodes suivantes, puis cliquez sur Ouvrir :

Sélectionnez Normal (Windows) ou Ouvrir normal (Mac OS) pour ouvrir le document original ou une copie de modèle.

Sélectionnez Original (Windows) ou Ouvrir original (Mac OS) pour ouvrir un document ou un modèle original.

Sélectionnez Copie (Windows) ou Ouvrir copie (Mac OS) pour ouvrir une copie de document ou de modèle.

Lorsque vous ouvrez un document InDesign, vous pouvez rencontrer les messages suivants :

Message signalant une version plus récente d’InDesign

Dans InDesign CS6 et CC, vous pouvez envoyer des documents à toute personne utilisant des versions antérieures d’InDesign sans exportation
manuelle au format IDML ni autres étapes supplémentaires. La compatibilité est intégrée, afin que vos documents s’ouvrent toujours correctement.

Si vous ouvrez un document créé dans une version plus récente d’InDesign, un message s’affiche et indique cette version. Pour convertir le
document dans la version actuelle d’InDesign, procédez comme suit :

1. Pour convertir le document dans la version actuelle d’InDesign, cliquez sur Convertir.

Le document est téléchargé sur Adobe Creative Cloud puis converti dans la version actuelle d’InDesign.

vous devez être connecté à Internet pour effectuer la conversion.

2. Lorsqu’un document a été converti au format de la version actuelle, la boîte de dialogue Enregistrer sous vous invite à
enregistrer le document.

Message signalant une différence entre les paramètres de couleur du document et ceux de l’application

Si un message vous signale que les paramètres de couleurs du document ne correspondent pas à ceux de l’application, sélectionnez une option
et cliquez sur le bouton OK.

les messages d’avertissement relatifs aux couleurs sont désactivés par défaut, mais vous pouvez afficher les avertissements en
modifiant les paramètres par défaut dans la boîte de dialogue Couleurs (Edition > Couleurs).

Message signalant un lien manquant ou modifié

Si un message vous signale que le document contient des liens manquants ou modifiés, effectuez toutes les corrections nécessaires à l’aide du
panneau Liens. Voir Mise à jour, restauration et remplacement de liens.

Message signalant des polices manquantes

Si un message d’avertissement vous informe que le document présente des polices manquantes, utilisez l’une des méthodes suivantes :

http://idiom-q-win-1/fr/indesign/using/graphics-links.html#update_restore_and_replace_links
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Cliquez sur OK. InDesign met automatiquement le texte en forme à l’aide d’une police de substitution.

Utilisez la commande Rechercher une police pour rechercher et indiquer les polices utilisées dans le document.

Pour plus d’informations sur la recherche des polices manquantes, voir Recherche et modification de polices.

Ouverture d’un document récent

Choisissez la commande Fichier > Ouvrir une composition récente, puis sélectionnez l’un des derniers documents que vous
avez enregistrés.

Pour préciser le nombre de documents récents à afficher, choisissez la commande Edition > Préférences > Gestion des fichiers (Windows) ou
InDesign > Préférences > Gestion des fichiers, puis donnez une valeur à l’option Nombre d’éléments récents à afficher. Le nombre maximum
est 30.

Choix de listes de mots à l’ouverture des documents

Lorsque vous ouvrez un document, il se peut qu’un message d’avertissement vous demande si vous souhaitez utiliser la liste des exceptions de
césure du dictionnaire personnel ou celle du document. Une liste des césures d’exception inclut les mots qui ont été ajoutés au dictionnaire
utilisateur lors de l’utilisation du document. Si vous savez précisément quelle liste vous devez utiliser, cliquez sur le bouton correspondant. Si vous
hésitez, cliquez sur l’un des deux boutons et choisissez la commande Edition > Orthographe > Dictionnaire pour consulter la liste des exceptions
de césure. Si nécessaire, choisissez ensuite la commande Edition > Préférences > Dictionnaire (Windows) ou InDesign > Préférences >
Dictionnaire (Mac OS) pour réinitialiser la liste des exceptions de césure utilisée pour la composition. Voir Césure et dictionnaires.

Conversion de documents InDesign créés à l’aide de versions antérieures

Pour convertir des documents créés dans des versions antérieures d’InDesign au format de la version actuelle, choisissez la
commande Fichier > Ouvrir, puis ouvrez le fichier.

Tenez compte des points suivants :

Si vous avez utilisé des modules externes tiers pour créer une version antérieure d’un document, vérifiez auprès du
fabricant qu’ils sont correctement installés et compatibles avec InDesign CS5 avant de convertir le document.

Lorsque vous convertissez un document, il se peut qu’un avertissement s’affiche, vous demandant si vous souhaitez
utiliser la liste des césures d’exception du dictionnaire personnel ou celle du document. Pour plus d’informations sur ce
message d’alerte, voir Choix de listes de mots à l’ouverture des documents.

Les fichiers de bibliothèque créés dans des versions antérieures d’InDesign peuvent être ouverts et convertis dans
InDesign CS5, même si la bibliothèque est verrouillée. Vous devez spécifier un nom et un emplacement pour les fichiers
de bibliothèque convertis ; la convention de nom de fichier par défaut est nom de fichier-X.indl.

Les versions précédentes d’InDesign ne peuvent pas ouvrir les derniers documents InDesign directement. Par exemple,
pour ouvrir un document InDesign CS5 dans InDesign CS4, vous devez effectuer deux opérations. Pour commencer,
choisissez Fichier > Exporter dans InDesign CS5 pour enregistrer le document au format IDML. Ensuite, procédez à la
mise à jour d’InDesign CS4 en installant des modules externes spéciaux permettant d’ouvrir le fichier IDML. (Voir
Enregistrement au format de versions précédentes d’InDesign.)

Si vous avez des problèmes avec un document créé dans une version précédente d’InDesign, enregistrez-le au format InDesign Markup
(IDML) dans la boîte de dialogue d’exportation d’InDesign CS5. Ouvrez le fichier IDML et enregistrez-le sous forme de document InDesign.

Utilisation d’Adobe Bridge avec InDesign

Adobe Bridge est une application multiplateforme, comprise dans les composants de la suite Adobe Creative Suite, qui vous aide à localiser, à
organiser et à parcourir les logiciels dont vous avez besoin pour créer des contenus d’impression, Web, vidéo et audio. Vous pouvez lancer
Adobe Bridge à partir de n’importe quel composant de la suite Creative Suite (sauf Adobe Acrobat®) et l’utiliser pour accéder aux types de
fichiers Adobe et autres.

http://idiom-q-win-1/fr/indesign/using/find-change.html#find_and_change_fonts
http://idiom-q-win-1/fr/indesign/using/spell-checking-language-dictionaries.html#hyphenation_and_spelling_dictionaries
http://idiom-q-win-1/fr/indesign/using/saving-documents.html#save_backwards_to_the_previous_indesign_version
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Remarque :

Adobe Bridge permet d’effectuer les opérations suivantes :

Gérer des images, des métrages et des fichiers audio : vous pouvez prévisualiser, rechercher, trier et traiter des fichiers dans
Adobe Bridge sans ouvrir d’applications individuelles. Vous pouvez également modifier des métadonnées de fichiers et utiliser
Adobe Bridge pour importer des fichiers dans vos documents, vos projets et vos compositions.

Visualiser sous forme de vignettes les liens contenus dans un document InDesign, sans qu’il soit nécessaire d’ouvrir ce
document dans InDesign.

Faire glisser des ressources d’Adobe Bridge dans la fenêtre du document InDesign ou faire glisser des ressources de la
fenêtre du document dans Adobe Bridge pour créer des extraits. Voir Utilisation des extraits.

Effectuer des tâches automatisées telles que les commandes de traitement.

Synchroniser les paramètres de couleur entre les composants de la suite Creative Suite, auxquels est appliquée la gestion des
couleurs.

Lancer une conférence Web en temps réel pour partager votre bureau et réviser des documents.

Adobe Version Cue

Adobe Version Cue® et Adobe Drive ne sont pas inclus dans Adobe Creative Suite 5, ni dans aucune version ultérieure d’Adobe Creative Suite.
Adobe poursuit son investissement en matière de gestion d’actifs par le biais de standards industriels ouverts et de partenariats. Pour plus
d’informations, consultez www.adobe.com/go/learn_vc_end_fr.

Utilisation de modèles de document

Un modèle peut être utilisé comme point de départ pour la création de documents standard. En effet, un modèle peut contenir des paramètres de
mise en page, des graphiques et du texte prédéfinis. Par exemple, si vous concevez un magazine mensuel, vous pouvez créer un modèle
contenant les paramètres de mise en page d’un numéro standard, à savoir des repères de règle, des grilles, des gabarits, des nuances et des
styles personnalisés, des blocs de substitution, des calques, ainsi que des graphiques ou du texte standard. Il vous suffit, lors de chaque mise à
jour mensuelle, d’ouvrir le modèle et d’y importer le nouveau contenu.

La procédure de création d’un modèle est identique à celle d’un document standard. La seule différence réside au niveau de l’enregistrement du
document. Lorsque vous préparez un modèle à l’usage d’autres personnes, il peut être utile d’ajouter un calque contenant des instructions sur le
modèle, de masquer ou de supprimer le calque avant d’imprimer le document Voir Calques.

pour les versions chinoises d’InDesign, vous pouvez ouvrir des modèles spécialement conçus incluant des jeux Mojikumi
personnalisés.

Pour enregistrer un document sous la forme d’un modèle

1. Choisissez Fichier > Enregistrer sous et indiquez un emplacement et un nom de fichier.

2. Choisissez Modèle InDesign CS5 dans la zone Type (Windows) ou Format (Mac OS), puis cliquez sur Enregistrer.

Pour créer un document à partir d’un modèle

1. Choisissez Fichier > Ouvrir.

2. Recherchez et sélectionnez un modèle.

3. Sélectionnez Normal (Windows) ou Ouvrir normal (Mac OS), puis cliquez sur Ouvrir.

4. Enregistrez le nouveau document sous son propre nom.

Pour modifier un modèle existant

1. Choisissez Fichier > Ouvrir.

http://idiom-q-win-1/fr/indesign/using/reusing-graphics-text.html#use_snippets
http://www.adobe.com/go/learn_vc_end_fr
http://idiom-q-win-1/fr/indesign/using/layers.html#layers
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2. Recherchez et sélectionnez un modèle.

3. Sélectionnez Original (Windows) ou Ouvrir original (Mac OS), puis cliquez sur Ouvrir.

Révision des documents InDesign

Adobe propose plusieurs méthodes de révision des documents InDesign.

Suivi des modifications d’édition

Lorsque vous ou une autre personne modifiez du texte et que le suivi des modifications est activé, InDesign surligne le texte ajouté et barre le
texte supprimé. Utilisez le mode éditeur pour afficher les modifications. Le propriétaire du document peut parcourir les modifications et les accepter
ou les ignorer. Voir Suivi et révision des corrections.

Utilisation d’Acrobat pour réviser un fichier PDF

Vous pouvez exporter le document InDesign au format PDF et utiliser Adobe Acrobat pour configurer une révision par e-mail ou une révision
partagée sur Acrobat.com ou un autre serveur. Les réviseurs peuvent ajouter des commentaires à l’aide de l’outil d’annotation et des autres
méthodes de marquage. Le propriétaire peut ensuite parcourir les commentaires de révision du PDF et modifier le document InDesign d’origine.
Pour plus de détails, reportez-vous à l’Aide d’Acrobat.

Utilisation de CS Review

CS Review est un service d’abonnement en ligne vous permettant de partager vos créations sur le Web afin que vous puissiez obtenir
immédiatement des commentaires en provenance d’autres utilisateurs. Lorsque vous créez une consultation à l’aide du panneau CS Review,
chargez un ou plusieurs instantanés du fichier dans l’espace de travail Acrobat.com. Les réviseurs peuvent ajouter des commentaires.

Lorsque vous créez une révision, vous pouvez diviser la révision en parties proposant des zones de commentaires distinctes. Une révision peut
consister en parties de divers fichiers et applications. Au fil de la révision, vous pouvez ajouter et supprimer des parties de révision dans le cadre
d’un processus de révision dynamique.

Création de calendriers et de cartes de visite à partir de modèles

L’une des méthodes pour créer des calendriers, des cartes de visite, des curriculum vitae et autres documents spécialisés consiste à utiliser des
modèles.

Adobe fournit plusieurs modèles, disponibles sur le site Adobe Marketplace and Exchange :

www.adobe.com/go/exchange_fr

Utilisez la fonction de recherche afin d’accéder à des ressources supplémentaires concernant des documents spécialisés.

Adobe recommande également
Adobe Bridge
Mini Bridge
CS Review

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr
http://idiom-q-win-1/fr/indesign/using/tracking-reviewing-changes.html#tracking_and_reviewing_changes
http://www.adobe.com/go/exchange_fr
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Personnalisation des menus
Il peut être utile de masquer certaines commandes et d’appliquer une couleur aux commandes que vous utilisez fréquemment pour éviter les
menus surchargés et faciliter l’accès aux commandes. Lorsque vous masquez une commande, celle-ci ne s’affiche plus dans le menu, mais la
fonction correspondante est toujours disponible. Vous pouvez à tout moment faire réapparaître les commandes masquées. Pour ce faire, il vous
suffit de choisir la commande Afficher tous les éléments de menu qui figure en bas de chaque menu ou bien la commande Fenêtre > Espace de
travail > Afficher les menus entiers pour obtenir l’ensemble des menus de l’espace de travail sélectionné. Il est possible d’inclure des menus
personnalisés dans les espaces de travail enregistrés.

Vous pouvez personnaliser le menu principal, les menus contextuels et les menus des panneaux. Pour afficher le menu contextuel, cliquez sur
une zone avec le bouton droit de la souris (Windows) ou en appuyant simultanément sur la touche Contrôle (Mac OS). Pour afficher le menu d’un
panneau, cliquez sur l’icône située dans l’angle supérieur droit du panneau.

Remarque : si vous sélectionnez un espace de travail différent (Prise en main, par exemple), certaines commandes de menu sont masquées.
Pour les afficher, choisissez la commande Afficher tous les éléments de menu qui figure en bas du menu ou sélectionnez un autre espace de
travail (Avancé, par exemple).

Pour créer un ensemble de menus personnalisé
1. Choisissez Edition > Menus.

Il est impossible de modifier l’ensemble de menus par défaut.

2. Cliquez sur Enregistrer sous, saisissez le nom de l’ensemble de menus, puis cliquez sur OK.
3. Dans le menu Catégorie, choisissez la commande Menus de l’application ou Menus contextuels et de panneau pour indiquer

les menus personnalisés.
4. Cliquez sur les flèches situées à gauche des catégories de menu pour afficher des sous-catégories ou des commandes de

menu. Pour chaque commande à personnaliser, cliquez sur l’icône en forme d’œil située sous la zone Visibilité pour afficher
ou masquer la commande et sur Sans sous la zone Couleur pour choisir une couleur dans le menu.

5. Cliquez sur le bouton Enregistrer, puis sur le bouton OK.

Pour sélectionner un ensemble de menus personnalisé
1. Choisissez Edition > Menus.
2. Choisissez l’ensemble de menus dans le menu Ensemble, puis cliquez sur OK.

Pour modifier ou supprimer un ensemble de menus personnalisé
1. Choisissez Edition > Menus.
2. Choisissez l’ensemble de menus dans le menu Ensemble, puis utilisez l’une des méthodes suivantes :

Pour modifier un ensemble de menus, la visibilité ou la couleur de commandes de menu, cliquez sur Enregistrer, puis
sur OK.

Pour supprimer un ensemble de menus, cliquez sur le bouton Supprimer, puis sur le bouton OK. Si vous avez modifié le
menu sans l’avoir enregistré, vous êtes invité à enregistrer l’ensemble de menus actif. Cliquez sur le bouton Oui pour
enregistrer l’ensemble de menus ou sur le bouton Non pour annuler les modifications.

Pour afficher les éléments de menu masqués
Choisissez la commande Fenêtre > Espace de travail > Afficher les menus entiers. Cette commande a pour effet d’activer la
totalité des menus pour l’espace de travail sélectionné. Si vous désirez les masquer à nouveau, il vous suffit de réinitialiser
l’espace de travail.
Choisissez la commande Afficher tous les éléments de menu au bas d’un menu comportant des commandes masquées.

Cliquez sur le nom d’un menu tout en maintenant la touche Ctrl (Windows) ou Commande (Mac OS) enfoncée pour afficher de manière
temporaire les commandes de menu que vous avez choisi de masquer.
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Commandes de menu manquantes
Si vous ne parvenez pas à trouver une commande de menu, il se peut qu’elle soit masquée. Si vous sélectionnez un espace de travail autre que
l’espace Avancé, certaines commandes de menu sont masquées. Il est également possible que vous ou une autre personne ayez utilisé la
commande Menus pour masquer les éléments de menu.

Lorsque la commande que vous cherchez n’est pas visible, utilisez l’une des méthodes suivantes :

Choisissez la commande Afficher tous les éléments de menu, dans la partie inférieure du menu.

Choisissez la commande Fenêtre > Espace de travail > Afficher les menus entiers.

Choisissez Fenêtre > Espace de travail et sélectionnez un espace de travail différent (l’espace Avancé affiche tous les
éléments de menu).

Choisissez Edition > Menus, repérez la commande qui vous intéresse et vérifiez si elle est masquée.

S’il manque encore des commandes de menu, essayez de restaurer les préférences.

Utilisation des ensembles de raccourcis clavier
Les infos-bulles vous renseignent immédiatement sur les raccourcis clavier. InDesign comporte également un éditeur de raccourcis qui permet de
générer et d’afficher une liste de tous les raccourcis et de créer et de modifier vos propres raccourcis. L’éditeur de raccourcis inclut toutes les
commandes pouvant accepter des raccourcis ; cependant, certaines de ces commandes ne sont pas définies dans l’ensemble de raccourcis par
défaut.

Vous pouvez également associer des raccourcis clavier à des styles de paragraphe ou de caractère (voir la section Ajout de styles de paragraphe
et de caractère) ou à des scripts.

Pour consulter un didacticiel vidéo sur l’utilisation des raccourcis clavier, rendez-vous à l’adresse www.adobe.com/go/vid0066.

Mike Witherell propose un guide de référence de raccourcis clavier sous le titre Free keyboard shortcuts  4 (en anglais uniquement).

Pour modifier l’ensemble de raccourcis actif
1. Si vous voulez que l’ensemble de raccourcis soit actif pour la totalité des documents, assurez-vous qu’aucun document n’est

ouvert.
2. Choisissez Edition > Raccourcis clavier.
3. Sélectionnez un ensemble de raccourcis dans le menu Ensemble. Par exemple, sélectionnez l’ensemble de raccourcis de

QuarkXPress ® 4.0.
4. Cliquez sur le bouton OK.

Pour afficher les raccourcis
1. Choisissez Edition > Raccourcis clavier.
2. Dans le menu déroulant Ensemble, sélectionnez un ensemble de raccourcis.
3. Dans le menu déroulant Zone du produit, sélectionnez la zone contenant les commandes que vous souhaitez afficher.
4. Dans la liste Commandes, sélectionnez une commande. Le raccourci s’affiche dans la zone Raccourcis actuels.

Pour créer une liste de raccourcis pour l’impression
1. Choisissez Edition > Raccourcis clavier.
2. Dans le menu déroulant Ensemble, sélectionnez un ensemble de raccourcis.
3. Cliquez sur Afficher l’ensemble.

Un fichier texte contenant tous les raccourcis actuels et non attribués de cet ensemble s’ouvre.

Pour créer un ensemble de raccourcis
1. Choisissez Edition > Raccourcis clavier.
2. Cliquez sur Nouvel ensemble.
3. Attribuez un nom au nouvel ensemble, sélectionnez un ensemble de raccourcis dans le menu déroulant D’après l’ensemble,

puis cliquez sur OK.

Pour créer ou redéfinir un raccourci
1. Choisissez Edition > Raccourcis clavier.
2. Sélectionnez un ensemble de raccourcis dans le menu déroulant Ensemble ou cliquez sur Nouvel ensemble pour créer un

ensemble de raccourcis.

http://www.adobe.com/go/vid0066
http://www.jetsetcom.net/index.php/component/content/article/55-free-keyboard-shortcuts-creative-suite-


 

Remarque : vous ne pouvez pas modifier les ensembles de raccourcis par défaut, ni ceux de QuarkXPress. Créez plutôt un
nouvel ensemble d’après l’un de ces deux ensembles puis modifiez-le.

3. Dans le menu déroulant Zone du produit, sélectionnez la zone contenant la commande que vous souhaitez définir ou redéfinir.
4. Dans la liste Commandes, sélectionnez la commande que vous souhaitez définir ou redéfinir.
5. Accédez à la zone Nouveau raccourci et appuyez sur les touches du nouveau raccourci clavier. Si la combinaison de touches

est déjà utilisée pour une autre commande, celle-ci s’affiche dans la zone Raccourcis actuels. Vous pouvez soit modifier le
raccourci initial, soit en sélectionner un nouveau.
Remarque : n’attribuez pas de raccourcis constitués d’une seule touche aux commandes de menu, car les touches sont
utilisées pour la saisie de texte. Si vous utilisez un raccourci de ce type alors qu’un point d’insertion est actif, InDesign active
le raccourci clavier au lieu d’insérer le caractère correspondant dans le texte.

6. Dans la liste Contexte, sélectionnez le contexte dans lequel vous souhaitez que le raccourci soit activé. Cette option permet de
s’assurer que le raccourci exécute bien la commande souhaitée en fonction du contexte. Par exemple, il est possible
d’attribuer le raccourci Ctrl+G au regroupement de deux cellules (pour un tableau) et à l’insertion de caractères spéciaux (pour
un texte).
Remarque : attribuez des raccourcis dans le contexte par défaut pour qu’ils fonctionnent quel que soit l’état du document. Les
raccourcis attribués dans les autres contextes, tels que dans un tableau ou un texte, remplacent ceux attribués dans le
contexte par défaut.

7. Utilisez l’une des méthodes suivantes :

Cliquez sur Attribuer pour créer un nouveau raccourci de commande.

Cliquez sur Attribuer pour ajouter un autre raccourci à une commande. Plusieurs raccourcis clavier peuvent correspondre
à une même commande de menu.

8. Cliquez sur OK pour fermer la boîte de dialogue ou sur Enregistrer pour laisser la boîte de dialogue ouverte et définir d’autres
raccourcis.

Pour copier les ensembles de raccourcis clavier
Les ensembles de raccourcis clavier (*.indk) sont enregistrés à deux emplacements. Les raccourcis prédéfinis de l’application figurent dans le
dossier Presets du dossier principal de l’application. Les ensembles de raccourcis que vous créez figurent dans le dossier Shortcut Sets aux
emplacements suivants :

Windows XP Documents and Settings\[nom d’utilisateur]\Application Data\Adobe\InDesign\[version]\[langue]InDesign Shortcut Sets
Windows Vista et Windows 7 Users\[nom d’utilisateur]\AppData\Roaming\Adobe\InDesign\[Version]\[Langue]\InDesign Shortcut Sets
Mac OS Users/[nom d’utilisateur]/Bibliothèque/Preferences/Adobe InDesign/[version]/[langue]/InDesign Shortcut Sets
Si vous avez créé un ensemble de raccourcis clavier sur un ordinateur et que vous souhaitez l’utiliser sur un autre ordinateur, copiez le fichier
*.indk au même emplacement sur l’autre ordinateur.

Vous pouvez déplacer un ensemble de raccourcis clavier depuis l’emplacement personnalisé vers le dossier de l’application. Ainsi, tous les
utilisateurs de l’ordinateur auront accès aux raccourcis personnalisés. Vérifiez toutefois que vous ne disposez pas de deux ensembles portant le
même nom, à des emplacements différents. Assurez-vous que les ensembles de raccourcis clavier de l’application et les ensembles personnalisés
ont des noms différents.

Voir aussi
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Récupération de documents
Correction d’erreurs

Récupération de documents
InDesign protège vos données des coupures de courant ou des pannes système impromptues grâce à une fonction de récupération automatique.
Les données récupérées sont enregistrées sur le disque dans un fichier temporaire distinct du fichier original. En règle générale, vous n’avez pas
à intervenir dans le cadre de la récupération : les données les plus récentes enregistrées dans le fichier de récupération sont en effet ajoutées
automatiquement au fichier original lorsque vous choisissez la commande Enregistrer ou Enregistrer sous ou lorsque vous fermez InDesign selon
la méthode habituelle. La fonction de récupération automatique ne doit être utilisée qu’en cas de blocage système ou de panne de courant,
lorsque vous ne parvenez pas à enregistrer vos données.

Elle ne doit pas vous dispenser d’enregistrer régulièrement vos fichiers et de créer des fichiers de sauvegarde pour vous prémunir contre ces
pannes ou ces blocages intempestifs.

Pour rechercher des documents récupérés
1. Redémarrez l’ordinateur.
2. Lancez InDesign.

Si des données ont été automatiquement récupérées, InDesign affiche systématiquement le document récupéré. La mention
[Récupéré] s’affiche en regard du nom de fichier dans la barre de titre de la fenêtre de document pour indiquer que le
document contient des données récupérées non enregistrées.

Remarque : si InDesign se bloque après une tentative d’ouverture d’un document contenant des données récupérées
automatiquement, il se peut que ces dernières soient altérées.

3. Utilisez l’une des méthodes suivantes :

Pour enregistrer les données récupérées, choisissez Fichier > Enregistrer sous, indiquez un emplacement et un nouveau
nom de fichier, puis cliquez sur Enregistrer. Si vous utilisez la commande Enregistrer sous, la version contenant les
données récupérées reste active. La mention [Récupéré] disparaît de la barre de titre.

Pour utiliser la dernière version du document enregistrée sur le disque avant le blocage et ignorer les données récupérées
automatiquement, fermez le fichier récupéré sans l’enregistrer et ouvrez le fichier enregistré sur le disque, ou bien
choisissez la commande Fichier > Version précédente.

Pour modifier l’emplacement des documents récupérés
1. Choisissez Edition > Préférences > Gestion des fichiers (Windows) ou InDesign Préférences> Gestion des fichiers (Mac OS).
2. Dans Données de récupération du document, cliquez sur Parcourir (Windows) ou sur Choisir (Mac OS).
3. Spécifiez le nouvel emplacement du document récupéré, cliquez sur le bouton Sélectionner (Windows) ou Choisir (Mac OS),

puis cliquez sur le bouton OK.

Correction d’erreurs
Vous avez la possibilité d’annuler une opération en cours avant que celle-ci n’arrive à son terme, d’annuler les dernières modifications effectuées
et de rétablir une version précédente du document. Vous pouvez annuler et rétablir plusieurs centaines d’opérations récentes (le nombre exact
dépend de la quantité de mémoire vive (RAM) disponible et du type d’opération effectuée). Si vous choisissez la commande Enregistrer sous ou si
vous fermez le document ou le programme, vous ne pouvez plus annuler ni rétablir les dernières opérations.

 Utilisez l’une des méthodes suivantes :

Pour annuler la dernière modification effectuée, choisissez Edition >Annuler > [action]. Certaines opérations, telles que le
défilement, ne peuvent pas être annulées.

Pour rétablir une opération, choisissez la commande Edition > Rétablir [action].

Pour annuler toutes les modifications effectuées depuis le dernier enregistrement du document, choisissez la commande
Fichier > Version précédente (InDesign) ou Fichier > Rétablir le contenu (InCopy).

Pour fermer une boîte de dialogue sans appliquer les modifications, cliquez sur le bouton Annuler.
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Conversion de documents QuarkXPress et PageMaker
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Ouverture de fichiers QuarkXPress dans InDesign
Conversion de documents PageMaker

Ouverture de fichiers QuarkXPress dans InDesign
InDesign peut convertir des fichiers de document et de modèle à partir de QuarkXPress 3.3 ou 4.1x. InDesign peut également convertir des
fichiers de document et de modèle à partir de fichiers QuarkXPress Passport 4.1x multilingues. Il n’est donc plus nécessaire d’enregistrer d’abord
ces fichiers en fichiers unilingues (pour convertir des documents créés dans QuarkXPress 5.0 ou toute version ultérieure, ouvrez les documents
dans QuarkXPress et enregistrez-les au format 4.0).

Pour plus de détails, reportez-vous au Guide de conversion QuarkXPress (PDF), à l’adresse www.adobe.com/go/learn_quarkconv_fr.

Pour ouvrir un modèle ou un document QuarkXPress
1. Vérifiez que le fichier original est bien fermé.
2. Pour conserver impérativement tous les liens, copiez tous les fichiers liés dans le même dossier que la composition

QuarkXPress.
3. Dans InDesign, choisissez Fichier > Ouvrir.
4. Sous Windows, choisissez QuarkXPress (3.3 - 4.1) ou QuarkXPress (4.1x) dans le menu Type.
5. Sélectionnez un fichier et cliquez sur Ouvrir.

Remarque : si la conversion du fichier ou d’une partie spécifique du fichier échoue, un avertissement s’affiche, indiquant les
causes de l’échec et les résultats de la conversion.

6. Si une boîte de dialogue d’avertissement s’affiche, utilisez l’une des méthodes suivantes :

Cliquez sur Enregistrer pour enregistrer les avertissements sous un fichier texte et ouvrez le fichier converti dans
InDesign.

Cliquez sur Fermer pour fermer la boîte de dialogue et ouvrez le fichier dans InDesign.

7. Pour convertir avec davantage de précision l’habillage appliqué dans QuarkXPress, procédez comme suit dans InDesign :

Sélectionnez l’option L’habillage n’agit que sur le texte au-dessus dans la zone Composition de la boîte de dialogue
Préférences.

Appliquez le Compositeur ligne par ligne Adobe du panneau Paragraphe à un ou plusieurs paragraphes.

Si vous avez des problèmes avec un document converti en QuarkXPress, enregistrez-le au format InDesign Markup (IDML) à l’aide de la boîte
de dialogue d’exportation. Ouvrez le fichier IDML et enregistrez-le sous forme de document InDesign.

Pour enregistrer un modèle QuarkXPress en modèle InDesign
1. Ouvrez le modèle dans InDesign.
2. Choisissez Fichier > Enregistrer sous, puis indiquez un emplacement et un nom de fichier.
3. Choisissez Modèle InDesign  dans la zone Type (Windows) ou Format (Mac OS), puis cliquez sur Enregistrer.

Pour convertir à partir de QuarkXPress
Lorsque vous ouvrez un fichier QuarkXPress, InDesign convertit les données d’origine du fichier en données InDesign natives :

Les zones de texte sont converties en blocs de texte InDesign.

Pour convertir avec précision l’habillage appliqué dans QuarkXPress, sélectionnez l’option L’habillage n’agit que sur le texte
au-dessous dans la zone Composition de la boîte de dialogue Préférences.

Les styles sont convertis en styles InDesign.

Etant donné que QuarkXPress utilise des profils colorimétriques différents, ceux-ci sont ignorés dans InDesign.

Les liens des graphiques et du texte sont conservés et s’affichent dans le panneau Liens.

Remarque : les graphiques incorporés (ceux ajoutés au document original à l’aide de la commande Coller) ne sont pas
convertis. Pour plus de détails sur les graphiques incorporés, reportez-vous à la section A propos des liens et des graphiques
incorporés.

http://www.adobe.com/go/learn_quarkconv_fr
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InDesign ne prend pas en charge OLE et les Quark XTension. Par conséquent, si vous ouvrez un fichier contenant des
graphiques à ces formats, les graphiques seront absents du document InDesign. Si la conversion d’un document
QuarkXPress échoue, parcourez le document original, supprimez tous les objets créés par le biais d’une Quark XTension,
enregistrez le document et recommencez la conversion.

Tous les gabarits et calques sont convertis en gabarits et calques InDesign.

Tous les objets de gabarits et les repères QuarkXPress sont disposés sur les gabarits InDesign correspondants.

Les objets groupés restent groupés sauf si le groupe comprend des éléments non imprimables.

Toutes les lignes et tous les contours (y compris les filets de paragraphe) sont convertis selon le style de contour le plus
proche. Les contours et les tirets personnalisés sont convertis en contours et tirets personnalisés dans InDesign.

Une couleur est convertie dans la couleur InDesign correspondante, sauf dans les cas suivants :

Les couleurs QuarkXPress composées de plusieurs encres sont mises en correspondance avec les encres mélangées dans
InDesign, sauf si les couleurs à plusieurs encres ne contiennent pas de ton direct. Le cas échéant, les couleurs d’encres
mélangées sont converties en couleurs quadri.

Les couleurs QuarkXPress 4.1 issues de la bibliothèque de couleurs sont converties en fonction de leurs valeurs CMJN.

Les couleurs TSL QuarkXPress 3.3 sont converties en RVB et les couleurs issues de la bibliothèque de couleurs sont
converties en fonction de leurs valeurs CMJN.

Les couleurs TSL et LAB QuarkXPress 4.1 sont converties en RVB et les couleurs issues de la bibliothèque de couleurs sont
converties en fonction de leurs valeurs RVB/CMJN.

Pour plus de détails sur d’autres aspects de la conversion, consultez les documents de support technique disponibles sur le site Web Adobe à
l’adresse suivante : http://www.adobe.com/fr/support.

Conversion de documents PageMaker
InDesign peut convertir des fichiers de document et de modèle à partir d’Adobe PageMaker 6.0 ou version ultérieure. Lorsque vous ouvrez un
fichier PageMaker, InDesign convertit les données d’origine du fichier en données InDesign natives. Les fichiers InDesign sont enregistrés avec
une extension de nom de fichier .indd.

Pour plus de détails, reportez-vous au Guide de conversion PageMaker (PDF) à l’adresse www.adobe.com/go/learn_pmconv_fr.

Avant d’ouvrir le document dans InDesign, procédez comme suit :

Si le fichier PageMaker ou les graphiques liés se trouvent sur un serveur de réseau, une disquette ou un lecteur amovible, ils
risquent de ne pas s’ouvrir correctement en cas d’interruption du transfert des données. Pour éviter tout problème de transfert
de données, copiez vos documents et leurs liens sur le disque dur, de préférence dans le même dossier dans lequel la
publication PageMaker est enregistrée, avant de les ouvrir dans InDesign.

Il est recommandé d’utiliser la commande Enregistrer sous dans PageMaker pour effacer toutes les données masquées
superflues.

Pour conserver impérativement tous les liens, copiez tous les fichiers liés dans le même dossier que la composition
PageMaker.

Assurez-vous que toutes les polices nécessaires sont disponibles dans InDesign.

Rétablissez les liens graphiques rompus dans la composition PageMaker.

Si la conversion d’un long document PageMaker vous pose problème, scindez-le en plusieurs parties, puis convertissez celles-
ci afin d’identifier les problèmes éventuels.

Si vous ne parvenez pas à ouvrir un document PageMaker endommagé dans PageMaker, essayez de l’ouvrir dans InDesign. InDesign peut
récupérer la majorité des documents que PageMaker ne peut pas ouvrir.

Pour ouvrir un modèle ou un document PageMaker
1. Vérifiez que le fichier original est bien fermé.

2. Dans InDesign, choisissez Fichier > Ouvrir.

3. Sous Windows, choisissez PageMaker (6.0-7.0) dans le menu Type.

4. Sélectionnez un fichier et cliquez sur Ouvrir.

Remarque : si la conversion du fichier ou d’une partie spécifique du fichier échoue, un message d’avertissement vous indique
les causes de l’échec et les résultats de la tentative de conversion.

5. Si une boîte de dialogue d’avertissement s’affiche, utilisez l’une des méthodes suivantes :

Cliquez sur Enregistrer pour enregistrer les avertissements sous un fichier texte et ouvrez le fichier converti dans

http://www.adobe.com/fr/support
http://www.adobe.com/go/learn_pmconv_fr


InDesign.

Cliquez sur Fermer pour ouvrir le fichier dans InDesign sans enregistrer le fichier texte.

Si vous avez des problèmes avec un document converti en PageMaker, enregistrez-le au format InDesign Markup (IDML) à l’aide de la boîte
de dialogue d’exportation. Ouvrez le fichier IDML et enregistrez-le sous forme de document InDesign.

Pour enregistrer un modèle PageMaker en modèle InDesign
1. Ouvrez le modèle dans InDesign.

2. Choisissez Fichier > Enregistrer sous, puis indiquez un emplacement et un nom de fichier.

3. Choisissez Modèle InDesign  dans la zone Type (Windows) ou Format (Mac OS), puis cliquez sur Enregistrer.

Problèmes de conversion dans PageMaker
Tenez compte des points suivants :

Tous les gabarits et calques sont convertis en gabarits et calques InDesign. Les gabarits PageMaker sont convertis en
gabarits InDesign et conservent tous leurs objets, y compris la pagination et les repères. Pour conserver l’ordre des éléments
superposés, InDesign crée deux calques pendant la conversion d’une composition PageMaker : le calque par défaut et le
calque type par défaut (contenant les éléments de gabarit).

Les repères de documents PageMaker sont disposés sur le calque par défaut dans InDesign.

Tous les éléments de la table de montage de PageMaker apparaissent sur la table de montage de la première planche dans
un document InDesign.

Lorsque l’option Non imprimable est sélectionnée dans le panneau Options d’objet d’InDesign, tous les objets désignés dans
PageMaker comme non imprimables sont convertis.

Les objets groupés restent groupés sauf si le groupe comprend des éléments non imprimables.

Problèmes de conversion du texte et des tableaux
Tenez compte des points suivants :

Le texte est converti en blocs de texte InDesign.

Les tableaux créés dans PageMaker sont convertis en tableaux InDesign.

Les styles sont convertis en styles InDesign. L’option [Aucun style] dans PageMaker équivaut à l’option [Aucun style de
paragraphe] dans InDesign. Toutefois, l’option [Aucun style de paragraphe] reprend les attributs d’un style nommé si ce style a
été sélectionné avant toute saisie de texte dans la composition PageMaker.

InDesign utilise le compositeur de paragraphe Adobe pour tous les paragraphes, ce qui entraîne parfois une redistribution du
texte. Vous pouvez appliquer le compositeur ligne par ligne Adobe à un ou plusieurs paragraphes pour insérer des sauts de
ligne selon un principe plus fidèle au moteur de composition PageMaker, mais le texte risque toutefois d’être redistribué.

InDesign utilise uniquement un interligne par rapport à la ligne de base. Les interlignages Proportionnel et Haut de majuscules
de PageMaker sont convertis en interligne de type Ligne de base dans InDesign, ce qui risque de produire un décalage du
texte.

La première ligne de base du texte converti peut sembler différente du texte créé dans InDesign. La première ligne de base du
texte converti est réglée sur Interligne, mais la première ligne de base du texte créé dans InDesign est définie par défaut sur
Ascendante.

Comme InDesign et PageMaker utilisent une méthode de césure différente, leurs sauts de ligne peuvent varier.

Le texte ombré est converti en texte normal. Le texte vectoriel est converti en texte doté d’un contour de 0,25 pouce et d’un
fond Papier.

Problème de conversion des livres, des index et des tables des matières
Tenez compte des points suivants :

InDesign ignore les cahiers au moment de l’ouverture des compositions PageMaker. Pour ouvrir simultanément toutes les
compositions d’un cahier, exécutez le module externe Créer un cahier dans PageMaker en définissant l’option de mise en
page sur Sans afin que les compositions en cahier soient fusionnées. Notez que les blocs de texte perdent alors leurs liens.

Les entrées d’index provenant d’une composition PageMaker apparaissent dans le panneau Index d’InDesign. Dans un texte,
les références croisées utilisant l’option Voir dans la présente ou Voir aussi dans la présente sont converties en renvois Voir ou
Voir aussi.

Le texte d’une table des matières est converti en table des matières et revêt le style de table des matières PageMaker
disponible dans le menu déroulant Style de la boîte de dialogue Table des matières d’InDesign.

Problèmes de liaison et d’incorporation



 

Tenez compte des points suivants :

Les liens des graphiques et du texte sont conservés et s’affichent dans le panneau Liens.

Si InDesign ne parvient pas à localiser le lien source d’un graphique, un message d’avertissement vous invite à réparer le lien
dans PageMaker.

InDesign ne prend pas en charge OLE (Object Linking and Embedding, liaison et incorporation d’objets). Par conséquent, si
vous ouvrez des fichiers contenant des graphiques OLE, ceux-ci n’apparaîtront pas dans le document InDesign.

Problèmes de conversion des couleurs et des recouvrements
Tenez compte des points suivants :

Les couleurs sont converties en leur équivalent InDesign exact. Les couleurs TLS PageMaker sont converties en couleurs RVB
et les couleurs provenant d’autres bibliothèques de couleurs sont converties selon leur valeur CMJN.

Les teintes sont converties en pourcentages d’une couleur parent. Si la couleur parent ne figure pas dans le panneau
Nuancier, elle y est ajoutée lors de la conversion. Si un objet teinté est sélectionné, la couleur parent est sélectionnée dans le
panneau Nuancier et la valeur de teinte correspondante apparaît dans le menu déroulant.

Les profils colorimétriques des fichiers PageMaker sont convertis directement. Toutes les couleurs hexachromes sont
converties en leurs équivalents RVB. Les profils non conformes à la norme ICC sont remplacés en fonction des paramètres et
des profils par défaut du SGC spécifiés dans InDesign.

Lignes et contours (filets de paragraphe compris) sont convertis selon les styles de contour par défaut les plus proches. Les
contours et les tirets personnalisés sont convertis en contours et tirets personnalisés dans InDesign.

InDesign ne prend en charge ni les moirages ni les angles de trame appliqués aux images TIFF dans la boîte de dialogue
Retouches/Trames ; l’application les supprime des fichiers TIFF importés.

Si l’option de surimpression du noir est sélectionnée pour les contours et/ou les fonds dans la boîte de dialogue Préférences
de recouvrement de PageMaker, InDesign reprend ce paramètre, mais l’option Surimpression du fond ou Surimpression du
contour est désélectionnée dans le panneau Options d’objet.

Pour plus de détails sur d’autres problèmes de conversion dans PageMaker, consultez les documents de support technique disponibles sur le
site Web d’Adobe.

Voir aussi
Guide de conversion PageMaker
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Commandes des menus PageMaker
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Commandes du menu Fichier de PageMaker
Commandes du menu Edition de PageMaker
Commandes du menu Page de PageMaker
Commandes du menu Typographie de PageMaker
Commandes du menu Elément de PageMaker
Commandes du menu Options de PageMaker
Commandes du menu Affichage de PageMaker
Commandes du menu Fenêtre de PageMaker

Consultez ces tableaux pour savoir quels sont les équivalents des commandes d’Adobe PageMaker dans Adobe InDesign CS5.

Commandes du menu Fichier de PageMaker

Commande
PageMaker

Equivalence
InDesign

Informations supplémentaires

Fichier >
Nouveau

Fichier >
Nouveau >
Document

 

Fichier > Ouvrir Fichier > Ouvrir  

Fichier >
Compositions
récentes

Fichier > Ouvrir
une composition
récente
(Windows®)

 

Fichier >
Fermer

Fichier >
Fermer

 

Fichier >
Enregistrer

Fichier >
Enregistrer

Il n’existe aucune préférence InDesign pour un enregistrement réduit ou rapide.
Il convient d’utiliser la commande Enregistrer pour effectuer un enregistrement
rapide et la commande Enregistrer sous pour minimiser la taille d’un document.

Fichier >
Enregistrer sous

Fichier >
Enregistrer sous

Voir la remarque ci-dessus.

Fichier >
Version
précédente

Fichier >
Version
précédente

A la différence de PageMaker, InDesign ne rétablit pas les mini-enregistrements
d’un document, mais offre un nombre illimité de niveaux d’annulation.

Fichier >
Importer

Fichier >
Importer

 

Fichier >
Capturer

Pas
d’équivalence

Numérisez les images à l’aide du logiciel livré avec votre scanner, puis importez-
les dans InDesign.

Fichier >
Exporter

Fichier >
Exporter

 

Fichier >
Gestionnaire de
liens

Fenêtre > Liens  

Fichier >
Format de
document

Fichier >
Format de
document
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Fichier > Styles
d’impression

Fichier >
Impressions
prédéfinies

 

Fichier >
Imprimer

Fichier >
Imprimer

 

Fichier >
Préférences >
Général

Edition >
Préférences
(Windows) ou
InDesign >
Préférences
(Mac OS)

Ces paramètres sont équivalents à ceux de Composition, Unités et incréments,
Repères et table de montage et Préférences de performance d’affichage.

Fichier >
Préférences >
En ligne

Pas
d’équivalence

Vous pouvez faire glisser des objets depuis un navigateur Web vers InDesign
sans avoir besoin de configurer une doublure.

Fichier >
Préférences >
Modifier la mise
en page

Page > Modifier
la mise en page

Vous pouvez spécifier des options de réglage de la mise en page et activer la
modification de la mise en page en même temps. Les paramètres d’InDesign
sont quasiment identiques à ceux de PageMaker. Les repères de règle suivent
les repères de colonne ou de marge correspondants par défaut. Pour modifier
ce comportement, désélectionnez l’option Autoriser le déplacement des repères
de règle.

Fichier >
Préférences >
Recouvrement

Fenêtre >
Sortie >
Recouvrements
prédéfinis

Pour spécifier les préférences de recouvrement, créez un recouvrement
prédéfini.

Fichier > Quitter
(Windows) ou
Fichier > Quitter
(Mac OS)

Fichier > Quitter
(Windows) ou
InDesign >
Quitter InDesign
(Mac OS)

 

Commandes du menu Edition de PageMaker

Commande
PageMaker

Equivalence
InDesign

Informations supplémentaires

Edition > Annuler Edition > Annuler InDesign autorise un nombre illimité de niveaux d’annulation.

Edition > Couper Edition > Couper  

Edition > Copier Edition > Copier  

Edition > Coller Edition > Coller InDesign ne prend pas en charge la technologie de liaison et
d’incorporation d’objets (OLE) ; vous pouvez toutefois définir des options
similaires dans le panneau Liens.

Edition > Effacer Edition > Effacer  

Edition >
Tout sélectionner

Edition >
Tout sélectionner

 

Edition >
Tout désélectionner

Edition >
Tout désélectionner

 

Edition > Editions
(Mac OS)

Pas d’équivalence InDesign ne prend pas en charge l’option de publication/abonnement ;
vous pouvez toutefois définir des options similaires dans le panneau
Liens.

Edition > Collage
multiple

Edition > Exécuter
et répéter

 

Edition > Collage
spécial

Edition > Coller
sans mise en forme
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Edition > Insérer un
objet (Windows)

Fichier > Importer  

Edition > Mode
éditeur

Edition > Mode
éditeur

 

Edition > Editer
original

Edition > Editer
original

Vous pouvez également sélectionner Editer l’original dans le menu du
panneau Liens.

Edition > Afficher le
Presse-papiers
(Mac OS)

Pas d’équivalence  

Commandes du menu Page de PageMaker

Commande
PageMaker

Equivalence InDesign Informations supplémentaires

Page >
Afficher page

Page > Afficher page Vous pouvez également cliquer deux fois sur une icône de page
dans le panneau Pages pour aller directement à cette page.

Page >
Insérer des
pages

Page > Pages > Insérer des
pages

 

Page >
Supprimer
des pages

Page > Pages > Supprimer des
pages

 

Page > Trier
des pages

Fenêtre > Pages Cliquez et faites glisser des pages pour les trier dans le panneau
Pages.

Page >
Précédent

Page > Précédent  

Page >
Suivant

Page > Suivant  

Page >
Repères de
colonne

Page > Marges et colonnes  

Page >
Copier les
repères types

Pas d’équivalence Les repères types d’un gabarit InDesign quelconque sont toujours
copiés vers des pages qui utilisent ce gabarit.

Page >
Placement
automatique

Appuyez sur la touche Maj
lorsqu’une icône de texte 
chargée s’affiche

Vous pouvez placer le texte manuellement, automatiquement
(avec la commande de placement automatique) ou de façon semi-
automatique.

Commandes du menu Typographie de PageMaker

Commande
PageMaker

Equivalence InDesign Informations supplémentaires

Typographie > Police Typographie > Police  

Typographie > Corps Typographie > Corps  

Typographie >
Interlignage

Texte > panneau
Caractère ou Contrôle
en mode Caractère
(Fenêtre > Contrôle)

InDesign utilise un interligne de base par défaut par opposition à
PageMaker qui adopte un interligne proportionnel par défaut.
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Typographie > Style
de caractère

Texte > panneau
Caractère ou Contrôle
en mode Caractère
(Fenêtre > Contrôle)

InDesign affiche les styles de caractère disponibles dans la police
sélectionnée. Vous pouvez également utiliser Application rapide.

Typographie >
Crénage Expert

Texte > panneau
Caractère ou Contrôle
en mode Caractère
(Fenêtre > Contrôle)

Le crénage expert dans PageMaker est similaire au crénage optique
dans InDesign.

Typographie >
Echelle horizontale

Panneau Contrôle en
mode Caractère
(Fenêtre > Contrôle)

 

Typographie >
Caractère

Typographie >
Caractère

 

Texte > Paragraphe Texte > Paragraphe  

Typographie >
Renfoncements/Tabs

Texte > Tabulations  

Typographie >
Coupure de mots

Texte > Paragraphe Choisissez Césure dans le menu du panneau Paragraphe.

Typographie >
Alignement

Texte > panneau
Paragraphe ou
Contrôle en mode
Paragraphe (Fenêtre >
Contrôle)

 

Typographie > Style
de paragraphe

Texte > Styles de
paragraphe ou Texte >
Styles de caractère

InDesign prend en charge à la fois les styles de paragraphe et les
styles de caractère.

Typographie >
Définir les styles

Texte > Styles de
paragraphe ou Texte >
Styles de caractère

Choisissez Nouveau style de paragraphe dans le panneau Styles de
paragraphe pour créer un style de paragraphe. Choisissez Nouveau
style de caractère dans le panneau Styles de paragraphe pour créer
un style de caractère.

Commandes du menu Elément de PageMaker

Commande
PageMaker

Equivalence
InDesign

Informations supplémentaires

Elément > Fond Fenêtre >
Couleur >
Nuancier ou
Fenêtre >
Couleur >
Couleur

InDesign ne prend pas en charge les fonds à motifs. Le panneau Nuancier
dans InDesign correspond au panneau Couleurs dans PageMaker.

Elément > Contour Fenêtre >
Contour

Choisissez un style de contour dans le panneau Contour ou définissez un
style de contour personnalisé.

Elément > Contour
et fond

Fenêtre >
Couleur >
Nuancier,
Fenêtre >
Contour et
Fenêtre >
Sortie > Options
d’objet.

Créez des teintes à l’aide du panneau Nuancier. Spécifiez une surimpression
dans le panneau Options d’objet.

Elément > Bloc >
Intégrer le contenu

Pas
d’équivalence

InDesign crée automatiquement un bloc pour les fichiers texte ou les
graphiques importés. Pour coller du contenu dans un bloc existant,
sélectionnez le bloc, puis importez ou collez le contenu dans ce bloc.



Elément > Bloc >
Options de bloc

Objet > Options
de bloc de texte
(blocs de texte
seulement) ou
Objet >
Ajustement

Pour les blocs de texte, spécifiez les colonnes, l’alignement vertical et la
marge dans la boîte de dialogue Options de bloc de texte. Définissez
l’alignement horizontal dans le panneau Paragraphe (Texte > Paragraphe).
Pour les blocs de texte et les graphiques, utilisez les commandes du sous-
menu Objet > Ajustement pour ajuster le contenu au bloc (ou inversement).

Elément > Bloc >
Convertir en bloc

Objet >
Contenu > [type
de contenu]

 

Elément > Bloc >
Bloc suivant

Affichage >
Extras >
Afficher le
chaînage du
texte

 

Elément > Bloc >
Bloc précédent

Affichage >
Extras >
Afficher le
chaînage du
texte

 

Elément > Bloc >
Supprimer des
liens

Cliquez deux
fois sur le port
d’entrée ou le
port de sortie
pour rompre un
lien.

 

Elément > Bloc >
Supprimer le
contenu

Sélectionnez le
contenu du
bloc, puis
appuyez sur la
touche
Supprimer.

Sélectionnez le texte avec l’outil Texte. Sélectionnez les graphiques avec
l’outil Sélection directe.

Elément >
Disposition

Objet >
Disposition

 

Elément > Aligner
les objets
(Windows) ou
Elément > Aligner
(Mac OS)

Fenêtre > Objet
et mise en
page >
Alignement

 

Elément >
Habillage de texte

Fenêtre >
Habillage de
texte

 

Elément >
Associer

Objet >
Associer

 

Elément >
Dissocier

Objet >
Dissocier

 

Elément >
Verrouiller la
position

Objet >
Verrouiller la
position

 

Elément >
Déverrouiller

Objet >
Déverrouiller la
position

 

Elément > Masque Objet > Masque Vous pouvez également masquer un graphique en créant une forme de
masquage, en copiant l’image à masquer, puis en la collant dans la forme
(Edition > Coller dedans) ou en réglant son bloc graphique.

Elément > Afficher Objet > Masque Voir la remarque ci-dessus.

Elément > Pas Utilisez la commande Editer l’original pour modifier les paramètres de
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Image >
Retouches/Trames

d’équivalence retouches/trames dans l’application d’origine.

Elément >
Image > Source
SGC

Objet >
Couleurs de
l’image

 

Elément >
Image > Effets
Photoshop

Objet > Effets  

Elément >
Polygone

Cliquez deux
fois sur l’outil
Polygone dans
le panneau
Outils.

 

Elément >
Arrondis d’angle

Objet > Options
d’arrondis

 

Elément > Info sur
le lien

Fenêtre > Liens Sélectionnez Info sur le lien dans le menu du panneau Liens.

Elément > Options
de lien

Préférences ou
Fenêtre > Liens

Dans les préférences de gestion des fichiers, sélectionnez ou désélectionnez
l’option Créer des liens avec les fichiers de texte et de feuilles de calcul
importés. Vous pouvez également choisir Rompre le lien dans le menu du
panneau Liens.

Elément > Non
imprimable

Fenêtre >
Sortie > Options
d’objet

 

Elément > Annuler
la transformation

Pas
d’équivalence

 

Commandes du menu Options de PageMaker

Commande
PageMaker

Equivalence InDesign Informations supplémentaires

Options >
Modules
externes

Aide > Configuration des modules externes
(Windows) ou InDesign > Configuration des
modules externes (Mac OS)

 

Options >
Rechercher

Edition > Rechercher/Remplacer Vous pouvez effectuer des recherches et des
remplacements en mode mise en page ou éditeur.

Options >
Rechercher
suivant

Edition > Suivant Voir la remarque ci-dessus.

Options >
Remplacer

Edition > Rechercher/Remplacer Voir la remarque ci-dessus.

Options >
Orthographe

Edition > Orthographe > Orthographe Vous pouvez effectuer une vérification
orthographique en mode mise en page ou éditeur.

Options >
Livre

Fichier > Nouveau > Livre Le panneau Livre permet de trier et de supprimer
les documents d’un livre, mais aussi d’ajouter des
documents à un livre.

Options >
Entrée
d’index

Fenêtre > Texte et tableaux > Index Pour ajouter une entrée d’index, cliquez sur le
bouton Nouveau du panneau Index.

Options >
Afficher
l’index

Panneau Index en mode Référence (Fenêtre >
Texte et tableaux > Index)
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Options >
Créer l’index

Fenêtre > Texte et tableaux > Index Choisissez Générer l’index dans le menu du
panneau Index.

Options >
Créer la table
des matières

Page > Table des matières  

Options >
Définir les
couleurs

Fenêtre > Couleur > Nuancier Dans le menu du panneau Nuancier, choisissez
Nouvelle couleur.

Commandes du menu Affichage de PageMaker

Commande
PageMaker

Equivalence InDesign Informations supplémentaires

Affichage >
Afficher les
éléments types

Choisissez Masquer/Afficher les éléments types dans le
menu du panneau Pages.

 

Affichage >
Afficher les
éléments non
imprimables

Sélectionnez le mode d’affichage Normal  dans le
panneau Outils pour afficher les éléments non
imprimables. Pour masquer les éléments non
imprimables, sélectionnez le mode d’affichage Aperçu 
.

Vous pouvez également créer un
calque pour les objets à ne pas
imprimer, puis afficher ou masquer ce
calque avant une impression ou une
exportation.

Affichage >
Zoom avant

Affichage > Zoom avant  

Affichage >
Zoom arrière

Affichage > Zoom arrière  

Affichage >
Taille réelle

Affichage > Taille réelle  

Affichage >
Page entière

Affichage > Ajuster la page à la fenêtre ou Affichage >
Ajuster la planche à la fenêtre

 

Affichage >
Table de
montage

Affichage > Table de montage  

Affichage >
Zoom à

Choisissez un facteur d’agrandissement dans le menu
Zoom, au bas de la fenêtre de document.

 

Affichage >
Masquer/Afficher
les règles

Affichage > Masquer/Afficher les règles  

Affichage > Aide
position règles

Pas d’équivalence  

Affichage >
Blocage origine

Cliquez sur l’origine avec le bouton droit de la souris
(Windows) ou en maintenant la touche Contrôle
enfoncée (Mac OS), puis choisissez Verrouiller l’origine
dans le menu contextuel qui apparaît.

 

Affichage >
Masquer/Afficher
les repères

Affichage > Grilles et repères > Masquer/Afficher les
repères

 

Affichage > Aide
position repères

Affichage > Grilles et repères > Magnétisme des repères  

Affichage >
Verrouiller les
repères

Affichage > Grilles et repères > Verrouiller les repères et
Affichage > Grilles et repères > Verrouiller les repères
de colonne
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Affichage >
Supprimer les
repères de règle

En utilisant les raccourcis clavier d’InDesign, appuyez
sur les touches Ctrl+Alt+G (Windows) ou
Commande+Option+G (Mac OS) pour sélectionner tous
les repères de la planche active et appuyez sur la
touche Suppr.

 

Affichage >
Repères à
l’arrière-plan

Edition > Préférences > Repères et table de montage
(Windows) ou InDesign > Préférences > Repères et
table de montage (Mac OS)

Sélectionnez l’option Repères en
arrière-plan.

Affichage >
Masquer/Afficher
les barres de
défilement

Pas d’équivalence  

Commandes du menu Fenêtre de PageMaker

Commande
PageMaker

Equivalence InDesign Informations supplémentaires

Fenêtre >
Réorganiser les
icônes (Windows)

Pas d’équivalence  

Fenêtre > Mosaïque Fenêtre > Disposition >
Mosaïque

 

Fenêtre > Cascade Fenêtre > Disposition >
Cascade

 

Fenêtre >
Masquer/Afficher les
outils

Fenêtre > Outils  

Fenêtre >
Masquer/Afficher le
panneau de contrôle

Fenêtre > Contrôle  

Fenêtre >
Masquer/Afficher
Couleurs

Fenêtre > Couleur >
Nuancier ou Fenêtre >
Couleur > Couleur

 

Fenêtre >
Masquer/Afficher
Styles

Fenêtre > Styles > Styles
de paragraphe ou Styles
de caractère

 

Fenêtre >
Masquer/Afficher
Calques

Fenêtre > Calques  

Fenêtre >
Masquer/Afficher
Pages types

Fenêtre > Pages  

Fenêtre >
Masquer/Afficher
Hyperliens

Fenêtre > Objet interactif >
Hyperliens

 

Fenêtre > Panneaux
Module externe

Pas d’équivalence Les modules externes apparaissent sous forme d’options
supplémentaires dans les menus, les panneaux ou les boîtes de
dialogues InDesign.

Fenêtre > [nom du
document ouvert]

Fenêtre > [nom du
document ouvert]
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Assemblages d’affectation
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Création et envoi d’assemblages (InDesign)
Réception d’assemblages (InCopy)
Réception d’assemblages renvoyés (InDesign)

Création et envoi d’assemblages (InDesign)
Dans l’idéal, tous les utilisateurs InDesign et InCopy de l’équipe ont accès à un serveur où sont stockés les fichiers d’affectation. Toutefois, si des
utilisateurs n’ont pas accès à un serveur commun, vous pouvez créer et distribuer des assemblages d’affectation compressés. Après avoir travaillé
sur l’affectation, l’utilisateur InCopy reconstitue l’assemblage de cette affectation et le renvoie afin qu’il soit intégré au document InDesign. Les
fichiers d’assemblage créés dans InDesign portent l’extension .icap. Les fichiers d’assemblage renvoyés créés dans InCopy portent
l’extension .idap.

Deux commandes permettent d’assembler des fichiers : Assembler pour InCopy et Assembler et envoyer par courrier électronique. La commande
Assembler pour InCopy permet de créer un assemblage compressé que vous pouvez envoyer manuellement ; la commande Assembler et envoyer
par courrier électronique crée un assemblage compressé qui est joint automatiquement à un message électronique.

Remarque : ne confondez pas l’assemblage d’affectation et la commande Fichier > Assemblage d’InDesign qui permet de grouper et d’envoyer un
document et ses actifs à une imprimante.

Pour créer un assemblage en vue d’une distribution manuelle
1. Créez une affectation et ajoutez le contenu que vous souhaitez inclure dans l’assemblage.

Seul le contenu archivé peut être inclus dans l’affectation assemblée. Si une partie du contenu est extraite, vous êtes invité à
l’archiver.

2. Dans le panneau Affectations, sélectionnez l’affectation souhaitée et choisissez la commande Assembler pour InCopy dans le
menu du panneau.

3. Indiquez le nom et l’emplacement du fichier d’affectation, puis cliquez sur Enregistrer.

Vous pouvez joindre le fichier d’affectation à un courrier électronique, le télécharger sur un serveur FTP ou le copier sur un disque ou autre
support externe.

Remarque : lorsque vous choisissez la commande Edition > Annuler après avoir créé un assemblage, ce dernier est annulé et les éléments de
l’affectation sont déverrouillés. Le fichier d’assemblage reste toutefois sur le disque et l’envoi du courrier électronique n’est pas annulé.

Pour créer un assemblage en vue d’un envoi par courrier électronique (InDesign)
1. Créez une affectation et ajoutez le contenu que vous souhaitez inclure dans l’assemblage.

Seul le contenu archivé est inclus dans l’affectation assemblée. Si une partie du contenu est extraite, vous êtes invité à
l’archiver.

2. Dans le panneau Affectations, sélectionnez l’affectation souhaitée et choisissez la commande Assembler pour InCopy et
envoyer par courrier électronique dans le menu du panneau.

Un assemblage d’affectation compressé est créé et joint à un message électronique dans votre programme de messagerie
électronique par défaut.

Remarque : si vous souhaitez utiliser une autre application de messagerie, modifiez l’application de messagerie par défaut.
Pour plus de détails, reportez-vous à la documentation de votre système.

3. Modifiez le message électronique en ajoutant un destinataire et des instructions si nécessaire. Envoyez le message.

Tous les éléments de l’affectation sont extraits vers l’utilisateur désigné. Cependant, le contenu de l’assemblage même n’est pas verrouillé. De ce
fait, tout utilisateur peut ouvrir l’assemblage et en modifier le contenu.

Pour annuler un assemblage
Dans certains cas, l’assemblage que vous envoyez n’est pas renvoyé. Par exemple, le message a pu se perdre, ou le destinataire ne travaille plus
sur le projet. Dans ce cas, vous pouvez annuler un assemblage.

1. Dans le panneau Affectations, sélectionnez l’affectation assemblée et choisissez la commande Annuler l’assemblage
d’affectation dans le menu du panneau.

2. Cliquez sur le bouton OK pour annuler l’assemblage.



Haut de la page

Haut de la page

L’annulation d’un assemblage ne supprime pas le fichier d’assemblage de l’ordinateur.

Lorsqu’un assemblage est annulé, son contenu est modifiable. Notez que des conflits peuvent survenir si un assemblage annulé est renvoyé.

Pour mettre à jour un assemblage
Après avoir créé un assemblage, vous pouvez ajouter, supprimer ou redimensionner des éléments.

1. Ajoutez, supprimez ou redimensionnez un ou plusieurs articles de l’affectation assemblée.
2. Sélectionnez l’affectation dans le panneau Affectations, puis utilisez l’une des méthodes suivantes :

Dans le menu du panneau Affectations, choisissez la commande Mettre à jour l’assemblage. Indiquez le nom et
l’emplacement du fichier. Mettez l’assemblage mis à jour à disposition des utilisateurs en le plaçant sur un serveur partagé
ou en l’envoyant par courrier électronique. N’oubliez pas de signaler aux utilisateurs InCopy que l’assemblage a été mis à
jour.

Choisissez la commande Mettre à jour l’assemblage et l’envoyer par courrier électronique dans le menu du
panneau Affectations, puis envoyez le message.

Lorsque les utilisateurs InCopy ouvrent l’assemblage mis à jour, seul le nouveau contenu est ajouté automatiquement à l’affectation. Les
utilisateurs InCopy peuvent choisir de remplacer le contenu existant. Ils peuvent ainsi conserver des modifications précédentes.

Réception d’assemblages (InCopy)
Vous pouvez recevoir un assemblage d’un utilisateur InDesign qui en est l’auteur, ou d’un utilisateur InCopy qui vous le transfère. Lorsque vous
ouvrez un assemblage d’affectation, ce dernier est décompressé et le contenu est copié dans un nouveau sous-dossier d’un dossier
d’affectations InCopy.

Pour ouvrir un assemblage (InCopy)
 Pour ouvrir un assemblage InCopy (*.icap ou *.incp), utilisez l’une des méthodes suivantes :

Lancez l’assemblage depuis le programme de messagerie électronique. Par exemple, cliquez deux fois sur le fichier joint.

Ouvrez le fichier à partir de l’Explorateur ou du Finder. Cliquez deux fois sur le fichier ou faites-le glisser sur l’icône de
l’application InCopy.

Dans InCopy, choisissez Fichier > Ouvrir, puis cliquez deux fois sur le fichier d’assemblage d’affectation.

Dans InCopy, choisissez la commande Ouvrir l’assemblage dans le menu du panneau Affectations, puis cliquez deux fois sur
le fichier d’assemblage.

Vous pouvez à présent modifier les articles de l’assemblage. Lorsque vous commencez à modifier un article, vous êtes invité à extraire le contenu
du bloc. Une fois les modifications terminées, enregistrez l’ensemble du contenu et renvoyez l’assemblage ou transférez-le.

Pour renvoyer ou transférer un assemblage (InCopy)
Après avoir ouvert et modifié un assemblage, vous pouvez l’envoyer à un autre utilisateur InCopy ou le renvoyer à l’utilisateur InDesign ayant créé
l’assemblage. Les fichiers d’assemblage créés pour d’autres utilisateurs d’InCopy portent l’extension .icap. Les fichiers d’assemblage renvoyés aux
utilisateurs d’InDesign portent l’extension .idap.

1. Modifiez et archivez le contenu à inclure dans l’assemblage.
2. Dans le menu du panneau Affectations, choisissez l’une des commandes suivantes :

Transférer pour InCopy Crée un assemblage pour un autre utilisateur InCopy. Spécifiez le nom et l’emplacement du fichier
d’affectation et mettez-le à disposition de l’utilisateur InCopy.

Transférer pour InCopy et envoyer par courrier électronique Crée un assemblage et l’envoie par courrier électronique à
un autre utilisateur InCopy. L’assemblage apparaît comme pièce jointe à un nouveau message électronique dans votre
programme de messagerie électronique par défaut. indiquez le destinataire, ajoutez des instructions et envoyez le message.

Renvoyer pour InDesign Crée un assemblage à renvoyer à l’utilisateur InDesign.

Renvoyer pour InDesign et envoyer par courrier électronique Crée et renvoie par courrier électronique un assemblage à
l’utilisateur InDesign. L’assemblage apparaît comme pièce jointe à un nouveau message électronique dans votre programme
de messagerie électronique par défaut. indiquez le destinataire, ajoutez des instructions et envoyez le message.

Réception d’assemblages renvoyés (InDesign)
 Pour ouvrir un assemblage InDesign (*.idap ou *.indp), utilisez l’une des méthodes suivantes :

Lancez l’assemblage depuis le programme de messagerie électronique. Par exemple, cliquez deux fois sur le fichier joint.

Ouvrez le fichier à partir de l’Explorateur ou du Finder. Cliquez deux fois sur le fichier ou faites-le glisser sur l’icône de
l’application InDesign.



 

Dans InDesign, choisissez Fichier > Ouvrir, puis cliquez deux fois sur le fichier d’assemblage.

Dans InDesign, choisissez la commande Ouvrir l’assemblage dans le menu du panneau Affectations, puis cliquez deux fois sur
le fichier d’assemblage.

A l’ouverture de l’assemblage, vous êtes invité à mettre à jour tous les liens. Si un article a été modifié depuis l’assemblage de l’affectation, vous
pouvez choisir de mettre à jour le contenu dans le fichier InDesign ou d’en rompre le lien. Lorsque les articles des fichiers sont renvoyés et
archivés, vous pouvez en extraire le contenu pour le modifier.

Voir aussi
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Déplacement de contenu entre les affectations (InDesign)
Suppression des affectations (InDesign)
Réédition de liens vers les fichiers d’affectation manquants (InDesign)
Correction des erreurs
Remplacement des fichiers de verrouillage (InDesign)
Rupture du lien de fichiers de contenu (InDesign)
Importation de fichiers InCopy dans des documents InDesign

Déplacement de contenu entre les affectations (InDesign)
Les utilisateurs d’InDesign peuvent déplacer du contenu entre les affectations existantes, ainsi qu’à partir de la section Contenu InCopy non affecté
du panneau Affectations. Vous pouvez également créer une affectation et y placer du contenu.

1. Enregistrez le document InDesign.
2. Dans le panneau Affectations, cliquez sur la flèche à gauche du nom de l’affectation pour afficher son contenu.
3. Sélectionnez un élément dans une affectation.
4. Utilisez l’une des méthodes suivantes :

Faites glisser le contenu d’une affectation vers une autre.

Pour déplacer le contenu vers une affectation existante, choisissez la commande Ajouter à l’affectation dans le menu du
panneau Affectations, puis sélectionnez l’affectation souhaitée.

Pour créer une affectation lorsque vous déplacez du contenu, choisissez la commande Ajouter à l’affectation > Nouveau,
puis définissez les options dans la boîte de dialogue Nouvelle affectation.

5. Dans le menu du panneau Affectations, choisissez Mettre à jour toutes les affectations.

Si les listes d’affectation sont courtes, vous pouvez faire glisser les éléments de contenu depuis et vers les affectations et la section Contenu
InCopy non affecté.

Suppression des affectations (InDesign)
 Dans le panneau Affectations, sélectionnez une ou plusieurs affectations, puis choisissez Supprimer l’affectation dans le menu du panneau.

La suppression des affectations entraîne :

le retrait des données d’affectation du document ;

la suppression du fichier d’affectation du système de fichiers ;

le retrait du nom de l’affectation de la liste ;

le déplacement du contenu InCopy vers la section Contenu InCopy non affecté du panneau Affectations.

Remarque : si un utilisateur InCopy a ouvert une affectation supprimée dans InDesign, une alerte avertit l’utilisateur d’InCopy que l’affectation a
été supprimée. Toutefois, les fichiers de contenu ne sont pas supprimés et peuvent être mis à jour sans entraîner la perte des modifications.

Réédition de liens vers les fichiers d’affectation manquants (InDesign)
Si vous déplacez ou supprimez un fichier d’affectation sur le disque, puis ouvrez le document InDesign à partir duquel il a été créé, InDesign ne
connaît pas l’emplacement du fichier d’affectation. Vous devez recréer le fichier d’affectation afin qu’InDesign puisse le localiser.

Pour recréer le fichier d’affectation à son emplacement d’origine
 Dans le panneau Affectations, utilisez l’une des méthodes suivantes :

Sélectionnez l’affectation manquante (elle est encore répertoriée dans le panneau), puis choisissez Mettre à jour les
affectations sélectionnées dans le menu du panneau.

Dans le menu du panneau, choisissez Mettre à jour toutes les affectations.
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Pour modifier l’emplacement de l’affectation
 Pour recréer le fichier d’affectation à un nouvel emplacement, dans le panneau Affectations, utilisez l’une des méthodes suivantes :

Sélectionnez l’affectation et choisissez Modifier l’emplacement de l’affectation dans le menu du panneau. Spécifiez un
emplacement et un nom pour le nouveau fichier.

Cliquez deux fois sur le nom de l’affectation. Dans la boîte de dialogue Options d’affectation, cliquez sur le bouton Modifier
pour définir l’emplacement et le nom du nouveau fichier.

Correction des erreurs
Si vous avez commis une erreur, vous pouvez annuler les modifications effectuées depuis la dernière activation de la commande Enregistrer et
restaurer le contenu à partir du système de fichiers.

Etant donné qu’InDesign enregistre automatiquement tout fichier de contenu InCopy modifiable lors de l’enregistrement d’un document, la
commande Annuler Extraire restaure l’état des articles lors du dernier enregistrement du document.

 Utilisez l’une des méthodes suivantes :

Pour annuler la dernière modification effectuée, choisissez Edition > Annuler [action].

Pour annuler toutes les modifications effectuées depuis le dernier enregistrement du document, choisissez Fichier > Version
précédente.

Pour annuler les modifications effectuées depuis le dernier enregistrement et supprimer le fichier de verrouillage, sélectionnez
le contenu dans le panneau Affectations et choisissez la commande Annuler Extraire dans le menu du panneau. Le contenu
est alors accessible en lecture seule et les autres utilisateurs peuvent l’extraire.

Remplacement des fichiers de verrouillage (InDesign)
Les utilisateurs peuvent ne pas immédiatement réaliser l’effet de leurs actions sur les autres membres du flux de production, ce qui peut créer des
conflits entre l’état du contenu et les autorisations. Si nécessaire, l’utilisateur d’InDesign peut résoudre les conflits en rompant le lien d’un fichier
verrouillé extrait pour un utilisateur différent et en reprenant le contrôle exclusif du fichier. Lorsque vous rompez le lien d’un fichier, le contenu est
stocké dans le document InDesign, mais il n’est plus partagé avec InCopy.

Rupture du lien de fichiers de contenu (InDesign)
Si nécessaire (en raison d’un délai de production, par exemple), les utilisateurs d’InDesign peuvent retirer un fichier de contenu du flux de
production géré et du panneau Liens en rompant son lien. Si vous souhaitez que le contenu puisse être à nouveau modifié, vous devez le
réexporter en tant que contenu InCopy en utilisant un nom de fichier différent. Cela permet d’éviter que le fichier de verrouillage empêche les
utilisateurs de modifier le fichier.
Remarque : lorsque vous rompez le lien de vos propres fichiers extraits, ces fichiers et les fichiers de verrouillage sont supprimés du flux de
production et du disque. Vous pouvez réexporter le contenu et remplacer le nom de fichier sans provoquer de conflit.

 Pour rompre le lien d’un fichier de contenu InCopy, dans le panneau Liens, sélectionnez le fichier (extension .icml ou .incx) et choisissez la
commande Rompre le lien dans le menu du panneau. La rupture du lien entraîne l’intégration du contenu dans le document et supprime le lien
vers le fichier InCopy sur le disque.
Pour rétablir le lien du fichier, choisissez Edition > Annuler Rompre le lien.

Vous pouvez également rompre le lien en supprimant un bloc ou en utilisant le panneau Liens d’InDesign pour rétablir le lien d’un fichier de
contenu à un autre fichier. Vous pouvez aussi sélectionner l’article dans le panneau Affectations et le faire glisser vers l’icône de la corbeille.

Importation de fichiers InCopy dans des documents InDesign
Même si un flux de production commence en général dans InDesign, où la mise en page de base et les balises d’emplacement du texte et des
graphiques sont définis et exportés vers InCopy, un autre flux de production peut démarrer avec un fichier de contenu InCopy autonome (.icml ou
.incx) que vous importez dans InDesign à l’aide de la commande Fichier > Importer.

Tenez compte des règles suivantes lors de l’importation de fichiers de contenu dans un document InDesign :

Les styles Si des styles ont été appliqués au fichier de contenu InCopy, ils sont ajoutés à la liste de styles InDesign pour le document. En cas de
conflit des noms de styles, InDesign écrase le style importé et le remplace par le style existant.
l’option Modifier la mise en page Vous pouvez créer une géométrie élémentaire de mise en page pour le contenu dans InDesign, puis créer le
texte et les styles, ou les importer à partir d’une application de traitement de texte. Les fichiers texte importés dans InCopy sont incorporés au
document InCopy et ne sont pas liés à un fichier externe.
Importation/duplication Si vous importez un fichier de contenu InCopy plusieurs fois, chaque occurrence du contenu apparaît dans le panneau
Liens d’InDesign, mais ces occurrences sont toutes gérées comme un seul fichier de contenu. La règle est la même pour toute copie exacte d’un
fichier de contenu (par duplication).
Remarque : si vous copiez et collez une partie du texte d’un fichier de contenu InCopy géré, cela entraîne la création d’un nouveau fichier de



 

contenu sans aucun lien avec l’original ou avec un fichier externe (InCopy ou autre). Il est possible d’éditer l’original et les parties collées
indépendamment.
Mises à jour/gestion Lorsque plusieurs occurrences d’un fichier de contenu géré se trouvent dans un document InDesign, elles se comportent
comme si elles étaient ouvertes dans deux applications. Par exemple, l’extraction d’une occurrence du fichier de contenu a pour effet de verrouiller
toutes les autres occurrences, ce qui permet de modifier uniquement l’occurrence extraite. Dans ce cas, vous devez utiliser la commande Mise à
jour appropriée pour mettre à jour les autres occurrences (ouvertes) du contenu.
Voir aussi
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Ouverture de contenu partagé
Seuls les utilisateurs d’InCopy peuvent ouvrir les fichiers d’affectation (.inca). Lorsqu’un utilisateur d’InCopy ouvre un fichier InDesign contenant
des affectations, il a accès à tout le contenu géré, quelles que soient les affectations.

 Utilisez l’une des méthodes suivantes :

Dans InCopy, choisissez la commande Fichier > Ouvrir, sélectionnez un fichier d’affectation (.icma ou .inca), puis cliquez sur la
commande Ouvrir.

Dans InDesign ou InCopy, choisissez Fichier > Ouvrir, sélectionnez un fichier InDesign (.indd) comportant du contenu affecté,
puis cliquez sur Ouvrir.

Ouvrez un assemblage d’affectation (voir la section Réception d’assemblages (InCopy)).

Les noms des affectations et leur contenu s’affichent dans le panneau Affectations.

Extraction de contenu
Lors de l’extraction d’un élément, un fichier de verrouillage masqué (.idlk) est placé sur le système de fichiers. Une fois le contenu extrait, vous
disposez du contrôle exclusif de son contenu. Les autres utilisateurs ne sont pas autorisés à effectuer des modifications. Vous pouvez extraire le
contenu InCopy uniquement ; vous ne pouvez pas extraire les documents InDesign comportant des informations de mise en page.

Si vous tentez de fermer un document InDesign contenant un ou plusieurs fichiers de contenu InCopy que vous avez extraits, l’application affiche
un message d’avertissement vous demandant d’archiver tout le contenu. Si vous fermez le document sans en archiver les fichiers de contenu, ils
resteront extraits pour vous à sa prochaine ouverture. Lors de l’enregistrement du document InDesign, tous les fichiers de contenu InCopy
modifiables sont automatiquement enregistrés.

Pour extraire du contenu (InDesign)
 Utilisez l’une des méthodes suivantes :

Dans la mise en page, sélectionnez les blocs de texte ou les blocs graphiques à modifier et choisissez Edition > InCopy >
Extraire.

Dans le panneau Affectations, sélectionnez les fichiers et choisissez Extraire dans le menu du panneau.

Lors de l’extraction du contenu disponible dans InDesign, l’icône Modification  est affichée sur le bloc InDesign. Dans InCopy, l’icône En cours
d’utilisation  s’affiche dans le bloc InCopy et dans le panneau Affectations si les fichiers d’affectation sont stockés sur un serveur local.

Pour extraire du contenu (InCopy)
1. Utilisez l’une des méthodes suivantes :

Si le contenu souhaité appartient à l’affectation, choisissez la commande Fichier > Ouvrir, puis sélectionnez le fichier
d’affectation (.imca ou .inca).

Si le contenu souhaité a été exporté dans des fichiers individuels, choisissez Fichier > Ouvrir, puis sélectionnez le fichier
InCopy (.icml ou .incx). Pour afficher la mise en page afin d’effectuer le calibrage, sélectionnez le document InDesign.
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2. Utilisez l’une des méthodes suivantes :

Pour extraire un fichier de contenu InCopy, choisissez Fichier > Extraire.

Pour extraire tout le contenu d’une affectation, sélectionnez l’affectation dans le panneau Affectations et choisissez
Extraire dans le menu du panneau.

Pour extraire des éléments individuels d’une affectation, ouvrez la liste des affectations dans le panneau Affectations,
sélectionnez un ou plusieurs éléments et choisissez Extraire dans le menu du panneau.

L’icône Modification  s’affiche en regard des éléments dans le panneau Affectations, indiquant que le contenu est extrait et
qu’il est réservé à votre usage.

3. Si vous êtes invité à mettre à jour le contenu avec les modifications, cliquez sur OK.

Lors de l’extraction du contenu disponible dans InCopy, l’icône Modification  s’affiche sur le bloc InCopy et dans le panneau Affectations. Dans
InDesign, l’icône En cours d’utilisation  s’affiche dans le bloc InDesign.

Ouverture de fichiers gérés (InCopy)
Pour rédiger un texte et effectuer des modifications rapidement, il est conseillé d’ouvrir un fichier de contenu géré (.icml ou .incx) directement dans
InCopy et de l’utiliser en mode Article. Il est inutile d’extraire un fichier géré indépendant pour le modifier ; InCopy s’en charge automatiquement.
Après l’enregistrement et la fermeture du fichier, InCopy l’archive automatiquement. Les commandes Enregistrer sont différentes lorsque vous
ouvrez des fichiers indépendants.

Mise à jour des fichiers d’affectation (InDesign)
Vous pouvez enregistrer les modifications manuellement dans les affectations lorsque vous fermez le document en cours. La seule méthode pour
rendre les modifications de mise en page disponibles aux utilisateurs d’InCopy consiste à mettre à jour un fichier d’affectation.

 Utilisez l’une des méthodes suivantes :

Pour mettre à jour les affectations sélectionnées, sélectionnez-les dans le panneau Affectations, puis choisissez Mettre à jour
les affectations sélectionnées dans le menu du panneau.

Pour mettre à jour toutes les affectations obsolètes dans le document en cours, choisissez la commande Mettre à jour les
affectations obsolètes dans le menu du panneau Affectations. Seules les affectations obsolètes sont mises à jour.

Pour mettre à jour toutes les affectations dans le document en cours, choisissez la commande Mettre à jour toutes les
affectations dans le menu du panneau Affectations.

Remarque : si un utilisateur InCopy a ouvert une affectation que vous mettez à jour, l’icône Obsolète  s’affiche en regard de l’affectation dans le
panneau Affectations d’InCopy.

Mise à jour de contenu
Pour vous assurer que vous utilisez le dernier contenu, vérifiez si le panneau Affectations contient des icônes Obsolète et mettez à jour le contenu
en conséquence. La mise à jour d’un fichier d’affectation InCopy et de son contenu ou de fichiers de contenu indépendants entraîne la copie des
données de la copie du système de fichiers la plus récente afin que la version affichée sur votre ordinateur corresponde à celle du système de
fichiers. La mise à jour ne nécessite ni archivage ni extraction et ne donne aucune autorisation d’édition. Elle peut toutefois poser certains
problèmes si un autre utilisateur a supprimé votre verrouillage.

Remarque : la mise à jour du contenu ne suffit pas à mettre à jour le contenu des assemblages d’affectation qui n’ont pas été renvoyés.
Exemple de mise à jour du flux de production :

1. L’utilisateur d’InCopy ouvre un fichier d’affectation ou extrait un fichier de contenu indépendant et modifie son contenu.

2. L’utilisateur d’InCopy enregistre le fichier de contenu (ce qui revient à mettre à jour sa version sur le système de fichiers) et
continue son travail.

3. Dans InDesign, l’icône Obsolète  s’affiche dans les panneaux Affectations et Liens en regard de la sélection, et les icônes
En cours d’utilisation  et Le contenu textuel est obsolète  ou Le contenu graphique est obsolète  s’affichent sur le bloc
associé.
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Panneau Affectations avec icônes En cours d’utilisation et Obsolète (à gauche), et mise en page avec contenu obsolète (à
droite)

4. L’utilisateur d’InDesign met le contenu à jour.

Pour mettre à jour du contenu lors de l’ouverture d’un document géré (InDesign)
1. Choisissez Fichier > Ouvrir, sélectionnez le fichier texte de votre choix, puis cliquez sur Ouvrir.
2. Cliquez sur Oui après l’affichage du message pour mettre à jour le document avec le contenu modifié sur le système de

fichiers.
3. Utilisez l’une des méthodes suivantes :

Pour permettre à InDesign de mettre à jour les liens, cliquez sur Réparer les liens automatiquement.

Pour réparer les liens manuellement, cliquez sur Ne pas réparer, puis sélectionnez le fichier à mettre à jour et choisissez
Mettre à jour le lien dans le menu du panneau Liens.

Pour mettre à jour du contenu au cours de son utilisation (InDesign)
 Utilisez l’une des méthodes suivantes :

Sélectionnez un bloc de texte ou un bloc graphique dans la mise en page et choisissez Edition > InCopy > Mettre à jour le
contenu.

Dans le panneau Liens, sélectionnez un bloc de texte ou un bloc graphique, puis cliquez sur le bouton Mettre à jour le lien 
ou choisissez Mettre à jour le lien dans le menu du panneau Affectations.

Pour mettre à jour du contenu au cours de son utilisation (InCopy)
 Utilisez l’une des méthodes suivantes :

Placez le point d’insertion dans un bloc de texte pour le sélectionner, puis choisissez Fichier > Mettre à jour le contenu.

Dans le panneau Affectations, sélectionnez le contenu, puis cliquez sur le bouton Mettre à jour le contenu  ou choisissez
Mettre à jour le contenu dans le panneau Affectations.

Vous pouvez également mettre à jour le contenu à l’aide du panneau Liens.

Mise à jour accidentelle
Dans la plupart des cas, les commandes de mise à jour sont désactivées pour un contenu extrait, le contenu étant constamment à jour. Toutefois,
une situation inopportune peut se présenter si un autre utilisateur supprime le verrou du contenu extrait en déposant le fichier de verrouillage (.idlk)
dans la corbeille et modifie le contenu. Dans ce cas, les commandes de mise à jour peuvent être activées même si vous avez extrait le contenu,
ce qui permet à deux personnes de modifier le contenu en même temps. Les mises à jour du contenu seraient alors perdues. Pour des résultats
optimaux, ne supprimez pas les fichiers de verrouillage.

Mise à jour de la mise en page InDesign
Les utilisateurs d’InDesign peuvent modifier la mise en page (par exemple, modifier la taille et l’emplacement des blocs de texte d’un article) et
enregistrer les modifications pendant que les utilisateurs d’InCopy modifient le texte de ces blocs. Dans un flux de production de serveur partagé,
la manière dont les utilisateurs InCopy sont avertis des modifications de mise en page varie selon qu’ils ont ouvert un fichier d’affectation ou extrait
des fichiers de contenu indépendants et ouvert le fichier InDesign lié.

Gardez les points suivants à l’esprit :

Si un utilisateur d’InDesign modifie la mise en page des blocs d’une affectation, l’utilisateur doit mettre à jour l’affectation afin
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de rendre les modifications de maquette disponibles aux utilisateurs d’InCopy. InDesign ne met pas automatiquement les
fichiers d’affectation à jour lors de l’enregistrement du document.

Une fois que l’utilisateur InDesign a mis à jour l’affectation se trouvant sur un serveur partagé, l’icône Obsolète  s’affiche en
regard de l’affectation dans le panneau Affectations d’InCopy. L’utilisateur d’InCopy doit mettre à jour la maquette pour afficher
la mise en page actuelle.

Si un utilisateur InDesign modifie la mise en page d’un contenu exporté qui n’appartient pas à une affectation, l’icône Obsolète
s’affiche en regard du nom du document InDesign dans le panneau Affectations et la barre de titre du document signale que la
mise en page est obsolète. Les utilisateurs d’InCopy peuvent mettre à jour le document InDesign actif avec les dernières
modifications de mise en page et de style.

La mise à jour de la mise en page dans InCopy est utile pour les tâches de calibrage, l’aspect le plus récent de la mise en page (avec sauts de
lignes) étant visible dans les modes Mise en page et Epreuve en placard.

 Utilisez l’une des méthodes suivantes :

Si vous avez ouvert un fichier d’affectation et que le panneau Affectations affiche l’icône Obsolète  en regard du nom de
l’affectation, cliquez sur le bouton Mettre à jour la maquette  ou choisissez la commande Fichier > Mettre à jour la maquette.
Il est impossible d’annuler cette commande.

Si vous n’utilisez pas de fichiers d’affectation et que plusieurs documents InDesign sont ouverts, sélectionnez celui que vous
souhaitez rendre actif, puis choisissez Fichier > Mettre à jour la maquette.

Archivage du contenu
Lors de l’archivage d’un fichier de contenu géré, ce fichier est enregistré dans un emplacement partagé d’un système de fichiers. Il peut ensuite
être extrait par d’autres utilisateurs pour modification. Les blocs de texte et les blocs graphiques exportés depuis InDesign sont également
archivés automatiquement.

Bien qu’un fichier archivé soit accessible en modification, il n’est pas véritablement modifiable avant son extraction (sauf si vous éditez le contenu
en mode autonome dans InCopy). L’archivage du contenu entraîne l’arrêt du contrôle de l’édition, mais pas la fermeture du fichier. Le contenu
reste ouvert à l’écran, mais en mode lecture seule.

Les modules externes LiveEdit Workflow créent une seule version de fichier. La version précédente de chaque fichier est automatiquement
écrasée lors de sa mise à jour dans InCopy ou InDesign.

Si vous travaillez sur un assemblage d’affectation, renvoyez-le ou transférez-le après l’avoir archivé.

Pour archiver du contenu géré (InDesign)
 Utilisez l’une des méthodes suivantes :

Sélectionnez le contenu dans la mise en page et choisissez Edition > InCopy > Archiver.

Dans le panneau Affectations, sélectionnez le contenu et choisissez Archiver dans le menu du panneau.

Pour archiver du contenu géré (InCopy)
 Utilisez l’une des méthodes suivantes :

Sélectionnez le contenu en mode Mise en page et choisissez Fichier > Archiver.

Dans le panneau Affectations, sélectionnez le contenu et choisissez Archiver dans le menu du panneau.

Remarque : vous pouvez annuler les modifications les plus récentes avant d’archiver le contenu.
Lorsque vous archivez un fichier, l’icône Disponible s’affiche sur les blocs de texte et les blocs graphiques dans la mise en page InDesign, le
mode Mise en page d’InCopy, le panneau Affectations et la barre d’articles (InCopy).

Enregistrement des modifications (InDesign)
Lorsque vous travaillez sur un contenu extrait, vous pouvez enregistrer et mettre à jour sa version sur le système de fichiers.

 Utilisez l’une des méthodes suivantes :

Pour enregistrer le contenu ailleurs que dans le document InDesign ou ses fichiers liés, sélectionnez le contenu dans la mise
en page et choisissez Edition > InCopy > Enregistrer le contenu.

Pour enregistrer tous les fichiers de contenu extraits sous votre nom, choisissez Fichier > Enregistrer. Ce type
d’enregistrement ne met pas automatiquement à jour les fichiers d’affectation ou les fichiers de contenu extraits dans InCopy.
Cependant, le panneau Affectation des fichiers extraits dans InCopy affiche l’icône Obsolète .

Pour enregistrer le document InDesign sous un nouveau nom avec des liens vers les fichiers InCopy existants, choisissez
Fichier > Enregistrer sous. Les affectations du fichier InDesign sont alors présentées comme manquantes, jusqu’à leur mise à
jour.
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Pour enregistrer une copie du document actif en cours, choisissez Fichier > Enregistrer une copie. Vous pouvez choisir de
donner un nouveau nom et un nouvel emplacement à la copie, ainsi que des liens vers tout fichier InCopy approprié.

Enregistrement des modifications (InCopy)
 Utilisez l’une des méthodes suivantes :

Pour enregistrer le fichier InCopy sous le même nom et au même emplacement sur le système de fichiers, choisissez Fichier >
Enregistrer le contenu. Le fichier reste extrait pour vous pendant le processus.

Pour enregistrer le fichier de contenu InCopy sous un nouveau nom, choisissez Fichier > Enregistrer le contenu sous. Le
fichier de contenu créé n’est pas géré dans le flux de production. La commande Enregistrer le contenu sous est uniquement
disponible si vous avez ouvert le fichier de contenu InCopy (.icml ou .incx) directement.

Pour enregistrer une copie du fichier de contenu InCopy actif, choisissez Fichier > Enregistrer une copie du contenu. Vous
pouvez choisir de donner un nouveau nom et un nouvel emplacement à la copie. La copie enregistrée n’est pas gérée dans le
flux de production. La commande Enregistrer une copie du contenu est uniquement disponible si vous avez ouvert le fichier de
contenu InCopy (.icml ou .incx) directement.

Pour enregistrer tous les fichiers de contenu InCopy extraits et ouverts, choisissez Fichier > Enregistrer tout le contenu. Cette
commande enregistre tous les fichiers à leur emplacement actuel. La commande Enregistrer tout le contenu est uniquement
disponible si vous avez ouvert un fichier d’affectations ou un fichier InDesign.

Voir aussi
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Zoom avant ou arrière
Réglage de l’affichage
Accès aux pages
Fenêtres supplémentaires
Lissage des contours
Faux texte
Calcul de valeurs dans les panneaux et les boîtes de dialogue
Saisie de valeurs dans les panneaux et les boîtes de dialogue

Zoom avant ou arrière
L’outil Zoom ou les commandes Zoom vous permettent de modifier la taille des documents.

Pour effectuer un zoom avant ou arrière
Pour effectuer un zoom avant, sélectionnez l’outil Zoom  et cliquez sur la section que vous souhaitez agrandir. Chaque clic
permet d’accéder au niveau de zoom supérieur (les différents niveaux étant prédéfinis). Les éléments affichés sont recentrés
par rapport à l’endroit de la page où vous avez cliqué. Lorsque vous atteignez le niveau de zoom maximal, la partie centrale
de l’outil Zoom devient blanche. Pour effectuer un zoom arrière, maintenez la touche Alt (Windows) ou Option (Mac OS)
enfoncée et cliquez sur la section que vous souhaitez réduire. A chaque clic, la vue est réduite.
Pour accéder au niveau de zoom supérieur, activez la fenêtre concernée et choisissez Affichage > Zoom avant. Pour restaurer
l’affichage au pourcentage prédéfini précédent, choisissez Affichage > Zoom arrière.
Pour définir un niveau d’agrandissement spécifique, saisissez un niveau ou choisissez-en un dans la zone Niveau de zoom de
la barre de l’application.

Sous Mac OS, vous pouvez afficher le facteur de zoom dans la barre d’état en masquant la barre de l’application
(commande Fenêtre > Barre de l’application). Sous Windows, il est impossible de masquer la barre de l’application.

Pour effectuer un zoom avant ou arrière, appuyez sur la touche Alt (Windows) ou Option (Mac OS) tandis que vous utilisez la
roulette de défilement ou le capteur de la souris.
Pour effectuer un zoom avant par glisser-déplacer, activez l’outil Zoom et créez un cadre de sélection par glisser-déplacer
autour de la zone à agrandir.

Pour utiliser le zoom
Le zoom vous offre un moyen rapide pour parcourir les pages de votre document. A l’aide de l’outil de sélection en forme de main, vous pouvez
effectuer un zoom avant ou arrière et avancer dans l’ensemble du document. Cette fonction est particulièrement utile pour les documents
comportant un grand nombre de pages.

1. Sélectionnez l’outil Sélection .

Pour activer la main de sélection, vous pouvez aussi appuyer sur la barre d’espace ou maintenir la touche Alt/Option
enfoncée en mode Texte.

2. En veillant à ce que la main de sélection soit active, cliquez et maintenez le bouton de la souris enfoncé.

Un zoom arrière est effectué sur le document pour afficher une plus grande partie de la planche. Un cadre rouge indique la
zone de visualisation.

3. Tout en continuant à maintenir le bouton de la souris enfoncé, faites glisser le cadre rouge pour faire défiler les pages du
document. Appuyez sur les touches fléchées ou utilisez la molette de défilement de la souris pour modifier la taille du cadre
rouge.

4. Relâchez le bouton de la souris pour zoomer sur la nouvelle zone du document.

La fenêtre du document revient au pourcentage de zoom d’origine ou à la taille du cadre rouge.

Pour afficher le document à sa taille réelle
Cliquez deux fois sur l’outil Zoom.
Choisissez Affichage > Taille réelle.
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Saisissez ou choisissez un niveau d’agrandissement de 100 % dans la zone Niveau de zoom de la barre de l’application.

Réglage de l’affichage
Vous pouvez axer l’affichage sur une certaine zone du document en ajustant les pages et les planches au sein de la fenêtre active et en faisant
défiler l’affichage.

Ajustement de la page, de la planche ou de la table de montage à la fenêtre active
Choisissez la commande Affichage > Ajuster la page à la fenêtre.
Choisissez la commande Affichage > Ajuster la planche à la fenêtre.
Choisissez Affichage > Table de montage.

Défilement de l’affichage
Plusieurs méthodes permettent de faire facilement défiler les objets ou les pages dans la fenêtre de document. Ces méthodes peuvent également
être utiles pour se déplacer d’une page à l’autre.

 Utilisez l’une des méthodes suivantes :

Sélectionnez l’outil Main  dans le panneau Outils, puis cliquez et faites glisser le pointeur dans la fenêtre de document.
Vous pouvez activer temporairement l’outil Main en appuyant sur la touche Alt (Windows) ou Option (Mac OS) et la barre
d’espace.

Cliquez sur la barre de défilement verticale ou horizontale ou faites glisser le curseur de défilement.

Utilisez les touches Pg suiv et Pg préc.

Utilisez la roulette de défilement ou le capteur de la souris pour faire défiler vers le haut ou le bas. Pour faire glisser le contenu
vers la gauche ou la droite, appuyez sur la touche Ctrl (Windows) ou Commande (Mac OS) tout en utilisant la roulette de
défilement ou le capteur de la souris.

Accès aux pages
Dans InDesign, vous pouvez facilement accéder aux différentes pages d’un document. Par exemple, comme la plupart des navigateurs Web
disposant des boutons Précédent et Suivant pour accéder aux pages déjà consultées, InDesign garde en mémoire l’ordre des pages du document
successivement affichées.

 Utilisez l’une des méthodes suivantes :

Pour parcourir les pages selon leur ordre d’affichage lors de la session en cours, choisissez Page > Précédent ou Suivant.

Pour accéder à la page suivante ou précédente, cliquez sur le bouton Page suivante  ou Page précédente  au bas de la
fenêtre de document, ou choisissez la commande Page > Page suivante ou Page précédente.

Pour accéder à la première ou à la dernière page, cliquez sur le bouton Première planche  ou Dernière planche , au bas de
la fenêtre de document, ou choisissez la commande Page > Première page ou Dernière page.

Pour accéder à une page spécifique, choisissez la commande Page > Atteindre la page, indiquez le numéro de page souhaité
et cliquez sur le bouton OK. Vous pouvez également cliquer sur le bouton flèche bas situé à droite de la zone de page, puis
sélectionner une page.

Pour accéder à une page spécifique, sélectionnez cette page dans la zone de page.

Pour atteindre un gabarit, cliquez dans la zone de page située dans le coin inférieur gauche de la fenêtre de document. Entrez
les premières lettres du nom du gabarit et appuyez sur Entrée (Windows) ou Retour (Mac OS). Vous pouvez aussi cliquer
deux fois sur l’icône du gabarit dans le panneau Pages.

Fenêtres supplémentaires
Il est possible d’afficher le document actif ou d’autres documents InDesign dans des fenêtres supplémentaires. L’utilisation de fenêtres
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supplémentaires vous permet de comparer simultanément diverses planches, en particulier lorsqu’elles ne sont pas adjacentes. Vous pouvez
également afficher une même page suivant différents niveaux de zoom, pour modifier une section spécifique et vérifier l’impact de ces
modifications sur l’ensemble de la page. De plus, il est possible d’afficher un gabarit dans une fenêtre et des pages dépendantes de celui-ci dans
d’autres fenêtres, pour vérifier l’impact sur diverses parties du document des modifications apportées au gabarit.

Lorsque vous rouvrez le document, seule la dernière fenêtre utilisée s’affiche.

Pour créer une nouvelle fenêtre pour le même document, choisissez Fenêtre > Disposition > Nouvelle fenêtre.
Pour afficher les fenêtres en cascade ou en mosaïque, choisissez Fenêtre > Disposition > Cascade pour superposer les
fenêtres avec un léger décalage. Choisissez Fenêtre > Disposition > Mosaïque pour disposer les fenêtres les unes à côté des
autres, de sorte qu’elles ne se chevauchent pas.
Pour activer une fenêtre, cliquez sur l’onglet ou la barre de titre de la fenêtre. Vous pouvez également choisir le nom de la
fenêtre dans le menu Fenêtre. Si un document est ouvert dans plusieurs fenêtres, celles-ci sont numérotées dans l’ordre de
leur création.
Pour fermer toutes les fenêtres du document actif, appuyez sur les touches Maj+Ctrl+W (Windows) ou
Maj+Commande+W (Mac OS).
Pour fermer toutes les fenêtres de l’ensemble des documents ouverts, appuyez sur les touches Maj+Ctrl+Alt+W (Windows) ou
Maj+Commande+Option+W (Mac OS).

Lissage des contours
Le lissage est une technique de suppression du crénelage du contour des caractères et des images bitmap, reposant sur l’atténuation de la
transition des couleurs entre les pixels du contour et les pixels du fond. Les modifications s’appliquent uniquement aux pixels du contour.

1. Choisissez Edition > Préférences > Performances d’affichage (Windows) ou InDesign > Préférences > Performances
d’affichage (Mac OS).

2. Dans le menu Réglage de l’affichage, choisissez le paramètre d’affichage pour lequel vous souhaitez activer le lissage.

Vous pouvez activer ou désactiver le lissage pour chacun des paramètres d’affichage. Par exemple, vous pouvez l’activer
pour l’affichage Qualité supérieure et le désactiver pour l’affichage Rapide.

3. Sélectionnez Lissage.

Faux texte
Lorsque les fonctions d’affichage ne permettent pas d’afficher du texte en petits caractères, InDesign affiche le texte sous la forme d’une barre
grisée. On parle alors de faux texte. Les caractères dont le corps est inférieur ou égal au corps défini sont remplacés à l’écran par des formes
standard utilisées comme texte de substitution.

1. Choisissez Edition > Préférences > Performances d’affichage (Windows) ou InDesign > Préférences > Performances
d’affichage (Mac OS).

2. Dans le menu Réglage de l’affichage, choisissez le paramètre d’affichage pour lequel vous souhaitez modifier le paramètre de
faux texte.

Vous pouvez spécifier des valeurs de faux texte différentes pour chaque paramètre d’affichage.

3. Définissez l’option Seuil de faux texte sur la valeur voulue, puis cliquez sur le bouton OK.

Pour savoir s’il faut créer du faux texte et de fausses images lorsque vous faites défiler un document, affichez la section Interface de la boîte de
dialogue Préférences, faites glisser le curseur de l’outil Main vers le niveau de performance souhaité par opposition à la qualité, puis cliquez sur le
bouton OK.

Calcul de valeurs dans les panneaux et les boîtes de dialogue
Il est possible d’effectuer des opérations mathématiques simples dans une zone d’édition numérique. Par exemple, pour déplacer un objet
sélectionné de trois unités sur la droite en utilisant les unités de mesure actives, il n’est pas nécessaire de définir la nouvelle position horizontale. Il
suffit de taper +3 après la valeur courante dans le panneau Transformation.

Les panneaux utilisent le système de mesure sélectionné dans la boîte de dialogue Préférences, mais vous pouvez spécifier des valeurs dans
d’autres unités de mesure.

1. Utilisez l’une des méthodes suivantes dans une zone de texte acceptant les valeurs numériques :

Pour remplacer la valeur active par une expression mathématique, sélectionnez cette valeur.

Pour utiliser la valeur active dans une expression mathématique, cliquez avant ou après cette valeur.

2. Entrez une expression mathématique simple avec un opérateur simple, tel que + (plus), - (moins), * (multiplication), / (division)
ou % (pourcentage).
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Par exemple, 0p0 + 3 ou 5 mm + 4.

3. Appuyez sur la touche Entrée ou Retour pour effectuer l’opération.

Dans les panneaux Contrôle et Transformation, vous pouvez dupliquer l’objet sélectionné et appliquer le calcul à la copie (au lieu de l’appliquer
à l’original). Entrez le calcul et appuyez sur les touches Alt+Entrée (Windows) ou Option+Retour (Mac OS).

Saisie de valeurs dans les panneaux et les boîtes de dialogue
Les unités de mesure et les incréments utilisés dans les panneaux et les boîtes de dialogue sont ceux définis dans la boîte de dialogue Edition >
Préférences > Unités et incréments (Windows) ou InDesign > Préférences > Unités et incréments (Mac OS). Toutefois, il est possible de spécifier
les valeurs dans toute autre unité de mesure prise en charge, en remplaçant provisoirement les préférences actives.

 Utilisez l’une des méthodes suivantes :

Entrez une valeur dans la zone et appuyez sur Entrée ou Retour.

Faites glisser le curseur.

Placez le cadran.

Cliquez sur les boutons fléchés du panneau pour modifier la valeur.

Cliquez dans la zone concernée, puis utilisez les touches flèche haut et flèche bas du clavier pour modifier la valeur.

Choisissez une valeur dans le menu associé à la zone de texte.

Remarque : InDesign applique instantanément les modifications effectuées à l’aide des boutons de sélection numérique, des touches de direction
ou des menus contextuels.
Voir aussi
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A propos des préférences et des paramètres par défaut
Les préférences se composent de paramètres tels que l’emplacement des panneaux, les options de mesure et les options d’affichage des
graphiques et des caractères typographiques. Vous pouvez définir les paramètres des documents et des objets InDesign en modifiant les
préférences.

Définition des préférences générales
Cette section décrit les paramètres de préférence de l’onglet Général de la boîte de dialogue Préférences. Pour plus de détails sur les autres
préférences, recherchez le paramètre approprié.

1. Choisissez la commande Edition > Préférences > Général (Windows) ou InDesign > Préférences > Général (Mac OS), puis
sélectionnez le type de préférences que vous souhaitez définir.

2. Choisissez une méthode de numérotation de pages dans le menu Affichage de la section Numérotation des pages (voir la
section Pour afficher une numérotation absolue ou par section dans le panneau Pages).

3. Dans la section Téléchargement et incorporation de polices, spécifiez un seuil pour créer un jeu de polices partiel d’après le
nombre de glyphes dans la police. Ce paramètre agit sur les options de téléchargement des polices dans les boîtes de
dialogue d’impression et d’exportation.

4. Dans la section Lors de la mise à l’échelle, vous pouvez spécifier le mode de présentation des objets mis à l’échelle dans les
panneaux et le comportement du contenu des blocs ainsi redimensionnés.

Sélectionnez l’option Appliquer au contenu si vous souhaitez que le corps soit modifié lors de la mise à l’échelle du bloc
de texte (voir la section Mise à l’échelle du texte). Si cette option est activée lorsqu’un bloc graphique est mis à l’échelle,
le pourcentage de taille de l’image change, mais celui du bloc revient à 100 % (voir la section Mise à l’échelle d’objets).

Sélectionnez Ajuster le pourcentage de mise à l’échelle pour faire apparaître le corps d’origine avec le nouveau corps
entre parenthèses lorsque vous mettez le texte à l’échelle. Si cette option est sélectionnée lorsque vous mettez à l’échelle
les blocs graphiques, le pourcentage de taille du bloc et de l’image sont tous les deux modifiés.

5. Cliquez sur Réinitialiser tous les messages d’avertissement pour afficher tous les avertissements, y compris ceux que vous
avez déjà choisis de ne pas afficher (un message d’avertissement s’affiche. Activez la case à cocher pour éviter que ce
message ne réapparaisse).

Définition de paramètres par défaut
Si vous modifiez des paramètres alors qu’aucun document n’est ouvert, les nouveaux paramètres deviennent les paramètres par défaut des
nouveaux documents. Si vous modifiez des paramètres alors qu’un document est ouvert, les modifications s’appliquent uniquement à ce
document.

De la même façon, si vous modifiez des paramètres alors qu’aucun objet n’est sélectionné, les nouveaux paramètres deviennent les paramètres
par défaut des nouveaux objets.

Pour modifier les paramètres par défaut des nouveaux documents
1. Fermez tous les documents.
2. Modifiez les paramètres souhaités au niveau des options de menu, des panneaux et des boîtes de dialogue.

Si vous utilisez le même format de page ou la même langue pour la plupart de vos documents, vous pouvez modifier les paramètres par défaut
correspondants en vous assurant qu’aucun document n’est ouvert. Par exemple, pour modifier le format de page par défaut, fermez tous les
documents, choisissez Fichier > Format de document, puis sélectionnez le format souhaité. Pour définir un dictionnaire par défaut, fermez tous
les documents, choisissez Edition > Préférences > Dictionnaire (Windows) ou InDesign > Préférences > Dictionnaire (Mac OS) et sélectionnez
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une option dans le menu Langue.

Pour définir les paramètres par défaut des nouveaux objets dans un document
1. Vérifiez qu’un document est ouvert, puis choisissez Edition > Tout désélectionner.
2. Modifiez les paramètres souhaités au niveau des options de menu, des panneaux et des boîtes de dialogue.

Rétablissement de l’ensemble des préférences et des paramètres par défaut
Dans les cas où InDesign se comporte de façon imprévisible, la suppression des préférences est souvent un bon moyen de résoudre le problème.

Il est judicieux d’effectuer une copie de sauvegarde des fichiers de préférences nommés InDesign Defaults et InDesign SavedData. Ainsi, plutôt
que de supprimer vos préférences, vous pouvez copier ces fichiers de sauvegarde sur les fichiers de préférences erronés sans perdre vos
paramètres personnalisés.

Mike Witherell propose une liste détaillée des fichiers affectés par la restauration des préférences ; cette liste figure dans le document au
format PDF intitulé Adobe InDesign Presets (en anglais uniquement).

 Utilisez l’une des méthodes suivantes :

(Windows) Lancez InDesign et appuyez sur les touches Maj+Ctrl+Alt. Cliquez sur le bouton Oui lorsque vous êtes invité à
supprimer vos fichiers de préférences.

(Mac OS) Lancez InDesign tout en appuyant sur les touches Maj+Option+Commande+Contrôle. Cliquez sur le bouton Oui
lorsque vous êtes invité à supprimer vos fichiers de préférences.

Un grand nombre de préférences et de paramètres par défaut de programme sont stockés dans les fichiers de préférences Adobe InDesign. Ces
fichiers, y compris le fichier InDesign Defaults, sont sauvegardés à chaque fois que vous quittez InDesign. Pour une suppression manuelle ou un
changement de nom, les emplacements des fichiers de préférences sont les suivants :

Mac OS

InDesign SavedData Users/[utilisateur]/Library/Caches/Adobe InDesign/Version [version]/InDesign SavedData

InDesign Defaults Users/[utilisateur]/Library/Preferences/Adobe InDesign/Version [version]/InDesign Defaults

Windows XP

InDesign SavedData \Documents and Settings\[nom d’utilisateur]\Local Settings\Application Data\Adobe\InDesign\Version
[version]\Caches

InDesign Defaults \Documents and Settings\[nom d’utilisateur]\Application Data\Adobe\InDesign\Version [version]

Windows Vista ou Windows 7

InDesign SavedData Users\[nom d’utilisateur]\AppData\Roaming\Adobe\InDesign\Version [version]\Caches\InDesign
SavedData

InDesign Defaults C:\Users\[nom d’utilisateur]\AppData\Roaming\Adobe\InDesign\Version [version]\InDesign Defaults

A propos des styles et des paramètres prédéfinis InDesign
Il est possible d’enregistrer des paramètres pour les réutiliser ultérieurement. Vous pouvez notamment enregistrer les paramètres définis lors des
procédures suivantes :

Création de styles de paragraphe et de caractère (voir la section Ajout de styles de paragraphe et de caractère).

Création de styles d’objets (voir la section Styles d’objet).

Création de styles de tableau et de cellule (voir la section Styles de tableau et de cellule).

Création de paramètres d’exportation PDF prédéfinis (voir la section Personnalisation des paramètres prédéfinis Adobe PDF).

Création de paramètres d’impression prédéfinis. Tous les attributs de la boîte de dialogue d’impression figurent dans un style
d’impression (voir la section Impression d’un document ou d’un livre).

Création de paramètres de recouvrement prédéfinis (voir la section Recouvrement des couleurs).

Création de paramètres d’aplatissement des transparences prédéfinis (voir la section Aplatissement d’une illustration avec
transparence).

Création de styles de tables des matières (voir la section Création de styles de tables des matières pour plusieurs listes).

Enregistrement de la configuration de l’espace de travail.

Création de paramètres prédéfinis de document (voir la section Définition de paramètres prédéfinis de document).

Création de styles de contour (voir la section Définition de styles de contour personnalisés).

http://www.indesignusergroup.com/chapters/washingtondc/files/729/21_presets-Mike_Witherell.pdf


 

En général, il suffit de modifier les paramètres de la fonction dans la boîte de dialogue correspondante et de les enregistrer. Les styles et les
paramètres prédéfinis sont enregistrés dans le document dans lequel ils ont été créés. Vous pouvez utiliser les paramètres d’un autre document
en important ou en chargeant les styles et les paramètres prédéfinis de ce document. En outre, vous pouvez exporter ou enregistrer la plupart des
paramètres prédéfinis dans un fichier séparé et les distribuer sur d’autres ordinateurs.

Mike Witherell propose une liste détaillée de paramètres prédéfinis dans le document au format PDF intitulé Adobe InDesign Presets (en anglais
uniquement).

De même, vous pouvez partager les styles et les paramètres prédéfinis dans les documents d’un livre. Pour plus de détails, voir la section
Synchronisation des documents de livre.

Informations juridiques   |   Politique de confidentialité en ligne

http://www.indesignusergroup.com/chapters/washingtondc/files/729/21_presets-Mike_Witherell.pdf
http://creativecommons.org/licenses/by-nc-sa/3.0/
http://helpx.adobe.com/fr/legal/legal-notices.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr


Panneau Outils

Haut de la page

Présentation du panneau Outils
Présentation des outils
Galerie d’outils de sélection
Galerie d’outils de dessin et de texte
Galerie d’outils de transformation
Galerie d’outils de modification et de navigation

Présentation du panneau Outils
Certains outils du panneau Outils permettent de sélectionner, modifier et créer des éléments de page. D’autres permettent de choisir un type, une
forme, une ligne ou un dégradé. Vous pouvez modifier la disposition du panneau Outils pour mieux l’adapter à la configuration de la fenêtre
principale et des autres panneaux. Par défaut, le panneau Outils s’affiche sur une seule colonne. Vous pouvez aussi le présenter sur deux
colonnes ou sur une rangée. Il est toutefois impossible de réorganiser les outils à l’intérieur du panneau Outils. Pour déplacer le panneau, faites-le
glisser en plaçant le pointeur sur sa partie supérieure.

Pour sélectionner un outil dans le panneau Outils par défaut, il suffit de cliquer dessus. Le panneau Outils contient également plusieurs outils
masqués liés aux outils visibles. Ces outils masqués sont signalés par une flèche à droite de l’icône de l’outil. Pour sélectionner un outil masqué,
cliquez sur l’outil actif dans le panneau Outils sans relâcher le bouton de la souris, puis choisissez l’outil souhaité.

Le nom de l’outil ainsi que son raccourci clavier apparaissent lorsque vous placez le pointeur sur l’outil : ce texte est appelé info-bulle. Vous
pouvez désactiver les info-bulles en sélectionnant l’option Sans dans le menu Description d’outils des préférences relatives à l’interface.

Ouvrez le panneau Info-bulles des outils (choisissez la commande Fenêtre > Utilitaires > Info-bulles des outils) pour afficher les touches de
raccourci et de modification compatibles avec l’outil sélectionné.

Remarque : les outils Récupérateur de contenu et Importation de contenu ne sont pas accessibles dans CS5.5 ou les versions antérieures.
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Pour afficher le panneau Outils
 Choisissez Fenêtre > Outils.

Pour afficher les options des outils
 Cliquez deux fois sur un outil du panneau Outils.

Cette procédure fonctionne uniquement pour certains outils, comme les outils Pipette, Crayon et Polygone.

Pour afficher et sélectionner un outil masqué
1. Dans le panneau Outils, cliquez sur un outil associé à des outils masqués sans relâcher le bouton de la souris.

2. Lorsque les outils masqués s’affichent, sélectionnez-en un.

Pour sélectionner temporairement des outils
1. Lorsqu’un outil est sélectionné, appuyez sur la touche de raccourci d’un autre outil.
2. Tout en maintenant la touche de raccourci enfoncée, effectuez une action.
3. Relâchez la touche de raccourci pour revenir à l’outil précédent.

Par exemple, si l’outil Espace est sélectionné, maintenez la touche de raccourci V enfoncée pour utiliser temporairement l’outil Sélection. Lorsque
vous relâchez la touche V, l’outil Espace est de nouveau actif.

Pour afficher des info-bulles d’outils
Le panneau Info-bulles des outils décrit le fonctionnement des touches de modification avec l’outil sélectionné.

1. Choisissez la commande Fenêtre > Utilitaires > Info-bulles des outils pour afficher le panneau du même nom.

2. Dans le panneau Outils, sélectionnez un outil afin d’afficher sa description, ainsi que les touches de modification et les
raccourcis qui lui sont associés.

Pour modifier la disposition du panneau Outils
1. Choisissez la commande Edition > Préférences > Interface (Windows) ou InDesign > Préférences > Interface (Mac OS).

2. Choisissez une option de disposition dans le menu Panneau d’outils flottant, puis cliquez sur le bouton OK.

Pour modifier la disposition du panneau Outils, vous pouvez également cliquer sur l’icône de la double flèche située en haut du panneau.

Présentation des outils
Outils Texte Créez et mettez en forme des blocs ou des tracés standard ou personnalisés (voir la section Création de blocs de texte.)
Outils de dessin Dessinez et concevez des objets simples et complexes, comme des rectangles, des ellipses, des polygones ou des formes
libres (voir la section Dessin).
Outils de sélection Sélectionnez (activez) des objets, des points ou des lignes (voir la section Sélection d’objets).
Outils de transformation Modifiez la forme, réorientez et redimensionnez des objets (voir la section Transformation d’objets).
Outils de navigation Déplacez-vous dans les documents, contrôlez leur affichage et mesurez des distances (voir les sections Zoom avant ou
arrière et Règles et unités de mesure).
Outil Ciseaux Scinde les tracés et les blocs (voir la section Fractionnement d’un tracé.)

Galerie d’outils de sélection

L’outil Sélection vous L’outil Sélection directe L’outil Page vous permet de L’outil Espace vous permet
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permet de sélectionner des
objets entiers.

vous permet de sélectionner
des points sur un tracé ou
du contenu dans un bloc.

définir plusieurs formats de
page au sein d’un
document.

de régler l’espacement des
objets.

Galerie d’outils de dessin et de texte

L’outil Plume vous permet
de dessiner des tracés
droits et incurvés.

L’outil Ajout de point
d’ancrage vous permet
d’ajouter des points
d’ancrage à un tracé.

L’outil Suppression de point
d’ancrage vous permet de
supprimer des points
d’ancrage d’un tracé.

L’outil Conversion de point
directeur vous permet de
convertir des sommets et
des arrondis.

L’outil Texte vous permet
de créer des blocs de texte
et de sélectionner du texte.

L’outil Texte curviligne vous
permet de créer et de
modifier du texte sur des
tracés.

L’outil Crayon vous permet
de dessiner une forme libre.

L’outil Arrondi vous permet
de supprimer les angles
superflus sur un tracé.

L’outil Gomme vous permet
de supprimer des points sur
un tracé.

L’outil Trait vous permet de
dessiner un segment de
ligne.

L’outil Bloc rectangulaire
vous permet de créer un
bloc de réservation carré ou
rectangle.

L’outil Bloc elliptique vous
permet de créer un bloc de
réservation circulaire ou
ovale.
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L’outil Bloc polygonal vous
permet de créer un bloc de
réservation à plusieurs
côtés.

L’outil Rectangle vous
permet de créer un carré ou
un rectangle.

L’outil Ellipse vous permet
de créer un cercle ou un
ovale.

L’outil Polygone vous
permet de créer une forme
à plusieurs côtés.

Galerie d’outils de transformation

L’outil Transformation
manuelle vous permet de
faire pivoter, mettre à
l’échelle ou déformer un
objet.

L’outil Rotation vous permet
de faire pivoter des objets
autour d’un point fixe.

L’outil Mise à l’échelle vous
permet de redimensionner
des objets autour d’un point
fixe.

L’outil Déformation vous
permet de déformer des
objets autour d’un point fixe.

Galerie d’outils de modification et de navigation

L’outil Pipette vous permet de
prélever un échantillon de
couleur ou d’attribut de texte à
partir d’un objet et de
l’appliquer à un autre objet.

L’outil Mesure vous permet
de mesurer la distance
entre deux points.

L’outil Nuance de dégradé
vous permet d’ajuster les
points de départ et d’arrivée
ainsi que l’angle des
dégradés dans les objets.

L’outil Contour
progressif dégradé
vous permet de faire
disparaître un objet
dans l’arrière-plan.



L’outil Ciseaux coupe les tracés
à différents points spécifiés.

L’outil Main déplace la page
dans la fenêtre de
document.

L’outil Zoom agrandit et
réduit la fenêtre de
document.

L’outil Note vous
permet d’ajouter des
commentaires.

Voir aussi
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Mise en page et conception

Lier du contenu
Anne-Marie Concepcion  (15 mai 2012)
Didacticiel - vidéo
Regardez ce didacticiel vidéo pour savoir comment créer et mettre à jour les liens entre les objets dans le même document et d’autres.

Revue des outils Formulaires
Anne-Marie Concepcion  (15 mai 2012)
Didacticiel - vidéo
Visite guidée des boutons, boîtes de dialogue et commandes de menu liés aux formulaires dans InDesign. Comparez les anciennes et
nouvelles méthodes de création de formulaires interactifs.

Tester un formulaire dans Acrobat
Anne-Marie Concepcion  (15 mai 2012)
Didacticiel - vidéo
Ce didacticiel vous présente les champs d’un formulaire InDesign dans Acrobat ou Reader. Ensuite, vous apprendrez à continuer de modifier
les champs interactifs dans Acrobat pour bénéficier de fonctionnalités supplémentaires, et comment fonctionne le formulaire dans Acrobat.

Utilisation de blocs
Kelly McCathran  (15 mai 2012)
Didacticiel - vidéo
Tout ce qui est placé dans InDesign se trouve dans un bloc. Vous pouvez créer des blocs à partir de rien, ou si vous "placez" (importez) du
texte ou des images dans un document, InDesign crée automatiquement le bloc pour vous.

Création de références croisées (vidéo 5:45), CS4-CS6
David Blatner  (01er janvier 2011)
Didacticiel - vidéo
Procédure détaillée d’ajout de références croisées. Créez des références croisées, qui peuvent être mises à jour rapidement en cas de
changement du texte cible ou de la pagination. Créez un format personnalisé de référence croisée.

Génération de légendes d’images avec les métadonnées (PDF de 148 Ko)
Référence  (01er janvier 2011)
Bref didacticiel sur la façon de travailler avec les métadonnées et de générer automatiquement des légendes pour les images de votre mise en
page.

Mode Grille et Live Distribute (vidéo 02:48)
Michael Ninness  (01er janvier 2011)
Didacticiel - vidéo
Visualisez la création rapide de grilles à la volée en utilisant les outils de conception qui sont « gridified ».

Légendes dynamiques (vidéo 03:04)
Michael Ninness  (01er janvier 2011)
Didacticiel - vidéo
Visualisez la façon dont InDesign CS5 et les versions ultérieures vous permettent de tirer parti des métadonnées incorporées dans une image
pour créer des légendes dynamiques et les placer automatiquement et aisément dans votre mise en page.

Rendre des graphiques brillants (PDF, 203 Ko)
Mike Rankin  (01er janvier 2011)
Référence
Ce didacticiel montre comment appliquer un effet brillant aux objets de votre mise en page.

Gestion des documents avec plusieurs formats de page (PDF, 136 Ko)
Référence  (01er janvier 2011)

http://tv.adobe.com/watch/learn-indesign-cs6/linking-content/
http://tv.adobe.com/watch/learn-indesign-cs6/reviewing-the-new-forms-tools/
http://tv.adobe.com/watch/learn-indesign-cs6/testing-a-form-in-acrobat/
http://tv.adobe.com/watch/learn-indesign-cs6/working-with-frames/
http://tv.adobe.com/watch/learn-indesign-cs4/creating-crossreferences/
http://www.adobe.com/fr/support/indesign/gettingstarted/pdfs/id_howto_metadata.pdf
http://tv.adobe.com/go/4949
http://tv.adobe.com/go/4958
http://www.adobe.com/fr/support/indesign/gettingstarted/pdfs/indesign_howto_b_shine.pdf
http://www.adobe.com/fr/support/indesign/gettingstarted/pdfs/indesign_howto_e_mps.pdf


Bref didacticiel sur la gestion des documents comportant plusieurs formats de page dans InDesign CS5 et les versions ultérieures.

Mini Bridge : accès à vos illustrations (PDF, 180 Ko)
Référence  (01er janvier 2011)
Utilisez Bridge comme panneau flottant dans InDesign. oui Mini Bridge.

Mixage de formats de page avec le nouvel outil Page (vidéo 8:03)
Anne-Marie Concepcion  (01er janvier 2011)
Didacticiel - vidéo
Créez des brochures compètes et des couvertures de livre avec du texte avec la nouvelle fonction de mixage formats de page dans un seul
fichier.

Paragraphes s’étendant sur plusieurs colonnes ou les scindant (vidéo 02:01)
Michael Ninness  (01er janvier 2011)
Didacticiel - vidéo
Découvrez comment créer des mises en page complexes en moins de clics à l’aide de paragraphes s’étendant sur plusieurs colonnes ou les
scindant dans InDesign CS5 et les versions ultérieures.

Rotation de planche (vidéo 03:31), CS4-CS6
David Blatner  (01er janvier 2011)
Didacticiel - vidéo
Lorsqu’un ou plusieurs objets sur une page sont pivotés, apprenez à faire pivoter la planche pour faciliter les modifications. Profitez de divers
conseils de navigation pour gagner du temps.

Extension et scission de colonnes (vidéo 6:15)
Anne-Marie Concepcion  (01er janvier 2011)
Didacticiel - vidéo
Définissez des titres étendus sur n’importe quel nombre de colonnes ou divisez un groupe de colonnes pour gagner de l’espace vertical.

http://www.adobe.com/fr/support/indesign/gettingstarted/pdfs/indesign_howto_c_minibridge.pdf
http://www.adobe.com/go/lrvid5153_id_fr
http://tv.adobe.com/go/4952
http://tv.adobe.com/watch/learn-indesign-cs4/rotating-spread-view/
http://www.adobe.com/go/lrvid_5151_fr


Création de nouveaux documents

Haut de la page

Haut de la page

Paramètre prédéfini de document

Mode

Nombre de pages

N° de la 1re page

Création de nouveaux documents
Création d’un nouveau document
Options de nouveau document
Présentation de la fenêtre de document
Création de formats de page personnalisés
Définition de paramètres prédéfinis de document
Création d’un document à partir d’un paramètre prédéfini

La conception d’une page débute par des opérations de base : création d’un nouveau document, configuration des pages et positionnement des
marges et des colonnes ou modification des paramètres de grille.

Création d’un nouveau document

1. Choisissez Fichier > Nouveau > Document.

La boîte de dialogue Nouveau document combine les boîtes de dialogue Format de document et Marges et colonnes. Ainsi
vous pouvez définir dans un même emplacement les dimensions de la page, ses marges et ses colonnes. Vous pouvez
modifier ces paramètres à tout moment.

2. Définissez les options de format de document. (Voir la section Options de nouveau document.)

Pour spécifier les zones de fond perdu et de ligne-bloc, cliquez sur le bouton fléchéavant l’étiquette Fond perdu et Ligne-bloc.
Ces zones s’étendent au-delà des bords du format de page défini. Pour que les zones s’étendent uniformément sur tous les
côtés, cliquez sur l’icône Uniformiser tous les paramètres .

3. (Uniquement dans InDesign CC) Cochez la case Aperçu pour vérifier l’apparence du nouveau document. Apportez les
modifications éventuelles nécessaires.

4. Cliquez sur OK pour ouvrir le nouveau document avec les paramètres que vous avez définis.

Pour définir les paramètres de mise en page de tous les nouveaux documents, choisissez Fichier > Format de document ou Mise en page >
Marges et colonnes, puis définissez les options lorsqu’aucun document n’est ouvert.

Options de nouveau document

Choisissez un paramètre déjà enregistré.

Si vous créez un document à exporter au format PDF ou SWF en vue de son utilisation sur le Web, la sélection de l’option Web entraîne la
modification de plusieurs options de la boîte de dialogue, notamment la désactivation de l’option Pages en vis-à-vis, le remplacement de
l’orientation Portrait par Paysage et l’utilisation d’un format de page basé sur la résolution du moniteur. Vous pouvez modifier ces paramètres
après avoir créé le document.
CS6 et versions suivantes : le mode Publication numérique a été ajouté pour les publications destinées à Digital Publishing Suite. Vous pouvez
également modifier le rendu du document après l’avoir créé.

Indiquez le nombre de pages à créer dans le nouveau document.

Indiquez le numéro de page de la première page du document. Si vous définissez un nombre pair (2, par exemple) et que
vous sélectionnez Pages en vis-à-vis, la première planche du document comporte une planche de deux pages Voir Créer un document avec une
planche de deux pages.

http://idiom-q-win-1/fr/indesign/using/create-new-documents.html#new_document_options
http://idiom-q-win-1/fr/indesign/using/pages-spreads-1.html
http://idiom-q-win-1/fr/indesign/using/pages-spreads-1.html


Pages en vis-à-vis

Bloc de texte type

Bloc de texte principal

Format de page

Orientation

Fond perdu

Ligne-bloc

Aperçu

Remarque :

Haut de la page

Sélectionnez cette option pour présenter en regard les pages de gauche et de droite d’une planche de deux pages, comme
pour les livres et les magazines. Désélectionnez-la pour disposer toutes les pages indépendamment les unes des autres, comme si vous
imprimiez des feuillets ou des affiches ou que vous vouliez que les objets débordent dans la zone de reliure.
Après avoir créé un document, vous pouvez utiliser le panneau Pages pour créer des planches de plus de deux pages ou forcer les deux
premières à s’ouvrir dans une planche. (voir Contrôle de la pagination des planches).

CS5.5 et versions antérieures : sélectionnez cette option pour créer un bloc de texte de la taille de la zone délimitée par les
repères de marge, selon les paramètres de colonnes spécifiés. Le bloc de texte type est ajouté au gabarit A. (voir Utilisation des blocs de texte sur
les gabarits).
L’option Bloc de texte type est disponible uniquement lorsque vous choisissez Fichier > Nouveau > Document.

CS6  et versions suivantes : sélectionnez cette option pour ajouter un bloc de texte principal sur le gabarit. Lorsque vous
appliquez un nouveau gabarit, l’article contenu dans le bloc de texte principal se poursuit automatiquement dans le bloc de texte principal du
nouveau gabarit.

Choisissez un format de page dans le menu ou tapez une largeur et une hauteur. Le format de page représente les dimensions
définitives que vous obtiendrez après rognage des fonds perdus et autres repères situés en dehors de la page.

Cliquez sur Portrait  (sens de la hauteur) ou Paysage  (sens de la largeur). Ces icônes interagissent dynamiquement avec les
dimensions de format de page que vous entrez. Si la hauteur est la dimension la plus grande, l’icône Portrait est sélectionnée. Si la largeur est la
dimension la plus grande, l’icône Paysage est sélectionnée. Pour permuter la hauteur et la largeur, cliquez sur l’icône désélectionnée.
Conseil : pour spécifier les dimensions des zones du fond perdu et de la ligne de bloc, cliquez sur le bouton fléché avant l’étiquette du fond perdu
et de la ligne-bloc dans la boîte de dialogue Nouveau document. Pour que le fond perdu et la ligne-bloc s’étendent uniformément sur tous les
côtés, cliquez sur l’icône Uniformiser tous les paramètres .

La zone de fond perdu permet d’imprimer des objets disposés sur le bord externe du format de page défini. Si un objet est placé
contre le bord d’une page aux dimensions requises, il est possible que du blanc apparaisse au bord de la zone d’impression en raison d’un léger
décalage d’alignement au cours de l’impression ou du rognage. Pour cette raison, il est recommandé d’éloigner légèrement l’objet du bord de la
page aux dimensions requises et de rogner une fois l’impression effectuée. La zone de fond perdu est indiquée par une ligne rouge sur le
document. Vous pouvez définir les paramètres de la zone de fond perdu depuis Fond perdu dans la boîte de dialogue Imprimer.

Cette zone est éliminée lorsque le document est rogné à sa taille finale. La zone de ligne-bloc contient les informations sur
l’impression et la gamme de couleurs personnalisées et affiche d’autres instructions et descriptions relatives à d’autres informations dans le
document. Les objets (y compris les blocs de texte) situés dans la zone de ligne-bloc sont imprimés mais disparaissent une fois le document
rogné à sa taille finale.
Les objets situés en dehors de la zone de fond perdu ou de ligne-bloc (selon celle qui s’étend le plus loin) ne seront pas imprimés.

(Uniquement dans InDesign CC) Cochez cette case pour vérifier l’apparence du nouveau document. Apportez les modifications
nécessaires aux options si l’aperçu ne vous convient pas.

vous pouvez également cliquer sur l’icône Enregistrer le paramètre prédéfini de document pour enregistrer les paramètres du
document afin de les réutiliser ultérieurement.

Présentation de la fenêtre de document

Chaque page ou planche dans le document dispose de ses propres table de montage et repères qui sont visibles en mode Affichage standard.
(Pour passer en mode Affichage standard, choisissez Affichage > Mode Ecran > Normal.) La table de montage est remplacée par un arrière-plan
grisé lorsque le document est affiché dans l’un des modes d’aperçu. (voir Aperçu des documents). Vous pouvez changer la couleur de l’arrière-
plan et des repères de l’aperçu dans les préférences Repères et tables de montage.

http://idiom-q-win-1/fr/indesign/using/pages-spreads-1.html#control_spread_pagination
http://idiom-q-win-1/fr/indesign/using/creating-text-text-frames.html#using_text_frames_on_master_pages
http://idiom-q-win-1/fr/indesign/using/creating-text-text-frames.html#using_text_frames_on_master_pages
http://idiom-q-win-1/fr/indesign/using/printing-documents.html#preview_documents
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Document et repères en mode Affichage standard

A. Planche (lignes noires) B. Page (lignes noires) C. Repères de marge (lignes magenta) D. Repères de colonne (lignes violettes) E. Zone de fond
perdu (lignes rouges) F. Ligne-bloc (lignes bleues) 

Notes de fenêtre de document :

Les autres filets de couleur caractérisent les repères de règle, lesquels s’affichent dans la couleur du calque actif. Voir
Calques.

Les repères de colonne s’affichent devant les repères de marge. Par conséquent, lorsqu’un repère de colonne se superpose à
un repère de marge, il masque ce dernier.

Création de formats de page personnalisés

Vous pouvez créer des formats de pages personnalisés qui seront inclus dans le menu Format de page de la boîte de dialogue Nouveau
document.

1. Choisissez Fichier > Nouveau > Document.

2. Choisissez Format de page personnalisé dans le menu Format de page.

3. Saisissez le nom du format de page, définissez ses paramètres et cliquez sur Ajouter.

Le fichier New Doc Sizes.txt qui permet de créer des formats de page personnalisés dans les versions précédentes d’InDesign n’est pas
disponible dans InDesign CS5 et les versions suivantes.

Définition de paramètres prédéfinis de document

Vous pouvez enregistrer des paramètres de document pour le format de page, les colonnes, les marges et les zones de fond perdu et de ligne-
bloc dans un fichier de paramètres prédéfinis pour gagner du temps et assurer une cohérence dans la création de documents similaires.

1. Choisissez Fichier > Paramètres prédéfinis de document > Définir.

2. Cliquez sur Nouveau dans la boîte de dialogue qui s’affiche.

3. Définissez le nom du paramètre prédéfini et sélectionnez des options de mise en page de base dans la boîte de dialogue
Nouveau paramètre prédéfini de document. (Voir Options de nouveau document qui décrit chaque option.)

4. Cliquez deux fois sur OK.

Vous pouvez enregistrer un paramètre prédéfini de document dans un fichier séparé et le distribuer aux autres utilisateurs. Pour enregistrer et
charger des fichiers de paramètres prédéfinis de document, utilisez les boutons Enregistrer et Charger dans la boîte de dialogue Paramètres
prédéfinis de document.

Création d’un document à partir d’un paramètre prédéfini

http://idiom-q-win-1/fr/indesign/using/layers.html
http://idiom-q-win-1/Output/Build/cq.pdf.book/sdl81123/XML/fr-fr/Products/InDesign/CS5/Using/pdf/cq.pdf.book/html/create-new-documents.html#new_document_options
http://idiom-q-win-1/Output/Build/cq.pdf.book/sdl81123/XML/fr-fr/Products/InDesign/CS5/Using/pdf/cq.pdf.book/html/create-new-documents.html#new_document_options
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1. Utilisez l’une des méthodes suivantes :

Choisissez Fichier > Paramètre prédéfini de document > [nom du paramètre prédéfini]. (Maintenez la touche Maj enfoncée
tout en choisissant le paramètre prédéfini pour créer un document basé sur le paramètre prédéfini dans ouvrir la boîte de
dialogue Nouveau document.)

Choisissez Fichier > Nouveau > Document, puis un paramètre prédéfini dans le menu Paramètre prédéfini de document
de la boîte de dialogue Nouveau document.

La boîte de dialogue Nouveau document affiche les options de mise en page du paramètre prédéfini.

2. Si nécessaire, modifiez les options et cliquez sur OK.

Pour ignorer la boîte de dialogue Nouveau document, appuyez sur la touche Maj tout en sélectionnant un paramètre prédéfini dans le menu
Paramètre prédéfini de document.

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr
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A propos des codes QR
Génération de codes QR dans InDesign

A propos des codes QR

Les codes QR sont une représentation imprimée, lisible par une machine, de données utilisables dans divers secteurs. Il sont largement utilisés
dans la publicité associée aux produits de consommation courante. Un consommateur avec un smartphone peut installer une application avec un
scanner de code QR qui peut lire et décoder les informations d’URL et rediriger le navigateur du téléphone vers le site Web d’une entreprise.

Après la lecture des codes QR, les utilisateurs peuvent recevoir du texte, ajouter une carte de visite à leurs périphériques, ouvrir un hyperlien Web
ou rédiger un courrier électronique ou un message texte.

Génération de codes QR dans InDesign

Vous pouvez à présent générer et modifier des images de code QR indépendantes de haute qualité dans InDesign. Le code QR généré est un
objet graphique haute-fidélité qui se comporte exactement comme une image vectorielle native dans InDesign. Vous pouvez aisément mettre à
l’échelle l’objet et le remplir avec des couleurs. Vous pouvez également appliquer à l’objet des effets, de la transparence et des attributs
d’impression, tels que la surimpression, les tons directs et le recouvrement. Vous pouvez copier-coller l’image du code comme objet graphique
vectoriel dans un éditeur graphique standard, tel qu’Adobe Illustrator.

Génération de code QR

1. Dans le menu, choisissez Objet > Générer un code QR. La boîte de dialogue Générer un code QR s’affiche.

La boîte de dialogue Générer/Modifier un code QRcomporte deux onglets, Contenu et Couleur.

2. Dans l’onglet Contenu, vous pouvez sélectionner l’un des types de données suivants dans la liste déroulante Type :

Hyperlien Web
Texte brut
Message texte
Courrier électronique



Carte de visite

En fonction du type sélectionné, un ou plusieurs champs s’affichent pour fournir le contenu pour lequel vous souhaitez
générer le code QR.

3. L’onglet Couleur affiche la liste des nuances. Si vous souhaitez appliquer une couleur spécifique au code QR, passez à
l’onglet Couleur et sélectionnez une couleur spécifique. Par défaut, le code QR généré est noir avec un arrière-plan
transparent.

4. Cliquez sur OK.

5. Si vous avez sélectionné un bloc avant de générer le code QR, le code est placé directement dans le bloc sélectionné et
remplace son contenu.

Si vous n’avez pas sélectionné de bloc, le code QR est chargé dans le pistolet de placement et vous pouvez le placer comme
un objet standard EPS :

Cliquez dans le document pour placer l’objet dans sa taille d’origine/par défaut – 30 X 30 (cm).
Cliquez dans un bloc existant pour placer le code dans le bloc avec la taille par défaut. (Il remplace son contenu existant
si vous cliquez dans le bloc avec la touche Alt enfoncée.)
Si vous cliquez et faites glisser la souris, vous tracez un nouveau bloc avec des proportions fixes. Pour placer le code
dans le bloc, relâchez le bouton de la souris.

Une fois placé dans un document, le code QR est traité comme un objet standard EPS. Néanmoins, si vous placez le pointeur de la souris dessus,
les informations du contenu s’affichent dans une info-bulle sous la forme d’un code incorporé.

Modification du contenu et de la couleur du code QR

1. Sélectionnez l’objet de code QR ou le bloc : cliquez deux fois dans le bloc.

2. Dans le menu, choisissez Objet > Modifier le code QR. Vous pouvez également cliquer avec le bouton droit de la souris et
choisir Modifier le code QR dans le menu contextuel.

3. La boîte de dialogue Modifier le code QR s’affiche avec les informations de contenu et de couleur existantes.

4. Dans l’onglet Contenu, modifier le type de données et le contenu de manière appropriée.

5. Pour sélectionner une couleur différente pour le code QR, cliquez sur l’onglet Couleur et sélectionnez la couleur appropriée.

6. Cliquez sur OK.

Modification de l’attribut de bloc du code QR

L’arrière-plan par défaut d’un bloc de code QR est transparent. Toutefois, vous pouvez changer les attributs Fond et Contour du bloc, tels que la
couleur, le style de trait et l’épaisseur, en utilisant les commandes habituelles.
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Transformation de l’objet de code QR

Vous pouvez déplacer, redimensionner ou la faire pivoter le code QR importé avec l’outil de sélection. Lorsque vous faites glisser la zone du bloc,
seul le bloc est redimensionné. Toutefois, lorsque vous faites glisser la souris :

Si vous appuyez sur la touche Maj, les proportions du bloc sont conservées.
Si vous appuyez sur la touche Ctrl (sous Windows) ou Commande (sous Mac), le bloc et le contenu sont mis à l’échelle et les
proportions sont conservées.
Si vous appuyez sur la touche Maj et Alt (sous Windows) ou Option (sous Mac), le bloc est mis à l’échelle depuis son centre et
les proportions ne sont pas conservées. Vous pouvez appuyer sur la touche Maj pour conserver les proportions.

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr


Numérotation de base des pages
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Ajout de la numérotation des pages
Ajout d’un repère de pagination à un gabarit
Modification du style de numérotation des pages
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Vous pouvez insérer un repère de pagination de type Numéro de page active sur vos pages, pour indiquer l’emplacement et l’aspect du numéro
de page. La mise à jour de ce repère étant automatique, le numéro de page qu’il désigne est toujours exact, même après l’ajout, la suppression
ou l’agencement des pages du document. Vous pouvez mettre en forme et ajouter un style aux repères de pagination comme s’il s’agissait de
texte.

Ajout d’un repère de pagination à un gabarit

Les repères de pagination sont souvent ajoutés aux gabarits. Lors de l’application de gabarits aux pages d’un document, la numérotation des
pages est mise à jour automatiquement, de la même façon que les en-têtes et les pieds de page.

Numéro de page sur le gabarit A (à gauche) et numéro de la page 5 d’après ce même gabarit (à droite)

Si le numéro de page automatique se trouve sur un gabarit, il adopte le préfixe du gabarit. Le numéro de page automatique affiche le numéro de
page sur une page de document, tandis qu’il indique NP sur une table de montage.

1. Dans le panneau Pages, cliquez deux fois sur le gabarit auquel ajouter un numéro de page. Pour créer des gabarits, voir la
section Création de gabarits.

2. Créez un bloc de texte assez grand pour contenir le numéro de page le plus long et tout texte qui doit l’accompagner. Placez
le bloc de texte à l’emplacement où vous voulez que le numéro de page apparaisse.

Si le document comporte des pages en vis-à-vis, créez des blocs de texte distincts pour les gabarits droit et gauche.

3. Dans le bloc de texte du numéro de page, ajoutez le texte qui précèdera ou suivra le numéro de page (« Page », par
exemple).

4. Placez le point d’insertion à l’emplacement où vous voulez que le numéro de page apparaisse, puis choisissez la commande
Texte > Insérer un caractère spécial > Marques > Numéro de page active.

5. Appliquez le gabarit aux pages du document à numéroter. Pour appliquer des gabarits, voir la section Application de gabarits.

Pour supprimer le numéro de page de la première page du document, vous disposez de deux options. Appliquez une table différente ou le
gabarit Aucun, ou remplacez et supprimez le bloc de texte type de la page de document. Pour remplacer un bloc de texte type, cliquez dessus
tout en maintenant les touches Ctrl/Cmde+Maj enfoncées.

Modification du style de numérotation des pages

Par défaut, les pages sont numérotées avec des chiffres arabes (1, 2, 3, etc.) ; toutefois, vous pouvez utiliser des caractères romains en
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majuscules ou minuscules (i, ii, iii, etc.) ou alphanumériques (a, b, c, etc.). Vous pouvez également faire apparaître un zéro précédant le numéro
des pages. Chaque partie du document qui utilise un style de numérotation différent est appelée section. Pour plus d’informations à ce sujet, voir
la section Définition de la numérotation de section.

Galerie de numérotation des pages

En japonais, chinois et dans les versions coréennes, par défaut, les chiffres arabes sont utilisés pour les numéros de page. Toutefois, il est
possible de choisir le style de numérotation voulu (chiffres romains, chiffres arabes, Kanji, et ainsi de suite) à l’aide de la commande Options de
numérotation et de section. L’option Style permet de sélectionner le nombre de chiffres dans le numéro de page, par exemple, 001 ou 0001.
Chaque partie du document qui utilise un style de numérotation différent est appelée section. Pour plus d’informations à ce sujet, voir la section
Définition de la numérotation de section.

Utilisez la boîte de dialogue Options de numérotation et de section pour modifier le style de numérotation des pages. Cette boîte de dialogue vous
permet également de redémarrer la numérotation des pages depuis le début ou de commencer la numérotation à partir d’un numéro donné.

1. Dans le panneau Pages, sélectionnez la page à partir de laquelle vous voulez changer le style de numérotation afin de
commencer une nouvelle section.

2. Choisissez la commande Page > Options de numérotation et de section.

3. Définissez les options voulues, puis cliquez sur OK. Voir la section Options de numérotation de document.

L’icône de marque de section  est affichée au-dessus de l’icône de page dans le panneau Pages et marque le début d’une nouvelle section.

si le numéro de page que vous venez d’insérer est précédé d’un numéro ou d’une lettre, cela signifie qu’il comporte un préfixe de
section. Si vous voulez éliminer ce préfixe, désélectionnez l’option Inclure le préfixe lors de la numérotation des pages dans la boîte de
dialogue Options de numérotation et de section.

Opérations courantes de numérotation des pages

InDesign propose diverses fonctions facilitant la création d’effets de numérotation des pages.

Galerie visuelle et conseils sur la manière
d’ajouter des numéros de page.... En savoir
plus

http://goo.gl/KKJvd

par Bob Bringhurst

Partagez votre expérience dans
Adobe Community Help

Action : Instructions :

Ajout de numéros de page aux documents
d’un livre

Voir Numérotation des pages, chapitres et paragraphes d’un livre.

Ajout de numéros de section et de chapitre Voir Numérotation des sections et des chapitres.

Création d’en-têtes et de pieds de page
continus utilisant des variables de texte telles
que la date de création, le nom de fichier ou
l’intitulé ou titre actuel

Voir Création d’en-têtes et de pieds de page et Variables de texte.

Création d’un effet de numérotation de page
de type « Page x sur y » où x correspond à la
page actuelle et y au nombre total de pages

Insertion d’un repère de pagination de type Numéro de page active
pour x, puis la variable de texte Dernier numéro de page pour y (via la
commande Texte > Variables de texte > Insérer une variable >
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Dernier numéro de page).

Création d’un saut d’article du type « Suite à
la page x »

Voir Numérotation automatique des pages pour les sauts d’article.
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A propos des tables des matières

Une table des matières peut répertorier le contenu d’un livre, d’un magazine ou d’une autre publication, afficher la liste des illustrations, des
annonceurs publicitaires ou des crédits photo, ou encore inclure des informations destinées à faciliter la recherche dans un document ou un livre.
Un document peut contenir plusieurs tables des matières, par exemple, la liste des chapitres et la liste des illustrations.

Chaque table des matières constitue un article séparé, comprenant un titre et une liste d’entrées, classées par numéro de page ou par ordre
alphabétique. Entrées et numéros de page sont directement extraits du document et peuvent être mis à jour à tout moment, même sur plusieurs
documents à la fois.

La création d’une table des matières comprend trois grandes étapes. Dans un premier temps, créez et appliquez les styles de paragraphe à utiliser
dans la table des matières. Ensuite, spécifiez les styles à utiliser dans la table des matières et la mise en forme de votre choix. Enfin, placez la
table des matières dans le document.

Les entrées de la table des matières peuvent être ajoutées automatiquement au panneau Signets pour les documents exportés au format
Adobe PDF.

Conseils pour la planification d’une table des matières

Prenez en compte les points suivants lors de la planification d’une table des matières :

Certaines tables des matières contiennent des éléments qui n’apparaissent pas dans le document, par exemple, la liste des
annonceurs publicitaires d’un magazine. Pour ce faire, entrez le contenu sur un calque masqué et incluez-le quand vous
générez la table des matières.

Vous pouvez charger des styles de table des matières d’autres livres ou documents afin d’en conserver les paramètres et la
mise en forme. Vous devrez peut-être éditer un style de table des matières importé si les noms des styles de paragraphe du
document ne correspondent pas à ceux du document source.

Vous pouvez créer des styles de paragraphe pour le titre et les entrées de la table des matières, y compris des taquets et des
points de conduite de tabulation, et les appliquer quand vous générez la table des matières.

Vous pouvez créer des styles de caractères pour mettre en forme les numéros de page et les caractères qui les séparent des
entrées. Par exemple, si vous voulez des numéros de page en gras, vous devez créer un style de caractère avec l’attribut gras
et sélectionner ce style lorsque vous créez la table des matières.

Création de tables des matières dans les livres

Pour un résultat optimal, veillez à respecter les points suivants avant de créer une table des matières pour un livre :
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Avant de créer la table des matières, vérifiez que la liste des documents du livre est complète, que tous les documents
apparaissent dans l’ordre correct et que les titres comportent les styles de paragraphes de mise en forme appropriés.

Veillez à utiliser les styles de paragraphe de manière cohérente dans tout le livre. Evitez de créer des styles portant le même
nom pour des définitions différentes. Si plusieurs styles portent le même nom pour des définitions différentes, InDesign
applique la définition du style du document actuel (si ce style est défini) ou bien la première occurrence du style dans le livre.

Si les styles recherchés n’apparaissent pas dans les menus déroulants de la boîte de dialogue Table des matières, vous
devrez synchroniser le livre pour copier les styles vers le document contenant la table des matières.

Si la table des matières doit comporter des entrées numérotées (par exemple, 1-1, 1-3, etc.), utilisez de préférence la
numérotation de section et non la numérotation de chapitre. En effet, les préfixes numérotés des sections peuvent figurer dans
une table des matières.

Génération d’une table des matières

Avant de générer une table des matières, vous devez décider quels paragraphes (tels que les titres de chapitre et les titres de sections) vous
voulez inclure et ensuite définir leurs styles. Assurez-vous que ces styles sont correctement appliqués aux paragraphes choisis dans le ou les
documents du livre.

Lorsque vous générez la table des matières, vous pouvez également utiliser les styles de paragraphe et de caractère pour définir sa mise en
forme.

Table des matières sans style de paragraphe (à gauche) et avec styles de paragraphe appliqués aux entrées (à droite)

Si les paragraphes à inclure dans la table des matières apparaissent sur la même page dans des articles différents, l’ordre dans lequel ils
apparaissent dans la table des matières est fonction de leur position sur la page.

1. Utilisez l’une des méthodes suivantes :

Si vous créez une table des matières pour un seul document, vous devrez ajouter une page au début du document.

Si vous créez une table des matières pour plusieurs documents d’un livre, créez ou ouvrez le document à utiliser pour la
table des matières, insérez ce document dans le livre, puis ouvrez le livre.

2. Sélectionnez Page > Table des matières.

Si vous avez défini un style dont les paramètres sont adaptés à votre table des matières, vous pouvez le choisir dans le menu
Style de table des matières.

3. Dans la zone de titre, indiquez un titre pour votre table des matières (par ex. Contenu ou Liste des illustrations). Ce titre
apparaît en haut de la table des matières. Pour mettre en forme le titre, choisissez un style dans le menu Style.

4. Sélectionnez Inclure les documents du livre pour créer une table des matières pour tous les documents dans la liste des
documents du livre et renuméroter les pages du livre. Vous devez désélectionner cette option si vous voulez générer une
table des matières uniquement pour le document actuel. Cette option est grisée si le document actif ne fait pas partie d’un
livre.

5. Déterminez le contenu à inclure dans la table des matières en cliquant deux fois sur les styles de paragraphe de la liste Autres
styles pour les ajouter à la liste Inclure les styles de paragraphe.

6. Sélectionnez Remplacer la table des matières existante pour remplacer tous les articles de la table des matières existante
dans le document. Vous devez désélectionner cette option si vous voulez générer une nouvelle table des matières, par
exemple une liste des illustrations.

7. Définissez les options de mise en forme pour chaque style de paragraphe de la table des matières

Il est judicieux de définir un style de table des matières comportant la mise en forme et les autres options voulues, en
particulier si vous voulez inclure plusieurs tables des matières dans un document. Pour ce faire, cliquez sur Enregistrer le
style. Vous pouvez également créer des styles de tables des matières en choisissant Page > Styles de tables des
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matières.

8. Cliquez sur le bouton OK.

Une icône de texte chargé  Avant de cliquer ou de faire glisser cette icône, vous pouvez ouvrir une autre page ou en créer
une nouvelle sans perdre le texte chargé.

9. Cliquez sur l’icône de texte chargée ou faites-la glisser sur une page pour importer l’article de la nouvelle table des matières.

évitez de relier le bloc de la table des matières à d’autres blocs de texte du document. En effet, si vous remplacez la table des
matières existante, l’article entier sera remplacé par la nouvelle table mise à jour.

Création de styles de tables des matières pour plusieurs listes

Les styles de tables des matières sont particulièrement utiles si vous devez créer plusieurs tables des matières pour un même document ou livre.
Par exemple, vous pouvez utiliser un style de tables des matières pour une liste de contenu, et un autre pour une liste d’annonceurs publicitaires,
d’illustrations ou de crédits photo. Il vous suffit de créer un style de table des matières pour chaque type de liste.

Il est également pratique de créer des styles de tables des matières si vous envisagez de réutiliser la même mise en forme pour la table des
matières d’un autre document.

ne confondez pas les styles de tables des matières avec les styles de paragraphe dotés d’un préfixe « TOC ». Les styles de
paragraphe avec préfixe TOC (« Titre de la table des matières » par exemple) sont utilisés pour la mise en forme des entrées d’une table des
matières. Par opposition, un style de table des matières est un ensemble de paramètres utilisés pour créer une table des matières de manière
automatique.

Pour créer un style de table des matières

1. Choisissez la commande Page > Styles de tables des matières.

2. Cliquez sur Nouveau.

3. Saisissez un nom pour le style de table des matières que vous créez.

4. Dans la zone de titre, indiquez un titre pour votre table des matières (par ex. Contenu ou Liste des illustrations). Ce titre
apparaît en haut de la table des matières. Pour spécifier un style de titre, choisissez un style dans le menu Style.

5. Dans la liste Autres styles, sélectionnez les styles de paragraphe qui représentent le contenu à inclure dans la table des
matières, puis cliquez sur Ajouter pour les ajouter à la zone Inclure les styles de paragraphe.

6. Définissez les options de mise en forme pour chaque style de paragraphe

Pour importer des styles de tables des matières à partir d’un autre document

1. Choisissez la commande Page > Styles de tables des matières.

2. Cliquez sur Charger, sélectionnez le fichier InDesign contenant les styles à copier, puis cliquez sur Ouvrir.

3. Cliquez sur le bouton OK.

si les styles de paragraphe de votre document ne correspondent pas à ceux du style de table des matières importé, modifiez ce
dernier avant de générer la table des matières.

Conseils pour la mise en forme d’une table des matières

Lorsque vous générez ou modifiez une table des matières, utilisez ces options pour définir l’apparence du texte de la table des matières générée.
Certaines de ces options sont disponibles uniquement lorsque vous cliquez sur Plus d’options dans la boîte de dialogue.

les paramètres de la section Style s’appliquent uniquement au style actuellement sélectionné dans l’option Inclure les styles de
paragraphes. Vous pouvez définir différentes options de mise en forme pour chaque style.
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Continues

Inclure le texte des calques masqués

Pour chaque style répertorié sous Inclure les styles de paragraphes, choisissez le style de paragraphe à appliquer aux entrées
de la table des matières concernés.

Vous pouvez créer un style de caractère pour mettre en forme les numéros de page, puis sélectionner ce style dans le menu
déroulant Style, à droite de l’option Numéro de page (Voir Ajout de styles de paragraphe et de caractère.)
Pour inclure des préfixes aux numéros de page de la table des matières ou pour utiliser une convention de numérotation différente, voir Définition
de la numérotation de section.

Entre l’entrée et le numéro Spécifiez les caractères à afficher entre l’entrée de table des matières et le numéro de page. Le caractère par défaut
^t indique à InDesign d’insérer une tabulation. Vous pouvez choisir un autre caractère spécial, comme Tabulation de retrait à droite ou Espace
cadratin, dans la liste déroulante.

Sélectionnez le texte existant dans la zone avant de choisir un autre caractère spécial afin de ne pas inclure les deux signes.

Vous pouvez créer un style de caractère pour mettre en forme l’espace entre l’entrée et le numéro de la page, puis sélectionner ce style dans le
menu déroulant Style, à droite de l’option Entre l’entrée et le numéro (Voir Ajout de styles de paragraphe et de caractère.)
Si le style de paragraphe de l’entrée inclut un paramètre de point de conduite et que le caractère de tabulation (^t) est sélectionné, des points de
conduite apparaissent dans la table des matières générée.

Vous pouvez indiquer un caractère séparant l’entrée et le numéro de page, ainsi que le style à appliquer au caractère.

Sélectionnez cette option pour classer la table des matières par ordre alphabétique dans le style
sélectionné. Cette option s’avère particulièrement utile pour la création de listes simples, telles que des listes d’annonceurs publicitaires. Les
entrées imbriquées (Niveau 2 ou 3) sont classées alphabétiquement au sein de leur groupe (Niveau 1 ou 2, respectivement).

l’ordre de tri d’une table des matières est défini par le paramètre de langue par défaut du document. Pour modifier la langue par
défaut, assurez-vous qu’aucun élément n’est sélectionné, puis choisissez une langue dans le menu Langue du panneau Caractère.

Par défaut, chaque élément ajouté à la liste de l’option Inclure les styles de paragraphe est défini sur un niveau inférieur à celui de
l’élément placé directement au-dessus. Vous pouvez modifier cette hiérarchie en spécifiant un nouveau niveau pour le style de paragraphe
sélectionné. Cette option ajuste uniquement l’affichage dans la boîte de dialogue. Elle n’a pas d’incidence sur la table des matières finale, sauf si
la liste est classée par ordre alphabétique, auquel cas les entrées sont triées par niveau.

Sélectionnez cette option pour que les entrées de la table des matières apparaissent dans le panneau Signets d’Adobe
Acrobat ou d’Adobe Reader® une fois le document exporté au format PDF.

Sélectionnez cette option si vous voulez toutes les entrées d’une table des matières dans un seul et même paragraphe. Les entrées
seront séparées par un point-virgule (;) suivi d’une espace.

Sélectionnez cette option uniquement si vous voulez que les paragraphes des calques masqués soient
inclus dans la table des matières. Cette option est utile pour créer une liste des annonceurs publicitaires ou d’illustrations qui n’apparaissent pas
dans le document. Désélectionnez-la si vous avez utilisé les calques pour stocker différentes versions ou traductions d’un texte.
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Si votre table des matières contient un style de paragraphe avec une numérotation, spécifiez si l’entrée de table des
matières comprend le paragraphe entier (numéros et texte), uniquement les numéros ou uniquement le paragraphe.

Indiquez le sens d’écriture pour le bloc de texte que vous souhaitez utiliser pour créer la table des matières.

Création d’entrées de table des matières avec des points de conduite

Les entrées d’une table des matières sont souvent séparées de leur numéro de page par des pointillés ou des points de conduite.

Table des matières avec points de conduite

1. Création d’un style de paragraphe avec un point de conduite.

2. Pour mettre à jour les paramètres du contenu, utilisez l’une des méthodes suivantes :

Sélectionnez Page > Styles de tables des matières. Sélectionnez un style, puis cliquez sur Modifier.

Sélectionnez Page > Table des matières (si vous n’utilisez pas de style de tables des matières).

3. Sous Inclure les styles de paragraphes, sélectionnez un élément qui doit s’afficher avec un point de conduite dans la table des
matières.

4. Pour Style des entrées, sélectionnez le style de paragraphe qui contient le point de conduite.

5. Cliquez sur Plus d’options.

6. Vérifiez que l’option Entre l’entrée et le numéro est définie sur ^t (représentant une tabulation). Cliquez sur OK ou sur
Enregistrer.

7. Le cas échéant, sélectionnez Page > Mettre à jour la table des matières. Ensuite, importez l’article de la nouvelle table des
matières.

Création d’un style de paragraphe avec un point de conduite

1. Choisissez la commande Fenêtre > Styles > Styles de paragraphe pour afficher le panneau du même nom.

2. Utilisez l’une des méthodes suivantes dans le panneau qui s’affiche :

Cliquez deux fois sur le nom du style de paragraphe appliqué aux entrées de la table des matières.

Dans le menu du panneau, choisissez Nouveau style de paragraphe.

3. Le cas échéant, entrez un nom pour le style de paragraphe.

4. Cliquez sur Tabulations.

5. Sélectionnez l’icône de tabulation justifiée à droite , puis cliquez sur la règle pour positionner le taquet de tabulation.

Si les paragraphes auxquels vous appliquez le style comportent des listes numérotées, pensez à définir deux tabulations : la
première pour le numéro en retrait et la seconde pour les points de conduite.

6. Dans le champ Point de conduite, entrez un point (.).

7. Sélectionnez d’autres options de style, puis cliquez sur OK.

Mise à jour et modification d’une table des matières
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La table des matières reflète le contenu de votre document. Si vous modifiez un numéro de page ou un autre élément répertorié dans la table des
matières, tel qu’un titre, la table des matières doit être mise à jour.

Mise à jour d’une table des matières

1. Ouvrez le document contenant la table des matières.

2. Utilisez l’une des méthodes suivantes :

Pour modifier les entrées de la table des matières, ne modifiez pas directement la table, mais votre livre ou document.

Pour modifier la mise en forme appliquée au titre, aux entrées ou aux numéros de page de la table des matières, modifiez
le paragraphe ou les styles de caractère associés à ces éléments.

Pour modifier la numérotation des pages (par exemple, 1, 2, 3 ou i, ii, iii), modifiez la numérotation de la section dans le
livre ou document (Voir Numérotation des pages, des chapitres et des paragraphes dans un livre.)

Pour spécifier un nouveau titre, ajouter des styles de paragraphe à la table des matières ou poursuivre la mise en forme
des entrées, modifiez le style de la table des matières.

3. Sélectionnez le bloc de texte contenant la table des matières ou placez-y le point d’insertion, puis choisissez la
commande Page > Mettre à jour la table des matières.

4. Si le document contient plusieurs tables des matières, par exemple une liste d’illustrations et une liste d’annonceurs
publicitaires, sélectionnez le bloc de texte contenant une autre liste, puis choisissez la commande Page > Mettre à jour la
table des matières.

Modification d’une table des matières

Si vous devez modifier une table des matières, effectuez les modifications directement dans les paragraphes du document, plutôt que dans l’article
de table des matières, puis générez une nouvelle table. Si vous modifiez l’article de table des matières, les modifications effectuées sont perdues
lorsque vous régénérez la table. De même, apportez les modifications nécessaires directement aux styles utilisés pour la mise en forme de la table
des matières.

Adobe recommande également
Vidéo Création d'une table des matières

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr
http://idiom-q-win-1/fr/indesign/using/creating-book-files.html#number_pages_chapters_and_paragraphs_in_a_book
http://www.adobe.com/go/vid0219


Notes de bas de page

Haut de la page

Haut de la page

Création de notes de bas de page
Modification de la numérotation et de la mise en page des notes de bas de page
Utilisation de texte de note de bas de page
Habillage de texte dans une note de bas de page
Suppression de notes de bas de page 

Création de notes de bas de page

Une note de bas de page est constituée de deux parties liées : le numéro de référence de la note de bas de page qui apparaît dans le texte et le
texte de la note qui apparaît au bas de la colonne. Vous pouvez créer des notes de bas de page ou les importer de documents Word ou RTF. Les
notes de bas de page sont numérotées automatiquement au fur et à mesure que vous les ajoutez au document. La numérotation reprend du
début pour chaque article. Vous pouvez choisir le style, l’apparence et la mise en page des notes de bas de page. Vous ne pouvez pas ajouter de
notes de bas de page à des tableaux ou au texte d’une note de bas de page. La largeur du texte de note de bas de page est fonction de la
largeur de la colonne contenant le marqueur de référence de note de bas de page.

Il est impossible de créer des notes de fin de page dans InDesign. Les notes de fin de page figurant dans des documents Microsoft Word
convertis se présentent sous forme de texte plutôt que de notes de bas de page. Pour une solution pour créer des notes de bas de page, voir
l’article Endnotes in InDesign (« Notes de bas de page dans InDesign ») par Bob Bringhurst. 

Suivez ces étapes pour créer des notes de bas de page :

1. Placez le point d’insertion là où vous souhaitez insérer le numéro de référence de la note de bas de page.

2. Choisissez Texte > Insérer une note de bas de page.

3. Saisissez le texte de la note.

Note ajoutée au document

A. Numéro de référence B. Texte de la note de bas de page 

A mesure que vous saisissez du texte, la zone de la note s’agrandit, tandis que la taille du bloc de texte reste la même. La zone de la note de bas
de page continue de s’étendre vers le haut jusqu’à ce qu’elle atteigne la ligne de la référence à la note. La note de bas de page se poursuit alors
dans la colonne suivante du bloc de texte ou du bloc lié. Si la note de bas de page ne peut pas être scindée et si le texte de la note est trop long
pour la zone de note de bas de page, la ligne contenant la référence à la note est décalée sur la colonne suivante, ou bien une icône de texte en
excès apparaît. Pour corriger ce problème, redimensionnez le bloc ou modifiez la mise en forme du texte.

Lorsque le point d’insertion se trouve dans une note de bas de page, choisissez Texte > Atteindre la référence de note de bas de page pour
revenir au point du texte où vous vous trouviez. Si vous utilisez fréquemment cette option, pensez à créer un raccourci clavier.

http://blogs.adobe.com/indesigndocs/2009/03/endnotes_in_indesign_cs4.html


Style de numérotation

Début

Recommencer la numérotation à chaque

Afficher le préfixe/suffixe dans

Position

Style de caractère

Style de paragraphe

Séparateur

Modification de la numérotation et de la mise en page des notes de bas de page

Les modifications apportées à la numérotation et à la mise en page des notes de bas de page s’appliquent aux notes de bas de page existantes
et à celles que vous créez ultérieurement.

1. Sélectionnez Texte > Options de note de bas de page du document.

2. Dans l’onglet Numérotation et mise en forme, sélectionnez les options qui déterminent le type de numérotation et l’apparence
du numéro de référence et du texte des notes de bas de page.

3. Cliquez sur l’onglet Mise en page et sélectionnez les options concernant l’aspect de la section contenant les notes de bas de
page sur la page.

4. Cliquez sur le bouton OK.

Options de numérotation et de mise en forme des notes de bas de page

Les options suivantes apparaissent dans la section Numérotation et mise en forme de la boîte de dialogue Options de note de bas de page :

Choisissez le style de numérotation à appliquer aux numéros de référence des notes de bas de page.

Spécifiez le numéro à utiliser pour la première note de bas de page de l’article. Tous les articles du document commencent au numéro
spécifié pour Début. Si un livre contient plusieurs documents dont les numéros de page se suivent, vous pouvez faire en sorte que les numéros
des notes de bas de page de chaque chapitre reprennent là où le chapitre précédent s’est arrêté.
Cette option est particulièrement utile pour les documents regroupés dans un livre. En effet, la numérotation des notes de bas de page n’est pas
continue d’un document à l’autre.

Si vous souhaitez que la numérotation recommence au début au sein d’un même document,
sélectionnez cette option et choisissez la commande Page, Planche ou Section pour déterminer l’endroit où la numérotation des notes de bas de
page doit repartir du début. Certains types de numérotation, comme l’astérisque (*), sont plus appropriés lorsque la numérotation reprend du début
à chaque page.

Sélectionnez cette option pour afficher les préfixes ou les suffixes dans la référence à la note de bas de page, le
texte de la note de bas de page, ou encore dans les deux. Les préfixes apparaissent avant le numéro (par exemple [1), et les suffixes après le
numéro (par exemple 1]). Cette option est particulièrement utile si vous souhaitez insérer des notes de bas de page entre des caractères, par
exemple [1]. Entrez un ou plusieurs caractères ou sélectionnez une option pour Préfixe, Suffixe ou les deux. Pour sélectionner des caractères
spéciaux, cliquez sur les icônes situées en regard des commandes Préfixe et Suffixe pour afficher un menu.

Si le numéro de référence à la note de bas de page est trop près du texte qui le précède, vous pouvez corriger ce problème en ajoutant un
espace comme préfixe. Vous pouvez également appliquer un style de caractère au numéro de référence.

Cette option détermine l’apparence du numéro de référence à la note de bas de page (par défaut en exposant). Si vous préférez
appliquer un style de caractère au numéro (par exemple un style de caractère comprenant les paramètres d’exposant OpenType), choisissez
Normale et spécifiez le style de caractère.

Choisissez un style de caractère pour formater le numéro de référence de note de bas de page. Par exemple, au lieu
d’utiliser l’exposant, sélectionnez un style de caractère à une position normale avec une ligne de base surélevée. Le menu affiche les styles de
caractères disponibles dans le panneau Styles de caractères.

Choisissez un style de paragraphe pour le texte de toutes les notes de bas de page du document. Le menu affiche les
styles de paragraphes disponibles dans le panneau Styles de paragraphes. Par défaut, le style [Paragraphe standard] est utilisé. Le style
[Paragraphe standard] peut ne pas avoir le même aspect que les paramètres de police par défaut du document.

Le séparateur détermine l’espace qui apparaît entre le numéro de la note de bas de page et le début du texte de la note. Pour
changer le séparateur, sélectionnez ou supprimez le séparateur existant, puis choisissez un autre séparateur. Vous pouvez inclure plusieurs
caractères. Pour insérer des espaces, utilisez le métacaractère approprié, comme ^m pour les espaces cadratin.



Espace minimum avant la 1ère note de bas de page

Espace entre les notes de bas de page

Décalage de la 1re ligne de base

Placer les notes de bas de page de fin d’article en bas du texte

Autoriser le fractionnement des notes de bas de page

Filet au-dessus

Haut de la page

Options de mise en page des notes de bas de page

Les options suivantes apparaissent dans la section Mise en page de la boîte de dialogue Options de note de bas de page :

Cette option détermine l’espace minimum entre le bas de la colonne et la première ligne
de notes de bas de page. Vous ne pouvez pas utiliser de valeur négative. Les paramètres Espace avant du paragraphe de note de bas de page
sont ignorés.

Cette option détermine la distance entre le dernier paragraphe d’une note de bas de page et le premier
paragraphe de la note de bas de page suivante dans une colonne. Vous ne pouvez pas utiliser de valeur négative. Les valeurs spécifiées pour
Espace avant/après dans un paragraphe de note de bas de page s’appliquent uniquement si la note de bas de page comprend plusieurs
paragraphes.

Cette option détermine la distance entre le début de la zone de note de bas de page (là où le séparateur
apparaît par défaut) et la première ligne du texte de la note de bas de page.
Pour plus d’informations sur les options de la première ligne de base, voir Modification des propriétés d’un bloc de texte.

Sélectionnez cette option si vous souhaitez que les notes de bas de page de
la dernière colonne apparaissent juste sous le texte du dernier bloc de l’article. Si cette option est sélectionnée, toutes les notes de bas de page
du dernier bloc de l’article apparaîtront au bas de la colonne.

Sélectionnez cette option si vous souhaitez que les notes de bas de page continuent
sur une autre colonne si la note dépasse l’espace maximal disponible pour les notes de cette colonne. Si la note ne peut pas être divisée, la ligne
contenant la référence à la note de bas de page est déplacée à la colonne suivante, ou le texte est composé en excès.

Même si le fractionnement des notes de bas de page est activé, vous pouvez empêcher des notes de bas de page de fractionner en plaçant le
point d’insertion dans le texte de note de bas de page. Choisissez la commande Options d’enchaînement dans le menu du panneau
Paragraphe, puis choisissez les options Lignes solidaires et Toutes les lignes du paragraphe. Si la note de bas de page contient plusieurs
paragraphes, utilisez l’option Paragraphes solidaires X lignes dans le premier paragraphe du texte de la note de bas de page. Choisissez
Texte > Insérer un caractère de saut > Saut de colonne pour choisir l’emplacement du fractionnement de la note de bas de page.

Note de bas de page fractionnée sur la colonne

Spécifiez l’emplacement et l’aspect de la ligne de séparation visible au-dessus du texte de note de bas de page. Une ligne de
séparation (également appelée « trait de séparation ») est également visible au-dessus de tout texte de note de bas de page qui se poursuit dans
un autre bloc Les options que vous sélectionnez s’appliquent soit à la première note de bas de page de la colonne, soit aux suites des notes de
bas de page, selon ce que vous avez sélectionné dans le menu. Ces options sont semblables à celles qui apparaissent lorsque vous spécifiez un
filet de paragraphe. Si vous voulez supprimer la ligne de séparation de note de bas de page, désélectionnez l’option Filet.

Utilisation de texte de note de bas de page

Tenez compte des points suivants lorsque vous modifiez un texte de note de bas de page :

Lorsque le point d’insertion se trouve dans le texte de la note de bas de page, si vous choisissez Edition > Tout sélectionner,
tout le texte de la note de bas de page est sélectionné, mais pas les autres notes de bas de page ni aucun autre texte.

http://idiom-q-win-1/fr/indesign/using/creating-text-text-frames.html#change_text_frame_properties
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Utilisez les touches de direction pour vous déplacer parmi les notes de bas de page.
En effet, la numérotation des notes de bas de page n’est pas continue d’un document à l’autre. Si vous ne voulez pas que la
numérotation recommence au début au sein de chaque document du livre, changez manuellement la valeur Début dans
chacun des documents après avoir finalisé leur édition.
En mode éditeur, vous pouvez cliquer sur l’icône de la note de bas de page pour développer ou réduire une note. Vous
pouvez développer ou réduire toutes les notes de bas de page en choisissant Affichage > Mode éditeur > Développer toutes
les notes de bas de page ou Réduire toutes les notes de bas de page.
En mode Epreuve en placard ou Article, vous pouvez cliquer sur l’icône de note de bas de page pour développer ou réduire
les notes de bas de page. Vous pouvez également développer ou réduire toutes les notes de bas de page en cliquant avec le
bouton droit de la souris (Windows) ou en cliquant tout en maintenant la touche Contrôle enfoncée (Mac OS) sur une note de
bas de page, puis en choisissant Développer toutes les notes de bas de page ou Réduire toutes les notes de bas de page.

Vous pouvez sélectionner et appliquer la mise en forme des caractères et des paragraphes au texte des notes de bas de
page. Vous pouvez également sélectionner et modifier l’apparence des numéros de référence aux notes de bas de page, mais
il est préférable pour cela d’utiliser la boîte de dialogue Options de note de bas de page du document.

Lorsque vous coupez et copier du texte comprenant un numéro de référence à une note de bas de page, le texte de la note
est également ajouté au Presse-papiers. Si vous copiez le texte dans un autre document, les notes de bas de page de ce
texte utiliseront les caractéristiques de numérotation et de mise en page du nouveau document.

Si vous avez accidentellement supprimé le numéro de la note de bas de page au début du texte de celle-ci, vous pouvez le
rajouter. Placez le point d’insertion au début du texte de note de bas de page, cliquez avec le bouton droit de la souris
(Windows) ou cliquez sur la touche Ctrl (Mac OS), puis sélectionnez Insérer un caractère spécial > Marques > Numéro de note
de bas de page.

Si vous effacez les remplacements et les styles de caractère d’un paragraphe contenant un marqueur de référence de note de
bas de page, les numéros de référence aux notes de bas de page perdent les attributs appliqués dans la boîte de dialogue
Options de note de bas de page du document.

Habillage de texte dans une note de bas de page

Vous pouvez appliquer l’habillage de texte à un objet ancré ou flottant faisant partie d’une note de bas de page.

Habillage de texte interne des objets dans les notes de bas de page

Vous pouvez placer un objet texte ou un objet ancré sur l’habillage de texte appliqué à une note de bas de page. L’habillage enveloppe l’objet et
s’y adapte automatiquement.

L’habillage de texte interne s’effectue au-dessous du point où l’objet est ancré dans une note de bas de page.



Habillage de texte interne

Habillage de texte externe des objets dans les notes de bas de page

Lorsqu’un objet flottant, non ancré ni sur la ligne, et auquel l’habillage de texte est appliqué, interagit avec le texte des notes de bas de page,
l’habillage de texte prend effet. Le texte s’ajuste dynamiquement autour de l’objet.

Dans l’exemple illustré ci-dessous, la photo ne fait pas partie de la note de bas de page, mais le texte s’adapte sans problème à l’objet.

Habillage de texte externe

Notes de bas de page dans des blocs non rectangulaires

Pour les blocs de texte non rectangulaires, tels que les angles arrondis, les ovales et les cercles, les notes de bas de page restent dans les limites
des formes de l’objet.
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Suppression de notes de bas de page 

Pour supprimer une note de bas de page, sélectionnez le numéro de référence à la note qui apparaît dans le texte, puis appuyez sur la touche
Retour arrière ou Suppr. Si vous supprimez uniquement le texte de la note, le numéro de référence et la structure de la note sont conservés.

Adobe recommande également

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr
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Création et modification de variables de texte
Insertion de variables de texte
Suppression, conversion et importation de variables de texte

Création et modification de variables de texte
Une variable de texte est un élément que vous insérez dans votre document et qui varie selon le contexte. Par exemple, la variable Dernier
numéro de page affiche le numéro de page de la dernière page du document. Si vous ajoutez ou supprimez des pages, la variable est mise à jour
en conséquence.

InDesign inclut plusieurs variables de texte prédéfinies que vous pouvez insérer dans votre document. Vous pouvez modifier le format de ces
variables ou créer vos propres variables. Certaines variables, telles que En-tête continu et Numéro de chapitre, sont spécialement utiles dans les
gabarits pour assurer une mise en forme et une numérotation uniformes. D’autres variables, telles que Date de création et Nom de fichier, peuvent
être ajoutées à la zone de ligne-bloc pour l’impression.

Remarque : n’ajoutez pas trop de texte à une variable pour ne pas risquer d’obtenir du texte en excès ou du texte compressé. Le texte de variable
ne saute pas d’une ligne à l’autre.

Pour créer ou modifier des variables de texte
Les options disponibles pour créer une variable dépendent du type de variable que vous spécifiez. Par exemple, si vous choisissez le type
Numéro de chapitre, vous pouvez spécifier le texte qui apparaîtra avant et après le numéro et vous pouvez spécifier le style de numérotation.
Vous pouvez créer plusieurs variables différentes basées sur le même type de variable. Par exemple, vous pouvez créer une variable qui affiche
« Chapitre 1 » et une autre qui affiche « Chap.  1 ».

De même, si vous choisissez le type En-tête continu, vous pouvez spécifier le style utilisé comme base de l’en-tête et vous pouvez sélectionner
les options pour supprimer la ponctuation de fin et modifier la casse.

1. Si vous voulez créer des variables de texte à utiliser dans tous les nouveaux documents que vous créez, fermez tous les
documents. Sinon, les variables de texte que vous créez apparaissent uniquement dans le document actif.

2. Choisissez Texte > Variables de texte > Définir.

3. Cliquez sur Nouveau ou sélectionnez une variable existante, puis cliquez sur Modifier.

4. Entrez un nom de variable, tel que « Chapitre entier » ou « Titre continu ».

5. Dans le menu Texte, choisissez un type de variable, spécifiez les options associées, puis cliquez sur OK.

Différentes options sont disponibles selon le type de variable que vous avez sélectionné.

Texte avant / Texte après Pour tous les types de variable (sauf Texte personnalisé), vous pouvez spécifier un texte à ajouter
avant ou après la variable. Par exemple, vous pouvez ajouter le mot « sur » avant la variable Dernier numéro de page et le
groupe de mots « pages au total » après la variable pour créer un effet « sur 12 pages au total ». Vous pouvez également
coller du texte dans ces zones, mais les caractères spéciaux tels que les tabulations et les numéros de page automatiques
sont supprimés. Pour insérer des caractères spéciaux, cliquez sur le triangle à droite de la zone de texte.

Style Pour tous les types de variables numérotées, vous pouvez spécifier le style de numérotation. Si [Style de numérotation
actuel] est sélectionné, la variable utilise le même style de numérotation sélectionné dans la boîte de dialogue Options de
numérotation et de section du document.

Types de variable

Numéro de chapitre
Une variable créée avec le type Numéro de chapitre insère le numéro de chapitre. Vous pouvez insérer du texte avant ou après le numéro de
chapitre et vous pouvez spécifier un style de numérotation.

Si le numéro de chapitre du document est défini pour continuer à partir du document précédent dans le livre, vous devez peut-être mettre à jour la
numérotation du livre afin que le numéro de chapitre approprié apparaisse.

Date de création, Date de modification et Date de sortie
Date de création insère la date ou l’heure à laquelle le document a été enregistré pour la première fois ; Date de modification insère la date ou
l’heure à laquelle le document a été enregistré pour la dernière fois sur le disque ; Date de sortie insère la date ou l’heure à laquelle le document



a été envoyé à l’impression, exporté au format PDF ou assemblé. Vous pouvez insérer du texte avant et après la date et vous pouvez modifier le
format de date pour toutes les variables de date.

Format de date Vous pouvez entrer des formats de date directement dans la zone Format de date ou vous pouvez choisir les options de format
en cliquant sur le triangle à droite de la zone. Par exemple, le format de date « dd/MM/yy » s’affiche de la façon suivante : 22/12/07. En modifiant
le format en « dd MMM. yyyy », la date s’affiche sous la forme 22 déc. 2007.
Les variables de date utilisent la langue appliquée au texte. Par exemple, la date de création peut apparaître en espagnol « 01 diciembre 2007 »
ou en allemand « 01 Dezember 2007 ».

Forme abrégée Description Exemple

M Numéro du mois, non précédé de zéro 8

MM Numéro du mois, précédé de zéro 08

MMM Nom de mois abrégé Aoû

MMMM Nom de mois complet Août

d Numéro du jour, non précédé de zéro 5

dd Numéro du jour, précédé de zéro 05

E Jour de la semaine abrégé Ven

EEEE Jour de la semaine complet Vendredi

yy ou YY Numéro de l’année, deux derniers chiffres 07

y (Y) ou yyyy (YYYY) Numéro de l’année complet 2007

G ou GGGG Ere, abrégée ou développée Après Jésus-Christ ou Ap. J.-C.

h Heure, non précédée de zéro 4

hh Heure, précédée de zéro 04

H Heure, non précédée de zéro, format 24 heures 16

HH Heure, précédée de zéro, format 24 heures 16

m Minute, non précédée de zéro 7

mm Minute, précédée de zéro 07

s Seconde, non précédée de zéro 7

ss Seconde, précédée de zéro 07

a AM ou PM, deux caractères PM

z ou zzzz Fuseau horaire, abrégé ou développé PST ou Pacific Standard Time

Nom de fichier
Cette variable insère le nom du fichier actif dans le document. Elle est généralement ajoutée à la ligne-bloc du document pour l’impression ou elle
est utilisée dans les en-têtes et les pieds de page. Outre Texte avant et Texte après, vous pouvez choisir les options suivantes.

Inclure le chemin entier du dossier Permet d’inclure le chemin d’accès complet du dossier avec le nom de fichier. Les conventions de chemin
d’accès standard pour Windows ou Mac OS sont utilisées.
Inclure l’extension de fichier Permet d’inclure l’extension du nom de fichier.
La variable Nom de fichier est mise à jour dès que vous enregistrez le fichier sous un nouveau nom ou à un nouvel emplacement. Le chemin
d’accès ou l’extension n’apparaît pas dans le document jusqu’à ce qu’il soit enregistré.

Nom de l’image
La variable Nom de l’image est particulièrement utile pour générer automatiquement des légendes à partir de métadonnées. La variable Nom de
l’image inclut un type de variable Légende des métadonnées. Si un bloc de texte contenant cette variable est adjacent à une image ou lui est
associé, la variable affiche les métadonnées de cette image. Vous avez toute latitude pour modifier la variable Nom de l’image afin de déterminer
le champ de métadonnées à utiliser.
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Voir la section Définition de variables de légende.

Dernier numéro de page
Le type Dernier numéro de page est utile pour ajouter le nombre de pages total d’un document aux en-têtes et pieds de page, selon le format
« Page 3 sur 12 ». Dans ce cas, le chiffre 12 est généré par la variable Dernier numéro de page et est mis à jour lorsque des pages sont ajoutées
ou supprimées. Vous pouvez insérer du texte avant ou après le dernier numéro de page et vous pouvez spécifier un style de numérotation. Dans
le menu Etendue, choisissez une option pour déterminer si le dernier numéro de page de la section ou du document est utilisé.

Le dernier numéro de page ne compte pas les pages du document.

En-tête continu (style de paragraphe ou de caractère)
Les variables En-tête continu insèrent sur la page la première et la dernière occurrence du texte auquel le style spécifié est appliqué. Si aucun
texte de la page ne se présente dans le style spécifié, alors le texte d’une page précédente est utilisé.

Voir la section Création de variables pour des en-têtes et des pieds de page continus.

Texte personnalisé
Cette variable est couramment utilisée pour insérer un texte de substitution ou une chaîne de texte susceptible d’être modifiée rapidement. Par
exemple, si vous travaillez sur un projet qui utilise un nom de code pour une société, vous pouvez créer une variable de texte personnalisé pour
le nom de code. Une fois que vous êtes prêt à utiliser le nom réel de la société, vous n’avez plus qu’à modifier la variable pour mettre à jour
toutes les occurrences.

Pour insérer des caractères spéciaux dans une variable de texte, cliquez sur le triangle à droite de la zone de texte.

Insertion de variables de texte
1. Placez le point d’insertion à l’emplacement où vous souhaitez que la variable apparaisse.

2. Choisissez Texte > Variables de texte > Insérer une variable, puis choisissez la variable que vous voulez insérer.

La variable apparaît sur la page comme si vous l’aviez saisie dans le document. Par exemple, la variable Date de création peut apparaître sous la
forme 22 décembre 2007. Si vous choisissez Texte > Afficher les caractères masqués, l’occurrence de variable est entourée d’un cadre utilisant la
couleur du calque actif.

Remarque : les variables de texte ne contiennent pas de sauts de ligne.

Suppression, conversion et importation de variables de texte
Utilisez la boîte de dialogue Variables de texte pour supprimer, convertir et importer des variables de texte.

Pour supprimer les variables de texte
Si vous voulez supprimer une occurrence de variable de texte insérée dans un document, il vous suffit de sélectionner la variable et d’appuyer sur
la touche Retour arrière ou Suppr. Vous pouvez également supprimer la variable. Dans ce cas, vous pouvez décider du mode de remplacement
des variables insérées dans le document.

1. Choisissez Texte > Variables de texte > Définir.

2. Sélectionnez la variable, puis cliquez sur Supprimer.

3. Indiquez le mode de remplacement de la variable en spécifiant une autre variable, en convertissant les occurrences de
variable en texte ou en les supprimant.

Pour convertir les variables de texte en texte
Pour convertir une seule occurrence, sélectionnez la variable de texte dans la fenêtre du document, puis choisissez Texte >
Variables de texte > Convertir une variable en texte.

Pour convertir toutes les instances de variables de texte dans le document, choisissez la commande Texte > Variables de
texte > Définir, sélectionnez la variable, puis cliquez sur l’option Convertir en texte.

Pour importer des variables de texte à partir d’un autre document
1. Choisissez Texte > Variables de texte > Définir.

2. Cliquez sur Charger, puis cliquez deux fois sur le document contenant les variables que vous voulez importer.

3. Dans la boîte de dialogue Charger des variables de texte, assurez-vous qu’une coche apparaît en regard des variables à
importer. Si une variable existante porte le même nom qu’une des variables importées, sélectionnez l’une des options
suivantes sous la rubrique Conflit avec une variable de texte existante, puis cliquez sur OK :

Utiliser la définition importée  Ecrase la variable existante avec la variable chargée et applique ses nouveaux attributs à tout



 

le texte du document actuel qui utilisait l’ancienne variable. Les définitions des variables chargées et existantes s’affichent au
bas de la boîte de dialogue Charger des variables de texte pour faciliter la comparaison.

Renommer automatiquement Renomme la variable chargée.

4. Choisissez l’option OK, puis cliquez sur le bouton Terminer.

Vous pouvez également copier les variables dans d’autres documents lorsque vous synchronisez un livre.

Voir aussi

Informations juridiques   |   Politique de confidentialité en ligne
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A propos de l’indexation
Présentation du panneau Index
Création d’une liste de rubriques d’index
Ajout d’entrées d’index
Options de groupes de pages dans les index
Ajout de références croisées « Voir » ou « Voir aussi » dans un index
Génération d’un index
Modification de l’ordre de tri des index
Gestion d’un index

A propos de l’indexation
Vous pouvez créer un simple index de mots-clés ou un guide complet et détaillé des informations contenues dans le livre. Vous ne pouvez créer
qu’un seul index par document ou par livre. Pour créer un index, commencez par placer les entrées d’index dans le texte. Vous associez ainsi
chaque marque d’index au mot, appelé rubrique, que vous souhaitez faire apparaître dans l’index.

Lorsque vous générez l’index, chaque rubrique est répertoriée, ainsi que la page dont elle provient. Les rubriques sont classées par ordre
alphabétique, généralement sous des titres de section (A, B, C, etc.). Une entrée d’index consiste en une rubrique (le terme recherché par
l’utilisateur) associée à une référence de page (numéro(s) de page(s)) ou une référence croisée. Une référence croisée, précédée de « Voir » ou
« Voir aussi », dirige l’utilisateur vers d’autres entrées d’index, plutôt que vers un numéro de page.

Eléments d’un index
A.  Titre B.  Titre de section C.  Entrée d’index D.  Sous-entrée E.  Rubrique F.  Référence de page G.  Référence croisée

Pour consulter un didacticiel vidéo sur la création d’un index, rendez-vous à l’adresse www.adobe.com/go/vid0220.

Conseils pour la création d’un index
Un index bien pensé et complet rend les informations contenues dans votre document immédiatement accessibles aux lecteurs. Considérez les
instructions suivantes lorsque vous créez un index :

Pensez à l’aspect que vous voulez donner à votre index. Combien de niveaux de rubriques voulez-vous créer ? Voulez-vous
renvoyer le lecteur vers des rubriques apparentées ? Est-ce qu’un index simple constitué de mots-clés sera suffisant ou avez-
vous besoin de créer un index plus complexe, avec des références croisées renvoyant à des rubriques apparentées et une
liste exhaustive de termes équivalents ?

Anticipez les différentes méthodes de recherche d’informations susceptibles d’être utilisées par les lecteurs. Par exemple,
certains lecteurs recherchent les informations concernant les animaux sous le mot-clé animaux, tandis que d’autres
recherchent mammifères ou faune.

Ajoutez les entrées d’index une fois que le contenu du document est plus ou moins définitif. En effet, si, plus tard, vous êtes
amené à supprimer d’importantes parties du texte, tout le temps que vous aurez passé à créer des entrées d’index aura été
perdu.

Un index bien pensé présente les rubriques de façon cohérente. L’un des problèmes les plus courants rencontré dans un
index est l’utilisation incohérente de majuscules et de minuscules (chats et Chats) et de formes au singulier et au pluriel (chat
et chats). Utilisez une liste de rubriques pour assurer la cohérence des termes.

Révisez l’index plusieurs fois avant de le générer pour la dernière fois. Recherchez les entrées doubles, les sujets vagues, les
fautes d’orthographe et les incohérences de casse ou de vocabulaire : par exemple, InDesign traite les mots Guépard,

http://www.adobe.com/go/vid0220
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guépard et guépards comme des entrées séparées.

Procédure de création d’un index
Pour créer un index, procédez comme suit :

1. Créez une liste de rubriques (facultatif). Une liste de rubriques vous aide à conserver une certaine cohérence dans vos entrées d’index (voir
la section Création d’une liste de rubriques d’index).
2. Ajoutez des marques d’index. Ajoutez des marques d’index sur les pages du document auxquelles vous souhaitez relier les entrées d’index
(voir la section Ajout d’entrées d’index).
3. Générez l’index. La génération d’un index crée un ensemble d’entrées pour les marques et les numéros des pages qui leur sont associées
(voir la section Génération d’un index).
4. Placez l’article d’index. Utilisez l’icône de texte chargée pour placer l’index dans un bloc de texte. Dans la plupart des cas, il est préférable
que l’index commence sur une nouvelle page. Après avoir placé l’index, vous pouvez mettre en forme les pages et l’index.
Vous devrez sans doute répéter ces étapes avant que l’index ne soit définitif.

Présentation du panneau Index
Pour créer, modifier et prévisualiser l’index, utilisez le panneau Index (Fenêtre > Texte et tableaux > Index). Il comprend deux modes : Référence
et Rubrique. En mode Référence, la zone d’aperçu affiche l’ensemble des entrées d’index dans le document ou dans le livre actuel. En mode
Rubrique, la zone d’aperçu n’affiche ni les numéros de page ni les références croisées, mais uniquement les rubriques. Le mode Rubrique est
principalement utilisé pour créer la structure de l’index, tandis que le mode Référence vous permet d’ajouter des entrées d’index.

En mode Référence, les entrées d’index sont classées par ordre alphabétique et divisées en sections par lettre. Un triangle en regard d’une entrée
permet de développer ou de réduire cette dernière pour afficher les sous-entrées, les numéros de page et les références croisées.

Les codes suivants s’affichent au lieu des références de page, indiquant les entrées d’index qui ne sont peut-être pas incluses dans l’index. Pour
visualiser ces codes, il est parfois nécessaire de choisir l’option Mettre à jour l’aperçu dans le panneau Index.

PB Indique les entrées d’index sur la table de montage (non visibles dans l’index généré).
HL Indique les entrées d’index sur un calque masqué. Lors de la génération de l’index, vous avez la possibilité d’inclure les entrées qui figurent
sur un calque masqué.
HT Indique les entrées d’index dans une condition masquée (non incluses dans l’index).
PN Indique les entrées d’index dans un texte en excès. Lorsque vous incluez ces entrées dans l’index généré, elles s’affichent sans numéro de
page.
Gabarit Indique les entrées d’index sur un gabarit (non visibles dans l’index généré).
Cliquez sur un triangle pour développer ou réduire une entrée. Pour développer ou réduire toutes les sous-entrées d’une entrée, cliquez sur le
triangle correspondant tout en maintenant la touche Alt (Windows) ou Option (Mac OS) enfoncée. Pour développer ou réduire toutes les entrées,
cliquez sur le triangle correspondant tout en maintenant la touche Ctrl (Windows) ou Commande (Mac OS) enfoncée.

Sélectionnez Mettre à jour l’aperçu dans le menu du panneau Index pour mettre à jour la zone d’aperçu. Cette commande est très utile si vous
avez apporté de nombreuses modifications au document ou déplacé des marques d’index dans la fenêtre de document.

Création d’une liste de rubriques d’index
Vous pouvez créer ou importer une liste de rubriques comme point de départ pour la création d’un index. Ensuite, lorsque vous ajoutez des
entrées, vous pouvez sélectionner des rubriques dans cette liste (au lieu d’avoir à les saisir à chaque fois) de façon à ce que toutes les
informations du livre ou document soient indexées.

Pour créer et modifier une liste de rubriques, utilisez le panneau Index en mode Rubrique. Le mode Rubrique affiche uniquement les rubriques.
Pour afficher les numéros de page et les références croisées, utilisez le mode Référence.



Panneau Index en mode Référence (à gauche) et en mode Rubrique (à droite)

Les rubriques de la liste s’affichent également dans la boîte de dialogue Nouvelle référence de page. Pour créer une entrée d’index, sélectionnez
une rubrique, puis associez-la à une page ou une référence croisée. Les rubriques non utilisées (sans page ni référence croisée) sont exclues lors
de la génération de l’index.

Vous n’êtes pas obligé de créer une liste de rubriques pour ajouter les entrées d’index. Chaque fois que vous créez une entrée d’index, sa
rubrique est ajoutée automatiquement à la liste des rubriques pour une utilisation ultérieure.

Par défaut, les rubriques que vous ajoutez à la liste des rubriques n’apparaissent pas dans la liste Référence, laquelle contient uniquement les
rubriques associées à une page. Toutefois, pour afficher les rubriques dans la liste Référence, vous pouvez choisir l’option Afficher les
rubriques inutilisées dans le menu du panneau Index en mode Référence.

Pour ajouter des rubriques à la liste
1. Sélectionnez Fenêtre > Texte et tableaux > Index pour afficher le panneau Index.
2. Sélectionnez Rubrique.
3. Sélectionnez Nouvelle rubrique dans le menu du panneau Index ou cliquez sur l’icône Créer une entrée d’index au bas du

panneau.
4. Utilisez l’une des méthodes suivantes :

Dans la zone Niveaux de rubrique, saisissez le nom de la rubrique, (par exemple, animaux) dans la première zone de
texte. Pour créer une sous-entrée, saisissez un nom (chats) dans la deuxième zone de texte. Dans cet exemple, « chats »
est en retrait sous « animaux ». Pour créer une sous-entrée dans la sous-entrée, saisissez un nom (Calicots) dans la
troisième zone de texte, etc.

Sélectionnez une rubrique existante. Saisissez les sous-entrées dans les deuxième, troisième et quatrième zones de
texte.

5. Cliquez sur Ajouter pour ajouter la rubrique. Celle-ci apparaît désormais dans la boîte de dialogue Nouvelle rubrique et dans
le panneau Index.

6. Cliquez sur Terminé lorsque vous n’avez plus de rubrique à ajouter.

Pour supprimer une rubrique que vous venez d’ajouter, cliquez sur Terminer, sélectionnez la rubrique dans le panneau Index, puis cliquez sur
le bouton Supprimer l’entrée sélectionnée.

Pour importer des rubriques à partir d’un autre document InDesign
1. Sélectionnez la commande Importer des rubriques dans le menu du panneau Index.
2. Choisissez le document contenant les rubriques d’index à importer, puis cliquez sur Ouvrir.

Pour modifier une rubrique d’index
Utilisez le panneau Index pour modifier les entrées avant ou après la génération de l’index. Les modifications apportées aux entrées du panneau
Index s’afficheront dans le prochain index que vous générerez, mais les modifications apportées à l’article d’index généré seront perdues lors de la
regénération de l’index.

1. Ouvrez un document contenant les rubriques de l’index.
2. Dans le panneau Index, choisissez le mode Rubrique.
3. Dans la zone d’aperçu, cliquez deux fois sur une rubrique.
4. Modifiez la rubrique à votre convenance, puis cliquez sur OK.
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Utilisez le panneau Index en mode Référence pour ajouter des entrées d’index. Les entrées d’index sont composées de deux parties : une
rubrique et une référence. Les rubriques peuvent être définies à l’avance à l’aide d’une liste de rubriques. Une référence peut renvoyer à un
numéro de page ou une référence d’une autre rubrique.

Panneau Index en mode Référence
A.  Entrée B.  Sous-entrée C.  Référence de page D.  Référence croisée

Une marque d’index est insérée au début du mot dans lequel du texte est sélectionné ou au niveau du point d’insertion. Vous pouvez visualiser
ces marques en choisissant Texte > Afficher les caractères masqués.

Pour ajouter une entrée d’index
1. A l’aide de l’outil Texte , placez le point d’insertion à l’endroit où vous voulez insérer la marque d’index ou sélectionnez un

texte à utiliser comme référence d’index.

Lorsque le texte sélectionné contient des images texte ou des caractères spéciaux, certains caractères (tels que les marques
d’index et les images texte) sont supprimés dans la zone Niveaux de rubrique. D’autres, tels que les tirets cadratin et les
symboles de copyright, sont convertis en métacaractères (par exemple, ^_ ou ^2).

2. Sélectionnez Fenêtre > Texte et tableaux > Index pour afficher le panneau Index.
3. Sélectionnez Référence.

Si les entrées ajoutées à la liste de rubriques ne figurent pas dans Référence, choisissez Afficher les rubriques inutilisées
dans le menu du panneau Index. Vous pouvez ensuite faire appel à ces rubriques lors de l’ajout des entrées.

4. Pour afficher les entrées d’index à partir des documents ouverts d’un livre, sélectionnez Livre.
5. Sélectionnez Nouvelle référence de page dans le menu du panneau Index. Si cette commande n’est pas visible, vérifiez que

l’option Référence est sélectionnée et qu’il existe un point d’insertion, ou une sélection de texte dans le document.
6. Pour ajouter du texte dans la zone Niveaux de rubrique, utilisez l’une des méthodes suivantes :

Pour créer une entrée d’index simple (telle que chats), saisissez l’entrée d’index dans la première zone Niveaux de
rubrique. Si du texte est sélectionné, il apparaît dans la zone Niveaux de rubrique.

Pour créer des entrées et des sous-entrées, saisissez le nom parent (dans cet exemple, animaux) dans la première zone
Niveaux de rubrique et saisissez les sous-entrées (chats et Calicots) dans les zones suivantes. Le cas échéant, cliquez
sur les touches flèches haut/bas pour intervertir les entrées.

Entrée d’index dans la zone Niveaux de rubrique (à gauche) et résultat dans l’index (à droite)

Cliquez deux fois sur une rubrique dans la zone de liste au bas de la boîte de dialogue.



7. Pour modifier le classement d’une entrée dans l’index, utilisez les zones Tri par. Par exemple, pour classer la rubrique de la
Vega sous V (au lieu de D), entrez Vega dans la zone Tri par, puis de la Vega dans la zone Niveaux de rubrique.

Vous pouvez également sélectionner l’ordre de tri des chiffres, des symboles et des langues, et modifier les informations de tri
des caractères chinois (voir la section Modification de l’ordre de tri des index).

8. Indiquez le type d’entrée d’index :

Pour créer des entrées d’index avec un numéro de page ou un groupe de pages (par exemple, chats 82–87), choisissez
une option décrivant l’étendue de l’entrée dans le menu déroulant Type (voir la section Options de groupes de pages dans
les index).

Pour créer une entrée d’index sans numéro de page, sélectionnez l’option Supprimer l’étendue dans le menu déroulant
Type. Le numéro de page n’apparaît pas dans l’index généré, mais il s’affiche entre parenthèses dans le panneau Index.

Pour créer une entrée d’index se rapportant à une autre entrée, sélectionnez l’une des options de référence croisée
(comme Voir ou Voir aussi) dans le menu déroulant Type, puis saisissez le nom de l’entrée dans la zone de texte
Référencée ou faites glisser l’entrée existante dans la liste située au bas de la zone Référencée. Vous pouvez également
personnaliser les termes « Voir » et « Voir aussi » qui s’affichent dans les entrées des références croisées en
sélectionnant Référence croisée personnalisée dans le menu déroulant Type (voir la section Ajout de références croisées
« Voir » ou « Voir aussi » dans un index).

9. Pour mettre en valeur une entrée particulière, sélectionnez l’option Remplacement du style de numéro, puis spécifiez le style
de caractère.

10. Pour ajouter une entrée dans l’index, utilisez l’une des méthodes suivantes :

Cliquez sur Ajouter pour ajouter une entrée sans fermer la boîte de dialogue.

Cliquez sur l’option Tout ajouter pour rechercher l’ensemble des occurrences du texte sélectionné dans la fenêtre du
document et créer une marque d’index pour chacune d’entre elles. L’option Tout ajouter n’est disponible que si du texte
est sélectionné.

Cliquez sur OK pour ajouter l’entrée d’index et fermer la boîte de dialogue.

Remarque : les entrées d’index ne sont pas supprimées si vous cliquez sur le bouton Annuler après avoir cliqué sur le
bouton Ajouter. Pour éliminer ces entrées, vous devez faire appel à la commande Annuler.

11. Pour fermer la boîte de dialogue, cliquez sur OK ou sur Terminer.

Pour indexer rapidement un mot, une expression ou une liste
En utilisant un raccourci d’indexation, vous pouvez rapidement indexer des mots simples, une expression ou une liste de mots et d’expressions.
Adobe InDesign reconnaît deux types de raccourcis d’indexation : le premier pour les entrées d’index standard et le second pour les noms
propres. Le raccourci du nom propre permet de créer des entrées d’index en inversant l’ordre d’un nom, de sorte que le tri s’opère par le nom de
famille. De cette manière, vous pouvez répertorier un nom précédé d’un prénom en le faisant apparaître dans un index trié par nom de famille. Par
exemple, le nom Alexandre Dumas apparaîtra dans l’index sous la forme Dumas, Alexandre.

Pour préparer une liste d’indexation, séparez chaque élément à indexer par l’un des délimiteurs suivants : retour, retour chariot
(Maj+touche Entrée), tabulation, tabulation de retrait à droite (Maj+Tab), point-virgule ou virgule. Le raccourci d’indexation ajoute une marque
devant chaque entrée et place tous les éléments dans l’index.

1. Dans la fenêtre du document, sélectionnez le ou les mots à indexer.
2. Utilisez l’une des méthodes suivantes :

Pour les mots ou les expressions standard, appuyez sur les touches Maj+Alt+Ctrl+[ (Windows) ou
Maj+Option+Commande+[ (Mac OS).

Pour les noms propres à indexer par le nom de famille, appuyez sur les touches Maj+Alt+Ctrl+] (Windows) ou
Maj+Option+Commande+] (Mac OS).

Une marque d’index comportant les paramètres par défaut est ajoutée au début de la sélection ou au début de chaque
élément sélectionné.

Pour indexer des noms de famille composés ou comportant un titre de noblesse, utilisez des espaces insécables entre
les mots. Par exemple, si vous voulez indexer « Alexandre Dumas père » sous « Dumas » et non sous « père », vous
devez insérer une espace insécable entre « Dumas » et « père ». Pour insérer une espace insécable, sélectionnez
Texte > Insérer une espace > Espace insécable.

Pour créer une entrée d’index à partir d’une entrée existante
Il arrive souvent qu’une rubrique indexée apparaisse à plusieurs endroits du livre ou document. Vous pouvez alors créer plusieurs entrées d’index
basées sur d’autres entrées déjà présentes dans l’index, de façon à garantir une cohérence.

1. Dans la fenêtre de document, cliquez pour créer un point d’insertion ou sélectionnez du texte là où vous voulez placer la
marque d’index.

2. Dans le panneau Index, sélectionnez le mode Référence et recherchez l’entrée à copier en faisant défiler la zone d’aperçu.
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3. Utilisez l’une des méthodes suivantes :

Faites glisser une entrée vers le bouton Nouveau  pour insérer une marque d’index au point d’insertion ou devant la
sélection.

Sélectionnez une entrée dans la zone d’aperçu du panneau, puis, tout en maintenant la touche Alt (Windows) ou Option
(Mac OS) enfoncée, cliquez sur le bouton Nouveau. La boîte de dialogue Nouvelle référence de page s’affiche, présentant
les informations sur l’entrée sélectionnée. Apportez les modifications nécessaires, puis cliquez sur Ajouter ou sur OK.

Vous pouvez également créer une liste de rubriques, puis sélectionner vos entrées pour l’index dans cette liste.

Pour indexer automatiquement chaque occurrence d’un mot
L’utilisation de l’option Tout ajouter est un moyen efficace d’indexer toutes les occurrences d’un terme spécifique dans un document ou un livre.
Lorsque vous choisissez cette option, InDesign crée une marque d’index pour chaque occurrence des mots sélectionnés dans le document (et
non du texte spécifié dans la boîte de dialogue). Par la suite, vous pouvez supprimer les entrées qui pointent vers une information moins
pertinente.

Lors de la recherche des occurrences du texte sélectionné, seuls les mots entiers sont pris en considération et la casse est respectée. Par
exemple, si vous sélectionnez le mot guépard, les mots guépards et Guépard ne sont pas indexés.

1. Dans la fenêtre de document, sélectionnez le texte à rechercher.
2. Dans le panneau Index, sélectionnez le mode Référence.
3. Pour créer des entrées d’index dans un document ouvert du livre, sélectionnez Livre.
4. Sélectionnez Nouvelle référence de page dans le menu du panneau Index.
5. Sélectionnez l’option Tout ajouter. InDesign ajoute une marque d’index à tout texte qui correspond au texte sélectionné,

même si ce texte comporte déjà une marque d’index. Par conséquent, vous risquez d’obtenir plusieurs entrées pour un même
mot ou une même phrase.

Pour modifier une entrée d’index
Le mode Rubrique du panneau Index permet de modifier une rubrique (tel que son nom ou son ordre de tri) et de mettre à jour toutes les entrées
apparentées à cette rubrique automatiquement. Pour modifier les entrées une à une, utilisez le mode Référence. Ce mode permet d’ajouter des
références croisées ou de rechercher la marque d’index associée à une référence de page.

1. Ouvrez le document contenant les entrées d’index.
2. Dans le panneau Index, utilisez l’une des méthodes suivantes :

Sélectionnez Rubrique pour modifier une rubrique et mettre à jour automatiquement toutes les entrées à l’aide de cette
rubrique.

Sélectionnez Référence pour modifier une seule entrée.

3. Dans la zone d’aperçu, sélectionnez une entrée ou une référence de page. Pour sélectionner une référence de page, cliquez
sur l’icône de page située sous l’entrée.

4. Cliquez deux fois sur l’entrée ou la référence de page à modifier.
5. Apportez les modifications nécessaires à l’entrée, puis cliquez sur OK.

Options de groupes de pages dans les index
Vous pouvez créer des entrées d’index comportant un groupe de pages (tel que chats 82 – 87), au lieu d’une seule référence de page. Le menu
déroulant Type, dans la boîte de dialogue Nouvelle référence de page, propose les options de groupe de pages suivantes :

Page active Le groupe de pages ne s’étend pas au-delà de la page active.
Jusqu’au style suivant Le groupe de pages s’étend de la marque d’index jusqu’au style de paragraphe suivant.
Jusqu’au style indiqué Le groupe de pages s’étend de la marque d’index jusqu’à la page contenant le style de paragraphe spécifié dans le menu
déroulant adjacent.
Jusqu’à la fin de l’article Le groupe de pages s’étend de la marque d’index jusqu’à la fin des blocs de texte liés sélectionnés contenant du
texte.
Jusqu’à la fin du document Le groupe de pages s’étend de la marque d’index jusqu’à la fin du document.
Jusqu’à la fin de la section Le groupe de pages s’étend de la marque d’index jusqu’à la fin de la section actuelle, comme définie dans le
panneau Pages (voir la section Options de numérotation de document).
Nombre de paragraphes indiqué Le groupe de pages s’étend de la marque d’index jusqu’à la fin du nombre de paragraphes indiqué dans la
zone adjacente ou jusqu’à la fin de tous les paragraphes.
Nombre de pages indiqué Le groupe de pages s’étend de la marque d’index jusqu’à la fin du nombre de pages indiqué dans la zone adjacente
ou jusqu’à la fin de toutes les pages.
Supprimer l’étendue Désactive l’option d’étendue de pages.



Haut de la page

Haut de la page

Ajout de références croisées « Voir » ou « Voir aussi » dans un index
Les références croisées sont des entrées d’index qui renvoient non pas à un numéro de page, mais à des entrées apparentées. Pour créer des
références croisées, utilisez le panneau Index. Les avantages d’une référence croisée sont multiples :

Une référence croisée associe un terme à d’autres termes équivalents utilisés dans le livre ou document. Par exemple, Faune.
Voir Animaux. Les entrées ainsi référencées ne renvoient pas à un numéro de page ; elles renvoient à un terme équivalent
dans l’index.

Une référence croisée renvoie à une autre entrée apparentée (mais pas équivalente) à une rubrique. Par exemple, Chats. Voir
aussi Chats sauvages. Dans ce cas, l’entrée d’index contenant la référence croisée contient également les numéros de page
et/ou les sous-entrées directement associés à la rubrique de l’entrée.

Deux types de références croisées
A.  Référence croisée renvoyant à une information apparentée (Voir aussi) B.  Référence croisée renvoyant à un terme
équivalent (Voir)

Lorsque vous créez une référence croisée dans InDesign, vous pouvez également choisir un préfixe. « Voir » et « Voir aussi » sont du texte
statique. Lorsque vous choisissez « Voir [aussi] », InDesign attribue automatiquement le préfixe approprié à la référence croisée chaque fois que
l’index est généré :

Les entrées avec un numéro de page, une sous-entrée ou les deux comportent le préfixe « Voir aussi ».

Les entrées sans numéro de page ni sous-entrée comportent le préfixe « Voir ».

L’option « Voir [aussi] » vous évite de mettre à jour manuellement les références croisées lorsque le contenu des entrées est modifié.

1. Sélectionnez Fenêtre > Texte et tableaux > Index.
2. Sélectionnez Référence.
3. Sélectionnez Livre pour afficher les entrées d’index dans un document de livre ouvert (facultatif).
4. Sélectionnez Nouvelle référence de page dans le menu du panneau Index.
5. Entrez une ou plusieurs rubriques dans les zones Niveaux de rubrique.
6. Dans le menu Type, choisissez un préfixe associé à la référence croisée (tel que Voir aussi) au bas du menu.
7. Entrez une rubrique dans la zone Référencée ou faites glisser une rubrique existante dans la liste des rubriques du bas.
8. Cliquez sur Ajouter pour ajouter la référence croisée à l’index.

Les références croisées s’affichent dans le panneau Index et dans l’index généré, mais ne sont pas associées aux marques d’index dans le
document.

Les références croisées avec un préfixe « Voir [aussi] » s’affichent avec le préfixe « Voir [aussi] » dans le panneau Index. Le préfixe approprié
s’affichera dans l’article d’index généré.

Génération d’un index
Lorsque les entrées d’index sont ajoutées et affichées dans le panneau Index, vous pouvez générer un index et le placer dans votre document.

Un article d’index peut apparaître dans un document séparé ou dans un document existant. Lorsque vous générez un index, InDesign compile les
entrées et met à jour les numéros de page pour tout le livre ou le document. Si vous ajoutez ou supprimez des entrées d’index ou que vous
mettez à jour la numérotation du document, vous devez générer de nouveau l’index.

Si des marques d’index apparaissent dans un texte en excès, vous êtes invité à inclure ces marques dans l’index lorsque vous générez ce dernier.
Si vous cliquez sur Oui, l’entrée s’affiche dans l’index sans numéro de page. Si une marque d’index figure dans du texte conditionnel masqué,
l’entrée correspondante est exclue de l’index.

Pour consulter un didacticiel vidéo sur la création d’un index, rendez-vous à l’adresse www.adobe.com/go/vid0220.

1. Utilisez l’une des méthodes suivantes :

Si vous créez un index pour un seul document, vous devrez ajouter une page à la fin du document.

Si vous créez un index pour plusieurs documents dans un livre, créez ou ouvrez le document à utiliser pour l’index et
insérez ce document dans le livre.

2. Sélectionnez la commande Générer l’index dans le menu du panneau Index. Spécifiez les paramètres pour les options

http://www.adobe.com/go/vid0220


suivantes :

Pour l’option Titre, saisissez le texte qui doit apparaître en haut de l’index. Pour définir la mise en forme du titre,
sélectionnez un style dans le menu déroulant Style du titre.

Sélectionnez Remplacer l’index existant, le cas échéant. Cette option est grisée si vous n’avez pas généré d’index.
Désélectionnez cette option pour créer plusieurs index.

Sélectionnez Inclure les documents du livre pour créer un index pour tous les documents dans la liste des documents du
livre et renuméroter les pages du livre. Vous devez désélectionner cette option si vous voulez générer un index
uniquement pour le document actif.

Sélectionnez l’option Inclure les entrées des calques masqués si vous voulez que les marques d’index dans les calques
masqués soient incluses dans l’index.

Cliquez sur Plus d’options pour afficher des options d’index supplémentaires.

3. Cliquez sur OK. Lorsque l’option Remplacer l’index existant est désélectionnée, une icône de texte chargée s’affiche. Vous
placez l’article d’index comme tout autre texte.

Si vous modifiez les entrées directement dans l’index, les modifications effectuées sont perdues lorsque vous régénérez l’index. Pour obtenir un
résultat optimal, modifiez l’index dans le panneau Index, puis générez de nouveau l’index.

Options de mise en forme de l’index
Lorsque vous cliquez sur le bouton Plus d’options dans la boîte de dialogue Générer l’index, vous avez accès à des options de mise en forme
pour définir le style et l’aspect de l’index généré. InDesign inclut plusieurs styles de paragraphe et de caractère intégrés que vous pouvez utiliser
pour mettre en forme l’index généré. Vous pouvez également créer et appliquer vos propres styles. Une fois l’index généré, vous pouvez modifier
ces styles à partir des panneaux Styles de paragraphe et Styles de caractère.

Index avec entrées imbriquées
A.  Titre B.  Titre de section C.  Entrée Niveau 1 D.  Sous-entrée Niveau 2 E.  Rubrique F.  Référence croisée

Pour remplacer les séparateurs d’entrées (comme les valeurs pour les options Rubrique suivante ou Entre les entrées), sélectionnez le
séparateur existant, puis saisissez ou choisissez un caractère de remplacement.

Imbriqué ou Continu Sélectionnez Imbriqué pour une mise en forme de l’index par défaut : les sous-entrées sont imbriquées sous une seule
entrée comme des paragraphes en retrait séparés. Sélectionnez Continu pour que tous les niveaux d’une même entrée apparaissent dans un seul
paragraphe. L’option Entre les entrées permet de définir le caractère séparant les entrées.
Inclure les titres de section d’index Sélectionnez cette option pour générer des titres de section composés de caractères alphabétiques (A, B,
C, etc.) représentant les sections qui suivent.
Inclure les sections d’index vides Sélectionnez cette option pour générer un titre de section pour chaque lettre de l’alphabet, même lorsqu’il
n’existe pas d’entrée de premier niveau sous la lettre de la section.
Style des niveaux Choisissez un style de paragraphe à appliquer aux entrées de chaque niveau d’index. Une fois l’index généré, vous pouvez
modifier ces styles dans le panneau Styles de paragraphes.
Titre de section Sélectionnez le style de paragraphe qui définit l’aspect des titres de section (A, B, C, etc.) dans l’index généré.
Numéro de page Sélectionnez le style de caractère qui définit l’aspect des numéros de page dans l’index généré. Ce paramètre n’agit pas sur les
entrées d’index que vous avez mises en forme en appliquant l’option Remplacement du style de numéro.
Remarque : pour inclure des préfixes dans les numéros de page des tables des matières, tels que B-1 ou II-1, reportez-vous à la section
Définition de la numérotation de section.
Référence croisée Sélectionnez le style de caractère qui définit l’aspect du préfixe des références croisées, tel que Voir et Voir aussi, dans
l’index généré.
Rubrique en référence croisée Sélectionnez le style de caractère qui définit l’aspect de la rubrique à laquelle vous renvoyez, tel que animaux
dans Voir aussi animaux, dans l’index généré.
Rubrique suivante Saisissez ou sélectionnez un caractère spécial pour séparer une entrée d’index de son numéro de page (par exemple
animaux  38). Le séparateur par défaut est deux espaces. Définissez la mise en forme de ce caractère en modifiant le style du niveau
correspondant ou en sélectionnant un autre style.
Entre les numéros de page Saisissez ou sélectionnez un caractère spécial pour séparer plusieurs numéros de page ou plusieurs groupes de
pages. Le séparateur par défaut est une virgule suivie d’une espace demi-cadratin.
Entre les entrées Si Continu est sélectionné, saisissez ou sélectionnez un caractère spécial pour définir le séparateur entre les entrées et les
sous-entrées. Si Imbriqué est sélectionné, ce paramètre définit le séparateur entre deux références croisées dans une même entrée.
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Avant la référence croisée Saisissez ou sélectionnez un caractère spécial pour séparer une référence d’une référence croisée, par exemple
Animaux. Voir aussi animaux. Le séparateur par défaut est un point suivi d’une espace. Définissez la mise en forme de ce caractère en
choisissant un autre niveau de style ou en modifiant le niveau de style correspondant.
Etendue Saisissez ou sélectionnez un caractère spécial pour séparer le premier et le dernier numéro de page dans un groupe de pages (tel que
animaux 38 – 43). Le séparateur par défaut est un tiret demi-cadratin. Définissez la mise en forme de ce caractère en choisissant un autre niveau
de style ou en modifiant le style du numéro de page correspondant.
Fin de l’entrée Saisissez ou sélectionnez un caractère spécial devant apparaître à la fin des entrées. Si Continu est sélectionné, le caractère
spécial apparaît à la fin de la dernière référence croisée. Aucun caractère n’est défini comme séparateur par défaut.

Modification de l’ordre de tri des index
Vous pouvez modifier l’ordre de tri des langues et des symboles. Ceci est particulièrement utile pour les langues grecque, cyrilliques et asiatiques.
Il en est de même si vous souhaitez modifier l’emplacement des symboles dans l’index. Si vous souhaitez que les symboles figurent à la fin, vous
pouvez déplacer la catégorie Symbole au bas de la liste de priorités.

Lorsque vous changez l’ordre de tri, cela modifie également l’ordre de tri dans le panneau Index et dans les articles d’index générés
ultérieurement. Vous pouvez créer plusieurs index avec des ordres de tri différents. Par exemple, vous pouvez générer un index en allemand,
modifier l’ordre de tri, puis générer un index séparé en suédois : assurez-vous que l’option Remplacer l’index existant n’est pas sélectionnée
lorsque vous générez l’index.

1. Choisissez Options de tri dans le menu du panneau Index.
2. Assurez-vous que les éléments que vous voulez trier sont sélectionnés.
3. Pour déterminer le type de script de langue utilisé, cliquez sur l’élément sous Type d’en-tête et choisissez une autre option

dans le menu.

Par exemple, pour le cyrillique, vous avez le choix entre russe, biélorusse, bulgare ou ukrainien. Pour le chinois, vous avez le
choix entre Pinyin, surtout utilisé pour le chinois simplifié, ou Nombre de frappes, surtout utilisé pour le chinois traditionnel.

4. Pour modifier la position d’une langue ou d’un symbole, sélectionnez-le dans la liste, puis cliquez sur les boutons Haut ou Bas
dans la partie inférieure droite de la liste.

Les éléments placés en haut dans la liste sont triés avant les éléments inférieurs. Tous les caractères des langues qui ne sont
pas incluses dans la boîte de dialogue Options de tri sont triés en tant que symboles. Par exemple, si vous avez un texte en
grec dans votre document, mais que la langue grecque n’est pas incluse dans les Options de tri, tout texte grec indexé
apparaîtra sous Symboles.

Pour trier l’ordre des index en japonais et en coréen
Lors de la création d’entrées d’index pour les langues asiatiques, tenez compte des points suivants :

Les langues asiatiques utilisent des conventions de tri différentes, s’appuyant sur des règles typographiques qui leur sont
propres.

Lorsque vous créez un index pour du texte en japonais, la lecture yomi des entrées d’index dans la zone Niveaux de rubrique
doit être saisie dans la zone de texte Yomi en utilisant des caractères hiragana pleine chasse et katakana. Il n’est pas
nécessaire d’entrer la lecture yomi pour les caractères hiragana pleine chasse, katakana, les caractères alphanumériques,
certains symboles, les caractères alphanumériques demi-chasse et les entrées d’index n’ayant que des symboles dans la
zone de texte Yomi. Les entrées de la zone Niveaux de rubrique sont triées. Dans certains cas, lorsqu’une entrée contient à la
fois des symboles pleine chasse et demi-chasse, le tri peut ne pas s’effectuer comme prévu. Une lecture yomi appropriée doit
alors être saisie.

Les caractères katakana demi-chasse ou kanji ne peuvent pas être saisis dans la zone de texte Yomi. Les symboles demi-
chasse, tels que  et , peuvent toutefois être saisis.

Le logiciel fait la distinction entre les caractères hiragana et katakana, et les caractères hiragana apparaissent avant les
katakana. Il distingue également les caractères alphabétiques minuscules des majuscules ; les caractères en majuscules
apparaissent avant les minuscules.

Si des caractères identiques sont saisis dans la zone Niveaux de rubrique, ils sont traités comme des entrées d’index
distinctes si une lecture yomi différente est saisie. Par exemple, si « Chat » est saisi comme entrée d’index sous la forme
« Neko » en katakana, puis saisi une deuxième fois sous la forme « Neko » en hiragana, deux entrées d’index seront générées
pour « Chat ». Cette fonction permet également de classer un même terme dans des rubriques d’index distinctes. Par
exemple, lorsque vous saisissez le terme « Les chats » dans un index, si « Chats » est saisi dans la zone de texte Yomi et
que deux entrées d’index sont créées sans saisie de texte correspondante, le terme « Les chats » sera généré sous les
rubriques d’index L et C.

Pour l’ordre de tri du coréen, vous avez le choix entre Consonne coréenne et Consonne coréenne plus voyelle.

Pour trier l’ordre des index en chinois
Vous déterminez l’ordre de tri des caractères chinois à deux emplacements : dans la boîte de dialogue Options de tri et dans le champ Tri par lors
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de la création ou de la modification d’une entrée d’index.

Boîte de dialogue Options de tri La commande Options de tri du menu du panneau Index vous permet de modifier l’ordre de tri et de préciser si
vous préférez utiliser Pinyin ou Nombre de frappes.
Trier par Lorsque vous créez ou modifiez une entrée d’index, la saisie de caractères chinois dans les champs Niveaux de rubrique vous permet
de modifier les informations de tri des caractères chinois.
Pour Pinyin, si plusieurs mots ont le même Pinyin, les entrées sont triées par (1) ton et (2) nombre de frappes en ordre croissant. Pour Nombre de
frappes, chaque caractère est trié par (1) nombre de frappes, (2) première frappe et (3) seconde frappe. Vous pouvez modifier les informations de
tri directement dans le champ Trier par ou cliquer sur la flèche à droite du champ Trier par pour ouvrir la boîte de dialogue Entrée Pinyin ou
Entrée Nombre de traits. Vous pouvez modifier les champs et cliquer sur OK. Répétez cette procédure pour chaque niveau de rubrique.

Gestion d’un index
Une fois que vous avez généré l’index et ajouté les marques d’index au document, plusieurs méthodes permettent de gérer l’index. Vous pouvez
afficher l’ensemble des rubriques d’index dans un livre, supprimer de la liste Rubrique celles qui ne sont pas utilisées dans la liste Référence,
rechercher des entrées dans la liste Référence ou Rubrique et supprimer des marques d’index du document.

Pour afficher toutes les rubriques d’index d’un livre
Lorsque l’option Livre est sélectionnée, le panneau Index affiche l’ensemble des entrées du livre et non celles du document uniquement.

1. Ouvrez le livre, ainsi que tous les documents qu’il contient.
2. Sélectionnez Livre en haut du panneau Index.

Si d’autres utilisateurs veulent accéder aux documents du livre lors de la création de l’index, créez une liste type des rubriques dans un document
séparé, puis importez les rubriques de la liste type dans chaque document du livre. Si la liste type est modifiée, vous devez réimporter les
rubriques dans chaque document.

Lorsque vous indexez un livre contenant plusieurs documents, vous pouvez afficher les rubriques d’index pour tous les documents répertoriés
en générant l’index du livre, avec l’ensemble des documents. Vous n’avez alors pas besoin d’utiliser l’option Importer des rubriques du menu
Index pour importer manuellement les rubriques dans chaque document.

Pour supprimer les rubriques inutilisées de la liste Rubrique
Après avoir créé votre index, vous pouvez supprimer des rubriques qui n’étaient pas comprises dans l’index.

1. Sélectionnez Fenêtre > Texte et tableaux > Index pour afficher le panneau Index.
2. Dans le menu du panneau Index, sélectionnez la commande Supprimer les rubriques inutilisées. Les rubriques sans numéro

de page associé sont supprimées.

Pour supprimer des marques d’index
 Utilisez l’une des méthodes suivantes :

Dans le panneau Index, sélectionnez l’entrée ou la rubrique à supprimer. Cliquez sur le bouton Supprimer l’entrée
sélectionnée .

Remarque : si l’entrée sélectionnée correspond au titre de plusieurs sous-titres, ces derniers sont également supprimés.

Dans la fenêtre de document, sélectionnez la marque d’index et appuyez sur la touche RetArr ou Suppr.

Remarque : pour afficher les marques d’index dans la fenêtre du document, sélectionnez Texte > Afficher les caractères masqués.

Pour rechercher une entrée d’index dans le panneau Index
1. Sélectionnez Afficher le champ Rechercher dans le menu du panneau Index.
2. Dans la zone Rechercher, saisissez le nom de l’entrée à rechercher, puis cliquez sur le bouton flèche haut ou bas.

Pour rechercher les marques d’index d’un document
1. Sélectionnez Texte > Afficher les caractères masqués pour afficher les marques d’index dans la fenêtre du document.
2. Dans le panneau Index, cliquez sur Référence, puis sélectionnez l’entrée que vous souhaitez rechercher.
3. Sélectionnez la commande Atteindre la marque sélectionnée dans le menu du panneau Index. Le point d’insertion apparaît à

droite de la marque d’index. Vous pouvez alors appuyer sur les touches Maj+Flèche Gauche pour sélectionner la marque et
couper, copier ou supprimer l’entrée.

Pour composer en majuscules les entrées d’index
La boîte de dialogue Composer en majuscules propose une solution globale pour modifier la casse des entrées d’index. Par exemple, si vous
avez indexé une entrée en minuscules (chats) et la même entrée avec une lettre initiale en majuscule (Chats), ces entrées sont considérées
comme deux rubriques distinctes. Vous pouvez corriger cette erreur en sélectionnant des entrées et en les composant en majuscules.

1. Dans la zone d’aperçu du panneau Index, sélectionnez une entrée.



 

2. Sélectionnez la commande Composer en majuscules dans le menu du panneau Index.
3. Choisissez une composition en majuscules pour la rubrique sélectionnée uniquement, la rubrique sélectionnée et toutes les

sous-rubriques correspondantes, toutes les rubriques de niveau 1 ou toutes les rubriques. Cliquez ensuite sur OK.

Voir aussi
Vidéo Créer un index
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Création de texte curviligne
Modification ou suppression d’un texte curviligne
Ajustement de la position du texte curviligne
Application d’un effet à un texte curviligne
Ajout d’objets ancrés à un texte curviligne

Création de texte curviligne
Vous pouvez créer un texte qui suit le contour d’un tracé ouvert ou fermé de n’importe quelle forme. Vous pouvez appliquer des options et des
effets à un texte curviligne : faites-le glisser le long d’un tracé, créez une symétrie de chaque côté du tracé ou déformez les caractères selon la
forme du tracé. Un texte curviligne est doté d’un port d’entrée et de sortie comme les autres blocs de texte, vous permettant de créer des liens
depuis ou vers le texte.

Vous pouvez afficher une seule ligne de texte sur un tracé. Ainsi, tout texte ne tenant pas sur le tracé est en excès (masqué), sauf si vous l’avez
lié à un autre tracé ou bloc de texte. Vous pouvez ajouter des objets ancrés sur la ligne et au-dessus de la ligne à un texte curviligne. Il est
impossible de créer un texte curviligne à l’aide de tracés transparents, tels que ceux obtenus avec la commande Vectoriser.

Texte curviligne
A.  Equerre de début B.  Port d’entrée C.  Equerre centrale D.  Equerre de fin E.  Port de sortie indiquant du texte lié

1. Sélectionnez l’outil Texte curviligne  (cliquez sur l’outil Texte et maintenez le bouton de la souris enfoncé pour afficher un
menu contenant l’outil Texte curviligne).

2. Positionnez le pointeur sur le tracé jusqu’à ce qu’un petit signe plus apparaisse en regard du pointeur , puis effectuez les
opérations suivantes :

Pour insérer du texte en utilisant les paramètres par défaut, cliquez sur le tracé. Par défaut, un point d’insertion apparaît
au début du tracé. Si les paramètres de paragraphe par défaut actifs appliquent un retrait ou un alignement (autre que
l’alignement à gauche), le point d’insertion risque de s’afficher ailleurs qu’au début du tracé.

Pour limiter le texte à une portion spécifique du tracé, cliquez à l’endroit du tracé où vous souhaitez faire commencer le
texte, puis faites glisser le pointeur vers l’endroit où vous souhaitez arrêter le texte et relâchez la souris. Pour plus de
détails sur la modification des positions de début et de fin du texte, reportez-vous à la section Ajustement de la position du
texte curviligne.

Modification de l’emplacement du texte curviligne

Remarque : si vous n’obtenez aucun effet en cliquant ou en faisant glisser le pointeur de la souris, vérifiez que le petit
signe plus s’affiche à côté du pointeur de l’outil Texte curviligne lorsque vous effectuez ces opérations.

3. Saisissez votre texte. Si vous avez cliqué pour placer le point d’insertion sur le tracé, le texte s’affiche sur toute la longueur du
tracé. Si vous avez fait glisser le pointeur, le texte s’étale sur la longueur définie par le glissement du pointeur.
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Remarque : si le tracé était visible à l’origine, il le reste après l’ajout de texte. Pour masquer le tracé, sélectionnez-le à l’aide de l’outil Sélection ou
Sélection directe, puis définissez les valeurs de fond et de contour sur Sans.

Modification ou suppression d’un texte curviligne
Vous pouvez appliquer des options de caractère et de paragraphe à un texte curviligne. Toutefois, les options de filet et d’espacement des
paragraphes sont sans effet sur les textes curvilignes. Le paramètre d’alignement du panneau Paragraphe contrôle l’alignement du texte
curviligne.

Pour modifier et mettre en forme des caractères de texte curviligne
1. A l’aide de l’outil Texte curviligne, utilisez l’une des méthodes suivantes :

Pour ajouter un point d’insertion, cliquez entre deux caractères du texte curviligne.

Pour sélectionner des caractères, faites glisser le pointeur sur le texte curviligne.

2. Modifiez et mettez le texte en forme à votre gré.

Pour supprimer un texte curviligne
1. A l’aide de l’outil Sélection  ou Sélection directe , sélectionnez un ou plusieurs objets de texte curviligne.
2. Choisissez la commande Texte > Texte curviligne > Supprimer texte curviligne.

Si le texte curviligne est lié, il se déplace vers le bloc de texte ou l’objet de texte curviligne lié suivant. S’il n’est pas lié, le texte est supprimé. Le
tracé subsiste mais il perd tous ses attributs de texte curviligne (les équerres, les ports d’entrée et de sortie, ainsi que les liens sont supprimés).

Remarque : si le fond et le contour du tracé sont définis sur Sans, le tracé est invisible après la suppression du texte. Pour le faire apparaître,
appuyez sur la touche D immédiatement après avoir choisi la commande Texte > Texte curviligne > Supprimer texte curviligne. Cela permet
d’appliquer le fond et le contour par défaut au tracé sélectionné.

Pour diminuer l’espacement des caractères disposés autour d’arrondis et d’angles aigus
1. A l’aide de l’outil Sélection ou Texte, sélectionnez le texte curviligne.
2. Choisissez la commande Texte > Texte curviligne > Options ou cliquez deux fois sur l’outil Texte curviligne.
3. Entrez une valeur en points pour l’option Espacement. Des valeurs élevées permettent de supprimer davantage d’espace

entre les caractères disposés le long de courbes et d’angles aigus.

Texte curviligne avant réglage de l’espacement (à gauche) et après réglage de l’espacement (à droite)

Remarque : la valeur Espacement compense la manière dont les caractères se déploient autour d’une courbe ou d’un angle aigu. Elle est sans
effet sur les caractères placés le long de segments droits. Pour modifier l’espacement des caractères sur le tracé, sélectionnez-les et appliquez-
leur un crénage ou une approche.

Ajustement de la position du texte curviligne
Vous pouvez modifier la position de début et de fin d’un texte curviligne, le faire glisser et le modifier de plusieurs façons.

Pour modifier la position de début et de fin du texte curviligne
1. A l’aide de l’outil Sélection , sélectionnez le texte curviligne.
2. Placez le pointeur au-dessus de l’équerre de début ou de fin du texte curviligne jusqu’à ce qu’une petite icône apparaisse en

regard du pointeur . Ne le positionnez pas sur le port d’entrée ou de sortie de l’équerre.
Effectuez un zoom avant pour sélectionner plus facilement l’équerre.

3. Faites glisser l’équerre de début ou de fin le long du tracé.
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Placez le pointeur sur l’équerre de début ou de fin, puis faites glisser la souris pour repositionner le cadre du texte curviligne.

Remarque : si vous appliquez une valeur de retrait de paragraphe, celle-ci est mesurée d’après ses équerres de début et de fin.

Pour faire glisser un texte le long d’un tracé
1. A l’aide de l’outil Sélection , sélectionnez le texte curviligne.
2. Placez le pointeur au-dessus de l’équerre centrale du texte curviligne jusqu’à ce qu’une icône d’équerre centrale apparaisse

en regard du pointeur .
Effectuez un zoom avant pour sélectionner plus facilement l’équerre.

3. Faites glisser l’équerre centrale le long du tracé.

Remarque : le texte ne se déplace pas lorsque les équerres de début et de fin se trouvent aux extrémités du tracé. Pour agrandir l’espace et faire
glisser le texte, déplacez les équerres de début ou de fin au-delà des extrémités du tracé.

Pour rendre un texte curviligne symétrique
1. A l’aide de l’outil Sélection , sélectionnez le texte curviligne.
2. Placez le pointeur au-dessus de l’équerre centrale du texte jusqu’à ce qu’une icône d’équerre centrale apparaisse en regard

du pointeur .
3. Faites glisser l’équerre centrale le long du tracé.

Placez le pointeur sur l’équerre centrale, puis faites-le glisser le long du tracé pour rendre le texte symétrique.

Vous pouvez également rendre un texte curviligne symétrique par le biais d’une boîte de dialogue. A l’aide de l’outil Sélection
ou Texte, sélectionnez le texte curviligne. Choisissez Texte > Texte curviligne > Options. Sélectionnez l’option Symétrie, puis
cliquez sur OK.

Application d’un effet à un texte curviligne
1. A l’aide de l’outil Sélection ou Texte, sélectionnez le texte curviligne.
2. Choisissez la commande Texte > Texte curviligne > Options ou cliquez deux fois sur l’outil Texte curviligne.
3. Choisissez l’une des options suivantes dans le menu Effet, puis cliquez sur OK :

Pour que le centre de la ligne de base de chaque caractère reste parallèle à la tangente du tracé, choisissez Arc-en-ciel. Il
s’agit du paramètre par défaut.
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Effets de texte curviligne
A.  Effet Arc-en-ciel B.  Effet Inclinaison C.  Effet Ruban 3D D.  Effet Marche d’escalier E.  Effet Gravité

Pour que les bords verticaux des caractères restent parfaitement verticaux quelle que soit la forme du tracé, tout en
laissant les bords horizontaux s’incliner pour suivre le tracé, choisissez Inclinaison. La déformation horizontale obtenue est
utile pour les textes qui suivent des vagues ou tournent autour d’un cylindre, comme dans le cas d’une étiquette de
bouteille.

Pour que les bords horizontaux des caractères restent parfaitement horizontaux quelle que soit la forme du tracé, tout en
maintenant le bord vertical de chaque caractère perpendiculaire au tracé, choisissez Ruban 3D.

Pour conserver le bord gauche de la ligne de base de chaque caractère sur le tracé sans faire pivoter les caractères,
choisissez Marche d’escalier.

Pour conserver le centre de la ligne de base de chaque caractère sur le tracé tout en préservant l’alignement de chaque
bord vertical sur le point central du tracé, choisissez Gravité. Pour contrôler l’effet de perspective de cette option, vous
pouvez régler la courbure appliquée au tracé du texte.

Ajout d’objets ancrés à un texte curviligne
1. A l’aide de l’outil Texte ou Texte curviligne, cliquez pour ajouter un point d’insertion à l’endroit du texte où vous souhaitez faire

apparaître l’ancrage de l’objet.
2. Ajoutez l’objet ancré. Vous pouvez ajouter des objets ancrés sur la ligne ou au-dessus de la ligne, mais aussi des blocs au

tracé (voir la section Objets ancrés).

Remarque : les options disponibles pour les objets ancrés au-dessus de la ligne dans un tracé diffèrent légèrement des options d’objets ancrés
dans un bloc de texte habituel : l’option Alignement est relative au marqueur d’objet ancré et l’option Espace avant n’est pas disponible.
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Récupérateur de contenu

Importation de contenu

Créer un lien

Faire correspondre les styles

Outils Récupérateur de contenu
Importer et lier
Spécifier les options de lien
Règle de correspondance de style personnalisée
Mettre à jour un élément lié

La réplication de contenus d’une page à l’autre n’est pas chose simple, sans compter que les manipulations de contenu par copier-coller sont
souvent fastidieuses et prennent un temps considérable. Servez-vous des fonctions de contenu lié pour gérer plusieurs versions de contenu. Vous
pouvez importer et lier le contenu dans un même document ou même dans différents documents. Le contenu lié simplifie la prise en charge des
nouveaux flux de production, qui supposent notamment d’élaborer des mises en page verticale et horizontale. Le contenu lié se prête tout aussi
bien aux flux de production de l’univers traditionnel de l’impression et de la publication, qui nécessitent de synchroniser du texte standard sur
plusieurs pages ou documents.

Le comportement du contenu lié est similaire à celui des liens traditionnels. Voir Présentation du panneau Liens pour en avoir un aperçu. Vous
pouvez désigner un objet en tant que parent, puis placer l’objet à d’autres emplacements en tant qu’objets enfants. A chaque mise à jour de l’objet
parent, les objets enfants sont signalés, ce qui vous permet de les mettre à jour et ainsi de les synchroniser avec l’objet parent.

Vous pouvez importer et lier des objets à l’aide des outils Récupérateur de contenu, ou en choisissant la commande de menu Edition > Importer et
lier.

L’icône  apparaît dans l’angle supérieur gauche d’un objet lié. L’élément apparaît sous forme d’objet lié dans le panneau Liens.

Outils Récupérateur de contenu
Les outils Récupérateur de contenu et Importation de contenu permettent de dupliquer des éléments de la page et de les importer dans des
documents InDesign ouverts. A mesure que le contenu est collecté, il est affiché dans le Transporteur de contenu. Utilisez le Transporteur de
contenu pour importer et lier facilement et rapidement plusieurs éléments de la page au sein de documents ouverts et entre eux.

Cliquez sur  dans le panneau Outils pour ouvrir le Récupérateur de contenu.

Utilisez l’outil Récupérateur de contenu  pour sélectionner un objet et l’ajouter au Transporteur de contenu

Utilisez l’outil Importation de contenu pour importer les objets de page sur une page

Appuyez sur B pour permuter entre l’outil Récupérateur de contenu et l’outil Importation de contenu.

 
Transporteur de contenu 
A. Outil Récupérateur de contenu B. Outil Importation de contenu C. Créer un lien D. Faire correspondre les styles E. Modifier la règle de
correspondance de style personnalisée F. Options d’importation G. Parcourir H. Collecter tous les blocs liés I. Charger le Transporteur de contenu 

Servez-vous de l’outil Récupérateur de contenu pour ajouter des éléments de page au Transporteur de contenu.

Servez-vous de l’outil Importation de contenu pour transférer les éléments du Transporteur de contenu vers le
document. Lorsque vous sélectionnez cet outil, l’élément actuel est ajouté au pistolet de placement.

Activez Créer un lien pour lier l’élément importé à l’emplacement d’origine de l’élément collecté. Vous pouvez gérer les liens à
partir du panneau Liens.

Faites correspondre les styles de paragraphe, de caractère, de tableau ou de cellule entre l’original et les

http://help.adobe.com/fr_FR/indesign/cs/using/WSA6A5201D-B07C-475f-A8F5-EE1774695851a.html


Modifier la règle de correspondance de style personnalisée

Options d’importation

Parcourir

Récupérer tous les blocs liés

Charger le transporteur
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éléments importés. Par défaut, la correspondance se base sur les noms de style. Voir la section Règle de correspondance de style personnalisée.

Définissez une règle de correspondance de style personnalisée entre les
éléments originaux et les éléments importés. Mettez les styles en correspondance pour remplacer automatiquement les styles d’origine
dans l’élément importé.

Définissez les options du Transporteur de contenu lors de l’importation des éléments.

Supprimez des éléments du Transporteur de contenu après leur importation.
Importez plusieurs fois l’élément actuel. L’élément reste chargé dans le pistolet de placement.
Importez l’élément et passez à l’élément suivant. L’élément est conservé dans le Transporteur de contenu.

Parcourez les éléments figurant dans le Transporteur de contenu.

Activez cette option pour récupérer tous les blocs liés. L’article et tous les blocs sont collectés. Si cette option est
désactivée, l’article est collecté dans un seul bloc.

Cliquez sur  pour charger le transporteur avec des éléments.
Sélection : utilisez cette option pour charger tous les éléments sélectionnés

Pages : utilisez cette option pour charger tous les éléments figurant sur les pages spécifiées
Tous : utilisez cette option pour charger les articles provenant de toutes les pages et de la table de montage

Activez l’option Créer un seul jeu pour regrouper tous les éléments dans un seul et même jeu.

Vous pouvez collecter les éléments de page indépendamment les uns des autres ou sous forme de « jeux ». Dans certains cas, InDesign crée
automatiquement des jeux pour préserver l’intégrité relationnelle des éléments de page.

Voici plusieurs méthodes (manuelles et automatiques) pour collecter les éléments sous forme de jeux :

Sélectionnez les éléments voulus à l’aide du rectangle de sélection.
Utilisez l’option Charger le transporteur, puis sélectionnez la plage de pages, l’intégralité du document ou les éléments
sélectionnés pour regrouper les éléments en question par jeu.
Récupérez un élément avec un contenu associé tel qu’une partie d’un bouton interactif à laquelle sont associés d’autres
éléments et états, de façon à réunir tous les éléments associés dans un même jeu (ce jeu sera toujours déposé dans un même
geste).
Récupérez une zone de texte contenant du texte lié s’étendant sur d’autres objets et cochez la case permettant de rassembler
tous les blocs de texte liés dans le Transporteur de contenu de façon à former un jeu à partir de l’ensemble des zones de texte
liées.

Importer et lier

1. Sélectionnez un élément de page, soit en sélectionnant le bloc, soit en plaçant le curseur d’insertion dans le texte. Vous
pouvez également sélectionner plusieurs éléments à l’aide de la combinaison Maj + clic.

2. Choisissez Edition> Importer et lier. Cela a pour effet de charger le curseur avec les éléments et d’afficher les éléments dans
le Transporteur de contenu.

3. Cliquez sur une page ou tracez un bloc pour y importer l’élément lié.

Spécifier les options de lien

1. Dans le panneau Liens, sélectionnez l’élément lié.

2. Dans le menu du panneau Liens, choisissez Options de lien.



Mettre à jour le lien lors de l’enregistrement du document

Avertir si la mise à jour des liens remplace les modifications locales

Conserver les modifications locales à la mise à jour des liens d’objet

Supprimer les sauts de ligne forcés de l’article

Définir la règle de correspondance de style personnalisée
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Appuyez sur la touche Alt (Windows) ou Option (Mac OS) pour remplacer le bouton Annuler par Réinitialiser. Cliquez sur
le bouton Réinitialiser pour rétablir les options par défaut.

3. Sélectionnez les options qui vous conviennent :

Activez cette option pour mettre à jour le lien au moment de
l’enregistrement du document.

Activez cette option pour afficher un message
d’avertissement si la mise à jour du lien a pour effet de remplacer les modifications locales apportées à l’objet lié.

Sélectionnez les catégories qui vous intéressent
pour conserver les modifications locales lors de la mise à jour des liens.

Activez cette option pour supprimer les sauts de ligne forcés dans l’article.
La suppression des sauts de ligne permet une redistribution fluide du texte dans le cadre lié en cas de changement de
dimension ou de mise en page.

Activez cette option si vous souhaitez faire correspondre les
styles et appliquer automatiquement un autre style au contenu lié. Voir la section Règle de correspondance de style
personnalisée.

Pour définir les options de lien par défaut, fermez tous les documents ouverts, ouvrez le menu du panneau Liens, puis choisissez Options de
lien.

Règle de correspondance de style personnalisée

Catégorie Exemples

Aspect

Attributs de style des objets, tels que Contour, Fond et Effets. Les attributs relatifs au
texte ou au bloc de texte (comme la surimpression, les paramètres autres que ceux
destinés à l’impression, etc.) sont exclus.

Taille et
forme

Hauteur, largeur, transformations, attributs de bloc de texte et autres attributs de taille
de colonne. 

Interactivité Animation, états d’objet, actions de bouton.

Contenu
du bloc

Image, vidéo, contenu importé ou collé dans des blocs, effets et paramètres appliqués
directement à ces objets.

Autres

Attributs ne faisant pas partie des autres catégories, tels que l’habillage de texte pour
les images, les options d’exportation d’objet ; attributs de bloc de texte tels que les
options de ligne de base, les options de dimensionnement automatique, la justification
verticale et ainsi de suite.
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Les styles de texte (paragraphe, caractère, tableau, cellule) ou les groupes de styles peuvent être mappés à différents styles pendant la création
de liens. Au lieu d’appliquer les styles d’origine au parent, ce sont les styles mappés qui sont automatiquement appliqués au contenu lié. La
correspondance de style personnalisée est pratique, par exemple, lorsque vous souhaitez substituer des polices sans empattement aux polices
numériques et à empattement dans les publications à imprimer. Cela permet également d’adapter le style de texte lorsque vous passez d’une mise
en page horizontale à une mise en page verticale.

Pour définir la correspondance de style personnalisée, effectuez l’une des opérations suivantes :

Dans la boîte de dialogue Options de lien (panneau Liens > Options de lien), activez l’option Définir la règle de
correspondance de style personnalisée, puis cliquez sur Paramètres.

Cliquez sur  dans le Transporteur de contenu.

 
Règle de correspondance de style personnalisée

1. Sélectionnez un document source et un type de style. 
2. Cliquez sur Nouvelle correspondance de style.
3. Choisissez les styles source et mappés ou les groupes de styles dans la liste.

Appuyez sur la touche Alt (Windows) ou Option (Mac OS) pour remplacer le bouton Annuler par Réinitialiser. Cliquez sur le bouton Réinitialiser
pour rétablir les options par défaut.

Mettre à jour un élément lié
En cas de modification d’un élément d’origine, le symbole  s’affiche sur l’image et dans le panneau Liens. Pour procédez à la mise à jour,
effectuez l’une des opérations suivantes :

Cliquez sur  dans la partie supérieure gauche de l’image.
Dans le panneau Liens, cliquez deux fois sur le symbole .

Si vous avez apporté des modifications locales à un élément enfant, celles-ci sont remplacées par le contenu de l’élément original. Si vous avez
sélectionné l’option Avertir si la mise à jour des liens remplace les modifications locales, un message d’avertissement s’affiche.

A l’aide du volet Informations sur les liens, déterminez si vous avez apporté des modifications locales à l’article ; le cas échéant, l’article affiche
l’état « Texte modifié ».
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A propos des pages et des planches

Haut de la page

Modification de l’affichage d’une page ou d’une planche
Ciblage ou sélection d’une page ou d’une planche
Ajout de nouvelles pages à un document
Création de libellés colorés pour les vignettes de page

Les pages d’un document sont agencées en planches lorsque vous sélectionnez l’option Pages en vis-à-vis de la boîte de dialogue Fichier >
Format de document. Une planche est une série de pages affichées ensemble, comme les deux pages visibles lorsque vous ouvrez un livre ou un
magazine. La table de montage, zone extérieure à la page dans laquelle sont stockés les objets qui ne sont pas encore positionnés sur une page,
est propre à une planche InDesign. Elle prévoit un espace réservé aux objets à fonds perdus, c’est-à-dire qui dépassent les limites d’une page.

Panneau Pages

A. Icônes de page B. Page avec le gabarit A appliqué C. Planche sélectionnée 

Lorsque vous choisissez De droite à gauche pour l’option Reliure dans la boîte de dialogue Format de document, les nombres sont associés aux
icônes de page de droite à gauche dans le panneau Pages.

Pour aller rapidement à une page dans un long document, choisissez Page > Atteindre la page.

Modification de l’affichage d’une page ou d’une planche

Outre son caractère informatif, le panneau Pages permet de gérer les pages, les planches (groupes de pages affichées ensemble) et les pages
types (pages ou planches régissant le format d’autres pages ou planches). Par défaut, le panneau Pages affiche le contenu de chaque page sous
forme de vignettes.

1. Si le panneau Pages n’est pas visible, choisissez Fenêtre > Pages.

2. Choisissez Options du panneau dans le menu du panneau Pages.

3. Dans la section Icônes, spécifiez les icônes qui doivent apparaître en regard des vignettes de la page dans le
panneau Pages. Ces icônes indiquent si la transparence ou les transitions de page ont été ajoutées à une planche et si cette
dernière est affichée avec rotation.

4. Dans les sections des pages et des gabarits :

Sélectionnez une taille d’icône pour les pages et les gabarits.

Sélectionnez Afficher verticalement pour afficher les planches dans une seule colonne verticale. Désélectionnez cette
option pour permettre l’affichage des planches côte à côte.

Sélectionnez Afficher les vignettes pour afficher le contenu de chaque page ou gabarit sous forme de vignettes (cette
option n’est pas disponible si vous avez sélectionné certaines options relatives à la taille de l’icône).
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Remarque :

Haut de la page
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5. Dans la section Mise en page du panneau, sélectionnez Pages toujours visibles pour afficher la section d’icônes de page au-
dessus de la section d’icônes de gabarit, ou sélectionnez Gabarits toujours visibles pour afficher la section d’icônes de gabarit
au-dessus de la section d’icônes de page.

6. Choisissez une option dans le menu Redimensionner pour contrôler la façon dont les sections s’affichent lorsque vous
redimensionnez le panneau :

Pour redimensionner à la fois les sections des pages et des gabarits du panneau, choisissez Proportionnel.

Pour conserver la taille de la section des pages et redimensionner uniquement la section des gabarits, choisissez Pages
fixes.

Pour conserver la taille de la section des gabarits et redimensionner uniquement la section des pages, choisissez Gabarits
fixes.

Ciblage ou sélection d’une page ou d’une planche

En fonction de la tâche effectuée, vous pouvez soit sélectionner, soit cibler des pages ou des planches. Certaines commandes affectent la page
ou la planche sélectionnée, tandis que d’autres affectent la page ou la planche cible. Par exemple, vous ne pouvez faire glisser des repères de
règle que vers la page ou la planche cible, alors que les commandes liées aux pages telles que Dupliquer une planche ou Supprimer une page
affectent la page ou planche sélectionnée dans le panneau Pages. Le ciblage rend une page ou planche active et se révèle utile lorsque, par
exemple, plusieurs planches sont visibles dans la fenêtre du document et que vous voulez coller un objet sur une planche spécifique.

Dans le panneau Pages :

Pour cibler et sélectionner simultanément une page ou une planche, cliquez deux fois sur son icône ou sur les numéros de
page sous l’icône. Si la page ou planche n’est pas visible dans la fenêtre du document, elle apparaît.

Conseil : vous pouvez également cibler et sélectionner une page ou une planche en cliquant sur une page, sur un objet
de la page ou sur sa table de montage dans la fenêtre de document.

La règle verticale est grisée, sauf au niveau de la page ou planche ciblée.

Pour sélectionner une page, cliquez sur son icône. Cliquez deux fois seulement si vous voulez cibler cette page et
l’afficher.

Pour sélectionner une planche, cliquez sur les numéros de page sous l’icône de la planche.

certaines options de planche, telles que celles du menu du panneau Pages, ne sont disponibles que lorsqu’une
planche entière est sélectionnée.

Ajout de nouvelles pages à un document

Utilisez l’une des méthodes suivantes :

Pour ajouter une page après la page ou la planche active, cliquez sur le bouton Créer une page du panneau Pages ou
choisissez Page > Pages > Ajouter une page. La nouvelle page utilise le même gabarit que la page active.

Pour ajouter plusieurs pages à la fin du document, choisissez Fichier > Format de document. Dans la boîte de dialogue
Format de document, spécifiez le nombre total de pages du document. InDesign ajoute les pages à la suite de la dernière
page ou planche.

Pour ajouter des pages et spécifier le gabarit du document, choisissez la commande Insérer des pages dans le menu du
panneau Pages ou sélectionnez la commande Page > Pages > Insérer des pages. Choisissez l’emplacement auquel les
pages seront ajoutées et sélectionnez un gabarit à appliquer.

Création de libellés colorés pour les vignettes de page

Il est possible d’associer des libellés colorés aux vignettes de page dans le panneau Pages. Vous pouvez, par exemple, utiliser des libellés
colorés pour indiquer l’état des pages (vert pour les planches terminées, jaune pour celles en cours et rouge pour celles qui n’ont pas encore été
travaillées).
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1. Dans le panneau Pages, sélectionnez les pages auxquelles vous voulez appliquer les libellés colorés.

2. Dans le menu du panneau Pages, choisissez Libellé coloré, puis la couleur voulue.

Le libellé coloré s’affiche au-dessous de la vignette dans le panneau Pages.

L’application d’un libellé coloré à un gabarit est répercutée sur l’ensemble des pages faisant appel à ce gabarit. Cependant, lorsque vous appliquez
un libellé coloré à des pages individuelles, le libellé coloré des pages du document est utilisé. Pour utiliser un libellé coloré pour le gabarit,
sélectionnez les pages du document que vous souhaitez modifier, puis choisissez Libellé coloré > Utiliser la couleur du gabarit dans le menu du
panneau Pages.

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
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Remarque :

En haut

Sommaire
Flux de production recommandé
Mises en page liquides

Règles de mises en page liquides
Variantes de mises en page

Créer des variantes de mises en page

Les variantes de mises en page et les règles de mises en page liquides permettent de disposer d’une plus grande souplesse pour concevoir vos
publications en fonction des formats de page, orientations ou proportions qui vous intéressent.

Si votre publication est prévue pour différents formats et différentes tailles, vous pouvez choisir la stratégie qui répond le mieux à votre projet :
manuelle, semi-automatique ou entièrement automatisée. Plus le flux de production est automatisé, moins votre marge de contrôle est grande en
terme de conception. InDesign propose plusieurs améliorations, à ce titre, pour que vous puissiez trouver le meilleur compromis entre coût et
contrôle.

la création automatique de publications basées sur une mise en page liquide n’est pas possible pour le moment, en raison de
l’absence de technologie de visualisation compatible. 

Flux de production recommandé

 
A. Flux de production pour les variantes de mise en page B. Variantes de mise en page et règles de mises en page liquides

ETAPE 1 : choisissez un périphérique cible et la dimension et l’orientation correspondantes. Créez ensuite la mise en page principale pour toutes
les pages.

ETAPE 2 : si vous le souhaitez, ajoutez des règles de mises en page liquides pour adapter le contenu en cas de modification des dimensions ou
des proportions. Les règles de mises en page liquides sont particulièrement pratiques si vous ciblez plusieurs périphériques. En l’absence de
telles règles, vous devez créer manuellement une mise en page unique pour chaque taille et orientation possible. Voir la section Mises en page
liquides.

ETAPE 3 : utilisez la fonction Créer une variante de mise en page pour créer de nouvelles pages dans le même document. En fonction de votre
mise en page principale et des règles de mises en page liquides, il peut être nécessaire d’ajuster manuellement la mise en page. Répétez cette
étape pour chaque nouvelle taille et orientation. Voir la section Variantes de mise en page.



En hautMises en page liquides

 
Mises en page liquides

Les mises en page liquides permettent de réorganiser facilement le contenu d’une publication dès que vous changez de format de page,
d’orientation ou de périphérique. Prévoyez des règles de mises en page liquides pour déterminer la façon dont vous souhaitez adapter les objets
d’une page aux variantes de mises en page ou aux nouvelles tailles, orientations ou proportions choisies.

Vous n’êtes pas obligé d’utiliser les mêmes règles pour chacune des pages. Tout dépend de la mise en page et du but visés. Vous ne pouvez
pas, en revanche, appliquer plusieurs règles au sein d’une même page. La mise en page liquide est un terme général qui couvre un ensemble de
règles spécifiques de mise en page liquide : mise à l’échelle, recentrage, règles basées sur le repère et basées sur l’objet.

Utilisez les règles de mises en page liquides pour adapter le contenu aux formats de sortie,

pour adapter les mises en page chaque fois que vous créez de nouvelles pages dans le même document en utilisant des
variantes de mises en page ou
pour adapter les mises en page en cas de modification des formats de page existants. Cette technique est plus efficace que la
fonction de modification de la mise en page précédemment utilisée.

Pour appliquer une règle de mise en page liquide, sélectionnez l’outil Page  et cliquez sur une page. Choisissez ensuite une règle de mise en
page liquide à partir de la barre de contrôle. Vous pouvez également choisir Mise en page > Mises en page liquides.

Pour prévisualiser les effets de la règle appliquée, sélectionnez l’outil Page et redimensionnez la page en faisant glisser ses poignées. La page
reprend sa taille d’origine dès que vous relâchez le pointeur.

Pour redimensionner la page, appuyez sur la touche Alt (Windows) ou Option (Mac OS) et faites glisser le pointeur. Avec la souris, vous
risquez toutefois de ne pas obtenir tout à fait le résultat voulu. Les widgets Hauteur et Largeur de la barre de contrôle permettent de
redimensionner la page avec une plus grande précision.

 
Règles de mises en page liquides 
A. Outil Page B. Règles de mises en page liquides de la barre de contrôle C. Poignées de redimensionnement de la page D. Coins pour les règles
basées sur l’objet E. Panneau Mise en page liquide 

Règles de mises en page liquides
Vous pouvez appliquer des règles différentes à chacune des pages, mais une seule règle de mise en page liquide peut être appliquée par page.

Regardez cette vidéo pour découvrir comment appliquer les règles Aucune, Mise à l’échelle et Recentrer lors du redimensionnement d’une mise



Mise à l’échelle

Recentrer

Basé sur le repère

en page. Apprenez aussi la signification de « Basé sur le gabarit ». Utilisation des règles de mise en page liquide de base : Mise à l’échelle,
Recentrer et Basé sur le gabarit.

Tout le contenu de la page est traité comme un groupe, et en cas de redimensionnement de la page, tous les éléments sont mis
à l’échelle de façon proportionnelle. Le résultat est similaire à celui des bandes noires horizontales et verticales sur les écrans de télévision HD.

 
Règles de mises en page liquides : Mise à l’échelle

Tout le contenu de la page est automatiquement recentré quelle que soit la largeur. Contrairement à la fonction de mise à l’échelle, le
contenu conserve sa taille d’origine. Vous pouvez obtenir un résultat similaire aux zones de sécurité des productions vidéo en combinant la règle
Recentrer à une mise en page soignée et bien planifiée.

 
Règles de mises en page liquides : Recentrer

Les repères définissent une ligne droite sur toute la page à l’endroit où le contenu peut s’adapter.
Il est possible d’ajouter des espaces blancs.
Les blocs de texte sont redimensionnés et le texte est redistribué (mais n’est pas mis à l’échelle).
Les images importées sont redimensionnées et les limites de recadrage des blocs contenant les images sont ajustées en
conséquence.

Pour ajouter un repère de mise en page liquide, sélectionnez l’outil Page, puis faites glisser les repères à l’extérieur de la règle.
Les règles basées sur des repères sont similaires aux mises à l’échelle en 3 tranches et en 9 tranches dans Illustrator, Fireworks et Flash.
Regardez cette vidéo sur Application des règles de mise en page liquide basée sur le repère.

Pour transformer un repère de règle en repère de mise en page liquide, sélectionnez l’outil Page et cliquez sur l’icône Convertir en repère de
mise en page liquide. Le repère de mise en page liquide est matérialisé par une ligne en pointillés alors que le repère de la règle se présente
sous la forme d’une ligne continue.

http://tv.adobe.com/watch/learn-indesign-cs6/using-basic-liquid-layout-rules-scale-recenter-and-based-on-master/
http://tv.adobe.com/watch/learn-indesign-cs6/using-basic-liquid-layout-rules-scale-recenter-and-based-on-master/
http://tv.adobe.com/watch/learn-indesign-cs6/applying-guide-based-liquid-layout-rules/


Basé sur l’objet

En haut

 
Règles de mises en page liquides : basé sur le repère

Vous pouvez définir le comportement de la mise en page liquide pour la taille et l’emplacement par rapport au bord de la page
pour chaque objet (en mode absolu ou relatif).

Chaque côté du cadre de délimitation de l’objet ou du bloc peut être fixe ou relatif au bord correspondant de la page. Par
exemple, le côté gauche du cadre ou du bloc peut être solidaire uniquement avec le bord gauche de la page.
La hauteur et la largeur peuvent être fixes ou redimensionnables par rapport à la page. 

Regardez cette vidéo sur Application des règles de mise en page liquide basée sur l’objet.

 
Règles de mises en page liquides : Basé sur l’objet

Variantes de mise en page
Utilisez les variantes de mise en page si vous souhaitez prévoir plusieurs formats de page pour l’impression ou la publication numérique d’un
même document. Cela est très pratique pour créer différentes tailles d’une même affiche ou pour concevoir les mises en page horizontale et
verticale destinées aux périphériques mobiles (iPad d’Apple ou tablettes Android, par exemple). 

 
Variantes de mise en page et panneau Pages

Lorsque vous les utilisez en association avec les mises en page liquides, vous pouvez réduire considérablement la quantité de travail manuel
nécessaire à la redisposition du contenu pour chaque nouveau format ou orientation de page.

Pour avoir un aperçu, regardez la vidéo sur les variantes de mises en page par Lynda.com.

Créer des variantes de mises en page

http://tv.adobe.com/watch/learn-indesign-cs6/applying-object-based-liquid-layout-rules/
http://www.adobe.com/go/CHLvid60107_id_fr
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Nom

Depuis les pages sources

Format de page

Largeur et Hauteur

Orientation

Règle de page liquide

Lier les articles

Copier les styles de texte dans le nouveau groupe de styles

Redistribution intelligente du texte

Pour créer une variante de mise en page, utilisez l’une des méthodes suivantes :

Choisissez Mise en page > Créer une variante de mise en page.
Choisissez Créer une variante de mise en page dans le menu du panneau Pages.

 
Créer des variantes de mises en page

Dans la boîte de dialogue Créer des variantes de mises en page, spécifiez les options suivantes :

Entrez le nom de la variante de mise en page.

Sélectionnez la mise en page source où se trouve votre contenu.

Sélectionnez une taille de page ou saisissez une taille personnalisée pour la variante de mise en page.

Ces champs indiquent la taille de la variante de mise en page. Vous pouvez entrer vos propres valeurs, mais dans ce cas, le
format de page prend la valeur Personnalisé.

Choisissez une orientation pour la variante de mise en page. Si vous basculez entre Portrait et Paysage, la hauteur et la largeur sont
mises à jour en conséquence.

Choisissez la règle de mise en page liquide que vous avez l’intention d’appliquer à la variante de mise en page.
Sélectionnez l’option Conserver les éléments existants afin d’hériter les règles de mises en page liquides appliquées aux pages sources.
Sélectionnez une autre règle si vous comptez appliquer de nouvelles règles de mises en page liquides.

Activez cette option pour importer les objets et les lier aux objets originaux de la mise en page source. Lorsque vous mettez à
jour l’objet d’origine, il est plus facile de gérer les mises à jour des objets liés. Voir la page Contenu lié.

Activez cette option pour copier tous les styles de texte et les importer dans un
nouveau groupe. Cette option est utile si vous avez besoin de faire varier les styles de texte d’une mise en page à une autre.

Activez cette option pour supprimer les sauts de ligne forcés et tout autre remplacement de style au texte.  

http://creativecommons.org/licenses/by-nc-sa/3.0/deed.fr
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr


Alignement et répartition des objets

Haut de la page

Haut de la page

Présentation du panneau Alignement
Alignement ou distribution d’objets
Alignement des objets à l’aide de l’outil Espace
Répartition des objets à l’aide de Live Distribute

Présentation du panneau Alignement
Le panneau Alignement (Fenêtre > Objet et mise en page > Alignement) vous permet d’aligner ou de distribuer des objets horizontalement ou
verticalement le long de la sélection, des marges, de la page ou de la planche. Prenez en compte les points suivants lorsque vous utilisez le
panneau Alignement :

Le panneau Alignement n’a aucun effet sur les objets auxquels vous avez appliqué la commande Verrouiller la position et ne
modifie pas l’alignement des paragraphes de texte dans leurs blocs respectifs.

Les options d’alignement d’objets n’affectent pas l’alignement du texte (voir Alignement ou justification du texte).

Vous pouvez utiliser la boîte de dialogue Raccourcis clavier (Edition > Raccourcis clavier) pour créer des raccourcis
d’alignement et de distribution personnalisés (dans Zone du produit, sélectionnez Edition d’objets).

Panneau Alignement
A.  Boutons d’alignement vertical B.  Boutons de distribution verticale C.  Utiliser l’espacement D.  Boutons d’alignement horizontal E.
Boutons de distribution horizontale F.  Options de positionnement de l’alignement

Alignement ou distribution d’objets
Le panneau Alignement vous permet d’aligner ou d’espacer des objets sélectionnés horizontalement ou verticalement par rapport à la sélection,
aux marges, à la page ou à la planche.

Objets distribués horizontalement par rapport à la sélection (en haut) et aux marges (en bas)

1. Sélectionnez les objets à aligner ou distribuer.



2. Choisissez Fenêtre > Objet et mise en page > Alignement pour afficher le panneau Alignement.
Pour afficher ou masquer des options supplémentaires, choisissez Afficher les options ou Masquer les options dans le
menu du panneau.

3. Dans le menu situé au bas du panneau, indiquez si vous souhaitez aligner ou distribuer des objets par rapport à la sélection,
aux marges, à la page ou à la planche.

4. Utilisez l’une des méthodes suivantes :

Pour aligner des objets, cliquez sur le bouton correspondant au type d’alignement souhaité.

Pour distribuer des objets, cliquez sur le bouton correspondant au type de distribution souhaité. Par exemple, si vous
cliquez sur le bouton Répartir les bords gauches lorsque l’option Aligner sur la sélection est activée, InDesign applique le
même espacement entre tous les bords de gauche de tous les objets sélectionnés.

Utilisation de l’option Répartir les centres dans le sens horizontal pour un espacement régulier
A.  Crée un espacement régulier entre les centres de chaque objet B.  Conserve l’épaisseur générale d’avant
transformation

Pour définir l’espacement entre les objets, centrez par rapport au centre ou faites-le correspondre au côté, sélectionnez
Utiliser l’espacement dans Répartition des objets, puis entrez la valeur d’espacement que vous voulez appliquer. Cliquez
sur le bouton correspondant pour distribuer les objets sélectionnés le long de l’axe horizontal ou vertical.

Utilisation de l’option Répartir les centres dans le sens horizontal et ajout d’une valeur pour l’utilisation de l’espacement
A.  Espace les objets à égale distance de leur centre (valeur spécifiée) B.  Change l’épaisseur générale des objets en
tant que tout

Pour définir l’espacement entre les objets (côté opposé à côté opposé), dans Répartition de l’espacement, sélectionnez
Utiliser l’espacement et entrez la valeur d’espacement que vous voulez entre ces objets (si Distribuer des espaces n’est
pas visible, choisissez Afficher les options dans le menu du panneau Alignement). Cliquez sur le bouton Répartition de
l’espacement pour répartir les objets le long de l’axe horizontal ou vertical.



Haut de la page

Haut de la page

Utilisation de l’option Répartir les centres dans le sens horizontal et ajout d’une valeur pour l’utilisation de l’espacement
A.  Crée un espacement défini par une valeur précise entre chaque objet B.  Change l’épaisseur générale des objets en
tant que tout

Lorsque vous choisissez d’espacer les objets par distribution verticale, les objets sélectionnés sont espacés de haut en bas à partir du premier
objet. Lorsque vous choisissez d’espacer les objets par distribution horizontale, les objets sélectionnés sont espacés de gauche à droite à partir du
premier objet.

Vous pouvez également faire appel à la fonction Espacement intelligent pour aligner ou espacer les objets pendant que vous les déplacez.
Supposons, par exemple, que l’espace entre deux objets disposés verticalement soit de 12 points et que vous vouliez placer un troisième objet
sous le deuxième. Lorsque la distance entre ces deux objets est quasiment égale à 12 points, des repères temporaires apparaissent pour vous
aider à placer le nouvel objet au bon endroit.

Alignement des objets à l’aide de l’outil Espace
L’outil Espace permet de régler rapidement l’espacement de plusieurs objets. Vous pouvez également l’utiliser pour redimensionner simultanément
plusieurs objets dont les contours sont alignés sans changer l’espace qui les sépare. En intervenant directement sur l’espace entre les objets,
vous disposez là d’un moyen simple et rapide d’ajuster votre mise en page.

L’outil Espace ignore les éléments de gabarit et les objets verrouillés.

Pour consulter un didacticiel vidéo sur l’utilisation de l’outil Espace, rendez-vous à l’adresse www.adobe.com/go/lrvid5155_id_en.

1. Sélectionnez l’outil Espace .

2. Placez le pointeur entre deux objets, puis utilisez l’une des méthodes suivantes :

Faites glisser la souris pour déplacer l’espace et redimensionner tous les objets alignés le long de cet espace.

Faites glisser la souris tout en maintenant la touche Maj enfoncée pour déplacer l’espace entre les deux objets les plus
proches uniquement.

Faites glisser la souris tout en maintenant la touche Ctrl (Windows) ou Commande (Mac OS) enfoncée pour augmenter ou
réduire l’espace au lieu de le déplacer. Appuyez aussi sur la touche Maj pour augmenter ou réduire l’espace entre les
deux objets les plus proches uniquement.

Faites glisser la souris tout en maintenant la touche Alt (Windows) ou Option (Mac OS) enfoncée pour déplacer l’espace
et les objets dans la même direction. Appuyez aussi sur la touche Maj pour déplacer uniquement les deux objets les plus
proches.

Faites glisser la souris tout en maintenant les touches Ctrl+Alt (Windows) ou Commande+Option (Mac OS) enfoncées
pour augmenter ou réduire l’espace et déplacer les objets. Appuyez aussi sur la touche Maj pour augmenter ou réduire
l’espace et déplacer uniquement les deux objets les plus proches.

Pour afficher des conseils relatifs à l’utilisation de l’outil Espace, sélectionnez cet outil, puis ouvrez le panneau Info-bulles des outils (Fenêtre >
Utilitaires > Info-bulles des outils).

Répartition des objets à l’aide de Live Distribute
Lorsque vous transformez plusieurs objets sélectionnés, vous pouvez augmenter ou réduire proportionnellement l’espace qui les sépare au lieu de
redimensionner les objets eux-mêmes. Par exemple, vous pouvez modifier l’espacement de cinq rectangles alignés sans utiliser aucune
commande de répartition.

Pour consulter une vidéo sur l’utilisation de Live Distribute, reportez-vous à l’adresse http://tv.adobe.com/go/4949/.

http://www.adobe.com/go/lrvid5155_id_en
http://tv.adobe.com/go/4949/


 

1. Sélectionnez les objets.

2. Commencez à faire glisser une poignée de sélection tout en maintenant la barre d’espace enfoncée. Continuez à faire glisser
la poignée pour modifier l’espacement des objets.

Voir aussi
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Création de nouveaux documents (chinois, japonais et coréen
uniquement)

Haut de la page

Création de nouveaux documents
Création d’un nouveau document
Création d’un nouveau document avec une grille de mise en page
Création d’un nouveau document avec les marges et les colonnes
Options de nouveau document
Présentation de la fenêtre de document
Création de formats de page personnalisés
Définition de paramètres prédéfinis de document
Création d’un document à partir d’un paramètre prédéfini

La conception d’une page débute par des opérations de base : création d’un nouveau document, configuration des pages et positionnement des
marges et des colonnes ou modification des paramètres de grille.

Lors de la création d’un nouveau document, vous avez le choix entre deux flux de production : Grille de mise en page ou Marges et colonnes.

Remarque : quel que soit le flux que vous sélectionnez, le type de fichier du document sera strictement identique. Vous pouvez afficher une grille
de mise en page créée dans le document en utilisant les marges et les colonnes ou masquer la grille de mise en page d’un document créé à l’aide
de l’option Grille de mise en page en changeant simplement de vue.

Le flux de production basé sur la composition faisant appel à la grille de mise en page est seulement disponible dans les versions en langues
asiatiques. Lorsque vous sélectionnez Grille de mise en page, une grille de carrés s’affiche dans le document. Vous pouvez définir le nombre de
carrés (nombre de lignes ou de caractères) dans les paramètres de taille de la page. Ces paramètres déterminent également les marges de la
page. La grille de mise en page permet de positionner un objet avec précision sur une page grâce aux cellules de la grille.

L’option Marges et colonnes est identique dans le cadre des flux de production en langues occidentales. Les flux de production en langues
occidentales sont configurés à partir de la boîte de dialogue Marges et colonnes et les objets sont placés sur les pages sans grilles de mise en
page. Vous pouvez définir le sens de l’écriture dans le sens horizontal ou vertical en vous servant des flux de production Marges et colonnes ou
Grille de mise en page.

Document montrant une grille de mise en page (à gauche). Document montrant les marges et les colonnes (à droite).

Création d’un nouveau document

1. Choisissez la commande Fichier > Nouveau > Document.

La boîte de dialogue Nouveau document regroupe les options des boîtes de dialogue Format de document et Marges et
colonnes. Vous pouvez ainsi à tout moment définir, à un seul et même endroit, les dimensions de la page, ses marges et ses
colonnes. Vous pouvez modifier ces paramètres à tout moment.

2. Définissez les options de format de document. (Voir la section Options de nouveau document.)

Pour spécifier les dimensions des zones de fond perdu et de ligne-bloc, cliquez sur Plus d’options. Ces zones s’étendent au-
delà des bords du format de page défini. Pour que ce débord soit régulier sur tous les côtés, cliquez sur l’icône Uniformiser
tous les paramètres .

http://idiom-q-win-1/Output/Build/cq.pdf.book/sdl81123/XML/fr-fr/Products/InDesign/CS5/Using/pdf/cq.pdf.book/html/create-new-documents.html#new_document_options
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Paramètre prédéfini de document

Mode

Nombre de pages

3. Cliquez sur OK pour ouvrir un nouveau document comportant les paramètres spécifiés.

pour définir des paramètres de mise en page par défaut pour tous les nouveaux documents, choisissez Fichier > Format de
document ou Page > Marges et colonnes, puis définissez les options lorsqu’aucun document n’est ouvert.

Création d’un nouveau document avec une grille de mise en page

1. Choisissez Fichier > Nouveau > Document.

2. Changez le nombre de pages, le format de la page et les autres options. Pour spécifier les dimensions des zones de fond
perdu et de ligne-bloc, cliquez sur Plus d’options.

3. Cliquez sur la boîte de dialogue Grille de mise en page, puis spécifiez les paramètres de la grille de mise en page. (Voir
Options de grilles de mise en page.)

4. Cliquez sur OK pour ouvrir un nouveau document comportant les paramètres spécifiés.

La grille de mise en page est destinée uniquement à la mise en forme. Pour ajouter du texte dans votre document, ajoutez des grilles de bloc ou
des blocs de texte.

Création d’un nouveau document avec les marges et les colonnes

Pour créer un document avec le flux de production de style occidental, servez-vous de la commande Marges et colonnes. Si les paramètres de
mise en page généraux tels que les marges et le nombre de colonnes dans un document sont déjà connus, la méthode la plus simple consiste à
utiliser la boîte de dialogue Marges et colonnes.

1. Choisissez Fichier > Nouveau > Document.

2. Définissez les options dans la boîte de dialogue Nouveau document. Ces options sont identiques à celles apparaissant lors de
la création d’un document à l’aide d’une grille de mise en page.

3. Cliquez sur Marges et colonnes et sélectionnez les options dans la nouvelle boîte de dialogue Marges et colonnes. Les
options sont identiques à celles de la boîte de dialogue Marges et colonnes. (Voir Modification du format, des marges et des
colonnes de document).

4. Cliquez sur le bouton OK.

Même si un document a été créé à l’aide de la commande Marges et colonnes, vous pouvez afficher sa grille de mise en page en choisissant la
commande Affichage > Grilles et repères > Afficher grille de mise en page, et vous pouvez modifier les paramètres de la grille de mise en page en
choisissant Page > Grille de mise en page.

Pour définir des paramètres par défaut pour tous les nouveaux documents, choisissez Fichier > Format de document, Page > Marges et
colonnes ou Page > Paramètres de la grille de mise en page, puis définissez les options lorsqu’aucun document n’est ouvert.

Options de nouveau document

Choisissez un paramètre prédéfini précédemment enregistré.

Si vous créez un document à exporter au format PDF ou SWF en vue de son utilisation sur le Web, la sélection de l’option Web entraîne la
modification de plusieurs options de la boîte de dialogue, notamment la désactivation de l’option Pages en vis-à-vis, le passage de l’orientation de
portrait à paysage, ainsi que l’utilisation d’un format de page basé sur la résolution du moniteur. Vous pouvez modifier tous ces paramètres mais
ne pouvez pas modifier le paramètre Mode une fois le document créé.
CS6 : le mode Publication numérique a été ajouté pour les publications destinées à Digital Publishing Suite.

Indiquez le nombre de pages à créer dans le nouveau document.
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Pages en vis-à-vis

Bloc de texte type

Bloc de texte principal

Format de page

Orientation

Fond perdu

Ligne-bloc

Remarque :
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Indiquez le numéro de page de la première page du document. Si vous indiquez un numéro pair (2, par exemple) et que vous
sélectionnez l’option Pages en vis-à-vis, la première planche du document comporte deux pages. Voir Pour créer un document avec une planche
de deux pages.

Sélectionnez cette option pour présenter en regard les pages de gauche et de droite d’une planche de deux pages, comme
pour les livres et les magazines. Désélectionnez-la pour disposer toutes les pages indépendamment les unes des autres, comme si vous
imprimiez des feuillets ou des affiches ou que vous vouliez que les objets débordent dans la zone de reliure.
Après avoir créé un document, vous pouvez utiliser le panneau Pages pour créer des planches contenant plus de deux pages ou pour forcer les
deux premières pages à s’ouvrir comme une planche. (Voir Contrôle de la pagination des planches.)

CS5.5 et versions antérieures : sélectionnez cette option pour créer un bloc de texte de la taille de la zone délimitée par les
repères de marge, selon les paramètres de colonnes spécifiés. Le bloc de texte type s’ajoute à la page A-Gabarit. (Voir Utilisation des blocs de
texte sur les gabarits.)
L’option Bloc de texte type est disponible uniquement lorsque vous choisissez Fichier > Nouveau > Document.

CS6 uniquement : sélectionnez cette option pour ajouter un bloc de texte principal sur le gabarit. Lorsque vous appliquez
un nouveau gabarit, l’article contenu dans le bloc de texte principal se poursuit automatiquement dans le bloc de texte principal du nouveau
gabarit.

Choisissez un format de page dans le menu ou entrez une largeur et une hauteur. Le format de page représente les dimensions
définitives que vous obtiendrez après rognage des fonds perdus et autres repères situés en dehors de la page.

Cliquez sur Portrait  (sens de la hauteur) ou Paysage  (sens de la largeur). Ces icônes interagissent directement avec les
dimensions définies pour le format de page. Si la hauteur représente la valeur la plus élevée, l’icône Portrait est activée. Si la largeur représente la
valeur la plus élevée, l’icône Paysage est activée. Il suffit de cliquer sur l’icône désactivée pour permuter la hauteur et la largeur.
Conseil : pour spécifier les dimensions des zones de fond perdu et de ligne-bloc, cliquez sur Plus d’options dans la boîte de dialogue Nouveau
document. Pour que les zones s’étendent uniformément sur tous les côtés, cliquez sur l’icône Uniformiser tous les paramètres .

La zone de fond perdu permet d’imprimer des objets disposés au bord externe du format de page défini. Si un objet est placé contre
le bord d’une page aux dimensions requises, il est possible que du blanc apparaisse au bord de la zone d’impression en raison d’un léger
décalage d’alignement au cours de l’impression ou du rognage. Pour cette raison, il est recommandé d’éloigner légèrement l’objet du bord de la
page aux dimensions requises et de rogner une fois l’impression effectuée. La zone de fond perdu est indiquée par une ligne rouge sur le
document. Vous pouvez définir les paramètres de la zone de fond perdu en cliquant sur le menu Fond perdu dans la boîte de dialogue Imprimer.

Cette zone est éliminée lorsque le document est rogné à sa taille finale. La zone de ligne-bloc contient les informations sur
l’impression et la gamme de couleurs personnalisées et affiche d’autres instructions et descriptions relatives à d’autres informations dans le
document. Les objets (y compris les blocs de texte) situés dans la zone de ligne-bloc sont imprimés mais disparaissent une fois le document
rogné à sa taille finale.
Les objets situés en dehors de la zone de fond perdu ou de ligne-bloc (selon celle qui s’étend le plus loin) ne seront pas imprimés.

vous pouvez également cliquer sur l’icône Enregistrer le paramètre prédéfini de document pour enregistrer les paramètres du
document afin de les réutiliser ultérieurement.

Présentation de la fenêtre de document

Chaque page ou planche du document se caractérise par ses propres table de montage et repères, visibles en mode Affichage standard. Pour
basculer vers l’affichage normal, choisissez Affichage > Mode écran > Normal. La table de montage est remplacée par un arrière-plan grisé
lorsque le document est affiché au moyen d’un des modes d’aperçu. (Voir Aperçu des documents.) Il est possible de modifier la couleur du fond et
des repères du mode Aperçu dans les préférences Repères et table de montage.
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Document et repères en mode Affichage standard

A. Planche (lignes noires) B. Page (lignes noires) C. Repères de marge (lignes magenta) D. Repères de colonne (lignes violettes) E. Zone de fond
perdu (lignes rouges) F. Ligne-bloc (lignes bleues) 

Notes de fenêtre de document :

Les autres filets de couleur caractérisent les repères de règle, lesquels s’affichent dans la couleur du calque actif. (Voir
Calques.)

Les repères de colonne s’affichent devant les repères de marge. Par conséquent, lorsqu’un repère de colonne se superpose à
un repère de marge, il masque ce dernier.

Création de formats de page personnalisés

Vous pouvez définir des formats de page personnalisés qui seront inclus dans le menu Format de page de la boîte de dialogue
Nouveau document.

1. Choisissez la commande Fichier > Nouveau > Document.

2. Choisissez Format de page personnalisé dans le menu Format de page.

3. Saisissez le nom du format de page, définissez ses paramètres et cliquez sur Ajouter.

Le fichier New Doc Sizes.txt, utilisé pour définir des formats de page personnalisés dans les versions antérieures d’InDesign, n’est pas disponible
dans InDesign CS5 ni dans les versions ultérieures.

Définition de paramètres prédéfinis de document

Vous pouvez enregistrer des paramètres de document pour le format de page, les colonnes, les marges et les zones de fond perdu et de ligne-
bloc dans un fichier de paramètres prédéfinis pour gagner du temps et assurer une cohérence dans la création de documents similaires.

1. Sélectionnez Fichier > Paramètres prédéfinis de document > Définir.

2. Cliquez sur Nouveau dans la boîte de dialogue qui s’affiche.

3. Attribuez un nom aux paramètres prédéfinis et sélectionnez des options élémentaires de mise en page dans la boîte de
dialogue Nouveau paramètre prédéfini de document. (Voir la section Options de nouveau document pour obtenir une
description de chaque option.)

4. Cliquez deux fois sur OK.

Vous pouvez enregistrer un paramètre prédéfini de document dans un fichier séparé et le distribuer aux autres utilisateurs. Pour enregistrer et
charger des fichiers de paramètres prédéfinis de document, utilisez les boutons Enregistrer et Charger dans la boîte de dialogue Paramètres
prédéfinis du document.

Création d’un document à partir d’un paramètre prédéfini
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1. Utilisez l’une des méthodes suivantes :

Sélectionnez la commande Fichier > Paramètre prédéfini de document > [nom du paramètre prédéfini] (maintenez la
touche Maj enfoncée pour créer un document basé sur ce paramètre prédéfini sans ouvrir la boîte de dialogue Nouveau
document).

Choisissez Fichier > Nouveau > Document, puis un paramètre prédéfini dans le menu Paramètre prédéfini de document
de la boîte de dialogue Nouveau document.

La boîte de dialogue Nouveau document affiche les options de mise en page du paramètre prédéfini.

2. Si nécessaire, modifiez les options et cliquez sur OK.

Pour ignorer la boîte de dialogue Nouveau document, appuyez sur la touche Maj tout en sélectionnant un paramètre prédéfini dans le menu
Paramètre prédéfini de document.

Flux de production recommandé pour les documents InDesign
Utilisation de modèles de document
Ajout de documents à un livre
Modification du format, des marges et des colonnes de document
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Formatting grids
Named Grids panel overview
Create named grid formats
Apply a named grid to a frame
Edit named grids
Delete named grids
Import grid formats from other documents

Named Grids panel overview

Use the Named Grids panel (Window > Type & Tables > Named Grids) to save frame grid settings in named grid
format, and apply those settings to other frame grids. You can apply or change frame grid formats efficiently, and
easily keep the appearance of a document consistent, using grid formats.

Named Grids panel

A. Grid name B. New Grid Format button C. Delete icon 

In the Named Grids panel, the Layout Grid format is shown by default. The layout grid setting for the currently
selected page is reflected in this grid format. When more than one layout grid is set for a single document, the
settings shown in Layout Grid in the Named Grids panel vary depending on the selected page layout grid contents.

When a frame grid with grid formatting is selected, the current grid format name is highlighted in the Named Grids
panel.

Create named grid formats

Like styles, named grid formats let you save a collection of frame grid settings and apply those settings to other
frame grids.

1. To define a new grid format in accordance with the existing frame grid format, select the frame grid with the
selection tool.

2. Choose Window > Type & Tables > Named Grids.
3. Choose New Named Grid from the Named Grids panel menu.
4. Specify options in the Edit Grid Format dialog box, and click OK.



If the named grid format you want to use is already saved in another InDesign document, you can import that grid
format into the current document.

When a new frame grid format is created based on an existing frame grid, changes to format attribute options also
are applied to the selected frame grid. If you do not want to modify the selected frame grid format, deselect the
frame grid before showing the Edit Grid Format dialog box.

Named Grid options

Named Grid options appear when you choose Window > Type & Tables > Named Grids.

Grid Name

Enter the name of the grid format.

Font

Select the font family and font style, and set the default font for the text to be placed in the grid.

Size

Specify individual grid sizes.

Vertical and Horizontal

Specify the grid scale for full-width Asian characters in %.

Char Aki

Specify the spacing between grid cells in the frame grid. This value will be the grid cell size.

Line Aki

Enter a value to specify the grid line spacing. The value used here is the distance between the bottom (or left)
edge of the character embox for the first line to the top (or right) edge of the character embox for the next line.

Line Align

Select an option to specify line alignment for the frame grid. For example, if Align Left/Top is selected, the
beginning of each line for a vertical type frame grid will be aligned with the top edge of the frame grid. (See Align
or justify text.)

Grid Align

Select an option to specify whether to align the text to the embox, ICF box, or roman baseline. See Align
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paragraphs to a baseline grid.

Char Align

Select an option to specify the method of aligning small characters to larger characters in a line. (See Align text of
different sizes.)

Apply a named grid to a frame

You can apply a custom named grid or the Layout Grid to a frame grid. If you apply the Layout Grid, the same
settings defined in the Layout Grid dialog box are used in the frame grid.

1. Select the frame grid using the Selection tool. You can also use the Type tool to click on the frame and
position the text insertion point or select text.

2. Click on the name of the format to be applied in the Named Grids panel or Control panel.

Applying a grid format causes grid format attributes to be set for text in the frame grid, but grid format
attributes will not be set for text which has been given Character or Paragraph styles, or text which has had
settings individually modified from the Character panel or Paragraph panel.

Note:

Priority is given to character style, paragraph style and grid format in that order in the frame grid.
Accordingly, when grid formatting is applied to text that has been given paragraph or character styles, a '+'
mark is shown next to each applied style name. (See Text formatting precedence.)

Before and after applying a grid format to the frame grid

3. To apply grid format attributes to the entire story, select the frame grid using the Selection tool and select
Edit > Apply Grid Format.

You can also add named grids to object styles. If you add a named grid to the default object style for grid frames,
all grid frames you create appear formatted according to the named grid you specify. (See About object styles.)

Edit named grids

You can change the grid format definitions at any time. When you change the definition of a grid format, all of the
frame grids formatted with that style change to conform with the newly defined style.

1. Using the Named Grids panel, select the grid format to be edited, and choose Named Grid Options from the
panel menu, or double-click the grid format you want to edit in the Named Grids panel.

2. Change the settings in the Modify Named Grid dialog box. (See Create named grid formats.)
3. Click OK.
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This modifies the grid format given to the currently selected frame grid. To modify settings for frame grids which
are not currently selected, perform the above operation without selecting any objects in the document, or double-
click the grid format name in the Named Grids panel while holding down Shift+Ctrl+Alt (Windows) or
Shift+Command+Option (Mac OS).

Delete named grids

The formatting applied to text in a frame is unchanged even if a grid format is deleted, but the link to the grid
format is removed.

1. Select the name of the grid format you want to delete in the Named Grids panel.
2. Choose Delete Named Grids from the panel menu, or click the Delete icon  at the bottom of the Named

Grids panel.

When you delete grid formats, the frame grid to which the grid format was applied doesn’t appear to change, but
the format is no longer connected with the grid format.

Import grid formats from other documents
1. Choose Load All Named Grids from the Named Grids panel menu.
2. Double-click the InDesign document containing the grid formats you want to import.

When you import a grid format from another document that has the same name as a grid format in the current
document, the existing grid format in the import destination will be overwritten, and when this grid format is
applied the grid format for all the frame grids will be changed.

Adobe also recommends

Customize layout and frame grids
Override character and paragraph styles
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Haut de la page

Création de blocs de texte
Déplacement et redimensionnement de blocs de texte
Utilisation des blocs de texte sur les gabarits
Modification des propriétés d’un bloc de texte
Affichage du nombre de mots et de caractères
Utilisation d’autres langues

Création de blocs de texte

Dans InDesign, le texte est placé dans des espaces appelés blocs de texte, semblables aux zones de texte
de QuarkXPress et aux blocs d’Adobe PageMaker.

Il existe deux types de blocs de texte : grilles de bloc et blocs de texte brut. Les grilles de bloc représentent
les blocs de texte spécifiques à la composition en langue asiatique dans laquelle les EmBox et l’espacement
des caractères s’affichent sous forme de grille. Les blocs de texte vides dans lesquels aucune grille n’est
affichée sont des blocs de texte brut.

Les blocs de texte, comme les blocs graphiques, peuvent être déplacés, redimensionnés et modifiés. L’outil
utilisé pour sélectionner le bloc de texte dépend du type de modification à apporter :

L’outil Texte  vous permet de saisir ou modifier du texte au sein d’un bloc.

L’outil Sélection  vous permet de réaliser des tâches générales de mise en page, telles
que le déplacement ou le redimensionnement de blocs.

L’outil Sélection directe  vous permet de modifier la forme d’un bloc.

L’outil Grille horizontale  ou l’outil Grille verticale vous permet de créer une grille de
bloc. Voir Création de grilles de bloc.

L’outil Texte  vous permet de créer un bloc de texte brut pour le texte horizontal et
l’outil Texte vertical  vous permet de créer un bloc de texte brut pour le texte vertical.
Utilisez les mêmes outils pour modifier le texte existant dans un bloc.

Les blocs de texte peuvent également être rattachés ensemble, de telle sorte qu’un texte peut commencer
dans un bloc et se terminer dans un autre. On dit de ces blocs qu’ils sont liés. Un texte qui s’étale sur
plusieurs blocs liés est appelé un article. Lorsque vous importez un fichier de traitement de texte, il apparaît
dans le document sous forme d’un seul article, quel que soit le nombre de blocs qu’il occupe.

Les blocs de texte peuvent contenir plusieurs colonnes. Ils peuvent être basés sur des colonnes de pages
sans pour autant en dépendre. Ainsi, un bloc de texte de deux colonnes peut figurer sur une page de quatre
colonnes. Les blocs de texte peuvent également être importés dans des gabarits et recevoir du texte sur des
pages du document.

Si vous utilisez souvent le même type de bloc de texte, créez un style incluant la mise en forme du bloc
de texte (couleurs des contours et du fond, options du bloc de texte et effets d’habillage et de
transparence, par exemple).
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Lorsque vous importez ou collez du texte, il n’est pas nécessaire de créer un bloc de texte. InDesign ajoute
automatiquement des blocs en fonction des paramètres de colonne de la page.

Lorsque le texte est collé, un bloc de texte brut est créé automatiquement. Vous pouvez également créer un
bloc de texte brut vide manuellement et saisir du texte.

Utilisez l’une des méthodes suivantes :

Sélectionnez l’outil Texte , puis faites glisser le pointeur pour définir la largeur et la
hauteur du nouveau bloc de texte. Maintenez la touche Maj enfoncée et faites glisser
le curseur pour créer un bloc de texte carré. Lorsque vous relâchez le bouton de la
souris, un point d’insertion apparaît dans le bloc.

Création d’un bloc de texte par glissement du curseur

Cliquez sur le port d’entrée ou de sortie d’un autre bloc de texte à l’aide de
l’outil Sélection, puis cliquez ou faites glisser le pointeur pour créer un autre bloc.

Utilisez la commande Importer pour insérer un fichier texte.

A l’aide de l’outil Texte , cliquez dans un bloc vide. Si l’option Conversion des
blocs en blocs de texte avec l’outil Texte est activée dans la boîte de dialogue des
préférences de texte, le bloc vide est converti en bloc de texte.

Déplacement et redimensionnement de blocs de texte

L’outil Sélection vous permet de déplacer ou de redimensionner des blocs de texte.

Si vous souhaitez déplacer ou redimensionner un bloc de texte tout en laissant l’outil Texte  activé,
maintenez la touche Ctrl (Windows) ou Commande (Mac OS) enfoncée, puis faites glisser le bloc.

Déplacement d’un bloc de texte

A l’aide de l’outil Sélection, faites glisser le bloc.
Sélectionnez l’outil Texte, maintenez la touche Ctrl (Windows) ou Commande (Mac OS)
enfoncée et faites glisser le bloc. L’outil Texte est toujours sélectionné lorsque vous
relâchez la touche.

Redimensionnement d’un bloc de texte

Utilisez l’une des méthodes suivantes :

Pour redimensionner un bloc à l’aide de l’outil Texte , maintenez la touche Ctrl
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(Windows) ou Commande (Mac OS) enfoncée et faites glisser l’une des poignées du
bloc. Si vous souhaitez recomposer le texte tout en redimensionnant le bloc,
maintenez le bouton de la souris enfoncé pendant une seconde avant de faire glisser
le pointeur.

Remarque : si vous cliquez sur le bloc de texte au lieu de le faire glisser, vous perdez
la sélection de texte ou l’emplacement du point d’insertion.

Pour redimensionner un bloc à l’aide de l’outil Sélection , faites glisser l’une des
poignées du bloc sur la bordure du bloc. Maintenez la touche Ctrl (Windows)
ou Commande (Mac OS) enfoncée pour mettre le texte à l’échelle à l’intérieur du bloc
(Voir Mise à l’échelle du texte.)

Pour redimensionner le bloc et l’ajuster à son contenu, utilisez l’outil Sélection pour
sélectionner le bloc de texte et cliquez deux fois sur une poignée. Par exemple, si
vous cliquez deux fois sur la poignée du centre du côté inférieur, le bord inférieur du
bloc est magnétisé sur le bas du texte. Si vous cliquez deux fois sur la poignée du
centre sur le côté droit, la hauteur est préservée tandis que la largeur est réduite pour
que le bloc de texte soit rempli.

Conseil : vous pouvez également cliquer deux fois sur une poignée d’un bloc de
texte en excès pour augmenter la hauteur et la largeur de façon à accommoder
l’ensemble du texte dans le bloc. Si un bloc de texte contient plus de texte en excès
que la page ne peut contenir, le bloc de texte n’est pas redimensionné.

Cliquez deux fois sur une poignée pour redimensionner un bloc de texte.

Pour ajuster le bloc de texte au contenu, sélectionnez le bloc à l’aide de
l’outil Sélection, puis choisissez Objet > Ajustement > Ajuster le bloc au contenu. Le
bas du bloc de texte s’adapte pour contenir l’ensemble du texte. Si un bloc de texte
contient plus de texte en excès que la page ne peut contenir, le bloc de texte n’est
pas redimensionné.

A l’aide de l’outil Mise à l’échelle , faites glisser le pointeur pour redimensionner le
bloc (voir Mise à l’échelle du texte).

Utilisation des blocs de texte sur les gabarits

Lorsque vous créez un document, vous pouvez sélectionner l’option Bloc de texte type, de sorte qu’un bloc
de texte vide soit inséré dans le gabarit par défaut du document. Ce bloc dispose des attributs de marge et
de colonne spécifiés dans la boîte de dialogue Nouveau document.

Suivez les indications ci-après pour utiliser les blocs de texte dans les gabarits :

Configurez des blocs de texte types si vous souhaitez que chaque page du document
contienne un bloc de texte d’une page dans lequel vous pourrez placer ou saisir du texte.
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En revanche, si la mise en page de votre document doit être plus souple, avec des blocs
de texte de diverses longueurs et en nombre variable sur chaque page, désélectionnez
l’option Bloc de texte type et créez vos blocs de texte sur les gabarits à l’aide de
l’outil Texte.

Que vous sélectionniez ou non l’option Bloc de texte type, vous pouvez ajouter des blocs
de texte dans le gabarit, pour réserver l’emplacement. Vous pouvez lier les blocs de
substitution vides les uns aux autres afin d’établir un flux de placement.

Placez du texte dans les blocs de texte types en utilisant les mêmes procédures que
celles utilisées pour les blocs créés sur les pages de document.

Si vous devez saisir du texte dans un bloc de texte type sur une page de document,
maintenez les touches Ctrl+Maj (Windows) ou Commande+Maj (Mac OS) enfoncées
lorsque vous cliquez sur le bloc de texte de la page de document. A l’aide de l’outil Texte,
cliquez dans le bloc et saisissez le texte.

La redistribution intelligente du texte permet d’ajouter ou de supprimer des pages
automatiquement à mesure que vous saisissez et modifiez du texte. Par défaut, lorsque
vous saisissez du texte à la fin d’un bloc de texte lié d’après un gabarit, une nouvelle
page est ajoutée pour vous permettre de continuer la saisie dans le nouveau bloc de
texte. Vous pouvez modifier les paramètres de la redistribution intelligente du texte.

Si vous modifiez les marges de la page, les blocs de texte s’adaptent aux nouvelles
dimensions seulement si l’option Activer l’ajustement de la mise en page est sélectionnée.

La sélection de l’option Bloc de texte type n’affecte pas l’ajout de nouvelles pages lorsque
vous placez le texte automatiquement.

Modification des propriétés d’un bloc de texte

La commande Options de bloc de texte vous permet de modifier les paramètres, tels que le nombre de
colonnes dans le bloc, l’alignement vertical du texte ou la marge (espace entre le bloc et le texte qu’il
contient).

Avant (à gauche) et après (à droite) avoir défini des marges et créé deux colonnes dans un bloc de texte

Pour utiliser les mêmes propriétés de bloc pour plusieurs blocs de texte, créez un style d’objet que vous
pourrez appliquer aux blocs de texte.

1. Sélectionnez un bloc à l’aide de l’outil Sélection  ou cliquez dans un bloc de texte ou
sélectionnez du texte avec l’outil Texte .  

2. Choisissez Objet > Options de bloc de texte, ou maintenez la touche Alt (Windows)
ou Option (Mac OS) enfoncée, puis cliquez deux fois sur le bloc de texte à l’aide d’un
outil de sélection.

3. Modifiez les options de bloc de texte, puis cliquez sur OK.



Ces options de bloc de texte sont disponibles lorsque vous définissez un style d’objet pour les zones de texte
(voir Styles d’objet).

Ajout de colonnes à un bloc de texte

Vous pouvez créer des colonnes dans un bloc de texte à l’aide de la boîte de dialogue Options de bloc de
texte.

Vous ne pouvez pas créer des colonnes à largeur variable dans un bloc de texte. Pour créer des colonnes
de largeur et de hauteur inégales, ajoutez des blocs de texte côte à côte soit sur une page du document,
soit sur un gabarit.

1. Sélectionnez un bloc à l’aide de l’outil Sélection ou cliquez dans un bloc de texte ou
sélectionnez du texte avec l’outil Texte.

2. Choisissez Objet > Options de bloc de texte.

3. Spécifiez le nombre de colonnes, la largeur de chaque colonne et l’espacement entre les
colonnes (gouttière) du bloc.

4. (Facultatif) Sélectionnez l’option Largeur de colonne fixe pour conserver la largeur des
colonnes lorsque vous redimensionnez le bloc. Si cette option est sélectionnée, le
redimensionnement du bloc peut modifier le nombre de colonnes mais pas leur largeur.

Largeur de colonne fixe

A. Bloc de texte initial à deux colonnes B. Bloc redimensionné avec l’option Largeur de
colonne fixe désélectionnée (toujours avec 2 colonnes) C. Bloc redimensionné avec
l’option Largeur de colonne fixe sélectionnée (avec 4 colonnes) 

5. (Facultatif) Sélectionnez l’option Equilibre des colonnes pour que le texte soit réparti
uniformément au sein d’un bloc de texte de plusieurs colonnes.
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Modification de la marge d’un bloc de texte

1. Sélectionnez un bloc à l’aide de l’outil Sélection ou cliquez dans un bloc de texte ou
sélectionnez du texte avec l’outil Texte.

2. Choisissez Objet > Options de bloc de texte.

3. Dans la section Marges à l’intérieur du bloc de l’onglet Général, entrez les distances de
décalage souhaitées en haut, à gauche, en bas et à droite. Cliquez sur l’icône
Uniformiser tous les paramètres  pour appliquer le même espacement de chaque côté.

Si le bloc que vous avez sélectionné n’est pas de forme rectangulaire, ces options sont grisées et une
option Marge est disponible.

Options de décalage de la première ligne de base

Pour modifier les options de la première ligne de base d’un bloc de texte sélectionné, choisissez Objet >
Options de bloc de texte, puis cliquez sur l’onglet Options de ligne de base. Les options suivantes
apparaissent dans le menu Décalage, sous Première ligne de base :

La hauteur du caractère « d » de la police est inférieure à la marge supérieure du bloc de texte.

Le haut des lettres majuscules touche la marge supérieure du bloc de texte.

Utilisez la valeur d’interligne du texte comme distance séparant la ligne de base de la première
ligne de texte et la marge supérieure du bloc.

La hauteur du caractère « x » de la police est inférieure à la marge supérieure du bloc.

Spécifiez la distance séparant la ligne de base de la première ligne de texte et la marge supérieure du
bloc.

Sélectionnez une valeur minimum de décalage de la ligne de base. Par exemple, si l’option Interligne
est sélectionnée et la valeur minimum est définie sur 1p, InDesign utilise la valeur d’interligne uniquement
lorsqu’elle est supérieure à 1 pica.

Pour magnétiser le haut du bloc de texte à une grille, sélectionnez Interligne ou Fixe afin de pouvoir
choisir l’emplacement de la première ligne de base du texte dans les blocs.

Définition des grilles de ligne de base d’un bloc de texte

Dans certains cas, il est préférable d’appliquer une grille de ligne de base à un bloc plutôt qu’à l’ensemble du
document. Utilisez la boîte de dialogue Options de bloc de texte pour appliquer une grille de ligne de base à
un bloc de texte. Lorsque vous définissez une grille de ligne de base pour un bloc de texte, tenez compte
des points suivants :

La grille de ligne de base du document n’apparaît pas derrière ou devant les blocs de
texte qui utilisent leurs propres grilles de ligne de base.
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Si vous avez sélectionné l’option Grilles en arrière-plan dans les préférences des grilles,
les grilles de ligne de base définies pour les blocs prennent le pas sur celles du
document. En revanche, si cette option n’est pas sélectionnée, les grilles de ligne de
base définies pour le document ont la priorité sur celles des blocs.

1. Choisissez Affichage > Grilles et repères > Afficher la grille de ligne de base pour
afficher toutes les grilles de ligne de base, y compris celles d’un bloc de texte.

2. Sélectionnez le bloc de texte ou placez le point d’insertion dans un bloc de texte, puis
choisissez Objet > Options de bloc de texte.

Si vous souhaitez que la grille de ligne de base s’applique à tous les blocs d’un lien
(même si un ou plusieurs blocs liés ne contiennent pas de texte), placez le point
d’insertion dans le texte, choisissez Edition > Tout sélectionner, puis appliquez les
paramètres de la grille de ligne de base de la boîte de dialogue Options de bloc de texte.

3. Cliquez sur l’onglet Options de ligne de base.

4. Dans Grille de ligne de base, sélectionnez l’option Utiliser la grille de ligne de base
personnalisée et utilisez l’une des méthodes suivantes :

Entrez une valeur de décalage de la grille par rapport au haut de la page, à la
marge supérieure de la page, au haut du bloc ou à la marge (interne) supérieure du bloc,
selon ce que vous avez sélectionné dans le menu Relative à.

Indiquez si la grille de ligne de base doit commencer par rapport au haut de
la page, à la marge supérieure de la page, au haut du bloc de texte ou au haut de la
marge (interne) du bloc de texte.

Entrez une valeur d’espacement entre les lignes de la grille. Dans la plupart des
cas, il convient de spécifier une valeur égale à l’interlignage du corps de texte pour
aligner parfaitement les lignes du texte sur cette grille.

Sélectionnez la couleur des lignes de la grille ou choisissez (Couleur de calque)
pour appliquer la même couleur que celle du calque sur lequel le bloc de texte figure.

Si la grille de ligne de base n’est pas visible dans un bloc de texte, choisissez Affichage > Grilles et
repères > Afficher la grille de ligne de base, afin de vérifier que les grilles de ligne de base ne sont pas
masquées. Si la grille de ligne de base n’apparaît toujours pas, vérifiez le seuil d’affichage des grilles dans
la section Grille de la boîte de dialogue Préférences. Pour afficher la grille, il vous faudra peut-être
effectuer un zoom avant sur le bloc ou réduire le niveau du seuil.

Affichage du nombre de mots et de caractères

1. Placez le point d’insertion dans un bloc de texte pour afficher le nombre de mots ou de
caractères de l’ensemble des blocs liés (donc de l’article), ou sélectionnez une partie du
texte pour afficher le nombre de mots ou de caractères du texte sélectionné.

2. Choisissez Fenêtre > Informations pour afficher le panneau Informations.

Le panneau Informations affiche le nombre de caractères, de mots, de lignes et de paragraphes que contient
un bloc de texte. La position du point d’insertion dans le bloc de texte apparaît également.

Utilisation d’autres langues
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Vous pouvez affecter une langue à différents textes. Cette fonctionnalité est particulièrement importante pour
la mise en œuvre de la vérification orthographique et des césures (voir Affectation d’une langue à un texte).

Si vous devez travailler avec du texte composé de caractères asiatiques, des versions spéciales d’InDesign
sont disponibles pour le japonais, le chinois simplifié, le chinois traditionnel et le coréen. Ces versions
permettent de créer des grilles de mise en page et de bloc pour la composition des textes à caractères multi-
octets. Elles comptent par ailleurs diverses fonctions de mise en forme du texte multi-octet, ainsi que des
polices supplémentaires.

De même, une version spéciale d’InDesign est disponible pour les langues du Moyen-Orient, comme l’arabe,
le farsi, l’hébreu et l’ourdou, qui présentent la particularité de composer le texte de droite à gauche. Cette
version se nomme InDesign ME.

Pour plus de détails sur l’achat d’InDesign ME ou d’une version en langue asiatique d’InDesign, consultez le
site Web d’Adobe.

Adobe recommande également
Création de formats de grille nommée
Propriétés des grilles de bloc
Présentation du panneau Grilles nommées
Liaison de texte
Importation de texte
Application d’une grille nommée à un bloc
Styles d’objet
Remplacement ou dissociation d’éléments types
Redistribution intelligente du texte
Gabarits
Modification des propriétés des grilles de bloc
Modification du format, des marges et des colonnes de document
Grilles
Application d’une rotation aux caractères demi-chasse dans un texte vertical
Affichage ou masquage du nombre de caractères de grille de bloc
Présentation du panneau Informations

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
https://www.adobe.com/go/gffooter_online_privacy_policy_fr
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Création d’un livre
Ajout de documents à un livre
Gestion de livres
Synchronisation des documents de livre
Conversion de livres créés dans des versions antérieures d’InDesign
Numérotation des pages, chapitres et paragraphes d’un livre
Impression d’un livre

Création d’un livre

Un fichier livre est un ensemble de documents pouvant partager des styles, des nuanciers, des gabarits et
autres éléments. Vous pouvez numéroter en séquence les pages des documents d’un livre, imprimer des
documents sélectionnés dans le livre ou les exporter au format PDF. Un même document peut appartenir à
plusieurs livres.

L’un des documents ajoutés à un livre est la source des styles. Par défaut, ce fichier est le premier fichier du
livre, mais vous pouvez sélectionner une autre source des styles à tout moment. Lorsque vous synchronisez
les documents d’un livre, les styles et les nuanciers spécifiés dans la source des styles remplacent les styles
et les nuanciers présents dans les autres documents du livre.

Michael Murphy propose sur Book Basics un didacticiel vidéo consacré à la création de livres.

1. Sélectionnez Fichier > Nouveau > Livre.

2. Attribuez un nom au livre, spécifiez un emplacement, puis cliquez sur Enregistrer.

Le panneau Livre s’affiche. Un fichier livre porte l’extension .indb.

3. Ajoutez des documents au livre.

Ajout de documents à un livre

Lorsque vous créez un livre, le panneau Livre s’affiche. Le panneau Livre correspond à l’espace de travail
d’un livre : vous pouvez y ajouter, supprimer ou réorganiser des documents.

1. Sélectionnez Ajouter un document dans le menu du panneau Livre ou cliquez sur le
bouton Plus  situé au bas du panneau Livre.

2. Sélectionnez les documents Adobe InDesign à ajouter, puis cliquez sur Ouvrir.

Vous pouvez faire glisser et déposer des fichiers dans le panneau Livre à partir de la
fenêtre de l’explorateur (Windows) ou du Finder (Mac OS), ou bien faire glisser un
document d’un livre dans un autre. Maintenez la touche Alt (Windows) ou Option
(Mac OS) enfoncée pour copier le document.

3. Si vous avez inclus des documents créés à l’aide de versions antérieures d’InDesign,
ceux-ci sont convertis au format Adobe InDesign CS5 lorsqu’ils sont ajoutés au livre.
Dans la boîte de dialogue Enregistrer sous, spécifiez un nouveau nom pour le document
converti (ou laissez-le inchangé), puis cliquez sur Enregistrer.

http://indesignsecrets.com/the-indesigner-episode-33-long-documents-part-1-book-basics.php
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toutefois, vous devez convertir les documents Adobe PageMaker et
QuarkXPress avant de les ajouter au livre.

4. Au besoin, modifiez l’ordre des documents du panneau en les faisant glisser vers le haut
ou vers le bas de la liste.

5. Pour choisir un document comme source des styles, cochez la case en regard du nom
du document dans le panneau.

Pour ouvrir un document dans un livre, cliquez deux fois sur le nom du document dans le panneau Livre.

Gestion de livres

Chaque livre ouvert s’affiche dans un onglet distinct du panneau Livre. Si plusieurs livres sont ouverts
simultanément, cliquez sur un onglet pour afficher le livre correspondant et accéder à son menu.

Les icônes du panneau Livre indiquent l’état actuel d’un document, par exemple ouvert , introuvable  (le
document a été déplacé, renommé ou supprimé), modifié  (le document a été modifié ou la numérotation
de ses pages ou de ses rubriques a changé alors que le livre était fermé) ou en cours d’utilisation  (lorsque
le document est ouvert chez un autre utilisateur dans un flux de production géré). Les documents fermés ne
sont pas signalés par une icône.

Pour afficher le chemin d’accès d’un document du livre, placez le pointeur de la souris sur le nom du
document jusqu’à ce qu’une info-bulle s’affiche. Vous pouvez également choisir Informations sur le
document dans le menu du panneau Livre.

Pour enregistrer un livre

Les livres sont des fichiers indépendants des fichiers de document. Ainsi, si vous sélectionnez la commande
Enregistrer le livre, InDesign enregistre les modifications apportées au livre et non les documents du livre.

Utilisez l’une des méthodes suivantes :

Pour enregistrer un livre sous un autre nom, sélectionnez la commande Enregistrer le
livre sous dans le menu du panneau Livre, indiquez un emplacement et un nom de
fichier, puis cliquez sur Enregistrer.

Pour enregistrer un livre sous son nom existant, sélectionnez la commande
Enregistrer le livre dans le menu du panneau Livre ou cliquez sur le bouton
Enregistrer  situé au bas du panneau Livre.

si vous partagez des livres au moyen d’un serveur, assurez-vous que vous disposez d’un
système de gestion des fichiers pour éviter d’écraser accidentellement les modifications effectuées par les
autres utilisateurs.

Pour fermer un livre

Pour fermer un seul livre, sélectionnez Fermer le livre dans le menu du panneau Livre.
Pour fermer tous les livres ouverts et ancrés sur le même panneau, cliquez sur le bouton
de fermeture de la barre de titre du panneau Livre.

Pour supprimer des documents d’un livre

1. Sélectionnez le document dans le panneau Livre.
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2. Sélectionnez la commande Supprimer le document dans le menu du panneau Livre.

Lorsque vous supprimez un document du livre, vous ne supprimez pas le fichier sur le disque ; le document
est supprimé dans le livre uniquement.

Pour remplacer des documents dans un livre

1. Sélectionnez le document dans le panneau Livre.

2. Sélectionnez la commande Remplacer le document dans le menu du panneau,
recherchez le nouveau document, puis cliquez sur Ouvrir.

Pour ouvrir un livre dans l’Explorateur ou dans le Finder

1. Dans le panneau Livre, sélectionnez un document.

2. Dans le menu du panneau Livre, choisissez la commande Faire apparaître dans
l’Explorateur (Windows) ou Faire apparaître dans le Finder (Mac OS).

Le fichier sélectionné s’affiche dans une fenêtre de navigateur.

Synchronisation des documents de livre

Lorsque vous synchronisez des documents dans un livre, les éléments que vous spécifiez (styles, variables,
gabarits, recouvrements prédéfinis, formats de références croisées, paramètres de texte conditionnel, listes
de numérotation et nuanciers) sont copiés de la source des styles vers les documents spécifiés dans le livre,
en remplaçant tous les éléments dont les noms sont identiques.

Si les éléments de la source des styles ne sont pas présents dans les documents en cours de
synchronisation, ils seront ajoutés. Les éléments qui ne sont pas inclus dans la source des styles sont laissés
en l’état dans les documents en cours de synchronisation.

Pour sélectionner les éléments à synchroniser

1. Sélectionnez la commande Options de synchronisation dans le menu du panneau Livre.

2. Sélectionnez les éléments que vous voulez copier de la source des styles vers les autres
documents du livre.

Assurez-vous de sélectionner tous les styles inclus dans la définition d’autres styles. Par
exemple, un style d’objet peut contenir des styles de paragraphe et de caractère qui, à
leur tour, comprennent des nuanciers.

3. Sélectionnez l’option Correspondance intelligente des groupes de styles pour éviter la
duplication de styles ayant un nom unique qui ont été déplacés à l’intérieur ou à
l’extérieur d’un groupe de styles.

Supposons que la source des styles comprenne un style de caractère dans un groupe
de styles et que les documents à synchroniser comprennent ce même style de caractère
hors du groupe de styles. Si cette option est sélectionnée, le style de caractère est placé
dans le groupe de styles dans les documents synchronisés.

En revanche, si vous ne sélectionnez pas cette option, une seconde instance du style de
caractère est créée dans le groupe de styles avec les options correspondant à la source.
Le style de caractère situé hors du groupe de styles reste inchangé.

si un document contient plusieurs styles portant le même nom (par
exemple, Style de caractère 1 dans un groupe de styles et Style de caractère 1 hors d’un
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groupe), InDesign ignore cette option et considère qu’elle n’est pas sélectionnée. Pour
éviter les surprises, pensez toujours à donner des noms uniques aux styles que vous
créez.

4. Cliquez sur le bouton OK.

Pour synchroniser les documents d’un livre

Vous pouvez synchroniser le livre alors que les documents de celui-ci sont fermés. InDesign ouvre les
documents fermés, effectue les modifications nécessaires, puis enregistre et ferme les documents ouverts.
Les documents ouverts lors de la synchronisation sont modifiés, mais ne sont pas enregistrés.

1. Dans le panneau Livre, activez la case vide en regard du document que vous avez choisi
comme source des styles : l’icône de source des styles  indique le document utilisé
comme source.

Source des styles sélectionnée

2. Assurez-vous que les éléments que vous voulez copier de la source des styles sont
sélectionnés dans la boîte de dialogue Options de synchronisation.

3. Dans le panneau Livre, sélectionnez les documents à synchroniser avec le document de
source des styles. Si aucun document n’est sélectionné, le livre entier sera synchronisé.

Pour vérifier qu’aucun document n’est sélectionné, cliquez dans la zone grise vide en
dessous des documents de livre (faites défiler ou redimensionnez le panneau Livre si
nécessaire). Vous pouvez également maintenir la touche Ctrl (Windows) ou
Commande (Mac OS) enfoncée et cliquer sur un document sélectionné pour le
désélectionner.

4. Choisissez Synchroniser les documents sélectionnés ou Synchroniser le livre dans le
menu du panneau Livre, ou cliquez sur le bouton Synchroniser  situé au bas du panneau
Livre.

la commande Edition > Annuler annule les modifications uniquement dans les documents
ouverts au moment de la synchronisation.

Pour synchroniser les gabarits

Les gabarits sont synchronisés à la manière d’autres éléments : les gabarits qui portent le même nom (A-
Gabarit par ex.) que ceux de la source des styles sont remplacés. La synchronisation des gabarits s’avère
utile pour les documents qui font appel aux mêmes éléments de composition (en-têtes et pieds de page
continus, par exemple). Cependant, si vous voulez préserver des éléments de page sur un gabarit de
document autre que la source des styles, ne synchronisez pas les gabarits ou créez des gabarits avec des
noms différents.

Les éléments de gabarit qui sont remplacés sur les pages de document après la première synchronisation
des gabarits sont détachés du reste du document. Ainsi, si vous voulez synchroniser les gabarits de votre
livre, il est conseillé de synchroniser l’ensemble des documents du livre au début du processus de
composition. De la sorte, les éléments remplacés conservent leur lien avec le gabarit et continueront d’être
mis à jour à chaque modification des éléments du gabarit dans la source des styles.

Il est également conseillé de synchroniser les gabarits à l’aide d’une seule source de styles. Si vous effectuez
la synchronisation à partir d’une source de styles différente, les éléments remplacés du gabarit risquent d’être
dissociés du reste du document. Pour synchroniser à l’aide d’une source de styles différente, désélectionnez
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d’abord l’option Gabarits dans la boîte de dialogue Options de synchronisation.

Conversion de livres créés dans des versions antérieures
d’InDesign

Pour convertir un livré créé dans une version antérieure d’InDesign, ouvrez-le dans InDesign CS5 et
enregistrez-le. Lorsque vous synchronisez, mettez à jour la numérotation, imprimez, assemblez ou exportez
un livre converti, les documents qu’il contient sont également convertis au format InDesign CS5. Vous pouvez
choisir de remplacer ou de conserver les documents d’origine.

Pour convertir un livre au format InDesign CS5

1. Dans InDesign CS5, choisissez Fichier > Ouvrir.

2. Sélectionnez le livre créé dans une version antérieure d’InDesign et cliquez sur OK.

Un message d’avertissement s’affiche si le livre contient des documents enregistrés dans
un format InDesign antérieur.

3. Sélectionnez la commande Enregistrer le livre sous dans le menu du panneau Livre.
Spécifiez un nouveau nom de fichier pour le livre converti, puis cliquez sur Enregistrer.

Pour convertir les documents d’un livre

1. Ouvrez le livre dans InDesign CS5.

2. Dans le menu du panneau Livre :

Pour remplacer automatiquement les documents d’origine lors de la conversion,
sélectionnez Conversion automatique des documents.

Pour conserver les documents d’origine et enregistrer les documents convertis sous
un nouveau nom, désélectionnez l’option Conversion automatique des documents.
La liste de livres affiche alors les fichiers convertis et non plus les originaux.

3. Utilisez l’une des méthodes suivantes pour convertir les documents :

Sélectionnez Synchroniser Livre dans le menu du panneau Livre (voir
Synchronisation des documents de livre).

Dans le panneau Livre, choisissez Mettre à jour la numérotation > Mettre à jour tous
les numéros.

4. Si l’option Conversion automatique des documents n’est pas sélectionnée, InDesign vous
invite à enregistrer chaque document converti avec un nom différent.

les documents sont également convertis lorsque vous imprimez ou exportez le livre dans
Adobe PDF.

Numérotation des pages, chapitres et paragraphes d’un livre

Vous pouvez définir la numérotation des pages, chapitres et paragraphes d’un livre. Dans un livre, les styles
de numérotation et les numéros de début des pages et chapitres dépendent des paramètres définis pour
chaque document dans la boîte de dialogue Options de numérotation et de section ou Options de
numérotation du document. Pour accéder à l’une de ces boîtes de dialogue, choisissez la commande Page >
Options de numérotation et de section dans le document ou la commande Options de numérotation du
document dans le menu du panneau Livre.
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Pour plus d’informations sur l’ajout d’une numérotation de pages de base à un document, reportez-vous à
l’article Numérotation de base des pages.

Dans le cas des paragraphes numérotés (tels que les listes d’illustrations), la numérotation dépend de la
définition des styles de liste numérotée incluse dans le style de paragraphe.

Le groupe de pages s’affiche en regard de chaque nom de document dans le panneau Livre. Par défaut,
InDesign met à jour la numérotation des pages et des sections dans le panneau Livre lorsque vous ajoutez
ou supprimez des pages de documents ou lorsque vous modifiez un livre en réorganisant des pages ou en
ajoutant ou supprimant des documents. Si vous désactivez le paramètre de mise à jour automatique des
numéros de pages et de sections, vous pouvez mettre à jour manuellement la numérotation d’un livre.

Si la numérotation semble incorrecte suite à la mise à jour du livre, ceci peut être dû au fait que les numéros
absolus, et non les numéros de section, sont affichés dans les préférences générales (voir Pour afficher une
numérotation absolue ou par section dans le panneau Pages).

Si un document est manquant ou ne peut pas être ouvert, l’étendue des pages affiche un signe « ? » de
l’emplacement du document manquant jusqu’à la fin du livre pour indiquer que la véritable étendue des pages
n’est pas connue. Supprimez ou remplacez le document manquant avant de mettre à jour la numérotation. Si
un utilisateur consulte le document sur un autre ordinateur dans le cadre d’un flux de production géré, l’icône
de document en cours d’utilisation  s’affiche : l’autre utilisateur doit alors fermer le document pour vous
permettre de mettre à jour la numérotation.

Pour modifier les options de numérotation des pages et des chapitres pour
chaque document

1. Sélectionnez le document dans le panneau Livre.

2. Choisissez Options de numérotation du document dans le menu du panneau Livre ou
cliquez deux fois sur les numéros de page du document dans le panneau Livre.

3. Spécifiez les options de numérotation de pages, sections et chapitres (voir Options de
numérotation de document).

4. Cliquez sur le bouton OK.

si vous spécifiez un numéro pour la page de début du document d’un livre au lieu de
sélectionner Numérotation automatique des pages, le document du livre commencera à la page spécifiée et
tous les documents suivants du livre seront renumérotés en conséquence.

Pour commencer la numérotation sur une page paire ou impaire

Vous pouvez commencer la numérotation d’un document de livre sur une page paire ou impaire.

1. Sélectionnez la commande Options de numérotation des pages du livre dans le menu du
panneau Livre.

2. Sélectionnez A la suite de la page paire suivante ou A la suite de la page impaire
suivante.

3. Sélectionnez Insérer une page blanche pour ajouter une page vide à la fin d’un
document suivi d’un autre document dont la numérotation doit commencer sur une page
paire ou impaire. Cliquez ensuite sur OK.

Pour désactiver la numérotation automatique des pages d’un livre

1. Sélectionnez la commande Options de numérotation des pages du livre dans le menu du
panneau Livre.

2. Désélectionnez l’option Mettre à jour automatiquement les numéros de page et de
section, puis cliquez sur OK.

3. Pour mettre à jour automatiquement les numéros de page, choisissez Mettre à jour la

http://idiom-q-win-1/fr/indesign/using/layout-design-9.html
http://idiom-q-win-1/fr/indesign/using/numbering-pages-chapters-sections.html#display_absolute_or_section_numbering_in_the_pages_panel
http://idiom-q-win-1/fr/indesign/using/numbering-pages-chapters-sections.html#display_absolute_or_section_numbering_in_the_pages_panel
http://idiom-q-win-1/fr/indesign/using/numbering-pages-chapters-sections.html#document_numbering_options
http://idiom-q-win-1/fr/indesign/using/numbering-pages-chapters-sections.html#document_numbering_options
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numérotation > Mettre à jour tous les numéros dans le menu du panneau Livre.

Vous pouvez également choisir de mettre à jour uniquement les numéros de page et de
section ou les numéros de chapitre et de paragraphe.

Pour utiliser la numérotation séquentielle des paragraphes d’un livre

Pour utiliser la numérotation séquentielle des paragraphes pour les listes d’illustration, les tableaux ou
d’autres éléments, vous devez d’abord définir une liste numérotée à utiliser dans un style de paragraphe. La
liste numérotée que vous définissez détermine si les paragraphes doivent conserver une numérotation
séquentielle dans tous les documents d’un livre.

1. Ouvrez le document utilisé comme source des styles du livre.

2. Choisissez la commande Texte > Listes à puces et numérotées > Définir des listes.

3. Cliquez sur Nouveau pour définir une liste ou sélectionnez une liste existante et
choisissez Modifier.

4. Sélectionnez les deux options Continuer la numérotation au fil des articles et Continuer la
numérotation du document précédent du livre.

5. Cliquez sur le bouton OK.

6. Définissez un style de paragraphe utilisant la liste numérotée et appliquez-le au texte de
chaque document contenant la liste (voir Création d’un style de paragraphe pour les
listes continues).

Pour vous assurer que le même paramètre de liste numérotée est utilisé dans tous les documents du livre,
sélectionnez les options Styles de paragraphe et Listes numérotées de la boîte de dialogue Options de
synchronisation, puis synchronisez le livre.

Impression d’un livre

L’un des avantages de la fonction de livre est que vous pouvez utiliser une seule commande pour la sortie
des documents sélectionnés ou du livre entier (pour imprimer, réaliser un contrôle en amont, assembler ou
exporter au format EPUB ou PDF).

1. Dans le panneau Livre, utilisez l’une des méthodes suivantes :

Pour imprimer des documents spécifiques, sélectionnez les documents souhaités.

Pour imprimer un livre entier, assurez-vous qu’aucun document n’est sélectionné.

2. Sélectionnez une commande de sortie, telle que Imprimer Livre ou Documents
sélectionnés, dans le menu du panneau Livre.

Adobe recommande également
Numérotation de base des pages
Création d’un style de paragraphe pour les listes continues
Impression d’un document ou d’un livre
Exportation de contenu pour EPUB (CS5)
Contrôle en amont de livres
Exportation au format PDF pour l’impression
Création de documents interactifs pour PDF
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Personnalisation de la table de montage et des repères
Modification du format, des marges et des colonnes de document

Pour plus d’informations et d’instructions, cliquez sur les liens ci-dessous.

Personnalisation de la table de montage et des repères
Vous pouvez modifier les couleurs utilisées pour afficher les repères de marge et de colonne ainsi que les repères des zones de fond perdu et de
ligne-bloc sur la table de montage. Pour faciliter la distinction entre les modes Affichage standard et Aperçu, il est possible de modifier la couleur
d’arrière-plan du mode Aperçu.

InDesign vous permet aussi de contrôler la proximité nécessaire aux objets pour s’accoler aux repères, l’affichage des repères par rapport aux
objets (devant ou derrière) et la taille de la table de montage.

1. Choisissez Edition > Préférences > Repères et table de montage (Windows) ou InDesign > Préférences > Repères et table de
montage (Mac OS).

2. Dans la zone Couleur, choisissez les couleurs souhaitées dans chacun des menus suivants, ou choisissez Personnalisée pour
spécifier une couleur personnalisée au moyen du sélecteur de couleurs.
Marges Définit la couleur des marges de page.

Colonnes Définit la couleur des repères de colonne de la page.

Fond perdu Définit la couleur de la zone de fond perdu (définie dans la boîte de dialogue Format de document).

Ligne-bloc Définit la couleur de la zone de ligne-bloc (définie dans la boîte de dialogue Format de document).

Arrière-plan du mode Aperçu Définit la couleur de la table de montage en mode Aperçu.

3. Pour définir la proximité nécessaire à un objet pour s’accoler à un repère ou une grille, spécifiez une valeur en pixels pour la
zone de magnétisme.

4. Pour afficher les repères derrière les objets, sélectionnez l’option Repères en arrière-plan.
5. Pour spécifier la longueur d’extension de la table de montage par rapport à la page ou à la planche (ou à la zone de fond

perdu ou de ligne-bloc le cas échéant), saisissez des valeurs dans les champs Marges horizontales et Marges verticales.
6. Cliquez sur OK pour fermer la boîte de dialogue Préférences.

Vous pouvez modifier la couleur du papier s’affichant à l’écran. En l’absence de texte ou d’objets sélectionnés, cliquez deux fois sur Couleur
papier dans le panneau Nuancier (choisissez Fenêtre > Nuancier). La couleur papier n’est visible qu’à l’écran et n’a aucune incidence sur
l’impression. Elle a pour objet de vous donner une idée de votre travail sur un papier qui n’est pas blanc.

Modification du format, des marges et des colonnes de document
Après avoir créé un document, vous pouvez changer d’avis concernant sa mise en forme. Par exemple, vous pouvez souhaiter des pages simples
au lieu de pages en vis-à-vis, ou vous pouvez vouloir modifier le format de page ou les paramètres de marge.

Modification du format de document
Les modifications effectuées dans la boîte de dialogue Format de document se répercutent sur toutes les pages du document. Si vous modifiez le
format de la page ou son orientation après l’insertion d’objets, utilisez la fonction Modifier la mise en page pour accélérer la réorganisation des
objets existants (voir la section Rectification automatique de la mise en page).

1. Choisissez Fichier > Format de document.

2. Spécifiez les options de document puis cliquez sur OK (voir la section Options de nouveau document).

Modification des paramètres de marge et de colonne de page
Vous pouvez modifier les paramètres des colonnes et marges des pages et planches. Lorsque vous modifiez les paramètres des colonnes et
marges d’un gabarit, ces modifications s’appliquent à l’ensemble des pages auxquelles le gabarit est appliqué. La modification des colonnes et
marges des pages normales n’affecte que les pages sélectionnées dans le panneau Pages.

Remarque : la boîte de dialogue Marges et colonnes ne modifie pas les blocs de texte. Les colonnes de bloc de texte sont spécifiques aux blocs
de texte individuels ; il ne s’agit pas d’éléments de la page proprement dite. Vous pouvez configurer les colonnes d’un bloc de texte au moyen de



 

la boîte de dialogue Options de bloc de texte (voir la section Ajout de colonnes à un bloc de texte). Les colonnes de bloc de texte peuvent
également être affectées par la fonctionnalité Modifier la mise en page.

1. Utilisez l’une des méthodes suivantes :

Pour modifier les paramètres de marge et de colonne d’une planche ou d’une page, affichez la planche à modifier ou
sélectionnez une planche ou une page dans le panneau Pages.

Pour modifier les paramètres de marge et de colonne de plusieurs pages, sélectionnez ces pages dans le panneau Pages
ou sélectionnez un gabarit qui contrôle les pages à retoucher.

2. Choisissez Page > Marges et colonnes, puis définissez les options suivantes avant de cliquer sur OK.

Marges Spécifiez la distance qui doit séparer les repères de marge des bords de la page. Si vous avez sélectionné l’option
Pages en vis-à-vis dans la boîte de dialogue Nouveau document ou Format de document, les options de marges gauche et
droite sont renommées Petit fond et Grand fond afin que vous puissiez définir une marge intérieure plus importante réservée
à la reliure.

Colonnes Spécifiez le nombre de colonnes.

Création de colonnes à largeur variable
Si vous travaillez sur des pages multicolonnes, les repères de colonne centraux s’affichent et se déplacent simultanément, même si vous n’en
faites glisser qu’un seul. L’espace qui sépare les repères de colonne est proportionnel à la gouttière précédemment définie ; cette valeur est
respectée grâce au déplacement synchrone des repères.

Remarque : vous ne pouvez pas donner des largeurs différentes aux colonnes d’un bloc de texte. Créez plutôt des blocs de texte liés côte à côte,
avec des largeurs de colonnes différentes.

1. Affichez le gabarit ou la planche à modifier.

2. Si les repères de colonnes sont verrouillés, choisissez Affichage > Grilles et repères > Verrouiller les repères de colonne pour
les désélectionner.

3. A l’aide de l’outil Sélection , faites glisser un repère de colonne. Il est impossible de lui faire dépasser un repère de colonne
adjacent ou de le faire sortir des limites de la page.

Glissement d’un repère de colonne pour former des colonnes à largeur variable

Pour créer des colonnes avec des gouttières inégales, créez des repères de règle à espacement régulier, puis faites glisser chacun de ces
repères vers un emplacement spécifique (voir la section Création de repères de règle).

Voir aussi
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Masques
Recadrage d’un objet à l’aide d’un tracé ou d’une couche alpha
Création automatique d’un masque
Options de masque
Conversion d’un masque en bloc graphique

Masques
Vous pouvez utiliser des masques pour détourer les objets d’une page. Des portions de ces objets apparaîtront à travers les formes de masquage.
Il est possible de créer des masques pour cacher des parties d’une image, en créant à la fois un tracé pour l’image et un cadre pour le graphique.
Le masque étant séparé du bloc graphique, vous pouvez modifier librement le masque sans que cela affecte le bloc à l’aide de l’outil Sélection
directe et des autres outils de dessin du panneau Outils.

Utilisez l’une des méthodes suivantes pour créer des masques :

Importez dans la mise en page des graphiques ayant déjà été enregistrés avec des tracés ou des couches alpha (masques)
qu’InDesign peut utiliser automatiquement. Pour ajouter des tracés et des couches alpha aux graphiques, vous pouvez utiliser
un logiciel comme Adobe Photoshop.

Utilisez l’option Détection des contours de la commande Masque pour créer le masque d’un graphique n’ayant pas été
enregistré avec un masque.

Utilisez l’outil Plume pour dessiner un tracé de la forme souhaitée, puis choisissez la commande Coller dedans pour coller le
graphique dans le tracé.

Si vous utilisez l’une des méthodes automatiques d’InDesign pour générer un masque, l’image est associée à un masque InDesign ; elle est donc
rognée par le tracé et recadrée par le bloc.

Remarque : le bloc graphique affiche la couleur du calque sur lequel il apparaît, et le masque est dessiné dans la couleur complémentaire du
calque. Par exemple, si le calque est bleu, le bloc graphique apparaît en bleu et le masque en orange.

Recadrage d’un objet à l’aide d’un tracé ou d’une couche alpha
InDesign peut recadrer un graphique EPS, TIFF ou Photoshop importé à l’aide d’un masque ou d’une couche alpha enregistré dans le fichier. Si le
graphique importé contient plusieurs tracés ou couches alpha, vous pouvez choisir le tracé ou la couche alpha à utiliser en créant un masque.

Une couche alpha est une couche invisible définissant les zones transparentes d’un graphique. Elle est stockée à l’intérieur du graphique, avec les
couches RVB ou CMJN. Les couches alpha sont généralement utilisées dans les applications de montage vidéo. InDesign reconnaît
automatiquement la transparence par défaut de Photoshop (le motif à damier) comme couche alpha. Si le graphique a un arrière-plan opaque,
vous devez utiliser Photoshop pour le supprimer, ou créer et enregistrer une ou plusieurs couches alpha avec le graphique. Dans
Adobe Photoshop, vous pouvez créer des couches alpha à l’aide des commandes de suppression de fond telles que les masques de fusion, le
panneau Couches, la gomme d’arrière-plan ou la gomme magique.

Résultats de l’utilisation de couches alpha et de tracés incorporés
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A.  Graphique d’origine B.  Couche alpha C.  Graphique importé D.  Graphique d’origine E.  Graphique avec tracé incorporé F.  Graphique
importé

Lorsque vous importez un fichier Photoshop, la boîte de dialogue Options d’importation d’image vous permet d’utiliser le masque par défaut ou
de sélectionner une couche alpha pour l’écrêtage.

1. Sélectionnez un graphique importé, puis choisissez Objet > Masque.
2. Dans la boîte de dialogue Masque, choisissez Tracé Photoshop ou Couche alpha dans le menu Type.
3. Choisissez le tracé désiré ou la couche alpha à partir du menu Tracé ou Couche Alpha.

Remarque : si aucune couche alpha n’est enregistrée avec le graphique, la commande de menu Couche Alpha n’est pas
disponible.

4. Pour créer un encart avec le masque, indiquez une valeur dans Bloc.
5. Pour inverser les zones visibles et masquées, sélectionnez Inverser.
6. Si vous choisissez une couche alpha, indiquez les autres options de masque et cliquez sur OK.

Pour désactiver le masque, sélectionnez le graphique importé, puis choisissez Objet > Masque. Choisissez Aucun dans le menu Type, puis
cliquez sur OK.

Création automatique d’un masque
Si vous voulez supprimer le fond d’un graphique n’ayant pas été enregistré avec un masque, vous pouvez le faire automatiquement à l’aide de
l’option Détection des contours de la boîte de dialogue Masque. L’option Détection des contours masque les zones les plus claires ou les plus
sombres d’un graphique ; elle est donc plus efficace lorsque le sujet est placé sur un fond blanc ou noir uni.

Bon candidat (à gauche) et mauvais candidat (à droite) pour l’option de masque automatique

1. Sélectionnez un graphique importé, puis choisissez Objet > Masque.
2. Dans la boîte de dialogue Masque, choisissez Détection des contours dans le menu Type. Par défaut, la commande supprime

les zones les plus claires ; pour supprimer les zones les plus foncées, sélectionnez également l’option Inverser.
3. Spécifiez les options de masque suivantes, puis cliquez sur OK.

Options de masque
Seuil Indique la valeur de pixel la plus sombre qui définira le masque résultant. Si vous augmentez cette valeur, davantage de pixels deviennent
transparents par l’extension de la plage des valeurs de luminosité, débutant à 0 (blanc) ajoutées à la zone cachée. Par exemple, si vous souhaitez
supprimer une ombre portée très claire lors de l’utilisation de la commande Détection des contours, essayez d’augmenter le seuil jusqu’à faire
disparaître l’ombre. Si certains pixels que vous souhaitez voir affichés sont invisibles, le seuil est trop élevé.

Niveau de seuil défini sur 25 (à gauche) et sur 55 (à droite)

Tolérance Indique la similarité de la valeur de luminosité d’un pixel par rapport à la valeur Seuil avant que ce pixel ne soit masqué par le masque.
Augmentez la valeur Tolérance ou déplacez le curseur pour supprimer les irrégularités indésirables dues à des pixels isolés plus foncés mais
proches de la valeur de luminosité du seuil. Une valeur Tolérance plus élevée crée généralement un masque plus lissé et plus approximatif, par
l’augmentation de la plage des valeurs proches de la valeur Tolérance et l’inclusion des pixels isolés plus foncés dans cette plage. Réduire la
valeur Tolérance revient à contraindre le masque à prendre en compte de plus petites variations de valeur. Une valeur Tolérance réduite crée un
masque moins précis par l’ajout de points d’ancrage, ce qui peut compliquer l’impression de l’image.
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Niveau de tolérance défini sur 0 (à gauche) et sur 5 (à droite)

Bloc Réduit le masque résultant par rapport au masque défini par les valeurs Seuil et Tolérance. Contrairement aux valeurs Seuil et Tolérance, la
valeur Bloc ne prend pas la luminosité en compte. Elle réduit uniformément la forme du masque. L’ajustement de la valeur Bloc permet de cacher
les pixels isolés qu’il n’a pas été possible d’éliminer à l’aide des valeurs Seuil et Tolérance. Entrez une valeur négative pour obtenir un masque
plus grand que celui défini par les valeurs Seuil et Tolérance.

Bloc de -0p1 (à gauche) et de 0p3 (à droite)

Inverser Inverse les zones visibles et masquées, en commençant le masque par les tons les plus foncés.
Inclure les contours intérieurs Sélectionnez cette option pour rendre transparentes les zones qui se trouvent dans le masque d’origine et dont
les valeurs de luminosité sont incluses dans les plages Seuil et Tolérance. Par défaut, la commande Masque ne rend transparentes que les zones
extérieures. Utilisez donc la commande Inclure les contours intérieurs pour représenter les « blancs » d’un graphique. Cette option fonctionne bien
lorsque les niveaux de luminosité des zones à rendre transparentes sont différents de ceux des zones devant être visibles. Par exemple, si vous
choisissez l’option Inclure les contours intérieurs pour une image représentant des lunettes en argent, et que les verres deviennent transparents,
les zones les plus claires de la monture peuvent aussi devenir transparentes. Si des zones deviennent transparentes sans que l’effet soit voulu,
essayez d’ajuster les valeurs Seuil, Tolérance et Bloc.
Limiter au bloc Crée un masque qui s’arrête au côté visible du graphique. Cela peut aboutir à un tracé plus simple lorsque vous utilisez le bloc du
graphique pour recadrer le graphique.
Image haute résolution Calcule les zones transparentes à l’aide du fichier réel pour un maximum de précision. Désélectionnez cette option pour
calculer la transparence en fonction de la résolution d’affichage de l’écran (solution plus rapide mais moins précise). Cette option n’est pas
disponible si vous choisissez Couche alpha, car InDesign utilise toujours la résolution réelle avec les couches alpha (voir la section A propos des
transparences).

Conversion d’un masque en bloc graphique
 Choisissez la commande Objet > Masque > Convertir le masque en bloc.

Voir aussi
  Création et modification de masques de couche alpha
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Formatting grids
Named Grids panel overview
Create named grid formats
Apply a named grid to a frame
Edit named grids
Delete named grids
Import grid formats from other documents

Named Grids panel overview

Use the Named Grids panel (Window > Type & Tables > Named Grids) to save frame grid settings in named grid
format, and apply those settings to other frame grids. You can apply or change frame grid formats efficiently, and
easily keep the appearance of a document consistent, using grid formats.

Named Grids panel

A. Grid name B. New Grid Format button C. Delete icon 

In the Named Grids panel, the Layout Grid format is shown by default. The layout grid setting for the currently
selected page is reflected in this grid format. When more than one layout grid is set for a single document, the
settings shown in Layout Grid in the Named Grids panel vary depending on the selected page layout grid contents.

When a frame grid with grid formatting is selected, the current grid format name is highlighted in the Named Grids
panel.

Create named grid formats

Like styles, named grid formats let you save a collection of frame grid settings and apply those settings to other
frame grids.

1. To define a new grid format in accordance with the existing frame grid format, select the frame grid with the
selection tool.

2. Choose Window > Type & Tables > Named Grids.
3. Choose New Named Grid from the Named Grids panel menu.
4. Specify options in the Edit Grid Format dialog box, and click OK.



If the named grid format you want to use is already saved in another InDesign document, you can import that grid
format into the current document.

When a new frame grid format is created based on an existing frame grid, changes to format attribute options also
are applied to the selected frame grid. If you do not want to modify the selected frame grid format, deselect the
frame grid before showing the Edit Grid Format dialog box.

Named Grid options

Named Grid options appear when you choose Window > Type & Tables > Named Grids.

Grid Name

Enter the name of the grid format.

Font

Select the font family and font style, and set the default font for the text to be placed in the grid.

Size

Specify individual grid sizes.

Vertical and Horizontal

Specify the grid scale for full-width Asian characters in %.

Char Aki

Specify the spacing between grid cells in the frame grid. This value will be the grid cell size.

Line Aki

Enter a value to specify the grid line spacing. The value used here is the distance between the bottom (or left)
edge of the character embox for the first line to the top (or right) edge of the character embox for the next line.

Line Align

Select an option to specify line alignment for the frame grid. For example, if Align Left/Top is selected, the
beginning of each line for a vertical type frame grid will be aligned with the top edge of the frame grid. (See Align
or justify text.)

Grid Align

Select an option to specify whether to align the text to the embox, ICF box, or roman baseline. See Align
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paragraphs to a baseline grid.

Char Align

Select an option to specify the method of aligning small characters to larger characters in a line. (See Align text of
different sizes.)

Apply a named grid to a frame

You can apply a custom named grid or the Layout Grid to a frame grid. If you apply the Layout Grid, the same
settings defined in the Layout Grid dialog box are used in the frame grid.

1. Select the frame grid using the Selection tool. You can also use the Type tool to click on the frame and
position the text insertion point or select text.

2. Click on the name of the format to be applied in the Named Grids panel or Control panel.

Applying a grid format causes grid format attributes to be set for text in the frame grid, but grid format
attributes will not be set for text which has been given Character or Paragraph styles, or text which has had
settings individually modified from the Character panel or Paragraph panel.

Note:

Priority is given to character style, paragraph style and grid format in that order in the frame grid.
Accordingly, when grid formatting is applied to text that has been given paragraph or character styles, a '+'
mark is shown next to each applied style name. (See Text formatting precedence.)

Before and after applying a grid format to the frame grid

3. To apply grid format attributes to the entire story, select the frame grid using the Selection tool and select
Edit > Apply Grid Format.

You can also add named grids to object styles. If you add a named grid to the default object style for grid frames,
all grid frames you create appear formatted according to the named grid you specify. (See About object styles.)

Edit named grids

You can change the grid format definitions at any time. When you change the definition of a grid format, all of the
frame grids formatted with that style change to conform with the newly defined style.

1. Using the Named Grids panel, select the grid format to be edited, and choose Named Grid Options from the
panel menu, or double-click the grid format you want to edit in the Named Grids panel.

2. Change the settings in the Modify Named Grid dialog box. (See Create named grid formats.)
3. Click OK.
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This modifies the grid format given to the currently selected frame grid. To modify settings for frame grids which
are not currently selected, perform the above operation without selecting any objects in the document, or double-
click the grid format name in the Named Grids panel while holding down Shift+Ctrl+Alt (Windows) or
Shift+Command+Option (Mac OS).

Delete named grids

The formatting applied to text in a frame is unchanged even if a grid format is deleted, but the link to the grid
format is removed.

1. Select the name of the grid format you want to delete in the Named Grids panel.
2. Choose Delete Named Grids from the panel menu, or click the Delete icon  at the bottom of the Named

Grids panel.

When you delete grid formats, the frame grid to which the grid format was applied doesn’t appear to change, but
the format is no longer connected with the grid format.

Import grid formats from other documents
1. Choose Load All Named Grids from the Named Grids panel menu.
2. Double-click the InDesign document containing the grid formats you want to import.

When you import a grid format from another document that has the same name as a grid format in the current
document, the existing grid format in the import destination will be overwritten, and when this grid format is
applied the grid format for all the frame grids will be changed.

Adobe also recommends

Customize layout and frame grids
Override character and paragraph styles
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Frame grid properties
Change frame grid properties
Convert text frames and frame grids
View or hide the frame grid character count

Change frame grid properties
1. Using the Selection tool , select the frame whose properties you want to modify. You can also use the Type

tool to click on the frame, and position the text insertion point or select text.

2. Choose Object > Frame Grid Options, and then specify the frame grid options. (See Frame grid properties.)

3. Click OK.

Select Preview to confirm options before applying the changes, and then confirm changes in the document.

Frame grid properties

Use the Frame Grid dialog box to change frame grid settings such as the font, character size, character spacing,
lines, and characters.

The values in the Text Frame Option dialog box and the number of columns in the Frame Grid settings dialog box
interact dynamically. Column number settings in Text Frame Options are also reflected in the frame grid settings.
Furthermore, First Baseline Offset and Ignore Text Wrapping can be set only from Text Frame Options.

Font

Select the font family and font style. These font settings will be applied in frame grids based on the layout grid.

Size

Specify the font size. This value will be the grid cell size.

Vertical and Horizontal

Specify the grid scaling for full-width Asian characters in %.

Char Aki

Specify the spacing between grid cells in the frame grid. This value is used for the grid mesh spacing.



Line Aki

Specify the grid spacing. This value is used as the distance from underneath (or left of) the grid mesh on the first
line to the top (or right) of the grid mesh on the next line. If a negative value is set here, Auto Leading value
under Justification in the Paragraph panel menu is set automatically to 80% (the default is 100%), since grid
alignment will only increase line spacing above the spacing already set by the leading amount in the text
attributes. Changing the leading value set in the text will change how the grid alignment spreads the text lines out
to match the nearest grid line.

Line Align

Select an option to specify line alignment for the text. For example, if you select Top for a vertical frame grid, the
start of each line will be aligned to the top of the frame grid. (See Align or justify text.)

Grid Align

Select an option to specify whether to align the text to the embox, ICF box, or roman baseline. (See Align
paragraphs to a baseline grid.)

Char Align

Select an option to specify the method of aligning small characters to larger characters in a line.

Char Count

Select an option to determine where the frame grid’s dimensions and character count appears. (See View or hide
the frame grid character count.)

View

Select an option to specify how to show the frame. Grid shows frame grids with grids and lines. N/Z View shows
the frame grid direction in dark blue diagonal lines; these lines disappear when you insert text. Alignment View
shows frame grid with only lines. Alignment shows the frame line alignment. Grid With N/Z shows a combination of
both.

Grid views

A. Grid view B. N/Z view C. Assignment view with text inserted D. Grid with N/Z view 

Characters

Specifies the number of characters in a line.

Lines

Specifies the number of lines in a column.
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Columns

Specifies the number of columns in a frame grid.

Gutter

Specifies the spacing between columns.

Note:

If you make changes in the Frame Grid settings dialog box when nothing is selected in the frame grid, that setting
becomes the default for the frame grid.

You can also use grid setting to adjust character spacing. (See Using grid tracking to adjust character spacing.)

Convert text frames and frame grids

You can convert plain text frames into frame grids or frame grids into plain text frames.

When plain text frames are converted into frame grids, for text that has not had a character style or paragraph
style applied in the story, the frame grid's document defaults are applied.

You cannot apply grid format directly to plain text frames. After converting a plain text frame into a frame grid,
you can apply grid format attributes by applying a predetermined grid format to a frame grid using text that has
not been given a paragraph style.

Also, when a text frame is converted to a frame grid, blank space may be created at the top, bottom, left or right
of the frame. This space is shown when the text frame width or height is not divisible by the font size or leading
values set in the grid format. This spacing can be removed by dragging the frame grid handle and adjusting with
the Selection tool. When converting text frames to frame grids, edit the text after adjusting any insets created
during conversion.

Convert a plain text frame into a frame grid

1. Select the text frame and do one of the following:

Choose Object > Frame Type > Frame Grid.

Choose Type > Story to show the Story panel. Select Frame Grid in Frame Type.

2. To reformat story text according to grid attributes, select Edit > Apply Grid Format when the frame grid is
selected.

Remove a grid from a frame grid

Select the frame grid, and do one of the following:

Choose Object > Frame Type > Text Frame.

Choose Type > Story to show the Story panel. Select Text Frame in Frame Type.
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The frame grid character count is shown at the bottom of the grid. Shown here are the values for characters, lines,
total number of cells and the actual number of characters.

In this frame the value for characters per line is 10, the value for lines is 5, and the total number of cells is 50. 29 characters have been
placed in the frame grid.

Choose View > Grids & Guides > Show Character Count or Hide Character Count.

To specify the size and position of the character count view, select the text frame and choose Object > Frame Grid
Options. Under View Options, specify the Char Count, view, and size, and click OK.

Adobe also recommends

Create frame grids
Formatting grids
Customize layout and frame grids
Differences between frame grids and plain text frames
Change the text direction
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Grids
Use grids
Snapping objects to grids

Use grids

Two kinds of nonprinting grids are available: a baseline grid for aligning columns of text, and a document grid for
aligning objects. On the screen, a baseline grid resembles ruled notebook paper, and a document grid resembles
graph paper. You can customize both kinds of grids.

Baseline grid (left) and document grid (right)

When a grid is visible, you can observe the following characteristics:

The baseline grid covers entire spreads, but the document grid covers the entire pasteboard.

Baseline grids and document grids appear on every spread and cannot be assigned to any master.

The document grid can appear in front of or behind all guides, layers, and objects, but cannot be assigned to
any layer.

Set up a baseline grid

Use Grid Preferences to set up a baseline grid for the entire document.

You can set up a baseline grid for a frame by using the Text Frame Options. (See Change text frame properties.)

1. Choose Edit > Preferences > Grids (Windows) or InDesign > Preferences > Grids (Mac OS).

2. Specify a baseline grid color by choosing a color in the Color menu. You can also choose Custom in the Color
menu.

3. For Relative To, specify whether you want the grid to start at the top of the page or the top margin.

4. For Start, type a value to offset the grid from either the top of the page or the top margin of the page,
depending on the option you choose from the Relative To menu. If you have trouble aligning the vertical
ruler to this grid, try starting with a value of zero.

5. For Increment Every, type a value for the spacing between grid lines. In most cases, type a value that equals
your body text leading, so that lines of text align perfectly to this grid.
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Baseline grid in document window

A. First grid line B. Increment between grid lines 

6. For View Threshold, type a value to specify the magnification below which the grid does not appear. Increase
the view threshold to prevent crowded grid lines at lower magnifications.

Baseline grid at magnification below view threshold (left) and above view threshold (right)

7. Click OK.

Note:

The Snap To Guides command controls both snapping to guides and snapping to the baseline grid.

Set up a document grid

1. Choose Edit > Preferences > Grids (Windows) or InDesign > Preferences > Grids (Mac OS).

2. Specify a document grid color by choosing a color in the Color menu. You can also choose Custom in the
Color menu.

3. To set horizontal grid spacing, specify a value for Gridline Every in the Horizontal section of the Document
Grid section, and then specify a value for Subdivisions between each grid line.

4. To set vertical grid spacing, specify a value for Gridline Every in the Vertical section of the Document Grid
section, and then specify a value for Subdivisions between each grid line.

5. Do one of the following, and click OK:

To put the document and baseline grids behind all other objects, make sure that Grids In Back is
selected.

To put the document and baseline grids in front of all other objects, deselect Grids In Back.

To put guides behind all other objects, you can also choose Guides In Back in the context menu that appears
when you right-click (Windows) or Control-click (Mac OS) an empty area of the document window.

Show or hide grids

To show or hide the baseline grid, choose View > Grids & Guides > Show/Hide Baseline Grid.

To show or hide the document grid, choose View > Grids & Guides > Show/Hide Document Grid.

Snapping objects to grids

When snapping is enabled, moving an object within the snap zone of a grid location will cause the object to snap
to that location.



Snap objects to the document grid

1. Choose View > Grids & Guides and make sure that Snap To Document Grid is selected (checked). If it is not
selected, click it.

Note:

The Snap to Guides command controls both snapping to guides and snapping to the baseline grid.

2. To specify the snap-to zone, choose Edit > Preferences > Guides & Pasteboard (Windows) or InDesign >
Preferences > Guides & Pasteboard (Mac OS), type a value for Snap to Zone, and click OK. The Snap to
Zone value is always in pixels.

To snap an object to a grid, drag an object toward a grid until one or more of the object’s edges is within the
grid’s snap-to zone.

Adobe also recommends

Ruler guides
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Grouping, locking, and duplicating objects
Group or ungroup objects
Group and ungroup objects on different layers
Lock or unlock objects
Hide objects
Duplicate objects
Duplicate an object using the Duplicate command
Duplicate a selected object as you transform
Use Step and Repeat to duplicate objects
Duplicate objects into a grid
Create nonprinting objects

Group or ungroup objects

You can combine several objects into a group so that they are treated as a single unit. You can then move or
transform the objects without affecting their individual positions or attributes. For example, you might group the
objects in a logo design so that you can move and scale the logo as one unit.

Groups can also be nested—grouped into subgroups within larger groups. Use the Selection, Direct Selection, and
Group Selection tools to select different levels of a nested group’s hierarchy.

If you’re working with a stack of overlapping objects, and you group some objects that aren’t adjacent in the
stacking order, the selected objects will be pulled together in the stacking order, right behind the frontmost
selected object. (For example, when objects are stacked as A, B, C, D from front to back, and you group B and D
together, the stacking order becomes A, B, D, C.) If you group objects that exist on different named layers, all of
the objects move to the frontmost layer on which you selected an object. Also, the objects you select must either
be all locked or all unlocked.

Grouped object

1. Select multiple objects to be grouped or ungrouped.

If your selection includes part of an object (for example, an anchor point), the group or ungroup operation
will group or ungroup the entire object.

2. To group the selected objects, choose Object > Group.

To ungroup the selected objects, Object > Ungroup.

If you’re not sure if an object is part of a group, select it using the Selection tool  and look at the Object menu. If
the Object > Ungroup command is available, you’ve selected a group.

Group and ungroup objects on different layers
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You can also use the Layers panel to group objects that are placed on different layers of a document. For more
details on layers, click here.

When you group objects on different layers, InDesign groups the objects on the topmost layer containing at least
one object in the group. However, InDesign remembers the layers to which each object belongs. This implies that,
by default, if you then ungroup the objects, all the objects are restored back to their original layers.

You can also choose to leave the ungrouped objects on the topmost layer. To do this, uncheck the Ungroup Remembers Layers option in the Layers
panel flyout menu.

Note:

This option is an application-level setting. This implies that this option is applied to all documents.

Lock or unlock objects

You can use the Lock command to specify that you don’t want certain objects to move in your document. Locked
objects stay locked when a document is saved, closed, and then reopened.

As long as an object is locked, it cannot be moved. However, you can select locked objects if you turn off the
Prevent Selection Of Locked Objects option in General preferences. When you select a locked object, you can
change attributes such as color.

1. Select the object or objects that you want to lock in place.
2. Do any of the following:

To lock the objects, choose Object > Lock.

To unlock an object, click the lock icon.

To unlock the objects on the current spread, choose Object > Unlock All On Spread.

You can also use the Layers panel to lock or unlock both objects and layers. When you lock a layer, the positions
of all objects on a layer are locked, and the objects cannot be selected. See Layers.

Hide objects

Hidden objects are not printed or exported, and they cannot be selected.

Do any of the following:

To hide an object, select it and choose Object > Hide.

To show hidden objects, choose Object > Show All On Spread.

Duplicate objects

You can duplicate objects using a number of different methods.



Duplicate an object using the Duplicate command

Use the Duplicate command to replicate a selected object instantly. The new copy appears on the layout slightly
offset down and to the right from the original.

Select an object or objects, and choose Edit > Duplicate.

Duplicate a selected object as you transform

You can duplicate an object each time you change its position, orientation, or proportions. For example, you can
create a flower by drawing one petal, setting its reference point at the base of the petal, and repeatedly rotating at
incremental angles, simultaneously duplicating to leave behind a new copy of the petal at each angle.

During a transformation, do one of the following:

If you’re dragging the Selection tool , the Rotate tool , the Scale tool , or the Shear tool , start
dragging, and then hold down Alt (Windows) or Option (Mac OS) after you begin dragging. To constrain
the duplicate’s transformation, Alt+Shift-drag (Windows) or Option+Shift-drag (Mac OS).

If you’re specifying a value in the Transform or Control panel, press Alt+Enter (Windows) or
Option+Return (Mac OS) after you’ve typed the value.

If you’re pressing arrow keys to move objects, hold down Alt (Windows) or Option (Mac OS) as you
press the keys.

Use Step and Repeat to duplicate objects

Use the Step and Repeat command to instantly create rows or columns of duplicates. For example, you can fill a
page with evenly spaced duplicates of a single business card design.

1. Select the object or objects you want to duplicate.

2. Choose Edit > Step and Repeat.

3. For Repeat Count, specify how many duplicates you want to make, not counting the original.

4. For Horizontal Offset and Vertical Offset, specify how far to shift the position of each new duplicate from the
previous duplicate along the  x and y axes, respectively, and click OK.

To create a page full of duplicates, first use Step and Repeat with Vertical Offset set to 0 (zero); this will create
one row of duplicates. Then select the entire row and use Step and Repeat with Horizontal Offset set to 0; this will
repeat the row down the page.

Duplicate objects into a grid

By dragging and using modifier keys, you can create a grid of object identical to the object being duplicated.
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For a video on using grid mode, see http://tv.adobe.com/go/4949/.

1. Select an object.

2. Using the Selection tool, hold down Alt (Windows) or Option (Mac OS) and begin dragging.

3. While still dragging, release the Alt or Option key. Press the Left Arrow and Right Arrow keys to change the
number of columns. Press the Up Arrow and Down Arrow keys to change the number of rows. Drag a
rectangle to specify the size of the grid.

4. Release the mouse button.

Create nonprinting objects

You might want to create objects that appear onscreen, but will not be printed or appear in portable versions of
the document.

You can also use layers to selectively hide or show elements in a document, and you can assign layers a non-
printing status.

1. Select the object or text frame that you don’t want to be printed.
2. Open the Attributes panel (Window > Output > Attributes).
3. In the Attributes panel, select Nonprinting.

Adobe also recommends

Arrange objects in a stack
Select nested or overlapping objects
Lock or unlock layers
Set a layer as nonprinting
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Importing Adobe Illustrator graphics

How you import Illustrator graphics depends on how much editing the graphics require after you import them. You
can import Illustrator graphics into InDesign in their native (.ai) format.

If you want to adjust layer visibility in InDesign...

Import the graphic using the Place command, and when you want to edit it, choose Edit > Edit Original to open
the graphic in Illustrator. For example, for a multilanguage publication, you can create a single illustration that
includes one text layer for each language. You can transform the illustration as a single object in InDesign but you
cannot edit the paths, objects, or text within the illustration.

Layered file with Spanish and English layers

If you want to edit objects and paths in InDesign...

Copy the art from Illustrator and paste it into your InDesign document. For example, in a magazine, you might use
the same design element in each issue, but change its color every month. By pasting a graphic into InDesign, you
can change objects’ color, path, and transparency using the InDesign tools designed for that purpose.

Importing Illustrator graphics with multiple artboards

Illustrator CS4 graphics can include multiple artboards. When you import an Illustrator graphic with multiple
artboards, you can use Import Options to specify which artboard, or “page,” will be imported.

Create a layered PDF in Adobe Illustrator



You can save an Illustrator graphic as a layered PDF and control the visibility of layers in InDesign. Adjusting layer
visibility in InDesign lets you vary an illustration depending on context. Rather than create multiple versions of the
same illustration, say for a multilanguage publication, you can place the same illustration where needed and adjust
the visibility of the layers as appropriate.

You can transform a PDF as a single object (you can rotate or resize it, for example), but you cannot edit the
paths, objects, or text within the illustration.

If you’re placing an Illustrator file that includes multiple artboards, you can specify which artboard is used, as
when placing multipage PDF files.

Note:

Don’t place layers in nested layer sets if you want to adjust layers in InDesign.

1. In Illustrator, choose File > Save As.

2. In the Save As dialog box, type a filename and choose a location for the file.

3. For Format, choose Adobe PDF (.pdf), and click Save.

4. In the Adobe PDF Options dialog box, choose Acrobat 6 (1.5) or later for Compatibility.

5. Select Create Acrobat Layers From Top-Level Layers, and click Save PDF.

Pasting Illustrator graphics into InDesign

When you paste a graphic from Illustrator 8.0 or later into an InDesign document, the artwork appears in InDesign
as a grouped collection of editable objects. For example, if you paste an Illustrator drawing of a soccer ball with
individually created patches into InDesign, the patches are pasted as a group, which can be ungrouped and edited
using tools in InDesign. You cannot change the visibility of layers within the illustration.

Illustration of soccer ball in Illustrator (left) and same illustration pasted into InDesign (right)

Note:

Before pasting a graphic, make sure that Illustrator is configured to copy as AICB (see Illustrator Help). In
InDesign, make sure that Prefer PDF When Pasting isn’t selected in the Clipboard Handling preferences. If these
options aren’t set properly, the Illustrator graphic cannot be edited in InDesign.

Issues you may encounter when pasting or dragging art from Illustrator to InDesign

Color

Illustrator supports the Grayscale, RGB, HSB, CMYK, and Web Safe RGB color models. InDesign supports LAB,
CMYK and RGB. When you paste or drag artwork from Illustrator into InDesign, RGB and CMYK colors convert in
the expected color model. Grayscale colors are converted to the appropriate K value in a CMYK color in InDesign.
HSB and Web Safe RGB objects are converted to RGB color in InDesign. Colors in smooth shades and gradients
can be edited in InDesign.

Gradients

Linear or radial gradients created in Illustrator can be modified using the Gradient tool or Gradient panel in
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InDesign. Gradients with multiple spot colors or complex patterns may appear as non-editable items in InDesign. If
your illustration contains complex gradients, import it using the Place command instead.

Transparency

Transparency is flattened when Illustrator art is pasted or dragged into InDesign.

Graphic styles

Illustrator Graphic Styles don’t become InDesign Object Styles when art is pasted or dragged into InDesign.

Patterns

Illustrator objects filled or stroked with patterns become embedded EPS images when pasted or dragged into
InDesign.

Text

If you drag text from Illustrator into InDesign, it’s converted to outlines and isn’t editable with the Text tool. If you
select text using the Text tool in Illustrator, and then copy it into a text frame in InDesign, the text loses its
formatting but is editable. If you drag the text into InDesign without a frame selected, the text loses all formatting
and isn’t editable.

When you paste text from Illustrator, the text is imported as one or more objects that can be transformed and
colorized in InDesign, but not edited. For example, if you create text on a path in Illustrator and paste it into
InDesign, the text can be colorized, rotated, and scaled, but it cannot be edited using the Type tool. If you want
to edit the text, use the Type tool and paste it into a text frame.

Artwork

Artwork copied from Illustrator and pasted into InDesign is embedded in the InDesign document. No link to the
original Illustrator file is created.

Importing Adobe Photoshop (.PSD) files

You can place graphics created in Adobe Photoshop 4.0 and later directly into an InDesign layout.

Layers and layer comps

You can adjust the visibility of the top-level layers in InDesign, as well as view different layer comps. Changing
layer visibility or layer comps in InDesign does not alter the original Photoshop file.

Paths, masks, or alpha channels

If you save paths, masks, or alpha channels in a Photoshop file, InDesign can use them to remove backgrounds, or
to wrap text around graphics. Graphics that contain paths, masks, or alpha channels act as transparent objects
when imported.
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ICC color management profile

If you place a Photoshop image with an embedded ICC color management profile, InDesign reads the embedded
profile, provided that color management is active. You can override the embedded profile for the image using the
Import Options dialog box or assign a different color profile to the graphic in InDesign. Overriding the color profile
in InDesign will not remove or alter the profile embedded in the Photoshop image.

Spot-color channels

Spot-color channels in Adobe Photoshop PSD or TIFF files appear in InDesign as spot colors in the Swatches panel.
If the image uses a spot color that InDesign does not recognize, the spot color may appear gray in the InDesign
document and print incorrectly as a composite. (The image will print correctly on color separations, however.) To
simulate the graphic as a composite, you can create a spot color with the correct color values, and then alias the
PSD color to this new spot color. The graphic will then print correctly as composite and display correctly on-screen
when Overprint Previewis turned on (choose View > Overprint Preview). Be sure to remove the alias before
printing separations, so that the image prints on the plate you expect.

Importing PDF pages

Using the Place command, you can specify which pages you want to import from a multipage PDF or an Illustrator
file with multiple artboards. You can place a single page, a range of pages, or all pages. Multipage PDF files let
designers combine illustrations for a publication into a single file.

The page range options appear when you select Show Import Optionsin the Place dialog box. See Acrobat (.pdf)
and Illustrator (.ai) import options. The dialog box includes a preview, so you can view a thumbnail of the pages
before you place them. If you place multiple pages, InDesign reloads the graphics icon with the next page, letting
you place the pages one after the next. InDesign doesn’t import movies, sound, links, or buttons when you place a
PDF file.

Comparing screen and device resolution in placed PDF pages

A placed PDF page displays at the best resolution possible for the given scale and screen resolution. When printed
on a PostScript output device, a placed PDF page always prints at the resolution of the device. When printed on a
non-PostScript printer, a placed PDF page prints at the same resolution as the other InDesign objects in the
document. For example, vector (drawn) objects will print at the same resolution as other vector objects in the
document. Bitmap images will print at the best resolution supplied in the placed PDF.

Linking to placed PDFs

A placed PDF page appears in the InDesign document as an on-screen preview, which is linked to a specific page
in the original PDF. After placing a PDF page, you may break links by doing any of the following:

If you add a password to the original PDF that has been placed in an InDesign document, and you update
the link, you’ll be prompted to enter the password.

If you delete pages in the original PDF and update the link, the placed PDF page changes to the page that
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now falls on the originally placed page number.

If you reorder the pages in the original PDF file and update the link, the placed PDF page may be different
from what you expect. When that happens, place the page again.

Color in placed PDF pages

InDesign preserves colors embedded in PDF pages, even if the color comes from a color library not installed with
InDesign (such as the PANTONE Hexachrome® library). In addition, any color traps included in a placed PDF page
are preserved.

When color management is active, InDesign displays the placed PDF using its embedded ICC or output intent
profile (PDF/X only). When color management is turned off, or when you place a PDF that doesn’t contain an ICC
or output intent profile, colors in the placed PDF are calibrated using the color profile in the InDesign document.

When you export or print the document, you can preserve the ICC profile embedded in the placed PDF or replace
it with the document profile instead. Output intent profiles are used for display and are included when you export
as PDF/X; they aren’t used when you print the document, and they aren’t included when you export to any other
format.

Security settings in placed PDF pages

Because a placed PDF page is linked to the original PDF, the placed page also includes the security settings of the
original file. If someone later changes the security settings in the original file, the security settings are updated in
the placed PDF page when you update the links.

If you correctly enter a required master password when placing a PDF page, you override any restrictions in the
PDF page, enabling the placed PDF page to export as expected.

Importing InDesign (.indd) pages

Using the Place command, you can import pages from one InDesign document into another. You can import a
page, a page range, or all of the pages in the document. The pages are imported as objects (much the same way
that PDFs are imported).

Add pages in your document to hold the pages you want to import. After you choose File > Place and select an
INDD file, you can choose Show Import Options and then choose which pages to import, which layers to make
visible, and how to crop the imported pages. You can scroll in the Preview window to examine the thumbnail
pages closely. The page or pages you select are loaded in the graphics icon. If you place multiple pages, InDesign
loads the graphics icon with the following page so you can import pages one after the other.

Note:

The Links panel lists the names of each page you imported. If a page you imported contains a graphic or other
item that was imported into it, this item is listed as well in the Links panel. The names of these secondary
imported items are listed under a disclosure triangle in the Links panel to distinguish them from imported pages.

Importing other graphics formats



InDesign supports a variety of graphics formats, including bitmap formats such as TIFF, GIF, JPEG, and BMP, and
vector formats such as EPS. Other supported formats include DCS, PICT, WMF, EMF, PCX, PNG, and Scitex CT
(.sct). You can import an SWF file as a movie file.

TIFF (.tif) files

TIFF is a flexible bitmap image format supported by virtually all painting, image-editing, and page-layout
applications. Also, virtually all desktop scanners can produce TIFF images.

The TIFF format supports CMYK, RGB, grayscale, Lab, indexed-color, and bitmap files with alpha and spot-color
channels. You can select an alpha channel when you place a TIFF file. Spot-color channels appear in InDesign as
spot colors in the Swatches panel.

You can use an image-editing program such as Photoshop to create a clipping path to create a transparent
background for a TIFF image. InDesign supports clipping paths in TIFF images and recognizes encoded OPI
comments.

Graphics Interchange Format (.gif) files

Graphics Interchange Format (GIF) is a standard for displaying graphics on the World Wide Web and other online
services. Because it compresses image data without losing detail, its compression method is called lossless. Such
compression works well with graphics that use a limited number of solid colors such as logos and charts; however,
GIF cannot display more than 256 colors. For this reason it is less effective for displaying photographs online (use
JPEG instead) and is not recommended for commercial printing. If an imported GIF file contains transparency, the
graphic interacts only where the background is transparent.

JPEG (.jpg) files

The Joint Photographic Experts Group (JPEG) format is commonly used to display photographs and other
continuous-tone images in HTML files over the web and in other online media. The JPEG format supports CMYK,
RGB, and grayscale color modes. Unlike GIF, JPEG retains all of the color information in an RGB image.

JPEG uses an adjustable, lossy compression scheme that effectively reduces file size by identifying and discarding
extra data not essential to the display of the image. A higher level of compression results in lower image quality; a
lower level of compression results in better image quality, but a larger file size. In most cases, compressing an
image using the Maximum quality option produces a result that is indistinguishable from the original. Opening a
JPEG image automatically decompresses it.

Note:

JPEG encoding, which can be performed on an EPS or DCS file in an image-editing application such as Photoshop,
does not create a JPEG file. Instead, it compresses the file using the JPEG compression scheme explained above.

JPEG works well for photographs, but solid-color JPEG images (images that contain large expanses of one color)
tend to lose sharpness. InDesign recognizes and supports clipping paths in JPEG files created in Photoshop. JPEG
can be used for both online and commercially printed documents; work with your prepress service provider to
preserve JPEG quality in printing.



Bitmap (.bmp) files

BMP is the standard Windows bitmap image format on DOS and Windows-compatible computers. However, BMP
does not support CMYK, and its color support is limited to 1, 4, 8, or 24 bits. It is less than ideal for commercially
printed or online documents, and it is not supported by some web browsers. BMP graphics can provide acceptable
quality when printed on low-resolution or non-PostScript printers.

Encapsulated PostScript (.eps) files

The Encapsulated PostScript (EPS) file format is used to transfer PostScript language artwork between applications,
and is supported by most illustration and page-layout programs. Typically, EPS files represent single illustrations or
tables that are placed into your layout, but an EPS file can also represent a complete page.

Because they are based on the PostScript language, EPS files can contain text, vector, and bitmap graphics. Since
PostScript cannot normally be displayed on-screen, InDesign creates a bitmap preview for an EPS file for on-screen
display. InDesign recognizes clipping paths in Photoshop-created EPS files.

When you import an EPS file, any spot colors it contains are added to the Swatches panel in InDesign. EPS allows
for prepress-quality resolution, precision, and color. This format includes all of the color and image data required
to color-separate DCS images embedded in the EPS graphic. EPS isn’t ideal for online publishing in HTML, but it
works well for online publishing in PDF.

EPS files can contain Open Prepress Interface (OPI) comments, which let you use fast, low-resolution versions
(proxies) of images for positioning on a page. For final output, either InDesign or your prepress service provider
can automatically replace the proxies with high-resolution versions.

Desktop Color Separations (.dcs) files

Desktop Color Separations (DCS), developed by Quark, is a version of the standard EPS format. The DCS 2.0
format supports multichannel CMYK files with multiple spot channels. (These spot channels appear as spot colors in
the Swatches panel in InDesign.) The DCS 1.0 format supports CMYK files without spot channels. InDesign
recognizes clipping paths in Photoshop-created DCS 1.0 and DCS 2.0 files.

DCS files are intended to be used in a preseparated, host-based workflow. In most cases, color separations files
associated with a DCS image are excluded when you export or print a composite to a PDF, EPS, or PostScript file.
(The sole exception is made for 8-bit DCS files that were created in Photoshop and that do not contain vector
graphics.)

InDesign can rebuild a composite image from DCS 2.0 or 1.0 separations files, if the files were created in
Photoshop. For best results, do not include DCS 1.0 files or DCS 2.0 files created in programs other than Photoshop
when you are creating high-resolution color composite proofs or separating a document in-RIP or from a composite
file.

Macintosh PICT (.pict) files

The Macintosh PICT (or Picture) format is used for Mac OS graphics and page-layout applications, and for
transferring files between applications. The PICT format compresses images that contain large areas of solid color.
InDesign can import PICT files created from Mac OS screenshots and a variety of other applications, including clip
art collections. However, PICT files are not recommended for high-resolution commercial printing.



InDesign supports RGB PICT images with variable resolutions and embedded QuickTime images. PICT graphics do
not support color separations, are device-dependent, and are not recommended for high-resolution commercial
printing. The PICT format can provide acceptable quality only when printed on low-resolution or non-PostScript
printers.

Windows Metafile Format (.wmf) and Enhanced Metafile Format (.emf) files

Windows Metafile Format (WMF) and Windows Enhanced Metafile Format (EMF) are native Windows formats used
primarily for vector graphics, such as clip art, shared between Windows applications. Metafiles may contain raster
image information; InDesign recognizes the vector information and provides limited support for raster operations.
Color support is limited to 16-bit RGB, and neither format supports color separations. As a general rule, avoid using
Metafile formats for commercially printed documents.

PCX (.pcx) files

The PCX format is commonly used in Windows systems. Most Windows software supports version 5 of the PCX
format.

The PCX format supports RGB, indexed-color, grayscale, and bitmap color modes, as well as the RLE compression
method, which is lossless. It does not support alpha channels. Images can have a bit depth of 1, 4, 8, or 24 bits.
However, PCX is not ideal for commercially printed or online documents. PCX graphics can provide acceptable
quality only when printed on low-resolution or non-PostScript printers.

Portable Network Graphics (.png) files

The Portable Network Graphics (PNG) format uses adjustable, lossless compression to display 24-bit photographs
or solid-color images on the World Wide Web and in other online media. PNG was developed as a patent-free
alternative to the GIF file format. It supports transparency in an alpha channel or a designated color. PNG is best
used for online documents. Color PNG graphics placed in an InDesign document are RGB bitmap images.

Scitex CT (.sct) files

The Scitex Continuous Tone (CT) format is used for high-end image processing on Scitex computers. Scitex CT files
often come from Scitex scanners, which produce high-quality scans for commercial printing. The Scitex CT format
supports CMYK, RGB, and grayscale files, but does not support alpha channels. Contact Scitex to obtain utilities for
transferring files saved in the Scitex CT format to a Scitex system.

Adobe also recommends

Control graphics’ display performance
Acrobat (.pdf) and Illustrator (.ai) import options
Control layer visibility in imported images
Importing, exporting, and saving
Paste or drag graphics
Import options for graphics
Place (import) graphics



Color management
Create an ink alias for a spot color
Saving and exporting images
Acrobat (.pdf) and Illustrator (.ai) import options
Control layer visibility in imported images
Import options for graphics
Place (import) graphics
Control layer visibility in imported images
Place (import) graphics
Import options for graphics
Exporting
Exporting artwork
Import swatches
Movies and sounds
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Layers
About layers
Create layers
Add objects to layers
Duplicate a layer
Change the order of layers
Show or hide layers and objects
Set a layer as nonprinting
Lock or unlock layers
Delete layers
Merge layers in a document

About layers

Each document includes at least one named layer. By using multiple layers, you can create and edit specific areas
or kinds of content in your document without affecting other areas or kinds of content. For example, if your
document prints slowly because it contains many large graphics, you can use one layer for just the text in your
document; then, when it’s time to proofread the text, you can hide all other layers and quickly print the text layer
only. You can also use layers to display alternate design ideas for the same layout, or versions of advertisements
for different regions.

Think of layers as transparent sheets stacked on top of each other. If a layer doesn’t have objects on it, you can
see through it to any objects on layers behind it.

Additional layer notes:

Each document layer has a disclosure triangle that can be expanded to reveal the objects and their stacking
order on that layer for the active spread. Groups, buttons, and multi-state objects also have disclosure
triangles that can be expanded to display their contained objects. You can re-order these objects, lock and
unlock them, and add or remove them from groups.

Objects on masters appear at the bottom of each layer. Master items can appear in front of document page
objects if the master page objects are on a higher layer. (See About masters, stacking order, and layers.)

Layers involve all pages of a document, including masters. For example, if you hide Layer 1 while editing
page 1 of your document, the layer is hidden on all pages until you decide to show it again.

For information on converting layers from Adobe PageMaker® or QuarkXPress, see Converting QuarkXPress
and PageMaker documents.

The Layers panel lists layers with the frontmost layer appearing at the top of the panel.

For a video tutorial on using layers, see http://tv.adobe.com/go/4953/.

http://tv.adobe.com/go/4953/
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You can add layers at any time using the New Layer command on the Layers panel menu or the New Layer button
at the bottom of the Layers panel. The number of layers a document can have is limited only by the RAM available
to InDesign.

Create layers

1. Choose Window > Layers.
2. To create a new layer, do any of the following:

To create a new layer above the selected layer, click the New Layer button.

To create a new layer below the selected layer, hold down Ctrl (Windows) or Command (Mac OS) as
you click the New Layer button.

To create a new layer at the top of the list, hold down Ctrl+Shift (Windows) or Command+Shift
(Mac OS) as you click the New Layer button.

To create a new layer and open the New Layer dialog box, hold down Alt (Windows) or Option
(Mac OS) as you click the New Layer button.

Specify layer options

1. Choose New Layer in the Layers panel menu, or double-click an existing layer.
2. Specify the layer options, and then click OK.

Color

Assign a color to identify the objects on that layer.

Show Layer

Select this option to make a layer visible. Selecting this option is the same as making the eye icon visible in
the Layers panel.

Show Guides

Select this option to make the guides on the layer visible. When this option is not selected for a layer, the
guides cannot be made visible, even by selecting View > Show Guides for the document.

Lock Layer

Select this option to prevent changes to any objects on the layer. Selecting this option is the same as making
the crossed-out pencil icon visible in the Layers panel.

Lock Guides

Select this option to prevent changes to all ruler guides on the layer.
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Print Layer

Select this option to allow the layer to be prevented from printing. When printing or exporting to PDF, you
can determine whether to print hidden and nonprinting layers.

Suppress Text Wrap When Layer Is Hidden

Select this option if you want text on other layers to flow normally when the layer is hidden and it contains
objects with text wrap applied.

Assign a layer color

Assigning a color to a layer makes it easier to distinguish the layers of different selected objects. For each layer
that contains a selected object, the Layers panel displays a dot in the layer’s color. On the page, each object
displays the color of its layer in its selection handles, bounding box, text ports, text wrap boundary (if used), frame
edges (including the X displayed by an empty graphics frame), and hidden characters. The layer color does not
appear for a deselected frame if its edges are hidden.

1. In the Layers panel, double-click a layer or select a layer and choose Layer Options for [layer name].
2. For Color, choose a color or choose Custom to specify a color in the system color picker.

Add objects to layers

Any new object is placed on the target layer, the layer currently displaying the pen icon in the Layers panel.
Targeting a layer also selects it. If multiple layers are selected, targeting one of them doesn’t change the selection,
but targeting a layer outside the selection deselects the other layers.

You can add objects to the target layer by any of the following methods:

Creating new objects with the Type tool or drawing tools.

Importing, placing, or pasting text or graphics.

Selecting objects on other layers, and then moving them to the new layer.

You cannot draw or place a new object on a hidden or locked layer. When you select a drawing tool or the
Type tool, or place a file when the target layer is hidden or locked, the pointer changes to the crossed-out-
pencil icon when it is positioned over the document window. Either show or unlock the target layer, or target
a visible, unlocked layer. If you choose Edit > Paste when the target layer is hidden or locked, an alert
message gives you the choice of showing or unlocking the target layer.

When you click a layer in the Layers panel to target it, the pen icon appears on the layer you clicked, and the layer
also highlights to indicate that it is targeted.

Changing the target layer for the next new object



Select, move, and copy objects on layers

By default, you can select any object on any layer. In the Layers panel, dots mark layers that contain selected
objects. The layer’s selection color helps you identify an object’s layer. To prevent selecting objects on a specific
layer, lock the layer.

Do any of the following:

To select individual objects on a layer, click the triangle icon next to the layer to display all, and select
the target object. You can also drag the target object to a different location without selecting it.

Dragging objects from one layer to another

To select all objects on a specific layer, hold down Alt (Windows) or Option (Mac OS) as you click a
layer in the Layers panel.

To move or copy objects to another layer, use the Selection tool to select one or more objects on a
document page or master. In the Layers panel, drag the colored dot on the right side of the layer list to
move the selected objects to the other layer.

Moving an object to a new layer

To move selected objects to a locked layer, hold down Ctrl (Windows) or Command (Mac OS) as you drag the
colored dot. To copy selected objects to another layer, hold down Alt (Windows) or Option (Mac OS) as you drag
the colored dot on the right side of the layer list to the other layer. To copy selected objects to a locked layer, hold
down Ctrl+Alt (Windows) or Command+Option (Mac OS) as you drag the colored dot.
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Paste objects into different layers

The Paste Remembers Layers command affects how objects pasted from other locations interact with existing
layers.

If the Paste Remembers Layers command is selected, objects cut or copied from different layers retain their layer
assignments when pasted to the new page or position. If you paste objects to a document that doesn’t have the
same layers as the document from which they were copied, InDesign adds the objects’ layer names to the Layers
panel in the second document, and pastes each object on its layer.

If the Paste Remembers Layers command is deselected, objects cut or copied from different layers are pasted
together on the target layer.

1. Make sure that Paste Remembers Layers is deselected in the Layers panel menu.

2. Select objects and choose Edit > Copy or Edit > Cut.

3. In the Layers panel, click the other layer to target it.

4. Choose Edit > Paste.

Duplicate a layer

When you duplicate a layer, you copy its contents and settings. The duplicate layer then appears above the
original layer in the Layers panel. Any duplicated frames that were threaded to other frames on the layer remain
threaded. Duplicated frames whose originals were threaded to frames on other layers are no longer threaded to
those frames.

In the Layers panel, do one of the following:

Select the layer name and choose Duplicate Layer [layer name] in the Layers panel menu.

Drag a layer name and drop it on the New Layer button.

Change the order of layers

Change the stacking order of layers in your document by rearranging the layers on the Layers panel. Rearranging
layers changes the order of layers on every page, not just on the target spread.

You can also change the stacking order of objects within a layer by repositioning objects within the layer. See
Arrange objects in a stack.

In the Layers panel, drag a layer up or down in the list. You can also drag multiple selected layers.

Reordering layers

Show or hide layers and objects
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You can hide or display any layer at any time, and you can hide or display objects on a layer. Hidden layers and
objects can’t be edited, and don’t appear on screen or in print. Hiding layers can be useful when you want to do
any of the following:

Hide parts of a document that are not meant to appear in the final document.

Hide alternate versions of a document.

Simplify the display of a document, to make it easier to edit other parts of the document.

Prevent a layer from printing.

Speed up screen redraw when a layer contains high-resolution graphics.

By default, text continues to wrap around objects on hidden layers. To ignore text wrap settings for hidden
objects, choose Layer Options from the Layers panel menu, and then select the Suppress Text Wrap When Layer
Is Hidden option.

Do any of the following:

To hide or show one layer at a time, in the Layers panel, click the square at the far left of a layer name
to hide or show the eye icon for that layer.

To show or hide individual objects in a layer, click the disclosure triangle to view all objects in a layer,
and then click the eye icon to show or hide the object.

To hide all layers except the selected layer, or to hide all objects on a layer except the selected object,
choose Hide Others in the Layers panel menu. Or, Alt-click (Windows) or Option-click (Mac OS) the
square on the far left side of the layer or object you want to remain visible.

To show all layers, choose Show All Layers in the Layers panel menu. Or, Alt-click (Windows) or Option-
click (Mac OS) the square on the far left side of a visible layer or object to show all layers or all objects
in a layer.

Set a layer as nonprinting
1. Select the layer in the Layers panel.
2. Choose Layer Options from the Layers panel menu.
3. To prevent the layer from being printed, deselect Print Layer, and then click OK.

Note:

When you print or export to PDF, you will still have the option of printing hidden and nonprinting layers.

Lock or unlock layers

Locking is useful for preventing accidental changes to a layer. A locked layer displays a crossed-out pencil icon in
the Layers panel. Objects on locked layers cannot be selected or edited directly; however, if objects on locked
layers have attributes that can be edited indirectly, they will change. For example, if you edit a tint swatch, objects
on locked layers using that tint swatch will reflect the change. Similarly, putting a series of threaded text frames on
both locked and unlocked layers will not prevent text on locked layers from recomposing.

You can also use the Layers panel to lock or unlock objects in a layer. See Lock or unlock objects.
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Do any of the following:

To lock or unlock one layer at a time, in the Layers panel, click a square in the second column from the
left to show (lock) or hide (unlock) the layer.

To lock all layers except the target layer, choose Lock Others in the Layers panel menu. Or, Alt-click
(Windows) or Option-click (Mac OS) the the square left of the layer you want to remain unlocked.

To unlock all layers, choose Unlock All Layers in the Layers panel menu.

Delete layers

Remember that each layer is document-wide—it appears on every page of a document. Before deleting a layer,
consider hiding all other layers first, and then turn to each page of the document to verify that it is safe to delete
the remaining objects.

Do any of the following:

To delete a layer, drag a layer from the Layers panel to the Delete icon  or choose Delete Layer [layer
name] from the Layers panel menu.

To delete multiple layers, hold Ctrl (Windows) or Command (Mac OS) while you click the layers to
select them. Then drag the layers from the Layers panel to the Delete icon or choose Delete Layers
from the Layers panel menu.

To delete all empty layers, choose Delete Unused Layers in the Layers panel menu.

To delete an object on a layer, select the object in the Layers panel, and then click the Delete icon.

Merge layers in a document

You can reduce the number of layers in a document without deleting any objects by merging layers. When you
merge layers, objects from all selected layers are moved to the target layer. Of the layers you merge, only the
target layer remains in the document; the other selected layers are deleted. You can also flatten a document by
merging all layers.

Note:

If you merge layers containing a mix of page objects and master items, the master items move to the back of the
resulting merged layer.

1. In the Layers panel, select any combination of layers. Be sure to include the layer you want to target as the
merged layer. If you’re flattening the document, select all layers in the panel.

2. Click any selected layer to make it the target layer, indicated by the pen.
3. Choose Merge Layers in the Layers panel menu.

You can also merge identically named layers for exporting a book to PDF.

Adobe also recommends

Show or hide frame edges
Prepare layers before exporting a book to PDF
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Laying out frames and pages
About paths and frames
Show or hide frame edges
Using placeholders to design pages
Redefine the purpose of paths and frames
About automatic layout adjustment

For detailed information and instructions, click the links below.

About paths and frames

You can draw objects in a document and use them as paths or as frames. Paths are vector graphics like those you
create in a drawing program such as Adobe Illustrator®. Frames are identical to paths, with only one difference—
they can be containers for text or other objects. A frame can also exist as a placeholder—a container without
contents. As containers and placeholders, frames are the basic building blocks for a document’s layout.

Paths and frames

A. Path B. Frame as graphic container C. Frame with placed graphic 

You can draw both paths and frames using tools in the Toolbox. You can also create frames by simply placing
(importing) or pasting contents into a path.

Note:

In QuarkXPress, paths are referred to as lines, and frames are referred to as boxes.

Because a frame is just a container version of a path, you can do anything to a frame that you can do to a path,
such as add a color or a gradient to its fill or stroke, or edit the shape of the frame itself with the Pen tool. You
can even use a frame as a path, or a path as a frame, at any time. This flexibility makes it easy to change your
design and provides a wide range of design choices.

Frames can contain text or graphics. A text frame determines the area to be occupied by text and how text will
flow through the layout. You can recognize text frames by the text ports in their respective upper left and lower
right corners.

A frame grid is a text frame, with a basic grid to determine character size and spacing within the frame attached.

A graphics frame can function as a border and background, and can crop or mask a graphic. When acting as an
empty placeholder, a graphics frame displays a crossbar.
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Text frame (left) and empty graphics frame (right)

If you don’t see the crossbar inside an empty graphics frame, the frame edges display may be turned off.

Show or hide frame edges

Unlike paths, you can see the nonprinting strokes (outlines) of frames by default even when the frames aren’t
selected. If the document window is getting crowded, use the Show/Hide Frame Edges command to simplify the
screen display by hiding the frame edges. Doing this also hides the crossbar in a graphics placeholder frame. The
display setting for frame edges doesn’t affect the display of the text ports on text frames.

Note:

The frame edge is defined as a frame’s stroke, not the outer edge of the stroke’s weight.

Do any of the following:

To show or hide frame edges, choose View > Extras > Show/Hide Frame Edges.

To hide frame edges, click Preview Mode  at the bottom of the Toolbox.

To show or hide a frame grid, choose View > Grids & Guides > Show Frame Grid, or View > Grids &
Guides > Hide Frame Grid.

Using placeholders to design pages

When your final text and graphics are available, you can simply add them to a document; InDesign automatically
creates frames when you import them (unless you’re importing text or graphics directly into existing frames).
However, when you don’t have the content yet or you want to block out the design before adding text and
graphics, you can use frames as placeholders.

Types of placeholders

A. Graphics frame placeholder B. Text frame placeholder 

For example, you might use any of these strategies:

Draw text frames using the Type tool, and draw graphics frames using the drawing tools. Thread empty text
frames together so that importing final text takes just one step.

Draw empty placeholder shapes using drawing tools. When you’re ready to start designating areas for text
and graphics, redefine the placeholders as either text or graphics frames.

Set frame fitting options for a placeholder frame so that when you place an image in the frame, the image is
cropped and fit accordingly.
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Redefine the purpose of paths and frames

To use a path or text frame as a graphics placeholder frame, select a path or an empty text frame, and then
choose Object > Content > Graphic.
To use a path or graphics frame as a text placeholder frame, select a path or an empty graphics frame, and
then choose Object > Content > Text.
To use a text or graphics frame as a path only, select an empty frame, and then choose Object > Content >
Unassigned.

Note:

When a frame contains text or graphics, you cannot redefine it using the Object > Content menu. However, if you
replace a graphic with text, the content type is automatically redefined.

About automatic layout adjustment

If you use the Document Setup or Margins and Columns commands to make changes to an existing layout, such
as altering column widths or page orientation, you could spend considerable time and effort in rearranging objects
to fit the new layout. The Layout Adjustment feature can do much of that work automatically. For example, you
can quickly reformat a wide four-column document designed for an A4-size page to a tall two-column format on a
U.S. legal-size page. With Layout Adjustment, text and graphics frames are moved and resized as necessary based
on the new relative positions of column guides, page margins, and page edges.

Note:

Dragging column guides does not trigger layout adjustment.

The Layout Adjustment feature produces more predictable results when a layout is tightly based on a framework of
margins, page columns, and ruler guides, and where objects are snapped to guides. Results are less predictable
when objects don’t adhere to margins, columns, and guides, or when extraneous ruler and column guides clutter a
page. Layout adjustment is not affected by the document grid or the baseline grid.

Page designed vertically, for print (left); page orientation changed for on-screen viewing, with layout automatically refitted by the Layout
Adjustment feature (right)

You can modify the rules in the Layout Adjustment dialog box. The Layout Adjustment feature attempts to
approximate the proportions of the old layout in the new layout by doing the following:

Adding or removing column guides, if the new layout specifies a different number of columns.

If the page size changes, moving ruler guides to maintain proportional distances from page edges, margins,
or column guides.

Moving objects already aligned to any margin, column, bleed/slug, or ruler guide, or to any two guides
perpendicular to each other, so that the objects stay with those guides if the guides move during layout
adjustment. Also, objects already aligned to any page edge or to any page edges perpendicular to each other
are moved.

Proportionally resizing objects already aligned to two parallel margin, column, bleed/slug, or ruler guides or to



guides on three sides, so that the objects stay with those guides if the guides move during layout adjustment.
Also, objects aligned to two parallel page edges or to page edges on three sides are moved.

Maintain the relative position of objects that are anchored to the text as specified in the Anchored Object
Options dialog box.

Moving objects to keep them in the same relative position on the page, if the page size changes.

Note:

Layout Adjustment affects columns inside a text frame differently than it does page columns. If the frame itself is
resized by Layout Adjustment and the Fixed Column Width option is not selected in the Object > Text Frame
Options dialog box, text frame columns are resized proportionally. If the Fixed Column Width option is selected,
columns are added or removed as necessary.

Set options for layout adjustment

Note that changing options in the Layout Adjustment dialog box does not immediately change anything. Layout
adjustment is triggered only by changes to page size, page orientation, margins, or column settings, or when a
new master is applied. When you want to restore a layout to its previous state, you must undo the action that
triggered the layout adjustment.

1. Choose Layout > Layout Adjustment.

2. Select Enable Layout Adjustment.

3. Specify the layout adjustment options, and click OK.

Layout Adjustment options

Enable Layout Adjustment

Select this option so that layout adjustment will occur whenever you change page size, page orientation, margins,
or columns.

Snap Zone

Type a value to specify how near an object must be to the closest margin guide, column guide, or page edge to
snap to that element during layout adjustment.

Allow Graphics And Groups To Resize

Select this option to let the Layout Adjustment feature scale graphics, frames, and groups. When deselected,
graphics and groups can be moved by Layout Adjustment, but not resized.

Allow Ruler Guides To Move

Select this option when you want ruler guides to be repositioned by the Layout Adjustment feature.



Ignore Ruler Guide Alignments

Select this option when ruler guides are not well positioned for layout adjustment. Objects will still align to column
and margin guides and to page edges.

Ignore Object And Layer Locks

Select this option when you want the Layout Adjustment feature to reposition objects that are locked individually,
or locked as a result of being on a locked layer.

Adobe also recommends

Understanding paths and shapes
Use document templates
Draw a placeholder shape
Set frame fitting options
Use multiple page sizes
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Layout grids
Layout grid overview
Change layout grid settings
Placing an object in a layout grid
Document windows with layout grids

Layout grid overview

For workflow, editorial designers for magazines tend to use paper-based workflows with layout sheets. InDesign’s
layout grid functions in the same way as this type of paper-based layout. In addition, InDesign's Layout Grid
differs from paper-based layout in that you can modify font size, stroke width, page count and other elements as
necessary in order to create customized layouts.

You can set a character grid (character size) using the Layout Grid and also arrange the grid to fit horizontal text
going from left to right, and vertical text starting from the top right hand corner.

A 2 paragraph vertical layout grid (left) A 2 paragraph horizontal layout grid (right)

With the Layout Grid you can snap an object into position in the same way as with a Document Grid or Baseline
Grid.

When creating a new document, click Layout Grid in the New Document dialog box and you can specify layout
settings in the New Layout Grid dialog box displayed. You can change the layout grid of an existing document or
apply a layout grid to a document created using Margins and Columns.

The page margins are determined by the outer edges of the layout grid (left) An object placed in a grid (right)

Change layout grid settings

When changing layout grid settings, note the following:

To specify application default settings for a document with layout grid, choose Layout > Layout Grid without
opening any documents, and modify the settings. These settings will be applied to new documents created
thereafter. Altering the default settings on the layout grid will also cause the frame layout application default
settings to change accordingly.

Changing settings in the Layout Grid dialog box can affect settings in the Margins and Columns dialog box.
The opposite can also occur. For example, when you change the number of columns in the Layout Grid dialog



box, the new column setting will be reflected in the Margins and Columns settings. However, if the values for
Margins and Paragraphs is not divisible by the number of characters or lines designated in the Layout Grid,
gaps may appear in the Layout Grid or Column Margin Guide. To show no spaces around the layout grid,
open the Layout Grid dialog box, and click OK. The grid is adjusted as closely as possible to the character
grid border.

The Layout Grid option displayed in the Grid Format panel will be affected by the grid attributes from the
Layout Grid settings applied to the current page. If you apply several layout grids to one document, the
contents of Layout Grid settings will change according to the settings of the Layout Grid of the selected page.

Change layout grid settings

1. Do any of the following:

To change the layout grid settings for one spread or page, move to the spread you want to change or,
select the spread or page in the Page panel.

To change the layout grid settings for multiple pages, select the pages in the Page panel, or select the
master page that controls the pages you want to change.

Layout grid settings can be set on individual pages, thus one document may contain a number of
different layout grids.

2. Choose Layout > Layout Grid, and change the settings.

3. Click OK.

Layout Grid options

The following options appear when you choose Layout Grid in the New Document dialog box or when you choose
Layout > Layout Grid.

Direction

Select Horizontal for text to flow left to right horizontally, and Vertical for text to flow top to bottom vertically.

Font

Select font family and font style.The font selected will become the Frame Grid default setting. Furthermore, if the
grid is set as ICF in the Character Grid in Preferences, the grid size varies depending on the ICF of the font
selected. (See Customize layout and frame grids.)

Size

Specify the font size to be used as a base for the body text in the layout grid. This determines the size of
individual grid cells within the layout grid.

Vertical and Horizontal

Specify the transformation ratio as a percentage for the font defined in the grid. The size of the grid will alter
according to these settings.



Char Aki

Specify the letter spacing for the font defined in the grid. If a negative value is entered, the grids will appear
overlapping. When a positive value is set, a gap will appear between the grids.

Line Aki

Specify the line gap for the font defined in the grid. The grid line gaps will change according to the value entered.

With the exception of Direction, the values set for Font, Size, Horizontal, Vertical, Char Aki, Line Aki in the Grid
Attributes section will all become Frame Grid default settings. (See Create frame grids.)

Characters

Sets a Line Character (Grid) count.

Lines

Specifies the number of lines in 1 column.

Columns

Specifies the number of columns in 1 page.

Gutter

Specifies the distance between columns.

A. Columns B. Gutters 

Starting Point

Select the Starting Point option from the pop-up menu, and select the Top, Bottom, Right (or Outside) and Left (or
Inside) margins in each text box. The grid will be arranged from the selected position options according to the
values set in Grid Attributes and Lines and Columns. Any space left on the other side of the Starting Point becomes
the margin. For this reason, it is not possible to enter values into the text box outside the points forming the Grid
Base starting points. The margin opposite the starting point can be modified by changing the Grid Attributes and
Lines and Columns options values. When you select Center Completely and add a line or character, a layout grid
with the number of characters or lines set will be created from the center.

Inside is specified as the inside of the facing page, but when no facing page is specified, Inside is the left hand
side. Similarly, Outside is specified as the outside of the facing page, but when no facing page is designated,
Outside is the right hand side.  

Note:

If the values you specify for columns and gutters are such that the layout grid is larger than the page size, the
values for characters, gutters, and columns will be adjusted so that it fits on the page. To change the settings,
choose Layout > Layout Grid after creating a new document, and specify different values.
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A. Top/Outside starting point (right page) B. Center Horizontally starting point C. Bottom/Outside starting point (right page) D. Center
Completely starting point 

Show or hide the layout grid

Choose View > Grids & Guides > Show Layout Grid or View > Grids & Guides > Hide Layout Grid.

If you hide the Layout Grid, the appearance will be the same as a document created in the Margins and
Columns option. Each margin will be determined by values in the Starting Point settings.

Placing an object in a layout grid

Place the text, graphic, or sample text after setting the layout grid. Keep the following guidelines in mind when you
are designing pages for a layout grid:

You can place text frames, frame grids, and graphic frames in a document. You can also place text or
graphics in placeholder frames. For more information, see About paths and frames and Create text frames.

You cannot enter text directly in a layout grid. Use the Horizontal Grid tool  or Vertical Grid tool   to
create a frame grid and enter text. When Layout Grid is selected in the grid format panel, frame grids
created will use the character and spacing attributes of the layout grid. See Create frame grids.

When you drag an object in a layout grid, the object corner closest to the grid will snap to one of the four
corners of the grid. See Snapping objects to grids.

Document windows with layout grids

Each document or spread has a Pasteboard and Guide. This is displayed in Normal View mode. (To switch to
normal view, click Normal View Mode  in the Tools panel). When the document is displayed in any preview mode,
the Paste Board will be replaced by a gray background. You can alter the color of the preview background and
guide.

In a document window, structural areas of a page are marked by the following default colors:

Black lines describe the size of each page in a spread. A thin drop shadow helps distinguish a spread from its



pasteboard. You can’t change the color of these lines.

Magenta lines are margin guides.

Violet lines are column guides.

The green box and lines are the layout grid.

The red line around the edge of the page shows the bleed area.

The blue line around the page shows the slug area.

Lines of different colors are the ruler guides. Ruler guides will be displayed in the color of the selected layer.

Column guides appear in front of margin guides. When a column guide is exactly in front of a margin guide,
it hides the margin guide.

Adobe also recommends

Create new documents
Create frame grids
Customize layout and frame grids
Change the grid display
CJK composition
Assign a layer color
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Managing graphics links
About links and embedded graphics
Links panel overview
Embed an image within the document
Update, restore, and replace links
Edit original artwork

About links and embedded graphics

When you place a graphic, you see a screen-resolution version of the file in the layout so that you can view and
position it. However, the actual graphic file may be either linked or embedded.

Linked artwork is connected to, but remains independent of, the document, resulting in a smaller document.
You can modify linked artwork using transformation tools and effects; however, you cannot select and edit
individual components in the artwork. You can use the linked graphic many times without significantly
increasing the size of the document; you can also update all links at once. When you export or print, the
original graphic is retrieved, creating the final output from the full resolution of the originals.

Embedded artwork is copied into the document at full resolution, resulting in a larger document. You can
control versions and update the file whenever you like; as long as the artwork is embedded, your document is
self-sufficient.

To determine if artwork is linked or embedded, or change its status from one to the other, use the Links panel.

If the bitmap image you place is 48K or smaller, InDesign automatically embeds the full-resolution image instead
of the screen-resolution version in your layout. InDesign displays these images in the Links panel, so that you can
control versions and update the file whenever you like; however, the link is not necessary for optimal output.

Note:

If you move a document to another folder or disk (for example, if you take it to a service provider), be sure that
you also move the linked graphics files; they are not stored inside the document. You can copy all related files
automatically, using the Preflight and Package features.

Links panel overview

All files placed in a document are listed in the Links panel. These include both local (on disk) files and assets that
are managed on a server. However, files that are pasted from a website in Internet Explorer do not display in this
panel.

In InCopy, the Links panel also displays linked stories. When you select a linked story in the Links panel, the Link



Info section displays information such as the number of notes, the managed status, and the status of tracked
changes.

Links panel

A. Category columns B. Show/Hide Link Information C. One or more instances modified icon D. Modified icon E. Missing-link icon F.
Embedded-link icon 

When the same graphic appears several times in the document, the links are combined under a disclosure triangle
in the Links panel. When a linked EPS graphic or InDesign document contains links, the links are also combined
under a disclosure triangle.

A linked file can appear in the Links panel in any of the following ways:

Up to Date

An up-to-date file is blank in the Status column.

Modified

This icon means that the version of the file on disk is more recent than the version in your document. For example,
this icon appears if you import a Photoshop graphic into InDesign, and then you or someone else edits and saves
the original graphic in Photoshop.

A slightly different version of the Modified icon appears when a graphic is modified and one or more instances are
updated while others are not.

Missing

The graphic is no longer in the location from which it was imported, although it may still exist somewhere. Missing
links can happen if someone deletes the original file or moves it to a different folder or server after it’s been
imported. You can’t know whether a missing file is up to date until its original is located. If you print or export a
document when this icon is displayed, the file may not print or export at full resolution.

Embedded

Embedding the contents of a linked file suspends management operations for that link. If the selected link is
currently in an “edit in place” operation, this option is not enabled. Unembedding the file restores management
operations to the link.

If a linked object does not appear on a specific document page, the following codes indicate where the object
appears: PB (pasteboard), MP (master page), OV (overset text), and HT (hidden text).

For a video tutorial on using the Links panel, see www.adobe.com/go/lrvid4027_id.

InDesign Secrets provides a videocast on Links panel tips and techniques at Saving time with the Links panel.

Use the Links panel

http://www.adobe.com/go/lrvid4027_id
http://indesignsecrets.com/indesignsecrets-videocast-2-saving-time-with-the-links-panel.php


To display the Links panel, choose Window > Links. Each linked file and automatically embedded file is
identified by name.
To select and view a linked graphic, select a link in the Links panel and then click the Go To Link button ,
click the page number of the link in the Page column, or choose Go To Link in the Links panel menu.
InDesign centers the display around the selected graphic. To view a hidden object, you show the layer (or
condition if it’s an anchored object).
To expand or collapse nested links, click the triangle icon to the left of the link. Nested links occur when the
same graphic appears several times in the document or when the linked EPS graphic or InDesign document
contains links.
To sort links in the panel, click the category title at the top of the Links panel to sort by that category. Click
the same category again to reverse the order. For example, if you click the Page category, the links appear in
their order from the first page to the last page. If you click Page again, the links are sorted from last page to
first. Use Panel Options to add columns to the Links panel.

Work with Links panel columns

You can display additional categories, such as Creation Date and Layer, in the Links panel to display more
information about the graphics. For each category, you can determine whether the information appears as a
column in the Links panel and in the Link Info section at the bottom of the Links panel.

1. Choose Panel Options from the Links panel menu.
2. Select the check boxes under Show Column to add columns in the Links panel.

Folder 0 is the folder that contains the linked file; Folder 1 is the folder that contains Folder 0, and so on.

3. Select the check boxes under Show In Link Info to display the information in the Link Info section at the
bottom of the Links panel.

4. Click OK.

You can change the order of columns by selecting a column and dragging it to a different location. Drag the
column boundaries to change the column width. Click a category title to sort the links by that category in
ascending order. Click again to sort in descending order.

Change the Links panel rows and thumbnails

1. Choose Panel Options from the Links panel menu.
2. For Row Size, select Small Rows, Regular Rows, or Large Rows.
3. For Thumbnails, determine whether thumbnail representations of the graphics appear in the Name column

and in the Link Info section at the bottom of the Links panel.
4. Click OK.

Display link information

The Link Info section of the Links panel lists information about the selected linked file.

To change the information displayed in the Link Info section of the Links panel, choose Panel Options from the
Links panel menu, and select check boxes in the Show In Link Info column.

Double-click a link, or select a link and click the Show/Hide Link Information icon, which is a triangle on the
left side of the panel.
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View metadata via the Links panel

If a linked or embedded file contains metadata, you can view the metadata using the Links panel. You cannot edit
or replace metadata associated with a linked file.

Select a file in the Links panel and choose Utilities > XMP File Info from the panel menu.

Embed an image within the document

Rather than link to a file that you’ve placed in a document, you can embed (or store) the file within the document.
When you embed a file, you break the link to the original. Without the link, the Links panel doesn’t alert you when
the original has changed, and you cannot update the file automatically.

Embedding a file increases the document file size.

Embed a linked file

1. Select a file in the Links panel.
2. Do any of the following:

Choose Embed Link in the Links panel menu.

If there are multiple instances of the file, choose Embed All Instances Of [Filename] in the Links panel
menu. To embed only one instance, select it and choose Embed Link.

The file remains in the Links panel marked with the embedded-link icon .

Note:

For a text file that appears in the Links panel, select Unlink in the Links panel menu. When you embed a text file,
its name is removed from the Links panel.

Unembed a linked file

1. Select one or more embedded files in the Links panel.
2. Do one of the following:

Select Unembed Link in the Links panel menu. If there are multiple instances of the file, choose
Unembed All Instances Of [Filename] in the Links panel menu.

Click the Relink button  or select Relink in the Links panel menu.

3. Choose to link the file to the original file or to a folder InDesign creates from the embedded data stored in
the document.

Update, restore, and replace links



Use the Links panel to check the status of any link, or to replace files with updated or alternate files.

When you update or reestablish (relink) a link to a file, any transformations performed in InDesign are preserved
(if you choose Relink Preserved Dimensions in the File Handling preferences). For example, if you import a square
graphic and rotate it 30°, and then you relink it to an unrotated graphic, InDesign rotates it 30° to match the
layout of the graphic it’s replacing.

Note:

Placed EPS files may contain OPI links, which appear in the Links panel. Don’t relink OPI links to files other than
those originally intended by the creator of the EPS file; doing so can cause problems with font downloading and
color separations.

Choose how relinked graphics are scaled

When you relink to replace one graphic with a different source file, you can keep the image dimensions of the file
that’s being replaced, or you can display the incoming file in its actual dimensions.

1. Choose Edit > Preferences > File Handling (Windows) or InDesign > Preferences > File Handling (Mac OS).

2. Choose Preserve Image Dimensions When Relinking if you want images to appear at the same size as the
images they’re replacing. Deselect this option to have relinked images appear at their actual size.

Update modified links

InDesign first looks for a missing link in the folder in which another file has been relinked in the current session.
Next, it looks for a link in the same folder where the document is located. If it’s still not found, it looks in the
parent folder of the document.

Modified links are also called “out of date” links.

In the Links panel, do one of the following:

To update specific links, select one or more links marked with the modified-link icon . Then click the
Update Link button , or choose Update Link from the Links panel menu.

To update all modified links, choose Update All Links from the Links panel menu, or select a modified
link and Alt-click (Windows) or Option-click (Mac OS) the Update Link button.

To update only one link to a graphic that appears in several places in the document, select only the
sublink and choose Update Link. If you select the “parent” link, you can update all links to the modified
graphic.

Replace a link with a different source file

1. Select any link in the Links panel, and click the Relink button  or choose Relink from the Links panel
menu. If a “parent” link of multiple instances is selected, choose Relink All Instances Of [Filename] from the
Links panel menu.

Relink is disabled in managed stories unless a story is checked out.

2. In the dialog box that appears, select Search For Missing Links In This Folder if you want InDesign to search



the folder for files that have the same names as other missing linked files. If this option is not selected, only
the selected image is relinked.

3. Choose Show Import Options to control how the new source file is imported.
4. Locate and double-click the new source file.
5. Choose import options if you clicked the Show Import options option. (See Import options for graphics.)

Restore missing links

1. To restore a missing link, select any link marked with the missing link icon  in the Links panel, and click the
Relink button .

2. In the dialog box that appears, select Search For Missing Links In This Folder to relink any missing file that
appears in the specified folder. Locate and double-click a file.

Find missing links

By default, InDesign checks for missing links and tries to resolve them when you open a document. Two
preference options let InDesign check for and find missing links automatically when you open a document.

Check Links Before Opening Document

If you turn off this option, InDesign opens the document immediately, and the link statuses remain pending until
links are determined to be up-to-date, missing, or modified. If you turn on this option, InDesign checks for
modified or missing links.

Find Missing Links Before Opening Document

If you turn off this option, InDesign does not attempt to resolve the missing links. You may want to turn off this
option if links slow performance to a server or if unexpected linkings occur. This option is dimmed if Check Links
Before Opening Document is turned off.

Search For Missing Links

Use the Search For Missing Links command to search for and resolve missing links in your document. This
command is useful if you turned off the preferences option that checks for missing links when you open a
document, and now you have missing links. This command is also useful if you mount a server where images are
stored after opening a document.

To change link settings, open the File Handling section of the Preferences dialog box, and determine whether
the Check Links Before Opening Document and Find Missing Links Before Opening Document options are
selected.
To let InDesign attempt to resolve missing links, choose Utilities > Search For Missing Links from the Links
panel menu.

This command is dimmed if the document contains no missing links.

Specify a default Relink folder

1. In the Preferences dialog box, select File Handling.



2. From the Default Relink Folder menu, choose either of the following options, and then click OK:

Most Recent Relink Folder

This option displays the most recently used folder you selected when relinking, matching InDesign CS3
behavior.

Original Link Folder

This option displays the original location of the linked file, matching the behavior of InDesign CS2 and earlier.

Copy links to a different folder

Use the Copy Link(s) To command to copy graphics files to a different folder and redirect the links to the copied
files. This command is especially useful for moving files to a different drive, such as moving files from a DVD to a
hard drive.

1. Select the links to the files you want to copy, and choose Utilities > Copy Link(s) To from the Links panel
menu.

2. Specify the folder where the linked files will be copied and choose Select (Windows) or Choose (Mac OS).

Relink to a different folder

When you use the Relink To Folder command, you can point to a folder that contains files with the same names as
your out-of-date links. For example, if your current links point to low-resolution images, you can specify a different
folder that contains high-resolution images. You can specify a different extension for the files, allowing you to
change links from .jpg to .tiff, for example.

The Relink To Folder command is dimmed in a managed InCopy story unless the story is checked out.

1. Select one or more links in the Links panel.
2. Choose Relink To Folder from the Links panel menu.
3. Specify the location of the new folder.
4. To use a different extension, select Match Same Filename But This Extension, and specify the new extension

(such as AI, TIFF, or PSD).
5. Click Select (Windows) or Choose (Mac OS).

Relink files with different file extensions

The Relink File Extension command lets you replace images based on file extensions. For example, if you have
several JPEG images in your document, you can replace them with PSD files. The files with different extensions
must be in the same folder as the linked files being replaced.

1. Make sure the files with different file extensions appear in the same folder as the original files.
2. Select one or more links in the Links panel.
3. Choose Relink File Extensions from the Links panel menu.
4. Specify the file extension to replace the selected files, and click Relink.
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Replace an imported file using the Place command

1. Do one of the following:

To replace the contents of a graphics frame, such as an imported graphic, use the Selection tool  to
select the frame.

To replace the contents of a graphics frame, such as an imported graphic, use the Position tool to
select the image.

To replace the contents of a text frame, use the Type tool to click an insertion point in a text frame,
and choose Edit > Select All.

2. Choose File > Place.
3. Locate and select the new file.
4. Make sure that Replace Selected Item is selected, and then click Open.
5. Click Open.

Copy the link pathname

You can copy either the full path of the linked image or the platform style path. Copying the full path of the image
is useful for notifying team members where art is located. For example, you can copy the full path and paste it into
an email message. Copying the platform path is useful for scripting or for specifying image fields in a data merge.

1. Select a link in the Links panel.
2. From the Links panel menu, choose Copy Info > Copy Full Path or Copy Platform Style Path.
3. Paste the path.

Edit original artwork

The Edit Original command lets you open most graphics in the application in which you created them so that you
can modify them as necessary. Once you save the original file, the document in which you linked it is updated with
the new version.

Note:

In InDesign, if you check out and select a managed graphics frame (one that has been exported to InCopy), rather
than the graphic itself, the graphic opens in InCopy.

Edit original artwork using the default application

By default, InDesign relies on the operating system to determine which application is used when opening the
original.

1. Select one or more images on the page or in the Links panel.
2. Do any of the following:

In the Links panel, click the Edit Original button .



Choose Edit > Edit Original.

3. After making changes in the original application, save the file.

Edit original artwork using a different application

1. Select the image.
2. Choose Edit > Edit With, and then specify the application you want to use to open the file. If the application

does not appear, choose Other, and browse to locate the application.

Adobe also recommends

Define preflight profiles
Package files
Links panel video
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Managing pages and spreads
Move, duplicate, and delete pages and spreads

Control spread pagination
Rotate the spread view
Use multiple page sizes

Move, duplicate, and delete pages and spreads

You can use the Pages panel to freely arrange, duplicate, and recombine pages and spreads. Keep the following
guidelines in mind when adding, arranging, duplicating, or removing pages within a document:

InDesign preserves the threads between text frames.

InDesign redistributes pages according to how the Allow Document Pages To Shuffle command is set.

An object that spans multiple pages stays with the page on which the object’s bounding box covers the most
area.

Move pages using Move Pages command

1. Choose Layout > Pages > Move Pages, or choose Move Pages from the Pages panel menu.
2. Specify the page or pages you want to move.
3. For Destination, choose where you want to move the pages, and specify a page if necessary. Click OK.

Move pages by dragging

As you drag, the vertical bar indicates where the page will appear when you drop it. If the black rectangle or
bar touches a spread when Allow Pages to Shuffle is turned off, the page you’re dragging will extend that
spread; otherwise, document pages will be redistributed to match the Facing Pages setting in the File >
Document Setup dialog box.

In the Pages panel, drag a page icon to a new position within the document.

Moving a page’s position using the Pages panel

Duplicate a page or spread

In the Pages panel, do one of the following:



Drag the page range numbers under a spread to the New Page button. The new spread appears at the
end of the document.

Select a page or spread, and then choose Duplicate Page or Duplicate Spread in the Pages panel menu.
The new page or spread appears at the end of the document.

Press Alt (Windows) or Option (Mac OS) as you drag the page icon or page range numbers under a
spread to a new location.

Note:

Duplicating a page or spread also duplicates all objects on the page or spread. Text threads from the duplicated
spread to other spreads are broken, but all text threads within the duplicated spread remain intact—as do all text
threads on the original spread.

Remove a page from a spread while keeping it in the document

1. Select the spread and deselect Allow Selected Spread To Shuffle in the Pages panel menu.
2. In the Pages panel, drag a page out of the spread until the vertical bar is not touching any other pages.

Delete a page or spread from the document

Do one of the following:

In the Pages panel, drag one or more page icons or page-range numbers to the Delete icon.

Select one or more page icons in the Pages panel, and click the Delete icon.

Select one or more page icons in the Pages panel, and then choose Delete Page(s) or Delete Spread(s)
in the Pages panel menu.

When you move or copy a page or spread from one document to another, all of the items on the page or spread,
including graphics, links, and text, are copied to the new document. Section markers are preserved. Threaded text
frames are also included, but text that is threaded to pages outside the spread does not transfer. If the page or
spread you are copying contains styles, layers, or masters with the same names as their counterparts in the
destination document, the destination document’s settings are applied to the page or spread.

If you copy a page from a document that has a different size than the document you are copying to, the page and
page item positions may not match exactly.

If you want to move or copy a multiple-page spread, deselect Allow Document Pages To Shuffle in the destination
document to keep the spread together.

Move or copy pages between documents

1. To move pages from one document to another, open both documents.
2. Choose Layout > Pages > Move Pages, or choose Move Pages from the Pages panel menu.
3. Specify the page or pages you want to move.
4. Choose the destination document name from the Move To menu.
5. For Destination, choose where you want to move the pages, and specify a page if necessary.
6. If you want to remove the pages from the original document, select Delete Pages After Moving.

Note:
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When you copy pages between documents, their associated masters are copied automatically. If the new
document contains a master with the same name as the master applied to the copied page, however, the master
of the new document is applied to the copied page instead.

Move or copy pages between documents by dragging

1. To move pages from one document to another, make sure that both documents are open and visible.

You can choose Window > Arrange > Tile to display documents side-by-side.

2. Drag the original document’s page icon to the new document.
3. In the Insert Pages dialog box, specify where the pages will be added.
4. If you want to remove the pages from the original document, select Delete Pages After Inserting.

Control spread pagination

Most documents use two-page spreads exclusively. When you add or remove pages before a spread, the pages
shuffle by default. However, you may want to keep certain pages in a spread together. For example, you can
create gatefold or accordion foldouts by creating a multiple-page spread (also called an island spread) and adding
pages to it. By not allowing pages to shuffle, you can ensure that pages are kept in the same spread.

Pages panel

A. One-page spread B. Four-page spread, identified by brackets around page numbers C. Entire two-page spread selected 

Create a multiple-page spread

1. Do one of the following:

To keep a single spread together, select a spread in the Pages panel, and then deselect Allow Selected
Spread To Shuffle in the Pages panel menu. You can identify an island spread in the Pages panel by the
brackets around its page numbers.

To allow the creation of spreads of more than two pages in the entire document and to preserve those
spreads when you add, remove, or arrange preceding pages, deselect Allow Document Pages To Shuffle
on the Pages panel menu. InDesign will preserve spreads of more than two pages while letting two-
page spreads repaginate normally.

2. Add pages to the selected spread either by using Insert Pages to insert a new page in the middle of a spread
or by dragging an existing page to the spread in the Pages panel. To drag an entire spread, drag its page
numbers.

Adding a page to a spread using the Pages panel

Note:

You can include up to ten pages in a spread. When you have reached the limit, the black vertical bar will not
appear.
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Redistribute pages

You can redistribute a spread’s pages to match the Facing Pages setting in the File > Document Setupdialog box.

Do either of the following:

If an individual spread has been allowed to shuffle, select the spread, and choose Allow Selected
Spread To Shuffle in the Pages panel menu to select it.

If document pages have been allowed to shuffle and you added pages to a spread, choose Allow
Document Pages To Shuffle from the Pages panel menu to select it. Click No to redistribute pages. If
you click Yes to maintain the multiple-page spreads, brackets surround the numbers on those spreads
in the Pages panel, indicating that those spreads are not allowed to shuffle.

Start a document with a two-page spread

Instead of beginning the document with a single page, you can begin your document with a two-page spread.

1. Do either of the following actions:

To create a document, choose File > New Document.

To edit an existing document, choose File > Document Setup.

2. For Start Page #, specify an even number, such as 2, and then click OK.

Rotate the spread view

In some instances, you need to edit rotated content. Instead of turning your head sideways to look at the rotated
content, you can rotate the spread view. This option is especially useful for working on rotated calendars and
tables.

Rotating the spread view does not affect printing or output.

Rotating the spread

A. Before rotating spread B. Rotated spread view C. Rotate icon in Pages panel 

1. In the Pages panel, select the page or spread that you want to rotate.

2. Do any of the following:

From the Pages panel menu, choose Rotate Spread View > 90° CW, 90° CCW, or 180°.

Choose View > Rotate Spread > 90° CW, 90° CCW, or 180°.

A rotation icon  appears next to the rotated spread in the Pages panel.

Objects you place or create mirror the rotated view. For example, if you create a text frame when the spread view
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is rotated 90 degrees, the text frame is also rotated. However, objects you paste are not rotated.

When transforming objects, keep in mind that you’re working on a rotated page view. For example, if you’re
editing a table on a rotated spread view, changing the “left” side of the table will change what appears to be the
top of the table in the rotated view.

Before you output the file or send it to someone else, it’s a good idea to avoid confusion by clearing the spread
rotation. Choose View > Rotate Spread > Clear Rotation.

Use multiple page sizes

You can define different page sizes for pages within a single document. This feature is especially useful when you
want to manage related designs in one file. For example, you can include business card, postcard, letterhead, and
envelope pages in the same document. Using multiple page sizes is also useful for creating gate-fold layouts in
magazines.

For video tutorials on creating multiple page sizes in a document, see www.adobe.com/go/lrvid5153_id_en and
http://tv.adobe.com/go/4950/.

Multiple page sizes in same document

A. Magazine page B. Gate-fold page C. Spine page 

Create different page sizes within a document

Use the Page tool to select the master page or layout page you want to resize, and then use the Control panel to
change the settings. A page inherits its page size from its master page, but you can change the size of a layout
page so that it’s different from the master page applied to it. A master page can be based on another master page
of a different size, so that a range of pages of mixed sizes can share the same master content.

To apply a different page size quickly, select the page in the Pages panel, and then choose a page size from the
Edit Page Size button .

1. Using the Page tool , select one or more master pages or layout pages that you want to resize.

Make sure that the entire page is selected in the layout, not only in the Pages panel.

2. Specify settings in the Control panel to change the page size of the selected pages:

X and Y values

Change the Y value to determine the vertical position of the page in relation to other pages in the spread.

W and H page size values

Change the width and height of the selected pages. You can also specify a page size preset from the menu.
To create a custom page size that appears in this list, choose Custom Page Size from the menu, specify the
page size settings, and click OK.

http://www.adobe.com/go/lrvid5153_id_en
http://tv.adobe.com/go/4950/


Orientation

Select a landscape or portrait page orientation.

Enable Layout Adjustment

Select this option if you want the objects on the page to be adjusted automatically when the page size
changes. See About automatic layout adjustment.

Show Master Page Overlay

Select this option to display a master page overlay on top of any page that is selected with the Page tool.

Objects Move With Page

Select this option to make the objects move along with the page when you adjust the X and Y values.

Use master page overlays

When you use the Page tool to select a page and turn on the Show Master Page Overlay option, a shaded box
appears over the selected page. You can move the master page overlay so that master page items appear in the
proper location. The Show Master Page Overlay option is especially useful if the master page and document page
have different page sizes.

Aligning the master page overlay to a smaller layout page

1. Using the Page tool, select a page.

2. In the Control panel, select Show Master Page Overlay.

3. Drag the edge of the master page overlay to position the page items.
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Gabarits

Haut de la page

A propos des gabarits, de l’ordre de superposition et des calques
Création de gabarits
Application de gabarits
Copie des gabarits
Suppression d’un gabarit d’un document
Remplacement ou dissociation d’éléments types
Importation d’un gabarit à partir d’un autre document

Pour plus d’informations et d’instructions, cliquez sur les liens ci-dessous.

A propos des gabarits, de l’ordre de superposition et des calques

Un gabarit s’apparente à un arrière-plan, rapidement applicable à plusieurs pages. Les objets d’un gabarit
apparaissent sur toutes les pages auxquelles vous appliquez le gabarit. Les éléments types qui apparaissent
sur les pages de document sont entourés d’une bordure en pointillé. Les modifications apportées au gabarit
sont automatiquement appliquées aux pages associées. Les gabarits contiennent en général des logos, des
numéros de page, des en-têtes et des pieds de page qui se répètent. Elles contiennent également des blocs
de texte ou graphiques vides servant de balises d’emplacement dans les pages de document. Un élément de
gabarit ne peut pas être sélectionné sur une page de document à moins que l’élément de gabarit ne soit
remplacé.

Les gabarits peuvent contenir plusieurs calques, comme les pages de votre document. Les objets à calque
unique ont leur propre ordre de superposition sur leur calque. Les objets d’un calque de gabarit apparaissent
derrière les objets de page du même calque.

Pour afficher un élément type devant les objets d’une page de document, il convient de le placer sur un
calque supérieur du gabarit. Un élément type sur un calque supérieur apparaît devant tous les objets des
calques inférieurs. La fusion de tous les calques déplace les éléments de gabarit derrière les objets de page
du document.

Les éléments types (en haut, à gauche) apparaissent derrière les objets de page du même calque (en bas, à
gauche) ; le déplacement d’un élément type vers un calque supérieur (en haut, à droite) le place devant tous
les objets des calques inférieurs (en bas, à droite).

Conseils et astuces concernant les gabarits

Comparez différents concepts en créant une série de gabarits, puis en les appliquant tour
à tour à des pages témoins représentatives d’un contenu type.

Pour une mise en page rapide des documents, vous pouvez enregistrer un ensemble de
gabarits dans un modèle de document, avec les styles de paragraphes et de caractères,
les bibliothèques de couleurs et autres styles et paramètres prédéfinis.

Si vous modifiez les paramètres de marge ou de colonne sur un gabarit, ou que vous
appliquez un nouveau gabarit avec des paramètres de marge ou de colonne différents,
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vous pouvez forcer les objets sur la page à adopter la nouvelle mise en page
automatiquement (voir Rectification automatique de la mise en page).

Les numéros de pages automatiquement insérés sur un gabarit affichent le numéro de
page correct pour chaque section du document à laquelle le gabarit est appliqué (voir
Numérotation de base des pages).

Création de gabarits

Par défaut, tous les documents créés possèdent un gabarit. Vous pouvez créer des gabarits supplémentaires
de toutes pièces ou à partir d’un gabarit ou d’une page de document existants. Une fois les gabarits
appliqués aux autres pages, les modifications apportées au gabarit source sont appliquées aux gabarits et
aux pages de document associés. En planifiant soigneusement vos documents, vous pouvez apporter
rapidement des modifications de mise en page à plusieurs pages dans le document.

Création d’un gabarit

1. Sélectionnez Nouveau gabarit dans le menu du panneau Pages.

2. Spécifiez les options suivantes, puis cliquez sur OK :

Dans la zone Préfixe, entrez un préfixe limité à quatre caractères, identifiant le
gabarit appliqué à chacune des pages présentes dans le panneau Pages. Vous
pouvez saisir jusqu’à quatre caractères.

Dans le champ Nom, entrez le nom de la planche type.

Dans la zone D’après le gabarit, choisissez une planche existante sur laquelle vous
voulez baser la planche ou choisissez l’option Aucun.

Dans la zone Nombre de pages, entrez le nombre de pages souhaité dans la
planche type (jusqu’à 10).

Création d’un gabarit à partir d’une page ou d’une planche existante

Faites glisser une planche entière de la section Pages du panneau Pages vers la section
Gabarits.
Sélectionnez une planche dans le panneau Pages, puis choisissez Enregistrer comme
gabarit dans le menu de ce panneau.

Le nouveau gabarit récupère tous les objets de la page ou planche d’origine. Si la page d’origine utilisait un
gabarit, le nouveau gabarit repose sur ce gabarit.

Création d’un nouveau gabarit d’après une autre page ou un autre gabarit

Création d’un gabarit à partir d’un autre

Vous pouvez créer un gabarit basé et mis à jour d’après un autre gabarit (appelé gabarit parent), à l’intérieur
d’un même document. Les planches gabarits reposant sur la page parent sont appelées gabarits enfants. Si,
par exemple, votre document compte dix chapitres auxquels sont appliquées des gabarits légèrement
différents, il est préférable de tous les baser sur une planche type présentant la maquette et les objets
communs à tous ces chapitres. Ainsi, la rectification du schéma de base nécessite de retoucher la planche

http://idiom-q-win-1/fr/indesign/using/laying-out-frames-pages.html#about_automatic_layout_adjustment
http://idiom-q-win-1/fr/indesign/using/layout-design-9.html
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parent et non plus les dix gabarits séparément. Changez la mise en forme des gabarits enfants. Vous pouvez
remplacer des éléments de gabarit parent sur un gabarit enfant pour créer des variantes de gabarit, tout
comme vous pouvez substituer des éléments types à partir des pages du document Il s’agit d’un moyen
efficace de mettre à jour une maquette de façon homogène et diversifiée à la fois.

Gabarits parent et enfant d’origine (à gauche) ; lorsque le gabarit parent est modifié, les gabarits enfants sont
mis à jour automatiquement (à droite)

Pour baser un gabarit sur un autre, dans la section Gabarits du panneau Pages, utilisez
l’une des méthodes suivantes :

Sélectionnez une planche type, puis choisissez Options de page type pour [nom de la
planche type] dans le menu du panneau Pages. Dans le menu D’après la page type,
choisissez une autre page type, puis cliquez sur le bouton OK.

Sélectionnez le nom de la planche type et faites-le glisser sur le nom d’une autre
planche type.

B-Gabarit basé sur le modèle A-Gabarit

Modification de la mise en page d’un gabarit

Vous pouvez modifier la mise en page des gabarits à tout moment ; les modifications apportées apparaissent
automatiquement sur toutes les pages créées d’après ce gabarit. Par exemple, tout texte ou graphique que
vous ajoutez à un gabarit apparaîtra sur les pages de document auxquelles le gabarit sera appliqué.

lorsque vous remplacez ou dissociez un objet de son gabarit, l’objet risque de ne pas être mis à
jour avec les modifications apportées au gabarit.

1. Cliquez deux fois sur l’icône du gabarit à modifier dans le panneau Pages ou
sélectionnez le gabarit dans la zone de liste, au bas de la fenêtre de document. La
planche type apparaît dans la fenêtre de document.

2. Effectuez les modifications appropriées.

InDesign met à jour automatiquement les pages utilisant ce gabarit.

Pour modifier le format d’un gabarit, sélectionnez ce dernier à l’aide de l’outil Page, puis modifiez les
dimensions à l’aide des options du panneau Contrôle (voir Utilisation de plusieurs formats de page).

Observez les résultats des modifications dans plusieurs vues. Choisissez la commande Fenêtre >
Disposition > Nouvelle fenêtre, puis Fenêtre > Disposition > Mosaïque. Affichez une page dans une vue et
le gabarit qui lui a été appliqué dans une autre. Modifiez ensuite le gabarit et visualisez la page mise à
jour.

Modification des options de gabarit

Vous pouvez modifier les options du gabarit pour attribuer un nouveau nom ou préfixe, baser le gabarit sur
un autre gabarit ou changer le nombre de pages dans la planche type.

1. Dans le panneau Pages, cliquez sur le nom de la planche type pour la sélectionner.

2. Dans le menu du panneau Pages, sélectionnez Options de gabarit pour [nom du gabarit].

http://idiom-q-win-1/fr/indesign/using/pages-spreads.html#use_multiple_page_sizes
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Remarque :

3. Modifiez des options, si nécessaire, puis cliquez sur le bouton OK.

Application de gabarits

Si votre document contient des planches personnalisées (par exemple, un dépliant de 3 ou 4 pages dans un
magazine), tout gabarit appliqué doit contenir le même nombre de pages.

Si le format de page du gabarit est différent, son application entraîne la modification de la page de mise en
page. Si la page de mise en page se présente dans un format personnalisé, vous pouvez préciser si vous
voulez conserver son format ou appliquer celui du gabarit.

les éléments types d’une page de document présentent une bordure en pointillé. Si vous ne
pouvez pas voir les éléments types sur une page de document, il se peut que l’élément type soit masqué sur
un calque inférieur ou que les éléments types soient masqués. Choisissez Afficher les éléments types dans le
menu du panneau Pages.

Pour appliquer un gabarit à la page ou planche d’un document

Pour appliquer un gabarit à une page, faites glisser l’icône du gabarit sur l’icône de la
page dans le panneau Pages. Lorsqu’un rectangle noir délimite la page cible, relâchez le
bouton de la souris.
Pour appliquer un gabarit à une planche, faites glisser l’icône du gabarit sur un coin de la
planche dans le panneau Pages. Lorsqu’un rectangle noir délimite toutes les pages de la
planche, relâchez le bouton de la souris.

Application d’un gabarit à une page (à gauche) et à une planche (à droite)

Pour appliquer un gabarit à plusieurs pages

Utilisez l’une des méthodes suivantes :

Dans le panneau Pages, sélectionnez les pages auxquelles vous voulez appliquer un
nouveau gabarit. Maintenez la touche Alt (Windows) ou Option (Mac OS) enfoncée
tout en cliquant sur un gabarit.

Choisissez la commande Appliquer un gabarit aux pages dans le menu du panneau
Pages, sélectionnez un gabarit pour l’option Appliquer un gabarit, assurez-vous que
l’étendue de pages du menu Aux pages est correcte, puis cliquez sur le bouton OK.
Vous pouvez appliquer un gabarit à plusieurs pages en même temps. Par exemple,
vous pouvez entrer 5, 7-9, 13-16 pour appliquer le même gabarit aux pages 5,
7 à 9 et 13 à 16 (voir Pour afficher une numérotation absolue ou par section dans le
panneau Pages).

Application d’un gabarit à une étendue de pages discontinues

Pour dissocier des gabarits de pages de document

http://idiom-q-win-1/fr/indesign/using/numbering-pages-chapters-sections.html#display_absolute_or_section_numbering_in_the_pages_panel
http://idiom-q-win-1/fr/indesign/using/numbering-pages-chapters-sections.html#display_absolute_or_section_numbering_in_the_pages_panel
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Haut de la page

Appliquez le gabarit Aucun de la section Gabarits du panneau Pages.

Lorsque vous dissociez un gabarit d’une page, sa mise en page et ses éléments ne
s’appliquent plus à cette page. Si un gabarit contient la plupart des éléments dont vous
avez besoin, mais que vous voulez modifier l’aspect de certaines pages, vous pouvez
remplacer les éléments du gabarit et les modifier dans ces pages de document, au lieu de
dissocier le gabarit.

Copie des gabarits

Vous pouvez copier les gabarits dans un même document ou d’un document à un autre pour les utiliser
comme point de départ d’un nouveau gabarit. Vous pouvez également copier les gabarits dans d’autres
documents lorsque vous synchronisez des documents d’un livre ou importez des gabarits à partir d’un autre
document.

Pour copier un gabarit dans un document

Dans la section Pages, utilisez l’une des méthodes suivantes :

Faites glisser le nom de page de la planche type vers le bouton Créer une page au
bas du panneau.

Sélectionnez le nom de la planche type, puis choisissez Dupliquer la planche type
[nom de la planche] dans le menu du panneau.

Lorsque vous copiez un gabarit, le préfixe de page du gabarit copié est la lettre suivante de l’alphabet.

Pour copier ou déplacer un gabarit vers un autre document

1. Ouvrez le document auquel vous voulez ajouter le gabarit. Ouvrez ensuite le document
contenant le gabarit à copier.

2. Dans le panneau Pages du document source, utilisez l’une des méthodes suivantes :

Cliquez sur la planche type et faites-la glisser vers la fenêtre du document cible pour
la copier.

Sélectionnez le gabarit à déplacer ou copier. Choisissez Page > Pages > Déplacer le
gabarit, puis choisissez le nom du document cible dans le menu Déplacer vers. Si
vous voulez supprimer la page ou des pages du document source, sélectionnez
Supprimer des pages après le déplacement, puis cliquez sur OK.

Si le document cible comporte déjà un gabarit possédant le même préfixe, le gabarit déplacé adopte la
prochaine lettre disponible de l’alphabet.

Suppression d’un gabarit d’un document

1. Sélectionnez une ou plusieurs icônes de gabarit dans le panneau Pages.

Pour sélectionner toutes les pages types inutilisées, choisissez Sélectionner les
pages types inutilisées dans le menu du panneau Pages.

2. Utilisez l’une des méthodes suivantes :

Faites glisser l’icône de gabarit ou de planche vers l’icône de suppression au bas du
panneau.
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Remplacement d’attributs d’élément de gabarit

Dissociation d’éléments de leur gabarit

Cliquez sur l’icône de suppression au bas du panneau.

Choisissez Supprimer la planche type [nom de la planche] dans le menu du panneau
Pages.

Lorsque vous supprimez un gabarit, le gabarit [Aucun] est appliqué à toutes les pages de document
auxquelles le gabarit supprimé était appliqué.

Remplacement ou dissociation d’éléments types

Lors de l’application d’un gabarit à une page de document, tous les objets situés sur le gabarit, appelés
éléments de gabarit, apparaissent sur la page de document. Si une page spécifique ne vous convient pas
entièrement, il est inutile de repenser la composition de sa page type ou de créer une nouvelle page type.
Vous pouvez remplacer ou dissocier l’élément de gabarit ; les autres éléments de gabarits sur la page du
document continueront d’être mis à jour avec le gabarit.

Notez la différence entre le remplacement et la dissociation des éléments de gabarit sur une page de
document :

Le remplacement d’un élément de gabarit place une copie
de celui-ci sur la page du document sans pour autant supprimer son association au gabarit. Une fois que
l’élément est remplacé, vous pouvez remplacer de façon sélective un ou plusieurs attributs de l’élément pour
le personnaliser. Par exemple, vous pouvez modifier la couleur de fond de la copie locale. Les modifications
apportées alors à la couleur de fond sur la page de gabarit ne sont plus mises à jour sur la copie locale.
Toutefois, les autres attributs, tels que la taille, continuent de se mettre à jour car ils n’ont pas été remplacés
sur la copie locale. Vous pourrez supprimer les remplacements plus tard pour faire correspondre l’objet au
gabarit.
Les attributs que vous pouvez remplacer pour un objet de page gabarit incluent les contours, les fonds, le
contenu d’un bloc et toutes les transformations (telles que la rotation, la mise à l’échelle, la déformation ou le
redimensionnement), les options d’arrondis, les options de bloc de texte, le verrouillage, les effets de
transparence et d’objet.

Il est possible de dissocier un élément type de son gabarit sur une
page de document. L’élément doit être remplacé sur la page du document, en créant une copie locale, avant
que vous ne puissiez le dissocier. Un élément dissocié ne se met pas à jour avec le gabarit car son
association avec la page de gabarit est supprimée.

Pour remplacer un élément de gabarit

1. Assurez-vous que l’élément de gabarit peut être remplacé.

Vous pouvez remplacer un élément de gabarit uniquement si l’option Autoriser les
remplacements des éléments du gabarit sur la sélection est sélectionnée pour cet
élément dans le menu du panneau Pages.

2. Utilisez l’une des méthodes suivantes :

Pour remplacer des éléments de gabarit spécifiques sur une page de document,
appuyez sur les touches Ctrl+Maj (Windows) ou Commande+Maj (Mac OS), puis
cliquez sur l’élément (ou faites glisser le curseur pour sélectionner plusieurs
éléments). Modifiez les éléments de gabarit sélectionnés comme vous le souhaitez.
Vous pouvez désormais sélectionner l’élément comme tout autre élément de page,
mais celui-ci conserve son association au gabarit.

Pour remplacer tous les éléments de gabarits sur une planche de document, ciblez la
planche, puis choisissez Libérer tous les éléments de gabarit dans le menu du
panneau Pages. Vous pouvez désormais sélectionner et modifier les éléments de
gabarits à votre convenance.

Lorsqu’un élément de gabarit est remplacé, son cadre de sélection en pointillé se



Remarque :

transforme en ligne pleine, pour montrer qu’une copie locale a été créée.

lors du remplacement d’un bloc de texte lié, tous les blocs visibles dans ce
lien sont substitués, même s’ils sont situés sur une page différente d’une planche.

Pour dissocier un élément de gabarit

Pour dissocier un seul élément de gabarit de son gabarit, remplacez-le d’abord en
appuyant sur les touches Ctrl+Maj (Windows) ou Commande+Maj (Mac OS) et en
cliquant sur l’élément sur une page de document. Choisissez ensuite Dissocier la
sélection du gabarit dans le menu du panneau Pages.
Pour dissocier tous les éléments de gabarit remplacés sur une planche, remplacez les
éléments de page de gabarit que vous voulez dissocier, puis ciblez cette planche du
document (ne sélectionnez pas la page de gabarit d’origine). Choisissez l’option Dissocier
tous les objets du gabarit dans le menu du panneau Pages. Si la commande n’est pas
accessible, la planche ne contient aucun objet substitué.

Pour empêcher un élément de gabarit d’être remplacé

Dans certains cas, il est possible que vous ne vouliez remplacer que quelques-uns des éléments de gabarit.
Par exemple, vous pouvez remplacer des éléments de gabarit tels que les images d’arrière-plan d’une page
de document, tout en évitant de remplacer un en-tête de numérotation de page. En empêcher l’en-tête d’être
remplacé, vous pouvez choisir l’option Libérer tous les éléments de gabarit pour remplacer tous les éléments
de gabarit, sauf l’en-tête.

1. Sélectionnez l’élément sur la page de gabarit.

2. Désélectionnez l’option Autoriser les remplacements des éléments du gabarit sur la
sélection dans le menu du panneau Pages.

Les éléments de gabarit dont le remplacement n’est pas autorisé ne présentent pas de cadres de bloc
lorsqu’ils sont affichés sur la page de document. Si vous voulez éviter de remplacer un bloc de texte lié, tous
les blocs de texte liés auront le même paramètre.

Pour réappliquer des éléments types

Si vous avez remplacé les éléments types, vous pouvez les restaurer pour reproduire le gabarit. Les attributs
de l’objet sont alors rétablis tels qu’ils apparaissent sur le gabarit correspondant et seront de nouveau mis à
jour avec le gabarit. La copie locale de l’objet est supprimée et l’élément de gabarit ne peut pas être
sélectionné, comme l’indique sa bordure en pointillé. L’annulation des substitutions s’applique aux objets
sélectionnés ou à tous les objets d’une planche, mais pas à l’ensemble d’un document.

Utilisez l’une des méthodes suivantes :

Pour supprimer les remplacements de gabarit d’un ou de plusieurs objets,
sélectionnez les objets qui étaient précédemment des éléments de gabarit. Dans le
panneau Pages, ciblez une planche, puis choisissez Ne pas appliquer les
remplacements locaux sélectionnés dans le menu du panneau Pages.

Pour supprimer tous les remplacements de gabarit d’une planche, dans le panneau
Pages, ciblez la planche (ou planche type) dont vous voulez supprimer les
remplacements de gabarit. Choisissez Edition > Tout désélectionner pour vous
assurer qu’aucun objet n’est sélectionné. Dans le panneau Pages, choisissez
N’appliquer aucun remplacement local dans le menu du panneau Pages.

Si vous avez dissocié les objets d’un gabarit, vous ne pouvez pas les restaurer dans le gabarit ; toutefois,
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vous pouvez supprimer les objets dissociés et réappliquer le gabarit à la page.

Si vous réappliquez un gabarit à une page contenant des objets de gabarit substitués, les objets contenant
des remplacements sont dissociés et tous les objets de gabarit sont réappliqués. Ceci peut produire deux
copies de certains objets sur la page. Vous devez supprimer les objets associés pour reproduire avec
exactitude l’aspect du gabarit.

Pour masquer les éléments du gabarit

La commande Masquer les éléments du gabarit permet de masquer des éléments de gabarit sur une ou
plusieurs pages d’un document. Les éléments de gabarit masqués ne sont pas imprimés.

1. Dans le panneau Pages, sélectionnez les pages et les planches sur lesquelles vous
souhaitez masquer les éléments de gabarit.

2. Dans le menu du panneau Pages, choisissez la commande Masquer les éléments du
gabarit.

Pour afficher de nouveau les éléments du gabarit, sélectionnez les planches voulues dans le panneau Pages,
puis choisissez la commande Afficher les éléments du gabarit dans le menu de ce panneau.

Importation d’un gabarit à partir d’un autre document

Vous pouvez importer des gabarits d’un autre document InDesign (quelle que soit la version) dans un
document actif. Si votre document cible contient des gabarits ayant des noms différents des gabarits du
document cible, les remplacements de ces pages et de leur page de document resteront inchangés.

1. Dans le menu du panneau Pages, choisissez Charger des gabarits.

2. Cliquez deux fois sur le document InDesign contenant les gabarits que vous voulez
importer.

3. Déterminez ce qui doit se passer si un gabarit chargé a le même nom qu’un gabarit du
document actif.

Choisissez Remplacer des gabarits si vous voulez que les gabarits du document
source remplacent les gabarits du document cible ayant les mêmes noms. Si votre
document cible n’a pas d’éléments remplacés, il est recommandé de Remplacer des
gabarits lors de l’importation.

Choisissez Renommer des gabarits pour modifier les préfixes de page par la lettre
suivante disponible dans l’alphabet.

Une fois que vous avez importé des gabarits depuis un document cible, un lien est créé entre le document
source et le document cible. Lorsque vous chargez ultérieurement les gabarits depuis le même document
source, l’association entre les éléments remplacés et leurs éléments parents sur les gabarits rechargés est
conservée. Les gabarits restent ainsi cohérents dans différents documents sans que vous ayez à placer ces
documents dans un livre.

Pour utiliser cette méthode, chargez les gabarits à partir du document source avant de remplacer les objets
sur le gabarit. Si votre document contient des éléments remplacés et que vous n’avez jamais importé de
gabarits d’un document source, ces éléments remplacés deviennent dissociés la première fois que vous
chargez à partir d’un document source et remplacent les gabarits portant le même nom que le gabarit parent
des éléments remplacés.

Toutefois, si vous importez ultérieurement des gabarits depuis un autre document source, et si vous utilisez la
commande Remplacer des gabarits, les éléments remplacés risquent d’être dissociés. Tout gabarit portant le
même nom dans le document source est appliqué à la page du document contenant les éléments remplacés,
ce qui crée deux ensembles d’objets.
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Numbering pages, chapters, and sections
Add section and chapter numbering
Define section numbering
Document numbering options
Create headers and footers
Add automatic page numbers for story jumps

Add section and chapter numbering

Determine what kind of numbering you want to use for your document or book. For long documents, you can
assign chapter numbers. Each document can be assigned only one chapter number. If you want to use different
numbering within a document, you can define ranges of pages as sections; these sections can be numbered
differently. For example, the first ten pages of a document (the front matter) might use Roman numerals, and the
rest of the document might use Arabic numerals.

A single InDesign document can contain up to 9,999 pages, but page numbers can be as large as 999,999. (For
example, you can correctly number a 100-page document that starts on page 9,949.) By default, the first page is a
recto (right) page numbered 1. Odd-numbered pages always appear on the right; if you use the Section Options
command to change the first page number to an even number, the first page becomes a verso (left) page.

For information on creating basic page numbering in a document, see Add basic page numbering.

Add an automatically updated chapter number

You can add a chapter number variable to your document. Like page numbers, chapter numbers can be updated
automatically and formatted and styled as text. A chapter number variable is commonly used in documents that
are part of a book. A document can have only one chapter number assigned to it; if you want to divide a single
document into chapters, you can create sections instead.

Note:

Chapter numbers cannot be included as a prefix in a generated index or table of contents (such as 1-3, 1-4, and
so on). If you want chapter numbers to be included as prefixes, use section prefixes instead of chapter numbers.

1. If necessary, create a text frame where you want a chapter number to appear. If you want a chapter
number to appear on several pages, create the text frame on a master page, and apply that master page to
the document pages.

2. In the chapter number text frame, add any text that will come before or after the chapter number.
3. Place the insertion point where you want the chapter number to appear, and then choose Type > Text

Variables > Insert Text Variable > Chapter Number.

You can update the starting number and format of chapter numbering by choosing Layout > Numbering & Section
Options.
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Add an automatically updated section marker

1. Define sections in your document. (See Define section numbering.)
2. On a page or master that you’re using in a section, drag the Type tool to create a text frame large enough

for the section marker text, or click in an existing frame.
3. Choose Type > Insert Special Character > Markers > Section Marker.

On master page A, section marker (left) and section marker with page number marker inserted (right)

Change the format of page and chapter numbering

1. Choose Layout > Numbering & Section Options.
2. Under Page Numbering or Document Chapter Numbering, select a new number format for Style. (See

Document numbering options.)
3. Click OK.

Define section numbering

By default, page and chapter numbers in a book are numbered consecutively. Using Numbering & Section Options,
you can restart page numbering at a specified page, add prefixes to page numbers, and change the numbering
style of both pages and chapters.

You can define a section prefix to label section pages automatically. For example, if you specify A– for Section
Prefix on page 16 of a document and include the section prefix, the page will appear in the table of contents or
index as A–16. Text you type for a section marker appears when you choose Type > Insert Special Character >
Markers > Section Marker.

Pages panel

A. Section indicator icon shows start of section B. Page number is changed for new section C. Status bar displays document length 

Define sections in a document

1. In the Pages panel, select the first page in the section you want to define.
2. Choose Layout > Numbering & Section Options, or choose Numbering & Section Options in the Pages panel.
3. If you’re changing the numbering options for any page other than the first page of the document, make sure

that Start Section is selected. This option marks the selected page as the beginning of a new section.
4. As necessary, specify the numbering and section options (see Document numbering options), and then

click OK.

A section indicator icon  appears above the page icon in the Pages panel, indicating the start of a new
section.

5. To end the section, repeat the section numbering steps on the first page that follows the section.

Edit or remove section numbering

1. In the Pages panel, double-click the section indicator icon  that appears above the page icon in the Pages
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panel. Or, select a page that uses a section marker, and choose Numbering & Section Options in the Pages
panel menu.

2. Do any of the following, and then click OK:

To change the style or starting number, change section and numbering options.

To remove a section, deselect the Start Section option.

To quickly identify a section in the Pages panel, position the pointer precisely over any section indicator icon . A
tool tip appears, displaying the starting page number or section prefix.

Display absolute or section numbering in the Pages panel

The Pages panel can display absolute numbering (labeling all pages with consecutive numbers, starting at the first
page of the document) or section numbering (labeling pages by section, as specified in the Section Options dialog
box).

Changing the numbering display affects how pages are indicated in the InDesign document, as in the Pages panel
and in the page box at the bottom of a document window. The numbering display also affects how you specify
page ranges when printing and exporting the document. However, the numbering display does not change the
appearance of page numbers on document pages.

1. Choose Edit > Preferences > General (Windows) or InDesign > Preferences > General (Mac OS).
2. For Page Numbering, choose a numbering method in the View menu.

Pages panel showing absolute numbering (left) and section numbering (right)

Document numbering options

You can change document numbering options when you select a document page (not a master page) and choose
Layout > Numbering & Section Options. You can also change these options when you choose Document
Numbering Options from the Book panel menu.

Automatic Page Numbering

Select if you want the page numbers of the current section to follow the numbering of the previous section. Using
this option, the page numbers in the document or section update automatically when you add pages prior to it.

Start Page Numbering At

Type the starting number for your document or for the first page of the current section. For example, if you want
to restart the numbering for a section, type 1 . The remaining pages in the section will be renumbered accordingly.

Note:

If you chose a non-Arabic page-numbering style (such as Roman numerals), you still must type an Arabic numeral
in this box.
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Section Prefix

Type a label for the section. Include the spaces or punctuation you want to appear between the prefix and the
page number (for example, A–16 or A 16). The prefix is limited to eight characters.

You cannot enter a blank space by pressing the spacebar—copy and paste a fixed-width space character from the
document window instead. Note that plus (+) or comma (,) symbols cannot be used in section prefixes. (See
Insert white space characters.)

Style (Page Numbering)

Choose a page-numbering style from the menu. The style applies to all pages in this section only.

Section Marker

Type a label that InDesign inserts on the page at the location of a section marker character that appears when you
choose Type > Insert Special Character > Markers > Section Marker.

Include Prefix When Numbering Pages

Select if you want the section prefix to appear when you generate a table of contents or index, or when you print
pages that contain automatic page numbers. Deselect this option to display the section prefix in InDesign but hide
the prefix in the printed document, index, and table of contents.

Section prefix in document window

A. Section prefix in the page box at the bottom of the document window B. Section marker and prefix on the page itself 

Style (Document Chapter Numbering)

Choose a chapter-numbering style from the menu. This chapter style is used throughout the document.

Automatic Chapter Numbering

Select this option to number chapters sequentially in a book.

Start Chapter Numbering At

Specify the starting number of the chapter numbering. This option is useful if you don’t want chapters to be
numbered sequentially in the book.

Same As Previous Document In The Book

The same chapter number as the previous document in a book is used. Select this option if the current document
is part of the same chapter as the previous document in a book.

Create headers and footers



Headers and footers run through the top and bottom of the pages in your document, providing important
background information. To create a simple header or footer that includes page numbering, see Add basic page
numbering.

Headers and footers can include such items as page, chapter, or section numbers; title or heading text; the
author’s name; and the document’s filename and creation or modification date.

You can add many of these items by using text variables. InDesign includes several preset variables, such as
Creation Date and File Name. You can modify these variables, and you can create your own. For example, you can
create a variable that displays the first use of a Heading paragraph style in the header or footer. Once you create
or edit the variables you need, you assemble them on the master page to create your header and footer, and then
you apply the master page to the appropriate document pages.

Using page numbers and variables to create a footer

A. Footer variable inserted on master page B. Variable text on document page that grabs text from the first heading on the page 

For a video tutorial on creating headers and footers, see www.adobe.com/go/vid0078.

Create a header or footer on a master page

1. If necessary, create or edit the variables you want to use in your header or footer. (See Create variables for
running headers and footers.)

2. Go to the master page where you want to add the header or footer.

The header or footer will appear on any document page to which the master page is applied.

3. Create a text frame large enough to include all the header or footer information. Place the text frame above
or below where the content of the document pages will appear.

4. Add text, page numbers, and variables as needed.
5. Apply the master page to document pages where you want the header or footer to appear.
6. If necessary, create headers and footers for additional master pages.

Create variables for running headers and footers

By default, the Running Header variables insert the first occurrence (on the page) of the text to which the
specified style is applied. Running Header variables are especially useful for displaying the current heading or title
in the header or footer.

1. If your content is not already formatted, create and apply the paragraph style or character style for the text
you want to appear in the header (such as a title or heading style).

2. Choose Type > Text Variables > Define.
3. Click New, and then type a name for the variable.
4. From the Type menu, choose Running Header (Paragraph Style) or Running Header (Character Style).
5. Specify the following options:

Style

Choose the style to display in your header or footer.

http://www.adobe.com/go/vid0078
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Use

Decide whether you want the first or last occurrence of the style that’s applied on the page. First On Page is
the first paragraph (or character) that begins on a page. If there is no occurrence of the style on the page,
the previous occurrence of the applied style is used. If there is no previous occurrence in the document, the
variable is empty.

Delete End Punctuation

If selected, the variable displays the text minus any end punctuation (periods, colons, exclamation points,
and question marks).

Change Case

Select this option to change the case of the text that appears in the header or footer. For example, you may
want to use sentence case in your footer, even though the heading on the page appears in title case.

6. Click OK, and then click Done in the Text Variables dialog box.

You can now insert the variable in a header or footer you create on the master page.

If a header or footer text frame has been created on the master page of the InDesign document, you can
insert the variable in the header or footer. (See Edit text on a master page.)

Add automatic page numbers for story jumps

You can easily maintain the jump lines of stories that continue to other pages, such as a line that says “Continued
on page 42.” Use a jump line page number to automatically update the number of the page containing a story’s
next or previous threaded text frame when you move or reflow the story’s threaded text frames.

Usually the jump line page number should be in a separate text frame from the story it tracks. That way, the jump
line page number remains in position even if the story’s text reflows.

If you insert a Current Page Number character in the Find/Change dialog box, jump line page numbers can also be
found.

1. With the Type tool, drag to create a new text frame where you want the jump line to appear.
2. With the Selection tool , position the new text frame so that it touches or overlaps the frame containing the

story you want to track.

Make sure text frame touches or overlaps the story you want it to track.

3. Select the Type tool and click an insertion point in the new text frame. Then type the text that you want to
appear before the page number, such as “Continued on” or “Continued from”.

4. Then choose Type > Insert Special Character > Marker and one of the following options:

Next Page Number

Inserts the number of the page containing the story’s next frame. Use this character when creating a
“continued on” jump line.

Previous Page Number



Inserts the number of the page containing the story’s previous frame. Use this character when creating a
“continued from” jump line.

The page number automatically updates to reflect the current location of the next or previous frame of the
story.

5. To prevent the story from being moved without its jump line, Shift-select the frames with the Selection tool,
then choose Object > Group.

6. If necessary, repeat this procedure to add more jump lines.

Note:

If an unwanted character appears at the beginning of the page number (so that, for example, a jump line reads
“Cont’d on page A16” instead of “Cont’d on page 16”), you probably included a section prefix in the Numbering &
Section Options dialog box. Turn off or edit the prefix.

Adobe also recommends

Number pages, chapters, and paragraphs in a book
Add basic page numbering
Number pages, chapters, and paragraphs in a book
Master pages
Text variables
Cross-references
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Placing graphics
Place (import) graphics
Import options for graphics
Place multiple graphics
Control layer visibility in imported images
Paste or drag graphics
Fixing low-resolution images
Control graphics’ display performance
Create contact sheets

Place (import) graphics

The Place command is the primary method used to insert graphics into InDesign because it provides the highest
level of support for resolution, file formats, multipage PDF and INDD files, and color. To place graphics is also
referred to as import images and insert pictures.

If you’re creating a document in which those characteristics aren’t critical, you can copy and paste to import
graphics InDesign. Pasting, however, embeds a graphic in a document; the link to the original graphic file is broken
and doesn’t appear in the Links panel, and you can’t update the graphic from the original file. However, pasting
Illustrator graphics allows you to edit paths in InDesign. See Importing Adobe Illustrator graphics.

The options available to you when you place a graphics file depend on the type of graphic. These options appear
when you select Show Import Options in the Place dialog box. If you don’t select Show Import Options, InDesign
applies the default settings or the last settings used in placing a graphics file of that type.

The names of graphics you’ve placed (imported) appear in the Links panel.

Note:

If you place or drag a graphic from a removable media, such as a CD-ROM, the link will break when you remove
that media from your system.

For a video tutorial on placing an image, see www.adobe.com/go/lrvid4279_id.

1. Do one of the following:

To import a graphic without first creating a frame, make sure that nothing in the document is selected.

To import a graphic into an existing frame, select the frame. If the new image is larger than the frame,
you can refit the frame later by choosing Object > Fitting > [fitting command].

To replace an existing image, select its graphics frame.

2. Choose File > Place and select one or more graphics files of any available format.

If you select multiple files, you can click or drag in the document to place the selected files one at a time.
(See Place multiple graphics.)

3. To replace an object you selected, select Replace Selected Item.

http://www.adobe.com/go/lrvid4279_id
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4. To add a caption based on the image metadata, select Create Static Captions. See Generate a caption from
an image.

5. To set format-specific import options, do one of the following:

Select Show Import Options, and then click Open.

Hold down Shift as you click Open or Shift-double-click a file name.

Note:

When you place a graphic created in Illustrator 9.0 or later by using the Show Import Options dialog box, the
options are identical to those for PDFs. When you place an Illustrator 5.5–8.x graphic, the options are
identical to those for EPS files.

6. If the Image Import Options dialog box appears (because you chose to set format-specific import options),
select import options and click OK. (See Import options for graphics.)

7. Do one of the following:

To import into a new frame, drag to create a frame. Or, click the loaded graphics icon  in the layout
at the place where you want the upper left corner of the graphic to appear.

Note:

When you drag to create a frame, the frame has the same proportions as the graphic unless you Shift-drag.

To import into an existing, unselected frame, click the loaded graphics icon anywhere in that frame.
To import into an existing selected frame, you don’t need to do anything if Replace Selected Item is
selected. The image automatically appears in that frame.
To replace an existing graphic, hold down Alt (Windows) or Option (Mac OS) and click the loaded
graphics icon on the graphic you want to replace.
To place all the specified pages of a multipage file (such as a PDF or INDD file) at the same time, one
overlapping another, hold down Alt (Windows) or Option (Mac OS) and click the loaded graphics icon
where you want the pages to appear.

If you accidently replace an existing graphic with an image you’re placing, press Ctrl+Z (Windows) or
Command+Z (Mac OS) to return the original image to the frame and display the loaded graphics icon.

8. To place the next graphic or the next page of a multipage PDF, click the loaded graphics icon in the layout
where desired. If necessary, you can scroll to a different location or change pages without losing the loaded
graphics icon.

Note:

The image you place may appear to have a low resolution, depending on your settings. The display setting of an
image does not affect final output of the file. To change your image display settings, see Control graphics’ display
performance.

Import options for graphics

The options for importing graphics vary depending on the type of image being imported. To display import options,
make sure that Show Import Options is selected in the Place dialog box.

Encapsulated PostScript (.eps) import options

When you place an EPS graphic (or a file saved with Illustrator 8.0 or earlier) and select Show Import Options in
the Place dialog box, you’ll see a dialog box containing these options:



Read Embedded OPI Image Links

This option tells InDesign to read links from OPI comments for images included (or nested) in the graphic.

Deselect this option if you’re using a proxy-based workflow and plan to have your service providers perform the
image replacement using their OPI software. When this option is deselected, InDesign preserves the OPI links but
does not read them. When you print or export, the proxy and the links are passed on to the output file.

Select this option if you’re using a proxy-based workflow and you want InDesign, instead of your service provider,
to perform image replacement when you output the final file. When you select this option, the OPI links appear in
the Links panel.

Also select this option when you import EPS files containing OPI comments that are not part of a proxy-based
workflow. For example, if you import an EPS file containing OPI comments for an omitted TIFF or bitmap image,
you’ll want to select this option so that InDesign can access the TIFF information when you output the file.

Apply Photoshop Clipping Path

Regardless of whether this option is selected, a placed EPS file includes a clipping path in InDesign. However,
deselecting this option may result in a different bounding box size.

Proxy Generation

This creates a low-resolution bitmap representation of an image when drawing the file to the screen. The following
settings control how the proxy will be generated:

Use TIFF Or PICT Preview

Some EPS images contain an embedded preview. Select this option to generate the proxy image of the existing
preview. If a preview does not exist, the proxy will be generated by rasterizing the EPS to an offscreen bitmap.

Rasterize The PostScript

Select this option to ignore the embedded preview. This option is typically slower but provides the highest-quality
results.

Note:

When you import more than one single file into the same document, all instances share the proxy setting of the
first instance of the imported file.

Bitmap import options

You can apply color-management options to individual imported graphics when using color-management tools with
a document. You can also import a clipping path or an alpha channel saved with an image created in Photoshop.
Doing so lets you directly select an image and modify its path without changing the graphics frame.

When you place a PSD, TIFF, GIF, JPEG, or BMP file and select Show Import Options in the Place dialog box, you’ll
see a dialog box containing these options:



Apply Photoshop Clipping Path

If this option isn’t available, the image wasn’t saved with a clipping path, or the file format doesn’t support clipping
paths. If the bitmap image doesn’t have a clipping path, you can create one in InDesign.

Alpha channel

Select an alpha channel to import the area of the image saved as an alpha channel in Photoshop. InDesign uses
the alpha channel to create a transparent mask on the image. This option is available only for images that contain
at least one alpha channel.

Click the Color tab to view the following options:

Image imported without clipping path (left) and with clipping path (right)

Profile

If Use Document Default is selected, leave this option unchanged. Otherwise, choose a color source profile that
matches the gamut of the device or software used to create the graphic. This profile enables InDesign to properly
translate its color to the gamut of the output device.

Rendering Intent

Choose a method for scaling the color range of the graphic to the color range of the output device. Typically, you’ll
choose Perceptual (Images) because it accurately represents colors in photographs. The Saturation (Graphics),
Relative Colorimetric, and Absolute Colorimetric options are better for areas of solid color; they don’t reproduce
photographs well. Rendering Intent options aren’t available for bitmap, grayscale, and index-color mode images.

Portable Network Graphics (.png) import options

When you place a PNG image and select Show Import Options in the Place dialog box, you’ll see a dialog box with
three sections of import settings. Two sections contain the same options available for other bitmap image formats.
The other section, PNG Settings, contains the following settings:

Use Transparency Information

This option is enabled by default when a PNG graphic includes transparency. If an imported PNG file contains
transparency, the graphic interacts only where the background is transparent.

White Background

If a PNG graphic does not contain a file-defined background color, this option will be selected by default. However,
it is only enabled if Use Transparency Information is activated. If this option is selected, white is used as the
background color when applying transparency information.



File Defined Background Color

If a PNG graphic was saved with a non-white background color, and Use Transparency Information is selected, this
option is selected by default. If you don’t want to use the default background color, click White Background to
import the graphic with a white background, or deselect Use Transparency Information to import the graphic
without any transparency (displaying areas of the graphic that are currently transparent). Some image-editing
programs can’t specify a non-white background color for PNG graphics.

Apply Gamma Correction

Select this option to adjust the gamma (midtone) values of a PNG graphic as you place it. This option lets you
match image gamma to the gamma of the device you will use to print or display the graphic (such as a low-
resolution or non-PostScript printer or computer monitor). Deselect this option to place the image without applying
any gamma correction. By default, this option is selected if the PNG graphic was saved with a gamma value.

Gamma Value

This option, available only if Apply Gamma Correction is selected, displays the gamma value that was saved with
the graphic. To change the value, type a positive number from 0.01 to 3.0.

When PNG files are imported, the settings in the Image Import Options dialog box are always based on the
selected file, not on the default or last-used settings.

Acrobat (.pdf) and Illustrator (.ai) import options

The layout, graphics, and typography in a placed PDF are preserved. As with other placed graphics, you cannot
edit a placed PDF page within InDesign. You can control the visibility of layers in a layered PDF. You can also place
more than one page of a multipage PDF.

When you place a PDF that was saved with passwords, you’ll be prompted to enter the required passwords. If the
PDF file was saved with usage restrictions (for example, no editing or printing), but no passwords, you can place
the file.

When you place a PDF (or a file saved with Illustrator 9.0 or later) and select Show Import Options in the Place
dialog box, you’ll see a dialog box containing the following options:

Show Preview

Preview a page in the PDF before you place it. If you’re placing a page from a PDF that contains multiple pages,
click the arrows, or type a page number under the preview image to preview a specific page.

Pages

Specify the pages you want to place: the page displayed in the preview, all pages, or a range of pages. For
Illustrator files, you can specify which artboard to place.

If you specify multiple pages, hold down Alt (Windows) or Option (Mac OS) while placing the file to place them all
at the same time, overlapping each other.

Crop To



Specify how much of the PDF page to place:

Bounding Box

Places the PDF page’s bounding box, or the minimum area that encloses the objects on the page, including page
marks. The Bounding Box (Visible Layers Only) option uses the bounding box only of the visible layers of the PDF
file. The Bounding Box (All Layers) option places the bounding box of the entire layer area of the PDF file, even if
layers are hidden.

Art

Places the PDF only in the area defined by a rectangle that the author created as a placeable artwork (for
example, clip art).

Crop

Places the PDF only in the area that is displayed or printed by Adobe Acrobat.

Trim

Identifies the place where the final produced page will be physically cut in the production process, if trim marks are
present.

Bleed

Places only the area that represents where all page content should be clipped, if a bleed area is present. This
information is useful if the page is being output in a production environment. Note that the printed page may
include page marks that fall outside the bleed area.

Media

Places the area that represents the physical paper size of the original PDF document (for example, the dimensions
of an A4 sheet of paper), including page marks.

Options for cropping placed PDFs

A. Media B. Trim C. Bleed D. Content E. Crop F. Art 

Transparent Background

Select this option to reveal text or graphics that fall beneath the PDF page in the InDesign layout. Deselect this
option to place the PDF page with an opaque white background.

If you make the background transparent in a frame containing a PDF graphic, you can make it opaque later by
adding a fill to the frame.

InDesign (.indd) import options
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InDesign preserves the layout, graphics, and typography in a placed INDD file. However, the file is treated as an
object, and you can’t edit it, although you can control the visibility of layers and choose which pages of a multi-
page INDD file to import.

When you place an InDesign file and select Show Import Options in the Place dialog box, you’ll see a dialog box
containing the following options:

Show preview

Preview a page before you place it. You can type a page number or click the arrows to preview a page in a multi-
page document.

Pages

Specify the pages you want to place: the page displayed in the preview, all pages, or a range of pages.

Crop to

Specify how much of the page or pages to place, the page itself or the bleed or slug areas on the pasteboard.

Place multiple graphics

The Place command lets you import more than one item at a time.

1. Create frames for the graphics if you want to place some or all of them in frames.
2. Choose File > Place, and select files.

You can select graphics files, text files, InDesign files, and other files you can add to InDesign documents.

3. Optionally, select Show Import Options, click Open, and specify the import options for each file. (See Import
options for graphics.)

A thumbnail image of the first graphic you selected appears next to the loaded graphics icon. A number next
to the loaded graphics icon tells you how many graphics are ready for importing. The names of the graphics
appear in the Links panel, with the letters LP (for “loaded in place cursor”) next to the frontmost graphic.

Placing four files into placeholder frames

Press an arrow key to cycle through the graphics; press Esc to unload the frontmost graphic from the loaded
graphics icon without placing it in InDesign.

Note:

You can keep thumbnail images from appearing in the loaded graphics icon if displaying the images slows
down your computer. In the Interface area of the Preferences dialog box, deselect Show Thumbnails On
Place.

4. Do one of the following:

To import into a new frame, click the loaded graphics icon where you want the upper left corner of the
graphic to appear.
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To create a frame of a certain size and import the graphic into the frame, drag to define the frame. The
frame conforms to the proportions of the graphic being placed.

To import into an existing frame, click the loaded graphics icon in the frame. Alt-click (Windows) or
Option-click (Mac OS) to replace the contents of an existing frame.

To import all the loaded graphics in a grid, start dragging, and press the arrow keys to determine the
number of rows and columns. Use the Up Arrow and Down Arrow keys to change the number of rows
and the Left Arrow and Right Arrow keys to change the number of columns. Release the mouse button
to place the grid of images.

To change the spacing between frames, press Page Up or Page Down or hold down Ctrl (Windows) or
Command (Mac OS) while pressing the arrow keys.

To change the spacing between frames, hold down Ctrl (Windows) or Command (Mac OS) while
pressing the arrow keys.

Note:

You can load more graphics by choosing File > Place while the graphics icon is displayed.

Control layer visibility in imported images

When you import Photoshop PSD files, layered PDFs, and INDD files, you can control the visibility of top-level
layers. Adjusting layer visibility in InDesign lets you vary an illustration depending on context. For example, in a
multilanguage publication, you can create a single illustration that includes one text layer for each language.

You can adjust layer visibility either when you place a file or by using the Object Layer Options dialog box. In
addition, if the Photoshop file contains layer comps, you can display the desired comp.

Set layer visibility

1. Do one of the following:

To import a graphic without first creating a frame, make sure that nothing in the document is selected.

To import a graphic into an existing frame, select the frame.

To replace an existing image, select the graphics frame.

2. Choose File > Place and select a graphics file.
3. To replace a selected object, select Replace Selected Item.
4. Select Show Import Options, and then click Open.
5. In the Image Import Options or Place dialog box, click the Layers tab.
6. To view a preview of the image, click Show Preview.
7. (PDFs only) If you’re placing a page from a multipage PDF, click the arrows, or type a page number under

the preview image to preview a specific page.
8. (Photoshop PSD files only) If the image contains layer comps, choose the layer comp you want to display

from the Layer Comp pop-up menu.
9. Do one of the following:

To open or close a layer set, click the triangle to the left of the folder icon.

To hide a layer or layer set, click the eye icon next to the layer or layer set.

To display the layer or layer set, click the empty eye column next to the layer or layer set.



To display only the content of a particular layer or layer set, Alt-click (Windows) or Option-click
(Mac OS) its eye icon. Alt-click or Option-click the eye icon again to restore the original visibility settings
of the other layers.

To change the visibility of multiple items, drag through the eye column.

10. Set the When Updating Link option as desired:

Use Photoshop’s/PDF’s Layer Visibility

Matches the layer visibility settings to those of the linked file when you update the link.

Keep Layer Visibility Overrides

Maintains the layer visibility settings as they were when the file was originally placed.

11. Click OK.
12. Click OK, and do one of the following:

To import into a new frame, click the loaded graphics icon  in the layout at the place where you want
the upper left corner of the graphic to appear.

To import into an existing, unselected frame, click the loaded graphics icon anywhere in that frame.

To import into an existing selected frame, you don’t need to do anything. The image automatically
appears in that frame.

If you accidently replace an existing graphic with an image you’re placing, press Ctrl+Z (Windows) or
Command+Z (Mac OS) to return the original image to the frame and display the loaded graphics icon.

Set layer visibility for placed AI, PSD, PDF, and INDD files

After you place a Photoshop PSD or layered PDF, an Illustrator AI file, or an InDesign INDD file, you can control
the visibility of its layers by using the Object Layer Options dialog box. If the Photoshop PSD file contains layer
comps, you can choose which comp you want to display. In addition, you can choose whether to maintain the
visibility settings or match the settings of the original file each time you update the link.

1. Select the file in the InDesign document.
2. Choose Object > Object Layer Options.
3. To view a preview of the image, select Preview.
4. (Photoshop PSD files only) If the image contains layer comps, choose the layer comp you want to display

from the Layer Comp pop-up menu.
5. Do one of the following:

To open or close a layer set, click the triangle to the left of the folder icon.

To hide a layer or layer set, click the eye icon next to the layer or layer set.

To display the layer or layer set, click the empty eye column next to the layer or layer set.

To display only the content of a particular layer or layer set, Alt-click (Windows) or Option-click
(Mac OS) its eye icon. Alt-click or Option-click the eye icon again to restore the original visibility settings
of the other layers.

To change the visibility of multiple items, drag through the eye column.

6. Set the Updating Link Options as desired:
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Use Layer Visibility

Matches the layer visibility settings to those of the linked file when you update the link.

Keep Layer Visibility Overrides

Maintains the layer visibility settings as they were when the file was originally placed.

7. Click OK.

Paste or drag graphics

When you copy and paste or drag a graphic into an InDesign document, some attributes of the original object may
be lost, depending on the limitations of the operating system and the range of data types the other application
makes available for transfer, and the InDesign Clipboard preferences. Pasting or dragging Illustrator graphics lets
you select and edit paths within the graphic.

Copying and pasting or dragging between two InDesign documents, or within a single document, however,
preserves all of the graphics attributes that were imported or applied. For example, if you copy a graphic from one
InDesign document and paste it into another, the new copy will be an exact duplicate of the original, even
including the original’s link information, so that you can update the graphic when the file on disk changes.

Copy and paste graphics

When copying and pasting a graphic from another document into an InDesign document, InDesign does not create
a link to the graphic in the Links panel. The graphic may be converted by the system clipboard during the transfer,
so both image quality and print quality may be lower in InDesign than in the graphic’s original application.

1. In InDesign or another program, select the original graphic, and choose Edit > Copy.
2. Switch to an InDesign document window, and choose Edit > Paste.

Drag and drop graphics

The drag-and-drop method works like the Place command, with images appearing in the Links panel after they’re
imported. You cannot set import options for the files you drag and drop; however, you can drag and drop multiple
files at once (the files are loaded in the graphics icon when you drag and drop more than one).

Select a graphic from Adobe Illustrator, Adobe Bridge, Explorer (Windows), the Finder (Mac OS), or your desktop,
and drag it into InDesign. The image must be in a format that InDesign can import.

After dragging and dropping a file from any location other than Illustrator, it appears in the Links panel in
InDesign. Using the Links panel, you can control versions and update as necessary.

1. Select the original graphic.
2. Drag the graphic into an open InDesign document window.

Note:

In Windows, if you try to drag an item from an application that does not support drag and drop, the pointer
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displays the Prohibited icon.

To cancel dragging a graphic, drop the graphic onto any panel title bar or the document title bar.

Fixing low-resolution images

Graphics you place in your document may appear pixelated or fuzzy or grainy. In most cases, it’s because InDesign
displays images in low-resolution by default to improve performance.

Check the display settings

To display graphics in high resolution, choose View > Display Performance > High Quality Display. For more details
on changing these display performance settings, see Control graphics’ display performance.

Use Place instead of Paste

The image may still be low resolution even though you changed the display performance settings. For these
images, make sure that you use the Place command to insert the image into InDesign. In some instances, pasting
an image from another application may result in the preview image being inserted instead of the original file.

Check your print settings

If your image appears in low resolution in print, check your print settings to make sure graphics are printing
properly. In the Graphics section of the Print dialog box, choose Send Data > All.

Avoid transformations in images of borderline quality

In addition, scaling or rotating an image could reduce its quality. You may want to choose Clear Transformations
from the Control panel menu.

Improve the image resolution

In some cases, such as with an image copied from a web page, you may need to replace a low-resolution image
with a high-resolution image.

Control graphics’ display performance



You can control the resolution of graphics placed in your document. You can change the display settings for the
entire document or for individual graphics. You can also change a setting that either allows or overrides the display
settings for individual documents.

Change a document’s display performance

A document always opens using the default Display Performance preferences. You can change the display
performance of a document while it is open, but the setting won’t be saved with the document.

If you’ve set the display performance of any images separately, you can override the settings so all objects use the
same settings.

1. Choose View > Display Performance, and select an option from the submenu.
2. To force objects that you have set individually to display using the document setting, deselect View > Display

Performance > Allow Object-Level Display Settings. (A check mark indicates it is selected.)

Change an object’s display performance

1. To preserve the display performance for individual objects when the document is closed and reopened, make
sure Preserve Object-Level Display Settings is selected in Display Performance preferences.

2. Choose View > Display Performance, and make sure Allow Object-Level Display Settings is selected.
3. With the Selection tool  or Direct Selection tool , select an imported graphic.
4. Do one of the following:

Select Object > Display Performance, and choose a display setting.

Right-click (Windows) or Control-click (Mac OS) the image, and choose a display setting from the
Display Performance submenu.

To remove an object’s local display setting, choose Use View Setting in the Display Performance submenu. To
remove local display settings for all graphics in the document, select Clear Object-Level Display Settings in the
View > Display Performance submenu.

Display performance options

These options control how graphics are displayed on the screen, but they do not affect the print quality or
exported output.

Use Display Performance preferences to set the default option used to open all documents, and customize the
settings that define those options. Each display option has separate settings for displaying raster images, vector
graphics, and transparencies.

Fast

Draws a raster image or vector graphic as a gray box (default). Use this option when you want to quickly page
through spreads that have lots of images or transparency effects.

Typical
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Draws a low-resolution proxy image (default) appropriate for identifying and positioning an image or vector
graphic. Typical is the default option, and is the fastest way to display an identifiable image.

High Quality

Draws a raster image or vector graphic at High Resolution (default). This option provides the highest quality but
the slowest performance. Use this option when you want to fine-tune an image.

Note:

Image display options don’t affect output resolution when exporting or printing images within a document. When
printing to a PostScript device, exporting to XHTML, or exporting to EPS or PDF, the final image resolution depends
on the output options you choose when you print or export the file.

Set default display performance

The Display Performance preferences let you set the default display option, which InDesign uses for every
document. You can change a document’s display performance using the View menu, or change the setting for
individual objects using the Object menu. For example, if you work on projects that contain numerous high-
resolution photos (such as a catalog), you may prefer to have all your documents open quickly. You can set the
default display option to Fast. When you want to see the images in more detail, you can switch the document view
to Typical or High Quality (leaving the preference set to Fast).

You can also choose to view or override display settings applied to individual objects. If Preserve Object-Level
Display Settings is selected, any settings applied to objects are saved with the document.

1. Select Edit > Preferences > Display Performance (Windows) or InDesign > Preferences > Display
Performance (Mac OS).

2. For Default View, select Typical, Fast, or High Quality. The display option you choose applies to all
documents you open or create.

3. Do one of the following:

To save display settings applied to individual objects, select Preserve Object-Level Display Settings.

To display all graphics using the default display option, deselect Preserve Object-Level Display Settings.

4. For Adjust View Settings, choose the display option you want to customize, and then move the slider for
Raster Images or Vector Graphics to the desired setting.

5. Click OK.

Each display option has separate settings for raster (bitmap) images, vector graphics, and transparency effects.

Create contact sheets

A contact sheet is a grid of thumbnail images, often used for pre-press analysis. You can use a number of different
Adobe applications to create a contact sheet. In Photoshop, you can use either the Contact Sheet or Picture
Package command.

In previous versions of Adobe Bridge (CS2 and CS3), you can create a contact sheet for InDesign pages using the
Create InDesign Contact Sheet feature. This feature does not appear in later versions of Adobe Bridge. Instead,
you can use the Adobe Output Module in Adobe Bridge to create a PDF contact sheet.



You can also create a simple contact sheet in InDesign by placing multiple images in a grid.

1. Choose File > Place, select multiple images, and choose Open.

If you want to include captions with your images, select Create Static Captions. See Generate a caption from
an image.

2. Start dragging, and press the arrow keys to determine the number of rows and columns. Use the Up Arrow
and Down Arrow keys to change the number of rows and the Left and Right arrow keys to change the
number of columns.

To change the spacing between frames, press Page Up or Page Down or hold down Ctrl (Windows) or
Command (Mac OS) while pressing the arrow keys.

To change the spacing between frames, hold down Ctrl (Windows) or Command (Mac OS) while pressing the
arrow keys.

3. Release the mouse button to place the grid of images.
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Reusing graphics and text
Ways to reuse graphics and text
Use snippets
Use object libraries

Ways to reuse graphics and text

InDesign offers several different ways to repurpose graphics and text.

Snippets

A snippet is a file that contains objects and describes their location relative to one another on a page or spread.
(See Use snippets.)

Object libraries

An object library provides a convenient place to store items such as logos, sidebars, pull-quotes, and other
repeating items. (See Use object libraries.)

Templates

A template is a document that includes placeholder text and graphics. (See Use document templates.)

Use snippets

A snippet is a file that holds objects and describes their location relative to one another on a page or page spread.
Use snippets to conveniently reuse and position page objects. Create a snippet by saving objects in a snippet file,
which has the .IDMS extension. (Previous InDesign versions use the .INDS extension.) When you place the snippet
file in InDesign, you can determine whether the objects land in their original positions or where you click. You can
store snippets in the Object library and in Adobe Bridge as well as on your hard disk.

Snippets contents retain their layer associations when you place them. When a snippet contains resource
definitions and these definitions are also present in the document to which it is copied, the snippet uses the
resource definitions in the document.

Snippets you create in InDesign CS5 can be opened in InDesign CS4 but not in any other previous version of
InDesign.

Create snippets
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Do one of the following:

Using a selection tool, select one or more objects, and then choose File > Export. From the Save As
Type (Windows) or Format (Mac OS) menu, choose InDesign Snippet. Type a name for the file and click
Save.

Using a selection tool, select one or more objects, and then drag the selection to your desktop. A
snippet file is created. Rename the file.

Select one or more objects, and then drag the selection to the Mini Bridge panel. A snippet file is
created. Rename the file.

Drag an item from Structure View to your desktop.

Add snippets to a document

1. Choose File > Place.
2. Select one or more snippet (*.IDMS or *.INDS) files.
3. Click the loaded snippet cursor where you want the upper-left corner of the snippet file to be.

If you placed the insertion point in a text frame, the snippet is placed in the text as an anchored object.

All objects remain selected after you place the snippet. By dragging, you can adjust the position of all
objects.

4. If you loaded more than one snippet, scroll and click the loaded snippet cursor to place the others.

You can drag a snippet file from your desktop into the InDesign document and click where you want the upper-left
corner of the snippet to be.

Choose how to place snippets

Rather than place snippet objects according to where you click on a page, you can place them in their original
locations. For example, a text frame that appeared in the middle of a page when it was made part of a snippet can
appear in the same location when you place it as a snippet.

In File Handling preferences, choose Original Location from the Position At menu to preserve objects’ original
locations in snippets. Choose Cursor Location from the Position At menu to place snippets according to where
you click a page.

You can press Alt (Windows) or Option (Mac) to override the Position setting you selected for handling snippets.
For example, if you selected Position At Cursor Location but you want to place snippet objects in their original
locations, hold down the Alt/Option key when you click the loaded snippet cursor on the page.

Use object libraries

Object libraries help you organize the graphics, text, and pages you use most often. You can also add ruler guides,
grids, drawn shapes, and grouped images to a library. You can create as many libraries as you need—for example,
you can create different object libraries for varied projects or clients.

During a work session, you can open as many libraries as system memory will allow. Object libraries can be shared
across servers, and across platforms, but only one person can have the library open at a time. If an object library
includes text files, make sure that the file’s fonts are available and active on all systems that will access the library.



When you add a page element, such as a graphic, to an object library, InDesign preserves all attributes that were
imported or applied. For example, if you add a graphic from an InDesign document to a library, the library copy
will duplicate the original, including the original’s link information, so that you can update the graphic when the file
on disk changes.

If you delete the object from the InDesign document, the object’s thumbnail will still appear in the Library panel,
and all of the link information will remain intact. If you move or delete the original object, a missing link icon will
appear next to the object’s name in the Links panel the next time you place it in your document from the Library
panel.

Within each object library, you can identify and search for an item by title, by the date it was added to the library,
or by keywords. You can also simplify the view of an object library by sorting the library items and displaying their
subsets. For example, you can hide all items except EPS files.

Object library in Library panel

A. Object thumbnail and name B. Library Item Information button C. Show Library Subset button D. New Library Item button E. Delete
Library Item button 

When adding an item to an object library, InDesign saves all page, text, and image attributes, and maintains
interrelationships among library objects and other page elements in the following ways:

Elements grouped in an InDesign document when dragged to the Library panel stay grouped when dragged
out of the Library panel.

Text retains its formatting.

Paragraph styles, character styles, and object styles that have the same name as styles used in the
destination document are converted to the destination document’s styles; those that have different names
are added to the document.

The original layers of an object are preserved when the Paste Remembers Layers option is selected in the
Layers panel menu.

Create an object library

An object library exists as a named file on disk. When you create an object library, you specify where to store it.
When you open a library, it appears as a panel that you can group with any other panel; the object library’s file
name appears in its panel tab. Closing an object library removes it from the current session, but doesn’t delete its
file.

You can add or remove objects, selected page elements, or an entire page of elements to or from an object
library. You can also add or move library objects from one library to another.

1. Choose File > New > Library.
2. Specify a location and name for the library, and click Save. Remember that the name you specify becomes

the name of the library’s panel tab.

Open an existing library

Do one of the following:



If you’ve already opened a library in the current session (and haven’t closed it), choose the library file
in the Window menu.

If you have not opened a library, choose File > Open, and select one or more libraries. In Windows,
library files use the INDL extension. InDesign converts newly opened libraries from previous versions of
the program to the new library format; you are asked to save these libraries under a new name.

Close a library

1. Click the tab for the library you want to close.
2. Do one of the following:

Choose Close Library in the Object Library panel menu.

Choose the library file name on the Window menu.

Delete a library

In Explorer (Windows) or Finder (Mac OS), drag a library file to the Recycle Bin (Windows) or Trash
(Mac OS). In Windows, library files have the INDL extension.

Add an object or page to a library

Do any of the following:

Drag one or more objects from a document window to an active Object Library panel.

Select one or more objects in a document window, and click the New Library Item button in the Object
Library panel.

Select one or more objects in a document window, and choose Add Item in the Object Library panel
menu.

Choose Add Items On Page [number] As Separate Objects in the Object Library panel menu to add all
the objects as separate library objects.

Choose Add Items On Page [number] in the Object Library panel menu to add all the objects as one
library object.

Drag an element from the Structure pane to an active Object Library panel.

If you hold down Alt (Windows) or Option (Mac OS) while you perform any of the above commands, the Item
Information dialog box appears as the item is added to the library.

Add an object from a library to a document

Do one of the following:

Drag an object from the Object Library panel to a document window.

In the Object Library panel, select an object, and choose Place Item(s) in the Object Library panel
menu. This method places the object at its original X,Y coordinates.

Drag an XML element to a parent element in the Structure pane or to the page.



Manage library objects

Use the Object Library panel to manage objects.

Update a library object with a new item

1. In the document window, select the item you want to add to the Library panel.
2. In the Library panel, select the object you want to replace, and then choose Update Library Item from the

Object Library panel menu.

Copy or move an object from one library to another

1. Drag one library’s panel tab out of the Object Library panel group to separate them, so you can see both
libraries at the same time.

2. Do one of the following:

To copy an object from one library to another, drag an item from one Library panel tab to the other.

To move an object out of one library into another, hold down Alt (Windows) or Option (Mac OS), and
drag an item from one Library panel tab to the other.

Delete an object from an object library

In the Object Library panel, select an object, and do one of the following:

Click the Delete Library Item button.

Drag the item to the Delete Library Item button.

Choose Delete Item(s) in the Object Library panel menu.

Change the object library display

The object library displays objects as thumbnails or as a text list. You can sort the thumbnails or list by object
name, age, or type. The list view and sorting options work best if you’ve cataloged the objects.

Do any of the following:

To view objects as thumbnails, choose Thumbnail View or Large Thumbnail View from the Object
Library panel menu.

To view objects as a text list, choose List View from the Object Library panel menu.

To sort the objects, choose Sort Items from the Object Library panel menu, and choose a sort method.

View all objects

Choose Show All in the Object Library panel menu.



View, add, or edit library information

With large or numerous object libraries, library information can be cataloged using the display objects’ names, by
type of object, or words in a description.

1. In the Object Library panel, do one of the following:

Double-click any object.

Select an object, and click the Library Item Information button.

Select an object, and choose Item Information in the Object Library panel menu.

2. View or change the Item Name, Object Type, or Description options as necessary, and click OK.

Find objects in a library

When you search for objects, all objects except the results of your search are hidden from view. You can also use
the search feature to show and hide specific categories of objects. For example, you can display only object items
with the word “star” in their names.

1. Choose Show Subset in the Object Library panel menu, or click the Show Library Subset button.
2. Do one of the following:

To search all objects in the library, select Search Entire Library.

To search only within the objects currently listed in the library (refining a previous search), select
Search Currently Shown Items.

3. Choose a category in the first menu in the Parameters section.
4. In the second menu, specify whether the category you chose in the first menu must be contained in or

excluded from the search.
5. To the right of the second menu, type a word or phrase you want to search for within the category you

specified.
6. To add search criteria, click More Choices up to five times; each click adds one search term. To remove

search criteria, click Fewer Choices as necessary; each click removes one search term.
7. To display only those objects that match all search criteria, select Match All. To display objects that match

any of the criteria, select Match Any One.
8. Click OK to begin the search.

To show all objects again, choose Show All in the Object Library panel menu.

Adobe also recommends
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Ruler guides
Create ruler guides
Work with ruler guides
Use smart guides

Create ruler guides

Ruler guides are different from grids in that they can be positioned freely on a page or on a pasteboard. You can
create two kinds of ruler guides: page guides, which appear only on the page on which you create them, or spread
guides, which span all pages and the pasteboard of a multiple-page spread. You can drag any ruler guide to the
pasteboard. A ruler guide is displayed or hidden with the layer on which it was created.

New ruler guides always appear on the target spread. For example, if several spreads are visible in the document
window and you drag a new guide into the window, the new guide becomes visible only on the target spread.

Guides in the document window

A. Spread guide B. Page guide 

Create a ruler guide

1. Make sure that both rulers and guides are visible, make sure the correct spread is targeted, and view the
document in Normal View mode, not Preview mode.

2. If the document contains multiple layers, click a layer name in the Layers panel to target the layer.
3. Do one of the following:

To create a page guide, position the pointer inside a horizontal or vertical ruler and then drag to the
desired location on the target spread. If you drop the guide onto the pasteboard, it spans the
pasteboard and spread; it will act as a page guide if you later drag it onto a page.

To create a spread guide, drag from the horizontal or vertical ruler, keeping the pointer in the
pasteboard but positioning the guide at the desired location on the target spread.

To toggle between horizontal and vertical guides, select the guide and hold down Alt (Windows) or
Option (Mac OS).

To create a spread guide when the pasteboard is not visible (for example, when you’ve zoomed in),
press Ctrl (Windows) or Command (Mac OS) as you drag from the horizontal or vertical ruler to the
target spread.

To create a spread guide without dragging, double-click a specific position on the horizontal or vertical
ruler. If you want to snap the guide to the nearest tick mark, hold down the Shift key when you
double-click the ruler.

To create vertical and horizontal guides simultaneously, press Ctrl (Windows) or Command (Mac OS) as
you drag from the target spread’s ruler intersection to the desired location.
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A vertical and horizontal guide created concurrently

To reposition a ruler guide numerically, select the guide and enter values for X and Y in the Control panel.

Create a set of evenly spaced page guides

1. If the document contains multiple layers, click a layer name in the Layers panel to target the layer.
2. Choose Layout > Create Guides.
3. For Number, type a value to specify the number of rows or columns you want to create.
4. For Gutter, type a value to specify the spacing between rows or columns. Start with a low value, such as 1

pica; large gutters leave little space for columns.

Columns created with the Create Guides command are not the same as those created with the Layout >
Margins And Columns command. For example, columns created using Create Guides cannot control text flow
when a text file is placed. Use the Margins And Columns command to create major column divisions
appropriate for autoflow text, and use the Create Guides command to create column grids and other layout
aids.

5. For Fit Guides To, click Margins to create the guides within the page margins, or click Page to create the
guides within the page edges.

Ruler guides evenly spaced within page margins (left) and page edges (right)

6. To delete any existing guides (including guides on locked or hidden layers), select Remove Existing Ruler
Guides.

7. If you like, select Preview to see the effect of your settings on the page, and then click OK.

Note:

The Create Guides command can create page guides only; it cannot create spread guides.

To space existing guides a uniform distance apart, select the guides (by dragging or pressing Shift as you click with
the mouse). Then, select Use Spacing from the Control panel, type the space value in the text box, and press
Enter or Return to confirm. Click either Distribute Horizontal Centers  or Distribute Vertical Centers  to the left
of the Use Spacing option.

Show or hide guides

To show or hide all margin, column, and ruler guides, choose View > Grids & Guides > Show/Hide Guides.
To show or hide ruler guides on one layer only without changing the visibility of the layer’s objects, double-
click the layer name in the Layers panel, select or deselect Show Guides, and then click OK.
To show or hide guides and all other non-printing elements, click the Preview Mode icon  at the bottom
of the Toolbox.

Work with ruler guides

You can change the attributes of individual ruler guides, and you can move, cut, copy, paste, or delete multiple
ruler guides simultaneously. Cut or copied ruler guides can be pasted to other pages or documents, but not to
other programs. To change attributes of specific guides, you must select the guides you want to change. When no
guides are selected, the Ruler Guides command sets the defaults for new guides only.



Select ruler guides

Unselected ruler guides appear light blue by default. Selected ruler guides are highlighted in their layer color.
When a guide is selected, the Reference Point icon in the Control panel changes to  or , representing the
selected guide.

To select a single ruler guide, use the Selection tool  or the Direct Selection tool  and click the guide to
highlight it in its layer color.

If you can’t select a ruler guide and the View > Grids & Guides > Lock Guides command is already deselected, the
guide might be on that page’s master, or on a layer where guides are locked.

To select multiple ruler guides, hold down Shift as you click guides using the Selection or Direct Selection
tool. You can also drag over multiple guides, as long as the selection marquee doesn’t touch or enclose any
other object.
To select all ruler guides on the target spread, press Ctrl+Alt+G (Windows) or Command+Option+G (Mac
OS).

Move ruler guides

Using Selection tool  or the Direct Selection tool , do any of the following:

To move a ruler guide, drag it.

To move multiple ruler guides, shift-select the guides you want to move, and then drag them.

Move selected guides just as you would any other selected object, including nudging with the arrow
keys and using the Control or Transform panels.

To make a guide snap to a ruler tick mark, press Shift as you drag it. Or select the guide, press and
hold down the Shift key, and then click the mouse button.

To move a spread guide, drag the part of the guide that’s on the pasteboard, or press Ctrl (Windows)
or Command (Mac OS) as you drag the guide from within the page.

To move guides to another page or document, select one or more guides, choose Edit > Copy or Edit >
Cut, go to another page, and then choose Edit > Paste. If you’re pasting onto a page of the same size
and orientation as the guides’ original page, the guides appear in the same position.

Note:

The Paste Remembers Layers option affects the layer on which pasted guides appear.

Delete ruler guides

To delete individual guides, select one or more ruler guides and then press Delete. (You can also drag ruler
guides and drop them on a ruler to delete them.)
To delete all ruler guides on the target spread, right-click (Windows) or Ctrl-click (Mac OS) a selected guide
or ruler, and choose Delete All Guides On Spread.



If you cannot delete a guide, it may be locked, it may be on a master page, or it may be on a locked layer.

Customize ruler guides

1. Do one of the following:

To change options for one or more existing ruler guides, select those ruler guides.

To set default options for new ruler guides, deselect all guides by clicking in an empty area.

2. Choose Layout > Ruler Guides.
3. For View Threshold, specify the magnification below which ruler guides do not appear. This prevents ruler

guides from appearing too close together at lower magnifications.
4. For Color, choose a color or choose Custom to specify a custom color in the system color picker. Then

click OK.

You can set the current magnification as the view threshold for new ruler guides by pressing Alt (Windows) or
Option (Mac OS) as you drag the ruler guides you’ve selected.

Lock or unlock ruler guides

To lock or unlock all ruler guides, choose View > Grids & Guides > Lock Guides to select or deselect the
menu command.
To lock or unlock ruler guides on one layer only, without changing the visibility of the layer’s objects, double-
click the layer name in the Layers panel, select or deselect Lock Guides, and then click OK.

Change ruler guide stacking order

By default, ruler guides appear in front of all other guides and objects. However, some ruler guides may block your
view of such objects as lines with narrow stroke widths. You can change the Guides in Back preference to display
ruler guides in front of or behind all other objects. However, regardless of the Guides in Back setting, objects and
ruler guides are always in front of margin and column guides. Also, although putting guides on different layers
organizes them structurally, it does not affect their visual stacking order—the Guides in Back preference stacks all
ruler guides as a single set in relation to all page objects.

Default stacking order

A. Ruler guides B. Page objects C. Margin and column guides D. Page 

1. Choose Edit > Preferences > Guides & Pasteboard (Windows) or InDesign > Preferences > Guides &
Pasteboard (Mac OS).

2. Select Guides in Back, and click OK.

Snap objects to guides and grids

To precisely align objects to guides, use the Snap To Guides and Snap To Document Grid commands. Object
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edges will snap to (be pulled toward) the nearest grid intersection or guide when you draw, move, or resize the
objects.

The exact range within which an object snaps to guides is called the snap-to zone, which you can adjust. When
you select both the Snap To Guides and the Snap To Document Grid commands, the grid takes precedence.

Keep the following guidelines in mind as you align objects to guides and grids:

To snap an object to a guide, drag an object toward a guide until one or more of the object’s edges is within
the guide’s snap-to zone.

Guides must be visible for objects to snap to them. However, objects can snap to the document and baseline
grids whether the grids are visible or not.

Objects on one layer snap to ruler guides visible on any other layer. If you don’t want objects to snap to
guides on a certain layer, hide that layer’s guides.

To snap the text baseline to the baseline grid, choose Grid Alignment > Roman Baseline from the Control
panel menu or Paragraph panel menu. Alternatively, set Grid Alignment to Roman Baseline from the column
style Grid Settings.

For the baselines of text to snap to the baseline grid, press the Align to Baseline Grid button  for individual
paragraphs or paragraph styles.

1. Choose View > Grids & Guides and make sure that Snaps To Guides is selected (checked).

Note:

The Snap To Guides command controls both snapping to guides and snapping to the baseline grid.

2. To specify the snap-to zone, choose Edit > Preferences > Guides & Pasteboard (Windows) or InDesign >
Preferences > Guides & Pasteboard (Mac OS), type a value for Snap To Zone, and click OK. The Snap To
Zone value is always in pixels.

Use smart guides

The Smart Guides feature makes it easy to snap objects to items in your layout. As you drag or create an object,
temporary guides appear, indicating that the object is aligned with an edge or center of the page or with another
page item.

By default, the Smart Guides feature is selected. You can turn off smart guides, or you can turn off any of the
smart guide categories:

Smart Object Alignment

Smart object alignment allows for easy snapping to page item centers or edges. In addition to snapping, smart
guides dynamically draw to indicate which object is being snapped to.

Smart Dimensions

Smart dimension feedback appears when you’re resizing, creating, or rotating page items. For example, if you
rotate one object on your page 24 degrees, a rotation icon appears as you rotate another object close to 24
degrees. This hint lets you snap the object to the same rotation angle of the adjacent object. Similarly, as you
resize an object next to another object, a line segment with arrows at each end lets you snap the object to the
same width or height as the adjacent object.



Smart Spacing

Smart spacing lets you quickly arrange page items with the help of temporary guides that indicate when the
spacing between objects is even.

Smart Cursors

Smart cursor feedback appears in a gray box as X and Y values when you’re moving or resizing object or as a
measurement when you’re rotating values. The Show Transformation Values option in Interface preferences lets
you turn smart cursors on and off.

For a video tutorial on using smart guides, see www.adobe.com/go/lrvid4029_id.

Turn smart guides on or off

Choose View > Grids & Guides > Smart Guides.

Turn smart guide categories on or off

1. Open the Guides & Pasteboard preferences.
2. Indicate whether you want Align To Object Center, Align To Object Edge, Smart Dimensions, and Smart

Spacing turned on or off, and click OK.

To turn off smart cursors, which displays the X and Y values of objects you mouse over, deselect Show
Transformation Values in Interface preferences.

Change the appearance of smart guides

1. Open the Guides & Pasteboard section of the Preferences dialog box.
2. Choose a different color from the Smart Guides menu, and click OK.

Tips for using Smart Guides

Smart Guides take effect only on page items and intersections that are in the current page view. If you have
many objects on a page and are trying to align an object to another object or objects in particular, zoom in
on that area specifically.If you don’t want Smart Guides to snap to column guides, turn off Snap To Guides
temporarily by choosing View > Grids & Guides > Snap To Guides.The Smart Guides feature is accurate
regardless of zoom percentage, so it isn’t necessary to zoom in to see if two objects are really aligned at their
left edges, for example.

Adobe also recommends
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Règles et unités de mesure

Haut de la page

Modification des règles et des unités de mesure
Modification de l’origine
Mesure des objets
Présentation du panneau Informations

Pour plus d’informations et d’instructions, cliquez sur les liens ci-dessous.

Modification des règles et des unités de mesure
Vous pouvez modifier des unités de mesure personnalisées pour les règles affichées à l’écran et pour les panneaux et les boîtes de dialogue.
Vous pouvez modifier ces paramètres à tout moment ou remplacer temporairement l’unité de mesure courante par une valeur que vous saisissez.
Par défaut, les règles commencent dans le coin supérieur gauche de la page ou de la planche. Vous pouvez modifier cela en déplaçant l’origine
(voir la section Modification de l’origine).

Les repères, les grilles et les objets sont insensibles au changement d’unité de mesure. Par conséquent, dès lors que les marques de graduation
des règles s’ajustent à la nouvelle unité adoptée, elles risquent de ne plus s’aligner sur les objets comme auparavant.

Règles dans une fenêtre de document
A.  Graduation avec libellé B.  Graduation principale C.  Graduation secondaire

Vous pouvez définir différents systèmes de mesure pour les règles horizontales et verticales. Le système choisi pour la règle horizontale régit
entre autres les tabulations, les marges et les retraits. Bien qu’une double page se caractérise par sa propre règle verticale, toutes les règles
verticales adoptent les paramètres spécifiés dans la boîte de dialogue Unités et incréments.

Par défaut, les règles sont graduées en picas (un pica équivaut à 12 points). Vous pouvez néanmoins remplacer les unités de règles
personnalisées et déterminer la position des graduations principales sur une règle. Si, par exemple, vous définissez une valeur de 12 points pour
la règle verticale, une marque de graduation principale est reportée tous les 12 points sur cette règle (si le facteur d’affichage actif le permet). Les
étiquettes de graduation prennent en compte vos marques de graduation principales personnalisées. Par conséquent, dans notre exemple, la
graduation 3 de la règle désigne la troisième occurrence de l’incrément de 12 points, à savoir une valeur de 36 points.

Masquage ou affichage des règles
 En mode Affichage standard (Affichage > Mode écran > Normal), choisissez Affichage > Afficher les règles ou Masquer les règles.

Modification des unités de mesure et des règles
1. Choisissez Edition > Préférences > Unités et incréments (Windows) ou InDesign > Préférences > Unités et incréments

(Mac OS).

2. Pour modifier l’origine, dans le menu Origine de la liste déroulante Unités de la règle, utilisez l’une des méthodes suivantes :

Pour situer l’origine de la règle dans le coin supérieur gauche de chaque planche, cliquez sur Planche. La règle
horizontale s’étend sur toute la longueur de la planche.

Pour situer l’origine de la règle dans le coin supérieur gauche de chaque page, cliquez sur Page. La règle horizontale
commence à zéro pour chaque page d’une planche.

Pour situer l’origine de la règle au milieu du dos, choisissez l’option Dos. Sur la règle horizontale, les mesures sont alors
exprimées en valeurs négatives à gauche du dos et en valeurs positives à droite.

3. Pour modifier le système de mesure employé pour les règles, boîtes de dialogue et panneaux, sélectionnez le système
souhaité pour Horizontale et Verticale ou choisissez Personnalisées, puis saisissez le nombre de points auxquels vous voulez
voir la règle afficher des graduations principales.
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Si vous définissez un système de mesure autre que le point, la valeur du pas de la grille de ligne de base reste affichée en
points, tout comme la taille du texte et l’interligne.

4. Pour modifier la valeur à utiliser pour le corps du texte, choisissez l’option Points ou Pixels dans le menu Corps du texte.
Cette option est particulièrement utile lors de la création d’un document pour le Web.

5. Pour modifier la valeur à utiliser pour les paramètres d’épaisseur de contour, choisissez l’option Points, Millimètres ou Pixels
dans le menu Contour. Cette option est particulièrement utile lors de la création d’un document pour le Web.

6. Pour modifier la valeur à utiliser pour le calcul des points, spécifiez le corps par pouce voulu pour Points/pouce.

7. Définissez l’un des incréments clavier suivants :

Touche curseur Contrôle l’incrément des touches de direction lors du déplacement d’objets à l’aide du clavier.

Taille/Interligne Contrôle l’incrément pour l’augmentation ou la réduction du corps ou de l’interligne à l’aide des raccourcis
clavier.

Décalage vertical Contrôle l’incrément pour le décalage de la ligne de base à l’aide des raccourcis clavier.

Crénage/Approche Contrôle l’incrément pour le crénage et l’approche à l’aide des raccourcis clavier.

8. Cliquez sur le bouton OK.

Pour changer rapidement les unités de la règle, cliquez sur une règle avec le bouton droit de la souris (Windows) ou en maintenant la touche
Contrôle enfoncée (Mac OS), puis choisissez une unité dans le menu contextuel. Cliquez sur l’intersection des règles horizontale et verticale
avec le bouton droit de la souris ou en maintenant la touche Contrôle enfoncée (Mac OS) pour modifier les unités des deux règles
simultanément.

Remplacement des unités de mesure par défaut
Vous pouvez spécifier une unité de mesure différente de l’unité de mesure par défaut.

 Mettez en surbrillance la valeur dans un panneau ou une boîte de dialogue, puis saisissez une nouvelle valeur d’après le tableau ci-dessous.

Unité : Entrez les lettres suivantes à la suite de la valeur : Exemples Résultat

Pouces p

po

pouce

"

5,25 p

5,25 po

5,25 pouces

5,25”

5 pouces 1/4

Millimètres mm 48 mm 48 millimètres

Centimètres cm 12 cm 12 centimètres

Picas p 3 p 3 picas

Points pt

p (devant la valeur)

6 pt

p6

6 points

Picas et points p (entre les valeurs) 3 p6 3 picas, 6 points

Pixels px 5px 5 pixels

Cicéros c 5 c 5 cicéros

Agates ag 5 ag agates

Modification de l’origine
L’origine est le point d’intersection du zéro de la règle horizontale avec celui de la règle verticale. Par défaut, l’origine se situe à l’angle supérieur
gauche de la première page d’une planche. Sa position par défaut est donc fixe sur une planche, mais variable sur la table de montage.

Les coordonnées X et Y des panneaux Contrôle, Informations et Transformation varient en fonction de l’origine que vous pouvez déplacer pour
mesurer des distances, définir un nouveau point de référence pour les mesures ou agencer en mosaïque les pages hors gabarit. Par défaut,
l’origine unique d’une planche est située à l’angle supérieur gauche de la première page. Rien ne vous empêche de la positionner sur le dos de
reliure ou de définir une origine différente sur chacune des pages d’une planche.
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Réglage de l’origine
Lorsque vous déplacez l’origine, elle adopte la même position relative sur toutes les planches. Si, par exemple, vous déplacez l’origine dans
l’angle supérieur gauche de la seconde page d’une double page, elle s’affiche à cet emplacement sur la seconde page de toutes les autres
doubles pages du document.

 Utilisez l’une des méthodes suivantes :

Pour déplacer l’origine, en partant de l’intersection des règles horizontale et verticale, faites glisser l’origine vers son nouvel
emplacement.

Définition d’une nouvelle origine

Pour réinitialiser l’origine, cliquez deux fois sur le point d’intersection des règles horizontale et verticale .

Pour verrouiller ou déverrouiller l’origine, cliquez avec le bouton droit de la souris (Windows) ou en maintenant la touche
Contrôle enfoncée (Mac OS) sur le point d’origine des règles, puis choisissez Verrouiller l’origine dans le menu contextuel.

Modification de l’origine par défaut
Le paramètre Origine de la boîte de dialogue Préférences permet de définir l’origine des règles ainsi que l’étendue de la règle horizontale.
L’étendue de la règle peut correspondre à la largeur de la page ou de la planche entière ou encore, dans le cas de planches à plusieurs pages,
partir du centre du dos.

Si vous définissez l’origine de la règle sur le dos de reliure de chaque planche, le point d’origine est verrouillé sur le dos. Vous ne pourrez plus
repositionner l’origine de la règle en la faisant glisser depuis l’intersection des règles sauf si vous choisissez une autre option pour l’origine.

1. Choisissez Edition > Préférences > Unités et incréments (Windows) ou InDesign > Préférences > Unités et incréments
(Mac OS).

2. Dans la section Unités de la règle du menu Origine, utilisez l’une des méthodes suivantes :

Pour situer l’origine de la règle dans le coin supérieur gauche de chaque planche, cliquez sur Planche. La règle
horizontale s’étend sur toute la longueur de la planche.

Pour situer l’origine de la règle dans le coin supérieur gauche de chaque page, cliquez sur Page. La règle horizontale
commence à zéro pour chaque page d’une planche.

Pour situer l’origine de la règle au milieu du dos, choisissez l’option Dos. Sur la règle horizontale, les mesures sont alors
exprimées en valeurs négatives à gauche du dos et en valeurs positives à droite.

Vous pouvez aussi modifier le point d’origine de la règle horizontale à l’aide du menu contextuel qui s’affiche lorsque vous cliquez avec le
bouton droit de la souris (Windows) ou en maintenant la touche Contrôle enfoncée (Mac OS) sur la règle horizontale.

Mesure des objets
L’outil Mesure calcule la distance entre deux points quelconques de la fenêtre de document. La distance entre les points s’affiche dans le panneau
Informations. Toutes les mesures, sauf la valeur de l’angle, sont calculées dans l’unité définie pour le document en cours.

Après avoir utilisé l’outil Mesure pour mesurer un élément, les lignes restent visibles jusqu’à ce que vous preniez une autre mesure ou que vous
sélectionniez un autre outil.

Pour mesurer la distance entre deux points
1. Vérifiez que le panneau Informations est visible (Fenêtre > Informations).

2. Sélectionnez l’outil Mesure  (cliquez sur l’outil Pipette et maintenez le bouton de la souris enfoncé pour afficher l’outil
Mesure).

3. Cliquez sur le premier point et faites glisser vers le second point. Faites glisser tout en maintenant la touche Maj enfoncée
pour contraindre le déplacement de l’outil à des angles multiples de 45°. Vous ne pouvez pas faire glisser au-delà d’un plan
de travail et de la planche correspondante.

Les mesures de largeur et de hauteur apparaissent dans le panneau Informations.



Haut de la page

Pour mesurer les angles
1. Vérifiez que le panneau Informations est visible (Fenêtre > Informations).

2. Sélectionnez l’outil Mesure  (cliquez sur l’outil Pipette et maintenez le bouton de la souris enfoncé pour afficher l’outil
Mesure).

3. Utilisez l’une des méthodes suivantes :

Pour mesurer un angle depuis l’axe des x, faites glisser l’outil.

Pour mesurer un angle personnalisé, faites glisser pour créer le premier segment de l’angle. Placez l’outil sur l’une des
extrémités de la ligne de mesure. Pour créer la seconde ligne de l’angle, cliquez deux fois et faites glisser la souris, ou
maintenez la touche Alt (Windows) ou Option (Mac OS) enfoncée tout en faisant glisser la souris.

Lorsque vous mesurez un angle personnalisé, le panneau Informations affiche la longueur du premier segment comme D1
et celle du second segment comme D2.

Présentation du panneau Informations
Ce panneau affiche les informations sur les objets sélectionnés, le document actif ou sur la zone située directement sous l’outil utilisé, y compris
les valeurs de position, taille et rotation. Lorsque vous déplacez un objet, le panneau affiche également sa position par rapport au point de départ.

Le panneau Informations est également utile pour déterminer les nombres de mots et de caractères figurant dans des articles.

A la différence des autres panneaux InDesign, le panneau Informations est conçu uniquement pour être consulté ; vous ne pouvez ni entrer ni
modifier les valeurs affichées. Vous pouvez visualiser d’autres détails en sélectionnant Afficher les options dans le menu du panneau.

Panneau Informations
A.  Position horizontale (X) du pointeur B.  Position verticale (Y) du pointeur C.  Distance de déplacement d’un objet ou d’un outil par rapport à
sa position initiale D.  Largeur en unités courantes E.  Hauteur en unités courantes F.  Angle de rotation

Pour afficher le panneau Informations
 Choisissez Fenêtre > Informations.

Pour modifier le système de mesure en cours, cliquez sur le petit triangle à côté de l’icône Plus.

Pour afficher le nombre de mots
1. Placez le point d’insertion à l’intérieur d’un bloc de texte ou sélectionnez le texte.
2. Choisissez Fenêtre > Informations.

Le panneau Informations affiche le nombre de mots et de caractères contenus dans l’article ou le texte sélectionné. S’il existe du texte en excès,
un signe « + » s’affiche, suivi d’une valeur indiquant les caractères, mots ou lignes en excès.

Pour afficher des options supplémentaires du panneau Informations
 Sélectionnez Afficher les options dans le menu du panneau Informations.

Vous pouvez visualiser différentes options selon l’objet ou l’outil sélectionné :

Valeurs des couleurs de fond et de contour de l’objet sélectionné, et informations sur les dégradés .

Nom des nuances. Vous pouvez afficher les valeurs de l’espace colorimétrique en cliquant sur le petit triangle en regard de
l’icône de fond ou de contour.

Informations sur le document actif, telles que l’emplacement, la date de la dernière modification, le nom de l’auteur et la taille
du fichier, lorsque rien n’est sélectionné dans le document.

Nombre de caractères, mots, lignes et paragraphes lorsque vous créez un point d’insertion de texte ou que vous sélectionnez
un texte avec l’un des outils Texte. S’il existe du texte en excès, un signe « + » s’affiche, suivi d’une valeur indiquant les
caractères, mots ou lignes en excès.

Type de fichier, résolution et espace colorimétrique lorsque vous sélectionnez un fichier graphique. La résolution s’affiche sous
forme de pixels réels par pouce (la résolution du fichier graphique natif) et de pixels effectifs par pouce (la résolution du
graphique redimensionné dans InDesign). Si la gestion des couleurs est activée, le profil colorimétrique ICC s’affiche
également.

Angle de déformation ou la valeur d’échelle horizontale ou d’échelle verticale si l’outil Déformation, Mise à l’échelle ou
Transformation manuelle est sélectionné.

Voir aussi
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Transforming objects
Transform panel overview
Change transformation settings
Transform objects
Rotate objects
Move objects
Scaling vs. resizing objects
Resize objects
Scale objects
Reflect (flip) objects
Shear (skew) objects
Repeat transformations
Clear transformations

Transform panel overview

Use the Transform panel to view or specify geometric information for any selected object, including values for
position, size, rotation, and shearing. Commands in the Transform panel menu provide additional options and quick
ways to rotate or reflect objects.

Note:

The buttons and panel menu commands in the Transform panel are also available in the Control panel.

Transform panel

A. Reference point locator B. Constrain Proportions icon C. Panel menu 

Display the Transform panel

Choose Window > Object & Layout > Transform.

View geometric information about objects

When you select an object, its geometric information appears in the Transform and Control panels. If you select
multiple objects, the information represents all selected objects as a unit.

Select one or more objects, and display the Transform panel (Window > Object & Layout > Transform).

Position information is relative to the ruler origin and the reference point of the object. Angle information is
relative to the pasteboard, where a horizontal line has an angle of 0°.
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The Transform panel includes several options that determine how objects are transformed and how
transformations are displayed in the Transform and Control panels.

Change the reference point for selected objects

All transformations originate from a fixed point on or near the object, called the reference point. An icon  is
displayed at the reference point when a transformation tool, such as the Scale tool, is active.

Reference point moved to center (left), and object scaled (right)

Do one of the following:

To specify a different reference point for the selected object, click any of the nine points on the
reference point locator  in the Transform or Control panel.

As you click different reference points on the Transform or Control panel (top left and right), the
reference point for the selected object changes (bottom left and right).

To move the selected object’s reference point to a specific location, select the Rotate tool , the Scale
tool , or the Shear tool , position the tool over the reference point icon, and then drag it to a new
location. Or, with one of these tools selected, click anywhere on the object or page. The reference point
moves to that location.

Note:

When a transform tool is selected, clicking away from the object does not deselect it— it moves the reference
point. Choose Edit > Deselect All to deselect an object.

The last-selected reference point on the reference point locator becomes the new default reference point for all
tools and objects. If you drag an object’s reference point icon to a custom location (not on an anchor point), the
panel reference point returns to the default position once the current object is no longer selected. InDesign
preserves the default reference point position for new documents so you don’t have to reset it.



Change the information displayed for nested objects

The Transform panel orients an object to a spread’s pasteboard, where a horizontal line has a rotation angle of 0°.
By default, this is true even if the object is nested inside a transformed container object (that is, if the object is
part of a transformed group or pasted inside a transformed frame). For example, if you paste an unrotated graphic
inside a frame, rotate the frame 10° with the graphic inside, and then select the graphic using the Direct Selection
tool, the Transform panel displays the graphic’s rotation angle as 10°.

Object’s rotation angle displayed relative to pasteboard

If you prefer, you can deselect the Transformations Are Totals command to see the same information relative to
the nested object’s container. In the example above, if you deselect Transformations Are Totals, the Transform
panel displays the graphic’s rotation angle as zero (the angle it has relative to its rotated container).

Object’s rotation angle displayed relative to container object

1. Open the Transform panel or Control panel.
2. In the Transform or Control panel menu, do one of the following:

Leave Transformations Are Totals selected (the default) to display transformation values for nested
objects relative to the pasteboard.

Deselect Transformations Are Totals to display rotate, scale, and shear values for nested objects relative
to the container object.

Measure the position of selected objects

The Show Content Offset command determines the appearance of the X and y values in the Transform panel for
nested objects selected with the Direct Selection tool . The selected reference point in the reference point locator
of the Transform and Control panels determines which of the nine reference points on the selected object is being
compared to the zero point of the document or to the zero point of a container frame. The zero point of a
container frame is always its upper-left corner.

The position of selected objects is measured from three positions:

The position of the container frame in relation to the zero point of the document. With Show Content Offset
turned on or off, select the container frame using the Selection tool.

The position of the nested object in relation to the zero point of the document. Turn off Show Content Offset
and select the nested object using the Direct Selection tool.

The position of the nested object in relation to the zero point (upper-left corner) of its container frame. Turn
on Show Content Offset and select the nested object using the Direct Selection tool.

Parent frame’s position displayed relative to zero point of document

Nested object’s position displayed relative to zero point of document
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Nested object’s position displayed relative to container frame

If Show Content Offset is selected, the X and Y values of the embedded object appear relative to the container
object, and the X/Y icons in the Transform panel change to X+/Y+. If this command is deselected, the nested
object values appear relative to the rulers.

In the Transform or Control panel menu, select or deselect Show Content Offset.

Include or exclude stroke weight in measurements

Stroke weight can affect an object’s size and position. You can change the stroke’s alignment and then choose
whether the Transform panel measures an object’s size and position from the center or from the edge of its stroke.
For information on changing stroke alignment, see Stroke panel options.

Note:

This option does not change how stroke weights are affected when scaling a frame, only whether any changes
affect measurements.

In the Transform or Control panel menu, do one of the following:

Select Dimensions Include Stroke Weight when you want panel measurements to represent the outer
edge of an object’s stroke. For example, if one frame is 2 points shorter than the other, but the shorter
frame’s stroke is 2 points thicker, this setting will cause both frames to display the same height values
in the Transform and Control panels.

Deselect Dimensions Include Stroke Weight when you want the panel measurements to represent an
object’s path or frame regardless of its stroke weight. For example, two frames of the same height will
display the same height values in the Transform and Control panels, regardless of differences in their
stroke weights.

Transform objects

You can modify an object’s size or shape, and change its orientation on the pasteboard, by using tools and
commands. The toolbox includes four transformation tools—the Rotate, Scale, Shear, and Free Transform tools. In
addition, you can use the Selection tool to transform objects. All transformations, with the addition of reflection,
are available in the Transform and Control panels, where you can precisely specify transformations.

Transformation tools (top) compared to Transform panel (bottom)

A. Rotation options B. Shearing options C. Scaling options 

When transforming objects, note the following:

The results of a transformation can differ significantly, depending on what is selected. For example, when you
rotate an image, what gets rotated depends on whether you select the image, the frame, or the frame and



the image. Use the Selection tool  to transform (rotate, scale, or shear) an entire path and its content (click
outside the content grabber); use the Direct Selection tool  to transform just the path without its content or
the content without its path. To transform the content without its path, make sure that all anchor points are
selected.

To resize both the frame and content, use the Scale X Percentage and Scale Y Percentage fields, not the W and H
fields. The W and H fields change only the selected frame or content, not both. Keep in mind that you’re not
limited to specifying percentages in the Scale fields. You can type dimensions by including the unit of
measurement, such as “6p.”

A transformation affects all selected objects as a single unit. For example, if you select multiple objects and
rotate them 30°, they all rotate around one reference point. If you want to rotate each selected object 30°
around its own reference point, you must select and rotate them individually.

When transforming type, you can use either of two selection methods: Use the Selection or Direct Selection
tool to select an entire text frame or text converted to outlines, and then use the transformation tools; or
use the Type tool to select text or to click an insertion point in a text frame, and then specify transformations
in the Transform panel, Control panel, or dialog boxes available when you double-click a tool. In both cases,
the transformation affects the entire text frame.

When you rotate, skew, or scale a group, the settings apply to the entire group, as well as to the individual
objects in the group. For example, if you rotate a group 30°, the rotation value in the Transform or Control
panel is 30° whether you select the group itself or direct-select an object in the group.

Transform objects with the Transform panel

Use the selection tools to determine whether the content and frame are transformed together or separately.

1. Select an object to transform.

To transform both the frame and its content, use the Selection tool to select the frame.

To transform the content without transforming its frame, use the Direct Selection tool  to direct-select
the object, or use the Selection tool to click the content grabber of an image.

To transform a frame without transforming the content, direct-select the frame, and select all the
anchor points.

2. In the Transform panel or Control panel, specify the reference point for the transformation.

All values in the panel refer to the bounding boxes of the objects. X and Y values refer to the selected
reference point on the bounding box relative to the ruler origin.

3. Do any of the following:
Enter new values in the text boxes.
Choose values from available pop-up menus.
Choose commands from the panel menu

Note:

To maintain the object’s proportions when using the Scale X Percentage and Scale Y Percentage options, click
the Constrain Proportions icon  in the panel. When the option is not selected, dots appear on both sides of
the icon (like a broken chain link). You can also specify dimensions rather than percentages by specifying the
unit of measurement, such as 6p.

4. Press Tab, Enter (Windows), or Return (Mac OS) to apply the change.
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Transform objects with the Selection tool

Use the Selection tool to move, resize, and rotate objects.

1. Using the Selection tool , select an object. To transform an image within a frame, click the content grabber
that appears when you hold the pointer over an image.

2. Do any of the following:

To move objects, click anywhere within the bounding box, and then drag.

To scale objects, hold down Ctrl (Windows) or Command (Mac OS), and drag any bounding box handle
until the object is the desired size. Include the Shift key to preserve the selection’s proportions. Include
the Alt (Windows) or Option (Mac OS) key to scale objects from the center.

To rotate objects, position the pointer anywhere outside a bounding box handle. When the pointer
changes to , drag until the selection is at the desired angle of rotation.

To reflect objects, drag a handle of the bounding box past the opposite edge or handle, until the object
is at the desired level of reflection.

Transform objects with the Free Transform tool

The Free Transform tool works the same way it does in Adobe Photoshop and Adobe Illustrator, by providing a
way to perform any transformation with just one tool. You can combine transformations, such as rotating and
scaling, while the Free Transform tool is active.

You can use keyboard shortcuts to instantly switch among the Free Transform tool (press E), the Selection tool (V),
and the Direct Selection tool (A).

1. Using the appropriate selection tool, select the object or objects to transform.
2. Select the Free Transform tool .

To move objects, click anywhere within the bounding box, and then drag.

To scale objects, drag any bounding box handle until the object is the desired size. Shift-drag the
handle to preserve the selection’s proportions.

To scale objects from the center of the bounding box, Alt-drag (Windows) or Option-drag (Mac OS).

To rotate objects, position the pointer anywhere outside the bounding box. When the pointer changes
to , drag until the selection is at the desired angle of rotation.

To reflect objects, drag a handle of the bounding box past the opposite edge or handle, until the object
is at the desired level of reflection.

To shear objects, begin dragging a handle, and then hold down Ctrl (Windows) or Command (Mac OS).
Hold down Alt+Ctrl (Windows) or Command+Option to shear from both sides of the object.

Rotate objects

You can rotate objects using any of several methods.



Rotate an object using the Rotate tool

1. Select an object to rotate. To rotate both the frame and its content, use the Selection tool to select the
frame. To rotate the content without rotating its frame, click the Content Grabber or use the Direct Selection
tool to select the object. To rotate a frame without rotating the content, direct-select the frame, and select
all the anchor points.

2. Select the Rotate tool .
3. If you want to use a different reference point for the rotation, click where you want the reference point to

appear.
4. Position the tool away from the reference point, and drag around it. To constrain the tool to multiples of 45°,

hold down Shift as you drag. For finer control, drag farther from the object’s reference point.

You can also rotate by using the Free Transform tool.

If Smart Guides (and Smart Dimensions) are turned on, visual clues indicate when you’re rotating an object the
same degree as a nearby rotated object. For example, if you rotate one object on your page 24 degrees, a rotation
icon appears as you rotate another object close to 24 degrees.

Rotate an object using the Selection tool

Using the Selection tool, position the pointer anywhere outside a selection handle. When the pointer changes
to , drag until the selection is at the desired angle of rotation.

Rotate an object using the Transform or Control panel

1. Select an object to rotate. To rotate both the frame and its content, use the Selection tool  to select the
frame. To rotate the content without rotating its frame, click the Content Grabber or use the Direct Selection
tool to select the object. To rotate a frame without rotating the content, direct-select the frame, and select
all the anchor points.

2. Do any of the following:

To rotate clockwise or counterclockwise in 90° increments, click either of the Rotate buttons in the
Control panel.

To rotate by a preset angle, choose an angle from the Rotation Angle  pop-up menu in the Transform
or Control panel.

In the Rotation Angle  box on the Transform or Control panel, type a positive angle to rotate selected
objects counterclockwise, or type a negative angle to rotate selected objects clockwise, and then press
Enter (Windows) or Return (Mac OS).

To create a copy of the object with the new rotation applied to the copy, type a value in the Rotation
Angle box on the Transform panel and then hold down Alt (Windows) or Option (Mac OS) as you press
Enter.

When you rotate a single object, the specified value remains displayed in the Transform or Control panel. When
you rotate multiple objects, the Rotation Angle is reset to 0 degrees, even though the objects are rotated.

Rotate an object using the Rotate command



To the top

You can use the Rotate command to rotate an object by a specific amount. This command also lets you rotate a
copy of the selected object, leaving the original in place.

1. Select an object to rotate. To rotate both the frame and its content, use the Selection tool to select the
frame. To rotate the content without rotating its frame, direct-select the object. To rotate a frame without
rotating the content, direct-select the frame, and select all the anchor points.

2. Do one of the following to open the Rotate dialog box:

Choose Object > Transform > Rotate.

Double-click the Rotate tool .

Select the Rotate tool and Alt-click (Windows) or Option-click (Mac OS) on or near the object to select
a new reference point.

3. Enter the rotation angle, in degrees, in the Angle box. Enter a negative angle to rotate the object clockwise;
enter a positive angle to rotate the object counterclockwise.

4. Do one of the following:

To preview the effect before you apply it, select Preview.

To rotate the object, click OK.

To rotate a copy of the object, click Copy.

Move objects

You can move objects by cutting them from one spot and pasting them into another, by entering new horizontal
and vertical coordinates, or by dragging them. Dragging also allows you to move a copy of an object or to copy
objects between software applications.

The Smart Guides feature makes it easy to move objects to precise locations in your layout. As you drag an object,
temporary guides appear, indicating that the object you’re moving is aligned with an edge or center of the page or
with another page item.

Move objects

For best results, use the Selection tool to move multiple objects. If you use the Direct Selection tool to select
multiple objects or paths, dragging moves only the selected graphic, path, or anchor points.

1. Select an object to move. To move both the frame and its content, use the Selection tool  to select the
frame. To move the content without moving its frame, direct-select the object, or click the content grabber
when you mouse over an image. To move a frame without moving the content, direct-select the frame, and
select all the anchor points.

2. Do one of the following:
To paste the object (or a copy of it) in a new location, choose Edit > Cut or Edit > Copy. Target the
destination spread, and choose Edit > Paste. The objects appear in the center of the target spread.
To paste a copy at the same position as the original, choose Edit > Copy. Then, choose Edit > Paste In
Place. (To offset the copy from the original, nudge it using the arrow keys.)

If you want an object to appear in the same position on many pages, consider creating a master page and
paste the object on it.

To move an object to a specific numeric location, type a value for each of the X (horizontal) or Y
(vertical) position options in the Transform or Control panel. Then press Enter (Windows) or Return



(Mac OS).

To nudge an object slightly in one direction, press or hold an arrow key; to nudge an object ten times
as far, hold down Shift as you press an arrow key.

To move an object by dragging, drag the object to a new position. Shift-drag to constrain the
movement of the object horizontally, vertically, or diagonally (in multiples of 45°).

Drag the content grabber to move an image within its frame.

Move objects by a precise amount

You can use the Move command to move an object by a specific amount. This command also lets you move a
copy of the selected object, leaving the original in place.

1. Select an object to move. To move both the frame and its content, use the Selection tool to select the frame.
To move the content without moving its frame, direct-select the object. To move a frame without moving the
content, direct-select the frame, and select all the anchor points.

2. Choose Object > Transform > Move, or double-click the icon for the Selection or Direct Selection tool in the
toolbox.

3. In the Move dialog box, do one of the following:

Enter the horizontal and vertical distances that you want the object to move. Positive values move the
object down and to the right of the x axis; negative values move the object up and to the left.

To move an object a precise distance and angle, enter the distance and angle for the move. The angle
you enter is calculated in degrees from the x axis. Positive angles specify a counterclockwise move;
negative angles specify a clockwise move. You can also enter values between 180° and 360°; these
values are converted to their corresponding negative values (for example, a value of 270° is converted
to –90°).

4. Do any of the following:

To preview the effect before you apply it, select Preview.

To move the object, click OK.

To move a copy of the object, click Copy.

Move objects to a precise location

1. Select an object to move.
2. If you want to use a different reference point for the move, click where you want the reference point to

appear.

For example, if you want to move the object to the upper-left corner of the page, select the upper-left
reference point.

3. In the X and Y fields on the Transform panel, enter the coordinates where you want the selection to be
moved.

Specify the distance objects move when nudged

1. Choose Edit > Preferences > Units & Increments (Windows) or InDesign > Preferences > Units & Increments
(Mac OS).

2. For Cursor Key, specify the distance you want each press of an arrow key to move selected objects, and then
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click OK.

If you hold down Shift while moving a selection, the selection moves ten times the distance you specify here.

Scaling vs. resizing objects

Resizing and scaling are different actions in InDesign. Resizing is simply changing the Width and Height values of
an object. Scaling involves using a percentage value related to the original scale (100%) of the frame.

The difference between resizing and scaling isn’t always apparent. A good way to see the difference is to resize
and scale a text frame that has a stroke applied to it. When you double the size of the text frame, the text size
and stroke weight remain the same. When you double the scale of the text frame, the text size and stroke weight
also double.

Resizing a frame

By default, when the frame (and not the frame contents) is selected, changing the values of the Width and Height
fields changes only the frame, not its contents, regardless of which selection tool is active.

Scaling a frame and its contents

When the frame is selected with the Selection tool, changing the values of the Scale X Percentage and Scale Y
Percentage fields changes the frame and its contents. If Auto-Fit is selected, the frame and its contents are
resized together.

Resizing or scaling frame contents

If you want to change only the content (resize or scale) of a frame, click the Content Grabber or use the Direct
Selection tool to select the contents. Once selected, you can use the Width and Height fields or the Scale fields,
depending on your preference.

Overriding defaults

If you want to scale the frame or its contents by a percentage and have the results returned in the current
measurement system, you can enter in a number with the percent sign to override the default measurement
system. For example, if the current width is 12p, and you want the new width to be 75% of the current value, you
can enter 75% in the Width field. After you press Enter, the new value for the Width displays as 9p.

Similarly, you can use other measurement system values if you want to scale to a specific increment but have the
results display in percent of the original. For example, you can replace 100% with 9p, and InDesign figures out
which percentage is required to make it that width/height.
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Resize objects

Dragging the handle of a frame that includes contents, such as an imported graphic, does not resize the contents
by default. It’s important to understand that the content and the container frame are separate items, each with its
own bounding box. Simply dragging the frame of an imported graphic will either crop the graphic or leave a blank
space outside the graphic, depending on which direction you drag. Being able to modify the frame apart from the
contents adds flexibility, but it takes some time to get used to.

The Smart Guides feature makes it easy to resize objects based on other items in your layout. As you resize an
object, temporary guides appear, indicating that the object is aligned with an edge or center of the page or is the
same height or width as another page item.

Resizing an imported graphic

A. Frame selected with Selection tool B. Frame resized C. Frame and content scaled 

To resize a frame, drag any handle using the Selection tool. If you hold down Ctrl (Windows) or Command
(Mac OS) while dragging, the frame and the content are scaled. Adding the Shift key scales proportionally.

Note:

If Auto-Fit is selected, resizing the frame resizes the image within the frame.

To resize the content of a graphics frame, use the Selection tool to click the content grabber or direct-select
the graphic, and then drag any of the graphics frame handles.
To resize a frame or its content to a precise size, select the object and enter the size in the width (W) or
height (H) fields on the Control panel.

To maintain the original proportions of the object when using the Control panel, make sure the Constrain
Proportions icon  is selected.

To resize both the frame and content, use the Scale X Percentage and Scale Y Percentage fields, not the W
and H fields. The W and H fields change only the selected frame or content, not both. Rather than specifying
percentages, you can type dimensions by including the unit of measurement, such as “6p.”
To resize a frame or its content to a percentage of its current size, select the object and enter the
percentage in the width or height fields on the Transform panel.
To create a copy of the selected object with the new size applied to the copy, type a value in the width or
height fields on the Transform panel and then hold down Alt (Windows) or Option (Mac OS) as you press
Enter.

After you resize a frame or object, you can use a fitting option (Object > Fitting) to fit the content to the frame or
the frame to the content.

Scale objects

Scaling an object enlarges or reduces it horizontally (along the x-axis), vertically (along the y-axis), or both
horizontally and vertically, relative to the reference point you specify.

By default, InDesign scales strokes. For example, if you scale a selected object with a 4-point stroke by 200%, the
Stroke panel indicates an 8-point stroke and the stroke visibly doubles in size. You can change the default stroke



behavior by deselecting Adjust Stroke Weight When Scaling in the Transform or Control panel menu.

Scale an object using the Selection tool

To scale the content and frame simultaneously, use the Selection tool to select the object and hold down Ctrl
(Windows) or Command (Mac OS). Add the Shift key to resize the object proportionally.

Scale an object using the Scale tool

1. Select an object to scale. To scale both the frame and its content, use the Selection tool to select the frame.
To scale the content without scaling its frame, click the Content Grabber to direct-select the object. To scale
a frame without scaling the content, direct-select the frame, and select all the anchor points.

2. Select the Scale tool .
3. Position the Scale tool away from the reference point and drag. To scale the x or y axis only, start dragging

the Scale tool along one axis only. To scale proportionally, hold down Shift as you drag the Scale tool. For
finer control, start dragging farther from the object’s reference point.

You can also scale by using the Free Transform tool.

Scale an object using the Transform panel

To maintain the original proportions of the object when using the Transform panel, make sure the Constrain
Proportions icon  is selected.

1. Select an object to scale. To scale both the frame and its content, use the Selection tool to select the frame.
To scale the content without scaling its frame, direct-select the object. To scale a frame without scaling the
content, direct-select the frame, and select all the anchor points.

2. In the Transform or Control panel, do one of the following:

Choose a preset percentage value in the Scale X Percentage  or Scale Y Percentage  pop-up menu.

Type a percentage value (such as 120%), or a specific distance (such as 10p) in the Scale X Percentage
or Scale Y Percentage box, and then press Enter or Return.

Scale an object using the arrow keys

1. Select or direct-select the object or frame.
2. In the Transform panel, click in the Scale X Percentage  or Scale Y Percentage  box.
3. Press the Up or Down Arrow Keys to scale the object by 1% increments. By pressing the Shift key at the

same time as the arrow keys you can scale the object by increments of 10%.

If you use this method to scale up by a percentage and scale down by that same percentage, the object returns to
the original scale value if Adjust Scaling Percentage is selected in General preferences. For example, if you scale a
20-mm circle up 10% and then down 10%, the circle returns to 20 millimeters (not 19.8 mm).

Scale an object using the Scale command

1. Select an object to scale. To scale both the frame and its content, use the Selection tool to select the frame.



To scale the content without scaling its frame, direct-select the object. To scale a frame without scaling the
content, direct-select the frame, and select all the anchor points.

2. Do one of the following to open the Scale dialog box:

Choose Object > Transform > Scale.

Double-click the Scale tool .

Select the Scale tool and Alt-click (Windows) or Option-click (Mac OS) on or near the object to select a
new reference point.

3. Type a percentage value in the Scale X or Scale Y box.

To maintain the original proportions of the object when using the Transform panel, make sure the Constrain
Proportions icon  is selected.

4. Do any of the following:

To preview the effect before you apply it, select Preview.

To scale the object, click OK.

To scale a copy of the object, click Copy.

Determine how scaling is tracked

You can determine how scaling is tracked in the interface. If the Apply To Content preference option is selected in
General preferences, scaling values are reset to 100% in the Transform panel after the object is scaled. If Adjust
Scaling Percentage is selected, scaling values remain as specified (such as 125%).

With multiple objects selected, the scaling value will always display as 100%. However, you can select objects
individually to see the applied effect of the transform (such as 125%) if Adjust Scaling Percentage is selected.

1. Choose Edit > Preferences > General (Windows) or InDesign > Preferences > General (Mac OS).
2. Under When Scaling, select Apply To Content or Adjust Scaling Percentage, and then click OK.

If Adjust Scaling Percentage is selected and you scale an object, you can choose Redefine Scaling As 100% from
the Transform or Control panel menu to reset the scaling percentages to 100%.

Adjust stroke weight when objects are scaled

Select the Adjust Stroke Weight When Scaling option in the Transform or Control panel menu.

For example, if you scale a 4-point stroke by 200% when this option is turned on, the stroke weight becomes 8
points. If you turn off this option, the object doubles in size but its stroke weight remains 4 points.

If this option is turned on and you scale an object disproportionally, InDesign applies the smallest stroke weight to
all sides. For example, suppose that you scale a selected object with a 4-point stroke only in the X direction by
200%. Instead of applying an 8-point stroke in the X direction and a 4-point stroke in the Y direction, InDesign
applies the smaller value (4 points) to all sides.

Scalability of an effect
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If you created an object, and apply an effect, the effect scales consistently in proportion to the object scaling. The
proportion in which you scale the object, the effect gets scaled in the same proportion.

In preferences, General > Apply to content > Include Effects. Deselect this option if you want only the objects to
scale and not the effects.

Preferences - Include Effects

Or

Window > Object & Layout > Transform. From the flyout menu, select Adjust Effects when Scaling to turn the
effect scalability on or off.

Adjust Scaling

This works similar to the way stroke effects work. So you can scale effects just like you scale strokes.

Reset scaling value to 100%

In some cases, if you want to reset the Scale X and Scale Y values of an object to 100% without resizing the
object. For example, if you opened a document from a previous version of InDesign that has non-100% scaling
values, or you have scaled an object with the Adjust Scaling Percentage preference setting selected. When you
choose this command, the scaling values for all selected frames are reset to 100%. Choosing this command does
not change the size or appearance of objects.

1. Select one or more objects that have non-100% scaling values.

This command is dimmed if you direct-select an imported image or if an object has 100% scaling values.

2. Choose Redefine Scaling As 100% from the Transform or Control panel menu.

Note:

Choosing this command may result in unexpected behavior with objects in transformed groups.

Reflect (flip) objects

Reflecting an object flips the object across an invisible axis at the reference point you specify. (See Change
transformation settings.)

Original object (top) reflected using Flip Horizontal (middle) and Flip Vertical (bottom)

The flip/rotate indicator (P) in the middle of the Control panel appears white with a black outline if an object is
flipped. If the object is not flipped, the indicator is solid black.

http://idiom-q-win-1/content/help/en/indesign/using/transforming-objects.html#main-pars_text_1
http://idiom-q-win-1/content/help/en/indesign/using/transforming-objects.html#main-pars_text_1
http://idiom-q-win-1/content/help/en/indesign/using/transforming-objects.html#main-pars_text_1
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1. Select an object to flip. To flip both the frame and its content, use the Selection tool to select the frame. To
flip the content without its frame, direct-select the object. To flip a frame without its content, direct-select
the frame, and select all the anchor points.

2. Do one of the following:

To reflect using the reference point as a horizontal axis, click the Flip Horizontal button in the Control
panel.

To reflect using the reference point as a vertical axis, click the Flip Vertical button in the Control panel.

You can also reflect objects by using the Selection tool or Free Transform tool to pull one side of an object’s
bounding box past the opposite side, or by typing negative values into the Scale X Percentage or Scale Y
Percentage options in the Transform or Control panel.

Shear (skew) objects

Shearing an object slants or skews it along its horizontal or vertical axis, and can also rotate both of the object’s
axes. Shearing is useful for:

Simulating some types of perspective, such as isometric projection.

Slanting a text frame.

Creating cast shadows when you shear a copy of an object.

Shear an object

1. Select an object to shear. To shear both the frame and its content, use the Selection tool to select the frame.
To shear the content without its frame, click the Content Grabber to direct-select the object. To shear a
frame without scaling the content, direct-select the frame, and select all the anchor points.

2. Do one of the following:

To shear selected objects by dragging, select the Shear tool . Then position the Shear tool away from
the reference point, and drag. Shift-drag to constrain shearing to a perpendicular vertical or horizontal
axis. If you start to drag at a non-perpendicular angle and then hold down the Shift key, shearing is
constrained to that angle.

Object being sheared by dragging Shear tool with reference point placed in center

If you want to use a different reference point for the shearing, click where you want the reference point to
appear.

To shear using a preset value, in the Transform or Control panel, choose an angle from the Shear
pop-up  menu.
To shear using a specific value, in the Transform or Control panel, type a positive or negative angle in
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the Shear box, and press Enter or Return.
To create a copy of the object with the new shear applied to the copy, type a value in the Shear box in
the Transform panel, and then hold down Alt (Windows) or Option (Mac OS) as press Enter.

When you shear a single object, the specified value remains displayed in the Transform or Control panel. When
you shear multiple objects, the Shear Angle value is reset to 0 degrees, even though the objects are sheared.

You can also shear by using the Free Transform tool.

Shear an object using the Shear command

You can shear an object by a specific amount by using the Shear command. This command also lets you shear a
copy of the selected object, leaving the original in place.

1. Select an object to shear. To shear both the frame and its content, use the Selection tool to select the frame.
To shear the content without its frame, click the Content Grabber to direct-select the object. To shear a
frame without scaling the content, direct-select the frame, and select all the anchor points.

2. Do one of the following to open the Shear dialog box:

Select Object > Transform > Shear.

Double-click the Shear tool .

Select the Shear tool and Alt-click (Windows) or Option-click (Mac OS) to select a new reference point.

3. Type a new shear angle.

The shear angle is the amount of slant to be applied to the object, relative to a line perpendicular to the
shear axis. (Shear angle is calculated clockwise from the current axis.)

4. Specify the axis along which the object is to be sheared. You can shear an object along a horizontal or
vertical axis.

5. Do any of the following:

To preview the effect before you apply it, select Preview.

To shear the object, click OK.

To shear a copy of the object, click Copy.

Repeat transformations

You can repeat transformations, such as moving, scaling, rotating, resizing, reflecting, shearing, and fitting. You
can repeat either a single transformation or a sequence of transformations, and you can apply those
transformations to more than one object at a time. InDesign remembers all transformations until you select a
different object or perform a different task.

Note:

Not all transformations are recorded. For example, modifying a path or its points is not recorded as a
transformation.

1. Select one or more objects, and perform all the transformations you want to repeat.
2. Select the object or objects to which you want to apply the same transformations.
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3. Choose Object > Transform Again and then select one of the following options:

Transform Again

Applies the last single transform operation to the selection.

Transform Again Individually

Applies the last single transform operation to each selected object individually, rather than as a group.

Transform Sequence Again

Applies the last sequence of transform operations to the selection.

Transform Sequence Again Individually

Applies the last sequence of transform operations to each selected object individually.

Clear transformations
1. Select the object or objects that have been transformed.
2. Choose Clear Transformations from the Transform or Control panel menu.

Unless all values are the default values, clearing transformations results in a change of appearance for the
objects.

Note:

If the Scale values were reset at 100%, clearing the transformations will not change the scale.

Adobe also recommends

Keys for transforming objects
Gallery of transformation tools
Keys for transforming objects
Use smart guides
Create masters
Use smart guides
Scale type
Keys for transforming objects
Duplicate objects
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Understanding graphics formats
Choosing the right graphics format
About vector graphics
About bitmap images
Image resolution guidelines for final output

Choosing the right graphics format

InDesign can import a wide range of graphics file formats. Consult with the service providers who will help you
produce your document to clarify which formats to use. You can then plan your document around those formats
and the options that best apply to your project.

The following table summarizes what graphics formats would work best for the kind of document you’re designing.

Final output Graphics type Format

High resolution (>1000 dpi) Vector drawings Illustrator, EPS, PDF

Bitmap images Photoshop, TIFF, EPS, PDF

Process-color separations Vector drawings Illustrator, EPS, PDF

Color bitmap
images

Photoshop, CMYK TIFF, DCS, EPS, PDF

Color-managed
graphics

Illustrator, Photoshop, RGB TIFF, RGB EPS, PDF

Low-resolution printing, or PDF for
online viewing

All Any (BMP images only)

Web All Any (InDesign converts graphics to JPEG and GIF when
exporting to HTML)

About vector graphics
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Vector graphics (sometimes called vector shapes or vector objects) are made up of lines and curves defined by
mathematical objects called vectors, which describe an image according to its geometric characteristics.

You can freely move or modify vector graphics without losing detail or clarity, because they are resolution-
independent—they maintain crisp edges when resized, printed to a PostScript printer, saved in a PDF file, or
imported into a vector-based graphics application. As a result, vector graphics are the best choice for artwork, such
as logos, that will be used at various sizes and in various output media.

The vector objects you create using the drawing and shape tools in Adobe Creative Suite are examples of vector
graphics. You can use the Copy and Paste commands to duplicate vector graphics betweenCreative Suite
components.

About bitmap images

Bitmap images—technically called raster images—use a rectangular grid of picture elements (pixels) to represent
images. Each pixel is assigned a specific location and color value. When working with bitmap images, you edit
pixels rather than objects or shapes. Bitmap images are the most common electronic medium for continuous-tone
images, such as photographs or digital paintings, because they can more efficiently represent subtle gradations of
shades and color.

Bitmap images are resolution-dependent—that is, they contain a fixed number of pixels. As a result, they can lose
detail and appear jagged if they are scaled to high magnifications on-screen or if they are printed at a lower
resolution than they were created for.

Example of a bitmap image at different levels of magnification

Bitmap images sometimes require large amounts of storage space, and often need to be compressed to keep file
sizes down when used in certain Creative Suite components. For instance, you compress an image file in its
original application before you import it into a layout.

Note:

In Adobe Illustrator, you can create bitmap effects in your artwork using effects and graphic styles.

Image resolution guidelines for final output

Bitmap images contain a fixed number of pixels, usually measured in pixels per inch (ppi). An image with a high
resolution contains more, and therefore smaller, pixels than an image of the same printed dimensions with a low
resolution. For example, a 1-inch-by-1-inch image with a resolution of 72 ppi contains a total of 5184 pixels (72
pixels wide x 72 pixels high = 5184). The same 1-inch-by-1-inch image with a resolution of 300 ppi would contain
a total of 90,000 pixels.

For imported bitmap images, image resolution is determined by the source file. For bitmap effects, you can specify
a custom resolution. To determine the image resolution to use, consider the medium of final distribution for the
image. The following guidelines can help you determine your requirements for image resolution:

Commercial printing

Commercial printing requires 150 to 300 ppi (or more) images, depending on the press (dpi) and screen frequency



(lpi) you’re using; always consult your prepress service provider before making production decisions. Because
commercial printing requires large, high-resolution images, which take more time to display while you’re working
with them, you may want to use low-resolution versions for layout and then replace them with high-resolution
versions at print time.

In Illustrator and InDesign, you can work with low resolution versions by using the Links panel. In InDesign you
can choose either Typical or Fast Display from the View > Display Performance menu; in Illustrator you can choose
View > Outline. Alternatively, if your service provider supports Open Prepress Interface (OPI), they may provide
low-resolution images to you.

Desktop printing

Desktop printing usually requires images within the range of 72 ppi (for photographs printed on a 300 ppi printer)
to 150 ppi (for photographs printed on devices up to 1000 ppi). For line art (1-bit images), make sure that the
resolution of your graphics matches the resolution of the printer.

Web publishing

Because online publishing generally requires images with pixel dimensions that fit the intended monitor, the images
are usually less than 500 pixels wide and 400 pixels tall, to leave room for browser window controls or such layout
elements as captions. Creating an original image at screen resolution—96 ppi for Windows–based images, and
72 ppi for Mac OS–based images—lets you see the image as it will likely appear when viewed from a typical web
browser. When you’re publishing online, the only times you’re likely to need resolutions above those ranges are
when you want viewers to be able to zoom in for more detail in a PDF document, or when you’re producing a
document for printing on demand.
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Designing calendars and business cards from templates

Recommended workflow for InDesign documents

You can improve performance and prevent many problems by establishing a good workflow to use with Adobe
InDesign.

Maintain a clean computer system

Over time, changes occur to software and hardware that can lead to performance loss and system problems.
Defragmenting the hard disk, removing older versions of software, updating device drivers, optimizing memory,
running virus protection utilities, and performing other maintenance tasks can prevent applications and files from
becoming damaged. Performing these tasks regularly helps ensure that InDesign opens, displays, and prints
documents as expected.

Create a project folder

Before you begin a project, determine which files you’ll need and how you’ll store them. If you’ve experienced
problems with broken links, consider storing your linked files in the same folder as your document. InDesign
maintains links to files you place in a document, but if a link is broken, InDesign looks for the file in the
document’s folder. Storing a document and its linked files in the same folder makes it easy to move them from one
computer to another. Storing files in one folder also ensures that InDesign finds the original graphics when printing
a document. If InDesign cannot locate a linked graphic, it won’t reflect changes you make to the original graphic,
and it may print the graphic poorly or not at all.

If your project consists of multiple documents (for example, chapters in a book), you may find it useful to create a
project folder that contains a folder for each document and its linked files.

Consider using a template

Use a template if you frequently create similar projects. Templates let you create consistent documents more



quickly while protecting the original file. For example, if you create a monthly newsletter, your template might
include ruler guides, page numbers, the newsletter masthead, and styles you want to use in each issue. (See Use
document templates.)

Open documents locally

Before you open a document stored on a network volume or on removable media, copy the document and any
linked graphics to your local hard disk. The slower access time and data transfer rate of a network volume or
removable media can cause data to become lost or corrupted, possibly damaging the document. However, be
aware of overriding someone else’s work if you copy the local files back to a network server.

Solve problems before converting a file

Damaged Adobe PageMaker or QuarkXPress® files usually remain damaged when opened in InDesign. If an error
or other unexpected behavior occurs with a converted file, open the original file in the source application and
troubleshoot it for damage.

If the converted file has problems, export it to IDML format, and then open the IDML file and save it as an
InDesign document.

Save documents

Save documents frequently, and create backup copies of important files. You can clear unnecessary data from a
document by using the Save As command. When you use the Save command, InDesign appends new information
to the document but doesn’t remove outdated data, such as information about a deleted graphic. When you use
the Save As command, however, InDesign completely rewrites the document, including only information about
objects and pages currently in the document. A document that contains only necessary data occupies less hard
drive space and redraws and prints more quickly.

Practice good design habits

Create styles in a document. Creating styles with no documents open can cause duplicate styles to appear
when you create a new document. To share styles in documents, save the styles and load them.

Use appropriate fonts. When choosing fonts for a document, consider how you intend to format and print the
text. InDesign works well with OpenType®, Type 1 (also called PostScript), and TrueType fonts. Damaged or
poorly constructed fonts can damage an InDesign document or cause it to print with unexpected results, so
use reliable fonts created by established font vendors. If you work with a service bureau, find out its font
requirements.

Avoid using too many text frames. Use as few text frames as possible to keep the document file size smaller
and the layout easier to manipulate.

Be smart with art

Use the appropriate graphics file format. When you create graphics for a project, consider how you plan to



To the top

print the document. If you intend to print the document at a service bureau, ask the service bureau which
graphic formats work best with the output device it uses. The service bureau can also advise you on the
optimal resolution for images.

Store graphics externally. When you import a graphic file, InDesign creates a link to the graphic by default.
Linking helps minimize the file size of the document and improves the performance of InDesign. When you
print the document, the original graphic file must be available and linked. If InDesign can’t find the original,
the graphic may print as a low resolution preview or as a gray box.

Verify links and fonts before you print

To ensure that a document prints correctly, verify that all links are intact and all fonts are available. A link
becomes broken if you delete, move, or rename the original graphic. Use the Preflight and Package features before
handing off files to a service bureau.

Open InDesign documents

In general, you open document and template files the same way you do in other programs. When you open an
InDesign template, it opens as a new, untitled document by default. Document files use the extension .indd,
template files use the extension .indt, snippet files use the extension .idms, library files use the extension .indl,
interchange files use the extension .inx, markup files use the extension .idml, and book files use the extension
.indb.

You can also use the File > Open command to open files from earlier versions of InDesign, InDesign Interchange
(.inx) files, InDesign Markup (.idml) files, Adobe PageMaker 6.0 and later, QuarkXPress 3.3 and 4.1, and
QuarkXPress Passport 4.1 files. In addition, other software vendors may make plug-in software that lets you open
other file formats.

To view additional information about an InDesign document, hold down Ctrl and choose Help > About InDesign
(Windows) or hold down Command and choose InDesign > About InDesign (Mac OS).

Use the Open command

1. Choose File > Open and select one or more documents.

2. Do one of the following, and then click Open:

Select Normal (Windows) or Open Normal (Mac OS) to open the original document or a copy of a
template.

Select Original (Windows) or Open Original (Mac OS) to open an original document or template.

Select Copy (Windows) or Open Copy (Mac OS) to open a copy of a document or template.

3. If a warning message appears telling you that the color settings in the document are different from the color
settings in the application, select an option, and click OK.

Note:

Color warning messages are off by default, but you can show warnings if you change the default settings in
the Color Settings dialog box (Edit >Color Settings.)

4. If a warning message appears telling you that the document contains missing fonts, do one of the following:



To the top

Click OK. InDesign will automatically format the text with a substitute.

Click Find Font to search for and list fonts used throughout your document.

For more information on finding missing fonts, see Find and change fonts.

5. If a warning message appears telling you that the document contains missing or modified links, use the Links
panel to fix the links. See Update, restore, and replace links.

Open recent document

Choose File > Open Recent, and select one of the documents you saved recently.

To specify how many recent documents are displayed, choose Edit > Preferences > File Handling (Windows), or
InDesign > Preferences > File Handling, and then specify a number for Number Of Recent Items To Display. The
maximum number is 30.

Choosing word lists when opening documents

When opening a document, you may see an alert message asking if you want to use the word list in the document
or an exception word list in the user dictionary. An exception word list includes words that were added to the User
Dictionary while the document was worked on. If you know which exception word list you use, click its button. If
you’re not sure, click either button, choose Edit > Spelling > Dictionary to inspect the word lists, and then, if
necessary, choose Edit > Preferences > Dictionary (Windows) or InDesign > Preferences > Dictionary (Mac OS) to
reset the word list used for composition. See Hyphenation and spelling dictionaries.

Convert earlier versions of InDesign documents
To convert previous versions of InDesign documents to the current version, choose File > Open and open the
file.

Keep in mind the following points:

If you used third-party plug-ins to create an earlier version of a document, check with the manufacturer
to make sure that they are installed correctly for and are compatible with InDesign CS5 before you
convert the document.

When you convert a document, you may see an alert message asking if you want to use the exception
word list in the user dictionary or the one in the document. For information about this alert message,
see Choosing word lists when opening documents.

Library files created in earlier versions of InDesign will open and convert in InDesign CS5, even if the
library is locked. You have to specify a name and location for the converted library files; the default
naming convention is filename-X.indl.

Previous versions of InDesign can’t open latest InDesign documents directly. For example, to open an
InDesign CS5 document in InDesign CS4, you must do two things. First, choose File > Export in
InDesign CS5 to save the document in IDML format. Second, update InDesign CS4 with special plug-ins
that let you open the IDML file. (See Save backwards to the previous InDesign version.)

If you’re experiencing problems with a document that was created in a previous version of InDesign, use the
Export dialog box in InDesign CS5 to save the document in InDesign Markup (IDML) format. Then open the IDML
file and save it as an InDesign document.



To the top

To the top

To the top

Using Adobe Bridge with InDesign

Adobe Bridge is a cross-platform application included with AdobeCreative Suite components that helps you locate,
organize, and browse the assets you need to create print, web, video, and audio content. You can start Adobe
Bridge from any Creative Suitecomponent (except Adobe Acrobat®), and use it to access both Adobe and non-
Adobe asset types.

From Adobe Bridge, you can:

Manage image, footage, and audio files: Preview, search, sort, and process files in Adobe Bridge without
opening individual applications. You can also edit metadata for files, and use Adobe Bridge to place files into
your documents, projects, or compositions.

View the links inside an InDesign document as thumbnails while in Adobe Bridge, without actually having to
open the InDesign document in InDesign.

Drag assets from Adobe Bridge into the InDesign document window, or drag assets from the document
window into Adobe Bridge to create snippets. See Use snippets.

Perform automated tasks, such as batch commands.

Synchronize color settings across color-managed Creative Suite components.

Start a real-time web conference to share your desktop and review documents.

Adobe Version Cue

Adobe Version Cue® and Adobe Drive are not included in Adobe Creative Suite 5, nor any future version of the
Creative Suite. Adobe continues to invest in asset management enablement through open industry standards and
partnerships. For more information, see www.adobe.com/go/learn_vc_end_en.

Use document templates

Templates are useful starting points for standard documents because you can preset them with layout, graphics,
and text. For example, if you prepare a monthly magazine, you can create a template that contains the layout of a
typical issue, including ruler guides, grids, master pages, custom styles and swatches, placeholder frames, layers,
and any standard graphics or text. That way you can simply open the template each month and import new
content.

You create a template the same way you create a regular document; the only difference occurs when you save the
document. When you prepare a template for others to use, you may want to add a layer containing instructions
about the template; hide or delete the layer before printing the document. See Layers.

Note:

For Chinese versions of InDesign, you can open specially designed templates that include custom mojikumi sets.

Save a document as a template

http://www.adobe.com/go/learn_vc_end_en
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1. Choose File > Save As, and specify a location and filename.
2. Choose InDesign CS5 Template for Save As Type (Windows) or Format (Mac OS), and then click Save.

Start a new document from a template

1. Choose File > Open.
2. Locate and select a template.
3. Select Normal (Windows) or Open Normal (Mac OS), and then click Open.
4. Save the new document with its own name.

Edit an existing template

1. Choose File > Open.
2. Locate and select a template.
3. Select Original (Windows) or Open Original (Mac OS), and then click Open.

Reviewing InDesign documents

Adobe offers several methods for reviewing InDesign documents.

Tracking editing changes

As you or another person edits text, InDesign highlights added text and strikes through deleted text when Track
Changes is turned on. Use the Story Editor to view changes. The document owner can go through the edits and
accept or reject changes. See Tracking and reviewing changes.

Using Acrobat to review a PDF file

You can export the InDesign document to PDF and use Adobe Acrobat to set up an e-mail review or a shared
review on Acrobat.com or another server. Reviewers can add comments using the Sticky Note tool and other
markup methods. The document owner can then go through the PDF review comments and edit the original
InDesign document. For more information, see Acrobat Help.

Using CS Review

CS Review is an online subscription service that lets you share your designs on the web so that others can provide
immediate feedback. When you create a review using the CS Review panel, you upload one or more snapshots of
the file to the Acrobat.com workspace. Reviewers can then add comments.

When you create a review, you can divide the review into parts that offer separate areas for review commenting. A
review can consist of parts from different files and applications. As the review progresses, you can add and remove
review parts as part of a dynamic review process.



To the topDesigning calendars and business cards from templates

One way to create a calendars, business cards, resumes or CVs, and other specialized documents is to use
templates.

Adobe provides several templates at the Adobe Marketplace and Exchange site:

www.adobe.com/go/exchange

Use search to locate additional resources for specialty documents.

Adobe also recommends

Save backwards to the previous InDesign
Add documents to a book file
Hyphenation and spelling dictionaries
Save backwards to the previous InDesign
Plug-ins
Reusing graphics and text
Adobe Bridge
Mini Bridge
CS Review
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Working with frames and objects
Modifying objects using graphics frames
Paste an object into a frame
Remove a frame’s content
Fitting objects to frames
Move a graphics frame or its content
Create a border or background
Crop or mask objects
Object export options

Modifying objects using graphics frames

Adobe InDesign objects include any item you can add or create in the document window, including open paths,
closed paths, compound shapes and paths, type, rasterized artwork, 3D objects, and any placed file, such as an
image.

If a graphic exists inside a frame (as all imported graphics do), you can modify it by changing its relationship to its
frame, as in the following examples:

Crop a graphic by making its frame smaller.

Create various masking and layout effects by pasting an object into a frame.

Add a keyline or outline to a graphic by changing the stroke weight and color of its frame.

Center a graphic against a background rectangle by enlarging its frame and setting the frame’s fill color.

Paste an object into a frame

Use the Paste Into command to nest graphics within container frames. You can even nest graphics into nested
frames.

Background image pasted into a frame

1. Do one of the following:

To paste one object inside a frame, select the object.

To paste two or more objects inside a frame, group them first, because a frame can contain only one
object.

To paste a text frame inside another frame and preserve its current appearance, select the entire text
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frame using the Selection tool  or Direct Selection tool , not the Type tool.

2. Choose Edit > Copy (or Edit > Cut, if you don’t want to keep the original).
3. Select a path or frame, and then choose Edit > Paste Into.

Remove a frame’s content
1. Do one of the following:

If you’re removing a graphic or a text frame, select the object with the Direct Selection tool . Or, use
the Selection tool to click the content grabber of the image.

If you’re removing text characters, select them with the Type tool .

2. Do one of the following:

To permanently remove the content, press Delete or Backspace.

To place the content elsewhere on the layout, choose Edit > Cut, deselect the frame, and then choose
Edit > Paste.

Note:

An imported image cannot exist without a frame. If you cut an imported image from its frame and paste it
elsewhere within a document, a new frame is created for it automatically.

Fitting objects to frames

If the frame and its content are different sizes, you can use the Fitting commands to achieve a perfect fit.

Frame alignment options apply to frames that contain either a graphic or another text frame (text frames nested
within another frame), but they do not affect paragraphs inside a text frame—you control alignment and
positioning of text itself using the Text Frame Options command and the Paragraph, Paragraph Styles, and Story
panels.

Fit an object to its frame

1. Select the frame of the object.

2. Choose Object > Fitting and one of the following options:

Fit Content To Frame

Resizes content to fit a frame and allows the content proportions to be changed. The frame will not change,
but the content may appear to be stretched if the content and the frame have different proportions.

Fit Frame To Content

Resizes a frame to fit its content. The frame’s proportions are altered to match the content proportions, if
necessary. This is useful for resetting a graphics frame that you accidentally altered.



To fit a frame to its content quickly, double-click any corner handle on the frame. The frame resizes away
from the point you click. If you click a side handle, the frame resizes only in that dimension.

Aligning an object within a graphics frame

A. Original B. Frame resized to fit content C. Content resized to fit frame 

Center Content

Centers content within a frame. The proportions of the frame and its content are preserved. The size of the
content and frame are unaltered.

Fit Content Proportionally

Resizes content to fit a frame while preserving the content proportions. The frame’s dimensions are not
changed. If the content and the frame have different proportions, some empty space will result.

Fill Frame Proportionally

Resizes content to fill the entire frame while preserving the content’s proportions. The frame’s dimensions are
not changed. If the content and the frame have different proportions, some of the content will be cropped by
the bounding box of the frame.

Note:

The Fitting commands fit the outer edges of the content to the center of the frame’s stroke. If the frame has
a thick stroke weight, outer edges of the content will be obscured. You can adjust the frame’s stroke
alignment to the center, inside, or outside of a frame edge. (See Set strokes.)

To remove undesired fitting settings applied using Auto-Fit, choose Object > Fitting > Clear Frame Fitting
Options.

Using Auto Fit

If you resize an image frame when Auto-Fit is not selected, the frame resizes while the image size remains the
same. If you select Auto-Fit, the image resizes with the frame. If you decide to crop or transform the image, use
the Direct Selection tool to transform the image itself. Or, deselect Auto-Fit, transform the image, and select Auto-
Fit again.

You can select the Auto-Fit option in the Control bar and in the Frame Fitting Options dialog box.

Set frame fitting options

You can associate a fitting option to a placeholder frame so that whenever new content is placed in that frame, the
fitting command is applied.

1. Select a frame.

2. Choose Object > Fitting > Frame Fitting Options.
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3. Specify the following options, and then click OK:

Auto-Fit

Select this option if you want the image to resize automically when you resize the frame.

Reference Point

Specify a reference point for the cropping and fitting actions. For example, if you select the upper-right
corner for a reference point and choose Fit Content Proportionally, the image may be cropped on either the
left or bottom side (away from the reference point).

Crop Amount

Specify the location of the image’s bounding box in relation to the frame. Use positive values to crop the
image. For example, you may want to exclude a border that surrounds the placed image. Use negative values
to add space between the image’s bounding box and the frame. For example, you may want white space to
appear between the image and the frame.

If you enter crop values that cause the image not to be visible, those values are ignored, but the fitting
option is still implemented.

Fitting On Empty Frame

Specify whether you want to fit the content to the frame (which may cause the image to be skewed), fit the
content proportionally (some empty space may result), or fill the frame proportionally (one or more sides
may be cropped).

The fitting action is applied only when content is placed into a frame. If you resize the frame, the fitting option is
automatically reapplied only if Auto-Fit is selected.

Move a graphics frame or its content

When you use the Selection tool to select a graphics frame, you can select either the frame or the image within
the frame. If you click outside the content grabber and drag the selection, the frame’s content moves with the
frame. If you drag the content grabber, the image moves within the frame.

The following techniques include ways to move a frame or its content independent of each other. These
techniques are useful for adjusting a graphic when cropped or masked in its frame.

If a selection tool doesn’t work the way you expect it to, try deselecting everything first. Do this by pressing
Ctrl+Shift+A (Windows) or Command+Shift+A (Mac OS).

Do any of the following:

To move a frame together with its content, use the Selection tool  to click the image outside the
content grabber.

To move imported content without moving the frame (that is, to pan content behind its frame), drag
the content grabber. You can also use the Direct Selection tool  to select and drag the image.
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Moving the content, but not its frame

Note:

If you hold down the mouse button on a graphic before you move it, a dynamic graphics preview (a ghosted-
back image) of the outside of the frame appears, but the preview of the image that moves inside the frame is
not ghosted. This makes it easier to see how you are positioning the entire image within a frame.

To move a frame without moving its content, click the frame using the Selection tool, switch to the
Direct Selection tool, and then drag the center point.

Moving the frame, but not its content

To move multiple frames, use the Selection tool to select the objects, and then drag them. If you use
the Direct Selection tool to select multiple objects, only the item you drag is affected.

Create a border or background

A graphics frame is ideally suited for use as a border or background for its content, because you can change the
frame’s stroke and fill independent of the content.

Adding borders to graphics frames

A. Photo in graphics frame B. Frame with stroke applied C. Frame enlarged with both stroke and fill applied 

1. Using the Selection tool , click an imported graphic outside the content grabber to select its frame.
2. To enlarge the frame without resizing the graphic, drag any bounding box handle outward. To maintain

frame proportions, hold down Shift as you drag.
3. Use the Swatches panel and the toolbox to apply a stroke and fill color.
4. Use the Stroke panel to adjust the frame’s stroke weight, style, or alignment.

You can quickly enlarge a frame equally around all sides by using the Transform or Control panel. Select the frame
with the Direct Selection tool , set the panel reference point locator   to the center point, and enter new
values for the width and height.

Crop or mask objects

Cropping and masking are both terms that describe hiding part of an object. In general, the difference is that
cropping uses a rectangle to trim the edges of an image, and masking uses an arbitrary shape to make an object’s
background transparent. A common example of a mask is a clipping path, which is a mask made for a specific
image.

Use graphics frames to crop or mask objects. Because an imported graphic is automatically contained within a
frame, you can crop or mask it immediately without having to create a frame for it. If you haven’t created a frame
for an imported graphic manually, the frame is automatically created at the same size as the graphic, so it is not
obvious that the frame is there.

Note:



For efficient printing, only the data for the visible parts of cropped or masked images is sent when you output the
document. However, you still save disk space and RAM if you crop or mask images to their desired shapes and
sizes before importing them into your document.

To crop an imported image or any other graphic already inside a rectangular frame, click the object using the
Selection tool  and drag any handle on the bounding box that appears. Press Shift as you drag to preserve
the frame’s original proportions.

Cropping an image using a graphics frame

To crop or mask any object, use the Selection or Direct Selection tool  to select one object you want to
mask. Choose Edit > Copy, select an empty path or frame smaller than the object, and choose Edit > Paste
Into.
To crop frame content precisely, select the frame with the Direct Selection tool, and use the Transform or
Control panel to change the size of the frame.
To specify crop settings for an empty placeholder frame, choose Object > Fitting > Frame Fitting Options,
and then specify the crop amount.

With an imported graphic, you can also create a mask by using the drawing tools to change the shape of the
graphic’s existing frame.

Creating see-through text

Learn how to make see-through text in this quick tutorial.... Read More

http://goo.gl/pY2e0

by David Blatner

Turn any object into a transparency mask

Learn how to make any object, text, or path into a transparency mask.... Read More

http://goo.gl/yQeIz

http://goo.gl/pY2e0
http://goo.gl/pY2e0
http://goo.gl/yQeIz
http://goo.gl/yQeIz
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by David Blatner

Object export options

Introduction to object export options

Object export options can be used to specify export parameters required when you export to different formats such
as EPUB, HTML, or accessible PDFs.

Object export options can be applied to both text frames and graphic frames, as well as groups. Use Object export
options to:

Define Alt text for placed images and graphics.

Apply tags and actual text settings for tagged PDFs.

Create different conversion settings on each object, so that they render well on different screen sizes and
pixel densities. Use these options to control the quality of rasterization applied to text effects such as drop
shadow and bevel when you export the layout to HTML or EPUB.

Note:

If an object is hyperlinked, it would be supported on export.

Apply Object export options

1. Select the frame or group in the layout.

2. Choose Object > Object Export Options.

or

Right-click on the object and select Object Export Options.

3. Apply the settings.

You can leave the Object Export Options dialog box while you select other objects on the layout to apply the
settings.

Alt-text options

Alternative text (Alt text) is a brief text-based description of an image or graphic. This text is used in situations
where the image is not rendered or to help screen-readers.



Alt-text Source

Select the source to assign the Alt text for the selected frames or groups.

Note:

When you import content from Microsoft Word, InDesign also imports alt-text applied to images.

Custom

Enter text manually.

From Structure

Use text as specified in the structure. See Label graphics for use with screen-reader software.

From XMP (Title |Description |Headline)

Use data stored in common XMP fields. If XMP data is updated using another application such as Adobe Bridge,
when you update the link, text is updated automatically.

From Other XMP

If text string is stored in some other XMP field, enter the complete namespace and property name in
<ns>:<property> format. For example, the Adobe Bridge user interface supports IPTC Core, which contains a field
titled “IPTC Subject Code”. If this field was used to store the text string, then the Property value would be
“Iptc4xmpCore:SubjectCode[1].”

Tagged PDF options

Apply Tag

Select the source to assign the PDF Tag for the selected frames or groups.

From Structure

Use text as specified in the structure.

Artifact

Use for graphic elements that have no important meaning when they are read aloud by a screen reader.

Based on Object

Automatically determines the content of the frame and applies “Story” or “Figure” tag.



Actual Text Source

PDF also supports actual text, in addition to Alt text. Actual text can be applied to graphic elements that visually
look like text. For example, a scanned TIFF image. Actual text is used to represent words that were converted to
artwork. Actual text is only applicable for tagged PDFs.

Custom

Enter text manually.

From Structure

Use text as specified in the structure. See Label graphics for use with screen-reader software.

From XMP (Title |Description |Headline)

Use data stored in common XMP fields. If XMP data is updated using another application such as Adobe Bridge,
when you update the link, text is updated automatically.

From Other XMP

If text string is stored in some other XMP field, enter the complete namespace and property name in
<ns>:<property> format. For example, the Bridge user interface supports IPTC Core, which contains a field titled
“IPTC Subject Code”. If this field was where the text string is stored, then the Property value would be
“Iptc4xmpCore:SubjectCode[1].”

EPUB and HTML options

Use the EPUB and HTML options to specify image conversion settings for individual objects. If these settings are
not specified, the EPUB export image conversion settings are used. See EPUB Images options.

Objext Export Options

epub: type

Click the arrow icon to choose the order in which the reader can read the document.

Preserve Appearance From Layout

Check to specify custom image conversion settings for selected frames.

Default

Deafult settings mapped to the Export dialog settings dialog.



Use Existing Image for Graphic Objects

Uses an existing image for graphic objects

Rasterize Container

Convert the object into an image. For example, a text frame gets converted to an image.

Rasterize Content

The appearance is preserved via CSS. 

Custom Rasterization

Check to specify custom image conversion settings for selected frames.

Format

Lets you choose whether the optimized images in your document are converted to GIF, JPEG, or PNG.

Resolution (ppi)

Specify the resolution of the images in pixels per inch (ppi). While operating systems have standardized on either
72 ppi or 96 ppi, mobile devices range from 132 ppi (iPad), to 172 ppi (Sony Reader), to over 300 ppi (iPhone 4).
You can specify a ppi value for each object selected. Values include 72, 96, 150 (average for all eBook devices
today), and 300.

Palette

Lets you control how InDesign handles colors when optimizing GIF files. The GIF format uses a limited color
palette, which cannot exceed 256 colors.

Choose Adaptive to create a palette using a representative sample of colors in the graphic without any dithering
(mixing of small spots of colors to simulate additional colors). Choose Web to create a palette of web-safe colors
that are a subset of Windows and Mac OS system colors. Choose System (Win) or System (Mac) to create a
palette using the built-in system color palette. This choice may cause unexpected results.

Select Interlace to display a slowly loaded image gradually by filling in missing lines. If this option is not select, an
image looks fuzzy and gradually becomes clear as the image reaches full resolution.

Quality

Determines the trade-off between compression (for smaller file sizes) and image quality for each JPEG image
created. Low produces the smallest file and lowest image quality.

Method

Determines how quickly JPEG graphics display when the file containing the image is opened on the web. Choose
Progressive to make the JPEG images display gradually and in increasing detail as they are downloaded. (Files



created with this option are slightly larger and require more RAM for viewing.) Choose Baseline to make each JPEG
file display only after it has been downloaded; a placeholder appears in its place until the file displays.

Custom Layout

Select the layout preference from the drop-down list.

Alignment and Spacing: Specify the image alignment, left, center, right, and the top and bottom padding.
Float Left: Select this option for floating left alignment.
Float Right: Select this option for floating right alignment.

Insert Page Break

Select this option to insert page breaks with images. Page breaks can be inserted Before Image, After Image, or
Before and After Image.

Size

Choose the custom CSS width and height from the following options:

None: No CSS width or height is applied on the object.
Default: The default CSS width and height are used.
Fixed: A fixed CSS width and height are applied.
Relative to Text Flow: Applies to CSS width only. The CSS width adapts to the text flow.
Relative to Text Size: Applies to CSS width only. The CSS width adapts to the text flow.
Custom Width: Select this option to enter the custom value for width.
Custom Height: Select this option to enter the custom value for height.

Note:

The Size drop-down list is applicable for the EPUB Reflowable and HTML Layout only. This is not applicable for
EPUB Fixed Layout.

Adobe also recommends

Using placeholders to design pages
Object styles
Applying line (stroke) settings
Apply color
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Texte

Création de listes à puces ou numérotées (vidéo 12:16), CS3-CS6
Anne-Marie Concepcion  (01er janvier 2011)
Didacticiel - vidéo
Découvrez comment créer des puces et les ajouter à votre mise en page.

Création de texte conditionnel (vidéo 06:48), CS4-CS6
David Blatner  (01er janvier 2011)
Didacticiel - vidéo
Découvrez comment utiliser le texte conditionnel dans InDesign.

Création de notes de pied de page (vidéo 02:44), CS3-CS6
David Blatner  (01er janvier 2011)
Didacticiel - vidéo
Dans cette courte vidéo, découvrez les principes fondamentaux de l’ajout de notes de bas de page.

Liaison d’articles de texte (PDF, 217 Ko)
Référence  (01er janvier 2011)
Un bref didacticiel sur la fonctionnalité Importer et lier l’article dans InDesign CS5.5.

Paragraphes s’étendant sur plusieurs colonnes ou les scindant (vidéo 02:01)
Michael Ninness  (01er janvier 2011)
Didacticiel - vidéo
Découvrez comment créer des mises en page complexes en moins de clics à l’aide de paragraphes s’étendant sur plusieurs colonnes ou les
scindant dans InDesign CS5 et les versions ultérieures.

Suivi des modifications du texte (vidéo 02:01)
Michael Ninness  (01er janvier 2011)
Didacticiel - vidéo
Découvrez comment collaborer avec plus d’efficacité à l’aide de la nouvelle fonctionnalité Suivi des modifications du texte dans InDesign CS5
et les versions ultérieures.

http://www.adobe.com/go/vid0077_fr
http://tv.adobe.com/watch/learn-indesign-cs4/creating-conditional-text/
http://www.adobe.com/go/vid0218_fr
http://www.adobe.com/support/indesign/gettingstarted/pdfs/indesign_howto_h_linkstories_2db.pdf
http://tv.adobe.com/go/4952
http://tv.adobe.com/go/4951


Liaison de texte
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Blocs de texte liés
Rupture de liens d’un bloc ou suppression de blocs de texte liés
Placement automatique ou manuel de texte
Redistribution intelligente du texte

Blocs de texte liés
Le texte d’un bloc peut être indépendant des autres blocs ou peut se poursuivre dans des blocs reliés. Pour placer du texte de sorte qu’il se
poursuive dans d’autres blocs (également appelés zones de texte), vous devez d’abord relier les blocs. Les blocs reliés peuvent se trouver sur la
même page ou la même planche, ou bien sur une autre page du document. Le processus qui consiste à relier du texte entre plusieurs blocs est
appelé liaison de texte. On parle aussi parfois de liaison de blocs de texte ou liaison de zones de texte.

Tous les blocs de texte contiennent un port d’entrée et un port de sortie, qui sont utilisés pour les relier les uns aux autres. Des ports d’entrée ou
de sortie vides indiquent respectivement le début ou la fin d’un article. Une flèche dans un port indique que le bloc correspondant est lié à un autre
bloc. Un signe plus (+) rouge dans un port de sortie indique que le texte de l’article n’est pas terminé mais qu’il n’y a plus de bloc de texte où le
placer. Le texte restant et invisible est appelé texte en excès.

 
Blocs liés 
A. Port d’entrée au début de l’article B. Port de sortie indiquant un lien au bloc suivant C. Lien de texte D. Port d’entrée indiquant un lien vers
l’image précédente E. Port de sortie indiquant un texte en excès 

Choisissez Affichage > Extras > Afficher le chaînage du texte, pour afficher les représentants visuels des blocs liés. Vous pouvez lier des blocs de
texte vides aussi bien que ceux contenant du texte.

Ajout d’un nouveau bloc au lien
1. A l’aide de l’outil Sélection , sélectionnez un bloc de texte, puis cliquez sur le port d’entrée ou de sortie pour charger une

icône de texte.

Cliquez sur le port d’entrée pour ajouter un bloc avant le bloc sélectionné. Inversement, cliquez sur le port de sortie pour
ajouter un bloc après le bloc sélectionné.

2. Positionnez l’icône de texte chargé  à l’endroit où vous souhaitez insérer un nouveau bloc de texte, puis cliquez ou faites
glisser le pointeur pour créer un bloc de texte.

Lorsque l’icône de texte chargé est active, vous pouvez effectuer de nombreuses actions, comme tourner des pages, créer des pages et
effectuer des zoom avant et arrière. Vous pouvez annuler un processus de liaison de blocs de texte en cours en cliquant sur n’importe quel
outil du panneau Outils. Aucun texte ne sera perdu.

Ajout d’un bloc existant au lien
1. A l’aide de l’outil Sélection, sélectionnez un bloc de texte, puis cliquez sur le port d’entrée ou de sortie pour charger une icône

de texte.
2. Positionnez l’icône de texte chargé sur le bloc à relier. L’icône de texte chargé se change en icône de lien.

 
Ajout d’un bloc existant à un lien
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3. Cliquez à l’intérieur du second bloc pour le lier au premier.

 

Lorsque vous liez une grille de bloc à un bloc de texte brut ou à une autre grille de bloc ne possédant pas les même paramètres de grille, le bloc
de texte du bloc lié est redéfini de façon à correspondre aux paramètres de la grille de bloc source.

Vous pouvez ajouter automatiquement une mention de tourne, comme « suite à la page » ou « suite de la page », pour suivre les articles liés
d’un bloc à un autre. (Voir Numérotation automatique des pages pour les sauts d’article.)

Ajout d’un bloc à une séquence de blocs liés
1. A l’aide de l’outil Sélection, cliquez sur le port de sortie correspondant à l’emplacement de l’article où vous souhaitez ajouter

un bloc. Lorsque vous relâchez le bouton de la souris, une icône de texte chargé apparaît.
2. Faites glisser le curseur pour créer un bloc, ou sélectionnez un autre bloc de texte. InDesign lie le bloc à la série de blocs liés

contenant l’article.

 
Ajout d’un bloc à l’intérieur d’un lien (en haut) et résultat (en bas)

Suppression de liens entre des blocs de texte
Lorsque vous supprimez le lien à un bloc de texte, vous rompez le lien qui relie le bloc à tous les blocs suivants du lien. Le texte qui auparavant
apparaissait dans les blocs devient du texte en excès (aucun texte n’est supprimé). Tous les blocs suivants sont vides.

A l’aide de l’outil Sélection, utilisez l’une des méthodes suivantes :
Cliquez deux fois dans un port d’entrée ou de sortie pour rompre le lien entre deux blocs.

Cliquez sur un port d’entrée ou de sortie représentant un lien vers un autre bloc. Par exemple, dans le cas d’un lien
constitué de deux blocs, cliquez soit sur le port de sortie du premier bloc, soit sur le port d’entrée du second bloc.
Positionnez l’icône de texte chargé sur le bloc précédent ou suivant pour afficher l’icône de suppression de lien . Cliquez
sur le bloc à supprimer du lien.

 
Suppression d’un bloc d’un lien

Pour diviser un article en deux, coupez la seconde partie du texte, rompez le lien entre les blocs, puis collez le texte dans le premier bloc du
second article.

Rupture de liens d’un bloc ou suppression de blocs de texte liés
Lorsque vous coupez ou supprimez des blocs de texte, aucun texte n’est supprimé. Le texte reste lié.

Rupture d’un lien d’un bloc
Vous pouvez rompre le lien d’un bloc et coller le bloc ailleurs. Le bloc est supprimé, avec une copie du texte, mais le texte n’est pas supprimé de

http://help.adobe.com/fr_FR/InDesign/CS5/Using/WSa285fff53dea4f8617383751001ea8cb3f-7107a.html
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l’article d’origine. Lorsque vous coupez et collez plusieurs blocs liés en même temps, les blocs collés conservent leurs liens les uns aux autres
mais perdent leur lien aux autres blocs de l’article d’origine.

1. Sélectionnez l’outil Sélection, sélectionnez un ou plusieurs blocs (maintenez la touche Maj enfoncée tout en cliquant pour
sélectionner plusieurs objets).

2. Choisissez Edition > Couper. Le bloc disparaît et le texte qu’il contenait se poursuit dans le bloc suivant de l’article. Lorsque
vous coupez le dernier bloc d’un article, le texte est stocké en tant que texte en excès dans le bloc précédent.

3. Si vous souhaitez utiliser le bloc dont vous avez rompu le lien ailleurs dans le document, accédez à la page dans laquelle
vous souhaitez insérer le texte et choisissez Edition > Coller.

Suppression d’un bloc de texte lié
Lorsque vous supprimez un bloc de texte faisant partie d’un lien, le texte n’est pas supprimé, mais il devient du texte en excès ou il se poursuit
dans le bloc suivant. Si le bloc de texte n’est pas relié à un autre bloc, le bloc et le texte sont tous deux supprimés.

1. Pour sélectionner le bloc de texte, utilisez l’une des méthodes suivantes :
Sélectionnez l’outil Sélection, puis cliquez sur le bloc.

Sélectionnez l’outil Texte, maintenez la touche Ctrl (Windows) ou Commande (Mac OS) enfoncée et cliquez sur le bloc.

2. Appuyez sur la touche Retour arrière ou Suppr.

Placement automatique ou manuel de texte

Lorsque vous avez importé du texte ou cliqué sur un port d’entrée ou de sortie, le pointeur prend la forme d’une icône de texte chargé . Cette
icône permet de placer du texte dans les pages. Vous pouvez déterminer la façon dont le texte sera placé tout en maintenant une touche de
modification enfoncée. L’icône de texte chargé change de forme selon l’endroit où elle est placée.

Lorsque vous positionnez l’icône de texte chargé sur un bloc de texte, l’icône  est encadrée par des parenthèses. Lorsque vous positionnez
l’icône de texte chargé en regard du point de magnétisme d’un repère ou d’une grille, le pointeur noir devient blanc .

Vous pouvez placer du texte de quatre façons :

Pour placer du texte dans des blocs, InDesign détecte s’il s’agit d’un bloc vertical ou horizontal. Si le texte est inséré en mode de placement semi-
automatique ou automatique, il est positionné selon le type de bloc et le sens défini dans le panneau Articles. L’icône donne un aperçu du sens du
texte.

Pour obtenir un didacticiel vidéo sur l’importation et le placement de texte, voir www.adobe.com/go/lrvid4278_id.

Placement manuel du texte
1. Avec la commande Importer, sélectionnez un fichier, ou cliquez sur le port de sortie  d’un bloc de texte sélectionné.
2. Utilisez l’une des méthodes suivantes :

Positionnez l’icône de texte chargé n’importe où dans le bloc ou le tracé, puis cliquez. Le texte est placé dans le bloc et se
poursuit dans les autres blocs liés. A noter que le texte commence toujours à remplir le bloc qui se trouve en haut de la
colonne la plus à gauche, même si vous cliquez dans une autre colonne.

Positionnez l’icône de texte chargé dans une colonne pour créer un bloc de texte de la largeur de cette colonne. Le haut
du bloc apparaît là où vous cliquez.

Faites glisser l’icône de texte chargé pour créer un bloc de texte de la largeur et de la hauteur de la zone que vous
définissez.

Méthode Fonction

Placement de texte manuel Ajoute le texte dans un bloc à la fois. Vous devez recharger
l’icône de texte pour continuer à placer du texte.

Placement semi-automatique  en cliquant tout en
maintenant la touche Alt (Windows) ou Option (Mac OS)
enfoncée.

Similaire au placement manuel, mais le pointeur se
transforme en icône de texte chargé à chaque fin de bloc,
jusqu’à ce que tout le texte soit placé.

Placement automatique  en cliquant tout en
maintenant la touche Maj enfoncée.

Ajoute des pages et des blocs jusqu’à ce que tout le texte
soit placé dans le document.

Placement automatique de pages fixes  en cliquant
tout en maintenant les touches Maj+Alt (Windows) ou
Maj+Option (Mac OS) enfoncées

Place tout le texte dans le document en ajoutant les blocs
nécessaires sans ajouter de pages. Le texte restant est
composé en excès.

http://tv.adobe.com/watch/visual-design/getting-started-06-placing-and-flowing-text/
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En haut

Ajouter les pages à la

Limiter aux blocs de texte types

Conserver les planches de pages en vis-à-vis

3. S’il y a trop de texte à importer, cliquez sur le port de sortie et répétez les étapes 1 et 2 jusqu’à ce que le texte soit
entièrement importé.

lorsque vous importez du texte dans un bloc lié, le texte se poursuit automatiquement dans les blocs liés, quelle que soit la méthode
de placement choisie.

Placement semi-automatique du texte
Avec une icône de texte chargé, maintenez la touche Alt (Windows) ou Option (Mac OS) enfoncée tout en cliquant sur une
page ou un bloc.

Le texte est placé dans une colonne à la fois, comme avec le placement manuel, mais l’icône de texte chargé se recharge automatiquement
chaque fois qu’une colonne est remplie.

Placement automatique du texte
L’icône de texte chargé étant affichée, maintenez la touche Maj enfoncée tout en effectuant l’une des opérations suivantes :

Cliquez sur l’icône de texte chargé dans une colonne pour créer un bloc de la largeur de cette colonne. InDesign crée de
nouveaux blocs de texte et de nouvelles pages de document jusqu’à ce que tout le texte soit placé dans le document.

Cliquez dans un bloc de texte type. Le texte est automatiquement placé dans le bloc, et de nouvelles pages sont créées
en fonction des besoins en utilisant les attributs de ce bloc de texte. (Voir A propos des gabarits, de l’ordre de
superposition et des calques.)

Placement automatique du texte sans ajout de page
Avec une icône de texte chargé, maintenez les touches Maj+Alt(Windows) ou Maj+Option (Mac OS) enfoncées.

Redistribution intelligente du texte
La fonction Redistribution intelligente du texte permet d’ajouter ou de supprimer des pages pendant la saisie ou la modification de texte. Elle vous
sera précieuse si vous utilisez InDesign comme un éditeur de texte et désirez ajouter une nouvelle page dès que le texte que vous saisissez
déborde de la page en cours. Cette fonction permet en outre d’éviter d’avoir du texte en excès ou des pages vides si la répartition change lorsque
vous modifiez le texte, affichez ou masquez le texte conditionnel, ou effectuez d’autres modifications de répartition.

Par défaut, la fonction Redistribution intelligente du texte est limitée aux blocs de texte types, c’est-à-dire, ceux situés sur un gabarit. Si le
document inclut des pages en vis-à-vis, les blocs de texte types doivent apparaître à gauche et à droite des gabarits. Ils doivent par ailleurs être
liés pour que la redistribution intelligente du texte puisse fonctionner.

Vous pouvez modifier les paramètres pour permettre l’ajout ou la suppression de pages lorsque vous travaillez dans des blocs de texte qui ne sont
pas basés sur les gabarits. Toutefois, pour que la redistribution intelligente du texte puisse se faire, le bloc de texte doit être lié à au moins un
autre bloc de texte d’une page différente.

Les paramètres de la fonction Redistribution intelligente du texte apparaissent dans les préférences de texte. Ils s’appliquent au document actif.
Pour modifier les paramètres par défaut des nouveaux documents, fermez au préalable tous les documents.

1. Choisissez Edition > Préférences > Texte (Windows) ou InDesign > Préférences > Texte (Mac OS).

2. Sélectionnez l’option Redistribution intelligente du texte.

3. Sélectionnez les options suivantes selon les besoins, puis cliquez sur OK.

Cette option permet de déterminer l’emplacement de création de la nouvelle page. Admettons par exemple que votre
document comporte trois pages contenant des blocs de texte sur les deux premières et une image pleine page sur la troisième. Si vous saisissez
du texte jusqu’à la fin de la deuxième page, vous pouvez déterminer si la nouvelle page est ajoutée avant ou après l’illustration de la troisième
page. Choisissez l’option Fin de l’article pour insérer une page après la deuxième. En revanche, si vous voulez insérer la page après la page de
l’illustration, choisissez l’option Fin du document.
Dans les documents comportant plusieurs sections, vous pouvez choisir l’option Fin de la section pour ajouter la page à la fin de la section.

Si cette option est désactivée, vous pouvez aussi ajouter ou supprimer des pages lorsque vous modifiez des
blocs de texte qui ne sont pas basés sur des gabarits. Afin d’éviter toute redistribution de texte intempestive, la fonction Redistribution intelligente
du texte ne s’applique que si le bloc de texte que vous modifiez est lié à au moins un autre bloc de texte d’une autre page.
Remarque : lorsque vous utilisez la redistribution intelligente du texte dans des blocs de texte qui ne sont pas basés sur des gabarits, les pages
sont ajoutées avec des blocs de texte pleine page d’une seule colonne, quels que soient les attributs du bloc de texte auquel le nouveau bloc est
lié.

Cette option détermine si les liens des pages en vis-à-vis sont conservés lors de la
redistribution de texte au milieu d’un document. Si cette option est sélectionnée lorsque du texte est redistribué au milieu du document, une
nouvelle planche de deux pages est ajoutée. Si elle n’est pas sélectionnée, une seule nouvelle page est insérée et les pages suivantes sont
réorganisées.
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Supprimer les pages vides

Si votre disposition inclut des éléments de conception propres au côté droit ou gauche de la planche, activez cette option. Si vos pages gauche et
droite sont interchangeables, vous pouvez désactiver cette option. Cette option est grisée si le document ne comporte pas de pages en vis-à-vis.

Sélectionnez cette option pour supprimer les pages lorsque vous modifiez du texte ou masquez des conditions. Les
pages ne sont supprimées que si le bloc de texte vidé est le seul objet de la page.

Pour voir comment la fonction Redistribution intelligente du texte peut vous permettre d’utiliser InDesign comme éditeur de texte, créez un
document en désactivant l’option Pages en vis-à-vis et en sélectionnant l’option Bloc de texte type. Dans les préférences de texte, assurez-
vous que les options Redistribution intelligente du texte et Supprimer les pages vides sont sélectionnées. Sur la première page, appuyez sur les
touches Ctrl+Maj (Windows) ou Commande+Maj (Mac OS) et cliquez sur le bloc de texte type pour l’ignorer. Lorsque vous saisissez assez de
texte pour remplir ce bloc de texte, InDesign ajoute automatiquement une nouvelle page et un nouveau bloc de texte. Si vous supprimez
suffisamment de texte, une page est supprimée.

http://creativecommons.org/licenses/by-nc-sa/3.0/deed.fr
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy


Habillage d’objets avec du texte

Haut de la page

Habiller le cadre de sélection 

Habiller la forme de l’objet 

Ne pas habiller l’objet 

Passer à la colonne suivante  

Habillage d’objets avec du texte
Modification de la forme d’un habillage
Application de l’habillage du texte sur des éléments de gabarit
Habillage d’objets ancrés avec du texte
Suppression de l’habillage sur les calques masqués
Justification du texte d’habillage en regard d’un objet
Ignorer dans un bloc de texte

Habillage d’objets avec du texte

Vous pouvez habiller n’importe quel objet avec du texte, y compris les blocs de texte, les images importées et les objets créés dans InDesign.
Lorsque vous appliquez un habillage à un objet, InDesign crée un cadre autour de l’objet qui repousse le texte. L’objet autour duquel le texte est
appliqué s’appelle objet habillé. S’agissant de l’habillage, on parle également de texte d’habillage.

N’oubliez pas que les options d’habillage de texte s’appliquent à l’objet habillé, non au texte. Toute modification appliquée au cadre d’habillage
sera conservée si vous déplacez l’objet habillé à proximité d’un autre bloc de texte.

Pour habiller des objets avec du texte

1. Pour afficher le panneau Habillage de texte, choisissez Fenêtre > Habillage de texte.

2. A l’aide de l’outil Sélection  ou Sélection directe , sélectionnez l’objet que vous voulez habiller de texte.

3. Dans le panneau Habillage de texte, cliquez sur la forme d’habillage désirée :

Crée un habillage rectangulaire dont la largeur et la hauteur sont déterminées par le cadre
de sélection de l’objet sélectionné, en tenant compte des distances de décalage que vous spécifiez.

Egalement connue sous le nom d’habillage de contour, crée un cadre d’habillage de texte
adapté à la forme du bloc sélectionné (plus ou moins les distances de décalage que vous spécifiez).

Comparaison des paramètres Habiller le cadre de sélection (à gauche) et Habiller la forme de l’objet (à droite)

Empêche l’apparition de texte dans tout espace disponible à droite ou à gauche du bloc.

Fait passer le paragraphe avoisinant en haut de la colonne suivante ou du bloc de texte
suivant.



4. A partir du menu Habiller, spécifiez si l’habillage est appliqué à un côté spécifique (comme le côté droit ou la plus grande
zone), au dos ou à l’opposé du dos (si vous ne voyez pas le menu Habiller, choisissez Afficher les options dans le menu du
panneau Habillage de texte).

Cette option est disponible uniquement si vous avez sélectionné Habiller le cadre de sélection ou Habiller la forme de l’objet.

Options Habiller

A. Côtés droit et gauche B. Côté dos C. Côté opposé au dos 

5. Spécifiez les valeurs de décalage Les valeurs positives éloignent l’habillage du bloc ; les valeurs négatives déplacent
l’habillage à l’intérieur du bloc.

Si vous ne parvenez pas à habiller une image, vérifiez que l’option Ignorer l’habillage n’est pas sélectionnée pour le bloc de texte concerné. De
plus, si l’option L’habillage n’agit que sur le texte au-dessous est sélectionnée dans les préférences de Composition, assurez-vous que le bloc de
texte se trouve bien sous l’objet habillé.

Les blocs de texte dans un groupe ne sont pas affectés par l’habillage de texte que vous appliquez au groupe.

Pour définir des options d’habillage par défaut pour les nouveaux objets, désélectionnez tous les objets, puis spécifiez les paramètres de
l’habillage.

Pour habiller des images importées avec du texte

Pour habiller de texte une image importée, enregistrez le masque dans l’application dans laquelle vous avez créé l’image, si possible. Lorsque
vous importez l’image dans InDesign, sélectionnez l’option Appliquer le masque Photoshop dans la boîte de dialogue Options d’importation
d’image.

1. Pour afficher le panneau Habillage de texte, choisissez Fenêtre > Habillage de texte.

2. Sélectionnez une image importée, puis dans le panneau Habillage de texte, cliquez sur l’icône Habiller la forme de l’objet .

3. Spécifiez les valeurs de décalage Les valeurs positives éloignent l’habillage du bloc ; les valeurs négatives déplacent
l’habillage à l’intérieur du bloc.

4. Choisissez Afficher les options dans le menu du panneau Habillage de texte pour afficher les options supplémentaires.

5. Dans le menu Type, choisissez une option de contour :

Cadre de sélection

Habille de texte le rectangle formé par la hauteur et la largeur de l’image.

Détection des contours

Génère le cadre par détection automatique des contours (pour ajuster la détection des contours, sélectionnez l’objet, puis
choisissez la commande Objet > Masque > Options).

Couche alpha

Génère le cadre à partir d’une couche alpha enregistrée avec l’image. Si aucune couche alpha n’a été enregistrée avec le
graphique, cette option n’est pas disponible. InDesign reconnaît la transparence par défaut d’Adobe Photoshop (motif à
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damier) comme couche alpha. Sinon, utilisez Photoshop pour supprimer l’arrière-plan ou créez et enregistrez une ou plusieurs
couches alpha avec l’image.

Tracé Photoshop

Génère le cadre à partir d’un tracé enregistré avec l’image. Choisissez Tracé Photoshop, puis sélectionnez un tracé dans le
menu Tracé. Si aucun tracé nommé n’a été enregistré avec l’image, l’option Tracé Photoshop n’est pas disponible.

Bloc graphique

Génère le cadre à partir du bloc conteneur.

Identique au masque

Génère le cadre à partir du masque de l’image importée.

6. Pour laisser le texte apparaître dans les « trous » d’une image, comme à l’intérieur d’une image, sélectionnez Inclure les
contours intérieurs.

Option Inclure les contours intérieurs activée (à gauche) et désactivée (à droite)

Pour créer un habillage inversé

1. A l’aide de l’outil Sélection  ou Sélection directe , sélectionnez un objet, tel qu’un tracé transparent, permettant un habillage de
texte.

2. Pour afficher le panneau Habillage de texte, choisissez Fenêtre > Habillage de texte.

3. Appliquez un habillage à un objet, puis sélectionnez l’option Inverser. Cette option est souvent associée à l’option Habiller la
forme de l’objet.

Habillage du texte avec les options Habiller la forme de l’objet (gauche) et Inverser (droite) sélectionnées

Modification de la forme d’un habillage

1. A l’aide de l’outil Sélection directe , sélectionnez un objet auquel un habillage est appliqué. Si le cadre d’habillage a la même
forme que l’objet, il apparaît en surimpression.

2. Utilisez l’une des méthodes suivantes :

Pour modifier la distance entre le texte et l’objet, spécifiez les valeurs de décalage dans le panneau Habillage.

Utilisez l’outil Plume  et l’outil Sélection directe pour modifier le cadre d’habillage de texte.

Edition d’un cadre d’habillage
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Remarque :

Si vous modifiez manuellement la forme d’un tracé d’habillage, l’option Tracé modifié par l’utilisateur est sélectionnée dans le menu Type et reste
grisée dans le menu. Cela indique que le tracé de la forme a été modifié.

Si vous voulez utiliser le masque d’origine plutôt que le cadre d’habillage de texte modifié, choisissez Identique au masque dans le menu Type
du panneau Habillage de texte.

Application de l’habillage du texte sur des éléments de gabarit

Si l’option Appliquer au gabarit uniquement est sélectionnée, vous devez remplacer un élément de gabarit sur une page de document pour
l’habiller de texte. Si cette option est désélectionnée, le texte des gabarits et des pages de document peut habiller les éléments de gabarit sans
que ceux-ci ne soient remplacés.

1. Sélectionnez l’objet sur la page de gabarit.

2. Dans le menu du panneau Habillage de texte, sélectionnez ou désélectionnez Appliquer au gabarit seulement.

Cette option est disponible uniquement lorsqu’un objet sur un gabarit est sélectionné et qu’un habillage lui est appliqué.

Habillage d’objets ancrés avec du texte

Si vous appliquez un habillage à un objet ancré, l’habillage affecte les lignes de texte de l’article qui suivent le marqueur d’ancrage. Toutefois,
l’habillage n’affecte pas la ligne de texte comportant le marqueur d’ancrage ou les lignes le précédant.

Lorsque vous collez un objet sous forme d’objet texte, son cadre d’habillage est préservé.

Suppression de l’habillage sur les calques masqués

Lorsque vous masquez un calque contenant un habillage, les blocs de texte des autres calques habillent l’objet, sauf si l’option Supprimer
l’habillage lorsque le calque est masqué est activée dans la boîte de dialogue Options de calque. Si cette option est activée, le masquage d’un
calque peut entraîner la recomposition du texte sur d’autres calques.

1. Dans le panneau Calques, cliquez deux fois sur le calque contenant l’habillage.

2. Sélectionnez Supprimer l’habillage lorsque le calque est masqué.

Justification du texte d’habillage en regard d’un objet

Lorsque vous spécifiez le mode de justification du texte autour des objets habillés, la modification s’applique à tout le document.

1. Choisissez la commande Edition > Préférences > Composition (Windows) ou InDesign > Préférences > Composition
(Mac OS).

2. Sélectionnez l’une des options suivantes, puis cliquez sur OK :

Justifier le texte en regard d’un objet habillé recouvrant complètement la colonne

Justifie le texte en regard des objets qui séparent une colonne de texte. Ce paramètre s’applique uniquement lorsque
l’habillage interrompt complètement des lignes de texte, de sorte que chaque ligne est divisée en deux parties ou plus.

les options Aligner à gauche, Aligner à droite et Justifier ont pour effet d’aligner respectivement le texte adjacent
à un objet à gauche ou en haut de l’objet, à droite ou en bas de l’objet ou de façon uniforme par rapport aux deux bords.
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Justifier le texte à côté d’un objet

Ignorer par interlignage

Déplace le texte jusqu’à l’incrément d’interligne disponible suivant sous un objet habillé de texte. Si cette option n’est pas
sélectionnée, les lignes de texte peuvent descendre sous un objet, annulant l’alignement du texte avec les colonnes et blocs
de texte voisins. Il peut être utile de sélectionner cette option pour vous assurer que le texte est aligné sur la grille de ligne de
base.

L’habillage n’agit que sur le texte au-dessous

Le texte superposé au-dessus de l’objet habillé n’est pas affecté par l’habillage. L’ordre de superposition est déterminé par la
position des calques dans le panneau Calques et par l’ordre de superposition des objets sur un calque.

Ignorer dans un bloc de texte

Il peut être parfois utile de désactiver l’habillage dans un bloc. Par exemple, vous souhaitez qu’un bloc habille une image, mais vous souhaitez
afficher un bloc différent dans cette image.

1. Sélectionnez le bloc de texte, puis choisissez Objet > Options de bloc de texte.

2. Sélectionnez Ignorer l’habillage, puis cliquez sur OK.

Tracés transparents et formes composées
A propos des masques et des couches alpha
Gabarits
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Compositeurs universels Adobe
Sens du texte
Sens de l’article
Insertion automatique de Kashidas
Ligatures
Signes diacritiques
Copier-coller à partir de Microsoft Word
Polices par défaut
Prise en charge des anciennes polices
Types de chiffres
Césure
Rechercher et remplacer
Glyphes
Variantes de justification
Insertion de caractères spéciaux du Moyen-Orient
Sens d’un tableau
Sens de la reliure
Préférences d’écriture de droite à gauche
Numéros de page et de chapitre
Sens d’écriture en mode d’affichage Galerie et mode éditeur
Coloration des signes diacritiques

De nouvelles fonctions améliorées pour travailler en arabe et en hébreu sont disponibles dans l’édition Moyen-Orient et Afrique du Nord de ce
logiciel.

Compositeurs universels Adobe
Les compositeurs universels Adobe vous permettent de créer du contenu dans les langues du Moyen-Orient. Vous pouvez saisir du texte en
allemand, anglais, arabe, français, hébreu, russe et dans d’autres langues latines et les combiner.

Vous pouvez choisir parmi les compositeurs disponibles dans le menu du panneau Paragraphe (Fenêtre > Paragraphe > menu du panneau). Par
exemple, dans InDesign, vous pouvez utiliser le compositeur de paragraphe universel Adobe. Ou, dans Illustrator, vous pouvez utiliser le
compositeur ligne par ligne pour le Moyen-Orient.

 
Compositeurs universels Adobe

Vous pouvez également enregistrer vos fichiers avec des noms en arabe et hébreu.

Sens du texte
Pour créer du contenu en arabe et en hébreu, activez le sens de texte de droite à gauche. Le sens de droite à gauche est le sens du texte par
défaut, mais de nombreux documents incluent également du texte de gauche à droite. Vous pouvez basculer entre les deux sens en toute
transparence.

Sélectionnez le sens du paragraphe dans le panneau Paragraphe.

 
Sélectionnez le sens du paragraphe

Si vous avez un mélange de langues dans le même paragraphe, vous pouvez spécifier le sens du texte au niveau des caractères. En outre, pour
insérer les dates et les nombres, spécifiez le sens du texte au niveau des caractères.
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A partir du menu du panneau Caractère, choisissez Sens des caractères, puis sélectionnez un sens.

 
Sens des caractères

Sens de l’article
Lorsque vous travaillez avec l’arabe et l’hébreu, l’article en règle générale défile de la droite vers la gauche. La première colonne doit être à droite
de l’image, et les colonnes suivantes sont ajoutées à gauche. Si votre disposition contient un contenu mixte, des articles différents nécessitent un
sens différent.

Dans le panneau Article (Fenêtre > Texte et tableaux > Article), cliquez sur un sens de l’article.

 
Sens de l’article

Insertion automatique de Kashidas
En arabe, le texte est justifié en ajoutant des Kashidas. Les Kashidas sont ajoutés aux caractères arabes pour les allonger. L’espace n’est pas
modifié. Utilisez l’insertion automatique de Kashidas pour justifier les paragraphes de texte en arabe.

Sélectionnez le paragraphe et, dans le panneau Paragraphe (Fenêtre > Texte et tableaux > Paragraphe), choisissez un paramètre dans la liste
déroulante Insérer Kashida. Les options disponibles sont les suivantes : aucun, court, moyen, long ou stylistique. Les Kashidas sont insérés
uniquement si le paragraphe est justifié. Ce paramètre n’est pas applicable pour les paragraphes qui ont des paramètres d’alignement.

Pour appliquer des Kashidas à un groupe de caractères, sélectionnez les caractères et choisissez Kashidas dans le menu du panneau Caractère.

 
Kashidas automatiques

Ligatures
Vous pouvez appliquer automatiquement des ligatures à des paires de caractères en arabe et en hébreu. Les ligatures sont des caractères de
remplacement typographiques utilisées pour certaines paires de lettres lorsqu’elles sont disponibles dans une police Open Type donnée.

Lorsque vous choisissez la commande Ligatures dans le menu du panneau Caractère ou Contrôle, une ligature standard définie dans la police est
créée.

1. Sélectionnez du texte.
2. Choisissez Ligatures dans le menu du panneau Caractère ou du panneau Contrôle.

Toutefois, certaines polices Open Type contiennent des ligatures conditionnelles ornées plus complexes que vous pouvez reproduire en
choisissant la commande Ligatures conditionnelles. Ces ligatures se trouvent dans le panneau Caractère > OpenType > Ligatures conditionnelles.

 
Activation automatique des ligatures

Signes diacritiques
Dans le script arabe, une diacritique ou un signe diacritique est un glyphe utilisé pour indiquer la longueur des consonnes ou les voyelles courtes.
Les signes diacritiques se placent au-dessus ou au-dessous du script. Pour définir au mieux le style de texte ou améliorer la lisibilité de certaines
polices, vous pouvez contrôler la position verticale ou horizontale des signes diacritiques :

1. Sélectionnez du texte qui contient des signes diacritiques.
2. Dans le panneau Caractère (Ctrl + T), modifiez la position des signes diacritiques par rapport au script. Les valeurs que vous

pouvez modifier sont : Ajuster la position horizontale des signes diacritiques, et Ajuster la position verticale des signes
diacritiques.
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Modification de la position des signes diacritiques

Copier-coller à partir de Microsoft Word
Vous pouvez copier du texte à partir de Microsoft Word et le coller directement dans un document. L’alignement et le sens du texte collé sont
automatiquement définis sur ceux du texte en arabe ou hébreu.

Polices par défaut
Lorsque vous installez une version Moyen-Orient ou Afrique du Nord, la police de texte par défaut est définie selon la langue de l’installation, par
défaut. Par exemple, si vous avez installé la version anglais/compatible arabe, la police de texte par défaut est définie sur Adobe arabe. De même,
si vous avez installé la version anglais/compatible hébreu, la police de texte par défaut est définie sur Adobe hébreu.

Prise en charge des anciennes polices
Les polices qui ont été traditionnellement utilisées (par exemple les polices AXT) peuvent toujours être utilisées dans cette version du logiciel.
Toutefois, il est recommandé d’utiliser les nouvelles polices Open Type pour les éléments basés sur le texte.

La protection des glyphes manquants (Edition > Préférences > Texte avancé) est activée par défaut. Le texte est traité automatiquement lorsque
les glyphes ne sont pas disponibles dans la police que vous utilisez.

Types de chiffres
Lorsque vous travaillez en arabe ou en hébreu, vous pouvez sélectionner le type de chiffres que vous souhaitez utiliser. Vous pouvez choisir entre
arabe, farsi et hindi.

Par défaut, en arabe, la version hindi est sélectionnée automatiquement, et dans le cas de l’hébreu, les chiffres de type arabe sont sélectionnés.
Toutefois, vous pouvez passer en chiffres arabes, si vous le souhaitez :

1. Sélectionnez les chiffres dans le texte saisi.
2. Dans le panneau Caractère (Ctrl + T), utilisez la liste Chiffres pour sélectionner la police que les chiffres doivent utiliser.

Vous pouvez vous assurer que les chiffres arabes sont utilisés en activant l’option Utiliser les chiffres natifs avec les langues arabes. Pour utiliser
cette option, choisissez Edition > Préférences > Texte avancé.

 
Sélection du type de chiffres

Césure
Les phrases qui ont plus de mots qu’une ligne de texte peut contenir enchaînent automatiquement à la ligne suivante. Le type de justification de
texte en situation de retour à la ligne entraîne parfois l’apparition d’espaces inutiles dans la ligne qui ne sont pas agréables esthétiquement ni
corrects linguistiquement. La césure permet de séparer les mots à la fin d’une ligne, à l’aide d’un trait d’union. Cette fragmentation permet à la
phrase de retourner à la ligne suivante de façon plus adaptée.

Texte mixte : la fonction d’insertion de Kashidas affecte la façon dont la césure se produit dans un texte mixte. Lorsque cette option est activée,
les Kashidas sont insérés dès qu’ils peuvent l’être et le texte qui n’est pas en arabe n’est pas césuré. Lorsque la fonction Kashida est désactivée,
seul le texte qui n’est pas en arabe est pris en compte pour la césure.

Texte en hébreu : la césure est autorisée. Pour activer la césure et personnaliser les paramètres, sélectionnez le panneau Paragraphe > menu du
panneau > Paramètres de césure.

 
Options de césure

Rechercher et remplacer
Les utilisateurs de l’hébreu et de l’arabe peuvent effectuer une recherche de texte intégral et remplacer. En plus de la recherche et du
remplacement de texte simple, vous pouvez également rechercher et remplacer du texte présentant des caractéristiques spécifiques. Ces
caractéristiques peuvent inclure des marques diacritiques, des Kashidas, des caractères spéciaux (par exemple, Alef), des chiffres dans
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différentes langues (par exemple, chiffres en Hindi), et bien plus encore.

Pour exécuter la recherche et le remplacement du texte :

InDesign: Edition > Rechercher/Remplacer

Dans InDesign, vous pouvez utiliser l’onglet Translittération (Edition > Rechercher/Remplacer) pour rechercher et remplacer les chiffres entre
l’arabe, l’hindi, et le farsi. Par exemple, vous pouvez rechercher les chiffres saisis en hindi et les convertir en arabe.

Glyphes
Les utilisateurs de l’arabe et de l’hébreu peuvent appliquer des glyphes dans le jeu de caractères par défaut. Cependant, pour y accéder,
sélectionner, puis appliquer un glyphe défini par le jeu de caractères par défaut ou une langue différente, utilisez le panneau Glyphes :

InDesign : Fenêtre > Texte et tableaux > Glyphes 
Illustrator : Fenêtre > Type > Glyphes

 
Parcourir, sélectionner et appliquer les glyphes

Variantes de justification
Une police peut posséder des formes alternatives pour certaines lettres de l’alphabet. Ces variantes de la police de caractères disponibles pour
certaines lettres sont généralement utilisées à des fins stylistiques ou calligraphiques. Dans de rares cas, des variantes de justification sont
utilisées pour justifier et aligner les paragraphes pour des besoins précis.

Les variantes de justification peuvent être activées au niveau des paragraphes, dans lesquels les variantes seront utilisées dès que possible. Vous
pouvez également activer ou désactiver cette fonction au niveau des caractères. Les variantes de justification sont uniquement disponibles dans
les polices qui sont dotées de cette fonction intégrée. Par conséquent, l’option pour les activer ou désactiver est uniquement disponible pour les
polices prises en charge.

Les polices arabes qui contiennent des variantes de justification sont : Adobe arabe, Myriad arabe et Adobe Naskh. Les polices hébraïques qui
contiennent des variantes de justification sont : Adobe hébreu et Myriad hébreu.

InDesign

Niveau paragraphe : Fenêtre > panneau Paragraphe > menu du panneau > Justification, puis choisissez une option dans la liste
Justification.

Niveau caractère : Fenêtre > panneau Caractère > menu du panneau > option Variante de justification.

Photoshop

Niveau caractère : Fenêtre > panneau Caractère > case à cocher Variantes de justification.

Insertion des caractères spéciaux du Moyen-Orient
Certains caractères en arabe et en hébreu sont difficiles à insérer dans le texte. De plus, la disposition des claviers arabe et hébreu complique la
saisie ou l’insertion de ces caractères. Pour insérer des caractères comme une apostrophe en hébreu (Geresh) ou Maqaf, sélectionnez un
caractère dans le panneau Caractère > menu du panneau > Insérer caractère spécial ME.

 
Insérer un caractère spécial ME

Sens d’un tableau
Les utilisateurs de l’arabe et de l’hébreu peuvent définir le sens d’un tableau inséré dans un document. En conséquence, l’ordre des cellules et
des colonnes, la langue par défaut et l’alignement du texte est défini. Pour un utilisateur arabe, la colonne la plus à droite est la première colonne,
et les colonnes supplémentaires sont ajoutées au-delà de la colonne de gauche du tableau. Le sens du tableau est également pris en charge dans
le mode éditeur (Ctrl + Y).

Pour définir le sens d’un nouveau tableau :

1. Cliquez sur Tableau > Insérer un tableau
2. Dans Insérer un tableau , choisissez une option dans la listeSens liste pour sélectionner le sens du tableau.

Pour modifier le sens d’un tableau existant :



En haut

En haut

En haut

En haut

En haut

1. Placez le curseur dans un tableau.
2. Ouvrez le panneau Tableau (Maj + F9), puis cliquez sur les icônes Tableau de gauche à droite ou Tableau de droite à gauche

pour définir le sens du tableau.

Pour les tableaux de droite à gauche, le versions arabe et Afrique du Nord sont en langue arabe par défaut. La version hébraïque est définie sur
hébreu. Pour les tableaux de gauche à droite, les versions arabe et hébraïque adoptent par défaut la langue anglaise. La version Afrique du Nord
est en français par défaut.

Sens de la reliure
Le sens de la reliure définit le bord le long duquel un livre est relié. Les livres écrit dans une langue de gauche à droite sont reliées à gauche. Les
documents écrits dans une langue de droite à gauche sont reliés à l’extrémité droite du livre.

 
Mise en page d’un livre relié à droite

Préférences d’écriture de droite à gauche
Caractères neutre

La direction de certains caractères en arabe et en hébreu peut apparaître ambiguë. Le manque de clarté quant à la direction des caractères peut
entraîner une confusion dans la direction et l’ordre des chaînes. Pour vous assurer que la direction de ces caractères est claire et sans ambiguïté.

1. Cliquez sur Edition > Préférences > Droite à gauche
2. Sélectionnez la boîte Forcer la direction du caractère neutre en fonction de la saisie clavier.

Contrôle du curseur

Les utilisateurs de l’arabe et de l’hébreu peuvent contrôler la direction de déplacement du curseur, lorsqu’ils utilisent les touches fléchées du
clavier. Cette liste de déplacement du curseur (Edition > Préférences > Droite à gauche) comporte deux options que vous pouvez choisir dans :

Visuel : le curseur se déplace dans le sens de la flèche. Lorsque la flèche vers la droite est enfoncée, le curseur à l’écran se
déplace vers la droite. 
Logique : le curseur se déplace en fonction de la direction du langage saisie. En arabe et en hébreu, lorsque la flèche de
droite est enfoncée, le curseur se déplace à gauche (vers le caractère suivant dans une langue de droite à gauche). 

Numéros de page et de chapitre
Les utilisateurs de l’arabe et de l’hébreu utilisent les systèmes de numérotation courants dans la région. Les systèmes de numérotation les plus
populaires sont :

Arabe : Abjad et Alef-Ba-Tah
Français : hébreu biblique standard et hébreu décimal non standard

Pour sélectionner ou modifier le système de numérotation, accéder à Mise en forme > Options de numérotation et de section, puis sélectionnez
dans la liste Style.

 
La numérotation des pages, des sections et des chapitres

Sens d’écriture dans un affichage Galerie et en mode éditeur
En en arabe ou en hébreu, vous pouvez indiquer le sens dans lequel vous écrivez. Allez dans Edition > Préférences > Affichage en mode éditeur,
puis sélectionnez la boîteIndiquer le sens de l’écriture pour activer cette fonction. Lorsque cette fonction est activée, le curseur a une flèche qui
indique le sens de l’écriture.

Coloration des signes diacritiques
Dans un texte en arabe, les signes diacritiques peuvent être colorés différemment pour des raisons stylistiques ou autres. Par exemple, des signes
diacritiques peuvent mettre l’accent sur un aspect spécifique d’un mot ou d’une phrase. Vous pouvez rechercher et modifier la couleur des signes
diacritiques à l’aide de la requête Modifier la couleur des signes diacritiques arabe.

1. Cliquez sur Edition > Rechercher/Remplacer



2. Dans la liste requête, sélectionnez Modifier la couleur des signes diacritiques arabiques
3. Utilisez les boutons Modifier, Tout modifier, ou Remplacer/Rechercher pour remplacer les anciens signes diacritiques par les

nouveaux signes de couleur.

Vous pouvez modifier et enregistrer la requête selon vos exigences.

 Les publications Twitter™ et Facebook ne sont pas couvertes par les dispositions de Creative Commons.

Informations juridiques | Politique de confidentialité en ligne

http://creativecommons.org/licenses/by-nc-sa/3.0/deed.fr
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr


Objets ancrés

Haut de la page

Sur la ligne

Au-dessus de la ligne

Autre

Remarque :

A propos des objets ancrés
Création d’un objet ancré
Placement d’un objet ancré selon des options personnalisées
Manipulation des objets ancrés par glisser-déposer (CS 5.5)
Sélection et copie d’objets ancrés
Affichage des marqueurs d’objets ancrés sur la page
Repositionnement manuel d’un objet ancré sur la page
Redimensionnement d’un objet ancré
Annulation d’ancrage d’un objet

A propos des objets ancrés

Les objets ancrés sont des éléments de type graphique ou zone de texte, liés (ou ancrés) à un texte spécifique. Les objets ancrés se déplacent
en même temps que le texte comportant un ancrage. Utilisez des objets ancrés pour tous les objets que vous souhaitez associer à une ligne ou à
un bloc de texte spécifique, comme les encadrés et les légendes, les illustrations ou les icônes associées à un mot particulier.

Vous pouvez créer un objet ancré en collant ou en important un objet (ou un bloc) dans le texte à l’aide de l’outil Texte ou de la commande
Insérer l’objet ancré. Lorsque vous importez cet objet, Adobe InDesign CS4 ajoute un marqueur d’ancrage au point d’insertion. Les objets ancrés
héritent des attributs de rotation et d’inclinaison du bloc de texte auquel ils sont ancrés, même lorsque l’objet se trouve en dehors du bloc de texte.
Vous pouvez sélectionner l’objet et modifier ces attributs.

Vous pouvez créer des objets ancrés aux emplacements suivants :

Aligne l’objet ancré sur la ligne de base du point d’insertion. Vous pouvez modifier le décalage sur Y afin de placer l’objet au-dessus
ou au-dessous de la ligne de base. Il s’agit du type d’objet ancré par défaut. Dans les versions précédentes d’InDesign, ces objets étaient appelés
images texte.

Importe l’objet ancré au-dessus de la ligne et propose les alignements suivants : Gauche, Centrer, Droite, Aligné au dos,
Aligné à l’opposé du dos et (Alignement du texte). L’option Alignement du texte correspond à l’alignement appliqué au paragraphe qui contient le
marqueur d’ancrage.

Importe l’objet ancré à l’endroit défini dans la boîte de dialogue Options d’objet ancré. Vous pouvez placer l’objet là où vous le souhaitez à
l’intérieur ou à l’extérieur du bloc de texte.

vous pouvez utiliser des objets sur la ligne et au-dessus de la ligne avec un texte curviligne (voir Ajout d’objets ancrés à du texte
curviligne).

http://idiom-q-win-1/fr/indesign/using/creating-type-path.html#add_anchored_objects_to_type_on_a_path
http://idiom-q-win-1/fr/indesign/using/creating-type-path.html#add_anchored_objects_to_type_on_a_path
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Exemple de document avec objets ancrés

A. Sur la ligne B. Au-dessus de la ligne (alignement à gauche) C. Position personnalisée (alignement sur le bord du bloc de texte) 

Tim Cole présente un raccourci pour l’insertion de blocs ancrés dans l’article Anchored Frames Productivity Shortcut.

Création d’un objet ancré

Si l’objet à importer dans le document n’est pas disponible (par exemple, un texte d’encadré qui n’est pas encore écrit), vous pouvez créer un bloc
ancré vide réservé au contenu que vous ajouterez par la suite. Vous pouvez redimensionner le bloc ancré à tout moment : les paramètres de
position du bloc se mettent à jour automatiquement.

1. Utilisez l’une des méthodes suivantes :

Pour ajouter un objet ancré, utilisez l’outil Texte afin de placer un point d’insertion là où vous souhaitez faire apparaître le
point d’ancrage de l’objet, puis importez ou collez l’objet.

Si le bloc de l’objet est plus haut que la ligne de texte dans laquelle il apparaît, le texte peut chevaucher l’image importée
ou engendrer un espace plus grand au-dessus de la ligne. Vous pouvez toujours sélectionner une autre position pour
l’objet ancré, insérer un saut de ligne forcé ou automatique, redimensionner l’objet sur la ligne ou spécifier une valeur
d’interligne différente pour les lignes voisines.

Pour ancrer un objet existant, sélectionnez-le, puis choisissez Edition > Couper. A l’aide de l’outil Texte, placez ensuite le
point d’insertion là où vous souhaitez faire apparaître l’objet, puis choisissez Edition > Coller. Par défaut, l’objet ancré
importé est sur la ligne.

Pour ajouter l’emplacement graphique d’un objet qui n’est pas disponible (par exemple, un texte d’encadré que vous
n’avez pas encore écrit), utilisez l’outil Texte pour placer le point d’insertion là où vous souhaitez faire apparaître le point
d’ancrage de l’objet, puis choisissez Objet > Objet ancré > Insérer.

Vous pouvez ancrer des caractères de texte en vectorisant le texte. La vectorisation permet de convertir automatiquement
chaque caractère de texte en objet ancré sur la ligne.  

2. Pour placer un objet, sélectionnez-le à l’aide d’un outil de sélection, puis choisissez Objet > Objet ancré > Options. Spécifiez
les options voulues.

Si vous ne souhaitez pas afficher la boîte de dialogue Objet ancré, utilisez le raccourci clavier Insérer l’objet ancré/Atteindre le marqueur
d’ancrage. Vous devrez définir les touches de ce raccourci dans l’éditeur de raccourcis clavier (dans la zone Texte et tableaux). Appuyez deux
fois sur les touches du raccourci clavier pour désélectionner l’objet et replacer le pointeur dans le texte principal (voir Utilisation des ensembles
de raccourcis clavier).

Options des objets ancrés insérés

Lorsque vous insérez un emplacement réservé à un objet ancré, vous pouvez définir les options suivantes à propos de son contenu :

http://blogs.adobe.com/indesignchannel/2007/11/anchored_frames_productivity_s.html
http://idiom-q-win-1/fr/indesign/using/customize-menus-keyboard-shortcuts.html#use_keyboard_shortcut_sets
http://idiom-q-win-1/fr/indesign/using/customize-menus-keyboard-shortcuts.html#use_keyboard_shortcut_sets
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Remarque :

Style d’objet

Style de paragraphe

Remarque :

Hauteur et Largeur

Sur la ligne

Décalage sur Y

Au-dessus de la ligne

Alignement

Gauche, Droite ou Centrer

Aligné au dos ou Aligné à l’opposé du dos

(Alignement du texte)

Espace avant

Espace après

Indique le type d’objet que l’emplacement réservé doit contenir.

si vous choisissez Texte, un point d’insertion s’affiche dans le bloc de texte ; si vous choisissez Graphique ou Non attribué, InDesign
sélectionne l’emplacement de l’objet.

Indique le style à utiliser pour mettre l’objet en forme. Si vous avez défini et enregistré des styles d’objet, ceux-ci apparaissent dans
le menu.

Indique le style de paragraphe à utiliser pour mettre l’objet en forme. Si vous avez défini et enregistré des styles de
paragraphe, ceux-ci apparaissent dans le menu.

si un style de paragraphe est activé en même temps qu’un style d’objet et si vous choisissez un style différent dans le menu Style de
paragraphe, ou si vous modifiez les options Position ancrée d’un style, un signe plus (+) apparaît dans le menu Style d’objet pour indiquer que
des remplacements ont été effectués.

Indique les dimensions de l’emplacement réservé.

Options de position sur la ligne ou au-dessus de la ligne

Lorsque vous choisissez Sur la ligne ou Au-dessus de la ligne dans le menu Position de la boîte de dialogue Options d’objet ancré, les options
suivantes permettent de modifier la position de l’objet ancré. Vous pouvez également accéder à ces options dans la boîte de dialogue Insérer
l’objet ancré.

Aligne le bas de l’objet ancré sur la ligne de base. Les objets sur la ligne sont soumis à certaines contraintes lorsqu’ils sont déplacés
le long de l’axe des Y : le haut de l’objet ne peut pas se situer en dessous de la ligne-bloc de l’interligne inférieur et le bas de l’objet ne peut pas
se trouver au-dessus du haut de la ligne-bloc de l’interligne.

Ajuste la position de la ligne de base. Vous pouvez également utiliser la souris pour faire glisser l’objet verticalement sur la page.

Aligne l’objet au-dessus de la ligne de texte comprenant le marqueur d’ancrage et au-dessous de la ligne de texte située
au-dessus du marqueur d’ancrage.

Utilisez l’une des méthodes suivantes :

Alignent l’objet à l’intérieur de la colonne de texte. Ces options ne tiennent pas compte des valeurs de retrait
appliquées au paragraphe et alignent l’objet au sein de la colonne entière.

Alignent l’objet à gauche ou à droite selon le côté de la planche où se situe l’objet. Ces
options ne tiennent pas compte des valeurs de retrait appliquées au paragraphe et alignent l’objet au sein de la colonne entière.

Aligne l’objet selon l’alignement défini par le paragraphe. Cette option utilise les valeurs de retrait du paragraphe
lors de l’alignement de l’objet.

Indique la position de l’objet par rapport au bas de la ligne-bloc de l’interligne de la ligne précédente du texte. Les valeurs positives
font baisser à la fois l’objet et le texte situé en dessous. Les valeurs négatives font remonter le texte situé en dessous de l’objet vers cet objet. La
valeur négative maximale correspond à la hauteur de l’objet.

Indique la position de l’objet par rapport à la hauteur de capitale du premier caractère de la ligne située en dessous de l’objet. Une
valeur de 0 permet d’aligner le bas de l’objet à la position de la hauteur de capitale. Les valeurs positives déplacent le texte situé sous l’objet vers
le bas (elles l’éloignent du bas de l’objet). Les valeurs négatives font remonter le texte situé en dessous de l’objet (vers cet objet).
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Utilisation des options Espace avant et Espace après

A. Une valeur Espace avant de 0P10 éloigne l’objet et le texte associé de la ligne de texte située au-dessus. B. Une valeur Espace après de 0P10
permet d’éloigner l’objet et la ligne de texte située au-dessus du texte associé (en dessous). 

les objets ancrés définis sur l’option Au-dessus de la ligne conservent toujours la ligne comprenant l’ancrage ; le texte ne fait pas
apparaître un objet au bas d’une page et la ligne où se trouve le marqueur d’ancrage en haut de la page suivante.

Options de position personnalisées

Vous pouvez utiliser les options suivantes lorsque vous voulez positionner un objet ancré de façon personnalisée. Vous pouvez spécifier ces
options dans la boîte de dialogue Insérer l’objet ancré ou Options d’objet ancré. Pour obtenir des instructions détaillées sur l’utilisation de ces
options, voir Placement d’un objet ancré selon des options personnalisées.

Indique si l’objet s’aligne en fonction du dos du document. Lorsque vous sélectionnez cette option, la doublure Point de
référence de l’objet ancré s’affiche sous la forme d’une planche. Les deux pages se reflètent. Une fois sélectionnés, les objets placés d’un côté de
la planche (à l’extérieur de la marge par exemple) restent à l’extérieur de la marge même si le texte est déplacé vers une page en vis-à-vis.

Utilisation de l’option Relative au dos

A. Option Relative au dos non sélectionnée : l’objet reste à gauche du bloc de texte lorsque le texte est déplacé vers le côté droit de la planche. B.
Option Relative au dos sélectionnée : l’objet reste à l’extérieur de la page lorsque le texte est déplacé vers le côté droit de la planche. 

si, après avoir sélectionné l’option Relative au dos, vous modifiez la valeur Décalage sur X, la direction de déplacement de l’objet
peut changer. Ce changement s’opère car la direction de ce déplacement dépend notamment du côté de la planche où se situe l’objet.



Point de référence de l’objet ancré 

Point de référence de la position ancrée 

Remarque :

Axe des X relatif à

Décalage sur X

Axe des Y relatif à

Indique l’emplacement de l’objet que vous souhaitez aligner sur l’emplacement de la page (comme indiqué
par le point de référence de la position ancrée). Par exemple, si vous souhaitez aligner le côté droit de l’objet avec un élément de la page, comme
un bloc de texte, cliquez sur le point le plus à droite de cette doublure. Pour obtenir plus d’informations sur l’utilisation de ce point de référence,
voir Placement d’un objet ancré selon des options personnalisées.

Indique l’emplacement de la page (défini à l’aide des options Axe des X relatif à et Axe des Y relatif à) vis-à-vis duquel vous souhaitez aligner
l’objet. Par exemple, si vous choisissez Bloc de texte pour l’option Axe des X relatif à et Ligne (ligne de base) pour l’option Axe des Y relatif à,
cette doublure représente la zone horizontale du bloc de texte et la zone verticale de la ligne de texte comprenant le marqueur d’ancrage de

l’objet. Si vous cliquez sur le point à l’extrême gauche de cette doublure, le point de référence de l’objet  s’aligne sur le bord gauche du bloc de
texte et la ligne de base du texte.

Côté droit de l’objet aligné sur le bord gauche du bloc de texte

selon les valeurs choisies pour les options Axe des X relatif à et Axe des Y relatif à, la doublure Point de référence de la position
ancrée affiche trois ou neuf positions. Les options de ligne, comme Ligne (ligne de base), proposent seulement trois options : Au centre, à gauche,
Centrer et Au centre, à droite. En effet, le positionnement vertical est défini par le marqueur d’ancrage dans le texte.

Indique ce que vous souhaitez utiliser comme base de l’alignement horizontal. Par exemple, Bloc de texte vous permet
d’aligner l’objet à gauche, au centre ou à droite du bloc de texte. L’alignement horizontal exact dépend du point de référence choisi et des valeurs
spécifiées pour le Décalage sur X.
Par exemple, si vous souhaitez que l’objet apparaisse dans la marge de la page de telle sorte que le bord droit est aligné sur la marge de page,
sélectionnez Marge de page pour Axe des X relatif à et spécifiez le point le plus à droite de la doublure Point de référence de l’objet ancré et le
point le plus à gauche de la doublure Point de référence de la position ancrée.

Option Axe des X relatif à

A. Alignement du bord droit d’un objet sur le bord gauche d’un bloc de texte &nbsp; B. Alignement du bord droit d’un objet sur le bord gauche de
la marge de page

Déplace l’objet vers la gauche ou vers la droite. Le déplacement vers la gauche ou vers la droite dépend du point de référence.
Si l’alignement se fait au centre de l’élément de la page, les valeurs positives permettent de déplacer l’objet vers la droite. La direction de
déplacement dépend également de la sélection de l’option Relative au dos.

Indique par rapport à quel élément l’objet s’aligne verticalement. Par exemple, l’option Bord de page vous permet d’utiliser le
bord de la page comme base d’alignement de l’objet vers le haut, le centre ou le bas de la page. Le point de référence de la position ancrée
indique si l’objet s’aligne sur le haut, le centre ou le bas de cet élément de page. Si vous choisissez une option de ligne, comme Ligne (base de
ligne), le point de référence de la position ancrée affiche uniquement la ligne de points horizontale du milieu.



Décalage sur Y

Conserver dans les limites supérieure/inférieure de colonne
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Empêcher le positionnement manuel

Aperçu

Haut de la page

Option Axe des Y relatif à

A. Alignement du haut de l’objet sur le bord supérieur de la page B. Alignement du bas de l’objet sur le bord inférieur de la page 

Déplace l’objet vers le haut ou vers le bas. Les valeurs positives déplacent l’objet vers le bas.

Maintient l’objet à l’intérieur de la colonne de texte même si le déplacement de
texte est censé le faire sortir des limites définies. Dans de tels cas, le bas de l’objet s’aligne sur l’encart du bas ou le haut de l’objet s’aligne sur
l’encart du haut. Par exemple, un objet ancré sur le côté d’une ligne de texte et au milieu d’une colonne paraît bien situé ; cependant, si cette
option n’est pas sélectionnée et que le marqueur d’ancrage est placé au bas de la colonne, l’objet peut passer en dessous du bord de la colonne
ou partiellement hors de la page. Lorsque cette option est sélectionnée, vous ne pouvez pas faire glisser l’objet au-dessus ou au-dessous des
limites de la colonne. Si vous redimensionnez l’objet, il s’aligne sur les limites du haut ou du bas de la colonne, le cas échéant. Cette option est
disponible uniquement lorsque vous sélectionnez une option de ligne, comme Ligne (ligne de base) pour Axe des Y relatif à.

lorsque InDesign remplace la position de l’objet pour la faire correspondre aux limites de la colonne, la valeur de décalage sur Y que
vous spécifiez est indiquée par un signe plus (+) dans la boîte de dialogue.

Fait en sorte que vous ne puissiez pas déplacer l’objet ancré en le faisant glisser ou en le déplaçant à
l’aide des touches de direction sur la page.

Affiche les paramètres de position sur la page tels que vous les avez définis.

Placement d’un objet ancré selon des options personnalisées

Suivez ces conseils lorsque vous utilisez la boîte de dialogue Options d’objet ancré pour positionner les objets ancrés selon les options
personnalisées.

Les options de position personnalisées comprennent quatre options principales : les deux doublures de Point de référence et
les menus Axe des X relatif à et Axe des Y relatif à. Ces options permettent conjointement d’indiquer l’emplacement de l’objet.
Par exemple, les valeurs des options Axe des X relatif à et Axe des Y relatif à déterminent ce que le point de référence de la
position ancrée représente (bloc de texte, ligne de texte au sein d’une colonne ou page entière). L’image suivante indique
comment modifier l’emplacement de l’objet en choisissant un point de référence différent avec les mêmes options d’Axe des X
relatif à et Axe des Y relatif à.



Modification de l’emplacement de l’objet ancré (Axe des X relatif à sur Bloc de texte ; Axe des Y relatif à sur Ligne (ligne de base))

A. Choix d’un point inférieur droit sur la doublure Objet ancré et du point centré gauche sur la doublure Position ancrée. B. Déplacement du point
de doublure Objet ancré vers l’angle supérieur gauche et maintien du point de doublure Position ancrée au centre gauche C. Maintien de la
doublure Objet ancré en haut à gauche et modification de la doublure Position ancrée au centre droit

Pour créer un objet ancré qui conserve sa position sur la page (dans le coin supérieur gauche, par exemple) lors du
déplacement d’un texte et se déplace uniquement lorsque le texte est déplacé vers une autre page, ancrez l’objet sur les
marges de la page ou les bords de page. Par exemple, définissez les options Axe des X relatif à et Axe des Y relatif à sur

Marge de page, puis cliquez sur le point de référence supérieur gauche de l’objet  et celui de l’élément de page . Lors du
déplacement du texte, l’objet reste dans le coin supérieur gauche, dans les marges de la page. L’objet est déplacé uniquement
lorsque la ligne de texte contenant l’ancrage passe sur une autre page, à savoir dans le coin supérieur gauche de la page
suivante.

Positionnement d’un objet ancré à un emplacement particulier de la page

A. Positionnement de l’objet à l’aide des options Marge de page ou Bord de page pour X et de l’option Axe des Y relatif à B. Lors de la
redistribution du texte, l’objet ne suit pas le texte tant que le texte n’atteint pas une nouvelle page

Pour conserver un objet aligné sur une ligne de texte spécifique afin que l’objet et ce texte soient déplacés simultanément,
choisissez une option Ligne dans le menu Axe des Y relatif à.

Pour conserver l’objet dans un bloc de texte, mais pas aligné sur une ligne de texte spécifique lors du déplacement de texte,
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choisissez Bloc de texte dans le menu Axe des X relatif à.

Pour aligner l’objet par rapport à la marge (par exemple, pour créer un encadré qui reste à l’extérieur des marges lors du
déplacement de texte d’une page à l’autre), sélectionnez Relative au dos.

1. Sélectionnez l’objet et choisissez Objet > Objet ancré > Options.

2. Dans le menu Position, choisissez Personnalisée.

Pour voir les déplacements de l’objet lorsque vous précisez les options, sélectionnez Aperçu au bas de la boîte de
dialogue.

3. Pour conserver l’objet sur le même côté de la page, relatif au dos du document, sélectionnez Relative au dos. Par exemple,
choisissez cette option pour que l’objet apparaisse toujours à l’extérieur des marges, quel que soit le côté de la planche où il
se trouve.

4. Cliquez sur le point de la doublure du point de référence de l’objet ancré  qui représente le point à aligner sur la page.

5. Dans le menu Axe des X relatif à, choisissez l’élément de page à utiliser comme base horizontale de l’alignement de l’objet.
Par exemple, sélectionnez Bloc de texte pour aligner l’objet sur la gauche, la droite ou au centre du bloc de texte.

6. Dans le menu Axe des Y relatif à, choisissez l’élément de page à utiliser comme base verticale de l’alignement de l’objet. Par
exemple, pour aligner un objet sur la ligne de base du texte auquel il est ancré, choisissez l’option Ligne (ligne de base).

7. Cliquez sur le point de la doublure du point de référence de la position ancrée  représentant l’emplacement, au sein des
éléments choisis à partir des menus Axe des X relatif à et Axe des Y relatif à, sur lequel aligner l’objet.

8. Indiquez une valeur de décalage sur X ou de décalage sur Y pour déplacer l’objet à l’aide des touches de direction ou
l’éloigner du point d’alignement.

9. Pour être sûr que l’objet ne dépasse pas des bords supérieur et inférieur d’une colonne lors du déplacement du texte,
sélectionnez Conserver dans les limites supérieure/inférieure de colonne. Cette option est disponible uniquement lorsque vous
sélectionnez une option de ligne, comme Ligne (ligne de base) dans le menu Axe des Y relatif à.

10. Cliquez sur le bouton OK.

Manipulation des objets ancrés par glisser-déposer (CS 5.5)

Manipulation des objets ancrés par glisser-déposer (CS 5.5)

Vous pouvez faire glisser un objet existant dans un bloc de texte pour l’ancrer et le déplacer. Sélectionnez l’objet à l’aide de l’outil Sélection  ou
Sélection directe , puis faites glisser le cadre bleu à proximité de l’angle supérieur droit du bloc de texte. Utilisez l’une des méthodes suivantes :

Pour ancrer un objet existant, faites glisser le cadre bleu à l’emplacement où vous souhaitez faire apparaître le point d’ancrage
de l’objet.

Pour créer un objet texte, appuyez sur la touche Maj et faites glisser le cadre bleu à l’emplacement où vous souhaitez faire
apparaître l’objet.

Pour spécifier les options de l’objet ancré, appuyez sur la touche Alt (Windows) ou Option (Mac OS) et faites glisser le cadre
bleu à l’emplacement où vous souhaitez faire apparaître le point d’ancrage de l’objet.

Sélection et copie d’objets ancrés

L’outil Sélection ne vous permet de sélectionner qu’un objet ancré à la fois. L’outil Texte vous permet de sélectionner une plage de texte avec
plusieurs marqueurs d’objet ancrés. Lorsque vous sélectionnez plusieurs marqueurs d’ancrage avec l’outil Texte, vous pouvez changer
simultanément les options de position de tous les objets ancrés.

si plusieurs objets ancrés se trouvent à la même place (par exemple, si une ligne de texte comporte les marqueurs de deux objets
ancrés avec les mêmes attributs d’ancrage), les objets se chevauchent.
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Lorsque vous copiez du texte comportant un marqueur d’objet ancré, vous copiez également l’objet ancré. Si vous copiez un objet ancré, puis le
collez hors du texte, cet objet ancré devient une image indépendante qui n’est pas liée au texte.

Affichage des marqueurs d’objets ancrés sur la page

Pour afficher les ancrages et leur relation vis-à-vis du texte sur la page, vous pouvez afficher les marqueurs d’objets. Utilisez l’une des méthodes
suivantes :

Pour afficher les marqueurs d’ancrage  dans le texte, choisissez Texte > Afficher les caractères masqués.
Pour afficher une ligne en pointillé reliant un marqueur d’ancrage à son objet positionné selon des options personnalisées,
sélectionnez l’objet et choisissez la commande Affichage > Extras > Afficher le chaînage du texte. Le lien s’étend du marqueur
d’ancrage au point de doublure actuel de l’objet ancré.
Pour afficher les symboles d’ancrage  des objets ancrés, choisissez la commande Affichage > Extras > Afficher les contours
du bloc. L’affichage des symboles d’ancrage vous permet de déterminer les objets ancrés.

Repositionnement manuel d’un objet ancré sur la page

Lorsque vous déplacez un bloc, vous déplacez également ses objets ancrés, sauf si l’objet est positionné par rapport aux marges ou aux pages.

avant de déplacer un objet ancré, vérifiez que l’option Empêcher le repositionnement manuel de l’objet est désélectionnée dans la
boîte de dialogue Objets ancrés ou choisissez Objet > Déverrouiller la position.

Utilisez l’une des méthodes suivantes :

Pour déplacer un objet ancré sur la ligne, sélectionnez l’objet à l’aide de l’outil Sélection  ou Sélection directe , puis
faites-le glisser verticalement. Vous pouvez déplacer des objets sur la ligne de manière verticale, mais pas horizontale.

Pour déplacer un objet sur la ligne ou au-dessus de la ligne de sorte qu’il se trouve en dehors du bloc de texte,
convertissez-le en objet positionné selon des options personnalisées, puis déplacez-le à votre gré.

Pour déplacer un objet texte ancré, utilisez l’outil Sélection ou l’outil Sélection directe pour sélectionner l’objet, puis faites-le
glisser verticalement dans une image horizontale ou horizontalement dans une image verticale. Dans le cas d’un texte
horizontal, vous pouvez déplacer des objets texte verticalement uniquement, et non pas horizontalement. Dans le cas d’un
texte vertical, vous pouvez déplacer des objets texte horizontalement uniquement.
Pour déplacer un objet ancré sur la ligne parallèlement à la ligne de base, placez le point d’insertion avant ou après l’objet
et indiquez une nouvelle valeur de crénage.

Pour déplacer un objet sur la ligne ou au-dessus de la ligne de sorte qu’il se trouve en dehors du bloc de texte,
convertissez-le en objet positionné selon des options personnalisées, puis déplacez-le à votre gré.

Pour déplacer un objet ancré selon des options personnalisées, sélectionnez l’objet à l’aide de l’outil Sélection ou Sélection
directe, puis faites-le glisser verticalement ou horizontalement.

Vous pouvez également faire pivoter et transformer un objet ancré (voirTransformation d’objets et Rotation d’objets).

Redimensionnement d’un objet ancré

Avant de redimensionner un objet ancré, assurez-vous d’avoir désélectionné l’option Empêcher le positionnement manuel dans la boîte de
dialogue Options des objets ancrés insérés.

A l’aide de l’outil Sélection  ou de l’outil Sélection directe , sélectionnez l’objet, puis faites glisser une poignée latérale ou une
poignée d’angle de cet objet.

après le redimensionnement vertical de marqueurs d’ancrage sur la ligne ou au-dessus de la ligne, l’objet peut
être en excès. Si le marqueur d’ancrage est en excès, l’objet peut également se retrouver en excès.

http://idiom-q-win-1/fr/indesign/using/transforming-objects.html#transform_objects
http://idiom-q-win-1/fr/indesign/using/transforming-objects.html#rotate_objects
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Le redimensionnement d’un objet ancré risque d’entraîner le repositionnement de l’objet. Par exemple, si vous avez aligné le côté droit d’un objet
sur le côté gauche du bloc de texte, puis que vous avez fait glisser la poignée latérale droite de l’objet de 1 pica vers la gauche (vous l’éloignez
donc de la limite du bloc de texte), l’objet est redimensionné, puis déplacé à nouveau de 1 pica vers la droite.

Annulation d’ancrage d’un objet

Si vous ne voulez plus lier les déplacements d’un objet à ceux du texte qui lui est associé, vous pouvez le libérer ou supprimer son ancrage.

Sélectionnez l’objet ancré avec un outil de sélection, puis choisissez Objet > Objet ancré > Annuler.

La position de l’objet sur la page ne change pas.

la commande Annuler ne fonctionne pas pour les objets ancrés sur la ligne ou au-dessus de la ligne. Si vous ne
pouvez pas utiliser la commande Annuler, sélectionnez l’objet ancré, puis coupez-le et collez-le. Vous pouvez également
utiliser l’outil Texte pour sélectionner et couper l’objet ancré.

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr
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Introduction aux articles
Création d’un article et ajout d’un contenu
Ajout de tous les éléments de page d’un document à un article
Gestion des articles
Inclusion d’articles pour l’exportation

Introduction aux articles

Les articles permettent aisément de mettre en relation les divers éléments d’une page. Les liens ainsi établis sont pratiques pour définir le contenu
à exporter au format EPUB, HTML ou PDF accessible et pour définir l’ordre du contenu. Vous pouvez créer des articles à partir d’une variété
d’éléments de page déjà présents dans une mise en page, notamment des images, des graphiques ou du texte. Une fois l’article créé, vous
pouvez ajouter des éléments de page, en supprimer ou les réorganiser. Il est possible de créer manuellement des articles en faisant glisser un ou
plusieurs éléments de page vers un article du panneau Articles.

Vous pouvez également ajouter du contenu volumineux à un article. L’ajout de contenu sélectionné à un article sélectionné et l’ajout d’un
document entier à un article sont pris en charge.

le panneau Structure XML permet, par un autre moyen, de choisir l’ordre du contenu à exporter vers des flux de travail d’exportation
ePub, HTML et PDF accessibles. Le panneau Articles se veut plus simple, plus facile d’utilisation et plus accessible, à l’attention des utilisateurs
sans compétences particulières en langage XML. Le panneau Structure XML reste cependant utilisable, parallèlement au panneau Articles
pendant le processus d’exportation Voir Structuration des documents au format XML.

Création d’un article et ajout d’un contenu

1. Choisissez Fenêtre > Articles, pour ouvrir le panneau Articles.

2. Sélectionnez les éléments de page à ajouter à l’article.

Pour créer un article vide, ne sélectionnez aucun élément de page dans la mise en page.

3. Utilisez l’une des méthodes suivantes :

Dans le menu du panneau Articles, choisissez Nouvel article.

Cliquez sur Créer un nouvel article  en bas du panneau Articles.

Faites glisser un article ou un élément de page jusqu’au panneau Articles.

4. Dans la boîte de dialogue Nouvel article, nommez l’article.

5. Sélectionnez Inclure lors de l’exportation, pour ajouter l’article à la sortie d’exportation au format EPUB/HTML.

Ajout de tous les éléments de page d’un document à un article

Pour ajouter tous les éléments de page à un article :

1. Choisissez Fenêtre > Articles, pour ouvrir le panneau Articles.

2. Sélectionnez l’article auquel ajouter les éléments. Si vous ne sélectionnez pas d’article, un nouvel article est créé.

3. Appuyez sur la touche Commande (Mac OS) ou Ctrl (Windows) et cliquez sur le signe  dans le panneau Articles.

4. Si la boîte de dialogue Nouvel article s’affiche, nommez l’article.

http://idiom-q-win-1/fr/indesign/using/structuring-documents-xml.html#structuring_documents_for_xml
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5. Sélectionnez Inclure lors de l’exportation, pour ajouter l’article à l’exportation au format EPUB/HTML.

Si vous avez sélectionné un article, choisissez Ajouter le contenu du document aux articles sélectionnés dans le menu du panneau Articles.

Gestion des articles

Vous pouvez gérer les articles à l’aide du panneau Articles. Vous pouvez faire glisser des éléments de page vers le panneau Articles pour les
ajouter à un article. Vous pouvez également faire glisser des éléments dans le panneau Articles pour les réordonner ou les déplacer d’un article à
un autre.

Le menu contextuel du panneau Articles comporte également des options de gestion de contenu.

Inclusion d’articles pour l’exportation

Vous pouvez créer des articles et sélectionner ceux que vous souhaitez inclure à l’exportation au format EPUB ou HTML. Par défaut, tous les
articles sont sélectionnés en vue de leur exportation.

Pour inclure un article lors de l’exportation, dans le panneau Articles, sélectionnez l’article, puis utilisez l’une des méthodes suivantes :

Cochez la case située en regard de l’article.

Choisissez Options de l’article dans le menu contextuel du panneau Articles, puis sélectionnez Inclure lors de l’exportation.

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr
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Création de listes à puces ou numérotées
Mise en forme d’une liste à puces ou d’une liste numérotée
Modification des puces
Modification des options de liste numérotée
Définition des listes
Création d’un style de paragraphe pour les listes continues
Création de listes multiniveaux
Création de légendes continues de figures et tableaux
Recommencement ou continuation de la numérotation d’une liste
Conversion des puces ou des numéros d’une liste en texte

Création de listes à puces ou numérotées
Dans une liste à puces, chaque paragraphe commence par une puce. Dans une liste numérotée, chaque paragraphe commence par une
expression constituée d’un numéro ou d’une lettre et d’un séparateur tel qu’un point ou une parenthèse. La numérotation est automatiquement
mise à jour dans une liste numérotée dès que vous ajoutez ou supprimez des paragraphes. Vous pouvez changer de type de puce, de style de
numéro ou de séparateur, ou modifier les attributs de la police, le style de caractère et le type et la longueur du retrait.

Vous ne pouvez pas utiliser l’outil Texte pour sélectionner les puces ou les numéros d’une liste. Vous pouvez en revanche modifier leur mise en
forme et la longueur du retrait dans la boîte de dialogue Puces et numérotation, dans le panneau Paragraphe ou, s’ils font partie d’un style, dans
la section Puces et numérotation de la boîte de dialogue Styles de paragraphe.

Liste à puces et liste numérotée

Le moyen le plus simple de créer une liste à puces ou numérotée consiste à saisir le texte composant la liste, à le sélectionner, puis à cliquer sur
les boutons Liste à puces ou Liste numérotée du panneau Contrôle. Ces boutons permettent d’activer et de désactiver l’option de liste ou de
transformer une liste à puces en liste numérotée et inversement. Vous pouvez aussi inclure des attributs de puces et de numéros dans un style de
paragraphe et générer une liste en attribuant un style à des paragraphes.

Remarque : les caractères de puce et de numéro automatiquement générés ne sont pas réellement insérés dans le texte. Par conséquent, ils ne
peuvent pas faire l’objet d’une recherche avec la fonction de recherche de texte et ne peuvent pas non plus être sélectionnés à l’aide de l’outil
Texte s’ils n’ont pas été préalablement convertis en texte. Les puces et numéros n’apparaissent pas non plus dans la fenêtre du mode éditeur
(sauf dans la colonne des styles de paragraphe).
Pour consulter un didacticiel vidéo sur la création de listes à puces et numérotées, rendez-vous à l’adresse www.adobe.com/go/vid0077.

InDesign Docs présente une série d’articles sur l’utilisation des puces et de la numérotation pour créer des listes sommaires, des listes à plusieurs
niveaux, des légendes de figures et des procédures numérotées.

1. Sélectionnez les paragraphes composant la liste ou cliquez à l’endroit où vous voulez faire commencer la liste pour créer un
point d’insertion.

2. Utilisez l’une des méthodes suivantes :

http://www.adobe.com/go/vid0077
http://blogs.adobe.com/indesigndocs/2009/04/numbered_lists_part_i_outlines.html
http://blogs.adobe.com/indesigndocs/2009/04/numbered_lists_part_ii_multile.html
http://blogs.adobe.com/indesigndocs/2009/04/numbered_lists_part_ii_multile.html
http://blogs.adobe.com/indesigndocs/2009/04/numbered_lists_part_iii_figure.html
http://blogs.adobe.com/indesigndocs/2009/04/numbered_lists_part_iv_numbere.html
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Cliquez sur le bouton Liste à puces  ou Liste numérotée  du panneau Contrôle (en mode Paragraphe). Tout en
maintenant la touche Alt (Windows) ou Option (Mac OS) enfoncée, cliquez sur un bouton pour afficher la boîte de
dialogue Puces et numérotation.

Choisissez la commande Puces et numérotation dans le panneau Paragraphe ou dans le panneau Commande. Pour
l’option Type de liste, choisissez Puces ou Numéros. Spécifiez les paramètres souhaités, puis cliquez sur OK.

Appliquez un style de paragraphe qui comprend des puces ou des numéros.

3. Pour continuer la liste au paragraphe suivant, déplacez le point d’insertion à la fin de la liste et appuyez sur Entrée ou Retour.
4. Pour terminer la liste (ou une section de la liste, si la liste doit se poursuivre plus loin dans l’article), cliquez de nouveau sur le

bouton Liste à puces ou Liste numérotée dans le panneau Contrôle ou choisissez la commande Puces et numérotation dans
le menu du panneau Paragraphe.

Mise en forme d’une liste à puces ou d’une liste numérotée
1. A l’aide de l’outil Texte , sélectionnez les paragraphes de la liste dont vous souhaitez modifier la mise en forme.
2. Utilisez l’une des méthodes suivantes pour ouvrir la boîte de dialogue Puces et numérotation :

Choisissez la commande Puces et numérotation dans le menu du panneau Contrôle (en mode Paragraphe) ou dans le
menu du panneau Paragraphe.

Maintenez la touche Alt (Windows) ou Option (Mac OS) enfoncée tout en cliquant sur le bouton Liste à puces  ou Liste

numérotée .

3. Dans la boîte de dialogue Puces et numérotation, utilisez l’une des méthodes suivantes :

Modifiez la puce.

Modifiez les options de liste numérotée.

Sélectionnez le style que vous souhaitez appliquer aux numéros ou aux puces dans la liste Style de caractère.

4. Pour modifier la position de la puce ou du numéro, spécifiez l’une des options suivantes :
Alignement Permet d’aligner à gauche ou à droite, ou de centrer les puces ou les numéros dans l’espace qui leur est alloué
sur l’axe horizontal. Lorsque cet espace est étroit, les trois options donnent des résultats sensiblement identiques.

Retrait à gauche Définit la longueur du retrait du paragraphe à partir de la deuxième ligne.

Retrait de 1re ligne Définit l’emplacement de la puce ou du numéro.

Augmentez la valeur Retrait de 1re ligne si vous souhaitez que la ponctuation des listes longues soit alignée. Par exemple,
pour aligner les chiffres « 9. » et « 10. » par rapport au point, définissez l’alignement à droite et augmentez progressivement
le retrait de la première ligne jusqu’à ce que les chiffres soient alignés (veillez à activer la fonction d’aperçu).

Pour créer un retrait négatif, indiquez une valeur de retrait à gauche positive (2p0, par exemple), puis spécifiez une valeur
identique négative (en l’occurrence -2p0) pour le retrait de première ligne.

Paramètres de position
A.  Retrait négatif B.  Liste alignée à gauche

Remarque : les paramètres Retrait à gauche, Retrait de 1re ligne et Position de la tabulation de la boîte de dialogue Puces et
numérotation sont des attributs de paragraphe. Par conséquent, si vous les modifiez dans le panneau Paragraphe, vos
modifications se répercuteront sur la mise en forme des listes à puces et numérotées.

Position de la tabulation Insère une tabulation pour créer une espace entre la puce ou le numéro et le début de l’élément de
liste.

Par défaut, les puces et les numéros héritent de certains des paramètres de mise en forme appliqués au premier caractère du paragraphe auquel
ils sont associés. Si le premier caractère d’un paragraphe est différent des caractères commençant les autres paragraphes, le numéro ou la puce
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aura un aspect probablement discordant par rapport aux autres éléments de la liste. Si ces paramètres de mise en forme ne vous conviennent
pas, créez un style de caractère pour les puces et les numéros et appliquez-le à votre liste à l’aide de la boîte de dialogue Puces et numérotation.

Le premier mot en italique de l’étape 3 fait que le numéro est lui aussi en italique, ce que vous pouvez éviter en créant un style de caractère pour
les numéros et en l’appliquant la liste.

Modification des puces
Si vous ne souhaitez pas utiliser l’une des puces existantes, vous pouvez ajouter de nouvelles puces dans la grille Puce. Une puce disponible
dans une police donnée n’est pas forcément disponible dans une autre police. Vous pouvez choisir de mémoriser la police associée à une puce
que vous ajoutez.

Si vous souhaitez utiliser une puce issue d’une police particulière (comme la main pointant vers une direction de Dingbats), pensez à mémoriser la
police associée à cette puce. Si vous utilisez une puce standard, il n’est pas nécessaire de mémoriser sa police puisque la plupart des polices
auront leur propre version de cette puce. Selon que vous avez sélectionné ou non l’option Mémoriser la police avec cette puce, la puce à ajouter
peut faire référence à une valeur Unicode, une famille et un style de police spécifiques ou bien à une valeur Unicode uniquement.

Remarque : les puces qui font uniquement référence à une valeur Unicode (sans police mémorisée) s’affichent avec l’indicateur « u ».

Boîte de dialogue Puces et numérotation
A.  Puce sans police mémorisée B.  Puce avec police mémorisée

Pour modifier la puce
1. Dans le menu du panneau Contrôle ou du panneau Paragraphe, sélectionnez Puces et numérotation.
2. Dans la boîte de dialogue Puces et numérotation, choisissez la commande Puces dans le menu Type de liste.
3. Sélectionnez une autre puce, puis cliquez sur OK.

Pour ajouter une puce
1. Dans la boîte de dialogue Puces et numérotation, choisissez la commande Puces dans le menu Type de liste, puis cliquez sur

Ajouter.
2. Sélectionnez le glyphe à utiliser comme puce. Plusieurs familles et styles de polices contiennent différents glyphes.
3. Pour que la nouvelle puce mémorise la police et le style actifs, sélectionnez l’option Mémoriser la police avec cette puce.
4. Cliquez sur Ajouter.

Remarque : la liste des puces est enregistrée dans le document, comme le sont les styles de paragraphe et de caractère. Lorsque vous collez ou
chargez des styles de paragraphe d’un autre document, les puces utilisées dans ces styles sont visibles dans la boîte de dialogue Puces et
numérotation avec les autres puces du document.
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Pour supprimer une puce
1. Dans la boîte de dialogue Puces et numérotation, choisissez la commande Puces dans le menu Type de liste.
2. Sélectionnez la puce à supprimer, puis cliquez sur Supprimer. La première puce prédéfinie ne peut pas être supprimée.

Modification des options de liste numérotée
Dans une liste numérotée, la numérotation est automatiquement mise à jour dès que vous ajoutez ou supprimez des paragraphes. Les
paragraphes qui font partie de la même liste sont numérotés de façon séquentielle. Il n’est pas nécessaire que ces paragraphes se suivent si vous
avez défini une liste pour les paragraphes

Vous pouvez également créer une liste multiniveau dont les éléments sont numérotés de façon hiérarchique et mis en retrait sur plusieurs niveaux.

1. Ouvrez la boîte de dialogue Puces et numérotation.
2. Sous Style de numérotation, sélectionnez le type de numérotation à utiliser dans le menu Format.
3. Dans la zone Numéro, utilisez l’expression par défaut (le point (.) et la tabulation (^t)) ou générez votre propre expression

numérique. Pour entrer une expression numérique, supprimez le point situé à la suite du métacaractère de numérotation (^#),
puis utilisez l’une des méthode suivantes :

Entrez un ou plusieurs caractères (par exemple une parenthèse fermante) à la place du point.

Choisissez un élément (tel que Tiret cadratin ou Points de suspension) dans le menu Insérer un caractère spécial.

Saisissez un mot ou un caractère avant le métacaractère de numérotation. Par exemple, pour numéroter les questions
dans une liste, vous pouvez entrer le mot Question.

4. Choisissez un style de caractère pour l’expression (le style sélectionné s’appliquera à l’ensemble de l’expression numérique,
et pas seulement au numéro ou à la puce).

5. Dans Mode, sélectionnez l’une des options suivantes :
Suite du numéro précédent Numérote la liste de façon séquentielle.

Début Fait commencer la numérotation à partir de la valeur (numéro ou autre) entrée dans la zone de texte. Entrez un
numéro, et non pas une lettre, même si votre liste est numérotée au moyen de lettres ou de chiffres romains.

6. Définissez d’autres options, si nécessaire, puis cliquez sur OK.

Définition des listes
Une liste définie peut être interrompue par d’autres paragraphes et listes ; elle peut également s’étendre sur plusieurs articles ou plusieurs
documents d’un livre. Par exemple, utilisez les listes définies pour créer une vectorisation multiniveau ou pour créer une liste continue de noms de
tableaux numérotés dans le document. Vous pouvez également définir des listes pour les éléments numérotés ou à puces individuels qui sont
mélangés. Par exemple, si le document contient une liste de questions et de réponses, vous pouvez définir une liste pour numéroter les questions
et une autre pour numéroter les réponses.

Les listes définies permettent souvent de conserver un lien entre les paragraphes de façon à les numéroter. Si vous avez créé un style de
paragraphe pour la numérotation, vous pouvez appliquer ce style à une liste définie : les paragraphes seront numérotés sur la base de ce style en
fonction de leur emplacement dans la liste définie. Par exemple, le premier paragraphe se verra attribuer le numéro 1 (« Tableau 1 ») et le
paragraphe suivant le numéro 2 (« Tableau 2 ») même s’ils sont séparés de plusieurs pages. Comme les deux paragraphes font partie de la
même liste définie, ils seront numérotés de façon séquentielle, quelle que soit la distance qui les sépare au sein du document ou du livre.

Définissez une nouvelle liste pour chaque type d’élément à numéroter : étapes d’une procédure, tableaux et figures par exemple. Lorsque vous
définissez plusieurs listes, vous pouvez interrompre une liste par une autre et conserver la séquence de numérotation de chaque liste.

Si des éléments de liste apparaissent dans des blocs de texte sans lien sur une même page, ils sont numérotés dans l’ordre selon lequel les
blocs de texte sont ajoutés à la page. Pour les réorganiser, coupez-les et collez-les un à un dans l’ordre voulu.
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Les listes définies vous permettent d’interrompre une liste par une autre.

Pour consulter un didacticiel vidéo sur la création de listes à puces et numérotées, rendez-vous à l’adresse www.adobe.com/go/vid0077.

Pour définir une liste
1. Choisissez la commande Texte > Listes à puces et numérotées > Définir des listes.
2. Cliquez sur Nouveau dans la boîte de dialogue Définir des listes.
3. Attribuez un nom à la liste et indiquez si la numérotation doit se poursuivre d’un article à l’autre et si elle doit continuer à la

suite des documents précédents du livre.
4. Cliquez deux fois sur OK.

Après avoir défini une liste, vous pouvez l’utiliser dans un style de paragraphe, par exemple dans un style pour tableaux, pour figures ou pour
listes numérotées, et vous pouvez l’appliquer par l’intermédiaire des panneaux Contrôle et Paragraphe

Remarque : certaines listes sont automatiquement définies. Par exemple, lorsque vous importez une liste numérotée à partir d’un document
Microsoft Word, une liste est automatiquement définie pour ce document.

Pour modifier une liste définie
1. Choisissez la commande Texte > Listes à puces et numérotées > Définir des listes.
2. Sélectionnez une liste et cliquez sur le bouton Modifier.
3. Modifiez le nom de la liste ou redéfinissez les options Continuer la numérotation.

Les styles de paragraphe associés à l’ancienne liste sont réaffectés à la liste renommée.

Pour supprimer une liste définie
1. Choisissez la commande Texte > Listes à puces et numérotées > Définir des listes.
2. Sélectionnez une liste.
3. Cliquez sur le bouton Supprimer et indiquez par quelle liste (liste par défaut ou autre liste) la liste supprimée doit être

remplacée.

http://www.adobe.com/go/vid0077
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Création d’un style de paragraphe pour les listes continues
Pour créer une liste continue (liste entrecoupée d’autres paragraphes ou qui s’étend sur plusieurs articles ou documents), générez un style de
paragraphe et appliquez-le aux paragraphes que vous souhaitez intégrer à la liste. Si, par exemple, vous souhaitez créer une liste continue des
tableaux de votre document, créez un style de paragraphe nommé Tableaux, ajoutez une liste définie au style, puis appliquez le style de
paragraphe Tableaux à tous les paragraphes qui doivent apparaître dans votre liste Tableaux.

Vous trouverez sur InDesign Docs une série d’articles sur l’utilisation des puces et de la numérotation pour créer des légendes de figures et des
procédures numérotées.

1. Choisissez la commande Nouveau style de paragraphe dans le menu du panneau Styles de paragraphe.
2. Attribuez un nom au style.
3. Sur le côté gauche de la boîte de dialogue Nouveau style de paragraphe, cliquez sur Puces et numérotation.
4. Pour l’option Type de liste, sélectionnez Puces ou Numéros.
5. Si vous créez un style pour listes numérotées, sélectionnez une liste définie dans le menu Liste, ou choisissez la

commande Nouvelle liste et définissez la liste.
6. Spécifiez les caractéristiques de la puce ou des numéros.
7. Utilisez les options de la section Position de la puce ou de la numérotation de la boîte de dialogue Nouveau style de

paragraphe pour modifier le retrait. Par exemple, pour créer un retrait négatif, entrez 2p pour l’option Retrait à gauche et -2p
pour l’option Retrait de 1re ligne.

8. Spécifiez d’autres attributs de style de paragraphe, puis cliquez sur OK.

Création de listes multiniveaux
Une liste multiniveau est une liste qui définit les liens hiérarchiques entre les paragraphes de la liste. Les listes de ce type sont également
appelées listes hiérarchiques car elles s’apparentent à une structure hiérarchique. Le modèle de numérotation d’une liste, tout comme la longueur
des retraits, permettent de connaître le niveau hiérarchique d’un élément et de savoir comment celui-ci se positionne par rapport aux autres. Vous
pouvez facilement déterminer à quel niveau se situe un paragraphe dans la liste par rapport au paragraphe qui le suit et à celui qui le précède.
Vous pouvez inclure jusqu’à neuf niveaux dans une liste multiniveau.

Liste multiniveau dont les niveaux hiérarchiques sont définis au moyen de numéros et de lettres

Pour créer une liste multiniveau, définissez la liste et créez un style de paragraphe pour chaque niveau souhaité. Par exemple, une liste
comportant quatre niveaux requiert quatre styles de paragraphe (ayant chacun la même liste définie). Vous devez définir des paramètres de mise
en forme des numéros et des paragraphes pour chacun des styles créés.

Gabriel Powell propose un didacticiel vidéo, Creating an automatic numbered list, portant sur la création de listes sommaires et à plusieurs
niveaux.

Bob Bringhurst propose une série d’articles sur l’utilisation des puces et de la numérotation pour créer des listes sommaires, des listes à plusieurs
niveaux, des légendes de figures et des procédures numérotées.

1. Choisissez la commande Nouveau style de paragraphe dans le menu du panneau Styles de paragraphe.
2. Attribuez un nom au style.
3. Si vous avez déjà créé un style pour votre liste multiniveau, choisissez le style que vous allez associer aux niveaux situés au-

dessus du niveau actif dans le menu D’après ; sinon, choisissez la commande Aucun style de paragraphe ou Paragraphe
standard.

4. Sur le côté gauche de la boîte de dialogue Nouveau style de paragraphe, cliquez sur Puces et numérotation.

http://blogs.adobe.com/indesigndocs/2009/04/numbered_lists_part_iii_figure.html
http://blogs.adobe.com/indesigndocs/2009/04/numbered_lists_part_iv_numbere.html
http://www.instantindesign.com/index.php?view=391
http://blogs.adobe.com/indesigndocs/2009/04/numbered_lists_part_i_outlines.html
http://blogs.adobe.com/indesigndocs/2009/04/numbered_lists_part_ii_multile.html
http://blogs.adobe.com/indesigndocs/2009/04/numbered_lists_part_ii_multile.html
http://blogs.adobe.com/indesigndocs/2009/04/numbered_lists_part_iii_figure.html
http://blogs.adobe.com/indesigndocs/2009/04/numbered_lists_part_iv_numbere.html
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5. Choisissez la commande Numéros dans le menu Type de liste.
6. Choisissez l’une des listes définies dans le menu Liste. Si vous n’avez pas encore défini votre liste, choisissez Nouvelle liste

dans le menu et définissez-la.
7. Dans le champ Niveau, entrez le numéro correspondant au niveau de la liste multiniveau auquel se destine le style en cours

de création.
8. Dans le menu Format, choisissez le type de numérotation à utiliser.
9. Dans le champ Numéro, indiquez sous quelle forme les éléments de la liste doivent être numérotés à ce niveau. Pour ce faire,

entrez des métacaractères ou sélectionnez des métacaractères dans les menus.

Pour insérer des préfixes de numérotation de niveaux supérieurs, entrez le texte de votre choix ou cliquez au début de la
zone Numéro, puis choisissez la commande Insérer une balise d’emplacement de numéro et sélectionnez une option
Niveau (par exemple Niveau 1), ou bien entrez le caractère ^ suivi du niveau (par exemple ^1). Supposons que vous ayez
défini une liste dont les éléments de premier niveau sont numérotés 1, 2, 3, etc., et les éléments de deuxième
niveau a, b, c, etc. Si vous insérez le préfixe du premier niveau dans le modèle de numérotation du deuxième niveau, les
éléments de deuxième niveau seront numérotés de la façon suivante : 1a, 1b, 1c ; 2a, 2b, 2c ; 3a, 3b, 3c.

Pour créer une expression numérique, entrez les signes de ponctuation et les métacaractères nécessaires, ou bien
sélectionnez des options dans la liste Insérer un caractère spécial.

10. Sélectionnez l’option Recommencer la numérotation à ce niveau après si vous souhaitez que la numérotation recommence
à 1 lorsqu’un paragraphe de ce niveau succède à un paragraphe de niveau supérieur ; désélectionnez cette option si vous
souhaitez que les paragraphes de ce niveau soient numérotés de façon séquentielle sur l’ensemble de la liste, quelle soit leur
emplacement dans la hiérarchie.

Pour recommencer la numérotation après un certain niveau ou une certaine plage de niveaux, saisissez le numéro ou la plage
du niveau (2-4, par exemple) dans le champ Recommencer la numérotation à ce niveau après.

11. Dans la zone Position de la puce ou de la numérotation, définissez les options de retrait ou de tabulation de telle sorte que les
éléments de ce niveau soit plus en retrait que ceux des niveaux supérieurs. La mise en retrait permet de faire ressortir les
éléments de niveau inférieur dans la liste.

12. Cliquez sur le bouton OK.

Dans certains cas, comme dans celui des procédures numérotées, il peut être nécessaire de recommencer la numérotation depuis le début au
sein d’un même article. Pour éviter d’avoir à effectuer cette opération manuellement, créez un style distinct identique au style du niveau 1 à une
exception près. Dans la section Mode, sélectionnez l’option Début, puis indiquez la valeur 1. Nommez ce style « Niveau 1 avec renumérotation »,
par exemple.

Création de légendes continues de figures et tableaux
Les légendes continues permettent de numéroter les figures, les tableaux et d’autres types d’éléments de façon séquentielle dans un document.
Par exemple, la légende de la première figure peut commencer par les mots « Figure 1 », celle de la deuxième par les mots « Figure 2 », etc.
Pour vous assurer que les figures, les tableaux et autres éléments semblables seront numérotés de façon séquentielle, définissez une liste pour
l’élément, puis créez un style de paragraphe incluant cette définition de liste. Vous pouvez également ajouter des mots descriptifs, par exemple
« figure » ou « tableau », au modèle de numérotation du style de paragraphe.

Bob Bringhurst propose un article sur la création de légendes de figures sous le titre Numbered Lists Part III - Figure Captions.

Les éléments d’une liste sont numérotés en respectant l’ordre dans lequel ils sont ajoutés à la page. Pour les réorganiser, coupez-les et collez-
les un à un dans l’ordre voulu.

1. Créez un nouveau style de paragraphe et, dans la section Puces et numérotation de la boîte de dialogue Options de style de
paragraphe, choisissez l’option Numéros dans le menu Type de liste.

2. Sélectionnez une liste définie dans le menu Liste ou choisissez la commande Nouvelle liste pour en définir une.
3. Sous Style de numérotation, sélectionnez le type de numérotation à utiliser dans le menu Format.

Par exemple, sélectionnez l’option A, B, C, D... pour créer une liste de type « Figure A », « Figure B », etc.

4. Dans la zone Numéro, entrez un terme descriptif, ainsi que les espaces et les signes de ponctuation nécessaires, en
complément des métacaractères de numérotation.

Par exemple, pour créer un effet « Figure A », entrez le mot « Figure » et une espace avant les métacaractères (tel que
Figure ^#.^t). Cette action ajoute le mot « Figure » suivi d’un numéro séquentiel (^#), d’un point et d’une tabulation (^t).

Remarque : pour inclure les numéros de chapitre dans les légendes continues, choisissez la commande Insérer une balise
d’emplacement de numéro >Numéro de chapitre dans la liste Numéro ou entrez ^H là où le numéro de chapitre doit apparaître
dans le modèle de numérotation.

5. Finalisez le style et cliquez sur le bouton OK.

Une fois le style créé, appliquez-le aux légendes de figures ou aux titres de tableaux.

Vous pouvez utiliser la fonction Table des matières pour générer la liste des tableaux ou des figures.

http://blogs.adobe.com/indesigndocs/2009/04/numbered_lists_part_iii_figure.html
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Recommencement ou continuation de la numérotation d’une liste
InDesign offre des commandes permettant de recommencer ou de continuer la numérotation d’une liste :

Pour recommencer la numérotation d’une liste Placez le point d’insertion dans le paragraphe et choisissez la commande Recommencer la
numérotation dans le menu contextuel ou choisissez la commande Texte > Listes à puces et numérotées > Recommencer la numérotation. Dans
le cas d’une liste normale, cette commande attribue le numéro 1 (ou la lettre A) à un paragraphe et définit celui-ci comme premier paragraphe de
la liste. Dans le cas d’une liste multiniveau, cette commande attribue le premier numéro du niveau inférieur à un paragraphe imbriqué.
Pour continuer la numérotation d’une liste Choisissez la commande Continuer la numérotation dans le menu contextuel ou choisissez la
commande Texte > Listes à puces et numérotées > Continuer la numérotation. Cette commande reprend la numérotation d’une liste ayant été
interrompue par un commentaire, un graphique ou un élément de liste imbriqué. InDesign offre également des commandes permettant de
numéroter les listes qui commencent dans un article ou un livre et qui se poursuivent dans l’article ou le livre suivant.

Pour numéroter une liste d’un article précédent ou en cours
Suivant les paramètres de configuration de la liste, la numérotation continue à la suite de l’article précédent ou recommence dans l’article actif.

1. Choisissez la commande Texte > Listes à puces et numérotées > Définir des listes.
2. Sélectionnez une liste et cliquez sur le bouton Modifier.

Ne sélectionnez pas la liste par défaut : cette liste ne peut pas s’étendre sur plusieurs articles.

3. Sélectionnez l’option Continuer la numérotation au fil des articles pour continuer la numérotation de la liste à la suite de
l’article précédent ou désélectionnez cette option pour recommencer la numérotation à 1 (ou A) dans l’article actif.

4. Cliquez deux fois sur OK.

Pour numéroter une liste d’un document précédent ou en cours dans un livre
Suivant les paramètres de configuration de la liste, la numérotation continue à la suite du document précédent du livre ou recommence dans le
document actif.

1. Choisissez la commande Texte > Listes à puces et numérotées > Définir des listes.
2. Sélectionnez une liste et cliquez sur le bouton Modifier.
3. Sélectionnez l’option Continuer la numérotation du document précédent du livre pour continuer la numérotation de la liste à la

suite du document précédent (vous devez choisir Continuer la numérotation au fil des articles pour activer cette option) ou
désélectionnez cette option pour recommencer la numérotation à 1 (ou A) dans le document actif.

4. Cliquez deux fois sur OK.

Pour vous assurer que la numérotation est correctement mise à jour dans un livre, synchronisez les documents du livre, puis choisissez la
commande Mettre à jour la numérotation > Mettre à jour tous les numéros, dans le menu du panneau de livres.

Conversion des puces ou des numéros d’une liste en texte
1. Sélectionnez le paragraphe contenant la liste à puces ou numérotée.
2. Utilisez l’une des méthodes suivantes :

Choisissez la commande Convertir Numérotation en texte ou Convertir puces en texte dans le menu du
panneau Paragraphe.

Cliquez sur la sélection avec le bouton droit de la souris (Windows) ou en maintenant la touche Commande enfoncée
(Mac OS), puis choisissez Convertir Numérotation en texte ou Convertir puces en texte.

Remarque : pour supprimer les numéros ou les puces de la liste, cliquez sur le bouton Liste numérotée ou Liste à puces pour
annuler l’application de la mise en forme de la liste au texte sélectionné.

Voir aussi
Vidéo Listes à puces et numérotées

Informations juridiques   |   Politique de confidentialité en ligne

http://www.adobe.com/go/vid0077
http://creativecommons.org/licenses/by-nc-sa/3.0/
http://helpx.adobe.com/fr/legal/legal-notices.html
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Présentation de la fonction de recherche et remplacement
Recherche et modification de texte
Recherche à l’aide d’expressions GREP
Métacaractères de recherche
Recherche et remplacement d’objets
Recherche et remplacement de glyphes
Recherche et modification de polices
Recherche et remplacement d’éléments à l’aide de requêtes

Présentation de la fonction de recherche et remplacement

La boîte de dialogue Rechercher/Remplacer contient des onglets qui vous permettent de spécifier ce que vous voulez rechercher et modifier.

Boîte de dialogue Rechercher/Remplacer

A. Onglets de recherche/remplacement B. Rechercher une tabulation C. Remplacer par un tiret cadratin D. Options de recherche E. Menu de
métacaractères F. Recherche en avant et en arrière 

Vous pouvez rechercher et modifier des occurrences précises de caractères, de mots, de groupes de mots ou de texte mis en forme. Vous
pouvez également rechercher et remplacer des caractères spéciaux tels que des symboles, des marques et des espaces. Les options de
caractères génériques vous aident à élargir votre recherche.

Utilisez des techniques de recherche avancées basées sur des motifs pour rechercher et remplacer du texte et des mises en forme.

Recherchez et remplacez des glyphes à l’aide des valeurs Unicode ou GID/CID, qui sont particulièrement pratiques pour les langues
asiatiques.

Recherchez et remplacez les effets et les attributs de mise en forme dans les objets et les blocs. Par exemple, vous pouvez rechercher des
objets avec un contour de 4 points et remplacer celui-ci par une ombre portée.

Recherche et modification de texte



Si vous voulez classer, rechercher et remplacer des polices dans votre document, vous pouvez utiliser la commande Rechercher une police au
lieu de la commande Rechercher/Remplacer.

Recherche et modification de texte

1. Pour rechercher une portion de texte ou un article, sélectionnez le texte ou placez le point d’insertion dans l’article. Pour
effectuer la recherche dans plusieurs documents, ouvrez les documents.

2. Choisissez Edition > Rechercher/Remplacer, puis cliquez sur l’onglet Texte.

3. Spécifiez l’étendue de votre recherche dans le menu Chercher dans, puis cliquez sur les icônes pour inclure les calques
verrouillés, les gabarits, les pieds de page et autres éléments dans la recherche.

4. Dans le champ Rechercher, décrivez l’objet de votre recherche :

Saisissez ou collez le texte que vous recherchez.

Pour rechercher ou remplacer les tabulations, les espaces ou autres caractères spéciaux, sélectionnez un caractère
représentatif (métacaractère) dans le menu déroulant à droite du champ Rechercher. Vous pouvez également choisir les
options de caractères génériques, tels que Chiffre quelconque ou Caractère quelconque.

Utilisez les métacaractères pour rechercher des caractères spéciaux (tabulations par exemple).

Utilisez une requête prédéfinie pour rechercher et remplacer du texte (Voir Recherche/remplacement d’éléments à l’aide
de requêtes.)

5. Dans la zone Remplacer par, entrez ou collez le texte de remplacement. Vous pouvez également sélectionner un caractère
représentatif dans le menu déroulant à droite du champ Remplacer par.

6. Cliquez sur Rechercher.

7. Pour poursuivre la recherche, cliquez sur Suivant, Remplacer (pour modifier l’occurrence courante), Tout remplacer (un
message indique le nombre total de remplacements) ou Remplacer/Rechercher (pour modifier l’occurrence courante et
rechercher la suivante).

8. La boîte de dialogue Rechercher/Remplacer d’InDesign comporte deux boutons de direction de recherche : un en avant et un
en arrière. Comme la recherche en avant est activée par défaut, vous pouvez basculer sur la recherche en arrière pour
inverser le flux de recherche. Cette nouvelle fonctionnalité permet de rechercher des chaînes dans les onglets Texte, GREP et
Glyphe.

9. Cliquez sur Terminer.

Si vous n’obtenez pas les résultats escomptés pour votre recherche, vérifiez que vous avez bien effacé toute mise en forme éventuellement
spécifiée dans une recherche précédente. Il est également conseillé d’étendre votre recherche. Par exemple, il se peut que vous recherchiez
uniquement dans une portion de texte ou un article plutôt que tout le document. Vous pouvez également rechercher du texte qui apparaît sur un
élément, comme un calque verrouillé, une note de bas de page ou du texte conditionnel masqué, actuellement exclus de la recherche.

http://chl-author.corp.adobe.com/content/help/fr/indesign/using/find-change.html#find_change_items_using_queries
http://chl-author.corp.adobe.com/content/help/fr/indesign/using/find-change.html#find_change_items_using_queries


Remarque :

Recherche par caractères génériques

Presse-papiers pour les recherches de métacaractères

Remplacement par le contenu du Presse-papiers

Recherche et suppression de texte indésirable

Balisage XML

Si vous changez d’avis à propos du remplacement de texte, sélectionnez Edition > Annuler Remplacer le texte (ou Annuler Remplacer tout le
texte).

Pour rechercher l’occurrence suivante d’une expression préalablement recherchée sans ouvrir la boîte de dialogue Rechercher/Remplacer,
sélectionnez Edition > Suivant. En outre, les chaînes de texte précédemment recherchées sont enregistrées dans la boîte de dialogue
Rechercher/Remplacer. Vous pouvez rechercher une chaîne de texte dans le menu à droite de l’option.

Recherche et remplacement de texte mis en forme

1. Choisissez Edition > Rechercher/Remplacer.

2. Cliquez sur Plus d’options afin d’afficher des options supplémentaires pour rechercher et modifier le format. Vice-versa, vous
pouvez cliquer sur Moins d’options pour afficher moins d’options.

3. Cliquez sur la zone Rechercher le format ou cliquez sur l’icône Spécifier les attributs à rechercher à droite de la section
Rechercher le format.

4. Dans la zone de gauche de la boîte de dialogue Rechercher un format, sélectionnez un type de mise en forme, puis spécifiez
les attributs de mise en forme et cliquez sur OK.

Certaines options de mise en forme OpenType s’affichent sous Options OpenType et sous Formats de caractères de base
(menu Position). Pour plus de détails sur OpenType et les autres attributs de mise en forme, recherchez les rubriques
connexes dans l’aide d’InDesign.

Pour ne rechercher (ou remplacer) que des éléments de mise en forme, laissez les zones Rechercher
ou Remplacer par vides.

5. Si vous souhaitez appliquer une mise en forme au texte trouvé, cliquez sur la zone Remplacer le format ou cliquez sur l’icône
Spécifier les attributs à rechercher  dans la section Remplacer le format. Sélectionnez ensuite un type de mise en forme,
spécifiez les attributs et cliquez sur OK.

6. Utilisez les boutons de recherche et de remplacement pour modifier le texte mis en forme.

Si vous spécifiez une mise en forme pour vos critères de recherche, des icônes d’informations apparaissent au-dessus des zones Rechercher et
Remplacer par. Elles vous signalent que des attributs de mise en forme ont été définis et que l’opération de recherche ou de remplacement sera
restreinte en conséquence.

Pour supprimer rapidement tous les attributs de mise en forme dans les zones Rechercher le format ou Remplacer le format, cliquez sur le
bouton Effacer dans la section appropriée.

Méthodes courantes pour rechercher et remplacer du texte

Spécifiez les caractères génériques, tels que Chiffre quelconque ou Espace quelconque, pour élargir
votre recherche. Par exemple, si vous entrez « b^?lle » dans la zone Rechercher, les mots « bulle », « balle », « belle » et « bille » seront
recherchés. Vous pouvez saisir les caractères génériques ou choisir une option dans le sous-menu Caractères génériques du menu déroulant
situé en regard du champ Rechercher.

Pour rechercher des métacaractères (tiret cadratin ou puce, par exemple), vous
pouvez sélectionner d’abord le texte, puis le coller dans la zone Rechercher ; cela vous évite de saisir les métacaractères. InDesign convertit
automatiquement les caractères spéciaux collés en métacaractères équivalents.

Vous pouvez remplacer les éléments de recherche par le contenu, mis en forme ou non,
copié dans le Presse-papiers. Vous pouvez également remplacer le texte par un graphique que vous avez copié. Copiez simplement l’élément,
puis, dans la boîte de dialogue Rechercher/Remplacer, choisissez une option dans le sous-menu Autre du menu déroulant situé à droite de la
zone Remplacer par.

Pour supprimer du texte indésirable, définissez le texte à supprimer dans la zone Rechercher,
puis laissez la zone Remplacer par vide (assurez-vous qu’aucune mise en forme n’est définie dans cette zone).

Vous pouvez appliquer des balises XML au texte que vous recherchez.



Recherche en avant ou en arrière

Menu Chercher dans

Inclure les calques verrouillés 

Inclure les articles verrouillés 

Inclure les calques masqués 

Inclure les gabarits 

Inclure les notes de bas de page 

Respect de la casse 

Mot entier 
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Vous pouvez effectuer une recherche vers l’avant ou vers l’arrière. Cela vous permet de rechercher du texte
au cas où vous l’auriez sauté en le recherchant. Ainsi, rechercher en avant et en arrière facilite la recherche du texte en évitant le lancement d’une
nouvelle recherche.

Options de recherche pour rechercher et remplacer du texte

Contient les options déterminant la portée de la recherche.
Documents
Sélectionnez Document si vous souhaitez effectuer la recherche sur tout le document, ou Tous les documents si vous souhaitez étendre la
recherche à tous les documents ouverts.
Article
Sélectionnez Article pour effectuer une recherche sur tout le texte du bloc sélectionné et sur le texte des blocs de texte liés et le texte en
excès. Sélectionnez Articles pour effectuer la recherche sur les articles de tous les blocs sélectionnés. Cette option apparaît uniquement si
un bloc de texte est sélectionné ou si un point d’insertion est placé.
Jusqu’à la fin de l’article
Recherche à partir du point d’insertion. Cette option apparaît uniquement si un point d’insertion est placé.
Sélection
Recherche uniquement dans le texte sélectionné. Cette option n’est disponible que si du texte est sélectionné.

Recherche du texte sur des calques qui ont été verrouillés à l’aide de la boîte de dialogue Options de calque.
Vous ne pouvez pas remplacer du texte sur des calques verrouillés.

Recherche du texte dans les articles qui ont été extraits d’un flux de production InCopy. Vous ne pouvez pas
remplacer du texte dans des articles verrouillés.

Recherche du texte sur des calques qui ont été masqués à l’aide de la boîte de dialogue Options de calque.
Lorsque vous trouvez du texte sur un calque masqué, vous pouvez apercevoir une zone en surbrillance à l’emplacement du texte, mais vous ne
pouvez pas voir le texte. Vous pouvez remplacer du texte sur des calques masqués.
Le texte inclus dans les conditions masquées est toujours omis par la recherche.

Recherche du texte sur les gabarits.

Recherche du texte de note de bas de page.

Recherche le ou les mots dont la casse correspond exactement à celle du texte dans la zone Rechercher. Par exemple, si
vous recherchez « PréPresse », les occurrences « Prépresse », « prépresse » ou « PREPRESSE » ne seront pas localisées.

Ignore ces caractères s’ils font partie d’un autre mot. Par exemple, si vous recherchez « tout » comme mot entier, InDesign ignore le
mot « toutes ».

Recherche à l’aide d’expressions GREP

Sur l’onglet GREP de la boîte de dialogue Rechercher/Remplacer, vous pouvez élaborer des expressions GREP pour rechercher des chaînes
alphanumériques et des motifs dans de longs documents ou dans plusieurs documents ouverts. Vous pouvez entrer des métacaractères GREP



manuellement ou les choisir dans la liste Caractères spéciaux pour la recherche. Les recherches de GREP sont sensibles à la casse par défaut.

Vous trouverez une liste de ressources GREP InDesign sur le site InDesign Secrets.

1. Choisissez Edition > Rechercher/Remplacer, puis cliquez sur l’onglet GREP.

2. Dans le bas de la boîte de dialogue, spécifiez l’étendue de la recherche, puis cliquez sur les icônes pour inclure des calques
verrouillés, des gabarits, des notes de bas de page et d’autres éléments dans la recherche

3. Dans la zone Rechercher, utilisez l’une des méthodes suivantes pour construire une expression GREP :

Entrez l’expression de la recherche manuellement (Voir Métacaractères de recherche.)

Cliquez sur l’icône Caractères spéciaux pour la recherche à droite de l’option Rechercher et choisissez les options des
sous-menus Emplacements, Répétition, Correspondance, Touches de modification et Posix pour vous aider à créer
l’expression de recherche.

4. Dans la zone Remplacer par, entrez ou collez le texte de remplacement.

5. Cliquez sur Rechercher.

6. Pour poursuivre la recherche, cliquez sur Suivant, Remplacer (pour modifier l’occurrence courante), Tout remplacer (un
message indique le nombre total de remplacements) ou Remplacer/Rechercher (pour modifier l’occurrence courante et
rechercher la suivante).

7. La boîte de dialogue Rechercher/Remplacer d’InDesign comporte deux boutons de direction de recherche : un en avant et un
en arrière. Comme la recherche en avant est activée par défaut, vous pouvez basculer sur la recherche en arrière pour
inverser le flux de recherche. Cette nouvelle fonctionnalité permet de rechercher des chaînes dans les onglets Texte, GREP et
Glyphe.

Vous pouvez également utiliser les styles GREP pour appliquer un style de caractère à un texte conforme à une expression GREP. En fait, la
boîte de dialogue Styles GREP est un bon moyen de tester votre expression GREP. Ajoutez les exemples que vous voulez rechercher dans un
paragraphe, puis définissez un style de caractère et une expression GREP dans la boîte de dialogue Styles GREP. Lorsque vous activez le
mode Aperçu, vous pouvez modifier l’expression jusqu’à ce qu’elle s’adapte correctement à tous les exemples.

Conseils pour l’élaboration des recherches de GREP

Voici quelques conseils pour la construction d’expressions GREP.

De nombreuses recherches sous l’onglet GREP sont semblables à celles de l’onglet Texte, mais veillez à insérer des codes
différents selon l’onglet utilisé. En général, les métacaractères de l’onglet Texte commencent par le symbole « ^ » (par
exemple, « ^t » pour une tabulation) et ceux de l’onglet GREP par le symbole « \ » (par exemple, « \t » pour une tabulation).
Cependant, tous les métacaractères n’obéissent pas à cette règle. Par exemple, le retour chariot est représenté par « ^p »
dans l’onglet Texte et par « \r » dans l’onglet GREP. Pour obtenir la liste des métacaractères utilisés pour les onglets Texte et
GREP, reportez-vous à la section Métacaractères de recherche.

Pour rechercher un caractère ayant un sens symbolique dans GREP, entrez une barre oblique arrière (\) avant le caractère
pour indiquer que le caractère qui suit est littéral. Par exemple, entrez un point ( . ) pour rechercher un caractère dans une
recherche GREP ; pour rechercher un point, entrez « \ ».

Enregistrez la recherche GREP sous forme de requête si vous pensez l’exécuter souvent ou la partager avec quelqu’un d’autre
(Voir Recherche/remplacement d’éléments à l’aide de requêtes.)

Utilisez des parenthèses pour diviser votre recherche en sous-expressions. Par exemple, si vous souhaitez rechercher « cat »
ou « cot », vous pouvez utiliser la chaîne c(a|o)t. Les parenthèses sont particulièrement utiles pour identifier les associations.
Par exemple, la recherche « le (chat) et le (chien) » identifie « chat » comme Texte recherché 1 et « chien » comme Texte
recherché 2. Vous pouvez utiliser des expressions de texte recherché (telles que $1 pour Texte recherché 1) afin de modifier
seulement une partie du texte recherché.

Exemples de recherches GREP

Inspirez-vous de ces exemples pour apprendre à tirer parti des expressions GREP.

Exemple 1 : recherche de texte entre guillemets

http://indesignsecrets.com/grep


Supposons que vous souhaitez rechercher tous les mots entre guillemets (comme « Espagne ») et que vous voulez supprimer les guillemets et
appliquer un style à ces mots (de sorte que « Espagne » devienne Espagne). L’expression (")(\w+)(") inclut trois associations, comme indiqué
par les parenthèses ( ). Les première et troisième associations indiquent que vous recherchez tous les guillemets ; la deuxième association
signale que vous recherchez un ou plusieurs caractères de mot.

Vous pouvez utiliser les expressions de texte recherché pour renvoyer à ces associations. Par exemple, $0 renvoie à tout le texte recherché et $2
uniquement à la deuxième association. Si vous insérez $2 dans le champ Remplacer par et que vous spécifiez un style de caractère dans le
champ Remplacer le format, vous pouvez rechercher un mot entre guillemets, puis le remplacer par un style de caractère. Si seul $2 est spécifié,
les associations $1 et $3 sont supprimées (si vous précisez $0 ou $1$2$3 dans le champ Remplacer par, le style de caractère est également
appliqué aux guillemets).

Exemple de GREP

A. Recherche tous les caractères de mot entre guillemets B. Le style de caractère est appliqué à la deuxième association (le mot) tandis que les
première et troisième associations (guillemets ouvrant et fermant) sont supprimées. C. Style de caractère défini 

Avec cet exemple, vous ne recherchez que les mots isolés entre guillemets. Si vous voulez rechercher des phrases entre parenthèses, ajoutez des
expressions génériques, telles que (\s*.*\w*\d*), pour rechercher les espaces, les caractères et les chiffres.

Exemple 2 : numéros de téléphone

InDesign compte un grand nombre de paramètres de recherche prédéfinis que vous pouvez choisir dans le menu Requêtes. Par exemple, vous
pouvez choisir la requête Conversion des numéros de téléphone, qui se présente de la façon suivante :

\(?(\d\d\d)\)?[-. ]?(\d\d\d)[-. ]?(\d\d\d\d)

Aux Etats-Unis, les numéros de téléphone peuvent apparaître sous de multiples formes, telles que 206-555-3982, (206) 555-3982, 206.555.3982
ou 206 555 3982. Avec cette chaîne, vous recherchez toutes les variantes possibles. Les trois premiers chiffres (\d\d\d) du numéro de téléphone
peuvent figurer ou non entre parenthèses, c’est pourquoi un point d’interrogation apparaît après chaque parenthèse : \(? et \)?. Notez que la barre
oblique inverse \ indique que l’on recherche une véritable parenthèse et qu’il ne s’agit pas d’une sous-expression. Tout caractère figurant entre
crochets [ ] est recherché ; dans cet exemple, [-. ] indique donc que l’on recherche un tiret, un point ou une espace. Le point d’interrogation situé
après les crochets indique que les éléments entre crochets sont facultatifs lors de la recherche. Enfin, les chiffres figurent entre parenthèses, ce
qui signifie que les associations peuvent être signalées dans le champ Remplacer par.

Vous pouvez modifier les références des associations dans le champ Remplacer par selon vos besoins. Par exemple, vous pouvez utiliser les
expressions suivantes :

206.555.3982 = $1.$2.$3

206-555-3982 = $1-$2-$3

(206) 555-3982 = ($1) $2-$3

206 555 3982 = $1 $2 $3



Autres exemples de GREP

Testez les exemples du tableau suivant pour en savoir plus sur les recherches GREP.

Expression Chaîne de recherche Exemple Correspondances (en gras)

Catégorie
de
caractères

[ ]

[abc]

Recherche les lettres a, b ou c.

Maria
cuenta
bien.

Maria cuenta bien.

Début de
paragraphe

^

^~_.+

Cette recherche s’effectue depuis le début du
paragraphe (^) et vise un tiret cadratin (~_) suivi de tout
caractère ( . ) une ou plusieurs fois (+).

« We saw
—or at
least we
think we
saw—a
purple
cow. »

—Konrad
Yoes

« We saw—or at least we
think we saw—a purple
cow. »

—Konrad Yoes

Lookahead
négatif

(?!motif)

InDesign (?!CS.*?)

Cette fonction recherche une correspondance avec la
chaîne indiquée seulement si cette dernière n’est pas
suivie du motif spécifié.

InDesign,
InDesign
2.0,
InDesign
CS et
InDesign
CS2

InDesign, InDesign 2.0,
InDesign CS et InDesign
CS2

Lookahead
positif

(?=motif)

InDesign (?=CS.*?)

Cette fonction recherche une correspondance avec la
chaîne indiquée seulement si cette dernière est suivie
du motif spécifié.

Utilisez les mêmes motifs pour les fonctions Lookbehind
négatif (?<!motif) et positif (?<=motif).

InDesign,
InDesign
2.0,
InDesign
CS et
InDesign
CS2

InDesign, InDesign 2.0,
InDesign CS et InDesign
CS2

Associations

( )

(rapide) (renard) (brun) Le rapide
renard
brun saute
et bondit.

Le rapide renard brun
saute et bondit.

Tout le texte recherché =
rapide renard brun ; Texte
recherché 1 = rapide ; Texte
recherché 2 = renard ; Texte
recherché 3 = brun

Parenthèses
non
marquantes

(?
:expression)

(rapide) (renard) ($:brun) Le rapide
renard
brun saute
et bondit.

Le rapide renard brun
saute et bondit.

Tout le texte recherché =
rapide renard brun ; Texte
recherché 1 = rapide ; Texte
recherché 2 = renard

Respect de
la casse
activé

(?p)

(?i)pomme

Vous pouvez également utiliser (?i:pomme)

Pomme
pomme
POMME

Pomme pomme POMME

Respect de
la casse

(?-i)pomme Pomme
pomme

Pomme pomme POMME
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Métacaractères de recherche

Les métacaractères représentent un caractère ou un symbole dans InDesign. Les métacaractères de la zone Texte de la boîte de dialogue
Rechercher/Remplacer commencent par un caret (^) ; les métacaractères de la fenêtre GREP commencent par un tilde (~) ou une barre oblique
arrière (\). Vous pouvez entrer des métacaractères dans les onglet Texte ou GREP de la boîte de dialogue Rechercher/Remplacer.

Pour ne pas perdre de temps à corriger les erreurs de ponctuation, enregistrez les chaînes de recherche sous forme de requêtes.

désactivé

(?-p)

POMME

Multiligne
activé

(?m)

(?m)^\w+

Dans cet exemple, l’expression recherchée est
composée d’un ou de plusieurs (+) caractères de mot
(\w) au début d’une ligne (^). L’expression (?m) peut se
trouver sur toutes les lignes du texte recherché à traiter
en tant que lignes séparées.

(?m)^\w correspond au début de chaque paragraphe. (?
-m)^\w correspond seulement au début de l’article.

Un Deux
Trois
Quatre
Cinq Six
Sept Huit

Un Deux Trois Quatre Cinq
Six Sept Huit

Multiligne
désactivé

(?-m)

(?-m)^\w+ Un Deux
Trois
Quatre
Cinq Six
Sept Huit

Un Deux Trois Quatre Cinq
Six Sept Huit

Ligne par
ligne activé

(?s)

(?s)c.a

Vous recherchez tout caractère ( . ) entre les lettres c
et a. Les expressions (?s) comprennent tous les
caractères, même s’ils sont situés sur la ligne suivante.

(.) correspond à tout sauf aux sauts de paragraphe. (?
s)(.) correspond à tout, y compris aux sauts de
paragraphe.

abc abc
abc abc

abc abcabc abc

Ligne par
ligne
désactivé

(?-s)c.a abc abc
abc abc

abc abc abc abc

Répéter un
certain
nombre de
fois

{ }

b{3} équivaut à exactement 3 fois

b(3,} équivaut à au moins 3 fois

b{3,}? équivaut à au moins 3 fois (correspondance la
plus courte)

b{2,3} équivaut à au moins 2 fois et pas plus de 3 fois

b{2,3}? équivaut à au moins 2 fois et pas plus de 3 fois
(correspondance la plus courte)

abbc
abbbc
abbbbc
abbbbbc

abbc abbbc abbbbc
abbbbbc

abbc abbbc abbbbc
abbbbbc

abbc abbbc abbbbc
abbbbbc

abbc abbbc abbbbc
abbbbbc

abbc abbbc abbbbc
abbbbbc

Caractère Métacaractère
de l’onglet du
texte

Métacaractère de l’onglet GREP

Tabulation ^t \t



Fin de paragraphe ^p \r

Saut de ligne forcé ^n \n

Tout numéro de page ^# ~#

Numéro de page active ^N ~N

Numéro de page suivant ^X ~X

Numéro de page précédente ^V ~V

* Variable quelconque ^v ~v

Marque de section ^x ~x

* Marqueur d’objet ancré ^a ~a

* Marqueur de référence de note de bas de
page

^F ~F

* Marque d’index ^I ~I

Puce ^8 ~8

Japanese Bullet ^5 ~5

Caret ^^ \^

Barre oblique inverse \ \\

Symbole de copyright ^2 ~2

Points de suspension ^e ~e

Tilde ~ \~

Marque de paragraphe ^7 ~7

Symbole de marque déposée ^r ~r

Symbole de section ^6 ~6

Symbole de marque commerciale ^d ~d

Parenthèse ouvrante ( \(

Parenthèse fermante ) \)

Accolade ouvrante { \{

Accolade fermante } \}

Crochet ouvrant [ \[

Crochet fermant ] \]

Tiret cadratin ^_ ~_

Tiret demi-cadratin ^= ~=

Tiret conditionnel ^- ~-

Trait d’union insécable ^~ ~~

Ideographic Space ^( ~(



Espace cadratin ^m ~m

Espace demi-cadratin ^> ~>

Tiers d’espace ^3 ~3

Quart d’espace ^4 ~4

Sixième d’espace ^% ~%

Espace sans alinéa ^f ~f

Espace ultrafine ^| ~|

Espace insécable ^s ~s

Espace insécable (chasse fixe) ^S ~S

Espace fine ^< ~<

Espace de lisibilité ^/ ~/

Espace de ponctuation ^. ~.

^ Contenu du presse-papiers avec mise en
forme

^c ~c

^ Contenu du presse-papiers sans mise en
forme

^C ~C

Guillemet anglais quelconque " "

Guillemet allemand quelconque ' '

Guillemets anglais droits ^" ~"

Guillemet anglais ouvrant ^{ ~{

Guillemet anglais fermant ^} ~}

Guillemet allemand droit ^' ~'

Guillemet allemand ouvrant ^[ ~[

Guillemet allemand fermant ^] ~]

Retour chariot standard ^b ~b

Saut de colonne ^M ~M

Saut de bloc ^R ~R

Saut de page ^P ~P

Saut de page impaire ^L ~L

Saut de page paire ^E ~E

Saut de ligne conditionnel ^k ~k

Tabulation de retrait à droite ^y ~y

Retrait jusqu’à ce point ^p ~p



Fin du style imbriqué ici ^h ~h

NJ (Non-joiner) ^j ~j

* Variable d’en-tête continu (style de
paragraphe)

^Y ~Y

* Variable d’en-tête continu (style de
caractère)

^Z ~Z

* Variable de texte personnalisé ^u ~u

* Variable de dernier numéro de page ^T ~T

* Variable de numéro de chapitre ^H ~H

* Variable de date de création ^S ~S

* Variable de date de modification ^o ~o

* Variable de date de sortie ^D ~D

* Variable de nom de fichier ^l (L
minuscule)

~l (L minuscule)

* Chiffre quelconque ^9 \d

* Caractère quelconque autre qu’un chiffre \D

* Lettre quelconque ^$ [\l\u]

* Caractère quelconque ^? . (insère un point dans le champ Remplacer par)

* Espace (tout espace ou tabulation) ^w \s (insère une espace dans le champ Remplacer
par)

* Caractère quelconque autre qu’une espace \S

* Caractère de mot quelconque \w

* Caractère quelconque autre qu’un caractère
de mot

\W

* Lettre capitale quelconque \u

* Caractère quelconque autre qu’une lettre
capitale

\U

* Lettre minuscule quelconque \l

* Caractère quelconque autre qu’une lettre
minuscule

\L

^ Tout le texte recherché $0

Texte recherché 1-9 $1 (précise le nombre d’associations trouvées,
comme $3 pour la troisième association ; les
associations figurent entre parenthèses)

* Kanji ^K ~K

* Début de mot \<

* Fin de mot \>

* Limite de mot \b



* Opposé de limite de mot \B

* Début de paragraphe ^

* Fin de paragraphe [emplacement] $

* Zéro ou une fois ?

* Zéro ou plusieurs fois *

* Une ou plusieurs fois +

* Zéro ou une fois (correspondance la plus
courte)

??

* Zéro ou plusieurs fois (correspondance la
plus courte)

*?

* Une ou plusieurs fois (correspondance la
plus courte)

+?

* Sous-expression marquante ( )

* Sous-expression non marquante (?: )

* Jeu de caractères [ ]

* Ou |

* Lookbehind positif (?<= )

* Lookbehind négatif (?<! )

* Lookahead positif (?= )

* Lookahead négatif (?! )

* Respect de la casse activé (?p)

* Respect de la casse désactivé (?-p)

* Multiligne activé (?m)

* Multiligne désactivé (?-m)

* Ligne par ligne activé (?s)

* Ligne par ligne désactivé (?-s)

* Caractère alphanumérique quelconque [[:alnum:]]

* Caractère alphabétique quelconque [[:alpha:]]

* Caractère vide quelconque, espace ou
tabulation

[[:blank:]]

* Caractère de contrôle quelconque [[:control:]]

* Caractère graphique quelconque [[:graph:]]

* Caractère imprimable quelconque [[:print:]]

* Caractère de ponctuation quelconque [[:punct:]]
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* Peut être saisi dans la zone Rechercher, et non la zone Remplacer par.

^ Peut être saisi dans la zone Remplacer par, et non la zone Rechercher.

Recherche et remplacement d’objets

Vous pouvez utiliser la commande Rechercher/Remplacer pour rechercher et remplacer les attributs et les effets appliqués aux objets, blocs
graphiques et blocs de texte. Par exemple, pour donner aux ombres portées une couleur uniforme, de la transparence ou une distance de
décalage, vous pouvez utiliser la commande Rechercher/Remplacer pour rechercher et remplacer les ombres portées dans l’ensemble d’un
document.

1. Choisissez Edition > Rechercher/Remplacer.

2. Cliquez sur l’onglet Objet.

3. Cliquez sur la zone Rechercher le format d’objet ou cliquez sur l’icône Spécifier les attributs à rechercher .

4. Dans la zone de gauche de la boîte de dialogue Options de recherche des formats d’objet, sélectionnez un type de mise en
forme, spécifiez les attributs de mise en forme, puis cliquez sur OK.

Assurez-vous que les catégories que vous voulez rechercher apparaissent avec l’état adéquat. Vous pouvez activer,
désactiver ou ignorer chaque catégorie d’effets. Par exemple, si vous activez l’effet Ombre portée, la mise en forme de l’ombre
portée est incluse dans la recherche ; si vous désactivez l’effet Ombre portée, votre recherche porte que les objets dont la
mise en forme de l’ombre portée est désactivée ; si vous ignorez l’effet Ombre portée, les ombres portées ne sont pas
incluses dans la recherche.

5. Si vous souhaitez appliquer une mise en forme à l’objet trouvé, cliquez sur la zone Remplacer le format de l’objet ou cliquez
sur l’icône Spécifier les attributs à modifier  dans la section Modifier le format. Sélectionnez ensuite un type de mise en forme,
spécifiez les attributs et cliquez sur OK.

6. Utilisez les boutons de recherche et de remplacement pour modifier les objets mis en forme.

Recherche et remplacement de glyphes

La section Glyphe de la boîte de dialogue Rechercher/Remplacer est particulièrement utile pour remplacer les glyphes qui partagent la même
valeur Unicode que les autres glyphes semblables, comme par exemple les variantes de glyphes.

Un exemple clair de recherche et de modification des glyphes est disponible sur le site InDesign Secrets, sous le titre Finding and Changing
Glyphs.

1. Choisissez Edition > Rechercher/Remplacer.

2. Dans le bas de la boîte de dialogue, spécifiez une étendue dans le menu Chercher dans, puis cliquez sur les icônes pour
déterminer quels éléments (tels que les calques, les gabarits et les notes de bas de page) sont inclus dans la recherche.

3. Sous Rechercher un glyphe, sélectionnez les options Famille de polices et Style de police dans lesquelles le glyphe est situé.

Le menu Famille de polices affiche uniquement les polices qui sont appliquées au texte dans le document actif. Les polices de
styles non utilisés n’apparaissent pas.

* Caractère quelconque dont le code est
supérieur à 255 (s’applique uniquement aux
catégories de caractères larges)

[[:unicode:]]

* Caractère ou chiffre hexadécimal quelconque
0-9, a-f ou A-F

[[:xdigit:]]

* Caractère quelconque d’un certain jeu de
glyphes, tel que a, à, á, â, ã, ä, å, A, À, Á, Â,
Ã, Ä et Å

[[=a=]]

http://indesignsecrets.com/finding-and-changing-glyphs.php
http://indesignsecrets.com/finding-and-changing-glyphs.php
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4. Utilisez l’une des méthodes suivantes pour entrer le glyphe que vous voulez rechercher dans la zone du glyphe :

Cliquez sur le bouton en regard de la zone Glyphe, puis cliquez deux fois sur un glyphe dans le panneau. Ce panneau
fonctionne comme le panneau Glyphes.

Choisissez Unicode ou GID/CID, puis entrez le code du glyphe.

Vous pouvez utiliser d’autres méthodes pour entrer le glyphe que vous voulez rechercher dans la zone Glyphe.
Sélectionnez un glyphe dans la fenêtre du document et choisissez Charger le glyphe sélectionné dans Rechercher, dans le
menu contextuel, ou sélectionnez un glyphe dans le panneau Glyphes et choisissez Charger un glyphe dans Rechercher,
dans le menu contextuel.

5. Sous Remplacer le glyphe, entrez le glyphe de remplacement à l’aide des mêmes techniques utilisées pour entrer le glyphe
que vous recherchez.

6. Cliquez sur Rechercher.

7. Pour poursuivre la recherche, cliquez sur Suivant, Remplacer (pour modifier le dernier glyphe trouvé), Tout remplacer (un
message indique le nombre total de remplacements) ou Remplacer/Rechercher (pour modifier l’occurrence active et
rechercher la suivante).

8. La boîte de dialogue Rechercher/Remplacer d’InDesign comporte deux boutons de direction de recherche : un en avant et un
en arrière. Comme la recherche en avant est activée par défaut, vous pouvez basculer sur la recherche en arrière pour
inverser le flux de recherche. Cette nouvelle fonctionnalité permet de rechercher des chaînes dans les onglets Texte, GREP et
Glyphe.

9. Cliquez sur Terminer.

Recherche et modification de polices

Utilisez la commande Rechercher une police pour rechercher et répertorier les polices utilisées dans le document. Vous pouvez alors remplacer
toutes les polices (sauf les polices des graphiques importés) par une autre police disponible sur votre ordinateur. Vous pouvez même remplacer
une police faisant partie d’un style de texte. Tenez compte des points suivants :

Un nom de police est répertorié une seule fois pour toutes ses occurrences dans la mise en page et répertorié à chaque
occurrence supplémentaire dans les graphiques importés. Par exemple, si vous utilisez la même police trois fois dans la mise
en page et trois fois dans des graphiques importés, elle sera répertoriée quatre fois dans la boîte de dialogue Rechercher une
police (une fois pour toutes les occurrences de mise en page et trois fois pour les graphiques importés). Si la police n’est pas
totalement incorporée dans les graphiques, le nom de la police risque de ne pas être répertorié dans la boîte de dialogue
Rechercher une police.

L’option Rechercher une police n’est pas disponible dans la fenêtre en mode éditeur.

Dans la boîte de dialogue Rechercher une police, des icônes identifient le type de police ou l’état de la police : polices Type 1 
, images importées , polices TrueType , polices OpenType  et polices manquantes .

Vous pouvez rechercher et remplacer les polices composites, mais vous ne pouvez pas modifier les polices individuelles qui
font partie des polices composites.

La commande Texte > Rechercher une police vous permet d’obtenir un résultat homogène grâce à l’analyse de l’utilisation des
polices dans les pages et les graphiques importés. Pour rechercher et remplacer des attributs de texte, des caractères ou des
styles spécifiques, choisissez plutôt Edition > Rechercher/Remplacer.

1. Choisissez Texte > Rechercher une police.

2. Sélectionnez un ou plusieurs noms de polices dans la liste Polices du document.

3. Utilisez l’une des méthodes suivantes :

Pour rechercher la première occurrence dans la mise en page de la police sélectionnée dans la liste, cliquez
sur Rechercher. Le texte utilisant cette police apparaît. Le bouton Rechercher n’est pas disponible si la police
sélectionnée est utilisée dans un graphique importé ou si plusieurs polices sont sélectionnées dans la liste.

Pour sélectionner un élément graphique importé utilisant une police indiquée dans la liste par une icône d’élément
graphique importé , cliquez sur Rechercher graphique. Le graphique apparaît. Le bouton Rechercher graphique n’est
pas disponible si la police sélectionnée est utilisée dans la mise en page ou si vous avez sélectionné plusieurs polices
dans la liste Police du document.



Remarque :
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4. Pour obtenir des informations détaillées sur une police sélectionnée, cliquez sur Plus d’infos. Pour masquer les détails, cliquez
sur Moins d’infos. La zone Informations est vierge lorsque vous sélectionnez plusieurs polices dans la liste.

Si le format de fichier du graphique sélectionné ne fournit pas d’informations sur le type de police, celui-ci risque d’être
indiqué comme Indéterminé. Les polices des graphiques bitmap, tels que les images TIFF, ne s’affichent pas dans la liste, car
elles ne sont pas considérées comme des caractères.

5. Pour remplacer une police, sélectionnez la nouvelle police à utiliser dans la liste Remplacer par, puis utilisez l’une des
méthodes suivantes :

Pour ne remplacer qu’une occurrence de la police sélectionnée, cliquez sur Modifier. Cette option n’est pas disponible si
plusieurs polices sont sélectionnées.

Pour remplacer la police dans cette occurrence et chercher l’instance suivante, cliquez sur Remplacer/Rechercher. Cette
option n’est pas disponible si plusieurs polices sont sélectionnées.

Pour remplacer toutes les instances de la police sélectionnée dans la liste, cliquez sur Tout remplacer. Activez
l’option Redéfinir le style avec Tout remplacer si vous souhaitez redéfinir tout style de paragraphe ou de caractère
comprenant la police recherchée.

Lorsqu’il n’existe plus aucune occurrence d’une police dans le fichier, son nom est supprimé de la liste Polices du document.

Pour modifier des polices dans des graphiques importés, utilisez le programme d’exportation d’origine du
graphique, puis remplacez le graphique ou mettez à jour le lien dans le panneau Liens.

6. Si vous avez cliqué sur Modifier, cliquez sur Suivant pour atteindre l’occurrence suivante de la police.

7. Cliquez sur Terminer.

Vous pouvez ouvrir la boîte de dialogue Rechercher une police lors du contrôle en amont d’un document. Dans la boîte de dialogue Contrôle en
amont, sélectionnez l’onglet Polices et cliquez sur Rechercher une police.

Pour afficher le dossier système dans lequel une police apparaît, sélectionnez la police dans la boîte de dialogue Rechercher une police et
choisissez Faire apparaître dans l’Explorateur (Windows) ou Faire apparaître dans le Finder (Mac OS).

Recherche et remplacement d’éléments à l’aide de requêtes

Vous pouvez rechercher et remplacer du texte, des objets et des glyphes en utilisant ou en créant une requête. Une requête est une opération de
recherche et de remplacement prédéfinie. InDesign inclut plusieurs requêtes prédéfinies pour modifier les formats de ponctuation et d’autres
actions utiles, telles que la modification des formats de numéro de téléphone. En enregistrant une requête que vous avez créée, vous pouvez
l’exécuter à nouveau ultérieurement et la partager.

Recherche à l’aide de requêtes

1. Choisissez Edition > Rechercher/Remplacer.

2. Choisissez une requête dans la liste Requête.

Les requêtes sont groupées par type.

3. Spécifiez une étendue de recherche dans le menu Chercher dans.

L’étendue de la recherche n’est pas incluse dans la requête.

4. Cliquez sur Rechercher.

5. Pour poursuivre la recherche, cliquez sur Suivant, Remplacer (pour modifier le dernier texte ou la dernière marque de
ponctuation trouvés), Tout remplacer (un message indique le nombre total de remplacements) ou Remplacer/Rechercher
(pour modifier le texte ou des marques de ponctuation et continuer votre recherche).

Après avoir sélectionné une requête de recherche, vous pouvez ajuster les paramètres pour affiner votre recherche.

Enregistrement de requêtes
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Mac OS

Windows XP

Windows Vista et Windows 7

Enregistrez une requête dans la boîte de dialogue Rechercher/Remplacer si vous voulez l’exécuter à nouveau ultérieurement ou la partager. Les
noms des requêtes que vous enregistrez s’affichent dans la liste Requête dans la boîte de dialogue Rechercher/Remplacer.

1. Choisissez Edition > Rechercher/Remplacer.

2. Sélectionnez Texte, GREP ou un autre onglet pour effectuer la recherche que vous voulez.

3. Dans le menu Chercher dans, cliquez sur les icônes pour déterminer quels éléments (calques verrouillés, gabarits et notes de
bas de page, par exemple) inclure dans la recherche.

Ces éléments sont inclus dans la requête enregistrée. Toutefois, l’étendue de la recherche n’est pas enregistrée dans la
requête.

4. Définissez les champs Rechercher et Remplacer par (Voir Métacaractères de recherche et Recherche à l’aide
d’expressions GREP.)

5. Cliquez sur le bouton Enregistrer la requête dans la boîte de dialogue Rechercher/Remplacer, puis entrez un nom pour la
requête.

Si vous utilisez le nom d’une requête existante, vous devrez le changer. Cliquez sur Oui si vous voulez mettre à jour la requête existante.

Suppression de requêtes

Sélectionnez une requête dans la liste Requête, puis cliquez sur le bouton Supprimer la requête.

Chargement de requêtes

Les requêtes personnalisées sont enregistrées sous forme de fichiers XML. Les noms des requêtes personnalisées s’affichent dans la liste
Requête dans la boîte de dialogue Rechercher/Remplacer.

Pour charger une requête qui vous a été donnée pour qu’elle apparaisse dans la liste Requête, copiez le fichier de requête
dans l’emplacement adéquat :

Utilisateurs\[nom d’utilisateur]\Bibliothèque\Preferences\Adobe InDesign\[Version]\[Langue]\Find-Change
Queries\[type de requête]

Documents and Settings\[nom d’utilisateur]\Application Data\Adobe\InDesign\[Version]\[Langue]\Find-Change
Queries\[type de requête]

Utilisateurs\[nom d’utilisateur]\AppData\Roaming\Adobe\InDesign\[Version]\[Langue]\Find-
Change Queries\[type de requête]

Adobe recommande également

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr
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Création de notes de bas de page
Modification de la numérotation et de la mise en page des notes de bas de page
Utilisation de texte de note de bas de page
Habillage de texte dans une note de bas de page
Suppression de notes de bas de page 

Création de notes de bas de page

Une note de bas de page est constituée de deux parties liées : le numéro de référence de la note de bas de page qui apparaît dans le texte et le
texte de la note qui apparaît au bas de la colonne. Vous pouvez créer des notes de bas de page ou les importer de documents Word ou RTF. Les
notes de bas de page sont numérotées automatiquement au fur et à mesure que vous les ajoutez au document. La numérotation reprend du
début pour chaque article. Vous pouvez choisir le style, l’apparence et la mise en page des notes de bas de page. Vous ne pouvez pas ajouter de
notes de bas de page à des tableaux ou au texte d’une note de bas de page. La largeur du texte de note de bas de page est fonction de la
largeur de la colonne contenant le marqueur de référence de note de bas de page.

Il est impossible de créer des notes de fin de page dans InDesign. Les notes de fin de page figurant dans des documents Microsoft Word
convertis se présentent sous forme de texte plutôt que de notes de bas de page. Pour une solution pour créer des notes de bas de page, voir
l’article Endnotes in InDesign (« Notes de bas de page dans InDesign ») par Bob Bringhurst. 

Suivez ces étapes pour créer des notes de bas de page :

1. Placez le point d’insertion là où vous souhaitez insérer le numéro de référence de la note de bas de page.

2. Choisissez Texte > Insérer une note de bas de page.

3. Saisissez le texte de la note.

Note ajoutée au document

A. Numéro de référence B. Texte de la note de bas de page 

A mesure que vous saisissez du texte, la zone de la note s’agrandit, tandis que la taille du bloc de texte reste la même. La zone de la note de bas
de page continue de s’étendre vers le haut jusqu’à ce qu’elle atteigne la ligne de la référence à la note. La note de bas de page se poursuit alors
dans la colonne suivante du bloc de texte ou du bloc lié. Si la note de bas de page ne peut pas être scindée et si le texte de la note est trop long
pour la zone de note de bas de page, la ligne contenant la référence à la note est décalée sur la colonne suivante, ou bien une icône de texte en
excès apparaît. Pour corriger ce problème, redimensionnez le bloc ou modifiez la mise en forme du texte.

Lorsque le point d’insertion se trouve dans une note de bas de page, choisissez Texte > Atteindre la référence de note de bas de page pour
revenir au point du texte où vous vous trouviez. Si vous utilisez fréquemment cette option, pensez à créer un raccourci clavier.

http://blogs.adobe.com/indesigndocs/2009/03/endnotes_in_indesign_cs4.html


Style de numérotation

Début

Recommencer la numérotation à chaque

Afficher le préfixe/suffixe dans

Position

Style de caractère

Style de paragraphe

Séparateur

Modification de la numérotation et de la mise en page des notes de bas de page

Les modifications apportées à la numérotation et à la mise en page des notes de bas de page s’appliquent aux notes de bas de page existantes
et à celles que vous créez ultérieurement.

1. Sélectionnez Texte > Options de note de bas de page du document.

2. Dans l’onglet Numérotation et mise en forme, sélectionnez les options qui déterminent le type de numérotation et l’apparence
du numéro de référence et du texte des notes de bas de page.

3. Cliquez sur l’onglet Mise en page et sélectionnez les options concernant l’aspect de la section contenant les notes de bas de
page sur la page.

4. Cliquez sur le bouton OK.

Options de numérotation et de mise en forme des notes de bas de page

Les options suivantes apparaissent dans la section Numérotation et mise en forme de la boîte de dialogue Options de note de bas de page :

Choisissez le style de numérotation à appliquer aux numéros de référence des notes de bas de page.

Spécifiez le numéro à utiliser pour la première note de bas de page de l’article. Tous les articles du document commencent au numéro
spécifié pour Début. Si un livre contient plusieurs documents dont les numéros de page se suivent, vous pouvez faire en sorte que les numéros
des notes de bas de page de chaque chapitre reprennent là où le chapitre précédent s’est arrêté.
Cette option est particulièrement utile pour les documents regroupés dans un livre. En effet, la numérotation des notes de bas de page n’est pas
continue d’un document à l’autre.

Si vous souhaitez que la numérotation recommence au début au sein d’un même document,
sélectionnez cette option et choisissez la commande Page, Planche ou Section pour déterminer l’endroit où la numérotation des notes de bas de
page doit repartir du début. Certains types de numérotation, comme l’astérisque (*), sont plus appropriés lorsque la numérotation reprend du début
à chaque page.

Sélectionnez cette option pour afficher les préfixes ou les suffixes dans la référence à la note de bas de page, le
texte de la note de bas de page, ou encore dans les deux. Les préfixes apparaissent avant le numéro (par exemple [1), et les suffixes après le
numéro (par exemple 1]). Cette option est particulièrement utile si vous souhaitez insérer des notes de bas de page entre des caractères, par
exemple [1]. Entrez un ou plusieurs caractères ou sélectionnez une option pour Préfixe, Suffixe ou les deux. Pour sélectionner des caractères
spéciaux, cliquez sur les icônes situées en regard des commandes Préfixe et Suffixe pour afficher un menu.

Si le numéro de référence à la note de bas de page est trop près du texte qui le précède, vous pouvez corriger ce problème en ajoutant un
espace comme préfixe. Vous pouvez également appliquer un style de caractère au numéro de référence.

Cette option détermine l’apparence du numéro de référence à la note de bas de page (par défaut en exposant). Si vous préférez
appliquer un style de caractère au numéro (par exemple un style de caractère comprenant les paramètres d’exposant OpenType), choisissez
Normale et spécifiez le style de caractère.

Choisissez un style de caractère pour formater le numéro de référence de note de bas de page. Par exemple, au lieu
d’utiliser l’exposant, sélectionnez un style de caractère à une position normale avec une ligne de base surélevée. Le menu affiche les styles de
caractères disponibles dans le panneau Styles de caractères.

Choisissez un style de paragraphe pour le texte de toutes les notes de bas de page du document. Le menu affiche les
styles de paragraphes disponibles dans le panneau Styles de paragraphes. Par défaut, le style [Paragraphe standard] est utilisé. Le style
[Paragraphe standard] peut ne pas avoir le même aspect que les paramètres de police par défaut du document.

Le séparateur détermine l’espace qui apparaît entre le numéro de la note de bas de page et le début du texte de la note. Pour
changer le séparateur, sélectionnez ou supprimez le séparateur existant, puis choisissez un autre séparateur. Vous pouvez inclure plusieurs
caractères. Pour insérer des espaces, utilisez le métacaractère approprié, comme ^m pour les espaces cadratin.
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Espace entre les notes de bas de page

Décalage de la 1re ligne de base

Placer les notes de bas de page de fin d’article en bas du texte

Autoriser le fractionnement des notes de bas de page

Filet au-dessus
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Options de mise en page des notes de bas de page

Les options suivantes apparaissent dans la section Mise en page de la boîte de dialogue Options de note de bas de page :

Cette option détermine l’espace minimum entre le bas de la colonne et la première ligne
de notes de bas de page. Vous ne pouvez pas utiliser de valeur négative. Les paramètres Espace avant du paragraphe de note de bas de page
sont ignorés.

Cette option détermine la distance entre le dernier paragraphe d’une note de bas de page et le premier
paragraphe de la note de bas de page suivante dans une colonne. Vous ne pouvez pas utiliser de valeur négative. Les valeurs spécifiées pour
Espace avant/après dans un paragraphe de note de bas de page s’appliquent uniquement si la note de bas de page comprend plusieurs
paragraphes.

Cette option détermine la distance entre le début de la zone de note de bas de page (là où le séparateur
apparaît par défaut) et la première ligne du texte de la note de bas de page.
Pour plus d’informations sur les options de la première ligne de base, voir Modification des propriétés d’un bloc de texte.

Sélectionnez cette option si vous souhaitez que les notes de bas de page de
la dernière colonne apparaissent juste sous le texte du dernier bloc de l’article. Si cette option est sélectionnée, toutes les notes de bas de page
du dernier bloc de l’article apparaîtront au bas de la colonne.

Sélectionnez cette option si vous souhaitez que les notes de bas de page continuent
sur une autre colonne si la note dépasse l’espace maximal disponible pour les notes de cette colonne. Si la note ne peut pas être divisée, la ligne
contenant la référence à la note de bas de page est déplacée à la colonne suivante, ou le texte est composé en excès.

Même si le fractionnement des notes de bas de page est activé, vous pouvez empêcher des notes de bas de page de fractionner en plaçant le
point d’insertion dans le texte de note de bas de page. Choisissez la commande Options d’enchaînement dans le menu du panneau
Paragraphe, puis choisissez les options Lignes solidaires et Toutes les lignes du paragraphe. Si la note de bas de page contient plusieurs
paragraphes, utilisez l’option Paragraphes solidaires X lignes dans le premier paragraphe du texte de la note de bas de page. Choisissez
Texte > Insérer un caractère de saut > Saut de colonne pour choisir l’emplacement du fractionnement de la note de bas de page.

Note de bas de page fractionnée sur la colonne

Spécifiez l’emplacement et l’aspect de la ligne de séparation visible au-dessus du texte de note de bas de page. Une ligne de
séparation (également appelée « trait de séparation ») est également visible au-dessus de tout texte de note de bas de page qui se poursuit dans
un autre bloc Les options que vous sélectionnez s’appliquent soit à la première note de bas de page de la colonne, soit aux suites des notes de
bas de page, selon ce que vous avez sélectionné dans le menu. Ces options sont semblables à celles qui apparaissent lorsque vous spécifiez un
filet de paragraphe. Si vous voulez supprimer la ligne de séparation de note de bas de page, désélectionnez l’option Filet.

Utilisation de texte de note de bas de page

Tenez compte des points suivants lorsque vous modifiez un texte de note de bas de page :

Lorsque le point d’insertion se trouve dans le texte de la note de bas de page, si vous choisissez Edition > Tout sélectionner,
tout le texte de la note de bas de page est sélectionné, mais pas les autres notes de bas de page ni aucun autre texte.

http://idiom-q-win-1/fr/indesign/using/creating-text-text-frames.html#change_text_frame_properties


Haut de la page

Utilisez les touches de direction pour vous déplacer parmi les notes de bas de page.
En effet, la numérotation des notes de bas de page n’est pas continue d’un document à l’autre. Si vous ne voulez pas que la
numérotation recommence au début au sein de chaque document du livre, changez manuellement la valeur Début dans
chacun des documents après avoir finalisé leur édition.
En mode éditeur, vous pouvez cliquer sur l’icône de la note de bas de page pour développer ou réduire une note. Vous
pouvez développer ou réduire toutes les notes de bas de page en choisissant Affichage > Mode éditeur > Développer toutes
les notes de bas de page ou Réduire toutes les notes de bas de page.
En mode Epreuve en placard ou Article, vous pouvez cliquer sur l’icône de note de bas de page pour développer ou réduire
les notes de bas de page. Vous pouvez également développer ou réduire toutes les notes de bas de page en cliquant avec le
bouton droit de la souris (Windows) ou en cliquant tout en maintenant la touche Contrôle enfoncée (Mac OS) sur une note de
bas de page, puis en choisissant Développer toutes les notes de bas de page ou Réduire toutes les notes de bas de page.

Vous pouvez sélectionner et appliquer la mise en forme des caractères et des paragraphes au texte des notes de bas de
page. Vous pouvez également sélectionner et modifier l’apparence des numéros de référence aux notes de bas de page, mais
il est préférable pour cela d’utiliser la boîte de dialogue Options de note de bas de page du document.

Lorsque vous coupez et copier du texte comprenant un numéro de référence à une note de bas de page, le texte de la note
est également ajouté au Presse-papiers. Si vous copiez le texte dans un autre document, les notes de bas de page de ce
texte utiliseront les caractéristiques de numérotation et de mise en page du nouveau document.

Si vous avez accidentellement supprimé le numéro de la note de bas de page au début du texte de celle-ci, vous pouvez le
rajouter. Placez le point d’insertion au début du texte de note de bas de page, cliquez avec le bouton droit de la souris
(Windows) ou cliquez sur la touche Ctrl (Mac OS), puis sélectionnez Insérer un caractère spécial > Marques > Numéro de note
de bas de page.

Si vous effacez les remplacements et les styles de caractère d’un paragraphe contenant un marqueur de référence de note de
bas de page, les numéros de référence aux notes de bas de page perdent les attributs appliqués dans la boîte de dialogue
Options de note de bas de page du document.

Habillage de texte dans une note de bas de page

Vous pouvez appliquer l’habillage de texte à un objet ancré ou flottant faisant partie d’une note de bas de page.

Habillage de texte interne des objets dans les notes de bas de page

Vous pouvez placer un objet texte ou un objet ancré sur l’habillage de texte appliqué à une note de bas de page. L’habillage enveloppe l’objet et
s’y adapte automatiquement.

L’habillage de texte interne s’effectue au-dessous du point où l’objet est ancré dans une note de bas de page.



Habillage de texte interne

Habillage de texte externe des objets dans les notes de bas de page

Lorsqu’un objet flottant, non ancré ni sur la ligne, et auquel l’habillage de texte est appliqué, interagit avec le texte des notes de bas de page,
l’habillage de texte prend effet. Le texte s’ajuste dynamiquement autour de l’objet.

Dans l’exemple illustré ci-dessous, la photo ne fait pas partie de la note de bas de page, mais le texte s’adapte sans problème à l’objet.

Habillage de texte externe

Notes de bas de page dans des blocs non rectangulaires

Pour les blocs de texte non rectangulaires, tels que les angles arrondis, les ovales et les cercles, les notes de bas de page restent dans les limites
des formes de l’objet.
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Suppression de notes de bas de page 

Pour supprimer une note de bas de page, sélectionnez le numéro de référence à la note qui apparaît dans le texte, puis appuyez sur la touche
Retour arrière ou Suppr. Si vous supprimez uniquement le texte de la note, le numéro de référence et la structure de la note sont conservés.

Adobe recommande également

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr
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Présentation du panneau Glyphes
Insertion de glyphes et de caractères spéciaux
Création et modification de jeux de glyphes personnalisés
Utilisation de guillemets
Insertion d’espaces

Présentation du panneau Glyphes
Entrez des glyphes à l’aide du panneau Glyphes. Le panneau affiche automatiquement les glyphes de la police sur laquelle le curseur est situé,
mais vous pouvez afficher une autre police, afficher un style de caractère dans la police (Maigre, Normal ou Gras, par exemple) et faire en sorte
que le panneau affiche un sous-ensemble de glyphes dans la police (des symboles mathématiques, des numéros ou des symboles de
ponctuation, par exemple).

Glyphes, panneau
A.  Affichage d’un sous-ensemble de glyphes B.  Info-bulle C.  Liste des polices D.  Style de la police

En plaçant le pointeur sur un glyphe, vous pouvez lire sa valeur CID/GID, sa valeur Unicode et son nom dans l’info-bulle.

Ouverture du panneau Glyphes
 Choisissez Texte > Glyphes ou Fenêtre > Texte et tableaux > Glyphes.

Changement du mode d’affichage du panneau Glyphes
Cliquez sur l’objet d’interface de cycle (situé à gauche du mot « Glyphes » dans le panneau Glyphes) pour modifier les vues
du panneau. Cliquez sur l’objet d’interface pour afficher les vues successivement : le panneau réduit, le panneau entier et le
panneau sans les glyphes récemment utilisés.
Cliquez sur les boutons Zoom avant ou Zoom arrière dans le coin inférieur droit du panneau Glyphes.
Redimensionnez le panneau Glyphes en faisant glisser le coin inférieur droit.

Filtrage des glyphes affichés
 Utilisez l’une des méthodes suivantes pour déterminer quels glyphes s’affichent dans le panneau Glyphes :

Choisissez Police entière pour afficher tous les glyphes disponibles dans la police.

Choisissez une option sous Police entière pour réduire la liste à un sous-ensemble de glyphes. Par exemple, Ponctuation
affiche uniquement les glyphes de ponctuation ; Symboles mathématiques réduit le choix aux symboles mathématiques.

Tri des glyphes dans le panneau Glyphes
 Choisissez Par CID / GID ou Par Unicode pour déterminer la manière dont les glyphes sont triés dans le panneau Glyphes.
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Un glyphe est une forme spéciale d’un caractère. Par exemple, dans certaines polices, la lettre majuscule A est disponible sous plusieurs formes,
notamment en lettre italique ornée et en petite majuscule. Vous pouvez utiliser le panneau Glyphes pour rechercher un glyphe dans une police.

Les polices OpenType, telles qu’Adobe Caslon™ Pro, fournissent une multitude de glyphes pour de nombreux caractères standard. Utilisez le
panneau Glyphes lorsque vous voulez insérer des variantes de glyphes dans un document. Vous pouvez également l’utiliser pour visualiser et
insérer des attributs OpenType, tels que des ornements, des lettres italiques ornées, des signes de fraction et des ligatures.

Insertion de caractères spéciaux
Vous pouvez insérer des caractères spéciaux tels qu’un tiret cadratin, un tiret demi-cadratin, un symbole de marque déposée et des points de
suspension.

1. Sélectionnez l’outil Texte, puis placez le point d’insertion à l’endroit où vous voulez insérer un caractère.
2. Choisissez Texte > Insérer un caractère spécial >, puis sélectionnez une option de l’une des catégories du menu.

Si les caractères spéciaux que vous utilisez fréquemment ne s’affichent pas dans la liste des caractères spéciaux, ajoutez-les à un jeu de glyphes
de votre création.

Insertion d’un glyphe d’une police spécifiée
1. Sélectionnez l’outil Texte, puis cliquez pour placer le point d’insertion à l’endroit où vous voulez insérer un caractère.
2. Choisissez Texte > Glyphes pour afficher le panneau Glyphes.
3. Pour afficher un autre jeu de caractères dans le panneau Glyphes, utilisez l’une des méthodes suivantes :

Sélectionnez une police et un style de caractère différent le cas échéant. Dans le menu Afficher, choisissez Police entière.
Si vous avez sélectionné une police OpenType, choisissez une catégorie OpenType.

Dans le menu Afficher, sélectionnez un jeu de glyphes personnalisé (voir la section Création et modification de jeux de
glyphes personnalisés).

4. Faites défiler les caractères jusqu’à ce que le glyphe que vous voulez insérer apparaisse. Si vous avez sélectionné une police
OpenType, vous pouvez afficher un menu déroulant de variantes de glyphes en cliquant sur la zone de glyphe et en
maintenant le bouton appuyé.

5. Cliquez deux fois sur le caractère à insérer. Le caractère apparaît au niveau du point d’insertion.

Insertion d’un glyphe récemment utilisé
InDesign répertorie les 35 derniers glyphes que vous avez insérés et les rend disponibles dans la section Récemment utilisés à la première ligne
du panneau Glyphes (vous devez développer le panneau pour afficher les 35 glyphes sur la première ligne).

 Utilisez l’une des méthodes suivantes :

Cliquez deux fois sur un glyphe sous Récemment utilisés.

Choisissez Glyphes récents dans la liste Afficher pour afficher tous les glyphes récemment utilisés dans la partie principale du
panneau Glyphes, puis cliquez deux fois sur un glyphe.

Effacement des glyphes récemment utilisés
Pour effacer un glyphe sélectionné dans la section Récemment utilisés, cliquez avec le bouton droit de la souris (Windows®)
ou tout en maintenant la touche Contrôle enfoncée (Mac OS) sur un glyphe dans la section Récemment utilisés, puis
choisissez l’option Supprimer le glyphe des éléments récemment utilisés.
Pour effacer tous les glyphes récemment utilisés, choisissez l’option Effacer tous les éléments récemment utilisés.

Remplacement d’un caractère par une variante de glyphe
Lorsqu’un caractère inclut des variantes de glyphes, il s’affiche dans le panneau Glyphes avec une icône en forme de triangle dans le coin
inférieur droit. Cliquez sur le caractère dans le panneau Glyphes et maintenez le bouton de la souris enfoncé pour afficher un menu déroulant des
variantes de glyphes ou affichez les variantes de glyphes dans le panneau Glyphes.

Sélection de variantes de glyphes dans une police OpenType

1. Choisissez Texte > Glyphes pour afficher le panneau Glyphes.
2. Sélectionnez Variantes de sélection dans la liste Afficher.
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3. A l’aide de l’outil Texte, sélectionnez un caractère dans le document.
4. Utilisez l’une des méthodes suivantes pour remplacer le caractère sélectionné dans le document :

Cliquez deux fois sur un glyphe dans le panneau Glyphes.

Sélectionnez un glyphe dans le menu.

Affichage des attributs de glyphes OpenType dans le panneau Glyphes
Pour une sélection aisée, le panneau Glyphes vous permet d’afficher des caractères pour les attributs OpenType sélectionnés uniquement. Vous
pouvez sélectionner différentes options dans le menu Afficher du panneau Glyphes.

Options du menu Afficher du panneau Glyphes

1. Dans le panneau Glyphes, choisissez une police OpenType dans la liste des polices.
2. Choisissez une option dans le menu Afficher.

Les options affichées varient selon la police sélectionnée. Pour plus de détails sur l’application des attributs de police OpenType, reportez-vous à
la section Application d’attributs de police OpenType. Pour plus de détails sur les polices OpenType, reportez-vous à l’adresse
www.adobe.com/go/opentype_fr.

Mise en surbrillance des variantes de glyphes dans le texte
1. Choisissez Edition > Préférences > Composition (Windows) ou InDesign > Préférences > Composition (Mac OS).
2. Sélectionnez Glyphes remplacés, puis cliquez sur OK. Les glyphes remplacés dans le texte s’affichent en surbrillance jaune

non imprimable.

Création et modification de jeux de glyphes personnalisés
Un jeu de glyphes est un ensemble nommé de glyphes provenant d’une ou de plusieurs polices. Le fait d’enregistrer les glyphes les plus
fréquemment utilisés vous évite d’avoir à les rechercher à chaque fois que vous en avez besoin. Les jeux de glyphes ne sont pas liés à un
document en particulier. Ils sont enregistrés avec d’autres préférences Indesign dans un fichier séparé qui peut être partagé.

Vous pouvez choisir de mémoriser la police associée à un glyphe que vous ajoutez. L’option de mémorisation des polices est utile, notamment
lorsque vous travaillez avec des caractères dingbat susceptibles d’apparaître dans d’autres polices. Dans le cas où la police d’un glyphe est
mémorisée, mais manquante, le carré de la police s’affiche en rose dans le panneau Glyphes et la boîte de dialogue Modifier le jeu de glyphes. Si
la police n’est pas mémorisée en même temps que le glyphe que vous ajoutez, un « u » s’affiche en regard du glyphe pour indiquer que c’est la
valeur unicode de la police qui détermine l’apparence du glyphe.

Création d’un jeu de glyphes personnalisé
1. Sélectionnez Texte > Glyphes.
2. Utilisez l’une des méthodes suivantes :

Dans le menu du panneau Glyphes, choisissez Nouveau jeu de glyphes.

Ouvrez le menu contextuel dans le panneau Glyphes, puis choisissez Nouveau jeu de glyphes.

3. Saisissez le nom du jeu de glyphes.

http://www.adobe.com/go/opentype_fr
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4. Choisissez l’ordre d’insertion des glyphes dans le jeu de glyphes, puis cliquez sur OK :
Insérer devant Chaque nouveau glyphe apparaît en premier dans la liste.

Ajouter à la fin Chaque nouveau glyphe apparaît en dernier dans la liste.

Ordre d’Unicode Tous les glyphes sont répertoriés dans l’ordre de leur valeur unicode.

5. Pour ajouter des glyphes au jeu personnalisé, sélectionnez la police contenant le glyphe au bas du panneau Glyphes, cliquez
sur le glyphe, puis choisissez le nom du jeu de glyphes personnalisés dans le menu Ajouter au jeu de glyphes du menu du
panneau Glyphes.

Affichage d’un jeu de glyphes personnalisé
 Utilisez l’une des méthodes suivantes dans le panneau Glyphes :

Choisissez le jeu de glyphes dans la liste Afficher.

Dans le menu du panneau Glyphes, choisissez Afficher le jeu de glyphes, puis le nom du jeu de glyphes.

Modification des jeux de glyphes personnalisés
1. Choisissez Modifier le jeu de glyphes dans le menu du panneau Glyphes, puis choisissez le jeu de glyphes personnalisé.
2. Sélectionnez le glyphe à modifier, effectuez l’une des opérations suivantes, puis cliquez sur OK :

Pour associer le glyphe à sa police, sélectionnez Mémoriser la police avec ce glyphe. Par la suite, ce glyphe conservera
sa police d’origine, quelle que soit la police du texte sélectionné dans lequel il est inséré et quelle que soit la police
spécifiée dans le panneau Glyphes. Si vous désélectionnez cette option, la valeur Unicode de la police est utilisée.

Pour afficher des variantes de glyphes, choisissez une police ou un style différent. La police d’un glyphe doit avoir été
définie au préalable pour pouvoir être modifiée.

Choisissez Supprimer du jeu pour supprimer un glyphe du jeu de glyphes personnalisé.

Pour modifier l’ordre des glyphes ajoutés au jeu, choisissez une option Ordre d’insertion. Ordre d’Unicode n’est pas
disponible si Insérer devant ou Ajouter à la fin était sélectionné au moment de la création du jeu de glyphes.

Suppression de glyphes de jeux de glyphes personnalisés
1. Dans le menu Afficher du panneau Glyphes, sélectionnez le jeu de glyphes personnalisé.
2. Cliquez avec le bouton droit de la souris (Windows) ou tout en maintenant la touche Contrôle enfoncée (Mac OS) sur un

glyphe, puis choisissez Supprimer le glyphe de ce jeu.

Suppression de jeux de glyphes personnalisés
1. Utilisez l’une des méthodes suivantes :

Dans le menu du panneau Glyphes, choisissez Supprimer le jeu de glyphes.

Dans le menu contextuel, choisissez Supprimer le jeu de glyphes.

2. Cliquez sur le nom d’un jeu de glyphes personnalisé.
3. Cliquez sur le bouton Oui pour confirmer.

Enregistrement et chargement des jeux de glyphes
Les jeux de glyphes personnalisés sont enregistrés dans des fichiers conservés dans le dossier Jeux de glyphes, sous-dossier du dossier
Paramètres prédéfinis. Vous pouvez copier les fichiers de jeux de glyphes vers d’autres ordinateurs, et ainsi rendre les jeux de glyphes
personnalisés disponibles aux autres. Copiez les fichiers de jeux de glyphes vers et depuis ces dossiers pour les partager :

Mac OS Users\[nom d’utilisateur]\Bibliothèque\Preferences\Adobe InDesign\[Version]\[Langue]\Glyph Sets
Windows XP Documents and Settings\[nom d’utilisateur]\Application Data\Adobe\InDesign\[Version]\[Langue]\Glyph Sets
Windows Vista et Windows 7 Users\[nom d’utilisateur]\AppData\Roaming\Adobe\InDesign\[Version]\[Langue]\Glyph Sets

Utilisation de guillemets
Vous pouvez spécifier différents types de guillemets pour différentes langues. Ces guillemets s’affichent automatiquement lors de la saisie si
l’option Utiliser les guillemets typographiques est sélectionnée dans la fenêtre Texte de la boîte de dialogue Préférences.

Indication des guillemets à utiliser
1. Choisissez Edition > Préférences > Dictionnaire (Windows) ou InDesign > Préférences > Dictionnaire (Mac OS).
2. Choisissez une langue dans le menu Langue.
3. Utilisez l’une des méthodes suivantes, puis cliquez sur OK :
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Pour Guillemets doubles, sélectionnez ou saisissez une paire de guillemets.

Pour Guillemets simples, sélectionnez ou saisissez une paire de guillemets.

Insertion de guillemets droits
 Utilisez l’une des méthodes suivantes :

Choisissez Page > Insérer un caractère spécial > Guillemets > Guillemets anglais droits ou Guillemet allemand droit
(apostrophe).

Dans la fenêtre Texte de la boîte de dialogue Préférences, désélectionnez l’option Utiliser les guillemets typographiques, puis
entrez le guillemet ou l’apostrophe.

Pour activer ou désactiver l’option Utiliser les guillemets typographiques, appuyez sur les touches Maj+Ctrl+Alt+’ (Windows) ou
Maj+Commande+Option+’ (Mac OS).

Le symbole prime est fréquemment utilisé pour exprimer les mesures en pieds, en minutes d’arc ou les durées en minutes. Il ressemble à une
apostrophe inclinée. Le symbole double prime est quant à lui souvent utilisé pour exprimer les mesures en pouces, en secondes d’arc ou les
durées en secondes. Ces symboles sont différents des apostrophes ou des guillemets anglais doubles et sont inclus dans certaines polices.
Vous les insérez au moyen du panneau Glyphe. Si les symboles prime et double prime ne sont pas inclus dans la police, insérez le guillemet
droit et mettez-le en italique.

Insertion d’espaces
Une espace est le blanc qui sépare deux caractères. Les espaces ont de multiples fonctions : elles peuvent par exemple servir à empêcher le
fractionnement d’une expression à cheval sur deux lignes.

1. A l’aide de l’outil Texte, placez le point d’insertion à l’endroit où vous voulez insérer une espace.
2. Choisissez Texte > Insérer une espace, puis sélectionnez une option, telle que Espace cadratin, dans le menu contextuel.

Les symboles représentant les espaces s’affichent lorsque vous sélectionnez Texte > Afficher les caractères masqués.

Options d’espaces
Les options suivantes apparaissent dans le menu Texte > Insérer une espace :

Espace cadratin Equivaut en largeur au corps du caractère. En valeur de 12 points, une espace cadratin mesure 12 points de large.
Espace demi-cadratin Moitié de la largeur d’une espace cadratin.
Espace insécable Ajoute une espace de la même largeur que lorsque vous appuyez sur la barre d’espacement, mais empêche le
sectionnement de la ligne au niveau de l’espace.
Espace insécable (chasse fixe) Une espace à chasse fixe empêche toute rupture de ligne à l’emplacement d’une espace, mais elle ne peut
pas être développée ni compressée lorsque le texte est justifié. L’espace à chasse fixe est identique au caractère Espace insécable inséré dans
InDesign CS2.
Tiers d’espace Un tiers de la largeur d’une espace cadratin.
Quart d’espace Un quart de la largeur d’une espace cadratin.
Sixième d’espace Un sixième de la largeur d’une espace cadratin.
Espace sans alinéa Ajoute un espace variable à la dernière ligne d’un paragraphe entièrement justifié. Utile pour justifier la dernière ligne d’un
texte (voir la section Modification des paramètres de justification).

Espace ultrafine Un vingt-quatrième de la largeur d’une espace cadratin.
Espace fine Un huitième de la largeur d’une espace cadratin. Peut par exemple être utilisé de chaque côté d’un tiret cadratin ou demi-
cadratin.

Espace de lisibilité Même largeur qu’un chiffre dans le style de caractères. Peut servir à aligner les chiffres d’un tableau de comptabilité.
Espace de ponctuation Même largeur qu’un point d’exclamation, un point ou le signe deux-points dans le style de caractères.
Voir aussi
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Formatting CJK characters
Apply shatai to text
Rotate characters
Adjust aki before and after characters
Use tate-chu-yoko
Add Ruby to text
Apply kenten
Align text of different sizes

Apply shatai to text

In traditional typesetting technology, characters were slanted by using a lens to distort the glyphs when being set
on film. This oblique style is known as shatai. Shatai is distinct from a simple slant of the glyphs, because it also
scales the glyphs. You can adjust the magnification or angle of text you want to slant from the center point,
without changing the height of the glyph, using the shatai feature in InDesign.

Shatai

A. No scale applied B. Magnification 30%, 45 shatai C. Selecting the Adjust Tsume option D. Selecting the Adjust Rotation option 

1. Select text.
2. Select Shatai from the Character panel menu or Control panel menu.
3. Specify the following options, and click OK:

Specify the degree of skew in Magnification (In traditional typesetting technology terms, 10%
magnification is lens 1, and 40% magnification is lens 4).

Set the angle of obliqueness to 30, 45, or 60, in Angle.

Select Adjust Rotation to rotate the glyphs, and display horizontal lines horizontally for horizontal text,
and vertical lines vertically for vertical text.

Select Adjust Tsume to apply jidori.

You can fine tune the rotated oblique effect for individual characters, after applying shatai to text.

Rotate characters
1. Select the characters.
2. In the Character panel, type a value for Character Rotation  Specify a minus value to rotate the character
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to the right (clockwise).

Adjust aki before and after characters
1. Select opening parenthesis or closing parenthesis with the type tool.
2. Choose the amount of aki you want to add from the Mojikumi Before Character  or Mojikumi After

Character  pop-up menu, in the Character panel.

For example, if you specify 2bu, half a full-width space is added, and if you specify 4bu, a quarter of a full-width
space is added. This aki will not be adjusted when the line is set to full justification. Adjusting aki is especially
useful to override Mojikumi Akiryo Settings for certain characters.

Adding aki before opening parenthesis

Use tate-chu-yoko

Using tate-chu-yoko (also known as kumimoji or renmoji) is an option to make a part of the text horizontal, in
vertical text. It is easier to read half-width characters such as numbers, dates, and short foreign words in a vertical
text frame, by rotating the text.

Before and after applying tate-chu-yoko

You can move text left, right, up, and down when you turn on the Tate-chu-yoko option. You can also set Auto
Tate-chu-yoko for special half-width characters. Auto Tate-chu-yoko is set in the paragraph attributes.

Use tsume or tracking in the Character panel to adjust the character spacing for Tate-chu-yoko.

Apply tate-chu-yoko

1. Select the text to which you want to apply tate-chu-yoko.
2. Do one of the following:

Choose Tate-chu-yoko from the Character panel menu or Control panel menu.
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Choose Tate-chu-yoko Settings from the Character panel menu or Control panel menu, choose Tate-
chu-yoko in the Tate-chu-yoko dialog box, and click OK.

If multiple instances of tate-chu-yoko appear next to each other, use the Non-joiner character to keep them
separate. Choose Type > Insert Special Character > Other > Non-joiner.

Remove tate-chu-yoko

1. Select the text to which you want to apply tate-chu-yoko.
2. Do one of the following:

Choose and cancel Tate-chu-yoko from the Character panel menu or Control panel menu.

Choose Tate-chu-yoko Settings from the Character panel menu, deselect Tate-chu-yoko in the Tate-
chu-yoko dialog box, and then click OK.

Change tate-chu-yoko settings

1. Choose Tate-chu-yoko Settings from the Character panel menu.
2. Specify a value for moving the text up or down in X Offset. If you specify a plus value, the text will move up,

and if you specify a minus value, it will move down.
3. Specify a value for moving the text left or right in Y Offset. If you specify a plus value, the text will move to

the right, and if you specify a minus value, it will move to the left.

Set Auto Tate-chu-yoko for specific paragraphs

1. Select the text to be set to Auto Tate-chu-yoko, or place the text insertion point in the paragraph.
2. Choose Auto Tate-chu-yoko from the Paragraph panel menu.
3. In KumiNumber, specify the number of successive half-width characters that you want to rotate to vertical

orientation. For example, if this is set to 2, the character string "123" will not rotate, while "12" will.
4. If you want to apply tate-chu-yoko to roman text, select Include Roman Characters, and click OK.

Add Ruby to text

In Japanese, Ruby (also known as furigana) is normally used to show the kanji yomi in hiragana. In Simplified
Chinese, Ruby is called Pinyin, while in Traditional Chinese, Ruby is called Chuyin. InDesign provides full support to
Japanese Ruby and limited support to Chinese Pinyin or Chuyin. You can adjust Ruby settings to specify Ruby
location, size, or color. Furthermore, when the ruby is longer than the parent you can specify the ruby distribution.
You can also apply tate-chu-yoko to Ruby.

Ruby on horizontal text (left), and ruby to the right of vertical text (right)

When the parent to which you want to attach ruby covers two lines, the ruby will follow when the parent moves to
the next line.



Note:

In some instances, such as when applying a style that includes a variable, Ruby characters may be removed.

1. Select the text to which you want to attach ruby. You cannot attach ruby when there are forced line breaks
in the selected text.

2. Select Ruby > Ruby from the Character panel menu or Control panel menu.
3. Enter the ruby characters in Ruby.
4. Change Ruby settings by clicking an option on the left side of the dialog box and specifying settings.
5. Click OK.

Ruby settings

The following options appear in the different panels of the Ruby dialog box.

Ruby Placement and Spacing

From the Type menu, choose Per-Character or Group Ruby. When Per Character Ruby is selected, enter a
half or full width space when inputting Ruby characters to separate them in line with their parent characters.
For "hakunetsutou" for example, enter as "haku netsu tou" (example of a word composed of Japanese
characters and its phonetic spelling is given).

Ruby

From the Alignment menu, specify the position of the Ruby characters. You can check the position with the
graphic shown in the sample field.

To attach ruby above horizontal text or to the right of vertical text, select Above/Right, and to attach below
horizontal text or to the left of vertical text, select Below/Left in Placement.

Specify the spacing between the ruby and the parent in XOffset and YOffset. When you enter a minus value,
the ruby moves closer to the parent.

Ruby Font and Size

Select a font family and font style in Font.

Specify the size of the ruby characters in Size. The default ruby size is half the size of the parent.

Specify the scale for the height and width of the ruby characters in Horizontal Scale and Vertical Scale.
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Select Use Open Type Pro Ruby Glyphs to use alternate glyphs for ruby (when possible). Specific kana
characters are available for some Open Type Pro fonts. When you select this option, the specific font for ruby
characters, and not the standard kana font, will be used.

In KumiNumber, specify the number of successive half-width characters that you want to rotate to vertical
orientation. For example, if this is set to 2, the character string "123" will not rotate, while "12" will.

Select Include Roman Characters to apply tate-chu-yoko to roman text.

Select Scale to Fit to force the tate-chu-yoko to have the same dimensions (1 em x 1 em) in the ruby string,
either using an OpenType feature or scaling the glyphs.

Adjustment When Ruby Is Longer Than Parent

With Overhang, when the total Ruby width is greater than that of their parent characters, the specified Ruby
will overflow widthways into the space above characters either side of the parents. For Japanese, character
types compatible with Overhang comply with the JISx4051-1995 specification.

Specify the parent character spacing necessary for attaching ruby in Spacing. When you select a different
option, the graphics displayed in the sample field are updated.

To automatically adjust the ruby character width, select Char Width Scaling, and specify the compression
scale for the width of the ruby characters.

Select Auto Align at Line Edges to align the parent with the start and end of the line.

Ruby Color

Select a color swatch in the list box.

Specify the degree of tinting and line weight, as necessary.

Select Overprint Fill or Overprint Stroke to set filling or stroke overprint for ruby characters.

(See Determining when to overprint manually.)

Apply kenten

Kenten (also known as Boten) are points which you attach to text you want to highlight. You can select the type of
points from existing kenten forms, or specify customized kenten characters. You can also specify the position,
scale, and color by adjusting the kenten settings.

Small black circle kenten, black sesame kenten, and small white circle kenten applied to text



Apply kenten

1. Choose the characters you want to highlight.
2. Choose a kenten character, such as Fisheye or White Circle, from Kenten in the Character panel menu or

Control panel menu.

Change kenten settings and color

1. Choose Kenten > Kenten from the Character panel menu or Control panel menu.
2. For Kenten Settings, specify the options below:

Kenten Type

Select a kenten character, such as Fisheye or White Circ le. Choose Custom to specify a custom character.
You can enter characters directly, or you can specify a character code value for the specified character set.

Position

Specify the spacing between the kenten and characters.

Location

Select Above/Right to attach kenten above horizontal text or to the right of vertical text, and Below/Left to
attach below horizontal text or to the left of vertical text.

Size

Specify the size of the kenten character.

Align

Specify whether the kenten should be displayed in the center (Center) or to the left (Left) (above for vertical
text) of the character's embox.

H/Scale and V/Scale

Specify the scale for the height and width of the kenten character.

3. To change the color of the kenten, choose Kenten Color from the list box, and then specify the options
below:

Select a color swatch from the list box.

Specify the degree of tinting and line weight, as necessary.

Select Overprint Fill or Overprint Stroke to set filling or stroke overprint for kenten characters.

(See Determining when to overprint manually.)

4. Click OK.
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You can specify how to align text to the largest characters in a line using the Character Alignment option, when
positioning characters of different sizes in 1 line. It is possible to align characters to the top, center or bottom of
the embox (right, center, and left for vertical frames), to the roman baseline, and to the top or bottom of the ICF
box (right or left for vertical frames). ICF (Ideographic Character Face) is the average height and width used by
the font designer to design the ideographic characters which comprise a font.

Align different sizes

A. Align different size letters above full space letters B. Align different size letters in the middle of full space letters C. Align different size
letters below full space letters 

Note:

The Character Alignment option is not effective, even if applied, when all characters are the same size in a line.

1. Select a range of text or lines for the characters you want to align, or select a text frame using the selection
tool.

2. Choose one of the following options from Character Alignment in the Character panel menu or Control panel
menu.

Roman Baseline aligns the small characters in a line to the large character baseline grid.

Embox Top/Right, Center, or Embox Bottom/Left align the small characters in a line to the specified
position of the large characters embox. In vertical text frames, Embox Top/Right aligns the text to the
right of the embox, and Embox Bottom/Left aligns the paragraph to the left of the embox.

ICF Top/Right and ICF Bottom/Left align the small characters in a line to the ICF specified by the large
characters. In vertical text frames, ICF Top/Right aligns the text to the right of the ICF, and ICF
Bottom/Left to the left of the ICF.

Adobe also recommends

Change the text direction
Align paragraphs to a baseline grid
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Création de texte curviligne
Modification ou suppression d’un texte curviligne
Ajustement de la position du texte curviligne
Application d’un effet à un texte curviligne
Ajout d’objets ancrés à un texte curviligne

Création de texte curviligne
Vous pouvez créer un texte qui suit le contour d’un tracé ouvert ou fermé de n’importe quelle forme. Vous pouvez appliquer des options et des
effets à un texte curviligne : faites-le glisser le long d’un tracé, créez une symétrie de chaque côté du tracé ou déformez les caractères selon la
forme du tracé. Un texte curviligne est doté d’un port d’entrée et de sortie comme les autres blocs de texte, vous permettant de créer des liens
depuis ou vers le texte.

Vous pouvez afficher une seule ligne de texte sur un tracé. Ainsi, tout texte ne tenant pas sur le tracé est en excès (masqué), sauf si vous l’avez
lié à un autre tracé ou bloc de texte. Vous pouvez ajouter des objets ancrés sur la ligne et au-dessus de la ligne à un texte curviligne. Il est
impossible de créer un texte curviligne à l’aide de tracés transparents, tels que ceux obtenus avec la commande Vectoriser.

Texte curviligne
A.  Equerre de début B.  Port d’entrée C.  Equerre centrale D.  Equerre de fin E.  Port de sortie indiquant du texte lié

1. Sélectionnez l’outil Texte curviligne  (cliquez sur l’outil Texte et maintenez le bouton de la souris enfoncé pour afficher un
menu contenant l’outil Texte curviligne).

2. Positionnez le pointeur sur le tracé jusqu’à ce qu’un petit signe plus apparaisse en regard du pointeur , puis effectuez les
opérations suivantes :

Pour insérer du texte en utilisant les paramètres par défaut, cliquez sur le tracé. Par défaut, un point d’insertion apparaît
au début du tracé. Si les paramètres de paragraphe par défaut actifs appliquent un retrait ou un alignement (autre que
l’alignement à gauche), le point d’insertion risque de s’afficher ailleurs qu’au début du tracé.

Pour limiter le texte à une portion spécifique du tracé, cliquez à l’endroit du tracé où vous souhaitez faire commencer le
texte, puis faites glisser le pointeur vers l’endroit où vous souhaitez arrêter le texte et relâchez la souris. Pour plus de
détails sur la modification des positions de début et de fin du texte, reportez-vous à la section Ajustement de la position du
texte curviligne.

Modification de l’emplacement du texte curviligne

Remarque : si vous n’obtenez aucun effet en cliquant ou en faisant glisser le pointeur de la souris, vérifiez que le petit
signe plus s’affiche à côté du pointeur de l’outil Texte curviligne lorsque vous effectuez ces opérations.

3. Saisissez votre texte. Si vous avez cliqué pour placer le point d’insertion sur le tracé, le texte s’affiche sur toute la longueur du
tracé. Si vous avez fait glisser le pointeur, le texte s’étale sur la longueur définie par le glissement du pointeur.
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Remarque : si le tracé était visible à l’origine, il le reste après l’ajout de texte. Pour masquer le tracé, sélectionnez-le à l’aide de l’outil Sélection ou
Sélection directe, puis définissez les valeurs de fond et de contour sur Sans.

Modification ou suppression d’un texte curviligne
Vous pouvez appliquer des options de caractère et de paragraphe à un texte curviligne. Toutefois, les options de filet et d’espacement des
paragraphes sont sans effet sur les textes curvilignes. Le paramètre d’alignement du panneau Paragraphe contrôle l’alignement du texte
curviligne.

Pour modifier et mettre en forme des caractères de texte curviligne
1. A l’aide de l’outil Texte curviligne, utilisez l’une des méthodes suivantes :

Pour ajouter un point d’insertion, cliquez entre deux caractères du texte curviligne.

Pour sélectionner des caractères, faites glisser le pointeur sur le texte curviligne.

2. Modifiez et mettez le texte en forme à votre gré.

Pour supprimer un texte curviligne
1. A l’aide de l’outil Sélection  ou Sélection directe , sélectionnez un ou plusieurs objets de texte curviligne.
2. Choisissez la commande Texte > Texte curviligne > Supprimer texte curviligne.

Si le texte curviligne est lié, il se déplace vers le bloc de texte ou l’objet de texte curviligne lié suivant. S’il n’est pas lié, le texte est supprimé. Le
tracé subsiste mais il perd tous ses attributs de texte curviligne (les équerres, les ports d’entrée et de sortie, ainsi que les liens sont supprimés).

Remarque : si le fond et le contour du tracé sont définis sur Sans, le tracé est invisible après la suppression du texte. Pour le faire apparaître,
appuyez sur la touche D immédiatement après avoir choisi la commande Texte > Texte curviligne > Supprimer texte curviligne. Cela permet
d’appliquer le fond et le contour par défaut au tracé sélectionné.

Pour diminuer l’espacement des caractères disposés autour d’arrondis et d’angles aigus
1. A l’aide de l’outil Sélection ou Texte, sélectionnez le texte curviligne.
2. Choisissez la commande Texte > Texte curviligne > Options ou cliquez deux fois sur l’outil Texte curviligne.
3. Entrez une valeur en points pour l’option Espacement. Des valeurs élevées permettent de supprimer davantage d’espace

entre les caractères disposés le long de courbes et d’angles aigus.

Texte curviligne avant réglage de l’espacement (à gauche) et après réglage de l’espacement (à droite)

Remarque : la valeur Espacement compense la manière dont les caractères se déploient autour d’une courbe ou d’un angle aigu. Elle est sans
effet sur les caractères placés le long de segments droits. Pour modifier l’espacement des caractères sur le tracé, sélectionnez-les et appliquez-
leur un crénage ou une approche.

Ajustement de la position du texte curviligne
Vous pouvez modifier la position de début et de fin d’un texte curviligne, le faire glisser et le modifier de plusieurs façons.

Pour modifier la position de début et de fin du texte curviligne
1. A l’aide de l’outil Sélection , sélectionnez le texte curviligne.
2. Placez le pointeur au-dessus de l’équerre de début ou de fin du texte curviligne jusqu’à ce qu’une petite icône apparaisse en

regard du pointeur . Ne le positionnez pas sur le port d’entrée ou de sortie de l’équerre.
Effectuez un zoom avant pour sélectionner plus facilement l’équerre.

3. Faites glisser l’équerre de début ou de fin le long du tracé.
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Placez le pointeur sur l’équerre de début ou de fin, puis faites glisser la souris pour repositionner le cadre du texte curviligne.

Remarque : si vous appliquez une valeur de retrait de paragraphe, celle-ci est mesurée d’après ses équerres de début et de fin.

Pour faire glisser un texte le long d’un tracé
1. A l’aide de l’outil Sélection , sélectionnez le texte curviligne.
2. Placez le pointeur au-dessus de l’équerre centrale du texte curviligne jusqu’à ce qu’une icône d’équerre centrale apparaisse

en regard du pointeur .
Effectuez un zoom avant pour sélectionner plus facilement l’équerre.

3. Faites glisser l’équerre centrale le long du tracé.

Remarque : le texte ne se déplace pas lorsque les équerres de début et de fin se trouvent aux extrémités du tracé. Pour agrandir l’espace et faire
glisser le texte, déplacez les équerres de début ou de fin au-delà des extrémités du tracé.

Pour rendre un texte curviligne symétrique
1. A l’aide de l’outil Sélection , sélectionnez le texte curviligne.
2. Placez le pointeur au-dessus de l’équerre centrale du texte jusqu’à ce qu’une icône d’équerre centrale apparaisse en regard

du pointeur .
3. Faites glisser l’équerre centrale le long du tracé.

Placez le pointeur sur l’équerre centrale, puis faites-le glisser le long du tracé pour rendre le texte symétrique.

Vous pouvez également rendre un texte curviligne symétrique par le biais d’une boîte de dialogue. A l’aide de l’outil Sélection
ou Texte, sélectionnez le texte curviligne. Choisissez Texte > Texte curviligne > Options. Sélectionnez l’option Symétrie, puis
cliquez sur OK.

Application d’un effet à un texte curviligne
1. A l’aide de l’outil Sélection ou Texte, sélectionnez le texte curviligne.
2. Choisissez la commande Texte > Texte curviligne > Options ou cliquez deux fois sur l’outil Texte curviligne.
3. Choisissez l’une des options suivantes dans le menu Effet, puis cliquez sur OK :

Pour que le centre de la ligne de base de chaque caractère reste parallèle à la tangente du tracé, choisissez Arc-en-ciel. Il
s’agit du paramètre par défaut.
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Effets de texte curviligne
A.  Effet Arc-en-ciel B.  Effet Inclinaison C.  Effet Ruban 3D D.  Effet Marche d’escalier E.  Effet Gravité

Pour que les bords verticaux des caractères restent parfaitement verticaux quelle que soit la forme du tracé, tout en
laissant les bords horizontaux s’incliner pour suivre le tracé, choisissez Inclinaison. La déformation horizontale obtenue est
utile pour les textes qui suivent des vagues ou tournent autour d’un cylindre, comme dans le cas d’une étiquette de
bouteille.

Pour que les bords horizontaux des caractères restent parfaitement horizontaux quelle que soit la forme du tracé, tout en
maintenant le bord vertical de chaque caractère perpendiculaire au tracé, choisissez Ruban 3D.

Pour conserver le bord gauche de la ligne de base de chaque caractère sur le tracé sans faire pivoter les caractères,
choisissez Marche d’escalier.

Pour conserver le centre de la ligne de base de chaque caractère sur le tracé tout en préservant l’alignement de chaque
bord vertical sur le point central du tracé, choisissez Gravité. Pour contrôler l’effet de perspective de cette option, vous
pouvez régler la courbure appliquée au tracé du texte.

Ajout d’objets ancrés à un texte curviligne
1. A l’aide de l’outil Texte ou Texte curviligne, cliquez pour ajouter un point d’insertion à l’endroit du texte où vous souhaitez faire

apparaître l’ancrage de l’objet.
2. Ajoutez l’objet ancré. Vous pouvez ajouter des objets ancrés sur la ligne ou au-dessus de la ligne, mais aussi des blocs au

tracé (voir la section Objets ancrés).

Remarque : les options disponibles pour les objets ancrés au-dessus de la ligne dans un tracé diffèrent légèrement des options d’objets ancrés
dans un bloc de texte habituel : l’option Alignement est relative au marqueur d’objet ancré et l’option Espace avant n’est pas disponible.
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Récupérateur de contenu

Importation de contenu

Créer un lien

Faire correspondre les styles

Outils Récupérateur de contenu
Importer et lier
Spécifier les options de lien
Règle de correspondance de style personnalisée
Mettre à jour un élément lié

La réplication de contenus d’une page à l’autre n’est pas chose simple, sans compter que les manipulations de contenu par copier-coller sont
souvent fastidieuses et prennent un temps considérable. Servez-vous des fonctions de contenu lié pour gérer plusieurs versions de contenu. Vous
pouvez importer et lier le contenu dans un même document ou même dans différents documents. Le contenu lié simplifie la prise en charge des
nouveaux flux de production, qui supposent notamment d’élaborer des mises en page verticale et horizontale. Le contenu lié se prête tout aussi
bien aux flux de production de l’univers traditionnel de l’impression et de la publication, qui nécessitent de synchroniser du texte standard sur
plusieurs pages ou documents.

Le comportement du contenu lié est similaire à celui des liens traditionnels. Voir Présentation du panneau Liens pour en avoir un aperçu. Vous
pouvez désigner un objet en tant que parent, puis placer l’objet à d’autres emplacements en tant qu’objets enfants. A chaque mise à jour de l’objet
parent, les objets enfants sont signalés, ce qui vous permet de les mettre à jour et ainsi de les synchroniser avec l’objet parent.

Vous pouvez importer et lier des objets à l’aide des outils Récupérateur de contenu, ou en choisissant la commande de menu Edition > Importer et
lier.

L’icône  apparaît dans l’angle supérieur gauche d’un objet lié. L’élément apparaît sous forme d’objet lié dans le panneau Liens.

Outils Récupérateur de contenu
Les outils Récupérateur de contenu et Importation de contenu permettent de dupliquer des éléments de la page et de les importer dans des
documents InDesign ouverts. A mesure que le contenu est collecté, il est affiché dans le Transporteur de contenu. Utilisez le Transporteur de
contenu pour importer et lier facilement et rapidement plusieurs éléments de la page au sein de documents ouverts et entre eux.

Cliquez sur  dans le panneau Outils pour ouvrir le Récupérateur de contenu.

Utilisez l’outil Récupérateur de contenu  pour sélectionner un objet et l’ajouter au Transporteur de contenu

Utilisez l’outil Importation de contenu pour importer les objets de page sur une page

Appuyez sur B pour permuter entre l’outil Récupérateur de contenu et l’outil Importation de contenu.

 
Transporteur de contenu 
A. Outil Récupérateur de contenu B. Outil Importation de contenu C. Créer un lien D. Faire correspondre les styles E. Modifier la règle de
correspondance de style personnalisée F. Options d’importation G. Parcourir H. Collecter tous les blocs liés I. Charger le Transporteur de contenu 

Servez-vous de l’outil Récupérateur de contenu pour ajouter des éléments de page au Transporteur de contenu.

Servez-vous de l’outil Importation de contenu pour transférer les éléments du Transporteur de contenu vers le
document. Lorsque vous sélectionnez cet outil, l’élément actuel est ajouté au pistolet de placement.

Activez Créer un lien pour lier l’élément importé à l’emplacement d’origine de l’élément collecté. Vous pouvez gérer les liens à
partir du panneau Liens.

Faites correspondre les styles de paragraphe, de caractère, de tableau ou de cellule entre l’original et les

http://help.adobe.com/fr_FR/indesign/cs/using/WSA6A5201D-B07C-475f-A8F5-EE1774695851a.html


Modifier la règle de correspondance de style personnalisée

Options d’importation

Parcourir

Récupérer tous les blocs liés

Charger le transporteur
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éléments importés. Par défaut, la correspondance se base sur les noms de style. Voir la section Règle de correspondance de style personnalisée.

Définissez une règle de correspondance de style personnalisée entre les
éléments originaux et les éléments importés. Mettez les styles en correspondance pour remplacer automatiquement les styles d’origine
dans l’élément importé.

Définissez les options du Transporteur de contenu lors de l’importation des éléments.

Supprimez des éléments du Transporteur de contenu après leur importation.
Importez plusieurs fois l’élément actuel. L’élément reste chargé dans le pistolet de placement.
Importez l’élément et passez à l’élément suivant. L’élément est conservé dans le Transporteur de contenu.

Parcourez les éléments figurant dans le Transporteur de contenu.

Activez cette option pour récupérer tous les blocs liés. L’article et tous les blocs sont collectés. Si cette option est
désactivée, l’article est collecté dans un seul bloc.

Cliquez sur  pour charger le transporteur avec des éléments.
Sélection : utilisez cette option pour charger tous les éléments sélectionnés

Pages : utilisez cette option pour charger tous les éléments figurant sur les pages spécifiées
Tous : utilisez cette option pour charger les articles provenant de toutes les pages et de la table de montage

Activez l’option Créer un seul jeu pour regrouper tous les éléments dans un seul et même jeu.

Vous pouvez collecter les éléments de page indépendamment les uns des autres ou sous forme de « jeux ». Dans certains cas, InDesign crée
automatiquement des jeux pour préserver l’intégrité relationnelle des éléments de page.

Voici plusieurs méthodes (manuelles et automatiques) pour collecter les éléments sous forme de jeux :

Sélectionnez les éléments voulus à l’aide du rectangle de sélection.
Utilisez l’option Charger le transporteur, puis sélectionnez la plage de pages, l’intégralité du document ou les éléments
sélectionnés pour regrouper les éléments en question par jeu.
Récupérez un élément avec un contenu associé tel qu’une partie d’un bouton interactif à laquelle sont associés d’autres
éléments et états, de façon à réunir tous les éléments associés dans un même jeu (ce jeu sera toujours déposé dans un même
geste).
Récupérez une zone de texte contenant du texte lié s’étendant sur d’autres objets et cochez la case permettant de rassembler
tous les blocs de texte liés dans le Transporteur de contenu de façon à former un jeu à partir de l’ensemble des zones de texte
liées.

Importer et lier

1. Sélectionnez un élément de page, soit en sélectionnant le bloc, soit en plaçant le curseur d’insertion dans le texte. Vous
pouvez également sélectionner plusieurs éléments à l’aide de la combinaison Maj + clic.

2. Choisissez Edition> Importer et lier. Cela a pour effet de charger le curseur avec les éléments et d’afficher les éléments dans
le Transporteur de contenu.

3. Cliquez sur une page ou tracez un bloc pour y importer l’élément lié.

Spécifier les options de lien

1. Dans le panneau Liens, sélectionnez l’élément lié.

2. Dans le menu du panneau Liens, choisissez Options de lien.



Mettre à jour le lien lors de l’enregistrement du document

Avertir si la mise à jour des liens remplace les modifications locales

Conserver les modifications locales à la mise à jour des liens d’objet

Supprimer les sauts de ligne forcés de l’article

Définir la règle de correspondance de style personnalisée

En haut

 

Appuyez sur la touche Alt (Windows) ou Option (Mac OS) pour remplacer le bouton Annuler par Réinitialiser. Cliquez sur
le bouton Réinitialiser pour rétablir les options par défaut.

3. Sélectionnez les options qui vous conviennent :

Activez cette option pour mettre à jour le lien au moment de
l’enregistrement du document.

Activez cette option pour afficher un message
d’avertissement si la mise à jour du lien a pour effet de remplacer les modifications locales apportées à l’objet lié.

Sélectionnez les catégories qui vous intéressent
pour conserver les modifications locales lors de la mise à jour des liens.

Activez cette option pour supprimer les sauts de ligne forcés dans l’article.
La suppression des sauts de ligne permet une redistribution fluide du texte dans le cadre lié en cas de changement de
dimension ou de mise en page.

Activez cette option si vous souhaitez faire correspondre les
styles et appliquer automatiquement un autre style au contenu lié. Voir la section Règle de correspondance de style
personnalisée.

Pour définir les options de lien par défaut, fermez tous les documents ouverts, ouvrez le menu du panneau Liens, puis choisissez Options de
lien.

Règle de correspondance de style personnalisée

Catégorie Exemples

Aspect

Attributs de style des objets, tels que Contour, Fond et Effets. Les attributs relatifs au
texte ou au bloc de texte (comme la surimpression, les paramètres autres que ceux
destinés à l’impression, etc.) sont exclus.

Taille et
forme

Hauteur, largeur, transformations, attributs de bloc de texte et autres attributs de taille
de colonne. 

Interactivité Animation, états d’objet, actions de bouton.

Contenu
du bloc

Image, vidéo, contenu importé ou collé dans des blocs, effets et paramètres appliqués
directement à ces objets.

Autres

Attributs ne faisant pas partie des autres catégories, tels que l’habillage de texte pour
les images, les options d’exportation d’objet ; attributs de bloc de texte tels que les
options de ligne de base, les options de dimensionnement automatique, la justification
verticale et ainsi de suite.
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Les styles de texte (paragraphe, caractère, tableau, cellule) ou les groupes de styles peuvent être mappés à différents styles pendant la création
de liens. Au lieu d’appliquer les styles d’origine au parent, ce sont les styles mappés qui sont automatiquement appliqués au contenu lié. La
correspondance de style personnalisée est pratique, par exemple, lorsque vous souhaitez substituer des polices sans empattement aux polices
numériques et à empattement dans les publications à imprimer. Cela permet également d’adapter le style de texte lorsque vous passez d’une mise
en page horizontale à une mise en page verticale.

Pour définir la correspondance de style personnalisée, effectuez l’une des opérations suivantes :

Dans la boîte de dialogue Options de lien (panneau Liens > Options de lien), activez l’option Définir la règle de
correspondance de style personnalisée, puis cliquez sur Paramètres.

Cliquez sur  dans le Transporteur de contenu.

 
Règle de correspondance de style personnalisée

1. Sélectionnez un document source et un type de style. 
2. Cliquez sur Nouvelle correspondance de style.
3. Choisissez les styles source et mappés ou les groupes de styles dans la liste.

Appuyez sur la touche Alt (Windows) ou Option (Mac OS) pour remplacer le bouton Annuler par Réinitialiser. Cliquez sur le bouton Réinitialiser
pour rétablir les options par défaut.

Mettre à jour un élément lié
En cas de modification d’un élément d’origine, le symbole  s’affiche sur l’image et dans le panneau Liens. Pour procédez à la mise à jour,
effectuez l’une des opérations suivantes :

Cliquez sur  dans la partie supérieure gauche de l’image.
Dans le panneau Liens, cliquez deux fois sur le symbole .

Si vous avez apporté des modifications locales à un élément enfant, celles-ci sont remplacées par le contenu de l’élément original. Si vous avez
sélectionné l’option Avertir si la mise à jour des liens remplace les modifications locales, un message d’avertissement s’affiche.

A l’aide du volet Informations sur les liens, déterminez si vous avez apporté des modifications locales à l’article ; le cas échéant, l’article affiche
l’état « Texte modifié ».
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Vérification orthographique et dictionnaires de langue
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Vérification de l’orthographe
Césure et dictionnaires

Vérification de l’orthographe

Vous pouvez vérifier l’orthographe dans une plage de texte sélectionnée, dans tout le texte d’un article, dans tous les articles d’un document ou
dans tous les articles de tous les documents ouverts. L’application met en surbrillance les mots mal orthographiés ou inconnus, les doublons (mots
entrés deux fois de suite, par exemple « le le ») et les mots qui comportent potentiellement des erreurs de casse. Outre la vérification de
l’orthographe d’un document, vous pouvez également activer la vérification dynamique de l’orthographe, qui consiste à souligner les mots
potentiellement mal orthographiés au fur et à mesure de la saisie du texte.

Lorsque vous vérifiez l’orthographe du texte, le dictionnaire correspondant aux langues que vous avez attribuées au texte de votre document est
utilisé. Vous pouvez ajouter rapidement des mots au dictionnaire.

Définition des préférences orthographiques

1. Choisissez Edition > Préférences > Orthographe (Windows) ou InDesign > Préférences > Orthographe (Mac OS).

2. Utilisez l’une des méthodes suivantes :

Sélectionnez Mots mal orthographiés pour rechercher les termes non répertoriés dans le dictionnaire de langue.

Sélectionnez Mots répétés pour rechercher des doublons tels que « le le ».

Sélectionnez Mots en minuscule pour rechercher les mots (comme « allemagne ») qui sont répertoriés dans le dictionnaire
avec une majuscule (« Allemagne »).

Sélectionnez Phrases en minuscule pour rechercher les mots sans majuscule après un point, un point d’exclamation ou
un point d’interrogation.

3. Sélectionnez Activer la vérification orthographique dynamique pour souligner les mots potentiellement mal orthographiés à
mesure que vous tapez.

4. Spécifiez la couleur à utiliser pour souligner les mots mal orthographiés (mots non trouvés dans les dictionnaires personnels),
les doublons (« le le », par exemple), les mots sans majuscule (« nigeria » au lieu de « Nigeria », par exemple) et les phrases
qui ne commencent pas par une majuscule.

Vérification de l’orthographe

1. Si votre document contient du texte en langue étrangère, sélectionnez le texte et utilisez le menu Langue du
panneau Caractère pour spécifier la langue du texte.

2. Choisissez Edition > Orthographe > Orthographe.

La vérification orthographique commence.

3. Si vous souhaitez modifier l’étendue de la vérification orthographique, utilisez l’une des méthodes suivantes, puis cliquez
sur Commencer pour lancer la vérification orthographique :

Sélectionnez Document pour vérifier l’ensemble du document.Sélectionnez Tous les documents pour vérifier tous les
documents ouverts.

Sélectionnez Article pour vérifier tout le texte du bloc sélectionné, y compris le texte des blocs de texte liés et le texte en
excès. Sélectionnez Articles pour vérifier les articles de tous les blocs sélectionnés.

Sélectionnez Jusqu’à la fin de l’article pour vérifier l’orthographe à partir du point d’insertion.



Sélectionnez Sélection pour ne vérifier que le texte sélectionné. Cette option n’est disponible que si du texte est
sélectionné.

4. Lorsqu’un mot inconnu ou mal orthographié ou d’autres erreurs éventuelles s’affichent, choisissez l’une des options
suivantes :

Cliquez sur Ignorer pour poursuivre la vérification sans changer le mot surligné. Cliquez sur Tout ignorer pour ignorer
toutes les occurrences du mot mis en surbrillance jusqu’au redémarrage d’InDesign.

Sélectionnez un mot dans la liste Orthographes proposées ou entrez le mot approprié dans le champ Remplacer par, puis
cliquez sur Remplacer pour ne modifier que cette occurrence du mot incorrectement orthographié. Vous pouvez
également cliquer sur Tout remplacer pour remplacer toutes les occurrences de ce mot dans le document.

Pour ajouter un mot à un dictionnaire, sélectionnez le dictionnaire dans le menu Ajouter à, puis cliquez sur Ajouter.

Cliquez sur Dictionnaire pour afficher la boîte de dialogue Dictionnaire, spécifiez un dictionnaire et une langue, puis
définissez les césures du mot ajouté. Si vous voulez ajouter ce mot dans toutes les langues, choisissez la commande
Toutes les langues dans le menu Langue. Cliquez sur Ajouter.

Correction des fautes d’orthographe lors de la saisie

Si la fonction de correction automatique est activée, les erreurs de majuscule et les fautes d’orthographe courantes sont corrigées au fur et à
mesure que vous saisissez le texte. Pour pouvoir utiliser la fonction de correction automatique, vous devez au préalable créer une liste de mots
couramment mal orthographiés et les associer à l’orthographe correcte.

1. Choisissez Edition > Préférences > Correction automatique (Windows) ou InDesign > Préférences > Correction automatique
(Mac OS).

2. Choisissez Activer la correction automatique Vous pouvez également activer rapidement cette fonction en choisissant
Edition > Orthographe > Correction automatique.

3. Dans le menu Langue, choisissez la langue à laquelle la correction automatique sera appliquée.

4. Pour corriger les erreurs de casse (par exemple si vous saisissez « allemagne » à la place de « Allemagne »), sélectionnez
Correction automatique des erreurs de casse. Il n’est pas nécessaire d’entrer les mots en capitales dans la liste de corrections
automatiques.

5. Pour ajouter un mot que vous avez tendance à mal orthographier, cliquez sur Ajouter, entrez le mot mal orthographié (par
exemple « el »), entrez le mot corrigé (« le »), puis cliquez sur OK.

6. Une fois tous les mots souvent mal orthographiés saisis, cliquez sur OK.

Lorsque vous saisissez un mot mal orthographié que vous avez ajouté à la liste, le mot est automatiquement remplacé par la correction
correspondant que vous avez entrée.

Pour supprimer des mots que vous avez ajoutés à la liste de corrections automatiques, sélectionnez-les, puis cliquez sur le bouton Supprimer.
Pour modifier des mots de la liste de corrections automatiques, sélectionnez-les, cliquez sur le bouton Modifier, effectuez les corrections
nécessaires, puis cliquez sur le bouton OK.

Vérification orthographique dynamique

Lorsque la fonction de vérification orthographique dynamique est activée, vous pouvez corriger les fautes d’orthographe et de frappe en utilisant le
menu contextuel. Les mots potentiellement mal orthographiés sont soulignés (selon le dictionnaire associé à la langue du texte). Si vous entrez du
texte dans une langue différente, sélectionnez le texte et définissez la langue correspondante.

1. Pour activer la vérification orthographique dynamique, choisissez Edition > Orthographe > Vérification orthographique
dynamique.

Les mots potentiellement mal orthographiés sont soulignés dans votre document.

2. Cliquez sur le mot souligné avec le bouton droit de la souris (Windows) ou tout en maintenant la touche Contrôle enfoncée
(Mac OS), puis utilisez l’une des méthodes suivantes :

Sélectionnez une orthographe proposée. Si un mot est répété ou doit être en capitales, choisissez l’option Supprimer le
mot répété [mot] ou Composer en capitales [mot].



Remarque :
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Remarque :

Sélectionnez Ajouter [mot] au dictionnaire personnel. Le mot est ajouté automatiquement au dictionnaire sans que la boîte
de dialogue Dictionnaire ne s’ouvre. Le mot reste inchangé dans le texte.

Sélectionnez Dictionnaire pour ouvrir la boîte de dialogue Dictionnaire. Sélectionnez le dictionnaire cible, changez les
césures et spécifiez la langue. Si vous voulez ajouter ce mot dans toutes les langues, choisissez la commande Toutes les
langues dans le menu Langue, puis cliquez sur le bouton Ajouter. Le mot est ajouté au dictionnaire et reste inchangé dans
le texte.

Sélectionnez Tout ignorer pour ignorer les occurrences de ce mot dans tous les documents. Lorsque vous redémarrez
InDesign, le mot est à nouveau indiqué comme mal orthographié.

si vous sélectionnez l’option Tout ignorer puis que vous changez d’avis et décidez que vous ne souhaitez pas ignorer ce mot,
choisissez l’option Mots ignorés dans le menu Listes du dictionnaire de la boîte de dialogue Dictionnaire et supprimez le mot de la liste.

Césure et dictionnaires

InDesign utilise les dictionnaires Proximity pour la plupart des langues pour vérifier l’orthographe et la césure des mots. Vous pouvez ajouter des
mots à chaque dictionnaire pour le personnaliser. Vous pouvez assigner différentes langues au texte. InDesign utilise ensuite le dictionnaire
adéquat pour vérifier l’orthographe et la césure des mots. Vous pouvez créer des dictionnaires personnels supplémentaires, puis les importer ou
les exporter sous forme de listes de mots enregistrées dans un fichier de texte brut.

Lorsque vous personnalisez les mots d’un dictionnaire, vous créez des listes de mots ajoutés (mots ne figurant pas encore dans le dictionnaire) et
de mots supprimés (mots figurant dans le dictionnaire que vous souhaitez voir indiqués comme potentiellement mal orthographiés). La boîte de
dialogue Dictionnaire permet d’afficher et de modifier les mots ajoutés, les mots supprimés et les mots ignorés (mots qui sont ignorés pour la
session en cours parce que vous avez cliqué sur Tout ignorer). Vous pouvez ajouter des mots s’appliquant à toutes les langues. Cette possibilité
est très utile dans le cas de noms de famille, noms de rues et autres éléments non spécifiques à une langue donnée.

Si vous souhaitez utiliser les dictionnaires de langue d’une version précédente d’InDesign ou d’InCopy, utilisez la commande Rechercher pour
localiser les fichiers de dictionnaire personnel (.idc), puis ajoutez-les à la liste de dictionnaires dans les préférences Dictionnaire.

Emplacement d’enregistrement des mots de dictionnaires

Par défaut, les exceptions de césure et d’orthographe sont entrées dans des fichiers de dictionnaire personnel stockés hors du document, sur
l’ordinateur sur lequel InDesign est installé (les noms de fichier des dictionnaires se terminent par l’extension .clam ou .not). Toutefois, vous
pouvez choisir de stocker les listes d’exceptions dans les documents InDesign. Vous pouvez également stocker les listes de mots dans un
dictionnaire utilisateur externe, dans le document, ou encore dans les deux. L’emplacement des dictionnaires existants apparaît dans les
préférences Dictionnaire.

Le stockage des exceptions de césure et d’orthographe dans un document permet de faciliter la conservation de la composition de texte lors du
transfert du document vers d’autres ordinateurs. Pour cette raison, vous pouvez fusionner le dictionnaire utilisateur avec le document dans les
préférences Dictionnaire. Vous pouvez également choisir l’emplacement des exceptions dans la boîte de dialogue Créer dossier Assemblage (voir
Assemblage de fichiers). En revanche, le stockage d’une liste d’exceptions hors du document facilite l’utilisation de la même liste pour plusieurs
documents.

si le dictionnaire personnel est fusionné dans la liste des exceptions, le dictionnaire personnel entier est ajouté au document, même
si les mots ne sont pas utilisés, ce qui accroît par conséquent la taille du fichier du document.

Application de langues au texte

Utilisez le menu Langue du panneau Caractère pour appliquer une langue au texte sélectionné. Vous pouvez également spécifier une langue par
défaut pour un document entier ou pour tous les nouveaux documents. InDesign comporte également une fonction de verrouillage de la langue
qui permet d’empêcher de changer les paramètres de langue des textes en langue asiatique lorsqu’ils font partie d’une sélection et qu’une langue
non asiatique est sélectionnée dans le menu Langue (voir Affectation d’une langue à un texte).

Listes d’exceptions

Vous pouvez exclure certains termes. Ainsi, si vous souhaitez utiliser une orthographe différente pour un nom commun tel que « bicyclette » (pour
un document spécifique ou parce que c’est le nom de votre société, par exemple), ajoutez le mot à la liste des mots exclus afin qu’il soit soumis
lors d’une vérification orthographique. InDesign peut conserver un ensemble indépendant de mots ajoutés et supprimés pour chaque langue

http://idiom-q-win-1/fr/indesign/using/preflighting-files-handoff.html#package_files
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installée.

Création ou ajout de dictionnaires personnels

Vous pouvez créer un dictionnaire personnel ou en ajouter à partir de versions précédentes d’InDesign ou d’InCopy, de fichiers envoyés par
d’autres personnes ou d’un serveur sur lequel le dictionnaire personnel du groupe de travail est stocké. Le dictionnaire que vous ajoutez est utilisé
pour tous les documents InDesign.

1. Choisissez Edition > Préférences > Dictionnaire (Windows) ou InDesign > Préférences > Dictionnaire (Mac OS).

2. Dans le menu Langue, choisissez la langue à associer au dictionnaire.

3. Utilisez l’une des méthodes suivantes :

Pour créer un nouveau dictionnaire, cliquez sur l’icône Nouveau dictionnaire personnel  sous le menu Langue. Spécifiez
le nom et l’emplacement du dictionnaire personnel (avec l’extension .udc), puis cliquez sur Enregistrer.

Pour ajouter un dictionnaire existant, cliquez sur l’icône Ajouter un dictionnaire personnel , sélectionnez le fichier du
dictionnaire personnel, qui porte l’extension .udc ou .not, puis cliquez sur Ouvrir.

si vous ne trouvez pas le fichier de dictionnaire, utilisez la commande Rechercher du système pour rechercher les fichiers .udc
(entrez *.udc), notez l’emplacement, puis réessayez.

Le dictionnaire est ajouté à la liste du menu Langue. Vous pouvez ajouter des mots au dictionnaire pendant la vérification de l’orthographe ou en
faisant appel à la boîte de dialogue Dictionnaire.

Définition du dictionnaire de langue par défaut pour le document ouvert

Vous pouvez modifier le dictionnaire de langue par défaut pour un document ou pour tous les documents que vous créez. Le changement de
dictionnaire par défaut dans un document existant n’affecte pas le texte qui a déjà été créé, ni le texte que vous saisissez dans un bloc de texte
existant.

Utilisez le panneau Styles de caractère ou Styles de paragraphe pour définir un dictionnaire spécifique pour un style spécifique. Le
menu Langue apparaît dans la section Formats de caractères avancés.

1. Ouvrez le document.

2. Sélectionnez l’outil Sélection dans la barre d’outils et assurez-vous qu’aucun élément n’est sélectionné dans le document.

3. Sélectionnez Texte > Caractère.

4. Choisissez le dictionnaire souhaité dans le menu Langue du panneau  Caractère. Si l’option Langue n’apparaît pas dans le
panneau Caractère, sélectionnez Afficher les options, puis sélectionnez votre langue dans la liste.

Définition du dictionnaire de langue par défaut pour tous les nouveaux documents

1. Démarrez InDesign, mais n’ouvrez pas de document.

2. Sélectionnez Texte > Caractère.

3. Choisissez le dictionnaire souhaité dans le menu déroulant Langue du panneau Caractère. Si l’option Langue n’apparaît pas
dans le panneau Caractère, sélectionnez Afficher les options, puis sélectionnez votre langue dans la liste.

Suppression, réédition de lien et réorganisation de dictionnaires

1. Choisissez Edition > Préférences > Dictionnaire (Windows) ou InDesign > Préférences > Dictionnaire (Mac OS).

2. Dans le menu Langue, choisissez la langue du dictionnaire.

3. Utilisez l’une des méthodes suivantes :

Pour supprimer un dictionnaire de la liste, sélectionnez-le et cliquez sur l’icône Supprimer le dictionnaire personnel .
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Vous devez disposer d’au moins un dictionnaire par langue.

Si un point d’interrogation figure en regard du dictionnaire, sélectionnez le dictionnaire, cliquez sur l’icône Rééditer le lien
vers le dictionnaire personnel , puis recherchez le dictionnaire personnel et ouvrez-le.

Changez l’ordre des dictionnaires personnels par glisser-déposer. L’ordre des dictionnaires dans la liste correspond à
l’ordre dans lequel les dictionnaires sont consultés.

Ajout de mots aux dictionnaires

Si, lors de la vérification orthographique, InDesign affiche un mot inconnu dans la boîte de dialogue Orthographe, sélectionnez le dictionnaire dans
le menu Ajouter à, puis cliquez sur Ajouter. Vous pouvez aussi faire appel à la boîte de dialogue Dictionnaire pour spécifier le dictionnaire et la
langue cible et pour préciser la façon dont les mots sont ajoutés à la liste des exceptions.

1. Choisissez Edition > Orthographe > Dictionnaire.

2. Dans le menu Langue, choisissez une langue. Chaque langue contient au moins un dictionnaire. Si vous voulez ajouter ce
mot dans toutes les langues, choisissez la commande Toutes les langues.

3. Dans le menu Cible, choisissez le dictionnaire où stocker le mot. Le menu Cible permet de stocker les modifications apportées
à un dictionnaire personnel externe ou à un document ouvert.

4. Dans le menu Listes du dictionnaire, choisissez Mots ajoutés.

5. Dans la zone Mot, saisissez ou modifiez le mot à ajouter à la liste.

6. Cliquez sur Césure pour afficher la césure par défaut du mot. Les tildes (~) indiquent les points de césure possibles.

7. Si le choix ne vous satisfait pas, utilisez les instructions suivantes pour indiquer la césure à privilégier pour ce mot :

Entrez un tilde (~) pour indiquer le point de césure le plus approprié pour ce mot.

Si un autre point de césure est envisageable, entrez deux tildes (~~) pour indiquer ce second point.

Entrez trois tildes (~~~) pour indiquer un point de césure peu approprié mais acceptable.

Si vous voulez que le mot ne soit jamais coupé, entrez un tilde avant sa première lettre.

Si vous avez besoin d’inclure le signe tilde dans un mot, insérez une barre oblique inverse avant le tilde (\~).

8. Cliquez sur Ajouter, puis sur Terminer. Le mot est ajouté aux listes du dictionnaire sélectionnées.

n’oubliez pas que les points de césure interfèrent avec les paramètres de césure de vos documents. En conséquence, le mot risque
de ne pas être coupé là où vous l’attendiez. Pour contrôler ces paramètres, choisissez Césure dans le menu du panneau Paragraphe (voir Césure
de texte).

Suppression ou modification de mots des dictionnaires

1. Choisissez Edition > Orthographe > Dictionnaire.

2. Dans le menu Langue, choisissez une langue.

3. Dans le menu Cible, choisissez le dictionnaire dans lequel vous voulez supprimer le mot. Le menu Cible vous permet de
choisir le dictionnaire personnel externe ou un document ouvert.

4. Dans le menu Listes du dictionnaire, utilisez l’une des méthodes suivantes :

Pour modifier la liste des mots ajoutés à la liste de mots cible sélectionnée, choisissez Mots ajoutés.

Pour modifier la liste des mots indiqués comme mal orthographiés, choisissez Mots supprimés.

Pour modifier la liste des mots ignorés lors de la session en cours d’InDesign, choisissez Mots ignorés. Cette liste
comprend tous les mots pour lesquels vous avez choisi Tout ignorer.

5. Dans la liste de mots, modifiez le mot, ou sélectionnez-le et cliquez sur Supprimer.

6. Cliquez sur Terminer.

Exportation d’une liste de mots
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Vous pouvez exporter une liste de mots dans un fichier texte (.txt), puis importer cette liste dans un dictionnaire personnel d’InDesign. Les mots
contenus dans le fichier texte doivent être séparés par une espace, une tabulation ou un saut de paragraphe. Vous pouvez exporter des mots
ajoutés et des mots supprimés, mais vous ne pouvez pas exporter des mots ignorés, qui sont utilisés uniquement dans la session en cours.

1. Choisissez Edition > Orthographe > Dictionnaire.

2. Choisissez la langue dans le menu Langue, puis, dans le menu Cible, choisissez le dictionnaire contenant la liste de mots à
exporter.

3. Cliquez sur Exporter, entrez le nom du fichier et son emplacement, puis cliquez sur Enregistrer.

La liste de mots est enregistrée dans un fichier texte. Vous pouvez modifier la liste de mots dans un éditeur de texte, puis l’importer. Vous pouvez
également envoyer la liste de mots à d’autres personnes, qui peuvent l’importer dans leurs dictionnaires personnels.

Importation d’une liste de mots

1. Choisissez Edition > Orthographe > Dictionnaire.

2. Choisissez la langue dans le menu Langue et le dictionnaire dans le menu Cible.

3. Cliquez sur Importer, recherchez le fichier texte contenant la liste des exceptions, puis cliquez sur Ouvrir.

Modification des préférences de dictionnaire

Utilisez les préférences Dictionnaire pour définir comment InDesign doit gérer les dictionnaires et la césure. La plupart des langues d’InDesign
utilisent des dictionnaires Proximity pour vérifier l’orthographe et la césure des mots. Si vous avez installé des composants orthographiques ou de
césure d’une autre société, vous pouvez sélectionner un fournisseur différent pour chaque langue installée.

la boîte de dialogue des préférences de dictionnaire ne vous permet pas de spécifier le dictionnaire de langue utilisé pour vérifier
l’orthographe et la césure des mots. Cette boîte de dialogue est utilisée pour spécifier quels modules externes de césure et d’orthographe
InDesign utilise pour la langue spécifiée dans le champ Langue. Si vous utilisez uniquement le module externe de césure et d’orthographe par
défaut, vous n’avez pas besoin de modifier les paramètres dans la boîte de dialogue des préférences de dictionnaire. Si vous installez un module
externe d’orthographe et de césure différent et fourni par un éditeur tiers, celui-ci apparaît sous forme d’option des menus Césure et Orthographe
de cette boîte de dialogue. Vous êtes ainsi libre de sélectionner un moteur d’orthographe ou de césure de mots pour certaines langues et un autre
pour les autres langues.

1. Choisissez Edition > Préférences > Dictionnaire (Windows) ou InDesign > Préférences > Dictionnaire (Mac OS).

2. Pour Langue, spécifiez la langue dont vous voulez modifier les paramètres ou modifier le fournisseur de césure ou
d’orthographe.

3. Créez, ajoutez ou supprimez des dictionnaires personnels (voir Création ou ajout de dictionnaires).

4. Si vous disposez d’un composant de césure provenant d’une société autre qu’Adobe, vous pouvez le sélectionner dans le
menu Césure.

5. Si vous disposez d’un dictionnaire orthographique provenant d’une société autre qu’Adobe, vous pouvez le sélectionner dans
le menu Orthographe.

6. Dans le menu Composer avec du menu Exceptions de césure, utilisez l’une des méthodes suivantes :

Pour composer le texte à l’aide de la liste des exceptions de césure stockée dans le dictionnaire personnel externe,
choisissez Dictionnaire personnel.

Pour composer le texte à l’aide de la liste des exceptions de césure stockée dans le document, choisissez Document.

Pour composer le texte à l’aide des deux listes, choisissez l’option Dictionnaire personnel et document. Il s’agit du
paramètre par défaut.

7. Pour ajouter la liste des exceptions stockée dans le dictionnaire personnel externe à celle des exceptions stockée dans le
document, sélectionnez Fusionner le dictionnaire personnel avec le document.

si vous travaillez avec de nombreux partenaires ou clients, vous pouvez désélectionner l’option Fusionner le
dictionnaire personnel avec le document. Par exemple, si vous êtes un prestataire de services, vous préférez sans doute
éviter de fusionner votre dictionnaire personnel avec le fichier de tous vos clients.
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8. Pour recomposer tous les articles lorsque certains paramètres sont modifiés, sélectionnez Recomposer tous les articles après
modification. Cette option permet de recomposer les articles lorsque vous modifiez l’option Composer avec (voir l’étape 6) ou
lorsque vous utilisez la commande Dictionnaire pour ajouter ou supprimer des mots. La durée de cette opération dépend de la
quantité de texte du document.

9. Cliquez sur le bouton OK.

Utilisation de dictionnaires dans un groupe de travail

Assurez-vous que, pour chaque station de votre groupe de travail, les mêmes dictionnaires personnels sont installés et ajoutés afin qu’un
document utilise les mêmes règles orthographiques et de césure quel que soit l’utilisateur. Vous pouvez faire en sorte que tout le monde ajoute
les mêmes dictionnaires à leur ordinateur, ou bien partager un dictionnaire personnel sur le serveur de réseau.

Une icône de verrou  indique qu’un dictionnaire est verrouillé et qu’il peut être utilisé, mais pas modifié. Lorsqu’un dictionnaire personnel est
stocké sur un serveur, le premier utilisateur à charger le dictionnaire verrouille le fichier. Les autres utilisateurs peuvent voir que le dictionnaire est
verrouillé. Les fichiers peuvent également être verrouillés à l’aide du système d’exploitation en les déclarant en lecture seule. Si vous partagez un
dictionnaire personnel sur un serveur de réseau, vous pouvez verrouiller le fichier de sorte que les utilisateurs puissent le consulter en lecture
seule tout en permettant à l’administrateur d’ajouter des mots.

Vérifiez que chaque personne du groupe de travail utilise le dictionnaire utilisateur personnalisé installé sur sa station de travail, et non le
dictionnaire stocké dans un document. Toutefois, avant de livrer un document à un prestataire de services, il peut être préférable de fusionner le
dictionnaire utilisateur avec le document

Si vous ne partagez pas de dictionnaire utilisateur personnalisé sur une station de travail réseau partagée, localisez et copiez les fichiers de votre
dictionnaire personnel d’une station de travail à une autre. L’emplacement des dictionnaires utilisateur apparaît dans les préférences Dictionnaire.

Une fois que vous avez ajouté un dictionnaire personnel à une station de travail partagée, les modifications apparaissent sur les stations de
travail individuelles après qu’un utilisateur a redémarré InDesign ou appuyé sur les touches Ctrl+Alt+/ (Windows) ou Commande+Option+/
(Mac OS) pour recomposer tout le texte.

Adobe recommande également

http://creativecommons.org/licenses/by-nc-sa/3.0/
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Colonnes à largeur modifiable
Options d’ajustement du bloc de texte persistantes

Colonnes à largeur modifiable

L’option Largeur modifiable permet d’ajuster le nombre et la largeur des colonnes au fur et à mesure que le bloc de texte est redimensionné. Les
colonnes sont automatiquement ajoutées ou supprimées lorsque la largeur maximale d’une colonne est atteinte lors du redimensionnement du bloc
de texte.

A. Bloc de texte d’origine B. Elargissement du bloc de texte C. Ajout d’une colonne dans la zone de texte 

Choisissez Largeur modifiable dans la liste déroulante Colonnes qui s’affiche dans la boîte de dialogue Options de bloc de texte
(Objet > Options de bloc de texte)

Colonnes à largeur modifiable

Options d’ajustement du bloc de texte persistantes

Les options de dimensionnement automatique du bloc de texte permettent de configurer un bloc de texte de manière à le redimensionner
automatiquement lorsque vous ajoutez, supprimez ou modifiez le texte. Pour accéder aux options de dimensionnement automatique, procédez
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comme suit :

1. Sélectionnez un bloc de texte, puis cliquez sur Objet > Options de bloc de texte.

2. Cliquez sur Dimensionnement automatique.

Options de dimensionnement automatique

3. Sélectionnez une option de dimensionnement automatique à appliquer lors de l’ajout ou de la suppression de texte :

Désactivé
Hauteur seulement
Largeur seulement
Hauteur et largeur
Hauteur et largeur (conserver les proportions)

4. Depuis le proxy de point d’ancrage, cliquez sur un emplacement de référence à utiliser pour le redimensionnement. Le proxy
de point d’ancrage sert également au redimensionnement du bloc de texte.

5. Spécifiez les valeurs des contraintes de hauteur et de largeur minimales, et les sauts de ligne.

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr


Ajout de texte dans les blocs

Haut de la page

Ajout de texte à un document
Collage de texte
Glisser-déposer de texte
Importation de texte
Importation de documents Buzzword
Liaison ou incorporation de fichiers texte importés

Ajout de texte à un document
Pour ajouter du texte dans un document, saisissez le texte ou importez-le à partir d’une application de traitement de texte. Si l’application de
traitement de texte source prend en charge le glisser-déposer, vous pouvez également faire glisser le texte dans les blocs InDesign. Pour de
grandes quantités de texte, la commande Importer constitue le meilleur moyen d’ajouter du texte à votre document. InDesign prend en charge
divers formats de fichiers de traitement de texte, de feuilles de calcul et de fichiers texte.

Lorsque vous importez ou collez du texte, InDesign crée automatiquement un bloc de texte. Il est donc inutile d’en créer un au préalable.

Lorsque vous importez du texte, vous pouvez sélectionner Afficher les options d’importation pour déterminer si le texte importé conservera les
styles et la mise en forme. Avant de coller du texte, vous pouvez activer l’option Toutes les informations ou Texte seul dans les préférences
Gestion du presse-papiers pour indiquer si le texte collé doit comprendre des informations supplémentaires, telles que nuances ou styles.

Si le texte importé contient du rose, du vert ou une autre couleur de mise en surbrillance, plusieurs options de préférences de composition sont
probablement activées. Ouvrez la section Composition de la boîte de dialogue Préférences pour savoir quelles options sont activées dans la
zone Sélecteur. Par exemple, si le texte collé contient des polices de caractères non disponibles, le texte est mis en surbrillance rose.

Saisie de texte dans un document
1. Pour placer le point d’insertion à l’intérieur du bloc de texte, utilisez l’une des méthodes suivantes :

A l’aide de l’outil Texte , faites glisser le pointeur pour délimiter un nouveau bloc de texte ou cliquez à l’intérieur d’un
bloc de texte existant.

A l’aide d’un outil de sélection, cliquez deux fois à l’intérieur d’un bloc de texte. L’outil Texte est automatiquement
sélectionné.

2. Saisissez le texte.

Si vous avez créé un bloc de texte sur un gabarit, cliquez dans le bloc de la page du document tout en maintenant les touches Ctrl+Maj
(Windows) ou Commande+Maj (Mac OS) enfoncées. Le bloc du gabarit est alors copié dans la page du document. Vous pouvez ensuite utiliser
l’outil Texte pour ajouter du texte dans le bloc sélectionné.

Saisie de caractères asiatiques par insertion des objets texte
1. Choisissez Edition > Préférences > Texte avancé (Windows) ou InDesign > Préférences > Texte avancé (Mac OS).
2. Sélectionnez l’option Utiliser l’insertion des objets texte pour le texte non latin, puis cliquez sur OK.

Le cas échéant, utilisez la méthode d’insertion du système pour ajouter des caractères à 2 ou 4 octets. Cette méthode est particulièrement
conseillée pour saisir des caractères asiatiques.

Insertion d’un texte de substitution
InDesign vous permet d’ajouter un texte de substitution, pour ensuite facilement le remplacer par le texte définitif. Le texte de substitution permet
de mieux visualiser la conception du document.

1. Sélectionnez un ou plusieurs blocs de texte à l’aide de l’outil Sélection, ou cliquez dans un bloc de texte avec l’outil Texte.
2. Choisissez Texte > Remplir avec le texte de substitution.

Si vous ajoutez un texte de substitution à un bloc lié, le texte de substitution est ajouté au début du premier bloc de texte (si tous les blocs sont
vides) ou à la fin du texte existant (si les blocs de texte liés contiennent déjà du texte) jusqu’au dernier bloc lié.

Pour supprimer ou remplacer le texte de substitution, cliquez deux fois dans l’un des blocs liés, choisissez Edition > Tout sélectionner, puis
supprimez le texte.

Pour modifier le texte de substitution, créez un fichier texte contenant le texte à utiliser, nommez-le Substitution.txt, puis enregistrez-le dans le
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dossier de l’application.

Collage de texte
Si le point d’insertion ne se situe pas dans un bloc de texte lorsque vous collez du texte dans InDesign, un nouveau bloc de texte simple est créé.
Si le point d’insertion se trouve à l’intérieur d’un bloc de texte, le texte est collé dans ce bloc. Si du texte est sélectionné au moment où vous collez
le texte, ce dernier écrase le texte sélectionné.

Collage de texte depuis une autre application
1. Pour préserver la mise en forme et les informations telles que les styles et les marques d’index, dans la section Gestion du

presse-papiers de la boîte de dialogue Préférences, sélectionnez l’option Toutes les informations dans la section Coller. Pour
supprimer ces informations et d’autres attributs de mise en forme lors du collage, activez l’option Texte seul.

2. Coupez ou collez le texte dans une autre application ou dans un document InDesign.
3. Le texte sera collé dans un nouveau bloc, sauf si vous sélectionnez le texte ou cliquez dans un bloc de texte.
4. Utilisez l’une des méthodes suivantes :

Choisissez Edition > Coller. Si la mise en forme n’a pas été entièrement conservée, modifiez les paramètres de la boîte de
dialogue d’options d’importation des documents RTF.

Choisissez Edition > Coller sans mise en forme. Si l’option Texte seul est sélectionnée dans les préférences Gestion du
presse-papiers, l’option Coller sans mise en forme est grisée lorsque vous collez du texte à partir d’une autre application.

Vous pouvez également faire glisser le texte depuis une autre application et le déposer dans un document InDesign, ou bien insérer un fichier
texte ou un fichier de traitement de texte dans un document InDesign directement à partir de l’Explorateur Windows ou du Finder Mac OS. Le
texte sera inséré dans un nouveau bloc. Lorsque vous faites glisser du texte tout en maintenant la touche Maj enfoncée, la mise en forme est
supprimée. L’option sélectionnée dans la section Gestion du presse-papiers de la boîte de dialogue Préférences détermine si les informations
telles que les marques d’index et les nuances sont préservées.

Ajustement automatique de l’espacement lors du collage de texte
Lorsque vous collez du texte, des espaces peuvent être ajoutées ou supprimées automatiquement selon le contexte. Par exemple, si vous collez
entre deux mots un mot que vous avez coupé, une espace s’insère avant et après le mot. Par contre, si vous collez le mot en fin de phrase, juste
avant le point, aucune espace n’est insérée.

1. Choisissez Edition > Préférences > Texte (Windows) ou InDesign > Préférences > Texte (Mac OS).
2. Sélectionnez l’option Ajuster l’espacement automatiquement lors du copier/coller de mots, puis cliquez sur OK.

Glisser-déposer de texte
Vous pouvez utiliser la souris pour faire glisser et déposer le texte dans la fenêtre du mode éditeur ou en mode Mise en page. Vous pouvez
même faire glisser du texte à partir du mode éditeur dans la fenêtre de mise en page (ou vice versa) ou dans certaines boîtes de dialogue telles
que Rechercher/Remplacer. Si vous faites glisser du texte à partir d’un article verrouillé ou archivé, le texte est copié et non déplacé. Vous pouvez
également copier le texte ou créer un bloc lorsque vous faites glisser et déposez le texte.

Jeff Witchel propose un didacticiel vidéo consacré à la méthode du glisser-déposer sous le titre Using InDesign Drag and Drop Text.

1. Pour activer la fonction de glisser-déposer, choisissez Edition > Préférences > Texte (Windows) ou InDesign > Préférences >
Texte (Mac OS), sélectionnez l’option Activer en mode Mise en page, Activer en mode éditeur (InDesign) ou Activer en mode
éditeur et épreuve en placard (InCopy), puis cliquez sur le bouton OK.

2. Sélectionnez le texte à déplacer ou copier.

3. Maintenez le pointeur de la souris sur le texte sélectionné jusqu’à ce que l’icône de glisser-déposer  s’affiche, puis faites
glisser le texte.

Lorsque vous faites glisser le texte, celui-ci reste à sa position initiale, mais une barre verticale indique l’emplacement auquel
il sera inséré lorsque vous relâcherez le bouton de la souris. La barre verticale apparaît dans tous les blocs sur lesquels vous
faites glisser le curseur.

4. Utilisez l’une des méthodes suivantes :

Pour déposer le texte à un nouvel emplacement, positionnez la barre verticale à l’endroit où vous souhaitez que le texte
apparaisse et relâchez le bouton de la souris.

Pour déposer le texte dans un nouveau bloc, commencez à faire glisser le texte, maintenez la touche Ctrl (Windows)
ou Commande (Mac OS) enfoncée, puis relâchez le bouton de la souris avant de relâcher la touche.

Pour déposer le texte sans mise en forme, commencez à faire glisser le texte, maintenez la touche Maj enfoncée, puis
relâchez le bouton de la souris avant de relâcher la touche.

Pour copier le texte, commencez à faire glisser le texte, maintenez la touche Alt (Windows) ou Option (Mac OS) enfoncée,
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puis relâchez le bouton de la souris avant de relâcher la touche.

Vous pouvez également combiner ces touches de modification. Par exemple, pour copier du texte non mis en forme dans un nouveau bloc,
commencez à faire glisser le texte et maintenez les touches Alt+Maj+Ctrl (Windows) ou Option+Maj+Commande (Mac OS) enfoncées.

Si l’espacement du texte disposé est incorrect, sélectionnez l’option Ajuster l’espacement automatiquement dans les préférences de texte.

Importation de texte
Lorsque vous importez un fichier texte ou une feuille de calcul, certaines options vous permettent de définir la mise en forme du texte importé.

Pour consulter un didacticiel vidéo sur l’importation de contenu dans InDesign, rendez-vous à l’adresse www.adobe.com/go/vid0067. Pour
consulter un didacticiel vidéo sur l’importation et le placement de texte, rendez-vous à l’adresse www.adobe.com/go/lrvid4278_id_fr.

1. (Facultatif) Pour créer des liens vers les fichiers importés, cliquez sur la commande Gestion des fichiers dans la boîte de
dialogue Préférences, puis activez l’option Créer des liens avec les fichiers de texte et de feuilles de calcul importés.

Cette option, lorsqu’elle est sélectionnée, permet de créer un lien vers le fichier importé. Vous pouvez mettre à jour, supprimer
ou rétablir des liens depuis le panneau Liens vers des fichiers texte. Toutefois, si vous mettez en forme du texte lié dans
InDesign, il peut ne pas conserver sa mise en forme lorsque vous mettez à jour le lien. Lorsque cette option est désactivée,
les fichiers texte ou feuilles de calcul importés sont incorporés et non liés.

2. Utilisez l’une des méthodes suivantes :

Pour créer un bloc de texte cible, assurez-vous qu’aucun point d’insertion n’est présent et qu’aucun texte ni bloc n’est
sélectionné.

Pour ajouter du texte à un bloc, sélectionnez l’outil Texte  et sélectionnez le texte, ou positionnez le point d’insertion à
l’endroit désiré.

Pour remplacer le contenu d’un bloc existant, sélectionnez un outil de sélection, puis sélectionnez le bloc. Si le bloc est lié,
une icône de texte chargé s’affiche.

Si vous remplacez un fichier texte ou un graphique par mégarde, choisissez Edition > Annuler Remplacer, puis cliquez
ou faites glisser le pointeur pour créer un bloc de texte.

3. Choisissez Fichier > Importer.
4. Sélectionnez l’option Remplacer l’élément sélectionné si vous souhaitez que le fichier importé remplace le contenu d’un bloc

sélectionné, le texte sélectionné, ou qu’il soit ajouté au bloc de texte au niveau du point d’insertion. Désélectionnez cette
option pour placer le fichier importé dans le nouveau bloc.

5. Sélectionnez Afficher les options d’importation et cliquez deux fois sur le fichier à importer.
6. Définissez les options d’importation et cliquez sur OK.

Si vous n’avez pas désigné le bloc qui contiendra le texte, le pointeur se transforme en icône de texte chargé, prêt à placer le texte là où vous
cliquerez ou ferez glisser le curseur.

Si un message vous avertit que le filtre requis est introuvable, vérifiez que vous n’essayez pas d’importer un fichier d’une application de traitement
de texte différente ou d’une version antérieure de Microsoft®Word, comme Word 6. Ouvrez le fichier dans son application d’origine et enregistrez-
le au format RTF, qui conserve la plupart de la mise en forme.

Si des points rouges s’affichent dans les cellules du document Excel importé, ajustez la taille des cellules ou les attributs de texte de manière à
rendre visible le contenu en excès. Vous pouvez également importer le fichier en tant que texte tabulé non mis en forme, puis le convertir en
tableau.

A propos des filtres d’importation
InDesign importe la plupart des attributs de mise en forme de paragraphe et de caractère provenant de fichiers texte, mais l’application ignore la
plupart des informations de mise en page, telles que les marges et les paramètres de colonne (que vous pouvez définir dans InDesign). Tenez
compte des points suivants :

InDesign importe en général toutes les informations de mise en forme spécifiées dans l’application de traitement de texte, à
l’exception des informations spécifiques à des fonctions qui ne sont pas disponibles dans InDesign.

InDesign peut ajouter des styles importés à sa liste de styles pour le document. Une icône de disquette  s’affiche en regard
des styles importés (voir la section Conversion des styles Word en styles InDesign).

Les options d’importation s’affichent lorsque vous sélectionnez Importer > Afficher les options d’importation ou lorsque vous
importez un fichier Excel. Si l’option Afficher les options d’importation est désélectionnée, InDesign choisit les dernières
options d’importation utilisées pour un document de type similaire. Les options que vous définissez restent en vigueur jusqu’à
ce que vous les modifiiez.

Si InDesign ne trouve pas de filtre permettant de reconnaître le fichier d’après son type de fichier ou par son extension, un
message vous en avertit. Pour obtenir de meilleurs résultats sous Windows, utilisez l’extension standard (telle que .doc, .docx,
.txt, .rtf, .xls ou .xlsx) correspondant au type de fichier à importer. Vous devrez peut-être ouvrir le fichier dans son application
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d’origine et l’enregistrer sous un autre format, tel que .rtf ou .txt.

Pour plus de détails sur les filtres d’importation, reportez-vous au fichier PDF LisezMoi disponible à l’adresse :
www.adobe.com/go/lr_indesignfilters_cs5_fr.

Options d’importation Microsoft Word et RTF
Si vous sélectionnez l’option Afficher les options d’importation lors de l’importation d’un fichier Word ou RTF, vous disposez des options
suivantes :

Texte de table des matières Importe la table des matières comme partie intégrante du texte dans l’article. Ces entrées sont importées au format
Texte seulement.
Texte d’index Importe l’index comme partie intégrante du texte dans l’article. Ces entrées sont importées au format Texte seulement.
Notes de bas de page Importe des notes de bas de page Word. Les notes de bas de page et les références sont conservées, mais
renumérotées en fonction des paramètres définis pour les notes de bas de page du document. Si le résultat de l’importation ne vous satisfait pas,
essayez d’enregistrer le document Word au format RTF avant de l’importer.
Notes de fin de page Importe les notes de fin de page comme partie intégrante du texte à la fin de l’article.
Utiliser les guillemets typographiques Garantit que le texte importé comprend les guillemets ouvrant et fermant (“ ”) et les apostrophes (’)
anglais au lieu des guillemets (" ") et apostrophes (') droits.
Supprimer les styles et la mise en forme du texte et des tableaux Supprime la mise en forme telle que le style de caractère, la couleur et le
style de texte, du texte importé, y compris dans les tableaux. Les styles de paragraphe et les images texte ne sont pas importés si cette option est
sélectionnée.
Conserver les remplacements locaux Lorsque vous choisissez de supprimer les styles et la mise en forme du texte et des tableaux, vous
pouvez sélectionner l’option Conserver les remplacements locaux pour conserver la mise en forme des caractères (par exemple, le gras ou
l’italique) appliquée à une partie d’un paragraphe. Désélectionnez cette option si vous souhaitez supprimer toute la mise en forme.
Convertir les tableaux en Lorsque vous choisissez de supprimer les styles et la mise en forme du texte et des tableaux, vous pouvez convertir
les tableaux soit en tableaux basiques sans mise en forme, soit en texte brut délimité par des tabulations.
Si vous souhaitez importer du texte non mis en forme et des tableaux mis en forme, importez le texte sans mise en forme, puis collez les tableaux
de Word dans InDesign.

Conserver les styles et la mise en forme du texte et des tableaux Conserve la mise en forme des documents Word dans le
document InDesign ou InCopy. Vous pouvez utiliser les autres options de la section Mise en forme pour déterminer la façon dont les styles et la
mise en forme sont conservés.
Sauts de page manuels Détermine la mise en forme des sauts de page du fichier Word dans InDesign ou InCopy. Sélectionnez
l’option Conserver les sauts de pages pour utiliser les sauts de page de Word ou sélectionnez l’option Convertir en sauts de colonnes ou
Aucune césure.
Importer les images texte Conserve les images texte du document Word dans InDesign.
Importer les styles inutilisés Importe tous les styles du document Word, même si les styles ne sont pas appliqués au texte.
Convertir les puces et numéros en texte Importe les puces et les numéros sous forme de vrais caractères, en préservant l’apparence du
paragraphe. Toutefois, dans les listes numérotées, les numéros ne sont pas mis à jour automatiquement lorsque les éléments de la liste sont
modifiés.
Suivi des modifications Si vous sélectionnez cette option, des balises de suivi des modifications du document Word apparaîtront dans le
document InDesign. Dans InDesign, vous pouvez afficher le suivi des modifications en mode Editeur.
Importer les styles automatiquement Importe les styles à partir du document Word dans le document InDesign ou InCopy. Si un triangle jaune
apparaît en regard de Conflits de noms de styles, cela signifie qu’un ou plusieurs styles de paragraphe ou de caractère ont le même nom qu’un
style InDesign.
Pour déterminer la façon dont les conflits sont gérés, sélectionnez une option dans le menu Conflits de styles de paragraphes et Conflits de styles
de caractères. Si vous choisissez l’option Utiliser la définition du style InDesign, le texte du style importé est mis en forme avec le style InDesign.
Si vous choisissez l’option Redéfinir le style InDesign, le texte du style importé est mis en forme en utilisant le style de Word, et le texte InDesign
existant formaté avec le style Word est modifié. Si vous choisissez Renommer automatiquement, les styles Word importés sont renommés. Par
exemple, si InDesign et Word ont tous deux un style nommé Sous-titre, le style Word importé est renommé Sous-titre_wrd_1 si l’option Renommer
automatiquement est sélectionnée.

Remarque : InDesign convertit les styles de paragraphe et de caractère, pas les styles de listes à puces et numérotées.
Personnaliser l’importation des styles Permet d’utiliser la boîte de dialogue Correspondance de style pour sélectionner le style InDesign à
utiliser pour chaque style Word dans le document importé.
Enreg. prédéfini Stocke les options d’importation de Word actives pour une utilisation ultérieure. Spécifiez les options d’importation, cliquez
sur Enreg. prédéfini, saisissez un nom, puis cliquez sur OK. La prochaine fois que vous importerez un style Word, vous pourrez sélectionner
l’enregistrement prédéfini créé dans le menu Style prédéfini. Cliquez sur Utiliser par défaut pour utiliser le style prédéfini sélectionné comme style
par défaut pour les importations futures de documents Word.

Options d’importation de fichier texte
Si vous sélectionnez l’option Afficher les options d’importation lors de l’importation d’un fichier texte, vous disposez des options suivantes :

Jeu de caractères Spécifie le jeu de caractères du langage de l’ordinateur, par exemple ANSI, Unicode UTF8 ou Windows CE, utilisé pour créer
le fichier texte. La sélection par défaut est le jeu de caractère correspondant à la langue et à la plate-forme par défaut d’InDesign ou InCopy.
Plate-forme Indique si le fichier a été créé sous Windows ou Mac OS.
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Définir le dictionnaire sur Indique le dictionnaire à utiliser pour le texte importé.
Retours chariot supplémentaires Indique la méthode d’importation des retours chariot supplémentaires utilisée. Sélectionnez l’option Supprimer
en fin de ligne ou Supprimer entre les paragraphes.
Remplacer Remplace le nombre d’espaces spécifié par une tabulation.
Utiliser les guillemets typographiques Garantit que le texte importé comprend les guillemets ouvrant et fermant (“ ”) et les apostrophes (’)
anglais au lieu des guillemets (" ") et apostrophes (') droits.

Options d’importation pour Microsoft Excel
Sélectionnez l’une des options suivantes lors de l’importation d’un fichier Excel :

Feuille Indique la feuille de calcul à importer.
Affichage Indique si vous voulez importer des affichages personnels ou personnalisés stockés ou ignorer les affichages.
Plage de cellules Indique la plage de cellules, en utilisant le signe deux-points (:) pour désigner la plage (telle que A1:G15). S’il existe des plages
nommées dans la feuille de calcul, ces noms apparaissent dans le menu Plage de cellules.
Importer les cellules masquées non enregistrées dans cette vue Importe les cellules définies comme cellules masquées dans la feuille de
calcul Excel.
Tableau Définit l’affichage des informations de la feuille de calcul dans le document.
Tableau mis en forme  InDesign essaie de préserver la même mise en forme utilisée dans Excel, même si la mise en forme du texte dans
chaque cellule risque de ne pas être conservée. Si la feuille de calcul est liée plutôt qu’incorporée, la mise à jour du lien prendra le pas sur toute
mise en forme appliquée au tableau dans InDesign.
Tableau non mis en forme  Le tableau est importé sans conserver aucune mise en forme de la feuille de calcul. Lorsque cette option est
sélectionnée, vous pouvez appliquer un style de tableau au tableau importé. Si vous mettez en forme du texte en utilisant des styles de
paragraphe et de caractère, la mise en forme est préservée, même si vous mettez à jour le lien à la feuille de calcul.
Texte tabulé non mis en forme  Le tableau est importé sous forme de texte tabulé que vous pouvez ensuite convertir en tableau dans InDesign
ou InCopy.
Mis en forme une seule fois  InDesign préserve la même mise en forme utilisée dans Excel lors de l’importation initiale. Si la feuille de calcul est
liée et non incorporée, les modifications de la mise en forme du tableau lié sont ignorées lorsque le lien est mis à jour. Cette option n’est pas
disponible dans InCopy.
Style de tableau Applique le style de tableau que vous spécifiez au document importé. Cette option n’est disponible que si l’option Tableau non
mis en forme est sélectionnée.
Alignement des cellules Indique l’alignement des cellules pour le document importé.
Inclure les images texte Conserve les images texte du document Excel dans InDesign.
Nombre de décimales à inclure Indique le nombre de décimales présentes dans les chiffres de la feuille de calcul.
Utiliser les guillemets typographiques Garantit que le texte importé comprend les guillemets ouvrant et fermant (“ ”) et les apostrophes (’)
anglais au lieu des guillemets (" ") et apostrophes (') droits.

Options d’importation de texte référencé
Vous pouvez importer (ou exporter) un fichier texte pouvant bénéficier des capacités de mise en forme InDesign en utilisant le format de texte
référencé. Les fichiers texte référencé sont des fichiers au format texte seulement contenant des informations qui décrivent la mise en forme à
appliquer dans InDesign. Du texte correctement référencé peut décrire presque tous les éléments pouvant apparaître dans un article InDesign, y
compris tous les attributs de niveau de paragraphe ou de caractère et tous les caractères spéciaux.

Pour plus de détails sur la définition de balises, consultez le fichier PDF relatif au texte référencé à l’adresse suivante :
www.adobe.com/go/learn_id_taggedtext_cs5_fr (PDF).

Les options suivantes sont disponibles lors de l’importation d’un fichier texte référencé si vous avez sélectionné l’option Afficher les options
d’importation dans la boîte de dialogue Importer.

Utiliser les guillemets typographiques Garantit que le texte importé comprend les guillemets ouvrant et fermant (“ ”) et les apostrophes (’)
anglais au lieu des guillemets (" ") et apostrophes (') droits.
Supprimer la mise en forme du texte Supprime la mise en forme telle que le style de caractère, la couleur et le style de texte, du texte importé.
Résoudre les conflits de style de texte avec Indique quel style de paragraphe ou de caractère est appliqué lorsque les styles du fichier texte
référencé et de votre document InDesign sont en conflit. Sélectionnez l’option Définition de la composition pour utiliser la définition préexistante
pour ce style dans le document InDesign. Sélectionnez Définition du fichier balisé pour utiliser le style défini dans le texte référencé.
Afficher la liste des références de problèmes avant l’importation Affiche une liste des références non reconnues. Si une liste apparaît, vous
pouvez choisir d’annuler ou de poursuivre l’importation. Si vous continuez, le fichier importé risque de présenter un aspect inattendu.

Enregistrement des options d’importation Word ou RTF en tant que paramètres prédéfinis
1. Lorsque vous importez un fichier Word ou RTF, assurez-vous d’activer l’option Afficher les options d’importation, puis

choisissez Ouvrir.
2. Dans la boîte de dialogue Options d’importation, définissez les paramètres souhaités.
3. Cliquez sur Enreg. prédéfini, saisissez un nom, puis cliquez sur OK.
4. (Facultatif) Cliquez sur Utiliser par défaut pour appliquer ce paramètre prédéfini à chaque importation d’un fichier de ce type.

Vous pouvez ensuite sélectionner des paramètres prédéfinis dans le menu Style prédéfini de la boîte de dialogue Options d’importation chaque
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fois que vous ouvrez un fichier Word ou RTF.

Importation de documents Buzzword
Buzzword est un éditeur de texte en ligne qui permet aux utilisateurs de créer et de stocker des fichiers texte sur un serveur Web. InDesign CS5
permet d’importer et d’exporter du texte à partir de documents Buzzword.

Lorsque vous importez un document Buzzword, un lien de type adresse URL pointant vers le document Buzzword stocké sur le serveur est créé.
Lorsque le document Buzzword est mis à jour en dehors d’InDesign, vous pouvez actualiser la version importée dans InDesign au moyen du
panneau Liens. Cette opération entraînera néanmoins la suppression des modifications que vous avez apportées au texte Buzzword dans
InDesign.

Remarque : l’application Buzzword d’Acrobat.com est actuellement disponible en allemand, anglais et français.

1. Choisissez la commande Fichier > Importer de Buzzword.

2. Si vous n’êtes pas déjà connecté à CS Live, cliquez sur Inscription, indiquez votre adresse électronique et votre mot de
passe, puis cliquez de nouveau sur Inscription.

Une fois la connexion établie, la boîte de dialogue Importer des documents Buzzword affiche une liste des documents
Buzzword que vous pouvez importer.

3. Sélectionnez les documents Buzzword à importer. Vous pouvez également coller l’adresse URL du document voulu dans le
champ prévu à cet effet.

4. Sélectionnez les options suivantes selon les besoins, puis cliquez sur le bouton OK.

Afficher les options d’importation Si vous sélectionnez cette option, la boîte de dialogue Options d’importation Buzzword
s’affiche avant l’importation du fichier.

Remplacer l’élément sélectionné Sélectionnez cette option pour remplacer l’objet actuellement sélectionné dans le
document.

Lien vers le document Sélectionnez cette option pour créer un lien entre le document Buzzword et le texte importé. Ainsi,
toute mise à jour du document Buzzword est signalée dans le panneau Liens. Si vous actualisez le lien, le texte importé dans
InDesign est mis à jour. Cette opération entraîne néanmoins la suppression des modifications que vous avez apportées à la
mise en forme du texte dans InDesign.

5. Si vous avez sélectionné l’option Afficher les options d’importation, définissez les paramètres voulus dans la boîte de dialogue
Options d’importation Buzzword.

Cette boîte de dialogue propose des options pour la plupart identiques à celles de la boîte de dialogue Options
d’importation RTF (voir la section Options d’importation Microsoft Word et RTF). Aucune fonction de style n’est actuellement
disponible dans Buzzword ; les options de style ne sont donc pas valides pour l’instant.

6. Cliquez sur l’icône de texte chargé ou faites-la glisser pour créer un bloc de texte.

Liaison ou incorporation de fichiers texte importés
Par défaut, le texte que vous importez dans InDesign n’est pas lié au fichier texte d’origine. Toutefois, si avant d’importer un fichier, vous
sélectionnez l’option Créer des liens avec les fichiers de texte et de feuilles de calcul importés dans les préférences Gestion des fichiers, le nom
du fichier texte apparaît dans le panneau Liens. Vous pouvez utiliser le panneau Liens pour mettre à jour et gérer le fichier. Lorsque vous mettez à
jour un fichier texte lié, toute modification de mise en forme ou d’édition appliquée dans InDesign est perdue. En raison de ce risque, les fichiers
texte liés ne sont pas automatiquement mis à jour lorsque le fichier original est modifié. Vous pouvez cependant mettre à jour le contenu d’un
fichier ou rompre son lien (l’incorporer) en toute simplicité au moyen du panneau Liens.

1. Utilisez l’une des méthodes suivantes :

Pour appliquer ce changement à un document, ouvrez le document.

Pour appliquer ce changement à tout nouveau document que vous créez, fermez tous les documents.

2. Choisissez Edition > Préférences > Gestion des fichiers (Windows) ou InDesign > Préférences > Gestion des fichiers
(Mac OS).

3. Pour créer des liens dans des fichiers importés, sélectionnez Créer des liens avec les fichiers de texte et de feuilles de calcul
importés. Si cette option est activée, le panneau Liens vous permet de mettre à jour, rétablir ou supprimer des liens. Si cette
option est désactivée, les fichiers texte sont incorporés et non liés.

Pour rompre le lien (incorporer) un fichier texte lié, sélectionnez ce fichier dans le panneau Liens, puis choisissez la commande Rompre le lien
dans le menu de ce panneau.

Voir aussi
Vidéo Importer un contenu
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Sélection de texte
Affichage de caractères masqués (non imprimables)
Ajout de colonnes, blocs et sauts de page
Utilisation du mode éditeur
Utilisation de texte conditionnel

Sélection de texte
 Sélectionnez l’outil Texte, puis utilisez l’une des méthodes suivantes :

Faites glisser le pointeur en I sur un caractère, un mot ou un bloc de texte pour le sélectionner.

Cliquez deux fois sur un mot pour le sélectionner. Les espaces adjacents au mot ne sont pas sélectionnés.

Cliquez trois fois n’importe où sur une ligne pour la sélectionner. Si l’option de préférence Cliquer trois fois pour sélectionner
une ligne n’est pas sélectionnée, le triple clic sélectionne le paragraphe entier.

Si l’option de préférence Cliquer trois fois pour sélectionner une ligne est sélectionnée, cliquez quatre fois n’importe où sur un
paragraphe pour le sélectionner en entier.

Cliquez cinq fois pour sélectionner un article entier ou cliquez n’importe où dans l’article et choisissez Edition >
Tout sélectionner.

Si vous ne parvenez pas à sélectionner le texte dans un bloc, cela peut signifier que ce bloc de texte se trouve sur un calque verrouillé ou sur un
gabarit. Essayez de déverrouiller le calque ou d’accéder au gabarit. Il se peut également que le bloc de texte soit situé sous un autre bloc de texte
ou un objet transparent (voir la section Sélection de texte dans un bloc couvert).

Modification de l’action du triple clic
1. Choisissez Edition > Préférences > Texte (Windows) ou InDesign > Préférences > Texte (Mac OS).
2. Sélectionnez la commande Cliquer trois fois pour sélectionner une ligne afin d’activer la sélection de la ligne (paramètre par

défaut). Désélectionnez cette option pour sélectionner le paragraphe.

Sélection de texte dans un bloc couvert
1. A l’aide de l’outil Sélection , maintenez la touche Ctrl (Windows) ou Commande (Mac OS) enfoncée et cliquez pour

sélectionner le bloc de texte.
2. Sélectionnez l’outil Texte, puis cliquez à l’intérieur du bloc de texte ou sélectionnez du texte.

Affichage de caractères masqués (non imprimables)
1. Sélectionnez Texte > Afficher les caractères masqués.
2. Si les caractères masqués ne s’affichent toujours pas, désactivez le mode Aperçu. Pour ce faire, choisissez Affichage > Mode

de l’écran > Normal, puis la commande Affichage > Aperçu de la surimpression.

Les caractères non imprimables, par exemple les espaces, les tabulations, les fins de paragraphes, les marques d’index et les fins d’articles
apparaissent. Ces caractères spéciaux ne sont visibles que dans les fenêtres de document et en mode éditeur ; ils ne s’impriment pas et ne sont
pas reproduits dans les fichiers au format PDF et XML par exemple. Les caractères masqués sont affichés dans la même couleur que la couleur
du calque.



Caractères non imprimables masqués (en haut) et visibles (en bas)

Anne Marie Concepcion propose une liste détaillée de caractères spéciaux sous le titre Free Guide to InDesign Special Characters.

Liste des caractères masqués

Caractère masqué Signification

Fin de paragraphe

Retour chariot (saut de ligne)

Espace

Fin de l’article

Tiret conditionnel

Trait d’union insécable

Tabulation

Tabulation de retrait à droite

Retrait jusqu’à ce point

Style imbriqué de fin à cet emplacement

NJ (Non-joiner)

Espace cadratin

Espace demi-cadratin

Espace insécable

Espace insécable (chasse fixe)

Espace ultrafine

Sixième d’espace

Espace fine

Quart d’espace

Tiers d’espace

Espace de ponctuation

Espace tabulaire
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Espace sans alinéa

Saut de colonne

Saut de bloc

Saut de page

Saut de page impaire

Saut de page paire

Saut de ligne forcé

Note InCopy

Note InCopy (en mode éditeur)

Marqueur d’emplacement (InCopy uniquement)

Marque d’index

Marque d’index (en mode éditeur)

Texte conditionnel masqué

Texte conditionnel masqué (en mode éditeur)

Marque de cible de signet ou d’hyperlien (il s’agit souvent d’une ancre de texte)

Marque de cible de signet ou d’hyperlien (en mode éditeur)

Destination d’hyperlien (en mode éditeur)

Référence croisée de paragraphe

Hyperlien de référence croisée (en mode éditeur)

Objet ancré

Objet ancré (en mode éditeur)

Balise XML

Balise XML (en mode éditeur)

Note de bas de page (en mode éditeur)

Tableau (en mode éditeur)

Variable (en mode éditeur)

Marque d’index (en mode éditeur)

Ajout de colonnes, blocs et sauts de page
Vous pouvez contrôler les sauts de colonne, de bloc ou de page en insérant des caractères de saut spéciaux dans le texte.

1. Sélectionnez l’outil Texte, puis cliquez pour créer un point d’insertion à l’endroit où vous voulez insérer le saut.
2. Choisissez Texte > Insérer un caractère de saut, puis sélectionnez une option de saut dans le sous-menu.

Vous pouvez également créer des sauts à l’aide de la touche Entrée du pavé numérique. Pour insérer un saut de colonne, appuyez sur la
touche Entrée. Pour insérer un saut de bloc, appuyez sur les touches Maj+Entrée et pour insérer un saut de page, appuyez sur les touches
Ctrl+Entrée (Windows) ou Commande+Retour (Mac OS).
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Pour supprimer un caractère de saut, choisissez Texte > Afficher les caractères masqués, afin de voir les caractères non imprimables, puis
sélectionnez et supprimez le caractère de saut.

Remarque : si vous créez un saut en modifiant des paramètres de paragraphe (par exemple des options d’enchaînement), le saut est inséré avant
le paragraphe concerné. Si vous créez un saut à l’aide d’un caractère spécial, il est inséré immédiatement après ce caractère spécial.

Options de saut
Les options suivantes apparaissent dans le menu Texte > Insérer un caractère de saut :

Saut de colonne Insère le texte dans la colonne suivante du bloc de texte actif. Si celui-ci comporte une seule colonne, le texte est inséré dans
le bloc lié suivant.
Saut de bloc Insère le texte dans le bloc lié suivant, quelle que soit la configuration des colonnes du bloc de texte actif.
Saut de page Insère le texte dans la page suivante contenant un bloc de texte lié au bloc de texte actif.
Saut de page impaire Insère le texte dans la page impaire suivante contenant un bloc de texte lié au bloc de texte actif.
Saut de page paire Insère le texte dans la page paire suivante contenant un bloc de texte lié au bloc de texte actif.
Saut de paragraphe Insère un saut de paragraphe (même résultat qu’en appuyant sur la touche Entrée ou Retour).
Saut de ligne forcé Force le retour à la ligne à l’endroit où ce caractère est inséré, sans commencer un nouveau paragraphe (même résultat
qu’en appuyant sur les touches Maj+Entrée ou Maj+Retour). On parle également de « retour chariot » pour désigner un saut de ligne forcé.

Saut de ligne conditionnel Indique où une ligne de texte doit s’interrompre si cela est nécessaire. Un saut de ligne conditionnel est semblable
à un tiret conditionnel, à la différence qu’aucun tiret n’est ajouté à l’endroit du saut de ligne.
Des options de saut associées sont disponibles dans les boîtes de dialogue Options d’enchaînement et Options de style de paragraphe.

Utilisation du mode éditeur
Vous pouvez éditer du texte dans InDesign dans la fenêtre de mise en page ou du mode éditeur. Ecrire ou apporter des modifications dans la
fenêtre du mode éditeur permet d’afficher l’article avec le type de caractères, le corps et l’espacement que vous spécifiez dans la boîte de
dialogue Préférences, sans la mise en page ou la mise en forme. La fenêtre du mode éditeur permet également d’afficher le suivi des
modifications apportées au texte.

Chaque article s’affiche dans une fenêtre différente du mode éditeur. Tout le texte de l’article s’affiche dans le mode éditeur, y compris le texte en
excès. Vous pouvez ouvrir plusieurs fenêtres du mode éditeur simultanément, et plusieurs copies du même article. Une règle de profondeur
verticale indique la quantité de texte par rapport au bloc, et une ligne indique là où le texte est en excès.

Lorsque vous éditez un article, les modifications s’affichent dans la fenêtre de mise en page. Les articles ouverts sont répertoriés dans le menu
Fenêtre. Le mode éditeur ne permet pas de créer d’article.

Fenêtre du mode éditeur
A.  Styles de paragraphe B.  Faites glisser le séparateur pour ajuster la largeur de colonne. C.  Règle de profondeur verticale D.  Indicateur de
texte en excès

Vous pouvez afficher et modifier les tableaux en mode éditeur, qui affiche le texte dans des colonnes et lignes séquentielles pour faciliter la
modification. Développez ou réduisez rapidement les tableaux et choisissez un affichage sous forme de lignes ou de colonnes.

Si le suivi des modifications est activé, vous pouvez également visualiser le texte ajouté, supprimé ou modifié en mode éditeur (voir la section
Suivi et révision des corrections).



Ouverture du mode éditeur
1. Sélectionnez le bloc de texte, cliquez sur un point d’insertion dans le bloc ou sélectionnez plusieurs blocs dans différents

articles.
2. Choisissez Edition > Modifier en mode éditeur.

Pour ouvrir une autre instance de la même fenêtre du mode éditeur, activez le mode éditeur et choisissez Fenêtre > Disposition >
Nouvelle fenêtre.

Pour revenir à la fenêtre de mise en page
 Dans le mode éditeur, utilisez l’une des méthodes suivantes :

Choisissez Edition > Mode mise en page. La fenêtre de mise en page affiche la sélection de texte ou le point d’insertion tels
qu’ils figuraient auparavant dans le mode éditeur. La fenêtre du mode éditeur reste ouverte, mais en arrière-plan de la fenêtre
de mise en page.

Cliquez dans la fenêtre de mise en page. La fenêtre du mode éditeur reste ouverte, mais en arrière-plan de la fenêtre de mise
en page.

Fermez la fenêtre du mode éditeur.

Sélectionnez le nom du document au bas du menu Fenêtre.

Affichage ou masquage des éléments du mode éditeur
Vous pouvez afficher ou masquer la colonne du nom de style et la règle de profondeur, développer ou réduire les notes de bas de page, et
afficher ou masquer les sauts de paragraphe pour indiquer le début des nouveaux paragraphes. Ces paramètres affectent toutes les fenêtres
ouvertes du mode éditeur, ainsi que toutes celles qui seront ouvertes ultérieurement.

Activez le mode éditeur, puis choisissez Affichage > Mode éditeur > Afficher la colonne Nom du style ou Masquer la colonne
Nom du style. Vous pouvez également ajuster la largeur de la colonne Nom du style en faisant glisser la barre verticale. Les
fenêtres du mode éditeur ouvertes par la suite conservent cette largeur de colonne.
Activez le mode éditeur, puis choisissez Affichage > Mode éditeur > Afficher la règle de profondeur ou Masquer la règle de
profondeur.
Activez le mode éditeur, puis choisissez Affichage > Mode éditeur > Développer toutes les notes de bas de page ou Réduire
toutes les notes de bas de page.
Activez le mode éditeur, puis choisissez Affichage > Mode éditeur > Afficher les marques de saut de paragraphes/Masquer les
marques de saut de paragraphe.

Préférences du mode éditeur
Vous pouvez modifier l’aspect du mode éditeur dans les préférences Affichage en mode éditeur. Même si le mode éditeur ne laisse que les
attributs de texte les plus basiques, certains objets et attributs sont représentés, comme indiqué dans le tableau ci-dessous :

Attribut Icône

Tableau

Objets texte

Balises XML

Variables

Sources des liens hypertexte

Ancrages des liens hypertexte

Référence croisée

Texte conditionnel masqué

Note

Notes de bas de page

Marques d’index

Texte supprimé
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Texte ajouté

Texte déplacé

Options d’affichage du texte Choisissez la police d’affichage, le corps, l’espacement entre les lignes, la couleur du texte et du fond. Vous pouvez
également définir un thème différent, tel que le thème Système classique pour obtenir un texte jaune affiché sur fond noir. Ces paramètres
affectent l’affichage du texte dans la fenêtre du mode éditeur et non dans la fenêtre de mise en page.
Lissage Lissez les bords du texte, puis choisissez le type de lissage : Spécial écrans LCD, Tamisé ou Par défaut (qui utilise les niveaux de gris
pour lisser le texte). L’option Spécial écrans LCD lisse le texte à l’aide des couleurs et non des niveaux de gris ; elle est plus efficace sur les
arrière-plans de couleur claire comportant du texte en noir. L’option Tamisé utilise les niveaux de gris, mais offre un aspect plus clair et plus flou
que l’option Par défaut.
Options du curseur Vous pouvez modifier l’aspect du curseur. Sélectionnez l’option Clignotement, par exemple, si vous souhaitez que le curseur
clignote.
Le texte d’un objet texte ne s’affiche pas dans la fenêtre parent du mode éditeur, mais il peut s’afficher dans sa propre fenêtre du mode éditeur.

Utilisation de texte conditionnel
Le texte conditionnel permet de créer différentes versions d’un même document. Une fois que vous avez créé les conditions, vous les appliquez
aux plages de texte souhaitées. Vous pouvez ensuite créer différentes versions des documents en masquant ou en affichant les conditions. Par
exemple, si vous créez un guide informatique, vous pouvez créer des conditions distinctes pour Mac OS et Windows. Avant d’imprimer la version
Mac OS du guide de l’utilisateur, vous pouvez afficher tout le texte auquel la condition « Mac » est appliquée et masquer celui concerné par la
condition « Windows ». Vous pouvez ensuite inverser les états de condition pour imprimer le guide de l’utilisateur pour Windows.

Texte conditionnel affiché
A.  Toutes les conditions affichées B.  Indicateurs conditionnels

Texte conditionnel masqué
A.  Condition « Mac » B.  Symboles de condition masquée

Les conditions ne peuvent être appliquées qu’à du texte. Vous pouvez rendre les objets ancrés conditionnels, mais seulement en sélectionnant le
marqueur d’ancrage correspondant. Vous pouvez appliquer des conditions au texte contenu dans les cellules d’un tableau, mais pas aux cellules,
colonnes ou lignes de tableau. Il n’est pas possible d’appliquer des conditions à du texte contenu dans des articles InCopy verrouillés.

Pour consulter un didacticiel vidéo sur l’utilisation de texte conditionnel, rendez-vous à l’adresse www.adobe.com/go/lrvid4026_id_fr.

Planification des documents conditionnels
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Lorsque vous planifiez un projet comportant du texte conditionnel, étudiez la nature du document et la manière dont plusieurs personnes peuvent
travailler sur celui-ci à tour de rôle. Prévoyez un traitement cohérent du texte conditionnel afin de faciliter l’utilisation et la gestion du document.
Suivez les indications suivantes.

Nombre de versions Définissez le nombre de versions que contiendra votre projet une fois terminé. Par exemple, si vous créez un manuel de
présentation d’un programme fonctionnant sur les plates-formes Windows et Mac OS, il peut être souhaitable de créer deux versions, une pour
Windows et une pour Mac OS. Si vous souhaitez insérer des commentaires de rédaction à certains endroits du texte lors de la révision, vous
aurez besoin de quatre versions, à savoir Mac OS avec commentaires, Mac OS sans commentaires, Windows avec commentaires et Windows
sans commentaires.
Pour les documents comportant de nombreuses conditions, vous pouvez définir des ensembles de conditions qui peuvent être appliqués au
document et ainsi permettre la création rapide de nouvelles versions.

Nombre de balises de condition requises Déterminez le nombre de balises de condition nécessaires pour produire les versions souhaitées. La
version d’un document est définie par un ensemble unique de balises de condition. Par exemple, la version d’un manuel Windows terminé peut
être définie avec une balise de condition Windows affichée, une balise de condition Mac OS masquée et une balise de condition Commentaires
masquée. Dans cet exemple, vous devez décider si vous utilisez une balise de condition pour les commentaires Windows et une autre pour les
commentaires Mac OS, ou si vous utilisez une seule balise de condition valable pour les commentaires Windows aussi bien que Mac OS.
Organisation du contenu Evaluez la mesure dans laquelle le document peut être conditionnel et la manière dont vous pouvez l’organiser pour en
simplifier le développement et la gestion. Par exemple, vous pouvez organiser un livre de manière à limiter le texte conditionnel à quelques
documents. Vous pouvez aussi choisir de conserver les versions d’un chapitre particulier dans des fichiers séparés plutôt que dans du texte
conditionnel et utiliser un fichier de livre différent pour chaque version du livre.
Il peut parfois être préférable de créer des couches séparées pouvant être affichées ou masquées plutôt que de recourir aux conditions. Dans le
cas d’une production en plusieurs langues, par exemple, chaque couche inclura le texte dans une langue différente.

Stratégie de balisage Déterminez l’unité de texte conditionnel la plus petite. Par exemple, si un document va être traduit dans une autre langue,
une phrase complète sera la quantité de texte minimum que vous rendez conditionnelle. La traduction entraînant souvent un changement de
l’ordre des mots, l’utilisation de texte conditionnel pour une partie de phrase peut être problématique.
Vous devez vous imposer une certaine rigueur pour l’application des conditions aux espaces et à la ponctuation, sous peine d’obtenir des espaces
en trop ou des mots mal orthographiés. Décidez si les espaces et la ponctuation doivent être conditionnels. Si du texte conditionnel commence ou
se termine par une ponctuation, cette dernière doit également être rendue conditionnelle. Le texte est ainsi plus facile à lire lorsque plusieurs
versions sont consultées.

Pour éviter les problèmes d’intermots (espace non conditionnel suivi d’un espace conditionnel, par exemple), fixez des règles de gestion pour les
espaces suivant du texte conditionnel (soit toujours conditionnels, soit toujours non conditionnels).

Pour éviter toute confusion, décidez de l’ordre dans lequel le texte conditionnel apparaîtra et utilisez le même ordre pour tout le document.

Index et références croisées Lorsque vous indexez un document, vérifiez bien si les marques d’index sont placées à l’intérieur ou à l’extérieur du
texte conditionnel. N’oubliez pas que les marques d’index contenues dans du texte conditionnel ne sont pas comprises dans l’index généré.
Si vous créez une référence croisée à du texte conditionnel, assurez-vous que le texte source possède la même condition. Par exemple, si vous
insérez une référence croisée dans un paragraphe « Windows » alors que l’ancrage de texte apparaît dans une condition « Mac », la référence
croisée est non résolue lorsque la condition « Mac » est masquée. « HT » apparaît à côté de la référence croisée dans le panneau Hyperliens.

Si vous créez une référence croisée à un paragraphe contenant du texte conditionnel, puis modifiez les paramètres de visibilité de cette condition,
mettez à jour la référence croisée.

Création de conditions
Les conditions que vous créez sont enregistrées dans le document actif. Si aucun document n’est ouvert lorsque vous créez une condition, cette
condition apparaît dans tous les nouveaux documents que vous créez.

Vous pouvez faire en sorte que le texte conditionnel soit facile à repérer en définissant des indicateurs de condition tels que les soulignements
sinusoïdaux en rouge.

1. Choisissez Fenêtre > Texte et tableaux > Texte conditionnel pour afficher le panneau Texte conditionnel.
2. Choisissez Nouvelle condition dans le menu du panneau Texte conditionnel et saisissez un nom de condition.
3. Dans le groupe Indicateur, spécifiez l’apparence de l’indicateur auquel la condition est appliquée.

Par défaut, les indicateurs (tels que les lignes rouges sinusoïdales) apparaissent dans le document mais pas à l’impression ou
à la sortie. Vous pouvez choisir une option du menu Indicateurs dans le panneau Texte conditionnel pour masquer les
indicateurs ou les imprimer et les sortir, ce qui peut être utile pour la révision.

4. Cliquez sur le bouton OK.

Application de conditions au texte
Vous pouvez appliquer plusieurs conditions au même texte. Par défaut, les indicateurs de condition identifient le texte conditionnel. S’ils sont
masqués, vous pouvez toutefois utiliser le panneau Texte conditionnel pour savoir quelles conditions ont été appliquées au texte actif. Une coche
pleine indique que la condition est appliquée au texte actif. Une coche estompée indique que la condition est appliquée à une partie de la
sélection uniquement.

1. Sélectionnez le texte auquel vous voulez appliquer la condition.



2. Dans le panneau Texte conditionnel (Fenêtre > Texte et tableaux > Texte conditionnel), utilisez l’une des méthodes
suivantes :

Pour appliquer une condition, cliquez sur celle-ci ou sur la case en regard de son nom.

Pour appliquer une condition et supprimer les autres conditions appliquées au texte, maintenez la touche Alt (Windows)
ou Option (Mac OS) enfoncée tout en cliquant sur une condition.

Pour supprimer une condition, cliquez sur la case en regard de son nom afin de la désélectionner. Vous pouvez aussi
cliquer sur [Non conditionnel] pour supprimer toutes les conditions du texte sélectionné.

Remarque : il n’est pas possible d’appliquer de raccourcis clavier à des conditions particulières. Vous pouvez néanmoins appliquer des conditions
à l’aide de la commande Application rapide.

Affichage ou masquage des conditions
Lorsque vous masquez une condition, tout le texte auquel la condition s’applique est masqué. Le fait de masquer les conditions entraîne souvent
une modification de la numérotation des pages du document ou livre. Vous pouvez utiliser la fonction Redistribution intelligente du texte pour
ajouter et supprimer des pages automatiquement suivant que vous masquez ou affichez les conditions.

En général, le texte conditionnel masqué est ignoré dans le document. Par exemple, le texte masqué n’est ni imprimé, ni exporté ; les marques
d’index contenues dans du texte conditionnel masqué ne sont pas incluses dans l’index généré ; et le texte conditionnel masqué est exclu lors des
opérations de recherche ou de correction orthographique de texte.

Lorsque vous masquez une condition, le texte masqué est stocké dans un symbole de condition masquée . Si vous sélectionnez du texte
contenant un symbole de condition masquée et essayez de le supprimer, InDesign vous invite à confirmer cette suppression. Vous ne pouvez pas
appliquer d’autres conditions, styles ou mises en forme au texte conditionnel masqué.

Si plusieurs conditions sont appliquées au texte et si au moins une de ces conditions est affichée et qu’une autre est masquée, le texte n’est pas
masqué.

Pour afficher ou masquer des conditions individuelles, cliquez sur la zone de visibilité en regard du nom des conditions
concernées. L’icône en forme d’oeil indique que la condition est affichée.
Pour afficher ou masquer toutes les conditions, choisissez l’option Tout afficher ou Tout masquer dans le menu du panneau
Texte conditionnel.

Utilisation d’ensembles de conditions
Un ensemble de conditions capture les paramètres de visibilité de toutes les conditions et permet ainsi d’appliquer rapidement différentes versions
d’un même document. Supposons par exemple que vous préparez un document complexe comportant des conditions de plate-forme pour
Mac OS, Windows XP, Vista, UNIX, des conditions de langue pour l’anglais, le français, l’allemand et l’espagnol, ainsi que des conditions de
rédaction telles que Révision de rédaction et Commentaires internes. Pour la révision de la version relative à Vista en français, vous pouvez créer
un ensemble affichant uniquement les conditions Vista, Français et Révision de rédaction, et masquant le reste.

Les ensembles de conditions ne sont pas indispensables pour parvenir à ce résultat, mais ils offrent plus de rapidité et de fiabilité pour modifier
différents paramètres de visibilité des conditions.

1. Appliquez les conditions au texte selon les besoins.
2. Si le menu Ensemble ne figure pas dans le panneau Texte conditionnel, choisissez la commande Afficher les options dans le

menu du panneau Texte conditionnel.
3. Dans le panneau Texte conditionnel, rendez les conditions visibles ou masquées, selon les besoins.
4. Choisissez la commande Créer un ensemble dans le menu Ensemble, spécifiez un nom pour l’ensemble, puis cliquez sur OK.

Le nouvel ensemble devient l’ensemble actif.

5. Utilisez l’une des méthodes suivantes :

Pour appliquer un ensemble de conditions à un document, sélectionnez son nom dans le menu Ensemble.

Pour ignorer un ensemble de conditions, sélectionnez cet ensemble afin de le rendre actif et modifiez le paramètre de
visibilité d’une condition. Le signe (+) apparaît en regard de l’ensemble de conditions. Sélectionnez de nouveau l’ensemble
de conditions pour annuler les omissions. Choisissez la commande Redéfinir « [ensemble de conditions] » pour mettre à
jour l’ensemble de conditions avec les nouveaux paramètres de visibilité.

Pour supprimer un ensemble de conditions, sélectionnez-le et choisissez la commande Supprimer « [ensemble de
conditions] ». La suppression d’un ensemble de conditions ne supprime pas les conditions de l’ensemble, ni les conditions
des emplacements où elles sont appliquées.

Gestion des conditions
 Utilisez l’une des méthodes suivantes :

Supprimer une condition Sélectionnez la condition concernée et cliquez sur l’icône de suppression au bas du panneau Texte conditionnel.
Spécifiez une condition devant remplacer la condition supprimée, puis cliquez sur OK. La condition que vous spécifiez est appliquée à tout le texte
qui était concerné par la condition supprimée.
Pour supprimer plusieurs conditions, cliquez tout en maintenant la touche Maj enfoncée pour sélectionner des conditions contiguës ou cliquez tout



 

en maintenant la touche Ctrl (Windows) ou Commande (Mac OS) enfoncée pour sélectionner des conditions non contiguës, puis cliquez sur
l’icône de suppression.

Supprimer une condition du texte La suppression d’une balise de condition du texte diffère de celle d’une balise de condition d’un document.
Les balises que vous supprimez d’un texte restent dans le document afin de pouvoir être de nouveau appliquées ultérieurement.
Pour supprimer une condition du texte, sélectionnez le texte concerné et cliquez sur la case en regard de la condition pour la désélectionner, ou
cliquez sur [Non conditionnel] pour supprimer toutes les conditions du texte sélectionné.

Charger (importer) des conditions Choisissez la commande Charger les conditions (pour ne charger que les conditions) ou Charger les
conditions et les ensembles dans le menu du panneau Texte conditionnel. Sélectionnez le document InDesign à partir duquel importer les
conditions, puis cliquez sur Ouvrir. Les conditions et ensembles chargés remplacent tous ceux possédant des noms identiques.
Vous ne pouvez pas charger les conditions depuis un fichier InCopy dans InDesign, mais vous pouvez charger les conditions depuis un fichier
InDesign vers InDesign et InCopy.

Les ensembles chargés ignorent les paramètres de visibilité des conditions actives dans le panneau Texte conditionnel.

Synchroniser les conditions dans un livre Pour vous assurer d’utiliser les mêmes conditions dans tous les documents d’un livre, créez les
conditions de votre choix dans le document de source des styles, sélectionnez l’option Paramètres de texte conditionnel dans la boîte de dialogue
Options de synchronisation, et synchronisez le livre.
Afficher ou masquer les indicateurs de condition Choisissez l’option Afficher ou Masquer dans le menu Indicateurs du panneau Texte
conditionnel, pour afficher ou masquer les indicateurs de condition. Si vous affichez une version et souhaitez voir les domaines conditionnels,
affichez les indicateurs de condition. Si vous trouvez les indicateurs de condition gênants pour la visualisation de la mise en page, masquez-les.
Choisissez l’option Afficher et imprimer, pour imprimer les indicateurs de condition.
Modifier le nom d’une condition Dans le panneau Texte conditionnel, cliquez sur une condition, marquez une pause, puis cliquez sur le nom de
la condition pour la sélectionner. Saisissez un autre nom.
Modifier les indicateurs de condition Dans le panneau Texte conditionnel, cliquez deux fois sur une condition, ou sélectionnez une condition et
choisissez la commande Options de condition dans le menu du panneau. Spécifiez les paramètres d’indicateur, puis cliquez sur OK.

Recherche et remplacement de texte conditionnel
A l’aide de la boîte de dialogue Rechercher/Remplacer, recherchez le texte auquel une ou plusieurs conditions ont été appliquées et remplacez-le
par une ou plusieurs autres conditions.

1. Affichez le texte conditionnel à inclure dans la recherche.

Le texte masqué est exclu de la recherche.

2. Choisissez Edition > Rechercher/Remplacer.
3. Si les zones Rechercher le format et Remplacer le format n’apparaissent pas en bas de la boîte de dialogue, cliquez sur Plus

d’options.
4. Cliquez sur la zone Rechercher le format pour afficher la boîte de dialogue Rechercher un format. Dans le menu Conditions,

sélectionnez l’option [Condition quelconque] pour rechercher le texte auquel des conditions sont appliquées, l’option [Non
conditionnel] pour rechercher le texte pour lequel aucune condition n’est appliquée, ou sélectionnez les conditions particulières
à rechercher. Cliquez sur le bouton OK.

Cette fonction recherche le texte correspondant parfaitement aux conditions sélectionnées. Par exemple, si vous sélectionnez
Condition 1 et Condition 2, le texte auquel une seule des conditions est appliquée n’est pas trouvé ; il en va de même pour le
texte auquel une troisième condition est appliquée en plus de ces deux conditions.

5. Cliquez sur la zone Remplacer le format pour afficher la boîte de dialogue Modifier le format. Spécifiez l’option de mise en
forme différente (condition ou style de caractère, par exemple), puis cliquez sur OK.

Si vous sélectionnez la section Conditions dans la boîte de dialogue Modifier le format, l’option [Condition quelconque] ne
modifie pas le texte conditionnel trouvé. Cette option est utile pour appliquer une mise en forme différente, telle qu’un style de
caractère particulier. Sélectionnez l’option [Non conditionnel] pour supprimer toutes les conditions du texte trouvé. Si vous
sélectionnez une condition particulière, indiquez si elle doit remplacer les éventuelles conditions appliquées au texte trouvé ou
être ajoutée à celles-ci.

6. Cliquez sur le bouton Rechercher et utilisez les boutons Remplacer, Remplacer/Rechercher ou Tout remplacer pour remplacer
la condition.

Voir aussi
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Création de blocs de texte

Dans InDesign, le texte est placé dans des espaces appelés blocs de texte, semblables aux zones de texte
de QuarkXPress et aux blocs d’Adobe PageMaker.

Il existe deux types de blocs de texte : grilles de bloc et blocs de texte brut. Les grilles de bloc représentent
les blocs de texte spécifiques à la composition en langue asiatique dans laquelle les EmBox et l’espacement
des caractères s’affichent sous forme de grille. Les blocs de texte vides dans lesquels aucune grille n’est
affichée sont des blocs de texte brut.

Les blocs de texte, comme les blocs graphiques, peuvent être déplacés, redimensionnés et modifiés. L’outil
utilisé pour sélectionner le bloc de texte dépend du type de modification à apporter :

L’outil Texte  vous permet de saisir ou modifier du texte au sein d’un bloc.

L’outil Sélection  vous permet de réaliser des tâches générales de mise en page, telles
que le déplacement ou le redimensionnement de blocs.

L’outil Sélection directe  vous permet de modifier la forme d’un bloc.

L’outil Grille horizontale  ou l’outil Grille verticale vous permet de créer une grille de
bloc. Voir Création de grilles de bloc.

L’outil Texte  vous permet de créer un bloc de texte brut pour le texte horizontal et
l’outil Texte vertical  vous permet de créer un bloc de texte brut pour le texte vertical.
Utilisez les mêmes outils pour modifier le texte existant dans un bloc.

Les blocs de texte peuvent également être rattachés ensemble, de telle sorte qu’un texte peut commencer
dans un bloc et se terminer dans un autre. On dit de ces blocs qu’ils sont liés. Un texte qui s’étale sur
plusieurs blocs liés est appelé un article. Lorsque vous importez un fichier de traitement de texte, il apparaît
dans le document sous forme d’un seul article, quel que soit le nombre de blocs qu’il occupe.

Les blocs de texte peuvent contenir plusieurs colonnes. Ils peuvent être basés sur des colonnes de pages
sans pour autant en dépendre. Ainsi, un bloc de texte de deux colonnes peut figurer sur une page de quatre
colonnes. Les blocs de texte peuvent également être importés dans des gabarits et recevoir du texte sur des
pages du document.

Si vous utilisez souvent le même type de bloc de texte, créez un style incluant la mise en forme du bloc
de texte (couleurs des contours et du fond, options du bloc de texte et effets d’habillage et de
transparence, par exemple).
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Lorsque vous importez ou collez du texte, il n’est pas nécessaire de créer un bloc de texte. InDesign ajoute
automatiquement des blocs en fonction des paramètres de colonne de la page.

Lorsque le texte est collé, un bloc de texte brut est créé automatiquement. Vous pouvez également créer un
bloc de texte brut vide manuellement et saisir du texte.

Utilisez l’une des méthodes suivantes :

Sélectionnez l’outil Texte , puis faites glisser le pointeur pour définir la largeur et la
hauteur du nouveau bloc de texte. Maintenez la touche Maj enfoncée et faites glisser
le curseur pour créer un bloc de texte carré. Lorsque vous relâchez le bouton de la
souris, un point d’insertion apparaît dans le bloc.

Création d’un bloc de texte par glissement du curseur

Cliquez sur le port d’entrée ou de sortie d’un autre bloc de texte à l’aide de
l’outil Sélection, puis cliquez ou faites glisser le pointeur pour créer un autre bloc.

Utilisez la commande Importer pour insérer un fichier texte.

A l’aide de l’outil Texte , cliquez dans un bloc vide. Si l’option Conversion des
blocs en blocs de texte avec l’outil Texte est activée dans la boîte de dialogue des
préférences de texte, le bloc vide est converti en bloc de texte.

Déplacement et redimensionnement de blocs de texte

L’outil Sélection vous permet de déplacer ou de redimensionner des blocs de texte.

Si vous souhaitez déplacer ou redimensionner un bloc de texte tout en laissant l’outil Texte  activé,
maintenez la touche Ctrl (Windows) ou Commande (Mac OS) enfoncée, puis faites glisser le bloc.

Déplacement d’un bloc de texte

A l’aide de l’outil Sélection, faites glisser le bloc.
Sélectionnez l’outil Texte, maintenez la touche Ctrl (Windows) ou Commande (Mac OS)
enfoncée et faites glisser le bloc. L’outil Texte est toujours sélectionné lorsque vous
relâchez la touche.

Redimensionnement d’un bloc de texte

Utilisez l’une des méthodes suivantes :

Pour redimensionner un bloc à l’aide de l’outil Texte , maintenez la touche Ctrl
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(Windows) ou Commande (Mac OS) enfoncée et faites glisser l’une des poignées du
bloc. Si vous souhaitez recomposer le texte tout en redimensionnant le bloc,
maintenez le bouton de la souris enfoncé pendant une seconde avant de faire glisser
le pointeur.

Remarque : si vous cliquez sur le bloc de texte au lieu de le faire glisser, vous perdez
la sélection de texte ou l’emplacement du point d’insertion.

Pour redimensionner un bloc à l’aide de l’outil Sélection , faites glisser l’une des
poignées du bloc sur la bordure du bloc. Maintenez la touche Ctrl (Windows)
ou Commande (Mac OS) enfoncée pour mettre le texte à l’échelle à l’intérieur du bloc
(Voir Mise à l’échelle du texte.)

Pour redimensionner le bloc et l’ajuster à son contenu, utilisez l’outil Sélection pour
sélectionner le bloc de texte et cliquez deux fois sur une poignée. Par exemple, si
vous cliquez deux fois sur la poignée du centre du côté inférieur, le bord inférieur du
bloc est magnétisé sur le bas du texte. Si vous cliquez deux fois sur la poignée du
centre sur le côté droit, la hauteur est préservée tandis que la largeur est réduite pour
que le bloc de texte soit rempli.

Conseil : vous pouvez également cliquer deux fois sur une poignée d’un bloc de
texte en excès pour augmenter la hauteur et la largeur de façon à accommoder
l’ensemble du texte dans le bloc. Si un bloc de texte contient plus de texte en excès
que la page ne peut contenir, le bloc de texte n’est pas redimensionné.

Cliquez deux fois sur une poignée pour redimensionner un bloc de texte.

Pour ajuster le bloc de texte au contenu, sélectionnez le bloc à l’aide de
l’outil Sélection, puis choisissez Objet > Ajustement > Ajuster le bloc au contenu. Le
bas du bloc de texte s’adapte pour contenir l’ensemble du texte. Si un bloc de texte
contient plus de texte en excès que la page ne peut contenir, le bloc de texte n’est
pas redimensionné.

A l’aide de l’outil Mise à l’échelle , faites glisser le pointeur pour redimensionner le
bloc (voir Mise à l’échelle du texte).

Utilisation des blocs de texte sur les gabarits

Lorsque vous créez un document, vous pouvez sélectionner l’option Bloc de texte type, de sorte qu’un bloc
de texte vide soit inséré dans le gabarit par défaut du document. Ce bloc dispose des attributs de marge et
de colonne spécifiés dans la boîte de dialogue Nouveau document.

Suivez les indications ci-après pour utiliser les blocs de texte dans les gabarits :

Configurez des blocs de texte types si vous souhaitez que chaque page du document
contienne un bloc de texte d’une page dans lequel vous pourrez placer ou saisir du texte.
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En revanche, si la mise en page de votre document doit être plus souple, avec des blocs
de texte de diverses longueurs et en nombre variable sur chaque page, désélectionnez
l’option Bloc de texte type et créez vos blocs de texte sur les gabarits à l’aide de
l’outil Texte.

Que vous sélectionniez ou non l’option Bloc de texte type, vous pouvez ajouter des blocs
de texte dans le gabarit, pour réserver l’emplacement. Vous pouvez lier les blocs de
substitution vides les uns aux autres afin d’établir un flux de placement.

Placez du texte dans les blocs de texte types en utilisant les mêmes procédures que
celles utilisées pour les blocs créés sur les pages de document.

Si vous devez saisir du texte dans un bloc de texte type sur une page de document,
maintenez les touches Ctrl+Maj (Windows) ou Commande+Maj (Mac OS) enfoncées
lorsque vous cliquez sur le bloc de texte de la page de document. A l’aide de l’outil Texte,
cliquez dans le bloc et saisissez le texte.

La redistribution intelligente du texte permet d’ajouter ou de supprimer des pages
automatiquement à mesure que vous saisissez et modifiez du texte. Par défaut, lorsque
vous saisissez du texte à la fin d’un bloc de texte lié d’après un gabarit, une nouvelle
page est ajoutée pour vous permettre de continuer la saisie dans le nouveau bloc de
texte. Vous pouvez modifier les paramètres de la redistribution intelligente du texte.

Si vous modifiez les marges de la page, les blocs de texte s’adaptent aux nouvelles
dimensions seulement si l’option Activer l’ajustement de la mise en page est sélectionnée.

La sélection de l’option Bloc de texte type n’affecte pas l’ajout de nouvelles pages lorsque
vous placez le texte automatiquement.

Modification des propriétés d’un bloc de texte

La commande Options de bloc de texte vous permet de modifier les paramètres, tels que le nombre de
colonnes dans le bloc, l’alignement vertical du texte ou la marge (espace entre le bloc et le texte qu’il
contient).

Avant (à gauche) et après (à droite) avoir défini des marges et créé deux colonnes dans un bloc de texte

Pour utiliser les mêmes propriétés de bloc pour plusieurs blocs de texte, créez un style d’objet que vous
pourrez appliquer aux blocs de texte.

1. Sélectionnez un bloc à l’aide de l’outil Sélection  ou cliquez dans un bloc de texte ou
sélectionnez du texte avec l’outil Texte .  

2. Choisissez Objet > Options de bloc de texte, ou maintenez la touche Alt (Windows)
ou Option (Mac OS) enfoncée, puis cliquez deux fois sur le bloc de texte à l’aide d’un
outil de sélection.

3. Modifiez les options de bloc de texte, puis cliquez sur OK.



Ces options de bloc de texte sont disponibles lorsque vous définissez un style d’objet pour les zones de texte
(voir Styles d’objet).

Ajout de colonnes à un bloc de texte

Vous pouvez créer des colonnes dans un bloc de texte à l’aide de la boîte de dialogue Options de bloc de
texte.

Vous ne pouvez pas créer des colonnes à largeur variable dans un bloc de texte. Pour créer des colonnes
de largeur et de hauteur inégales, ajoutez des blocs de texte côte à côte soit sur une page du document,
soit sur un gabarit.

1. Sélectionnez un bloc à l’aide de l’outil Sélection ou cliquez dans un bloc de texte ou
sélectionnez du texte avec l’outil Texte.

2. Choisissez Objet > Options de bloc de texte.

3. Spécifiez le nombre de colonnes, la largeur de chaque colonne et l’espacement entre les
colonnes (gouttière) du bloc.

4. (Facultatif) Sélectionnez l’option Largeur de colonne fixe pour conserver la largeur des
colonnes lorsque vous redimensionnez le bloc. Si cette option est sélectionnée, le
redimensionnement du bloc peut modifier le nombre de colonnes mais pas leur largeur.

Largeur de colonne fixe

A. Bloc de texte initial à deux colonnes B. Bloc redimensionné avec l’option Largeur de
colonne fixe désélectionnée (toujours avec 2 colonnes) C. Bloc redimensionné avec
l’option Largeur de colonne fixe sélectionnée (avec 4 colonnes) 

5. (Facultatif) Sélectionnez l’option Equilibre des colonnes pour que le texte soit réparti
uniformément au sein d’un bloc de texte de plusieurs colonnes.
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Modification de la marge d’un bloc de texte

1. Sélectionnez un bloc à l’aide de l’outil Sélection ou cliquez dans un bloc de texte ou
sélectionnez du texte avec l’outil Texte.

2. Choisissez Objet > Options de bloc de texte.

3. Dans la section Marges à l’intérieur du bloc de l’onglet Général, entrez les distances de
décalage souhaitées en haut, à gauche, en bas et à droite. Cliquez sur l’icône
Uniformiser tous les paramètres  pour appliquer le même espacement de chaque côté.

Si le bloc que vous avez sélectionné n’est pas de forme rectangulaire, ces options sont grisées et une
option Marge est disponible.

Options de décalage de la première ligne de base

Pour modifier les options de la première ligne de base d’un bloc de texte sélectionné, choisissez Objet >
Options de bloc de texte, puis cliquez sur l’onglet Options de ligne de base. Les options suivantes
apparaissent dans le menu Décalage, sous Première ligne de base :

La hauteur du caractère « d » de la police est inférieure à la marge supérieure du bloc de texte.

Le haut des lettres majuscules touche la marge supérieure du bloc de texte.

Utilisez la valeur d’interligne du texte comme distance séparant la ligne de base de la première
ligne de texte et la marge supérieure du bloc.

La hauteur du caractère « x » de la police est inférieure à la marge supérieure du bloc.

Spécifiez la distance séparant la ligne de base de la première ligne de texte et la marge supérieure du
bloc.

Sélectionnez une valeur minimum de décalage de la ligne de base. Par exemple, si l’option Interligne
est sélectionnée et la valeur minimum est définie sur 1p, InDesign utilise la valeur d’interligne uniquement
lorsqu’elle est supérieure à 1 pica.

Pour magnétiser le haut du bloc de texte à une grille, sélectionnez Interligne ou Fixe afin de pouvoir
choisir l’emplacement de la première ligne de base du texte dans les blocs.

Définition des grilles de ligne de base d’un bloc de texte

Dans certains cas, il est préférable d’appliquer une grille de ligne de base à un bloc plutôt qu’à l’ensemble du
document. Utilisez la boîte de dialogue Options de bloc de texte pour appliquer une grille de ligne de base à
un bloc de texte. Lorsque vous définissez une grille de ligne de base pour un bloc de texte, tenez compte
des points suivants :

La grille de ligne de base du document n’apparaît pas derrière ou devant les blocs de
texte qui utilisent leurs propres grilles de ligne de base.
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Si vous avez sélectionné l’option Grilles en arrière-plan dans les préférences des grilles,
les grilles de ligne de base définies pour les blocs prennent le pas sur celles du
document. En revanche, si cette option n’est pas sélectionnée, les grilles de ligne de
base définies pour le document ont la priorité sur celles des blocs.

1. Choisissez Affichage > Grilles et repères > Afficher la grille de ligne de base pour
afficher toutes les grilles de ligne de base, y compris celles d’un bloc de texte.

2. Sélectionnez le bloc de texte ou placez le point d’insertion dans un bloc de texte, puis
choisissez Objet > Options de bloc de texte.

Si vous souhaitez que la grille de ligne de base s’applique à tous les blocs d’un lien
(même si un ou plusieurs blocs liés ne contiennent pas de texte), placez le point
d’insertion dans le texte, choisissez Edition > Tout sélectionner, puis appliquez les
paramètres de la grille de ligne de base de la boîte de dialogue Options de bloc de texte.

3. Cliquez sur l’onglet Options de ligne de base.

4. Dans Grille de ligne de base, sélectionnez l’option Utiliser la grille de ligne de base
personnalisée et utilisez l’une des méthodes suivantes :

Entrez une valeur de décalage de la grille par rapport au haut de la page, à la
marge supérieure de la page, au haut du bloc ou à la marge (interne) supérieure du bloc,
selon ce que vous avez sélectionné dans le menu Relative à.

Indiquez si la grille de ligne de base doit commencer par rapport au haut de
la page, à la marge supérieure de la page, au haut du bloc de texte ou au haut de la
marge (interne) du bloc de texte.

Entrez une valeur d’espacement entre les lignes de la grille. Dans la plupart des
cas, il convient de spécifier une valeur égale à l’interlignage du corps de texte pour
aligner parfaitement les lignes du texte sur cette grille.

Sélectionnez la couleur des lignes de la grille ou choisissez (Couleur de calque)
pour appliquer la même couleur que celle du calque sur lequel le bloc de texte figure.

Si la grille de ligne de base n’est pas visible dans un bloc de texte, choisissez Affichage > Grilles et
repères > Afficher la grille de ligne de base, afin de vérifier que les grilles de ligne de base ne sont pas
masquées. Si la grille de ligne de base n’apparaît toujours pas, vérifiez le seuil d’affichage des grilles dans
la section Grille de la boîte de dialogue Préférences. Pour afficher la grille, il vous faudra peut-être
effectuer un zoom avant sur le bloc ou réduire le niveau du seuil.

Affichage du nombre de mots et de caractères

1. Placez le point d’insertion dans un bloc de texte pour afficher le nombre de mots ou de
caractères de l’ensemble des blocs liés (donc de l’article), ou sélectionnez une partie du
texte pour afficher le nombre de mots ou de caractères du texte sélectionné.

2. Choisissez Fenêtre > Informations pour afficher le panneau Informations.

Le panneau Informations affiche le nombre de caractères, de mots, de lignes et de paragraphes que contient
un bloc de texte. La position du point d’insertion dans le bloc de texte apparaît également.

Utilisation d’autres langues
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Vous pouvez affecter une langue à différents textes. Cette fonctionnalité est particulièrement importante pour
la mise en œuvre de la vérification orthographique et des césures (voir Affectation d’une langue à un texte).

Si vous devez travailler avec du texte composé de caractères asiatiques, des versions spéciales d’InDesign
sont disponibles pour le japonais, le chinois simplifié, le chinois traditionnel et le coréen. Ces versions
permettent de créer des grilles de mise en page et de bloc pour la composition des textes à caractères multi-
octets. Elles comptent par ailleurs diverses fonctions de mise en forme du texte multi-octet, ainsi que des
polices supplémentaires.

De même, une version spéciale d’InDesign est disponible pour les langues du Moyen-Orient, comme l’arabe,
le farsi, l’hébreu et l’ourdou, qui présentent la particularité de composer le texte de droite à gauche. Cette
version se nomme InDesign ME.

Pour plus de détails sur l’achat d’InDesign ME ou d’une version en langue asiatique d’InDesign, consultez le
site Web d’Adobe.

Adobe recommande également
Création de formats de grille nommée
Propriétés des grilles de bloc
Présentation du panneau Grilles nommées
Liaison de texte
Importation de texte
Application d’une grille nommée à un bloc
Styles d’objet
Remplacement ou dissociation d’éléments types
Redistribution intelligente du texte
Gabarits
Modification des propriétés des grilles de bloc
Modification du format, des marges et des colonnes de document
Grilles
Application d’une rotation aux caractères demi-chasse dans un texte vertical
Affichage ou masquage du nombre de caractères de grille de bloc
Présentation du panneau Informations
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Création d’une légende à partir d’une image
Définition des options de format des légendes
Création de légendes à l’aide de variables
Définition de variables de légende

Une légende est un texte descriptif visible sous une image. Dans InDesign, plusieurs méthodes permettent de créer des légendes à partir des
métadonnées d’image que vous définissez. Vous disposez notamment d’une variable de légende particulière qui affiche les métadonnées définies
d’une image. Si un bloc de texte contenant cette variable se trouve près d’une image ou lui est associé, la variable affiche les métadonnées de
cette image. Vous pouvez créer une légende à partir d’une image existante ou lors de l’importation d’une image, ou encore créer un bloc de texte
contenant une variable de légende.

Pour consulter des didacticiels vidéo sur la création de légendes à partir de métadonnées, rendez-vous aux adresses
www.adobe.com/go/lrvid5156_id_en et http://tv.adobe.com/go/4958/.

Légende créée à partir de métadonnées d’image

Création d’une légende à partir d’une image
Lorsque vous créez une légende à partir d’une image existante, vous pouvez faire en sorte qu’elle soit statique (elle ne peut être modifiée que
manuellement) ou dynamique (elle est mise à jour lorsque l’image ou ses métadonnées changent). Par exemple, si vous déplacez une légende
dynamique près d’une autre image, elle affiche les métadonnées de cette image.

Lorsque vous choisissez la commande Générer une légende dynamique, une nouvelle variable est créée automatiquement sur la base des
paramètres de légende actuels. Par exemple, si le type de métadonnées Description est sélectionné dans la boîte de dialogue Format des
légendes, vous obtenez une variable intitulée « Légende dynamique des métadonnées : Description ».

1. Pour définir le contenu et l’aspect de la légende que vous créez, choisissez la commande Objet > Légendes > Format des
légendes et définissez les paramètres (voir la section Définition des options de format des légendes).

2. Choisissez la commande Objet > Légendes > Générer une légende dynamique ou Générer une légende statique.

Remarque : une légende dynamique correspondant à une variable, elle n’inclut pas de sauts de ligne lorsqu’elle affiche une longue chaîne de
texte, telle une description. Si une légende se présente sur une seule ligne, envisagez de la convertir en une légende statique. Pour procéder à la
conversion, sélectionnez la légende dynamique, puis choisissez la commande Objet > Légendes > Convertir en légende statique.
Vous pouvez également créer une légende statique lors de l’importation d’une image. Dans la boîte de dialogue Importer, sélectionnez
l’option Créer des légendes statiques, puis importez le bloc de texte de la légende après avoir importé l’image.

Définition des options de format des légendes
Utilisez la boîte de dialogue Format des légendes pour déterminer le contenu et la mise en forme des légendes que vous créez. Seules les
nouvelles légendes, non les légendes existantes, seront concernées par ces sélections.

1. Choisissez la commande Objet > Légendes > Format de légendes.

2. Choisissez les métadonnées à inclure, puis définissez le texte qui doit figurer avant et après ces métadonnées.

3. Pour ajouter plusieurs lignes de métadonnées, cliquez sur l’icône du signe plus.

4. Définissez les options suivantes, puis cliquez sur le bouton OK.

http://www.adobe.com/go/lrvid5156_id_en
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Texte avant / Texte après Texte visible avant ou après les métadonnées définies.

Métadonnées Choisissez une option parmi celles proposées dans la liste, par exemple Description ou Ville.

Alignement Indiquez la position de la légende par rapport à l’image.

Décalage Définissez la taille de l’espace entre la légende et le bord du bloc de texte à côté de l’image.

Style de paragraphe Indiquez le style de paragraphe à appliquer au texte de la légende. Si vous voulez que la légende fasse
l’objet d’une numérotation automatique, par exemple « Figure 1 », « Figure 2 », etc., définissez la numérotation dans le style
de paragraphe (voir la section Création de légendes continues de figures et tableaux).

Calque Précisez le calque auquel appartient la légende.

Associer la légende à l’image Indiquez si le bloc de l’image et celui du texte de la légende sont associés.

Création de légendes à l’aide de variables
Lorsqu’un bloc de texte contenant une variable de légende est adjacent à une image ou lui est associé, la variable affiche les métadonnées de
cette image.

Variables de légende
A.  Bloc de texte avec variable de légende non adjacent à l’image B.  Bloc de texte placé près de l’image

1. Au besoin, définissez la variable de légende à utiliser Voir la section Définition de variables de légende.

2. Créez le bloc de texte à utiliser pour la légende.

3. Après avoir placé le point d’insertion dans le bloc de texte, choisissez la commande Texte > Variables de texte > Insérer une
variable, puis sélectionnez la variable de légende à inclure. Insérez autant de variables de légende que vous le souhaitez.

4. Déplacez le bloc de texte de légende près d’un bloc contenant une image ou associez-le au bloc de l’image.

Si la variable de légende est vide, modifiez les métadonnées de l’image, puis mettez l’image à jour au moyen du panneau Liens. La procédure de
modification des métadonnées d’une image est décrite à la section Modification des métadonnées dans des fichiers image.

Définition de variables de légende
Une variable de légende est automatiquement mise à jour lorsque le bloc de texte dans lequel elle figure est placé près d’une image. Par défaut,
la variable Nom est utilisée pour le type de variable lorsque vous choisissez Texte > Variables de texte > Insérer une variable > Nom de l’image.
Vous pouvez modifier la variable Nom de l’image ou créer de nouvelles variables qui spécifient les métadonnées de l’image.

1. Choisissez la commande Texte > Variables de texte > Définir.

2. Choisissez la commande Nouvelle pour créer une variable ou la commande Modifier pour modifier une variable existante.

3. Sélectionnez l’option Légende des métadonnées dans le menu Type.

4. Choisissez une option dans le menu Métadonnées.

5. Définissez le texte à ajouter avant ou après les métadonnées, puis cliquez sur le bouton OK.
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Suivi des modifications
Acceptation ou refus des modifications
Définition des préférences de suivi des modifications
Modification du nom et de la couleur de l’utilisateur

Suivi des modifications
Le suivi des modifications effectuées dans un article par chacun des acteurs du processus de rédaction et d’édition est une fonction
particulièrement utile. Les marques de révision correspondant à tous les ajouts, suppressions et déplacements de texte dans un article existant
sont visibles en mode éditeur dans InDesign et en modes Epreuve en placard et Article dans InCopy. Libre à vous d’accepter ou d’ignorer ces
modifications.

Utilisez le panneau Suivi des modifications d’InDesign ou la barre d’outils de suivi des modifications d’InCopy pour activer ou désactiver le suivi
des modifications, ainsi que pour afficher, masquer, accepter ou ignorer les corrections apportées par vos collaborateurs.

Suivi des modifications en mode éditeur (InDesign)
A.  Barres de modification B.  Texte ajouté C.  Texte supprimé D.  Texte déplacé (source) E.  Texte déplacé (cible)

Pour activer le suivi des modifications
1. Choisissez la commande Fenêtre > Editorial > Suivi des modifications pour ouvrir le panneau du même nom (InDesign) ou la

commande Fenêtre > Suivi des modifications pour afficher la barre d’outils du même nom (InCopy).

2. Après avoir placé le point d’insertion dans le texte, utilisez l’une des méthodes suivantes :

Pour activer le suivi des modifications dans l’article actif uniquement, cliquez sur l’icône Activer le suivi des modifications
dans l’article actif .

(InDesign) Pour activer le suivi dans tous les articles, choisissez la commande Activer le suivi dans tous les articles dans
le menu du panneau Suivi des modifications.

(InCopy) Pour activer le suivi dans tous les articles ouverts d’un document constitué de plusieurs articles, choisissez la
commande Modifications > Activer le suivi dans tous les articles.

3. Insérez, effacez ou déplacez du texte dans l’article, en fonction des besoins.

Mode d’affichage du suivi des modifications
Lorsque le suivi des modifications est activé, les corrections apportées s’affichent par défaut de la façon suivante en mode éditeur (InDesign) ou
en modes Epreuve en placard et Article (InCopy) :

La section Suivi des modifications de la boîte de dialogue Préférences vous permet de choisir la couleur permettant d’identifier les
modifications. Elle vous permet également de sélectionner les modifications à suivre (ajouts, suppressions ou déplacements de texte) et la
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manière de les afficher.

Texte ajouté Mis en surbrillance.
Texte supprimé Mis en surbrillance et barré.
Texte déplacé (coupé et collé) Mis en surbrillance et barré à l’emplacement d’origine ; mis en surbrillance et encadré au nouvel emplacement.
Remarque : lorsque vous coupez du texte dans un document pour le coller dans un autre, il est affiché comme texte supprimé à son emplacement
d’origine dans le document source et comme texte ajouté à son nouvel emplacement.
Texte copié Mis en surbrillance au nouvel emplacement. Le texte d’origine demeure inchangé.
Barres de modification Une barre de modification est une ligne verticale qui apparaît à gauche d’une ligne de texte modifié. Vous pouvez afficher
ou masquer les barres de modification à votre convenance et spécifier leur couleur.

Affichage ou masquage des modifications
Lorsque les corrections sont masquées, le texte se présente sous la même forme que si la fonction de suivi des corrections était désactivée. Ainsi,
le texte ajouté est visible, le texte supprimé est invisible et le texte déplacé ou collé s’affiche à l’endroit où il a été inséré.

(InDesign) Lorsque le suivi des modifications est activé, les modifications sont suivies, que vous travailliez en mode éditeur ou dans la mise en
page du document. Vous pouvez afficher les modifications en mode éditeur, mais pas dans la mise en page.

(InCopy) Lorsque le suivi des modifications est activé, les modifications sont suivies, que vous travailliez en mode Epreuve en placard, Article
ou Mise en page. Vous pouvez afficher les modifications dans les modes Epreuve en placard, Article, mais pas dans le mode Mise en page.

 Dans le panneau Suivi des modifications (InDesign) ou la barre d’outils de suivi des modifications (InCopy), cliquez sur le bouton
Afficher/Masquer les modifications .

Désactivation du suivi des modifications
 Après avoir placé le point d’insertion dans le texte, utilisez l’une des méthodes suivantes :

Pour désactiver le suivi des modifications dans l’article actif uniquement, cliquez sur l’icône Désactiver le suivi des

modifications dans l’article actif .

(InDesign) Pour désactiver le suivi dans tous les articles, choisissez la commande Désactiver le suivi dans tous les articles
dans le menu du panneau Suivi des modifications.

(InCopy) Pour désactiver le suivi dans tous les articles ouverts d’un document contenant plusieurs articles, choisissez la
commande Modifications > Désactiver le suivi dans tous les articles.

Remarque : cela met fin au suivi des modifications, mais n’a aucune incidence sur le suivi des modifications effectué précédemment.

Acceptation ou refus des modifications
La fonction de suivi des corrections permet la révision de toutes les modifications effectuées par les différents auteurs d’un article et leur
incorporation dans cet article. Vous pouvez accepter ou ignorer toutes les corrections individuellement, globalement ou partiellement.

Lorsque vous validez une modification, celle-ci s’intègre au texte et n’est plus balisée. Lorsque vous l’ignorez, le texte d’origine est rétabli.

1. En mode éditeur (InDesign) ou en mode Epreuve en placard ou Article (InCopy), placez le point d’insertion au début de
l’article.

2. Dans le panneau Suivi des modifications (InDesign) ou la barre d’outils de suivi des modifications (InCopy), cliquez sur le
bouton Modification suivante .

3. Utilisez l’une des méthodes suivantes :

Pour valider la correction en surbrillance et l’incorporer au texte, cliquez sur le bouton Accepter la modification .

Pour ignorer la correction et restaurer le texte d’origine, cliquez sur le bouton Ignorer la modification .

Pour valider ou ignorer la modification en surbrillance et passer à la modification suivante, cliquez sur le
bouton Accepter la modification ou Ignorer la modification en maintenant la touche Alt (Windows) ou Option (Mac OS)
enfoncée.

Pour revenir à la modification précédente ou éviter une modification et passer à la suivante, cliquez sur le bouton
Modification précédente  ou Modification suivante .

Pour accepter ou ignorer toutes les modifications sans les passer en revue, cliquez sur le bouton Accepter toutes les
modifications de l’article  ou Ignorer toutes les modifications de cet article .

Pour valider ou ignorer toutes les modifications dans l’article ou le document, ou pour valider ou ignorer toutes les
modifications effectuées par un utilisateur, choisissez l’option adéquate dans le menu du panneau Suivi des modifications
(InDesign) ou dans le menu Modifications (InCopy).

Remarque : si vous changez d’avis sur une correction, vous pouvez annuler l’opération à l’aide de la commande Edition > Annuler ou à l’aide du
raccourci clavier Ctrl+Z (Windows) ou Commande+Z (Mac OS).
Les commandes Accepter les modifications et Ignorer les modifications s’appliquent également au texte conditionnel masqué.
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Définition des préférences de suivi des modifications
Les préférences permettent de définir plusieurs options de suivi. Vous pouvez choisir une couleur pour identifier vos modifications et sélectionner
les modifications à suivre : ajout, suppression ou déplacement de texte. Vous pouvez également définir l’apparence de chaque type de
modification suivie et identifier les modifications à l’aide de barres de modification de couleur dans les marges.

1. Choisissez la commande Edition > Préférences > Suivi des modifications (Windows) ou InDesign > Préférences > Suivi des
modifications (Mac OS).

2. Sélectionnez les types de modifications que vous souhaitez suivre.

3. Pour chaque type de modification, indiquez la couleur du texte, celle de l’arrière-plan et la méthode de balisage.

4. Sélectionnez l’option Empêcher la duplication des couleurs utilisateur pour veiller à ce qu’une couleur différente soit attribuée à
chacun des utilisateurs.

5. Pour afficher les barres de modification, sélectionnez l’option Barres de modification. Choisissez une couleur dans le menu
déroulant Couleur des barres de modification, puis indiquez si vous souhaitez afficher les barres de modification dans la
marge de droite ou de gauche.

6. Choisissez Inclure le texte supprimé pour la vérification orthographique si vous voulez vérifier l’orthographe du texte marqué
pour la suppression.

7. Cliquez sur le bouton OK.

Modification du nom et de la couleur de l’utilisateur
1. Choisissez Fichier > Utilisateur.
2. Indiquez le nom de l’utilisateur et la couleur à utiliser pour le suivi de modifications et les notes, puis cliquez sur OK.

Voir aussi
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Ajout de notes éditoriales
Utilisation du mode Notes
Gestion des notes
Modifications des préférences de notes

La fonction Notes d’InDesign utilise les noms d’utilisateur du flux de production pour identifier l’auteur d’une note ou d’une modification suivie. Les
notes et modifications suivies comportent des codes couleur qui varient selon l’utilisateur. Vous pouvez définir ces codes dans les préférences de
notes d’InDesign ou dans la boîte de dialogue Utilisateur d’InCopy (Fichier > Utilisateur).

Les notes apparaissent uniquement dans le texte. Dans InDesign, il est possible de les imprimer seulement en mode éditeur. De plus, elles ne
peuvent pas être exportées au format PDF.

Ajout de notes éditoriales
Lorsque vous ajoutez des notes éditoriales à un contenu géré dans InDesign, elles deviennent accessibles à vos collaborateurs dans le flux de
production. Les notes sont conçues pour être principalement utilisées avec un flux de production InCopy, mais vous pouvez aussi en tirer parti
dans InDesign. Par exemple, vous pouvez placer dans des notes du texte que vous souhaiterez peut-être insérer ultérieurement dans un article.
Dans InCopy, lorsque vous exportez au format Adobe PDF, les notes peuvent être converties en commentaires PDF.

1. A l’aide de l’outil Texte, cliquez à l’endroit où vous souhaitez placer la note, puis choisissez Texte > Notes > Nouvelle note.

Lorsque vous effectuez des modifications en mode éditeur, le serre-livres apparaît. En mode Mise en page, le panneau Notes
apparaît.

2. Saisissez la note entre les serre-livres de la note ou saisissez-la dans le panneau Notes.

Vous pouvez insérer autant de notes que vous le souhaitez n’importe où dans le texte. Cependant, vous ne pouvez pas créer de note dans une
autre note.

Pour afficher ou masquer les notes, choisissez Affichage > Extras > Afficher les notes ou Masquer les notes.

Utilisation du mode Notes
Le mode Notes permet d’ajouter, de scinder ou de supprimer facilement des notes en fonction de l’emplacement du point d’insertion ou du texte
sélectionné.

1. Utilisez l’une des méthodes suivantes :

Pour créer une note, placez le point d’insertion dans le texte.

Pour convertir le texte en note, sélectionnez le texte.

Pour scinder une note, placez le point d’insertion dans une note.

Pour convertir la note en texte, sélectionnez le serre-livres de la note (en Mode éditeur).

Pour placer le point d’insertion à l’extérieur d’une note, insérez-le au début ou à la fin de la note.

2. Choisissez Texte > Notes > Mode Notes.

Gestion des notes
Le point d’ancrage de la note  indique l’emplacement d’une note. Le panneau Notes affiche le contenu de la note, ainsi que des informations
spécifiques sur cette note.

Pour convertir du texte en note, sélectionnez-le et choisissez Texte > Notes > Convertir en note. Une nouvelle note est créée.
Le texte sélectionné est supprimé de l’article et collé dans la nouvelle note. L’ancrage ou le serre-livres de la note apparaît à
l’endroit où le texte sélectionné a été coupé.

Pour convertir une note en texte, sélectionnez le texte à ajouter au texte du document dans le panneau Notes ou, en mode
éditeur, sélectionnez le texte de la note texte. Choisissez ensuite Texte > Notes > Convertir en texte.

Pour scinder une note, placez le point d’insertion dans la note à l’endroit où vous souhaitez qu’elle soit scindée, puis
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choisissez Texte > Notes > Scinder la note.

Pour passer d’une note à une autre, cliquez sur le point d’insertion dans l’article, puis choisissez Texte > Notes > Note
précédente ou Texte > Notes > Note suivante.

Modifications des préférences de notes
Les préférences permettent de définir la couleur des notes ancrées, des serre-livres et des arrière-plans lorsqu’ils sont incorporés en mode
éditeur. Vous pouvez choisir d’afficher les informations sur la note dans une info-bulle, d’inclure le contenu de la note lors d’opérations de
recherche et de remplacement et de vérifier l’orthographe en mode éditeur.

1. Choisissez Edition > Préférences > Notes (Windows) ou InDesign > Préférences > Notes (Mac OS).

2. Sélectionnez une couleur pour les ancres et les serre-livres des notes dans le menu déroulant Couleur des notes.
Sélectionnez [Couleur utilisateur] pour utiliser la couleur indiquée dans la boîte de dialogue utilisateur. Cette fonction est très
utile lorsque plusieurs personnes travaillent sur le fichier.

3. Sélectionnez Afficher les infos-bulles des notes pour afficher des informations relatives aux notes et une partie ou l’ensemble
du contenu de la note dans une info-bulle lorsque le curseur passe sur l’ancrage d’une note en mode Mise en page ou sur un
serre-livres de note en mode éditeur.

4. Indiquez si vous souhaitez inclure le contenu de la note texte lors de l’utilisation des commandes Rechercher/Remplacer et
Orthographe (en mode éditeur uniquement).

Remarque : en mode Mise en page, vous ne pouvez pas utiliser les commandes Rechercher/Remplacer et Orthographe pour
le contenu des notes, quels que soient les paramètres de la boîte de dialogue Préférences. Néanmoins, l’option Tout
remplacer modifie le contenu des notes.

5. Sélectionnez [Sans] ou [Couleur de note] (la couleur choisie à l’étape 2) pour définir la couleur de fond d’une note texte.

6. Cliquez sur le bouton OK.

Voir aussi
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Création d’un article lié
Définition des options de l’article lié
Mise à jour d’un article lié
Modification de l’article original

La réplication de contenus d’une page à l’autre n’est pas chose simple, sans compter que les manipulations de contenu par copier-coller
favorisent le risque d’erreur et prennent un temps considérable. Les articles liés se révèlent des plus utiles pour gérer plusieurs versions d’un
article ou contenu textuel dans un seul et même document. Les articles liés simplifient la prise en charge des nouveaux flux de travail, qui
supposent notamment d’élaborer des mises en page verticale et horizontale. Les articles liés se prêtent tout aussi bien aux flux de travail de
l’univers traditionnel de l’impression et de la publication, qui peuvent nécessiter la synchronisation du texte standard sur plusieurs pages.

Le principe des articles liés s’apparente à celui des liens traditionnels Vous pouvez définir un article comme parent puis placer ce même article à
d’autres endroits dans le document comme articles enfants. A chaque mise à jour de l’article parent, les articles enfants sont signalés dans le
panneau Liens, ce qui vous permet de les mettre à jour et ainsi de les synchroniser avec l’article parent. Vous pouvez créer des articles liés en
utilisant des articles ordinaires ou des articles de texte curviligne. Les objets ancrés intra-articles sont également compatibles.

Les articles liés restent synchronisés même après la mise à jour d’un style InDesign appliqué.

Les articles liés sont signalés comme étant désynchronisés dans le panneau Liens, même si aucun changement n’est visible. Si des modifications
globales apportées au document entraînent la recomposition des articles, les liens correspondants sont signalés. Ces modifications globales
peuvent résulter des mises à jour apportées aux options ou aux définitions des éléments suivants :

Notes de bas de page

Variables de texte

Texte conditionnel

Nuancier

Balises XML

Grilles nommées

Par ailleurs, si vous remplacez toutes les polices ou toutes les instances d’un objet, InDesign recompose tous les articles et balise les liens.

Création d’un article lié
1. Sélectionnez un article soit en sélectionnant son bloc de texte, soit en plaçant le curseur d’insertion dans le texte. Si vous

choisissez de sélectionner le bloc de texte, vous pouvez sélectionner plusieurs articles en cliquant dessus tout en maintenant
la touche Maj enfoncée.

2. Choisissez Edition > Importer et lier l’article. L’article est chargé dans le curseur.

3. Cliquez à l’intérieur d’un bloc de texte vide existant ou tracez un bloc pour y placer l’article lié.

L’icône  apparaît dans l’angle supérieur gauche d’un article lié. L’article apparaît comme article lié dans le panneau Liens. Par défaut, le nom
de l’article affiché dans le panneau Liens emprunte les premiers caractères de l’article original.

Vous pouvez également changer le nom par défaut de l’article lié à partir du panneau Calques.

Définition des options de l’article lié

1. Dans le panneau Liens, sélectionnez l’article lié.

2. Dans le menu du panneauLiens, choisissez Options d’article lié.

3. Sélectionnez les options qui vous conviennent :
Mettre à jour le lien lors de l’enregistrement du document

Avertir si la mise à jour des liens remplace les modifications locales
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Supprimer les sauts de ligne forcés

Conseil : pour définir les options d’article par défaut, fermez tous les documents ouverts, ouvrez le menu du panneau Liens, puis choisissez
Options d’article lié.

Conseil : pour définir les options de l’article lié pendant sa création, choisissez Edition > Importer et lier l’article tout en maintenant la touche Maj
enfoncée.

Mise à jour d’un article lié
En cas de modification d’un article original, l’icône  apparaît en regard de l’article lié dans le panneau Liens.

Dans le panneau Liens, cliquez deux fois sur l’icône  pour mettre à jour l’article enfant.

Si vous avez apporté des modifications locales à un article enfant, celles-ci sont remplacées par le contenu de l’article original. Si vous avez
sélectionné l’option Avertir si la mise à jour des liens remplace les modifications locales, un message d’avertissement s’affiche.

A l’aide du volet Informations sur les liens, déterminez si vous avez apporté des modifications locales à l’article ; le cas échéant, l’article affiche
l’état « Texte modifié ».

Modification de l’article original
Pendant que vous travaillez sur un article lié, si vous avez besoin d’accéder à l’article original, procédez comme suit :

1. Dans le panneau Liens, sélectionnez l’article lié.

2. Cliquez sur  ou choisissez Modifier l’original dans le menu du panneau Liens ( ).

La page contenant l’article original devient active.
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About markers

InDesign inserts a marker in text for items such as index entries, XML tags, and hyperlink text and anchors. These
markers have no width and they don’t affect composition of text. However, you can select these markers and cut,
copy, or delete them. InDesign uses the location of the marker to produce an accurate bookmark or page
reference in the table of contents, index, and exported PDF files.

You can view all markers at once, or view hyperlink or tagged text markers only. You can also view markers in
Story Editor, where they are larger and easier to identify.

Note:

When you select a word, all of its markers are also selected. Keep this in mind when you are cutting, copying, or
deleting text.

Types of markers

A. Tagged text B. Index marker C. Hyperlink 

View markers

To display markers, choose Type > Show Hidden Characters.
To view hyperlink markers only, choose View > Extras > Show Hyperlinks.
To view tagged text markers only, choose View > Structure > Show Tag Markers.

Select markers
1. Choose Type > Show Hidden Characters.
2. Place the insertion point next to the marker.
3. Holding down Shift, press the Left Arrow or Right Arrow key to select a marker.

You can also locate markers using different methods. For example, you can locate an index marker by choosing the
Go To Selected Marker option in the Index panel menu.
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Effacement des remplacements de styles d’objet
Rupture du lien à un style d’objet
Modification du nom d’un style d’objet
Modification des styles d’objet
Suppression d’un style d’objet
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A propos des styles d’objet

De la même façon que vous pouvez utiliser les styles de paragraphe et de caractère pour mettre en forme rapidement un texte, vous pouvez
utiliser des styles d’objet pour mettre en forme rapidement des graphiques et des blocs. Les styles d’objet comprennent les paramètres de contour,
couleur, transparence, ombres portées, styles de paragraphe, habillage, etc. Vous pouvez attribuer différents effets de transparence à l’objet, au
fond, au contour et au texte.

Vous pouvez appliquer les styles d’objet aux objets, aux groupes et aux blocs (y compris les blocs de texte). Un style peut effacer et remplacer
l’ensemble des paramètres d’un objet ou remplacer uniquement des paramètres spécifiques et laisser les autres paramètres tels quels. Vous
pouvez contrôler les paramètres affectés par le style en incluant ou en excluant une catégorie de paramètres dans la définition.

Vous pouvez également appliquer des styles d’objet à des grilles de bloc. Par défaut, toute nouvelle grille de bloc créée utilise le style d’objet
[Grille standard]. Vous pouvez modifier le style [Grille standard] ou appliquer d’autres styles d’objet à la grille. Lorsque vous créez ou modifiez un
style d’objet pour une grille de bloc, utilisez la section Options d’article pour spécifier le sens de l’écriture, le type de bloc et la grille nommée.

Lors de la création de styles, certains styles peuvent partager des caractéristiques identiques. Au lieu d’indiquer ces caractéristiques à chaque fois
que vous définissez le style suivant, vous pouvez créer un style d’objet à partir d’un autre. Lorsque vous changez le style de base, les attributs
partagés du style « parent » changent également dans le style « enfant ».

Présentation du panneau Styles d’objet

Utilisez le panneau Styles d’objet pour créer, nommer et appliquer des styles d’objet. Pour chaque nouveau document, le panneau énumère une
liste par défaut des styles d’objet. Les styles sont enregistrés avec un document et s’affichent dans le panneau à chaque ouverture de ce
document. L’icône Bloc de texte  désigne le style par défaut des blocs de texte, et l’icône Bloc graphique  désigne le style par défaut des blocs
graphiques et des formes de dessin.

Utilisez le panneau Styles d’objet pour créer, nommer et appliquer des styles d’objet. Pour chaque nouveau document, le panneau énumère une
liste par défaut des styles d’objet. Les styles sont enregistrés avec un document et s’affichent dans le panneau à chaque ouverture de ce
document. L’icône Bloc de texte  marque le style par défaut pour les blocs de texte ; l’icône Bloc graphique  marque le style par défaut pour
les blocs graphiques ; l’icône Grille  marque le style par défaut pour les grilles de bloc.

Ouverture du panneau Styles d’objet
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Choisissez Fenêtre > Styles > Styles d’objet.

Modification de l’affichage des styles d’objet dans la liste du panneau

Dans le menu de panneau, sélectionnez Petites rangées de panneau pour afficher une version condensée des styles d’objet.
Faites glisser le style d’objet vers un autre emplacement. Relâchez le bouton de la souris lorsqu’une ligne noire s’affiche à
l’emplacement souhaité.
Pour afficher les styles d’objet par ordre alphabétique, choisissez Trier par nom dans le menu du panneau.

Définition des styles d’objet

Vous pouvez définir un style à partir de paramètres déjà appliqués à un objet ou créer un style de toutes pièces à partir d’un autre style.

1. Sélectionnez l’objet ou le bloc de texte qui utilise les paramètres à inclure au style d’objet.

2. Choisissez Nouveau style d’objet dans le menu du panneau Styles d’objet ou cliquez sur le bouton Créer un nouveau style
tout en maintenant la touche Alt (Windows) ou Option (Mac OS) enfoncée.

3. Dans la boîte de dialogue Nouveau style d’objet, indiquez le nom du style.

4. Pour créer un style à partir d’un autre style, choisissez un style dans la liste déroulante D’après.

l’option D’après permet de lier les styles entre eux, de sorte que les modifications d’un style se répercutent sur
les styles enfants. Si vous avez modifié la mise en forme d’un style enfant et que vous décidez de tout reprendre à zéro,
cliquez sur le bouton Réinitialiser par défaut. La mise en forme du style enfant redevient celle du style sur lequel il repose.

5. Pour ajouter un raccourci clavier, placez le point d’insertion dans la zone Raccourci et assurez-vous que le verrouillage
numérique est activé. Maintenez enfoncée la combinaison de touches Alt+Maj+Ctrl (Windows) ou Option+Maj+Commande
(Mac OS), puis appuyez sur un chiffre du pavé numérique. Vous ne pouvez pas utiliser de lettres ni de nombres hors du pavé
numérique pour définir des raccourcis de style.

6. Dans Attributs de base, sélectionnez les catégories dont vous souhaitez définir les options et paramétrez-les à votre
convenance. Activez la case située à gauche de chaque catégorie pour choisir de l’ignorer ou pas dans le style.

Utilisez la catégorie Options d’article pour spécifier le sens de l’écriture, le type de bloc et la grille nommée d’un style d’objet
de grille. La grille nommée stocke les paramètres de grille de bloc qui peuvent être appliqués à toute grille de bloc.

7. Pour appliquer des effets, choisissez une option dans Effets (Objet, Contour, Fond ou Texte), puis sélectionnez des catégories
d’effets et définissez leurs paramètres. Vous pouvez définir divers effets pour chaque catégorie. Indiquez les catégories
d’effets à activer, à désactiver ou à ignorer dans le style.

8. Sous Options d'exportation, sélectionnez une option et spécifier les paramètres d'exportation de l'option. Vous pouvez définir
le texte de remplacement (Alt) pour les images et les graphiques importés. Pour les fichiers PDF balisés, vous pouvez
appliquer les balises et les paramètres de texte réel. Pour les fichiers HTML et EPUB dispositions, vous pouvez spécifier
différents paramètres de conversion pour chaque objet pour un rendu de qualité quelles que soient la taille d'écran et de
densité de pixels différentes.
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Options d’exportation

les options d’exportation d’objet permettent de spécifier les paramètres d’exportation nécessaires pour exporter
des objets dans des formats différents, notamment EPUB, HTML ou PDF accessible. Ces options sont applicables aux blocs
de texte, aux blocs graphiques et aux groupes. Voir la rubrique Options d’exportation d’objet.

9. Cliquez sur le bouton OK.

Catégories de style d’objet

Si vous souhaitez que le style applique uniquement certains attributs sans modifier les autres paramètres, vérifiez l’état des catégories devant être
contrôlées par le style. Trois états sont possibles pour chaque catégorie : activée, désactivée ou ignorée. Par exemple, lorsque vous activez la
case Ombre portée, la mise en forme correspondante est incluse dans le style d’objet. Lorsque vous désélectionnez la case Ombre portée, l’ombre
portée est désactivée dans le style (toute ombre portée appliquée à un objet s’affiche en tant que remplacement). Si vous définissez la
case Ombre portée sur « Ignorer » (s’affiche sous forme de petite case sous Windows ou de tiret sous Mac OS), l’effet d’ombre portée est exclus
du style. De ce fait, aucune ombre portée appliquée au style ne s’affiche en tant que remplacement.

Catégories de style d’objet

A. Activée B. Ignorée C. Désactivée 

les catégories dont les paramètres peuvent être activés ou désactivés de manière individuelle, tels que Fond, Contour et
Transparence, disposent de deux états uniquement. Elles peuvent être activées ou ignorées.

La catégorie Styles de paragraphe est désactivée par défaut, même si vous êtes en train de créer un bloc de texte. Cette catégorie est applicable
uniquement si l’objet est un bloc de texte sans lien.

http://idiom-q-win-1/fr/indesign/using/frames-objects.html#object_export_options_cc_cs6_cs5_5
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Application de styles d’objet

Si vous appliquez un style d’objet à un groupe d’objets, le style est appliqué à chacun des objets du groupe. Pour appliquer un style d’objet à un
groupe d’objets, imbriquez ces derniers à l’intérieur d’un bloc. (L’une des méthodes pour coller un objet dans un bloc consiste à utiliser la
commande Edition > Coller dedans.)

1. Sélectionnez un objet, un bloc ou un groupe.

2. Cliquez sur un style d’objet dans le panneau Contrôle ou le panneau Styles d’objet pour appliquer un style.

Si vous choisissez la commande Effacer les remplacements pendant l’application du style dans le panneau Styles d’objet, il suffit de cliquer sur un
style d’objet pour effacer les remplacements par défaut. Si cette option n’est pas activée, vous pouvez cliquer en maintenant la touche Alt
(Windows) ou Option (Mac OS) enfoncée sur le style d’objet afin d’effacer les remplacements tout en appliquant le style.

Vous pouvez également faire glisser un style d’objet sur un objet pour appliquer celui-ci sans avoir auparavant sélectionné l’objet.

Si un groupe est sélectionné lorsque vous appliquez un style d’objet, ce style est appliqué à chaque objet du groupe.

Une fois le style appliqué, vous pouvez appliquer d’autres paramètres à l’objet selon votre convenance. Vous remplacerez peut-être un paramètre
défini dans le style, mais vous ne perdrez pas le lien avec ce style.

Utilisation des styles d’objet par défaut

Pour chaque nouveau document, le panneau énumère une liste par défaut des styles d’objet. Lorsque vous créez un objet, un style d’objet lui est
appliqué. Par défaut, si vous créez un bloc de texte, le style d’objet appliqué est le style [Bloc de texte standard]. Si vous dessinez un tracé ou une
forme, le style d’objet appliqué est le style [Bloc graphique standard]. Si vous importez une image ou dessinez un emplacement réservé
comportant un X, le style d’objet appliqué est le style [Sans]. Vous pouvez sélectionner un autre style d’objet par défaut pour les blocs de texte et
les blocs graphiques.

Pour chaque nouveau document, le panneau énumère une liste par défaut des styles d’objet. Lorsque vous créez un objet, un style d’objet lui est
appliqué. Par défaut, si vous créez un bloc de texte, le style d’objet appliqué est le style [Bloc de texte standard]. Si vous placez une image ou
tracez une trajectoire ou forme, le style d’objet appliqué est le style [Bloc graphique standard]. Si vous créez une grille de bloc, le style d’objet
[Grille standard] est appliqué. Si vous tracez un emplacement réservé comportant un X, le style d’objet appliqué est le style [Sans]. Vous pouvez
sélectionner un autre style d’objet à utiliser par défaut pour chacun de ces types d’objet.

Pour modifier le style d’un bloc de texte par défaut, choisissez Style de bloc de texte par défaut dans le menu du panneau
Styles d’objet, puis sélectionnez le style d’objet.
Pour modifier le style d’un bloc graphique par défaut, choisissez Style de bloc graphique par défaut dans le menu du panneau
Styles d’objet, puis sélectionnez le style d’objet.
Les blocs de substitution de graphique (contenant un X), utilisent toujours le style [Aucun] comme paramètre par défaut. Vous
ne pouvez pas spécifier un style d’objet par défaut.
Pour modifier le style par défaut d'une grille, choisissez Style de grille par défaut dans le menu du panneau Styles d’objet, puis
sélectionnez le style d’objet.
Pour modifier le style par défaut d’un type d’objet, faites glisser l’icône qui indique le type d’objet par défaut d’un style d’objet
vers un autre.

si vous sélectionnez un style d’objet alors qu’aucun bloc n’est sélectionné, ce style d’objet devient le nouveau style d’objet par défaut
pour le texte ou les graphiques, selon l’objet sélectionné dans la panneau Outils.

si vous sélectionnez un style d’objet alors qu’aucun bloc n’est sélectionné, ce style devient le nouveau style d’objet par défaut pour
les blocs de texte, graphiques ou de grille, selon l’objet sélectionné dans le panneau Outils.

Vous pouvez modifier les styles [Standard], mais vous ne pouvez pas les supprimer.

Effacement des remplacements de styles d’objet
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Lorsque la mise en forme d’un objet est en conflit avec une partie de la définition de style appliquée à cet objet, il s’agit d’un remplacement.
Lorsque vous sélectionnez un objet avec un remplacement, un signe plus (+) s’affiche en regard du nom du style.

Utilisez la commande Effacer les remplacements pour remplacer toute mise en forme active ou non active dans le style d’objet ; utilisez la
commande Effacer les attributs non définis par le style pour effacer les attributs ignorés.

Effacement des remplacements de styles d’objet

1. Sélectionnez l’objet ou le groupe à modifier.

2. Cliquez sur le bouton Effacer les remplacements  situé au bas du panneau Styles d’objet.

Un remplacement s’affiche uniquement si l’attribut appliqué fait partie du style.

Pour supprimer des attributs ignorés dans un style d’objet

Vous pouvez également supprimer les attributs d’un objet même si ces derniers sont ignorés dans un style. Par exemple, si la catégorie Fond est
ignorée dans un style d’objet et que vous appliquez un fond rouge à un bloc auquel le style d’objet est appliqué, choisissez la commande Effacer
les attributs non définis par le style pour supprimer le fond rouge.

si une catégorie de style d’objet est désactivée (non cochée) et non pas ignorée, la commande Effacer les remplacements vous
permet de remplacer le style.

1. Sélectionnez l’objet ou le groupe à modifier.

2. Cliquez sur le bouton Effacer les attributs non définis par le style  situé au bas du panneau Styles d’objet.

Rupture du lien à un style d’objet

Vous pouvez rompre le lien entre un objet et le style qui lui est appliqué. L’objet conserve les mêmes attributs, mais ne change pas si le style est
modifié.

1. Sélectionnez l’objet auquel le style d’objet est appliqué.

2. Dans le menu du panneau Styles d’objet, choisissez Rompre le lien au style.

Si vous ne souhaitez pas conserver la mise en forme d’un style d’objet, choisissez [Sans] dans le panneau Styles d’objet.

Modification du nom d’un style d’objet

1. Assurez-vous qu’aucun objet n’est sélectionné afin qu’aucun style ne soit appliqué par erreur.

2. Dans le panneau Styles d’objet, cliquez deux fois sur le style à renommer.

3. Dans la boîte de dialogue Options de style d’objet, indiquez le nouveau nom du style, puis cliquez sur OK.

Vous pouvez modifier un style d’objet directement dans le panneau. Cliquez sur le style, attendez quelques secondes, puis cliquez à nouveau
pour modifier le nom du style.

Modification des styles d’objet

1. Utilisez l’une des méthodes suivantes :

Pour ne pas appliquer le style au bloc sélectionné ou pour le définir en tant que style par défaut, cliquez avec le bouton
droit de la souris (Windows) ou tout en maintenant la touche Contrôle enfoncée (Mac OS) sur le nom du style dans le
panneau Styles d’objet, puis choisissez Modifier [nom de style].
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Cliquez deux fois sur le nom du style dans le panneau Styles d’objet, ou sélectionnez le style et choisissez Options de
style dans le menu du panneau Styles. Le style est alors appliqué à tous les objets sélectionnés, ou bien il devient le type
d’objet par défaut.

2. Dans la boîte de dialogue Options de style d’objet, sélectionnez la catégorie qui contient les options que vous voulez modifier,
puis modifiez les paramètres souhaités.

3. Choisissez si vous voulez activer, désactiver ou ignorer les catégories de style d’objet.

4. Cliquez sur le bouton OK.

Suppression d’un style d’objet

1. Dans le panneau Styles d’objet, sélectionnez un style d’objet.

2. Choisissez Supprimer le style dans le menu du panneau ou faites glisser le style vers l’icône de suppression située au bas du
panneau.

3. Si vous supprimez un style appliqué à des objets ou servant à créer d’autres styles, vous êtes invité à indiquer un style de
remplacement dans la boîte de dialogue Supprimer le style d’objet. Utilisez l’une des méthodes suivantes :

Pour redéfinir le style d’objets qui utilisaient le style supprimé, choisissez le style à appliquer aux objets, puis cliquez sur le
bouton OK.

Pour que les objets ne soient pas modifiés, choisissez [Sans], assurez-vous que la case Conserver la mise en forme est
activée, puis cliquez sur OK. Tous les objets utilisant le style supprimé conservent les même attributs, mais ne sont plus
associés à aucun style.

Pour supprimer tous les paramètres d’attribut que vous avez appliqués, choisissez [Sans], désactivez la case Conserver la
mise en forme, puis cliquez sur OK.

pour supprimer tous les styles qui ne sont pas appliqués aux objets, choisissez Sélectionner tous les styles inutilisés dans le menu
du panneau Styles d’objet, puis cliquez sur l’icône de suppression.

Redéfinition d’un style d’objet

Après avoir appliqué un style d’objet, vous pouvez remplacer n’importe lequel de ses paramètres. Si les modifications apportées à un objet
particulier vous conviennent, vous pouvez en redéfinir le style afin qu’il corresponde à la mise en forme de l’objet que vous avez modifié. N’oubliez
pas que la commande Redéfinir le style d’objet redéfinit uniquement les catégories qui sont activées ou désactivées et non les catégories
ignorées. Si l’objet inclut d’autres paramètres, vous devez les ajouter indépendamment du style ou simplement créer un style d’objet.

1. Sélectionnez un objet qui utilise le style à modifier.

2. Modifiez les attributs d’apparence selon votre convenance.

3. Dans le menu du panneau Styles d’objet, choisissez Redéfinir le style.

La définition du style d’objet est modifiée pour correspondre aux paramètres de remplacement que vous avez appliqués. Toutes les occurrences
du style d’objet dans le document sont mises à jour en fonction des nouveaux paramètres.

si l’option Redéfinir le style d’objet n’est pas disponible, les attributs que vous avez définis ne font pas partie de la définition de style
d’objet. Pour modifier directement la définition de style, choisissez Options de style d’objet ou créez un style à partir de l’objet.

Importation de styles d’objet

Vous pouvez importer des styles à partir d’autres documents. En plus des styles d’objet eux-mêmes, InDesign importe tous les nuanciers, contours
personnalisés, styles de caractère ou de paragraphe utilisés dans les styles. Si un nuancier, un contour ou un style de paragraphe importé porte le
même nom qu’un nuancier ou un style existant mais a une valeur différente, InDesign le renomme.
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Utiliser la définition du style importé

Renommer automatiquement

Si les styles d’objet que vous importez comprennent des grilles nommées, celles-ci sont également importées.

1. Dans le menu du panneau Styles d’objet, choisissez Charger les styles d’objet.

2. Sélectionnez le fichier à partir duquel importer des styles d’objet, puis cliquez sur Ouvrir.

3. Dans la boîte de dialogue Charger des styles, assurez-vous qu’une coche apparaît en regard des styles à importer. En cas de
conflit entre noms de style, sélectionnez l’une des options suivantes sous Conflit avec le style existant, puis cliquez sur OK :

Ecrase le style existant avec le style chargé et applique ses nouveaux attributs à tous
les objets du document actuel qui utilisait l’ancien style. Les définitions des styles chargés et existants s’affichent au bas de la
boîte de dialogue Charger des styles pour faciliter la comparaison.

Renomme le style chargé.

Les styles d’objet apparaissent dans le panneau Styles d’objet.

Adobe recommande également

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr
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A propos des styles de caractère et de paragraphe

Un style de caractère rassemble tous les attributs de mise en forme applicables simultanément à un texte. Un style de paragraphe comprend les
attributs de mise en forme de caractère et de paragraphe, et peut être appliqué à un ou plusieurs paragraphes. Les styles de paragraphes et les
styles de caractères sont disponibles à partir de panneaux différents. Les styles de paragraphe et de caractères sont parfois appelés styles de
texte.

Il est possible d’appliquer un format de grille nommée à une grille de bloc dans les paramètres Grille de bloc. (voir Présentation du panneau Grilles
nommées). Vous pouvez également créer un style d’objet avec des caractéristiques de grille (voir A propos des styles d’objet).

Lorsque vous modifiez la mise en forme d’un style, l’ensemble du texte auquel il a été appliqué est réactualisé avec le nouveau format.

Vous pouvez créer, modifier et supprimer des styles dans les documents Adobe InCopy ou du contenu InCopy lié à un document Adobe
InDesign CS4. Lorsque du contenu est mis à jour dans InDesign, de nouveaux styles sont ajoutés au document InDesign, mais toutes les
modifications de style effectuées dans InCopy sont remplacées par le style InDesign. Dans le cas de contenu lié, il est généralement recommandé
de gérer les styles dans InDesign.

Styles [Paragraphe standard]

Par défaut, chaque nouveau document comprend un style [Paragraphe standard] qui s’applique au texte saisi. Vous pouvez modifier ce style, mais
vous ne pouvez pas le renommer, ni le supprimer. Vous pouvez renommer et supprimer uniquement les styles que vous créez. Vous pouvez
également sélectionner un autre style par défaut pour l’appliquer au texte.

Attributs de style de caractère

Contrairement aux styles de paragraphe, les styles de caractère ne comprennent pas tous les attributs de mise en forme du texte sélectionné.
Lorsque vous créez un style de caractère, InDesign enregistre uniquement dans ce style les attributs différents de la mise en forme du texte
sélectionné. Ainsi, vous pouvez créer un style de caractère qui, lorsqu’il est appliqué au texte, ne modifie que certains attributs, tel que la famille et
la taille de la police, tout en ignorant tous les autres attributs de caractère. Si vous voulez que d’autres attributs soient enregistrés sous ce style,
ajoutez-les lorsque vous modifiez le style.

Style suivant

http://idiom-q-win-1/fr/indesign/using/formatting-grids.html#named_grids_panel_overview
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Remarque :

Vous pouvez appliquer des styles automatiquement à mesure que vous tapez. Si, par exemple, vous souhaitez que le style « Corps de texte » soit
suivi d’un style de titre appelé « Titre 1 » dans votre document, vous pouvez indiquer « Titre 1 » pour l’option Style suivant de « Corps de texte ».
Après avoir saisi un paragraphe en style « Titre 1 », appuyez sur la touche Entrée ou Retour pour commencer un nouveau paragraphe en style
« Corps de texte ».

Si vous utilisez le menu contextuel pour appliquer un style à plusieurs paragraphes, vous pouvez choisir d’appliquer le style parent au premier
paragraphe et le style suivant aux autres paragraphes (voir Application de styles).

Pour utiliser la fonction Style suivant, choisissez un style dans le menu Style suivant lors de la création ou de la modification d’un style.

Jeff Witchel propose un didacticiel vidéo sur l’utilisation de la fonction Style suivant intitulé Using the Next Style feature (en anglais uniquement).

Présentation du panneau Styles

Utilisez le panneau Styles de caractère pour créer, nommer et appliquer des styles de caractère à une partie de texte d’un paragraphe ; utilisez le
panneau Styles de paragraphe pour créer, nommer et appliquer des styles de paragraphe à des paragraphes entiers. Les styles sont enregistrés
avec un document et s’affichent dans le panneau à chaque ouverture de ce document.

Lorsque vous sélectionnez du texte ou que vous placez le point d’insertion, tout style appliqué à ce texte est mis en surbrillance dans l’un des
panneaux Styles, à moins que le style ne figure dans un groupe de style réduit. Si vous sélectionnez une plage de texte comprenant plusieurs
styles, aucun style n’est mis en surbrillance dans le panneau Styles. Si vous sélectionnez une plage de texte à laquelle plusieurs styles sont
appliqués, le panneau Styles affiche « (Mixte) ».

Pour ouvrir le panneau Styles de paragraphe

Pour afficher le panneau Styles de paragraphe, choisissez Texte > Styles de paragraphe ou cliquez sur l’onglet Styles de
paragraphe qui apparaît par défaut sur le côté droit de la fenêtre d’application.

Pour ouvrir le panneau Styles de caractère

Choisissez Texte > Styles de caractère ou cliquez sur l’onglet Styles de caractère à droite de la fenêtre d’application.

Ajout de styles de paragraphe et de caractère

Si les styles recherchés existent déjà dans un autre document InCopy ou InDesign, vous pouvez les importer dans le document actif. Lorsque
vous travaillez sur un article autonome, InCopy permet de définir des styles de caractère et de paragraphes.

Définition de styles de paragraphe ou de caractère

1. Pour créer un style à partir de la mise en forme d’un texte existant, sélectionnez le texte mis en forme ou placez-y le point
d’insertion.

Si un groupe est sélectionné dans le panneau Styles, le nouveau style fera partie de ce groupe.

2. Choisissez Nouveau style de paragraphe dans le menu du panneau Styles de paragraphe ou Nouveau style de caractère
dans le menu du panneau Styles de caractère.

3. Pour l’option Nom du style, entrez le nom du nouveau style.

4. Dans la liste D’après, sélectionnez le nom du style sur lequel repose le style actuel.

l’option D’après permet de lier les styles entre eux, de sorte que les modifications d’un style se répercutent sur
les styles enfants. Par défaut, les nouveaux styles sont définis sur [Aucun style de paragraphe] pour les styles de paragraphe
ou [Aucun] pour les styles de caractère, ou bien sur le style du texte actuellement sélectionné.

5. Pour l’option Style suivant (panneau Styles de paragraphe uniquement), indiquez le nom du style appliqué à la suite du style
actuel lorsque vous appuyez sur la touche Entrée ou Retour.

6. Pour ajouter un raccourci clavier, placez le point d’insertion dans la zone Raccourci et assurez-vous que le verrouillage

http://www.layersmagazine.com/using-the-next-style-paragraph-feature-in-indesign.html


numérique est activé. Maintenez une combinaison de touches Alt, Maj et Ctrl (Windows) ou Option, Maj et Commande
(Mac OS) enfoncée, puis appuyez sur un chiffre du pavé numérique. Vous ne pouvez pas utiliser de lettres ni de nombres
hors du pavé numérique pour définir des raccourcis de style. Si votre clavier ne comporte pas une touche de verrouillage
numérique, vous ne pouvez pas ajouter de raccourcis clavier aux styles.

7. Si vous souhaitez que le nouveau style soit appliqué au texte sélectionné, choisissez Appliquer le style à la sélection.

8. Pour spécifier les attributs de mise en forme, cliquez sur une catégorie (Formats de caractères de base, par exemple) sur la
gauche, puis spécifiez les options à ajouter au style.

Lorsque vous spécifiez une couleur de caractère dans la boîte de dialogue Options de style, vous créez une couleur en
cliquant deux fois dans la case du fond ou du contour.

9. Pour les styles de caractère, les attributs non spécifiés sont ignorés ; lorsque le style est appliqué, le texte conserve la mise en
forme du style de paragraphe de cet attribut. Pour supprimer un paramètre d’attribut d’un style de caractère :

Dans le menu d’un paramètre, choisissez (Ignorer).

Dans une zone de texte, supprimez le texte de l’option.

Dans une case à cocher, cliquez jusqu’à ce qu’une petite case (Windows) ou un trait (-) (Mac OS) s’affiche.

Pour une couleur de caractère, maintenez la touche Ctrl (Windows) ou Commande (Mac OS) enfoncée en cliquant sur la
nuance de couleur.

10. Cliquez ensuite sur OK.

Les styles que vous créez s’affichent uniquement dans le document actif. Si aucun document n’est ouvert, les styles que vous créez apparaîtront
dans tous les nouveaux documents.

Création d’un style de paragraphe ou de caractère à partir d’un style existant

De nombreux modèles de document sont dotés de hiérarchies de styles partageant certains attributs. Les titres et les sous-titres, par exemple,
utilisent souvent la même police. Vous pouvez facilement établir des liens entre des styles similaires en créant un style de base ou parent. Lorsque
vous modifiez le style parent, les styles enfants sont également modifiés. Vous pouvez ensuite modifier les styles enfants pour les différencier du
style parent.

Pour créer un style approximativement identique à un autre style, mais sans relation parent-enfant, utilisez la commande Dupliquer un style,
puis modifiez la copie.

1. Créez un style.

2. Dans le menu déroulant D’après de la boîte de dialogue Nouveau style de paragraphe ou Nouveau style de caractère,
sélectionnez le style parent. Le nouveau style devient le style enfant.

Par défaut, les nouveaux styles sont définis sur [Aucun style de paragraphe] ou [Sans], ou sur le style du texte actuellement
sélectionné.

3. Spécifiez la mise en forme du nouveau style pour le différencier du style sur lequel il repose. Par exemple, vous pouvez
décider de diminuer légèrement la taille de police du sous-titre par rapport à celle utilisée dans le style de titre (parent).

Si vous avez modifié la mise en forme d’un style enfant et que vous décidez de tout reprendre à zéro, cliquez sur le bouton Réinitialiser à la
base. La mise en forme du style enfant redevient celle du style sur lequel il repose. Vous pouvez ensuite spécifier une nouvelle mise en forme.
De même, si vous modifiez le style D’après du style enfant, la définition du style enfant est mise à jour afin de correspondre au nouveau style
parent.

Importation des styles à partir d’autres documents

Vous pouvez importer des styles de paragraphe et de caractère d’un autre document InDesign (quelle que soit la version) vers le document actif.
Pendant l’importation, vous pouvez définir les styles chargés et indiquer ce qui doit se passer lorsqu’un style chargé porte le même nom qu’un
style du document actuel. Vous pouvez également importer des styles à partir d’un document InCopy.

Vous pouvez importer des styles de paragraphe ou de caractère à partir d’un document InDesign ou InCopy dans un document InCopy autonome
ou dans du contenu InCopy lié à InDesign. Vous pouvez définir les styles chargés et indiquer ce qui doit se passer lorsqu’un style chargé porte le
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même nom qu’un style du document actuel.

si vous importez des styles dans du contenu lié, de nouveaux styles sont ajoutés au document InDesign lorsque le contenu est mis à
jour. Tout style présentant un conflit de nom est remplacé par le style InDesign portant le même nom.

1. Dans le panneau Styles de caractère ou Styles de paragraphe, utilisez l’une des méthodes suivantes :

Dans le menu du panneau Styles, sélectionnez Charger des styles de caractère ou Charger des styles de paragraphe.

Sélectionnez Charger tous les styles de texte dans le panneau Styles pour charger les styles de caractère et de
paragraphes.

2. Cliquez deux fois dans le document InDesign contenant les styles que vous voulez importer.

3. Dans la boîte de dialogue Charger des styles, assurez-vous qu’une coche apparaît en regard des styles à importer. Si un
style existant porte le même nom qu’un des styles importés, sélectionnez l’une des options suivantes sous la rubrique Conflit
avec le style existant, puis cliquez sur OK :

Ecrase le style existant avec le style chargé et applique ses nouveaux attributs à tout
le texte du document actuel qui utilisait l’ancien style. Les définitions des styles chargés et existants s’affichent au bas de la
boîte de dialogue Charger des styles pour faciliter la comparaison.

Renomme le style chargé. Par exemple, si les deux documents disposent d’un style Sous-
titre, le style chargé est renommé « Copie de Sous-titre » dans le document actif.

Vous pouvez également utiliser la fonction Livre pour partager des styles (voir Synchronisation des documents de livre).

Correspondance des styles et des balises d'exportation | CC, CS6, CS5.5

Introduction et des balises d'exportation

L’option Exporter le balisage permet de définir la manière dont du texte auquel des styles InDesign sont appliqués est marqué dans une sortie au
format HTML, EPUB ou PDF balisé.

Elle permet également de préciser les noms de classe CSS à ajouter au contenu exporté. Dans les formats d’exportation EPUB et HTML, les
classes CSS peuvent servir à différencier les variations de style mineures. Il n'est pas nécessaire que vous entrez un nom de classe - InDesign
génère automatiquement un basé sur le nom du style.

Il est impossible de prévisualiser l’exportation du balisage dans une mise en page InDesign, car cela n’a d’impact que sur les fichiers EPUB,
HTML ou PDF exportés.

L’option Modifier toutes les balises d’exportation permet d’afficher et de modifier les mises en correspondance dans une seule boîte de dialogue.

Définition des mises en correspondance de balises de style

1. Pour mettre un style en correspondance, ouvrez la boîte de dialogue Options de style de paragraphe, Options de style de
caractère ou Options de style d’objet.

2. Cliquez sur Exporter le balisage dans le volet de gauche, puis utilisez l’une des méthodes suivantes :

Choisissez une balise à mettre en correspondance pour une sortie EPUB et HTML.

Précisez une classe à mettre en correspondance pour une sortie EPUB et HTML. Les noms de classe servent à la
définition de style pour les balises par défaut.

Si vous souhaitez inclure ce style dans le fichier CSS, cochez la case Emettre le fichier CSS. Si vous ne cochez pas la
case, aucune classe CSS ne sera générée pour ce style. Si deux ou plusieurs styles sont affectés à la même classe,
InDesign affiche un message d’erreur/d’avertissement lors de l’exportation. Cette option est uniquement disponible dans
InDesign CC.

Choisissez une balise à mettre en correspondance pour une sortie PDF. Cette option est disponible uniquement pour les
styles de paragraphe.

http://idiom-q-win-1/fr/indesign/using/creating-book-files.html#synchronize_book_documents
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Modification de toutes les balises d’exportation

Vous pouvez afficher et modifier toutes les balises d’exportation dans une même fenêtre.

1. Sélectionnez Modifier toutes les balises d’exportation dans le menu des panneaux Style de paragraphe, Style de caractère ou
Style d’Objet.

2. Cliquez sur EPUB et HTML, ou sur PDF.

3. Cliquez sur la balise correspondant au style. Celle-ci se transforme en liste ; choisissez la nouvelle valeur.

Conversion des styles Word en styles InDesign

Lorsque vous importez un document Microsoft Word dans InDesign ou InCopy, vous pouvez faire correspondre chaque style utilisé dans Word à
un style correspondant dans InDesign ou InCopy. Cela permet d’indiquer les styles utilisés pour mettre en forme le texte importé. Une icône de
disquette  s’affiche en regard de chaque style Word importé jusqu’à ce que vous modifiiez le style dans InDesign ou InCopy.

1. Utilisez l’une des méthodes suivantes :

Pour ajouter le document Word au texte existant dans InDesign ou InCopy, choisissez Fichier > Importer. Sélectionnez
Afficher les options d’importation, puis cliquez deux fois sur le document Word.

Pour ouvrir le document Word dans un document InCopy autonome, lancez InCopy, choisissez Fichier > Ouvrir, puis
cliquez deux fois sur le fichier Word.

2. Sélectionnez l’option Conserver les styles et la mise en forme du texte et des tableaux.

3. Sélectionnez Personnaliser l’importation des styles, puis cliquez sur Correspondance de style.

4. Dans la boîte de dialogue Correspondance de style, sélectionnez le style Word, puis une option dans le menu situé sous le
style InDesign. Choisissez parmi les options suivantes :

S’il n’y a aucun conflit de nom, choisissez l’option Nouveau style de paragraphe ou Nouveau style de caractère ou bien
optez pour un style InDesign existant.

En cas de conflit, choisissez l’option Redéfinir le style InDesign pour mettre le texte importé en forme selon le style Word.
Choisissez un style InDesign existant pour modifier la mise en forme du texte qui utilise le style importé en fonction du
style InDesign. Choisissez Renommer automatiquement pour renommer le style Word.

5. Cliquez sur OK pour fermer la boîte de dialogue Correspondance de style, puis de nouveau sur OK pour importer le
document.

Application de styles

Par défaut, l’application d’un style de paragraphe ne supprime aucune mise en forme de caractère ni aucun style de caractère déjà appliqué à une
partie d’un paragraphe. Vous pouvez cependant supprimer une mise en forme existante lorsque vous appliquez un style. Un signe plus (+)
apparaît dans le panneau Styles en regard du style utilisé si le texte auquel le style est appliqué utilise déjà un style de caractère ou de
paragraphe et des attributs de mise en forme supplémentaires ne faisant pas partie du style appliqué. Dans ce cas, on parle de remplacement ou
de mise en forme locale.

Les styles de caractère suppriment ou réinitialisent les attributs de caractère du texte si ces attributs sont définis par le style.

Application d’un style de caractère

1. Sélectionnez les caractères auxquels appliquer le style.

2. Utilisez l’une des méthodes suivantes :

Dans le panneau Styles de caractères, cliquez sur le nom du style de caractère.

Dans la liste déroulante du panneau Contrôle, sélectionnez le nom du style de caractère.
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Appuyez sur le raccourci clavier que vous avez attribué au style. Vérifiez que la touche Verr num est activée.

Application d’un style de paragraphe

1. Cliquez sur un paragraphe ou sélectionnez l’ensemble ou une partie des paragraphes auxquels appliquer le style.

2. Utilisez l’une des méthodes suivantes :

Dans le panneau Styles de paragraphe, cliquez sur le nom du style de paragraphe.

Sélectionnez le nom du style de paragraphe dans le menu du panneau Contrôle.

Appuyez sur le raccourci clavier que vous avez attribué au style. Vérifiez que la touche Verr num est activée.

3. Si une mise en forme non souhaitée reste dans le texte, choisissez Effacer les remplacements dans le panneau Styles de
paragraphe.

Application de styles séquentiels à plusieurs paragraphes

L’option Style suivant indique le style automatiquement appliqué lorsque vous appuyez sur la touche Entrée ou Retour après avoir appliqué un
style particulier. Elle vous permet également d’appliquer différents styles à plusieurs paragraphes en une seule opération.

Par exemple, vous avez défini trois styles pour mettre en forme une colonne de journal : Titre, Signature et Corps. Le style Titre a recours au style
Signature comme style suivant, Signature à Corps et Corps à [Même style]. Si vous sélectionnez un article entier (comprenant le titre, la signature
de l’auteur et les paragraphes de l’article) et appliquez le style Titre à l’aide de la commande spéciale « Style suivant » du menu contextuel, le
premier paragraphe de l’article est mis en forme selon le style Titre, le deuxième selon le style Signature et tous les autres paragraphes selon le
style Corps.

Avant et après l’application d’un style avec l’option Style suivant

1. Sélectionnez les paragraphes auxquels appliquer le style.

2. Dans le panneau Styles de paragraphe, cliquez sur le style parent avec le bouton droit de la souris (Windows) ou tout en
maintenant la touche Contrôle enfoncée (Mac OS), puis choisissez Appliquer [nom de style], puis Style suivant.

Si le texte contient des remplacements de mise en forme ou des styles de caractère, le menu contextuel vous permet de les supprimer.

Modification des styles de caractère et de paragraphe

L’utilisation des styles offre entre autres l’avantage suivant : lorsque vous modifiez un style, l’ensemble du texte mis en forme selon ce style
change également pour refléter les nouveaux critères.

si vous modifiez les styles d’un contenu InCopy lié à un document InDesign, les modifications sont remplacées lorsque le contenu lié
est mis à jour.

Modification d’un style à l’aide de la boîte de dialogue

1. Utilisez l’une des méthodes suivantes :
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Pour ne pas appliquer le style au texte sélectionné, cliquez avec le bouton droit de la souris (Windows) ou tout en
maintenant la touche Contrôle enfoncée (Mac OS) sur le nom du style dans le panneau Styles, puis choisissez Modifier
[nom de style].

Dans le panneau Styles, cliquez deux fois sur le nom du style ou sélectionnez le style, puis choisissez Options de style
dans le menu du panneau Styles. Le style est alors appliqué au texte ou au bloc de texte sélectionné ou, en l’absence de
sélection, devient le style par défaut de tout texte saisi dans un nouveau bloc.

2. Modifiez les paramètres dans la boîte de dialogue, puis cliquez sur OK.

Redéfinition d’un style correspondant au texte sélectionné

Après avoir appliqué le style, vous pouvez remplacer tous les paramètres définis. Si ces modifications vous conviennent, vous pouvez redéfinir ce
style afin qu’il corresponde à la mise en forme du texte modifié.

si vous redéfinissez les styles d’un contenu InCopy lié à un document InDesign, les modifications sont remplacées lorsque le contenu
lié est mis à jour.

1. A l’aide de l’outil Texte , sélectionnez le texte mis en forme avec le style redéfini.

2. Modifiez les attributs de paragraphe ou de caractère à votre convenance.

3. Dans le menu du panneau Styles, choisissez Redéfinir le style.

Suppression de styles de caractère et de paragraphe

Lorsque vous supprimez un style, vous pouvez sélectionner un style différent pour le remplacer, et vous pouvez choisir de conserver la mise en
forme. Lorsque vous supprimez un groupe de styles, vous supprimez tous les styles du groupe. Vous êtes invité à remplacer chaque style du
groupe, l’un après l’autre.

1. Dans le panneau Styles, sélectionnez le nom de style souhaité.

2. Utilisez l’une des méthodes suivantes :

Choisissez Supprimer le style dans le menu du panneau ou cliquez sur l’icône de suppression  au bas du panneau.

Cliquez sur le style avec le bouton droit de la souris (Windows) ou tout en maintenant la touche Contrôle enfoncée
(Mac OS), puis choisissez Supprimer le style. Cette méthode est particulièrement utile pour supprimer un style sans
l’appliquer au texte.

3. Dans la boîte de dialogue Supprimer le style de paragraphe, sélectionnez le style de remplacement.

Si vous sélectionnez [Aucun style de paragraphe] pour remplacer un style de paragraphe ou [Sans] pour remplacer un style
de caractère, sélectionnez Conserver la mise en forme afin de conserver la mise en forme de texte à laquelle s’applique le
style. Le texte préserve sa mise en forme, mais il n’est plus associé à aucun style.

4. Cliquez sur le bouton OK.

Pour supprimer tous les styles inutilisés, choisissez Sélectionner tous les styles inutilisés dans le menu du panneau Styles, puis cliquez sur
l’icône de suppression. Lorsque vous supprimez un style inutilisé, vous n’êtes pas invité à le remplacer.

Remplacement de styles de caractère et de paragraphe

Lorsque vous appliquez un style de paragraphe, les styles de caractère et autres mises en forme demeurent intacts. Après avoir appliqué le style,
vous pouvez remplacer tous les paramètres définis en appliquant une mise en forme ne faisant pas partie du style. Dans ce cas, on parle de
remplacement ou de mise en forme locale. Lorsque vous sélectionnez du texte avec un remplacement, un signe plus (+) s’affiche en regard du
nom du style. Dans les styles de caractère, un remplacement s’affiche uniquement si l’attribut appliqué appartient à ce style. Par exemple, si un
style de caractère modifie uniquement la couleur du texte, la modification du corps de la police n’est pas considérée comme un remplacement.

Vous pouvez effacer les styles de caractères et les remplacements de mise en forme lors de l’application d’un style. Vous pouvez également
effacer les remplacements d’un paragraphe auquel un style a été appliqué.
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Si un signe plus (+) s’affiche en regard d’un style, placez le pointeur de la souris sur le style pour afficher une description des attributs de
remplacement.

Conservation ou suppression des remplacements lors de l’application de styles de paragraphe

Pour appliquer un style de paragraphe et préserver les styles de caractères, tout en supprimant les remplacements, maintenez
la touche Alt (Windows) ou Option (Mac OS) enfoncée lorsque vous cliquez sur le nom du style dans le panneau Styles de
paragraphe.
Pour appliquer un style de paragraphe et supprimer les styles de caractère ainsi que les remplacements, maintenez les
touches Alt+Maj (Windows) ou Option+Maj (Mac OS) enfoncées lorsque vous cliquez sur le nom du style dans le panneau
Styles de paragraphe.

Cliquez avec le bouton droit de la souris (Windows) ou tout en maintenant la touche Contrôle enfoncée (Mac OS) sur le style du panneau
Styles de paragraphe, puis choisissez une option dans le menu contextuel. Vous pouvez effacer les remplacements et/ou les styles de
caractère lors de l’application du style.

Effacement des remplacements de style de paragraphe

1. Sélectionnez le texte comportant des remplacements. Vous pouvez même sélectionner plusieurs paragraphes avec des styles
différents.

2. Dans le panneau Styles de paragraphe, utilisez l’une des méthodes suivantes :

Pour supprimer la mise en forme d’un paragraphe ou d’un caractère, cliquez sur l’icône Effacer les remplacements  ou
choisissez Effacer les remplacements dans le panneau Styles de paragraphe.

Pour supprimer les remplacements de mise en forme de caractère mais préserver les remplacements de mise en forme de
paragraphe, maintenez la touche Ctrl (Windows) ou Commande (Mac OS) enfoncée lorsque vous cliquez sur l’icône
Effacer les remplacements.

Pour supprimer les remplacements au niveau des paragraphes mais conserver ceux des caractères, dans le panneau
Styles de paragraphe, maintenez les touches Maj+Ctrl (Windows) ou Maj+Commande (Mac OS) enfoncées lorsque vous
cliquez sur l’icône Effacer les remplacements.

lorsque vous effacez les remplacements, les remplacements effectués au niveau des paragraphes sont
supprimés de l’ensemble du paragraphe, même si celui-ci n’est que partiellement sélectionné. Les remplacements effectués
au niveau des caractères sont supprimés dans la sélection uniquement.

L’effacement des remplacements ne fait pas disparaître la mise en forme du style de caractères. Pour supprimer la mise en
forme de style de caractères, sélectionnez le texte contenant le style de caractères en question, puis cliquez sur [Sans] dans
le panneau Styles de caractère.

Rupture du lien entre le texte et son style

Lorsque vous rompez le lien entre le texte et son style, le texte conserve sa mise en forme. Toutefois, les modifications ultérieures de ce style
n’affectent pas le texte séparé du style.

1. Sélectionnez le texte pour lequel vous souhaitez annuler le lien au style.

2. Dans le menu du panneau Styles, choisissez Annuler le lien au style.

Si aucun texte n’est sélectionné lorsque vous choisissez Annuler le lien au style, le nouveau texte que vous saisissez utilise la même mise en
forme que le style sélectionné, mais aucun style n’est affecté à ce texte.

Conversion des puces et de la numérotation d’un style en texte

Lorsque vous créez un style qui ajoute des puces et de la numérotation à des paragraphes, ces puces et ces numéros risquent d’être perdus si le
texte est copié ou exporté vers une autre application. Pour éviter ce problème, convertissez les puces et la numérotation du style en texte.
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si vous convertissez les puces du style en un article InCopy lié à une mise en page InDesign, la modification peut être annulée
lorsque le contenu est mis à jour dans InDesign.

1. Dans le panneau Styles de paragraphe, sélectionnez le style qui contient les puces et la numérotation.

2. Dans le menu du panneau Styles de paragraphe, choisissez Convertir les puces et numéros « [style] » en texte.

Si vous convertissez les puces et la numérotation en texte dans un style servant à créer un autre style (style parent), les puces et la numérotation
du style enfant sont également converties en texte.

Après avoir converti une numérotation en texte, il se peut que vous deviez mettre à jour les nombres manuellement si vous modifiez le texte.

Recherche et modification de styles de caractère et de paragraphe

Utilisez la boîte de dialogue Rechercher/Remplacer pour rechercher les occurrences d’un style particulier et les remplacer par un autre style.

1. Choisissez Edition > Rechercher/Remplacer.

2. Dans la zone Chercher dans, sélectionnez Document pour modifier le style dans l’ensemble du document.

3. Laissez les zones Rechercher et Remplacer par vides. Si les zones Rechercher le format et Remplacer le format
n’apparaissent pas en bas de la boîte de dialogue, cliquez sur Plus d’options.

4. Cliquez sur la zone Rechercher le format pour afficher la boîte de dialogue Rechercher un format. Sous Options de style,
sélectionnez le style de caractère et de paragraphe à rechercher, puis cliquez sur OK.

5. Cliquez sur la zone Remplacer le format pour afficher la boîte de dialogue Modifier le format. Sous Options de style,
sélectionnez le style de caractère et de paragraphe de remplacement, puis cliquez sur OK.

6. Cliquez sur Rechercher et utilisez les boutons Remplacer, Remplacer/Rechercher ou Tout remplacer pour remplacer le style.

Adobe recommande également
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Lettrines et styles imbriqués
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Application d’un style de caractère à une lettrine
Création de styles imbriqués
Création de styles GREP

La fonction Lettrines et styles imbriqués a trois applications principales : elle peut être utilisée pour appliquer un style de caractère à une lettrine,
pour appliquer un style imbriqué au texte de début d’un paragraphe et pour appliquer un style de ligne imbriqué à une ou plusieurs lignes d’un
paragraphe.

Application d’un style de caractère à une lettrine
Vous pouvez appliquer un style de caractère à une ou plusieurs lettrines d’un paragraphe. Par exemple, si vous voulez appliquer à une lettrine
une couleur et une police différentes du reste du paragraphe, vous pouvez définir un style de caractère à cette fin. Vous pouvez alors appliquer ce
style directement à un paragraphe ou l’imbriquer dans un style de paragraphe.

Lettrine mise en forme automatiquement par un style de caractère imbriqué

1. Créez un style de caractère avec la mise en forme souhaitée pour la lettrine.
2. Utilisez l’une des méthodes suivantes :

Pour appliquer la lettrine à un seul paragraphe, choisissez l’option Lettrines et styles imbriqués dans le menu du panneau
Paragraphe.

Pour imbriquer le style de caractère dans un style de paragraphe, cliquez deux fois sur le style de paragraphe, puis
cliquez sur l’option Lettrines et styles imbriqués.

3. Spécifiez le nombre de lignes de lettrines et de caractères, puis choisissez le style de caractère.
4. Si la lettrine est trop éloignée du bord gauche, choisissez Aligner le bord gauche.

En sélectionnant cette option, vous utilisez la portée latérale gauche d’origine de la lettrine plutôt qu’une valeur supérieure.
Elle est particulièrement utile pour les lettrines mises en forme en police sans serif.

5. Si le caractère de la lettrine chevauche le texte situé en dessous, sélectionnez Echelle de jambage inférieur.
6. Cliquez sur le bouton OK.

Si vous souhaitez appliquer un style imbriqué différent à des caractères après la lettrine, utilisez l’option Nouveau style imbriqué (voir la section
Création de styles imbriqués).

Création de styles imbriqués
Vous pouvez spécifier une mise en forme de niveau de caractère pour une ou plusieurs portions de texte d’un paragraphe ou d’une ligne. Vous
pouvez également définir deux ou plusieurs styles imbriqués de sorte que l’un succède à l’autre. Pour les paragraphes à la mise en forme
répétitive et prévisible, vous pouvez même revenir au premier style de la séquence.

Les styles imbriqués sont particulièrement adaptés aux titres continus. Par exemple, vous pouvez appliquer un style de caractère à la première
lettre d’un paragraphe et un autre style au reste du titre jusqu’au signe deux-points (:). Pour chaque style imbriqué, vous pouvez définir un
caractère qui termine le style, tel qu’une tabulation ou la fin d’un mot.



Dans cet exemple, le style de caractères Numéro s’applique au premier mot et le style de caractères Continu au reste du texte jusqu’au premier
signe deux-points.

Michael Murphy propose un article sur les styles imbriqués intitulé InDesign’s Nested Styles Auto-Format Multiple Paragraphs (en anglais
uniquement). Il fournit également une série de didacticiels vidéo, dont le premier correspond à Nested Style Sheets.

Création d’un ou plusieurs styles imbriqués
1. Créez un ou plusieurs styles de caractère à appliquer au texte.
2. Utilisez l’une des méthodes suivantes :

Pour ajouter des styles imbriqués à un style de paragraphe, cliquez deux fois sur ce dernier, puis sur l’option Lettrines et
styles imbriqués.

Pour ajouter des styles imbriqués à un seul paragraphe, choisissez Lettrines et styles imbriqués dans le menu du panneau
Paragraphe.

Remarque : pour un résultat optimal, appliquez les styles imbriqués dans le cadre des styles de paragraphe. Si vous
appliquez des styles imbriqués comme remplacements locaux dans un paragraphe, toute modification ultérieure apportée
au style imbriqué risque d’engendrer une mise en forme inattendue des caractères du texte.

3. Cliquez sur le bouton Nouveau style imbriqué une ou plusieurs fois.
4. Pour chacun des styles, effectuez l’une des opérations suivantes, puis cliquez sur OK :

Cliquez sur la zone de style de caractère, puis sélectionnez un style de caractère afin de déterminer l’apparence de cette
section du paragraphe. Si vous n’avez pas créé de style de caractère, choisissez Nouveau style de caractère et spécifiez
la mise en forme à utiliser.

Spécifiez l’élément qui marque la fin du style de caractère. Vous pouvez également saisir le caractère, par exemple les
deux-points (:) ou toute autre lettre ou chiffre. Vous ne pouvez pas saisir de mot.

Spécifiez le nombre d’occurrences de l’élément sélectionné (caractères, mots ou phrases) requis.

Choisissez Sur ou Jusqu’à. L’option Sur inclut le caractère marquant la fin du style. Jusqu’à s’applique uniquement aux
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caractères précédents.

Sélectionnez un style, puis cliquez sur le bouton haut  ou bas  pour modifier l’ordre des styles de la liste. L’ordre des
styles définit l’ordre dans lequel la mise en forme est appliquée. La mise en forme définie par le second style commence là
où finit la mise en forme du premier style. Si vous appliquez un style de caractère à une lettrine, celui-ci fait office de
premier style imbriqué.

Création de styles de ligne imbriqués
Vous pouvez appliquer un style de caractère à un nombre donné de lignes d’un paragraphe. Comme pour les styles imbriqués, vous pouvez
définir au moins deux styles de ligne imbriqués à combiner, et créer une séquence qui se répète.

Les attributs appliqués par des styles de ligne imbriqués peuvent coexister avec des attributs appliqués par des styles imbriqués. Par exemple, un
style de ligne imbriqué peut appliquer une couleur, alors qu’un style imbriqué peut appliquer des italiques. Si les deux styles définissent des
paramètres incompatibles pour le même attribut (rouge et bleu, par exemple), le style imbriqué prévaut sur le style de ligne imbriqué.

1. Créez un ou plusieurs styles de caractère à appliquer au texte.
2. Utilisez l’une des méthodes suivantes :

Pour ajouter des styles de ligne imbriqués à un style de paragraphe, cliquez deux fois sur ce dernier, puis sur l’option
Lettrines et styles imbriqués.

Pour ajouter des styles de ligne imbriqués à un seul paragraphe, sélectionnez l’option Lettrines et styles imbriqués dans le
menu du panneau Paragraphe.

3. Cliquez une ou plusieurs fois sur le bouton Nouveau style de ligne imbriqué.
4. Cliquez sur la zone de style de caractère, puis sélectionnez un style de caractère afin de déterminer l’apparence de cette

section. Si vous n’avez pas créé de style de caractère, choisissez Nouveau style de caractère et spécifiez la mise en forme à
utiliser.

5. Spécifiez le nombre de lignes de paragraphe auxquelles vous souhaitez appliquer le style de caractère.

Sélectionnez un style, puis cliquez sur le bouton haut  ou bas  pour modifier l’ordre des styles de la liste. L’ordre définit
l’ordre dans lequel la mise en forme est appliquée.

6. Cliquez sur le bouton OK.

Répétition de styles imbriqués
Vous pouvez répéter une série de styles imbriqués tout au long d’un paragraphe. Vous pourriez, par exemple, tout simplement alterner des mots
en vert et en rouge dans un paragraphe, ou, avec les styles de ligne imbriqués, vous pourriez alterner des lignes en vert et en rouge dans un
paragraphe. Le motif répété reste intact même si vous ajoutez ou supprimez des mots dans le paragraphe.

1. Créez les styles de caractère que vous souhaitez utiliser.
2. Modifiez ou créez un style de paragraphe, ou positionnez le point d’insertion dans le paragraphe que vous souhaitez mettre en

forme.
3. Dans la boîte de dialogue ou section Lettrines et styles imbriqués, cliquez au moins deux fois sur Nouveau style imbriqué (ou

Nouveau style de ligne imbriqué) et définissez les paramètres de chaque style.
4. Utilisez l’une des méthodes suivantes :

Pour les styles imbriqués, cliquez de nouveau sur la commande Nouveau style imbriqué, activez l’option [Répéter] dans la
zone de style de caractère, puis indiquez le nombre de styles imbriqués à répéter.

Pour les styles de ligne imbriqués, cliquez de nouveau sur la commande Nouveau style de ligne imbriqué, activez
l’option [Répéter] dans la zone de style de caractère, puis indiquez le nombre de lignes à répéter.

Vous pouvez au besoin ignorer le ou les premiers styles. Par exemple, un paragraphe mettant en avant un calendrier
d’événements peut inclure « A la une cette semaine » suivi des jours de la semaine et des événements associés. Dans cet
exemple, vous pouvez créer cinq styles imbriqués : un pour « A la une cette semaine », un pour les jours, un pour les
événements, un pour l’heure des événements et un dernier doté d’une valeur [Répéter] de 3, excluant ainsi le premier style
imbriqué de la boucle.

L’élément [Répéter] doit être le dernier de la liste. Tous les styles imbriqués situés sous [Répéter] sont ignorés.



Répétition de styles imbriqués

5. Cliquez sur le bouton OK.

Options de style imbriqué pour les caractères
Pour définir la fin d’un style de caractère imbriqué, sélectionnez l’une des options suivantes :

Si vous ne voulez pas que le caractère soit inclus dans la mise en forme du style imbriqué, choisissez Jusqu’à au lieu de Sur lorsque vous
définissez le style.

Phrases Les points, points d’interrogation et points d’exclamation indiquent la fin d’une phrase. Si un guillemet suit le signe de ponctuation, il est
inclus dans la phrase.
Mots Les espaces indiquent la fin d’un mot.
Caractères Tous les caractères, sauf les marques de largeur zéro (ancres, marques d’index, balises XML, etc.).
Remarque : si vous sélectionnez Caractères, vous pouvez également saisir un caractère (par exemple, deux-points ou point) pour marquer la fin
du style imbriqué. Si vous entrez plusieurs caractères, chacun de ces caractères permet de marquer la fin du style. Par exemple, si vos titres
continus se terminent par un trait d’union, le signe deux-points ou un point d’interrogation, vous pouvez saisir -:? pour marquer la fin du style
imbriqué à chaque fois que l’un de ces caractères apparaît.
Lettres Tout caractère ne contenant ni signe de ponctuation, ni espace, ni chiffre, ni symbole.
Chiffres Les chiffres arabes de 0 à 9 sont inclus.
Caractère du style imbriqué de fin Etend le style imbriqué jusqu’à l’occurrence du caractère de fin du style imbriqué (inclus ou non) inséré. Pour
insérer ce caractère, choisissez Texte > Insérer un caractère spécial > Autre > Fin du style imbriqué ici.
Caractères de tabulation Etend le style imbriqué jusqu’au caractère de tabulation, inclus ou non (non le paramètre de tabulation).
Saut de ligne forcé Etend le style imbriqué jusqu’au saut de ligne forcé, inclus ou non. Choisissez Texte > Insérer un caractère de saut > Saut
de ligne forcé.
Caractère en retrait jusqu’à ce point Etend le style imbriqué jusqu’au caractère en retrait jusqu’à ce point, inclus ou non. Choisissez Texte >
Insérer un caractère spécial > Autre > Retrait jusqu’à ce point.
Espaces cadratins, demi-cadratins ou insécables Etend le style imbriqué jusqu’à l’espace, incluse ou non (choisissez Texte > Insérer une
espace > {}[espace]).
Marqueur d’objet ancré Etend le style imbriqué jusqu’au symbole d’image texte, inclus ou non, qui s’affiche au point d’insertion de l’image
texte.
Numérotation automatique des pages ou Marque de section Etend le style imbriqué jusqu’au repère de pagination ou de section, inclus ou
non.

Marquage de la fin d’un style imbriqué
Dans la plupart des cas, un style imbriqué prend fin selon les conditions définies par le style défini, par exemple après trois mots ou lorsqu’un point
apparaît. Vous pouvez toutefois mettre fin à un style imbriqué avant que les conditions ne soient satisfaites en utilisant le caractère Fin du style
imbriqué ici.

1. Placez le point d’insertion là où vous souhaitez que le style imbriqué prenne fin.
2. Choisissez Texte > Insérer un caractère spécial > Autre > Fin du style imbriqué ici.

Ce caractère marque la fin du style imbriqué à ce point, quelle que soit la définition du style imbriqué.
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Suppression de la mise en forme d’un style imbriqué
Dans la boîte de dialogue Lettrines et styles imbriqués ou dans la section du même nom de la boîte de dialogue Options de
style de paragraphe, sélectionnez le style imbriqué, puis cliquez sur le bouton Supprimer.
Appliquez un style de paragraphe différent.

Création de styles GREP
GREP est une technique de recherche avancée basée sur des motifs. Vous pouvez utiliser les styles GREP pour appliquer un style de caractère
au texte respectant l’expression GREP spécifiée. Par exemple, vous voulez appliquer un style de caractère à tous les numéros de téléphone du
texte. Lorsque vous créez un style GREP, vous devez sélectionner le style de caractère et spécifier l’expression GREP. Le style de caractère est
appliqué à l’ensemble du texte du paragraphe correspondant à l’expression GREP.

Utilisation d’un style GREP pour appliquer un style de caractère aux numéros de téléphone
A.  Style de caractère B.  Expression GREP

Pour consulter un didacticiel vidéo sur la création de styles GREP, rendez-vous à l’adresse www.adobe.com/go/lrvid4028_id_fr.

David Blatner fournit des exemples réels de styles GREP sous le titre 5 Cool Things You Can Do with GREP Styles. Cari Jansen propose une
série en quatre volets consacrée aux styles GREP, qui débute par une présentation intitulée Introducing GREP Styles.

1. Utilisez l’une des méthodes suivantes :

Pour appliquer des styles GREP à des paragraphes individuels, sélectionnez les paragraphes et choisissez Styles GREP
dans le menu du panneau Paragraphe ou Contrôle.

Pour utiliser des styles GREP dans un style de paragraphe, créez ou modifiez un style de paragraphe, puis cliquez sur
l’onglet Application d’un style GREP sur le côté gauche de la boîte de dialogue Options de style de paragraphe.

2. Cliquez sur Nouveau style GREP.

3. Cliquez à droite de l’option Appliquer le style, puis spécifiez un style de caractère. Si vous n’avez pas créé de style de
caractère à utiliser, choisissez Nouveau style de caractère et spécifiez la mise en forme à utiliser.

4. Cliquez à droite de l’option Au texte, puis utilisez l’une des méthodes suivantes pour créer une expression GREP :

Entrez l’expression de la recherche manuellement (voir la section Métacaractères de recherche).

Cliquez sur l’icône Caractères spéciaux pour la recherche à droite de l’option Au texte. Choisissez les options des sous-
menus Emplacements, Répétition, Correspondance, Touches de modification et Posix pour vous aider à créer l’expression
GREP.

5. Cliquez sur le bouton OK.

Voir aussi
Vidéo Styles GREP
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Duplication des styles ou des groupes de styles
Regroupement de styles
Déplacement et tri des styles

Duplication des styles ou des groupes de styles
 Cliquez avec le bouton droit de la souris (Windows) ou tout en maintenant la touche Contrôle enfoncée (Mac OS) sur un style ou un groupe de

styles dans le panneau Styles, puis choisissez Dupliquer un style.
Un nouveau style ou groupe s’affiche dans le panneau Styles, de nom identique suivi de la mention « copie ». Si vous avez dupliqué un groupe de
styles, les noms des styles au sein du groupe restent intacts.

Vous pouvez également dupliquer des styles en les copiant dans un autre groupe.

Regroupement de styles
Vous pouvez organiser les styles en les groupant dans des dossiers séparés dans les panneaux Styles de caractère, Styles de paragraphe, Styles
d’objet, Styles de tableau et Styles de cellule. Vous pouvez également imbriquer des groupes dans d’autres groupes. Il n’est pas nécessaire de
placer les styles dans des groupes. Vous pouvez les ajouter à un groupe ou à la racine du panneau.

Création d’un groupe de styles
1. Dans le panneau Styles :

Pour créer un groupe à la racine, désélectionnez tous les styles.

Pour créer un groupe dans un groupe, sélectionnez et ouvrez un groupe.

Pour inclure des styles existants dans un groupe, sélectionnez les styles.

2. Choisissez Nouveau groupe de styles dans le menu du panneau Styles, ou choisissez Nouveau groupe d’après des styles
pour déplacer les styles sélectionnés dans le nouveau groupe.

3. Entrez le nom du groupe, puis cliquez sur OK.
4. Pour déplacer un style dans le groupe, faites-le glisser sur le groupe de styles. Lorsque le groupe de styles est mis en

surbrillance, relâchez le bouton de la souris.

Copie de styles dans un groupe
Lorsque vous copiez un style dans un groupe différent, les styles ne sont pas liés. Bien qu’ils portent le même nom, la modification d’un style ne
change pas les attributs de l’autre.

1. Sélectionnez le style ou le groupe que vous souhaitez copier.
2. Dans le menu du panneau Styles, choisissez Copier vers le groupe.
3. Sélectionnez le groupe (ou le niveau [Racine]) dans lequel vous souhaitez copier les styles ou le groupe, puis cliquez sur OK.

Si le groupe contient déjà des noms de style identiques à ceux copiés, les copies chargées sont renommées.

Développement ou réduction des groupes de styles
Pour développer ou réduire un seul groupe, cliquez sur l’icône de triangle située en regard du groupe.
Pour développer ou réduire le groupe et l’ensemble de ses sous-groupes, cliquez sur l’icône de triangle tout en maintenant la
touche Ctrl (Windows) ou Commande (Mac OS) enfoncée.

Suppression de groupes de styles
Lorsque vous supprimez un groupe de styles, le groupe et l’ensemble de son contenu sont supprimés, y compris les styles et autres groupes.

1. Sélectionnez le groupe que vous souhaitez supprimer.
2. Choisissez Supprimer le groupe de styles dans le menu du panneau Styles, puis cliquez sur Oui.
3. Pour chacun des styles du groupe, définissez un style de remplacement ou choisissez l’option [Sans], puis cliquez sur OK.

Si vous souhaitez utiliser le même style de remplacement pour tous les styles, choisissez l’option Appliquer à tout.
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Si vous annulez le remplacement d’un style, le groupe n’est pas supprimé. Vous pouvez restaurer des styles supprimés en choisissant Edition >
Annuler Supprimer les styles.

Déplacement et tri des styles
Par défaut, les styles que vous créez apparaissent au bas du groupe de styles ou du panneau.

Pour trier par ordre alphabétique tous les groupes et styles dans des groupes, choisissez Tri par nom dans le menu du
panneau Styles.
Pour déplacer un seul style, faites-le glisser vers le nouvel emplacement. Une ligne noire indique l’endroit vers lequel le style
sera déplacé. Un dossier de groupe mis en surbrillance indique que le style sera ajouté dans ce groupe.
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Polices installées dans les documents (vidéo 02:29)
Michael Ninness  (01er janvier 2011)
Didacticiel - vidéo
Découvrez comment utiliser les polices de document installées dans vos conceptions, dans InDesign CS5 et les versions ultérieures.

http://tv.adobe.com/go/4955
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A propos des polices
Adobe Typekit
Installation des polices
Application d’une police au texte
Indication du corps d’un caractère
Aperçu des polices
Polices OpenType
Application d’attributs de police OpenType
Gestion des polices manquantes
Polices de document installées
Polices Multiple Master

A propos des polices

Une police est un ensemble complet de caractères alphabétiques, chiffres et symboles qui partagent une épaisseur, une largeur et un style (par
exemple, Adobe Garamond, 10 points, gras).

Les types de caractères (souvent appelés familles de caractères ou familles de polices) sont des ensembles de polices de caractères apparentés
par le graphisme et conçus pour être utilisés ensemble (par exemple, Adobe Garamond).

Un style de caractères est une variante d’une police au sein d’une même famille caractères. En général, l’élément d’une famille de polices appelé
Romain ou Normal (le nom diffère d’une famille à l’autre) constitue la police de base comprenant les styles de caractères, tels que normal, gras,
demi-gras, italique et gras italique.

Adobe Typekit

Tous les abonnements d’InDesign comportent un programme portefeuille d’Adobe Typekit, qui inclut une bibliothèque de polices pouvant être
synchronisées sur votre bureau et utilisées avec InDesign et toute autre application de bureau. Pour plus d’informations sur la synchronisation des
polices de bureau avec Typekit, cliquez ici.

Installation des polices

Pour plus de détails sur l’installation et l’activation des polices pour toutes les applications, consultez la documentation de votre système ou de
votre gestionnaire de polices.

Vous pouvez rendre les polices disponibles dans InDesign en copiant les fichiers de polices dans le dossier Polices du dossier d’application
InDesign de votre disque dur. Notez toutefois que les polices installées dans ce dossier ne seront disponibles que dans InDesign.

Si deux polices ou plus sont actives dans InDesign et utilisent le même nom de famille, mais des noms Adobe PostScript différents, elles sont
disponibles dans InDesign. Les polices dupliquées sont affichées dans les menus avec l’abréviation de leur technologie entre parenthèses. Par
exemple, une police Helvetica TrueType s’affiche comme « Helvetica (TT) », une police Helvetica PostScript Type 1 s’affiche comme
« Helvetica (T1) » et une police Helvetica OpenType s’affiche comme « Helvetica (OTF) ». Si deux polices portent le même nom PostScript, et que
l’une d’entre elles contient .dfont dans son nom, l’autre police est utilisée.

Instructions relatives à l'installation de polices

https://typekit.com/
https://typekit.com/
http://help.typekit.com/customer/portal/articles/1145956-how-to-sync-fonts-to-your-desktop
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Remarque :

Haut de la page

Application d’une police au texte

Lorsque vous spécifiez une police, vous pouvez sélectionner la famille de polices et son style de caractère séparément. Lorsque vous changez de
famille de police, InDesign tente de faire correspondre le style actuel avec le style disponible dans la nouvelle famille de police. Par exemple, Arial
Gras devient Times Gras lorsque vous passez d’Arial à Times.

Lorsque vous appliquez le style gras ou italique à du texte, InDesign applique le style de caractères spécifié par la police. Le plus souvent, la
version spécifique de style gras ou italique est appliquée. Cependant, certaines polices peuvent appliquer une variation de style gras ou italique
qui n’est pas nommée comme telle. Par exemple, certains créateurs de polices définissent que lorsqu’un style gras est appliqué à une police, la
variation demi-gras doit être utilisée.

1. Sélectionnez le texte à modifier.

2. Utilisez l’une des méthodes suivantes :

Dans le panneau Caractère ou Contrôle, sélectionnez une police dans le menu Famille de polices ou un style dans le
menu des styles de caractère (sous Mac OS, vous pouvez sélectionner des styles de caractère dans les sous-menus des
familles de polices).

Dans le panneau Caractère ou Contrôle, cliquez devant le nom de la famille de polices ou du style de caractère (ou
cliquez deux fois sur son premier mot), puis entrez les premières lettres du nom de votre choix. A mesure que vous tapez,
InDesign affiche les noms des familles de polices ou des styles de caractères qui correspondent au texte.

Sélectionnez une police dans le menu Texte > Police. Remarquez que lorsque vous utilisez ce menu, vous sélectionnez à
la fois une famille de polices et un style de caractère.

Indication du corps d’un caractère

Par défaut, le corps d’un caractère est mesuré en points (un point équivaut à 1/72 de pouce). Vous pouvez spécifier un corps de caractère
compris entre 0,1 et 1296 par incréments de 0,001 point.

dans Adobe Fireworks, le corps d’un caractère est mesuré par défaut en pixels.

1. Sélectionnez les caractères ou les objets texte à modifier. Si vous ne sélectionnez pas de texte, le corps de caractère
s’applique au nouveau texte.

2. Effectuez l’une des opérations suivantes :

Définissez l’option Corps de police dans le panneau Caractère ou dans la barre de commandes.

Choisissez un corps dans le menu Texte > Corps. Lorsque vous choisissez Autre, vous pouvez entrer un corps différent
dans le panneau Caractère.

Vous pouvez modifier l’unité de mesure des caractères dans la boîte de dialogue Préférences. Cette option n’est pas
disponible dans Fireworks.

Aperçu des polices

Vous pouvez visualiser des échantillons d’une police dans les menus de familles de caractères et de styles de caractères du panneau Caractères
ou dans les autres espaces de l’application permettant de choisir les polices. Les icônes suivantes sont utilisées pour désigner différents types de

Apprendre à installer des polices sur votre
ordinateur. Instructions disponibles pour la
plupart des versions Windows et Mac OS....
En savoir plus

http://adobe.ly/OSoIB3

par Polices Adobe 
http://www.adobe.com/fr/ty...

Partagez votre expérience dans
Adobe Community Help

http://adobe.ly/OSoIB3
http://adobe.ly/OSoIB3
http://www.adobe.com/fr/type
http://www.adobe.com/fr/type
http://www.adobe.com/fr/community/publishing/download.html
http://www.adobe.com/fr/community/publishing/download.html
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polices :

OpenType 

Type 1 

TrueType 

Multiple Master 

Composite 

Vous pouvez désactiver la fonction d’aperçu ou changer le corps de caractère des noms de police ou des échantillons de
polices dans les préférences de texte.

Polices OpenType

Les polices OpenType utilisent un fichier de police unique commun à Windows® et Macintosh® vous permettant de déplacer des fichiers d’une
plate-forme à une autre sans vous soucier de la substitution des polices et d’autres problèmes provoquant la redistribution du texte. Elles incluent
souvent de nombreux attributs, tels que des lettres italiques ornées et des ligatures conditionnelles qui ne sont pas disponibles dans les polices
PostScript et TrueType courantes.

Les polices OpenType affichent l’icône .

Lorsque vous travaillez avec une police OpenType, vous pouvez remplacer automatiquement dans votre texte les glyphes alternés, tels que les
ligatures, les petites majuscules, les fractions et les chiffres arabes non alignés.

Polices normale (à gauche) et OpenType (à droite)

A. Ordinaux B. Ligatures conditionnelles C. Lettres italiques ornées 

Les polices OpenType peuvent inclure un grand choix de jeux de caractères et de fonctions de mise en page pour fournir une meilleure prise en
charge linguistique et un contrôle typographique amélioré. Dans les menus des polices de l’application, le nom des polices OpenType d’Adobe qui
prennent en charge les langues d’Europe centrale (CE) contiennent le mot « Pro ». Les polices OpenType qui ne prennent pas en charge les
langues d’Europe centrale sont dites « Standard » et comportent un suffixe « Std ». Toutes les polices OpenType peuvent également être
installées et utilisées avec les polices PostScript Type 1 et TrueType.

Pour plus de détails sur les polices OpenType, reportez-vous à l’adresse www.adobe.com/go/opentype_fr.

Application d’attributs de police OpenType

Utilisez le panneau Caractère ou le panneau Contrôle pour appliquer au texte des attributs de police OpenType, tels que des signes de fraction et
des lettres italiques ornées.

Pour plus de détails sur les polices OpenType, reportez-vous à l’adresse www.adobe.com/go/opentype_fr.

Application d’attributs de police OpenType

1. Vérifiez qu’une police OpenType est sélectionnée dans le panneau Caractère ou Contrôle.

2. Choisissez la commande OpenType dans le menu du panneau Caractère, puis sélectionnez un attribut OpenType, tel que

http://www.adobe.com/go/opentype_fr
http://www.adobe.com/go/opentype_fr


Remarque :

Ligatures conditionnelles

Fractions

Ordinal

Lettre italique ornée

Variantes de titrage

Variantes contextuelles

Tout en petites capitales

Zéro barré

Jeux stylistiques

Formes positionnelles

Exposant/Supérieur et Indice/Inférieur

Ligatures conditionnelles ou Fractions.

Les fonctionnalités incompatibles avec la police active s’affichent entre crochets (par exemple, [Lettre italique ornée]).

Vous pouvez également sélectionner des attributs de police OpenType lors de la définition d’un style de paragraphe ou de caractère. Utilisez la
section Fonctionnalités OpenType de la boîte de dialogue Options de style.

Attributs de police OpenType

Lorsque vous sélectionnez une police OpenType pour mettre en forme du texte ou définir un style, vous pouvez choisir des fonctionnalités
OpenType dans le panneau Contrôle ou Caractère.

OpenType offre un grand nombre de styles et d’attributs différents selon la police. Les fonctionnalités non disponibles s’affichent
entre crochets (par exemple, [Lettre italique ornée]) dans le menu du panneau Contrôle.

Toutes les ligatures conditionnelles proposées par le créateur de la police ne doivent pas être activées. Choisissez,
selon votre texte, celles que vous voulez inclure. La sélection de cette option permet d’utiliser ces ligatures si elles sont présentes dans une
police. Pour obtenir plus d'informations sur les ligatures, consultez la page Web Application de ligatures à des paires de lettres.

Les chiffres séparés par une barre oblique (par exemple, 1/2) sont convertis en fractions, lorsque cette option est disponible.

Les chiffres ordinaux, tels que 1er et 2e, utilisent des caractères en exposant (1  et 2 ), lorsque cette option est disponible. Les
caractères comme le a et le o en exposant dans les mots espagnols segunda (2 ) et segundo (2 ) sont également correctement composés.

Si disponibles, les lettres italiques ornées normales et contextuelles, pouvant inclure des variantes de capitales et de fins de
mots, sont incluses.

Si disponibles, les caractères en majuscules utilisés dans les titres sont activés. Certaines polices produisent des effets
inattendus, si vous appliquez cette option à un texte contenant des caractères en majuscules et en minuscules.

Si disponibles, les ligatures contextuelles et de connexion sont activées. Des caractères de remplacement sont proposés
dans certains types de caractères d’écriture pour améliorer la liaison des lettres. Il est possible par exemple de relier les lettres « b » et « l » du
mot « blason » de manière à renforcer l’impression d’écriture manuscrite. Cette option est sélectionnée par défaut.

Pour les polices qui contiennent des petites capitales vraies, la sélection de cette option transforme tous les caractères
en petites capitales. Pour plus d'informations, consultez Modification de la casse du texte.

Lorsque cette option est sélectionnée, une barre oblique traverse le numéro 0. Sur certaines polices (notamment les polices
condensées), il peut être difficile de faire la distinction entre le numéro 0 et la lettre capitale O.

Certaines polices OpenType intègrent des jeux de glyphes de substitution conçus pour améliorer l’esthétique. Un jeu stylistique
est un groupe de glyphes de substitution qu’il est possible d’appliquer à un caractère spécifique ou à une plage de texte. Si vous sélectionnez un
nouveau jeu stylistique, les glyphes définis dans ce jeu se substituent aux glyphes par défaut de la police. Si vous combinez un glyphe issu d’un
jeu stylistique avec un glyphe défini par autre paramètre OpenType, le glyphe défini par le paramètre prend le pas sur le glyphe issu du jeu
stylistique. Les glyphes de chacun des jeux s’affichent dans le panneau Glyphes.

Certaines écritures cursives et certaines langues telles que l’arabe comportent des caractères qui présentent un aspect
différent selon leur emplacement au sein d’un mot. Ces caractères peuvent changer de forme lorsqu’ils se trouvent au début (position initiale), au
milieu (position médiale) ou à la fin (position finale) d’un mot, ou encore lorsqu’ils sont seuls (position isolée). Sélectionnez un caractère et
choisissez une option Formes positionnelles pour le mettre en forme selon les besoins. L’option Forme générale a pour effet d’insérer le caractère
générique ; l’option Forme automatique a pour effet d’insérer la forme correcte du caractère, suivant l’emplacement de celui-ci au sein du mot et
selon qu’il est isolé ou non.

Certaines polices OpenType incluent des glyphes en exposant ou en indice, et de taille relative aux
caractères qui les entourent. Si une police OpenType ne contient pas ces glyphes pour les fractions non standard, vous pouvez utiliser les

er e

a o

http://idiom-q-win-1/fr/indesign/using/formatting-characters.html#apply_ligatures_to_letter_pairs
http://idiom-q-win-1/fr/indesign/using/formatting-characters.html#change_the_case_of_type


Numérateur et Dénominateur

Chiffres alignés tabulaires

Chiffres elzéviriens proportionnels

Chiffres alignés proportionnels

Chiffres elzéviriens tabulaires

Style de chiffre par défaut
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attributs Numérateur et Dénominateur.

Certaines polices OpenType convertissent uniquement les fractions de base (par exemple, 1/2 ou 1/4) en glyphes
de fraction et non en fractions non standard (telles que 4/13 ou 99/100). Dans ce cas, appliquez les attributs Numérateur et Dénominateur à ces
fractions.

Les types à hauteur fixe ont tous la même largeur. Cette option est appropriée dans le cas de tableaux, par exemple,
dans lesquels il est important d’aligner les chiffres des différentes lignes.

Des types à hauteur et à largeur variables sont inclus. Cette option est recommandée pour donner aux
textes n’utilisant pas de capitales un aspect à la fois élégant et sophistiqué.

Des types à hauteur fixe, tous de la même largeur sont inclus. Cette option est appropriée dans le cas de textes
en capitales.

Des types à hauteur variable, de largeur fixe et égale sont inclus. Cette option est recommandée pour obtenir
l’aspect classique des caractères elzévir pour le texte aligné dans des colonnes, dans un rapport annuel par exemple.

Les glyphes numériques utilisent le style du chiffre par défaut de la police active.

Gestion des polices manquantes

Lorsque vous ouvrez ou importez des documents contenant des polices qui ne sont pas installées sur votre système, un message d’alerte
indiquant les polices manquantes apparaît. Si vous sélectionnez du texte contenant une police manquante, celle-ci s’affiche entre crochets dans le
menu déroulant des polices du panneau Caractère ou Contrôle.

InDesign remplace les polices manquantes par une police disponible. Lorsque cela se produit, vous pouvez sélectionner le texte et lui appliquer
n’importe quelle police disponible. Les polices manquantes remplacées par d’autres polices sont répertoriées en haut du menu Texte > Police,
dans une section intitulée « Polices manquantes ». Par défaut, le texte mis en forme avec des polices manquantes apparaît surligné en rose.

Si une police TrueType est installée et que le document contient une version Type 1 (T1) de cette même police, la police est indiquée comme
manquante.

Vous pouvez choisir Texte > Rechercher la police pour rechercher et modifier les polices manquantes. Si un style contient une police manquante,
vous pouvez modifier la définition du style pour mettre à jour la police.

La boîte de dialogue des polices manquantes d’InDesign peut afficher si la synchronisation de polices est activée ou non dans l’application
Creative Cloud. Si elle est désactivée, une option de la boîte de dialogue des polices manquantes permettra d’activer Typekit.

Pour rendre les polices manquantes disponibles

Utilisez l’une des méthodes suivantes :

Utilisez le flux de Typekit pour synchroniser la police manquante avec InDesign et d’autres applications. Voir
Synchronisation des polices de bureau.
Installez les polices manquantes sur votre système.
Placez les polices manquantes dans le dossier Fonts, situé dans le dossier d’application InDesign. Les polices de ce
dossier sont disponibles uniquement dans InDesign. Voir Installation des polices.
Activez les polices manquantes à l’aide d’une application de gestion des polices.

 

http://help.typekit.com/customer/portal/articles/1145956-how-to-sync-fonts-to-your-desktop
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Polices manquantes

Si vous ne parvenez pas à localiser une police manquante, utilisez la commande Rechercher une police pour la rechercher et la remplacer.

Pour mettre en surbrillance des polices substituées dans votre document

Si vous avez sélectionné l’option Polices substituées dans la boîte de dialogue des préférences, les plages de texte associées à une police
manquante apparaissent surlignées en rose, ce qui permet de les localiser plus facilement.

1. Choisissez la commande Edition > Préférences > Composition (Windows®) ou InDesign > Préférences > Composition
(Mac OS®).

2. Sélectionnez l’option Polices substituées, puis cliquez sur OK.

Polices de document installées

Les polices contenues dans un dossier Document Fonts situé au même emplacement qu’un document InDesign sont temporairement installées
lorsque le document est ouvert. Lorsque vous devez partager un document ou le déplacer sur un autre ordinateur, utilisez la
commande Assemblage pour créer un dossier Document Fonts. (Avant de partager toute police de document, assurez-vous que la licence du
logiciel de police le permet). Les polices synchronisées Adobe Typekit ne sont pas copiées par la commande Assemblage. Découvrez plus
d’informations sur les polices Typekit et la commande Assemblage ici.

Les polices contenues dans le dossier Document Fonts sont différentes de celles disponibles dans les dossiers de polices standard du système
d’exploitation. Elles sont installées à l’ouverture du document et remplacent les polices qui présentent un nom PostScript équivalent. Néanmoins,
le remplacement s’effectue au sein du document uniquement. Les polices installées à l’ouverture d’un document ne sont pas disponibles pour
d’autres documents. A la fermeture du document, ces polices sont désinstallées. Les polices de document installées sont répertoriées dans un
sous-menu du menu Police.

Certaines polices de type 1 ne sont pas disponibles dans le document. En outre, certaines polices Mac OS ne sont pas disponibles lorsque vous
exécutez InDesign sous Windows.

Pour visualiser une vidéo sur l’utilisation des polices de document installées, voir Partage des fichiers avec accès facile aux polices de document
(vidéo).

Polices Multiple Master

http://help.typekit.com/customer/portal/articles/1166052
https://helpx.adobe.com/fr/creative-cloud/tutorials/videos/indesign-access-to-document-fonts.html
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Multiple master désigne des polices personnalisables de Type 1 dont les styles de caractères sont décrits en termes d’axes de conception
variables, tels que l’épaisseur, la largeur, le style et le corps optique.

Certaines polices Multiple Master comprennent un corps optique vous permettant d’utiliser une police spécialement conçue pour une lisibilité
optimale à une taille spécifique. En général, et comparativement à un corps optique de 72 points, le corps optique d’une police plus petite, tel que
10 points, est conçu avec des hampes et des empattements plus gros, des caractères plus larges, moins de contraste entre les lignes épaisses et
minces, un œil plus important et un espacement plus large entre les caractères.

1. Choisissez Edition > Préférences > Texte (Windows) ou InDesign > Préférences > Texte (Mac OS).

2. Sélectionnez Utiliser automatiquement le corps optique correct, puis cliquez sur OK.

Adobe recommande également

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr
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Création de listes à puces ou numérotées
Mise en forme d’une liste à puces ou d’une liste numérotée
Modification des puces
Modification des options de liste numérotée
Définition des listes
Création d’un style de paragraphe pour les listes continues
Création de listes multiniveaux
Création de légendes continues de figures et tableaux
Recommencement ou continuation de la numérotation d’une liste
Conversion des puces ou des numéros d’une liste en texte

Création de listes à puces ou numérotées
Dans une liste à puces, chaque paragraphe commence par une puce. Dans une liste numérotée, chaque paragraphe commence par une
expression constituée d’un numéro ou d’une lettre et d’un séparateur tel qu’un point ou une parenthèse. La numérotation est automatiquement
mise à jour dans une liste numérotée dès que vous ajoutez ou supprimez des paragraphes. Vous pouvez changer de type de puce, de style de
numéro ou de séparateur, ou modifier les attributs de la police, le style de caractère et le type et la longueur du retrait.

Vous ne pouvez pas utiliser l’outil Texte pour sélectionner les puces ou les numéros d’une liste. Vous pouvez en revanche modifier leur mise en
forme et la longueur du retrait dans la boîte de dialogue Puces et numérotation, dans le panneau Paragraphe ou, s’ils font partie d’un style, dans
la section Puces et numérotation de la boîte de dialogue Styles de paragraphe.

Liste à puces et liste numérotée

Le moyen le plus simple de créer une liste à puces ou numérotée consiste à saisir le texte composant la liste, à le sélectionner, puis à cliquer sur
les boutons Liste à puces ou Liste numérotée du panneau Contrôle. Ces boutons permettent d’activer et de désactiver l’option de liste ou de
transformer une liste à puces en liste numérotée et inversement. Vous pouvez aussi inclure des attributs de puces et de numéros dans un style de
paragraphe et générer une liste en attribuant un style à des paragraphes.

Remarque : les caractères de puce et de numéro automatiquement générés ne sont pas réellement insérés dans le texte. Par conséquent, ils ne
peuvent pas faire l’objet d’une recherche avec la fonction de recherche de texte et ne peuvent pas non plus être sélectionnés à l’aide de l’outil
Texte s’ils n’ont pas été préalablement convertis en texte. Les puces et numéros n’apparaissent pas non plus dans la fenêtre du mode éditeur
(sauf dans la colonne des styles de paragraphe).
Pour consulter un didacticiel vidéo sur la création de listes à puces et numérotées, rendez-vous à l’adresse www.adobe.com/go/vid0077.

InDesign Docs présente une série d’articles sur l’utilisation des puces et de la numérotation pour créer des listes sommaires, des listes à plusieurs
niveaux, des légendes de figures et des procédures numérotées.

1. Sélectionnez les paragraphes composant la liste ou cliquez à l’endroit où vous voulez faire commencer la liste pour créer un
point d’insertion.

2. Utilisez l’une des méthodes suivantes :

http://www.adobe.com/go/vid0077
http://blogs.adobe.com/indesigndocs/2009/04/numbered_lists_part_i_outlines.html
http://blogs.adobe.com/indesigndocs/2009/04/numbered_lists_part_ii_multile.html
http://blogs.adobe.com/indesigndocs/2009/04/numbered_lists_part_ii_multile.html
http://blogs.adobe.com/indesigndocs/2009/04/numbered_lists_part_iii_figure.html
http://blogs.adobe.com/indesigndocs/2009/04/numbered_lists_part_iv_numbere.html
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Cliquez sur le bouton Liste à puces  ou Liste numérotée  du panneau Contrôle (en mode Paragraphe). Tout en
maintenant la touche Alt (Windows) ou Option (Mac OS) enfoncée, cliquez sur un bouton pour afficher la boîte de
dialogue Puces et numérotation.

Choisissez la commande Puces et numérotation dans le panneau Paragraphe ou dans le panneau Commande. Pour
l’option Type de liste, choisissez Puces ou Numéros. Spécifiez les paramètres souhaités, puis cliquez sur OK.

Appliquez un style de paragraphe qui comprend des puces ou des numéros.

3. Pour continuer la liste au paragraphe suivant, déplacez le point d’insertion à la fin de la liste et appuyez sur Entrée ou Retour.
4. Pour terminer la liste (ou une section de la liste, si la liste doit se poursuivre plus loin dans l’article), cliquez de nouveau sur le

bouton Liste à puces ou Liste numérotée dans le panneau Contrôle ou choisissez la commande Puces et numérotation dans
le menu du panneau Paragraphe.

Mise en forme d’une liste à puces ou d’une liste numérotée
1. A l’aide de l’outil Texte , sélectionnez les paragraphes de la liste dont vous souhaitez modifier la mise en forme.
2. Utilisez l’une des méthodes suivantes pour ouvrir la boîte de dialogue Puces et numérotation :

Choisissez la commande Puces et numérotation dans le menu du panneau Contrôle (en mode Paragraphe) ou dans le
menu du panneau Paragraphe.

Maintenez la touche Alt (Windows) ou Option (Mac OS) enfoncée tout en cliquant sur le bouton Liste à puces  ou Liste

numérotée .

3. Dans la boîte de dialogue Puces et numérotation, utilisez l’une des méthodes suivantes :

Modifiez la puce.

Modifiez les options de liste numérotée.

Sélectionnez le style que vous souhaitez appliquer aux numéros ou aux puces dans la liste Style de caractère.

4. Pour modifier la position de la puce ou du numéro, spécifiez l’une des options suivantes :
Alignement Permet d’aligner à gauche ou à droite, ou de centrer les puces ou les numéros dans l’espace qui leur est alloué
sur l’axe horizontal. Lorsque cet espace est étroit, les trois options donnent des résultats sensiblement identiques.

Retrait à gauche Définit la longueur du retrait du paragraphe à partir de la deuxième ligne.

Retrait de 1re ligne Définit l’emplacement de la puce ou du numéro.

Augmentez la valeur Retrait de 1re ligne si vous souhaitez que la ponctuation des listes longues soit alignée. Par exemple,
pour aligner les chiffres « 9. » et « 10. » par rapport au point, définissez l’alignement à droite et augmentez progressivement
le retrait de la première ligne jusqu’à ce que les chiffres soient alignés (veillez à activer la fonction d’aperçu).

Pour créer un retrait négatif, indiquez une valeur de retrait à gauche positive (2p0, par exemple), puis spécifiez une valeur
identique négative (en l’occurrence -2p0) pour le retrait de première ligne.

Paramètres de position
A.  Retrait négatif B.  Liste alignée à gauche

Remarque : les paramètres Retrait à gauche, Retrait de 1re ligne et Position de la tabulation de la boîte de dialogue Puces et
numérotation sont des attributs de paragraphe. Par conséquent, si vous les modifiez dans le panneau Paragraphe, vos
modifications se répercuteront sur la mise en forme des listes à puces et numérotées.

Position de la tabulation Insère une tabulation pour créer une espace entre la puce ou le numéro et le début de l’élément de
liste.

Par défaut, les puces et les numéros héritent de certains des paramètres de mise en forme appliqués au premier caractère du paragraphe auquel
ils sont associés. Si le premier caractère d’un paragraphe est différent des caractères commençant les autres paragraphes, le numéro ou la puce
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aura un aspect probablement discordant par rapport aux autres éléments de la liste. Si ces paramètres de mise en forme ne vous conviennent
pas, créez un style de caractère pour les puces et les numéros et appliquez-le à votre liste à l’aide de la boîte de dialogue Puces et numérotation.

Le premier mot en italique de l’étape 3 fait que le numéro est lui aussi en italique, ce que vous pouvez éviter en créant un style de caractère pour
les numéros et en l’appliquant la liste.

Modification des puces
Si vous ne souhaitez pas utiliser l’une des puces existantes, vous pouvez ajouter de nouvelles puces dans la grille Puce. Une puce disponible
dans une police donnée n’est pas forcément disponible dans une autre police. Vous pouvez choisir de mémoriser la police associée à une puce
que vous ajoutez.

Si vous souhaitez utiliser une puce issue d’une police particulière (comme la main pointant vers une direction de Dingbats), pensez à mémoriser la
police associée à cette puce. Si vous utilisez une puce standard, il n’est pas nécessaire de mémoriser sa police puisque la plupart des polices
auront leur propre version de cette puce. Selon que vous avez sélectionné ou non l’option Mémoriser la police avec cette puce, la puce à ajouter
peut faire référence à une valeur Unicode, une famille et un style de police spécifiques ou bien à une valeur Unicode uniquement.

Remarque : les puces qui font uniquement référence à une valeur Unicode (sans police mémorisée) s’affichent avec l’indicateur « u ».

Boîte de dialogue Puces et numérotation
A.  Puce sans police mémorisée B.  Puce avec police mémorisée

Pour modifier la puce
1. Dans le menu du panneau Contrôle ou du panneau Paragraphe, sélectionnez Puces et numérotation.
2. Dans la boîte de dialogue Puces et numérotation, choisissez la commande Puces dans le menu Type de liste.
3. Sélectionnez une autre puce, puis cliquez sur OK.

Pour ajouter une puce
1. Dans la boîte de dialogue Puces et numérotation, choisissez la commande Puces dans le menu Type de liste, puis cliquez sur

Ajouter.
2. Sélectionnez le glyphe à utiliser comme puce. Plusieurs familles et styles de polices contiennent différents glyphes.
3. Pour que la nouvelle puce mémorise la police et le style actifs, sélectionnez l’option Mémoriser la police avec cette puce.
4. Cliquez sur Ajouter.

Remarque : la liste des puces est enregistrée dans le document, comme le sont les styles de paragraphe et de caractère. Lorsque vous collez ou
chargez des styles de paragraphe d’un autre document, les puces utilisées dans ces styles sont visibles dans la boîte de dialogue Puces et
numérotation avec les autres puces du document.
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Pour supprimer une puce
1. Dans la boîte de dialogue Puces et numérotation, choisissez la commande Puces dans le menu Type de liste.
2. Sélectionnez la puce à supprimer, puis cliquez sur Supprimer. La première puce prédéfinie ne peut pas être supprimée.

Modification des options de liste numérotée
Dans une liste numérotée, la numérotation est automatiquement mise à jour dès que vous ajoutez ou supprimez des paragraphes. Les
paragraphes qui font partie de la même liste sont numérotés de façon séquentielle. Il n’est pas nécessaire que ces paragraphes se suivent si vous
avez défini une liste pour les paragraphes

Vous pouvez également créer une liste multiniveau dont les éléments sont numérotés de façon hiérarchique et mis en retrait sur plusieurs niveaux.

1. Ouvrez la boîte de dialogue Puces et numérotation.
2. Sous Style de numérotation, sélectionnez le type de numérotation à utiliser dans le menu Format.
3. Dans la zone Numéro, utilisez l’expression par défaut (le point (.) et la tabulation (^t)) ou générez votre propre expression

numérique. Pour entrer une expression numérique, supprimez le point situé à la suite du métacaractère de numérotation (^#),
puis utilisez l’une des méthode suivantes :

Entrez un ou plusieurs caractères (par exemple une parenthèse fermante) à la place du point.

Choisissez un élément (tel que Tiret cadratin ou Points de suspension) dans le menu Insérer un caractère spécial.

Saisissez un mot ou un caractère avant le métacaractère de numérotation. Par exemple, pour numéroter les questions
dans une liste, vous pouvez entrer le mot Question.

4. Choisissez un style de caractère pour l’expression (le style sélectionné s’appliquera à l’ensemble de l’expression numérique,
et pas seulement au numéro ou à la puce).

5. Dans Mode, sélectionnez l’une des options suivantes :
Suite du numéro précédent Numérote la liste de façon séquentielle.

Début Fait commencer la numérotation à partir de la valeur (numéro ou autre) entrée dans la zone de texte. Entrez un
numéro, et non pas une lettre, même si votre liste est numérotée au moyen de lettres ou de chiffres romains.

6. Définissez d’autres options, si nécessaire, puis cliquez sur OK.

Définition des listes
Une liste définie peut être interrompue par d’autres paragraphes et listes ; elle peut également s’étendre sur plusieurs articles ou plusieurs
documents d’un livre. Par exemple, utilisez les listes définies pour créer une vectorisation multiniveau ou pour créer une liste continue de noms de
tableaux numérotés dans le document. Vous pouvez également définir des listes pour les éléments numérotés ou à puces individuels qui sont
mélangés. Par exemple, si le document contient une liste de questions et de réponses, vous pouvez définir une liste pour numéroter les questions
et une autre pour numéroter les réponses.

Les listes définies permettent souvent de conserver un lien entre les paragraphes de façon à les numéroter. Si vous avez créé un style de
paragraphe pour la numérotation, vous pouvez appliquer ce style à une liste définie : les paragraphes seront numérotés sur la base de ce style en
fonction de leur emplacement dans la liste définie. Par exemple, le premier paragraphe se verra attribuer le numéro 1 (« Tableau 1 ») et le
paragraphe suivant le numéro 2 (« Tableau 2 ») même s’ils sont séparés de plusieurs pages. Comme les deux paragraphes font partie de la
même liste définie, ils seront numérotés de façon séquentielle, quelle que soit la distance qui les sépare au sein du document ou du livre.

Définissez une nouvelle liste pour chaque type d’élément à numéroter : étapes d’une procédure, tableaux et figures par exemple. Lorsque vous
définissez plusieurs listes, vous pouvez interrompre une liste par une autre et conserver la séquence de numérotation de chaque liste.

Si des éléments de liste apparaissent dans des blocs de texte sans lien sur une même page, ils sont numérotés dans l’ordre selon lequel les
blocs de texte sont ajoutés à la page. Pour les réorganiser, coupez-les et collez-les un à un dans l’ordre voulu.
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Les listes définies vous permettent d’interrompre une liste par une autre.

Pour consulter un didacticiel vidéo sur la création de listes à puces et numérotées, rendez-vous à l’adresse www.adobe.com/go/vid0077.

Pour définir une liste
1. Choisissez la commande Texte > Listes à puces et numérotées > Définir des listes.
2. Cliquez sur Nouveau dans la boîte de dialogue Définir des listes.
3. Attribuez un nom à la liste et indiquez si la numérotation doit se poursuivre d’un article à l’autre et si elle doit continuer à la

suite des documents précédents du livre.
4. Cliquez deux fois sur OK.

Après avoir défini une liste, vous pouvez l’utiliser dans un style de paragraphe, par exemple dans un style pour tableaux, pour figures ou pour
listes numérotées, et vous pouvez l’appliquer par l’intermédiaire des panneaux Contrôle et Paragraphe

Remarque : certaines listes sont automatiquement définies. Par exemple, lorsque vous importez une liste numérotée à partir d’un document
Microsoft Word, une liste est automatiquement définie pour ce document.

Pour modifier une liste définie
1. Choisissez la commande Texte > Listes à puces et numérotées > Définir des listes.
2. Sélectionnez une liste et cliquez sur le bouton Modifier.
3. Modifiez le nom de la liste ou redéfinissez les options Continuer la numérotation.

Les styles de paragraphe associés à l’ancienne liste sont réaffectés à la liste renommée.

Pour supprimer une liste définie
1. Choisissez la commande Texte > Listes à puces et numérotées > Définir des listes.
2. Sélectionnez une liste.
3. Cliquez sur le bouton Supprimer et indiquez par quelle liste (liste par défaut ou autre liste) la liste supprimée doit être

remplacée.

http://www.adobe.com/go/vid0077
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Création d’un style de paragraphe pour les listes continues
Pour créer une liste continue (liste entrecoupée d’autres paragraphes ou qui s’étend sur plusieurs articles ou documents), générez un style de
paragraphe et appliquez-le aux paragraphes que vous souhaitez intégrer à la liste. Si, par exemple, vous souhaitez créer une liste continue des
tableaux de votre document, créez un style de paragraphe nommé Tableaux, ajoutez une liste définie au style, puis appliquez le style de
paragraphe Tableaux à tous les paragraphes qui doivent apparaître dans votre liste Tableaux.

Vous trouverez sur InDesign Docs une série d’articles sur l’utilisation des puces et de la numérotation pour créer des légendes de figures et des
procédures numérotées.

1. Choisissez la commande Nouveau style de paragraphe dans le menu du panneau Styles de paragraphe.
2. Attribuez un nom au style.
3. Sur le côté gauche de la boîte de dialogue Nouveau style de paragraphe, cliquez sur Puces et numérotation.
4. Pour l’option Type de liste, sélectionnez Puces ou Numéros.
5. Si vous créez un style pour listes numérotées, sélectionnez une liste définie dans le menu Liste, ou choisissez la

commande Nouvelle liste et définissez la liste.
6. Spécifiez les caractéristiques de la puce ou des numéros.
7. Utilisez les options de la section Position de la puce ou de la numérotation de la boîte de dialogue Nouveau style de

paragraphe pour modifier le retrait. Par exemple, pour créer un retrait négatif, entrez 2p pour l’option Retrait à gauche et -2p
pour l’option Retrait de 1re ligne.

8. Spécifiez d’autres attributs de style de paragraphe, puis cliquez sur OK.

Création de listes multiniveaux
Une liste multiniveau est une liste qui définit les liens hiérarchiques entre les paragraphes de la liste. Les listes de ce type sont également
appelées listes hiérarchiques car elles s’apparentent à une structure hiérarchique. Le modèle de numérotation d’une liste, tout comme la longueur
des retraits, permettent de connaître le niveau hiérarchique d’un élément et de savoir comment celui-ci se positionne par rapport aux autres. Vous
pouvez facilement déterminer à quel niveau se situe un paragraphe dans la liste par rapport au paragraphe qui le suit et à celui qui le précède.
Vous pouvez inclure jusqu’à neuf niveaux dans une liste multiniveau.

Liste multiniveau dont les niveaux hiérarchiques sont définis au moyen de numéros et de lettres

Pour créer une liste multiniveau, définissez la liste et créez un style de paragraphe pour chaque niveau souhaité. Par exemple, une liste
comportant quatre niveaux requiert quatre styles de paragraphe (ayant chacun la même liste définie). Vous devez définir des paramètres de mise
en forme des numéros et des paragraphes pour chacun des styles créés.

Gabriel Powell propose un didacticiel vidéo, Creating an automatic numbered list, portant sur la création de listes sommaires et à plusieurs
niveaux.

Bob Bringhurst propose une série d’articles sur l’utilisation des puces et de la numérotation pour créer des listes sommaires, des listes à plusieurs
niveaux, des légendes de figures et des procédures numérotées.

1. Choisissez la commande Nouveau style de paragraphe dans le menu du panneau Styles de paragraphe.
2. Attribuez un nom au style.
3. Si vous avez déjà créé un style pour votre liste multiniveau, choisissez le style que vous allez associer aux niveaux situés au-

dessus du niveau actif dans le menu D’après ; sinon, choisissez la commande Aucun style de paragraphe ou Paragraphe
standard.

4. Sur le côté gauche de la boîte de dialogue Nouveau style de paragraphe, cliquez sur Puces et numérotation.

http://blogs.adobe.com/indesigndocs/2009/04/numbered_lists_part_iii_figure.html
http://blogs.adobe.com/indesigndocs/2009/04/numbered_lists_part_iv_numbere.html
http://www.instantindesign.com/index.php?view=391
http://blogs.adobe.com/indesigndocs/2009/04/numbered_lists_part_i_outlines.html
http://blogs.adobe.com/indesigndocs/2009/04/numbered_lists_part_ii_multile.html
http://blogs.adobe.com/indesigndocs/2009/04/numbered_lists_part_ii_multile.html
http://blogs.adobe.com/indesigndocs/2009/04/numbered_lists_part_iii_figure.html
http://blogs.adobe.com/indesigndocs/2009/04/numbered_lists_part_iv_numbere.html
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5. Choisissez la commande Numéros dans le menu Type de liste.
6. Choisissez l’une des listes définies dans le menu Liste. Si vous n’avez pas encore défini votre liste, choisissez Nouvelle liste

dans le menu et définissez-la.
7. Dans le champ Niveau, entrez le numéro correspondant au niveau de la liste multiniveau auquel se destine le style en cours

de création.
8. Dans le menu Format, choisissez le type de numérotation à utiliser.
9. Dans le champ Numéro, indiquez sous quelle forme les éléments de la liste doivent être numérotés à ce niveau. Pour ce faire,

entrez des métacaractères ou sélectionnez des métacaractères dans les menus.

Pour insérer des préfixes de numérotation de niveaux supérieurs, entrez le texte de votre choix ou cliquez au début de la
zone Numéro, puis choisissez la commande Insérer une balise d’emplacement de numéro et sélectionnez une option
Niveau (par exemple Niveau 1), ou bien entrez le caractère ^ suivi du niveau (par exemple ^1). Supposons que vous ayez
défini une liste dont les éléments de premier niveau sont numérotés 1, 2, 3, etc., et les éléments de deuxième
niveau a, b, c, etc. Si vous insérez le préfixe du premier niveau dans le modèle de numérotation du deuxième niveau, les
éléments de deuxième niveau seront numérotés de la façon suivante : 1a, 1b, 1c ; 2a, 2b, 2c ; 3a, 3b, 3c.

Pour créer une expression numérique, entrez les signes de ponctuation et les métacaractères nécessaires, ou bien
sélectionnez des options dans la liste Insérer un caractère spécial.

10. Sélectionnez l’option Recommencer la numérotation à ce niveau après si vous souhaitez que la numérotation recommence
à 1 lorsqu’un paragraphe de ce niveau succède à un paragraphe de niveau supérieur ; désélectionnez cette option si vous
souhaitez que les paragraphes de ce niveau soient numérotés de façon séquentielle sur l’ensemble de la liste, quelle soit leur
emplacement dans la hiérarchie.

Pour recommencer la numérotation après un certain niveau ou une certaine plage de niveaux, saisissez le numéro ou la plage
du niveau (2-4, par exemple) dans le champ Recommencer la numérotation à ce niveau après.

11. Dans la zone Position de la puce ou de la numérotation, définissez les options de retrait ou de tabulation de telle sorte que les
éléments de ce niveau soit plus en retrait que ceux des niveaux supérieurs. La mise en retrait permet de faire ressortir les
éléments de niveau inférieur dans la liste.

12. Cliquez sur le bouton OK.

Dans certains cas, comme dans celui des procédures numérotées, il peut être nécessaire de recommencer la numérotation depuis le début au
sein d’un même article. Pour éviter d’avoir à effectuer cette opération manuellement, créez un style distinct identique au style du niveau 1 à une
exception près. Dans la section Mode, sélectionnez l’option Début, puis indiquez la valeur 1. Nommez ce style « Niveau 1 avec renumérotation »,
par exemple.

Création de légendes continues de figures et tableaux
Les légendes continues permettent de numéroter les figures, les tableaux et d’autres types d’éléments de façon séquentielle dans un document.
Par exemple, la légende de la première figure peut commencer par les mots « Figure 1 », celle de la deuxième par les mots « Figure 2 », etc.
Pour vous assurer que les figures, les tableaux et autres éléments semblables seront numérotés de façon séquentielle, définissez une liste pour
l’élément, puis créez un style de paragraphe incluant cette définition de liste. Vous pouvez également ajouter des mots descriptifs, par exemple
« figure » ou « tableau », au modèle de numérotation du style de paragraphe.

Bob Bringhurst propose un article sur la création de légendes de figures sous le titre Numbered Lists Part III - Figure Captions.

Les éléments d’une liste sont numérotés en respectant l’ordre dans lequel ils sont ajoutés à la page. Pour les réorganiser, coupez-les et collez-
les un à un dans l’ordre voulu.

1. Créez un nouveau style de paragraphe et, dans la section Puces et numérotation de la boîte de dialogue Options de style de
paragraphe, choisissez l’option Numéros dans le menu Type de liste.

2. Sélectionnez une liste définie dans le menu Liste ou choisissez la commande Nouvelle liste pour en définir une.
3. Sous Style de numérotation, sélectionnez le type de numérotation à utiliser dans le menu Format.

Par exemple, sélectionnez l’option A, B, C, D... pour créer une liste de type « Figure A », « Figure B », etc.

4. Dans la zone Numéro, entrez un terme descriptif, ainsi que les espaces et les signes de ponctuation nécessaires, en
complément des métacaractères de numérotation.

Par exemple, pour créer un effet « Figure A », entrez le mot « Figure » et une espace avant les métacaractères (tel que
Figure ^#.^t). Cette action ajoute le mot « Figure » suivi d’un numéro séquentiel (^#), d’un point et d’une tabulation (^t).

Remarque : pour inclure les numéros de chapitre dans les légendes continues, choisissez la commande Insérer une balise
d’emplacement de numéro >Numéro de chapitre dans la liste Numéro ou entrez ^H là où le numéro de chapitre doit apparaître
dans le modèle de numérotation.

5. Finalisez le style et cliquez sur le bouton OK.

Une fois le style créé, appliquez-le aux légendes de figures ou aux titres de tableaux.

Vous pouvez utiliser la fonction Table des matières pour générer la liste des tableaux ou des figures.

http://blogs.adobe.com/indesigndocs/2009/04/numbered_lists_part_iii_figure.html
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Recommencement ou continuation de la numérotation d’une liste
InDesign offre des commandes permettant de recommencer ou de continuer la numérotation d’une liste :

Pour recommencer la numérotation d’une liste Placez le point d’insertion dans le paragraphe et choisissez la commande Recommencer la
numérotation dans le menu contextuel ou choisissez la commande Texte > Listes à puces et numérotées > Recommencer la numérotation. Dans
le cas d’une liste normale, cette commande attribue le numéro 1 (ou la lettre A) à un paragraphe et définit celui-ci comme premier paragraphe de
la liste. Dans le cas d’une liste multiniveau, cette commande attribue le premier numéro du niveau inférieur à un paragraphe imbriqué.
Pour continuer la numérotation d’une liste Choisissez la commande Continuer la numérotation dans le menu contextuel ou choisissez la
commande Texte > Listes à puces et numérotées > Continuer la numérotation. Cette commande reprend la numérotation d’une liste ayant été
interrompue par un commentaire, un graphique ou un élément de liste imbriqué. InDesign offre également des commandes permettant de
numéroter les listes qui commencent dans un article ou un livre et qui se poursuivent dans l’article ou le livre suivant.

Pour numéroter une liste d’un article précédent ou en cours
Suivant les paramètres de configuration de la liste, la numérotation continue à la suite de l’article précédent ou recommence dans l’article actif.

1. Choisissez la commande Texte > Listes à puces et numérotées > Définir des listes.
2. Sélectionnez une liste et cliquez sur le bouton Modifier.

Ne sélectionnez pas la liste par défaut : cette liste ne peut pas s’étendre sur plusieurs articles.

3. Sélectionnez l’option Continuer la numérotation au fil des articles pour continuer la numérotation de la liste à la suite de
l’article précédent ou désélectionnez cette option pour recommencer la numérotation à 1 (ou A) dans l’article actif.

4. Cliquez deux fois sur OK.

Pour numéroter une liste d’un document précédent ou en cours dans un livre
Suivant les paramètres de configuration de la liste, la numérotation continue à la suite du document précédent du livre ou recommence dans le
document actif.

1. Choisissez la commande Texte > Listes à puces et numérotées > Définir des listes.
2. Sélectionnez une liste et cliquez sur le bouton Modifier.
3. Sélectionnez l’option Continuer la numérotation du document précédent du livre pour continuer la numérotation de la liste à la

suite du document précédent (vous devez choisir Continuer la numérotation au fil des articles pour activer cette option) ou
désélectionnez cette option pour recommencer la numérotation à 1 (ou A) dans le document actif.

4. Cliquez deux fois sur OK.

Pour vous assurer que la numérotation est correctement mise à jour dans un livre, synchronisez les documents du livre, puis choisissez la
commande Mettre à jour la numérotation > Mettre à jour tous les numéros, dans le menu du panneau de livres.

Conversion des puces ou des numéros d’une liste en texte
1. Sélectionnez le paragraphe contenant la liste à puces ou numérotée.
2. Utilisez l’une des méthodes suivantes :

Choisissez la commande Convertir Numérotation en texte ou Convertir puces en texte dans le menu du
panneau Paragraphe.

Cliquez sur la sélection avec le bouton droit de la souris (Windows) ou en maintenant la touche Commande enfoncée
(Mac OS), puis choisissez Convertir Numérotation en texte ou Convertir puces en texte.

Remarque : pour supprimer les numéros ou les puces de la liste, cliquez sur le bouton Liste numérotée ou Liste à puces pour
annuler l’application de la mise en forme de la liste au texte sélectionné.

Voir aussi
Vidéo Listes à puces et numérotées

Informations juridiques   |   Politique de confidentialité en ligne

http://www.adobe.com/go/vid0077
http://creativecommons.org/licenses/by-nc-sa/3.0/
http://helpx.adobe.com/fr/legal/legal-notices.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr
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Formatting CJK characters
Apply shatai to text
Rotate characters
Adjust aki before and after characters
Use tate-chu-yoko
Add Ruby to text
Apply kenten
Align text of different sizes

Apply shatai to text

In traditional typesetting technology, characters were slanted by using a lens to distort the glyphs when being set
on film. This oblique style is known as shatai. Shatai is distinct from a simple slant of the glyphs, because it also
scales the glyphs. You can adjust the magnification or angle of text you want to slant from the center point,
without changing the height of the glyph, using the shatai feature in InDesign.

Shatai

A. No scale applied B. Magnification 30%, 45 shatai C. Selecting the Adjust Tsume option D. Selecting the Adjust Rotation option 

1. Select text.
2. Select Shatai from the Character panel menu or Control panel menu.
3. Specify the following options, and click OK:

Specify the degree of skew in Magnification (In traditional typesetting technology terms, 10%
magnification is lens 1, and 40% magnification is lens 4).

Set the angle of obliqueness to 30, 45, or 60, in Angle.

Select Adjust Rotation to rotate the glyphs, and display horizontal lines horizontally for horizontal text,
and vertical lines vertically for vertical text.

Select Adjust Tsume to apply jidori.

You can fine tune the rotated oblique effect for individual characters, after applying shatai to text.

Rotate characters
1. Select the characters.
2. In the Character panel, type a value for Character Rotation  Specify a minus value to rotate the character
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to the right (clockwise).

Adjust aki before and after characters
1. Select opening parenthesis or closing parenthesis with the type tool.
2. Choose the amount of aki you want to add from the Mojikumi Before Character  or Mojikumi After

Character  pop-up menu, in the Character panel.

For example, if you specify 2bu, half a full-width space is added, and if you specify 4bu, a quarter of a full-width
space is added. This aki will not be adjusted when the line is set to full justification. Adjusting aki is especially
useful to override Mojikumi Akiryo Settings for certain characters.

Adding aki before opening parenthesis

Use tate-chu-yoko

Using tate-chu-yoko (also known as kumimoji or renmoji) is an option to make a part of the text horizontal, in
vertical text. It is easier to read half-width characters such as numbers, dates, and short foreign words in a vertical
text frame, by rotating the text.

Before and after applying tate-chu-yoko

You can move text left, right, up, and down when you turn on the Tate-chu-yoko option. You can also set Auto
Tate-chu-yoko for special half-width characters. Auto Tate-chu-yoko is set in the paragraph attributes.

Use tsume or tracking in the Character panel to adjust the character spacing for Tate-chu-yoko.

Apply tate-chu-yoko

1. Select the text to which you want to apply tate-chu-yoko.
2. Do one of the following:

Choose Tate-chu-yoko from the Character panel menu or Control panel menu.
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Choose Tate-chu-yoko Settings from the Character panel menu or Control panel menu, choose Tate-
chu-yoko in the Tate-chu-yoko dialog box, and click OK.

If multiple instances of tate-chu-yoko appear next to each other, use the Non-joiner character to keep them
separate. Choose Type > Insert Special Character > Other > Non-joiner.

Remove tate-chu-yoko

1. Select the text to which you want to apply tate-chu-yoko.
2. Do one of the following:

Choose and cancel Tate-chu-yoko from the Character panel menu or Control panel menu.

Choose Tate-chu-yoko Settings from the Character panel menu, deselect Tate-chu-yoko in the Tate-
chu-yoko dialog box, and then click OK.

Change tate-chu-yoko settings

1. Choose Tate-chu-yoko Settings from the Character panel menu.
2. Specify a value for moving the text up or down in X Offset. If you specify a plus value, the text will move up,

and if you specify a minus value, it will move down.
3. Specify a value for moving the text left or right in Y Offset. If you specify a plus value, the text will move to

the right, and if you specify a minus value, it will move to the left.

Set Auto Tate-chu-yoko for specific paragraphs

1. Select the text to be set to Auto Tate-chu-yoko, or place the text insertion point in the paragraph.
2. Choose Auto Tate-chu-yoko from the Paragraph panel menu.
3. In KumiNumber, specify the number of successive half-width characters that you want to rotate to vertical

orientation. For example, if this is set to 2, the character string "123" will not rotate, while "12" will.
4. If you want to apply tate-chu-yoko to roman text, select Include Roman Characters, and click OK.

Add Ruby to text

In Japanese, Ruby (also known as furigana) is normally used to show the kanji yomi in hiragana. In Simplified
Chinese, Ruby is called Pinyin, while in Traditional Chinese, Ruby is called Chuyin. InDesign provides full support to
Japanese Ruby and limited support to Chinese Pinyin or Chuyin. You can adjust Ruby settings to specify Ruby
location, size, or color. Furthermore, when the ruby is longer than the parent you can specify the ruby distribution.
You can also apply tate-chu-yoko to Ruby.

Ruby on horizontal text (left), and ruby to the right of vertical text (right)

When the parent to which you want to attach ruby covers two lines, the ruby will follow when the parent moves to
the next line.



Note:

In some instances, such as when applying a style that includes a variable, Ruby characters may be removed.

1. Select the text to which you want to attach ruby. You cannot attach ruby when there are forced line breaks
in the selected text.

2. Select Ruby > Ruby from the Character panel menu or Control panel menu.
3. Enter the ruby characters in Ruby.
4. Change Ruby settings by clicking an option on the left side of the dialog box and specifying settings.
5. Click OK.

Ruby settings

The following options appear in the different panels of the Ruby dialog box.

Ruby Placement and Spacing

From the Type menu, choose Per-Character or Group Ruby. When Per Character Ruby is selected, enter a
half or full width space when inputting Ruby characters to separate them in line with their parent characters.
For "hakunetsutou" for example, enter as "haku netsu tou" (example of a word composed of Japanese
characters and its phonetic spelling is given).

Ruby

From the Alignment menu, specify the position of the Ruby characters. You can check the position with the
graphic shown in the sample field.

To attach ruby above horizontal text or to the right of vertical text, select Above/Right, and to attach below
horizontal text or to the left of vertical text, select Below/Left in Placement.

Specify the spacing between the ruby and the parent in XOffset and YOffset. When you enter a minus value,
the ruby moves closer to the parent.

Ruby Font and Size

Select a font family and font style in Font.

Specify the size of the ruby characters in Size. The default ruby size is half the size of the parent.

Specify the scale for the height and width of the ruby characters in Horizontal Scale and Vertical Scale.
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Select Use Open Type Pro Ruby Glyphs to use alternate glyphs for ruby (when possible). Specific kana
characters are available for some Open Type Pro fonts. When you select this option, the specific font for ruby
characters, and not the standard kana font, will be used.

In KumiNumber, specify the number of successive half-width characters that you want to rotate to vertical
orientation. For example, if this is set to 2, the character string "123" will not rotate, while "12" will.

Select Include Roman Characters to apply tate-chu-yoko to roman text.

Select Scale to Fit to force the tate-chu-yoko to have the same dimensions (1 em x 1 em) in the ruby string,
either using an OpenType feature or scaling the glyphs.

Adjustment When Ruby Is Longer Than Parent

With Overhang, when the total Ruby width is greater than that of their parent characters, the specified Ruby
will overflow widthways into the space above characters either side of the parents. For Japanese, character
types compatible with Overhang comply with the JISx4051-1995 specification.

Specify the parent character spacing necessary for attaching ruby in Spacing. When you select a different
option, the graphics displayed in the sample field are updated.

To automatically adjust the ruby character width, select Char Width Scaling, and specify the compression
scale for the width of the ruby characters.

Select Auto Align at Line Edges to align the parent with the start and end of the line.

Ruby Color

Select a color swatch in the list box.

Specify the degree of tinting and line weight, as necessary.

Select Overprint Fill or Overprint Stroke to set filling or stroke overprint for ruby characters.

(See Determining when to overprint manually.)

Apply kenten

Kenten (also known as Boten) are points which you attach to text you want to highlight. You can select the type of
points from existing kenten forms, or specify customized kenten characters. You can also specify the position,
scale, and color by adjusting the kenten settings.

Small black circle kenten, black sesame kenten, and small white circle kenten applied to text



Apply kenten

1. Choose the characters you want to highlight.
2. Choose a kenten character, such as Fisheye or White Circle, from Kenten in the Character panel menu or

Control panel menu.

Change kenten settings and color

1. Choose Kenten > Kenten from the Character panel menu or Control panel menu.
2. For Kenten Settings, specify the options below:

Kenten Type

Select a kenten character, such as Fisheye or White Circ le. Choose Custom to specify a custom character.
You can enter characters directly, or you can specify a character code value for the specified character set.

Position

Specify the spacing between the kenten and characters.

Location

Select Above/Right to attach kenten above horizontal text or to the right of vertical text, and Below/Left to
attach below horizontal text or to the left of vertical text.

Size

Specify the size of the kenten character.

Align

Specify whether the kenten should be displayed in the center (Center) or to the left (Left) (above for vertical
text) of the character's embox.

H/Scale and V/Scale

Specify the scale for the height and width of the kenten character.

3. To change the color of the kenten, choose Kenten Color from the list box, and then specify the options
below:

Select a color swatch from the list box.

Specify the degree of tinting and line weight, as necessary.

Select Overprint Fill or Overprint Stroke to set filling or stroke overprint for kenten characters.

(See Determining when to overprint manually.)

4. Click OK.
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You can specify how to align text to the largest characters in a line using the Character Alignment option, when
positioning characters of different sizes in 1 line. It is possible to align characters to the top, center or bottom of
the embox (right, center, and left for vertical frames), to the roman baseline, and to the top or bottom of the ICF
box (right or left for vertical frames). ICF (Ideographic Character Face) is the average height and width used by
the font designer to design the ideographic characters which comprise a font.

Align different sizes

A. Align different size letters above full space letters B. Align different size letters in the middle of full space letters C. Align different size
letters below full space letters 

Note:

The Character Alignment option is not effective, even if applied, when all characters are the same size in a line.

1. Select a range of text or lines for the characters you want to align, or select a text frame using the selection
tool.

2. Choose one of the following options from Character Alignment in the Character panel menu or Control panel
menu.

Roman Baseline aligns the small characters in a line to the large character baseline grid.

Embox Top/Right, Center, or Embox Bottom/Left align the small characters in a line to the specified
position of the large characters embox. In vertical text frames, Embox Top/Right aligns the text to the
right of the embox, and Embox Bottom/Left aligns the paragraph to the left of the embox.

ICF Top/Right and ICF Bottom/Left align the small characters in a line to the ICF specified by the large
characters. In vertical text frames, ICF Top/Right aligns the text to the right of the ICF, and ICF
Bottom/Left to the left of the ICF.

Adobe also recommends

Change the text direction
Align paragraphs to a baseline grid
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Sens d’écriture en mode d’affichage Galerie et mode éditeur
Coloration des signes diacritiques

De nouvelles fonctions améliorées pour travailler en arabe et en hébreu sont disponibles dans l’édition Moyen-Orient et Afrique du Nord de ce
logiciel.

Compositeurs universels Adobe
Les compositeurs universels Adobe vous permettent de créer du contenu dans les langues du Moyen-Orient. Vous pouvez saisir du texte en
allemand, anglais, arabe, français, hébreu, russe et dans d’autres langues latines et les combiner.

Vous pouvez choisir parmi les compositeurs disponibles dans le menu du panneau Paragraphe (Fenêtre > Paragraphe > menu du panneau). Par
exemple, dans InDesign, vous pouvez utiliser le compositeur de paragraphe universel Adobe. Ou, dans Illustrator, vous pouvez utiliser le
compositeur ligne par ligne pour le Moyen-Orient.

 
Compositeurs universels Adobe

Vous pouvez également enregistrer vos fichiers avec des noms en arabe et hébreu.

Sens du texte
Pour créer du contenu en arabe et en hébreu, activez le sens de texte de droite à gauche. Le sens de droite à gauche est le sens du texte par
défaut, mais de nombreux documents incluent également du texte de gauche à droite. Vous pouvez basculer entre les deux sens en toute
transparence.

Sélectionnez le sens du paragraphe dans le panneau Paragraphe.

 
Sélectionnez le sens du paragraphe

Si vous avez un mélange de langues dans le même paragraphe, vous pouvez spécifier le sens du texte au niveau des caractères. En outre, pour
insérer les dates et les nombres, spécifiez le sens du texte au niveau des caractères.
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A partir du menu du panneau Caractère, choisissez Sens des caractères, puis sélectionnez un sens.

 
Sens des caractères

Sens de l’article
Lorsque vous travaillez avec l’arabe et l’hébreu, l’article en règle générale défile de la droite vers la gauche. La première colonne doit être à droite
de l’image, et les colonnes suivantes sont ajoutées à gauche. Si votre disposition contient un contenu mixte, des articles différents nécessitent un
sens différent.

Dans le panneau Article (Fenêtre > Texte et tableaux > Article), cliquez sur un sens de l’article.

 
Sens de l’article

Insertion automatique de Kashidas
En arabe, le texte est justifié en ajoutant des Kashidas. Les Kashidas sont ajoutés aux caractères arabes pour les allonger. L’espace n’est pas
modifié. Utilisez l’insertion automatique de Kashidas pour justifier les paragraphes de texte en arabe.

Sélectionnez le paragraphe et, dans le panneau Paragraphe (Fenêtre > Texte et tableaux > Paragraphe), choisissez un paramètre dans la liste
déroulante Insérer Kashida. Les options disponibles sont les suivantes : aucun, court, moyen, long ou stylistique. Les Kashidas sont insérés
uniquement si le paragraphe est justifié. Ce paramètre n’est pas applicable pour les paragraphes qui ont des paramètres d’alignement.

Pour appliquer des Kashidas à un groupe de caractères, sélectionnez les caractères et choisissez Kashidas dans le menu du panneau Caractère.

 
Kashidas automatiques

Ligatures
Vous pouvez appliquer automatiquement des ligatures à des paires de caractères en arabe et en hébreu. Les ligatures sont des caractères de
remplacement typographiques utilisées pour certaines paires de lettres lorsqu’elles sont disponibles dans une police Open Type donnée.

Lorsque vous choisissez la commande Ligatures dans le menu du panneau Caractère ou Contrôle, une ligature standard définie dans la police est
créée.

1. Sélectionnez du texte.
2. Choisissez Ligatures dans le menu du panneau Caractère ou du panneau Contrôle.

Toutefois, certaines polices Open Type contiennent des ligatures conditionnelles ornées plus complexes que vous pouvez reproduire en
choisissant la commande Ligatures conditionnelles. Ces ligatures se trouvent dans le panneau Caractère > OpenType > Ligatures conditionnelles.

 
Activation automatique des ligatures

Signes diacritiques
Dans le script arabe, une diacritique ou un signe diacritique est un glyphe utilisé pour indiquer la longueur des consonnes ou les voyelles courtes.
Les signes diacritiques se placent au-dessus ou au-dessous du script. Pour définir au mieux le style de texte ou améliorer la lisibilité de certaines
polices, vous pouvez contrôler la position verticale ou horizontale des signes diacritiques :

1. Sélectionnez du texte qui contient des signes diacritiques.
2. Dans le panneau Caractère (Ctrl + T), modifiez la position des signes diacritiques par rapport au script. Les valeurs que vous

pouvez modifier sont : Ajuster la position horizontale des signes diacritiques, et Ajuster la position verticale des signes
diacritiques.
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Modification de la position des signes diacritiques

Copier-coller à partir de Microsoft Word
Vous pouvez copier du texte à partir de Microsoft Word et le coller directement dans un document. L’alignement et le sens du texte collé sont
automatiquement définis sur ceux du texte en arabe ou hébreu.

Polices par défaut
Lorsque vous installez une version Moyen-Orient ou Afrique du Nord, la police de texte par défaut est définie selon la langue de l’installation, par
défaut. Par exemple, si vous avez installé la version anglais/compatible arabe, la police de texte par défaut est définie sur Adobe arabe. De même,
si vous avez installé la version anglais/compatible hébreu, la police de texte par défaut est définie sur Adobe hébreu.

Prise en charge des anciennes polices
Les polices qui ont été traditionnellement utilisées (par exemple les polices AXT) peuvent toujours être utilisées dans cette version du logiciel.
Toutefois, il est recommandé d’utiliser les nouvelles polices Open Type pour les éléments basés sur le texte.

La protection des glyphes manquants (Edition > Préférences > Texte avancé) est activée par défaut. Le texte est traité automatiquement lorsque
les glyphes ne sont pas disponibles dans la police que vous utilisez.

Types de chiffres
Lorsque vous travaillez en arabe ou en hébreu, vous pouvez sélectionner le type de chiffres que vous souhaitez utiliser. Vous pouvez choisir entre
arabe, farsi et hindi.

Par défaut, en arabe, la version hindi est sélectionnée automatiquement, et dans le cas de l’hébreu, les chiffres de type arabe sont sélectionnés.
Toutefois, vous pouvez passer en chiffres arabes, si vous le souhaitez :

1. Sélectionnez les chiffres dans le texte saisi.
2. Dans le panneau Caractère (Ctrl + T), utilisez la liste Chiffres pour sélectionner la police que les chiffres doivent utiliser.

Vous pouvez vous assurer que les chiffres arabes sont utilisés en activant l’option Utiliser les chiffres natifs avec les langues arabes. Pour utiliser
cette option, choisissez Edition > Préférences > Texte avancé.

 
Sélection du type de chiffres

Césure
Les phrases qui ont plus de mots qu’une ligne de texte peut contenir enchaînent automatiquement à la ligne suivante. Le type de justification de
texte en situation de retour à la ligne entraîne parfois l’apparition d’espaces inutiles dans la ligne qui ne sont pas agréables esthétiquement ni
corrects linguistiquement. La césure permet de séparer les mots à la fin d’une ligne, à l’aide d’un trait d’union. Cette fragmentation permet à la
phrase de retourner à la ligne suivante de façon plus adaptée.

Texte mixte : la fonction d’insertion de Kashidas affecte la façon dont la césure se produit dans un texte mixte. Lorsque cette option est activée,
les Kashidas sont insérés dès qu’ils peuvent l’être et le texte qui n’est pas en arabe n’est pas césuré. Lorsque la fonction Kashida est désactivée,
seul le texte qui n’est pas en arabe est pris en compte pour la césure.

Texte en hébreu : la césure est autorisée. Pour activer la césure et personnaliser les paramètres, sélectionnez le panneau Paragraphe > menu du
panneau > Paramètres de césure.

 
Options de césure

Rechercher et remplacer
Les utilisateurs de l’hébreu et de l’arabe peuvent effectuer une recherche de texte intégral et remplacer. En plus de la recherche et du
remplacement de texte simple, vous pouvez également rechercher et remplacer du texte présentant des caractéristiques spécifiques. Ces
caractéristiques peuvent inclure des marques diacritiques, des Kashidas, des caractères spéciaux (par exemple, Alef), des chiffres dans
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différentes langues (par exemple, chiffres en Hindi), et bien plus encore.

Pour exécuter la recherche et le remplacement du texte :

InDesign: Edition > Rechercher/Remplacer

Dans InDesign, vous pouvez utiliser l’onglet Translittération (Edition > Rechercher/Remplacer) pour rechercher et remplacer les chiffres entre
l’arabe, l’hindi, et le farsi. Par exemple, vous pouvez rechercher les chiffres saisis en hindi et les convertir en arabe.

Glyphes
Les utilisateurs de l’arabe et de l’hébreu peuvent appliquer des glyphes dans le jeu de caractères par défaut. Cependant, pour y accéder,
sélectionner, puis appliquer un glyphe défini par le jeu de caractères par défaut ou une langue différente, utilisez le panneau Glyphes :

InDesign : Fenêtre > Texte et tableaux > Glyphes 
Illustrator : Fenêtre > Type > Glyphes

 
Parcourir, sélectionner et appliquer les glyphes

Variantes de justification
Une police peut posséder des formes alternatives pour certaines lettres de l’alphabet. Ces variantes de la police de caractères disponibles pour
certaines lettres sont généralement utilisées à des fins stylistiques ou calligraphiques. Dans de rares cas, des variantes de justification sont
utilisées pour justifier et aligner les paragraphes pour des besoins précis.

Les variantes de justification peuvent être activées au niveau des paragraphes, dans lesquels les variantes seront utilisées dès que possible. Vous
pouvez également activer ou désactiver cette fonction au niveau des caractères. Les variantes de justification sont uniquement disponibles dans
les polices qui sont dotées de cette fonction intégrée. Par conséquent, l’option pour les activer ou désactiver est uniquement disponible pour les
polices prises en charge.

Les polices arabes qui contiennent des variantes de justification sont : Adobe arabe, Myriad arabe et Adobe Naskh. Les polices hébraïques qui
contiennent des variantes de justification sont : Adobe hébreu et Myriad hébreu.

InDesign

Niveau paragraphe : Fenêtre > panneau Paragraphe > menu du panneau > Justification, puis choisissez une option dans la liste
Justification.

Niveau caractère : Fenêtre > panneau Caractère > menu du panneau > option Variante de justification.

Photoshop

Niveau caractère : Fenêtre > panneau Caractère > case à cocher Variantes de justification.

Insertion des caractères spéciaux du Moyen-Orient
Certains caractères en arabe et en hébreu sont difficiles à insérer dans le texte. De plus, la disposition des claviers arabe et hébreu complique la
saisie ou l’insertion de ces caractères. Pour insérer des caractères comme une apostrophe en hébreu (Geresh) ou Maqaf, sélectionnez un
caractère dans le panneau Caractère > menu du panneau > Insérer caractère spécial ME.

 
Insérer un caractère spécial ME

Sens d’un tableau
Les utilisateurs de l’arabe et de l’hébreu peuvent définir le sens d’un tableau inséré dans un document. En conséquence, l’ordre des cellules et
des colonnes, la langue par défaut et l’alignement du texte est défini. Pour un utilisateur arabe, la colonne la plus à droite est la première colonne,
et les colonnes supplémentaires sont ajoutées au-delà de la colonne de gauche du tableau. Le sens du tableau est également pris en charge dans
le mode éditeur (Ctrl + Y).

Pour définir le sens d’un nouveau tableau :

1. Cliquez sur Tableau > Insérer un tableau
2. Dans Insérer un tableau , choisissez une option dans la listeSens liste pour sélectionner le sens du tableau.

Pour modifier le sens d’un tableau existant :
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1. Placez le curseur dans un tableau.
2. Ouvrez le panneau Tableau (Maj + F9), puis cliquez sur les icônes Tableau de gauche à droite ou Tableau de droite à gauche

pour définir le sens du tableau.

Pour les tableaux de droite à gauche, le versions arabe et Afrique du Nord sont en langue arabe par défaut. La version hébraïque est définie sur
hébreu. Pour les tableaux de gauche à droite, les versions arabe et hébraïque adoptent par défaut la langue anglaise. La version Afrique du Nord
est en français par défaut.

Sens de la reliure
Le sens de la reliure définit le bord le long duquel un livre est relié. Les livres écrit dans une langue de gauche à droite sont reliées à gauche. Les
documents écrits dans une langue de droite à gauche sont reliés à l’extrémité droite du livre.

 
Mise en page d’un livre relié à droite

Préférences d’écriture de droite à gauche
Caractères neutre

La direction de certains caractères en arabe et en hébreu peut apparaître ambiguë. Le manque de clarté quant à la direction des caractères peut
entraîner une confusion dans la direction et l’ordre des chaînes. Pour vous assurer que la direction de ces caractères est claire et sans ambiguïté.

1. Cliquez sur Edition > Préférences > Droite à gauche
2. Sélectionnez la boîte Forcer la direction du caractère neutre en fonction de la saisie clavier.

Contrôle du curseur

Les utilisateurs de l’arabe et de l’hébreu peuvent contrôler la direction de déplacement du curseur, lorsqu’ils utilisent les touches fléchées du
clavier. Cette liste de déplacement du curseur (Edition > Préférences > Droite à gauche) comporte deux options que vous pouvez choisir dans :

Visuel : le curseur se déplace dans le sens de la flèche. Lorsque la flèche vers la droite est enfoncée, le curseur à l’écran se
déplace vers la droite. 
Logique : le curseur se déplace en fonction de la direction du langage saisie. En arabe et en hébreu, lorsque la flèche de
droite est enfoncée, le curseur se déplace à gauche (vers le caractère suivant dans une langue de droite à gauche). 

Numéros de page et de chapitre
Les utilisateurs de l’arabe et de l’hébreu utilisent les systèmes de numérotation courants dans la région. Les systèmes de numérotation les plus
populaires sont :

Arabe : Abjad et Alef-Ba-Tah
Français : hébreu biblique standard et hébreu décimal non standard

Pour sélectionner ou modifier le système de numérotation, accéder à Mise en forme > Options de numérotation et de section, puis sélectionnez
dans la liste Style.

 
La numérotation des pages, des sections et des chapitres

Sens d’écriture dans un affichage Galerie et en mode éditeur
En en arabe ou en hébreu, vous pouvez indiquer le sens dans lequel vous écrivez. Allez dans Edition > Préférences > Affichage en mode éditeur,
puis sélectionnez la boîteIndiquer le sens de l’écriture pour activer cette fonction. Lorsque cette fonction est activée, le curseur a une flèche qui
indique le sens de l’écriture.

Coloration des signes diacritiques
Dans un texte en arabe, les signes diacritiques peuvent être colorés différemment pour des raisons stylistiques ou autres. Par exemple, des signes
diacritiques peuvent mettre l’accent sur un aspect spécifique d’un mot ou d’une phrase. Vous pouvez rechercher et modifier la couleur des signes
diacritiques à l’aide de la requête Modifier la couleur des signes diacritiques arabe.

1. Cliquez sur Edition > Rechercher/Remplacer



2. Dans la liste requête, sélectionnez Modifier la couleur des signes diacritiques arabiques
3. Utilisez les boutons Modifier, Tout modifier, ou Remplacer/Rechercher pour remplacer les anciens signes diacritiques par les

nouveaux signes de couleur.

Vous pouvez modifier et enregistrer la requête selon vos exigences.

 Les publications Twitter™ et Facebook ne sont pas couvertes par les dispositions de Creative Commons.
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Mise en forme de texte
Utilisez le panneau Contrôle pour modifier l’aspect du texte. Lors de la sélection de texte ou de l’insertion d’un point dans un texte, les
commandes de mise en forme des caractères ou les commandes de mise en forme des paragraphes ou une combinaison des deux s’affichent
dans le panneau Contrôle selon la résolution de votre écran. Les mêmes commandes de mise en forme de texte s’affichent dans les panneaux
Caractère et Paragraphe. Vous pouvez également utiliser le panneau Caractère et le panneau Paragraphe pour modifier l’aspect du texte.

Pour consulter un didacticiel vidéo sur la mise en forme des caractères, rendez-vous à l’adresse www.adobe.com/go/lrvid4275_id_fr. Pour
consulter un didacticiel vidéo sur la mise en forme des paragraphes, rendez-vous à l’adresse www.adobe.com/go/lrvid4276_id_fr.

Pour la mise en forme de texte, utilisez l’une des méthodes suivantes :

Pour mettre des caractères en forme, sélectionnez-les à l’aide de l’outil Texte  ou cliquez sur le document pour créer un
point d’insertion, sélectionnez une option de mise en forme et commencez à taper le texte.

Pour mettre en forme un paragraphe, il n’est pas nécessaire que tous les caractères du paragraphe soient sélectionnés ; il
suffit de sélectionner un mot ou un caractère, ou de créer un point d’insertion dans le paragraphe. Vous pouvez également
sélectionner du texte sur plusieurs paragraphes.

Pour définir la mise en forme de tous les blocs de texte que vous créez dans le document actif, assurez-vous qu’aucun point
d’insertion n’est actif et que rien n’est sélectionné, puis définissez les options de mise en forme. Pour définir la mise en forme
par défaut du texte de tout nouveau document, fermez d’abord l’ensemble des documents, puis définissez les paramètres de
texte (voir la section Définition de paramètres par défaut).

Sélectionnez un bloc pour appliquer la mise en forme à tout le texte qu’il contient. Le bloc ne peut pas faire partie d’un lien.

Utilisez les styles de paragraphe et de caractère pour mettre en forme le texte plus rapidement et de façon homogène.

Pour consulter un didacticiel vidéo sur l’utilisation de texte, rendez-vous à l’adresse www.adobe.com/go/vid0075.

1. Sélectionnez l’outil Texte .
2. Cliquez sur le document pour créer un point d’insertion ou sélectionnez le texte à mettre en forme.

3. Dans le panneau Contrôle, cliquez sur l’icône Commandes de mise en forme des caractères  ou Commandes de mise en
forme des paragraphes .

Panneau Contrôle
A.  Commandes de mise en forme des caractères B.  Commandes de mise en forme des paragraphes

4. Définissez les options de mise en forme.

Copie des attributs de texte (outil Pipette)
L’outil Pipette permet de copier des attributs de caractère, de paragraphe, de fond et de contour, puis de les appliquer à un autre texte. Par défaut,
l’outil Pipette copie tous les attributs de texte. Pour personnaliser les attributs à copier à l’aide de l’outil Pipette, utilisez la boîte de dialogue
Options de la pipette.

Pour copier des attributs de texte vers du texte non sélectionné
1. A l’aide de l’outil Pipette , cliquez sur le texte auquel sont appliqués les attributs de mise en forme à copier (le texte peut se

trouver dans un autre document ouvert). Le pointeur de la pipette change de sens et apparaît rempli  pour indiquer qu’il
contient les attributs copiés. Lorsque vous placez la pipette sur le texte, une barre verticale I s’affiche à côté de la pipette
chargée .

2. A l’aide de l’outil Pipette, sélectionnez le texte à modifier.

http://www.adobe.com/go/lrvid4275_id_fr
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Les attributs chargés dans la pipette s’appliquent au texte sélectionné. Tant que l’outil Pipette est sélectionné, vous pouvez
continuer à appliquer la mise en forme.

3. Pour désélectionner l’outil Pipette, cliquez sur un autre outil.

Pour effacer les attributs de mise en forme définis dans l’outil Pipette (si celui-ci est chargé), appuyez sur la touche Alt (Windows) ou Option
(Mac OS). L’outil Pipette change de sens et apparaît vide  pour indiquer qu’il est prêt à prélever de nouveaux attributs. Cliquez sur un objet
contenant les attributs à copier, puis faites glisser les nouveaux attributs vers un autre objet.

Cliquez avec l’outil Pipette sur les attributs d’un texte mis en forme (à gauche) pour les copier, puis faites-le glisser vers du texte non mis en forme
(au milieu) pour lui appliquer les attributs copiés (à droite).

Si vous utilisez l’outil Pipette pour copier le style de paragraphe d’un texte d’un document à un autre, sachant que le style de paragraphe porte le
même nom mais possède des attributs différents, toutes les différences de styles s’affichent sous la forme de remplacements locaux du style de
destination.

Pour copier des attributs de texte vers du texte sélectionné
1. A l’aide de l’outil Texte  ou Texte curviligne , sélectionnez le texte auquel appliquer les attributs à copier.

2. A l’aide de l’outil Pipette , cliquez sur le texte dont vous souhaitez copier les attributs. Le texte dont vous souhaitez copier
les attributs doit se trouver dans le même document InDesign que le texte à modifier. L’outil Pipette change de sens et
apparaît rempli  pour indiquer qu’il contient les attributs copiés. Les attributs sont appliqués au texte sélectionné à l’étape 1.

Attributs de texte copiés vers du texte sélectionné

Pour modifier les attributs de texte copiés par l’outil Pipette
1. Dans le panneau Outils, cliquez deux fois sur l’outil Pipette.
2. Dans la boîte de dialogue Options de la pipette, choisissez Caractères ou Paragraphes.
3. Sélectionnez les attributs à copier à l’aide de l’outil Pipette, puis cliquez sur OK.

Pour copier ou appliquer uniquement les attributs de paragraphe sans avoir à modifier les paramètres de la boîte de dialogue Options de l’outil
Pipette, maintenez la touche Maj enfoncée et cliquez sur le texte avec l’outil Pipette.

Utilisation de la commande Application rapide
La commande Application rapide vous permet de rechercher et d’appliquer des commandes de menu, des scripts, des variables, ainsi que la
plupart des commandes se trouvant dans la boîte de dialogue Raccourcis clavier.

1. Sélectionnez le texte ou le bloc auquel vous souhaitez appliquer le style, la commande de menu, le script ou la variable.
2. Choisissez Edition > Application rapide ou appuyez sur les touches Ctrl+Entrée (Windows) ou Commande+Retour (Mac OS).
3. Commencez à entrer le nom de l’élément que vous souhaitez appliquer.

Il est inutile que le nom indiqué soit parfaitement exact. Par exemple, si vous saisissez ti, les styles tels que Titre 1, Titre 2 et
Sous-titre vous sont proposés, ou les commandes du menu d’aide si vous saisissez « ai » (menu Aide > Aide InDesign).



 

Utilisez la commande Application rapide pour rechercher des styles, des commandes de menu, des scripts et des variables.

Vous pouvez restreindre la recherche à une seule catégorie en saisissant le préfixe adéquat au début de la recherche, par
exemple m: pour menu ou s: pour style de paragraphe. Pour consulter une liste des préfixes, cliquez sur le bouton flèche
bas à gauche de la zone de texte d’Application rapide. Vous pouvez désélectionner les catégories de la liste que vous ne
souhaitez pas voir apparaître.

4. Sélectionnez l’élément que vous souhaitez appliquer, puis :

Pour appliquer un style, une commande de menu ou une variable, appuyez sur la touche Entrée ou la touche Retour.

Pour appliquer un style de paragraphe et supprimer les remplacements, appuyez sur les touches Alt+Entrée (Windows) ou
Option+Retour (Mac OS).

Pour appliquer un style de paragraphe et supprimer les remplacements ainsi que les styles de caractère, appuyez sur les
touches Alt+Maj+Entrée (Windows) ou Option+Maj+Retour (Mac OS).

Pour appliquer un élément sans fermer la liste Application rapide, appuyez sur les touches Maj+Entrée (Windows)
ou Maj+Retour (Mac OS).

Pour fermer la liste Application rapide sans appliquer d’élément, appuyez sur la touche Echap ou cliquez à un endroit
quelconque de la fenêtre de document.

Pour modifier un style, appuyez sur Ctrl+Entrée (Windows) ou sur Commande+Retour (Mac OS).

Lorsque la liste Application rapide est à l’écran, appuyez sur les touches flèche gauche et flèche droite pour parcourir le champ d’édition et sur
les touches flèche haut et flèche bas pour parcourir la liste d’éléments.

Voir aussi
Vidéo Travailler avec du texte
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Composition de texte
L’aspect du texte sur une page dépend d’un système complexe d’interaction entre différents processus, appelé composition. A l’aide des options
d’espacement des mots et des lettres, d’échelle glyphe et de césure que vous avez sélectionnées, InDesign compose votre texte afin qu’il
corresponde le mieux aux paramètres spécifiés.

InDesign offre deux méthodes de composition : le Compositeur de paragraphe Adobe (par défaut) et le Compositeur ligne simple Adobe (les deux
étant accessibles à partir du panneau Contrôle). Vous pouvez sélectionner le compositeur à utiliser dans le menu du panneau Paragraphe, de la
boîte de dialogue Justification ou du menu du panneau Contrôle.

Pour consulter un didacticiel vidéo sur l’utilisation de texte, rendez-vous à l’adresse www.adobe.com/go/vid0075.

InDesign Magazine propose un article consacré à la résolution des problèmes de composition intitulé Mind the Gaps.

Méthodes de composition
InDesign propose deux méthodes de composition : le compositeur de paragraphe Adobe (la méthode par défaut) et le compositeur de ligne
simple Adobe. Ces deux méthodes de composition évaluent les coupures possibles et sélectionnent celle qui correspond le mieux aux options de
césure et de justification que vous avez spécifiées pour un paragraphe donné.

Compositeur de paragraphe Adobe
Le compositeur de paragraphe Adobe prend en considération un réseau de points de coupure pour une plage de lignes et peut ainsi optimiser les
lignes du début d’un paragraphe afin d’éliminer ultérieurement les coupures désagréables à l’œil. L’utilisation du compositeur de paragraphe
entraîne un espacement plus régulier et moins de césures.

Le compositeur de paragraphe aborde une composition en identifiant et en évaluant les points de coupure possibles et en leur attribuant une
pénalité pondérée basée sur les principes tels que la régularité de l’espacement des lettres et des mots, et de la césure.

Vous pouvez utiliser la boîte de dialogue Césure pour définir la relation entre un meilleur espacement et le nombre de césures (voir la section
Césure de texte).

Compositeur ligne simple Adobe
Le compositeur de ligne simple propose une composition traditionnelle du texte, ligne par ligne. Cette option est utile si vous voulez limiter les
effets des modifications de dernière minute sur la composition.

Choix d’une méthode de composition d’un paragraphe
 Utilisez l’une des méthodes suivantes :

Dans le menu du panneau Paragraphe, sélectionnez Compositeur de paragraphe Adobe (méthode par défaut) ou Compositeur
de ligne simple Adobe.

Dans le menu du panneau Paragraphe ou Contrôle, choisissez la commande Justification, puis sélectionnez une option dans
le menu Compositeur.

Remarque : différentes sociétés proposent des modules de composition supplémentaires, fournis avec des interfaces vous permettant de
personnaliser les paramètres d’un moteur.

Définition des préférences de composition
1. Choisissez Edition > Préférences > Composition (Windows) ou InDesign > Préférences > Composition (Mac OS).

2. Pour utiliser la mise en surbrillance afin d’identifier les problèmes de composition, sélectionnez Infractions et Infractions de
césure et de justification.

3. Pour justifier le texte qui habille un objet, vous devez sélectionner Justifier le texte en regard d’un objet habillé recouvrant
complètement la colonne.

http://www.adobe.com/go/vid0075
http://www.creativepro.com/article/indesign-how-to-mind-the-gaps


Haut de la page

Haut de la page

4. Cliquez sur le bouton OK.

Césure de texte
Les paramètres sélectionnés pour la césure et la justification ont un impact sur l’espacement horizontal des lignes et l’aspect esthétique du texte
sur une page. Les options de césure déterminent si les mots peuvent être coupés et, si tel est le cas, quelles coupures sont autorisées.

La justification dépend de l’option d’alignement sélectionnée, de l’intermots et de l’interlettrage spécifiés et de l’utilisation ou non de la mise à
l’échelle glyphe. Vous pouvez également justifier des mots isolés dans les colonnes étroites d’un texte justifié.

Dans son article intitulé Mind the Gaps, Eda Warren indique comment éviter les problèmes de composition.

Pour régler manuellement la césure
Vous pouvez couper les mots manuellement ou automatiquement ou bien combiner les deux méthodes. La méthode de césure manuelle la plus
sûre consiste à insérer un tiret conditionnel : ce type de tiret n’apparaît que s’il est nécessaire de couper le mot en fin de ligne. Un tiret
conditionnel placé au début d’un mot l’empêche d’être coupé en deux.

1. A l’aide de l’outil Texte , cliquez à l’endroit où vous souhaitez insérer le tiret.
2. Utilisez l’une des méthodes suivantes :

Choisissez la commande Texte > Insérer un caractère spécial > Césures et tirets > Tiret conditionnel.

Appuyez sur les touches Ctrl+Maj+- (Windows) ou Commande+Maj+- (Mac OS) pour insérer un tiret conditionnel.

Remarque : un tiret conditionnel n’implique pas forcément que le mot qui le contient sera coupé. La coupure du mot à l’endroit indiqué dépend
d’autres paramètres de césure et de composition. Cependant, si le mot doit être coupé, la césure se fera à l’endroit du tiret conditionnel.

Pour régler automatiquement la césure
La césure repose sur des listes de mots stockées dans un fichier de dictionnaire utilisateur séparé, sur le disque dur de l’ordinateur, ou dans le
document lui-même. Pour garantir une césure homogène, vous pouvez désigner une liste de mots à rechercher ; cette fonction est
particulièrement utile pour les documents destinés à un prestataire de services ou si vous travaillez en groupe.

 Pour activer ou désactiver la césure automatique d’un paragraphe, activez ou désactivez l’option Césure du panneau Paragraphe ou Contrôle.
Vous pouvez également inclure cette option dans un style de paragraphe.
Lorsque vous définissez des options de césure automatique, vous pouvez indiquer le meilleur compromis entre l’espacement et le nombre de
césures. Il est possible également d’éviter que les mots en capitales et le dernier mot d’un paragraphe soient coupés.

Pour définir des options de césure automatique d’un paragraphe
1. Cliquez sur un paragraphe ou sélectionnez la plage de paragraphes concernée.
2. Choisissez Césure dans le menu du panneau Paragraphe.
3. Sélectionnez l’option Césure.
4. Modifiez les paramètres suivants selon les besoins, puis cliquez sur le bouton OK :

Mots d’au moins _ lettres Indiquez le nombre minimum de caractères qu’un mot doit comporter pour pouvoir être coupé.

Après les premières _ lettres / Avant les dernières _ lettres Indiquez le nombre minimum de caractères à conserver au
début ou à la fin d’un mot avec césure. Par exemple, lorsque vous spécifiez la valeur 3 pour ces valeurs, la coupure du mot
aromate s’effectue sur aro- mate plutôt que sur ar- omate ou aroma- te.

Limite de césure _ Césures Spécifiez le nombre maximum de tirets qui peuvent apparaître sur des lignes consécutives. Zéro
signifie un nombre illimité de césures.

Zone de césure Spécifiez à quelle distance de la fin de la ligne doit s’effectuer la coupure d’un mot dans du texte non justifié.
Cette option est disponible uniquement lorsque vous utilisez le compositeur ligne par ligne avec du texte non justifié.

Meilleur espacement / Moins de césures Pour modifier l’équilibre entre ces deux options, faites glisser le curseur situé au
bas de la boîte de dialogue.

Césure des mots en capitales Pour éviter que les mots en capitales soient coupés, désélectionnez cette option.

Couper le dernier mot Désélectionnez cette option pour éviter que le dernier mot d’un paragraphe soit coupé.

Césure sur la colonne Désélectionnez cette option pour éviter qu’un mot soit coupé sur une colonne, un bloc ou une page.

Prévention des coupures indésirables
L’utilisation de tirets conditionnels vous permet d’éviter la coupure de certains mots, tels que les noms propres ou des mots pour lesquels la
césure n’est pas souhaitable. Vous pouvez également éviter la césure d’un groupe de mots, par exemple, un groupe d’initiales accompagnant un
nom de famille (tel que « J.-P. Sartre »).

http://www.creativepro.com/article/indesign-how-to-mind-the-gaps
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Pour empêcher la coupure d’un texte
1. Sélectionnez le texte devant tenir sur la même ligne.
2. Choisissez la commande Sans retour automatique dans le menu du panneau Caractère ou Contrôle.

Vous pouvez également éviter qu’un mot soit coupé en insérant un tiret conditionnel au début de celui-ci. Appuyez sur les touches Ctrl+Maj+-
(Windows) ou Commande+Maj+- (Mac OS) pour insérer un tiret conditionnel.

Pour créer un trait d’union insécable
1. A l’aide de l’outil Texte , cliquez à l’endroit où vous souhaitez insérer le tiret.
2. Choisissez Texte > Insérer un caractère spécial > Césures et tirets > Trait d’union insécable.

Pour créer une espace insécable
1. A l’aide de l’outil Texte , cliquez à l’endroit où vous souhaitez insérer l’espace.
2. Choisissez Texte > Insérer une espace > Espace insécable (ou un autre espace).

La taille d’une espace insécable varie en fonction du corps du texte, des paramètres de justification et des paramètres d’intermots, tandis que la
taille du caractère Espace insécable (chasse fixe) reste inchangée en toutes circonstances.

Modification des paramètres de justification
Utilisez le panneau Justification pour contrôler avec précision l’espacement des lettres et des mots ainsi que la mise à l’échelle glyphe. Le réglage
de l’espacement est particulièrement utile avec du texte justifié, bien qu’il soit également possible de régler l’espacement d’un texte non justifié.

Définition de l’intermots et de l’interlettrage dans un texte justifié
1. Insérez le pointeur dans le paragraphe à modifier ou sélectionnez un cadre ou objet texte pour modifier tous ses paragraphes.
2. Choisissez Justification dans le menu du panneau Paragraphe.
3. Saisissez des valeurs dans les zones Intermots, Interlettrage et Mise à l’échelle glyphe. Les valeurs Minimum et Maximum

définissent une plage d’espacement acceptable pour les paragraphes justifiés uniquement. La valeur Optimum définit
l’espacement souhaité pour les paragraphes justifiés et non justifiés :
Intermots Espace entre les mots créé en appuyant sur la barre d’espace. Les valeurs d’intermots sont comprises entre 0 % et
1 000 %. Une valeur de 100 % indique qu’aucun espacement supplémentaire n’est inséré entre les mots.

Interlettrage Distance entre les lettres, valeurs de crénage ou d’approche comprises. Les valeurs d’interlettrage peut varier
de -100 % à 500 % : à 0 %, aucun espace n’est ajouté entre les lettres ; à 100 %, une largeur d’espace complet est ajoutée
entre les lettres.

Mise à l’échelle du glyphe Chasse des caractères (un glyphe est un caractère de n’importe quelle police). La mise à
l’échelle du glyphe peut varier de 50 % à 200 %.

Les options d’espacement s’appliquent toujours à un paragraphe entier. Pour modifier l’espacement de quelques
caractères seulement, utilisez l’option Approche.

4. Définissez l’option Justification d’un seul mot pour indiquer le type de justification appliqué aux paragraphes d’un seul mot.

Il arrive que les colonnes étroites contiennent un seul mot sur une ligne. Si la justification entière est définie pour le
paragraphe, un seul mot sur une ligne peut apparaître trop étiré. Vous pouvez choisir de centrer ce mot ou de l’aligner à
droite, ou à gauche dans la colonne.

Définition de la mise à l’échelle glyphe dans un texte justifié
1. Créez un point d’insertion dans un paragraphe ou sélectionnez les paragraphes concernés.
2. Choisissez Justification dans le menu du panneau Paragraphe.
3. Pour l’option Mise à l’échelle glyphe, entrez une valeur pour Minimum, Maximum et Optimum. Cliquez ensuite sur OK.



 

Avant (en haut) et après (en bas) la mise à l’échelle glyphe de texte justifié

La mise à l’échelle glyphe permet d’obtenir une justification régulière. Toutefois, les valeurs dépassant 3 % de la valeur par défaut (100 %)
peuvent entraîner la distorsion des lettres. A moins que vous ne recherchiez un effet spécial, il est conseillé d’appliquer des valeurs subtiles
pour la mise à l’échelle glyphe, par exemple, 97–100–103.

Utilisation d’une espace sans alinéa dans un texte justifié
L’utilisation d’un caractère d’espace sans alinéa ajoute une quantité variable d’espace à la dernière ligne d’un paragraphe entièrement justifié,
entre le dernier mot et un caractère de fin d’article d’une police décorative, par exemple. Utilisée avec du texte non justifié, l’espace sans alinéa
apparaît comme un caractère d’espace normal. Dans un texte justifié, elle s’agrandit pour assimiler tous les espaces supplémentaires présents sur
la dernière ligne. L’utilisation d’une espace sans alinéa peut avoir un effet spectaculaire sur la façon dont le paragraphe est mis en forme par le
compositeur de paragraphe Adobe.

Avant et après l’ajout d’un caractère d’espace sans alinéa

1. A l’aide de l’outil Texte , cliquez directement devant le caractère de fin d’article.
2. Choisissez Texte > Insérer une espace > Espace sans alinéa.

Remarque : l’effet produit par une espace sans alinéa est visible uniquement lorsque vous appliquez au paragraphe l’option Justifier toutes les
lignes.

Mise en surbrillance des lignes trop étirées ou resserrées
Outre l’intermots et l’interlettrage, la composition d’une ligne de caractères implique différents facteurs (les préférences de césure, par exemple).
Par conséquent, InDesign ne peut pas toujours respecter vos paramètres d’intermots et d’interlettrage. Toutefois, les problèmes de composition
des lignes de texte peuvent être surlignés en jaune, la plus foncée des trois teintes indiquant le problème le plus sérieux.

1. Choisissez Edition > Préférences > Composition (Windows) ou InDesign > Préférences > Composition (Mac OS).
2. Choisissez Infractions de césure et de justification, puis cliquez sur OK.

Voir aussi
Vidéo Travailler avec du texte
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Application du décalage vertical
Création de caractères Exposant ou Indice dans une police non OpenType
Application de soulignement et de style barré au texte
Application de ligatures à des paires de lettres
Modification de la couleur, du dégradé ou du contour du texte
Ajout de transparence au texte
Affectation d’une langue à un texte
Modification de la casse d’un texte
Mise à l’échelle du texte
Inclinaison du texte

Pour consulter un didacticiel vidéo sur la mise en forme des caractères, rendez-vous à l’adresse www.adobe.com/go/lrvid4275_id_fr.

Application du décalage vertical
Vous pouvez utiliser le décalage vertical pour déplacer un caractère sélectionné vers le haut ou vers le bas par rapport à la ligne de base du texte.
Cette option est particulièrement utile lorsque vous composez des fractions manuellement ou que vous modifiez la position des images texte.

Valeurs de décalage vertical appliquées au texte

1. Sélectionnez du texte.

2. Dans le panneau Caractère ou Contrôle, entrez une valeur numérique pour l’option Décalage vertical . Les valeurs
positives déplacent la ligne de base du caractère au-dessus de la ligne de base de la ligne et les valeurs négatives la
déplacent au-dessous.

Vous pouvez cliquer dans la zone Décalage vertical et appuyer sur la touche flèche haut ou flèche bas pour augmenter ou diminuer la valeur.
Maintenez la touche Maj enfoncée lorsque vous appuyez sur les touches flèche haut et flèche bas pour modifier la valeur par incréments plus
élevés.

Pour modifier l’incrément par défaut du décalage vertical, spécifiez une valeur pour l’option Décalage vertical dans la section Unités et incréments
de la boîte de dialogue Préférences.

Création de caractères Exposant ou Indice dans une police non OpenType
1. Sélectionnez du texte.
2. Dans le menu du panneau Caractère ou Contrôle, choisissez la commande Supérieur/Exposant ou Inférieur/Indice.

Lorsque vous sélectionnez Exposant ou Indice, InDesign applique des valeurs prédéfinies de décalage vertical et de corps de caractère au texte
sélectionné.

Les valeurs appliquées sont des pourcentages du corps de la police et de l’interligne utilisés, et reposent sur les paramètres définis dans la boîte
de dialogue des préférences de texte. Lorsque vous sélectionnez le texte, ces valeurs n’apparaissent pas dans les zones Décalage vertical et
Taille du panneau Caractère.

Remarque : vous pouvez modifier la taille par défaut et la position des exposants et indices dans les préférences Texte avancé.

Application de soulignement et de style barré au texte
L’épaisseur par défaut d’un style souligné ou barré dépend du corps du texte.

Jeff Witchel propose un didacticiel vidéo, Custom Underlines in InDesign, consacré au soulignement.

Application de soulignement et de style barré au texte
1. Sélectionnez du texte.

http://www.adobe.com/go/lrvid4275_id_fr
http://www.layersmagazine.com/custom-underlines-in-indesign.html
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2. Dans le menu du panneau Caractère ou Contrôle, sélectionnez Souligné ou Barré.

Modification des options de soulignement et de style barré
Vous pouvez ainsi créer un soulignement homogène sous des caractères de corps différents et créer des effets spéciaux tels qu’une mise en
surbrillance d’arrière-plan.

Avant et après l’ajustement des soulignements

1. Dans le menu du panneau Caractère ou Contrôle, choisissez la commande Options de soulignement ou Options de texte
barré.

2. Utilisez l’une des méthodes suivantes, puis cliquez sur OK :

Sélectionnez Souligner ou Barrer pour activer ces options dans le texte actif.

Pour Epaisseur, sélectionnez une épaisseur ou entrez une valeur pour déterminer l’épaisseur du soulignement ou de la
barre.

Pour Type, sélectionnez une des options de soulignement ou de style barré.

Pour Décalage, définissez la position verticale de la ligne. Le décalage est mesuré à partir de la ligne de base. Les
valeurs négatives placent le soulignement au-dessus de la ligne de base et le style barré sous la ligne de base.

Sélectionnez Surimpression du contour pour vous assurer que le contour ne masque pas les couleurs sous-jacentes lors
de l’impression.

Choisissez une couleur et une teinte. Si vous spécifiez un type de ligne autre que plein, choisissez une couleur d’espace
ou une teinte d’espace pour modifier l’apparence de la zone entre les tirets, les points ou les lignes.

Sélectionnez Surimpression du contour ou Surimpression de l’espace si le style souligné ou barré doit être imprimé par-
dessus une autre couleur et que vous voulez éviter les problèmes de montage lors de l’impression.

Pour modifier les options de soulignement ou de texte barré dans un style de caractère ou de paragraphe, utilisez la section Options de
soulignement ou Options de texte barré de la boîte de dialogue qui s’affiche lorsque vous créez ou éditez ce style.

Application de ligatures à des paires de lettres
InDesign peut insérer des ligatures automatiquement si elles sont disponibles dans la police. Les ligatures sont des caractères typographiques de
remplacement pour certaines paires de lettres telles que « fi » et « fl ». Avec l’option Ligatures, InDesign applique au texte des caractères qui
apparaissent et s’impriment en tant que ligatures. Cependant, ces caractères sont entièrement modifiables et le vérificateur orthographique ne
relève pas les mots qui en contiennent.

Caractères distincts (en haut) et combinaisons de ligatures (en bas)

Si vous utilisez une police OpenType, lorsque vous choisissez la commande Ligatures dans le menu du panneau Caractère ou Contrôle, InDesign
reproduit les ligatures standard définies dans la police par son créateur. Toutefois, certaines polices contiennent des ligatures conditionnelles
ornées plus complexes que vous pouvez reproduire en choisissant la commande Ligatures conditionnelles

1. Sélectionnez du texte.
2. Choisissez la commande Ligatures dans le menu du panneau Caractère ou Contrôle.
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Modification de la couleur, du dégradé ou du contour du texte
Vous pouvez appliquer des couleurs, des dégradés et des contours aux caractères et continuer à modifier le texte. Faites appel aux
panneaux Nuancier et Contour pour appliquer les couleurs, les dégradés et les contours de votre choix au texte. Vous pouvez aussi changer les
paramètres de couleur des caractères lors de la création ou de la modification d’un style.

Nuancier
A.  La nuance est appliquée au fond ou au contour. B.  La nuance est appliquée au conteneur ou au texte. C.  Pourcentage de teinte

1. Utilisez l’une des méthodes suivantes :

Pour modifier la couleur d’une plage de texte située dans un bloc, sélectionnez le texte à l’aide de l’outil Texte .

Pour modifier la couleur de l’ensemble du texte contenu dans un bloc, sélectionnez le bloc à l’aide de l’outil Sélection .
Assurez-vous de cliquer sur l’icône La mise en forme agit sur le texte  dans le panneau Outils ou Nuancier pour
sélectionner le texte, plutôt que le bloc de texte.

2. Dans le panneau Outils ou Nuancier, indiquez si la nouvelle couleur doit s’appliquer au fond ou au contour. Si vous
sélectionnez Contour, la nouvelle couleur n’est appliquée qu’au contour des caractères.

3. Utilisez l’une des méthodes suivantes :

Dans le panneau Nuancier, cliquez sur une couleur ou une nuance de dégradé.

Dans le panneau Contour, spécifiez une épaisseur ou d’autres options de contour (voir la section Options du panneau
Contour).

Vous pouvez également appliquer un dégradé au texte en déplaçant le curseur sur le texte sélectionné à l’aide de l’outil Nuance de dégradé  ou
de l’outil Contour progressif dégradé .

Pour créer du texte inversé, utilisez le blanc ou [Papier] comme couleur de fond pour le texte et sélectionnez une couleur foncée pour le fond
du bloc. Vous pouvez également créer du texte inversé en utilisant un filet de paragraphe derrière le texte ; toutefois, si le filet est de couleur
noire, vous devrez sélectionner le blanc comme couleur de texte.

Ajout de transparence au texte
Utilisez le panneau Effets pour ajouter des effets de transparence, tels que des ombres portées, au texte.

Mike Rankin propose des exemples d’effets de transparence dans son article InDesign Eye Candy, Part I.

1. Utilisez l’outil Sélection  pour sélectionner le bloc de texte.
2. Choisissez Objet > Effets > [effet].
3. Choisissez Texte dans le menu Paramètres pour.

Choisissez la commande Objet si vous souhaitez que les effets sélectionnés s’appliquent au contour et au fond du bloc de
texte, ainsi qu’au texte qu’il contient.

4. Spécifiez les attributs d’effet, puis cliquez sur OK.

Utilisez le panneau Effet pour modifier le mode de fusion ou les paramètres d’opacité du texte.

Affectation d’une langue à un texte
L’affectation d’une langue à un texte détermine le dictionnaire utilisé pour la vérification orthographique et les césures. Ceci ne modifie pas le texte
réel.

http://indesignsecrets.com/eye-candy-draft.php
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1. Utilisez l’une des méthodes suivantes :

Pour appliquer une langue au texte sélectionné uniquement, sélectionnez le texte.

Après avoir fermé tous les documents, cliquez sur une langue pour choisir le dictionnaire de langue par défaut d’InDesign.

Pour choisir un autre dictionnaire de langue par défaut dans le cadre d’un document particulier, ouvrez le document,
choisissez la commande Edition > Tout désélectionner, puis sélectionnez une langue.

2. Dans le panneau Caractère, choisissez le dictionnaire approprié dans le menu déroulant Langue.

InDesign utilise les dictionnaires Proximity (et Winsoft pour certaines langues) pour la correction orthographique et la césure. Ces dictionnaires
permettent de spécifier une langue différente même pour un caractère de texte. Chaque dictionnaire contient des centaines de milliers de mots
spécifiant une césure syllabique standard. La modification de la langue par défaut n’affecte pas les blocs et documents existants.

Vous pouvez personnaliser les dictionnaires de langues pour qu’un lexique particulier utilisé soit effectivement reconnu et traité correctement

Incidence des dictionnaires sur les césures
A.  « Glockenspiel » en anglais B.  « Glockenspiel » en allemand traditionnel C.  « Glockenspiel » en allemand réformé

Modification de la casse d’un texte
Les commandes Tout en capitales ou Petites capitales modifient l’aspect du texte, sans modifier le texte lui-même. De même, la commande
Modifier la casse modifie le paramètre de casse du texte sélectionné. Cette distinction est importante lorsque vous effectuez une recherche ou une
vérification orthographique dans le texte. Par exemple, supposons que vous entrez le mot « fichiers » dans votre document, puis appliquez l’option
Tout en capitales à ce mot. Si vous utilisez alors la commande Rechercher/Remplacer (avec l’option Respecter la casse sélectionnée) pour
rechercher « FICHIERS », vous ne trouverez pas l’instance « fichiers » à laquelle vous avez appliqué l’option Tout en capitales. Pour obtenir de
meilleurs résultats de recherche et de vérification orthographique, utilisez la commande Modifier la casse et non la commande Tout en capitales.

Vous pouvez consulter l’article d’Anne-Marie Concepcion, Small Caps vs OpenType All Small Caps, consacré aux petites capitales.

Pour appliquer la commande Tout en capitales ou Petites capitales à un texte
InDesign peut modifier automatiquement la casse du texte sélectionné. Lorsque vous mettez en forme du texte en petites capitales, InDesign
utilise automatiquement les petites capitales conçues au sein de la police, à condition que ces dernières soient disponibles. Sinon, InDesign
reproduit les petites capitales en utilisant une version réduite des lettres capitales normales. Vous pouvez définir la taille des petites capitales
reproduites dans la boîte de dialogue des préférences de texte.

Avant (haut) et après (bas) la définition des caractères BC et AD en petites capitales pour accommoder les chiffres elzévir et le texte environnant

Si vous sélectionnez l’option Tout en capitales ou Petites capitales dans une police OpenType, InDesign est capable de créer un texte d’aspect
plus élégant. Si vous utilisez une police OpenType, vous pouvez également choisir Tout en petites capitales dans le menu du panneau Caractère
ou Contrôle (voir la section Application d’attributs de police OpenType).

1. Sélectionnez du texte.
2. Choisissez la commande Tout en capitales ou Petites capitales dans le menu du panneau Caractère ou Contrôle. L’option

Petites capitales ne modifie pas le texte si celui-ci a été tapé en capitales.

Pour définir le corps des petites capitales
1. Choisissez Edition > Préférences > Texte avancé (Windows) ou InDesign > Préférences > Texte avancé (Mac OS).
2. Dans la zone de texte de l’option Petites capitales, saisissez un pourcentage du corps de la police d’origine pour que le texte

http://indesignsecrets.com/small-caps-vs-opentype-all-small-caps.php
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soit mis en forme en petites majuscules. Cliquez ensuite sur OK.

Pour modifier la casse
1. Sélectionnez du texte.
2. Choisissez l’une des options suivantes dans le sous-menu Texte > Modifier la casse :

Pour transformer tous les caractères en minuscules, choisissez Bas de casse.

Pour mettre en capitales la première lettre de chaque mot, choisissez Première lettre des mots en capitales.

Pour changer tous les caractères en majuscules, choisissez Capitales.

Pour mettre en capitales la première lettre de chaque phrase, choisissez Casse de la phrase.

Remarque : la commande Casse de la phrase suppose que le point (.), le point d’exclamation (!) et le point d’interrogation (?) marquent la fin de
phrases. L’application de l’option Casse de la phrase peut entraîner des modifications de casse inattendues lorsque ces caractères sont utilisés
différemment, comme dans des abréviations, des noms de fichiers ou des adresses Internet. De plus, les noms propres risquent de perdre leur
capitale.

Mise à l’échelle du texte
Vous pouvez spécifier les proportions entre la hauteur et la largeur du texte en fonction de la hauteur et de la largeur d’origine des caractères. Les
caractères dont l’échelle n’a pas été modifiée ont une valeur de 100 %. Certaines familles de polices comprennent une vraie police étendue,
conçue avec un empattement (ou sérif) plus grand que celui du style de caractère normal. La mise à l’échelle déforme la police. En général, il est
préférable d’utiliser une police condensée ou étendue, si disponible.

Mise à l’échelle des polices dans le sens horizontal
A.  Texte sans modification d’échelle B.  Police condensée sans modification d’échelle C.  Police condensée avec modification d’échelle

Pour modifier la mise à l’échelle horizontale ou verticale
1. Sélectionnez le texte à mettre à l’échelle.
2. Dans le panneau Caractère ou Contrôle, entrez une valeur numérique pour modifier le pourcentage de l’option Mise à l’échelle

verticale  ou Mise à l’échelle horizontale .

Pour mettre à l’échelle un texte en redimensionnant le bloc de texte dans InDesign
 Utilisez l’une des méthodes suivantes :

Maintenez la touche Ctrl (Windows) ou Commande (Mac OS) enfoncée, puis, à l’aide de l’outil Sélection, faites glisser un
angle du bloc pour le redimensionner.

A l’aide de l’outil Mise à l’échelle , redimensionnez le bloc.

(voir la section Mise à l’échelle d’objets).

Pour déterminer les valeurs d’aspect du texte mis à l’échelle
Lorsque vous modifiez l’échelle d’un bloc, le texte qu’il contient est également mis à l’échelle. Par exemple, lorsque vous doublez la taille d’un bloc
de texte, le corps du texte double également ; s’il était de 20 points, il passe à 40 points.
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David Blatner propose un article portant sur les blocs de texte mis à l’échelle, sous le titre Making a Magnifying Glass Text Frame in InDesign.

Vous pouvez modifier une option de préférence pour déterminer comment s’affiche le texte mis à l’échelle dans les panneaux :

Par défaut, lorsque l’option Appliquer au contenu est sélectionnée, les zones Corps des panneaux Contrôle et Caractère
indiquent le nouveau corps du texte (par exemple 40 pt). Si vous sélectionnez l’option Ajuster le pourcentage de mise à
l’échelle, les zones Corps indiquent à la fois le corps du texte initial et le corps du texte mis à l’échelle, par exemple « 20 pt
(40) ».

Les valeurs de mise à l’échelle présentées sur le panneau Transformation indiquent le pourcentage de mise à l’échelle du bloc
dans les sens horizontal et vertical. Par défaut, lorsque l’option Appliquer au contenu est sélectionnée, les valeurs de mise à
l’échelle restent à 100 % lorsqu’un texte est mis à l’échelle. Si vous sélectionnez l’option Ajuster le pourcentage de mise à
l’échelle, les valeurs de mise à l’échelle indiquent le pourcentage de redimensionnement du bloc de texte ; ainsi, si vous
doublez la taille d’un bloc, les valeurs de mise à l’échelle passent à 200 %.

Le suivi de la mise à l’échelle d’un bloc peut être utile si vous souhaitez faire revenir un bloc ou le texte qu’il contient à sa taille initiale. Il peut être
utile également pour connaître le pourcentage selon lequel un bloc a été redimensionné. Pour activer le suivi de la mise à l’échelle des blocs et du
texte qu’ils contiennent :

1. Choisissez Edition > Préférences > Général (Windows) ou InDesign > Préférences > Général (Mac OS).

2. Sélectionnez l’option Ajuster le pourcentage de mise à l’échelle et cliquez sur le bouton OK.

Tenez compte des points suivants :

L’option Ajuster le pourcentage de mise à l’échelle s’applique uniquement aux blocs redimensionnés une fois l’option activée.
Elle n’a pas d’effet sur les blocs existants.

L’option Ajuster le pourcentage de mise à l’échelle reste appliquée au texte de façon permanente. Si vous désactivez
l’option Ajuster le pourcentage de mise à l’échelle et que vous redimensionnez un bloc, le corps du texte mis à l’échelle reste
affiché entre parenthèses.

Pour faire en sorte que le panneau Transformation n’indique plus le corps du texte mis à l’échelle, sélectionnez
l’option Redéfinir la mise à l’échelle à 100 % dans ce même panneau. Cette option ne modifie pas l’aspect du bloc de texte
mis à l’échelle.

Si vous modifiez une plage de texte ou mettez à l’échelle un bloc situé dans des blocs liés, alors que l’option Ajuster le
pourcentage de mise à l’échelle est activée, le texte est mis à l’échelle même s’il se déplace vers un autre bloc. En revanche,
si l’option Appliquer au contenu est activée, une plage de texte qui se déplace vers un autre bloc n’est pas mise à l’échelle.

Inclinaison du texte
1. Sélectionnez du texte.

2. Dans le panneau Caractère, entrez une valeur numérique pour l’option Inclinaison . Les valeurs positives inclinent le texte
vers la droite, alors que les valeurs négatives l’inclinent vers la gauche.

Notez que lorsque vous appliquez une inclinaison à du texte, vous n’obtenez pas de véritables caractères italiques.

Voir aussi
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Alignement ou justification du texte
Alignement des paragraphes sur une grille de ligne de base
Création de texte de titre équilibré
Création de paragraphes s’étendant sur plusieurs colonnes ou les scindant
Alignement ou justification de texte verticalement au sein d’un bloc de texte

Alignement ou justification du texte
Le texte peut être aligné par rapport à un ou aux deux bords (ou encarts) d’un bloc de texte. Le texte est justifié lorsqu’il est aligné par rapport aux
deux bords. Vous pouvez justifier le texte d’un paragraphe en excluant la dernière ligne (Justifier à gauche ou Justifier à droite) ou en l’incluant
(Justifier toutes les lignes). Lorsque la dernière ligne ne contient que quelques caractères, vous pouvez utiliser un caractère spécial de fin d’article
et créer une espace sans alinéa.

Justifier à gauche (à gauche) et Justifier toutes les lignes (à droite)

Remarque : lorsque vous justifiez toutes les lignes de texte et que vous utilisez le Compositeur de paragraphe Adobe, InDesign décale le texte
pour que le paragraphe soit harmonieux et sa densité constante. Vous pouvez ajuster précisément l’espacement dans du texte justifié.

1. Sélectionnez du texte.
2. Cliquez sur l’un des boutons d’alignement (Aligner à gauche, Centrer, Aligner à droite, Justifié à gauche, Justifié au centre,

Justifié à droite et Justifier) du panneau Paragraphe ou Contrôle.
3. (Facultatif) Cliquez sur Aligner au dos ou Aligner à l’opposé du dos.

Lorsque vous appliquez l’option Aligner au dos à un paragraphe, le texte figurant sur une page de gauche est justifié à droite ;
toutefois, si ce même texte s’étend sur (ou si vous déplacez le bloc vers) une page de droite, il est aligné à gauche. De
même, lorsque vous appliquez l’option Aligner à l’opposé du dos à un paragraphe, le texte figurant sur une page de gauche
est justifié à gauche, tandis que le texte figurant sur une page de droite est aligné à droite.

Si vous voulez que le côté gauche d’une ligne de texte soit aligné à gauche et le côté droit à droite, placez le point d’insertion à l’endroit où
vous souhaitez aligner le texte à droite, appuyez sur la touche de tabulation, puis alignez le reste de la ligne à droite.

Alignement des paragraphes sur une grille de ligne de base
La grille de ligne de base représente l’interligne du corps de texte dans un document. Vous pouvez utiliser des multiples de ces valeurs
d’interligne avec tous les éléments de la page pour garantir que le texte s’aligne toujours entre les colonnes d’une page sur l’autre. Par exemple,
si l’interligne du texte dans votre document est de 12 points, vous pouvez définir l’interligne du texte de titre sur 18 points et ajouter une espace
de 6 points avant les paragraphes qui suivent les titres.

L’utilisation d’une grille de ligne de base assure la cohérence de position des éléments de texte d’une page. Vous pouvez modifier l’interligne du
paragraphe pour faire en sorte que ses lignes de base soient alignées sur la grille sous-jacente de la page. Cela est utile lorsque vous voulez
aligner les lignes de base en plusieurs colonnes ou des blocs de texte adjacents. Vous pouvez modifier les paramètres de la grille de ligne de
base dans la section Grilles de la boîte de dialogue Préférences.

Vous pouvez également aligner uniquement la première ligne d’un paragraphe sur la grille de ligne de base, de sorte que les autres lignes suivent
les valeurs d’interligne spécifiées.

Pour afficher la ligne de grille de base, choisissez Affichage > Grilles et repères > Afficher la grille de ligne de base.

Remarque : la grille de ligne de base est visible uniquement si le niveau de zoom du document est supérieur au seuil d’affichage défini dans les
préférences de la grille. Effectuez un zoom avant pour afficher la grille de la ligne de base.
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Pour aligner des paragraphes sur la grille de ligne de base
1. Sélectionnez du texte.
2. Dans le panneau Paragraphe ou Contrôle, sélectionnez l’option Aligner sur la grille de ligne de base .

Pour que l’interligne de votre texte ne change pas, définissez l’interligne de la grille de ligne de base sur la même valeur d’interligne que votre
texte ou sur un sous-multiple de celle-ci.

Pour aligner uniquement la première ligne sur la grille de ligne de base
1. Sélectionnez les paragraphes à aligner.
2. Choisissez la commande Aligner seulement la première ligne sur la grille dans le menu du panneau Paragraphe ou Contrôle.
3. Dans le panneau Paragraphe ou Contrôle, sélectionnez l’option Aligner sur la grille de ligne de base .

Création de texte de titre équilibré
Vous pouvez équilibrer un texte en drapeau aligné sur plusieurs lignes. Cette fonction est particulièrement adaptée aux titres de plusieurs lignes,
aux citations et aux paragraphes centrés.

Avant et après application de l’option Equilibrer les lignes en drapeau au titre

1. Cliquez sur le paragraphe à équilibrer.
2. Dans le panneau Paragraphe ou Contrôle, sélectionnez l’option Equilibrer les lignes en drapeau.

Elle s’applique uniquement lorsque le Compositeur de paragraphe Adobe est sélectionné.

Création de paragraphes s’étendant sur plusieurs colonnes ou les scindant
Vous pouvez faire en sorte qu’un paragraphe s’étende sur plusieurs colonnes d’un bloc de texte afin de créer un effet de titre de fusion. Libre à
vous d’étendre un paragraphe sur l’ensemble des colonnes ou sur un nombre défini de colonnes. Lorsqu’un paragraphe est configuré de manière
à s’étendre sur plusieurs colonnes d’un bloc de texte, le texte qui le précède est redistribué.

Vous pouvez également diviser un paragraphe en plusieurs colonnes à l’intérieur d’un même bloc de texte.

Pour consulter un didacticiel vidéo sur la création de paragraphes s’étendant sur plusieurs colonnes ou les scindant, rendez-vous à l’adresse
www.adobe.com/go/lrvid5151_id_en ou http://tv.adobe.com/go/4952/.

Paragraphe sur plusieurs colonnes
A.  Titre s’étendant sur plusieurs colonnes B.  Colonne scindée

Etendue d’un paragraphe sur plusieurs colonnes
1. Placez le point d’insertion dans le paragraphe.

http://www.adobe.com/go/lrvid5151_id_en
http://tv.adobe.com/go/4952/
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Vous pouvez également intégrer cette fonctionnalité à un style de paragraphe, notamment un style de titre.

2. Choisissez la commande Etendue de colonnes dans le menu du panneau Contrôle ou dans un menu du
panneau Paragraphe.

3. Dans le menu Disposition des paragraphes, choisissez la commande Etendue de colonnes.

4. Dans le paragraphe Etendue, choisissez le nombre de colonnes sur lesquelles étendre le paragraphe. Choisissez Toutes si
vous souhaitez étendre le paragraphe sur toutes les colonnes.

5. Pour ajouter un espace avant ou après le paragraphe étendu, spécifiez les valeurs Espace avant l’étendue et Espace après
l’étendue, puis cliquez sur OK.

Scission d’un paragraphe en colonnes
1. Placez le point d’insertion dans le paragraphe.

Vous pouvez également intégrer cette fonctionnalité à un style de paragraphe, notamment un style de titre.

2. Choisissez la commande Etendue de colonnes dans le menu du panneau Contrôle ou dans un menu du
panneau Paragraphe.

3. Dans le menu Disposition des paragraphes, choisissez la commande Scinder les colonnes.

4. Spécifiez les options suivantes, puis cliquez sur OK :

Sous-colonnes Choisissez le nombre de colonnes que contiendra le paragraphe scindé.

Espace avant l’étendue / Espace après l’étendue Ajoutez un espace avant ou après le paragraphe scindé.

Gouttière intérieure Spécifiez l’espacement des paragraphes scindés.

Gouttière extérieure Spécifiez l’espace compris entre l’extérieur des paragraphes scindés et les marges.

Alignement ou justification de texte verticalement au sein d’un bloc de texte
Il est possible d’aligner ou de distribuer des lignes de texte dans un bloc le long de son axe vertical pour répartir le texte à la verticale de façon
uniforme parmi les blocs et leurs colonnes.

Vous pouvez aligner le texte en haut, au centre ou en bas du bloc à l’aide des paramètres d’interligne et d’espacement de chaque paragraphe.
Vous avez également la possibilité de justifier le texte verticalement de sorte à espacer les lignes régulièrement, quelles que soient les valeurs
d’interligne et d’espacement du paragraphe.

Justification verticale - Bas (à gauche) et Justifier (à droite)

L’alignement et la justification de texte vertical se calculent d’après les positions des lignes de base de chaque ligne de texte comprise dans le
bloc. Gardez les instructions suivantes à l’esprit lorsque vous réglez l’alignement vertical :

Le bord supérieur du bloc est défini en tant que ligne de base de la première ligne de texte alignée en haut. L’option Décalage
de la 1re ligne de base dans la boîte de dialogue Options de bloc de texte agit sur cette valeur.

Le bord inférieur du bloc est défini en tant que ligne de base de la dernière ligne de texte alignée en bas. Le texte des notes
de bas de page n’est pas justifié.

Lorsque vous appliquez l’option Aligner sur la grille de ligne de base à des paragraphes alignés en haut, au centre ou en bas,
toutes les lignes s’alignent sur la grille de ligne de base. Lorsque vous sélectionnez l’option de justification, seules les première
et dernière lignes s’alignent sur la grille de ligne de base.

Si vous réglez les valeurs des encarts de tête et de pied d’un bloc de texte dans la boîte de dialogue Options de bloc de texte,
vous modifiez respectivement l’emplacement de la première ou de la dernière ligne de base.

1. Utilisez l’une des méthodes suivantes :

A l’aide de l’outil Sélection, sélectionnez un bloc de texte.

A l’aide de l’outil Texte , cliquez sur un bloc de texte.



 

2. Choisissez Objet > Options de bloc de texte.
3. Dans la section Justification verticale de la boîte de dialogue Options de bloc de texte, choisissez l’une des options suivantes

à partir du menu Alignement :

Pour aligner le texte verticalement du haut du bloc vers le bas, choisissez De tête (paramètre par défaut).

Pour centrer des lignes de texte dans le bloc, choisissez Centrer.

Pour aligner les lignes de texte verticalement vers le haut à partir du bas du bloc, choisissez De pied.

Pour distribuer les lignes de texte verticalement de manière régulière entre le haut et le bas du bloc, choisissez Justifier.

4. Si vous choisissez Justifier et souhaitez empêcher que la valeur d’interligne n’augmente de manière disproportionnée par
rapport à celle de l’espacement des paragraphes, spécifiez une valeur pour Limite d’espacement des paragraphes. L’espace
entre les paragraphes s’étend jusqu’à la valeur spécifiée. Si le texte ne remplit toujours pas le bloc, l’espace entre les lignes
est ajusté afin que le bloc soit rempli. La limite d’espacement des paragraphes s’applique en plus des valeurs Espace avant et
Espace après spécifiées dans le panneau Paragraphe.

Limite d’espacement des paragraphes définie sur zéro (à gauche) et sur 1 pica (à droite)

Remarque : soyez prudent lorsque vous utilisez la justification verticale des blocs de texte de plusieurs colonnes. Si la
dernière colonne ne contient que quelques lignes, trop d’espace blanc risque d’apparaître entre ces lignes.

5. Cliquez sur le bouton OK.

Pour ajuster rapidement la valeur Limite d’espacement des paragraphes, sélectionnez Aperçu, puis cliquez sur le bouton flèche haut ou flèche
bas située en regard de cette valeur jusqu’à ce que l’espacement des paragraphes apparaisse équilibré avec l’interligne.

Voir aussi

Informations juridiques   |   Politique de confidentialité en ligne
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Espacement des paragraphes
Utilisation de lettrines
Ajout de filets au-dessus ou au-dessous des paragraphes
Contrôle des sauts de paragraphe
Gestion des sauts de paragraphe à l’aide des options d’enchaînement
Création de ponctuation en retrait
Création d’une nuance (ou couleur) derrière un paragraphe

Espacement des paragraphes

Vous pouvez contrôler l’espace entre les paragraphes. Si un paragraphe est situé en haut d’une colonne ou
d’un bloc, InDesign ne prend pas en compte la valeur Espace avant. Dans ce cas, vous pouvez augmenter
l’interligne de la première ligne du paragraphe ou augmenter l’encart supérieur du bloc de texte
dans InDesign.

1. Sélectionnez du texte.

2. Dans le panneau Paragraphe ou Contrôle, ajustez les valeurs appropriées pour les
options Espace avant et Espace après.  

Pour assurer une mise en forme continue, modifiez l’espacement des paragraphes dans les styles de
paragraphes que vous définissez.

Utilisation de lettrines

Vous pouvez ajouter des lettrines à un ou plusieurs paragraphes à la fois. La ligne de base d’une lettrine est
placée une ou plusieurs lignes au-dessous de la ligne de base de la première ligne d’un paragraphe.

Vous pouvez également créer un style de caractère pour l’appliquer aux lettrines. Par exemple, vous pouvez
créer une grande initiale en spécifiant une lettrine d’une ligne et d’un caractère et en appliquant un style de
caractère qui augmente le corps de la première lettre.

Lettrine d’un caractère et de trois lignes (à gauche) et lettrine de cinq caractères et de deux lignes (à droite)
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Pour créer une lettrine

1. Activez l’outil Texte et cliquez sur le paragraphe dans lequel vous souhaitez créer une
lettrine.

2. Dans le panneau Paragraphe ou Contrôle, entrez un nombre pour l’option Nombre de
lignes en lettrine pour définir le nombre de lignes que la lettrine doit occuper.

3. Dans le champ Un ou plusieurs caractères en lettrine, entrez le nombre de caractères en
lettrine souhaité.

4. Pour appliquer un style de caractère à la lettrine, choisissez la commande Lettrines et
styles imbriqués dans le menu du panneau Paragraphe, puis sélectionnez le style de
caractère que vous avez créé.

Vous pouvez également utiliser la boîte de dialogue Lettrines et styles imbriqués pour
aligner la lettrine sur le bord du texte (l’espace situé à gauche de la lettrine étant ainsi
réduit), puis l’ajuster sur des jambages, tels que « g » et « y ». Si vous souhaitez
redimensionner, incliner ou modifier la police de la lettrine pour plus d’effet,
sélectionnez une ou plusieurs lettres et apportez les modifications de mise en forme.

Pour supprimer une lettrine

1. Activez l’outil Texte et cliquez sur le paragraphe comportant la lettrine.

2. Dans le panneau Paragraphe ou Contrôle, entrez 0 dans le champ Nombre de lignes en
lettrine ou Nombre de caractères en lettrine.

Ajout de filets au-dessus ou au-dessous des paragraphes

Les filets sont des attributs de paragraphe qui se déplacent et sont redimensionnés dans la page avec le
paragraphe. Si vous utilisez un filet pour les titres de votre document, vous pouvez l’intégrer à la définition de
style du paragraphe. La largeur du filet est définie par la largeur de la colonne.

Le décalage d’un filet au-dessus d’un paragraphe est mesuré à partir de la ligne de base de la première ligne
de texte jusqu’au bas du filet. Le décalage d’un filet au-dessous d’un paragraphe est mesuré à partir de la
ligne de base de la dernière ligne de texte jusqu’au sommet du filet.

Placement des filets

A. Filet au-dessus d’un paragraphe B. Filet au-dessous d’un paragraphe 



Remarque :

Michael Murphy propose un didacticiel vidéo, Paragraph Rules Rule, consacré à la création d’effets spéciaux
à l’aide de filets de paragraphe.

Vous pouvez également consulter l’article de Creative Curio, Creative Uses for Paragraph Rules in InDesign,
Pt 1, qui traite de l’utilisation créative des filets de paragraphe.

Pour ajouter un filet au-dessus ou au-dessous d’un paragraphe

1. Sélectionnez du texte.

2. Choisissez la commande Filets de paragraphe dans le menu du panneau Caractère ou
Contrôle.

3. En haut de la boîte de dialogue Filets de paragraphe, sélectionnez Filet au-dessus ou
Filet au-dessous.

4. Sélectionnez Filet.

pour obtenir un filet au-dessus et un autre au-dessous du paragraphe,
vous devez sélectionner Filet pour les deux options, Filet au-dessus et Filet au-dessous.

5. Sélectionnez Aperçu pour visualiser le filet en place.

6. Pour l’option Epaisseur, sélectionnez une épaisseur ou entrez une valeur pour
déterminer l’épaisseur du filet. Si vous augmentez l’épaisseur d’un filet supérieur (option
Filet au-dessus), le filet est élargi vers le haut. Si vous augmentez l’épaisseur d’un filet
inférieur (option Filet au-dessous), le filet est élargi vers le bas.

7. Sélectionnez Surimpression du contour pour vous assurer que le contour ne masque pas
les couleurs sous-jacentes lors de l’impression.

8. Utilisez l’une ou plusieurs des méthodes suivantes :

Sélectionnez une couleur. Les couleurs disponibles sont indiquées dans le
panneau Nuancier. Sélectionnez l’option Couleur du texte pour attribuer au filet
supérieur la couleur du premier caractère du paragraphe, et au filet inférieur la
couleur du dernier caractère du paragraphe.

Sélectionnez une teinte ou spécifiez une valeur de teinte. La teinte est basée sur la
couleur spécifiée. Notez qu’il est impossible de créer les teintes des couleurs
intégrées ayant pour attribut Sans, Papier, Repérage et Couleur du texte.

Si vous spécifiez un type de ligne autre que plein, choisissez une couleur d’espace
ou une teinte d’espace pour modifier l’apparence de la zone entre les tirets, les
points ou les lignes.

9. Choisissez la largeur du filet. Vous pouvez sélectionner Texte (du bord gauche du texte
jusqu’à la fin de la ligne) ou Colonne (du bord gauche au bord droit de la colonne). Si le
bord gauche du bloc est doté d’un encart de colonne, le filet commence au niveau de
l’encart.

10. Pour définir la position verticale du filet, entrez une valeur pour Décalage.

11. Pour vous assurer qu’un filet placé au-dessus du texte sera positionné à l’intérieur du
bloc de texte, sélectionnez l’option Conserver dans le bloc. Si cette option n’est pas
sélectionnée, il se peut que le filet s’affiche en dehors du bloc de texte.

Pour vous assurer que le filet de paragraphe figurant en haut d’une colonne sera
aligné avec le texte en haut de la colonne adjacente, sélectionnez l’option Conserver
dans le bloc.

12. Définissez des retraits à gauche ou à droite pour le filet (et non pour le texte) en entrant
des valeurs pour Retrait à gauche et Retrait à droite.

13. Sélectionnez l’option Surimpression du contour si le filet de paragraphe doit être imprimé
par-dessus une autre couleur et que vous voulez éviter les problèmes de montage lors
de l’impression. Cliquez ensuite sur OK.

http://www.theindesigner.com/blog/episode-49-paragraph-rules-rule
http://creativecurio.com/2009/03/creative-uses-for-paragraph-rules-in-indesign-pt-1/
http://creativecurio.com/2009/03/creative-uses-for-paragraph-rules-in-indesign-pt-1/
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Espaces insécables
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Début du paragraphe

Paramètres de la césure

Modification du texte

Utilisation d’un autre compositeur
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Pour supprimer un filet de paragraphe

1. A l’aide de l’outil Texte, cliquez sur le paragraphe contenant le filet.

2. Choisissez la commande Filets de paragraphe dans le menu du panneau Caractère ou
Contrôle.

3. Désélectionnez Filet et cliquez sur OK.

Contrôle des sauts de paragraphe

Vous pouvez éviter les lignes orphelines et veuves, c’est-à-dire les lignes composées d’un seul mot ou les
lignes de texte uniques qui sont isolées du reste du paragraphe. Les orphelines figurent au bas d’une
colonne ou d’une page et les veuves en haut. Un autre problème typographique à éviter est un titre se
retrouvant seul sur une page, avec le paragraphe qu’il annonce décalé sur la page suivante. Différentes
options permettent de résoudre les problèmes de coupure de paragraphe, tels que les veuves, les orphelines
et les lignes de fin trop courtes.

Un tiret conditionnel (Texte > Insérer un caractère spécial > Césures et tirets > Tiret
conditionnel) ne s’affiche que si le mot est coupé. Cette option permet d’éviter un problème courant en
typographie, à savoir l’apparition de mots coupés, par exemple « consti-tution », au milieu d’une ligne lorsque
le texte est réagencé. Vous pouvez également insérer un saut de ligne conditionnel.

Choisissez la commande Sans retour automatique dans le menu du
panneau Caractère pour faire en sorte que l’ensemble du texte sélectionné reste sur la même ligne.

Insérez une espace insécable (Texte > Insérer une espace > [espace insécable]) entre
les mots qui ne doivent pas être séparés.

Choisissez la commande Options d’enchaînement dans le menu du
panneau Paragraphe pour indiquer combien de lignes du paragraphe suivant doivent rester liées au
paragraphe actif.

Sélectionnez l’option Début du paragraphe dans la boîte de dialogue Options
d’enchaînement pour faire en sorte qu’un paragraphe (généralement un titre ou en-tête) s’affiche en haut
d’une page, d’une colonne ou d’une section. Cette option prend tout son intérêt lorsqu’elle fait partie d’un
style de titre.

Choisissez la commande Césure dans le menu du panneau Paragraphe pour
modifier les paramètres de césure.

Il se peut que vous n’ayez pas la possibilité de modifier le texte, suivant la nature du
document traité. Si vous avez l’autorisation de récrire le texte, il suffit dans bien des cas de changer quelques
mots pour obtenir des sauts de lignes plus harmonieux.

En général, la composition des paragraphes dans InDesign se fait de
façon automatique par l’intermédiaire du Compositeur de paragraphes Adobe. Si un paragraphe n’est pas
composé comme vous le souhaitez, choisissez la commande Compositeur ligne simple Adobe dans le menu
du panneau Paragraphe ou Contrôle pour ajuster séparément chacune des lignes sélectionnées Voir
Composition d’un texte.

http://idiom-q-win-1/fr/indesign/using/text-composition.html#compose_text
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Gestion des sauts de paragraphe à l’aide des options
d’enchaînement

Vous pouvez indiquer combien de lignes du paragraphe suivant doivent rester liées au paragraphe actif
lorsque celui-ci se déplace d’un bloc à l’autre. Cette méthode permet d’éviter que les titres soient isolés du
corps de texte qu’ils annoncent. InDesign peut mettre en surbrillance les paragraphes qui sont parfois coupés
à l’encontre de vos paramètres.

S’il n’est pas nécessaire que les colonnes de votre document partagent la dernière ligne de base, les options
d’enchaînement peuvent ne pas vous être utiles.

Pour mettre en surbrillance les paragraphes qui ne respectent pas les options d’enchaînement, choisissez
la commande Edition > Préférences > Composition (Windows) ou InDesign > Préférences > Composition
(Mac OS), sélectionnez l’option Infractions et cliquez sur le bouton OK.

1. Sélectionnez le ou les paragraphes appropriés.

2. Choisissez la commande Options d’enchaînement dans le menu du panneau Paragraphe
ou Contrôle. Il est possible également de modifier les options d’enchaînement lors de la
création ou de la modification d’un style de paragraphe.

3. Choisissez la commande Options d’enchaînement dans le menu du panneau
Paragraphe. Il est possible également de modifier les options d’enchaînement lors de la
création ou de la modification d’un style de paragraphe.

4. Sélectionnez l’une des options suivantes, puis cliquez sur OK :

Sélectionnez Conserver avec précédent pour enchaîner la première ligne du
paragraphe actuel avec la dernière ligne du paragraphe précédent.

Dans Paragraphes solidaires _ lignes, spécifiez combien de lignes (jusqu’à cinq) du
paragraphe suivant doivent être maintenues avec la dernière ligne du paragraphe
actuel. Cette option est particulièrement utile pour garantir le maintien d’un titre avec
les premières lignes du paragraphe suivant.

Sélectionnez l’option Lignes solidaires, puis Toutes les lignes du paragraphe pour
éviter la coupure du paragraphe.

Sélectionnez l’option Lignes solidaires, puis l’option Au début/A la fin du paragraphe
et spécifiez le nombre de lignes devant apparaître au début ou à la fin du paragraphe
pour éviter les orphelines et les veuves.

Dans Début du paragraphe, sélectionnez une option pour forcer InDesign à déplacer
le paragraphe sur la colonne, la page ou le bloc suivants. Si vous sélectionnez
N’importe où, la position de début dépend des paramètres de la zone Lignes
solidaires. Les autres options permettent de faire débuter le paragraphe à la position
correspondante.

Lorsque vous créez des styles de paragraphe pour les titres, utilisez le volet Options d’enchaînement pour
que le titre reste lié au paragraphe qui le suit.

Création de ponctuation en retrait

L’alignement des bordures gauche et droite des colonnes contenant des signes de ponctuation et des lettres
telles que « W » peut sembler altéré. L’alignement optique des marges permet de contrôler si les signes de
ponctuation (tels que les points, les virgules, les points d’interrogation et les tirets) et le bord de certaines
lettres (telles que W ou A) sont en retrait à l’extérieur des marges, de façon à ce que le texte semble aligné.
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Remarque :

Avant (à gauche) et après (à droite) application de l’option Alignement optique des marges

1. Sélectionnez un bloc de texte ou cliquez n’importe où dans l’article.

2. Choisissez Texte > Article.

3. Sélectionnez Alignement optique des marges.

4. Sélectionnez une taille de police pour définir la valeur de dépassement appropriée à la
taille du texte de votre article. Pour un résultat optimal, utilisez la même taille que le texte
de votre article.

Pour désactiver l’option Alignement optique des marges pour un paragraphe donné, choisissez la
commande Ignorer la marge optique dans le menu du panneau Paragraphe ou Contrôle.

Création d’une nuance (ou couleur) derrière un paragraphe

1. Pour appliquer l’ombrage de paragraphe au texte dans un bloc de texte, sélectionnez le
bloc de texte.

Ou placez le pointeur sur le texte dans le bloc de texte.

2. Ouvrez la boîte de dialogue Ombrage de paragraphe.

Dans le menu contextuel du panneau Paragraphe (Fenêtre > Texte et tableaux >
Paragraphe), sélectionnez Ombrage de paragraphe.

les options suivantes sont également disponibles dans l’onglet Ombrage de
paragraphe de la boîte de dialogue Style de paragraphe. Pour ouvrir cette boîte de
dialogue, dans le menu contextuel du panneau Styles de paragraphe (Fenêtre > Styles >
Styles de paragraphe), choisissez Options de style.

3. Dans la boîte de dialogue Ombrage de paragraphe, sélectionnez les options suivantes :

A. Couleur d’ombrage B. Teinte d’ombrage C. Appliquer la surimpression D. Etendre
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Remarque :

l’ombre au delà de la marge supérieure E. Etendre l’ombre au delà de la marge
gauche F. Etendre l’ombre au delà de la marge inférieure G. Etendre l’ombre au delà de
la marge droite H. (Ascendante par défaut) Bord supérieur de l’ombrage pour un
paragraphe donné I. (Descendante par défaut) Bord inférieur de l’ombrage pour un
paragraphe donné J. Colonne : étend l’ombre dans le bloc de texte. Texte : étend
l’ombre sur le texte. K. L’ombrage sera rogné aux bords du bloc L. L’ombrage est ignoré
si le document est imprimé ou exporté dans des formats tels que PDF, Epub, Jpeg et
PNG 

le bord supérieur est défini par défaut sur EmBox Haut et le bord inférieur est défini
par défaut sur EmBox Bas pour l’ensemble de fonctions japonais.

4. Vérifiez le bouton Chaîne pour assurer que toutes les valeurs de décalage restent les
mêmes. Si vous modifiez la valeur d’un décalage, toutes les autres valeurs sont mises à
jour.

Pour créer des valeurs de décalage différentes, assurez-vous que le bouton de chaîne
est désactivé.

5. Cliquez sur OK.

La nuance s’étend au-delà du texte dans le bloc de texte. Elle ne s’étend pas sur l’intégralité du bloc de
texte.

En outre, l’option Ecrêter selon le bloc est parfaitement adaptée pour les blocs de texte non rectangulaires.

Adobe recommande également
Ajout de styles de paragraphe et de caractère
Lettrines et styles imbriqués
Application d’un style de caractère à une lettrine
Ajout de colonnes, blocs et sauts de page

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
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A propos de l’interligne
Modification de l’interligne

A propos de l’interligne
L’espace vertical entre deux lignes de texte est appelé interligne. L’interligne est l’espace compris entre la ligne de base d’une ligne de texte et la
ligne de base de la ligne du dessus. La ligne de base est la ligne invisible sur laquelle les caractères (ceux dépourvus de jambage inférieur)
reposent.

Par défaut, l’option Interligne automatique est définie sur 120 % du corps du caractère (par exemple, un interlignage de 12 points pour un
caractère de 10 points). Lorsque l’interligne automatique est activé, InDesign affiche la valeur d’interlignage dans le menu Interligne du
panneau Caractère.

Interligne
A.  Interligne B.  Hauteur du texte C.  Si l’on augmente la taille d’un mot par rapport aux autres mots d’une même ligne, l’interligne de cette ligne
est augmenté en conséquence.

Modification de l’interligne
Par défaut, l’interligne est considéré comme un attribut de caractère, ce qui signifie que vous pouvez appliquer différentes valeurs d’interligne au
sein du même paragraphe. Dans une ligne de texte, la valeur d’interligne la plus élevée détermine la valeur d’interligne de la ligne entière. Vous
pouvez cependant sélectionner une option de préférence pour appliquer la valeur d’interligne à un paragraphe entier, plutôt qu’au texte du
paragraphe. Ce paramètre n’affecte pas l’interligne des blocs existants.

Pour modifier l’interligne dans du texte sélectionné
1. Sélectionnez le texte à modifier.
2. Utilisez l’une des méthodes suivantes :

Dans le panneau Caractère ou Contrôle, choisissez l’interligne dans le menu Interligne .

Sélectionnez la valeur existante et entrez une nouvelle valeur.

Lors de la création d’un style de paragraphe, modifiez l’interligne à l’aide du panneau Formats de caractère standard.

Il peut arriver qu’InDesign ignore la modification de l’interligne si les options Justification verticale ou Aligner sur la grille de ligne de base sont
sélectionnées. Dans ce cas, choisissez la commande Objet > Options de bloc de texte, puis assurez-vous que l’option Justification verticale est
réglée sur la valeur Haut et que l’option Ne pas aligner sur la grille de ligne de base est sélectionnée dans le panneau Paragraphe, le
panneau Contrôle ou le style de paragraphe.

Vous pouvez également modifier l’espace vertical en alignant le texte sur la grille de ligne de base. Si l’on définit la grille de ligne de base, la
valeur de la grille prend le pas sur la valeur d’interligne.

Pour modifier le pourcentage d’interligne automatique par défaut
1. Sélectionnez les paragraphes à modifier.
2. Choisissez la commande Justification dans le menu du panneau Paragraphe ou Contrôle.
3. Pour l’option Interligne automatique, spécifiez un nouveau pourcentage par défaut. La valeur minimum est de 0 %, la valeur

maximum de 500 %.



 

Pour appliquer l’interligne à l’ensemble d’un paragraphe
1. Choisissez Edition > Préférences > Texte (Windows) ou InDesign > Préférences > Texte (Mac OS).
2. Sélectionnez l’option Appliquer l’interligne à l’ensemble du paragraphe, puis cliquez sur le bouton OK.

Remarque : lorsque vous utilisez un style de caractère pour appliquer une valeur d’interligne à un texte, l’interligne est appliqué au texte
uniquement, et non au paragraphe, que l’option Appliquer l’interligne à l’ensemble du paragraphe soit sélectionnée ou non.
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Présentation de la boîte de dialogue Tabulations
Dans un bloc, les tabulations positionnent le texte à des emplacements horizontaux spécifiques. Les paramètres de tabulation par défaut
dépendent des unités de la règle horizontale définies dans le panneau Unités et règles de la boîte de dialogue Préférences.

Les tabulations s’appliquent à l’ensemble du paragraphe. Lorsque vous définissez la première tabulation, toutes les tabulations par défaut situées
à gauche de celle-ci sont supprimées. Les tabulations suivantes suppriment toutes les tabulations par défaut situées entre les tabulations que vous
avez définies. Vous pouvez définir des tabulations à gauche, centrées, à droite et décimales ou des tabulations de caractère spécial.

Utilisez la boîte de dialogue Tabulations pour définir des tabulations.

Boîte de dialogue Tabulations
A.  Boutons d’alignement de tabulation B.  Position de tabulation C.  Points de conduite de tabulation D.  Champ Aligner sur E.  Réglette de
tabulation F.  Magnétisme au-dessus du bloc

Pour ouvrir la boîte de dialogue Tabulations
1. A l’aide de l’outil Texte, cliquez dans le bloc de texte.
2. Choisissez Texte > Tabulations.

Si le haut du bloc est visible, la boîte de dialogue Tabulations est attirée par magnétisme vers le bloc de texte sélectionné et adapte sa largeur à
celle de la colonne active.

Pour aligner la règle de la boîte de dialogue Tabulations sur votre texte
1. Faites défiler le document jusqu’à ce que la partie supérieure du bloc de texte s’affiche.
2. Cliquez sur l’icône de l’aimant  dans la boîte de dialogue Tabulations. La boîte de dialogue Tabulations est attirée par

magnétisme vers le haut de la colonne qui contient la sélection ou le point d’insertion.

Définition de tabulations
Vous pouvez définir des tabulations à gauche, centrées, à droite et décimales ou des tabulations de caractère spécial. Lorsque vous utilisez la
tabulation de caractère spécial, vous pouvez définir une tabulation pour un alignement sur le caractère de votre choix, tel que le signe deux-
points (:) ou le signe dollar ($).

Bob Bringhurst propose un article portant sur les effets de tabulation et de retrait, sous le titre Tabs and Indents Gallery.

1. A l’aide de l’outil Texte , créez un point d’insertion dans le paragraphe.
2. Appuyez sur la touche de tabulation. Ajoutez des tabulations aux paragraphes aux emplacements où vous souhaitez insérer

un espace horizontal. Vous pouvez également ajouter les tabulations après avoir défini les paramètres de tabulation.

http://blogs.adobe.com/indesigndocs/2009/09/tabs_and_indents_gallery.html
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Utilisation de tabulations pour aligner un texte

3. Choisissez Texte > Tabulations pour afficher la boîte de dialogue Tabulations.
4. Pour spécifier les paragraphes, sélectionnez un paragraphe ou un groupe de paragraphes.
5. Pour définir votre première tabulation, cliquez sur l’un des boutons d’alignement de tabulation (gauche, droite, centre ou

décimale) dans la boîte de dialogue Tabulations pour spécifier la façon dont le texte doit s’aligner sur la position de la
tabulation.

6. Utilisez l’une des méthodes suivantes :

Cliquez sur un emplacement de la règle de tabulation pour placer une nouvelle tabulation.

Ajout d’un nouveau paramètre de tabulation

Entrez une position dans la zone X et appuyez sur Entrée ou Retour. Si la valeur X est sélectionnée, appuyez sur les
touches flèche haut et flèche bas pour augmenter ou diminuer la valeur de la tabulation d’1 point, respectivement.

7. Pour les tabulations suivantes dotées d’alignements différents, répétez les étapes 3 et 4.

La première tabulation définit l’alignement à droite et la deuxième tabulation l’alignement à gauche.

Pour insérer une tabulation dans un tableau, choisissez la commande Texte > Insérer un caractère spécial > Autre > Tabulation.

Répétition de tabulations
La commande Répéter la tabulation crée plusieurs tabulations en fonction de la distance entre chacune d’entre elles et le retrait gauche ou le
taquet précédent.

1. Créez un point d’insertion dans le paragraphe.
2. Dans le panneau Tabulations, sélectionnez un taquet sur la réglette.
3. Choisissez Répéter la tabulation dans le menu du panneau.

Tabulations répétées
A.  Boutons d’alignement des tabulations B.  Taquet de tabulation sur la réglette C.  Menu du panneau
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Déplacement, suppression et modification des paramètres de tabulation
Utilisez la boîte de dialogue Tabulations pour déplacer, supprimer et modifier les paramètres de tabulation.

Pour déplacer une tabulation
1. A l’aide de l’outil Texte , créez un point d’insertion dans le paragraphe.
2. Dans la boîte de dialogue Tabulations, sélectionnez une tabulation sur la règle de tabulation.
3. Utilisez l’une des méthodes suivantes :

Entrez un nouvel emplacement dans la zone X, puis appuyez sur la touche Entrée ou Retour.

Faites glisser la tabulation.

Pour supprimer une tabulation
1. Créez un point d’insertion dans le paragraphe.
2. Utilisez l’une des méthodes suivantes :

Faites glisser la tabulation hors de la réglette.

Sélectionnez la tabulation, puis choisissez Supprimer la tabulation dans le menu du panneau.

Pour revenir aux taquets de tabulation par défaut, choisissez Tout supprimer dans le menu du panneau.

Pour modifier l’alignement d’une tabulation
1. Dans la boîte de dialogue Tabulations, sélectionnez une tabulation sur la règle de tabulation.
2. Cliquez sur un bouton d’alignement de tabulation.

Vous pouvez aussi cliquer sur la marque de taquet de tabulation en maintenant la touche Alt (Windows) ou Option
(Mac OS) enfoncée pour changer d’option d’alignement.

Spécification des caractères pour les tabulations décimales
Vous pouvez utiliser les tabulations décimales pour aligner le texte sur un caractère spécifique, par exemple, un point ou un symbole dollar.

1. Dans le panneau Tabulations, créez ou sélectionnez une tabulation décimale  sur la règle de tabulation.
2. Dans la zone Aligner sur, saisissez le caractère sur lequel vous souhaitez effectuer l’alignement. Vous pouvez saisir ou coller

n’importe quel caractère. Assurez-vous que les paragraphes que vous alignez contiennent bien ce caractère.

Texte aligné à l’aide d’une tabulation décimale

Ajout de points de conduite
Un point de conduite désigne un groupe répétitif de caractères, comme une série de points ou de traits, entre une tabulation et le texte qui suit.

1. Dans le panneau Tabulations, sélectionnez un taquet sur la réglette.
2. Saisissez une série de huit caractères au maximum dans la zone Point de conduite, puis appuyez sur la touche Entrée

ou Retour. Les caractères saisis sont répétés sur toute la largeur de la tabulation.
3. Pour modifier la police ou tout autre attribut de mise en forme des points de conduite de tabulation, sélectionnez le caractère

de tabulation dans le bloc de texte et utilisez le panneau Caractère ou le menu Texte pour appliquer une mise en forme.

Insertion de tabulations de retrait à droite
En une seule opération, vous pouvez ajouter une tabulation alignée à droite pour un retrait à droite, ce qui facilite la préparation d’un texte séparé
par des tabulations et disposé dans une colonne entière. Les tabulations de retrait à droite diffèrent légèrement des tabulations normales. Une
tabulation de retrait à droite :
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Aligne tout le texte qui suit sur le bord droit d’un bloc de texte. Si le même paragraphe comprend une tabulation après la
tabulation de retrait à droite, cette première tabulation et son texte sont renvoyés à la ligne suivante.

Constitue un caractère spécial situé dans le texte et non dans la boîte de dialogue Tabulations. Pour ajouter une tabulation de
retrait à droite, utilisez un menu contextuel et non la boîte de dialogue Tabulations. Par conséquent, une tabulation de retrait à
droite ne peut pas faire partie d’un style de paragraphe.

Diffère de la valeur Retrait à droite du panneau Paragraphe. Cette valeur permet de maintenir le bord droit du paragraphe à
distance du bord du bloc de texte.

Peut être utilisée avec un point de conduite de tabulation. Les tabulations de retrait à droite utilisent le point de conduite de
tabulation du premier taquet de tabulation au-delà de la marge de droite, ou, s’il n’en existe pas un, le dernier taquet avant la
marge de droite.

1. A l’aide de l’outil Texte , cliquez sur la ligne à laquelle vous souhaitez ajouter une tabulation de retrait à droite.
2. Choisissez la commande Texte > Insérer un caractère spécial > Autre > Tabulation de retrait à droite.

Définition de retraits
Les retraits déplacent le texte des bords droit et gauche d’un bloc vers l’intérieur. Utilisez surtout les retraits de première ligne, et non les espaces
ou les tabulations, pour mettre la première ligne d’un paragraphe en retrait.

La position du retrait de première ligne est en fonction de celle du retrait à gauche. Par exemple, si le bord gauche d’un paragraphe est en retrait
d’un pica, la définition du retrait de première ligne sur un pica décale la première ligne du paragraphe de deux picas à partir du bord gauche du
bloc ou de l’encart.

Vous pouvez définir des retraits dans la boîte de dialogue Tabulations, le panneau Paragraphe ou le panneau Contrôle. Il est possible également
de mettre une liste à puces ou numérotée en retrait.

Bob Bringhurst propose un article portant sur les effets de tabulation et de retrait, sous le titre Tabs and Indents Gallery.

Définition d’un retrait au moyen de la boîte de dialogue Tabulations
1. A l’aide de l’outil Texte , cliquez sur le paragraphe à mettre en retrait.
2. Choisissez la commande Texte > Tabulations pour afficher la boîte de dialogue Tabulations.

3. Dans la boîte de dialogue Tabulations, effectuez l’une des opérations suivantes sur les marques de retrait  :

Faites glisser la marque du haut pour mettre en retrait la première ligne de texte. Faites glisser la marque du bas pour
déplacer les deux marques et mettre en retrait l’ensemble du paragraphe.

Retrait de première ligne (à gauche) et aucun retrait (à droite)

Sélectionnez la marque du haut et entrez une valeur pour X afin de mettre en retrait la première ligne de texte.
Sélectionnez la marque du bas et entrez une valeur pour X pour déplacer les deux marques et mettre en retrait l’ensemble
du paragraphe.

Pour plus de détails sur l’utilisation de la boîte de dialogue Tabulations, voir la section Présentation de la boîte de dialogue Tabulations.

Définition de retraits au moyen du panneau Paragraphe ou Contrôle
1. A l’aide de l’outil Texte , cliquez sur le paragraphe à mettre en retrait.
2. Dans le panneau Paragraphe ou Contrôle, ajustez les valeurs de retrait selon vos besoins. Vous pouvez par exemple

procéder de la manière suivante :

Pour appliquer un retrait de 1 pica à un paragraphe entier, entrez une valeur (par exemple, 1p) dans le champ Retrait à
gauche .

Pour appliquer un retrait de 1 pica à la première ligne d’un paragraphe, entrez une valeur (par exemple 1p) dans le champ
Retrait de première ligne .

Pour créer un retrait négatif de 1 pica, entrez une valeur positive (par exemple  1p ) dans le champ Retrait à gauche et

http://blogs.adobe.com/indesigndocs/2009/09/tabs_and_indents_gallery.html


une valeur négative (par exemple  -1p ) dans le champ Retrait de première ligne (voir la section Définition de retraits).

Restauration de retraits
1. Cliquez sur le paragraphe auquel sont appliqués les retraits à réinitialiser.
2. Choisissez la commande Réinitialiser les retraits dans le menu de la boîte de dialogue Tabulations.

Création d’un retrait négatif
Dans un retrait négatif, toutes les lignes d’un paragraphe sont en retrait, excepté la première ligne. Les retraits négatifs sont particulièrement utiles
lorsque vous voulez ajouter des images texte au début du paragraphe.

Pas de retrait (à gauche) et retrait négatif (à droite)

1. A l’aide de l’outil Texte , cliquez sur le paragraphe à mettre en retrait.
2. Indiquez une valeur de retrait à gauche supérieure à 0 dans la boîte de dialogue Tabulations ou le panneau Contrôle.
3. Pour spécifier une valeur négative de retrait à gauche de première ligne, utilisez l’une des méthodes suivantes :

Dans le panneau Contrôle, entrez une valeur négative pour le retrait à gauche de la première ligne .

Dans la boîte de dialogue Tabulations, faites glisser la marque du haut vers la gauche ou sélectionnez la marque et entrez
une valeur négative pour X.

La plupart du temps, vous spécifiez l’équivalent négatif de la valeur entrée à l’étape 2. Par exemple, si vous avez spécifié un retrait à gauche de
2 picas, le retrait à gauche de première ligne sera de -2 picas.

Mise en retrait à droite de la dernière ligne d’un paragraphe
L’option Retrait à droite de dernière ligne permet de créer un retrait négatif à droite de la dernière ligne d’un paragraphe. Cette option est
particulièrement utile pour aligner les prix à droite dans un catalogue.

Retrait à droite de dernière ligne

1. Tapez le texte des paragraphes. Placez le point d’insertion devant le texte à mettre en retrait sur la dernière ligne de chacun
des paragraphes, puis choisissez la commande Texte > Insérer un caractère spécial > Autre > Tabulation de retrait à droite.

2. Sélectionnez les paragraphes.
3. Pour mettre les paragraphes en retrait à droite, entrez une valeur (par exemple, 2p) dans le champ Retrait à droite du

panneau Paragraphe ou Contrôle.



 

4. Pour décaler vers la droite le texte qui suit la tabulation, entrez une valeur négative (par exemple, -2p) dans le champ Retrait
à droite de dernière ligne du panneau Paragraphe ou Contrôle.

Utilisation du caractère Retrait jusqu’à ce point
Vous pouvez utiliser le caractère spécial Retrait jusqu’à ce point pour mettre en retrait des lignes dans un paragraphe, indépendamment de la
valeur de retrait à gauche du paragraphe. Le caractère spécial Retrait jusqu’à ce point diffère du retrait à gauche d’un paragraphe sur les points
suivants :

Le caractère Retrait jusqu’à ce point fait partie du texte, comme s’il constituait un caractère visible. Lors d’un déplacement de
texte, il se déplace avec lui.

Le caractère Retrait jusqu’à ce point agit sur toutes les lignes qui suivent la ligne à laquelle vous l’ajoutez, ce qui permet de
mettre uniquement en retrait certaines lignes d’un paragraphe.

Lorsque vous choisissez Texte > Afficher les caractères masqués, le caractère Retrait jusqu’à ce point  est visible.

Retrait jusqu’à ce point, caractère spécial

1. A l’aide de l’outil Texte , créez un point d’insertion à l’emplacement où le retrait doit s’appliquer.
2. Choisissez la commande Texte > Insérer un caractère spécial > Autre > Retrait jusqu’à ce point.

Voir aussi
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A propos du crénage et de l’approche
Le crénage consiste à augmenter ou à diminuer l’espacement de paires de lettres spécifiques. L’approche consiste à définir un espacement
identique à l’intérieur d’un bloc de texte.

Types de crénage
Le crénage peut être métrique ou optique. Le crénage métrique utilise le crénage par paire inclus dans la plupart des polices. Le crénage par paire
contient des informations concernant l’espacement de paires de caractères spécifiques. Par exemple : LA, P., To, Tr, Ta, Tu, Te, Ty, Wa, WA,
We, Wo, Ya et Yo.

Par défaut, InDesign utilise le crénage métrique de façon à ce que le crénage par paire soit automatiquement respecté lorsque vous importez ou
saisissez du texte. Pour désactiver le crénage métrique, sélectionnez 0.

Le crénage optique permet de modifier l’espacement entre deux caractères adjacents en fonction de leur forme. Certaines polices comportent
d’importantes spécifications de crénage par paire. Toutefois, si une police comporte uniquement un crénage intégré réduit ou ne comporte pas de
crénage, ou encore si vous utilisez deux polices ou deux corps différents dans un ou plusieurs mots d’une ligne, vous pouvez utiliser l’option de
crénage optique.

Aucun crénage appliqué entre « W » et « a » (en haut), puis crénage optique appliqué (en bas)

Vous pouvez également recourir au crénage manuel, idéal pour modifier l’espace entre deux lettres. Les effets des options d’approche et de
crénage s’additionnent ; vous pouvez ainsi commencer par modifier des paires de lettres, puis, sans modifier leur position relative, resserrer ou
élargir une plage entière de texte.

Le crénage diffère de l’option Intermots de la boîte de dialogue Justification dans le sens où il permet de modifier uniquement la valeur de crénage
entre le premier caractère d’un mot et l’espace précédant ce caractère.

Crénage et approche
A.  Original B.  Crénage appliqué entre « W » et « a » C.  Approche appliquée

Mesure du crénage et de l’approche
Vous pouvez appliquer le crénage, l’approche ou les deux au texte sélectionné. L’approche et le crénage sont mesurés en 1/1000 de cadratin, une
unité de mesure relative au corps du caractère utilisé. Pour un corps de 6 points, 1 cadratin est égal à 6 points ; pour un corps de 10 points, 1
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cadratin est égal à 10 points. Le crénage et l’approche sont strictement proportionnels au corps du caractère utilisé.

Les effets des options d’approche et de crénage s’additionnent ; vous pouvez ainsi commencer par modifier des paires de lettres, puis, sans
modifier leur position relative, resserrer ou élargir une plage entière de texte.

Si vous introduisez un point d’insertion entre deux lettres, InDesign affiche les valeurs de crénage dans les panneaux Caractère et Contrôle. Les
valeurs de crénage métrique et optique (crénage par paire) s’affichent entre parenthèses. De même, si vous sélectionnez un mot ou une plage de
texte, InDesign affiche les valeurs d’approche dans les panneaux Caractère et Contrôle.

Application de crénage au texte
Vous pouvez appliquer l’un des deux types de crénage automatique (crénage métrique ou crénage optique) ou modifier manuellement l’espace
entre les lettres.

Pour appliquer le crénage métrique
1. Positionnez le point d’insertion de texte entre les caractères auxquels doit s’appliquer le crénage par paire, ou bien

sélectionnez du texte.

2. Choisissez la commande Métrique dans le menu Crénage  du panneau Caractère ou Contrôle.

Si vous ne souhaitez pas utiliser les paramètres de crénage intégrés associés à une police, choisissez « 0 » dans le menu Crénage .

Pour appliquer le crénage optique
1. Positionnez le point d’insertion de texte entre les caractères auxquels doit s’appliquer le crénage par paire, ou bien

sélectionnez le texte auquel vous souhaitez appliquer le crénage.

2. Choisissez la commande Optique dans le menu Crénage  du panneau Caractère ou Contrôle.

Pour régler manuellement le crénage
1. A l’aide de l’outil Texte , cliquez sur le document pour créer un point d’insertion entre deux caractères.

Remarque : si vous sélectionnez une plage de texte, vous ne pouvez pas effectuer de crénage manuel (vous pouvez choisir
uniquement Métrique, Optique ou 0). Utilisez plutôt l’option Approche.

2. Utilisez l’une des méthodes suivantes :

Dans le menu Crénage du panneau Caractère ou Contrôle, entrez ou sélectionnez une valeur numérique.

Appuyez sur les touches Alt+Touche flèche gauche/flèche droite (Windows) ou Option+Touche flèche gauche/flèche
droite (Mac OS) pour augmenter ou diminuer le crénage entre deux caractères.

La valeur de réglage du crénage est identique à la valeur Crénage de la boîte de dialogue de préférences Unités et incréments. Lorsque vous
appuyez sur la touche de raccourci tout en maintenant la touche Ctrl (Windows) ou Commande (Mac OS) enfoncée, la valeur de crénage
correspond à celle spécifiée dans les préférences de crénage, multipliée par 5.

Pour modifier la valeur par défaut de l’incrément de crénage
 Dans la section Unités et incréments de la boîte de dialogue Préférences, entrez une nouvelle valeur pour l’option Crénage, puis cliquez

sur OK.

Pour désactiver le crénage du texte sélectionné
1. Sélectionnez du texte.
2. Entrez ou sélectionnez 0 dans le menu Crénage du panneau Caractère ou Contrôle.

Vous pouvez également appuyer sur les touches Alt+Ctrl+Q (Windows) ou Option+Commande+Q (Mac OS) pour réinitialiser le crénage et
l’approche. Le crénage est alors défini sur Métrique, quelle que soit l’option préalablement définie.

Pour régler l’approche
1. Sélectionnez une plage de caractères.

2. Dans le panneau Caractère ou Contrôle, entrez ou sélectionnez une valeur numérique pour l’option Approche .

Pour mettre en surbrillance du texte contenant un crénage et une approche personnalisés
Dans certains cas, il peut être nécessaire de mettre en évidence le texte auquel une approche ou un crénage personnalisé a été appliqué.
Lorsque l’option Approche/Crénage personnalisés est activée dans la boîte de dialogue des préférences, le texte faisant l’objet d’une approche ou
d’un crénage personnalisé est surligné en vert.

1. Choisissez Edition > Préférences > Composition (Windows) ou InDesign > Préférences > Composition (Mac OS).
2. Sélectionnez Approche/Crénage personnalisés, puis cliquez sur OK.
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 A l’aide de l’outil Texte , sélectionnez une plage de texte et utilisez l’une des méthodes suivantes :

Pour augmenter l’espace entre les mots sélectionnés, appuyez sur les touches Alt+Ctrl+\ (Windows) ou Option+Commande+\
(Mac OS).

Pour diminuer l’espace entre les mots sélectionnés, appuyez sur les touches Alt+Ctrl+Retour arrière (Windows) ou
Option+Commande+Suppr (Mac OS).

Pour multiplier la valeur de l’incrément de crénage par cinq, maintenez la touche Maj enfoncée tout en appuyant sur les
touches de raccourci.

Voir aussi
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Mise en forme de tableaux
Redimensionnement de colonnes, rangées et tableaux
Modification de l’espacement avant ou après un tableau
Répartition de tableaux sur plusieurs blocs
Insertion de texte au-dessus d’un tableau
Mise en forme de texte dans un tableau
Fusion et fractionnement de cellules
Gestion des cellules en excès

Mise en forme de tableaux
Vous pouvez mettre en forme le texte d’un tableau à l’aide du panneau Contrôle ou du panneau Caractère, comme s’il s’agissait d’un texte
ordinaire. Vous disposez également de deux boîtes de dialogue dédiées à la mise en forme d’un tableau : Options de tableau et Options de
cellule. Vous pouvez y modifier le nombre de lignes et de colonnes et l’aspect du contour et du fond d’un tableau, y définir l’espace avant ou après
le tableau, y éditer les lignes d’en-tête et de pieds de tableau, et bien d’autres attributs de mise en forme.

Le panneau Tableau, le panneau Contrôle, et le menu contextuel vous permettent également de mettre en forme un tableau. Sélectionnez une ou
plusieurs cellules, puis cliquez avec le bouton droit de la souris (Windows) ou en maintenant la touche Contrôle enfoncée (Mac OS) pour afficher
un menu contextuel comportant des options relatives aux tableaux.

Pour consulter un didacticiel vidéo sur la création et la mise en forme des tableaux, rendez-vous à l’adresse www.adobe.com/go/vid0081.

Redimensionnement de colonnes, rangées et tableaux
Il existe plusieurs méthodes pour redimensionner des colonnes, des rangées et des tableaux.

Pour redimensionner des colonnes et des rangées
1. Sélectionnez des cellules dans les colonnes et les lignes à redimensionner.
2. Utilisez l’une des méthodes suivantes :

Dans le panneau Tableau, définissez la valeur des paramètres Largeur de la colonne et Hauteur de la rangée.

Choisissez la commande Tableau > Options de cellules > Lignes et colonnes, définissez la valeur des options Hauteur de
la ligne et Largeur de la colonne, puis cliquez sur le bouton OK.

Remarque : si vous sélectionnez l’option Supérieure ou égale à pour définir une hauteur de ligne minimale, cette hauteur
augmente selon le texte inséré ou la force de corps choisie. Si vous sélectionnez l’option Exactement pour définir une
hauteur de ligne fixe, cette hauteur ne change pas quand vous ajoutez ou supprimez du texte. Il arrive souvent que ce
type de cellule contienne du texte en excès (voir la section Gestion des cellules en excès).

Positionnez le pointeur sur le bord d’une colonne ou d’une rangée jusqu’à ce qu’une double flèche (  ou ) apparaisse,
puis faites glisser le pointeur vers la gauche ou la droite pour augmenter ou réduire la largeur de la colonne, ou vers le
haut ou le bas pour augmenter ou réduire la hauteur de la rangée.

Avant et après le redimensionnement des lignes

Par défaut, la hauteur d’une ligne est déterminée par la hauteur de la ligne-bloc de la police sélectionnée. Par conséquent, la hauteur d’une ligne
change également lorsque vous modifiez la force de corps du texte de lignes entières ou le paramètre de hauteur de ligne. La hauteur de ligne
maximale est déterminée par le paramètre Maximum dans la section Lignes et colonnes de la boîte de dialogue Options de cellule.

http://www.adobe.com/go/vid0081
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Pour redimensionner des colonnes et des rangées sans modifier la largeur du tableau
Maintenez la touche Maj enfoncée tout en faisant glisser le bord d’une ligne ou d’une colonne intérieure (et non les limites du
tableau). Une ligne ou une colonne s’agrandit alors que l’autre diminue.
Pour redimensionner des lignes ou des colonnes proportionnellement, maintenez la touche Maj enfoncée tout en faisant glisser
la limite droite ou inférieure du tableau.

Maintenez la touche Maj enfoncée tandis que vous faites glisser le bord droit ou le bord inférieur du tableau pour redimensionner respectivement
toutes les colonnes ou toutes les lignes proportionnellement.

Pour redimensionner un tableau entier
 A l’aide de l’outil Texte , positionnez le pointeur sur le coin inférieur droit du tableau jusqu’à ce que le pointeur se transforme en flèche ,

puis faites glisser le pointeur pour augmenter ou réduire la taille du tableau. Maintenez la touche Maj enfoncée pour conserver les proportions de
la largeur et de la hauteur du tableau.
Remarque : si le tableau s’étend sur plusieurs blocs d’un article, il est impossible de redimensionner le tableau entier avec le pointeur de la souris.

Pour répartir uniformément des colonnes et des rangées
1. Sélectionnez des cellules dans les colonnes ou les lignes auxquelles appliquer une largeur ou une hauteur uniforme.
2. Choisissez Tableau > Répartir les lignes uniformément ou Répartir les colonnes uniformément.

Modification de l’espacement avant ou après un tableau
1. Après avoir placé le point d’insertion à l’intérieur du tableau, choisissez Tableau > Options de tableau > Format de tableau.
2. Dans la section Espacement du tableau, spécifiez des valeurs différentes pour les options Espace avant et Espace après, puis

cliquez sur OK.

Notez que cette modification n’agit pas sur l’espacement d’une ligne qui se situe en haut d’un bloc.

Répartition de tableaux sur plusieurs blocs
Les options d’enchaînement vous permettent de définir le nombre de lignes à conserver ensemble ou de spécifier l’emplacement de la coupure
d’une ligne, le haut d’une colonne ou d’un bloc, par exemple.

Lorsque vous créez un tableau dont la hauteur est supérieure à celle du bloc qui le contient, le bloc présente un excédent. Si vous liez le bloc à un
autre bloc, le tableau continue dans ce bloc. Les lignes se déplacent une à une dans les blocs liés ; il est donc impossible de partager une même
ligne sur plusieurs blocs. Spécifiez les lignes d’en-tête ou de pied de tableau dans lesquelles les informations seront répétées dans le nouveau
bloc.

1. Placez le point d’insertion dans la ligne appropriée ou sélectionnez une série de cellules sur les lignes à conserver ensemble.
2. Choisissez Tableau > Options de cellules > Lignes et colonnes.
3. Pour conserver les lignes sélectionnées ensemble, sélectionnez Lignes solidaires.
4. Pour couper la ligne à un endroit précis, sélectionnez une option (par exemple, Prochain bloc) du menu Début de la ligne, puis

cliquez sur OK.

Si vous créez un seul tableau s’étendant sur une double page, ajoutez une colonne vide au milieu du tableau pour créer des marges.

Insertion de texte au-dessus d’un tableau
Un tableau est ancré aux paragraphes immédiatement adjacents. Si vous insérez un tableau au début d’un bloc de texte, il vous est impossible de
cliquer au-dessus du tableau pour y placer un point d’insertion. Il vous faut donc utiliser les touches de direction pour amener le point d’insertion
avant le tableau.

 Placez le point d’insertion au début du paragraphe de la première cellule, appuyez sur la touche flèche gauche, puis saisissez le texte.

Mise en forme de texte dans un tableau
De manière générale, vous pouvez mettre en forme du texte dans un tableau comme s’il s’agissait de texte non contenu dans un tableau.

Pour insérer des tabulations dans une cellule
Lorsque le point d’insertion est placé à l’intérieur du tableau, la touche Tabulation a pour effet de déplacer ce point vers la cellule suivante. Vous
pouvez toutefois insérer un caractère de tabulation dans une cellule de tableau. Utilisez le panneau Tabulations pour définir les paramètres de
tabulation d’un tableau, lesquels agissent sur le paragraphe dans lequel le point d’insertion se trouve.

1. A l’aide de l’outil Texte , placez le point d’insertion là où vous souhaitez insérer la tabulation.
2. Choisissez la commande Texte > Insérer un caractère spécial > Autre > Tabulation.
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Pour modifier les paramètres d’une tabulation, sélectionnez les colonnes ou cellules concernées, choisissez Texte > Tabulations pour afficher le
panneau Tabulations, puis modifiez les paramètres.

Remarque : si vous utilisez la règle Tabulations pour appliquer une tabulation décimale à une cellule ou un groupe de cellules, il n’est
généralement pas nécessaire d’appuyer sur Tabulation au début de chaque paragraphe pour aligner le texte selon une tabulation décimale. Les
paragraphes sont automatiquement alignés sur le caractère décimal sauf si le paragraphe contient une mise en forme supplémentaire, par
exemple s’il est centré, auquel cas la tabulation décimale n’est pas prise en compte.

Pour modifier l’alignement du texte d’une cellule
1. A l’aide de l’outil Texte , sélectionnez la ou les cellules appropriées.
2. Choisissez Tableau > Options de cellules > Texte.
3. Dans le menu Justification verticale, sélectionnez un paramètre d’alignement : Aligner en haut, Centrer, Aligner en bas ou

Justifier verticalement.

Si vous avez sélectionné l’option Justifié, spécifiez la limite d’espacement des paragraphes, laquelle définit un espace
maximum à insérer entre les paragraphes (voir la section Alignement ou justification de texte verticalement au sein d’un bloc
de texte).

4. Dans la section Première ligne de base, sélectionnez une option de décalage du texte par rapport au haut de la cellule.

Les options disponibles sont identiques à celles de la boîte de dialogue Options de bloc de texte (voir la section Modification
des propriétés d’un bloc de texte).

5. Cliquez sur le bouton OK.

Remarque : modifiez l’alignement horizontal du texte d’une cellule à l’aide de l’option d’alignement du panneau Paragraphe. Pour aligner le texte
d’une cellule sur une tabulation décimale, ajoutez un paramètre de tabulation décimale à l’aide du panneau Tabulations.

Pour appliquer une rotation au texte d’une cellule
1. Placez le point d’insertion dans la cellule à faire pivoter ou sélectionnez les cellules concernées.
2. Choisissez Tableau > Options de cellules > Texte ou affichez le panneau Tableau.
3. Sélectionnez une valeur de rotation, puis cliquez sur OK.

Pour modifier la marge des cellules
1. A l’aide de l’outil Texte , placez le point d’insertion sur une ou plusieurs cellules ou sélectionnez-les.
2. Choisissez Tableau > Options de cellules > Texte ou affichez le panneau Tableau.
3. Dans la section Marges de cellule, spécifiez les valeurs des options De tête, De pied, Gauche et Droite, puis cliquez sur OK.

Dans la plupart des cas, l’augmentation de la marge de cellule se répercute proportionnellement sur la hauteur des lignes. Si la valeur de la
hauteur de ligne est fixe, veillez à réserver suffisamment d’espace pour les valeurs d’encart afin d’éviter tout débordement de texte.

Fusion et fractionnement de cellules
Vous pouvez fusionner (combiner) ou fractionner (diviser) les cellules d’un tableau.

Pour fusionner des cellules
Vous pouvez regrouper plusieurs cellules d’une même ligne ou colonne dans une seule cellule. Vous pouvez par exemple fusionner les cellules de
la première ligne d’un tableau pour créer une seule cellule dédiée au titre du tableau.

1. A l’aide de l’outil Texte , sélectionnez les cellules que vous souhaitez fusionner.
2. Choisissez Tableau > Fusionner les cellules.

Pour annuler la fusion de cellules
 Placez le point d’insertion dans la cellule fusionnée et choisissez Tableau > Annuler la fusion des cellules.

Pour fractionner des cellules
Vous pouvez par ailleurs fractionner les cellules sur l’axe horizontal ou vertical, ce qui est très pratique lors de la création des tableaux de
formulaire. Vous pouvez ainsi sélectionner plusieurs cellules et les fractionner verticalement ou horizontalement.

1. Placez le point d’insertion dans la cellule à fractionner, ou sélectionnez une ligne, une colonne ou un bloc de cellules.
2. Choisissez Tableau > Scinder la cellule dans le sens vertical ou Scinder la cellule dans le sens horizontal.

Gestion des cellules en excès
En règle générale, la cellule d’un tableau s’élargit verticalement en fonction des nouveaux graphiques ou textes insérés. Si toutefois vous



 

définissez une hauteur de ligne fixe et ajoutez du texte ou des graphiques trop larges par rapport à la cellule, un petit point rouge apparaît dans
l’angle inférieur droit de la cellule pour signaler un excédent de texte.

Il est impossible de répartir du texte en excès dans une autre cellule. Il vous faut donc éditer ou redimensionner le contenu ou élargir la cellule ou
le bloc de texte qui reçoit le tableau.

S’il s’agit d’une image texte ou d’un texte à interligne fixe, il est impossible de faire déborder le contenu de la cellule de son contour. S’il y a lieu,
sélectionnez l’option Ecrêter le contenu selon la cellule pour rogner le texte ou l’image texte en excès à la bordure de la cellule. Toutefois, si des
images texte sont en excès et s’étendent au-delà des bords inférieurs des cellules (tableaux horizontaux), cette opération ne s’applique pas.

Pour afficher le contenu d’une cellule en excès
 Utilisez l’une des méthodes suivantes :

Agrandissez la cellule.

Modifiez la mise en forme du texte. Pour sélectionner le contenu de la cellule, cliquez sur la cellule en excès, appuyez sur la
touche Echap, puis mettez le texte en forme avec les options du panneau Contrôle.

Pour écrêter une image d’une cellule
Si une image est trop grande pour une cellule, elle s’étend au-delà des bords de la cellule. Vous pouvez écrêter les parties de l’image qui
s’étendent au-delà de la bordure.

1. Placez le point d’insertion dans la cellule à rogner ou sélectionnez la ou les cellules sur lesquelles l’écrêtage agira.
2. Choisissez Tableau > Options de cellules > Texte.
3. Sélectionnez l’option Ecrêter le contenu selon la cellule, puis cliquez sur le bouton OK.

Voir aussi
Vidéo Créer et mettre en forme des tableaux
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Création de tableaux
Ajout de texte à un tableau
Ajout de graphiques à un tableau
Ajout d’en-têtes et de pieds de tableau

Un tableau se compose de lignes et de colonnes de cellules. Une cellule est un bloc de texte dans lequel il
est possible d’insérer du texte, des blocs ancrés ou d’autres tableaux. Vous pouvez créer des tableaux dans
Adobe InDesign CS5 ou les exporter à partir d’autres applications.

pour créer, modifier et mettre en forme des tableaux dans Adobe InCopy, assurez-vous que
vous êtes bien en mode Mise en page.

Création de tableaux

Un tableau se compose de lignes et de colonnes de cellules. Une cellule est un bloc de texte dans lequel il
est possible d’insérer du texte, des images texte ou d’autres tableaux. Vous pouvez créer des tableaux de
toutes pièces ou en convertissant du texte en tableau. Vous pouvez également imbriquer un tableau dans un
tableau.

Lorsque vous créez un tableau, il occupe la largeur du bloc de texte contenant. Il est inséré sur la même
ligne que le point d’insertion ou sur la ligne suivante, selon que celui-ci figure respectivement au début ou au
milieu de la ligne.

Les tableaux accommodent le texte avoisinant, comme les images texte. Ainsi, un tableau subit le même
déplacement que les blocs liés lorsque vous modifiez le corps du texte situé au-dessus ou lorsque vous
insérez ou supprimez du texte. En revanche, il est impossible d’insérer un tableau dans un bloc de texte
curviligne.

La création et la mise en forme des tableaux sont également abordées dans l’article Mind Your Table
Manners de Michael Murphy.

Jeff Witchel d’InfiniteSkills.com fournit une vidéo de démonstration sur les principes de base de la
configuration de tableaux.

Pour créer un tableau

Lorsque vous créez un tableau dans InDesign, vous avez la possibilité de créer le tableau dans un bloc de
texte existant (Utilisation de l’option Insérer un tableau). Vous pouvez également créer un tableau et
permettre à InDesign de créer le bloc de texte englobant (Utilisation de l’option Créer un tableau.)

Utilisation de l’option Insérer un tableau

1. Pour dessiner un tableau dans un bloc de texte existant, utilisez l’outil Texte et placez
le point d’insertion où vous souhaitez insérer le tableau.

2. Choisissez Tableau > Insérer un tableau.

http://www.creativepro.com/article/indesign-how-mind-your-table-manners
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si le curseur n’est actuellement dans aucun bloc de texte, l’option Créer un
tableau est disponible.

3. Spécifiez le nombre de lignes et de colonnes.

4. Si le contenu du tableau doit être réparti sur plusieurs colonnes ou blocs, spécifiez le
nombre de rangées d’en-tête ou de pied de tableau dans lesquelles les informations
devront être répétées.

5. (Facultatif) Spécifiez un style de tableau.

6. Cliquez sur le bouton OK.

Le nouveau tableau occupe la largeur du bloc de texte.

Utilisation de l’option Créer un tableau

Lorsque vous utilisez l’option Créer un tableau, vous n’avez pas besoin de créer préalablement un bloc de
texte dans votre document. Dès que vous dessinez le tableau dans le document, InDesign crée un bloc de
texte de la taille du tableau dessiné.

1. Choisissez Tableau > Créer un tableau.

si le curseur est actuellement dans un bloc de texte, l’option Insérer un
tableau est disponible.

2. Spécifiez le nombre de lignes et de colonnes.

3. Si le contenu du tableau doit être réparti sur plusieurs colonnes ou blocs, spécifiez le
nombre de rangées d’en-tête ou de pied de tableau dans lesquelles les informations
devront être répétées.

4. (Facultatif) Spécifiez un style de tableau.

5. Cliquez sur le bouton OK.

6. Utilisez le curseur du tableau pour dessiner le tableau dont vous avez besoin.

InDesign crée un bloc de texte de la taille de la zone dessinée et place le tableau dans le
bloc de texte.

La hauteur de rangée d’un tableau dépend du style de tableau choisi. Ainsi, un style de tableau peut
s’appuyer sur des styles de cellules pour mettre en forme diverses parties du tableau. Si l’un de ces styles de
cellule comprend des styles de paragraphe, la valeur d’interligne des styles de paragraphe détermine la
hauteur de rangée de cette zone. Si aucun style de paragraphe n’est utilisé, la ligne-bloc par défaut du
document détermine la hauteur de rangée. La ligne-bloc est fonction de la valeur d’interligne. Dans ce
contexte, une ligne-bloc, correspond approximativement à la hauteur de la surbrillance pour le texte
sélectionné.

Pour créer un tableau à partir de texte existant

Avant de convertir un texte en tableau, assurez-vous que le texte est composé correctement.

1. Pour préparer la conversion d’un texte, insérez des tabulations, des virgules, des retours
chariot ou d’autres caractères pour séparer les colonnes. Insérez des tabulations, des
virgules, des retours chariot ou d’autres caractères pour séparer les lignes. Souvent, le
texte peut être converti en tableau sans être modifié.

2. A l’aide de l’outil Texte , sélectionnez le texte à convertir en tableau.

3. Choisissez la commande Tableau > Convertir le texte en tableau.



4. Dans Séparateur de lignes et Séparateur de colonnes, indiquez le début des nouvelles
lignes et colonnes. Choisissez la commande Tabulation, Virgule ou Paragraphe, ou
entrez le caractère (par exemple le point virgule) dans les champs Séparateur de
colonnes et Séparateur de lignes (le caractère saisi apparaît ensuite dans le menu
lorsque vous créez un tableau à partir de texte).

5. Si vous spécifiez le même séparateur pour les colonnes et les rangées, indiquez le
nombre de colonnes à inclure dans le tableau.

6. (Facultatif) Spécifiez un style de tableau pour mettre en forme le tableau.

7. Cliquez sur le bouton OK.

Si une ligne a moins d’éléments que le nombre de colonnes d’un tableau, des cellules vides remplissent la
ligne.

Pour imbriquer un tableau dans un autre

1. Utilisez l’une des méthodes suivantes :

Sélectionnez les cellules ou le tableau à imbriquer, puis choisissez Edition > Couper
ou Copier. Placez le point d’insertion dans la cellule dans laquelle le tableau doit
apparaître, puis choisissez Edition > Coller.

Cliquez à l’intérieur d’une cellule, choisissez la commande Tableau > Insérer un
tableau, spécifiez le nombre de lignes et de colonnes, puis cliquez sur OK.

2. S’il y a lieu, ajustez l’encart de cellule. (Voir Mise en forme de texte dans un tableau .)

Si vous créez un tableau à l’intérieur d’une cellule, il vous est impossible d’utiliser la souris pour sélectionner
une portion du tableau qui déborde de la cellule. Vous devez étendre la ligne ou la colonne ou placer le point
d’insertion dans la première moitié du tableau, puis utiliser les touches de raccourci clavier pour déplacer le
point d’insertion et sélectionner le texte.

Pour importer des tableaux à partir d’autres applications

Lorsque vous importez un document Microsoft Word comprenant des tableaux ou une feuille de
calcul Microsoft Excel, à l’aide de la commande Importer, les données importées se présentent sous forme de
tableau modifiable. Vous pouvez en contrôler la mise en forme grâce à la boîte de dialogue Options
d’importation.

Vous pouvez également coller des données provenant d’une feuille de calcul Excel ou d’un tableau Word
dans un document InDesign ou InCopy. Les préférences de Gestion du presse-papiers déterminent la mise
en forme du texte collé depuis une autre application. Si l’option Texte seul est activée, les informations
s’affichent sous forme de texte tabulé non mis en forme, que vous pouvez convertir en tableau. Si
l’option Toutes les informations est sélectionnée, le texte collé prend la forme d’un tableau mis en forme.

Si vous collez du texte depuis une autre application dans un tableau existant, insérez suffisamment de
rangées et de colonnes pour le texte collé, choisissez l’option Texte seul dans les préférences de Gestion du
presse-papiers et sélectionnez au moins une cellule (sauf si vous souhaitez imbriquer le tableau collé dans
une cellule).

Pour contrôler davantage la mise en forme du tableau importé ou pour conserver la mise en forme de la
feuille de calcul, utilisez la commande Importer pour importer le tableau. Pour conserver un lien vers la feuille
de calcul, sélectionnez l’option Créer des liens avec les fichiers de texte et de feuilles de calcul importés,
dans les préférences de gestion des fichiers.

Vous pouvez également copier et coller du texte tabulé dans une sélection de cellules de tableau. Cette
technique permet de remplacer facilement le contenu tout en conservant la mise en forme. Supposons,
par exemple, que vous deviez mettre à jour le contenu d’un tableau mis en forme dans un magazine
mensuel. Vous pouvez pour cela utiliser un lien vers une feuille de calcul Excel. Toutefois, si le contenu
provient d’une autre source, vous pouvez copier le texte tabulé comportant le nouveau contenu,
sélectionner la plage de cellules dans le tableau InDesign mis en forme et coller le contenu.
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Ajout de texte à un tableau

Vous pouvez ajouter du texte, des objets ancrés, des balises XML ou d ’autres tableaux à des cellules. La
hauteur de ligne du tableau s’ajuste au texte supplémentaire, à moins que vous ne choisissiez une hauteur
fixe. Il n’est pas possible d’ajouter des notes de bas de page aux tableaux.

A l’aide de l’outil Texte , utilisez l’une des méthodes suivantes :

Placez un point d’insertion dans une cellule, puis saisissez le texte. Appuyez sur la
touche Entrée ou Retour pour créer un nouveau paragraphe dans la même cellule.
Appuyez sur la touche de tabulation pour passer d’une cellule à l’autre (si vous
appuyez sur cette touche alors que le curseur se trouve dans la dernière cellule, vous
insérez une nouvelle ligne). Appuyez sur les touches Maj+tabulation pour passer aux
cellules précédentes.

Copiez le texte, placez un point d’insertion dans une cellule, puis choisissez la
commande Edition > Coller.

Placez le point d’insertion dans la cellule où vous voulez insérer le texte, choisissez la
commande Fichier > Importer, puis cliquez deux fois sur un fichier texte.

Ajout de graphiques à un tableau

1. Placez le point d’insertion dans la cellule de tableau dans laquelle vous souhaitez ajouter
l’image.

2. Utilisez l’une des méthodes suivantes :

Choisissez Fichier > Importer, puis sélectionnez un ou plusieurs fichiers graphiques.
Sélectionnez et faites glisser un ou plusieurs graphiques de la catégorie Graphiques
dans le panneau Bibliothèques CC.

L’image ou les images sont disponibles sur le curseur d’importation.

3. Pour importer l’image ou les images, cliquez à l’intérieur de chaque cellule du tableau.

4. Utilisez l’une des méthodes suivantes :

vous ne pouvez pas glisser et déposer des extraits InDesign de la catégorie Graphiques dans
le panneau Bibliothèques CC.

Si les dimensions du graphique sont supérieures à celles de la cellule, la hauteur de celle-ci s’ajuste au
graphique tandis que sa largeur reste inchangée (le graphique risque de déborder à droite de la cellule). Si la
hauteur du graphique est supérieure à la hauteur fixe de la rangée à laquelle il est destiné, la cellule sera
composée par excès.

Pour empêcher toute cellule en excès, placez l’image en dehors du tableau, redimensionnez-la, puis
collez-la dans la cellule de tableau.

Vous pouvez également importer des images dans des cellules de tableau à l’aide des méthodes suivantes :

Sélectionnez Objet > Objet ancré > Insérer, puis spécifiez les paramètres. Vous pourrez
ensuite ajouter un graphique à l’objet ancré.
Copiez un graphique ou un bloc, placez le point d’insertion à l’endroit voulu, puis
choisissez Edition > Coller.



Ajout d’en-têtes et de pieds de tableau

Lorsque vous créez un long tableau, il peut être réparti sur plusieurs colonnes, blocs ou pages. Il est possible
d’utiliser des en-têtes ou des pieds de tableau pour répéter les informations du haut ou du bas de chaque
portion du tableau.

Vous pouvez ajouter des lignes d’en-tête ou de pied de tableau lors de la création du tableau. Vous pouvez
également utiliser la boîte de dialogue Options de tableau pour ajouter des lignes d’en-tête et de pied de
tableau et modifier leur aspect dans le tableau. Il est aussi possible de convertir des lignes de corps en lignes
d’en-tête ou de pied de tableau.

Ligne d’en-tête répétée une fois par bloc

Pour numéroter les tableaux de manière séquentielle, par exemple Tableau 1A, Tableau 1B, ajoutez une
variable à l’en-tête ou au pied de tableau. (Voir Création de légendes continues de figures et tableaux.)

Pour convertir des rangées existantes en rangées d’en-tête ou de pied de
tableau

1. Sélectionnez les lignes du haut du tableau pour créer des lignes d’en-tête ou celles du
bas du tableau pour créer des lignes de pied de tableau.

2. Choisissez Tableau > Convertir les lignes > En ligne d’en-tête ou En ligne de pied de
tableau.

Pour modifier les options de rangées d’en-tête ou de pied de tableau

1. Placez le point d’insertion dans le tableau et choisissez la commande Tableau > Options
de tableau > En-têtes et pieds de tableau.

2. Spécifiez le nombre de lignes d’en-tête ou de pied de tableau. Des lignes vierges
peuvent être ajoutées dans le haut ou dans le bas du tableau.

3. Indiquez si les informations contenues dans l’en-tête ou le pied de tableau doivent
apparaître dans toutes les colonnes de texte (si les blocs de texte ont plusieurs
colonnes), une fois par bloc ou une fois par page.

4. Sélectionnez Ignorer premier en-tête pour éviter que les informations d’en-tête
apparaissent dans la première ligne du tableau. Sélectionnez Ignorer dernier pied de
tableau pour éviter que les informations de pied de tableau apparaissent dans la dernière
ligne du tableau.

L’option Ignorer premier en-tête est particulièrement utile si vous souhaitez indiquer que
l’en-tête ou le pied de page se poursuit. Par exemple, dans le cas d’un tableau
s’étendant sur plusieurs pages, vous pouvez décider d’utiliser « Tableau 2 (Suite) »
comme texte de l’en-tête. Pour éviter que le mot « (Suite) » ne figure au début du
tableau, sélectionnez l’option Ignorer premier en-tête, puis saisissez simplement
Tableau 2 dans la première ligne du tableau.

5. Cliquez sur le bouton OK.

Utilisation des lignes et des colonnes
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Vous pouvez exécuter plusieurs fonctions pour créer des lignes et des colonnes similaires ou les dupliquer. 

Vous pouvez principalement exécuter les fonctions suivantes sur les lignes et les colonnes du tableau :

Glisser-déposer des lignes et des colonnes de tableaux, d’une position à une autre dans
un même tableau
Dupliquer des lignes et des colonnes
Coller des lignes et des colonnes avant ou après une autre ligne/colonne
Copier le contenu d’une ligne dans une colonne ou celui d’une colonne sur une ligne

Pour glisser-déposer et dupliquer des lignes/colonnes

Vous pouvez déplacer des lignes et des colonnes de tableaux, d’une position à une autre dans un même
tableau. Procédez comme suit pour glisser-déposer et dupliquer des lignes/colonnes.

1. Sélectionnez la ligne ou la colonne que vous souhaitez glisser-déposer vers une autre
ligne ou colonne. Assurez-vous que l’intégralité de la colonne ou de la ligne a été
sélectionnée. Vous ne pouvez pas faire glisser et déposer des lignes ou colonnes
partiellement sélectionnées.

2. Placez le pointeur de la souris au-dessus les lignes sélectionnées : un curseur unique
indiquant que la sélection peut être déplacée s’affiche.

3. Vous pouvez faire glisser et déposer la ligne des éléments. Vous pouvez permuter les
colonnes et les lignes. Vous pouvez uniquement faire glisser une ligne pour la déposer
sur une ligne et vous pouvez uniquement faire glisser une colonne pour la déposer sur
une colonne.

Glisser-déposer des lignes et des colonnes

Ici, le déplacement d’une ligne d’un emplacement à un autre permet de conserver le
nombre total de lignes d’origine, trois.

l’opération de glisser-déposer n’est possible qu’au sein du même tableau.

4. Pour dupliquer une ligne ou une colonne, appuyez sur la touche Alt (Windows) ou
Option (Mac) ou maintenez-la enfoncée après avoir sélectionné une ligne ou une
colonne. Vous pouvez glisser-déposer plusieurs lignes ou colonnes sélectionnées de
façon contiguë.

5. Faites glisser et déposez la ligne ou la colonne sélectionnée à l’endroit souhaité. Le
nombre total de lignes ou de colonnes augmente puisque l’entité sélectionnée a été
dupliquée.

Vous pouvez également copier le contenu des lignes d’en-tête et de pied de page dans
les lignes de corps (en appuyant sur la touche Alt/Option). De la même façon, les lignes
de corps peuvent également être dupliquées et converties en lignes d’en-tête et de pied
de page.

Vous pouvez uniquement faire glisser et déposer des lignes d’en-tête au sein d’une section d’en-tête
(applicable uniquement si vous disposez de plusieurs lignes d’en-tête) sauf si vous utilisez les touches
Alt/Option pour dupliquer les lignes. Vous ne pouvez pas faire glisser et déposer les lignes de corps dans la
section d’en-tête sauf si vous utilisez les touches Alt/Option pour dupliquer les lignes.

Pour copier des lignes/des colonnes et les coller avant/après
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Vous pouvez copier et coller des lignes avant ou après une ligne sélectionnée. Avec le flux de production
Coller avant/après, vous pouvez copier des lignes/des colonnes d’un tableau et les coller dans un autre
tableau.

1. Sélectionnez une ligne/une colonne.

2. Sélectionnez la ligne ou la colonne.

3. Sélectionnez Tableau > Coller avant/Coller après. 

Pour supprimer des rangées d’en-tête ou de pied de tableau

Utilisez l’une des méthodes suivantes :

Placez le point d’insertion dans la ligne d’en-tête ou de pied de tableau, puis
choisissez Tableau > Convertir les lignes > En ligne de corps.

Choisissez la commande Tableau > Options de tableau > En-têtes et pieds de
tableau, puis spécifiez un nombre différent de lignes d’en-tête ou de lignes de pied de
tableau.

Adobe recommande également
Mise en forme de tableaux
Importation de texte
Redimensionnement de colonnes, rangées et tableaux
Gestion des cellules en excès
Balisage d’éléments
Répartition de tableaux sur plusieurs blocs
Création de variables pour des en-têtes et des pieds de page continus

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
https://www.adobe.com/go/gffooter_online_privacy_policy_fr


Styles de tableau et de cellule
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About table and cell styles
Table/Cell Styles panels overview
Define table and cell styles
Load (import) table styles from other documents
Apply table and cell styles
Base one table or cell style on another
Edit table and cell styles
Delete table and cell styles
Redefine table or cell styles based on current formatting
Override table and cell styles
Break the link to table or cell styles

About table and cell styles

Just as you use text styles to format text, you can use table and cell styles to format tables. A table style is a collection of table formatting
attributes, such as table borders and row and column strokes, that can be applied in a single step. A cell style includes formatting such as cell
insets, paragraph styles, and strokes and fills. When you edit a style, all tables or cells to which the style is applied are updated automatically.

There is one important difference between text styles and table styles. While all character styles attributes can be part of a paragraph
style, cell style attributes are not part of the table style. For example, you cannot use a table style to change the border color of interior cells.
Instead, create a cell style and include it in the table style.

Styles [Tableau simple] et [Aucun]

By default, each new document contains a [Basic Table] style that can be applied to tables you create and a [None] style that can be used to
remove cell styles applied to cells. You can edit the [Basic Table] style, but you can’t rename or delete either [Basic Table] or [None].

Utilisation de styles de cellule dans les styles de tableau

When you create a table style, you can specify which cell styles are applied to different regions of the table: header and footer rows, left and right
columns, and body rows. For example, for the header row, you can assign a cell style that applies a paragraph style, and for the left and right
columns, you can assign different cell styles that apply shaded backgrounds.

Styles de cellule appliqués aux régions dans le style de tableau

A. Ligne d’en-tête mise en forme avec le style de cellule incluant le style de paragraphe B. Colonne gauche C. Cellules de corps D. Colonne
droite 



Cell style precedence

Table style precedence
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Attributs de style de cellule

Cell styles do not necessarily include all the formatting attributes of a selected cell. When you create a cell style, you can determine which
attributes are included. That way, applying the cell style changes only the desired attributes, such as cell fill color, and ignores all other cell
attributes.

Priorité des attributs de mise en forme dans les styles

If a conflict occurs in formatting applied to a table cell, the following order of precedence determines which formatting is used:

1. Header/Footer 2. Left column/Right column 3. Body rows. For example, if a cell appears in both the header and the left
column, the formatting from the header cell style is used.

1. Cell overrides 2. Cell style 3. Cell styles applied from a table style 4. Table overrides 5. Table styles. For example, if
you apply one fill using the Cell Options dialog box and another fill using the cell style, the fill from the Cell Options dialog box is used.

Table/Cell Styles panels overview

Use the Table Styles panel (Window > Styles >Table Styles) to create and name table styles, and to apply the styles to existing tables or tables
you create or import. Use the Cell Styles panel (Window > Styles > Cell Styles) to create and name cell styles, and to apply the styles to table
cells. Styles are saved with a document and appear in the panel each time you open that document. You can save table and cell styles in groups
for easier management.

When you position the insertion point in a cell or table, any style that is applied is highlighted in either of the panels. The name of any cell style
that is applied through a table style appears in the lower left corner of the Cell Styles area. If you select a range of cells that contains multiple
styles, no style is highlighted and the Cell Styles panel displays “(Mixed).”

Open the Table Styles or Cell Styles panel

Choisissez la commande Fenêtre > Styles, puis l’option Styles de tableau ou Styles de cellule.

Change how styles are listed in the panel

Sélectionnez Petites rangées de panneau pour afficher une version condensée des styles.
Faites glisser le style vers un autre emplacement. Vous pouvez également faire glisser les styles vers des groupes que vous
créez.
Dans le menu du panneau, choisissez Tri par nom pour répertorier les styles par ordre alphabétique.

Define table and cell styles

1. Si vous voulez créer un style à partir de la mise en forme d’une cellule ou d’un tableau existant, placez le point d’insertion
dans une cellule.

2. Le cas échéant, définissez un style de paragraphe pour le style de cellule.

3. Choisissez la commande Fenêtre > Styles > Styles de tableau pour ouvrir le panneau Styles de tableau, ou la
commande Fenêtre > Styles > Styles de cellule pour ouvrir le panneau Styles de cellule.

4. Choisissez Nouveau style de tableau dans le menu du panneau Styles de paragraphe ou Nouveau style de cellule dans le
menu du panneau Styles de cellule.

5. Dans Nom du style, saisissez un nom.
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6. Dans la liste D’après, sélectionnez le nom du style sur lequel repose le style actuel.

7. Pour ajouter un raccourci clavier, placez le point d’insertion dans la zone de texte Raccourci et assurez-vous que le
verrouillage numérique est activé. Maintenez une combinaison quelconque de touches Alt, Maj et Ctrl (Windows) ou Option,
Maj et Commande (Mac OS) enfoncée, et appuyez sur un chiffre du pavé numérique. Vous ne pouvez pas utiliser de lettres ni
de nombres hors du pavé numérique pour définir des raccourcis de style.

8. Pour définir les attributs de mise en forme, cliquez sur une catégorie à gauche, puis spécifiez les attributs souhaités. Par
exemple, pour assigner un style de paragraphe à un style de cellule, cliquez sur la catégorie Général, puis choisissez le style
de paragraphe dans le menu Style de paragraphe.

For cell styles, options that don’t have a setting specified are ignored in the style. If you don’t want a setting to be part of the
style, choose (Ignore) from the setting’s menu, delete the contents of the field, or click a check box until a small box appears
in Windows or a hyphen (-) appears in Mac OS.

9. Si vous voulez que le nouveau style apparaisse dans un groupe de style que vous avez créé, faites-le glisser vers le dossier
du groupe de style.

Load (import) table styles from other documents

You can import table and cell styles from another InDesign document into the active document. During import, you can determine which styles are
loaded and what should occur if a loaded style has the same name as a style in the current document. You can also import styles from an InCopy
document.

1. Dans le menu du panneau Styles de cellule ou Styles de tableau, choisissez Charger les styles de cellule, Charger les styles
de tableau ou Charger des styles de tableau et de cellule.

2. Cliquez deux fois dans le document InDesign contenant les styles que vous voulez importer.

3. Dans la boîte de dialogue Charger des styles, assurez-vous qu’une coche apparaît en regard des styles à importer. Si un
style existant porte le même nom qu’un des styles importés, sélectionnez l’une des options suivantes sous la rubrique Conflit
avec le style existant, puis cliquez sur OK :

Overwrites the existing style with the loaded style and applies its new attributes to all cells in
the current document that used the old style. The definitions of the incoming and existing styles appear at the bottom of the
Load Styles dialog box so you can compare them.

Renames the loaded style. For example, if both documents have a style named “Table Style 1,” the loaded
style is renamed “Table Style 1 copy” in the current document.

Apply table and cell styles

Unlike paragraph and character styles, table and cell styles do not share attributes, so applying a table style does not override cell formatting, and
applying a cell style does not override table formatting. By default, applying a cell style removes formatting applied by any previous cell style, but
does not remove local cell formatting. Similarly, applying a table style removes formatting applied by any previous table style, but does not remove
overrides made using the Table Options dialog box.

In the Styles panel, a plus sign (+) appears next to the current cell or table style if the selected cell or table has additional formatting that isn’t part
of the applied style. Such additional formatting is called an override.

1. Placez le point d’insertion dans un tableau ou sélectionnez les cellules auxquelles vous voulez appliquer le style.

2. Utilisez l’une des méthodes suivantes :

Cliquez sur le style de tableau ou de cellule dans le panneau Styles de tableau ou Styles de cellule (Fenêtre > Styles >
Styles de tableau ou Styles de cellule). Si le style fait partie d’un groupe de style, développez le groupe de style pour
localiser le style.

Appuyez sur la touche de raccourci que vous avez définie pour le style. Vérifiez que la touche Verr num est activée.
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Base one table or cell style on another

You can create links between similar table or cell styles by creating a base, or parent, style. When you edit the parent style, any changed attribute
that appears in the child styles will change as well. By default, table styles are based on [No Table Style], and cell styles are based on [None].

1. Créez un style.

2. Dans le menu déroulant D’après de la boîte de dialogue Nouveau style de tableau ou Nouveau style de cellule, sélectionnez
le style parent. Le nouveau style devient le style enfant.

3. Spécifiez la mise en forme pour le nouveau style pour le distinguer du style parent.

Edit table and cell styles

One of the advantages of using styles is that when you change the definition of a style, all of the tables or cells formatted with that style change to
match the new style definition.

1. Utilisez l’une des méthodes suivantes :

Pour ne pas appliquer le style à la cellule ou au tableau sélectionné, cliquez avec le bouton droit de la souris (Windows)
ou en maintenant la touche Contrôle enfoncée (Mac OS) sur le nom du style dans le panneau Styles, puis choisissez la
commande Modifier [nom de style].

Dans le panneau Styles, cliquez deux fois sur le style ou sélectionnez le style, puis choisissez Options de style dans le
menu du panneau Styles. Le style de cellule est alors appliqué à toutes les cellules sélectionnées, et le style de tableau à
tous les tableaux sélectionnés. Si aucun tableau n’est sélectionné, cliquez deux fois sur un style de tableau pour le définir
comme style par défaut de tout tableau que vous créez.

2. Modifiez les paramètres dans la boîte de dialogue, puis cliquez sur OK.

Delete table and cell styles

When you delete a style, you can select a different style to replace it, and you can choose whether to preserve the formatting.

1. Dans le panneau Styles, sélectionnez le style souhaité.

2. Utilisez l’une des méthodes suivantes :

Choisissez Supprimer le style dans le menu du panneau.

Cliquez sur l’icône de suppression 

Cliquez sur le style avec le bouton droit de la souris (Windows) ou en maintenant la touche Contrôle enfoncée (Mac OS),
puis choisissez Supprimer le style. Cette méthode est particulièrement utile pour supprimer un style sans l’appliquer à la
cellule ou au tableau sélectionné.

3. Sélectionnez le style à remplacer.

If you select [No Table Style] to replace a table style or [None] to replace a cell style, select Preserve Formatting to keep the
formatting of the table or cell to which the style is applied. The table or cell preserves its formatting but is no longer associated
with a style.

4. Cliquez sur le bouton OK.

Redefine table or cell styles based on current formatting

After you apply a style, you can override any of its settings. If you decide you like the changes, you can redefine the style to retain the new
formatting.
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1. Placez le point d’insertion dans le tableau (ou la cellule) mis en forme avec le style que vous voulez redéfinir.

2. Apportez vos modifications au tableau (ou à la cellule) comme vous le souhaitez.

3. Dans le menu du panneau Styles, choisissez Redéfinir le style.

For cell styles, changes to only those attributes that are part of the cell style will enable the Redefine Style command. For example, if
the cell style includes a red fill and you override a cell to use a blue fill, you can redefine the style based on that cell. But if you change an attribute
that is ignored in the cell style, you can’t redefine the style with that attribute.

Override table and cell styles

After you apply a table or cell style, you can override any of its settings. To override a table style, you can change options in the Table Options
dialog box. To override a cell, you can change options in the Cell Options dialog box or use other panels to change the stroke or fill. If you select a
table or cell that has an override, a plus sign (+) appears next to the style in the Styles panel.

You can clear table and cell overrides when you apply a style. You can also clear overrides from a table or cell to which a style has already been
applied.

If a style has a plus sign (+) next to it, hover over the style to view a description of the override attributes.

Preserve or remove overrides while applying a table style

Pour appliquer un style de tableau et préserver les styles de cellule, tout en supprimant les remplacements, maintenez la
touche Alt (Windows) ou Option (Mac OS) enfoncée lorsque vous cliquez sur le style dans le panneau Styles de tableau.
Pour appliquer un style de tableau et supprimer les styles de tableau ainsi que les remplacements, maintenez les
touches Alt+Maj (Windows) ou Option+Maj (Mac OS) enfoncées lorsque vous cliquez sur le style dans le panneau Styles de
tableau.

Right-click (Windows) or Control-click (Mac OS) the style in the Table Styles panel, and then choose Apply [table style], Clear Cell Styles to
apply a style and clear cell styles.

Remove overrides while applying a cell style

Pour appliquer un style de cellule et supprimer les remplacements, maintenez la touche Alt (Windows) ou Option (Mac OS)
enfoncée lorsque vous cliquez sur le nom du style dans le panneau Styles de cellule.

Only those attributes that are part of the cell style are considered overrides. For example, if the cell style includes
a red fill and all other attributes are ignored, changing a different cell option is not considered an override.

Clear attributes not defined by a cell style

Choisissez l’option Effacer les attributs non définis par le style dans le menu du panneau Styles de cellule.

Clear table or cell overrides

1. Sélectionnez le tableau ou les cellules contenant les remplacements.

2. Dans le panneau Styles, cliquez sur l’icône Effacer les remplacements dans la sélection  ou choisissez Effacer les
remplacements dans le menu du panneau Styles.

Break the link to table or cell styles

When you break the link between tables or cells and the style applied to them, the tables or cells retain their current formatting. However, future
changes to that style won’t affect them.
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1. Sélectionnez les cellules auxquelles le style a été appliqué.

2. Dans le menu du panneau Styles, choisissez Annuler le lien au style.

Adobe recommande également
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Sélection de cellules, de rangées et de colonnes
Insertion de rangées et de colonnes
Suppression de rangées, colonnes ou tableaux
Modification de l’alignement d’un tableau dans un bloc
Navigation dans un tableau
Coupage, copie et collage du contenu d’un tableau
Déplacement ou copie d’un tableau
Conversion de tableau en texte
Combinaison de tableaux
Utilisation des tableaux en mode éditeur

Sélection de cellules, de rangées et de colonnes
La sélection de l’ensemble ou d’une partie du texte d’une cellule présente le même aspect que du texte sélectionné en dehors d’un tableau. Si
toutefois cette sélection s’étend sur plusieurs cellules, les cellules et leur contenu sont sélectionnés.

Si un tableau s’étend sur plusieurs blocs et que vous placez le pointeur de la souris au-dessus d’une ligne d’en-tête ou de pied de tableau autre
que la première ligne d’en-tête ou de pied de tableau, une icône de verrou apparaît, indiquant que vous ne pouvez pas sélectionner le texte ou les
cellules de cette ligne. Pour sélectionner des cellules d’une ligne d’en-tête ou de pied de tableau, placez le pointeur au début du tableau.

Pour sélectionner des cellules
 A l’aide de l’outil Texte , utilisez l’une des méthodes suivantes :

Pour sélectionner une seule cellule, cliquez à l’intérieur d’une cellule ou sélectionnez le texte, puis choisissez la commande
Tableau > Sélectionner > Cellule.

Pour sélectionner plusieurs cellules, faites glisser le pointeur sur le bord de la cellule. Prenez garde à ne pas faire glisser le
trait délimitant la colonne ou la ligne, sans quoi vous risquez de redimensionner le tableau.

Pour basculer entre la sélection de tout le texte d’une cellule et la sélection de la cellule, appuyez sur la touche Echap.

Pour sélectionner des colonnes ou des rangées entières
 A l’aide de l’outil Texte , utilisez l’une des méthodes suivantes :

Cliquez à l’intérieur d’une cellule ou sélectionnez le texte, puis choisissez la commande Tableau > Sélectionner > Colonne
ou Ligne.

Placez le pointeur sur le bord supérieur d’une colonne ou le bord gauche d’une rangée pour qu’il se transforme en flèche (
ou ), puis cliquez pour sélectionner la totalité de la colonne ou de la rangée.

Avant et après la sélection d’une ligne

Pour sélectionner toutes les rangées d’en-tête, de corps ou de pied de tableau
1. Cliquez à l’intérieur d’un tableau ou sélectionnez le texte.
2. Choisissez Tableau > Sélectionner > Lignes d’en-tête, Lignes de corps ou Lignes de pied de tableau.

Pour sélectionner un tableau entier
 A l’aide de l’outil Texte , utilisez l’une des méthodes suivantes :

Cliquez à l’intérieur d’un tableau ou sélectionnez le texte, puis choisissez Tableau > Sélectionner > Tableau.
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Placez le pointeur sur l’angle supérieur gauche du tableau pour qu’il prenne la forme d’une flèche , puis cliquez pour
sélectionner la totalité du tableau.

Avant et après la sélection d’un tableau

Faites glisser l’outil Texte sur tout le tableau.

Vous pouvez sélectionner un tableau de la même manière qu’un graphique ancré. Pour cela, placez le point d’insertion juste avant ou après le
tableau, puis maintenez la touche Maj enfoncée tandis que vous appuyez respectivement sur la touche flèche droite ou flèche gauche pour
sélectionner le tableau.

Insertion de rangées et de colonnes
Il existe plusieurs méthodes pour insérer des rangées et des colonnes.

Pour insérer une rangée
1. Placez le point d’insertion dans la ligne située au-dessous ou au-dessus de l’emplacement auquel insérer la nouvelle ligne.
2. Choisissez Tableau > Insérer > Ligne.
3. Spécifiez le nombre de lignes à insérer.
4. Spécifiez l’emplacement de la ou des nouvelles lignes (au-dessus ou au-dessous de la ligne sélectionnée), puis cliquez

sur OK.

Les nouvelles cellules présentent la même mise en forme que le texte de la rangée dans laquelle figure le point d’insertion.

Vous pouvez également créer une nouvelle ligne en appuyant sur la touche de tabulation lorsque le point d’insertion figure dans la dernière
cellule.

Pour insérer une colonne
1. Placez le point d’insertion dans la colonne adjacente sur l’emplacement d’insertion de la nouvelle colonne.
2. Choisissez Tableau > Insérer > Colonne.
3. Spécifiez le nombre de colonnes à insérer.
4. Spécifiez l’emplacement de la ou des nouvelles colonnes (avant ou après la colonne sélectionnée), puis cliquez sur OK.

Les nouvelles cellules présentent la même mise en forme que le texte de la colonne dans laquelle figure le point d’insertion.

Pour insérer plusieurs rangées ou colonnes
1. Après avoir placé le point d’insertion à l’intérieur d’une cellule, choisissez la commande Tableau > Options de tableau >

Format de tableau.
2. Spécifiez un nombre différent de lignes et de colonnes, puis cliquez sur OK.

Les nouvelles lignes sont insérées au bas du tableau et les colonnes à droite du tableau.

Vous pouvez également modifier le nombre de rangées et de colonnes dans le panneau Tableau. Pour afficher le panneau Tableau, choisissez
Fenêtre > Texte et tableaux > Tableau.

Pour insérer une rangée ou une colonne par glissement
Lors de l’insertion de colonnes, si vous faites glisser une colonne sur une distance supérieure à une fois et demi sa largeur, les nouvelles
colonnes ont la même largeur que la colonne d’origine. Si vous faites glisser pour insérer une seule colonne, la largeur de celle-ci peut être
inférieure ou supérieure à celle de la colonne à partir de laquelle vous effectuez le glissement. Il en est de même pour les lignes, à moins que la
hauteur de la ligne que vous faites glisser soit définie sur la valeur Au moins. Dans ce cas, si vous faites glisser pour créer une seule ligne,
InDesign ajuste la nouvelle ligne, s’il y a lieu, afin qu’elle puisse contenir le texte.

1. Placez l’outil Texte  sur le bord d’une colonne ou d’une rangée jusqu’à ce qu’une double flèche (  ou ) apparaisse.
2. Maintenez le bouton de la souris et la touche Alt (Windows) ou Option (Mac OS) enfoncés, tout en faisant glisser le pointeur

vers le bas ou vers la droite, pour créer respectivement une nouvelle ligne ou une nouvelle colonne. Si vous appuyez sur la
touche Alt ou Option avant de maintenir le bouton de la souris enfoncé, l’outil Main apparaît. Veillez donc à faire glisser avant
d’appuyer sur cette touche.

Remarque : les bords supérieur et gauche d’un tableau ne se prêtent pas à l’insertion de lignes ou de colonnes par glissement. Ces champs
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servent à sélectionner des lignes ou des colonnes.

Suppression de rangées, colonnes ou tableaux
Pour supprimer une ligne, une colonne ou un tableau, placez le point d’insertion à l’intérieur du tableau ou sélectionnez le texte
dans le tableau, puis choisissez Tableau > Supprimer > Ligne, Colonne ou Tableau.
Pour supprimer des lignes et des colonnes à l’aide de la boîte de dialogue Options de tableau, choisissez Tableau > Options
de tableau > Format de tableau. Spécifiez un nombre différent de lignes et de colonnes, puis cliquez sur OK. Les lignes sont
supprimées au bas du tableau et les colonnes à droite du tableau.
Pour supprimer une rangée ou une colonne à l’aide de la souris, positionnez le pointeur sur le bord inférieur ou droit du
tableau jusqu’à ce qu’une double flèche (  ou ) apparaisse, maintenez le bouton de la souris enfoncé, puis la
touche Alt (Windows) ou Option (Mac OS) tout en faisant glisser le pointeur vers le haut pour supprimer des rangées, ou vers
la gauche pour supprimer des colonnes.
Remarque : si vous appuyez sur la touche Alt ou Option avant de maintenir le bouton de la souris enfoncé, l’outil Main
apparaît. Veillez donc à appuyer sur cette touche avant de commencer à faire glisser.
Pour supprimer le contenu d’une cellule sans supprimer les cellules, sélectionnez les cellules contenant le texte à supprimer ou
utilisez l’outil Texte  pour sélectionner le texte dans les cellules. Appuyez sur la touche Retour arrière ou Suppr, ou
choisissez Edition > Effacer.

Modification de l’alignement d’un tableau dans un bloc
Un tableau s’adapte à la largeur du paragraphe ou de la cellule dans lequel il est créé. Vous pouvez toutefois redimensionner le bloc de texte ou le
tableau de sorte que celui-ci soit plus large ou plus étroit que le bloc. Le cas échéant, vous pouvez définir l’alignement du tableau à l’intérieur du
bloc.

1. Placez le point d’insertion à droite ou à gauche du tableau. Assurez-vous que le point d’insertion du texte est placé sur le
paragraphe du tableau et non à l’intérieur du tableau, pour qu’il adapte la hauteur du tableau dans le bloc.

2. Cliquez sur un bouton d’alignement (par exemple le bouton Centrer) du panneau Paragraphe ou Contrôle.

Navigation dans un tableau
Vous pouvez vous déplacer dans un tableau à l’aide de la touche Tabulation ou des touches de direction. Vous pouvez également atteindre une
rangée spécifique d’un tableau, ce qui est particulièrement utile dans les tableaux longs.

Pour se déplacer dans un tableau à l’aide de la touche Tabulation
Appuyez sur la touche de tabulation pour passer à la cellule suivante. Si vous appuyez sur cette touche alors que le point
d’insertion est placé dans la dernière cellule du tableau, vous créez une nouvelle ligne. Pour plus de détails sur l’insertion de
tabulations et de retraits dans un tableau, reportez-vous à la section Mise en forme de texte dans un tableau.
Appuyez sur les touches Maj+tabulation pour passer à la cellule précédente. Si vous appuyez sur ces touches depuis la
première cellule du tableau, le point d’insertion s’affiche dans la dernière cellule du tableau.

Pour se déplacer dans un tableau à l’aide des touches de direction
 Appuyez sur les touches de direction pour vous déplacer à l’intérieur des cellules du tableau ou d’une cellule à l’autre. Si vous appuyez sur la

touche flèche droite alors que le point d’insertion est placé à la fin de la dernière cellule d’une ligne, celui-ci s’affiche au début de la première
cellule de cette même ligne. De la même manière, si vous appuyez sur la touche flèche bas alors que le point d’insertion est placé à la fin de la
dernière cellule d’une colonne, celui-ci se déplace au début de la première cellule de cette même colonne.

Pour atteindre une rangée spécifique d’un tableau
1. Choisissez Tableau > Atteindre la ligne.
2. Utilisez l’une des méthodes suivantes :

Spécifiez le numéro de la ligne vers laquelle se déplacer, puis cliquez sur OK.

Si une ligne d’en-tête ou de pied de tableau est définie dans le tableau sélectionné, choisissez En-tête ou Pied de tableau
dans le menu et cliquez sur OK.

Coupage, copie et collage du contenu d’un tableau
Lorsque le texte d’une cellule est sélectionné, les opérations couper, copier et coller fonctionnent de la même manière que pour un texte
sélectionné en dehors d’un tableau. Vous pouvez également couper, copier et coller les cellules et leur contenu. Si le point d’insertion figure dans
un tableau lorsque vous collez, plusieurs cellules collées forment un tableau à l’intérieur d’un tableau. Vous pouvez aussi déplacer ou copier le
tableau entier.
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1. Sélectionnez les cellules à couper ou copier, puis choisissez Edition > Couper ou Copier.
2. Utilisez l’une des méthodes suivantes :

Pour imbriquer un tableau dans un autre, placez le point d’insertion dans la cellule qui recevra le tableau, puis choisissez
Edition > Coller.

Pour remplacer des cellules, sélectionnez-en une ou plusieurs dans le tableau, en veillant à ce qu’un nombre suffisant de
cellules figurent au-dessous et à droite des cellules sélectionnées, puis choisissez Edition > Coller.

Déplacement ou copie d’un tableau
1. Pour sélectionner le tableau entier, placez le point d’insertion à l’intérieur du tableau, puis choisissez Tableau > Sélectionner >

Tableau.
2. Choisissez Edition > Couper ou Copier, déplacez le point d’insertion vers l’endroit où vous voulez afficher le tableau, puis

choisissez Edition > Coller.

Conversion de tableau en texte
1. A l’aide de l’outil Texte , placez le point d’insertion à l’intérieur du tableau ou sélectionnez le texte du tableau.
2. Choisissez la commande Tableau > Convertir le tableau en texte.
3. Dans Séparateur de colonnes et Séparateur de lignes, spécifiez les séparateurs à utiliser, puis cliquez sur OK.

Pour optimiser vos résultats, utilisez un séparateur différent pour les colonnes et les lignes, par exemple des tabulations pour
les colonnes et des sauts de paragraphe pour les lignes.

4. Cliquez sur le bouton OK.

Lorsque vous convertissez un tableau en texte, l’application supprime les rangées du tableau et insère le séparateur spécifié à la fin de chaque
rangée et de chaque colonne.

Combinaison de tableaux
Utilisez la commande Coller pour fusionner deux ou plusieurs tableaux en un seul.

1. Dans le tableau cible, insérez au moins autant de lignes que vous en collerez depuis les autres tableaux (si vous insérez
moins de lignes que vous n’en copiez, vous ne pourrez pas les coller).

2. Dans le tableau source, sélectionnez les cellules que vous voulez copier (si vous copiez plus de cellules de colonnes que le
nombre de cellules disponibles dans le tableau cible, vous ne pourrez pas les copier).

3. Sélectionnez au moins une cellule à l’endroit où vous voulez insérer les nouvelles lignes, puis choisissez Edition > Coller.

Si les lignes collées utilisent une mise en forme différente du reste du tableau, définissez un ou plusieurs styles de cellules, puis appliquez les
styles de cellule aux cellules collées. Tout en maintenant la touche Alt (Windows) ou Option (Mac OS) enfoncée, cliquez sur le style de cellule
pour remplacer la mise en forme existante.

L’article Joining Tables d’Anne-Marie Concepcion aborde le thème de la combinaison de tableaux.

Utilisation des tableaux en mode éditeur
Lorsque vous choisissez la commande Edition > Modifier en mode éditeur, les tableaux et leur contenu s’affichent en mode éditeur. Vous avez
alors la possibilité de les modifier.

http://indesignsecrets.com/joining-tables.php


 

Modification de tableaux en mode éditeur
A.  Icône de tableau C.  Graphique en excès

Pour développer ou réduire le tableau en mode éditeur, cliquez sur le triangle visible en haut, à gauche de l’icône de tableau.

Pour indiquer si le tableau doit être trié par rangées ou colonnes, cliquez sur l’icône de tableau avec le bouton droit de la
souris (Windows) ou en maintenant la touche Contrôle enfoncée (Mac OS), puis choisissez la commande Disposition par
rangées ou Disposition par colonnes.

Utilisez le mode Mise en page pour modifier le tableau et procéder à sa mise en forme. Il est impossible de sélectionner les
colonnes ou les rangées en mode éditeur.

Voir aussi
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A propos des contours et du fond des tableaux
Modification de la bordure d’un tableau
Application d’un contour et d’un fond à des cellules
Ajout de diagonales à une cellule
Options de contour et de fond de tableau
Contours et fonds alternés dans un tableau

A propos des contours et du fond des tableaux
Il existe plusieurs façons d’ajouter des contours et un fond aux tableaux. Utilisez la boîte de dialogue Options de tableau pour modifier le contour
de la bordure d’un tableau et ajouter des fonds et des contours alternés aux colonnes et aux lignes. La boîte de dialogue Options de cellule ou les
panneaux Nuancier, Contour et Couleur sont à votre disposition pour modifier le contour et le fond de cellules individuelles ou de cellules d’en-
têtes et de pieds de tableau.

Par défaut, la mise en forme définie dans la boîte de dialogue Options de tableau prévaut sur toute mise en forme précédemment appliquée aux
cellules du tableau. Si toutefois vous sélectionnez l’option Conserver la mise en forme locale dans la boîte de dialogue Options de tableau, les
contours et les fonds appliqués individuellement aux cellules sont conservés.

Pour appliquer la même mise en forme à plusieurs tableaux ou cellules, vous pouvez créer et appliquer des styles de tableau et de cellule.

Modification de la bordure d’un tableau
Vous pouvez modifier la bordure d’un tableau au moyen de la boîte de dialogue Format de tableau ou du panneau Contour.

1. Après avoir placé le point d’insertion à l’intérieur d’une cellule, choisissez la commande Tableau > Options de tableau >
Format de tableau.

2. Dans la section Bordure du tableau, spécifiez les paramètres d’épaisseur, de type, de couleur, de teinte et d’espace (voir la
section Options de contour et de fond de tableau).

3. Dans l’option Ordre de dessin des contours, sélectionnez l’un des ordres de tracé suivants :
Meilleurs sommets Cette option permet d’afficher les contours des lignes au premier plan là où les contours de différentes
couleurs se croisent. En outre, lorsque des contours tels que des doubles lignes se croisent, ils sont joints et les points de
croisement sont raccordés.

Contours de ligne au premier plan Cette option permet de faire apparaître les contours de ligne au premier plan.

Contours de colonne au premier plan Cette option permet de faire apparaître les contours de colonne au premier plan.

Compatibilité avec InDesign 2.0 Cette option permet de faire apparaître les contours de ligne au premier plan. En outre,
lorsque des contours tels que des doubles lignes se croisent, ils sont joints et les points de croisement sont raccordés
uniquement là où les contours se croisent en T.

4. Si vous souhaitez conserver la mise en forme individuelle des cellules, sélectionnez Conserver la mise en forme locale.
5. Cliquez sur le bouton OK.

Si vous supprimez le contour et le fond d’un tableau, choisissez la commande Affichage > Extras > Afficher les contours du bloc pour afficher
les délimitations des cellules du tableau.

Application d’un contour et d’un fond à des cellules
La boîte de dialogue Options de cellules ainsi que les panneaux Contour ou Nuancier vous permettent d’appliquer un contour et un fond à des
cellules.

Pour appliquer un contour et un fond à l’aide de la boîte de dialogue Options de cellules
Déterminez les lignes de cellules à mettre en forme avec un contour ou un fond en sélectionnant ou en désélectionnant des lignes dans la zone
d’aperçu. Pour modifier l’aspect de toutes les lignes ou colonnes du tableau, utilisez une alternance de motifs de contours ou de fonds en
choisissant 0 pour le second motif.

1. A l’aide de l’outil Texte , placez le point d’insertion sur la ou les cellules concernées ou sélectionnez-les. Pour appliquer un
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contour ou un fond à des rangées d’en-tête ou de pied de tableau, sélectionnez les cellules correspondantes au début du
tableau.

2. Choisissez la commande Tableau > Options de cellule > Contours et fonds.
3. Dans la zone d’aperçu, spécifiez les lignes sur lesquelles les modifications de contour doivent porter. Si, par exemple, vous

voulez ajouter un contour épais aux lignes extérieures (mais pas intérieures) des cellules sélectionnées, cliquez sur une ligne
intérieure pour la désélectionner (les lignes sélectionnées sont bleues et les lignes désélectionnées sont grises).

Sélectionnez les lignes concernées dans la zone d’aperçu de doublure.

Dans la zone d’aperçu, cliquez deux fois sur une ligne extérieure pour sélectionner le rectangle de sélection extérieur en
entier. Cliquez deux fois sur une ligne intérieure pour les sélectionner toutes. Cliquez trois fois n’importe où dans la zone
d’aperçu pour sélectionner ou désélectionner des lignes.

4. Dans la section Contour de cellule, spécifiez les paramètres d’épaisseur, de type, de couleur, de teinte et d’espacement (voir
la section Options de contour et de fond de tableau).

5. Dans la section Fond de cellule, spécifiez la couleur et la teinte qui vous conviennent.
6. S’il y a lieu, sélectionnez Surimpression du contour et Surimpression du fond, puis cliquez sur OK.

Pour appliquer un contour à des cellules à l’aide du panneau Contour
1. Sélectionnez la ou les cellules appropriées. Pour appliquer un contour à des cellules d’en-tête ou de pied de tableau,

sélectionnez la rangée correspondante.
2. Choisissez Fenêtre > Contour pour afficher le panneau Contour.
3. Dans la zone d’aperçu, spécifiez les lignes sur lesquelles les modifications de contour doivent porter.
4. Dans le panneau Outils, assurez-vous que le bouton Objet  est sélectionné. Si le bouton Texte  est sélectionné, les

modifications du contour agiront sur le texte et non sur les cellules.
5. Spécifiez une épaisseur et un type de contour.

Pour appliquer un fond à des cellules à l’aide du panneau Nuancier
1. Sélectionnez la ou les cellules appropriées. Pour appliquer un fond à des cellules d’en-tête ou de pied de tableau,

sélectionnez la rangée correspondante.
2. Choisissez la commande Fenêtre > Couleur > Nuancier pour afficher le panneau Nuancier.
3. Assurez-vous que le bouton Objet  est sélectionné. Si le bouton Texte  est sélectionné, les modifications du contour agiront

sur le texte et non sur les cellules.
4. Sélectionnez une nuance.

Pour appliquer un dégradé à des cellules à l’aide du panneau Dégradé
1. Sélectionnez les cellules que vous souhaitez mettre en forme. Pour appliquer un dégradé à des cellules d’en-tête ou de pied

de tableau, sélectionnez la rangée correspondante.
2. Choisissez la commande Fenêtre > Couleur > Dégradé pour afficher le panneau Dégradé.
3. Cliquez sur Gamme des dégradés pour appliquer un dégradé aux cellules sélectionnées. Ajustez les paramètres de dégradé

si besoin.

Ajout de diagonales à une cellule
1. A l’aide de l’outil Texte , placez le point d’insertion sur la ou les cellules dans lesquelles vous souhaitez ajouter des traits

diagonaux, ou sélectionnez-les.
2. Choisissez Tableau > Options de cellules > Traits diagonaux.
3. Cliquez sur le bouton correspondant au type de diagonale à ajouter.
4. Dans la section Contour, spécifiez les paramètres d’épaisseur, de type, de couleur et d’espacement ; spécifiez un pourcentage

de teinte ainsi que les options de surimpression.
5. Dans le menu Tracer, choisissez l’option Diagonales au premier plan pour placer toute ligne diagonale devant le contenu de

la cellule ; choisissez la commande Contenu au premier plan pour placer toute ligne diagonale derrière le contenu de la
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cellule, puis cliquez sur le bouton OK.

Options de contour et de fond de tableau
Lors de la sélection de contours et de fonds pour un tableau ou des cellules, vous avez le choix parmi les options suivantes :

Epaisseur Définit l’épaisseur du tracé de la bordure de la cellule ou du tableau.
Type Indique le style de tracé, par exemple Epais - Fin.
Couleur Définit la couleur du tracé de la bordure de la cellule ou du tableau. Les options répertoriées sont identiques à celles du
panneau Nuancier.
Teinte Indique le coefficient d’encre de la couleur spécifiée à appliquer au contour ou au fond.
Couleur d’espace Applique une couleur aux espaces entre les tirets, les pointillés ou les lignes. Cette option n’est pas disponible si le type
Continu est sélectionné.
Teinte d’espace Applique une teinte aux espaces entre les tirets, les pointillés ou les lignes. Cette option n’est pas disponible si le type Continu
est sélectionné.
Surimpression L’encre spécifiée dans le menu déroulant Couleur est appliquée par-dessus toutes les couleurs sous-jacentes ; ces encres ne
sont donc pas masquées.

Contours et fonds alternés dans un tableau
Vous pouvez alterner les contours et les fonds pour rendre un tableau plus lisible ou améliorer son aspect. Les contours et les fonds alternés des
lignes de tableau n’ont pas d’incidence sur les lignes d’en-tête et de pied de tableau. L’application de contours et de fonds alternés à des colonnes
affecte néanmoins les lignes d’en-tête et de pied de tableau.

Les paramètres de contour et de fond alternés prévalent sur la mise en forme du contour des cellules, à moins que vous ne sélectionniez l’option
Conserver la mise en forme locale dans la boîte de dialogue Options de tableau.

Si vous souhaitez appliquer un fond ou un contour à chaque cellule de corps du tableau et non pas seulement aux motifs alternés, vous pouvez
quand même utiliser les paramètres de contour et de fond alternés pour créer des motifs non alternés. Pour créer un tel effet, spécifiez 0 pour
Suivante.

Avant (à gauche) et après (à droite) l’application des fonds alternés dans un tableau

Pour ajouter des contours alternés à un tableau
1. Après avoir placé le point d’insertion à l’intérieur d’une cellule, choisissez la commande Tableau > Options de tableau >

Contours de ligne en alternance ou Contours de colonne en alternance.
2. Dans le menu Motif en alternance, sélectionnez le type de motif à utiliser. Sélectionnez Ligne personnalisée ou Colonne

personnalisée pour spécifier un motif, par exemple une colonne avec un trait noir épais suivie de trois colonnes avec des
traits fins jaunes.

3. Dans la section En alternance, spécifiez les options de fond pour le premier motif ainsi que le suivant. Vous pouvez ainsi
ajouter un contour plein à la première colonne, puis un trait Epais - Fin à la colonne suivante de sorte qu’ils soient alternés.
Spécifiez 0 pour Suivant afin que les contours affectent toutes les lignes et colonnes.
Remarque : dans les tableaux répartis sur plusieurs blocs, les contours et les fonds alternés des lignes ne reprennent pas au
début des blocs supplémentaires de l’article (voir la section Répartition de tableaux sur plusieurs blocs).

4. Sélectionnez Conserver la mise en forme locale si vous souhaitez conserver les contours mis en forme précédemment
appliqués au tableau.

5. Pour les options Ignorer la/les première(s) et Ignorer la/les dernière(s), spécifiez le nombre de lignes ou de colonnes au début
et à la fin du tableau auxquelles vous ne souhaitez pas appliquer les attributs de contour, puis cliquez sur OK.

Pour ajouter des fonds alternés à un tableau
1. Après avoir placé le point d’insertion à l’intérieur d’une cellule, choisissez la commande Tableau > Options de tableau > Fonds

en alternance.
2. Dans le menu Motif en alternance, sélectionnez le type de motif à utiliser. Sélectionnez Ligne personnalisée ou Colonne

personnalisée pour spécifier un motif, par exemple, une ligne estompée en gris suivie de trois lignes ombrées en jaune.
3. Dans la section En alternance, spécifiez les options de fond pour le premier motif ainsi que le suivant. Si, par exemple, vous

avez sélectionné le motif en alternance Toutes les deux colonnes, vous pouvez ombrer les deux premières colonnes en
niveaux de gris et laisser les deux colonnes suivantes en noir. Spécifiez 0 pour Suivant afin que le fond affecte toutes les



 

lignes.
4. Sélectionnez Conserver la mise en forme locale si vous souhaitez conserver les fonds mis en forme précédemment appliqués

au tableau.
5. Pour les options Ignorer la/les première(s) et Ignorer la/les dernière(s), spécifiez le nombre de lignes ou de colonnes au début

et à la fin du tableau auxquelles vous ne souhaitez pas appliquer les attributs de contour, puis cliquez sur OK.

Pour désactiver les contours et fonds alternés d’un tableau
1. Placez le point d’insertion dans le tableau.
2. Choisissez Tableau > Options de tableau > Contours de ligne en alternance, Contours de colonne en alternance ou Fonds en

alternance.
3. Dans le menu Motif en alternance, choisissez Aucun, puis cliquez sur OK.

Voir aussi
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Interactivité

Création et modification des mouvements prédéfinis) (vidéo 05:23)
Anne-Marie Concepcion  (01er janvier 2011)
Didacticiel - vidéo
Découvrez comment modifier et personnaliser des paramètres prédéfinis de trajectoire, qui permettent d’animer les images ou le texte dans
InDesign.

Création de références croisées (vidéo 5:45), CS4-CS6
David Blatner  (01er janvier 2011)
Didacticiel - vidéo
Procédure détaillée d’ajout de références croisées. Créez des références croisées, qui peuvent être mises à jour rapidement en cas de
changement du texte cible ou de la pagination. Créez un format personnalisé de référence croisée.

Création de documents interactifs (vidéo 08:06)
Anne-Marie Concepcion  (01er janvier 2011)
Didacticiel - vidéo
Découvrez comment utiliser le panneau Multimédia, le panneau Aperçu et le panneau Minutage pour déterminer ce qui se passe et à quel
moment.

Création de documents interactifs dans une zone de magnétisme (PDF, 201 Ko)
Référence  (01er janvier 2011)
Un didacticiel pratique sur la manière d’ajouter de l’interactivité à vos documents.

Création d’objets à états multiples (PDF, 203 Ko)
Référence  (01er janvier 2011)
Ce court didacticiel vous montre comment créer des objets à états multiples pour rendre vos documents plus interactifs.

Création de documents interactifs riches (PDF, 6,7 Mo)
Référence  (01er janvier 2011)
Apprenez à créer des documents interactifs riches avec InDesign.

Exploration des nouvelles options d’exportation FLA (vidéo 06:26)
Anne-Marie Concepcion  (01er janvier 2011)
Didacticiel - vidéo
Découvrez comment publier votre projet InDesign dans une grande variété de formats Flash à l’aide de la boîte de dialogue d’exportation
améliorée dans InDesign CS5 et les versions ultérieures.

http://www.adobe.com/go/lrvid5159_id_fr
http://tv.adobe.com/watch/learn-indesign-cs4/creating-crossreferences/
http://www.adobe.com/go/lrvid5152_id_fr
http://www.adobe.com/support/indesign/gettingstarted/pdfs/indesign_dyk_b_interactive.pdf
http://www.adobe.com/support/indesign/gettingstarted/pdfs/indesign_howto_f_mso.pdf
http://www.adobe.com/support/indesign/gettingstarted/pdfs/indesign_rid_whitepaper.pdf
http://www.adobe.com/go/lrvid5154_id_fr
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Flux de production de formulaires

Vous pouvez concevoir des formulaires dans InDesign et les exporter directement au format PDF. InDesign prend désormais en charge les
champs de formulaire et des actions supplémentaires liées aux formulaires. La bibliothèque Boutons et formulaires (Fenêtre > Objet interactif >
Boutons et formulaires) contient des éléments que vous pouvez utiliser pour concevoir des formulaires interactifs.

InDesign permet de créer des formulaires simples dans InDesign, sans avoir à retoucher le document PDF dans Acrobat après publication. Vous
pouvez ajouter des éléments de formulaire simples dans les pages du document. Les types de champ courants tels que les zones de texte, les
cases d’option, les cases à cocher ou les signatures sont pris en charge. Vous pouvez également ajouter des actions permettant d’imprimer le
formulaire ou de l’envoyer par e-mail.

Après avoir défini les éléments de base du formulaire, vous pouvez tirer parti des fonctions de créativité d’InDesign pour ajouter une touche
personnelle à votre formulaire.

Ajoutez des contours unis et des fonds aux champs de formulaire PDF.
Ajoutez les états Activé, Désactivé et Survol pour les boutons, des cases à cocher et des cases d’option.
Définissez la taille de police utilisée pour les champs de saisie de texte.

Par exemple, pour recueillir les informations relatives à une carte de crédit, vous pouvez utiliser les icônes de carte de crédit sous forme de cases
d’option, en prévoyant une image différente pour l’état sélectionné.

Pour les flux de production de formulaire avancés, vous avez la possibilité d’exporter le formulaire de base et de poursuivre l’édition dans Adobe
Acrobat.

Ajout d’un champ de formulaire

Utilisez le panneau Boutons et formulaires pour ajouter des champs de formulaire à la mise en page. Les procédures à suivre pour ajouter des
champs de formulaire interactifs sont les mêmes que pour ajouter des boutons. Vous pouvez créer un formulaire exploitable avec Adobe Reader
ou Adobe Acrobat. InDesign permet de concevoir des formulaires originaux impossibles à obtenir avec Acrobat.

Panneau Boutons et formulaires
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1. Placez un bloc à l’endroit où vous souhaitez insérer le champ de formulaire.
2. Ouvrez le panneau Boutons et formulaires (Fenêtre > Objet interactif > Boutons et formulaires).
3. Sélectionnez le cadre et choisissez un type d’élément de formulaire dans la liste Type. Vous pouvez également cliquer avec le

bouton droit de la souris sur un cadre et choisir Objet interactif > Convertir en [...].
4. Donnez un nom au champ de formulaire. Pour créer un groupe de cases d’option, veillez à ce qu’elles aient toutes le même

nom.
5. Sélectionnez un événement et ajoutez les actions que vous souhaitez lui associer. Les actions, telles que Effacer le

formulaire, Imprimer le formulaire et Soumettre le formulaire ont été ajoutées. Dans l’action Soumettre le formulaire, spécifiez
l’URL sous la forme mailto:xyz@example.com.

6. Dans le cas d’une case d’option, d’une case à cocher ou de boutons : définissez les attributs d’aspect pour les différents états.
InDesign ajoute des graphiques par défaut pour les différents états, mais vous êtes libre d’ajouter vos propres graphiques.

7. Spécifiez les options PDF :
Description - la valeur entrée est affichée sous forme d’info-bulle et sert à créer des formulaires accessibles.
Valeur de bouton : cette valeur correspond à la valeur d’exportation dans Acrobat et peut également être utilisé pour
identifier une case d’option d’un groupe dans un formulaire accessible. 

Définition de l’ordre des tabulations

Pour créer des formulaires conviviaux et simples à compléter, il est nécessaire de définir l’ordre des tabulations. Les utilisateurs pourront ainsi
passer facilement d’un champ à l’autre sans avoir besoin de dispositif de pointage. Une simple pression sur la touche Tabulation permet d’activer
le champ logique suivant.

Il existe deux méthodes pour définir l’ordre des tabulations dans un document PDF balisé :

Utilisez le panneau Articles (Fenêtre > Articles) pour spécifier un ordre des tabulations personnalisé.
Choisissez Objet > Objet interactif > Définir l’ordre des tabulations.

Définition de l’ordre des tabulations au moyen du panneau Articles

Utilisation du panneau Articles pour spécifier l’ordre des tabulations

1. Ouvrez le panneau Articles (Fenêtre > Articles).

2. Faites glisser les champs de formulaire vers le panneau Articles.

3. Dans le panneau Articles, réorganisez les champs dans l’ordre approprié en les faisant glisser.

Pour que les lecteurs d’écran respectent l’ordre spécifié, activez l’option Utiliser pour l’ordre de lecture dans les PDF balisés dans le menu du
panneau Articles. N’oubliez pas d’activer l’option Créer un PDF balisé lors de l’exportation du fichier PDF.

Définition de l’ordre des tabulations au moyen de la structure

1. Choisissez Objet > Objet interactif > Définir l’ordre des tabulations.
2. Cliquez sur Déplacer vers le haut ou Déplacer vers le bas pour réorganiser les éléments selon l’ordre des tabulations

souhaité.

Lors de l’exportation au format PDF interactif, activez l’option Utiliser la structure pour l’ordre des tabulations dans la boîte de dialogue Exportation



  Les publications Twitter™ et Facebook ne sont pas couvertes par les dispositions Creative Commons.

Mentions légales   |   Politique de confidentialité en ligne

PDF.

Voir aussi

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr


Hyperliens

Haut de la page

Remarque :

Présentation du panneau Hyperliens
Création d’hyperliens
Gestion des hyperliens
Modification des hyperliens importés depuis Word

Présentation du panneau Hyperliens

Vous pouvez créer des hyperliens dans un document de sorte que, une fois le document exporté au format Adobe PDF ou SWF dans InDesign,
les utilisateurs puissent cliquer sur ces liens pour accéder directement à d’autres emplacements du document, à d’autres documents PDF ou à des
sites Web. Les hyperliens exportés au format PDF ou SWF dans InCopy ne sont pas actifs.

La source est un texte, bloc de texte ou bloc graphique lié à la cible. La cible correspond à l’adresse URL, au fichier, à l’adresse de courrier
électronique, à l’ancre de texte de la page ou à la destination partagée, accessible grâce à l’hyperlien. La source ne peut avoir qu’une seule cible,
mais plusieurs sources peuvent accéder à la même cible.

La source est un texte ou une image lié(e) à la cible. La cible correspond à l’adresse URL, au fichier, à l’adresse de courrier électronique, à la
page, à l’ancre de texte ou à la destination partagée, accessible grâce à l’hyperlien. La source ne peut avoir qu’une seule cible, mais plusieurs
sources peuvent accéder à la même cible.

si vous souhaitez générer le texte source à partir du texte cible, insérez une référence croisée au lieu d’un hyperlien (voir
Références croisées).

Panneau Hyperliens

A. Liste d’hyperliens dans le document actif B. Icônes de type « feux de circulation » indiquant instantanément la disponibilité d’une URL C. Lien
vers l’adresse électronique D. Numéro de page cliquable qui renvoie vers la page contenant le lien et le sélectionne 

Pour ouvrir le panneau Hyperliens

http://idiom-q-win-1/fr/indesign/using/cross-references.html#cross_references
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Choisissez la commande Fenêtre > Objet interactif > Hyperliens.

Pour trier les hyperliens dans le panneau Hyperliens

Choisissez la commande Tri dans le menu du panneau Hyperliens, puis sélectionnez l’une des options suivantes :

Affiche les hyperliens en respectant l’ordre dans lequel ils ont été ajoutés au document.

Affiche les hyperliens dans l’ordre alphabétique.

Affiche les hyperliens en les regroupant selon leur type.

Pour afficher les hyperliens par petites rangées

Choisissez la commande Petites rangées de panneau dans le menu du panneau Hyperliens.

Création d’hyperliens

Vous pouvez créer des hyperliens renvoyant à des pages, des adresses URL, des ancres de texte, des adresses de courrier électronique et des
fichiers. Si vous prévoyez des hyperliens pour accéder à des pages ou ancres de texte d’un autre document, vous devez veiller à ce que les
fichiers exportés figurent dans le même dossier.

Pour afficher ou masquer les hyperliens, choisissez Affichage > Extras > Afficher les hyperliens ou Masquer les hyperliens.

pour inclure les hyperliens dans les fichiers Adobe PDF exportés, vous devez sélectionner l’option Hyperliens dans la boîte de
dialogue Exporter au format Adobe PDF dans InDesign. De même, pour faire figurer les hyperliens dans les fichiers SWF exportés, vous devez
sélectionner l’option Inclure les hyperliens dans la boîte de dialogue Exporter au format SWF.

Pour créer un hyperlien vers une page Web (URL)

Il existe plusieurs méthodes pour créer des hyperliens renvoyant à des adresses URL. Pour spécifier ces adresses, vous pouvez utiliser tous les
protocoles de ressources Internet valides : http://, file://, ftp:// ou mailto://.

Vous avez également la possibilité de faire appel à la fonction Boutons pour créer des liens vers des pages Web (voir Boutons).

Dans InDesign CC, le style Hyperlien est automatiquement appliqué aux hyperliens (texte en bleu souligné).

1. Cliquez avec le bouton droit de la souris sur le texte, le bloc ou le graphique sélectionné, puis sélectionnez Hyperliens >
Nouvel hyperlien. La boîte de dialogue Nouvel hyperlien s’affiche.

http://idiom-q-win-1/fr/indesign/using/interactivity-5.html#create_buttons


Remarque :

2. Spécifiez une URL cible appropriée :

Saisissez ou collez l’URL dans la zone correspondante (par exemple, http://www.adobe.com). Assurez-vous que l’option
URL est sélectionnée dans le menu déroulant Liens vers.

-OU-

Sélectionnez une adresse URL ajoutée antérieurement dans le menu déroulant URL. Le nouvel hyperlien a le même
aspect que l’adresse URL utilisée pour le créer.

3. Cliquez sur OK.

si l’hyperlien d’une adresse URL ne fonctionne pas dans le fichier PDF exporté, le problème peut être dû au fait que cet hyperlien
est défini en tant que « destination partagée ». Décochez la case Cible d’hyperlien partagée, puis cliquez sur OK.

Pour créer un hyperlien vers un fichier

Lorsque vous créez un hyperlien renvoyant à un fichier, il suffit de cliquer sur ce lien dans le fichier PDF ou SWF exporté pour ouvrir le fichier
cible dans son application d’origine, par exemple Microsoft Word pour les fichiers .doc.

Veillez à ce que le fichier spécifié soit accessible à tous les utilisateurs qui ouvriront le fichier PDF ou SWF que vous exportez. Si, par exemple,
vous envoyez le fichier PDF exporté à un collaborateur, spécifiez un fichier cible situé sur un serveur partagé et non sur votre disque dur.

1. Sélectionnez le texte, le bloc ou le graphique que vous voulez désigner comme source de l’hyperlien.

2. Choisissez la commande Nouvel hyperlien dans le menu du panneau Hyperliens ou cliquez sur le bouton Créer un nouvel
hyperlien situé au bas du panneau.

3. Dans la boîte de dialogue Nouvel hyperlien, choisissez l’option Fichier dans le menu Lien vers.

4. Pour définir l’option Chemin, saisissez le chemin d’accès ou cliquez sur le bouton de dossier pour rechercher le fichier, puis
cliquez deux fois sur son nom.

5. Sélectionnez l’option Cible d’hyperlien partagée pour stocker le fichier dans le panneau Hyperliens, en vue de le réutiliser.

6. Définissez les options d’aspect de la source de l’hyperlien, puis cliquez sur le bouton OK.

Pour créer un hyperlien vers un message électronique

1. Sélectionnez le texte, le bloc ou le graphique que vous voulez désigner comme source de l’hyperlien.

2. Choisissez la commande Nouvel hyperlien dans le menu du panneau Hyperliens ou cliquez sur le bouton Créer un nouvel
hyperlien situé au bas du panneau.

3. Dans la boîte de dialogue Nouvel hyperlien, choisissez l’option Courrier électronique dans le menu Lien vers.

4. Dans la zone de texte Adresse, saisissez l’adresse de courrier électronique, par exemple utilisateur@société.com.

5. Dans la zone Objet, saisissez le texte correspondant à l’objet du message de courrier électronique.

6. Sélectionnez l’option Cible d’hyperlien partagée pour stocker le message électronique dans le panneau Hyperliens, en vue de
le réutiliser.

7. Définissez les options d’aspect de la source de l’hyperlien, puis cliquez sur le bouton OK.

Pour créer un hyperlien vers une page

Vous pouvez créer un hyperlien vers une page sans créer préalablement la cible. Si toutefois vous créez cette cible, vous avez la possibilité de
spécifier un numéro de page et un paramètre d’affichage.

1. Sélectionnez le texte, le bloc ou le graphique que vous voulez désigner comme source de l’hyperlien.

2. Choisissez la commande Nouvel hyperlien dans le menu du panneau Hyperliens ou cliquez sur le bouton Créer un nouvel
hyperlien situé au bas du panneau.



3. Dans la boîte de dialogue Nouvel hyperlien, choisissez l’option Page dans le menu Lien vers.

4. Pour l’option Document, sélectionnez le document contenant la cible à laquelle vous voulez accéder. Tous les documents
ouverts qui ont été enregistrés sont répertoriés dans le menu déroulant. Si le document que vous recherchez n’est pas ouvert,
sélectionnez Parcourir dans le menu déroulant, recherchez le fichier, puis cliquez sur Ouvrir.

5. Indiquez le numéro de la page cible dans le champ Page.

6. Pour l’option Zoom, utilisez l’une des méthodes suivantes pour sélectionner l’état d’affichage de la page cible :

Sélectionnez l’option Fixe pour afficher la page au facteur d’affichage et à la position d’origine au moment de la création
du lien.

Sélectionnez l’option Vue entière pour afficher la partie visible de la page actuelle comme cible.

Sélectionnez l’option Taille écran pour afficher la page actuelle dans la fenêtre cible.

Sélectionnez Pleine largeur ou Page entière pour afficher la largeur ou la hauteur de la page active dans la fenêtre cible.

Sélectionnez l’option Contenu pour afficher la page de sorte que le texte et les graphiques qu’elle contient remplissent la
largeur de l’écran. En général, les marges ne s’affichent pas dans cette vue.

Sélectionnez l’option Hériter du zoom pour ouvrir la fenêtre cible au facteur d’affichage utilisé par le lecteur lorsqu’il clique
sur l’hyperlien.

7. Définissez les options d’aspect, puis cliquez sur le bouton OK.

Pour créer une cible d’hyperlien

La création d’une cible d’hyperlien est justifiée uniquement si vous définissez un hyperlien ou une référence croisée renvoyant à une ancre de
texte. Cette dernière peut faire référence à du texte sélectionné ou à l’emplacement du point d’insertion. Vous créez ensuite l’hyperlien ou la
référence croisée pointant vers la cible choisie. Vous pouvez également définir des cibles d’hyperliens pour des pages ou des adresses URL, bien
que ce ne soit pas indispensable pour ces liens.

Les cibles d’hyperlien que vous avez créées ne figurent pas dans le panneau Hyperliens. En revanche, elles sont affichées dans la boîte de
dialogue qui apparaît lors de la création ou de la modification des hyperliens.

1. Si vous créez une ancre de texte, servez-vous de l’outil Texte pour placer le point d’insertion dans le document ou
sélectionnez la plage de texte que vous voulez définir comme point d’ancrage.

Vous ne pouvez pas définir un texte sur un gabarit comme ancre cible.

2. Choisissez la commande Nouvelle cible d’hyperlien dans le menu du panneau Hyperliens.

3. Choisissez la commande Ancre de texte dans le menu Type. Spécifiez un nom pour l’ancre de texte, puis cliquez sur le
bouton OK.

4. Utilisez l’une des méthodes suivantes, puis cliquez sur le bouton OK :

Choisissez la commande Ancre de texte dans le menu Type. Spécifiez le nom de l’ancre de texte.

Choisissez la commande Page dans le menu Type. Spécifiez le numéro de la page à laquelle vous voulez accéder, ainsi
que le zoom. Saisissez un nom pour la page ou sélectionnez l’option Nom avec numéro de page pour attribuer
automatiquement un nom à la cible, en fonction du numéro de page et du zoom spécifiés.

Choisissez la commande URL dans le menu Type. Saisissez ou collez l’URL, par exemple, http://www.adobe.fr. Vous
pouvez utiliser tout protocole de ressources Internet valide : http://, file://, ftp:// ou mailto://.

Pour créer un hyperlien vers une ancre de texte

1. Sélectionnez le texte, le bloc ou le graphique que vous voulez désigner comme source de l’hyperlien.

2. Choisissez la commande Nouvel hyperlien dans le menu du panneau Hyperliens ou cliquez sur le bouton Créer un nouvel
hyperlien situé au bas du panneau.

3. Choisissez la commande Ancre de texte dans le menu Lien vers.

4. Pour l’option Document, sélectionnez le document contenant la cible à laquelle vous voulez accéder. Tous les documents
ouverts qui ont été enregistrés sont répertoriés dans le menu déroulant. Si le document que vous recherchez n’est pas ouvert,
sélectionnez Parcourir dans le menu déroulant, recherchez le fichier, puis cliquez sur Ouvrir.



Style de caractère

Style de caractère appliqué aux liens de texte

Le style de caractère est ajouté à la liste des styles de caractères du
document. Le style est imprimé et exporté.

Repère visuel appliqué aux liens d’objet

Une ligne pointillée est appliquée autour des objets liés. Il s’agit d’un
repère visuel uniquement qui n’est pas imprimé ni exporté.

Type

Sélecteur

Couleur

5. Dans le menu Ancre de texte, choisissez l’ancre cible que vous avez créée.

6. Définissez les options d’aspect de l’hyperlien, puis cliquez sur le bouton OK.

Pour créer un hyperlien vers une cible partagée

Lors de la création d’un hyperlien, si vous choisissez la commande Destination partagée dans le menu Lien vers, vous pouvez spécifier une cible
nommée quelconque. Pour nommer une cible, il suffit de saisir une adresse URL dans la zone de texte correspondante ou de sélectionner l’option
Cible d’hyperlien partagée lors de la création d’un hyperlien renvoyant à une adresse URL, un fichier ou une adresse de courrier électronique.

1. Sélectionnez le texte, le bloc ou le graphique que vous voulez désigner comme source de l’hyperlien.

2. Choisissez la commande Nouvel hyperlien dans le menu du panneau Hyperliens ou cliquez sur le bouton Créer un nouvel
hyperlien situé au bas du panneau.

3. Dans la boîte de dialogue Nouvel hyperlien, choisissez l’option Destination partagée dans le menu Lien vers.

4. Pour l’option Document, sélectionnez le document contenant la cible à laquelle vous voulez accéder. Tous les documents
ouverts qui ont été enregistrés sont répertoriés dans le menu déroulant. Si le document que vous recherchez n’est pas ouvert,
sélectionnez Parcourir dans le menu déroulant, recherchez le fichier, puis cliquez sur Ouvrir.

5. Sélectionnez une cible dans le menu Nom.

6. Définissez les options d’aspect de l’hyperlien, puis cliquez sur le bouton OK.

Options d’aspect des hyperliens

Les options décrites dans cette section permettent de définir l’aspect d’un hyperlien ou de la source d’une référence croisée dans le fichier exporté
au format PDF ou SWF. Ces options sont également visibles dans le document InDesign si vous choisissez la commande Affichage > Extras >
Afficher les hyperliens.

Choisissez un style de caractère à appliquer à la source de l’hyperlien.  Par défaut, InDesign applique le style Hyperlien au
texte ou à l’objet sélectionné. Vous pouvez facilement sélectionner un autre style de texte dans le menu déroulant Style disponible dans la boîte
de dialogue Nouvel hyperlien. Pour les objets non textuels, InDesign applique un repère visuel sur les liens : une ligne pointillée autour de l’objet,
de la couleur du calque.

Choisissez l’une des deux options proposées : Rectangle visible et Rectangle invisible.

Les options disponibles sont les suivantes : Inverser, Contour, Marge et Sans. Ces options permettent de définir l’aspect de l’hyperlien
lorsque l’utilisateur clique dessus dans le fichier PDF ou SWF.

Sélectionnez la couleur du rectangle visible de l’hyperlien.
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Remarque :

Définissez l’épaisseur du filet du rectangle de l’hyperlien à l’aide de l’une des options suivantes : Fin, Moyen ou Epais.

Sélectionnez l’option Continu ou Tirets pour définir l’aspect du rectangle de l’hyperlien.

Conversion d’adresses URL en hyperliens

Vous pouvez rechercher des adresses URL du type « www.adobe.com » dans un document et les convertir en hyperliens.

1. Choisissez la commande Convertir les URL en hyperliens dans le menu du panneau Hyperliens.

2. Définissez l’option Etendue pour indiquer si vous voulez convertir les adresses URL dans l’ensemble du document ou dans
l’article ou la sélection en cours.

3. Au besoin, sélectionnez le style de caractère à appliquer à l’hyperlien dans le menu Style de caractère.

4. Utilisez l’une des méthodes suivantes, puis cliquez sur le bouton Terminer.

Cliquez sur le bouton Rechercher pour trouver l’adresse URL suivante.

Cliquez sur le bouton Convertir pour convertir l’adresse URL active en hyperlien.

Cliquez sur le bouton Tout convertir pour convertir toutes les adresses URL en hyperliens.

Gestion des hyperliens

Utilisez le panneau Hyperliens pour modifier, supprimer, réinitialiser ou rechercher les hyperliens. Dans InCopy, vous pouvez gérer les hyperliens
uniquement si vous avez extrait l’article en vue de le modifier.

Pour modifier des hyperliens

1. Cliquez avec le bouton droit de la souris sur le texte ou l’objet lié, puis sélectionnez Hyperliens > Modifier l’hyperlien.

-OU-

Dans le panneau Hyperliens, cliquez deux fois sur l’élément à modifier.

2. Dans la boîte de dialogue Modifier les hyperliens, effectuez toutes les corrections nécessaires, puis cliquez sur le bouton OK.

pour modifier un hyperlien renvoyant à une adresse URL, sélectionnez-le, corrigez l’adresse URL dans la zone de texte
correspondante, et appuyez sur la touche Tab ou Entrée.

Pour supprimer des hyperliens

Lorsque vous supprimez un hyperlien, le texte ou le graphique source est conservé.

Sélectionnez les éléments à supprimer dans le panneau Hyperliens, puis cliquez sur le bouton Supprimer situé au bas du
panneau.

Pour renommer une source d’hyperlien

Si vous renommez la source d’un hyperlien, vous changez également la façon dont elle apparaît dans le panneau Hyperliens.

1. Dans le panneau Hyperliens, sélectionnez l’hyperlien qui vous intéresse.

2. Choisissez la commande Renommer l’hyperlien dans le menu du panneau Hyperliens, puis spécifiez un nouveau nom.

Pour modifier ou supprimer des cibles d’hyperliens



  Les publications Twitter™ et Facebook ne sont pas couvertes par les dispositions Creative Commons.

Mentions légales   |   Politique de confidentialité en ligne

Haut de la page

1. Ouvrez le document dans lequel apparaît la cible.

2. Choisissez Options de cible d’hyperlien dans le menu du panneau Hyperliens.

3. Pour l’option Destination, sélectionnez le nom de la destination à modifier.

4. Utilisez l’une des méthodes suivantes :

Cliquez sur Modifier et apportez les modifications nécessaires à la cible.

Cliquez sur Supprimer pour supprimer la cible.

5. Une fois la modification ou suppression terminée, cliquez sur le bouton OK.

Pour réinitialiser ou mettre à jour des hyperliens

1. Sélectionnez la plage de texte, le bloc de texte ou le bloc graphique que vous voulez définir comme nouvelle source
d’hyperlien. Vous pouvez, par exemple, sélectionner du texte supplémentaire à inclure dans la source.

2. Sélectionnez l’hyperlien dans le panneau Hyperliens.

3. Utilisez l’une des méthodes suivantes :

Choisissez Réinitialiser l’hyperlien dans le menu du panneau Hyperliens.

Pour mettre à jour un hyperlien pointant vers un document externe, choisissez Mettre à jour l’hyperlien dans le menu du
panneau Hyperliens.

Pour accéder à la source ou au point d’ancrage d’un hyperlien

Pour rechercher la source d’un hyperlien ou d’une référence croisée, sélectionnez l’élément à repérer dans le
panneau Hyperliens. Choisissez Accéder à la source dans le menu du panneau Hyperliens. Le texte ou le bloc est sélectionné.
Pour rechercher la cible d’un hyperlien ou d’une référence croisée, sélectionnez l’élément à repérer dans le
panneau Hyperliens. Choisissez la commande Accéder à la cible dans le menu du panneau Hyperliens.

Si la cible est une adresse URL, InDesign lance ou active votre navigateur Web pour l’afficher. Si l’élément est un ancrage de texte ou une page
cible, InDesign accède à cet emplacement.

Modification des hyperliens importés depuis Word

Lorsque vous importez un document Microsoft Word avec hyperliens dans un document InDesign, vous remarquerez peut-être un cadre ou une
bordure autour des adresses URL d’hyperlien (par exemple, www.adobe.fr). Le document InDesign hérite d’une nuance bleue nommée
« Word_R0_G0_B255 », ainsi que d’un style de caractère appelé « Hyperlien » qui permet de souligner le texte et de lui appliquer la couleur bleu.

Pour supprimer la bordure, cliquez deux fois sur l’hyperlien dans le panneau Hyperliens. Dans la section Aspect, choisissez la
commande Rectangle invisible dans le menu Type, puis cliquez sur le bouton OK.

Vous pouvez également décider de supprimer la nuance importée. Au cours de cette opération, vous avez la possibilité de la remplacer par une
autre nuance (voir Suppression de nuances individuelles).

Avant d’importer le document Word dans InDesign, vous pouvez supprimer les hyperliens des adresses URL contenues dans ce document
pour ne pas hériter de cette mise en forme (voir la documentation Word). Une autre possibilité consiste à créer un style de caractère nommé
« Hyperlien » dans le document InDesign avant de procéder à l’importation. Lorsque vous importez le document Word, le style InDesign de
même nom est utilisé par défaut.

Adobe recommande également

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr
http://idiom-q-win-1/fr/indesign/using/swatches.html#delete_individual_swatches
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Création de boutons
Ajout d’effets interactifs aux boutons
Modification de l’état d’un bouton au survol et sur un clic de la souris
Création d’objets à états multiples
Création de zones sensibles sur les boutons
Définition de l’ordre de sélection des boutons à l’aide de la touche de tabulation

Création de boutons

Vous pouvez créer des boutons permettant d’effectuer certaines opérations une fois le document exporté au format EPUB, PDF ou SWF à mise en
page fixe. Il peut s’agir, par exemple, d’un bouton pour accéder à une autre page ou à un site Web.

Bouton pour lire une séquence vidéo dans le fichier PDF exporté

Après avoir créé des boutons, vous pouvez :

Les rendre interactifs au moyen du panneau Boutons. Lorsqu’un utilisateur clique sur un bouton dans le fichier exporté EPUB,
PDF ou SWF à mise en page fixe, une action est exécutée. Voir la section Ajout d’effets interactifs aux boutons.

Précisez, dans la section Aspect du panneau Boutons, l’aspect que doivent avoir les boutons en fonction des actions
effectuées avec la souris. Voir la section Modification de l’état d’un bouton au survol et sur un clic de la souris.

Créez un objet à états multiples au moyen du panneau Etats d’objet. Voir la section Création d’objets à états multiples.

Créez une « zone sensible » ou « lien actif » permettant d’afficher une image lorsque l’utilisateur pointe ou clique sur le
bouton. Voir la section Création de zones sensibles sur les boutons.

Lorsque vous créez ou modifiez des boutons et concevez des documents dynamiques, sélectionnez l’espace de travail Interactivité.

Création d’un bouton

1. Servez-vous de l’outil Plume ou d’un outil de dessin (par exemple, Rectangle ou Ellipse) pour tracer la forme du bouton. Si
nécessaire, ajoutez du texte sur le bouton (par exemple, « Suivant » ou « Acheter ») à l’aide de l’outil Texte.

Pour éviter d’avoir à recréer sur chaque page les boutons de navigation qui doivent être visibles sur plusieurs pages du
document (tels les boutons Page suivante et Page précédente), ajoutez-les au gabarit. Ces boutons apparaîtront alors sur
toutes les pages de document auxquelles vous avez appliqué ce gabarit.

2. A l’aide de l’outil Sélection, vous pouvez sélectionner l’image, la forme ou le bloc de texte à convertir,

mais pas une séquence vidéo ou audio ni une affiche.

3. Cliquez sur l’icône Convertir l’objet en bouton  du panneau Boutons (Fenêtre > Objet interactif > Boutons). Vous pouvez
également choisir la commande Objet > Objet interactif > Convertir en bouton.
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4. Dans le panneau Boutons, utilisez l’une des méthodes suivantes :

Saisissez le nom du bouton dans la zone de texte correspondante, afin de le distinguer des autres boutons.

Spécifiez une ou plusieurs actions pour le bouton, autrement dit les événements qui doivent se produire lorsque
l’utilisateur clique sur le bouton dans le fichier exporté EPUB, PDF ou SWF à mise en page fixe. Voir la rubrique Ajout
d’effets interactifs aux boutons.

Activez d’autres états et changez leur aspect pour définir l’aspect du bouton lorsque l’utilisateur passe la souris sur celui-ci
ou clique dessus dans le fichier exporté EPUB, PDF ou SWF à mise en page fixe. Voir la rubrique Modification de l’état
d’un bouton au survol et sur un clic de la souris.

5. Utilisez le panneau Aperçu (Fenêtre > Interactif > Aperçu de l’interactivité EPUB/aperçu SWF) pour tester le bouton avant
d’exporter le document vers un fichier EPUB, PDF ou SWF à mise en page fixe interactive.

Ajout d’un bouton à partir du panneau Boutons exemples

Le panneau Boutons exemples propose plusieurs boutons prédéfinis que vous pouvez faire glisser vers votre document. Ces boutons comportent
des effets, tels que le contour progressif dégradé et l’ombre portée, et présentent un aspect légèrement différent pour l’aspect Survol. Des actions
sont également affectées à ces exemples de boutons, notamment Atteindre la page suivante et Atteindre la page précédente pour les boutons
contenant des flèches. Vous pouvez modifier ces boutons à votre convenance.

Le panneau Boutons exemples est une bibliothèque d’objets. Vous pouvez ainsi y ajouter d’autres boutons et supprimer ceux dont vous n’avez
pas besoin. (Voir Utilisation des bibliothèques d’objets.) Les exemples de bouton sont stockés dans le fichier ButtonLibrary.indl, situé dans le
dossier Presets/Button Library du dossier de l’application InDesign.

1. Pour afficher le panneau Boutons exemples, choisissez la commande éponyme dans le menu du panneau Boutons.

2. Faites glisser l’un des boutons du panneau Boutons exemples vers le document. Si vous voulez que les boutons de navigation
soient visibles sur chacune des pages, ajoutez-les à un gabarit.

3. Sélectionnez le bouton à l’aide de l’outil Sélection, puis modifiez-le à votre guise à l’aide du panneau Boutons.

Lorsque vous modifiez un exemple de bouton, tenez compte des points suivants :

Si vous ajoutez du texte à un bouton, pensez à copier et coller ce texte de l’état Normal à l’état Survol. En effet, si vous
omettez de le faire, le texte ajouté ne s’affiche pas lorsque l'utilisateur survole le bouton avec le pointeur de la souris dans le
fichier EPUB, PDF ou SWF à mise en page fixe.

Vous pouvez modifier les dimensions des boutons. Si vous faites glisser deux boutons fléchés (page suivante/précédente),
redimensionnez le premier bouton, sélectionnez ensuite le second bouton, puis choisissez la commande Objet > Répéter la
transformation > Répéter la transformation.

Utilisez le panneau Aperçu pour tester le bouton.

Conversion d’un bouton en objet

Lorsque vous convertissez un bouton en objet, son contenu reste sur la page, mais sans les propriétés du bouton. Tout contenu associé aux
autres états du bouton est également supprimé.

1. Sélectionnez le bouton souhaité à l’aide de l’outil Sélection .

2. Choisissez la commande Objet > Objet interactif > Convertir en objet.

Ajout d’effets interactifs aux boutons

InDesign vous permet de créer, de modifier et de gérer des effets interactifs. Ces actions interactives deviennent actives lorsque le document est
exporté dans un fichier EPUB, PDF ou SWF à mise en page fixe.

Supposons à titre d’exemple que vous devez créer un bouton pour lire une séquence audio dans un document PDF. Vous devez d’abord importer

http://help.adobe.com/fr_FR/InDesign/CS5/Using/WSB563B522-0E6F-4a26-A5C5-97E84AC9377Ca.html
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Relâché

le fichier son dans le document InDesign, puis créer le bouton qui déclenchera la lecture de la séquence audio lorsque vous cliquerez dessus dans
le document PDF.

Dans cet exemple, le fait de cliquer avec le bouton de la souris correspond à l’événement, et la lecture de la séquence audio correspond à
l’action.

Ce bouton est configuré pour lancer une séquence audio après relâchement du bouton de la souris.

certaines actions sont prises en charge à la fois dans les fichiers PDF et SWF/EPUB ; d’autres ne le sont que dans un format ou
dans l’autre. Lorsque vous sélectionnez une action, évitez de choisir une action uniquement compatible avec le format PDF si vous exportez au
format SWF ou EPUB à mise en page fixe. Evitez également de sélectionner une action uniquement compatible avec le format SWF/EPUB
uniquement si vous exportez au format PDF.

Ajout d’actions aux boutons

Vous pouvez associer des actions à divers événements. Par exemple, vous pouvez faire en sorte qu’une séquence audio dans un fichier PDF
exporté démarre lorsque le pointeur de la souris se trouve dans la zone du bouton ou encore qu’une séquence vidéo soit activée après un clic
suivi du relâchement du bouton de la souris. Vous pouvez également associer plusieurs actions à un même événement. Ainsi, vous pouvez faire
en sorte qu’un événement entraîne la lecture d’une séquence vidéo et l’affiche dans sa taille réelle.

1. A l’aide de l’outil Sélection , sélectionnez le bouton que vous avez créé.

2. Dans le panneau Boutons, choisissez l’événement (par exemple, Relâché) qui détermine le mode d’activation des actions.

3. Cliquez sur le bouton contenant le signe plus  situé à côté de la section Scripts d’action, puis choisissez l’action à associer à
l’événement.

4. Définissez les divers paramètres de l’action.

Si, par exemple, vous choisissez l’action Atteindre la première page, vous devez préciser le niveau de zoom. De même, pour
l’action Atteindre l’URL, vous devez spécifier l’adresse de la page Web. En revanche, certaines actions (par exemple,
Atteindre la vue suivante) ne comportent aucun paramètre supplémentaire.

5. Continuez à ajouter les actions de votre choix aux divers événements.

Pour tester le bouton, exportez le document au format EPUB, PDF ou SWF à mise en page fixe, puis examinez le fichier exporté. Si vous optez
pour le format PDF, veillez à bien sélectionner l’option Eléments interactifs. En revanche, dans le cas du format SWF, pensez à sélectionner
l’option Inclure les boutons.

Types d’événements

Les événements déterminent la manière dont les actions de bouton sont activées dans un document exporté au format EPUB, PDF ou SWF. Dans
Acrobat, les événements sont désignés par le terme déclencheurs.

Déclenche l’action lorsque l’utilisateur relâche le bouton de la souris après avoir cliqué. Cet événement est le plus utilisé pour sa
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Atteindre la vue suivante (format PDF)

flexibilité, car il laisse à l’utilisateur la possibilité de retirer le pointeur du bouton sans déclencher l’action.

Déclenche l’action dès que l’utilisateur clique à l’aide du bouton de la souris (sans le relâcher). A moins d’avoir une raison particulière
d’utiliser cet événement, il est préférable de choisir l’événement Relâché qui permet à l’utilisateur d’annuler l’action.

Déclenche l’action dès que le pointeur entre dans la zone du bouton définie par le cadre de sélection.

Déclenche l’action dès que le pointeur de la souris est déplacé hors de la zone du bouton.

Déclenche l’action lors de la sélection du bouton au moyen de la souris ou de la touche de tabulation dans le fichier PDF.

Déclenche l’action lors de la sélection d’un autre bouton ou champ de formulaire dans le fichier PDF.

Types d’actions

La création d’une action consiste à spécifier l’opération que doit déclencher un événement donné (le plus courant étant l’utilisateur qui clique sur le
bouton). Il est possible de sélectionner parmi les actions suivantes celle qui doit se déclencher lorsque l’événement se produit :

Affiche le point d’ancrage de texte défini, créé à l’aide du panneau Signets ou Hyperliens Voir la rubrique Création de liens
vers des ancres de texte.

Affiche la première ou la dernière page ou encore la page
suivante ou précédente du fichier EPUB, PDF ou SWF à mise en page fixe. Sélectionnez le mode d’affichage de la page dans le menu Zoom.

Ouvre la page Web correspondant à l’URL définie.

Affiche ou masque alternativement les boutons spécifiés dans le fichier exporté au format EPUB, PDF ou SWF à
mise en page fixe. Par exemple, pour qu’un bouton s’affiche lorsque le pointeur se trouve sur un autre bouton, vous pouvez masquer le bouton
cible jusqu’à ce qu’il soit activé et créer une action permettant d’afficher le bouton masqué au survol. Voir la section Affichage d’un autre bouton au
survol.

Lance, suspend, arrête ou redémarre la séquence vidéo sélectionnée. Seules les séquences incluses dans le document sont visibles dans
le menu Vidéo.

Lance, suspend, arrête ou redémarre la séquence audio sélectionnée. Seules les séquences incluses dans le document sont visibles dans le
menu Son.

Lance, suspend, arrête ou redémarre l’animation sélectionnée. Seules les animations incluses dans le document sont
visibles dans le menu Animation.

Affiche la page du fichier SWF que vous avez spécifiée.

Affiche un état particulier de l’objet lorsqu’il en comporte plusieurs. Par exemple, si un objet à états multiples est
associé à diverses images représentant un état distinct, vous pouvez utiliser cette action pour afficher une image spécifique.

Affichent l’état suivant ou précédent d’un objet à états multiples. Ces options sont
particulièrement utiles pour parcourir un diaporama. Voir la section Création d’objets à états multiples.

Affiche une autre page après consultation d’une vue précédente. Tout comme le bouton Suivant d’un
navigateur Web n’est disponible qu’après sélection du bouton Précédent, cette option ne peut être utilisée tant que l’utilisateur n’a pas consulté
une vue précédente.
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Permet d’atteindre la dernière page visualisée dans le document PDF ou de rétablir le dernier niveau
de zoom utilisé.

Ouvre le fichier défini. Si ce dernier n’est pas au format PDF, il convient de disposer de l’application native pour
que l’opération aboutisse. Définissez le chemin d’accès complet (c:\docs\document.pdf, par exemple).

Affiche la page en fonction de l’option de zoom choisie. Vous pouvez modifier le niveau de zoom de la page
(Taille réelle, par exemple), la mise en page (Continu - Pages en vis à vis, etc.) ou l’orientation de la rotation.

Modification ou suppression des actions de bouton

1. Sélectionnez le bouton souhaité à l’aide de l’outil Sélection .

2. Dans le panneau Boutons, utilisez l’une des méthodes suivantes :

Désélectionnez la case à cocher correspondant aux actions à désactiver. Cette opération peut se révéler utile dans le
cadre de tests.

Pour modifier l’ordre, faites glisser les actions vers les positions désirées.

Pour supprimer une action, sélectionnez-la dans la zone de liste, puis cliquez sur le bouton Supprimer le script d’action
sélectionné .

Pour modifier une action, choisissez l’événement auquel elle est affectée, sélectionnez l’action dans la zone de liste, puis
changez les paramètres la concernant. Pour remplacer l’action associée à un événement existant, supprimez-la, puis
ajoutez la nouvelle action nécessaire à l’événement.

Création de liens vers des ancres de texte

Si vous créez un point d’ancrage de texte dans un document InDesign, vous pouvez utiliser un bouton pour atteindre ce point d’ancrage, même
s’il se trouve dans un autre document InDesign. Utilisez les panneaux Signets et Hyperliens pour ajouter des points d’ancrage de texte. Il est
impossible de créer des liens entre des boutons et des signets autres que des points d’ancrage de texte.

si le bouton a pour cible un hyperlien, ce dernier reste sans effet dans le document exporté EPUB, PDF ou SWF à mise en page
fixe.

1. Sélectionnez le bouton souhaité à l’aide de l’outil Sélection .

2. Dans le panneau Boutons, choisissez l’événement (par exemple, Relâché) qui déclenchera le renvoi à la cible.

3. Cliquez sur le bouton contenant le signe plus situé à côté de la section Scripts d’action, puis choisissez la commande Accéder
à la cible.

4. Dans le menu Documents, sélectionnez l’un des documents InDesign ouverts, ou cliquez sur l’icône de dossier située à droite
du menu et spécifiez le fichier qui vous intéresse.

5. Définissez le point d’ancrage créé à l’aide du panneau Signets ou Hyperliens.

6. Sélectionnez le mode d’affichage de la page dans le menu Zoom.

si vous définissez un point d’ancrage dans un autre document, exportez ce dernier au format PDF et utilisez le même nom de fichier
que dans InDesign (remplacez uniquement l’extension .indd par .pdf). De même, stockez les documents PDF dans le même dossier pour que les
liens demeurent valides dans Acrobat ou Reader.

Modification de l’état d’un bouton au survol et sur un clic de la souris

Un bouton est en réalité un groupe d’objets distincts, chacun représentant un état (ou aspect) du bouton. Chaque bouton peut avoir trois états :
Normal, Survol et Clic. Dans le fichier exporté, l’état Normal est utilisé sauf si le pointeur de la souris passe sur le bouton (Survol) ou si l’utilisateur
clique dessus à l’aide de la souris (Clic). Vous pouvez faire en sorte que chaque état soit visuellement différent.

Par défaut, tout nouveau bouton adopte l’état Normal et contient son texte ou son image. Lorsque vous activez un nouvel état, il reprend les
caractéristiques de l’état Normal. Pour distinguer les différents états, vous pouvez changer la couleur ou ajouter du texte ou une image.



Remarque :

Remarque :

Haut de la page

Etats d’un bouton

A. Pointeur hors de la zone du bouton (Normal) B. Pointeur entrant dans la zone du bouton (Survol) C. Clic avec le pointeur (Clic) 

la zone sensible du bouton (celle qui réagit lorsque l’utilisateur clique dessus) correspond au cadre de sélection carré le plus étendu,
en considérant tous les états du bouton. Un bouton de forme ronde, par exemple, a une zone sensible carrée.

Modification de l’état d’un bouton

Si vous décidez de créer un bouton comportant plusieurs états (Normal, Survol et Clic), vous avez tout intérêt à définir toutes ses caractéristiques
avant d’activer les autres états. En effet, lorsque vous les activez, les états Survol et Clic reprennent les caractéristiques de l’état Normal.

Certaines modifications affectent uniquement l’état sélectionné, alors que d’autres s’appliquent à tous les états actifs. Si, par exemple, vous
sélectionnez un état et appliquez une autre couleur d’arrière-plan ou modifiez le texte, cette modification se limite à l’état sélectionné. En revanche,
si vous déplacez ou redimensionnez le bouton à l’aide de l’outil Sélection, cette modification est répercutée sur tous les états.

1. Choisissez la commande Fenêtre > Objet interactif > Boutons pour afficher le panneau correspondant.

2. A l’aide de l’outil Sélection , sélectionnez le bouton à modifier dans la mise en page.

3. Cliquez sur l’option [Survol] pour activer cet état.

L’état Survol adopte les caractéristiques de l’état Normal.

4. Sans désélectionner l’état Survol, effectuez toutes les modifications désirées.

Pour changer la couleur, cliquez sur une nuance dans le menu Contour ou Fond du panneau Nuancier.

Pour importer une image dans l’état, sélectionnez l’image existante à l’aide de l’outil Sélection directe ou en cliquant deux
fois sur le bouton de l’image existante. Sélectionnez ensuite Fichier > Importer, puis cliquez deux fois sur un fichier.

Pour coller une image dans un bloc de texte, copiez-la dans le Presse-papiers, sélectionnez l’état dans le
panneau Boutons, puis choisissez la commande Edition > Coller dedans.

Pour insérer du texte, sélectionnez l’outil Texte, cliquez sur le bouton, puis commencez la saisie. Vous pouvez également
choisir la commande Edition > Coller dedans pour copier un bloc de texte collé.

5. Pour ajouter l’état Clic, activez l’option [Clic] en cliquant dessus, puis modifiez l’aspect de cet état en suivant la même
procédure.

6. Utilisez le panneau Aperçu pour tester les divers états du bouton.

Pour changer la taille des vignettes Aspect de l’état dans le panneau Boutons, choisissez la commande Options de panneau dans le menu du
panneau Boutons, sélectionnez l’option désirée, puis cliquez sur le bouton OK.

Suppression et désactivation d’états

1. Sélectionnez l’état voulu dans le panneau Boutons.

2. Utilisez l’une des méthodes suivantes :

Pour supprimer l’état Survol ou Clic, cliquez sur l’icône de suppression en bas du panneau. Il peut être très pratique de
supprimer un état si, par exemple, vous avez apporté de nombreuses modifications à l’état Normal et décidez de définir
l’état Survol ou Clic d’après le nouvel état Normal.

Pour désactiver un état sans le supprimer, cliquez sur l’icône en forme d’œil située en regard de cet état pour le
désélectionner. Les états désactivés ne sont pas exportés dans le fichier EPUB, PDF ou SWF à mise en page fixe.

il est impossible de supprimer ou de désactiver l’état Normal.



Création d’objets à états multiples

Le panneau Etats d’objet vous permet de créer plusieurs versions d’un objet. Un état correspond à une version d’un élément de page. Un objet
est dit à état multiple lorsqu’il est associé à plusieurs états.

Le panneau Etats d’objet autorise la création d’un nombre illimité d’états pour un objet. Chaque fois que vous créez un état, vous obtenez une
autre version de l’élément de page. Vous ne pouvez visualiser qu’un seul état à la fois sur la page. Dans le cas d’une sortie pour impression ou au
format PDF, seul l’état actif est visible dans la sortie finale.

Création d’un diaporama d’objets à états multiples

Les objets à états multiples sont souvent utilisés pour créer des diaporamas, permettant ainsi aux utilisateurs d’un fichier SWF de cliquer sur une
série d’images. Vous pouvez, par exemple, créer un diaporama de 20 images sans avoir à placer les images sur 20 pages distinctes.

1. Importez les images à afficher dans le diaporama.

Pour de meilleurs résultats, veillez à ce que les blocs d’image soient de la même taille.

Il n’est pas indispensable qu’un état se compose d’un seul élément ; il peut correspondre à un ensemble d’éléments.

2. Pour superposer les images, sélectionnez-les, puis cliquez sur l’option Aligner les centres dans le sens horizontal  et sur
l’option Aligner les centres dans le sens vertical  dans le panneau Contrôle.

3. Tant que les images sont sélectionnées, ouvrez le panneau Etats d’objet (Fenêtre > Objet interactif > Etats d’objet), puis
cliquez sur le bouton Convertir la sélection en objet à états multiples .

Les images s’affichent sous la forme d’états dans le panneau Etats d’objet ; celles sélectionnées sont entourées d’un bloc en
pointillé.

4. Créez des boutons de navigation permettant de déclencher les actions Atteindre l’état suivant et Atteindre l’état précédent
après relâchement du bouton de la souris. Voir la section Création de boutons.

5. Utilisez le panneau Aperçu (Fenêtre > Interactif > Aperçu de l’interactivité EPUB/aperçu SWF) pour tester les boutons de
navigation.

6. Exportez le document au format SWF. Voir la section Documents interactifs.

Modification d’un objet à états multiples

1. Sélectionnez l’objet à états multiples voulu.

2. Dans le panneau Etats d’objet, utilisez l’une des méthodes suivantes :

Pour modifier un état, sélectionnez-le dans le panneau Etats d’objet, puis effectuez les modifications voulues. Vous
pouvez, par exemple, y ajouter un contour ou un fond ou encore, redimensionner l’objet.

Pour ajouter un objet à un état existant, sélectionnez à la fois l’objet voulu et l’objet à états multiples, puis cliquez sur le
bouton Ajouter des objets à l’état visible .

Pour ajouter un objet à un objet à états multiples existants, sélectionnez à la fois l’objet voulu et l’objet à états multiples,
puis cliquez sur le bouton Convertir la sélection en objet à états multiples .

Pour dupliquer un état, sélectionnez-le, puis choisissez la commande Nouvel état dans le menu du panneau. Ajoutez,
supprimez ou modifiez le contenu de cet état.

Pour coller des objets dans un état existant, coupez ou copiez les objets voulus, sélectionnez l’objet à états multiples, puis
choisissez l’état dans le panneau Etats d’objet et la commande Coller dans l’état dans le menu de ce panneau.

Pour convertir un objet à états multiples en un ensemble d’objets indépendants, sélectionnez l’état dans le panneau Etats
de l’objet, puis choisissez la commande Annuler l’état des objets dans le menu du panneau. Pour convertir en objets tous
les états d’un objet, choisissez la commande Annuler tous les états des objets.

Pour supprimer un état avec son contenu, sélectionnez-le, puis choisissez la commande Supprimer l’état dans le menu du
panneau.

Pour masquer l’objet à états multiples dans le fichier exporté jusqu’à ce qu’il soit déclenché par un bouton, choisissez la
commande Masqué jusqu’au déclenchement dans le menu du panneau.

Pour que tous les objets à états multiples du document reprennent leur état initial, choisissez la commande Réinitialiser

http://help.adobe.com/fr_FR/indesign/cs/using/WSFE8A2A9F-6111-416c-85D7-6C51F202E8ED.html
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tous les objets à états multiples sur le premier état dans le menu du panneau. Lorsque vous sélectionnez un état, l’objet
demeure dans cet état, y compris après la fermeture et la réouverture du document. Il s’agit là d’un moyen simple et
rapide de réinitialiser l’ensemble des objets à états multiples.

Création de zones sensibles sur les boutons

Il est parfois souhaitable que la zone du bouton (également appelée « zone sensible » ou « lien actif ») demeure invisible jusqu’à ce que le
pointeur de la souris soit placé dessus. Il est possible, par exemple dans le cas d’une carte géographique, de faire en sorte qu’une image
représentant une région apparaisse lorsque l’utilisateur place le pointeur de la souris sur un bouton et qu’elle disparaisse lorsqu’il retire le pointeur
de la zone correspondante.

Dans le fichier PDF exporté, une image s’affiche lorsque l’utilisateur place le pointeur de la souris sur une zone sensible.

Affichage d’une image masquée au survol

L’une des façons d’obtenir un effet de « zone sensible » consiste à appliquer une image à l’état Survol du panneau Boutons. Pour ce faire, créez
un bouton dans lequel l’état [Survol], mais pas l’état [Normal], entraîne l’affichage d’une image.

1. Sélectionnez l’image à afficher lors de l’activation de la zone sensible. Veillez à ce que le bloc de l’image ne présente ni
contour ni arrière-plan.

2. Dans le panneau Boutons (Fenêtre > Objet interactif > Boutons), cliquez sur l’état [Normal] pour convertir l’image sélectionnée
en bouton.

3. Cliquez sur l’état [Survol] dans le panneau Boutons pour l’activer.

4. Cliquez à nouveau sur l’état [Normal]. Sélectionnez ensuite l’image à l’aide de l’outil Sélection directe , puis supprimez
l’image.

Assurez-vous de supprimer l’image (contenu du bloc), non le bloc et le contenu. Si vous supprimez le bloc, le bouton l’est
également.

5. Utilisez le panneau Aperçu pour afficher un aperçu de l’effet de zone sensible.

Affichage d’un autre bouton au survol

Vous pouvez créer une zone sensible qui permet d’afficher un autre objet lorsque vous cliquez ou placez le pointeur sur un objet. Pour ce faire,
créez deux boutons, masquez l’un d’eux, puis utilisez l’action Afficher/Masquer les boutons pour afficher et masquer le bouton cible.

1. Créez l’objet à utiliser comme bouton source. Dans le panneau Boutons, cliquez sur l’icône Convertir l’objet en bouton.

2. Importez l’image à utiliser comme bouton cible, puis convertissez-la en bouton.

3. Sélectionnez l’image cible, puis l’option Masqué jusqu’au déclenchement située au bas du panneau Boutons.

L’image doit être masquée dans le document exporté de manière à pouvoir être affichée lorsque l’utilisateur place le pointeur
de la souris ou clique sur le bouton source.

4. Sélectionnez le bouton source et créez deux actions différentes, l’une pour afficher l’image cible et l’autre, pour la masquer.

Pour que l’image s’affiche lorsque le pointeur de la souris se trouve sur le bouton source, utilisez les événements Effleuré
et Sortie. Pour que l’image s’affiche lorsque vous cliquez sur le bouton source et disparaisse lorsque vous le relâchez, utilisez
les événements Clic et Relâché. Dans un cas comme dans l’autre, utilisez l’action Afficher/Masquer les boutons pour afficher
et masquer le bouton cible. Voir la section Ajout d’effets interactifs aux boutons.

5. Utilisez le panneau Aperçu pour tester les boutons.
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Modification des options PDF des boutons

1. Sélectionnez le bouton souhaité à l’aide de l’outil Sélection .

2. Dans le menu du panneau Boutons, choisissez la commande Options PDF.

3. Saisissez une description qui servira de complément pour les utilisateurs malvoyants.

4. Indiquez si le bouton doit être imprimé dans le fichier PDF, puis cliquez sur le bouton OK.

Définition de l’ordre de sélection des boutons à l’aide de la touche de tabulation

L’ordre des tabulations détermine l’ordre de sélection des champs dans le document PDF ou SWF lorsque l’utilisateur appuie sur la touche de
tabulation (ou sur les touches Maj+Tab). L’ordre des tabulations concerne les boutons figurant sur les calques masqués, non ceux des gabarits.

1. Accédez à la page contenant les boutons.

2. Choisissez Objet > Objet interactif > Définir l’ordre des tabulations.

3. Sélectionnez chaque bouton à déplacer et faites-le glisser à l’endroit requis ou cliquez sur les boutons Déplacer vers le haut
et Déplacer vers le bas. Cliquez ensuite sur OK.

Si vous modifiez le fichier PDF et ajoutez des boutons ou des champs de formulaire supplémentaires à une page avec Acrobat, vous devez
redéfinir l’ordre des tabulations dans cette application.

Présentation du panneau Hyperliens
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Remarque :

Insertion d’une référence croisée
Utilisation des formats de référence croisée
Gestion des références croisées

Si vous rédigez un manuel ou un document de référence, vous aurez sans doute besoin d’insérer des références croisées pour inviter le lecteur à
consulter d’autres parties de votre document. En voici un exemple : Pour plus de détails, voir la section « Rats des champs »,
page 249. Vous pouvez préciser si les références croisées sont créées à partir d’un style de paragraphe, par exemple un style de titre, ou à
partir d’une ancre de texte définie par vos soins. Vous avez également la possibilité de spécifier le format des références croisées, en choisissant
d’inclure uniquement le numéro de page ou le paragraphe entier accompagné du numéro de page.

Insertion d’une référence croisée

Pour insérer des références croisées dans votre document, utilisez le panneau Références croisées. Pour ouvrir le panneau, choisissez la
commande Fenêtre > Texte et tableaux > Références croisées.

A. Cliquez sur l’indicateur visuel vert pour accéder à la destination. B. Cliquez sur le numéro de page pour sélectionner la source. C. Cliquez sur
l’icône pour créer une référence croisée. 

Le texte auquel il est fait référence est la cible. Le texte généré à partir de la cible est la source de référence croisée.

Lorsque vous insérez une référence croisée dans votre document, vous avez la possibilité de choisir l’un des formats prédéfinis ou de créer un
format personnalisé. Vous pouvez appliquer un style de caractère à l’ensemble de la source de la référence croisée ou au texte contenu dans la
référence. Les formats de références croisées peuvent être synchronisés sur l’ensemble d’un livre.

Le texte de la source de référence croisée est modifiable et peut contenir des retours à la ligne.

pour inclure les références croisées dans les fichiers Adobe PDF exportés, vous devez sélectionner l’option Hyperliens dans la boîte
de dialogue Exporter au format Adobe PDF dans InDesign. De même, pour faire figurer les références croisées dans les fichiers SWF exportés,
vous devez sélectionner l’option Inclure les hyperliens dans la boîte de dialogue Exporter au format SWF.



Insertion d’une référence croisée

A. Paragraphe cible sélectionné B. Cliquez ici pour créer ou modifier le format de la référence croisée. 

1. Placez le point d’insertion à l’endroit où vous souhaitez faire apparaître la référence croisée.

2. Utilisez l’une des méthodes suivantes pour ouvrir la boîte de dialogue Nouvelle référence croisée :

Choisissez la commande Texte > Hyperliens et références croisées > Insérer la référence croisée.

Choisissez la commande Fenêtre > Texte et tableaux > Références croisées, puis sélectionnez la commande Insérer la
référence croisée dans le menu du panneau.

Dans le panneau, cliquez sur le bouton Créer une référence croisée.

3. Dans la boîte de dialogue, choisissez l’option Paragraphe ou Ancre de texte dans le menu Lien vers.

Si vous sélectionnez l’option Paragraphe, votre référence croisée pourra renvoyer au paragraphe de votre choix dans le
document spécifié.

En revanche, si vous sélectionnez l’option Ancre de texte, votre référence croisée pourra renvoyer à du texte dans lequel
vous avez créé une cible d’hyperlien (voir Pour créer une cible d’hyperlien). La création d’une ancre de texte peut se révéler
utile lorsque la référence doit contenir un texte différent du paragraphe cible.

4. Pour l’option Document, sélectionnez le document contenant la cible à laquelle vous voulez faire référence. Tous les
documents ouverts qui ont été enregistrés sont répertoriés dans le menu déroulant. Si le document que vous recherchez n’est
pas ouvert, sélectionnez l’option Parcourir, recherchez le fichier, puis cliquez sur le bouton Ouvrir.

5. Cliquez sur un style de paragraphe (par exemple, Titre1) dans la zone de gauche pour limiter la liste des choix, puis
sélectionnez le paragraphe auquel vous voulez faire référence (ou l’ancre de texte, si vous aviez choisi l’option
correspondante).

6. Choisissez le format de référence croisée à utiliser dans le menu Format.

Vous pouvez modifier ces formats prédéfinis ou créer des formats personnalisés (voir Utilisation des formats de référence
croisée).

7. Définissez les options d’aspect PDF pour la référence croisée.

8. Cliquez sur OK.

Lorsque vous insérez une référence croisée, une marque d’ancre de texte  Cette marque est visible si vous avez sélectionné la commande
Texte > Afficher les caractères masqués. En cas de déplacement ou de suppression de cette marque, la référence croisée n’est plus résolue.

http://idiom-q-win-1/fr/indesign/using/hyperlinks.html#create_a_hyperlink_destination
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Remarque :

Utilisation des formats de référence croisée

Par défaut, la boîte de dialogue Nouvelle référence croisée propose plusieurs formats de référence croisée. Vous pouvez modifier ces formats, les
supprimer ou créer des formats personnalisés.

si vous avez supprimé ou modifié des formats de référence croisée dans votre document et désirez rétablir les formats par défaut, il
vous suffit de choisir la commande Charger les formats de référence croisée dans le menu du panneau et de sélectionner un document contenant
les formats originaux. Il est également possible de synchroniser les formats de référence croisée dans un livre.

Création ou modification d’un format de référence croisée

Les formats de référence croisée, à l’inverse des autres paramètres prédéfinis, peuvent être modifiés ou supprimés. La modification de l’un de ces
formats entraîne la mise à jour automatique de toutes les références croisées sources utilisant ce format.

1. Utilisez l’une des méthodes suivantes :

Choisissez la commande Définir les formats de référence croisée dans le menu du panneau Références croisées.

Pendant la création ou la modification d’une référence croisée, cliquez sur le bouton Créer ou modifier les formats des
références croisées .

2. Dans la boîte de dialogue Formats de référence croisée, effectuez l’une des opérations suivantes :

Pour modifier un format, sélectionnez-le sur le côté gauche.

Pour créer un format, sélectionnez celui qui servira de modèle, puis cliquez sur le bouton Créer un format . Vous
obtenez ainsi une copie du format sélectionné.

3. Spécifiez le nom du nouveau format dans la zone de texte correspondante.

4. Dans la zone de texte Définition, modifiez le texte en ajoutant ou supprimant des informations, si nécessaire. Cliquez sur
l’icône de bloc fonctionnel  pour insérer ces blocs à partir d’un menu. Cliquez sur l’icône des caractères spéciaux  pour

sélectionner des tirets, des espaces, des guillemets ou d’autres caractères spéciaux.

5. Pour appliquer un style de caractère à l’ensemble de la référence croisée, sélectionnez l’option Style de caractère de la
référence croisée, puis choisissez ou créez le style de votre choix à l’aide du menu.

Vous pouvez également faire appel au bloc fonctionnel Style de caractère pour appliquer un style au texte de la référence
croisée.

6. Cliquez sur le bouton Enregistrer pour valider les modifications. Cliquez sur le bouton OK.

Blocs fonctionnels des références croisées

Bloc
fonctionnel

Fonction Exemple

Numéro de
page

Insère le numéro de page. , page <pageNum />

, page 23

Numéro de
paragraphe

Insère le numéro de paragraphe dans une
référence croisée renvoyant à une liste
numérotée.

Voir la section <paraNum/>

Voir 1

Dans cet exemple, la référence croisée utilise
seulement le numéro du paragraphe qui commence
par « 1. Animaux ».

Texte du Insère le texte du paragraphe sans le numéro Voir la section « <paraText/> »



Création de références croisées renvoyant à des paragraphes partiels

Vous avez la possibilité de définir des formats de référence croisée de façon à inclure uniquement la première partie d’un paragraphe. Si, par
exemple, les titres de votre document se présentent sous la forme « Chapitre 7 — De Grenade à Barcelone », vous pouvez parfaitement créer une
référence croisée renvoyant seulement à « Chapitre 7 ».

paragraphe dans une référence croisée renvoyant à une
liste numérotée.

Voir la section « Animaux »

Dans cet exemple, la référence croisée utilise
seulement le texte du paragraphe qui commence par
« 1. Animaux ».

Paragraphe
entier

Insère l’ensemble du paragraphe, autrement dit
le numéro et le texte.

Voir la section « <fullPara/> »

Voir la section « 1. Animaux ».

Paragraphe
partiel

Permet de créer une référence croisée
contenant la première partie d’un paragraphe
jusqu’au délimiteur spécifié, un signe deux-
points ou un tiret cadratin par exemple.

Voir <fullPara delim=”:” includeDelim=”false”/>

Voir Chapitre 7

Dans cet exemple, la référence croisée utilise
seulement le texte « Chapitre 7 » du titre
« Chapitre 7 : Chiens et chats ».

Spécifiez le caractère délimiteur (comme le signe
« : » dans cet exemple), puis précisez s’il doit être
exclu (« false » ou « 0 ») ou inclus (« true » ou « 1 »)
dans la référence croisée source.

Reportez-vous à Création de références croisées
renvoyant à des paragraphes partiels.

Nom de
l’ancre de
texte

Insère le nom de l’ancre de texte. Pour créer
des ancres de texte, il suffit de choisir la
commande Nouvelle cible d’hyperlien dans le
menu du panneau Hyperliens.

Voir <txtAnchrName/>

Voir Figure 1

Numéro de
chapitre

Insère le numéro de chapitre. du chapitre <chapNum/>

du chapitre 3

Nom de
fichier

Insère le nom de fichier du document cible. dans <fileName/>

dans bulletin.indd

Style de
caractère

Applique un style de caractère au texte d’une
référence croisée.

Reportez-vous à la section <cs
name=”bold”><fullPara/></cs>, page <pageNum>

Reportez-vous à la section Animaux, page 23.

Spécifiez le nom du style de caractère, ainsi que le
texte auquel vous voulez l’appliquer entre les
balises <cs name=””> et </cs>.

Reportez-vous à Application de styles de caractères
à des références croisées.



Référence croisée renvoyant à un paragraphe partiel

A. La source de la référence croisée se termine au tiret cadratin (^_) B. « false » exclut le tiret cadratin de la source. 

L’insertion du bloc fonctionnel Paragraphe partiel est une opération en deux temps. Tout d’abord, il est nécessaire de spécifier entre guillemets le
délimiteur, autrement dit, le caractère qui termine le paragraphe. Bien souvent, il s’agit du signe deux-points (Chapitre 7 : De Grenade), du point
(Chapitre 7. De Grenade) ou du tiret (Chapitre 7 — De Grenade). Pour insérer un caractère spécial tel que le tiret cadratin (^_), l’espace cadratin
(^m) et la puce (^8), il suffit de choisir l’une des options proposées dans le menu qui apparaît lorsque vous cliquez sur l’icône Caractères
spéciaux.

En second lieu, vous devez préciser si ce délimiteur sera exclu (Chapitre 7) ou inclus (Chapitre 7—). Pour exclure le délimiteur, spécifiez
includeDelim=”false”. En revanche, pour le faire figurer dans la référence croisée, saisissez includeDelim=”true”. Vous pouvez remplacer les
valeurs « false » et « true » respectivement par « 0 » et « 1 ».

Application de styles de caractères à des références croisées

Si vous désirez mettre en évidence une partie du texte d’une référence croisée, vous avez la possibilité de faire appel au bloc fonctionnel Style de
caractère. Ce bloc est constitué de deux balises : la balise <cs name=”nomdustyle”> précise le style qui doit être appliqué, et la balise </cs>
indique la fin de ce style de caractère. L’ensemble du texte et des blocs fonctionnels compris entre ces deux balises adopte le style spécifié.

Application d’un style de caractère à une partie d’une référence croisée

A. Cette balise applique un style de caractère nommé « Rouge ».  B. Cette balise met fin au style de caractère. C. Le style de caractère « Gras »
est appliqué au reste de la source de la référence croisée. 
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1. Créez le style de caractère que vous souhaitez utiliser.

2. Dans la boîte de dialogue Formats de référence croisée, créez ou modifiez le format à appliquer.

3. Dans la zone Définition, sélectionnez le texte et les blocs fonctionnels auxquels vous voulez appliquer le style de caractère.

4. Choisissez l’option Style de caractère dans le menu situé à droite de la liste de définition.

5. Saisissez le nom du style de caractère entre les guillemets, exactement tel qu’il apparaît dans le panneau Styles de caractère.

Il est important de respecter les majuscules et les minuscules dans les noms de styles. Si le style de caractère fait partie d’un
groupe, saisissez le nom du groupe suivi du signe deux-points et du nom du style de caractère, par exemple Groupe de
style 1: Rouge.

6. Cliquez sur le bouton Enregistrer, puis sur le bouton OK.

Chargement (importation) de formats de référence croisée

Lorsque vous chargez des formats de référence croisée à partir d’un autre document, ils remplacent les formats existants qui portent le même
nom.

Dans InCopy, vous pouvez importer des formats de référence croisée uniquement dans les documents autonomes. Par ailleurs, il est impossible
d’importer des formats à partir d’un document InCopy dans un document InDesign. Si le format nouveau ou modifié dans InCopy est en conflit
avec un format du document InDesign lors de l’extraction de l’article, le format InDesign prend le pas sur l’autre.

1. Choisissez la commande Charger les formats de référence croisée dans le menu du panneau Références croisées.

2. Cliquez deux fois sur le document contenant les formats à importer.

Il est également possible de partager les formats de référence croisée d’un document à un autre en synchronisant un livre.

Suppression des formats de référence croisée

Il est impossible de supprimer un format appliqué à des références croisées dans le document.

1. Dans la boîte de dialogue Formats de référence croisée, sélectionnez le format à supprimer.

2. Cliquez sur le bouton Supprimer le format .

Gestion des références croisées

Lorsque vous insérez une référence croisée, son état apparaît dans le panneau Références croisées. Des icônes indiquent si, par exemple, le
texte cible figure sur la table de montage , dans un gabarit , sur un calque masqué , dans du texte en excès  ou dans du texte masqué .
Les références croisées renvoyant à ces zones cibles sont non résolues. A l’aide du panneau, vous pouvez également déterminer si le paragraphe
cible a été modifié  (le lien est alors obsolète) ou s’il est manquant . Le texte cible est manquant si ce texte ou le fichier qui le contient sont
introuvables. Maintenez le pointeur de la souris sur une icône pour afficher l’info-bulle correspondante.

Dans InCopy, vous pouvez gérer les références croisées uniquement si vous avez extrait l’article en vue de le modifier.

Mise à jour des références croisées

La présence d’une icône de mise à jour indique que le texte cible ou source de la référence croisée a changé. Dans ce cas, il suffit de mettre à
jour la référence croisée. En revanche, si la cible a changé de page, la mise à jour de la référence croisée est automatique.

Lorsque vous mettez à jour une référence croisée, vous perdez toutes les modifications de mise en forme appliquées au texte source.

Lors de l’impression ou de la sortie du document, un message vous informe des éventuelles références croisées obsolètes ou non résolues.



Vous pouvez également faire appel au panneau Contrôle en amont pour obtenir ces renseignements. Pour cela, vous devez simplement
sélectionner l’option Références croisées dans la section Texte, lors de la définition du profil (voir Définition de profils de contrôle en amont).

1. Sélectionnez une ou plusieurs références croisées obsolètes. Si vous désirez mettre à jour toutes les références croisées,
veillez à ce qu’aucune d’elles ne soit sélectionnée.

2. Utilisez l’une des méthodes suivantes :

Cliquez sur le bouton Mettre à jour les références croisées  dans le panneau Références croisées.

Choisissez la commande Mettre à jour la référence croisée dans le menu du panneau Références croisées.

Choisissez Texte > Hyperliens et références croisées > Mettre à jour la référence croisée.

Pour mettre à jour toutes les références croisées d’un livre, choisissez la commande Mettre à jour toutes les références croisées dans le menu du
panneau Livre. Un message vous informe de l’éventuelle présence de références croisées non résolues.

Réédition des liens des références croisées

Si le texte cible manquant a été déplacé dans un autre document ou si le document contenant ce texte a changé de nom, vous avez la possibilité
de rééditer le lien de la référence croisée. Lorsque vous effectuez cette opération, vous perdez toutes les modifications apportées à la référence
croisée source.

1. Dans le panneau Références croisées, sélectionnez la référence croisée dont vous souhaitez rééditer le lien.

2. Choisissez la commande Rééditer le lien de la référence croisée dans le menu du panneau Références croisées.

3. Recherchez le document contenant le texte cible, puis cliquez sur le bouton Ouvrir.

Si ce document comporte d’autres sections de texte cible, vous pouvez rééditer les liens des autres références croisées.

Modification de références croisées

Si vous désirez changer l’aspect d’une référence croisée source ou spécifier un autre format, vous pouvez simplement modifier la référence
croisée. Si elle renvoie à un autre document, celui-ci s’ouvre automatiquement.

1. Utilisez l’une des méthodes suivantes :

Choisissez la commande Texte > Hyperliens et références croisées > Options de référence croisée.

Dans le panneau Références croisées, cliquez deux fois sur la référence croisée que vous souhaitez modifier.

Sélectionnez la référence croisée, puis choisissez Options de référence croisée dans le menu du panneau Références
croisées.

2. Apportez les modifications nécessaires à la référence croisée, puis cliquez sur le bouton OK.

Suppression de références croisées

Lorsque vous supprimez une référence croisée, la référence source est convertie en texte.

1. Dans le panneau Références croisées, sélectionnez la ou les références croisées que vous souhaitez supprimer.

2. Cliquez sur l’icône de suppression ou choisissez Supprimer la référence croisée dans le menu du panneau.

3. Cliquez sur le bouton Oui pour confirmer.

Pour éliminer définitivement une référence croisée, vous pouvez aussi sélectionner la source de la référence et la supprimer.

Modification du texte de la source d’une référence croisée
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Création de fichiers SWF (Flash) interactifs pour le Web
Création de fichiers FLA pour le Web
Problèmes d’exportation vers Flash

Pour créer un contenu de type diaporama destiné à être lu dans Flash Player, vous avez la possibilité d’exporter les données au format SWF
ou FLA. A la différence des fichiers FLA, qui doivent être modifiés dans AdobeFlash Professional pour pouvoir être visualisés dans Adobe
Flash Player, les fichiers SWF sont directement lisibles mais ne sont pas modifiables.

Un fichier SWF exporté est directement lisible dans Adobe Flash Player et peut se composer d’éléments interactifs comme des transitions
de page, des hyperliens, des séquences vidéo et audio, des animations et des boutons de navigation.

Un fichier FLA exporté contient quelques éléments interactifs seulement. Vous pouvez ouvrir un fichier FLA dans Flash Pro pour y ajouter
des effets élaborés avant son exportation au format SWF.

Exportation vers Flash

A. Exportation directe au format SWF B. Exportation au format FLA pour modification dans Flash Professional 

Création de fichiers SWF (Flash) interactifs pour le Web

Lors de l’exportation au format SWF, vous créez un fichier interactif directement lisible dans Adobe Flash Player ou un navigateur Web. Le
fichier SWF peut inclure des boutons, des transitions de page, des fichiers vidéo et audio, des animations et des hyperliens qui ont été ajoutés
dans InDesign. L’exportation au format SWF est un bon moyen de créer un diaporama interactif, ou folioscope, à partir d’un document InDesign.

Pour modifier le document dans Flash Pro avant de créer le fichier SWF, exportez-le plutôt au format FLA (voir Création de fichiers FLA pour le
Web).



Exporter

Exportation au format SWF

A. Document dans InDesign avant l’exportation au format SWF B. Fichier SWF interactif dans le navigateur Web 

1. Créez ou modifiez le document InDesign afin de le préparer pour l’exportation vers Flash. Pour plus de détails sur la
configuration d’un document pour l’exportation, voir la section Problèmes d’exportation vers Flash.

Ajoutez des boutons de navigation qui permettront aux utilisateurs de parcourir les pages du fichier SWF exportés. Vous
pouvez créer un bouton en dessinant un objet et en le convertissant en bouton au moyen du panneau Boutons (Fenêtre >
Objet interactif > Boutons). Vous pouvez également faire glisser des boutons de navigation dans votre document depuis le
panneau Boutons exemples (voir Création de boutons).

Utilisez le panneau Transitions de page (Fenêtre > Objet interactif > Transitions de page) pour ajouter des transitions de
page, tels que des balayages et des fondus. Lorsque vous exportez au format SWF, vous pouvez également sélectionner
l’option Inclure le coin de page interactif, qui permet aux utilisateurs de faire glisser le coin d’une page pour la tourner.

Utilisez le panneau Animation (Fenêtre > Objet interactif > Animation) pour ajouter des mouvements prédéfinis (voir
Animation).

2. Pour exporter le document au format SWF, choisissez la commande Fichier > Exporter. Choisissez Flash Player (SWF) dans
le menu Type (Windows) ou Format (Mac OS), puis cliquez sur Enregistrer.

3. Dans la boîte de dialogue Exporter au format SWF, définissez les options voulues, puis cliquez sur le bouton OK (voir Options
d’exportation au format SWF).

Lorsque vous exportez un fichier SWF, des fichiers HTML et SWF distincts sont créés. Si le fichier SWF comprend des films et des sons, un
dossier Resources est également créé. Lorsque vous transmettez ou téléchargez des fichiers sur le Web, veillez à ne pas oublier de fichiers.

Options d’exportation au format SWF

Les options suivantes sont disponibles dans les onglets Général et Avancé de la boîte de dialogue Exporter au format SWF.

Indiquez si vous voulez exporter la sélection en cours, l’ensemble des pages du document ou une série de pages. L’option Sélection
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Générer le fichier HTML

Afficher le fichier SWF après exportation

Taille (pixels)

Arrière-plan

Interactivité et multimédia

Transitions de page

Inclure le coin de page interactif

Cadence

L’habillage de texte

Pixelliser les planches

Aplatir la transparence

Compression

Qualité JPEG

Résolution

est particulièrement utile pour enregistrer le fichier SWF exporté en vue de l’utiliser dans un fichier PDF exporté. Si vous choisissez l’option
Etendue, indiquez une étendue de pages, par exemple 1-7, 9 pour inclure les pages 1 à 7 et 9 (voir Spécification des pages à imprimer).

Sélectionnez cette option pour générer une page HTML de lecture du fichier SWF. Vous disposez ainsi d’un moyen
très rapide de prévisualiser le fichier SWF dans votre navigateur Web.

Sélectionnez cette option pour lire le fichier SWF dans votre navigateur Web par défaut. Cette option
est disponible uniquement si vous décidez de générer un fichier HTML.

Précisez le mode de définition de la taille du fichier SWF : mise à l’échelle exprimée en pourcentage, adaptation aux dimensions
de moniteur spécifiées ou redimensionnement en fonction des valeurs de largeur et hauteur saisies.

Indiquez si l’arrière-plan du fichier SWF doit être transparent ou s’il doit utiliser la teinte du papier actuellement définie dans le
panneau Nuancier. Les options Transitions de page et Inclure le coin interactif de la page sont désactivées lorsque l’option Transparent est
sélectionnée.

Sélectionnez l’option Tout inclure pour préserver l’interactivité des séquences vidéo et audio, des boutons et des
animations dans le fichier SWF exporté. Sélectionnez l’option Aspect seulement pour inclure les boutons et les affiches vidéo dans leur état
normal, en tant qu’éléments statiques. Si vous choisissez l’option Aspect seulement, les animations sont exportées telles qu’elles se présentent
dans la mise en page au moment de l’exportation. L’option Aspect seulement est sélectionnée dès lors que vous choisissez l’option Aplatir la
transparence dans le panneau Avancé.

Définissez la transition de page à appliquer à l’ensemble des pages lors de l’exportation. Si vous effectuez cette opération
au moyen du panneau Transitions de page, choisissez l’option Du document afin d’utiliser ces paramètres.

Si vous sélectionnez cette option, les utilisateurs qui visualiseront le fichier SWF pourront tourner les pages en
faisant glisser le coin, comme s’il s’agissait d’un livre réel.

La cadence agit proportionnellement sur la fluidité des animations et sur la taille du fichier. En revanche, la modification de la cadence
n’a aucune incidence sur la durée de la lecture.

Précisez le mode de sortie du texte InDesign. Optez pour l’option Texte Flash classique si vous voulez obtenir du texte
autorisant les recherches. Cette solution limite également la taille du fichier. Choisissez l’option Vectoriser pour traiter le texte comme une série de
lignes droites régulières, comme lors de la vectorisation du texte. Choisissez l’option Pixelliser pour convertir le texte en image bitmap. Il est à
noter que le texte pixellisé peut présenter des bords irréguliers lors du zoom avant.

Cette option a pour effet de convertir tous les éléments des pages InDesign en images bitmap. Il en résulte toutefois un
fichier SWF plus volumineux, ainsi que des éléments de page aux bords dentelés lorsque vous effectuez un zoom avant.

Cette option permet de supprimer les effets de transparence dynamique dans le fichier SWF tout en préservant l’aspect
des objets transparents. Néanmoins, son application a pour effet d’annuler toute interactivité du fichier SWF exporté.

Choisissez l’option Automatique pour laisser à InDesign le soin de déterminer la qualité optimale des images en couleurs et en
niveaux de gris. Cette option donne des résultats satisfaisants pour la plupart des fichiers. L’option JPEG (avec perte) convient aux images en
niveaux de gris et en couleurs. La compression JPEG est un mode de compression avec perte de données, ce qui signifie qu’elle supprime des
données de l’image, entraînant parfois une baisse de la qualité image. Toutefois, cette compression tente de réduire la taille du fichier avec une
perte minimale d’informations. En raison de cette suppression de données, la compression JPEG produit des fichiers nettement plus petits.
L’option PNG (sans perte) permet d’exporter le fichier en utilisant un mode de compression sans perte de données.

Choisissez l’option PNG (sans perte) pour améliorer la qualité d’image si vous observez une détérioration des images transparentes lors de
l’exportation au format SWF.

Spécifie le niveau de détail de l’image exportée. Plus la qualité est grande, plus le fichier est volumineux. Cette option est
estompée si vous choisissez la compression PNG (sans perte).

Indiquez la résolution des images bitmap dans le fichier SWF exporté. Une résolution élevée est particulièrement importante pour
permettre aux utilisateurs d’effectuer un zoom avant sur du contenu en pixels dans le fichier SWF exporté. Le choix d’une résolution élevée peut
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néanmoins entraîner une augmentation significative de la taille du fichier.

Création de fichiers FLA pour le Web

Après exportation d’un document InDesign au format FLA, vous pouvez ouvrir le fichier FLA dans Adobe Flash® CS5 Professional pour en
modifier le contenu. Le format d’exportation FLA disponible InDesign CS5 remplace le format XFL utilisé dans InDesign CS4. Vous pouvez ajouter
ou modifier des séquences vidéo ou audio, des animations et d’autres éléments interactifs complexes à l’aide des fonctions de conception
disponibles dans Flash.

Si vous voulez exporter le document InDesign dans un format lisible directement dans un navigateur Web, optez pour le format SWF plutôt que le
format FLA (voir Création de fichiers SWF (Flash) interactifs pour le Web).

Exportation au format FLA

A. Document dans InDesign avant l’exportation au format FLA B. Fichier FLA ouvert dans Flash Pro 

1. Créez ou modifiez le document InDesign afin de le préparer pour l’exportation vers Flash Pour plus de détails sur la
configuration d’un document pour l’exportation, voir la section Problèmes d’exportation vers Flash.

2. Pour exporter le document au format FLA, choisissez la commande Fichier > Exporter. Choisissez Flash CS5 Professional
(FLA) dans le menu Type (Windows) ou Format (Mac OS), puis cliquez sur Enregistrer.

3. Dans la boîte de dialogue Exporter au format Flash CS5 Professional (FLA), définissez les options voulues, puis cliquez sur le
bouton OK. Pour plus de détails sur les options d’exportation, reportez-vous à la section Options d’exportation au format FLA.

4. Ouvrez le fichier FLA exporté dans Flash Professional.

Options d’exportation au format FLA

Les options suivantes sont disponibles dans la boîte de dialogue Exporter au format Flash CS5 Professional (FLA).
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Mode de conversion des pages InDesign

Format de page

Indiquez si vous voulez exporter la sélection en cours, l’ensemble des pages du document ou une série de pages. Si vous choisissez
l’option Etendue, indiquez une étendue de pages, par exemple 1-7, 9 pour inclure les pages 1 à 7 et 9 (voir Spécification des pages à
imprimer).

Cette option a pour effet de convertir tous les éléments des pages InDesign en images bitmap. Il en résulte toutefois un
fichier FLA plus volumineux, ainsi que des éléments de page aux bords dentelés lorsque vous effectuez un zoom avant.

Cette option a pour effet d’aplatir tous les objets dotés de transparence. Gardez toutefois à l’esprit que les objets aplatis
sont parfois difficiles à animer dans Adobe Flash Pro.

Précisez le mode de définition de la taille du fichier FLA : mise à l’échelle exprimée en pourcentage, adaptation aux dimensions de
moniteur spécifiées ou redimensionnement en fonction des valeurs de largeur et hauteur saisies.

Sélectionnez l’option Tout inclure pour inclure des séquences vidéo et audio, des boutons et des animations dans le
fichier FLA exporté. Si le document comporte un objet à états multiples, ce dernier est converti en un symbole de séquence vidéo dans lequel
chaque état apparaît sur sa propre image dans le montage.
Sélectionnez l’option Aspect seulement pour inclure les boutons et les affiches vidéo dans leur état normal, en tant qu’éléments statiques. Si vous
choisissez l’option Aspect seulement, les animations sont exportées telles qu’elles se présentent dans la mise en page au moment de
l’exportation. L’option Aspect seulement est sélectionnée dès lors que vous choisissez l’option Aplatir la transparence.

Précisez le mode de sortie du texte InDesign. Choisissez Texte Flash TLF si vous voulez profiter du large éventail
d’attributs TLF (Text Layout Framework) disponible dans Flash Professional. Dans cas, sélectionnez aussi l’option Insérer des points de tirets
conditionnels pour permettre la césure. Optez pour l’option Texte Flash classique si vous voulez obtenir du texte permettant les recherches. Cette
solution limite également la taille du fichier. Choisissez l’option Vectoriser pour traiter le texte comme une série de lignes droites régulières,
comme lors de la vectorisation du texte. Choisissez l’option Pixelliser pour convertir le texte en image bitmap. Il est à noter que le texte pixellisé
peut présenter des bords irréguliers lors du zoom avant.

Choisissez l’option Automatique pour laisser à InDesign le soin de déterminer la qualité optimale des images en couleurs et en
niveaux de gris. Cette option donne des résultats satisfaisants pour la plupart des fichiers. L’option JPEG (avec perte) convient aux images en
niveaux de gris et en couleurs. La compression JPEG est un mode de compression avec perte de données, ce qui signifie qu’elle supprime des
données de l’image, entraînant parfois une baisse de la qualité image. Toutefois, cette compression tente de réduire la taille du fichier avec une
perte minimale d’informations. En raison de cette suppression de données, la compression JPEG produit des fichiers nettement plus petits.
L’option PNG (sans perte) permet d’exporter le fichier en utilisant un mode de compression sans perte de données.

Spécifie le niveau de détail de l’image exportée. Plus la qualité est grande, plus le fichier est volumineux. Cette option est
estompée si vous choisissez la compression PNG (sans perte).

Indiquez la résolution des images bitmap dans le fichier FLA exporté. Une résolution élevée est particulièrement importante pour
permettre aux utilisateurs d’effectuer un zoom avant sur du contenu en pixels. Le choix d’une résolution élevée peut néanmoins entraîner une
augmentation significative de la taille du fichier.

Problèmes d’exportation vers Flash

Tenez compte des facteurs suivants lors de la conception d’un document InDesign destiné à être exporté au format SWF ou FLA.

Problèmes de configuration du document

Lorsque vous exportez le document au format SWF ou FLA, les planches InDesign deviennent des
clips distincts dans le montage, comme les diapositives d’un diaporama. Chacune de ces planches correspond à une nouvelle image clé. Pour
passer d’une planche à une autre dans Flash Player, vous pouvez vous servir des touches fléchées ou cliquer sur des boutons interactifs.

Lors de la création d’un document destiné au Web, choisissez l’option Web dans le menu Mode de la boîte de dialogue Nouveau document.

Lorsque vous créez un document, vous pouvez choisir une résolution spécifique (par exemple, 800 x 600) à partir du
menu Format de page de la boîte de dialogue Nouveau document. Au moment de l’exportation, vous avez également la possibilité de modifier
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l’échelle ou la résolution du fichier SWF ou FLA exporté.

Fonctions d’interactivité

Il est possible d’inclure des boutons, des transitions de page, des hyperliens, des animations et des fichiers multimédias dans les fichiers SWF
et FLA exportés.

Dans un fichier SWF ou FLA exporté, les boutons associés aux actions Page suivante et Page précédente sont particulièrement utiles
pour faciliter la lecture dans Flash Player. En revanche, certaines actions qui fonctionnent parfaitement dans les fichiers PDF interactifs n’ont
aucun effet dans Flash Player. Evitez de sélectionner une option de la section PDF seulement lors du choix d’une action dans le
panneau Boutons.

Vous pouvez associer des boutons de navigation prédéfinis aux actions Page suivante et Page précédente. Il vous suffit de choisir la
commande Boutons exemples dans le menu du panneau Boutons (voir Ajout d’un bouton à partir du panneau Boutons exemples).

Toutes les transitions de page fonctionnent bien dans Flash Player. En complément des transitions de page qui
apparaissent lors du changement de page, vous pouvez inclure pendant l’exportation la fonction de coin de page interactif qui permet de faire
glisser le coin de la page pour la tourner.

Créez des liens renvoyant à des sites Web ou à d’autres pages du document. Dans les fichiers FLA, les hyperliens ne sont pas
maintenus.

Les séquences vidéo et audio sont incluses dans un fichier SWF exporté à condition de se présenter dans un format
pris en charge (SWF, FLV, F4V et MP4 pour les séquences vidéo ou MP3 pour les séquences audio).
Lors de l’exportation au format FLA, seule l’affiche est incluse dans le fichier. Les fichiers multimédias pris en charge figurent dans un dossier de
ressources enregistré au même emplacement que le fichier FLA exporté.

Problèmes de conversion

Les fichiers SWF et FLA utilisent les couleurs RVB. Lorsque vous exportez un document au format SWF ou FLA, InDesign convertit tous
les espaces colorimétriques (par exemple, CMJN et LAB) en sRVB. De même, les tons directs sont convertis en leur équivalent quadri RVB.
Pour éviter toute variation indésirable des couleurs dans les images contenant du texte avec transparence, choisissez la commande Edition >
Espace de fusion des transparences > Espace RVB du document. Pour éviter toute variation indésirable des couleurs dans les images avec
transparence, n’utilisez pas une compression avec perte au cours de l’exportation.

Lors de l’exportation au format SWF ou FLA, vous pouvez spécifier le mode de sortie du texte : texte Flash, vectorisé ou
pixellisé. Si vous choisissez d’exporter le texte au format Texte Flash classique, vous pourrez ensuite le modifier à votre guise dans le fichier FLA,
à l’aide d’Adobe Flash CS5 Professional. Dans le cas d’un fichier SWF, ce format de texte permet en outre les recherches de texte dans les
navigateurs Web.

Lorsque vous exportez des images au format SWF ou FLA, vous pouvez modifier divers paramètres : Compression d’image,
Qualité JPEG et Résolution.
Lorsque vous exportez des images au format FLA, une image importée à plusieurs reprises dans un document InDesign est enregistrée comme
une seule ressource avec un emplacement partagé. Gardez toutefois à l’esprit qu’un grand nombre d’images vectorielles dans le document
InDesign risque de compromettre sérieusement les performances du fichier exporté.
Pour contenir la taille du fichier, pensez à importer les images répétées sur les gabarits, et évitez de copier et coller les images. Si vous importez
plusieurs fois une même image dans le document sans la transformer ou la recadrer, une seule copie du fichier d’image est exportée dans le
fichier FLA. Les images que vous copiez et collez sont, quant à elles, considérées comme des objets distincts.
Par défaut, un fichier Illustrator importé est traité comme une seule image dans le fichier FLA. Si, en revanche, vous copiez et collez un fichier
Illustrator, vous générez autant d’objets indépendants. Pour obtenir un résultat optimal, il est préférable d’importer l’image Illustrator sous forme de
fichier PDF au lieu de la copier et de la coller à partir d’Illustrator. Vous évitez ainsi de créer d’innombrables tracés modifiables.

Pour vous assurer que chaque objet Illustrator que vous collez reste un seul objet et non un ensemble de petits vecteurs, pensez à modifier
certaines préférences. Dans les préférences Illustrator Gestion des fichiers et presse-papiers, sélectionnez l’option PDF, puis désélectionnez
l’option AICB (pas de prise en charge des transparences). Dans les préférences InDesign Gestion du presse-papiers, sélectionnez les
options Préférer le PDF au collage et Copier dans le presse-papiers au format PDF.

Avant de procéder à l’exportation au format SWF, vous devez vous assurer que les objets transparents ne chevauchent aucun

http://idiom-q-win-1/fr/indesign/using/buttons.html#add_a_button_from_the_sample_buttons_panel
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Attributs 3D

élément interactif tel qu’un bouton ou un hyperlien. En effet, le cas échéant, l’interactivité de cet élément risque d’être perdue pendant
l’exportation. Vous pouvez éventuellement aplatir les transparences avant d’exporter votre document au format FLA.
Il arrive parfois qu’une compression avec perte de données amoindrisse la qualité des images comportant des transparences. Choisissez
l’option PNG (sans perte) pour améliorer la qualité des images lors de l’exportation.

Les attributs 3D ne sont pas pris en charge dans les fichiers SWF et FLA exportés.

http://creativecommons.org/licenses/by-nc-sa/3.0/
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Animation

Panneau Animation

Outils Sélection directe et Plume

Panneau Minutage

Panneau Aperçu

Remarque :

Haut de la page

Animation d’un document à l’aide de mouvements prédéfinis
Gestion des mouvements prédéfinis
Modification d’une trajectoire
Utilisation du panneau Minutage pour modifier l’ordre d’une animation

Les effets d’animation vous permettent d’animer des objets dans les fichiers SWF exportés. Par exemple, vous pouvez appliquer un mouvement
prédéfini à une image de sorte qu’elle semble apparaître par la gauche de l’écran en tournoyant et en rétrécissant. Servez-vous des outils et
panneaux ci-dessous pour animer des documents.

Cliquez sur le bouton Lecture pour visualiser l’animation.

Appliquez un mouvement prédéfini et modifiez les paramètres tels que la durée et la vitesse.

Modifiez la trajectoire suivie par l’objet animé.

Définissez l’ordre dans lequel les objets d’une page sont animés.

Affichez l’animation dans un panneau InDesign.

les effets de survol de bouton sont des types d’animation apparentés que vous pouvez aussi ajouter dans InDesign. Pour plus
d’informations, voir la rubrique Création de boutons.

Jeff Witchel d’Infiniteskills.com propose une présentation vidéo sur l’animation des mises en page.

Animation d’un document à l’aide de mouvements prédéfinis

Les mouvements prédéfinis sont des animations préconfigurées que vous pouvez appliquer rapidement à des objets. Vous effectuez cette
opération au moyen du panneau Animation, lequel permet également de modifier les paramètres d’animation, comme la durée et la vitesse, et de
préciser à quel moment déclencher un objet animé.

Ces mouvements prédéfinis sont identiques à ceux disponibles dans Adobe Flash CS5 Professional. Vous pouvez importer toute présélection de
mouvement personnalisée créée dans Flash Professional. Vous pouvez également enregistrer des présélections de mouvement que vous créez
pour les utiliser dans InDesign ou Flash Professional.

Les fonctions d’animation sont prises en charge uniquement dans le cadre de l’exportation vers Adobe Flash Player (format .SWF). Elles ne le
sont pas lors de l’exportation au format PDF interactif. Pour ajouter des effets d’animation à un fichier PDF, exportez la sélection voulue au
format SWF depuis InDesign, puis importez le fichier SWF ainsi obtenu dans le document InDesign.

1. Importez l’objet à animer dans le document.

2. Dans le panneau Animation (Fenêtre > Objet interactif > Animation), choisissez un mouvement prédéfini dans le

http://idiom-q-win-1/fr/indesign/using/buttons.html#create_buttons
http://www.infiniteskills.com/demos/movie-player.php?h=565&w=970&sku=01710&movie=http://infiniteskills.bc.cdn.bitgravity.com/iskills-media/indesigncs6-demo/1606.mp4


Remarque :

Nom

Paramètre prédéfini

Evénement(s)

Créer un déclencheur de bouton

Durée

Lecture

menu Animation prédéfinie.

3. Définissez les options du mouvement prédéfini.

4. Modifiez la trajectoire de l’animation au moyen des outils Plume et Sélection directe.

5. Définissez l’ordre des effets d’animation à l’aide du panneau Minutage.

6. Affichez un aperçu de l’animation dans InDesign au moyen du panneau Aperçu.

Pour supprimer l’animation d’un objet, sélectionnez ce dernier, puis cliquez sur l’icône de suppression dans le panneau Animation.

lorsque certains effets d’animation, tels que Fondu en entrée, sont combinés avec une transition de page ou un coin de page,
l’animation peut ne pas se comporter comme prévu dans le panneau Aperçu ou dans le fichier SWF exporté. Par exemple, les objets auxquels
sont appliqués l’effet Fondu en entrée sont visibles au moment où la page est tournée alors qu’ils devraient être invisibles. Pour éviter ce conflit,
n’utilisez pas de transitions de page sur les pages comportant des animations et désactivez l’option Inclure le coin de page interactif dans la boîte
de dialogue d’exportation SWF. Les mouvements prédéfinis susceptibles de ne pas fonctionner comme prévu avec les transitions de page et les
coins de page incluent Apparition, Fondu en entrée, les différents paramètres Entrée rapide, Zoom avant (2D) et Coup de pinceau.

Conversion des objets sélectionnés en trajectoire

Vous pouvez créer une animation en sélectionnant un objet et un tracé et en les convertissant en trajectoire. Si vous sélectionnez deux tracés
fermés, par exemple deux rectangles, c’est le tracé supérieur (du dessus) qui est converti en trajectoire.

1. Sélectionnez l’objet à animer et le tracé à utiliser comme trajectoire.

Vous ne pouvez pas convertir plus de deux objets sélectionnés.

2. Dans le panneau Animation, cliquez sur le bouton Convertir en trajectoire .

3. Dans ce même panneau, modifiez les paramètres voulus.

Options de mouvement prédéfini

Les options de mouvement prédéfini sont disponibles dans le panneau Animation. Cliquez sur l’option Propriétés pour afficher des paramètres
avancés

Indiquez le nom de l’animation. Le choix d’un nom descriptif est un avantage lors de la configuration d’une action qui déclenche l’animation.

Choisissez des paramètres de mouvement prédéfinis parmi ceux répertoriés.

L’option Au chargement de la page est sélectionnée par défaut, ce qui signifie que l’objet animé est exécuté à l’ouverture de la
page dans le fichier SWF. Choisissez l’option Au clic sur la page pour déclencher l’animation lorsqu’un utilisateur clique sur la page. Choisissez
l’option Au clic (auto) ou Au survol (auto) pour déclencher l’animation lorsqu’un utilisateur clique sur l’objet lui-même ou place le pointeur dessus,
respectivement. Si vous créez une action de bouton pour déclencher l’animation, choisissez l’option Evénement bouton activé (Voir la rubrique
Ajout d’actions aux boutons.) Vous pouvez définir plusieurs événements pour démarrer l’animation.
Si vous sélectionnez l’option Au survol (auto), vous pouvez également sélectionner l’option Inversion à la fin du survol. Elle permet d’inverser
l’action de l’animation lorsque le pointeur ne se trouve plus sur l’objet.

Cliquez sur ce bouton pour déclencher l’animation à partir d’un objet ou d’un bouton existant. Après avoir
cliqué sur le bouton Créer un déclencheur de bouton , cliquez sur l’objet à utiliser pour déclencher l’animation. Cet objet est converti en bouton,
le cas échéant, puis le panneau Boutons s’affiche.

Indiquez la durée de l’animation.

Indiquez la fréquence d’exécution de l’animation ou sélectionnez l’option En boucle pour que l’animation soit exécutée en continu jusqu’à
ce qu’elle soit interrompue.

http://idiom-q-win-1/fr/indesign/using/buttons.html#add_actions_to_buttons
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Remarque :

Animation

Rotation

Origine

Mise à l’échelle

Opacité

Visibilité

Haut de la page

Indiquez si l’animation est lue à une vitesse normale (option Sans), démarre lentement puis accélère (option Accélération) ou se termine
au ralenti (option Décélération).

les options suivantes sont disponibles lors de la sélection de l’option Propriétés.

Choisissez l’option De l’aspect actuel pour utiliser les propriétés actuelles de l’objet (facteur d’échelle, angle de rotation et position)
comme point de départ de l’animation.
Choisissez l’option A l’aspect actuel pour utiliser les propriétés de l’objet comme point d’arrivée de l’animation. Cette option est particulièrement
utile dans les diaporamas. Par exemple, les objets qui font leur apparition hors de la page peuvent s’afficher sur la page plutôt que sur la table de
montage, améliorant ainsi l’aspect du document à l’impression.
Choisissez l’option A l’emplacement actuel pour utiliser les propriétés actuelles de l’objet comme point de départ de l’animation et sa position
comme point d’arrivée. Cette option est semblable à l’option De l’aspect actuel, si ce n’est que l’objet s’arrête à son emplacement actuel et que la
trajectoire est décalée. Cette option est particulièrement utile pour certains mouvements prédéfinis, tels que les flous et les fondus, car elle permet
d’éviter que l’objet n’apparaisse dans un état indésirable à la fin de l’animation.

Pour afficher la doublure de l’animation à la fin de la trajectoire, cliquez sur le bouton Afficher la doublure de l’animation au bas du
panneau Animation.

Paramètres d’animation

A. Objet et tracé avant animation B. De l’aspect actuel C. A l’aspect actuel D. A l’emplacement actuel 

Indiquez l’angle de rotation de l’objet au cours de l’animation.

Définissez le point d’origine de la trajectoire sur l’objet animé en vous aidant de la doublure.

Indiquez un facteur d’échelle afin de déterminer si la taille de l’objet augmente ou diminue au cours de la lecture.

Indiquez si l’animation demeure opaque (option Sans), apparaît progressivement (option Fondu en entrée) ou disparaît progressivement
(option Fondu en sortie).

Sélectionnez l’option Masquer jusqu’à l’animation ou Masquer après l’animation pour que l’objet soit invisible avant ou après la lecture.

Gestion des mouvements prédéfinis

Vous pouvez enregistrer des paramètres d’animation en tant que mouvements prédéfinis afin de faciliter leur réutilisation dans InDesign. Vous
pouvez également importer des paramètres prédéfinis issus de fichiers XML pouvant être consultés dans Flash Professional ou partagés avec
d’autres utilisateurs InDesign.

Enregistrement de mouvements prédéfinis pour réutilisation

Les paramètres personnalisés sont visibles en haut du menu Paramètres prédéfinis, dans le panneau Animation.

1. Dans le panneau Animation, modifiez les paramètres à votre convenance.

2. Choisissez la commande Enregistrer dans le menu du panneau Animation.

3. Saisissez le nom de votre choix, puis cliquez sur le bouton OK.

Suppression de mouvements prédéfinis personnalisés
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La boîte de dialogue Gérer les paramètres prédéfinis permet de supprimer les mouvements prédéfinis que vous avez enregistrés, dupliqués ou
importés. Il est impossible de supprimer les mouvements prédéfinis installés avec InDesign (ils figurent entre parenthèses). Lorsque vous
supprimez un mouvement prédéfini, il ne figure plus ni dans le menu Paramètres prédéfinis ni sur l’ordinateur.

1. Dans le menu du panneau Animation, choisissez la commande Gérer les paramètres prédéfinis.

2. Sélectionnez le mouvement prédéfini voulu, puis cliquez sur l’option Supprimer.

Duplication de mouvements prédéfinis

1. Dans le menu du panneau Animation, choisissez la commande Gérer les paramètres prédéfinis.

2. Sélectionnez le mouvement prédéfini voulu, puis cliquez sur le bouton Dupliquer.

Enregistrement de mouvements prédéfinis dans des fichiers XML

Il est utile d’enregistrer les mouvements prédéfinis dans des fichiers XML si vous souhaitez les partager avec d’autres utilisateurs InDesign ou les
ouvrir dans Flash Professional.

Lorsque vous enregistrez un mouvement prédéfini dans un fichier XML, la trajectoire est enregistrée, de même que les paramètres Durée, Vitesse,
Mise à l’échelle, Rotation et Opacité.

1. Dans le menu du panneau Animation, choisissez la commande Gérer les paramètres prédéfinis.

2. Sélectionnez un paramètre prédéfini, puis cliquez sur le bouton Enregistrer sous.

3. Précisez le nom et l’emplacement du mouvement prédéfini, puis cliquez sur le bouton Enregistrer.

Importation de mouvements prédéfinis

Vous pouvez importer des présélections de mouvement exportées depuis InDesign ou Flash Professional sous forme de fichiers XML.

1. Dans le menu du panneau Animation, choisissez la commande Gérer les paramètres prédéfinis.

2. Cliquez sur Charger.

3. Cliquez deux fois sur le fichier .xml à importer.

Modification d’une trajectoire

Lorsque vous sélectionnez un objet animé, la trajectoire s’affiche en regard de l’objet.

Trajectoire

A. Point de départ B. Point d’arrivée 

Pour modifier une trajectoire, utilisez l’une des méthodes suivantes :

A l’aide des outils Sélection directe et Plume, modifiez la trajectoire conformément à la procédure suivie pour les tracés.
Voir la rubrique Modification des trajectoires.

Pour créer une trajectoire à partir d’un tracé existant, sélectionnez le tracé et l’objet, puis cliquez sur le bouton Convertir en
trajectoire dans le panneau Animation.

Pour modifier la direction de la trajectoire, cliquez sur le bouton Propriétés du panneau Animation, puis choisissez un

http://idiom-q-win-1/fr/indesign/using/editing-paths.html#editing_paths
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paramètre dans le menu Animation (Voir la rubrique Options de mouvement prédéfini.) Vous pouvez également
sélectionner la trajectoire et choisir la commande Objet > Tracés > Inverser le tracé. Pour inverser le tracé sans déplacer
l’objet, supprimez l’animation, inversez le tracé, puis rétablissez l’animation.

Utilisation du panneau Minutage pour modifier l’ordre d’une animation

Le panneau Minutage permet de modifier l’ordre de lecture des objets animés Ce panneau répertorie les animations figurant sur la planche active
selon l’événement de page auxquelles elles sont associées. Vous pouvez, par exemple, modifier un ensemble d’animations déclenchées lors du
chargement de la page, puis modifier un autre jeu d’animations déclenchées lors d’un clic sur la page.

Les objets animés sont recensés dans l’ordre dans lequel ils ont été créés. Par défaut, les animations associées à l’événement Au chargement de
la page sont lues de manière séquentielle. Celles associées à l’événement Au clic sur la page sont lues dans l’ordre à chaque clic sur la page.

Vous pouvez modifier l’ordre des animations, faire en sorte que des objets soient lus en même temps ou encore, retarder la lecture d’une
animation.

1. Choisissez la commande Fenêtre > Objet interactif > Minutage pour afficher le panneau Minutage.

2. Pour déterminer si le minutage des événements Au chargement de la page et Au clic sur la page doit être modifié,
sélectionnez une option dans le menu Evénement.

Les options Au chargement de la page et Au clic sur la page s’affichent uniquement si ces événements sont associés à au
moins un élément.

3. Pour modifier le minutage, utilisez l’une des méthodes suivantes :

Pour modifier l’ordre d’animation, faites glisser les éléments vers le haut ou vers le bas de la liste. Les éléments figurant
en haut de la liste sont animés en premier.

Pour retarder la lecture d’une animation, sélectionnez l’élément et indiquez le délai voulu, en secondes.

Pour lire plusieurs objets animés en même temps, sélectionnez-les dans la liste, puis cliquez sur le bouton Lire ensemble 
 afin de les lier. Pour sélectionner une plage d’éléments consécutifs, cliquez dessus en maintenant la touche Maj

enfoncée ; pour sélectionner des éléments non adjacents, cliquez dessus en maintenant la touche Ctrl (Windows)
ou Commande (Mac OS) enfoncée.

Si vous préférez que certains éléments liés soient lus séparément, sélectionnez-les et cliquez sur le bouton Lire
séparément .

Pour lire les éléments liés un certain nombre de fois ou en boucle, sélectionnez tous les éléments liés ensemble, puis
indiquez le nombre d’itérations des animations ou sélectionnez l’option En boucle.

Pour modifier l’événement utilisé pour déclencher l’animation, sélectionnez l’élément voulu, puis choisissez la
commande Réattribuer au chargement de la page ou Réattribuer au clic sur la page.

Pour supprimer un élément associé à l’événement actuellement sélectionné (Au chargement de la page ou Au clic sur la
page, par exemple), choisissez la commande Supprimer l’élément. Si l’élément n’est associé à aucun événement, il
s’affiche dans la catégorie Non attribué, disponible dans le menu Evénement.

http://creativecommons.org/licenses/by-nc-sa/3.0/
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Création de documents interactifs pour PDF
Création de formulaires PDF (CS5.5 et CS5)
Aperçu des documents interactifs
Utilisation du mode de présentation

La création d’un document PDF dynamique est un bon moyen de produire un diaporama interactif. Vous pouvez créer des documents interactifs
comportant des boutons, des séquences vidéo et audio, des hyperliens, des signets et des transitions de page. Vous pouvez également configurer
des documents dans InDesign en vue de les convertir en formulaires dans Acrobat.

Création de documents interactifs pour PDF
Vous avez la possibilité d’exporter des documents Adobe PDF contenant les fonctions interactives décrites ici.

Signets Les signets créés dans un document InDesign s’affichent sur l’onglet Signets, sur le côté gauche de la fenêtre Adobe Acrobat ou
Adobe Reader. Chaque signet renvoie à une page, un élément de texte ou une image du fichier PDF exporté (voir la section Signets).
Séquences vidéo et audio Vous pouvez ajouter des séquences vidéo et audio à un document ou encore créer des liens vers des fichiers vidéo
exécutés en continu sur Internet. Il est alors possible de lire ces séquences vidéo et audio dans le fichier PDF exporté (voir la section Films et
sons).
Hyperliens Les hyperliens présents dans un document PDF exporté permettent d’accéder directement à d’autres emplacements du même
document, à d’autres documents PDF ou à des sites Web. (voir la section Hyperliens).
Références croisées Les références croisées renvoient le lecteur d’une partie à une autre du fichier PDF exporté. Elles sont particulièrement
utiles dans les guides de l’utilisateur et les manuels de référence. Lors de l’exportation au format PDF d’un document contenant des références
croisées, celles-ci se comportent comme des hyperliens interactifs (voir la section Références croisées).
Transitions de page Les transitions de page sont des effets décoratifs, tels qu’un fondu ou un balayage, qui accompagnent le passage d’une
page à une autre dans le document PDF exporté et visualisé en mode plein écran (voir la section Transitions de page).

1. Choisissez Fichier > Exporter.

2. Entrez un nom de fichier et choisissez un emplacement.

3. Choisissez Adobe PDF (interactif) dans le menu Type (Windows) ou Format (Mac OS), puis cliquez sur Enregistrer.

4. Définissez les options voulues dans la boîte de dialogue Exporter au format PDF interactif, puis cliquez sur le bouton OK.

Options d’exportation au format PDF interactif
Les options suivantes sont disponibles dans la boîte de dialogue Exporter au format PDF interactif.

Pages Indiquez si vous voulez exporter l’ensemble des pages du document ou une série de pages. Si vous choisissez l’option Etendue, indiquez
une étendue de pages, par exemple 1-7, 9 pour inclure les pages 1 à 7 et 9 (voir la section Spécification des pages à imprimer).
Afficher après l’exportation Ouvre le fichier PDF nouvellement créé dans l’application de visualisation PDF par défaut.
Incorporer les vignettes de page  Incorpore une vignette d’aperçu pour chaque page du fichier PDF, ce qui accroît la taille du fichier. Désactivez
cette option pour les utilisateurs d’Acrobat 5.0 ou version ultérieure ; ces versions génèrent les vignettes de manière dynamique, à chaque fois
que l’utilisateur active le panneau Pages du fichier PDF.
Créer des calques Acrobat Enregistre chaque calque InDesign sous forme de calque Acrobat dans le PDF. Les calques étant entièrement
accessibles, les utilisateurs d’Adobe Acrobat 6.0 et versions ultérieures peuvent créer plusieurs versions d’un document à partir d’un seul
fichier PDF.
Créer un PDF balisé Balise automatiquement les éléments de l’article pendant l’exportation, selon un sous-ensemble de balises Acrobat pris en
charge par InDesign. Ce balisage comprend la reconnaissance des paragraphes, des options élémentaires de mise en forme du texte, des listes
et des tableaux (vous pouvez insérer et ajuster ces balises dans le document avant de l’exporter au format PDF, voir la section Ajout d’une
structure aux PDF).
Définition de l’ordre des tabulations au moyen de la structure Au cours de l’exportation, utilisez l’ordre des tabulations défini à l’aide de la
commande Objet > Objet interactif > Définir l’ordre des tabulations. Cette option s’applique uniquement aux fichiers PDF balisés.
Affichage Paramètres d’affichage initial du document PDF à l’ouverture.
l’option Modifier la mise en page Mise en page initiale du document PDF à l’ouverture.
Présentation Sélectionnez l’option Ouvrir en mode Plein écran pour afficher le document PDF sans menus ni panneaux dans Adobe Acrobat ou
Adobe Reader. Pour permettre le défilement automatique des pages, sélectionnez l’option Changer de page toutes les, puis indiquez le délai
voulu, en secondes.
Transitions de page Définissez la transition de page à appliquer à l’ensemble des pages lors de l’exportation. Si vous effectuez cette opération



Haut de la page

Haut de la page

au moyen du panneau Transitions de page, choisissez l’option Du document afin d’utiliser ces paramètres.
Boutons et multimédia Sélectionnez l’option Tout inclure pour préserver l’interactivité des séquences vidéo et audio et des boutons dans le
fichier PDF exporté. Sélectionnez l’option Aspect seulement pour inclure les boutons et les affiches vidéo dans leur état normal, en tant
qu’éléments statiques.
Compression Choisissez l’option JPEG (avec perte) pour supprimer des données de l’image, ce qui peut entraîner une baisse de la qualité
graphique. La taille du fichier est toutefois réduite avec une perte minimale d’informations. Choisissez l’option JPEG 2000 (sans perte) pour
exporter le fichier en utilisant une compression sans perte de données. Choisissez l’option Automatique pour laisser à InDesign le soin de
déterminer la qualité optimale des images en couleurs et en niveaux de gris.
Qualité JPEG Spécifie le niveau de détail de l’image exportée. Plus la qualité est grande, plus le fichier est volumineux. Cette option est
estompée si vous choisissez la compression JPEG 2000 (sans perte).
Résolution Indiquez la résolution des images bitmap dans le fichier PDF exporté. Une résolution élevée est particulièrement importante pour
permettre aux utilisateurs d’effectuer un zoom avant sur du contenu en pixels dans le fichier PDF exporté. Le choix d’une résolution élevée peut
néanmoins entraîner une augmentation significative de la taille du fichier.

Création de formulaires PDF (CS5.5 et CS5)
A l’inverse d’Adobe Acrobat, InDesign ne propose pas d’outils permettant l’ajout de champs de formulaire. Néanmoins, rien ne vous empêche de
créer, dans InDesign, un formulaire comportant des balises d’emplacements de champs pour des éléments tels que des cases d’option, des cases
à cocher et des champs de texte. Vous pouvez ensuite exporter le fichier au format PDF, puis convertir les balises d’emplacement en champs de
formulaire dans Acrobat.

1. Dans InDesign, créez le document à utiliser comme formulaire. Utilisez des tableaux et des zones de texte pour créer des
balises d’emplacement de champs.

Vous pouvez également ajouter des boutons interactifs dans InDesign.

2. Exportez le document au format Adobe PDF.

3. Lancez l’assistant de création de formulaire pour convertir les balises d’emplacement en champs de formulaire. Utilisez les
outils de formulaire pour ajouter du contenu au formulaire ou le modifier. Pour plus de détails, reportez-vous à la
documentation d’Adobe Acrobat.

Dans Acrobat X, choisissez Outils > Formulaires > Créer pour lancer l’assistant de création de formulaire.

Dans Adobe Acrobat 9, choisissez Formulaires > Lancer l’assistant de création de formulaire.

Ressources supplémentaires
Gabriel Powell propose un didacticiel vidéo intitulé InDesign and Acrobat Forms Workflow, qui explique comment créer un modèle de
formulaire PDF dans InDesign et terminer son traitement dans Adobe Acrobat.

L’équipe Acrobat fournit un article sur la Conception de formulaires pour la détection automatique de champs dans Adobe Acrobat.

Un autre didacticiel vidéo, conçu par Michael Murphy et portant sur la création de formulaires, est disponible sous le titre Acrobat Friendly Form
Design.

Vous pouvez également consulter l’article de Bob Bringhurst, Creating PDF Forms in InDesign, consacré à la création de formulaires PDF
dans InDesign.

Aperçu des documents interactifs
Utilisez le panneau Aperçu pour prévisualiser l’interactivité et l’animation de la sélection en cours, de la planche active ou du document complet.
Vous pouvez redimensionner ou ancrer le panneau Aperçu, le transformer en panneau flottant ou encore, l’afficher sur un second moniteur.

1. Choisissez la commande Fenêtre > Objet interactif > Aperçu.

2. Pour afficher un aperçu de l’interactivité et de l’animation, utilisez l’une des méthodes suivantes :

Cliquez sur le bouton Définir le mode d’aperçu de la sélection  pour afficher un aperçu de la sélection en cours.

Cliquez sur le bouton Définir le mode d’aperçu de la planche  pour afficher un aperçu de la planche en cours.

Cliquez sur le bouton Définir le mode d’aperçu du document  pour afficher un aperçu du document en cours.

3. Cliquez sur le bouton Lecture de l’aperçu  pour lire l’aperçu de la sélection, de la planche ou du document. Au besoin,
cliquez sur les éléments interactifs du panneau Aperçu, comme les boutons, afin de vérifier leur fonctionnement.

Si vous affichez un aperçu du document, vous pouvez cliquez sur les flèches Atteindre la page précédente et Atteindre la
page suivante au bas du panneau pour visualiser d’autres pages.

Lors de la modification du document, vous pouvez actualiser l’aperçu en cliquant sur le bouton Lecture de l’aperçu du panneau Aperçu.

Aperçu d’un document dans un navigateur Web

http://www.adobe.com/designcenter/cs4/articles/lrvid4434_ds.html
http://www.acrobatusers.com/tutorials/designing-forms-auto-field-detection-adobe-acrobat
http://www.theindesigner.com/blog/episode-52-acrobat-friendly-form-design
http://www.theindesigner.com/blog/episode-52-acrobat-friendly-form-design
http://blogs.adobe.com/indesigndocs/2009/05/creating_pdf_forms_in_indesign.html
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1. Dans le menu du panneau Aperçu, choisissez la commande Test dans le navigateur.

2. Cliquez sur les éléments interactifs du document afin de vérifier leur fonctionnement.

Modification des paramètres d’aperçu
1. Choisissez la commande Modifier les paramètres d’aperçu dans le menu du panneau Aperçu.

La boîte de dialogue Paramètres d’aperçu indique les paramètres actuels de la boîte de dialogue Exporter au format SWF.

2. Modifiez les paramètres à votre convenance (voir la section Options d’exportation au format SWF).

Utilisation du mode de présentation
Le mode de présentation permet de visualiser le document InDesign actif sous forme de présentation. Dans ce mode, la barre de menus de
l’application, les panneaux, les repères et les contours de bloc sont masqués. Une couleur sombre est appliquée par défaut à la zone d’arrière-
plan au cas où les dimensions de votre document seraient différentes de celles de votre moniteur.

Le mode de présentation est le complément idéal à la fonction d’Adobe Connect. Vous pouvez démarrer une réunion en ligne à l’aide de la
commande Fichier > Partager mon écran. Une fois que le partage d’écran a débuté, vous pouvez afficher votre document InDesign en mode de
présentation.

1. Choisissez la commande Affichage > Mode de l’écran > Présentation.

2. Utilisez l’une des touches suivantes :

Action Fonction

Clic de souris, flèche droite ou Pg suiv Planche suivante

Maj-clic, clic avec le bouton droit de la souris, flèche
gauche ou Pg préc

Planche précédente

Echap Sortie du mode de présentation

Origine Première planche

Fin Dernière planche

B Utilisation du noir comme couleur
d’arrière-plan

W Utilisation du blanc comme couleur
d’arrière-plan

G Utilisation du gris comme couleur
d’arrière-plan

Il est impossible de modifier le document en mode de présentation. Néanmoins, si vous disposez d’un moniteur à double écran, rien ne vous
empêche d’afficher le même document dans deux fenêtres, dont l’une en mode de présentation. Vous pouvez ainsi modifier le document dans
la fenêtre en mode d’affichage normal et visualiser immédiatement les résultats dans la fenêtre en mode de présentation.

Voir aussi

Informations juridiques   |   Politique de confidentialité en ligne

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://helpx.adobe.com/fr/legal/legal-notices.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr
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Regroupement d’éléments de page en un élément Article

Ajout d’une structure aux PDF
Lorsque vous exportez un fichier au format Adobe PDF et que vous activez l’option Créer PDF balisé dans la zone Général de la boîte de dialogue
Exporter au format Adobe PDF, InDesign ajoute automatiquement aux pages exportées un ensemble de balises de structure fournissant une
description du contenu et permettant d’identifier les différents éléments de page, tels que les titres, les articles et les images. Pour ajouter des
balises supplémentaires ou régler les balises existantes avant l’exportation, utilisez le panneau Balises d’InDesign. Le volet Structure (Affichage >
Structure > Afficher la structure) permet de visualiser le résultat obtenu suite aux modifications effectuées.

Vous pouvez améliorer l’accessibilité et les possibilités de réutilisation des documents Adobe PDF en ajoutant des balises aux documents
InDesign avant de les exporter. Si le document PDF ne contient pas de balises, il se peut qu’Adobe Reader ou Adobe Acrobat tente de le baliser
lorsque l’utilisateur essaie de le lire ou de le redistribuer, mais les résultats risquent d’être décevants. Si le fichier Adobe PDF ne donne pas les
résultats escomptés, vous pouvez utiliser les outils disponibles dans Acrobat 6.0 Professional ou version ultérieure, pour modifier la structure du
document PDF balisé. Utilisez Acrobat 9 Professional pour bénéficier des outils les plus avancés.

Lorsque vous appliquez des balises à un document à exporter au format PDF, ces balises ne déterminent pas quel est le contenu à exporter,
comme c’est le cas avec l’exportation XML. Elles fournissent simplement à Acrobat des informations supplémentaires sur la structure du
document.

Avantages de l’utilisation des balises
En appliquant des balises à un document avant de l’exporter au format PDF, vous pouvez :

Mettre en correspondance les styles de paragraphe InDesign et les balises Adobe PDF afin de créer un fichier PDF dont le
contenu peut être redistribué en vue de l’adapter à des appareils de poche et à d’autres supports.

Baliser et masquer les artefacts d’impression, le texte et les images pour qu’ils n’apparaissent pas une fois le contenu
redistribué au format Acrobat. Par exemple, si vous attribuez une balise de type Artefact à un élément dans un document, puis
que vous créez un fichier Adobe PDF balisé à partir de ce document, l’élément en question ne s’affichera pas une fois le
contenu du PDF redistribué sur un appareil de poche, sur un petit écran ou sur un moniteur standard à un niveau de zoom
élevé.

Associer à une image un texte de remplacement destiné à être lu à voix haute par un logiciel de lecture d’écran pour
malvoyants.

Remplacer les lettres graphiques, telles que les lettrines ornées, par des lettres pouvant être lues à voix haute.

Donner un titre à un ensemble d’articles ou regrouper vos articles et illustrations sous forme de reportages.

Classer vos articles et illustrations afin de définir un ordre de lecture.

Permettre l’identification des tableaux, des listes mises en forme et des tables des matières. Associer les différents blocs de
contenu aux articles dont ils dépendent.

Intégrer d’autres informations de mise en forme de texte, notamment les valeurs Unicode des caractères, l’intermots et la
distinction entre les traits d’union et les tirets conditionnels.

Importance des balises en termes de réutilisation et d’accessibilité
Le contenu d’un document Adobe PDF peut être réutilisé de différentes manières suivant les besoins. Vous pouvez, par exemple, créer un fichier
Adobe PDF d’un rapport comportant du texte, des tableaux et des images et le diffuser sous différents formats : impression ou affichage sur un
moniteur de bureau, affichage sur un appareil de poche, lecture à voix haute à l’aide d’un lecteur d’écran et accès direct, sous forme de pages
HTML, au moyen d’un navigateur Web. Lorsque l’on tente de réutiliser du contenu, on obtient des résultats plus ou moins satisfaisants suivant la
qualité de la structure logique sous-jacente du document.

Pour vous assurer que les documents Adobe PDF pourront être correctement réutilisés, vous devez leur ajouter des balises. L’ajout de balises
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permet de définir la structure logique, ou structure organisationnelle sous-jacente, du document. La structure logique correspond à l’organisation
du contenu du document (page de titre, chapitres, sections, sous-sections, etc.). Elle peut être utilisée pour définir un ordre de lecture précis et
faciliter la navigation, notamment si le document est long et complexe, sans pour autant modifier l’aspect du PDF.

Les personnes souffrant de déficiences visuelles qui éprouvent des difficultés à lire les documents peuvent avoir recours à des dispositifs
d’assistance destinés à rendre le contenu accessible. La plupart des dispositifs d’assistance s’appuient sur la structure logique d’un document
pour faire passer le sens du texte ou d’une image sous une forme alternative, par exemple sous forme audio. Dans un document non balisé, une
telle structure n’existe pas : Acrobat doit déterminer comment le document est agencé sur la base des paramètres d’ordre de lecture définis dans
les préférences. Cette méthode n’est pas fiable et, dans de nombreux cas, les différents éléments de page sont lus dans un ordre incorrect ou ne
peuvent tout simplement pas être lus.

Les balises s’affichent au niveau de l’onglet Balises d’Acrobat 6.0 ou version ultérieure et sont imbriquées suivant les paramètres de liaison définis
pour chacun des éléments balisés. Il est impossible de modifier les balises dans Acrobat Standard. Si vous devez travailler directement avec des
balises, utilisez Adobe Acrobat 9 Professional. Pour plus de détails, reportez-vous à l’Aide d’Acrobat.

Structure logique affichée sur l’onglet Balises dans Acrobat 9

Remarque : les balises utilisées dans les fichiers Adobe PDF peuvent être comparées à celles utilisées dans les fichiers HTML et XML. Pour en
savoir plus sur les concepts fondamentaux du balisage de documents, consultez les nombreux ouvrages de référence disponibles en librairie,
dans les bibliothèques et sur Internet.

Principes de base et méthodes d’optimisation de la redistribution
Vous pouvez redistribuer le contenu d’un document PDF de sorte que celui-ci puisse être lu sur un appareil de poche, sur un écran de petite taille
ou sur un moniteur standard à un niveau de zoom élevé, sans qu’il soit nécessaire de faire défiler les lignes dans le sens horizontal.

Lorsque vous redistribuez le contenu d’un document Adobe PDF, certains éléments du contenu sont réagencés et d’autres non. Dans la plupart
des cas, seul le texte « exploitable » est réagencé dans un document redistribué. Le texte exploitable inclut les articles, les paragraphes, les
tableaux, les images et les listes mises en forme. En revanche, les éléments suivants ne sont pas réagencés : numéros de page, en-têtes et pieds
de page (artefacts), mais aussi champs de formulaire, de commentaire et de signature numérique. Les pages contenant à la fois du texte
exploitable et des champs de formulaire ou de signature numérique ne sont pas redistribuées. Le texte vertical est redistribué horizontalement.

En tant qu’auteur, vous pouvez optimiser les documents PDF pour la redistribution en y insérant des balises. L’insertion de balises permet de
s’assurer que les blocs de texte sont correctement réagencés et que le contenu se présente dans l’ordre prévu, de sorte que les lecteurs puissent
suivre le fil d’un article qui s’étend sur plusieurs pages et plusieurs colonnes sans que le cours de la lecture soit interrompu pas d’autres articles.
L’ordre de lecture est défini au niveau de la structure du document ; il est possible de modifier cette structure par le biais du volet Structure.
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Les titres et les colonnes (en haut) sont redistribués suivant l’ordre de lecture logique (en bas).

Balisage d’éléments de page
Vous pouvez baliser des blocs de texte et des blocs graphiques automatiquement ou manuellement. Après avoir balisé des éléments de page,
vous pouvez utiliser le volet Structure pour modifier l’ordre de votre page en faisant glisser les éléments vers un nouvel emplacement dans la
hiérarchie. Si vous modifiez l’ordre des éléments dans le volet Structure, ces modifications seront prises en compte dans le fichier Adobe PDF.
L’ordre des éléments est utile lorsque le fichier PDF est enregistré en tant que fichier HTML ou XML à partir d’Acrobat. Il l’est également lors de
l’exportation d’un document InDesign pour Dreamweaver (XHTML) ou Digital Editions (EPUB).

Pour baliser des éléments de page automatiquement
Lorsque vous choisissez la commande Ajouter les éléments sans balise, InDesign ajoute des balises au panneau Balises et applique les balises
Article et Image à certains éléments de page sans balise. La balise Article est appliquée à tout bloc de texte non balisé et la balise Image est
appliquée à tout graphique non balisé. Vous pouvez ensuite appliquer manuellement d’autres balises à des sections de texte. Néanmoins, le
balisage automatique des éléments de page ne garantit pas que les éléments seront structurés en conséquence dans le fichier PDF exporté.

1. Choisissez la commande Fenêtre > Utilitaires > Balises pour afficher le panneau Balises.
2. Pour afficher le volet Structure, choisissez Affichage > Structure > Afficher la structure (le volet apparaît sur le côté gauche de

la fenêtre Document).
3. Choisissez Ajouter les éléments sans balise dans le menu du volet Structure.
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Balises répertoriées dans le volet Structure et le panneau Balises

Pour baliser des éléments de page manuellement
1. Choisissez la commande Fenêtre > Utilitaires > Balises pour afficher le panneau Balises.
2. Pour afficher le volet Structure, choisissez Affichage > Structure > Afficher la structure (le volet apparaît sur le côté gauche de

la fenêtre Document).
3. Choisissez Ajouter les éléments sans balise dans le menu du volet Structure.
4. Sélectionnez un élément de page dans le document.
5. Sélectionnez une balise dans le panneau Balises. Tenez compte des suggestions d’usage suivantes pour certains types de

balises importées :
Artefact Cette balise permet de masquer les éléments de page, tels que les numéros de page ou les objets de moindre
importance, lorsque vous affichez le fichier PDF exporté dans une vue redistribuée ; seuls les éléments balisés sont visibles
(voir la documentation d’Adobe Acrobat). Elle est particulièrement pratique pour consulter les fichiers PDF sur un appareil de
poche ou d’autres lecteurs PDF.

Cellule Utilisez cette balise pour l’identification des cellules de tableau.

Image Cette balise convient aux graphiques importés. La balise Image est appliquée à tous les blocs graphiques sans balise
figurant dans le document lorsque vous sélectionnez l’option Ajouter les éléments sans balise.

Balises Paragraphe (P, H, H1-H6) Ces balises n’ont aucun effet sur le texte PDF exporté affiché dans une vue redistribuée.
Néanmoins, elles peuvent parfois être utiles lors de l’exportation d’un fichier PDF au format HTML.

Article Cette balise convient aux articles. La balise Article est appliquée à tous les blocs de texte sans balise lorsque vous
sélectionnez l’option Ajouter les éléments sans balise. Supposons, par exemple, que votre document InDesign comporte trois
styles de paragraphe : Head1, Head2 et Body. Commencez par associer les styles de paragraphe aux balises H1, H2 et P
respectivement. Exportez ensuite le document au format PDF. Lorsque vous aurez exporté le document PDF au format HTML
ou XML dans Acrobat, les paragraphes dotés des balises H1, H2 et P seront affichés de la façon appropriée (caractères gras
de grande taille pour H1, par exemple) dans un navigateur Web. Pour plus de détails sur l’exportation du document PDF au
format HTML ou XML, reportez-vous à la documentation d’Adobe Acrobat.

Ajout d’un libellé aux graphiques pour une prise en charge par un lecteur d’écran
Pour faire en sorte qu’un lecteur d’écran puisse décrire les éléments graphiques illustrant les aspects importants du document, vous devez fournir
les descriptions correspondantes. Les images et les séquences multimédias ne seront pas reconnues ou ne pourront pas être décrites par un
lecteur d’écran si le texte de remplacement n’a pas été fourni au niveau des propriétés de la balise.

L’attribut Alt text vous permet de créer un texte destiné à se substituer à une image. L’attribut ActualText est similaire à l’attribut Alt text dans le
sens où le texte défini apparaît également à la place d’une image, mais ce texte se substitue à une image faisant partie d’un mot, comme c’est le
cas pour les lettrines. Dans cet exemple, l’attribut ActualText fait en sorte que la lettrine soit lue comme faisant partie du mot.

Lorsque vous exportez un fichier au format Adobe PDF, les valeurs des attributs Alt text et ActualText sont enregistrées dans le fichier PDF et
peuvent être consultées dans Acrobat 6.0 ou toute version ultérieure. Ces informations textuelles peuvent alors être utilisées lorsque le fichier PDF
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est enregistré en tant que fichier HTML ou XML à partir d’Acrobat. Pour plus de détails, reportez-vous à la documentation d’Adobe Acrobat.

1. Au besoin, choisissez la commande Affichage > Structure > Afficher la structure pour afficher le volet Structure, puis
sélectionnez la commande Fenêtre > Utilitaires > Balises pour afficher le panneau Balises.

2. Choisissez Ajouter les éléments sans balise dans le menu du volet Structure.
3. Pour vous assurer que l’image porte la balise Image, sélectionnez l’image, puis sélectionnez Image dans le panneau Balises.
4. Sélectionnez l’élément Image dans le volet Structure, puis choisissez Nouvel attribut dans le menu du volet Structure.
5. Dans le champ Nom, tapez soit Alt, soit ActualText (cette fonction est sensible à la casse).
6. Dans le champ Valeur, saisissez le texte qui s’affichera à la place de l’image.

Regroupement d’éléments de page en un élément Article
Utilisez le volet Structure pour regrouper logiquement des éléments de page en un élément Article. Par exemple, si un ensemble d’articles occupe
plusieurs pages, vous pouvez créer un élément parent qui réunira ces articles en un seul groupe. Ces éléments sont appelés éléments structurels.
Vous pouvez également nommer vos articles groupés.
Remarque : il est impossible de baliser un groupe d’éléments de page.

Pour grouper des éléments de page, sélectionnez Nouvel élément dans le menu du volet Structure, sélectionnez l’élément
Article dans le panneau Balises, puis faites glisser des éléments de page pour les positionner sous cet élément dans le volet
Structure.
Pour attribuer un nom à un groupe d’éléments, cliquez avec le bouton droit sur l’élément Article dans le volet Structure, puis
sélectionnez Nouvel attribut. Dans le champ Nom, saisissez Titre. Dans le champ Valeur, saisissez le nom à attribuer à
l’article.

Voir aussi
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Réédition des liens de fichiers multimédias hérités

Ajout de fichiers vidéo et audio à des documents
Les séquences vidéo et audio que vous ajoutez à un document sont exécutables une fois ce dernier exporté au format Adobe PDF, SWF ou XML
(dans ce cas, une adaptation des balises est nécessaire).

Vous pouvez importer des fichiers vidéo au format vidéo Flash (.FLV et .F4V), des fichiers codés en H.264 (MP4, par exemple) et des
fichiers SWF. Vous pouvez également importer des fichiers audio au format MP3. Les types de fichier multimédia tels que QuickTime (.MOV), AVI
et MPEG sont pris en charge dans les fichiers PDF interactifs exportés, mais pas dans les fichiers SWF ou FLA exportés. Il est recommandé de
privilégier les formats de fichier FLV, F4V, SWF, MP4 et MP3 pour profiter pleinement des capacités de prise en charge de contenu multimédia
offertes par Acrobat 9, Adobe Reader 9 et Adobe Flash Player 10 ou version ultérieure.

Assurez le suivi des fichiers multimédias que vous ajoutez à un document InDesign au cours du cycle de production. Si vous déplacez une
séquence multimédia liée après l’avoir ajoutée au document, utilisez le panneau Liens pour redéfinir son lien. Si vous devez transmettre le
document InDesign à une autre personne, envoyez également tout fichier multimédia ajouté à ce document.

Ajout d’un fichier vidéo ou audio
1. Choisissez Fichier > Importer, puis cliquez deux fois sur le fichier vidéo ou audio requis. Cliquez à l’endroit où vous souhaitez

que la séquence vidéo apparaisse. Si vous utilisez la méthode glisser-déplacer pour créer le bloc multimédia, le contour de la
séquence risque d’être tronqué ou de travers.

Lorsque vous importez un fichier audio ou vidéo dans un document, un objet multimédia apparaît dans un bloc. Cet objet
constitue le lien avec le fichier multimédia. Vous pouvez le redimensionner en fonction de la taille de la zone de lecture
requise

Si le point central de la séquence vidéo est situé en dehors de la page, la séquence ne sera pas exportée.

2. Affichez un aperçu du fichier multimédia et modifiez les paramètres voulus au moyen du panneau Multimédia (Fenêtre > Objet
interactif > Multimédia).

3. Exportez le document au format Adobe PDF ou SWF.

Si vous exportez le document au format Adobe PDF, choisissez l’option Adobe PDF (interactif), non l’option Adobe PDF
(impression) (voir la section Création de documents interactifs pour PDF).

Modification des paramètres vidéo
Utilisez le panneau Multimédia pour modifier les paramètres vidéo.

1. Sélectionnez l’objet vidéo dans le document.

2. Dans le panneau Multimédia, les options disponibles sont les suivantes :

Lire au chargement de la page La séquence vidéo est lue lors de la consultation de la page sur laquelle elle figure. Si
d’autres éléments doivent être lus au chargement de la page, déterminez l’ordre de lecture au moyen du panneau Minutage.

En boucle La séquence vidéo est lue de manière répétée. Si le fichier source est au format vidéo Flash, il est possible
d’effectuer une lecture en boucle de la séquence dans les fichiers SWF exportés mais pas dans les fichiers PDF.

Affiche Cette option permet de spécifier le type d’image à afficher dans la zone de lecture de la séquence (voir la section
Options d’affiche).

Barre de contrôle Si le fichier vidéo est au format vidéo Flash (FLV ou F4V) ou codé en H.264, vous pouvez spécifier des
habillages de barre de contrôle prédéfinis qui permettront aux utilisateurs de suspendre, de démarrer ou d’arrêter la séquence
par divers moyens. L’option Afficher la barre de contrôle au survol permet de faire en sorte que les commandes s’affichent
lorsque le pointeur de la souris passe sur l’objet multimédia. Utilisez le panneau Aperçu pour afficher un aperçu de l’habillage
de barre de contrôle sélectionné.

Si la séquence vidéo se présente dans un format hérité (.AVI ou .MPEG, par exemple), vous pouvez choisir l’option Sans ou
Afficher la barre de contrôle pour afficher une barre de contrôle standard permettant aux utilisateurs de suspendre, de



démarrer ou d’arrêter la séquence.

Les fichiers SWF que vous importez peuvent posséder leurs propres habillages de barre de contrôle. Utilisez le
panneau Aperçu pour tester les options de barre de contrôle.

Points de navigation Pour créer un point de navigation, faites défiler la séquence vidéo jusqu’à l’image voulue, puis cliquez
sur l’icône du signe plus. Les points de navigation sont utiles pour démarrer la lecture d’une séquence vidéo à partir d’un autre
point. Lorsque vous créez un bouton de lecture vidéo, vous pouvez utiliser l’option Lire à partir du point de navigation pour
faire en sorte que la lecture de la vidéo commence au point de navigation que vous ajoutez.

Modification des paramètres audio
Utilisez le panneau Multimédia pour modifier les paramètres audio.

1. Sélectionnez l’objet audio dans le document.

2. Dans le panneau Multimédia, les options disponibles sont les suivantes :

Lire au chargement de la page Le fichier audio est lu lors de la consultation de la page sur laquelle figure l’objet audio. Si
d’autres éléments doivent être lus au chargement de la page, déterminez l’ordre de lecture au moyen du panneau Minutage.

Arrêter au changement de page La lecture du fichier audio MP3 s’interrompt lors du chargement d’une autre page. Cette
option est estompée lorsque le fichier audio n’est pas au format MP3.

En boucle Cette option permet de lire le fichier audio MP3 de manière répétée. Elle est estompée lorsque le fichier source
n’est pas au format MP3.

Affiche Cette option permet de spécifier le type d’image à afficher dans la zone de lecture de la séquence (voir la section
Options d’affiche).

Options d’affiche
Une affiche est une image représentant une séquence multimédia. Elle n’est pas obligatoire, une séquence audio ou vidéo pouvant apparaître
sans affiche. Si l’affiche dans InDesign est plus grande que la séquence vidéo, elle est rognée aux dimensions de cette dernière dans le
fichier PDF ou SWF exporté. Choisissez l’un des types d’affiche suivants dans le panneau Multimédia.

Aucune La séquence audio ou vidéo n’est représentée par aucune affiche. Cette option est utile si vous souhaitez que la séquence ne soit pas
visible sur la page. Par exemple, utilisez-la pour que la séquence soit lue lorsque vous tournez la page uniquement ou pour afficher un graphisme
plus complexe au-dessous de la séquence.
Standard La séquence audio ou vidéo est représentée par une affiche générique qui n’est pas basée sur son contenu.

Pour utiliser une autre affiche standard, enregistrez une image au format .jpg en lui attribuant le même nom qu’un fichier d’affiche existant, puis
remplacez ce dernier (ces fichiers se trouvent dans le dossier Presets/Multimedia du dossier de l’application).

De l’image en cours Sélectionnez cette option pour utiliser l’image actuellement affichée dans la zone d’aperçu du panneau Multimédia. Pour
sélectionner une autre image, déplacez le curseur d’aperçu et cliquez sur l’icône à droite du menu Affiche. Cette option n’est pas disponible pour
les formats vidéo hérités comme AVI et MPEG.
Sélectionner une image Cette option vous permet de choisir l’image à utiliser comme affiche. Cliquez deux fois sur l’image à utiliser. Vous
pouvez utiliser des images bitmap comme affiches, mais pas des images vectorielles.
[De la vidéo] Cette option est sélectionnée pour les documents CS4 convertis ayant des séquences multimédias définies sur une image
particulière.

Modification des paramètres multimédias des fichiers PDF interactifs
1. Choisissez la commande Options PDF dans le menu du panneau Multimédia.

2. Définissez les options suivantes, puis cliquez sur le bouton OK.

Description Saisissez la description à afficher s’il est impossible de lire le fichier multimédia dans Acrobat. Cette description
constitue également une aide supplémentaire pour les utilisateurs malvoyants.

Lire la vidéo dans une fenêtre flottante Lancez la lecture de la séquence dans une fenêtre séparée. Dans ce cas, précisez
la position et la taille de cette fenêtre. Notez qu’une taille importante peut altérer la qualité de l’image. L’échelle de la fenêtre
flottante est basée sur la taille de la séquence d’origine, non la taille de la séquence mise à l’échelle dans la mise en page du
document. Cette option n’est pas disponible pour les fichiers SWF, ni pour les fichiers audio.

Importation d’un fichier vidéo à partir d’une URL
Importez un fichier vidéo à partir d’une adresse URL valide pour lire la séquence vidéo diffusée en continu dans le fichier PDF ou SWF exportée.
La séquence vidéo doit correspondre à un fichier vidéo Flash valide (FLV ou F4V) ou codé en H.264 (MP4, par exemple).

1. Sélectionnez une image vide ou un objet vidéo contenant une vidéo que vous voulez remplacer.

2. Choisissez la commande Vidéo à partir d’une URL dans le menu du panneau Multimédia.

3. Définissez l’adresse URL, puis cliquez sur le bouton OK.
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Redimensionnement d’objets vidéo, d’affiches ou de blocs
Lorsque vous ajoutez une séquence vidéo à un document InDesign, l’objet et l’affiche apparaissent dans un bloc. Lorsque vous exportez le
document au format PDF, le cadre de l’objet vidéo détermine la taille de la séquence dans le document PDF, mais pas la taille du bloc ou de
l’affiche.

Pour obtenir de meilleurs résultats, faites en sorte que la taille de l’affiche soit identique à celle de la séquence vidéo. Si vous appliquez un
masque à l’image ou si vous la redimensionnez, ces modifications risquent d’être ignorées dans le document PDF exporté.

Les séquences vidéo sont affichées sur le calque supérieur du document PDF. Si, dans InDesign, vous superposez un autre objet à une séquence
vidéo, cet objet apparaîtra en dessous de la séquence dans le fichier PDF exporté.

Si le document PDF doit comporter une zone de lecture avec des contours progressifs ou autres effets difficilement exportables dès lors qu’ils
sont appliqués à une affiche, utilisez une image importée dans la zone de lecture, puis placez la séquence vidéo (sans affiche) sur cette image.

Redimensionnement d’un objet vidéo
A.  Affiche B.  Objet vidéo C.  Bloc

 Utilisez l’une des méthodes suivantes :

Pour redimensionner l’objet vidéo, l’affiche et le bloc, faites glisser l’une des poignées d’angle à l’aide de l’outil Mise à l’échelle 
 (maintenez la touche Maj enfoncée pour conserver les proportions).

Pour redimensionner le bloc uniquement, faites glisser une poignée d’angle à l’aide de l’outil Sélection .

Pour redimensionner l’affiche ou l’objet multimédia, utilisez l’outil Sélection directe  pour sélectionner l’affiche. Basculez sur
l’outil Sélection, puis faites glisser une poignée d’angle.

Vous pouvez également utiliser les commandes d’ajustement (Objet > Ajustement) pour redimensionner une affiche dans
un bloc.

Réédition des liens de fichiers multimédias hérités
Dans InDesign, les formats vidéo FLV et F4V et les formats audio MP3 sont particulièrement adaptés à l’exportation de documents interactifs. Les
formats vidéo de type MOV, AVI et MPG peuvent être exportés au format PDF, mais pas dans des formats basés sur Flash, comme le
format SWF.

Utilisez Adobe Media Encoder pour convertir les fichiers vidéo au format FLV, F4V ou MP4. S’agissant des formats de fichier audio, utilisez une
application comme Apple iTunes pour les convertir au format MP3, Adobe Media Encoder ne prenant pas en charge ce type de conversion.

1. Ouvrez Adobe Media Encoder, ajoutez les fichiers vidéo requis, puis convertissez-les au format FLV ou F4V.

Pour plus de détails, voir l’aide d’Adobe Media Encoder.

2. Utilisez l’une des méthodes suivantes :

Importez le fichier multimédia dans un document InDesign (voir la section Ajout de fichiers vidéo et audio à des
documents).

Si les fichiers vidéo ont déjà été importés dans un document InDesign, rééditez les liens des fichiers à l’aide du
panneau Liens afin qu’ils pointent vers leurs nouvelles versions (voir la section Mise à jour, restauration et remplacement
de liens).

Voir aussi
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Création de signets pour un document PDF
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Création de signets pour un document PDF
Un signet est un type de lien avec un texte représentatif qui facilite la consultation des documents exportés au format Adobe PDF. Les signets
créés dans un document InDesign s’affichent sur l’onglet Signets, sur le côté gauche de la fenêtre Acrobat ou Adobe Reader. Chaque signet
permet d’accéder à une ancre de texte ou à une page.

Les entrées d’une table des matières générée sont automatiquement ajoutées au panneau Signets. Vous pouvez également définir des signets
supplémentaires pour attirer l’attention du lecteur sur un élément particulier ou pour simplifier encore davantage la consultation d’un document.
Des signets peuvent être imbriqués sous d’autres signets.

Vous pouvez cependant décider de faire figurer les signets dans l’onglet Signets du document PDF, mais de ne pas faire apparaître la table
des matières dans le fichier PDF. Dans ce cas, créez une table des matières sur la dernière page du document. Il vous suffit ensuite de ne pas
inclure cette dernière page lors de l’exportation du document au format PDF. Si vous avez inclus cette page dans le document PDF exporté,
l’autre possibilité consiste à la supprimer dans Acrobat.

1. Choisissez la commande Fenêtre > Objet interactif > Signets pour afficher le panneau Signets.
2. Cliquez sur le signet qui doit précéder le nouveau signet, faute de quoi ce dernier sera automatiquement inclus à la fin de la

liste.
3. Utilisez l’une des méthodes suivantes pour définir la cible du signet :

Cliquez dans le texte pour marquer le point d’insertion.

Sélectionnez du texte. Par défaut, le texte sélectionné est utilisé comme libellé du signet.

Cliquez deux fois sur une page du panneau Pages pour l’afficher dans la fenêtre du document.

4. Utilisez l’une des méthodes suivantes pour créer le signet :

Cliquez sur l’icône Créer un nouveau signet du panneau Signets.

Choisissez la commande Nouveau signet dans le menu du panneau.

Les signets sont visibles dans l’onglet Signets, à l’ouverture du fichier PDF exporté dans Adobe Reader ou Acrobat.

Remarque : lors de la mise à jour d’une table des matières, les signets sont réorganisés ; ceux qui ont été générés à partir de la table des
matières sont affichés en fin de liste.

Gestion des signets
Utilisez le panneau Signets pour renommer, supprimer et organiser les signets.

Pour renommer un signet
 Cliquez sur le signet souhaité dans le panneau Signets, puis choisissez Renommer le signet dans le menu du panneau.

Pour supprimer un signet
 Cliquez sur le signet souhaité dans le panneau Signets, puis choisissez Supprimer le signet dans le menu du panneau.

Pour organiser, regrouper et trier les signets
Vous avez la possibilité d’imbriquer une liste de signets pour indiquer le lien entre diverses sections d’un document. Cette opération permet de
créer des listes hiérarchiques basées sur une relation parent/enfant. Vous pouvez développer ou réduire ces listes au gré de vos besoins. La
modification de l’ordre des signets imbriqués n’a aucune incidence sur l’aspect du document.

 Utilisez l’une des méthodes suivantes :

Pour développer ou réduire la structure hiérarchique des signets, cliquez sur le triangle situé en regard de l’icône
correspondant au signet dont vous souhaitez afficher ou masquer les signets enfants.

Pour imbriquer un signet dans un autre signet, sélectionnez le signet ou le groupe de signets à imbriquer, puis faites glisser
l’icône ou les icônes vers le signet parent. Relâchez le bouton de la souris.



 

Le ou les signets déplacés sont imbriqués dans le signet parent, sans toutefois entraîner le déplacement des pages cibles de
leur position d’origine.

Imbrication de signets dans un signet parent du panneau Signets

Pour modifier l’emplacement d’imbrication d’un signet, sélectionnez le signet ou le groupe de signets à déplacer. Faites glisser
les icônes correspondantes au-dessous puis sur la gauche du signet parent. Une barre noire apparaît, indiquant le nouvel
emplacement des signets. Relâchez le bouton de la souris.

Pour modifier l’ordre des signets, sélectionnez un signet et faites-le glisser vers son nouvel emplacement. Une barre noire
apparaît, indiquant le nouvel emplacement du signet.

Pour trier les signets, choisissez Trier les signets dans le menu du panneau Signets. Les signets s’affichent dans l’ordre des
pages auxquelles ils renvoient.

Voir aussi

Informations juridiques   |   Politique de confidentialité en ligne

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://helpx.adobe.com/fr/legal/legal-notices.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr


Dessiner et peindre



Dessin à l’aide de l’outil Trait et des outils de forme

Haut de la page

Haut de la page

Création de traits et de formes de base
Tracé de plusieurs objets sous la forme d’une grille
Dessin d’un emplacement réservé
Définition des paramètres de polygone
Modification automatique de la forme d’un tracé

Création de traits et de formes de base
1. Dans le panneau Outils, utilisez l’une des méthodes suivantes :

Pour dessiner une ligne ou une forme, sélectionnez l’outil Trait , l’outil Ellipse , l’outil Rectangle  ou l’outil
Polygone  (cliquez sur l’outil Rectangle et maintenez le bouton de la souris enfoncé pour sélectionner l’outil Ellipse
ou Polygone).

Pour dessiner un bloc graphique de substitution (vide), sélectionnez l’outil Bloc elliptique , l’outil Bloc rectangulaire  ou
l’outil Bloc polygonal .

2. Faites glisser le pointeur dans la fenêtre de document pour créer le tracé ou le bloc.

Pour dessiner le tracé ou bloc à partir de son centre, maintenez la touche Alt (Windows) ou Option (Mac OS) enfoncée.

Pour limiter les angles d’un trait à 45 degrés ou pour limiter la largeur et la hauteur d’un tracé ou d’un bloc aux mêmes
proportions, maintenez la touche Maj enfoncée tout en faisant glisser la souris.

Pour créer plusieurs formes dans une grille, appuyez sur les touches fléchées tout en maintenant le bouton de la souris
enfoncé (voir la section Tracé de plusieurs objets sous la forme d’une grille).

Pour modifier le nombre de côtés d’un polygone, faites glisser le polygone, appuyez sur la barre d’espace puis sur les
touches flèche haut ou flèche bas. Appuyez sur les touches flèche gauche et flèche droite pour modifier la marge en
étoile. Appuyez de nouveau sur la barre d’espace pour revenir en mode grille.

Création d’un cercle par glissement

Remarque : le résultat ci-dessus affiche un cadre de sélection autour du tracé. Si l’outil Sélection  est activé, le cadre de sélection est visible. Si
l’outil Sélection directe  a été utilisé en dernier, le tracé apparaît avec des points d’ancrage.

Tracé de plusieurs objets sous la forme d’une grille
Lors de l’utilisation des outils de création de bloc, comme les outils Rectangle ou Texte, vous pouvez créer une grille composée de blocs espacés
de manière égale à l’aide des touches de modification.

Pour consulter une vidéo sur la création d’objets dans une grille, rendez-vous à l’adresse http://tv.adobe.com/go/4949/.

1. Sélectionnez un outil de création de bloc.

2. Commencez à faire glisser la souris. Tout en maintenant le bouton de la souris enfoncé, utilisez l’une des méthodes
suivantes :

Appuyez sur les touches flèche gauche et flèche droite pour modifier le nombre de colonnes. Appuyez sur les touches
flèche haut et flèche bas pour modifier le nombre de lignes.

Tout en maintenant la touche Ctrl (Windows) ou Commande (Mac OS) enfoncée, appuyez sur les touches fléchées pour
modifier l’espacement des blocs.

http://tv.adobe.com/go/4949/
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3. Relâchez le bouton de la souris.

Si vous souhaitez utiliser les touches flèche pour modifier le nombre de côtés ou la marge en étoile lorsque vous utilisez l’outil Polygone, appuyez
sur la barre d’espace tout en maintenant le bouton de la souris enfoncé.

Dessin d’un emplacement réservé
Un emplacement réservé (également appelé « forme d’emplacement réservé ») est une ellipse, un rectangle ou un polygone qui s’affiche dans la
fenêtre du document avec un X indiquant qu’il sera remplacé ultérieurement par du texte ou une image.

1. Dans le panneau d’outils, sélectionnez l’outil Bloc elliptique , l’outil Bloc rectangulaire  ou l’outil Bloc polygonal .
2. Faites glisser le pointeur dans la fenêtre de document pour créer le tracé ou le bloc. Maintenez la touche Maj enfoncée pour

conserver la largeur et la hauteur du bloc.

Vous pouvez modifier la valeur de coupe, le point de référence ainsi que d’autres options d’ajustement d’un bloc de substitution en choisissant
Objet > Ajustement > Options d’ajustement de bloc.

Définition des paramètres de polygone
1. Si vous voulez que les paramètres de polygone soient appliqués à des formes existantes, sélectionnez les polygones.

2. Cliquez deux fois sur l’outil Polygone , spécifiez les paramètres suivants, puis cliquez sur OK :

Dans la zone Nombre de côtés, entrez une valeur correspondant au nombre de côtés que vous voulez attribuer au
polygone.

Dans la zone Marge en étoile, entrez une valeur de pourcentage définissant la longueur des branches de l’étoile. Les
pointes des branches touchent le bord extérieur du cadre de sélection du polygone, et le pourcentage détermine la
profondeur de la dépression entre chaque branche. Plus le pourcentage est élevé, plus les branches sont longues et fines.

Modification automatique de la forme d’un tracé
Il est possible de convertir un tracé en une forme prédéfinie. Par exemple, il est possible de transformer un rectangle en triangle. Les paramètres
de contour du tracé initial restent appliqués au nouveau tracé. Si le nouveau tracé est un polygone, sa forme dépend des options définies dans la
boîte de dialogue Polygone. Si le nouveau tracé comporte un effet d’arrondi, la taille du rayon de l’arrondi dépend du paramètre de taille défini
dans la boîte de dialogue Options d’arrondis.

1. Sélectionnez le tracé.
2. Utilisez l’une des méthodes suivantes :

Sélectionnez Objet > Convertir la forme > [nouvelle forme].

Dans le panneau Pathfinder (Fenêtre > Objet et mise en page > Pathfinder), cliquez sur un bouton de forme dans la zone
Convertir la forme.

Voir aussi
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Enregistrement de styles de contour personnalisés

Définition de contours
Il est possible d’appliquer des contours, ou paramètres de trait, aux tracés, aux formes, aux blocs de texte et au texte vectorisé. Le panneau
Contour permet de définir l’épaisseur et l’aspect du contour, et notamment le mode de jonction des segments, les formes de départ et d’arrivée
ainsi que les options d’arrondi. Vous pouvez également définir les paramètres de contour à partir du panneau Contrôle lorsqu’un tracé ou un bloc
est sélectionné.

Application de contours
A.  Contour appliqué à un bloc de texte B.  Contour appliqué à un texte vectorisé C.  Contour appliqué à un cercle

Si vous utilisez fréquemment les mêmes paramètres de contour, vous pouvez les enregistrer dans un style d’objet pour pouvoir ensuite les
appliquer rapidement à tout objet. Pour plus de détails, voir la section Styles d’objet.

1. Sélectionnez le tracé dont vous voulez modifier le contour.
Remarque : lorsque vous sélectionnez un tracé à l’aide de l’outil Sélection , vous activez un cadre de sélection qui englobe
l’objet dans son ensemble. Si vous souhaitez sélectionner le tracé proprement dit, utilisez plutôt l’outil Sélection directe .

2. Choisissez Fenêtre > Contour pour afficher le panneau Contour.
3. Dans le champ Epaisseur, choisissez l’épaisseur du contour dans le menu ou entrez une valeur et appuyez sur la

touche Entrée ou Retour.
Remarque : les contours inférieurs à 0,25 point sont parfois trop fins pour être facilement repérables lorsqu’ils sont imprimés
sur les périphériques de sortie haute résolution tels qu’une photocomposeuse. Pour supprimer le contour, entrez la
valeur 0 (zéro).

4. Choisissez Afficher les options dans le menu du panneau pour afficher les autres attributs de contour si ceux-ci sont
masqués.

5. Modifiez les autres attributs de contour selon vos besoins.

Remarque : pour modifier la couleur du contour, utilisez le panneau Outils et le panneau Nuancier (voir la section Application de couleur).

Options du panneau Contour
Pointe Permet de spécifier le rapport longueur du sommet/épaisseur du contour à partir duquel un sommet en pointe doit être converti en sommet
en biseau. Par exemple, si l’on règle ce paramètre sur 9, la longueur du sommet doit être 9 fois égale à l’épaisseur du contour pour que le sommet
soit converti en sommet en biseau. Entrez une valeur (entre 1 et 500) et appuyez sur la touche Entrée ou Retour. L’option Pointe ne s’applique
pas aux sommets en arrondi.

Vous pouvez inclure des paramètres de pointe et d’alignement des contours dans un style de paragraphe ou de caractère. Cliquez sur la
section Couleur des caractères, puis sur l’icône de contour pour rendre les options disponibles.

Extrémité Sélectionnez un style pour spécifier l’aspect des deux extrémités d’un tracé ouvert :
Extrémité carrée  Permet de créer des terminaisons carrées qui s’étendent jusqu’aux extrémités de tracé.
Extrémité arrondie  Permet de créer des terminaisons semi-circulaires qui s’étendent de la moitié de l’épaisseur du contour au-delà des
extrémités de tracé.
Extrémité projetée  Permet de créer des terminaisons carrées qui s’étendent de la moitié de l’épaisseur du contour au-delà des extrémités de
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tracé. Si vous utilisez cette option, l’épaisseur du contour s’étend de façon égale dans tous les sens autour du tracé.
Remarque : vous pouvez spécifier une option d’extrémité pour un tracé fermé, mais l’extrémité ne sera visible que si vous ouvrez le tracé (par
exemple, en le coupant avec l’outil  Ciseaux). Les styles d’extrémités sont également plus visibles si vous appliquez des épaisseurs de tracé plus
importantes.
Sommet Spécifiez l’aspect du contour aux sommets :
Sommet en pointe  Permet de créer des sommets en pointe qui s’étendent au-delà de l’extrémité du tracé lorsque la longueur de la pointe est
inférieure à la limite de pointe.
Sommet en arrondi  Permet de créer des sommets arrondis qui s’étendent de la moitié de l’épaisseur du contour au-delà des extrémités de
tracé.
Sommet en biseau  Permet de créer des sommets carrés qui s’étendent jusqu’aux extrémités de tracé.
Remarque : vous pouvez spécifier des options de pointe pour un tracé n’utilisant pas de sommets, mais les options de pointe ne s’appliquent pas
tant que vous ne créez pas de sommets en les ajoutant ou en convertissant des points d’inflexion. Les pointes sont également plus visibles si
vous appliquez des épaisseurs de tracé plus importantes.
Alignement de contour Cliquez sur une icône pour spécifier l’emplacement du contour par rapport à son tracé.
Type Choisissez un type de contour dans le menu. Si vous choisissez Tirets, un nouveau groupe d’options s’affiche.
Début Faites une sélection pour le début du tracé.
Fin Faites une sélection pour la fin du tracé.
Couleur d’espace Spécifiez une couleur pour l’espace entre les tirets, les points ou les différentes lignes dans un contour à motif.
Teinte d’espace Spécifiez une teinte (lorsqu’une couleur d’espace est indiquée).

Vous pouvez définir des contours en tirets dans le panneau Contour, mais il est plus facile de créer un contour en tirets à l’aide d’un style de
contour personnalisé.

Ajout de formes de début et de fin
Gardez à l’esprit les instructions suivantes lorsque vous travaillez avec des formes de début et de fin :

Vous ne pouvez pas modifier les formes de début et de fin disponibles. Toutefois, les menus Début et Fin du panneau Contour
peuvent comprendre des formes supplémentaires si vous disposez d’un module externe venant compléter les options de ces
deux menus.

Les formes de début et de fin sont ajustées selon l’épaisseur du contour. Cependant, l’ajout d’une forme de début ou de fin ne
modifie pas la longueur du tracé.

Les formes de début et de fin pivotent automatiquement pour suivre l’orientation de la ligne directrice d’une extrémité de tracé.

Les formes de début et de fin apparaissent au niveau des extrémités des tracés ouverts uniquement ; elles n’apparaissent pas
sur les tirets d’un contour en tirets.

Si vous appliquez des formes de début et de fin à un tracé transparent comprenant des sous-tracés ouverts, ces derniers
utilisent tous les mêmes formes de début et de fin.

Vous pouvez appliquer des formes de début et de fin à un tracé fermé, mais elles ne sont visibles que si vous ouvrez le tracé.

Exemples de formes de début et de fin

Création de flèches à l’aide des formes de début et de fin
Utilisez les menus Début et Fin du panneau Contour pour ajouter une pointe de flèche ou une autre forme à la fin d’un tracé ouvert.

1. Dessinez une ligne ou créez un tracé ouvert à l’aide de l’outil Trait.
2. Après avoir sélectionné le trait ou le tracé, ouvrez le panneau Contour, puis choisissez un style dans les menus Début et Fin.

Début applique une forme à la première extrémité d’un tracé (suivant l’ordre dans lequel les points du tracé ont été dessinés),
et le menu Fin applique une forme à la dernière extrémité de tracé.

Basculement entre les formes de début et de fin d’un tracé
1. Sélectionnez un tracé à l’aide de l’outil Sélection directe .
2. Choisissez Objet > Tracés > Inverser le tracé ou cliquez sur le bouton Inverser le tracé du panneau Pathfinder.
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Vous pouvez créer un style de contour personnalisé à l’aide du panneau Contour. Un style de contour personnalisé peut avoir l’aspect de tirets, de
pointillés ou de bandes ; dans le style, vous pouvez définir les attributs de sommet, d’extrémité et de motif du contour. Les autres attributs de
contour, tels que l’épaisseur, la couleur d’espace et les formes de début et de fin sont définis une fois que le style de contour personnalisé a été
appliqué à un objet.

Styles de contour personnalisés
A.  Tirets B.  Pointillés C.  Bandes

Les styles de contour personnalisés peuvent être enregistrés et chargés dans d’autres documents InDesign.

1. Choisissez Fenêtre > Contour pour afficher le panneau Contour.
2. Dans le menu du panneau, choisissez Styles de contour.
3. Cliquez sur Nouveau.
4. Attribuez un nom au style du contour.
5. Dans le champ Type, sélectionnez l’une des options suivantes :

Tirets, pour définir un style avec des tirets à intervalles réguliers ou irréguliers ;

Bandes, pour définir un style avec une ou plusieurs lignes parallèles ;

Pointillés, pour définir un style avec des points à intervalles réguliers ou irréguliers.

Les options de la boîte de dialogue s’adaptent à votre sélection.

6. Dans le champ Longueur du motif, spécifiez la longueur du motif répété (tirets ou pointillés uniquement). La règle s’ajuste
pour s’adapter à la longueur spécifiée.

7. Pour définir le motif du contour, utilisez l’une des méthodes suivantes :

Cliquez sur la règle pour ajouter un tiret, un point ou une bande.

Faites glisser un tiret, un point ou une bande pour le déplacer.

Pour régler la largeur d’un tiret, déplacez les marques de la règle . Vous pouvez aussi sélectionner le tiret puis entrer les
valeurs pour Début (où commence le tiret sur la règle) et Longueur.

Pour régler l’emplacement d’un point, déplacez les marques de la règle . Vous pouvez aussi sélectionner le point puis
entrer une valeur pour Centrer (où est positionné le centre du point).

Pour régler l’épaisseur d’une bande, déplacez les marques de la règle . Vous pouvez aussi sélectionner la bande puis
entrer les valeurs pour Début et Largeur, exprimées en pourcentage de l’épaisseur du contour.

Pour supprimer un tiret, un point ou une bande, faites-le glisser hors de la fenêtre de la règle (un style de contour
personnalisé doit toutefois contenir au moins un tiret, un point ou une bande).

Création d’une ligne en pointillé dans la boîte de dialogue Nouveau style de contour
A.  Clic pour ajouter un tiret au motif B.  Glissement d’une marque pour épaissir le tiret C.  Glissement du tiret pour
ajuster l’espace entre les tirets

8. Pour visualiser le contour avec différentes épaisseurs de trait, spécifiez une épaisseur de trait à l’aide de l’option Aperçu de
l’épaisseur.



 

Haut de la page

9. Pour les motifs en tireté ou en pointillé, utilisez l’option Angles afin de déterminer l’emplacement des tirets et des points et de
garder un motif régulier autour de l’angle.

10. Pour les motifs en tireté, sélectionnez un style pour Extrémité afin de déterminer la forme des tirets. Ce paramètre annule le
paramètre Extrémité du panneau Contour.

11. Utilisez l’une des méthodes suivantes :

Cliquez sur Ajouter pour enregistrer le style de contour et en définir un nouveau. Cliquez sur Terminer pour quitter la boîte
de dialogue.

Cliquez sur OK pour enregistrer le style de contour et quitter la boîte de dialogue.

Enregistrement de styles de contour personnalisés
Vous pouvez enregistrer des styles de contour personnalisés de façon à les utiliser dans d’autres documents InDesign.

Enregistrement d’un style de contour personnalisé
1. Choisissez Styles de contour dans le panneau Contour.
2. Sélectionnez un style de contour personnalisé, puis cliquez sur Enregistrer.

Remarque : vous ne pouvez ni enregistrer ni modifier les styles de contour par défaut (indiqués entre crochets).
3. Spécifiez un nom et un emplacement pour le fichier de style de contour (.inst), puis cliquez sur OK.

Chargement d’un style de contour personnalisé
1. Choisissez Styles de contour dans le panneau Contour.
2. Cliquez sur Charger.
3. Sélectionnez le fichier de style de contour (.inst) qui contient le style de contour personnalisé à importer, puis cliquez sur OK.

Application d’un style de contour personnalisé
 Sélectionnez un tracé ou un bloc, puis choisissez un style de contour personnalisé dans le menu Type du panneau Contour.

Voir aussi

Informations juridiques   |   Politique de confidentialité en ligne

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://helpx.adobe.com/fr/legal/legal-notices.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr


Dessin avec l’outil Plume
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Dessin de segments droits avec l’outil Plume
Tracé de courbes avec l’outil Plume
Repositionnement des points d’ancrage tout en dessinant
Fin du dessin d’un tracé
Dessin de droites suivies de courbes
Dessin de courbes suivies de droites
Dessin de deux segments incurvés reliés par un sommet

Dessin de segments droits avec l’outil Plume
La ligne droite est le tracé le plus simple à réaliser avec l’outil Plume. Il suffit de cliquer avec l’outil Plume pour créer deux points d’ancrage. Si
vous continuez à cliquer, vous créez un tracé composé de segments rectilignes reliés par des sommets.

Pour obtenir des segments droits, cliquez sur le document à l’aide de l’outil Plume.

1. Sélectionnez l’outil Plume.
2. Placez l’outil Plume à l’endroit où commencer le segment de droite et cliquez pour définir le premier point d’ancrage (ne le

faites pas glisser).
Remarque : le premier segment dessiné ne sera visible que lorsque vous aurez cliqué pour définir un second point d’ancrage
(sélectionnez l’option Etirement dans Photoshop pour afficher un aperçu des segments de tracé). Si vous faites glisser l’outil
Plume accidentellement, des lignes directrices apparaissent ; sélectionnez Edition > Annuler et cliquez de nouveau.

3. Cliquez de nouveau à l’endroit où doit se terminer le segment (maintenez la touche Maj enfoncée pour contraindre l’angle du
segment à un multiple de 45°).

4. Continuez de cliquer pour définir les points d’ancrage des autres segments droits.

Le dernier point d’ancrage que vous ajoutez apparaît toujours sous la forme d’un carré plein, ce qui indique qu’il est
sélectionné. Les points d’ancrage définis au préalable sont évidés et désélectionnés au fur et à mesure que vous ajoutez
d’autres points d’ancrage.

5. Terminez le tracé en procédant de l’une des façons suivantes :

Pour fermer un tracé, faites revenir l’outil Plume sur le premier point d’ancrage (vide). Un petit cercle apparaît en regard
de l’outil Plume  lorsqu’il est placé correctement. Cliquez ou faites glisser pour fermer le tracé.

Remarque : pour fermer un tracé dans InDesign, vous pouvez également sélectionner l’objet et choisir Objet > Tracés >
Fermer le tracé.

Pour laisser le tracé ouvert, cliquez sur Ctrl (Windows) ou Commande (Mac OS) à un endroit quelconque où il n’y a aucun
objet.

Pour laisser le tracé ouvert, vous pouvez également sélectionner un autre outil ou choisir Sélectionner > Désélectionner
dans Illustrator ou Edition > Désélectionner tout dans InDesign. Dans InDesign ou Illustrator, il suffit d’appuyer sur Entrée
ou Retour pour laisser le tracé ouvert.

Tracé de courbes avec l’outil Plume
Pour créer une courbe, ajoutez un point d’ancrage à l’endroit où la courbe change de sens et faites glisser les lignes directrices contrôlant la forme
de la courbe. La longueur et la pente des lignes directrices déterminent la forme de la courbe.



Les courbes se modifient plus facilement, et s’affichent et s’impriment plus rapidement si vous les dessinez avec le moins de points d’ancrage
possible. De plus, si vous utilisez trop de points, la courbe risque de présenter des irrégularités non désirées. Vous avez donc plutôt intérêt à
espacer autant que possible les points d’ancrage et à modeler la courbe en agissant sur la longueur et l’inclinaison des lignes directrices.

1. Sélectionnez l’outil Plume.
2. Placez l’outil Plume à l’endroit où commencer la courbe et maintenez le bouton de la souris enfoncé.

Le premier point d’ancrage apparaît et l’outil Plume prend la forme d’une flèche (dans Photoshop, le pointeur ne change
qu’après que vous ayez commencé à faire glisser).

3. Faites glisser pour définir l’inclinaison de la courbe que vous tracez, puis relâchez le bouton de la souris.

D’une façon générale, prolongez la ligne directrice d’environ un tiers de la distance à laquelle vous allez placer le point
d’ancrage suivant (vous pouvez ajuster ultérieurement un ou les deux côtés de la ligne directrice).

Maintenez la touche Maj enfoncée pour contraindre l’outil à des multiples de 45°.

Tracé du premier point de courbe
A.  Positionnement de l’outil Plume B.  Début du glissement (bouton de la souris enfoncé) C.  Glissement pour prolonger les
lignes directrices

4. Placez l’outil Plume à l’endroit où la courbe doit se terminer, puis procédez de l’une des façons suivantes :

Pour créer une courbe en forme de « C », faites glisser dans la direction opposée à la ligne directrice précédente, puis
relâchez le bouton de la souris.

Tracé du deuxième point de courbe
A.  Début du traçage du deuxième point B.  Traçage à l’opposé de la ligne directrice précédente, créant ainsi une courbe
en forme de « C » C.  Résultat après avoir relâché le bouton de la souris

Pour créer une courbe en forme de « S », faites glisser dans la même direction que la ligne directrice précédente, puis
relâchez le bouton de la souris.

Formation d’une courbe en S
A.  Début du traçage du nouveau point B.  Traçage dans la même direction que la ligne directrice précédente, créant
ainsi une courbe en « S » C.  Résultat après avoir relâché le bouton de la souris

(Photoshop uniquement) Pour changer brusquement la direction de la courbe, relâchez le bouton de la souris, puis
maintenez la touche Alt (Windows) ou Option (Mac OS) enfoncée et faites glisser le point directeur dans la direction de
la courbe. Relâchez la touche Alt (Windows) ou Option (Mac OS) et le bouton de la souris, placez le pointeur à l’endroit
où le segment doit s’arrêter et faites glisser dans la direction opposée pour le terminer.

5. Continuez à faire glisser l’outil Plume vers d’autres endroits pour créer une série de courbes lisses. Notez que vous placez
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des points d’ancrage au début et à la fin de chaque courbe, non au milieu de la courbe.
Maintenez la touche Alt enfoncée (Windows) ou Option (Mac OS) et faites glisser les lignes directrices pour arrêter les
lignes directrices à un point d’ancrage.

6. Terminez le tracé en procédant de l’une des façons suivantes :

Pour fermer un tracé, faites revenir l’outil Plume sur le premier point d’ancrage (vide). Un petit cercle apparaît en regard
de l’outil Plume  lorsqu’il est placé correctement. Cliquez ou faites glisser pour fermer le tracé.

Remarque : pour fermer un tracé dans InDesign, vous pouvez également sélectionner l’objet et choisir Objet > Tracés >
Fermer le tracé.

Pour laisser le tracé ouvert, cliquez sur Ctrl (Windows) ou Commande (Mac OS) à un endroit quelconque où il n’y a aucun
objet.

Pour laisser le tracé ouvert, vous pouvez également sélectionner un autre outil ou choisir Sélectionner > Désélectionner
dans Illustrator ou Edition > Désélectionner tout dans InDesign.

Pour visualiser une vidéo relative à l’utilisation de l’outil Crayon dans Illustrator, rendez-vous à l’adresse suivante : www.adobe.com/go/vid0037_fr.

Repositionnement des points d’ancrage tout en dessinant
 Après avoir cliqué pour créer un point d’ancrage, gardez le bouton de la souris enfoncé, maintenez la barre d’espacement enfoncée, et faites

glisser pour repositionner le point d’ancrage.

Fin du dessin d’un tracé
 Vous pouvez terminer un tracé de l’une des manières suivantes :

Pour fermer un tracé, placez l’outil Plume sur son premier point d’ancrage (vide). Un petit cercle apparaît en regard de l’outil
Plume  lorsqu’il est placé correctement. Cliquez ou faites glisser pour fermer le tracé.

Remarque : pour fermer un tracé dans InDesign, vous pouvez également sélectionner l’objet et choisir Objet > Tracés >
Fermer le tracé.

Pour laisser un tracé ouvert, cliquez sur Ctrl (Windows) ou Commande (Mac OS) à un endroit quelconque où il n’y a aucun
objet.

Pour laisser le tracé ouvert, vous pouvez également sélectionner un autre outil ou choisir Sélectionner > Désélectionner dans Illustrator ou
Edition > Désélectionner tout dans InDesign. Dans InDesign, il suffit d'appuyer sur Entrée ou Retour pour laisser le tracé ouvert.

Dessin de droites suivies de courbes
1. A l’aide de l’outil Plume, cliquez pour créer des sommets à deux emplacements et dessiner un segment droit.
2. Placez l’outil Plume sur l’extrémité sélectionnée. Dans Illustrator et InDesign, une icône de conversion de point apparaît en

regard de l’outil Plume lorsque celui-ci est placé correctement (dans Photoshop, un petit trait diagonal ou une barre oblique
apparaît en regard de l’outil Plume). Pour définir l’inclinaison du segment incurvé que vous allez ensuite créer, cliquez sur le
point d’ancrage et faites glisser la ligne directrice qui apparaît.

Tracé d’un segment droit suivi d’un segment courbe (première partie)
A.  Segment droit terminé B.  Positionnement de l’outil Plume sur l’extrémité (l’icône de conversion de point ne s’affiche que
dans Illustrator et InDesign) C.  Glissement du point directeur

3. Positionnez l’outil Plume à l’endroit où vous souhaitez placer le point d’ancrage suivant, puis cliquez (et faites-le glisser si
vous le souhaitez) pour créer le nouveau point d’ancrage pour terminer la courbe.

http://www.adobe.com/go/vid0037_fr
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Tracé d’un segment droit suivi d’un segment courbe (deuxième partie)
A.  Positionnement de l’outil Plume B.  Glissement de la ligne directrice C.  Nouveau segment incurvé terminé

Dessin de courbes suivies de droites
1. Faites glisser la souris avec l’outil Plume pour créer le premier point d’inflexion de la courbe, puis relâchez le bouton de la

souris.
2. Placez ensuite l’outil Plume à l’endroit où vous souhaitez terminer la courbe, faites glisser afin de la terminer, puis relâchez le

bouton de la souris.

Tracé d’une courbe suivie d’une droite (première partie)
A.  Premier point d’inflexion du segment incurvé terminé et outil Plume placé sur l’extrémité du tracé B.  Glissement pour
terminer la courbe

3. Placez l’outil Plume sur l’extrémité sélectionnée. Une icône de conversion de point apparaît en regard de l’outil Plume lorsque
celui-ci est placé correctement. Cliquez sur le point d’ancrage pour convertir le point d’inflexion en sommet.

4. Repositionnez l’outil Plume à l’endroit où vous souhaitez que le segment droit se termine, et cliquez pour le terminer.

Tracé d’une courbe suivie d’une droite (deuxième partie)
C.  Positionnement de l’outil Plume sur une extrémité existante D.  Clic sur l’extrémité E.  Clic sur le sommet suivant

Dessin de deux segments incurvés reliés par un sommet
1. A l’aide de l’outil Plume, faites glisser pour créer le premier point d’inflexion d’un segment incurvé.
2. Replacez l’outil Plume et faites glisser le pointeur pour créer une courbe avec un deuxième point d’inflexion ; puis, maintenez

la touche Alt (Windows) ou Option (Mac OS) enfoncée, et faites glisser la ligne directrice vers son côté opposé pour définir
l’inclinaison de la prochaine courbe. Relâchez la touche et le bouton de la souris.

Cette opération convertit le point d’inflexion en sommet en scindant les lignes directrices.

3. Repositionnez l’outil Plume sur le point d’arrivée du second segment incurvé et faites glisser un nouveau point d’inflexion pour
terminer le segment incurvé.



 

Tracé de deux courbes
A.  Glissement d’un nouveau point d’inflexion B.  Glissement tout en maintenant la touche Alt ou Option enfoncée pour séparer les lignes
directrices et déplacement de la ligne directrice vers le haut C.  Résultat obtenu après la troisième étape de repositionnement et de glissement

Voir aussi
Vidéo de l’outil Plume dans Illustrator
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Types de tracés et de formes

Vous pouvez créer des tracés et les combiner de multiples façons dans InDesign. InDesign crée les types de tracés et de formes suivants :

Les tracés simples constituent les pièces maîtresses des tracés transparents et des formes composées. Ils consistent en un
tracé ouvert ou fermé, qui peut avoir une intersection avec lui-même.

Les tracés transparents consistent en un minimum de deux tracés simples qui interagissent ou s’interceptent. Ils sont plus
simples que les formes composées et sont reconnus par toutes les applications PostScript. Les tracés combinés dans un tracé transparent
agissent comme un objet et partagent des attributs (tels que les couleurs et styles de contour).

Les formes composées consistent en plusieurs tracés, tracés transparents, groupes, dégradés, textes vectorisés, blocs de
texte ou autres formes qui interagissent et s’interceptent pour créer de nouvelles formes modifiables. Certaines formes composées apparaissent
comme tracés transparents mais leurs tracés transparents peuvent être modifiés par tracé et ne partagent pas nécessairement les mêmes
attributs.

Types de tracés et de formes

A. Trois tracés simples B. Tracé transparent C. Forme composée 

A propos des tracés

Lorsque vous dessinez, vous créez une ligne appelée tracé. Un tracé est composé d’un ou de plusieurs segments droits ou incurvés. Le début et
la fin de chaque segment sont indiqués par des points d’ancrage qui fonctionnent à la manière d’épingles maintenant un fil en place. Un tracé peut
être fermé (un cercle, par exemple) ou ouvert, s’il comporte des extrémités distinctes (une ligne onduleuse, par exemple).

Pour modifier la forme d’un tracé, vous pouvez faire glisser ses points d’ancrage, les points directeurs à l’extrémité des lignes directrices qui
apparaissent aux points d’ancrage ou le segment du tracé lui-même.



Remarque :
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Composants d’un tracé

A. Extrémité de tracé sélectionnée (pleine) B. Point d’ancrage sélectionné C. Point d’ancrage non sélectionné D. Segment de tracé incurvé E.
Ligne directrice F. Point directeur 

Les tracés peuvent avoir deux types de point d’ancrage : les sommets et les points d’inflexion. Au niveau d’un sommet, un tracé change
brusquement de sens. Au niveau d’un point d’inflexion, les segments de tracé sont reliés en une courbe continue. Lorsque vous dessinez un tracé,
vous pouvez mélanger à votre guise les sommets et les points d’inflexion. Vous pouvez toujours transformer un sommet en point d’inflexion, et
inversement.

Points d’un tracé

A. Quatre sommets B. Quatre points d’inflexion C. Combinaison de sommets et de points d’inflexion 

Un sommet peut relier deux segments rectilignes ou courbes, tandis qu’un point d’inflexion raccorde toujours deux segments courbes.

Un sommet peut relier des segments rectilignes et des segments courbes.

ne confondez pas les sommets et les points d’inflexion avec les segments droits et incurvés.

La ligne que forme un tracé s’appelle contour. Une couleur ou un dégradé appliqué à la zone interne d’un tracé ouvert ou fermé s’appelle fond. Un
contour peut avoir une épaisseur, une couleur et un modèle de trait (Illustrator et InDesign) ou un modèle de ligne stylisée (InDesign). Une fois que
vous avez créé un tracé ou une forme, vous pouvez modifier ses caractéristiques de contour et de fond.

Dans InDesign, à chaque tracé est également associé un point central qui correspond au centre du tracé, mais qui ne fait pas partie intégrante du
tracé. Utilisez le point central pour déplacer le tracé, l’aligner sur les autres éléments ou pour sélectionner tous ses points d’ancrage. Le point
central est toujours visible et ne peut être ni masqué ni supprimé.

A propos des lignes directrices et des points directeurs
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Remarque :

Lorsque vous sélectionnez un point d’ancrage qui relie des segments incurvés (ou lorsque vous sélectionnez le segment lui-même), les points
d’ancrage des segments reliés affichent des poignées de direction, qui se composent de lignes directrices se terminant par des points directeurs.
L’angle et la longueur des lignes directrices déterminent la forme et la taille des segments incurvés. Le déplacement des points directeurs modifie
la forme de la courbe. Les lignes directrices n’apparaissent pas sur la sortie finale.

Une fois que vous avez sélectionné un point d’ancrage (à gauche), les lignes directrices apparaissent sur toutes les courbes reliées par ce point
d’ancrage (à droite).

Un point d’inflexion est toujours doté de deux lignes directrices qui se déplacent ensemble comme une seule unité droite. Lorsque vous déplacez
une ligne directrice sur un point d’inflexion, les segments incurvés des deux côtés du point s’ajustent simultanément, assurant une courbe continue
à ce point d’ancrage.

Un sommet peut quant à lui avoir une, deux ou aucune lignes directrices, selon qu’il relie respectivement un, deux ou aucun segments courbes.
Les lignes directrices d’un sommet conservent le sommet en utilisant différents angles. Lorsque vous placez une ligne directrice sur un sommet,
seule la courbe située du même côté du point que la ligne directrice est ajustée.

Une fois que vous avez sélectionné un point d’ancrage (à gauche), les lignes directrices apparaissent sur toutes les courbes reliées par ce point
d’ancrage (à droite).

Réglage des lignes directrices d’un point d’inflexion (à gauche) et d’un sommet (à droite)

Les lignes directrices sont toujours tangentes (perpendiculaires au rayon) à la courbe au niveau des points d’ancrage. L’inclinaison de chaque
ligne directrice détermine celle de la courbe. De même, la longueur de chaque ligne directrice détermine la hauteur ou l’incurvation de la courbe.

Le déplacement et le redimensionnement des lignes directrices modifient l’inclinaison des courbes.

dans Illustrator, vous pouvez afficher ou masquer les points d’ancrage, les lignes directives et les points directeurs en choisissant la
commande Affichage > Afficher le contour de sélection ou Affichage > Masquer le contour de sélection.

http://creativecommons.org/licenses/by-nc-sa/3.0/
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Dessin avec l’outil Crayon
Modification de tracés à l’aide de l’outil Crayon
Options de l’outil Crayon

Dessin avec l’outil Crayon
L’outil Crayon fonctionne de la même manière dans Adobe Illustrator et dans InDesign. Il permet de dessiner des tracés ouverts et fermés, comme
lorsque vous dessinez sur papier. Il se prête tout particulièrement à la réalisation d’esquisses ou de dessins à la main. Une fois le tracé terminé,
vous pouvez le modifier immédiatement, si nécessaire.

Des points d’ancrage sont insérés automatiquement au fur et à mesure que vous dessinez avec l’outil Crayon ; ce n’est pas vous qui déterminez
leur emplacement mais vous pouvez les retoucher par la suite. Le nombre de points d’ancrage dépend de la longueur et de la complexité du tracé,
ainsi que des paramètres de tolérance définis dans la boîte de dialogue Préférences de l’outil Crayon. Ces paramètres déterminent la sensibilité de
l’outil Crayon aux déplacements de la souris ou du stylet de la table graphique.

Pour visualiser une vidéo relative au dessin avec l’outil Crayon dans Illustrator, rendez-vous à l’adresse suivante : www.adobe.com/go/vid0039_fr.

Dessin d’une forme libre avec l’outil Crayon
1. Sélectionnez l’outil Crayon .

2. Placez le pointeur au point de départ, puis faites glisser pour dessiner le tracé. L’outil Crayon  affiche un petit x pour
indiquer le dessin d’une forme libre.

Une ligne pointillée se dessine dans le sillage du pointeur lorsque vous faites glisser. Des points d’ancrage apparaissent le
long du tracé ainsi qu’à ses extrémités. Celui-ci prend les attributs de fond et de contour courants et reste sélectionné par
défaut.

Dessin d’un tracé fermé avec l’outil Crayon
1. Sélectionnez l’outil Crayon.
2. Placez l’outil au point de départ du tracé, puis faites glisser pour dessiner le tracé.
3. Tout en faisant glisser le pointeur, maintenez la touche Alt (Windows) ou Option (Mac OS) enfoncée. L’outil Crayon affiche un

petit cercle (une gomme dans InDesign) pour indiquer que vous êtes en train de créer un tracé fermé.
4. Lorsque le tracé atteint la taille et la forme souhaitées, relâchez le bouton de la souris (mais pas la touche Alt ou Option). Une

fois le tracé fermé, relâchez la touche Alt ou Option.

Pour créer un tracé fermé, vous n’avez pas besoin de positionner le curseur sur le point de départ du tracé ; si vous relâchez
le bouton de la souris à un autre endroit, l’outil Crayon ferme la forme en créant la ligne la plus courte possible vers le point
d’origine.

Modification de tracés à l’aide de l’outil Crayon
Vous pouvez modifier un tracé à l’aide de l’outil Crayon et ajouter des lignes et des formes libres dans n’importe quelle forme.

Ajout d’un tracé à l’aide de l’outil Crayon
1. Sélectionnez un tracé.
2. Sélectionnez l’outil Crayon.
3. Placez la pointe du crayon sur une extrémité du tracé.

Vous savez lorsque vous êtes suffisamment près de l’extrémité du tracé lorsque le petit x en regard de la pointe du crayon
disparaît.

4. Faites glisser le pointeur pour terminer le tracé.

Liaison de deux tracés à l’aide de l’outil Crayon
1. Sélectionnez les deux tracés (cliquez en maintenant la touche Maj enfoncée ou faites glisser sur les deux tracés à l’aide de

l’outil Sélection).

http://www.adobe.com/go/vid0039_fr
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2. Sélectionnez l’outil Crayon.
3. Placez le pointeur à l’endroit auquel vous voulez débuter l’un des tracés et faites glisser vers l’autre tracé.
4. Tout en faisant glisser le pointeur, maintenez la touche Ctrl (Windows) ou Commande (Mac OS) enfoncée. L’outil Crayon

affiche un petit symbole de fusion pour indiquer que vous êtes en train d’ajouter au tracé existant.
5. Faites glisser sur l’extrémité de l’autre tracé, relâchez le bouton de la souris, puis relâchez les touches Ctrl ou Commande.

Remarque : pour des résultats optimaux, faites glisser le pointeur d’un tracé vers l’autre comme si vous poursuiviez les tracés
vers leur point d’origine.

Remodelage de tracés à l’aide de l’outil Crayon
1. Sélectionnez le tracé à modifier.
2. Placez l’outil Crayon sur le tracé à modifier ou à proximité de celui-ci.

Vous savez lorsque vous êtes suffisamment près du tracé lorsque le petit x disparaît de l’outil.

3. Faites glisser l’outil jusqu’à ce que le tracé ait la forme souhaitée.

Modification d’une forme fermée avec l’outil Crayon

Remarque : des résultats inattendus peuvent se produire du fait de l’origine du tracé ou de la direction du déplacement. Par
exemple, vous pouvez transformer sans le vouloir un tracé fermé en tracé ouvert, et inversement, ou perdre une partie d’une
forme.

Options de l’outil Crayon
Cliquez deux fois sur l’outil Crayon pour définir l’une des options suivantes :

Fidélité Contrôle la distance que doit parcourir la souris ou le stylet avant qu’un point d’ancrage ne soit ajouté au tracé. Plus la valeur est élevée,
plus le tracé est lisse et moins il est complexe. Plus les valeurs sont basses, moins la correspondance du tracé est précise par rapport à la ligne
que vous avez dessinée. La fidélité va de 0,5 à 20 pixels.
Lissage Contrôle le pourcentage de lissage appliqué lors de l’utilisation de l’outil. Le lissage va de 0 à 100 %. Plus la valeur est élevée, plus le
tracé sera lisse. Plus les valeurs sont basses, plus le nombre de points d’ancrage est élevé et plus les irrégularités de la ligne sont conservées.
Remplir les nouveaux contours au crayon (Illustrator uniquement) Applique un fond aux contours au crayon après avoir sélectionné cette
option, mais non aux contours au crayon existants. Assurez-vous de sélectionner un fond avant de tracer de nouveaux contours.
Conserver la sélection Détermine s’il faut conserver le tracé sélectionné après que vous l’ayez dessiné. Cette option est sélectionnée par
défaut.
Modifier les tracés sélectionnés Détermine si vous pouvez modifier ou fusionner un tracé sélectionné lorsque vous êtes à une certaine distance
(spécifiée par l’option suivante).
Dans les limites de : _ pixels Permet de déterminer la distance entre la souris ou le stylet et le tracé pour pouvoir modifier celui-ci à l’aide de
l’outil Crayon. Cette option est disponible uniquement si l’option Modifier les tracés sélectionnés est activée.
Voir aussi
Vidéo Utiliser l’outil Crayon
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A propos des tracés transparents
Vous pouvez combiner plusieurs tracés en un objet unique appelé tracé transparent. Créez un tracé transparent, puis utilisez l’une des méthodes
suivantes :

Ajoutez des parties évidées transparentes à un tracé.

Conservez les parties évidées transparentes de certains caractères, tels que les lettres o et e, lorsque vous convertissez des
caractères en dessins de lettre modifiables en utilisant la commande Vectoriser. L’utilisation de la commande Vectoriser
résulte toujours en la création de tracés transparents.

Appliquez un dégradé ou ajoutez un contenu qui s’étend sur plusieurs tracés. Bien que vous puissiez également appliquer un
dégradé à plusieurs objets à l’aide de l’outil Dégradé, l’application d’un dégradé à un tracé transparent donne souvent de
meilleurs résultats, car vous pouvez ensuite modifier la totalité du dégradé en sélectionnant l’un des sous-tracés. Avec l’outil
Dégradé, toute modification ultérieure nécessite la sélection de tous les tracés que vous aviez initialement sélectionnés.

Méthodes recommandées pour la modification des tracés transparents
Gardez à l’esprit les instructions suivantes lorsque vous modifiez des tracés transparents :

Les modifications apportées aux attributs de tracé (tels que le contour et le fond) altèrent toujours tous les sous-tracés d’un
tracé transparent, et cela indépendamment de l’outil de sélection utilisé ou du nombre de sous-tracés sélectionnés. Pour
conserver les attributs de contour et de fond de chaque tracé que vous voulez combiner, associez-les.

Dans un tracé transparent, tout effet placé relativement au cadre de sélection du tracé (tel qu’un dégradé ou une image collée
à l’intérieur du tracé) est placé par rapport au cadre de sélection du tracé transparent (c’est-à-dire, le tracé qui contient tous
les sous-tracés).

Si vous créez un tracé transparent, que vous modifiez ses propriétés puis que vous l’annulez avec la commande Annuler, les
tracés annulés héritent des propriétés du tracé transparent et ne récupèrent pas leurs propriétés d’origine.

Si votre document contient des tracés transparents comportant de nombreux points d’inflexion, ils peuvent être difficiles à
imprimer sur certains périphériques de sortie. Dans ce cas, simplifiez ou éliminez les tracés transparents, ou convertissez-les
en images bitmap à l’aide d’un programme tel qu’Adobe Photoshop.

Si vous appliquez un fond à un tracé transparent, des parties évidées peuvent apparaître à des emplacements inattendus.
Pour un tracé simple tel qu’un rectangle, l’intérieur, ou la zone à laquelle vous pouvez appliquer un fond, correspond tout
simplement à la zone que renferme le tracé. Toutefois, pour un tracé transparent, InDesign doit décider si les intersections
créées par les sous-tracés du tracé transparent sont situées à l’intérieur (zones remplies) ou à l’extérieur (parties évidées). Le
sens de chaque sous-tracé (ordre dans lequel ses points ont été créés) détermine si la zone qu’il renferme se trouve à
l’intérieur ou à l’extérieur. Si un sous-tracé est rempli alors que vous vouliez en faire une partie évidée, ou vice versa, cliquez
sur le bouton Inverser le tracé du panneau Pathfinder pour en inverser le sens.
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Tracé transparent contenant deux sous-tracés ayant le même sens de tracé (à gauche) et des sens de tracé différents (à droite)

Création d’un tracé transparent
Vous pouvez créer un tracé transparent à partir d’au moins deux tracés ouverts ou fermés. Une fois un tracé transparent créé, tous les tracés
sélectionnés à l’origine deviennent des sous-tracés du nouveau tracé transparent. Les tracés sélectionnés héritent des paramètres de contour et
de fond des objets les plus bas dans l’ordre de superposition.

Remarque : si un ou plusieurs objets ont un contenu, tel que du texte ou une image importée, les attributs et le contenu du tracé transparent
obtenu sont définis par les attributs et le contenu de l’objet le plus bas. Les objets sélectionnés plus avant mais sans contenu n’affectent pas le
tracé.

Vous pouvez modifier la forme de n’importe quelle partie d’un tracé transparent en utilisant l’outil Sélection directe  pour sélectionner un point
d’ancrage sur un sous-tracé.

1. Utilisez l’outil Sélection  pour sélectionner tous les tracés que vous voulez inclure dans le tracé transparent.
2. Choisissez Objet > Tracés > Créer un tracé transparent. Une partie évidée apparaît à l’intersection des tracés sélectionnés.

Il est possible d’appliquer un fond à une partie évidée résultant d’un sous-tracé ou de convertir un sous-tracé en partie évidée. A l’aide de
l’outil Sélection directe, sélectionnez un point sur le sous-tracé dont vous souhaitez inverser le sens. Ensuite, choisissez Objet > Tracés >
Inverser le tracé ou cliquez sur le bouton Inverser le tracé du panneau Pathfinder.

Transformation de parties évidées en fonds dans un tracé transparent
Le sens de chaque sous-tracé (l’ordre dans lequel ses points ont été créés) détermine si la zone qu’il délimite se trouve à l’intérieur (zones
remplies) ou à l’extérieur (parties évidées). Si certaines parties évidées du tracé transparent apparaissent à des endroits inattendus, vous pouvez
inverser le sens du sous-tracé.

Deux tracés fermés séparés (à gauche) et deux sous-tracés du même tracé transparent (à droite) ; le tracé transparent utilise comme partie
évidée le cercle central.

1. A l’aide de l’outil Sélection directe , sélectionnez la partie du tracé transparent à inverser (ou un point dans cette partie). Ne
sélectionnez pas l’intégralité du tracé transparent.

2. Utilisez l’une des méthodes suivantes :

Choisissez Objet > Tracés > Inverser le tracé.

Cliquez sur le bouton Inverser le tracé du panneau Pathfinder.

Décomposition d’un tracé transparent
Vous pouvez décomposer un tracé transparent en l’annulant, ce qui transforme tous ses sous-tracés en tracés indépendants.

1. Sélectionnez un tracé transparent à l’aide de l’outil Sélection .
2. Choisissez Objet > Tracés > Annuler le tracé transparent.

Remarque : la commande Annuler n’est pas disponible lorsque le tracé transparent sélectionné est compris dans un bloc ou lorsqu’il contient lui-
même du texte.
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Modification des parties évidées dans un tracé transparent
Il est possible d’éliminer une partie évidée résultant d’un sous-tracé ou d’appliquer un fond à un sous-tracé à l’origine d’une partie évidée par
inversion du sens du sous-tracé.

1. A l’aide de l’outil Sélection directe , sélectionnez un point sur le sous-tracé dont vous souhaitez inverser le sens. Ne
sélectionnez pas l’intégralité du tracé transparent.

2. Choisissez Objet > Tracés > Inverser le tracé ou cliquez sur le bouton Inverser le tracé du panneau Pathfinder.

Création de formes composées
Pour créer une forme composée, utilisez le panneau Pathfinder (Fenêtre > Objet et mise en page > Pathfinder). Les formes composées peuvent
être créées à partir de tracés simples ou transparents, de blocs de texte, de textes vectorisés ou d’autres formes. L’aspect de la forme composée
dépend du bouton Pathfinder que vous avez choisi.

Panneau Pathfinder
A.  Objets d’origine B.  Addition C.  Soustraction D.  Intersection E.  Exclusion du chevauchement F.  Soustraction (avant-arrière)

Addition Trace le contour de tous les objets pour créer une seule forme.
Soustraction Les objets au premier plan « perforent » l’objet à l’arrière-plan.
Intersection Crée une forme à partir de zones se chevauchant.
Exclusion du chevauchement Crée une forme à partir de zones qui ne se chevauchent pas.
Soustraction (avant-arrière) Les objets à l’arrière-plan « perforent » l’objet au premier-plan.
Dans la plupart des cas, la forme qui en résulte adopte les attributs (fond, contour, transparence, calque, etc.) de l’objet le plus en avant. Toutefois,
lorsque vous soustrayez des formes, les objets à l’avant sont supprimés. La forme qui en résulte adopte les attributs de l’objet le plus en arrière.

Lorsque vous incluez un bloc de texte dans une forme composée, la forme du bloc de texte se transforme, mais le texte lui-même reste inchangé.
Pour modifier le texte, créez un tracé transparent à l’aide de textes vectorisés.

Forme composée utilisée comme bloc de texte (à gauche) comparée à une forme composée créée à partir d’un texte vectorisé (à droite)

Création d’une forme composée
Vous pouvez utiliser une forme composée comme unité simple ou libérer ses tracés de composants pour travailler individuellement avec chacun
d’eux. Vous pouvez, par exemple, appliquer un fond en dégradé à une partie seulement de la forme composée.
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Dégradé appliqué à une forme composée (à gauche) comparé à un dégradé appliqué à une partie de la forme composée seulement (à droite)

1. Choisissez Fenêtre > Objet et mise en page > Pathfinder, pour ouvrir le panneau.
2. Sélectionnez les objets à combiner dans une forme composée
3. Cliquez sur un bouton (Ajouter, par exemple) dans la section Pathfinder du panneau Pathfinder.

Vous pouvez également choisir une commande du sous-menu Objet > Pathfinder.

Annulation des tracés dans une forme composée
 Sélectionnez la forme composée. Choisissez Objet > Tracés > Annuler le tracé transparent. La forme composée est séparée en tracés de

composants.
Pour regrouper des tracés de composants sans perdre les modifications appliquées aux différents tracés, choisissez Associer dans le
menu Objet plutôt que Tracés transparents > Créer.

Création de tracés à partir de texte vectorisé
Utilisez la commande Vectoriser pour convertir des caractères sélectionnés en un ensemble de tracés transparents que vous pouvez modifier et
manipuler comme tout autre tracé. La commande Vectoriser est particulièrement utile pour créer des effets destinés à un affichage grand format,
mais elle est rarement utilisée pour le corps du texte et autres petits caractères.

Si vous voulez simplement appliquer un contour en couleurs, un fond ou un contour dégradé à des caractères, il n’est pas nécessaire de
vectoriser le texte. Vous pouvez utiliser le panneau Outils, ainsi que les panneaux Nuancier, Couleur ou Dégradé, pour appliquer les couleurs
et les dégradés directement au contour ou au fond des caractères sélectionnés.

La commande Vectoriser utilise les données de vectorisation de police des fichiers de polices Type 1, TrueType ou OpenType. Lorsque vous
créez un texte vectorisé, les caractères sont convertis à leur emplacement courant et conservent tous leurs attributs de mise en forme graphique,
tels que le contour et le fond.

Remarque : certains fondeurs bloquent les données de polices de caractères indispensables à la vectorisation. Si vous choisissez une police ainsi
protégée et que vous choisissez Texte > Vectoriser, un message vous informe que la police ne peut pas être convertie.
Lorsque vous vectoriser du texte, celui-ci perd les renseignements qu’il contient, c’est-à-dire les instructions intégrées aux polices vectorielles pour
modifier leur forme et permettre au système de les afficher ou de les imprimer de façon optimale, quelle que soit leur taille. Par conséquent,
l’affichage d’un texte vectorisé risque d’être médiocre en petit corps de caractère ou à une résolution faible.

Une fois le texte vectorisé, vous pouvez utiliser l’une des méthodes suivantes :

Modifier les dessins de lettres en faisant glisser les points d’ancrage individuellement à l’aide de l’outil Sélection directe 

Copier les caractères vectorisés et utiliser la commande Edition > Coller dedans pour masquer une image en la collant dans
les caractères vectorisés convertis

Utiliser les caractères vectorisés convertis comme blocs de texte pour y saisir ou y importer du texte

Changer les attributs de contour des dessins de lettres

Utiliser la vectorisation de texte pour créer des formes composées

Utilisation de la vectorisation de texte
A.  Caractère avant vectorisation B.  Caractère vectorisé avec image collée dedans C.  Caractère vectorisé utilisé comme
bloc de texte



 

Etant donné que les caractères vectorisés convertis deviennent un ensemble de tracés transparents, vous pouvez modifier
certains sous-tracés des ses caractères avec l’outil Sélection directe. Vous pouvez également décomposer les contours de
caractères en tracés indépendants en les dissociant du tracé transparent.

Conversion de texte vectorisé en tracés
Par défaut, la vectorisation de texte supprime le texte d’origine. Vous pouvez toutefois, si vous le préférez, faire apparaître la vectorisation par-
dessus une copie du texte pour éviter de perdre le texte d’origine.

Lorsque vous sélectionnez des caractères dans un bloc de texte et que vous les vectorisez, les contours obtenus deviennent des objets (texte)
ancrés qui suivent le texte. Le texte converti étant devenu un objet graphique, vous ne pouvez plus le mettre en surbrillance ni modifier ses
caractères à l’aide de l’outil Texte. En outre, les commandes typographiques ne s’y appliquent plus. Assurez-vous que vous êtes satisfait des
paramètres typographiques du texte avant de le vectoriser et créez une copie du texte original.

1. Utilisez l’outil Sélection  pour sélectionner un bloc de texte, ou utilisez l’outil Texte pour sélectionner un ou plusieurs
caractères.

2. Sélectionnez Texte > Vectoriser.

Conversion d’une copie du texte vectorisé en tracés
1. Utilisez l’outil Sélection  pour sélectionner un bloc de texte, ou utilisez l’outil Texte pour sélectionner un ou plusieurs

caractères.
2. Tout en maintenant la touche Alt (Windows) ou Option (Mac OS) enfoncée, choisissez Texte > Vectoriser. La copie est créée

par-dessus l’original ; utilisez l’outil Sélection pour la déplacer si vous le souhaitez.

Voir aussi
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Application de formes d’arrondi à l’aide de la boîte de dialogue Options d’arrondi
Utilisation des angles dynamiques
Instructions relatives à l’application des formes d’arrondi

La commande Options d’arrondis vous permet d’appliquer rapidement des effets d’arrondi à tout tracé. Les effets disponibles incluent l’arrondi
simple et les ornements fantaisie.

Effets obtenus par différentes épaisseurs de lignes sur des formes d’arrondi
A.  Effet de sommet Fantaisie sans contour B.  Même effet avec un contour de 1 point C.  Même effet avec un contour de 4 points

Pour consulter une vidéo sur l’utilisation des effets d’arrondi, reportez-vous à l’adresse http://tv.adobe.com/go/4948/.

Application de formes d’arrondi à l’aide de la boîte de dialogue Options d’arrondi
1. Sélectionnez un tracé à l’aide d’un outil de sélection.

2. Sélectionnez Objet > Options d’arrondis.

3. Pour appliquer l’effet d’arrondi aux quatre angles d’un rectangle, sélectionnez l’icône Uniformiser tous les paramètres .
Lorsque cette option est désactivée, l’icône prend la forme d’un chaînon brisé.

4. Choisissez un effet d’arrondi et définissez la taille d’au moins un angle.

La taille détermine le rayon d’extension de l’effet d’arrondi à partir de chaque sommet.

5. Sélectionnez Aperçu pour voir les résultats de l’effet avant de l’appliquer. Cliquez ensuite sur OK.

Utilisation des angles dynamiques
Lorsque les angles dynamiques sont activés, vous pouvez appliquer des effets d’arrondi à des blocs rectangulaires en cliquant sur le carré jaune
qui s’affiche sur le bloc et en faisant glisser la souris. Vous pouvez également appliquer un effet et un rayon d’arrondi différents à chaque angle.

1. Sélectionnez un bloc rectangulaire, puis cliquez sur le carré jaune.

Quatre losanges jaunes apparaissent sur le bloc sélectionné, indiquant que les angles dynamiques sont activés. Si le carré
jaune n’est pas visible sur le bloc sélectionné, choisissez la commande Affichage > Extras > Afficher les angles dynamiques.

2. Pour ajouter des effets d’arrondi, utilisez l’une des méthodes suivantes :

Pour régler le rayon d’arrondi des quatre sommets en même temps, faites glisser un des losanges vers le centre du bloc.

Pour régler un seul angle, faites glisser un losange tout en maintenant la touche Maj enfoncée.

Pour faire défiler les divers effets, cliquez sur un losange jaune tout en maintenant la touche Alt (Windows) ou Option
(Mac OS) enfoncée.

3. Pour mettre fin à la modification des angles, cliquez en dehors du bloc sélectionné.

Pour supprimer des effets d’arrondi, choisissez la commande Objet > Options d’arrondis, puis choisissez l’option Sans.

Pour éviter que le carré jaune n’apparaisse lorsque vous sélectionnez un bloc, choisissez la commande Affichage > Extras > Masquer les angles
dynamiques.

http://tv.adobe.com/go/4948/


 

Instructions relatives à l’application des formes d’arrondi
Tenez compte des points suivants :

La commande Options d’arrondis du panneau Contour peut comprendre des formes supplémentaires si vous avez acquis un
module externe qui ajoute de tels effets.

Les effets d’arrondis apparaissent sur tous les sommets d’un tracé mais jamais sur les points d’inflexion. Les effets modifient
les angles automatiquement lorsque vous déplacez les sommets d’un tracé.

Si un effet modifie de façon significative le tracé, par exemple en créant un renflement vers l’intérieur ou vers l’extérieur, cela
peut affecter l’interaction d’un bloc avec son contenu ou avec d’autres parties de la page. Par exemple, l’augmentation de la
taille d’un effet d’arrondi peut éloigner du bloc un habillage ou un encart de bloc.

Vous ne pouvez pas modifier les effets d’arrondis, mais vous pouvez modifier leur aspect en modifiant le rayon d’arrondi du
sommet ou le contour.

Si vous avez appliqué des effets d’arrondis, mais que vous ne les voyez pas, assurez-vous que le tracé comporte des
sommets et qu’une couleur ou un dégradé de contour lui sont appliqués. Augmentez ensuite la valeur de l’option Taille dans la
boîte de dialogue Options d’arrondis ou augmentez l’épaisseur de contour dans le panneau Contour.

Informations juridiques   |   Politique de confidentialité en ligne

http://creativecommons.org/licenses/by-nc-sa/3.0/
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Ajout et gestion des groupes de couleurs
Création d’un groupe de couleurs contenant des éléments de page sélectionnés 
Chargement et enregistrement de nuances à partir d’un fichier .ASE
Importation de thèmes à partir de l’application Adobe Color

Application de couleurs

Adobe InDesign dispose d’un grand nombre d’outils d’application des couleurs, notamment le panneau Outils,
le panneau Nuancier, le panneau Couleur, le sélecteur de couleurs et le panneau Contrôle.

Lorsque vous appliquez une couleur, vous pouvez préciser si celle-ci s’applique au contour ou au fond d’un
objet. Le contour renvoie à la bordure ou à l’encadrement d’un objet, tandis que le fond correspond à son
arrière-plan. Lorsque vous appliquez une couleur à un bloc de texte, vous pouvez préciser si celle-ci affecte
l’encadrement du texte ou le texte situé à l’intérieur du bloc.

1. Sélectionnez l’objet à colorer en utilisant l’une des méthodes suivantes :

S’il s’agit d’un tracé ou d’un bloc, utilisez l’outil Sélection  ou Sélection directe ,
selon vos besoins.

S’il s’agit d’une image en niveaux de gris ou monochrome (1 bit), cliquez sur la saisie
de contenu ou utilisez l’outil Sélection directe. Vous ne pouvez appliquer que deux
couleurs aux images en niveaux de gris ou monochromes.

S’il s’agit de caractères de texte, utilisez l’outil Texte  pour modifier la couleur du
texte d’un mot ou de l’ensemble du texte contenu dans le bloc.

Pour modifier la couleur des espaces dans un contour en tirets, en pointillés ou en
bandes, utilisez le panneau Contour.

2. Dans le panneau Outils, Couleur ou Nuancier, sélectionnez la commande La mise en
forme agit sur le texte ou La mise en forme agit sur le conteneur pour déterminer si la
couleur est appliquée au texte ou au bloc de texte.

3. Dans le panneau Outils, Couleur ou Nuancier, sélectionnez la case Fond ou Contour
pour définir le fond ou le contour de l’objet (si une image est sélectionnée, la case
Contour n’a aucun effet).
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Spécification du mode d’application de la couleur dans le panneau Outils

A. Case Fond B. La mise en forme agit sur le conteneur C. Case Contour D. La mise en
forme agit sur le texte 

4. Utilisez l’une des méthodes suivantes :

Sélectionnez une couleur, une teinte ou un dégradé à l’aide des panneaux Nuancier
ou Dégradé.

Sélectionnez une couleur, une teinte ou un dégradé dans le menu Fond ou Contour
du panneau Contrôle.

Cliquez deux fois sur la case Fond ou Contour du panneau Outils ou sur le panneau
Couleur pour ouvrir le sélecteur de couleurs. Sélectionnez la couleur souhaitée, puis
cliquez sur OK.

Vous pouvez appliquer de la couleur à n’importe quelle image en niveaux de gris, à condition qu’elle ne
contienne ni couche alpha ni couche de tons directs. Si vous importez une image avec un masque,
sélectionnez le masque au moyen de l’outil Sélection directe pour appliquer la couleur uniquement à la
zone rognée.

Sélection d’une couleur au moyen du sélecteur de couleurs

Le sélecteur de couleurs vous permet de choisir les couleurs à partir d’un champ de couleur ou de spécifier
les couleurs numériquement. Vous pouvez définir les couleurs au moyen des modèles colorimétriques RVB,
LAB ou CMJN.

1. Cliquez deux fois sur la case Fond ou Contour du panneau Outils ou sur le panneau
Couleur pour ouvrir le sélecteur de couleurs.

2. Pour modifier le spectre des couleurs affiché dans le sélecteur de couleurs, cliquez sur
une lettre : R (rouge), V (vert) ou B (bleu) ; ou (luminance), a (axe rouge-vert) ou b (axe
jaune-bleu).

Sélecteur de couleurs
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A. Couleur d’origine B. Nouvelle couleur C. Champ de couleur D. Triangles du curseur de
couleur E. Spectre des couleurs 

3. Pour choisir une couleur, utilisez l’une des méthodes suivantes :

Cliquez ou faites glisser le curseur à l’intérieur du champ de couleur. Le réticule
indique la position de la couleur dans le champ.

Faites glisser les triangles du curseur de couleur le long du spectre des couleurs ou
cliquez à l’intérieur du spectre.

Saisissez des valeurs dans les zones de texte.

4. Pour enregistrer la couleur en tant que nuance, cliquez sur Ajouter une nuance CMJN,
Ajouter la nuance RVB ou Ajouter la nuance LAB. InDesign ajoute la couleur au panneau
Nuancier et la nomme d’après ses valeurs.

5. Cliquez sur le bouton OK.

Application de la dernière couleur utilisée

Le panneau Outils affiche la dernière couleur ou le dernier dégradé appliqué. Vous pouvez appliquer cette
couleur ou ce dégradé directement à partir du panneau Outils.

1. Sélectionnez l’objet ou le texte à colorer.

2. Dans le panneau Outils, cliquez sur le bouton Fond ou sur le bouton Contour selon la
partie du texte ou de l’objet à colorer.

3. Dans le panneau Outils, effectuez l’une des opérations suivantes :

Cliquez sur le bouton Couleur  pour appliquer la dernière couleur unie sélectionnée
dans le panneau Nuancier ou Couleur.

Cliquez sur le bouton Dégradé  pour appliquer le dernier dégradé sélectionné dans
le panneau Nuancier ou Dégradé.

Cliquez sur le bouton Sans  pour supprimer le fond ou le contour de l’objet.

Suppression de la couleur du fond ou du contour

1. Sélectionnez le texte ou l’objet dont vous voulez supprimer la couleur.

2. Dans le panneau Outils, cliquez sur le bouton Fond ou sur le bouton Contour selon la
partie du texte ou de l’objet à modifier.

3. Cliquez sur le bouton Sans  pour supprimer le fond ou le contour de l’objet.

Application de couleurs par glisser-déposer

Vous pouvez appliquer facilement des couleurs ou des dégradés en les faisant glisser d’une source de
couleur vers un objet ou un panneau. Le glisser-déposer permet d’appliquer des couleurs et des dégradés
aux objets sans les sélectionner préalablement. Vous pouvez faire glisser les éléments suivants :

la case Fond ou Contour du panneau Outils ou d’un autre panneau ;

la case de dégradé du panneau Dégradé ;
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Remarque :

les nuances du panneau Nuancier ;

la dernière nuance imprimable utilisée, située en regard de l’icône de la couleur non
imprimable (hors gamme)  dans un panneau.

Vous pouvez déposer des couleurs ou des dégradés sur les panneaux et les objets suivants :

le fond ou le contour d’un tracé. Pour déposer une couleur sur un fond ou un contour,
positionnez précisément le centre de l’icône de la couleur que vous faites glisser sur le
fond ou le contour du tracé, puis relâchez le bouton de la souris ;

le panneau Nuancier.

 

Si vous faites glisser une ou plusieurs nuances du panneau Nuancier ou une nuance située en regard d’une
icône de couleur non imprimable (hors gamme), vous pouvez les déposer dans une autre fenêtre de
document InDesign pour les ajouter à son panneau Nuancier.

Application d’une nuance de couleur ou de dégradé

1. Sélectionnez un texte ou un bloc d’objet à l’aide de l’outil Sélection  ou une plage de
texte à l’aide de l’outil Texte .

2. Si le panneau Nuancier n’est pas affiché, choisissez la commande Fenêtre > Couleur >
Nuancier.

3. Dans le panneau Nuancier, sélectionnez la case Fond ou Contour.

4. Utilisez l’une des méthodes suivantes :

Pour appliquer une couleur au texte sélectionné, cliquez sur le bouton Texte .

Pour appliquer une couleur à l’objet ou au conteneur de texte sélectionné (tel qu’un
bloc ou un tableau), cliquez sur le bouton Objet .

5. Cliquez sur une couleur ou un dégradé. La couleur ou le dégradé sélectionné est
appliqué à tout texte ou objet sélectionné et apparaît dans le panneau Couleur ainsi que
dans la case Fond ou Contour du panneau Outils.

Les couleurs de fond ou de contour par défaut se définissent comme les autres paramètres par défaut
InDesign. Choisissez Edition > Tout désélectionner pour vous assurer qu’aucun objet n’est sélectionné,
puis choisissez une couleur.

Application d’une couleur à l’aide du panneau Couleur

Bien que le panneau Nuancier soit l’outil recommandé pour manipuler les couleurs, vous pouvez également
les mélanger à l’aide du panneau Couleur. Vous pouvez ajouter à tout moment la couleur active du panneau
Couleur au panneau Nuancier. Le panneau Couleur est l’outil idéal pour mélanger les couleurs sans nom.

si vous sélectionnez un objet qui utilise une nuance nommée et que vous modifiiez sa couleur à
l’aide du panneau Couleur, la couleur est uniquement modifiée dans l’objet. Pour modifier la couleur dans
l’ensemble du document, cliquez deux fois sur sa nuance dans le panneau Nuancier.

Modification de la couleur du fond ou du contour

1. Sélectionnez l’objet ou le texte à modifier.

2. Si le panneau Couleur n’est pas affiché, choisissez la commande Fenêtre > Couleur.

3. Sélectionnez la case Fond ou Contour dans le panneau Couleur.
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Panneau Couleur

A. Case Fond B. Case Contour C. La mise en forme agit sur le conteneur D. La mise en
forme agit sur le texte 

4. Si vous avez sélectionné un bloc de texte, choisissez la zone de conteneur  ou la zone
de texte  pour modifier la couleur du fond ou du texte à l’intérieur de ce bloc.  

5. Utilisez l’une des méthodes suivantes :

Réglez le curseur Teinte, qui apparaît par défaut si l’objet utilise une nuance du
panneau Nuancier.

Choisissez un modèle colorimétrique LAB, CMJN ou RVB dans le menu du panneau
Couleur, puis utilisez les curseurs pour modifier les valeurs chromatiques. Vous
pouvez également saisir des valeurs numériques dans les zones situées en regard
des curseurs de couleurs.

Placez le pointeur sur la gamme de couleurs et cliquez.

Cliquez deux fois sur la case Fond ou Contour, puis sélectionnez une couleur dans le
sélecteur de couleurs. Cliquez ensuite sur OK.

6. Si une icône d’avertissement hors gamme  apparaît et que vous souhaitez utiliser les
valeurs chromatiques CMJN les plus proches de la couleur initialement spécifiée, cliquez
sur la petite case de couleur en regard de l’icône d’avertissement.

Création d’une nuance à partir d’une couleur du panneau Couleur

1. Dans le panneau Couleur, assurez-vous que la case Fond ou Contour affiche la couleur
à ajouter.

2. Dans le menu du panneau, choisissez Ajouter au nuancier.

Passage d’un mode de couleur à un autre

Utilisez l’une des méthodes suivantes :

Cliquez sur la gamme de couleurs située au bas du panneau Couleur en maintenant
la touche Maj enfoncée.

Dans la boîte de dialogue Nouvelle couleur ou Options de nuance, cliquez sur la case
de couleur en maintenant la touche Maj enfoncée.

Dans la boîte de dialogue Nouveau dégradé ou Options de dégradé, sélectionnez une
couleur, assurez-vous que l’option RVB, CMJN ou LAB est sélectionnée dans le
menu Couleur, puis cliquez sur la case de couleur en maintenant la touche Maj
enfoncée.

Génération de thèmes de couleur avec l’outil Thème de couleur



Vous pouvez extraire des thèmes de couleur dans les zones, les images ou les objets sélectionnés dans un
document InDesign. Vous pouvez également choisir une couleur à partir d’une image, l’image entière ou la
mise en page complète. Vous avez en fait la possibilité de générer des thèmes à partir de toutes les couleurs
de votre illustration. Utilisez l’outil Thème de couleur pour choisir une seule couleur ou un seul thème et
ajouter le thème de couleur au panneau Nuancier. 

Ajoutez ces couleurs à la mise en page, et au panneau Nuancier. Vous pouvez également les enregistrer
dans vos Bibliothèques Creative Cloud.

1. Cliquez sur l’outil Thème de couleur dans le panneau d’outils. Vous pouvez utiliser le
raccourci clavier I pour basculer entre les outils Thème de couleur et Pipette.

Outil Thème de couleur

2. Cliquez sur n’importe quelle partie de la mise en page pour choisir une couleur. Vous
pouvez également exploiter les couleurs d’une illustration provenant d'Adobe Photoshop,
d'Illustrator ou de tout autre fichier.

La couleur est conservée une fois sélectionnée à l’aide de l’outil de thème. Après avoir
récupéré les couleurs, si vous changez d’outil pour effectuer une autre opération, par
exemple dessiner un objet, puis que vous sélectionnez à nouveau l’outil Thème de
couleur, le thème choisi plus tôt est conservé. A moins d’appuyer sur la touche Echap
pour fermer le panneau, le thème choisi sera conservé pour être réutilisé. Si vous
appuyez sur la touche Echap, tout est effacé.

3. Survolez l'illustration avec la souris pour identifier les zones marquées automatiquement
par InDesign et à partir desquelles vous pouvez créer un thème de couleur. Cliquez sur
une section et InDesign crée un thème de couleur.

4. Un thème de couleur est composé de cinq couleurs différentes. Cliquez sur le menu
rapide pour afficher les autres choix de couleurs générés.

5. 
Outil Thème de couleur - Options

A. Cliquer pour afficher tous les thèmes B. Ajouter le thème de couleur actuel au
Nuancier C. Enregistrer dans la bibliothèque CC actuelle 

Un thème de couleur est composé de cinq couleurs différentes. Cliquez sur le menu
rapide (A depuis l’image), pour afficher les autres choix de thème générés pour le même
thème de couleur, tel que coloré, clair, foncé et atténué.

Si vous n'aimez pas le thème de couleur généré, appuyez pas sur la touche Echap et
réessayez, ou appuyez sur la touche Alt pour passer temporairement au mode Choisir
afin de créer un nouveau thème.

Utilisez la combinaison Maj + clic pour sélectionner une seule couleur (exacte) comme
couleur de base pour le thème. Les thèmes de couleur sont générés en fonction des
règles d’Adobe Color : Semblable, Monochrome, Triade, Complémentaire, Composite,
Nuances.

6. Pour appliquer les couleurs, vous pouvez cliquer sur une seule couleur avec l’outil



Thème de couleur. Survolez l'élément de page avec le pointeur de la souris. La Pipette
apparaît à moitié pleine. Cliquez pour modifier le fond ou le contour.

Lorsque vous survolez le texte avec le pointeur de la souris, la pipette se transforme en
texte. Vous pouvez appliquer au texte une couleur générée à partir de l’outil Thème de
couleur.

7. Cliquez deux fois sur l’outil Thème de couleur. Les couleurs sélectionnées et ajoutées au
Nuancier honorent le mode du document et se convertissent automatiquement en
espace colorimétrique approprié avant d’être ajoutées au Nuancier ou d’être déposées
sur d’autres objets. Vous pouvez choisir parmi les trois options suivantes :

1. Conversion en fonction du mode du document
2. Conversion en CMJN
3. Conversion en RVB

Options du thème de couleur

8. 
Outil Thème de couleur - Options

A. Cliquer pour afficher tous les thèmes B. Ajouter le thème de couleur actuel au
Nuancier C. Enregistrer dans la bibliothèque CC actuelle 

Cliquez sur B pour ajouter ces couleurs au panneau Nuancier. Le thème de couleur est
ajouté au panneau Nuancier en tant que dossier.

Pour ajouter une couleur spécifique au panneau Nuancier, appuyez sur Alt et cliquez sur
le bouton « Ajouter le thème de couleur actuel au Nuancier ».

9. 
Thème de couleur

Cliquez sur ce bouton. Le thème sélectionné sur le panneau est enregistré dans la
bibliothèque CC actuelle du panneau Bibliothèques CC.

10. Vous pouvez appliquer des valeurs colorimétriques en utilisant le code RVB hexadécimal
dans le menu Sélecteur de couleurs, Nouvelle nuance et Modifier une nuance. Vous
pouvez également appliquer des valeurs colorimétriques à l’aide du code RVB
hexadécimal. Il existe trois façons d'appliquer une valeur colorimétrique hexadécimale :

Utilisation du Sélecteur de couleurs dans une Nouvelle nuance : à partir du
panneau Nuancier, cliquez pour développer le menu rapide et sélectionnez Nouvelle
nuance. Dans la boîte de dialogue Nouvelle nuance, sélectionnez l’option RVB dans
la liste Mode.
Cliquez sur l'outil de capture d'écran, maintenez le bouton de la souris enfoncé puis
cliquez sur n’importe quelle partie de l’écran pour afficher la valeur colorimétrique
hexadécimale depuis toute source. Cliquez sur Ajouter pour ajouter la nuance.
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Remarque :

Nouvelle nuance : Hexvalue

Modifier la nuance : vous pouvez également modifier une nuance ainsi que sa valeur
hexadécimale. Cliquez deux fois sur une nuance, puis dans la liste déroulante Mode,
sélectionnez RVB.
Doublure de couleur : cliquez deux fois sur la doublure de couleur dans le panneau
d’outils. Vous pouvez choisir la valeur hexadécimale à partir d’ici.

Application de couleurs à l’aide de l’outil Pipette

Utilisez l’outil Pipette  pour copier les attributs de fond et de contour, notamment la couleur, d’un objet
contenu dans un fichier InDesign, y compris les images importées. Par défaut, l’outil Pipette charge tous les
attributs de fond et de contour disponibles d’un objet et les définit comme paramètres par défaut pour tout
nouvel objet dessiné. Vous pouvez utiliser la boîte de dialogue Options de la pipette pour modifier les
attributs que cet outil copie. Vous pouvez aussi utiliser l’outil Pipette pour copier les attributs de texte et de
transparence.

si un attribut n’est pas répertorié dans la boîte de dialogue Options de la pipette, il ne peut pas
être copié avec cet outil.

Application de couleurs à l’aide de l’outil Pipette

1. Sélectionnez un ou plusieurs objets dotés d’attributs de fond et de contour à modifier.

2. Sélectionnez l’outil Pipette .

3. Cliquez sur un objet doté des attributs de fond et de contour à prélever. Une pipette
chargée apparaît  ; les objets sélectionnés sont automatiquement mis à jour avec les
attributs de fond et de contour de l’objet sur lequel vous avez cliqué.

4. Pour appliquer les même attributs à d’autres objets, cliquez sur ces derniers avec la
pipette pleine. Si un objet est doté d’un contour et dépourvu de fond, cliquez sur son
contour.

Prélèvement de nouveaux attributs lorsque l’outil Pipette est chargé

1. Appuyez sur Alt (Windows) ou Option (Mac OS) lorsque l’outil Pipette  est chargé.
L’outil Pipette change de sens et apparaît vide  pour indiquer qu’il est prêt à prélever
de nouveaux attributs.

2. Sans relâcher la touche Alt ou Option, cliquez sur un objet contenant les attributs à
copier, puis relâchez la touche Alt ou Option pour appliquer les attributs à un objet.
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Modification des paramètres de l’outil Pipette

1. Dans le panneau Outils, cliquez deux fois sur l’outil Pipette .

2. Sélectionnez les attributs que vous voulez copier avec l’outil Pipette dans les sections
Fonds et Contours, puis cliquez sur OK.

Pour prélever la couleur du fond ou du contour d’un objet sans prélever d’autres attributs, cliquez sur
l’objet avec l’outil Pipette en maintenant la touche Maj enfoncée. Lorsque vous appliquez la couleur à un
autre objet, seule la couleur du fond ou du contour est appliquée, selon que le fond ou le contour figure au
premier plan dans la barre d’outils.

Application de couleurs à des images en niveaux de gris

Vous avez la possibilité d’appliquer des couleurs à une image en niveaux de gris importée dans InDesign.

Une image au format PSD peut contenir plusieurs couches, il est impératif que celle du dessous soit opaque.
En effet, dans InDesign, il est impossible d’appliquer des couleurs à une image PSD dotée d’un arrière-plan
transparent. En outre, l’image en niveaux de gris ne peut comporter ni couches alpha ni couches de tons
directs.

1. Assurez-vous que l’image est enregistrée en tant qu’image en niveaux de gris ou image
bitmap et qu’elle se présente au format PSD, TIFF, BMP ou JPG.

Dans Photoshop, vous pouvez choisir la commande Image > Mode > Bitmap ou Image >
Mode > Niveaux de gris.

2. Cliquez sur la saisie de contenu ou utilisez l’outil Sélection directe  pour sélectionner
l’image.

3. Sélectionnez une couleur depuis le panneau Nuancier ou Couleur.

Ajout et gestion des groupes de couleurs

Les groupes de couleurs permettent de mieux organiser les modèles de couleurs et d’échanger les nuanciers
fréquemment utilisés pour plusieurs applications. Les groupes de couleurs permettent de :

Organiser les nuanciers.
Charger les groupes de couleurs d’un projet dans Illustrator.

Ajouter des groupes de couleurs

1. Pour créer un groupe de couleurs, cliquez sur l’icône de groupe de couleurs dans le
panneau Nuancier. Vous pouvez également créer un groupe de couleurs dans le menu
rapide et le menu contextuel.

Nouveau groupe de couleurs
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2. Saisissez le nom du groupe de couleurs.
Sélectionnez l’option de création de modèle de groupe de couleurs :

Nuances sélectionnées :  sélectionnez cette option si vous souhaitez déplacer
les nuances dans un groupe de couleurs au moment de la création. Maintenez la
touche Ctrl (Windows) ou Option (Mac) enfoncée pour sélectionner plusieurs
nuanciers avant de sélectionner une nouvelle option de groupe de couleurs. Si
aucun nuancier n’est sélectionné, un groupe de couleurs vide est créé.
Élément(s) de la page sélectionnée : les nuanciers des éléments ou
illustrations de la page sélectionnée sont ajoutés au groupe de couleurs créé.
Cette option est activée par défaut lorsqu’une illustration est sélectionnée.

pour attribuer un nom au groupe de couleurs au moment de la création,
vous pouvez utiliser l’une des options ou maintenir la touche Alt (Windows) ou Option
(Mac OS) lorsque vous cliquez sur le bouton Nouveau groupe de couleurs.

3. Vous pouvez glisser et déposer plusieurs nuanciers à partir de la racine ou d’autres
groupes de couleurs, dans le groupe créé.

4. Cliquez avec le bouton droit de la souris sur un nuancier pour rechercher d’autres
options. Vous pouvez passer à une vue de groupe de couleurs et ainsi utiliser ces
derniers de façon intensive. Cliquez sur l’icône Filtre au bas du panneau et choisissez
Afficher les groupes de couleurs. Cela vous permet d’utiliser les groupes de couleurs de
façon intensive. Les nuances et dégradés racines ne sont pas visibles dans cet
affichage.

Afficher les groupes de couleurs

Différentes opérations de gestion des groupes de couleurs

Les opérations suivantes permettent de gérer les groupes de couleurs.

Ajout d’une nuance à un groupe de couleurs : sélectionnez le groupe de couleurs.
Sélectionnez une nuance, faites-la glisser puis déposez-là à l’intérieur du groupe de
couleurs.
Duplication de groupes de couleurs : vous pouvez dupliquer un groupe de couleurs à
l’aide du menu contextuel ou du menu rapide. Cliquez sur un groupe de couleurs et
sélectionnezDupliquer le groupe de couleurs. Toutes les nuances du groupe de couleurs
sont dupliquées avec le groupe de couleurs. Les nuances de groupes de couleurs
différents ne sont pas créées avec les mêmes noms, pour éviter toute confusion.
Dissociation de groupes de couleurs : il est possible de dissocier des groupes de
couleurs à partir du menu déroulant ou du menu rapide. Cliquez sur un groupe de
couleurs avec le bouton droit de la souris et choisissezDissocier le groupe de couleurs.
Lors de la dissociation de groupes de couleurs, toutes les nuances à l’intérieur d’un
groupe sont déplacées vers le dossier racine du groupe de couleur.
Renommage de groupes de couleurs : l’option Options de groupe de couleurs du
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menu déroulant/rapide permet de renommer les groupes de couleurs. Cliquez deux fois
sur un groupe pour modifier le nom du groupe de couleurs. Vous pouvez également
modifier en ligne le groupe de couleurs.
Suppression de groupes de couleurs : sélectionnez un groupe de couleurs, effectuez
un clic droit avec la souris et sélectionnez Supprimer le groupe de couleurs. Vous pouvez
également sélectionner le groupe de couleurs et choisir Supprimer le groupe de couleurs
dans le menu rapide.

lorsque vous supprimez un groupe de couleurs, toutes les nuances du groupe de couleurs sont
supprimées.

Création d’un groupe de couleurs contenant des éléments de page
sélectionnés 

Vous pouvez sélectionner l’illustration d’un élément de page dans le document et créer un groupe de
couleurs à partir des nuanciers présents dans les éléments de la page. Vous pouvez ajouter des nuances à
partir des éléments dans le groupe de couleurs.

1. Sélectionnez des éléments de page dans le document.

2. A partir du menu rapide ou du menu déroulant, sélectionnez Nouveau groupe de
couleurs.

3. Sélectionnez Elément(s) de page sélectionné(s) dans la boîte de dialogue Nouveau groupe de couleurs.
Lorsque plusieurs nuances sont sélectionnées dans le panneau Nuancier, la sélection par défaut est
Nuances sélectionnées.

4. Les groupes de couleurs fonctionnent dans toutes les modes de liste (nom, petit nom)
ainsi que dans les modes de grille (petite vignette, grande vignette). Toutes les actions,
telles que la création, le déplacement de nuances et la création de groupes de couleurs,
peuvent être effectuées sur toutes les vues du panneau Nuancier.

Chargement et enregistrement de nuances à partir d’un fichier .ASE

Les fichiers .ASE permettent l’importation et l’exportation de nuanciers dans des applications comme
Adobe Illustrator. Vous pouvez importer des fichiers .ASE pour charger des groupes de couleurs dans le
panneau Nuancier. Les groupes de couleurs peuvent également être enregistrés sous forme de fichiers .ase
à partir du menu rapide Nuanciers. De la même façon, si les groupes de couleurs sont enregistrés à partir
d’Illustrator, ils peuvent être chargés dans InDesign.

Charger des nuanciers

1. Dans le menu du panneau Nuancier, choisissez Charger un nuancier.

2. Sélectionnez le fichier .ase enregistré. Cliquez sur Ouvrir.

Enregistrer des nuanciers

Vous pouvez enregistrer une nuance ou un groupe de couleurs sous forme de fichier .ase.

1. Sélectionnez le groupe de couleurs ou la nuance.

2. Dans le menu rapide, sélectionnez Enregistrer le nuancier.

3. Saisissez le nom du fichier .ase. Cliquez sur Enregistrer.
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Importation de thèmes à partir de l’application Adobe Color

Dans InDesign, vous pouvez ajouter des thèmes du panneau Couleur dans le panneau Nuancier sous forme
de groupes de couleurs. Ces thèmes sont créés en tant que groupe de couleurs avec le nom du thème.

1. Choisissez Fenêtre > Couleur.

2. Dans la fenêtre de navigation, sélectionnez un thème.

Suivez l’une des procédures suivantes pour exporter le thème vers InDesign :

Cliquez sur la flèche en regard d’un thème et sélectionnez l’option Ajouter au
nuancier.                       

Cliquez sur l’icône Ajouter le thème sélectionné pour importer le thème vers le
panneau Nuancier.

 

Icône/option Ajouter un nuancier

3. Vous pouvez également accéder à l’onglet Créer dans le panneau Couleur, sélectionner
une règle dans Sélectionner une règle, puis cliquer sur l’icône Ajouter ce thème au
Nuancier.

Menu Ajouter le thème au Nuancier

Prise en charge du comportement existant

Si vous ouvrez un fichier .idml avec les informations de groupes de couleurs des versions précédentes, le
panneau Nuancier affiche la liste des nuances plates sans groupes de couleurs car ces derniers ne sont pas
disponibles dans les versions antérieures.
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A propos des tons directs et des couleurs quadrichromiques
Les couleurs quadrichromiques et les tons directs constituent les deux principaux types d’encres utilisés en impression commerciale. Dans le
panneau Nuancier, vous avez la possibilité d’identifier le type d’une couleur à l’aide de l’icône située en regard de son nom.

Tenez compte du support final lorsque vous appliquez de la couleur aux tracés et aux images, de manière à choisir le mode colorimétrique le
mieux adapté.

Si votre flux de production de couleurs comprend le transfert de documents d’un périphérique à un autre, il est conseillé d’utiliser un système
de gestion des couleurs (SGC) afin d’assurer l’uniformité des couleurs tout au long du processus.

A propos des tons directs
Un ton direct est une encre spéciale prémélangée, utilisée à la place ou en complément d’encres quadrichromiques et qui nécessite sa propre
plaque d’impression sur une presse. Il est conseillé d’utiliser des tons directs lorsqu’un nombre limité de couleurs est spécifié et que la précision
des couleurs est primordiale. Les tons directs permettent de reproduire fidèlement des couleurs situées hors de la gamme de couleurs
quadrichromiques. Toutefois, à l’impression, l’apparence exacte des tons directs dépend du mélange d’encre effectué par l’imprimeur et du papier
utilisé, et non des valeurs chromatiques attribuées, ni de la gestion des couleurs. Lorsque vous spécifiez des valeurs de tons directs, vous ne
faites que décrire une simulation de l’aspect de la couleur sur votre moniteur ou votre imprimante composite (qui varie selon les limitations de
gamme spécifiques à chaque périphérique).

Gardez les points suivants à l’esprit lorsque vous spécifiez un ton direct :

Pour une impression optimale de vos documents, spécifiez un ton direct issu d’un système de concordance des couleurs pris
en charge par votre imprimeur. Le logiciel comprend plusieurs bibliothèques de concordance des couleurs.

Réduisez le nombre de tons directs utilisés, car chaque ton direct créé nécessite une plaque d’impression supplémentaire sur
la presse d’imprimerie, augmentant ainsi considérablement vos coûts d’impression. Si vous pensez avoir besoin de plus de
quatre couleurs différentes, envisagez l’utilisation de couleurs quadrichromiques pour l’impression de votre document.

Si un objet comportant des tons directs chevauche un autre objet auquel sont appliqués des effets de transparence, des
résultats indésirables risquent de se produire lors de l’exportation au format EPS, de la conversion des tons directs en couleurs
quadrichromiques à partir de la boîte de dialogue d’impression ou de la préparation des séparations de couleurs dans une
application autre qu’Illustrator ou InDesign. Pour un résultat optimal, utilisez l’aperçu de l’aplatissement ou l’aperçu des
séparations pour vérifier à l’écran les effets de l’aplatissement des transparences avant d’imprimer. Vous pouvez, en outre,
convertir les tons directs en couleurs quadrichromiques à l’aide du Gestionnaire d’encres d’Adobe InDesign avant de procéder
à une impression ou une exportation.

Vous pouvez utiliser une plaque d’impression de ton direct pour appliquer un vernis sur des zones imprimées en couleurs
quadrichromiques. Dans ce cas, votre travail d’impression utilisera cinq encres au total : quatre encres quadri et un ton direct
ou un vernis.

A propos des couleurs quadrichromiques
Une couleur quadrichromique (ou couleur quadri) est imprimée à l’aide d’une combinaison des 4 encres quadri standard : cyan, magenta, jaune et
noir (CMJN). Privilégiez la quadrichromie pour les travaux d’impression, des photographies couleur notamment, qui nécessitent un nombre élevé
de couleurs et pour lesquels l’utilisation de tons directs serait peu pratique ou trop onéreuse.

Gardez les points suivants à l’esprit lorsque vous spécifiez une couleur quadri :

Pour obtenir un résultat optimal lors de l’impression haute qualité de vos documents, utilisez les valeurs CMJN imprimées sur
les chartes de couleurs quadri (ou nuanciers), que vous pourrez vous procurer auprès de votre imprimeur.

Les valeurs chromatiques définitives d’une couleur quadri correspondent à ses valeurs CMJN. Par conséquent, si vous



 

Haut de la page

Haut de la page

spécifiez une couleur quadri avec des valeurs RVB (ou LAB, dans InDesign), celles-ci seront converties en CMJN à
l’impression des séparations de couleurs. Ces conversions varient suivant vos paramètres de gestion des couleurs et le profil
du document.

Ne vous fiez pas à l’aspect d’une couleur quadri sur votre moniteur, à moins que vous n’ayez correctement configuré un
système de gestion des couleurs et que vous soyez conscient de ses limites.

Evitez d’utiliser des couleurs quadri dans les documents destinés exclusivement à une diffusion en ligne, car la gamme de
couleurs CMJN est plus réduite que celle d’un moniteur standard.

Dans Illustrator et InDesign, vous avez la possibilité de définir des couleurs quadri comme couleurs globales ou non globales.
Dans Illustrator, les couleurs quadri globales demeurent associées à une nuance du panneau Nuancier ; ainsi, lorsque vous
modifiez la nuance d’une couleur quadri globale, tous les objets utilisant cette couleur sont mis à jour en conséquence. Les
couleurs quadri non globales ne sont pas mises à jour automatiquement sur l’ensemble du document lorsque la couleur est
modifiée. Les couleurs quadri sont non globales par défaut. Dans InDesign, lorsque vous appliquez une nuance aux objets, la
nuance est appliquée automatiquement en tant que couleur quadri globale. Les nuances non globales sont des couleurs sans
nom que vous pouvez modifier dans le panneau Couleur.

Remarque : le fait qu’une couleur soit globale ou non influe uniquement sur le mode d’application d’une couleur aux objets, et en aucun cas sur le
procédé de séparation des couleurs, ni sur leur comportement en cas de transfert d’une application à une autre.

Utilisation combinée de tons directs et de couleurs quadrichromiques
Pour certains travaux d’impression, il peut se révéler utile de combiner couleurs quadri et tons directs. Par exemple, vous pouvez utiliser un ton
direct pour reproduire la couleur exacte du logo d’une société sur un rapport annuel et imprimer, sur les mêmes pages, des photographies en
couleurs quadri. Vous pouvez également utiliser une plaque d’impression de tons directs pour appliquer un vernis sur des parties d’un travail en
couleurs quadri. Dans ces deux cas, votre travail d’impression nécessitera cinq encres au total : quatre encres quadri et un ton direct ou un vernis.

Dans InDesign, vous pouvez mélanger des couleurs quadri et des tons directs pour créer des encres mélangées.

Comparaison entre les couleurs dans InDesign et dans Illustrator
La méthode d’application des couleurs nommées dans Adobe InDesign diffère légèrement de celle utilisée dans Adobe Illustrator. Dans Illustrator,
vous avez la possibilité de définir des couleurs nommées comme étant des couleurs globales ou non globales. Dans InDesign, toutes les couleurs
sans nom sont traitées comme des couleurs quadri non globales.

Dans InDesign, les nuances sont les équivalents des couleurs globales. Les nuanciers facilitent les modifications générales des couleurs, car ils
évitent d’avoir à rechercher et à retoucher chaque objet séparément. Ils conviennent particulièrement aux documents standardisés et à grand
tirage, tels que les magazines. Les couleurs InDesign étant liées aux nuances du panneau Nuancier, tout changement apporté à une nuance se
répercute sur tous les objets auxquels la couleur est appliquée.

Dans InDesign, les couleurs non globales correspondent aux couleurs sans nom. Les couleurs sans nom n’apparaissent pas dans le
panneau Nuancier, et elles ne sont pas mises à jour automatiquement à l’échelle du document lorsqu’elles sont modifiées dans le
panneau Couleur. Vous pouvez toutefois ajouter ultérieurement une couleur sans nom au panneau Nuancier.

Le fait qu’une couleur soit nommée ou sans nom influe uniquement sur la façon dont une couleur est mise à jour dans le document, et en aucun
cas sur le procédé de séparation des couleurs, ni sur leur comportement en cas de transfert d’une application à une autre.

Voir aussi
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A propos des teintes
Une teinte est une variante tamisée (plus claire) d’une couleur. La création de teintes est une manière économique de créer des variantes de tons
directs supplémentaires sans avoir à acheter d’autres encres de ton direct. Elle permet également de créer rapidement des variantes plus claires
des couleurs quadri, bien que cela ne réduise pas le coût d’impression des couleurs quadri. Comme pour les autres couleurs, il est préférable de
nommer et de stocker les teintes dans le panneau Nuancier de manière à pouvoir modifier facilement toutes les occurrences de la teinte dans le
document.

Tons directs et teintes

La teinte d’un ton direct est imprimée avec la même plaque d’impression que le ton direct. La teinte d’une couleur quadri multiplie chacune des
encres quadri CMJN par le pourcentage de teinte ; par exemple, une teinte à 80 % de C10 M20 J40 N10 donne C8 M16 J32 N8.

Etant donné que les couleurs et les teintes sont mises à jour en même temps, lorsque vous modifiez une nuance, tous les objets qui utilisent une
teinte de cette nuance sont modifiés en conséquence. Vous pouvez également modifier la nuance de base d’une teinte nommée à l’aide de la
commande Options de nuance du menu du panneau Nuancier ; toutes les autres teintes reposant sur la même nuance sont alors mises à jour.

La gamme de teintes proposée dans Adobe Creative Suite 3 est comprise entre 0 et 100 % ; plus la valeur est faible, plus la teinte est claire.

Création et modification de teintes
Vous pouvez modifier la teinte d’un objet spécifique ou créer des teintes à l’aide du curseur Teinte du panneau Nuancier ou du panneau Couleur.
La gamme de teintes est comprise entre 0 et 100 % ; plus la valeur est faible, plus la teinte est claire.

Etant donné que les couleurs et les teintes sont mises à jour en même temps, lorsque vous modifiez une nuance, tous les objets qui utilisent une
teinte de cette nuance sont modifiés en conséquence. Vous pouvez également modifier la nuance de base d’une teinte nommée à l’aide de la
commande Options de nuance du menu du panneau Nuancier ; toutes les autres teintes reposant sur la même nuance sont alors mises à jour.

Création d’une nuance de teinte à l’aide du panneau Nuancier
1. Dans le panneau Nuancier, sélectionnez une couleur.

2. Sélectionnez la flèche en regard de la case Teinte.

3. Déplacez le curseur Teinte, puis cliquez sur le bouton Nouvelle nuance  ou sélectionnez Nouvelle teinte dans le menu du
panneau Nuancier.

La teinte apparaît dans le panneau Nuancier avec le nom de sa couleur de base et le pourcentage de la teinte.

Création d’une nuance de teinte à l’aide du panneau Couleur
1. Dans le panneau Nuancier, sélectionnez une nuance.

2. Dans le panneau Couleur, déplacez le curseur Teinte ou entrez une valeur de teinte dans la case Pourcentage.



 

3. Dans le menu du panneau Couleur, choisissez Ajouter au nuancier.

Déplacez le curseur Teinte, puis cliquez sur Ajouter au nuancier.

Création d’une teinte sans nom
1. Dans le panneau Nuancier, sélectionnez la case Fond ou Contour.

2. Déplacez le curseur Teinte ou entrez une valeur de teinte dans la case Pourcentage.

Modification d’une teinte ou d’une nuance de couleur de base
1. Dans le panneau Nuancier, cliquez deux fois sur la teinte.

2. Utilisez l’une des méthodes suivantes, puis cliquez sur OK :

Pour modifier la teinte, modifiez la valeur Teinte. Tous les objets utilisant cette teinte sont alors mis à jour.

Pour modifier la couleur de base de la teinte, changez le mode colorimétrique ou les valeurs du mode colorimétrique.
Toutes les autres teintes reposant sur la même couleur sont également mises à jour.
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Création et modification de nuances d’encres mélangées
Lorsque vous disposez d’un nombre d’encres limité pour obtenir le maximum de couleurs imprimées, vous pouvez créer des nuances en
mélangeant deux tons directs ou un ton direct avec une ou plusieurs couleurs quadri. Vous pouvez ainsi augmenter le nombre de couleurs
disponibles sans augmenter le nombre de séparations utilisées pour imprimer le document.

Vous pouvez créer une seule nuance d’encres mélangées ou plusieurs à la fois en créant un groupe d’encres mélangées. Un groupe d’encres
mélangées contient une série de couleurs créées à partir de pourcentages incrémentés de différentes couleurs quadri et tons directs. Par exemple,
le mélange de quatre teintes de cyan quadri (20 %, 40 %, 60 % et 80 %) avec cinq teintes d’un ton direct (10 %, 20 %, 30 %, 40 % et 50 %)
produit un groupe d’encres mélangées contenant 20 nuances distinctes.

Panneau Nuancier contenant des nuances d’encres mélangées
A.  Nuance parent du groupe d’encres mélangées B.  Nuance enfant du groupe d’encres mélangées C.  Nuance d’encres mélangées
(indépendante)

Pour pouvoir créer une nuance ou un groupe d’encres mélangées, vous devez ajouter au moins un ton direct au panneau Nuancier.

Création d’une nuance d’encres mélangées
1. Dans le menu du panneau Nuancier, cliquez sur l’option Nouvelle nuance d’encres mélangées (cette option est grisée jusqu’à

ce que vous ajoutiez un ton direct au panneau Nuancier).
2. Attribuez un nom à la nuance.
3. Pour inclure une encre dans la nuance, cliquez sur la case vide en regard de son nom. Une icône d’encre  apparaît. Une

nuance d’encres mélangées doit contenir au moins un ton direct.
4. Ajustez le pourcentage de chaque encre à inclure dans la nuance en déplaçant le curseur ou en entrant une valeur dans la

case Pourcentage.
5. Pour ajouter la nuance au panneau Nuancier, cliquez sur Ajouter ou sur OK.

Les couleurs affichées à l’écran et les couleurs imprimées présentent souvent des différences. Pour obtenir les meilleurs
résultats possibles, il est conseillé de demander à votre imprimeur d’imprimer un échantillon des encres mélangées que
vous souhaitez utiliser.

Création d’un groupe d’encres mélangées
1. Dans le menu du panneau Nuancier, cliquez sur l’option Nouveau groupe d’encres mélangées (cette option est grisée jusqu’à

ce que vous ajoutiez un ton direct au panneau Nuancier).
2. Attribuez un nom au groupe. Les couleurs du groupe adoptent ce nom, suivi du suffixe Nuance incrémenté pour chaque

nouveau groupe (Nuance 1, Nuance 2, etc.).
3. Pour inclure une encre dans le groupe, cliquez sur la case vide en regard de son nom.
4. Pour chaque encre sélectionnée, procédez comme suit :

Dans la zone Initial, indiquez le pourcentage d’encre initial à mélanger pour créer le groupe.

Dans la zone Répétition, indiquez le nombre d’incrémentations du pourcentage souhaitées.

Dans la zone Incrément, indiquez le pourcentage d’encre à ajouter pour chaque répétition.

5. Cliquez sur Prévisualiser le nuancier afin de générer les nuances sans fermer la boîte de dialogue ; vous pouvez ainsi vérifier
si les sélections et valeurs d’encre produisent les résultats voulus, et, dans le cas contraire, les modifier.
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Remarque : si le total des valeurs saisies dans les zones Initial, Répétition et Incrément dépasse 100 % d’une encre donnée,
un avertissement s’affiche. Si vous décidez de poursuivre malgré tout, InDesign plafonne les pourcentages à 100 %.

6. Cliquez sur OK pour ajouter toutes les encres du groupe au panneau Nuancier.

Modification de nuances d’encres mélangées
La modification d’une nuance d’encres mélangées est identique à la modification des autres nuances. Lorsque vous modifiez une nuance ou un
groupe d’encres mélangées, tenez compte des points suivants :

Si vous utilisez le panneau Nuancier pour supprimer une encre utilisée dans une nuance d’encres mélangées, InDesign vous
invite à choisir une encre de remplacement. Une nuance d’encres mélangées doit contenir au moins un ton direct, faute de
quoi elle est convertie en couleur quadri.

Toute modification apportée à la nuance parent  d’un groupe d’encres mélangées est appliquée à toutes les encres
mélangées du groupe. En revanche, les modifications apportées à une autre nuance du groupe portent uniquement sur cette
nuance.

Si vous convertissez une encre mélangée en couleur quadri, elle est retirée du groupe d’encres mélangées auquel elle est
associée.

La suppression de la nuance parent d’un groupe d’encres mélangées supprime toutes les nuances du groupe.

1. Dans le panneau Nuancier, cliquez deux fois sur la nuance parent  du groupe à modifier.
2. Utilisez l’une des méthodes suivantes :

Sélectionnez une nouvelle encre pour remplacer une formulation d’encre existante.

Cliquez sur la case figurant en regard d’une encre pour exclure ou inclure celle-ci comme composante du groupe d’encres
mélangées.

Remarque : vous ne pouvez pas modifier les pourcentages, répétitions ou incréments définis lors de la création du groupe.

3. Cliquez sur le bouton OK.

Gestion des groupes d’encres mélangées
Utilisez le panneau Nuancier pour supprimer les groupes d’encres mélangées, ajouter des nuances et convertir des nuances d’encres mélangées
en couleurs quadri.

Suppression de groupes d’encres mélangées
 Dans le panneau Nuancier, sélectionnez la nuance parent du groupe d’encres mélangées à supprimer, puis cliquez sur le bouton Supprimer.

Ajout d’une nuance à un groupe d’encres mélangées
1. Dans le panneau Nuancier, sélectionnez la nuance parent du groupe d’encres mélangées.
2. Dans le menu du panneau, choisissez Nouvelle couleur.
3. Attribuez un nom à la nuance, si vous le souhaitez.
4. Pour chaque encre répertoriée, spécifiez le pourcentage à ajouter à la nuance d’encres mélangées (vous ne pouvez ni ajouter

ni supprimer des encres).
5. Cliquez sur le bouton OK.

Conversion d’une seule nuance d’encres mélangées en couleur quadri
Il est possible de réduire les coûts d’impression en convertissant des nuances d’encres mélangées en couleurs quadri. Lorsque vous convertissez
la nuance parent d’un groupe d’encres mélangées en couleur quadri, elle disparaît ; les autres nuances du groupe sont converties en couleurs
quadri.

1. Cliquez deux fois sur la nuance d’encres mélangées à convertir.
2. Dans la zone Type, sélectionnez Quadrichromie et cliquez sur OK.

Conversion de toutes les encres d’un groupe d’encres mélangées en couleurs quadri
 Cliquez deux fois sur la nuance parent  du groupe d’encres mélangées et sélectionnez Convertir les nuances d’encres mélangées en

quadrichromie, dans la boîte de dialogue qui s’affiche.
Voir aussi
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A propos des dégradés
Un dégradé est une transition progressive entre au moins deux couleurs ou teintes de même valeur chromatique. La séparation des couleurs du
dégradé dépend du périphérique de sortie utilisé.

Les dégradés peuvent inclure des couleurs quadri, des tons directs, la nuance Papier ou des couleurs d’encres mélangées utilisant n’importe quel
mode colorimétrique. Les dégradés sont définis par un ensemble de paliers de couleur (appelés étapes de dégradé) sur la bande de dégradé. Une
étape de dégradé, représentée par un taquet de couleur situé au-dessous de la bande de dégradé, correspond au point auquel un dégradé passe
d’une couleur à une autre. Par défaut, les dégradés commencent avec deux couleurs et un point médian à 50 %.

Remarque : si vous créez un dégradé à partir de couleurs reposant sur des modes colorimétriques différents, puis que vous imprimez le dégradé
ou en séparez les couleurs, toutes les couleurs sont converties en couleurs quadri CMJN. Le changement de mode colorimétrique peut entraîner
un glissement des couleurs. Pour obtenir de meilleurs résultats, définissez les dégradés en utilisant des couleurs CMJN.

Création d’une nuance de dégradé
Vous pouvez créer et modifier les dégradés ou leur attribuer un nom dans le même panneau Nuancier que celui que vous utilisez pour manipuler
les couleurs en aplat et les teintes. Vous pouvez également créer des dégradés à l’aide du panneau Dégradé.

1. Choisissez Nouveau dégradé dans le menu du panneau Nuancier.
2. Dans Nom de la nuance, attribuez un nom au dégradé.
3. Dans Type, choisissez Linéaire ou Radial.
4. Sélectionnez la première étape du dégradé.

Première étape du dégradé

5. Pour Couleur, utilisez l’une des méthodes suivantes :

Pour choisir une couleur déjà présente dans le panneau Nuancier, choisissez Nuancier et sélectionnez une couleur dans
la liste.

Pour mélanger une nouvelle couleur sans nom afin de créer le dégradé, choisissez un mode colorimétrique et entrez les
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valeurs chromatiques ou faites glisser les curseurs.

Par défaut, le premier palier de couleur du dégradé correspond au blanc. Pour rendre ce palier transparent, appliquez
la nuance Papier.

6. Pour modifier la dernière couleur du dégradé, sélectionnez la dernière étape de dégradé et répétez l’étape 5.
7. Pour régler la position des couleurs de dégradé, utilisez l’une des méthodes suivantes :

Déplacez les étapes de dégradé situées sous la bande.

Sélectionnez une étape de dégradé sous la bande et entrez une valeur dans la zone Emplacement pour définir la position
de cette couleur. La position représente la distance, en pourcentage, qui sépare une couleur de la couleur précédente et
de la couleur suivante.

8. Pour régler le point médian entre deux couleurs du dégradé (le point au niveau duquel les couleurs sont chacune à 50 % de
leur teinte), utilisez l’une des méthodes suivantes :

Déplacez le losange situé au-dessus de la bande.

Sélectionnez le losange situé au-dessus de la bande et entrez une valeur dans la zone Emplacement pour définir la
position de cette couleur. La position représente la distance, en pourcentage, qui sépare une couleur de la couleur
précédente et de la couleur suivante.

9. Cliquez sur OK ou sur Ajouter. Le dégradé est stocké dans le panneau Nuancier avec son nom.

Application d’un dégradé sans nom à l’aide du panneau Dégradé
Bien que le panneau Nuancier soit l’outil recommandé pour créer et stocker des dégradés, vous pouvez également utiliser les dégradés à l’aide du
panneau Dégradé (Fenêtre > Couleur > Dégradé), dont le fonctionnement vous est sûrement familier si vous utilisez Adobe Illustrator. Vous
pouvez ajouter à tout moment le dégradé actif au panneau Nuancier. Le panneau Dégradé permet, par exemple, de créer un dégradé sans nom
qui sera peu utilisé.

Panneau Dégradé
A.  Fond en dégradé B.  Menu du type de dégradé C.  Bouton Inverser D.  Etape de départ E.  Point médian F.  Etape d’arrivée

Remarque : si vous sélectionnez un objet qui utilise un dégradé nommé et que vous modifiez le dégradé à l’aide du panneau Dégradé, la couleur
est uniquement modifiée dans l’objet. Pour modifier toutes les occurrences d’un dégradé nommé, cliquez deux fois sur sa nuance dans le
panneau Nuancier.

1. Sélectionnez le ou les objets que vous souhaitez modifier.
2. Cliquez sur la case Fond ou Contour dans le panneau Nuancier ou le panneau Outils (si la case Fond en dégradé n’est pas

visible, choisissez Afficher les options dans le menu du panneau Dégradé).

3. Pour ouvrir le panneau Dégradé, choisissez Fenêtre > Couleur > Dégradé ou cliquez deux fois sur l’outil Dégradé  dans le
panneau Outils.

4. Pour définir la couleur de départ d’un dégradé, cliquez sur l’étape de dégradé située le plus à gauche, sous la bande de
dégradé, et utilisez l’une des méthodes suivantes :

Faites glisser une nuance à partir du panneau Nuancier et déposez-la dans l’étape de dégradé.

Cliquez sur une nuance du panneau Nuancier tout en maintenant la touche Alt (Windows) ou Option (Mac OS) enfoncée.

Dans le panneau Couleur, créez une couleur à l’aide des curseurs ou de la gamme de couleurs.

5. Pour définir la couleur d’arrivée du dégradé, cliquez sur l’étape de dégradé située le plus à droite sous la bande de dégradé.
Choisissez ensuite la couleur appropriée, comme indiqué à l’étape précédente.

6. Sélectionnez Linéaire ou Radial dans le menu Type et réglez la couleur et le point médian comme indiqué dans la section
Création d’une nuance de dégradé.

7. Pour régler l’angle du dégradé, entrez une valeur dans la zone Angle.

Modification des dégradés
Pour modifier les dégradés, ajoutez des couleurs (pour obtenir des dégradés multicolores) ou redéfinissez leur point médian et leurs étapes. Il est
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conseillé d’appliquer le dégradé au fond d’un objet afin d’en prévisualiser l’effet sur l’objet et de le régler.

Vous pouvez modifier un dégradé collé à partir d’Adobe Illustrator, du moment qu’il a été collé au format AICB, c’est-à-dire
Adobe Illustrator Clipboard (voir la section Collage de graphiques Illustrator dans InDesign). Pour sélectionner le dégradé, utilisez l’outil
Sélection directe.

Remarque : lorsque vous modifiez une couleur, toutes les étapes de dégradé qui utilisent cette couleur sont modifiées en conséquence, ce qui
change également l’aspect du dégradé.

Ajout de couleurs intermédiaires à un dégradé
1. Cliquez deux fois sur un dégradé dans le panneau Nuancier ou affichez le panneau Dégradé.
2. Cliquez sous la bande de dégradé pour ajouter une nouvelle étape de dégradé. La nouvelle étape prend automatiquement les

valeurs chromatiques correspondant à cette position dans le dégradé existant.
3. Réglez la nouvelle étape de dégradé.

Vous pouvez également définir une nouvelle étape de dégradé en faisant glisser une nuance du panneau Nuancier vers la
bande de dégradé, dans le panneau Dégradé.

Suppression d’une des couleurs intermédiaires d’un dégradé
 Sélectionnez l’étape de dégradé intermédiaire et faites-la glisser hors du panneau.

Inversion de la progression d’un dégradé
1. Activez un dégradé.

2. Dans le panneau Dégradé, cliquez sur le bouton Inverser .

Réglage d’un dégradé à l’aide des outils Dégradé
Une fois qu’un fond en dégradé est appliqué à un objet, vous pouvez modifier le dégradé à l’aide de l’outil Nuance de dégradé  ou de l’outil
Contour progressif dégradé  afin de « repeindre » le fond en déplaçant le pointeur le long d’une trajectoire imaginaire. Les outils Dégradé vous
permettent de modifier le sens du dégradé, ses points de départ et d’arrivée et de l’appliquer à plusieurs objets. L’outil Contour progressif dégradé
vous permet de lisser le dégradé dans la direction dans laquelle vous faites glisser l’outil.

1. Dans le panneau Nuancier ou Outils, sélectionnez la case Fond ou Contour selon l’emplacement du dégradé d’origine.
2. Sélectionnez l’outil Nuance de dégradé ou Contour progressif dégradé et placez-le à l’endroit où vous souhaitez définir le

point de départ du dégradé. Faites glisser le pointeur sur l’objet en suivant le sens du dégradé recherché. Maintenez la
touche Maj enfoncée afin de contraindre l’outil à appliquer un multiple de 45 °.

En faisant glisser l’outil Contour progressif dégradé sur le dégradé, vous pouvez adoucir progressivement les couleurs du
dégradé dans la zone dans laquelle vous le faites glisser.

3. Relâchez le bouton de la souris à l’endroit choisi pour la couleur d’arrivée.

Application d’un dégradé de couleurs sur plusieurs objets
1. Assurez-vous que tous les objets sélectionnés utilisent déjà un dégradé.
2. Dans le panneau Outils, sélectionnez la case Fond ou Contour.

3. Sélectionnez l’outil Dégradé  et placez-le à l’endroit où vous souhaitez définir le point de départ du dégradé. Faites glisser
le pointeur sur l’objet en suivant le sens du dégradé recherché. Maintenez la touche Maj enfoncée afin de contraindre l’outil à
appliquer un multiple de 45 °.

4. Relâchez le bouton de la souris à l’endroit choisi pour la couleur d’arrivée.

Fond en dégradé par défaut (à gauche) et dégradé appliqué sur plusieurs objets (à droite)

Si un tracé transparent avec dégradé est sélectionné, vous pouvez modifier le dégradé sur tous ses sous-tracés à l’aide du seul panneau
Dégradé, sans avoir à recourir à l’outil Dégradé.



 

Application de dégradés au texte
Il est possible de créer plusieurs groupes de texte dégradé coexistant avec du texte noir par défaut et du texte en couleurs dans un même bloc de
texte.

Les extrémités des dégradés sont toujours ancrées au cadre de sélection du tracé ou du bloc de texte. Chaque caractère affiche la portion du
dégradé sur lequel il se trouve. Si vous redimensionnez le bloc de texte ou que vous effectuez d’autres modifications affectant la répartition du
texte, les caractères n’occupent plus la même place sur le dégradé et leur couleur change en conséquence.

Utilisation de caractères de texte auxquels est appliqué un dégradé
A.  Fond en dégradé sous-jacent B.  Caractères de texte auxquels le dégradé est appliqué C.  Du texte a été ajouté et les caractères n’occupent
plus la même place sur le fond en dégradé

Pour régler un dégradé afin que toute sa gamme de couleurs s’étende sur un groupe spécifique de caractères, vous pouvez utiliser l’une des
méthodes suivantes :

Utilisez l’outil Dégradé pour redéfinir les extrémités du dégradé et les limiter aux caractères que vous aviez sélectionnés au
moment d’appliquer le dégradé.

Sélectionnez le texte et vectorisez-le (convertissez-le en tracés modifiables), puis appliquez un dégradé aux contours ainsi
obtenus. C’est la méthode qui convient le mieux s’il s’agit d’une petite portion de texte dans un bloc de texte. Le dégradé est
alors ancré définitivement à la portion de texte vectorisé et non au bloc de texte, et la portion de texte vectorisé continue de
suivre le reste du texte en cas de modification. Le texte vectorisé se comporte toutefois comme une image texte unique dans
le bloc de texte ; vous ne pourrez donc plus le modifier. Les options typographiques, telles que l’option de césure, ne
s’appliquent pas non plus au texte vectorisé.

Par défaut, le texte qui change de position change de couleur par rapport au dégradé (à gauche) ; si le texte est vectorisé, le dégradé qui lui est
appliqué se déplace avec le texte (à droite).

Pour plus de détails sur la conversion de vectorisations de texte en tracés, reportez-vous à la section Création de tracés à partir de texte vectorisé.

Dégradés multiples dans un même bloc de texte
Il est possible de sélectionner plusieurs groupes de texte et de leur appliquer différents dégradés dans un même bloc de texte. Chaque dégradé
est ajouté au bloc de texte et associé aux caractères sélectionnés lors de l’application du dégradé. Les extrémités des dégradés restent toutefois
ancrées au cadre de sélection du bloc de texte et non à chaque groupe de texte.

Voir aussi
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Utilisation de couleurs provenant de graphiques importés
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Utilisation des couleurs avec les fichiers EPS ou PDF
Conversion d’un ton direct importé en couleur quadri

Utilisation de couleurs provenant de graphiques importés
InDesign met à votre disposition plusieurs méthodes pour échantillonner et redéfinir les couleurs des graphiques que vous importez dans vos
documents. Les tons directs provenant de fichiers PDF ou EPS importés et les couches de tons directs présentes dans les fichiers
Adobe Photoshop (PSD) et TIFF apparaissent dans le panneau Nuancier sous forme de tons directs. Vous pouvez appliquer ces couleurs à des
objets du document ou les convertir en couleurs quadri, mais vous ne pouvez ni redéfinir les valeurs chromatiques ni supprimer les nuances
importées. Si vous supprimez l’image importée, les couleurs sont conservées, mais elles sont converties en couleurs InDesign natives qu’il est
ensuite possible de modifier ou de supprimer.

Utilisation de l’outil Pipette pour prélever les couleurs
Vous pouvez utiliser l’outil Pipette  pour ajouter à votre document des couleurs provenant d’images importées ou pour les appliquer aux objets
qu’il contient. Cela permet de coordonner la disposition des couleurs avec les images.

Pour obtenir des résultats optimaux avec les séparations de couleurs, vérifiez que le nom, le type (ton direct ou quadri) et le modèle (tel que RVB
ou CMJN) des couleurs échantillonnées dans InDesign correspondent à la définition des couleurs des graphiques importés. En cas de doute sur
les meilleurs paramètres à utiliser, consultez votre prestataire de services prépresse.

Utilisation des couches de tons directs dans un fichier Adobe Photoshop (PSD)
Si vous importez un fichier Photoshop (PSD) ou TIFF dans un document InDesign, les couches de tons directs présentes dans le fichier
apparaissent dans le panneau Nuancier du document sous forme de tons directs. Vous pouvez sélectionner et appliquer ces nuances à des objets
du document ; cependant, pour les supprimer, vous devez d’abord supprimer l’image importée.

Si vous importez un fichier qui contient une couche de tons directs portant le même nom qu’un ton direct déjà présent dans le document, mais
dont les valeurs chromatiques diffèrent, un message s’affiche pour vous demander si vous voulez utiliser les valeurs chromatiques du fichier
importé ou celles du document.

Utilisation des couleurs avec les fichiers EPS ou PDF
Si vous importez un fichier PDF, une image EPS ou un fichier Adobe Illustrator (.AI), les noms des tons directs utilisés dans l’élément graphique
sont ajoutés au panneau Nuancier du document ; vous pouvez utiliser ces tons dans le document, mais sachez qu’ils peuvent entraîner des frais
d’impression supplémentaires.

Si l’élément graphique que vous importez contient un ton direct portant le même nom qu’un ton direct déjà présent dans le document, mais dont
les valeurs chromatiques diffèrent, ce sont les valeurs chromatiques du document qui sont utilisées.

Conversion d’un ton direct importé en couleur quadri
Lors de l’importation d’un graphique EPS, PSD, TIFF ou PDF contenant un ton direct (ou une couche de tons directs), InDesign ajoute le nom et
la définition du ton direct au panneau Nuancier. Vous pouvez convertir un ton direct importé en couleur quadri. Cela vous permet d’adapter
facilement les couleurs, même celles des graphiques importés, en fonction de vos besoins du moment en matière d’impression.

1. Dans le panneau Nuancier, cliquez deux fois sur la nuance à convertir.
2. Dans le menu Type de la boîte de dialogue Options de nuance, choisissez Quadrichromie.

Remarque : le type de couleur change uniquement dans le document InDesign. Pour modifier définitivement le type des couleurs dans un
graphique, ouvrez le graphique et modifiez ses couleurs dans le programme ayant servi à sa création.
Voir aussi
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A propos des transparences
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Utilisation de l’éclairage global
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Désactivation de l’affichage des transparences
Suppression de l’effet de bordure blanche dans les documents comportant des transparences

Par défaut, les objets créés dans Adobe InDesign apparaissent pleins, c’est-à-dire d’une opacité de 100 %. Vous pouvez appliquer des effets
d’opacité et de dégradé de formes aux objets. Superposez des objets, ajoutez-leur de la transparence ou masquez des formes derrière les objets.

A propos des transparences

Lorsque vous créez un objet, que vous appliquez un contour ou un fond ou que vous saisissez du texte, ces éléments sont pleins par défaut, c’est
à dire qu’ils présentent une opacité de 100 %. Vous pouvez les transformer en éléments transparents de plusieurs manières. Vous pouvez par
exemple nuancer la valeur d’opacité sur une échelle allant de 100 % (opacité totale) à 0 % (transparence totale). Lorsque vous réduisez l’opacité
d’un élément (objet, contour, fond ou texte), l’illustration sous-jacente transparaît à la surface de celui-ci.

Le panneau Effets permet de régler l’opacité d’un objet, de son contour, de son fond ou de son texte. Vous pouvez définir le mode de fusion de
l’objet, de son contour, de son fond ou de son texte avec les objets situés en dessous. En ce qui concerne les objets, vous pouvez décider de
limiter la portée de la fusion à des objets spécifiques, de sorte que seuls certains objets d’un groupe fusionnent avec les objets situés en dessous
d’eux, ou bien faire en sorte que les objets d’un groupe masquent les objets du même groupe au lieu de fusionner avec ceux-ci.

 

Les zones des objets sous-jacents apparaissent à travers l’objet transparent.

Présentation du panneau Effets

Le panneau Effets (Fenêtre > Effets) permet de définir l’opacité et le mode de fusion des objets et des groupes, de limiter la portée de la fusion
aux objets d’un groupe spécifique, de masquer les objets d’un groupe ou d’appliquer un effet de transparence.
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Ajout et modification d’effets de transparence dans le panneau Effets

A. Mode de fusion B. Niveaux C. Icône FX D. Effacer les effets E. Bouton FX 

Mode de fusion

Détermine le mode d’interaction entre les couleurs des objets transparents et les objets situés derrière (voir Définition du mode de fusion des
couleurs).

Opacité

Définit l’opacité d’un objet, contour, fond ou texte (voir Définition de l’opacité d’un objet).

Niveau

Indique les paramètres d’opacité d’objet, de contour, de fond ou de texte de l’objet et si des effets de transparence sont appliqués. Cliquez sur
l’icône en forme de triangle située à gauche du mot Objet (ou Groupe ou Graphique) pour afficher ou masquer ces paramètres de niveau.
L’icône FX apparaît sur un niveau lorsque vous lui appliquez des paramètres de transparence. Vous pouvez cliquez deux fois sur cette icône pour
modifier les paramètres.

Fusion isolée

Applique un mode de fusion à un groupe d’objets sélectionné (voir Modes de fusion isolée).

Groupe perçant

Permet aux attributs d’opacité et de fusion de chaque objet d’un groupe de masquer, ou bloquer, les objets sous-jacents d’un groupe (voir
Masquage des objets d’un groupe).

Bouton Tout effacer

Supprime les effets (contour, fond ou texte) appliqués à un objet, rétablit le mode de fusion Normal et redéfinit le paramètre Opacité à 100 % sur
l’ensemble de l’objet.

Bouton FX

Affiche une liste des effets de transparence (voir Application d’effets de transparence).

Pour afficher les options du panneau Effets

Choisissez la commande Fenêtre > Effets et, si nécessaire, ouvrez le menu du panneau Effets et choisissez la
commande Afficher les options.

Les options du panneau Effets sont également disponibles dans la boîte de dialogue Effets (sélectionnez un objet et choisissez
la commande Objet > Effets > Transparence) et sous forme simplifiée dans le panneau Contrôle.

Application d’effets de transparence

1. Sélectionnez un objet. Pour appliquer des effets à un graphique, sélectionnez celui-ci à l’aide de l’outil Sélection directe.

2. Choisissez la commande Fenêtre > Effets pour afficher le panneau Effets.

3. Sélectionnez un niveau pour désigner la ou les parties de l’objet à modifier :

Agit sur l’objet dans son ensemble : contour, fond et texte.
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Graphique

Groupe

Contour

Fond

L’habillage de texte

Agit uniquement sur le graphique sélectionné à l’aide de l’outil Sélection directe. Un graphique conserve les effets
que vous lui avez appliqués lorsque vous le collez dans une autre image.

Agit sur tous les objets et le texte du groupe (utilisez l’outil Sélection directe pour appliquer des effets aux objets d’un
groupe)

Agit sur le contour de l’objet uniquement (y compris sur la couleur d’espace).

Agit sur le fond de l’objet uniquement.

Agit uniquement sur le texte compris dans l’objet ; n’agit pas sur le bloc de texte Les effets que vous
appliquez au texte agissent sur l’intégralité du texte contenu dans l’objet. Il est impossible d’appliquer un effet à des mots ou
lettres individuels.

Vous pouvez également choisir un paramètre de niveau dans le panneau Contrôle : cliquez sur le bouton Appliquer l’effet à 
et sélectionnez Objet, Contour, Fond ou Texte.

4. Utilisez l’une des méthodes suivantes pour ouvrir la boîte de dialogue Effets :

Dans le panneau Effets ou Contrôle, cliquez sur le bouton FX  et choisissez un effet dans le menu.

Dans le menu du panneau Effets, choisissez la commande Effets, puis un nom d’effet.

Dans le menu du panneau contextuel, choisissez la commande Effets, puis un nom d’effet.

Choisissez la commande Objet > Effets, puis un nom d’effet.

Dans le panneau Effets, cliquez si nécessaire sur l’icône en forme de triangle pour afficher les paramètres de niveau, puis
cliquez deux fois sur un paramètre de niveau : Objet, Contour, Fond ou Texte. Lorsque vous cliquez deux fois sur un
paramètre de niveau, vous ouvrez la boîte de dialogue Effets et choisissez en même temps un paramètre de niveau.

5. Choisissez des options et des paramètres pour l’effet (voir Options et paramètres de transparence courants).

6. Cliquez sur le bouton OK.

Pour modifier un effet de transparence

1. Sélectionnez le ou les objets auxquels l’effet a été appliqué.

2. Utilisez l’une des méthodes suivantes pour ouvrir la boîte de dialogue Effets :

Sur le panneau Effets, cliquez deux fois sur l’icône FX située à droite de Objet (et non au bas du panneau). Si nécessaire,
cliquez sur l’icône en forme de triangle en regard du mot Objet pour afficher l’icône FX.

Sélectionnez le niveau comportant l’effet à modifier, cliquez sur le bouton FX  dans le panneau Effets, puis choisissez
le nom de l’effet.

3. Modifiez l’effet.

Pour copier des effets de transparence

Utilisez l’une des méthodes suivantes pour copier un effet de transparence :

Pour copier un effet d’un objet à l’autre, sélectionnez l’objet auquel doit être appliqué l’effet à copier, cliquez sur l’icône FX 
 de l’objet dans le panneau Effets et faites-la glisser vers l’autre objet. Vous pouvez faire glisser et déposer des effets

d’un objet à l’autre uniquement au sein d’un même niveau.

Pour copier un effet d’un objet à l’autre de manière sélective, utilisez l’outil Pipette . Pour contrôler les paramètres de
transparence (contour, fond, objet) que vous souhaitez copier à l’aide de l’outil Pipette, cliquez deux fois sur l’outil pour
ouvrir la boîte de dialogue Options de la pipette. Activez ou désactivez les options souhaitées dans les zones Contours,
Fonds et Paramètres d’objet.

Pour copier un effet d’un niveau à l’autre au sein d’un même objet, maintenez la touche Alt (Windows) ou Option (Mac OS)
enfoncée et faites glisser l’icône FX d’un niveau à l’autre (Contour, Fond, Texte) sur le panneau Effets.
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Ombre portée

Ombre interne

Lueur externe et Lueur interne

Biseau et estampage

Satin

Contour progressif simple, Contour progressif directionnel et Contour progressif dégradé

Vous pouvez déplacer un effet d’un niveau à l’autre au sein d’un même objet en faisant glisser l’icône FX.

Pour effacer les effets de transparence d’un objet

Utilisez l’une des méthodes suivantes :

Pour supprimer tous les effets appliqués à un objet, rétablir le mode de fusion Normal et redéfinir le paramètre Opacité sur
100 %, cliquez sur le bouton Effacer les effets  du panneau Effets ou choisissez Effacer toute transparence dans le
menu du panneau Effets.

Pour supprimer tous les effets sans modifier les paramètres de fusion et d’opacité, sélectionnez un niveau et choisissez la
commande Effacer les effets dans le menu du panneau Effets ou faites glisser l’icône FX  depuis le niveau Contour,
Fond ou Texte du panneau Effets, vers l’icône de la corbeille.

Pour supprimer plusieurs niveaux (Contour, Fond ou Texte) d’un effet, sélectionnez les niveaux et cliquez sur l’icône de la
corbeille.

Pour supprimer un effet spécifique appliqué à un objet, ouvrez la boîte de dialogue Effets et désélectionnez un effet
Transparence.

Effets de transparence

InDesign propose neuf effets de transparence. Un grand nombre de paramètres et d’options permettant de créer ces effets sont similaires.

Effets

A. Ombre portée B. Ombre interne C. Lueur externe D. Lueur interne E. Biseau et estampage F. Satin G. Contour progressif simple H. Contour
progressif directionnel I. Contour progressif dégradé 

Ajoute une ombre tombant derrière l’objet, le contour, le fond ou le texte.

Ajoute une ombre tombant juste à l’intérieur des bords de l’objet, du contour, du fond ou du texte, lui conférant un aspect
encastré.

Ajoute une lueur qui émane des bords extérieurs ou intérieurs de l’objet, du contour, du fond ou du texte.

Ajoute différentes combinaisons de tons clairs et foncés pour donner un aspect 3D au texte et aux images.

Applique un ombrage interne créant un fini satiné.

Vous pouvez lisser les contours d’un objet en les
rendant transparents.
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Angle et Elévation

Mode de fusion

Maigri

Distance

Bruit

Opacité

Taille

Grossi

Technique

Plus tamisée

Précise

Utiliser l’éclairage global

Décalage sur X et Décalage sur Y

en complément des descriptions abordées dans cette section, reportez-vous à la section Options et paramètres de transparence
courants.

Options et paramètres de transparence courants

Un grand nombre de paramètres et d’options permettant de créer des effets de transparence sont similaires. Les options et paramètres de
transparence courants comprennent les suivants :

Détermine l’angle d’un effet d’éclairage. La valeur 0 correspond au niveau du sol et la valeur 90 place la source de lumière
directement au-dessus de l’objet. Cliquez sur le rayon d’angle ou saisissez une valeur en degrés. Activez l’option Utiliser l’éclairage global si vous
souhaitez un angle d’éclairage uniforme pour tous les objets. Ce paramètre est utilisé pour les effets Ombre portée, Ombre interne, Biseau et
estampage, Satin et Contour progressif.

Détermine le mode d’interaction entre les couleurs des objets transparents et les objets situés derrière Ce paramètre est utilisé
pour les effets Ombre portée, Ombre interne, Lueur externe, Lueur interne et Satin (voir Définition du mode de fusion des couleurs).

Tout comme les paramètres de taille, ce paramètre détermine la part d’opacité et la part de transparence de la lueur ou de l’ombre. Une
valeur supérieure augmente l’opacité et une valeur inférieure augmente la transparence. Ce paramètre est utilisé pour les effets Ombre interne,
Lueur interne et Contour progressif.

Détermine la distance de décalage pour les effets Ombre portée, Ombre interne ou Satin.

Spécifie la quantité des éléments aléatoires dans l’opacité d’une lueur ou d’une ombre lorsque vous entrez une valeur ou que vous
déplacez le curseur correspondant. Ce paramètre est utilisé pour les effets Ombre portée, Ombre interne, Lueur externe, Lueur interne et
Contour progressif.

Définit l’opacité d’un effet. Faites glisser le curseur ou saisissez une mesure en pourcentage (voir Définition de l’opacité d’un objet). Ce
paramètre est utilisé pour les effets Ombre portée, Ombre interne, Lueur externe, Lueur interne, Contour progressif dégradé, Biseau et estampage
et Satin.

Indique la quantité d’ombre ou de lueur. Ce paramètre est utilisé pour les effets Ombre portée, Ombre interne, Lueur externe, Lueur interne
et Satin.

Détermine la transparence de flou des effets d’ombre ou de lueur, telle que définie par le paramètre Taille. Un pourcentage supérieur rend
le flou plus opaque. Ce paramètre est utilisé pour les effets Ombre portée et Lueur externe.

Ces paramètres définissent le mode d’interaction entre le bord d’un effet de transparence et les couleurs d’arrière-plan. Les
options Plus tamisée et Précise sont disponibles pour les effets Lueur externe et Lueur interne :

Rend le bord de l’effet choisi plus flou. Dans des tailles supérieures, ce paramètre ne préserve pas les détails des
caractéristiques.

Préserve le bord de l’effet, dont les angles et autres détails nets. Cette technique préserve mieux les détails que la
technique Plus tamisée.

Applique le paramètre d’éclairage global à l’ombre. Ce paramètre est utilisé pour les effets Ombre portée, Biseau et
estampage, et Ombre interne.

Décale l’ombre sur l’axe des x ou l’axe des y de la valeur que vous indiquez. Ce paramètre est utilisé pour les
effets Ombre portée et Ombre interne.

Ombre portée
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Ombre masquée par l’objet

Autres effets respectés par l’ombre

Source

Style

Corps

Technique

L’effet Ombre portée crée une ombre tridimensionnelle. Vous pouvez décaler l’ombre portée le long de l’axe des x ou de l’axe des y et modifier le
mode de fusion, la couleur, l’opacité, la distance, l’angle et la taille de l’ombre portée. Ces options vous permettent de définir le mode d’interaction
de l’ombre portée avec des objets et des effets de transparence :

L’objet s’affiche au-dessus de l’ombre qu’il projette.

L’ombre portée inclut d’autres effets de transparence. Par exemple, si l’objet comporte un contour
progressif sur l’un de ses côtés, vous pouvez faire en sorte que l’ombre portée soit appliquée sans tenir compte de ce contour, pour éviter que son
bord ne soit estompé ou, au contraire, faire en sorte que l’ombre présente un contour progressif comme l’objet.

Cliquez sur le bouton Ombre portée  du panneau Contrôle pour appliquer rapidement une ombre portée à un objet, un contour, un fond ou un
texte, ou pour la supprimer.

Pour sélectionner la couleur de l’ombre portée, cliquez sur le bouton Définir la couleur de l’ombre (en regard du menu Mode de fusion), puis
sélectionnez une couleur.

Ombre interne

L’effet Ombre interne place l’ombre à l’intérieur de l’objet, donnant l’impression que l’objet est encastré. Vous pouvez décaler l’ombre interne le
long d’axes différents et modifier le mode de fusion, l’opacité, la distance, l’angle, la taille, le bruit et l’effet maigri de l’ombre.

Lueur externe

L’effet Lueur externe émane du dessous de l’objet. Vous pouvez définir le mode de fusion, l’opacité, la technique, le bruit, la taille et le
grossissement.

Lueur interne

L’effet Lueur interne émane depuis l’intérieur de l’objet. Choisissez les paramètres de mode de fusion, d’opacité, de technique, de bruit, de taille et
de grossissement, ainsi que le paramètre Source :

Indique la source de la lueur. Choisissez l’option Centre pour appliquer une lueur qui émane du centre et l’option Bord pour appliquer une
lueur qui émane des bords de l’objet.

Biseau et estampage

L’effet Biseau et estampage permet de donner aux objets un aspect tridimensionnel réaliste. Les paramètres Structure déterminent la taille et la
forme de l’objet :

Définit le style de biseau : l’option Biseau externe crée le biseau sur les bords externes de l’objet ; l’option Biseau interne crée le biseau sur
les bords internes ; l’option Estampage simule l’effet de l’estampage de l’objet sur des objets sous-jacents ; l’option Estampage oreiller simule
l’effet de l’estampage des bords de l’objet sur des objets sous-jacents.

Détermine la taille de l’effet de biseau et d’estampage.

Détermine le mode d’interaction entre le bord de l’effet de biseau ou d’estampage et les couleurs d’arrière-plan : l’option Arrondi
applique un léger flou aux bords (sans conserver les détails des caractéristiques en taille supérieure) ; l’option Ciselage léger applique un flou aux
bords, quoique modéré par rapport à l’option Arrondi (cette option conserve mieux les détails des caractéristiques que l’option Arrondi, mais moins
efficacement que l’option Ciselage marqué) ; l’option Ciselage marqué applique un bord plus épais et visible (cette option conserve mieux les
détails des caractéristiques que les options Arrondi et Ciselage léger).



Atténuation

Sens

Profondeur

Angle et Elévation

Utiliser l’éclairage global

Tons clairs et tons foncés

Inverser

En complément du paramètre Technique, cette option estompe l’effet pour réduire les artefacts indésirables et lisser les contours.

Choisissez les options Haut ou Bas pour que l’effet semble poussé vers le haut ou vers le bas.

Détermine la profondeur de l’effet de biseau et d’estampage.

Les paramètres d’ombrage déterminent le mode d’interaction entre la lumière et l’objet :

Définit la hauteur de la source de lumière. La valeur 0 correspond au niveau du sol et la valeur 90 place la source de lumière
directement au-dessus de l’objet.

Applique la source d’éclairage global telle que définie pour tous les effets de transparence. Lorsqu’elle est activée,
cette option remplace les paramètres Angle et Elévation.

Spécifie le mode de fusion des tons clairs ou foncés d’un biseau ou d’un estampage.

Satin

L’effet Satin permet de donner un fini satiné et lisse aux objets. Choisissez les paramètres de mode de fusion, d’opacité, d’angle, de distance et
de taille et indiquez si vous souhaitez inverser les couleurs et les transparences :

Activez cette option pour inverser les zones colorées et transparentes de l’objet.

Contour progressif simple

L’effet Contour progressif adoucit (estompe) les bords d’un objet sur une distance que vous indiquez :

Largeur de contour progressif

Définit la distance sur laquelle l’objet doit passer d’opaque à transparent.

 

Maigri

Tout comme le paramètre Largeur de contour progressif, ce paramètre détermine la part d’opacité et la part de transparence de la lueur
d’atténuation. Les valeurs élevées augmentent l’opacité et les valeurs faibles augmentent la transparence.

 

Angles

Choisissez parmi les options Pointus, Arrondis ou Diffus :

 Pointus  Suit le bord extérieur de la forme, angles pointus compris. Cette option est idéale pour des objets en forme d’étoile ou pour des effets
spéciaux sur une forme rectangulaire.

Arrondis  Arrondit les angles de la valeur du rayon du contour progressif. Concrètement, un contour incrusté, puis un contour en relief sont
ajoutés pour former les deux contours. Cette option est optimale pour les rectangles.

Diffus  Utilise la méthode d’Adobe Illustrator qui rend transparents les angles opaques de l’objet.

Bruit

Spécifie la quantité des éléments aléatoires dans la lueur d’atténuation. Cette option vous permet d’atténuer la lueur.

Contour progressif directionnel

L’effet Contour progressif directionnel lisse les bords d’un objet en les rendant transparents dans le sens défini. Par exemple, vous pouvez
appliquer un contour progressif en haut et en bas de l’objet, mais pas sur les côtés gauche et droit.
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Largeurs de contour progressif

Définit la distance sur laquelle le haut, le bas, ou les côtés gauche ou droit de l’objet deviennent transparents. Activez l’option Verrouiller pour
rendre transparents tous les côtés de l’objet sur la même distance.

Bruit

Spécifie la quantité des éléments aléatoires dans la lueur d’atténuation. Cette option vous permet de créer une lueur plus douce.

Maigri

Tout comme les paramètres de largeur, ce paramètre détermine la part d’opacité et la part de transparence de la lueur. Les valeurs élevées
augmentent l’opacité et les valeurs faibles augmentent la transparence.

Forme

Choisissez une option (Premier bord uniquement, Bords d’interlignage ou Tous les bords) afin de délimiter la forme initiale de l’objet.

Angle

Fait pivoter le cadre de référence de l’effet de contour progressif, de sorte que les contours progressifs sont inclinés plutôt que parallèles à l’objet,
à condition d’éviter les multiples de 90 degrés.

Contour progressif dégradé

L’effet Contour progressif dégradé permet de lisser les zones d’un objet en les rendant transparentes.

Couleurs de dégradé

Adoptez une couleur de dégradé pour chaque degré de transparence que vous souhaitez appliquer à l’objet.

Pour créer une couleur de dégradé, cliquez en dessous du curseur de dégradé (faites glisser le curseur d’un cran pour écarter
une couleur).

Pour ajuster la position d’une couleur de dégradé, faites-la glisser vers la gauche ou la droite, ou sélectionnez-la et faites
glisser le curseur d’emplacement.

Pour régler le point central entre deux étapes d’opacité, faites glisser le losange correspondant au-dessus du curseur de
dégradé. Selon l’emplacement du losange, vous obtiendrez une transition plus ou moins marquée entre les étapes, c’est-à-dire
une transition brutale ou plus progressive.

Inverser le dégradé

Cliquez sur cette option pour inverser le sens du dégradé. Cette case se situe à droite du curseur de dégradé.

Opacité

Définit la transparence entre les points de dégradé. Sélectionnez un point et faites glisser le curseur d’opacité.

Emplacement

Ajuste la position d’une couleur de dégradé. Sélectionnez une couleur de dégradé, puis faites glisser le curseur ou saisissez une mesure.

Texte

L’option Linéaire applique un dégradé en ligne droite depuis le point de dégradé de départ au point de dégradé d’arrivée. L’option Radial applique
un dégradé circulaire du point de départ au point d’arrivée.

Angle

Pour les dégradés linéaires, établit l’angle des lignes de dégradé. A 90 degrés, par exemple, les lignes sont horizontales et à 180 degrés,
verticales.

Utilisation de l’éclairage global

Vous pouvez appliquer un angle d’éclairage uniforme aux effets de transparence qui ont l’ombre pour facteur : Ombre portée, Ombre interne et
Biseau et estampage. Lorsque vous appliquez l’option Utiliser l’éclairage global à l’un de ces effets, l’éclairage dépend du paramètre global défini
dans la boîte de dialogue Eclairage global.

1. Utilisez l’une des méthodes suivantes pour ouvrir la boîte de dialogue Eclairage global :

Choisissez la commande Eclairage global dans le menu du panneau Effets.

Choisissez Objet > Effets > Eclairage global.
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2. Entrez une valeur ou déplacez le rayon d’angle pour définir les valeurs Angle et Elévation, puis cliquez sur OK.

Définition de l’opacité d’un objet

Il est possible d’appliquer un effet de transparence à un objet individuel ou à des objets sélectionnés (y compris les images et blocs de texte), mais
pas à des caractères individuels ou calques. Toutefois, les images importées avec ces types d’effets de transparence s’affichent et s’impriment
correctement.

1. Sélectionnez le ou les objets.

Le mot mixte s’affiche dans le panneau Effets lorsque vous sélectionnez plusieurs objets dont les paramètres d’opacité
diffèrent. Par exemple, si le paramètre d’opacité Fond diffère dans les objets sélectionnés, le panneau Transparence indique
« Fond : Opacité (mixte) ».

2. Choisissez Objet, Contour, Fond ou Texte en utilisant l’une des méthodes suivantes :

Cliquez sur le bouton Appliquer les effets  du panneau Contrôle et choisissez une option.

Cliquez sur une option du panneau Effets (si nécessaire, cliquez sur l’icône en forme de triangle située en regard du mot
Objet pour afficher les options).

3. Dans le panneau Contrôle ou Effets, saisissez une valeur pour l’opacité ou cliquez sur la flèche située en regard du
paramètre Opacité, puis faites glisser le curseur. La réduction de la valeur de l’opacité d’un objet en augmente la
transparence.

si vous sélectionnez un objet avec l’outil Sélection directe, que vous le coupez ou le copiez depuis un groupe transparent dans
InDesign, puis que vous le collez dans une autre partie du document, l’objet collé ne sera pas transparent à moins de l’avoir préalablement
sélectionné individuellement et d’y avoir appliqué une transparence.

Application de la transparence aux groupes

Outre l’application d’effets de transparence à des objets individuels, vous pouvez les appliquer à des groupes.

Si vous sélectionnez simplement des objets et modifiez leur paramètre d’opacité individuel, l’opacité des objets sélectionnés change en fonction de
l’opacité des autres. les intersections affichent alors une opacité cumulée.

Si, en revanche, vous ciblez un groupe créé à l’aide de la commande Associer, puis que vous modifiez l’opacité, le groupe est traité comme un
tout par le panneau Effets (ce dernier ne présente qu’une seule option de niveau : Groupe) et les opacités au sein du groupe restent inchangées.
En d’autres termes, les transparences des objets du groupe n’interagissent pas les unes avec les autres.

Objets individuels sélectionnés et définis avec une opacité de 50 % (à gauche) et groupe sélectionné et défini avec une opacité de 50 % (à droite)

Modification de l’apparence des illustrations transparentes à l’écran

Utilisez la boîte de dialogue Performances d’affichage pour définir les préférences de transparence. Ces préférences déterminent la qualité
d’affichage à l’écran des objets transparents dans les nouveaux documents et dans les documents enregistrés avec des préférences modifiées.
Vous pouvez également définir les préférences de façon à activer ou désactiver l’affichage de la transparence dans le document. Si vous
désactivez l’affichage des transparences, elles apparaîtront néanmoins lors de l’impression ou de l’exportation du fichier.

avant d’imprimer un fichier contenant des effets de transparence, assurez-vous que les préférences de transparence sont définies
selon les besoins car une impression automatique aplatit les illustrations et risque d’altérer l’aspect de ces effets.
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1. Choisissez Edition > Préférences > Performances d’affichage (Windows) ou Adobe InDesign > Préférences > Performances
d’affichage (Mac OS).

2. Sélectionnez une option (Rapide, Standard ou Qualité supérieure) dans la section Réglage de l’affichage pour déterminer la
résolution à l’écran de tout effet dans le document. Les paramètres que vous modifiez ne s’appliquent qu’à l’option que vous
sélectionnez ici :

Rapide désactive la transparence et définit la résolution à 24 ppp.

Standard affiche des effets basse résolution et définit la résolution à 72 ppp.

Qualité supérieure améliore l’affichage des effets, principalement dans les fichiers PDF et EPS, et définit la résolution à
144 ppp.

3. Faites glisser le curseur de transparence. Le paramètre par défaut est Qualité moyenne. Il affiche des ombres portées et des
contours progressifs.

4. Cliquez sur le bouton OK.

5. Lorsque des encres se superposent à des modes de fusion, choisissez Affichage > Aperçu de la surimpression. Cette option
permet de visualiser à l’écran l’interaction des encres avec les transparences.

Utilisez le menu Affichage pour régler rapidement le mode d’affichage des transparences sur Affichage rapide, Affichage standard ou Affichage
de qualité supérieure.

Désactivation de l’affichage des transparences

Il est possible de désactiver l’affichage des transparences pour améliorer les performances d’affichage. Si vous désactivez l’affichage des
transparences à l’écran, elles apparaîtront néanmoins lors de l’impression ou de l’exportation du fichier.

Choisissez Affichage > Performances d’affichage > Affichage rapide.

Suppression de l’effet de bordure blanche dans les documents comportant des transparences

Il arrive parfois qu’une bordure blanche (ou cadre indésirable) soit visible à l’endroit où un effet de transparence est appliqué, généralement dans
les documents contenant des ombres portées ou des dégradés. Ce problème peut survenir si l’effet de transparence interfère avec un ton direct.

Pour résoudre ce problème, vous pouvez soit éviter d’utiliser des tons directs avec des transparences, soit activer la surimpression.

Pour visualiser et imprimer un document PDF sans effet de bordure blanche, activez l’option Simuler la surimpression dans Acrobat. Dans
Acrobat 9, choisissez Options avancées > Impression > Aperçu de la sortie. Dans Acrobat X, choisissez Outils > Travaux d’impressions > Aperçu
de la sortie.

Si vous envoyez le document à un imprimeur qui fait face à ce problème, demandez au prestataire de services d’activer la surimpression
PostScript pour le RIP. Si le problème persiste, vous pouvez aplatir les transparences et sélectionnez l’option Simuler la surimpression avant
d’envoyer le fichier. Dans InDesign, cette option se trouve dans le panneau Sortie de la boîte de dialogue d’impression lorsque vous sélectionnez
l’option CMJN composite.

Adobe recommande également

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr


Aplatissement d’une illustration avec transparence

Haut de la page

Haut de la page

A propos de l’aplatissement
A propos des paramètres d’aplatissement prédéfinis des transparences
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Création ou modification d’un paramètre prédéfini d’aplatissement des transparences
Exportation et importation d’un paramètre prédéfini d’aplatissement des transparences personnalisé
Changement de nom ou suppression d’un paramètre prédéfini d’aplatissement des transparences personnalisé
Aplatissement d’une planche individuelle
Ignorer l’aplatissement prédéfini pour une planche
Options d’aplatissement des transparences
Aperçu des zones de l’illustration qui seront aplaties
Réactualisation de l’aperçu à partir du panneau Aperçu de l’aplatissement
Méthodes recommandées en matière de création de transparences

A propos de l’aplatissement
Si votre document ou votre illustration fait appel à la transparence, il est généralement nécessaire d’appliquer un processus appelé aplatissement
pour sa sortie. L’aplatissement divise l’illustration transparente en zones vectorielles et en zones pixellisées. Plus l’illustration est complexe (mêlant
images, vecteurs, tons directs, surimpression, etc.), plus l’aplatissement et son résultat le sont également.

L’aplatissement peut être nécessaire lors de l’impression ou lors de l’enregistrement ou de l’exportation dans des formats différents ne prenant pas
en charge la transparence. Pour conserver la transparence sans aplatissement lorsque vous créez des fichiers PDF, enregistrez-les en tant que
documents Adobe PDF 1.4 (Acrobat 5.0) ou version ultérieure.

Vous pouvez spécifier les paramètres d’aplatissement avant de les enregistrer et de les appliquer en tant qu’aplatissements prédéfinis des
transparences. Les objets transparents sont aplatis en fonction des paramètres de l’aplatissement prédéfini sélectionné.

Remarque : l’aplatissement de la transparence ne peut pas être annulé après enregistrement du fichier.

Une zone graphique en chevauchement est divisée lors de l’aplatissement.

Pour plus d'informations sur les problèmes de sortie de la transparence, reportez-vous à la page de ressources du prestataire de services
d'impression du site Adobe Solutions Network (ASN) (en anglais uniquement), disponible sur le site Web Adobe.

A propos des paramètres d’aplatissement prédéfinis des transparences
Si vous imprimez ou exportez régulièrement des documents contenant des transparences, vous pouvez automatiser le processus d’aplatissement
en enregistrant des paramètres dans un aplatissement prédéfini des transparences. Vous pouvez ensuite appliquer ces paramètres pour une
sortie imprimée, ainsi que pour l'enregistrement et l'exportation des fichiers aux formats PDF 1.3 (Acrobat 4.0), EPS et PostScript. En outre, dans
Illustrator, vous pouvez appliquer ces paramètres lorsque vous enregistrez les fichiers dans des versions antérieures d'Illustrator ou lorsque vous
les copiez dans le Presse-papiers ; dans Acrobat, vous pouvez également appliquer ces paramètres lors de l'optimisation de fichiers PDF.

Ces paramètres contrôlent également le comportement de l'aplatissement lors de l'exportation dans des formats ne prenant pas en charge les
transparences.

Vous pouvez sélectionner un aplatissement prédéfini dans le panneau Avancés de la boîte de dialogue Imprimer ou de la boîte de dialogue propre
au format qui apparaît après la boîte de dialogue initiale Exporter ou Enregistrer sous. Vous pouvez créer vos propres aplatissements prédéfinis ou
sélectionner une option par défaut fournie avec le logiciel. Les paramètres de chacune de ces options sont conçus pour correspondre à la qualité
et la vitesse de l'aplatissement avec une résolution appropriée pour les zones transparentes pixellisées, suivant l'usage prévu du document :

http://www.adobe.com/go/partner_asn_indesign_fr
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[Haute résolution] S'utilise pour les impressions finales sur presse et les épreuves haute qualité comme les épreuves présentant une séparation
des couleurs.
[Résolution moyenne] S'utilise pour les épreuves de bureau et les documents destinés à une impression sur demande sur des imprimantes
couleur PostScript.
[Basse résolution] S'utilise pour obtenir des épreuves rapides à imprimer sur des imprimantes de bureau en noir et blanc et pour des documents
destinés à être publiés sur le Web ou exportés au format SVG.

Application d’un aplatissement prédéfini pour la sortie
Vous pouvez sélectionner un aplatissement prédéfini dans la boîte de dialogue Imprimer ou dans la boîte de dialogue de format qui s’affiche à la
suite de la boîte de dialogue d’exportation.

Si vous avez souvent l’occasion d’exporter ou d’imprimer des documents contenant des transparences, vous pouvez automatiser l’aplatissement
en enregistrant les paramètres dans un aplatissement prédéfini des transparences. Vous pouvez ensuite appliquer ces paramètres lorsque vous
imprimez ou exportez vers les formats PDF 1.3 (Acrobat 4.0) ou EPS.

 Dans le panneau Avancé des boîtes de dialogue Imprimer, Exportation EPS ou Exporter au format Adobe PDF, sélectionnez un aplatissement
prédéfini personnalisé ou l’un des aplatissements prédéfinis par défaut répertoriés ci-dessous :
[Basse résolution] S’utilise pour obtenir des épreuves rapides à imprimer sur des imprimantes de bureau en noir et blanc et pour des documents
destinés à être publiés sur le Web.
[Résolution moyenne] S’utilise pour les épreuves de bureau et les documents destinés à une impression sur demande sur des imprimantes
couleur Adobe PostScript.
[Haute résolution] S’utilise pour les impressions finales sur presse et les épreuves haute qualité comme les épreuves présentant une séparation
des couleurs.
Remarque : les paramètres d’aplatissement sont utilisés uniquement si l’illustration contient des transparences ou si l’option Simuler la
surimpression est activée dans la zone Sortie de la boîte de dialogue Exporter au format Adobe PDF.

Création ou modification d’un paramètre prédéfini d’aplatissement des transparences
Il est possible d’enregistrer les aplatissements prédéfinis des transparences dans un fichier séparé, ce qui vous permet d’effectuer des copies de
sauvegarde ou les mettre à disposition de vos flasheurs, de vos clients ou de vos collaborateurs. Dans InDesign, les fichiers d’aplatissements
prédéfinis des transparences portent l’extension .flst.

1. Choisissez Edition > Aplatissements prédéfinis des transparences.
2. Effectuez l’une des opérations suivantes :

Pour créer un nouveau paramètre prédéfini, cliquez sur Nouveau.

Pour créer un aplatissement prédéfini basé sur un paramètre prédéfini, sélectionnez-en un dans la liste et cliquez sur
Nouveau.

Pour modifier un paramètre prédéfini existant, sélectionnez-le et cliquez sur OK.

Remarque : il n’est pas possible de modifier les aplatissements prédéfinis par défaut.
3. Définissez les options d’aplatissement.
4. Cliquez sur OK pour retourner dans la boîte de dialogue Aplatissements prédéfinis des transparences, puis cliquez de

nouveau sur OK.

Exportation et importation d’un paramètre prédéfini d’aplatissement des transparences
personnalisé
Vous pouvez exporter ou importer les paramètres d’aplatissement des transparences prédéfinis pour les partager avec vos prestataires de
services, vos clients ou vos collaborateurs.

1. Choisissez Edition > Aplatissements prédéfinis des transparences.
2. Sélectionnez un aplatissement prédéfini dans la liste
3. Effectuez l’une des opérations suivantes :

Pour exporter un paramètre prédéfini dans un fichier spécifique, cliquez sur Enregistrer (InDesign) ou sur Exporter
(Illustrator), spécifiez un nom et un emplacement puis cliquez sur Enregistrer.

Pensez à enregistrer le paramètre prédéfini en dehors du dossier des préférences de l’application. Ainsi, il ne sera pas
perdu si vous supprimez vos préférences.

Pour importer des paramètres prédéfinis à partir d’un fichier, cliquez sur Charger (InDesign) ou sur Importer (Illustrator).
Localisez et sélectionnez le fichier contenant le paramètre prédéfini à charger, puis cliquez sur Ouvrir.
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Changement de nom ou suppression d’un paramètre prédéfini d’aplatissement des
transparences personnalisé

1. Choisissez Edition > Aplatissements prédéfinis des transparences.
2. Sélectionnez un aplatissement prédéfini dans la liste
3. Effectuez l’une des opérations suivantes :

Pour renommer un aplatissement prédéfini existant, cliquez sur Modifier, entrez un nouveau nom, puis cliquez sur OK.

Pour supprimer un aplatissement prédéfini, cliquez sur Supprimer puis sur OK pour confirmer la suppression.
Remarque : vous ne pouvez pas supprimer les paramètres prédéfinis par défaut.

Aplatissement d’une planche individuelle
Vous pouvez appliquer des paramètres d’aplatissement à chaque planche d’un document, annulant ainsi l’aplatissement prédéfini pour l’ensemble
du document ou du livre. Ceci s’avère utile pour contrôler la qualité d’aplatissement des documents associant des images haute résolution avec
nombre de transparences et des images basse résolution. Dans ce cas, vous pouvez aplatir la planche complexe avec une qualité supérieure et
utiliser un aplatissement prédéfini sommaire sur les autres planches.

Au moment de l’exportation ou de l’impression, il est possible de rétablir les paramètres d’aplatissement pour le document ou le livre.

1. Affichez la planche dans la fenêtre de document.
2. Dans le menu du panneau Pages, choisissez l’option Aplatissement des planches.
3. Sélectionnez l’une des options suivantes, puis cliquez sur OK :

Par défaut Permet d’appliquer l’aplatissement prédéfini du document à la planche.

Aucun (ignorer la transparence) Ignore les transparences de la planche. Cette option peut se révéler utile pour les
opérations de dépannage effectuées par le fournisseur de services.

Autre Ouvre la boîte de dialogue Paramètres personnalisés d’aplatissement des planches en vue de définir les paramètres.

Ignorer l’aplatissement prédéfini pour une planche
 Sélectionnez Ignorer le remplacement des planches à l’un des emplacements suivants dans InDesign :

Panneau Aperçu de l’aplatissement (Fenêtre > Sortie > Aperçu de l’aplatissement).

Zone Avancé de la boîte de dialogue Imprimer ou Exporter au format Adobe PDF.

Options d’aplatissement des transparences
Vous pouvez définir les options d’aplatissement des transparences en créant, modifiant ou affichant un aperçu des aplatissements prédéfinis dans
Illustrator, InDesign ou Acrobat.

Options de mise en surbrillance (aperçu)
Aucune (aperçu en couleur) Désactive l’aperçu.
Zones complexes pixellisées Met en surbrillance les zones à pixelliser pour des raisons de performances à l’aide du curseur Equilibre
Pixellisation/Vectorisation. Souvenez-vous que les limites de la zone de mise en surbrillance risquent plus fortement de produire des problèmes de
raccordement (en fonction de la configuration du pilote d'imprimante et de la résolution de pixellisation). Pour limiter les problèmes de
raccordement, sélectionnez Ecrêter les zones complexes.
Objets transparents Met en surbrillance les objets sources de transparence, tels que les objets présentant une opacité partielle (y compris les
images avec des couches alpha), les objets fusionnés et les objets comportant des masques d’opacité. En outre, notez que les effets et les styles
peuvent être porteurs de transparence, et les objets surimprimés peuvent être traités en tant que sources de transparence s’ils sont impliqués
dans la transparence ou si la surimpression requiert un aplatissement.
Tous les objets concernés Met en surbrillance tous les objets impliqués dans la transparence, y compris les objets transparents et les objets
recouverts par des objets transparents. Le processus d’aplatissement a un impact sur les objets mis en surbrillance : leurs contours ou leurs motifs
sont décomposés, certaines parties sont pixellisées, etc.
Fichiers EPS associés affectés (Illustrator uniquement) Met en surbrillance tous les fichiers EPS associés affectés par la transparence.
Graphiques affectés (InDesign uniquement) Met en surbrillance l’ensemble du contenu placé affecté par la transparence ou les effets de la
transparence. Cette option est utile pour les prestataires de services qui ont besoin de visualiser les graphiques dont l’impression requiert une
attention particulière.
Motifs décomposés (Illustrator et Acrobat) Met en surbrillance tous les motifs dont l’implication dans la transparence entraîne la
décomposition.
Contours vectorisés Met en surbrillance tous les contours vectorisés du fait de la présence de transparences ou de l’activation de l’option
Vectoriser tous les contours.



Texte vectorisé (Illustrator et InDesign) Met en surbrillance l’ensemble du texte vectorisé du fait de la présence de transparences ou de
l’activation de l’option Vectoriser tout le texte.
Remarque : dans la sortie finale, les contours et le texte vectorisés peuvent apparaître légèrement différents des originaux, notamment les
contours très fins et le texte de très petite taille. Toutefois, ces différences n’apparaissent pas dans l’aperçu de l’aplatissement.
Contours et texte pixellisés (InDesign uniquement) Met en surbrillance les contours et le texte pixellisés suite à l’aplatissement.
Toutes les zones pixellisées (Illustrator et InDesign) Met en surbrillance les objets et les intersections d'objets auxquels est appliquée la
pixellisation car il n'existe aucun autre moyen de les représenter en PostScript ou du fait de leur complexité par rapport au seuil spécifié par le
curseur Equilibre Pixellisation/Vectorisation. Par exemple, l'intersection de deux dégradés transparents sera toujours pixellisée, même si la valeur
Equilibre Pixellisation/Vectorisation est égale à 100. L’option Toutes les zones pixellisées permet également d’afficher les graphiques pixellisés
(tels que les fichiers Photoshop) impliqués dans la transparence, ainsi que les effets de la pixellisation tels que les ombres portées et les contours
progressifs. Notez que le traitement de cette option est plus long que les autres.

Aplatissement des transparences Options prédéfinies
Nom/Paramètre prédéfini Indique le nom d’un paramètre prédéfini. Selon la boîte de dialogue qui apparaît, vous pouvez saisir un nom dans la
zone de texte Nom ou accepter le nom par défaut. Vous pouvez saisir le nom d’un paramètre prédéfini existant afin de le modifier. Vous ne
pouvez cependant pas modifier les paramètres prédéfinis par défaut.
Equilibre Pixellisation/Vectorisation Spécifie la quantité d’informations vectorielles qui seront conservées. Plus la valeur est élevée, plus le
nombre d’objets vectoriels conservés l’est aussi, alors que plus la valeur est faible, plus le nombre d’objets vectoriels pixellisés est important. Une
valeur moyenne conserve les zones simples sous forme vectorielle et les zones complexes sous forme pixellisées. Sélectionnez la valeur la plus
faible pour pixelliser l’ensemble de l’illustration.
Remarque : le niveau de pixellisation atteint dépend de la complexité de la page et des types d’objets se chevauchant.
Résolution des dessins au trait et du texte Pixellise tous les objets, y compris les images, les illustrations vectorielles, le texte et les dégradés
selon la résolution spécifiée. Acrobat et InDesign autorisent un maximum de 9 600 pixels par pouce (ppp) pour les dessins et de 1 200 ppp pour
les filets. Illustrator autorise un maximum de 9600 ppp à la fois pour les dessins et les filets. La résolution affecte la précision des intersections
aplaties. L'option Résolution des dessins au trait et du texte doit généralement être définie entre 600 et 1 200 pour une qualité de pixellisation
optimale, notamment en serif ou avec une petite taille de points.
Résolution des dégradés et des filets Indique la résolution des objets de dégradés et de filets Illustrator pixellisés en raison de l'aplatissement.
Cette résolution est comprise entre 72 et 2 400 ppp. La résolution affecte la précision des intersections aplaties. La résolution des dégradés et des
filets doit généralement être définie entre 150 et 300 pixels par pouce car la qualité des dégradés, des ombres portées et des contours progressifs
ne s'améliore pas avec une résolution plus élevée, mais le temps d'impression et la taille de fichier augmentent.
Vectoriser tout le texte Convertit tous les objets de type (type de point, type de zone et type de chemin) en contours et supprime l’ensemble des
informations de glyphe sur les types dans les pages contenant une transparence. Cette option préserve la largeur du texte lors de l’aplatissement.
Notez que l’activation de cette option a pour effet de donner aux petites polices un aspect légèrement plus épais lors de l’affichage dans Acrobat
ou lors de l’impression sur des imprimantes à faible résolution. La qualité du type imprimé sur des imprimantes à résolution élevée ou sur des
photocomposeuses n’est pas affectée.
Vectoriser tous les contours Convertit tous les contours en tracés simples remplis dans les pages contenant une transparence. Cette option
préserve la largeur des contours lors de l’aplatissement. Notez que l’activation de cette option a pour effet de donner aux contours fins un aspect
légèrement plus épais et peut dégrader les performances de l’aplatissement.
Ecrêter les zones complexes Garantit que les limites entre l’illustration vectorielle et l’illustration pixellisée s’inscrivent sur les tracés d’objet.
Cette option réduit les artefacts de raccordement qui subviennent lorsqu’un objet est partiellement pixellisé (une partie de l’objet restant
vectorielle). L’activation de cette option peut toutefois générer des chemins trop complexes pour pouvoir être gérés par l’imprimante.

Raccord à l’intersection de trames et de vecteurs.

Remarque : certains pilotes d'imprimante traitent les dessins pixellisés et vectorisés différemment, ce qui entraîne parfois un raccordement de
couleurs. Vous pouvez éventuellement minimiser les problèmes de jointure en désactivant certains paramètres de gestion des couleurs spécifiques
au pilote d'impression. Ces paramètres varient selon les imprimantes, consultez la documentation de votre imprimante pour obtenir plus de détails.
(Illustrator uniquement) Sélectionnez Conserver la transparence alpha (boîte de dialogue Aplatissement de la transparence
uniquement) Conserve l’opacité globale des objets aplatis. Avec cette option, les modes de fusion et les surimpressions sont perdues, mais leur
aspect est conservé dans l'illustration traitée, ainsi que le niveau de transparence alpha (comme lorsque vous pixellisez des illustrations à l'aide
d'un arrière-plan transparent). L’option Conserver la transparence alpha peut être utile lors de l’exportation au format SWF ou SVG, étant donné
que ces deux formats prennent en charge la transparence alpha.
(Illustrator uniquement) Sélectionnez Conserver les surimpressions et les tons directs (boîte de dialogue Aplatissement de la
transparence uniquement) Conserve généralement les tons directs. Cette option conserve également la surimpression pour les objets qui ne
sont pas impliqués dans la transparence. Sélectionnez cette option si vous imprimez des séparations et que le document contient des tons directs
et des objets surimprimés. Désélectionnez cette option lors de l’enregistrement de fichiers à utiliser dans des applications de mise en page. Avec
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cette option sélectionnée, les zones surimprimées ayant une interaction avec les transparences sont aplaties, tandis que la surimpression dans les
autres zones est conservée. Les résultats sont imprévisibles lorsque le fichier est généré à partir d’une application de mise en page.
Conserver la surimpression (Acrobat uniquement) Fusionne la couleur des illustrations transparentes et la couleur d’arrière-plan afin de créer
un effet de surimpression.

Aperçu des zones de l’illustration qui seront aplaties
Les options d’aperçu de l’aperçu de l’aplatissement permettent de mettre en surbrillance les zones affectées par l’aplatissement. Ces informations
fournies sous forme de codes de couleur vous permettent de régler les options d’aplatissement.

Remarque : l’aperçu de l’aplatissement ne donne pas un aperçu précis des tons directs, des surimpressions et des objets fusionnés. Utilisez plutôt
le mode Aperçu de la surimpression.

1. Affichage du panneau Aperçu de l'aplatissement (ou boîte de dialogue) :

Dans Illustrator, sélectionnez Fenêtre > Aperçu de l'aplatissement.

Dans Acrobat, sélectionnez Outils > Impression > Aperçu de l’aplatissement.

Dans InDesign, sélectionnez Fenêtre > Sortie > Aperçu de l'aplatissement.

2. Dans le menu Sélection, sélectionnez le type de zones à mettre en surbrillance. La disponibilité des options dépend du
contenu de l’illustration.

3. Sélectionnez les paramètres d’aplatissement à utiliser : sélectionnez un paramètre prédéfini ou, le cas échéant, définissez des
options spécifiques.
Remarque : (Illustrator) si les paramètres d'aplatissement n'apparaissent pas, sélectionnez Afficher les options dans le menu
du panneau pour les afficher.

4. Si l’illustration contient des objets surimprimés ayant une interaction avec des objets transparents, dans Illustrator,
sélectionnez une option dans le menu déroulant Surimpressions. Vous pouvez conserver, simuler ou ignorer les
surimpressions. Dans Acrobat, sélectionnez Conserver la surimpression pour fusionner la couleur de l’illustration transparente
et la couleur d’arrière-plan afin de créer un effet de surimpression.

5. A tout moment, cliquez sur Actualiser pour afficher un aperçu actualisé en fonction des paramètres sélectionnés. Selon la
complexité de l’illustration, l’aperçu peut prendre quelques secondes à s’afficher. Dans InDesign, vous pouvez également
sélectionner Rafraîchir auto. sélection.

Dans Illustrator et Acrobat, pour agrandir l’aperçu, cliquez dans la zone d’aperçu. Pour effectuer un zoom arrière, cliquez
avec la touche Alt ou Option enfoncée dans la zone d’aperçu. Pour effectuer un panoramique de l’aperçu, maintenez la
barre d’espacement enfoncée et faites glisser le curseur dans la zone d’aperçu.

Réactualisation de l’aperçu à partir du panneau Aperçu de l’aplatissement
Pour faire en sorte que l’affichage soit automatiquement réactualisé dès qu’il n’est plus à jour ou lorsqu’il reste inchangé,
sélectionnez Rafraîchir auto. sélection.
Pour réactualiser l’affichage manuellement, cliquez sur Réactualiser.

Dans les deux cas, l’affichage est mis à jour dans la fenêtre du document en fonction des paramètres d’aplatissement des
transparences sélectionnés.

Méthodes recommandées en matière de création de transparences
Dans la plupart des cas, l’aplatissement permet d’obtenir des résultats optimaux lorsque vous utilisez un aplatissement prédéfini adapté ou lorsque
vous créez un aplatissement prédéfini avec des paramètres adaptés à votre sortie finale. Pour obtenir un guide complet de référence et de
dépannage sur l’impression des effets de transparence, voir le document « Achieving Reliable Print Output with Transparency » (Obtenir une
impression de qualité avec effets de transparence) (en anglais uniquement) sur le site Web d’Adobe.

Cependant, si votre document présente des zones superposées complexes et que vous souhaitez une sortie haute résolution, vous pouvez
obtenir une impression de meilleure qualité en suivant certaines règles élémentaires :

Important : si vous appliquez des transparences aux documents destinés à une sortie haute résolution, parlez-en à votre fournisseur de services.
N’hésitez pas à consulter ce dernier régulièrement car une bonne communication conditionne des résultats proches de vos attentes.

Surimpression d’objets
Les objets aplatis semblent transparents mais ils sont en fait opaques et ne laissent pas transparaître les objets situés au-dessous. Toutefois, si
vous n’appliquez pas de simulation de la surimpression, l’aplatissement des transparences pourra préserver une surimpression de base des objets
lors de l’impression ou de l’exportation vers un fichier PDF. Dans ce cas, les destinataires du fichier PDF devront sélectionner Aperçu de la
surimpression dans Acrobat 5.0 ou version ultérieure pour visualiser correctement les résultats de la surimpression.

Inversement, si vous appliquez la simulation de la surimpression, l’aplatissement des transparences produit une simulation de la surimpression qui
correspond à tous les objets opaques. En sortie PDF, cette simulation convertit les tons directs en leurs équivalents quadri. Par conséquent,



l’option Simuler la surimpression ne doit pas être sélectionnée pour toute sortie dont les couleurs seront par la suite séparées.

Tons directs et modes de fusion
L’utilisation des tons directs avec certains modes de fusion peut parfois produire des résultats inattendus. Ceci s’explique parce qu’InDesign utilise
des équivalents quadri à l’écran et des tons directs à l’impression. En outre, les fusions isolées dans une image importée risquent de créer des
groupes perçants dans le document actif.

Si vous utilisez des fusions, vérifiez régulièrement votre dessin à l’aide de l’option Aperçu de la surimpression du menu Affichage. Cette option
donne un aperçu approximatif des tons directs en surimpression ou en interaction avec les objets transparents. Si l’effet visuel obtenu n’est pas
celui escompté, procédez de l’une des façons suivantes :

Utilisez un autre mode de fusion ou aucun mode de fusion. Lorsque vous travaillez avec des tons directs, évitez d’utiliser les
modes de fusion suivants : Différence, Exclusion, Teinte, Saturation, Couleur et Luminosité.

Utilisez une couleur quadri chaque fois que cela est possible.

Espace de fusion
Si vous appliquez des transparences aux objets d’une planche, toutes les couleurs de la planche sont converties selon l’espace de fusion des
transparences que vous avez défini (dans Edition > Espace de fusion des transparences), c’est-à-dire Document RVB ou Document CMJN, même
si la transparence ne les affecte pas. La conversion de toutes les couleurs assure l’homogénéité de deux objets de même couleur d’une planche
et réduit les problèmes de rendu des couleurs sur les contours des transparences. Les couleurs sont converties au fur et à mesure de la
conception des objets. Les couleurs des images importées qui interagissent avec les transparences sont également converties en fonction de
l’espace de fusion. Ceci a pour effet d’altérer l’aspect des couleurs à l’écran et à l’impression, mais pas la façon dont elles sont définies dans le
document.

Selon votre flux de production, optez pour l’une des méthodes suivantes :

Si vous créez des documents pour l’impression uniquement, choisissez Document CMJN pour l’espace de fusion.

Si vos documents sont destinés à une diffusion sur le Web uniquement, choisissez Document RVB.

Si vos documents sont destinés à une impression et un affichage sur le Web, choisissez l’espace de fusion correspondant à la
sortie finale la plus importante à vos yeux.

Si vous créez un document d’impression haute résolution que vous prévoyez également de diffuser sur un site Web sous la
forme d’un document PDF haute qualité, il peut être nécessaire d’alterner entre les espaces de fusion avant de produire la
sortie finale. Dans ce cas, vérifiez bien les couleurs de chaque planche présentant des transparences et évitez d’utiliser les
modes de fusion Différence et Exclusion qui risquent de considérablement changer l’apparence.

Type
Si le texte est proche d’objets transparents, il risque d’interagir avec ces objets transparents de façon inattendue. Par exemple, un texte qui habille
un objet transparent peut ne pas être superposé par rapport à l’objet et il se peut que les glyphes ne soient pas assez proches pour interagir avec
les transparences. Dans ce cas, l’aplatissement peut vectoriser les glyphes afin d’obtenir des contours épais uniquement pour les glyphes.

Si cela se produit, effectuez l’une des opérations suivantes :

Déplacez le texte en haut de l’ordre de superposition. Utilisez l’outil Sélection pour sélectionner le bloc de texte, puis
choisissez Objet > Disposition > Premier plan.

Vectorisez tout le texte pour un effet homogène dans le document. Pour vectoriser tout le texte, sélectionnez l’option
Vectoriser tout le texte dans la boîte de dialogue Options d’aplatissements prédéfinis des transparences. Cette option risque
de réduire les performances de traitement.

Remplacement des images
L’aplatissement requiert des données haute résolution permettant d’assurer un traitement précis des documents présentant des transparences.
Cependant, dans le cadre d’un flux de production OPI, le serveur OPI remplacera les marques de réservation ou doublures d’images par des
versions haute résolution. Si l’aplatissement n’a pas accès aux données haute résolution, aucun commentaire OPI n’est produit et seules les
doublures d’images à basse résolution sont sorties ; les images finales présentent alors une basse résolution.

Si vous travaillez avec un flux de production OPI, envisagez d’utiliser InDesign pour la substitution d’images avant d’enregistrer le document au
format PostScript. Pour cela, vous devez spécifier les paramètres lorsque vous importez et imprimez l’image EPS. Lorsque vous importez
l’image EPS, dans la boîte de dialogue Options d’importation EPS, sélectionnez Lire les liens d’images incorporés OPI. Au moment de la sortie,
dans la zone Avancé de la boîte de dialogue Imprimer ou Exportation EPS, sélectionnez l’option Substitution d’image OPI.

Conversion des couleurs
Si un objet transparent chevauche un objet doté de tons directs, cela peut produire des résultats inattendus lors de l’exportation au format EPS et
une conversion des tons directs en couleurs quadri au moment de l’impression ou de la création des séparations de couleurs dans une application
autre qu’InDesign.

Pour éviter ce type de problème, utilisez le Gestionnaire d’encres et convertissez les tons directs en équivalents quadri avant d’exporter à partir
d’InDesign. Une autre solution consiste à s’assurer que les tons directs de l’application initiale (Adobe Illustrator par exemple) sont en adéquation
avec ceux d’InDesign. Il sera peut-être nécessaire d’ouvrir un document Illustrator, de convertir des tons directs en couleurs quadri, d’exporter ce
document au format EPS, puis d’importer ce dernier dans la mise en page InDesign.



 

Fichiers PDF
L’exportation vers Acrobat 4.0 (Adobe PDF1.3) a toujours pour effet d’aplatir un document avec des transparences, ce qui altère l’apparence de
ses objets transparents. Un contenu dépourvu de transparence n’est pas aplati, sauf si l’option Simuler la surimpression est activée dans la zone
Sortie de la boîte de dialogue Exporter au format Adobe PDF. Par conséquent, lorsque vous exportez un document InDesign avec des
transparences au format PDF, procédez de l’une des façons suivantes :

Choisissez de préférence la compatibilité Acrobat 5.0 (Adobe PDF 1.4), Acrobat 6.0 (Adobe DF 1.5) ou Acrobat 7.0
(Adobe PDF 1.6) dans la boîte de dialogue Exporter au format Adobe PDF pour que les transparences soient conservées et
demeurent modifiables. Vérifiez que votre fournisseur de services peut travailler avec des fichiers Acrobat 5.0, Acrobat 6.0 ou
Acrobat 7.0.

Si vous devez utiliser la compatibilité Acrobat 4.0, si votre document contient des tons directs et si vous voulez créer un
fichier PDF pour une visualisation à l’écran (pour révision du client par exemple), sélectionnez l’option Simuler la surimpression
dans la zone Sortie de la boîte de dialogue Exporter au format Adobe PDF. Cette option simule les zones de transparence et
de tons directs ; les destinataires du fichier PDF n’auront pas à sélectionner Aperçu de la surimpression pour prévisualiser le
document avant l’impression. Cependant, l’option Simuler la surimpression convertit tous les tons directs en équivalents quadri
dans le fichier PDF ; assurez-vous alors de bien la désactiver lorsque vous créez le PDF pour la production finale.

Envisagez d’utiliser le paramètre Adobe PDF prédéfini [Qualité de presse]. Ce paramètre contient des paramètres
d’aplatissement adaptés aux documents complexes destinés à une sortie haute résolution.

Recouvrement
Il se peut que l’aplatissement convertisse les vecteurs en zones pixellisées. Les recouvrements appliqués aux illustrations dans Adobe Illustrator à
l’aide de contours et importées dans InDesign sont préservés. Il se peut que les recouvrements appliqués aux illustrations vectorielles conçues
dans InDesign, puis vectorisées ne soient pas préservés.

Pour conserver un maximum de vecteurs d’objets, sélectionnez l’aplatissement prédéfini des transparences [Haute résolution] dans la
zone Avancé de la boîte de dialogue Imprimer ou Exporter au format Adobe PDF.

Voir aussi
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Exportation et publication

Créer des magazines numériques avec InDesign CS5.5 et Adobe Digital Publishing Suite (vidéo 09:06)
Terry White  (07 mai 2012)
Didacticiel - vidéo
Dans cette vidéo, découvrez comment créer les magazines numériques immersifs pour les tablettes électroniques à l’aide d’InDesign.

Ajout d’un contenu audio et vidéo au format EPUB (vidéo 02:46)
Colin Fleming  (01er janvier 2011)
Didacticiel - vidéo
Dans ce didacticiel vidéo, découvrez comme il est facile d’incorporer un contenu audio et vidéo dans InDesign CS 5.5 et version ultérieure, pour
l’exportation au format EPUB.

Gestion de l’ordre d’exportation du contenu à partir d’InDesign vers EPUB sans changer votre mise en page
(vidéo 04:54)
Colin Fleming  (01er janvier 2011)
Didacticiel - vidéo
Apprenez à créer et organiser les articles dans le panneau Articles pour l’exportation au format EPUB, sans modifier la mise en page ou écrire
du code.

Création de couvertures et de pages de titre pour EPUB (vidéo 05:50)
Colin Fleming  (01er janvier 2011)
Didacticiel - vidéo
Apprenez à créer des couvertures et pages de titre pour vos titres EPUB.

Exploration des nouvelles options d’exportation FLA (vidéo 06:26)
Anne-Marie Concepcion  (01er janvier 2011)
Didacticiel - vidéo
Découvrez comment publier votre projet InDesign dans une grande variété de formats Flash à l’aide de la boîte de dialogue d’exportation
améliorée dans InDesign CS5 et les versions ultérieures.

Exportation de documents au format EPUB (PDF, 265 Ko)
Référence  (01er janvier 2011)
Un petit aperçu rapide sur la façon d’exporter vos mises en page au format EPUB dans InDesign CS5.

Exportation au format EPUB pour l’Apple iBookstore (PDF, 2,5 Mo)
Référence  (01er janvier 2011)
Apprenez à créer un EPUB pour l’App Store Apple d’iBook

Paramétrage des options d’exportation d’objet (PDF, 160 Ko), CS5.5 et versions ultérieures
Référence  (01er janvier 2011)
Comment utiliser les options d’exportation d’objet pour rationaliser votre flux de travail d’exportation.

Styles mappés vers les balises dans InDesign pour une exportation au format EPUB améliorée (vidéo 05:13)
Colin Fleming  (01er janvier 2011)
Didacticiel - vidéo
Dans InDesign CS 5.5 et ultérieur, vous pouvez mapper les styles de paragraphe et de caractère directement vers les balises des formats
EPUB, HTML et PDF pour garantir que les styles définis dans InDesign sont exportés correctement. Vous pouvez également ajouter des noms
de classe CSS et taper vos propres balises personnalisées.

Utilisation des options d’exportation d’objet pour personnaliser l’exportation des objets et des images au
format EPUB (vidéo 05:18)
Colin Fleming  (01er janvier 2011)
Didacticiel - vidéo

http://tv.adobe.com/watch/cs-55-design-premium-feature-tour-/build-digital-magazines-with-indesign-cs55-and-adobe-digital-publishing-suite/
http://tv.adobe.com/watch/cs-55-design-premium-feature-tour-/adding-audio-and-video-content-to-epub-from-indesign-cs55-/
http://tv.adobe.com/watch/cs55-design-standard-feature-tour/controlling-order-of-content-export-from-indesign-cs55-to-epub-without-changing-your-layout-and-without-writing-code/
http://tv.adobe.com/watch/cs55-design-standard-feature-tour/controlling-order-of-content-export-from-indesign-cs55-to-epub-without-changing-your-layout-and-without-writing-code/
http://tv.adobe.com/watch/cs55-design-standard-feature-tour/creating-covers-and-title-pages-for-epub-in-indesign-cs55/
http://www.adobe.com/go/lrvid5154_id_fr
http://www.adobe.com/support/indesign/gettingstarted/pdfs/id_dyk_epub_production_v4.pdf
http://www.adobe.com/content/dam/Adobe/en/devnet/indesign/pdfs/indesign-to-ipad.pdf
http://www.adobe.com/support/indesign/gettingstarted/pdfs/indesign_howto_g_objexport_2db.pdf
http://tv.adobe.com/watch/cs55-design-standard-feature-tour/styles-mapped-to-tags-in-indesign-cs55-for-improved-epub-export/
http://tv.adobe.com/watch/cs-55-design-premium-feature-tour-/using-object-export-options-to-customize-how-objects-and-images-export-to-epub/
http://tv.adobe.com/watch/cs-55-design-premium-feature-tour-/using-object-export-options-to-customize-how-objects-and-images-export-to-epub/


Utilisez les Options d’exportation d’objet pour personnaliser la manière dont les objets et les images sont exportés au format EPUB pour
garantir des résultats optimaux sur n’importe quel écran, quelle que soit sa taille.



Publish Online (aperçu)
Nouveauté d’InDesign CC 2015
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Remarque :
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Nom de fichier

Cette fonction est uniquement disponible dans les versions destinées à l’Amérique du Nord (en_US) et au Royaume-Uni (en_GB).

Présentation de Publish Online (aperçu)
Qu’est-ce qu’une fonction d’aperçu technologique ?
Publication d’un document InDesign en ligne
Résultat du document en ligne
Documents publiés récemment
Utilisation du tableau de bord Web
Activation ou désactivation de Publish Online (aperçu)

Présentation de Publish Online (aperçu)

Avec Publish Online, vous pouvez réutiliser vos documents en les publiant en ligne. Vous pouvez publier une version numérique qui fonctionne
sur les ordinateurs de bureau et les portables, dans n’importe quel navigateur Web récent, sans installer de module externe.

Vous pouvez publier n’importe quel document InDesign incluant des boutons, des diaporamas, des animations, du son et des vidéos à l’aide des
fonctions de création interactives d’InDesign CC.

Après avoir publié vos documents, vous pouvez spécifier l’URL du document en ligne à un utilisateur pour qu’il puisse le visualiser dans une
expérience en ligne élégante et simple. Cette procédure est possible sur un ordinateur de bureau ou un portable, depuis n’importe quelle plate-
forme. Vous pouvez même partager le document en ligne sur Facebook.

Qu’est-ce qu’une fonction d’aperçu technologique ?

Les aperçus technologiques sont des services et fonctions qu’Adobe publie pour ses clients avant même qu’ils
soient complets ou entièrement testée. Une fonction d’aperçu technologique, telle que Publish Online, vous permet de tester la fonction et de fournir de manière anticipée
des données à l’équipe d’InDesign. Ces données peuvent être utilisées par l’équipe pour améliorer la fonction avant de la mettre à disposition dans une version ultérieure
d’InDesign.

les fonctions d’aperçu technologique ne sont pas encore prêtes pour la production. Il convient donc de rester discret lors de
l’utilisation de cette fonction dans des documents/projets importants.

Publication d’un document InDesign en ligne

1. Pour publier le document actuel en ligne, cliquez sur le bouton Publish Online dans la barre de l’application ou sélectionnez Fichier > Publish
Online (aperçu).

La boîte de dialogue des options Publish Online s’affiche.

2. Dans l’onglet Général de la boîte de dialogue Publish Online, saisissez les informations suivantes :

Titre du document en ligne.

Ce nom s’affiche comme titre de navigateur des résultats publiés.

Le titre s’affiche également dans le menu Publié récemment (Fichier >Publié récemment).



Description

Pages

Exporter sous

Pages

Planches

Choisir la vignette

Première page

Page choisie

Sélectionner une image

Paramètres d’image

Automatique ** recommandé **

JPEG

GIF

PNG

Résolution

Standard

HiDPI

Options JPEG

Options GIF

Description du document en ligne.
Elle s’affiche dans le tableau de bord Web et sur Facebook si vous y partagez le document.

Choisissez d’exporter tout ou un groupe de pages à partir du document actuel.

Précisez la méthode d’affichage des pages en ligne dans le navigateur Web.

Affiche une seule page à la fois dans le navigateur.

Affiche deux pages à la fois dans le navigateur Web.

3. Dans l’onglet Avancé, entrez les informations suivantes :

Sélectionnez la couverture pour votre document publié. Cette vignette apparaît dans la boîte de dialogue
Publish Online (aperçu) avec le titre et la description lors du transfert.

Indique que la première page du document InDesign est utilisée comme vignette de couverture.

Choisissez une page du document InDesign à utiliser comme vignette de couverture.

Sélectionnez une image externe comme vignette de couverture.

Précisez comment les images des documents doivent être exportées.

InDesign détermine comment les images du document doivent être exportées, tout
en tenant compte de l’optimisation des performances.

Convertit toutes les images au format JPEG.

Convertit toutes les images au format GIF.

Convertit toutes les images au format PNG.

Précisez la résolution de l’image de sortie.

InDesign optimise la résolution des images.

InDesign garantit une haute résolution des images.
Remarque : les images HiDPI ralentissent sensiblement le chargement de la page et augmentent le volume des
données téléchargé par les utilisateurs.

Lorsque le format de l’image est défini sur JPEG, cette option fournit plusieurs options pour la qualité de
l’image.

Lorsque le format de l’image est défini sur GIF, cette option fournit plusieurs palettes pour le rendu GIF.

4. Cliquez sur OK pour publier le document en ligne.

La boîte de dialogue Publish Online s’affiche :

La vignette, le titre et la description sont affichés dans la partie gauche de la boîte de dialogue.
Le processus est affiché dans la partie droite.



Remarque :

Afficher le document

Copier

Partager sur Facebook

Haut de la page

5. Dans la boîte de dialogue Publish Online, cliquez sur Annuler le transfert pour interrompre et restaurer le processus de
transfert.

6. Cliquez sur Fermer pour réduire cette boîte de dialogue au bouton Publish Online dans la barre de l’application.

le fait de réduire la boîte de dialogue Publish Online ne permet pas d’arrêter le processus de publication en
ligne. Cependant, vous pouvez continuer à travailler dans le document actuel ou dans n’importe quel autre document
InDesign.

7. Cliquez sur Publish Online dans la barre de l’application pour ouvrir la boîte de dialogue Publish Online.

8. Une fois que le document est publié en ligne, choisissez les options suivantes dans la boîte de dialogue Publish Online (aperçu) :

Ouvre le document en ligne dans votre navigateur Web par défaut.

Copie l’URL du document en ligne.

Partage l’URL du document sur votre page Facebook.

Résultat du document en ligne

Le document publié en ligne fournit plusieurs options d’affichage et de partage.



A (Afficher/Masquer les vignettes)

B (Zoom avant)

C (Zoom arrière)

D (Plein écran)

E (Partager)

F (Couper le volume)

G (Rapport d’infraction)

Haut de la page

Haut de la page

Affiche/Masque l’ancrage de vignette qui affiche les vignettes de toutes les pages dans les résultats publiés.

Agrandit la page active.

Réduit la page active.

Affiche la page active en mode plein écran.

Ouvre la boîte de dialogue Partager la publication.
Cette boîte de dialogue fournit des options de partage pour copier l’URL du document actuel (et la partager par courrier électronique) ou partager
le document sur Facebook.

Coupe le son du fichier audio et vidéo dans le document actuel.

Ouvre la boîte de dialogue Rapport d’infraction.
Cette boîte de dialogue fournit les options correspondant au type d’infraction, ainsi que vos coordonnées.

Documents publiés récemment

Le menu Publié récemment affiche la liste des cinq derniers documents publiés.

Cliquez sur un document de cette liste pour ouvrir le résultat publié dans votre navigateur par défaut.

Pour afficher la liste des documents publiés récemment, choisissez Fichier > Publié récemment.

Utilisation du tableau de bord Web

InDesign fournit un tableau de bord Web qui vous permet d’accéder à tous vos documents publiés.

1. Pour afficher le tableau de bord Web d’InDesign, choisissez Fichier > Tableau de bord Web.

Le tableau de bord Web affiche la liste des documents que vous avez publiés dans votre navigateur par défaut.



  Les publications Twitter™ et Facebook ne sont pas couvertes par les dispositions Creative Commons.

Mentions légales   |   Politique de confidentialité en ligne

Haut de la page

2. Pour supprimer un document publié, cliquez sur l’icône Supprimer.

Activation ou désactivation de Publish Online (aperçu)

Par défaut, Publish Online (aperçu) est disponible lorsque vous installez InDesign 2015. Toutefois, vous pouvez supprimer les références de
l’interface utilisateur d’InDesign de cette fonction.

1. Pour ouvrir la boîte de dialogue Préférences, choisissez Edition > Préférences > Général.

2. Dans la boîte de dialogue Préférences, cliquez sur l’onglet Aperçus technologiques.

3. Pour supprimer les préférences de l’interface utilisateur, désélectionnez Publish Online (aperçu) et cliquez sur OK.

http://creativecommons.org/licenses/by-nc-sa/3.0/
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Exportation de contenu pour EPUB
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Présentation
Prise en charge du texte
Prise en charge d’hyperliens
Prise en charge de la navigation
Génération de feuille de style CSS pour un livre
Exporter au format EPUB
Options d’exportation de mise en page fixe
Options d’exportation au format redistribuable
Options d'exportation d'objet
Ressources EPUB

Présentation

Vous pouvez exporter un document InDesign au format EPUB pour permettre aux utilisateurs d’afficher la sortie dans un lecteur EPUB.

Vous pouvez choisir d’exporter le document au format EPUB redistribuable. Un document EPUB redistribuable permet au lecteur EPUB
d’optimiser le contenu selon le périphérique d’affichage.

Le format redistribuable est plus adapté pour les documents destinés aux utilisateurs de périphériques eInk. De plus, le format redistribuable est
recommandé si vous souhaitez fournir des options permettant de modifier la police et la taille du texte dans le lecteur.

Vous pouvez choisir d’exporter vos documents au format de mise en page fixe. Le format de mise en page fixe permet d’inclure du contenu audio,
vidéo et Edge dans vos documents.

Vous pouvez également exporter des documents interactifs qui comportent des contrôles tels que des boutons de navigation, des transitions de
page, des animations et des hyperliens au format de mise en page fixe.

Le format de mise en page fixe est plus adapté aux documents comprenant un grand nombre de graphiques, ainsi que du contenu audio et vidéo
volumineux. Ce format convient mieux aux livres pour enfants, aux livres de cuisine, aux manuels et aux bandes dessinées.

Prise en charge du texte

Les options de texte suivantes sont prises en charge lors de la création de documents pour l’exportation au format de mise en page fixe :

Le texte ne subit pas de pixellisation. Ceci implique que le texte dynamique est indexable et sélectionnable.

Le texte dynamique peut être redimensionné horizontalement et verticalement.

Des points de conduite peuvent être inclus.

Les attributs de langue sont marqués sur des balises.

Les balises sont identifiées par des classes CSS.

Les hyperliens et les références croisées du texte sont pris en charge pour les adresses URL, les ancres de texte et les pages.

Notez également les restrictions suivantes lors de l’insertion de texte dans vos documents pour l’exportation au format EPUB :

Le crénage n’est pas pris en charge sur un glyphe individuel et est distribué sous forme d’interlettrage sur toutes les lettres d’un mot.

Les variantes de glyphes générées par des fonctions OpenType, notamment Petites capitales, Tout en capitales et Fractions, ne sont pas prises en



Haut de la page

Haut de la page

Points de repère NAV

EPUB 2

Liste des pages NAV

Haut de la page

charge en raison de la prise en charge de périphérique limitée.

Les blocs de texte lu de droite à gauche du Moyen-Orient ne sont toujours pas correctement pris en charge.

Prise en charge de texte en japonais

Les options suivantes de fonction pour le japonais sont disponibles pour l’exportation au format de mise en page fixe :

Le texte Ruby est dynamique et non pixellisé à la sortie.
Warichu est pris en charge en tant que texte dynamique.
La rotation de caractères est prise en charge dans le texte dynamique.
Les polices composites sont prises en charge.
Les blocs de texte verticaux sont pris en charge, y compris les glyphes pivotés.

Notez également les restrictions suivantes lors de l’insertion de texte en japonais dans vos documents destinés à l’exportation au format EPUB :

Le bloc de texte en japonais Tate-Chu-Yoko n’est pas pris en charge dans les blocs de texte verticaux.

Les caractères idéographiques japonais perdent leur positionnement lors de l’utilisation de polices True Type.

La police japonaise Kenten est pixellisée dans du texte dynamique.

Prise en charge d’hyperliens

Les options suivantes d’hyperliens sont prises en charge lors de la création de documents destinés à l’exportation au format de mise en page fixe :

Hyperliens et références croisées textuels

Hyperliens d’objets

Hyperliens vers les pages pour les hyperliens textuels et d’objets

Prise en charge de la navigation

Le processus d’exportation offre les fonctionnalités suivantes de navigation dans la sortie EPUB :

Les points de repère NAV sont générés à la fois pour la mise en page fixe et pour les formats redistribuables basés sur
les valeurs pour le type epub:type spécifiées dans la boîte de dialogue Options d’exportation d’objet.

Seule la première occurrence de la valeur est ajoutée aux points de repère.

InDesign prend en charge la section EPUB 2 dans le fichier OPF. InDesign détecte automatiquement la couverture et l’option
d’impression de la table des matières. Pour déterminer le type de texte, InDesign utilise les valeurs epub:type spécifiées dans la boîte de
dialogue Options d’exportation d’objet.

(Format de mise en page fixe). InDesign génère une liste de pages en mappant les chaînes de numéro de la page sur les
fichiers XHTML générés à partir de cette page.

Génération de feuille de style CSS pour un livre

Lorsque vous exportez un livre au format EPUB, le processus d’exportation génère une feuille de style CSS pour chaque document du livre.
Chaque feuille de style CSS de document définit les styles propres au document. Le processus crée également une feuille de style CSS de gabarit



Haut de la page

Haut de la page

Version

EPUB 3.0

Couverture

Sans

Pixelliser la première page

Sélectionner une image

Table des matières de navigation

qui inclut les styles communs utilisés dans l’ensemble des documents du livre.

Exporter au format EPUB

Vous pouvez exporter un document ou un livre au format EPUB redistribuable ou de mise en page fixe.

1. Utilisez l’une des méthodes suivantes :

Ouvrez le document et choisissez Fichier > Exporter.

Ouvrez un livre, puis dans le menu du panneau Livre, choisissez Exporter le livre au format EPUB.

2. Spécifiez le nom et le dossier du fichier.

3. Dans la liste Format, sélectionnez EPUB (mise en page fixe) ou EPUB (redistribuable), puis cliquez sur Enregistrer.

4. Dans la boîte de dialogue Options d’exportation EPUB, spécifiez les options désirées, puis cliquez sur OK.

Pour plus d’informations, voir les Options d’exportation de mise en page fixe ou les Options d’exportation au format
redistribuable.

InDesign crée un seul fichier .epub incluant le contenu XHTML. L’affichage du fichier nécessite un lecteur ePUB. Vous pouvez également utiliser
le lecteur Adobe Digital Editions, qui peut être téléchargé gratuitement à partir du site Web d’Adobe.

Le fichier .epub s'apparente à un fichier .zip. Pour afficher et modifier le contenu d’un fichier EPUB, remplacez l’extension .epub par .zip, puis
extrayez le contenu. Ceci est particulièrement utile pour modifier un fichier CSS.

Le fichier .epub exporté peut inclure une image de couverture. Vous pouvez sélectionner une image à utiliser comme couverture. Vous pouvez
aussi autoriser InDesign à pixelliser la première page du document exporté, le document source des styles ou le livre exporté. La miniature
apparaît dans les lecteurs EPUB ou dans l’affichage de bibliothèque du logiciel Digital Editions Reader.

Options d’exportation de mise en page fixe

Section générale

Version du fichier EPUB. 

Prend en charge le contenu audio, vidéo, JavaScript et le texte vertical en japonais.
Ce n'est pas le cas sur les périphériques qui ne prennent pas en charge la norme EPUB 3.0.
EPUB 3.0 est une norme approuvée (IDPF, 2011).

Image de couverture pour l’eBook. Choisissez l’une des options suivantes :

Aucune image de couverture n’est ajoutée.

Sélectionnez cette option pour permettre à InDesign de créer une image en pixellisant la première page de
l’eBook à utiliser comme couverture.

Sélectionnez un fichier image sur votre ordinateur pour l’utiliser comme couverture.

Spécifiez l’option de navigation pour la Table des matières du visualiseur EPUB.
Utilisez l'option Niveaux multiples (style de table des matières) pour créer la barre latérale de navigation ou utiliser le nom de fichier.

http://idiom-q-win-1/fr/indesign/using/export-content-epub-cc.html#main-pars_header_3
http://idiom-q-win-1/fr/indesign/using/export-content-epub-cc.html#main-pars_header_1
http://idiom-q-win-1/fr/indesign/using/export-content-epub-cc.html#main-pars_header_1
http://www.adobe.com/fr/solutions/ebook/digital-editions.html


Nom de fichier

Niveaux multiples (style de table des matières)

Signets

Options

En fonction du format de document

Convertir la planche au format paysage

Activer les planches synthétiques

Désactiver les planches

Format

Automatique

PNG

Résolution (ppp)

Options GIF (Palette)

Adaptative (sans simulation)

Web

Système (Windows) ou Système (Mac)

Entrelacement

Générez une table des matières en réutilisant les noms de fichiers.

Générez une table des matières en réutilisant le style de table des matières
sélectionné.
Dans le menu Style de table des matières, définissez le style de la table des matières à utiliser pour créer la table des matières de
l’eBook.
Vous pouvez choisir Mise en page > Styles de tables des matières pour créer un style spécial de table des matières pour l’eBook.

(EPUB 3) Générez une table des matières en réutilisant les signets créés dans un document InDesign.
InDesign prend en charge les ancres de texte et des pages locales ou externes (du livre). Ces dernières peuvent être générées en créant
une table des matières dans InDesign et en spécifiant Créer des signets PDF.
Pour plus d’informations, voir la rubrique Signets.

Définissez l’ordre dans lequel les éléments de la page sont exportés.

InDesign détermine le contrôle de planche à partir des paramètres définis dans la boîte de dialogue
Configuration du document (Fichier > Format de document).

Convertir la planche au format paysage.

Autoriser l’exportation des planches synthétiques dans le document.

Aucune des planches n’est exportée vers la sortie EPUB.

Section Paramètres de conversion

Dans le menu Conversion d’image, déterminez le mode d'exportation des images au format EPUB.

Indiquez si les images optimisées dans le document sont converties au format GIF, JPEG ou PNG.

Laissez InDesign définir le format à utiliser dans chaque cas.

Désactivez les paramètres de compression de l’image. Utilisez le format PNG pour les images sans perte de données ou pour celles
qui contiennent des objets transparents.

Choisissez la résolution des images en pixels par pouce (ppp). Tandis que les systèmes d’exploitation ont adopté une
résolution standard de 72 ppp ou 96 ppp, la résolution des terminaux mobiles varie de 132 ppp (iPad) à 172 ppp (Sony Reader), voire même plus
de 300 ppp (iPhone 4).
Vous pouvez choisir une valeur ppp pour chaque objet sélectionné, parmi lesquelles 72, 96, 150 (moyenne pour tous les lecteurs électroniques du
moment) et 300.

Cette option vous permet de contrôler la façon dont InDesign gère les couleurs lors de l’optimisation des fichiers GIF. Le
format GIF utilise une palette de couleurs limitée, qui ne doit pas contenir plus de 256 couleurs.

Créez une palette à l’aide d’un échantillon représentatif de couleurs dans l’illustration sans aucun tramage
(mélange de petits points de couleurs permettant de simuler des couleurs supplémentaires).

Créez une palette de couleurs Web qui sont un sous-ensemble des couleurs système Windows et Mac OS.

Créez une palette à l’aide de la palette de couleurs système intégrée. Cette option peut
entraîner des résultats inattendus.

Chargez progressivement les images en remplissant les lignes manquantes. Lorsque cette option est désélectionnée,

http://idiom-q-win-1/fr/indesign/using/bookmarks.html#bookmarks


Options JPEG > Méthode de mise en forme

Progressive

Ligne de base

Options JPEG > Qualité d’image

Afficher le fichier EPUB après l’exportation

Identifiant

l’image paraît floue, puis elle devient plus nette au fur à et mesure qu’elle approche de sa résolution maximale.

Déterminez la vitesse d’affichage des images JPEG à l’ouverture du fichier contenant l’image dans
un navigateur Web.

Affichez les images JPEG graduellement avec un nombre croissant de détails lors de leur téléchargement.
Les fichiers créés avec cette option sont légèrement plus volumineux et utilisent davantage de RAM à l’affichage.
Choisissez l'option Ligne de base pour afficher chaque fichier JPEG uniquement après son téléchargement. Un espace réservé s’affiche
tant que l’image n’est pas téléchargée.

Affichez chaque fichier JPEG uniquement après son téléchargement.
Un espace réservé s’affiche tant que l’image n’est pas téléchargée.

Sélectionnez la qualité d’image requise pour chaque image JPEG créée à la sortie.
Sélectionnez l'option Faible pour générer le plus petit fichier et la qualité d’image la plus faible.

La section Affichage des applications de la boîte de dialogue EPUB - Options d’exportation de mise en page fixe contient les options suivantes :

Ouvre le fichier EPUB dans l’application par défaut sélectionnée pour lire ce format, si elle est
disponible.
S’applique aux deux boîtes de dialogue des options d’exportation de mise en page fixe et reformatable.

Section Métadonnées

Les métadonnées du document (ou le document de source des styles, si un livre a été sélectionné) sont incluses dans le fichier exporté.

(Lecture seule) Chaque document EPUB doit comporter un identifiant unique. Un identifiant unique est créé automatiquement
et s’affiche.

Application EPUB  Version  Pris en charge Non pris en charge

Mac

iBooks d’Apple 1.0.1 Oui  

Oxygen 14.1 Oui  

Previewer de Kindle 2.92 Oui  

Sigil 0.7.4 Oui  

Kindle 1.10.6  Non

VitalSource Bookshelf 6.2  Non

Book Proofer d’Apple 1.0.1 N’accepte pas les fichiers EPUB avec polices incorporées.

Windows

Sigil 0.7.4 Oui  

Previewer de Kindle 2.92 Oui  

Adobe Digital Editions 3.0.86137 Oui  

Calibre 1.26 Oui  

Oxygen 15 Oui  

Azardi 2.0 Oui  

Kobo 3.6.0  Non



Titre

Créateur

Date

Description

Editeur

Droits

Sujet

Ajouter une feuille de style

Supprimer

JavaScript

Haut de la page

Version

EPUB 2.0.1

EPUB 3.0

Couverture

Sans

Pixelliser la première page

Sélectionner une image

Saisissez le titre du fichier EPUB.

Saisissez le nom de l’auteur du fichier EPUB.

Spécifiez la date à laquelle le fichier EPUB a été créé.

Saisissez une description du fichier EPUB.

Spécifiez les détails concernant l’éditeur qui doivent figurer dans les métadonnées eBook. Par exemple, vous pouvez spécifier
l’adresse URL de l’éditeur.

Saisissez les informations de copyright ici.

Saisissez le sujet du EPUB.

Section CSS

Indiquez l’adresse URL d’une feuille de style CSS existante qui va être utilisée dans l’exportation EPUB.
InDesign ne vérifie pas si la feuille de style CSS existe ou est valide. Vous pouvez utiliser Dreamweaver pour confirmer la configuration
CSS externe.

Supprimer la feuille de style sélectionnée

Section JavaScript

Indiquez l’URL d’un JavaScript existant. InDesign ne vérifie ni l’existence ni la validité du JavaScript. Il est donc recommandé de
confirmer la configuration de votre JavaScript.

Options d’exportation au format redistribuable

Section générale

Spécifiez une version pour EPUB.

EPUB 2.0.1 est une norme approuvée par l’IDPF en 2007. Ce format est pris en charge sur de nombreux périphériques.

EPUB 3.0est une norme approuvée par l’IDPF en 2011. Ce format prend également en charge l’audio, la vidéo, le JavaScript,
le texte vertical en japonais. Ce format ne fonctionne pas sur les lecteurs et les périphériques qui ne prennent pas en charge la norme
EPUB 3.0.

Il s’agit de l’image de couverture de l’eBook. Choisissez l’une des options suivantes :

Aucune image de couverture n’est ajoutée.

Sélectionnez cette option pour permettre à InDesign de créer une image en pixellisant la première page de
l’eBook à utiliser comme couverture.

Sélectionnez un fichier image sur votre ordinateur pour l’utiliser comme couverture.



Table des matières de navigation

Nom de fichier

Niveaux multiples (style de table des matières)

Ordre

D’après la mise en page

Identique à la structure XML

Identique au panneau Articles

Notes de bas de page

Options > Supprimer les sauts de ligne forcés

Listes > Puces

Listes > Numéros

Faire correspondre à des listes triées

Spécifiez l’option de navigation pour la Table des matières du visualiseur EPUB.
Utilisez l'option Niveaux multiples (style de table des matières) pour créer la barre latérale de navigation ou utiliser le nom de fichier.

Générez une table des matières en réutilisant les noms de fichiers.

Générez une table des matières en réutilisant le style de table des matières
sélectionné. Dans le menu Style de table des matières, définissez le style de la table des matières à utiliser pour créer la table des
matières de l’eBook. Vous pouvez choisir Mise en page > Styles de tables des matières pour créer un style spécial de table des matières
pour l’eBook.

Définissez l’ordre dans lequel les éléments de la page sont exportés.

La position des éléments sur la page détermine l’ordre de lecture.
Si vous sélectionnez D’après la mise en page, InDesign détermine l’ordre de lecture des objets de la page en les balayant de la gauche
vers la droite et de haut en bas. Dans certains cas, et spécialement dans les documents complexes comprenant plusieurs colonnes, les
éléments de conception n’apparaissent pas dans l’ordre de lecture souhaité. Réorganisez et mettez en forme le contenu à l’aide de
Dreamweaver.
(Versions asiatiques uniquement) Si vous sélectionnez D’après la mise en page, InDesign détermine l’ordre de lecture des objets de la
page en fonction de la reliure du document (gauche à droite ou droite à gauche). Dans certains cas, et spécialement dans les documents
complexes comprenant plusieurs colonnes, les éléments de conception exportés sont susceptibles de ne pas apparaître dans l’ordre de
lecture souhaité. Réorganisez et mettez en forme le contenu à l’aide de Dreamweaver.

L’ordre des balises dans la vue Structure détermine l’ordre de lecture. Voir Balisage d’éléments de page.

L’ordre des éléments dans le panneau Articles détermine l’ordre de lecture. Seuls les articles cochés sont
exportés. Voir Inclusion d’articles pour l’exportation.

Zone de texte

Sélectionnez l’une des options suivantes pour définir l’emplacement des notes de bas de page.
Après le paragraphe : pour définir des notes de bas de page après le paragraphe.
Fin de la section (notes finales) : pour convertir les notes de bas de page en notes finales.
Dans une info-bulle (EPUB3) : pour placer une note de bas de page dans une info-bulle.

Si vous ajoutez une note de bas de page à l’aide de l’option de note de bas de page du document et que vous spécifiez une règle (par exemple,
épaisseur de 10 points), cette barre horizontale est prise en charge dans le document EPUB redistribuable à l’exportation.

Retirez tous les retours à la ligne automatiques de l’eBook exporté.

Sélectionnez l'option Faire correspondre à une liste non triée pour convertir les paragraphes à puces en éléments de liste HTML
à l’aide de la balise 

.
Sélectionnez l'option Convertir en texte pour mettre en forme en utilisant la balise
avec des puces de format texte. Si vous avez utilisé les puces automatiques natives d’InDesign, les puces de deuxième
niveau (ou sous-puces) sont également incluses.

Détermine la façon dont les nombres sont convertis dans le fichier HTML. Si vous avez utilisé la numérotation automatique
InDesign native, les puces de deuxième niveau (ou sous-puces) sont également incluses.

Convertissez les listes numérotées en éléments de liste, mis au format HTML à l’aide de la
balise 

.

http://idiom-q-win-1/fr/indesign/using/structuring-pdfs.html#tag_page_items
http://idiom-q-win-1/fr/indesign/urlpointers/help.adobe.com/using/WS8c5bc4f64c7a4a3d78b7a8b312dbccaf5b2-8000.html


Convertir en texte

Conserver l’aspect de la mise en page

Paramètres de conversion > Résolution (ppp)

CSS > Mise en page

CSS > Insérer un saut de page

Format

Options GIF (Palette)

Adaptative (sans simulation)

Web

Système (Windows) ou Système (Mac)

Entrelacement

Options JPEG > Méthode de mise en forme

Progressive

Ligne de base

Options JPEG > Qualité d’image

Convertissez les listes numérotées en paragraphes commençant par le numéro en cours du paragraphe au format
texte.

Section Objet

Dans le menu Conversion d’image, déterminez le mode d'exportation des images au format HTML.

Cochez cette case pour réutiliser les attributs des objets d’image de la mise en page.

Choisissez la résolution des images en pixels par pouce (ppp). Tandis que les systèmes
d’exploitation ont adopté une résolution standard de 72 ppp ou 96 ppp, la résolution des terminaux mobiles varie de 132 ppp (iPad) à 172 ppp
(Sony Reader), voire même plus de 300 ppp (iPhone 4). Vous pouvez choisir une valeur ppp pour chaque objet sélectionné, parmi lesquelles 72,
96, 150 (moyenne pour tous les lecteurs électroniques du moment) et 300.

Spécifiez l’alignement d’image : gauche, centre et droite. Vous pouvez également spécifier le remplissage en haut et en
bas.

Insérez des sauts de page avec les images. Vous pouvez insérer des sauts de page avant l’image, après
l’image ou avant et après l’image.

Paramètres de conversion section

Permet d’indiquer si les images optimisées dans le document sont converties dans le format GIF, JPEG ou PNG. Choisissez Automatique
pour laisser InDesign définir le format à utiliser dans chaque cas. L’option PNG désactive les paramètres de compression d’image ; utilisez PNG
pour les images sans perte de données ou qui contiennent des objets transparents.

Cette option vous permet de contrôler la façon dont InDesign gère les couleurs lors de l’optimisation des fichiers GIF. Le
format GIF utilise une palette de couleurs limitée, qui ne doit pas contenir plus de 256 couleurs.

Créez une palette à l’aide d’un échantillon représentatif de couleurs dans l’illustration sans aucun tramage
(mélange de petits points de couleurs permettant de simuler des couleurs supplémentaires).

Créez une palette de couleurs Web qui sont un sous-ensemble des couleurs système Windows et Mac OS.

Créez une palette à l’aide de la palette de couleurs système intégrée. Cette option peut
entraîner des résultats inattendus.

Chargez progressivement les images en remplissant les lignes manquantes. Lorsque cette option est désélectionnée,
l’image paraît floue, puis elle devient plus nette au fur à et mesure qu’elle approche de sa résolution maximale.

Déterminez la vitesse d’affichage des images JPEG à l’ouverture du fichier contenant l’image dans
un navigateur Web.

Affichez les images JPEG graduellement avec un nombre croissant de détails lors de leur téléchargement.
Les fichiers créés avec cette option sont légèrement plus volumineux et utilisent davantage de RAM à l’affichage.
Choisissez l'option Ligne de base pour afficher chaque fichier JPEG uniquement après son téléchargement. Un espace réservé s’affiche
tant que l’image n’est pas téléchargée.

Affichez chaque fichier JPEG uniquement après son téléchargement.
Un espace réservé s’affiche tant que l’image n’est pas téléchargée.

Sélectionnez la qualité d’image requise pour chaque image JPEG créée à la sortie.
Sélectionnez l'option Faible pour générer le plus petit fichier et la qualité d’image la plus faible.



Paramètres Ignorer l’exportation d’objet

Identifiant

Titre

Créateur

Date

Description

Editeur

Droits

Sujet

Générer des CSS

Conserver les remplacements locaux

Inclure les polices incorporables

Ajouter une feuille de style

JavaScript

Paramètres Ignorer l’exportation d’objet appliqués à chaque images. Voir Options Appliquer le style
d’objet.

Section Métadonnées

Les métadonnées du document (ou le document de source des styles si un livre a été sélectionné) sont incluses dans le fichier exporté. La section
Métadonnées de la boîte de dialogue EPUB - Options d’exportation de la mise en page redistribuable comprend les options suivantes :

(Lecture seule) Chaque document EPUB doit comporter un identifiant unique. Un identifiant unique est créé automatiquement
et s’affiche.

Saisissez le titre du fichier EPUB.

Saisissez le nom de l’auteur du fichier EPUB à mise en page fixe.

Spécifiez la date à laquelle le fichier EPUB a été créé.

Saisissez une description du fichier EPUB.

Entrez les détails concernant l’éditeur, comme son adresse URL.

Saisissez des informations connexes de copyright du fichier EPUB.

Saisissez le sujet du EPUB.

Section CSS

Les feuilles de style CSS (Cascading Style Sheets) regroupent des règles de mise en forme qui définissent l’apparence du contenu dans une
page Web. Lorsque vous utilisez des CSS pour mettre en forme une page, vous séparez le contenu de sa présentation. La section CSS de la
boîte de dialogue EPUB - Options d’exportation de la mise en page redistribuable contient les options suivantes :

Indiquez si vous souhaitez qu’InDesign génère un fichier CSS externe pour le fichier exporté. Si vous voulez exporter
le document/livre vers EPUB sans générer une feuille de style CSS, seules les classes associées aux styles sont marquées dans les
balises HTML. Aucune classe de remplacement n’est créée.

Incluez la mise en forme locale (italique ou gras par exemple).

Incluez toutes les polices qui sont incorporables, dans l’eBook. Les polices contiennent des bits
d’incorporation qui déterminent s’il est possible de les incorporer.

Indiquez l’adresse URL d’une feuille de style CSS existante. InDesign ne vérifie pas si la feuille de style CSS
existe ou est valide. Vous pouvez utiliser Dreamweaver pour confirmer la configuration CSS externe.

JavaScript section

Indiquez l’URL d’un JavaScript existant. InDesign ne vérifie ni l’existence ni la validité du JavaScript. Il est donc recommandé de
confirmer la configuration de votre JavaScript.

http://idiom-q-win-1/fr/indesign/using/frames-objects.html#object_export_options_cc_cs6_cs5_5
http://idiom-q-win-1/fr/indesign/using/frames-objects.html#object_export_options_cc_cs6_cs5_5


Haut de la page

Par défaut

Utiliser une image existante pour les objets graphiques

Pixelliser le conteneur

Pixelliser le contenu

Sans

Par défaut

Fixe

Selon la répartition du texte

Selon la taille du texte

Personnalisation de la largeur et de la hauteur dans un fichier

Remarque :

Remarque :
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Options d'exportation d'objet

Utilisez les options de la boîte de dialogue Options d’exportation d’objet pour indiquer comment les objets d’un document sont traités pendant
l’exportation au format EPUB.

1. Ouvrez la boîte de dialogue Options d’exportation d’objet (Objet > Options d’exportation) et accédez à la section EPUB et
HTML.

2. Choisissez l’une des options suivantes dans la liste Conserver l’aspect de la mise en page :

Le traitement de l’objet est déterminé par les paramètres de la boîte de dialogue d’exportation.
Pour le format redistribuable, le traitement est contrôlé par les paramètres de l’onglet Conversion.

Si l’objet contient une image, et que celle-ci est compatible avec
l’exportation EPUB (formats JPG, PNG et GIF), le conteneur est défini à l’aide d'une feuille de style CSS et l’image n’est pas
traitée.

Cette option équivaut à l’option Conserver l’aspect de la mise en page dans la section
d’exportation/de conversion au format redistribuable. L’objet entier est pixellisé afin de préserver l’aspect.
Si l’objet est un bloc de texte, le texte n’est plus dynamique.

Le contenu de l’objet est pixellisé. Le style de l’objet ou du conteneur est ainsi contrôlé par feuille de
style CSS et peut ne pas s’afficher entièrement tel que dans InDesign.

3. (Format EPUB redistribuable) Sélectionnez les options suivantes dans la liste Taille afin de conserver les proportions d’un objet (une image par
exemple), qui ne comporte pas de contenu fixe interne :

Aucune largeur ou hauteur CSS n’est générée pour la balise mappée à partir de l’objet. La taille de l’objet est
déterminée par le contenu interne, le cas échéant, conformément aux règles CSS, et les proportions ne sont pas conservées.

La taille CSS est déterminée par les paramètres de la boîte de dialogue d'exportation/l'onglet Objet.

La taille CSS est déterminée par le calcul de la dimension de l’objet en points et en définissant ces mêmes dimensions
dans la feuille de styleCSS en tant que pixels. Les proportions de l’objet sont conservées.

La largeur CSS est déterminée en prenant la largeur de l’objet et en l’exprimant en
pourcentage par rapport à la largeur du bloc contenant le texte. Les proportions de l’objet sont conservées.

La hauteur CSS est déterminée en prenant la hauteur de l’objet en points et en la convertissant en
ems à 12 pts par em. Les proportions de l’objet sont conservées.

Les unités CSS valides sont cm, mm, po, pt, %, px, vh,
vW, vmin et vmax. Les proportions de l’objet sont conservées.

ces options ne s’appliquent pas aux blocs de texte principaux.

les objets incluant du contenu Edge Animate ne prennent pas en charge les mesures associées.

Ressources EPUB

Les liens suivants vous permettront d’en savoir plus le format EPUB.



  Les publications Twitter™ et Facebook ne sont pas couvertes par les dispositions Creative Commons.

Mentions légales   |   Politique de confidentialité en ligne

Pour plus d’informations sur la spécification EPUB, consultez le site www.idpf.org.

Téléchargez une version gratuite de Digital Editions Reader sur le site www.adobe.com/fr/products/digital-editions.html.

Consultez le blog Digital Editions pour plus d’informations sur Digital Editions.

Pour plus d’informations sur l’exportation vers Kindle, consultez le livre blanc sur l’exportation d’InDesign vers Kindle (PDF).

Découvrez comment convertir vos fichiers InDesign au format EPUB et commencez à vendre vos eBooks pour l’iPad d’Apple. Consultez le livre
blanc sur la conversion d’InDesign vers iPad.

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr
http://www.idpf.org/
http://www.adobe.com/fr/products/digital-editions.html
http://blogs.adobe.com/digitaleditions/
http://wwwimages.adobe.com/www.adobe.com/content/dam/Adobe/en/devnet/digitalpublishing/pdfs/indesigntokindle_wp_ue1.pdf
http://wwwimages.adobe.com/www.adobe.com/content/dam/Adobe/en/devnet/indesign/pdfs/indesign-to-ipad.pdf
http://wwwimages.adobe.com/www.adobe.com/content/dam/Adobe/en/devnet/indesign/pdfs/indesign-to-ipad.pdf


Options Adobe PDF
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Standard

Compatibilité

Général

Compression

Repères et fonds perdus

Sortie

Avancé

Sécurité

Catégories d’options Adobe PDF
A propos des normes PDF/X
Niveaux de compatibilité PDF
Options générales appliquées aux fichiers PDF
Options de compression et de sous-échantillonnage appliquées aux PDF
Options de repères et de fonds perdus appliquées aux PDF
Options de gestion des couleurs et de sortie PDF/X appliquées aux PDF
Options de polices, d’OPI et d’aplatissement appliquées aux fichiers PDF
Ajout de protection aux fichiers PDF
Options de sécurité appliquées aux PDF
Incorporation et substitution de polices
Préparation d’un document en vue de l’afficher à l’écran

Catégories d’options Adobe PDF

Vous pouvez définir les options PDF lorsque vous exportez au format PDF ou lorsque vous créez ou modifiez
les paramètres prédéfinis PDF. Les options Adobe PDF sont divisées en plusieurs catégories. Les catégories
sont répertoriées dans la partie gauche de la boîte de dialogue Exporter au format Adobe PDF, à l’exception
des options Standard et Compatibilité qui se situent dans la partie supérieure. Lorsque vous exportez au
format PDF et que vous modifiez l’une des options, la mention « modifié » est ajoutée à la fin du nom du
paramètre prédéfini.

Permet d’attribuer un format PDF/X au fichier.

Permet d’attribuer une version PDF au fichier.

Permet de définir les options de base du fichier.

Permet d’indiquer si l’illustration doit être compressée et sous-échantillonnée et, dans ce cas,
la méthode et les paramètres à utiliser.

Permet de définir les repères d’impression, ainsi que les zones de fonds perdus
et de lignes-blocs. Bien que ces options soient identiques à celles de la boîte de dialogue d’impression, les
calculs sont légèrement différents du fait qu’un PDF n’est pas imprimé sur un format de page connu.

Permet de définir le mode d’enregistrement des couleurs et des profils de rendu de la sortie PDF/X
dans le fichier PDF.

Permet de définir le mode d’enregistrement des polices, des spécifications OPI, des paramètres
d’aplatissement des transparences et des instructions JDF dans le fichier PDF.

Permet de protéger les fichiers PDF. Les options de sécurité ne sont pas disponibles lorsque vous



Résumé
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Remarque :

Haut de la page

Remarque :

créez ou modifiez un paramètre prédéfini PDF.

Permet d’obtenir un résumé des paramètres PDF définis. Vous pouvez cliquer sur la flèche en
regard d’une catégorie (Général, par exemple) pour afficher les paramètres individuels. Pour enregistrer le
résumé sous forme de fichier texte ASCII, cliquez sur Enregistrer le résumé. Une icône d’avertissement 
accompagnée d’un texte explicatif s’affiche si le paramètre sélectionné ne peut pas être mis en œuvre et doit
être redéfini. Par exemple, si les profils source spécifiés dans un paramètre prédéfini ne correspondent pas
au fichier de paramètres de couleur actif, ces profils sont remplacés par ceux spécifiés dans le fichier de
paramètres de couleur.

A propos des normes PDF/X

Les normes PDF/X sont définies par l’Organisation internationale de normalisation (ISO). Elles s’appliquent
aux échanges de contenus graphiques. Au cours de la conversion au format PDF, le fichier en cours de
traitement est contrôlé par rapport à la norme spécifiée. Si le fichier PDF ne respecte pas la norme ISO
sélectionnée, un message s’affiche vous demandant d’annuler la conversion ou de poursuivre la création du
fichier non conforme. Il existe une norme couramment utilisée dans les flux de publication d’impression ; il
s’agit du format PDF/X, tel que PDF/X-1a.

Le format PDF/X-4 convient parfaitement à la transparence dynamique et à la gestion des couleurs. Ce
format est optimal pour le traitement RIP, les imprimantes numériques qui utilisent le moteur d’impression
Adobe PDF et tout fichier PDF à imprimer dans Acrobat.

pour plus de détails sur les normes PDF/X, consultez le site Web de l’Organisation
internationale de normalisation (ISO) et le site Web d’Adobe.

Niveaux de compatibilité PDF

Lors de la création d’un fichier PDF, vous devez décider de la version de PDF à utiliser. Vous pouvez
modifier la version de PDF en sélectionnant un paramètre prédéfini différent ou en choisissant une option de
compatibilité lors de l’enregistrement au format PDF ou de la modification du paramètre prédéfini PDF.

A moins que la compatibilité avec des versions antérieures s’avère nécessaire, il est en général recommandé
d’utiliser la version la plus récente (1.7 dans le cas présent). Cette version comprend les toutes dernières
fonctions et fonctionnalités. Cependant, si vous prévoyez de diffuser le fichier créé auprès d’un grand nombre
d’utilisateurs, vous pouvez envisager de choisir Acrobat 5.0 (PDF 1.4) ou Acrobat 6.0 (PDF 1.5) pour vous
assurer qu’ils pourront tous afficher et imprimer ce document.

Le tableau ci-après permet de comparer certaines fonctionnalités des fichiers PDF créés avec différents
paramètres de compatibilité.

Acrobat 8.0 et 9.0 utilisent également PDF 1.7.

Acrobat 3.0
(PDF 1.3)

Acrobat 5.0
(PDF 1.4)

Acrobat 6.0
(PDF 1.5)

Acrobat 7.0
(PDF 1.6) et
Acrobat X (PDF 1.7)

Ces fichiers PDF
peuvent être
ouverts avec
Acrobat 3.0,
Acrobat
Reader 3.0 et
versions
ultérieures.

Ces fichiers PDF
peuvent être
ouverts avec
Acrobat 3.0,
Acrobat
Reader 3.0 et
versions
ultérieures.
Cependant, les
fonctions
spécifiques à des

La plupart de ces
fichiers PDF peuvent
être ouverts avec
Acrobat 4.0, Acrobat
Reader 4.0 et
versions ultérieures.
Cependant, les
fonctions spécifiques
à des versions
ultérieures peuvent
être perdues ou non

La plupart de ces
fichiers PDF peuvent
être ouverts avec
Acrobat 4.0, Acrobat
Reader 4.0 et
versions ultérieures.
Cependant, les
fonctions spécifiques
à des versions
ultérieures peuvent
être perdues ou non

http://www.adobe.com/go/ext_iso_fr
http://www.adobe.com/go/ext_iso_fr
http://www.adobe.com/fr/
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versions
ultérieures peuvent
être perdues ou
non visibles.

visibles. visibles.

Ne prend pas en
charge les
illustrations
utilisant des
effets de
transparence
dynamiques.
Veillez à aplatir
toute option de
transparence
préalablement à
la conversion au
format PDF 1.3.

Format prenant en
charge l’utilisation
des effets de
transparence
dynamiques dans
les illustrations.
(La fonction
Acrobat Distiller
aplatit la
transparence.)

Format prenant en
charge l’utilisation
des effets de
transparence
dynamiques dans
les illustrations. (La
fonction Acrobat
Distiller aplatit la
transparence.)

Format prenant en
charge l’utilisation
des effets de
transparence
dynamiques dans les
illustrations. (La
fonction Acrobat
Distiller aplatit la
transparence.)

Calques non pris
en charge.

Calques non pris
en charge.

Conserve les
calques lors de la
création des
fichiers PDF à partir
d’applications
prenant en charge la
génération de
documents PDF
comportant des
calques, telles
qu’Illustrator CS ou
InDesign CS et
versions ultérieures.

Conserve les
calques lors de la
création des
fichiers PDF à partir
d’applications
prenant en charge la
génération de
documents PDF
comportant des
calques, telles
qu’Illustrator CS ou
InDesign CS et
versions ultérieures.

L’espace
colorimétrique
DeviceN avec
8 colorants est
pris en charge.

L’espace
colorimétrique
DeviceN avec
8 colorants est pris
en charge.

Espace
colorimétrique
DeviceN avec
31 colorants au
maximum pris en
charge.

Espace
colorimétrique
DeviceN avec
31 colorants au
maximum pris en
charge.

L’incorporation
des polices
multioctets est
prise en charge.
(Distiller
convertit les
polices lors de
leur
incorporation.)

L’incorporation des
polices multioctets
est prise en
charge.

L’incorporation des
polices multioctets
est prise en charge.

L’incorporation des
polices multioctets
est prise en charge.

Sécurité RC4
40 bits prise en
charge.

Sécurité RC4
128 bits prise en
charge.

Sécurité RC4
128 bits prise en
charge.

Sécurités RC4
128 bits et AES
(Advanced
Encryption Standard,
norme de
chiffrement avancé)
128 bits prises en
charge.

Options générales appliquées aux fichiers PDF



Description

Toutes

Etendue

Planches

Affichage

Mise en page

Incorporer les vignettes de page

Optimiser pour un affichage rapide sur le Web

Créer un PDF balisé

Cliquez sur la catégorie Général de la boîte de dialogue Exporter au format Adobe PDF pour définir les
options suivantes :

Fournit une description, que vous pouvez modifier, du paramètre prédéfini sélectionné. Vous
pouvez y coller une description à partir du Presse-papiers.

Pages

Exporte toutes les pages du document ou du livre actif.

Indique l’étendue de pages à exporter dans le document actif. Vous pouvez spécifier une
étendue avec un tiret et séparer les pages et les étendues par une virgule. Cette option n’est pas
disponible lorsque vous exportez des livres ou créez des paramètres prédéfinis.

Exporte toutes les pages ensemble comme si elles étaient imprimées sur la même feuille.
Remarque : ne choisissez pas l’option Planches pour vos impressions commerciales car elle ne
permet pas au prestataire de services d’étudier l’imposition des pages.

Affichage

Paramètres d’affichage initial du document PDF à l’ouverture.

Cette liste déroulante est activée uniquement si vous sélectionnez la norme PDF - Aucune.

Mise en page initiale du document PDF à l’ouverture.

Si dans la liste déroulante Compatibilité, Acrobat 4 (PDF 1.3) ou Acrobat 5 (PDF 1.4) est sélectionné, les options
suivantes de la liste déroulante Mise en page sont désactivées :

Deux pages (page double)
Deux pages (page de couverture)

Options

Permet d’incorporer une vignette d’aperçu pour chaque page du
fichier PDF, ce qui accroît la taille du fichier. Désactivez cette option pour les utilisateurs d’Acrobat
5.0 ou version ultérieure ; ces versions génèrent les vignettes de manière dynamique, à chaque fois
que l’utilisateur active le panneau Pages du fichier PDF.

Réduit la taille du fichier PDF et optimise celui-ci
pour le téléchargement « page par page » (byte serving) afin d’accélérer son affichage dans un
navigateur Web. Cette option compresse le texte et les dessins au trait sans tenir compte des
paramètres de compression préalablement définis dans la catégorie Compression de la boîte de
dialogue Exporter au format Adobe PDF.

Balise automatiquement les éléments de l’article pendant l’exportation, selon
un sous-ensemble de balises Acrobat pris en charge par InDesign. Ce balisage comprend la
reconnaissance des paragraphes, des options élémentaires de mise en forme du texte, des listes et
des tableaux (vous pouvez insérer et ajuster ces balises dans le document avant de l’exporter au
format PDF, Voir Ajout d’une structure aux PDF.)
Remarque : si le paramètre Compatibilité est défini sur Acrobat 6 (PDF 1.5) ou version ultérieure, les
balises sont compressées pour réduire la taille du fichier. Si vous ouvrez le PDF ainsi obtenu dans
Acrobat 4.0 ou Acrobat 5.0, les balises ne sont pas visibles : en effet, ces versions d’Acrobat ne
peuvent pas décompresser les balises.

http://idiom-q-win-1/fr/indesign/using/structuring-pdfs.html#adding_structure_to_pdfs


Afficher le PDF après exportation

Créer des calques Acrobat

Exporter les calques

Signets

Hyperliens

Grilles et repères visibles

Objets non imprimables

Eléments interactifs

Haut de la page

Ouvre le fichier PDF nouvellement créé dans l’application de
visualisation PDF par défaut.

Enregistre chaque calque InDesign sous forme de calque Acrobat dans
le PDF. Exporte également tous les repères d’impression que vous avez intégrés dans un calque
séparé de repères et de fonds perdus. Les calques étant entièrement accessibles, les utilisateurs
d’Adobe Acrobat 6.0 et versions ultérieures peuvent créer plusieurs versions d’un document à partir
d’un seul PDF. Si un document doit être publié en plusieurs langues, par exemple, vous pouvez
placer le texte de chaque langue sur un calque différent. Il suffit alors à votre prestataire de services
de prépresse d’afficher et de masquer les calques pour générer différentes versions du document.
Si vous sélectionnez l’option Créer des calques Acrobat lorsque vous exportez un livre au format
PDF, les calques ayant le même nom sont fusionnés par défaut.
Remarque : l’option Créer des calques Acrobat est disponible uniquement lorsque le paramètre
Compatibilité est défini sur Acrobat 6 (PDF 1.5) ou version ultérieure.

Détermine si les calques visibles et les calques non imprimables sont inclus
dans le PDF. Vous pouvez utiliser les paramètres Options de calque pour déterminer si chaque
calque est masqué ou défini comme non imprimable. Lors de l’exportation au format PDF, choisissez
si vous voulez exporter tous les calques (y compris les calques masqués et non imprimables), les
calques visibles (calques non imprimables inclus) ou les calques visibles et imprimables.

Inclure

Crée des signets pour les entrées de la table des matières et préserve les niveaux de cette
dernière. Les signets sont créés à partir des informations définies dans le panneau Signets.

Crée des annotations PDF sous forme d’hyperliens pour les hyperliens InDesign, les
entrées de table des matières et les entrées d’index.

Exporte les repères de marge, les repères de règle, les repères de
colonne et les grilles de ligne de base visibles dans le document. Les grilles et les repères sont
exportés dans la même couleur que celle utilisée dans le document.

Exporte les objets auxquels l’option Non imprimable a été appliquée dans
le panneau Attributs.

Choisissez l’option Inclure l’aspect pour inclure des éléments tels que des
boutons et des affiches vidéo dans le fichier PDF. Pour créer un fichier PDF comportant des éléments
interactifs, choisissez l’option Adobe PDF (interactif) plutôt que l’option Adobe PDF (impression) Voir
Options d’exportation au format PDF interactif.

Options de compression et de sous-échantillonnage appliquées
aux PDF

Lorsque vous exportez un document au format Adobe PDF, vous pouvez compresser le texte et les dessins
au trait et compresser et sous-échantillonner les images bitmap. Selon les paramètres choisis, la
compression et le sous-échantillonnage peuvent réduire de manière sensible la taille du fichier PDF et ce
avec très peu, voire aucune perte de détails et de précision.

La zone Compression de la boîte de dialogue Exporter au format Adobe PDF est divisée en trois sections.
Chaque section propose les options suivantes pour la compression et le sous-échantillonnage des images
couleur, en niveaux de gris ou monochromes.

http://idiom-q-win-1/fr/indesign/using/dynamic-pdf-documents.html#export_to_interactive_pdf_options


Sous-échantillonnage

Compression

Remarque :

Si vous envisagez d’utiliser le fichier PDF sur le Web, le sous-échantillonnage
permet un niveau de compression supérieur. Si vous envisagez d’imprimer le fichier PDF en haute résolution,
consultez votre fournisseur de services prépresse avant de définir les options de compression et de sous-
échantillonnage.
Vous devez également déterminer s’il sera nécessaire d’agrandir le document. Par exemple, si vous créez un
document PDF à partir d’une carte géographique, prévoyez d’utiliser une résolution d’image élevée, de sorte
que les utilisateurs puissent agrandir la carte.
Le sous-échantillonnage désigne la réduction du nombre de pixels dans une image. Pour sous-échantillonner
des images en couleur, en niveaux de gris ou monochromes, choisissez une méthode d’interpolation
(interpolation, sous-échantillonnage bicubique ou échantillonnage) et saisissez la résolution souhaitée (en
pixels par pouce). Saisissez ensuite une résolution dans la zone de texte « pour les images au-dessus de ».
Toutes les images dont la résolution dépasse ce seuil seront sous-échantillonnées.
La méthode d’interpolation choisie détermine la façon dont les pixels sont supprimés :

Interpolation à
Calcule la couleur moyenne des pixels d’une zone échantillon, puis remplace toute la zone par cette
couleur à la résolution indiquée.
Echantillonnage à
Choisit un pixel au centre de la zone d’échantillonnage et remplace toute la zone par la couleur de ce
pixel. L’échantillonnage est plus rapide que le sous-échantillonnage mais produit des images aux
variations chromatiques plus brutales.
Sous-échantillonnage bicubique à
Utilise une moyenne pondérée pour déterminer la couleur de pixel, ce qui donne généralement de
meilleurs résultats que la méthode d’interpolation par calcul de moyenne. C’est la méthode la plus lente
mais aussi la plus précise, qui donne les variations chromatiques les plus douces.

Détermine le type de compression à utiliser :
Automatique (JPEG)
Calcule automatiquement le niveau de compression permettant d’obtenir des images en couleurs et en
niveaux de gris de qualité optimale. Cette option donne des résultats satisfaisants pour la plupart des
fichiers.
JPEG
Convient aux images en niveaux de gris et en couleur. La compression JPEG entraîne une perte de
données, ce qui signifie qu’elle supprime des données de l’image et peut entraîner une baisse de la
qualité ; toutefois, cette compression tente de réduire la taille du fichier avec une perte minimale
d’informations. Etant donné que la compression JPEG supprime des données, elle produit des fichiers
nettement plus petits que la compression ZIP.
ZIP
Convient aux images qui présentent des zones étendues de couleurs unies ou des motifs récurrents,
ainsi qu’aux images en noir et blanc aux textures répétées. Selon la valeur du paramètre Qualité de
l’image, la compression ZIP peut être sans perte ou avec perte.
JPEG 2000
Constitue la norme internationale pour la compression et le conditionnement de données d’image. Tout
comme la compression JPEG, la compression JPEG 2000 est adaptée aux images en niveaux de gris
et en couleur. Elle présente des avantages supplémentaires, tels que l’affichage progressif. L’option
JPEG 2000 est uniquement disponible lorsque l’option Compatibilité est définie sur Acrobat 6
(PDF 1.5) ou version ultérieure.
Automatique (JPEG 2000)
Calcule automatiquement le niveau de compression permettant d’obtenir des images en couleurs et en
niveaux de gris de qualité optimale. L’option Automatique (JPEG 2000) est uniquement disponible
lorsque l’option Compatibilité est définie sur Acrobat 6 (PDF 1.5) ou version ultérieure.
Compressions CCITT et RLE
Disponibles uniquement pour les images bitmap monochromes. La compression CCITT (Consultative
Committee on International Telegraphy and Telephony) convient aux images noir et blanc ou aux
images numérisées avec une profondeur de 1 bit. Groupe 4 est une méthode générale qui produit une
bonne compression pour la plupart des images monochromes. Groupe 3, utilisé par la plupart des
télécopieurs, compresse les images bitmap monochromes une rangée à la fois. RLE est la meilleure
compression lorsque les images contiennent des zones étendues de blancs ou noirs unis.

les images en niveaux de gris qui ont été colorisées dans InDesign se voient appliquer les
paramètres de compression des images en couleur. En revanche, les images en niveaux de gris colorisées à
l’aide d’un ton direct (et dont les blocs sont associés à [Aucun]) utilisent les paramètres de compression des



Qualité d’image

Taille du carreau

Compression du texte et des dessins au trait

Recadrer les données de l’image sur les cadres
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Haut de la page

Remarque :

Conversion de la couleur

Aucune conversion de la couleur

Convertir vers la destination

Convertir vers la destination (conserver les numéros)

images en niveaux de gris.

Détermine le niveau de compression devant être appliqué. Pour la compression JPEG ou
JPEG 2000, vous avez le choix entre la qualité Minimum, Faible, Moyen, Elevée ou Maximum. Pour la
compression ZIP, seul le niveau 8 bits est disponible. Dans la mesure où InDesign utilise la compression ZIP
sans perte, qui ne supprime aucune donnée pour réduire la taille du fichier, la qualité de l’image demeure
inchangée.

Détermine la taille des carreaux pour l’affichage progressif. Cette option est uniquement
disponible lorsque la compatibilité est définie sur Acrobat 6 (1.5) ou une version ultérieure et que la
compression JPEG 2000 est sélectionnée.

Utilise la compression Flate (similaire à la compression ZIP
destinée aux images) pour l’ensemble du texte et des dessins au trait contenus dans le document, sans perte
de détails ou de qualité.

Peut réduire la taille du fichier en exportant uniquement
les données d’image correspondant à la partie visible du bloc. Ne sélectionnez pas cette option si les autres
données peuvent se révéler nécessaires pour les post-traitements (pour repositionner ou définir le fond perdu
d’une image, par exemple).

Options de repères et de fonds perdus appliquées aux PDF

Le fond perdu désigne la zone s’étendant au-delà du cadre de l’illustration, délimitée par les traits ou repères
de coupe. Il représente en quelque sorte votre marge d’erreur, afin de garantir que l’encre s’étend bien
jusqu’aux bords, une fois la page rognée, ou que le positionnement de l’illustration peut respecter un filet
technique défini sur la page.

Vous pouvez définir l’étendue des fonds perdus et ajouter un ensemble de repères d’impression au fichier.

Options de gestion des couleurs et de sortie PDF/X appliquées aux
PDF

La zone Sortie de la boîte de dialogue Exporter au format Adobe PDF vous permet de définir les options
suivantes. Les interactions entre les options du volet Sortie dépendent de l’état de la gestion des couleurs
(activée ou désactivée), de la présence de balises de profils de couleurs dans le document et de la
norme PDF sélectionnée.

pour obtenir une brève description d’une option de la zone Sortie, placez le pointeur de la
souris sur cette option : un texte descriptif s’affiche dans la zone Description, au bas de la boîte de dialogue.

Indique comment représenter les informations de couleur dans le fichier
Adobe PDF. Toutes les informations de tons directs sont préservées lors de la conversion des couleurs ;
seuls les équivalents quadri sont convertis vers l’espace colorimétrique désigné.

Les couleurs sont conservées en l’état. Cette option est celle
proposée par défaut lorsque PDF/X-3 est sélectionné.

Convertit les couleurs vers le profil sélectionné dans le champ
Destination. L’option Règle d’inclusion de profil permet de spécifier si le profil doit être inclus ou non.

Convertit les couleurs vers l’espace



Destination

Règle d’inclusion de profil

Ne pas inclure les profils

Inclure tous les profils

Inclure les profils de source balisée

Inclure tous les profils CMJN de source balisée et RVB

Inclure le profil de destination

Simuler la surimpression

Gestionnaire d’encres

Nom du profil de rendu de la sortie

colorimétrique de destination uniquement si leurs profils incorporés diffèrent du profil de destination
(ou bien s’il s’agit de couleurs RVB alors que le profil de destination correspond à CMJN, et
inversement). Les objets de couleur non balisés (objets sans profil incorporé) et les objets natifs (tels
que les dessins au trait ou le texte) ne sont pas convertis. Cette option n’est pas disponible si la
gestion des couleurs est désactivée. L’option Règle d’inclusion de profil permet de spécifier si le profil
doit être inclus ou non.

Décrit la gamme de votre périphérique de sortie RVB ou CMJN final, tel que le moniteur ou une
norme SWOP. A l’aide de ce profil, InDesign convertit les informations de couleur du document (définies dans
le profil source de la section Espaces de travail de la boîte de dialogue Couleurs) dans l’espace
colorimétrique du périphérique de sortie cible.

Permet d’indiquer si un profil de couleurs doit être inclus dans le fichier. La
disponibilité de cette option et les valeurs associées varient suivant le paramètre sélectionné dans le menu
Conversion de la couleur, selon que l’une des normes PDF/X a été sélectionnée ou non et selon que la
gestion des couleurs est activée ou désactivée.

Crée un document dont les couleurs ne sont pas gérées et sans profil de
couleurs incorporé.

Crée un document dont les couleurs sont gérées. Si le périphérique de
sortie ou l’application qui exploite le fichier Adobe PDF doit convertir les couleurs vers un autre
espace colorimétrique, il ou elle utilise l’espace colorimétrique incorporé dans le profil. Avant de
sélectionner cette option, activez la gestion des couleurs et définissez les informations de profil.

Laisse les couleurs dépendantes du périphérique inchangées
et conserve les couleurs dépendantes du périphérique sous leur forme équivalente la plus proche
dans le PDF. Cette option est utile aux imprimeurs qui ont étalonné tous leurs périphériques, qui ont
utilisé les informations correspondantes pour définir la couleur dans le fichier et qui utilisent
uniquement ces périphériques pour le traitement en sortie.

Intègre tous les profils associés aux
objets RVB balisés et aux objets CMJN balisés, tels que les objets importés comportant des profils
incorporés. Cette option a également pour effet d’intégrer le profil Document RVB associé aux
objets RVB non balisés.

Associe le profil de destination à tous les objets. Lorsque l’option
Convertir vers la destination (conserver les numéros) est sélectionnée, les objets non balisés du
même espace colorimétrique se voient attribuer le profil de destination, de sorte que les numéros de
couleur ne changent pas.

Simule l’aspect des séparations à l’impression en conservant l’aspect de la
surimpression sur la sortie composite. Lorsque l’option Simuler la surimpression est désélectionnée, il est
nécessaire de sélectionner l’option Aperçu de la surimpression dans Acrobat pour visualiser les
chevauchements de couleurs. Lorsque l’option Simuler la surimpression est sélectionnée, les tons directs
sont convertis en leur équivalent quadri et les couleurs se chevauchant s’affichent et s’impriment
correctement, même si l’option Aperçu de la surimpression est désactivée dans Acrobat. Lorsque l’option
Simuler la surimpression est sélectionnée et que l’option Compatibilité (zone Général) est définie sur
Acrobat 4 (PDF 1.3), il est possible d’effectuer une vérification du document directement à l’écran avant de le
traiter en sortie sur un périphérique spécifique.

Permet d’indiquer si les tons directs doivent être convertis en leur équivalent quadri
et de définir d’autres paramètres liés à l’encre. Si vous modifiez le document à l’aide du Gestionnaire
d’encres (par exemple, si vous convertissez tous les tons directs en leur équivalent quadri), vos modifications
seront prises en compte dans le fichier exporté et dans le document enregistré, mais ne seront pas
conservées dans le paramètre prédéfini Adobe PDF.

Définit les conditions d’impression spécifiques du document. Le profil



Nom de condition de sortie

Identificateur de condition de sortie

Nom du registre

Haut de la page

Jeux partiels de polices lorsque le pourcentage de caractères utilisé est inférieur à

OPI

Paramètre prédéfini

Remarque :

Ignorer le remplacement des planches

Créer un fichier JDF avec Acrobat

de rendu de la sortie est indispensable pour la création de fichiers conformes à la norme PDF/X. Ce menu
est disponible uniquement si une norme (ou un paramètre prédéfini) PDF/X est sélectionnée dans la zone
Général de la boîte de dialogue Exporter au format Adobe PDF. Les options disponibles sont différentes
selon que la gestion des couleurs est activée ou pas. Par exemple, si la gestion des couleurs est désactivée,
seuls les profils de sortie qui concordent avec l’espace colorimétrique du profil de destination sont répertoriés
dans le menu. Si la gestion des couleurs est activée, le profil de rendu de la sortie est identique à celui
sélectionné dans le champ Destination (à condition qu’il corresponde à un périphérique de sortie CMJN).

Décrit les conditions d’impression prévues. Cette description peut être utile au
destinataire du document PDF.

Indique une référence renvoyant à d’autres informations sur les
conditions d’impression prévues. Ce champ est automatiquement renseigné si les conditions d’impression
sont comprises dans le registre ICC. Lorsque l’une des normes (ou paramètres définis) PDF/X-3 est utilisée,
cette option ne peut pas être activée car si elle l’était, les fichiers obtenus ne pourraient pas satisfaire aux
tests de compatibilité réalisés dans le cadre de la fonction de contrôle en amont d’Acrobat 7.0 Professional
ou version ultérieure, ou de l’application Enfocus PitStop (module externe d’Acrobat 6.0).

Indique une URL permettant d’obtenir des informations complémentaires sur le registre. Ce
champ est automatiquement renseigné dans le cas d’un nom de registre ICC. Lorsque l’une des normes (ou
paramètres définis) PDF/X-3 est utilisée, cette option ne peut pas être activée car si elle l’était, les fichiers
obtenus ne pourraient pas satisfaire aux tests de compatibilité réalisés dans le cadre de la fonction de
contrôle en amont d’Acrobat 7.0 Professional ou version ultérieure, ou de l’application Enfocus PitStop
(module externe d’Acrobat 6.0).

Options de polices, d’OPI et d’aplatissement appliquées aux
fichiers PDF

Vous pouvez définir les options suivantes dans la zone Avancé de la boîte de dialogue Exporter au format
Adobe PDF.

Définit le seuil
d’incorporation de polices complètes en fonction du nombre de caractères de la police utilisée dans le
document. Dès que le pourcentage de caractères utilisé dans le document pour une police donnée dépasse
ce seuil, la totalité de la police est incorporée. Sinon, la police est incorporée dans un jeu partiel. Pour
incorporer toutes les polices, entrez 0 (zéro), mais sachez que l’incorporation de polices complètes augmente
la taille des fichiers. Vous pouvez aussi définir un seuil dans la boîte de dialogue Préférences générales afin
de déclencher l’incorporation d’un jeu partiel en fonction du nombre de glyphes que contient une police.

Permet d’ignorer de manière sélective différents types d’images importées lors de l’envoi des données
d’image vers un fichier ou une imprimante, laissant un serveur OPI se charger ultérieurement des liens OPI
(commentaires) uniquement.

Si Compatibilité (dans la zone Général de la boîte de dialogue) est défini sur Acrobat 4
(PDF 1.3), vous pouvez spécifier un paramètre prédéfini (ou jeu d’options) pour l’aplatissement des
transparences. Ces options sont utilisées uniquement lors de l’exportation de planches comprenant des
transparences.

les versions 5 (PDF 1.4) et ultérieures d’Acrobat conservent systématiquement les
transparences appliquées aux illustrations. Par conséquent, les options Paramètre prédéfini et Personnalisé
ne sont pas disponibles pour ces niveaux de compatibilité.

Applique les paramètres d’aplatissement à toutes les planches d’un
document ou d’un livre sans tenir compte des aplatissements prédéfinis associés à chacune des planches.

Crée un fichier JDF (Job Definition Format) et lance
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Compatibilité

Exiger un mot de passe pour l’ouverture du document

Mot de passe d’ouverture

Remarque :

Utiliser un mot de passe pour restreindre l’impression, la modification et autres opérations

Acrobat Professional en vue du traitement de ce fichier. Une définition de tâche dans Acrobat comporte des
références aux fichiers à imprimer, ainsi que des instructions et des informations destinées aux prestataires
de services prépresse. Cette option n’est disponible que si Acrobat 7.0 Professional (ou version ultérieure)
est installé sur votre ordinateur. Pour plus de détails, reportez-vous à l’Aide d’Acrobat.

Ajout de protection aux fichiers PDF

Lors de l’enregistrement au format PDF, vous pouvez protéger le fichier par un mot de passe et définir des
restrictions afin de limiter l’accès au fichier non seulement à l’ouverture, mais également lors de la copie, de
l’extraction, de l’impression, etc., du document.

Il se peut que vous deviez saisir des mots de passe pour ouvrir un fichier PDF (mot de passe d’ouverture du
document) et modifier les paramètres de protection (mot de passe d’accès aux droits). Si vous restreignez
l’accès à certaines fonctions d’un fichier, vous devez également définir les mots de passe (autrement, tout
utilisateur ayant accès au fichier pourrait supprimer les restrictions). Lorsque le fichier est ouvert avec ce mot
de passe, les restrictions de sécurité sont désactivées temporairement.

La méthode de protection par mot de passe RC4 de RSA Corporation est utilisée pour protéger les
fichiers PDF. Le niveau de chiffrement dépend de la valeur de l’option Compatibilité (catégorie Général).

les paramètres prédéfinis Adobe PDF ne prennent pas en charge les mots de passe ni les
paramètres de sécurité. Si vous définissez des mots de passe et des paramètres de sécurité dans la boîte de
dialogue Exporter au format Adobe PDF, puis que vous cliquez sur le bouton Enreg. prédéfini, les mots de
passe et les paramètres de sécurité ne sont pas conservés.

Options de sécurité appliquées aux PDF

Vous pouvez configurer les options suivantes lors de la création d’un fichier PDF ou lors de la protection d’un
fichier PDF par mot de passe. La disponibilité et les valeurs proposées pour chacune des options dépendent
du paramètre Compatibilité. Les options de sécurité ne sont pas disponibles pour les normes ou paramètres
prédéfinis PDF/X.

Le niveau de chiffrement appliqué aux documents protégés par mot de passe dépend de ce
paramètre. Un niveau de chiffrement bas (RC4 à 40 bits) est utilisé si vous avez sélectionné Acrobat 4
(PDF 1.3) et un niveau de chiffrement élevé (RC4 ou AES à 128 bits) si vous avez sélectionné l’une des
autres options.
N’oubliez pas que toute personne utilisant une version inférieure à celle définie au niveau du paramètre
Compatibilité ne pourra pas ouvrir le document PDF. Par exemple, si vous sélectionnez Acrobat 7 (PDF 1.6),
le document ne peut pas être ouvert dans Acrobat 6.0 ou antérieur.

Sélectionnez cette option pour obliger les
utilisateurs à saisir le mot de passe indiqué pour l’ouverture du document.

Indiquez le mot de passe nécessaire aux utilisateurs pour ouvrir le fichier PDF.

si vous oubliez un mot de passe, il est impossible de le récupérer à partir du document. Par
conséquent, il est conseillé de noter les mots de passe et de les conserver en lieu sûr.

Restreint
l’accès aux paramètres de sécurité du fichier PDF. Si le fichier est ouvert dans Adobe Acrobat, l’utilisateur
peut le visualiser mais il doit indiquer le mot de passe d’accès aux droits pour pouvoir modifier les paramètres
de sécurité et d’autorisation. Si le fichier est ouvert dans Illustrator, Adobe Photoshop ou Adobe InDesign,
l’utilisateur doit indiquer le mot de passe d’accès aux droits ; en effet, il n’est pas possible d’ouvrir le fichier
en mode Affichage seulement.



Mot de passe d’accès aux droits

Impression autorisée

Sans

Basse résolution (150 ppp)

Haute résolution

Modifications autorisées

Sans

Insertion, suppression et rotation des pages

Remplir des formulaires et apposer une signature

Insérer des commentaires, remplir des formulaires et apposer une signature

Mettre en page, remplir des formulaires et apposer une signature

Tout sauf extraire des pages

Activer la copie de texte, d’images et d’autre contenu

Activer la copie de contenu et l’accès pour les malvoyants

Activer l’accès au texte pour les lecteurs d’écran destinés aux malvoyants

Indiquez le mot de passe requis pour modifier les paramètres de droits.
Cette option est disponible uniquement si l’option précédente est sélectionnée.

Définit le niveau d’impression autorisé pour le document PDF.

Empêche l’utilisateur d’imprimer le document.

Permet à l’utilisateur d’imprimer à toute résolution inférieure ou égale à
150 ppp. L’impression risque d’être plus lente, chaque page étant imprimée comme image bitmap.
Cette option est uniquement disponible si l’option de compatibilité est définie sur Acrobat 5 (PDF 1.4)
ou version ultérieure.

Permet aux utilisateurs d’imprimer en toute résolution, en transférant une sortie
vectorielle de haute qualité à des imprimantes Adobe PostScript ou dotées de fonctionnalités
avancées pour l’impression de haute qualité.

Définit le type de modifications autorisées dans le document PDF.

Empêche les utilisateurs d’apporter au document toutes les modifications répertoriées dans le
menu Modifications autorisées, telles que le remplissage de champs de formulaire ou l’ajout de
commentaires.

Autorise les utilisateurs à insérer, supprimer et faire
pivoter des pages, et à créer des signets et des vignettes. Cette option est uniquement disponible
pour un niveau de chiffrement élevé (RC4 ou AES à 128 bits).

Permet aux utilisateurs de remplir des
formulaires et d’apposer des signatures numériques. Cette option ne les autorise pas à insérer des
commentaires, ni à créer des champs de formulaire. Cette option est uniquement disponible pour un
niveau de chiffrement élevé (RC4 ou AES à 128 bits).

Permet aux
utilisateurs d’ajouter des commentaires, d’apposer des signatures numériques et de remplir des
formulaires. Cette option n’autorise pas les utilisateurs à déplacer des objets de page ni à créer des
champs de formulaire.

Autorise les utilisateurs à
insérer, supprimer et faire pivoter des pages, créer des signets et des vignettes, remplir des
formulaires et apposer une signature numérique. Cette option ne les autorise pas à créer des champs
de formulaire. Cette option est disponible uniquement pour le niveau de chiffrement faible (RC4 à
40 bits).

Permet aux utilisateurs de modifier le document, de créer et de
remplir les champs du formulaire, ainsi que d’ajouter des commentaires et d’apposer des signatures
numériques.

Permet aux utilisateurs de sélectionner et de
copier le contenu d’un document PDF.

Permet aux utilisateurs malvoyants de lire et
de copier le document à l’aide de lecteurs d’écran. Cette option est disponible uniquement pour le niveau de
chiffrement faible (RC4 à 40 bits).

Permet aux utilisateurs
malvoyants de lire le document à l’aide de lecteurs d’écran, mais n’autorise pas les utilisateurs à copier ni à



Activer les métadonnées en texte normal

Haut de la page

Haut de la page

extraire le contenu du document. Cette option est disponible uniquement pour un niveau de chiffrement élevé
(RC4 ou AES à 128 bits).

Autorise les utilisateurs à copier et à extraire du contenu du
fichier PDF. Cette option est uniquement disponible lorsque le paramètre Compatibilité est défini sur
Acrobat 6 (PDF 1.5) ou version ultérieure. Sélectionnez cette option pour autoriser les systèmes de
stockage/recherche et les moteurs de recherche à accéder aux métadonnées stockées dans le document.

Incorporation et substitution de polices

Une police ne peut être incorporée que si son auteur a ajouté un paramètre permettant de le faire.
L’incorporation permet d’empêcher la substitution des polices lors de l’affichage ou l’impression du fichier et
garantit que les lecteurs visualisent les polices d’origine. L’incorporation accroît la taille des fichiers dans une
faible mesure, à moins que le document ne contienne des polices CID, format généralement utilisé pour les
polices asiatiques. Vous pouvez incorporer ou substituer des polices dans Acrobat ou lors de l’exportation
d’un document InDesign au format PDF.

Il est possible d’incorporer la police complète ou uniquement le jeu de caractères utilisés dans le fichier.

Lorsqu’un utilisateur ouvre ou imprime un fichier PDF dont la police ne peut être incorporée en raison de ses
paramètres d’origine et qu’il ne peut accéder à la police d’origine, une police de substitution est utilisée
temporairement. Pour éviter tout problème, imprimez uniquement les fichiers PDF dans lesquels les polices
peuvent être incorporées.

Les caractères Multiple Master peuvent être étirés ou condensés pour occuper le même espace que le
caractère d’origine et préserver les sauts de ligne et de page du document d’origine. Cependant, il peut
arriver que la forme du caractère de substitution ne corresponde pas à celle du caractère d’origine,
notamment lorsque les caractères ne sont pas courants (les caractères d’écriture, par exemple).

Si les caractères ne sont pas standard (à gauche), la police de substitution ne correspondra pas (à droite).

Préparation d’un document en vue de l’afficher à l’écran

Avec ses tailles de fichier réduites, sa compatibilité interplate-forme et ses possibilités de navigation en ligne,
le format Adobe PDF est idéal pour la distribution électronique des documents et leur visualisation à l’écran.
Vous pouvez envoyer des documents Adobe PDF à d’autres utilisateurs comme pièces jointes à un courrier
électronique, ou les distribuer sur le Web ou sur un intranet.

Pour plus d’informations sur la création de documents PDF accessibles, consultez le Centre de ressources
sur l’accessibilité Adobe InDesign CS4.

Les instructions ci-dessous s’appliquent à la distribution électronique de fichiers Adobe PDF :

Avant de placer des documents Adobe PDF sur un site Web, vérifiez que le texte, les
illustrations et la mise en page sont complets et corrects.

Vérifiez que les entrées de la table des matières, les hyperliens et les signets ont été
générés correctement. Les entrées de la table des matières sont générées
automatiquement à partir des informations du panneau Signets.

Définissez les mots de passe et les autres options de sécurité éventuelles.

Attribuez au fichier un nom ne dépassant pas huit caractères et une extension ne
dépassant pas trois caractères. De nombreux réseaux et logiciels de messagerie
abrègent les noms de fichiers longs.

http://www.adobe.com/fr/accessibility/products/indesign.html
http://www.adobe.com/fr/accessibility/products/indesign.html
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Remarque :

Vérifiez que le fichier porte une extension PDF si le fichier doit être visualisé sur un
ordinateur Windows ou sur Internet.

Si le fichier PDF se destine à être visualisé sur écran, choisissez le paramètre prédéfini
Taille de fichier minimale.

pour visualiser les fichiers Adobe PDF exportés à partir de documents InDesign contenant des
surimpressions ou des transparences, il est conseillé d’utiliser Acrobat version 5.0 ou ultérieure, ou bien
Adobe Reader version 7.0 ou ultérieure, en veillant à sélectionner l’option Aperçu de la surimpression.

Adobe recommande également
Exportation au format PDF pour l’impression
Hyperliens
Signets
Films et sons
Boutons
Repères d’impression et fonds perdus
Options d’omission d’images
Personnalisation des paramètres prédéfinis Adobe PDF

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
https://www.adobe.com/go/gffooter_online_privacy_policy_fr


Exportation de contenu au format HTML

Eléments exportés

Eléments non exportés

Exporter

Ordre du contenu

L’exportation au format HTML constitue un moyen simple de mettre en forme votre contenu InDesign pour le Web. Lorsque vous exportez du
contenu au format HTML, vous pouvez contrôler la manière dont le texte et les images sont exportés. InDesign conserve les noms des styles de
paragraphe, caractère, objet, tableau et cellule appliqués aux contenus exportés en marquant les contenus HTML avec les classes de styles CSS
du même nom. Grâce à Adobe Dreamweaver ou tout autre éditeur HTML compatible avec les feuilles de style en cascade (CSS), vous pouvez
sans difficulté appliquer des mises en forme et des mises en page aux contenus.

InDesign exporte tous les articles, les graphiques liés et incorporés, les séquences vidéo SWF, les notes de bas de page, les
variables de texte (au format texte), les listes à puces et numérotées, les références croisées internes, ainsi que les hyperliens renvoyant à du
texte ou à des pages Web.
Les tableaux peuvent également être exportés au format HTML. InDesign conserve la mise en forme des tableaux, tel que le contour du tableau et
des contours. Des identifiants uniques sont attribués aux tableaux afin que ces derniers puissent être référencés comme jeux de données Spry
dans Dreamweaver. Les fichiers audio et vidéo h.264 importés sont placés à l’intérieur de balises HTML5 <audio> et <video>. InDesign exporte
également les objets dessinés (tels que les rectangles, les ovales et les polygones), les objets collés (et notamment les images d’Illustrator
collées) et le texte vectorisé.

InDesign n’exporte pas les hyperliens (à part les liens renvoyant à des pages Web et ceux appliqués à du texte
renvoyant à des points d’ancrage de texte au sein du même document), les balises XML, les livres, les signets, les glyphlets SING, les transitions
de page, les marques d’index, les objets de la table de montage qui ne sont pas sélectionnés et qui ne touchent pas la page ni les éléments du
gabarit (sauf s’ils ont été remplacés ou sélectionnés avant l’exportation).

1. Si vous n’exportez pas le document dans sa totalité, sélectionnez les blocs de texte, les plages de texte, les cellules de
tableau ou les graphiques que vous voulez exporter.

2. Choisissez Fichier > Exporter et sélectionnez HTML dans la liste Type.

3. Définissez le nom et l’emplacement du document HTML, puis cliquez sur Enregistrer.

4. Dans la boîte de dialogue Options d’exportation HTML, définissez les options appropriées dans les zones Général, Image et
Avancé, puis cliquez sur OK.

Un document portant le nom spécifié et une extension .html (« bulletin.html », par exemple) est créé ; le cas échéant, un sous-dossier d’images
Web (« images-bulletins-Web ») est enregistré au même endroit.

Options d’exportation HTML

Dans la boîte de dialogue HTML, spécifiez les options suivantes.

Options générales

La zone Général contient les options suivantes.

Vous pouvez choisir d’exporter le document entier ou seulement certains éléments sélectionnés. Si un bloc de texte est sélectionné,
l’intégralité de l’article contenant le texte en excès est exporté.
Si le document est sélectionné, tous les éléments de page de toutes les planches sont exportés, sauf les éléments de gabarit qui n’ont pas été
substitués et les éléments de page sur des calques invisibles. Les balises XML, ainsi que les index et tables des matières générés sont également
ignorés.

Vous pouvez spécifier l’ordre de lecture des objets de la page.
D’après la mise en page
La position des éléments sur la page détermine l’ordre de lecture.



Options de mise en forme

Puces

Nombres

Afficher le fichier HTML après l’exportation

Copier les images

Original

Optimisées

Lier au chemin du serveur

Conserver l’aspect de la mise en page

Résolution (ppp)

Taille de l’image

Si vous sélectionnez D’après la mise en page, InDesign détermine l’ordre de lecture des objets de la page en les balayant de la gauche
vers la droite et de haut en bas. Dans certains cas, et spécialement dans les documents complexes comprenant plusieurs colonnes, les
éléments de conception sont susceptibles de ne pas apparaître dans l’ordre de lecture souhaité. Réorganisez et mettez en forme le contenu
à l’aide de Dreamweaver.
(Versions asiatiques uniquement) Si vous sélectionnez D’après la mise en page, InDesign détermine la lecture des objets de la page en
fonction de la reliure du document (de gauche à droite ou de droite à gauche).
Identique à la structure XML
Si vous choisissez l’option Identique à la structure XML, le panneau Structure XML détermine le contenu à exporter et l’ordre d’exportation
du contenu. Si le contenu est déjà balisé, vous pouvez simplement faire glisser les balises dans le panneau Structure XML pour définir
l’ordre d’exportation XHTML. Si le contenu n’est pas balisé, vous pouvez choisir Ajouter les éléments sans balise dans le menu du panneau
Structure pour générer des balises que vous pouvez réorganiser. Si vous souhaitez exclure un élément de l’exportation, supprimez
simplement sa balise dans le panneau Structure XML. (La suppression d’une balise n’entraîne pas la suppression du contenu du
fichier INDD.) Voir la page Balisage d’éléments de page.
Identique au panneau Articles
L’ordre des éléments dans le panneau Articles détermine l’ordre de lecture. Seuls les articles cochés sont exportés. (voir Inclusion d’articles
pour l’exportation).

Sélectionnez les options de mise en forme pour les puces et la numérotation.

Sélectionnez Faire correspondre à une liste non triée pour convertir les paragraphes à puces en éléments de liste au format HTML
en utilisant la balise. Sélectionnez Convertir en texte pour mettre en forme en utilisant la balise avec des puces de format texte. Si vous
avez utilisé les puces automatiques natives d’InDesign, les puces de deuxième niveau (ou sous-puces) sont également incluses.

Détermine la façon dont les nombres sont convertis dans le fichier HTML. Si vous avez utilisé la numérotation automatique
InDesign native, les puces de deuxième niveau (ou sous-puces) sont également incluses..

Faire correspondre à des listes triées : convertit les listes numérotées en éléments de liste, qui sont convertis au
format HTML à l’aide de la balise.
Convertir en texte : convertit les listes numérotées en paragraphes commençant par le numéro en cours du
paragraphe au format texte.

Démarre le navigateur, si celui-ci est présent.

Options d’image

Spécifie la manière dont les images sont exportées au format HTML.

Exporte l’image d’origine vers le sous-dossier « <nom_document>-web-images ». Lorsque cette option est sélectionnée, toutes
les autres options sont grisées.

Vous permet de modifier les paramètres pour déterminer comment l’image est exportée.

Plutôt que d’exporter des images vers un sous-dossier, cette option vous permet de saisir une URL locale
(telle que « images/ ») qui apparaît devant le fichier image. Dans le code HTML, l’attribut de lien affiche le chemin et l’extension que vous
avez spécifiés. Cette option est particulièrement efficace lorsque vous convertissez vous-même des images en images compatibles Web.

Cochez cette case pour réutiliser les attributs des objets d’image de la mise en page.

Choisissez la résolution des images en pixels par pouce (ppp). Tandis que les systèmes d’exploitation ont adopté une
résolution standard de 72 ppp ou 96 ppp, la résolution des terminaux mobiles varie de 132 ppp (iPad) à 172 ppp (Sony Reader), voire même plus
de 300 ppp (iPhone 4). Vous pouvez choisir une valeur ppp pour chaque objet sélectionné, parmi lesquelles 72, 96, 150 (moyenne pour tous les
lecteurs électroniques du moment) et 300.

Indiquez si l’image doit conserver une taille fixe ou être redimensionnée par rapport au texte de la page. L’option Selon la
répartition du texte définit un poucentage relatif d’après le flux de texte par rapport à la largeur de la page InDesign. Les images sont ainsi
redimensionnées proportionnellement, par rapport au texte dans la surface de lecture.

http://idiom-q-win-1/fr/indesign/using/structuring-pdfs.html#tag_page_items
http://idiom-q-win-1/fr/indesign/using/articles-cs5-5.html
http://idiom-q-win-1/fr/indesign/using/articles-cs5-5.html
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Alignement et espacement des images

Conversion d’image

Options GIF (Palette)

Options JPEG (Qualité d’image)

Options JPEG (Méthode de mise en forme)

Paramètres Ignorer l’exportation d’objet

Options CSS

Générer des CSS

Ajouter une feuille de style

Options JavaScript

Spécifiez l’alignement d’image : gauche, centre et droite. Vous pouvez également spécifier le
remplissage en haut et en bas.

Choisissez GIF, JPEG ou PNG pour la conversion des images optimisées dans votre document. Choisissez Automatique
pour laisser InDesign déterminer le format à utiliser dans chaque cas. Si vous choisissez PNG, vous désactivez les paramètres de compression
d’image.; utilisez PNG pour les images sans perte de données ou qui contiennent des objets transparents.

Cette option vous permet de contrôler la façon dont InDesign gère les couleurs lors de l’optimisation des fichiers GIF. Le
format GIF utilise une palette de couleurs limitée, qui ne doit pas contenir plus de 256 couleurs.
Choisissez l’option Adaptative (sans simulation) pour créer une palette utilisant un échantillon représentatif de couleurs dans l’illustration sans
aucun tramage (mélange de petits points de couleurs pour simuler des couleurs supplémentaires). Choisissez Web pour créer une palette de
couleurs Web qui sont un sous-ensemble des couleurs système Windows et Mac OS. Choisissez Système (Win) ou Système (Mac) pour créer
une palette utilisant la palette de couleurs système intégrée. Ce choix peut donner des résultats inattendus.
Sélectionnez Entrelacement pour charger les images progressivement en remplissant les lignes manquantes. Lorsque cette option est
désélectionnée, l’image paraît floue, puis elle devient plus nette au fur à et mesure qu’elle approche de sa résolution maximale.

Permet de choisir entre une compression (et une taille de fichier réduite) et une haute qualité d’image pour
chaque image JPEG. L’option Faible génère le plus petit fichier et la qualité d’image la plus faible.

Permet de déterminer la vitesse d’affichage des images JPEG à l’ouverture du fichier contenant
l’image sur le Web. Choisissez Progressive pour que les images JPEG s’affichent graduellement avec un nombre croissant de détails lors de leur
téléchargement. Les fichiers créés avec cette option sont légèrement plus volumineux et utilisent davantage de RAM à l’affichage. Choisissez
Ligne de base pour que le fichier JPEG s’affiche uniquement après qu’il a été téléchargé ; une marque de réservation apparaît à la place de
l’image avant son affichage.

Cette option permet de passer outre les options d’exportation d’objet appliquées individuellement aux
images. (voir Application d’options d’exportation d’objet).

Options avancées

Utilisez la zone Avancé pour définir des options de feuille de style CSS et JavaScript.

Les feuilles de style CSS (Cascading Style Sheets) regroupent des règles de mise en forme qui définissent l’apparence du contenu
dans une page Web. Lorsque vous utilisez CSS pour mettre en forme une page, vous séparez le contenu de sa présentation. Le contenu de la
page, à savoir le code HTML, se trouve dans le fichier HTML lui-même, alors que les règles CSS définissant la présentation du code figurent dans
un autre fichier (une feuille de style externe) ou dans le document HTML (généralement dans la section de titre). Par exemple, vous pouvez
spécifier différentes tailles de polices pour le texte sélectionné et vous pouvez utiliser CSS pour contrôler la mise en forme et le positionnement
des éléments de niveau bloc dans une page Web.

Indiquez si vous souhaitez qu’InDesign génère un fichier CSS pour le fichier exporté. Si vous sélectionnez l’option
Générer des CSS, vous pouvez également sélectionner l’option Conserver les remplacements locaux pour inclure la mise en forme locale
(italique ou gras, par exemple).

Spécifiez l’URL de la feuille de style CSS existante ; il s’agit généralement d’une URL relative, telle que
« /styles/style.css ». InDesign ne vérifie pas si la feuille de style CSS existe ou est valide. Vous pouvez utiliser Dreamweaver pour
confirmer la configuration de feuille de style CSS.

Sélectionnez Ajouter un script pour exécuter un script JavaScript à l’ouverture de la page HTML. InDesign ne vérifie ni
l’existence ni la validité du script JavaScript.

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr
http://idiom-q-win-1/fr/indesign/using/frames-objects.html#object_export_options_cc_cs6_cs5_5
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A propos d’Adobe PDF

Le format PDF (Portable Document Format) est un format de fichier universel permettant de conserver les
polices, les images et la mise en page des documents source, quelles que soient l’application et la plate-
forme d’origine. Le format Adobe PDF est la norme pour une diffusion et un échange internationaux fiables de
documents et de formulaires électroniques. Compacts et complets, les fichiers Adobe PDF peuvent être
partagés, affichés et imprimés par tous les utilisateurs disposant du logiciel gratuit Adobe Reader®.

Adobe PDF est particulièrement adapté aux processus de publication. En enregistrant un composite de votre
illustration au format Adobe PDF, vous créez un fichier compact et fiable que vous ou votre prestataire de
services pouvez afficher, modifier, organiser et vérifier. Au moment approprié du processus, votre prestataire
de services peut alors générer directement le fichier Adobe PDF, ou le traiter à l’aide d’outils de diverses
sources pour des tâches de post-traitement telles que vérifications de contrôle en amont, recouvrement,
imposition et séparation des couleurs.

Lors de l’enregistrement dans Adobe PDF, vous pouvez choisir de créer un fichier conforme à la
norme PDF/X. PDF/X (Portable Document Format Exchange) est un sous-ensemble d’Adobe PDF qui permet
d’éliminer de nombreuses variables de couleur, police et recouvrement pouvant entraîner des problèmes
d’impression. Vous pouvez avoir recours à la norme PDF/X dès lors que des fichiers PDF utilisés comme
matrices numériques sont échangés en vue d’une impression professionnelle, tant à l’étape de la création
que de la sortie, à condition que la norme soit prise en charge par les applications et les périphériques de
sortie.

Les fichiers PDF d’Adobe peuvent résoudre les problèmes suivants associés aux documents électroniques :

Problème courant Solution avec Adobe PDF

Le destinataire ne peut pas ouvrir le fichier,
car il ne dispose pas de l’application dans
laquelle ce fichier a été créé.

Toute personne, où qu’elle se trouve,
peut ouvrir un fichier PDF. Le logiciel
gratuit Adobe Reader est le seul
élément nécessaire.

Les archives électroniques combinées aux
archives papier occupent beaucoup d’espace,
offrent des possibilités limitées en termes de
recherche et impliquent que l’on dispose des
applications dans lesquelles les documents
ont été créés.

Les fichiers PDF sont compacts,
permettent une recherche sur tous les
éléments du fichier et peuvent être
ouverts à tout moment par le biais de
Reader. Les liens facilitent la navigation
dans les fichiers PDF.

Les documents ne s’affichent pas
correctement sur les appareils de poche.

Les documents PDF balisés permettent
de redistribuer le texte en vue de leur
affichage sur les plates-formes
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d’ordinateurs de poche telles que
Palm OS®, Symbian™ et Pocket PC®.

Les documents dont la mise en page est
complexe sont inaccessibles aux malvoyants.

Les fichiers PDF balisés contiennent
des informations sur le contenu et la
structure, ce qui permet de les
consulter à l’écran.

Exportation au format PDF pour l’impression

L’exportation d’un document ou d’un livre au format Adobe PDF peut être automatisée grâce aux paramètres
d’impression Qualité supérieure par défaut ou entièrement personnalisée selon les besoins. Les paramètres
d’exportation PDF que vous spécifiez sont enregistrés avec l’application et appliqués à chaque document ou
livre InDesign que vous exportez au format PDF, tant que vous ne les modifiez pas de nouveau. Vous
pouvez utiliser des paramètres prédéfinis pour appliquer rapidement des paramètres personnalisés aux
fichiers PDF.

Vous pouvez exporter un document, un livre ou des documents sélectionnés dans un livre sous la forme d’un
fichier PDF unique. Vous pouvez également copier le contenu de votre mise en page InDesign dans le
Presse-papiers, puis créer automatiquement un fichier Adobe PDF à partir de ce contenu. Cette fonction est
très utile pour coller un fichier PDF dans une autre application, telle qu’Adobe Illustrator.

Lorsque vous exportez un fichier InDesign au format PDF, vous pouvez conserver les éléments de navigation
tels que les tables des matières et les entrées d’index, ainsi que les fonctions interactivité tels que les
hyperliens, les signets, les séquences multimédias et les boutons. Vous pouvez également exporter des
calques masqués, des calques et des objets non imprimables au format PDF. Si vous exportez un livre, vous
pouvez fusionner les calques de noms identiques à l’aide du panneau Livre.

Pour plus d’informations sur la création de documents PDF accessibles, consultez le Centre de ressources
sur l’accessibilité Adobe InDesign.

Pour exporter un document ouvert au format PDF pour l’impression

1. Choisissez Fichier > Exporter.

2. Entrez un nom de fichier et choisissez un emplacement.

3. Dans la zone Type (Windows) ou Format (Mac OS) de la boîte de dialogue
Enregistrer sous , choisissez Adobe PDF (Impression), puis cliquez sur Enregistrer.

Lorsque vous sélectionnez l’option Adobe PDF (impression), vous ne pouvez pas inclure
d’éléments interactifs dans le fichier PDF. Pour exporter un document interactif en PDF,
voir Création de documents interactifs pour PDF.

4. Utilisez l’une des méthodes suivantes :

Pour utiliser un ensemble prédéfini d’options de traitement, sélectionnez un
paramètre prédéfini dans le menu Paramètres prédéfinis Adobe PDF.

Pour créer un fichier PDF/X, sélectionnez soit un paramètre prédéfini PDF/X dans le
menu Paramètres prédéfinis Adobe PDF, soit un format PDF/X prédéfini dans le
menu Standard.

Pour personnaliser les options, sélectionnez une catégorie dans la liste de gauche,
puis définissez les options.

5. Dans le champ Compatibilité, sélectionnez la plus ancienne des versions PDF pouvant
être utilisée pour ouvrir les fichiers créés.

6. Cliquez sur Exporter (Windows) ou Enregistrer (Mac OS).

Pour restaurer les options par défaut, dans la boîte de dialogue Exporter au format Adobe PDF, maintenez
la touche Alt (Windows) ou Option (Mac OS) enfoncée et cliquez sur le bouton Réinitialiser. Le bouton

http://www.adobe.com/accessibility/products/indesign.html
http://www.adobe.com/accessibility/products/indesign.html
http://help.adobe.com/fr_FR/InDesign/CS5/Using/WS25B6E685-EB91-4c42-9EC4-87E1F94D68B2.html


Remarque :

Annuler devient Réinitialiser.

Pour préparer les calques avant d’exporter un livre au format PDF

Lorsque vous exportez un livre au format PDF, vous pouvez afficher et masquer les calques InDesign dans le
document PDF. Pour éviter la duplication des noms de calques dans le PDF, vous pouvez fusionner les
calques lors de l’exportation.

Si l’option Fusionner les calques de noms identiques à l’exportation est sélectionnée, les noms des calques
apparaissent sous le même nom de livre dans Acrobat ou Reader. Si cette option n’est pas sélectionnée, les
noms de calques apparaissent séparément sous chaque nom de document.

1. Si vous ne voulez pas que certains calques soient fusionnés, donnez-leur un nom
différent et unique dans chaque document de livre.

Les noms de calques sont sensibles à la casse. Par exemple, les calques « Art » et
« art » ne sont pas fusionnés.

2. Dans le menu du panneau Livre, sélectionnez Fusionner les calques de noms identiques
à l’exportation.

lorsque vous exportez le livre au format PDF, assurez-vous que l’option
Créer des calques Acrobat est sélectionnée. Pour sélectionner cette option, vous devez
utiliser Acrobat 6 (PDF 1.5) ou une version ultérieure compatible.

Pour exporter un livre au format PDF

1. Utilisez l’une des méthodes suivantes :

Pour créer un PDF du livre entier, cliquez dans une zone vide du panneau Livre pour
désélectionner tout document sélectionné, puis choisissez Exporter le livre au format
PDF dans le menu du panneau Livre.

Pour créer un PDF de documents provenant d’un livre, sélectionnez les documents
dans le panneau Livre, puis choisissez Exporter les documents sélectionnés au
format PDF dans le menu du panneau Livre.

2. Spécifiez un nom et un emplacement pour le fichier PDF, puis cliquez sur Enregistrer.

3. Sélectionnez un paramètre prédéfini dans le menu Paramètres prédéfinis Adobe PDF ou
sélectionnez une catégorie dans la liste située dans la partie gauche de la boîte de
dialogue Exporter au format Adobe PDF, puis définissez les options selon vos besoins.

4. Cliquez sur Exporter (Windows) ou Enregistrer (Mac OS).

Pour réduire la taille des PDF

Lorsque vous prévoyez de distribuer les fichiers PDF à seule fin de visualisation, vous pouvez réduire leur
taille lors de leur exportation à partir d’InDesign. Vous trouverez ici quelques techniques de réduction des
fichiers que vous pouvez utiliser dans la boîte de dialogue Exporter au format Adobe PDF :

Choisissez [Taille de fichier minimale] dans le menu Paramètres prédéfinis Adobe PDF.

Dans la zone Compression, sous-échantillonnez les images à 72 pixels par pouce,
sélectionnez la compression automatique ainsi que la qualité d’image basse ou moyenne
pour les images en couleurs et en niveaux de gris. Lorsque vous travaillez avec des
images photographiques, utilisez la compression Automatique (JPEG) ; lorsque vous
travaillez avec des images aux couleurs unies, telles que les diagrammes et les graphes,
utilisez la compression ZIP.

Dans la zone Sortie, utilisez le Gestionnaire d’encres pour convertir les tons directs en
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couleurs quadri.

Pour réduire la taille des fichiers PDF, ouvrez le PDF dans Acrobat 8.0 ou version ultérieure, choisissez la
commande Document > Réduire la taille du fichier, puis spécifiez le niveau de compatibilité. Pour un
meilleur contrôle, choisissez la commande Options avancées > Optimisation PDF.

Pour plus d’informations sur la réduction de la taille des fichiers PDF, reportez-vous à l’aide d’Acrobat et au
site Web d’Adobe.

Paramètres prédéfinis Adobe PDF

Un paramètre prédéfini PDF est un groupe de paramètres ayant un impact sur le processus de création d’un
fichier PDF. Ces paramètres sont conçus pour équilibrer la taille et la qualité du fichier, en fonction de
l’utilisation du fichier Adobe PDF envisagée. La plupart des paramètres prédéfinis sont partagés dans les
composants d’Adobe Creative Suite, y compris InDesign, Illustrator, Photoshop et Acrobat. Vous avez
également la possibilité de créer et de partager des paramètres prédéfinis personnalisés pour vos exigences
particulières en matière de sortie.

Certains des paramètres prédéfinis répertoriés ci-dessous ne sont disponibles qu’une fois déplacés, selon
vos besoins, du dossier Extras (où ils sont installés par défaut) vers le dossier Settings. De manière
générale, les dossiers Extras et Settings sont disponibles dans ProgramData\Adobe\AdobePDF (Windows
Vista et Windows 7), Documents and Settings\All Users\Application Data\Adobe\Adobe PDF (Windows XP)
ou dans Bibliothèque/Application Support/Adobe PDF (Mac OS). Certains paramètres prédéfinis ne sont pas
disponibles dans certains composants Creative Suite.

Les paramètres personnalisés sont enregistrés dans le dossier /Documents and Settings/[nom
d’utilisateur]/Application Data/Adobe/Adobe PDF/Settings (Windows XP), Users/[nom
d’utilisateur]/AppData/Roaming/Adobe/Adobe PDF/Settings (Windows Vista et Windows 7) ou Users/[nom
d’utilisateur]/Bibliothèque/Application Support/Adobe/PDF/Settings (Mac OS).

Passez régulièrement en revue les paramètres PDF. Les options par défaut ne sont pas rétablies
automatiquement. Les applications et utilitaires de création de fichiers PDF utilisent toujours le jeu de
paramètres PDF défini et sélectionné en dernier.

Crée des fichiers PDF pour la qualité d’impression sur les imprimantes de bureau et les
périphériques d’épreuves. Ce paramètre prédéfini utilise PDF 1.4, et sous-échantillonne les images couleur et
en niveaux de gris à 300 ppp et les images monochromes à 1 200 ppp. Il incorpore également les jeux
partiels de polices, ne modifie pas les couleurs et n’aplatit pas la transparence (pour les types de fichiers
ayant la capacité de transparence). Les fichiers PDF obtenus peuvent être ouverts avec Acrobat 5.0, Adobe
Reader 5.0 et versions ultérieures. Dans InDesign, ce paramètre prédéfini crée également des fichiers PDF
balisés.

Crée un fichier PDF dans lequel sont conservées les
données Illustrator. Les fichiers PDF obtenus peuvent être de nouveau ouverts dans Illustrator sans perte de
données.

Crée des fichiers PDF adaptés à l’affichage et à l’impression de
dessins d’ingénierie dont la taille est supérieure à 200 x 200 pouces. Les fichiers PDF obtenus peuvent être
ouverts dans Acrobat, Reader 7.0 et versions ultérieures.

Utilisé pour la préservation (l’archivage) durable
des documents électroniques. Le format PDF/A-1b utilise PDF 1.4 et convertit l’ensemble des couleurs en
CMJN ou RVB en fonction de la norme sélectionnée. Les fichiers PDF créés avec ce fichier d’options peuvent
être ouverts avec Acrobat et Reader version 5.0 et ultérieures.

PDF/X-1a requiert l’incorporation de toutes les polices, la spécification des repères
et fonds perdus appropriés et l’affichage des couleurs en tant que CMJN et/ou couleurs avec tons directs.
Les fichiers conformes doivent contenir des informations relatives aux conditions d’impression pour lesquelles
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ils ont été préparés. Les fichiers PDF créés avec la compatibilité PDF/X-1a peuvent être ouverts dans
Acrobat 4.0, Acrobat Reader 4.0 et versions ultérieures.
Le format PDF/X-1a utilise PDF 1.3 et sous-échantillonne les images couleur et en niveaux de gris à 300 ppp
et les images monochromes à 1 200 ppp. Il incorpore également les jeux partiels de polices, crée des
fichiers PDF non balisés et aplatit la transparence à l’aide du paramètre Haute résolution.
Remarque : le format PDF/X1-a:2003 et les paramètres prédéfinis PDF/X-3 (2003) sont placés sur
l’ordinateur au cours de l’installation. Cependant, ils ne sont disponibles qu’une fois déplacés du dossier
Extras vers le dossier Settings.

Ce paramètre prédéfini crée un document PDF basé sur la norme ISO PDF/X-3:2002. Les fichiers
PDF créés avec ce paramètre peuvent être ouverts dans Adobe Acrobat 4.0 et Adobe Acrobat Reader 4.0 ou
versions ultérieures.

Ce paramètre prédéfini permettant de créer des fichiers ISO PDF/X-4:2008 prend en charge
les effets de transparence dynamiques (les effets de transparence ne sont pas aplatis) et le gestion des
couleurs ICC. Les fichiers PDF exportés avec ce paramètre prédéfini sont au format PDF 1.4 pour CS5 et
PDF 1.6 pour CS5.5 et versions ultérieures. Les images sont sous-échantillonnées et compressées et les
polices sont intégrées de la même manière qu’avec les paramètres PDF/X-1a et PDF/X-3. Vous avez la
possibilité de créer des fichiers conformes au format PDF/X-4:2008 directement avec les composants de
Creative Suite 4 et 5 (dont Illustrator, InDesign et Photoshop). Acrobat 9 Pro permet de valider et contrôler en
amont la conformité des fichiers PDF avec le format PDF/X-4:2008 et de convertir si possible les fichiers non
PDF/X en PDF/X-4:2008.
Adobe recommande PDF/X-4:2008 comme format de fichier optimal pour les processus de publication en
PDF.

Crée des fichiers PDF pour la production d’impression de haute qualité (par exemple, pour
l’impression numérique ou pour les séparations sur photocomposeuse ou imageuse de plaques), mais ne
crée pas de fichiers compatibles PDF/X. Dans ce cas, la qualité du contenu est prioritaire. Le but est de
conserver dans le fichier PDF toutes les informations nécessaires à un imprimeur ou un prestataire de
service d’impression afin de garantir la précision de l’impression du document. Cet ensemble d’options utilise
PDF 1.4, convertit les couleurs en CMJN et sous-échantillonne les images couleur et en niveaux de gris à
300 ppp et les images monochromes à 1 200 ppp. Il incorpore également les jeux partiels de polices et
conserve la transparence (pour les types de fichiers ayant la capacité de transparence).
Les fichiers PDF obtenus peuvent être ouverts dans Acrobat 5.0 et Acrobat Reader 5.0 et versions
ultérieures.
Remarque : avant de créer un fichier Adobe PDF destiné à un imprimeur professionnel ou un prestataire de
service d’impression, demandez-lui la résolution de sortie et les autres paramètres requis ou de vous fournir
le fichier .joboptions adéquat. Il vous faudra peut-être modifier les paramètres Adobe PDF en fonction des
recommandations du prestataire de services, puis lui fournir votre propre fichier .joboptions.

Permet de créer des fichiers PDF adaptés à un affichage sur le Web, à un
intranet ou à la distribution par courrier électronique. Cet ensemble d’options utilise la compression, le sous-
échantillonnage et une résolution d’image relativement basse. Il permet la conversion de toutes les couleurs
en sRVB et l’incorporation des polices. Il optimise également les fichiers pour le téléchargement page à page.
Pour un meilleur résultat, n’utilisez pas ce paramètre prédéfini si vous envisagez d’imprimer le fichier PDF.
Les fichiers PDF obtenus peuvent être ouverts dans Acrobat 5.0 et Acrobat Reader 5.0 et versions
ultérieures.

Ce paramètre prédéfini crée un document PDF basé sur
les règles de création conçues par le comité Digital Data Delivery.

Crée des fichiers PDF destinés à l’impression sur des imprimantes de
bureau ou numériques, à l’édition sur CD-ROM ou à l’envoi à un client comme épreuve d’impression. Cet
ensemble d’options utilise la compression et le sous-échantillonnage afin de maintenir la taille du fichier au
minimum, mais comprend également des jeux partiels de toutes les polices (autorisées) utilisées dans le
fichier, convertit les couleurs en sRVB et applique une résolution moyenne. Veuillez noter que les jeux
partiels de polices Windows ne sont pas incorporés par défaut. Les fichiers PDF créés avec ce fichier de
paramètres peuvent être ouverts dans Acrobat 6.0, Acrobat Reader 6.0 et versions ultérieures.



Haut de la page

Haut de la page

Windows XP

Windows Vista et Windows 7

Mac OS

Personnalisation des paramètres prédéfinis Adobe PDF

Bien que les paramètres prédéfinis PDF se basent sur les méthodes recommandées, il se peut que votre flux
de production ou d’impression requière des paramètres PDF spécialisés qui ne sont pas disponibles dans les
paramètres prédéfinis intégrés. Si tel est le cas, votre prestataire de services ou vous-même pouvez créer
des paramètres prédéfinis personnalisés. Les paramètres prédéfinis Adobe PDF sont enregistrés en tant que
fichiers .joboptions.

1. Choisissez Fichier > Paramètres prédéfinis Adobe PDF > Définir.

2. Utilisez l’une des méthodes suivantes :

Pour créer un paramètre prédéfini, cliquez sur Nouveau. Si vous voulez baser le
nouveau paramètre prédéfini sur un paramètre prédéfini existant, sélectionnez
d’abord le paramètre prédéfini. Définissez les options PDF, puis cliquez sur OK. (Voir
la section Paramètres prédéfinis Adobe PDF.)

Pour modifier un paramètre prédéfini personnalisé, sélectionnez-le et cliquez sur
Edition (vous ne pouvez pas modifier les paramètres prédéfinis par défaut).
Définissez les options PDF, puis cliquez sur OK.

Pour supprimer un paramètre prédéfini, sélectionnez-le, puis cliquez sur Supprimer.

Pour enregistrer un paramètre prédéfini à un emplacement autre que le sous-dossier
de paramètres du dossier Adobe (emplacement par défaut), sélectionnez le
paramètre, puis cliquez sur Enregistrer sous. Spécifiez un emplacement, puis cliquez
sur Enregistrer.

Sinon, vous pouvez créer un paramètre prédéfini personnalisé lorsque vous enregistrez un fichier PDF en
cliquant sur Enreg. prédéfini en bas de la boîte de dialogue Exporter au format Adobe PDF. Attribuez un nom
au paramètre prédéfini et cliquez sur OK.

Chargement des paramètres prédéfinis Adobe PDF

Les paramètres prédéfinis (fichiers .joboptions) que vous créez sont enregistrés dans le dossier Settings aux
emplacements suivants :

Documents and Settings\[nom d’utilisateur]\Application Data\Adobe\Adobe PDF

Users\[nom d’utilisateur]\AppData\Roaming\Adobe\Adobe PDF

User/[nom d’utilisateur]/Library/Application Support/Adobe/Adobe PDF

Ces paramètres prédéfinis apparaissent automatiquement dans le menu Paramètres prédéfinis Adobe PDF.

Les paramètres prédéfinis PDF InDesign supplémentaires sont installés dans le dossier Adobe PDF\Extras.
Recherchez les autres fichiers .joboptions à l’aide de l’utilitaire de recherche de votre système. Vous pouvez
aussi recevoir des paramètres prédéfinis personnalisés PDF de vos prestataires de services ou de vos
collègues. Pour que ces paramètres prédéfinis s’affichent dans le menu Paramètres prédéfinis Adobe PDF,
ils doivent être déplacés vers le dossier des paramètres soit manuellement soit à l’aide de la commande
Charger.

Pour charger les paramètres prédéfinis PDF
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La commande Charger est utile si vous voulez charger des paramètres prédéfinis PDF qui vous ont été
envoyés ou charger des paramètres prédéfinis PDF depuis InDesign CS2.

1. Choisissez Fichier > Paramètres prédéfinis Adobe PDF > Définir.

2. Cliquez sur Charger et sélectionnez le fichier .joboptions que vous voulez charger.

Le fichier .joboptions est copié vers le dossier Settings dans lequel les nouveaux paramètres prédéfinis PDF
sont stockés.

Pour rendre un fichier .joboptions disponible dans le menu Paramètres prédéfinis Adobe PDF, vous
pouvez également le faire glisser vers le dossier Settings dans lequel vos paramètres PDF sont stockés.

Pour convertir les paramètres prédéfinis PDF depuis InDesign CS

InDesign CS et versions antérieures exportent les paramètres prédéfinis PDF avec des extensions .pdfs ;
InDesign CS2 et versions ultérieures les exportent avec des extensions .joboptions. L’opération d’importation
a pour effet de convertir le fichier PDFS en fichier .joboptions et de redéfinir les paramètres si cela s’avère
nécessaire. Par exemple, si le profil de destination était défini sur RVB Moniteur dans la zone Sortie dans
InDesign CS, il est automatiquement défini sur Document RVB dans InDesign CS4.

1. Choisissez Fichier > Paramètres prédéfinis Adobe PDF > Définir.

2. Cliquez sur Charger.

3. Choisissez la commande Fichiers de paramètres de versions antérieures de PDF (.pdfs)
dans le menu Type (Windows) ou Tous les fichiers dans le menu Activer (Macintosh).

4. Cliquez deux fois sur le fichier que vous voulez convertir.

Le fichier apparaît en surbrillance dans la liste des paramètres prédéfinis Adobe PDF.

Panneau Tâches en arrière-plan

L’exportation des fichiers PDF pouvant être effectuée en arrière-plan dans InDesign, vous n’avez plus besoin
d’attendre la fin de cette opération pour continuer à travailler sur un document. Vous pouvez également
lancer plusieurs opérations d’exportation PDF en arrière-plan. Utilisez le panneau Tâches en arrière-plan
pour vérifier la progression des opérations d’exportation.

1. Exportez un ou plusieurs documents au format Adobe PDF.

2. Pour vérifier la progression de cette opération, choisissez Fenêtre > Utilitaires > Tâches
en arrière-plan.

Options Adobe PDF
Niveaux de compatibilité PDF
Création de documents interactifs pour PDF

http://creativecommons.org/licenses/by-nc-sa/3.0/
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Exportation de pages au format JPEG

Sélection

Etendue

Tout sélectionner

Planches

Incorporer le profil colorimétrique

Utiliser les paramètres de fond perdu du document

Le format JPEG utilise un mécanisme de compression d’image standard pour compresser des images en couleurs ou en niveaux de gris en vue
de leur affichage sur un écran. Utilisez la commande Exporter pour l’exportation au format JPEG d’une page, d’une planche ou d’un objet
sélectionné.

1. Si vous le souhaitez, sélectionnez un objet à exporter. Il n’est pas nécessaire d’effectuer une sélection pour exporter une page
ou une planche.

2. Choisissez Fichier > Exporter.

3. Spécifiez un emplacement et un nom de fichier.

4. Dans la zone Type (Windows) ou Format (Mac OS) de la boîte de dialogue Enregistrer sous, choisissez l’option JPEG, puis
cliquez sur Enregistrer.

La boîte de dialogue Exporter au format JPEG s’affiche.

5. Dans la section Exporter, optez pour l’une des méthodes suivantes :

Exportez l’objet sélectionné.

Indiquez le numéro de la page ou des pages à exporter. Séparez les numéros de pages d’une étendue par un tiret,
et plusieurs pages ou étendues de pages distinctes par une virgule.

Exportez toutes les pages des documents.

Exportez les pages en vis-à-vis d’une planche dans un seul fichier JPEG. Désactivez cette option pour exporter
chaque page d’une planche sous forme de fichier JPEG distinct.

6. Les options du menu Qualité permettent de choisir entre une compression élevée (et une taille de fichier réduite) ou une
haute qualité d’image.

Maximum inclut toutes les données d’image haute résolution disponibles dans le fichier exporté et utilise un espace
important sur le disque. Choisissez cette option si le fichier est destiné à une impression sur un périphérique de sortie
haute résolution.

Faible inclut uniquement des versions avec une résolution d’écran (72 ppp) des images bitmap importées dans le fichier
exporté. Choisissez cette option si le fichier est destiné uniquement à l’affichage sur un écran.

Avec les résolutions Moyenne et Supérieure, les données d’image seront plus nombreuses qu’avec la résolution Réduite,
mais la taille du fichier sera réduite avec différents niveaux de compression.

7. Vous avez le choix entre les options de mise en forme suivantes :

Progressive permet d’afficher progressivement les images JPEG, avec de plus en plus de détails au fur et à mesure de
leur téléchargement par l’intermédiaire d’un navigateur Web.

Ligne de base permet d’afficher les images JPEG après leur téléchargement.

8. Sélectionnez ou saisissez la résolution de l’image JPEG exportée.

9. Définissez l’espace colorimétrique du fichier exporté. Vous avez le choix entre RVB, CMJN ou Gris.

10. Sélectionnez les éléments suivants selon les besoins, puis cliquez sur le bouton Exporter.

Lorsque cette option est sélectionnée, le profil colorimétrique du document est incorporé
au fichier JPEG exporté. Le nom du profil est affiché en petits caractères à droite de l’option. Vous pouvez sélectionner le
profil voulu à l’aide de la commande Edition > Attribuer des profils, avant d’exporter le fichier au format JPEG.

L’option Incorporer le profil colorimétrique est désactivée lorsque l’espace colorimétrique Niveaux de gris est sélectionné.

Lorsque cette option est sélectionnée, la zone de fond perdu définie
dans la boîte de dialogue Format de document est visible dans le fichier JPEG obtenu. Cette option est désactivée lors de
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Lissage

Simuler la surimpression

l’utilisation de l’option Sélection.

Le lissage est une technique de suppression du crénelage du contour du texte et des images bitmap.

Cette option est semblable à la fonction Aperçu de la surimpression, à la différence qu’elle
s’applique à n’importe quel espace colorimétrique parmi ceux sélectionnés. Lorsqu’elle est sélectionnée, le fichier JPEG
exporté par InDesign simule les effets de surimpression des encres de tons directs avec différentes valeurs de densité neutre
en convertissant les tons directs en couleurs quadri pour l’impression.

Fichiers JPEG (.jpg)

http://creativecommons.org/licenses/by-nc-sa/3.0/deed.fr
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Remarque :

Haut de la page

Haut de la page

Ressources EPUB
Options d’exportation générales EPUB
Options d’image EPUB
Options de contenu EPUB

Vous pouvez exporter un document ou un livre sous forme d’eBook EPUB au contenu redistribuable, compatible avec le logiciel
Adobe Digital Editions et d’autres lecteurs d’eBooks.

1. Utilisez l’une des méthodes suivantes :

Ouvrez le document, puis choisissez Fichier > Exporter.

Ouvrez un livre, puis choisissez Exporter le livre au format EPUB dans le menu du panneau Livre.

2. Spécifiez le nom et le dossier du fichier.

3. Dans la liste Type, choisissez EPUB, puis cliquez sur le bouton Enregistrer.

4. Dans la boîte de dialogue Options d’exportation EPUB, spécifiez les options désirées dans les zones Général, Image
et Contenu.

InDesign crée un seul fichier .epub incluant le contenu XHTML. Si cela est spécifié, le fichier exporté peut inclure une image de couverture. Si
cela est spécifié, le fichier exporté peut inclure une image de couverture provenant d’un fichier image ou créée à partir de la pixellisation de la
première page du document spécifié (ou du document source des styles si un livre a été sélectionné). Cette miniature est utilisée pour décrire le
livre dans les lecteurs ePUB ou dans la bibliothèque du logiciel Digital Editions Reader. L’affichage du fichier nécessite un lecteur ePUB. Mais
vous pouvez également utiliser le logiciel Adobe Digital Editions, disponible gratuitement sur le site Web d’Adobe.

En fait, le fichier .epub s’apparente à un fichier .zip. Pour visualiser et modifier le contenu du fichier .epub, remplacez son extension .epub par
l’extension .zip, puis extrayez-en le contenu. Ceci est particulièrement utile pour modifier le fichier CSS.

les objets InDesign, tels que les blocs de texte et les objets contenant des images importées, sont systématiquement exportés
lorsque vous sélectionnez l’option d’ordre D’après la mise en page. Les objets InDesign vides sont exportés uniquement si vous leur avez appliqué
un paramètre d’exportation au format JPEG, GIF ou PNG, parmi les options d’exportation d’objet.

Ressources EPUB

Les liens suivants vous permettront d’en savoir plus le format EPUB.

Pour plus d’informations sur le format EPUB, rendez-vous à l’adresse www.idpf.org.

Téléchargez une version gratuite de Digital Editions Reader sur le site www.adobe.com/fr/products/digitaleditions.

Consultez le blog Digital Editions pour plus d’informations sur Digital Editions.

Pour plus d’informations sur l’exportation vers Kindle, consultez le document InDesign to Kindle white paper (PDF).

Découvrez comment convertir vos fichiers InDesign au format EPUB et commencez à vendre vos eBooks pour l’iPad d’Apple.
Consultez le livre blanc InDesign to iPad white paper.

Options d’exportation générales EPUB

La section Général de la boîte de dialogue Options d’exportation EPUB contient les options suivantes.

http://www.idpf.org/
http://www.adobe.com/fr/products/digitaleditions
http://blogs.adobe.com/digitaleditions/
http://www.adobe.com/content/dam/Adobe/en/devnet/digitalpublishing/pdfs/indesigntokindle_wp_ue1.
http://wwwimages.adobe.com/www.adobe.com/content/dam/Adobe/en/devnet/indesign/pdfs/indesign-to-ipad.pdf


Inclure les métadonnées du document

Ajouter une entrée pour l’éditeur

Identifiant unique

Couverture de l’eBook

Pas d’image de couverture

Pixelliser la première page

Utiliser le fichier d’image existant

Ordre

Marge du livre

Puces

Nombres

Faire correspondre à une liste triée

Faire correspondre à une liste triée statique

Convertir en texte

Les métadonnées du document (ou le document de source des styles si un livre a été sélectionné) sont
incluses dans le fichier exporté.

Spécifiez les détails concernant l’éditeur qui doivent figurer dans les métadonnées eBook. Vous pouvez
indiquer l’URL du site Web de l’éditeur afin que le destinataire de l’eBook puisse s’y référer.

Chaque document EPUB doit comporter un identifiant unique. Vous avez la possibilité de définir cet attribut. Si vous ne
renseignez pas le champ correspondant, un identifiant unique est créé automatiquement.

Il s’agit de l’image de couverture de l’eBook. Choisissez l’une des options suivantes :

Si cette option est sélectionnée, aucune image de couverture n’est ajoutée à l’eBook.

Si cette option est sélectionnée, la première page de l’eBook est pixellisée et sert à créer un fichier image
qui fera office de couverture.

Si cette option est sélectionnée, vous pouvez spécifier une image se trouvant sur votre ordinateur
comme couverture.

Vous pouvez définir l’ordre d’exportation des éléments de page.
D’après la mise en page
La position des éléments sur la page détermine l’ordre de lecture.
Si vous choisissez l’option D’après la mise en page, InDesign détermine l’ordre de lecture des objets de page en analysant celle-ci de gauche à
droite et de haut en bas. Dans certains cas, et spécialement dans les documents complexes comprenant plusieurs colonnes, les éléments de
conception sont susceptibles de ne pas apparaître dans l’ordre de lecture souhaité. Réorganisez et mettez en forme le contenu à l’aide de
Dreamweaver.
(versions asiatiques seulement) Si vous choisissez l’option D’après la mise en page, InDesign détermine l’ordre de lecture des objets de page en
fonction de la liaison du document (de gauche à droite ou de droite à gauche). Dans certains cas, et spécialement dans les documents complexes
comprenant plusieurs colonnes, les éléments de conception exportés sont susceptibles de ne pas apparaître dans l’ordre de lecture souhaité.
Réorganisez et mettez en forme le contenu à l’aide de Dreamweaver.
Identique à la structure XML
L’ordre des balises dans la vue Structure détermine l’ordre de lecture. Voir Balisage d’éléments de page.
Identique au panneau Articles
L’ordre des éléments dans le panneau Articles détermine l’ordre de lecture. Seuls les articles cochés sont exportés. Voir Inclusion d’articles pour
l’exportation.

Définissez une marge simple en ems ou en pixels. Les marges exprimées en ems sont particulièrement indiquées pour la
compatibilité multiécran. La même valeur est appliquée à toutes les marges : supérieure, inférieure, gauche et droite.

Sélectionnez Faire correspondre à une liste non triée pour convertir les paragraphes à puces en éléments de liste, qui sont mis en forme
en HTML à l’aide de la balise <ul>. Sélectionnez Convertir en texte pour mettre en forme à l’aide de la balise <p>, avec les puces au format texte.
Si vous avez utilisé les puces automatiques InDesign natives, les puces de deuxième niveau (ou sous-puces) sont également incluses.

Détermine la façon dont les nombres sont convertis dans le fichier HTML. Si vous avez utilisé la numérotation automatique InDesign
native, les puces de deuxième niveau (ou sous-puces) sont également incluses.

Convertit les listes numérotées en éléments de liste, mis au format HTML à l’aide de la balise <ol>.

Convertit les listes numérotées en éléments de liste et affecte un attribut <value> basé sur
le numéro en cours du paragraphe dans InDesign.

Convertit les listes numérotées en paragraphes commençant par le numéro en cours du paragraphe au format texte.

http://help.adobe.com/fr_FR/indesign/cs/using/WSa285fff53dea4f8617383751001ea8cb3f-70aba.html
http://idiom-q-win-1/indesign/urlpointers/help.adobe.com/using/WS8c5bc4f64c7a4a3d78b7a8b312dbccaf5b2-8000.html
http://idiom-q-win-1/indesign/urlpointers/help.adobe.com/using/WS8c5bc4f64c7a4a3d78b7a8b312dbccaf5b2-8000.html


Afficher le fichier EPUB après l’exportation

Haut de la page

Conserver l’aspect de la mise en page

Résolution (ppp)

Taille de l’image

Alignement et espacement des images

Insérer un saut de page

Les paramètres s’appliquent aux objets ancrés

Conversion d’image

Options GIF (Palette)

Options JPEG (Qualité d’image)

Options JPEG (Méthode de mise en forme)

Ignorer les paramètres de conversion d’objet

Haut de la page

Lance le logiciel Adobe Digital Editions Reader s’il est installé.

Options d’image EPUB

La section Images de la boîte de dialogue Options d’exportation Digital Editions comprend les options suivantes : Dans le menu Conversion
d’image, déterminez comment les images sont exportées en HTML.

Cochez cette case pour réutiliser les attributs des objets d’image de la mise en page.

Spécifiez la résolution des images en pixels par pouce (ppp). Tandis que les systèmes d’exploitation ont adopté une résolution
standard de 72 ppp ou 96 ppp, la résolution des terminaux mobiles varie de 132 ppp (iPad) à 172 ppp (Sony Reader), voire même plus de
300 ppp (iPhone 4). Vous pouvez spécifier une valeur exprimée en ppp pour chaque objet sélectionné, parmi lesquelles 72, 96, 150 (moyenne
pour tous les lecteurs électroniques du moment) et 300.

Indiquez si l’image doit conserver une taille fixe ou être redimensionnée par rapport à la page. Si vous optez pour une taille
adaptée au format de page, une valeur relative exprimée en pourcentage est définie en fonction de la taille de l’image par rapport à la largeur de
page InDesign. Les images sont ainsi redimensionnées proportionnellement, par rapport à la largeur de la surface de lecture.

Spécifiez l’alignement, à gauche, au centre ou à droite, et le remplissage, en haut et en bas, de l’image.

Cochez cette case pour insérer des sauts de page avec les images. Vous pouvez insérer des sauts de page avant
et/ou après l’image.

Cochez cette case pour appliquer ces paramètres à tous les objets ancrés.

Choisissez GIF, JPEG ou PNG pour la conversion des images optimisées dans votre document. Choisissez Automatique
pour laisser InDesign décider quel format utiliser dans chaque instance. L’option PNG désactive les paramètres de compression de l’image. ;
utilisez PNG pour les images sans perte de données ou qui contiennent des objets transparents.

Cette option vous permet de contrôler la façon dont InDesign gère les couleurs lors de l’optimisation des fichiers GIF. Le
format GIF utilise une palette de couleurs limitée, qui ne doit pas contenir plus de 256 couleurs.
Choisissez Adaptative pour créer une palette utilisant un échantillon représentatif de couleurs dans l’illustration sans aucun tramage (mélange de
quelques tons de couleurs pour simuler des couleurs supplémentaires). Choisissez l’option Web pour créer une palette de couleurs Web (ces
couleurs sont un sous-ensemble des couleurs système Windows et Mac OS). Choisissez Système (Win) ou Système (Mac) pour créer une palette
utilisant la palette de couleurs intégrée de Windows ou de Mac OS. Ce choix peut donner des résultats inattendus.
Sélectionnez Entrelacement pour charger progressivement les images par remplissage des lignes manquantes. Lorsque cette option est
désélectionnée, l’image paraît floue, puis elle devient plus nette au fur à et mesure qu’elle approche de sa résolution maximale.

Permet de choisir entre une compression (et une taille de fichier réduite) et une haute qualité d’image pour
chaque image JPEG. L’option Faible génère le plus petit fichier et la qualité d’image la plus faible.

Permet de déterminer la vitesse d’affichage des images JPEG à l’ouverture du fichier contenant
l’image sur le Web. Choisissez Progressive pour que les images JPEG s’affichent graduellement avec de plus en plus de détails à mesure qu’elles
sont téléchargées. Les fichiers créés avec cette option sont légèrement plus volumineux et utilisent davantage de RAM à l’affichage. Choisissez
Ligne de base pour que le fichier JPEG s’affiche une fois téléchargé seulement ; une marque de réservation apparaît à la place de l’image avant
son affichage.

Cette option permet de passer outre les options d’exportation d’objet appliquées individuellement
aux images. Voir Application d’options d’exportation d’objet.

Options de contenu EPUB
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Formatpour le contenu EPUB

Utiliser le style de table des matières d’InDesign

Diviser le document en fonction du style de paragraphe

Importer une note de bas de page après le paragraphe

Supprimer les sauts de ligne forcés

Générer des CSS

Inclure les définitions de style

Conserver les remplacements locaux

Inclure les polices incorporables

Noms de style uniquement

Utiliser le fichier CSS existant

La section Contenu de la boîte de dialogue Options EPUB contient les options suivantes.

Précisez si vous voulez utiliser le format XHTML ou DTBook. Le format spécialisé DTBook est destiné aux
lecteurs finaux présentant une déficience visuelle.

Sélectionnez cette option si vous souhaitez générer une table des matières en réutilisant le
style sélectionné. Dans le menu Style de table des matières, choisissez le style à utiliser pour générer la table des matières de l’eBook. Vous
pouvez également choisir la commande Page > Styles de tables des matières pour créer un style spécial pour l’eBook.

Vous pouvez scinder l’eBook selon le style de paragraphe spécifié. Ce fractionnement
a pour effet d’accroître le nombre de fichiers HTML dans l’assemblage d’EPUB. Il peut toutefois s’avérer utile, notamment pour scinder des fichiers
longs et améliorer les performances des lecteurs EPUB.

Cochez cette case pour positionner les notes de bas de page à la suite du
paragraphe. Si cette case reste désélectionnée, les notes de bas de page sont converties en notes de fin de page.

Cochez cette case pour retirer tous les retours à la ligne automatiques de l’eBook exporté.

Les feuilles de style CSS (Cascading Style Sheets) regroupent des règles de mise en forme qui définissent l’apparence du
contenu dans une page Web. Lorsque vous utilisez des CSS pour mettre en forme une page, vous séparez le contenu de sa présentation.

Lors de l’exportation au format EPUB, vous pouvez créer une liste de styles CSS modifiables.

Lorsque cette option est sélectionnée, la mise en forme locale (style italique ou gras, par
exemple) est incluse.

Cette option permet d’inclure toutes les polices qui sont incorporables, dans l’eBook. Les polices
contiennent des bits d’incorporation qui déterminent s’il est possible ou non de les incorporer.

Cette option permet d’inclure uniquement les noms de style non définis dans la feuille de style EPUB.

Spécifiez l’URL de la feuille de style CSS existante, qui est généralement une URL relative, telle que
« /styles/style.css ». InDesign ne vérifie ni l’existence ni la validité de la feuille de style CSS. Il est donc recommandé de confirmer la définition de
la feuille de style CSS.
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Exportation de texte
Exportation de contenu pour le Web
Exportation de contenu au format Dreamweaver (CS5)
Exportation de contenu pour EPUB (CS5)
Exportation de contenu vers Buzzword
Utilisation de la bibliothèque de nuances Web

Exportation de texte
Vous pouvez enregistrer tout ou partie d’un article InDesign dans un format de fichier que vous pouvez ouvrir dans plusieurs applications. Chaque
article d’un document est exporté dans un document distinct.

InDesign peut exporter du texte dans plusieurs formats de fichiers qui sont répertoriés dans la boîte de dialogue d’exportation. Les formats
répertoriés sont utilisés par d’autres applications et peuvent conserver de nombreuses caractéristiques de texte, comme les retraits et les
tabulations définis dans votre document.

Vous pouvez enregistrer en tant qu’extraits de texte ou de code des sections de texte et des éléments de mise en page que vous utilisez souvent.

1. A l’aide de l’outil Texte , cliquez sur l’article à exporter.
2. Choisissez Fichier > Exporter.
3. Spécifiez un nom et un emplacement pour l’article exporté et sélectionnez un format de fichier texte sous Type (Windows) ou

Format (Mac OS).

Si le format correspondant à votre application de traitement de texte n’apparaît pas dans la liste, enregistrez le document dans
un format pouvant être importé par l’application, tel que le format RTF. Si votre application de traitement de texte ne prend en
charge aucun autre format d’exportation InDesign, utilisez le format Texte seulement. Notez cependant que l’exportation au
format Texte seulement supprime tous les attributs de caractère du texte.

4. Cliquez sur le bouton Enregistrer pour exporter l’article au format sélectionné.

Pour conserver toute la mise en forme, utilisez le filtre d’exportation de texte référencé Adobe InDesign. Pour plus de détails, consultez le
fichier PDF relatif au texte référencé à l’adresse suivante : www.adobe.com/go/learn_id_taggedtext_cs5_fr.

Exportation de contenu pour le Web
Pour réutiliser du contenu InDesign pour le Web, vous disposez de plusieurs options :

Dreamweaver (XHTML) Exportez une sélection ou la totalité du document vers un document HTML de base sans mise en forme. Vous pouvez
créer des liens vers des images sur un serveur ou créer un dossier séparé pour les images. Vous pouvez ensuite utiliser un éditeur HTML, tel
qu’Adobe Dreamweaver®, pour mettre en forme le contenu pour le Web (voir la section Exportation de contenu au format Dreamweaver (CS5)).
Copier-coller Copiez le texte et les images du document InDesign et collez-les dans votre éditeur HTML.
Adobe PDF Exportez un document au format Adobe PDF, puis publiez ce fichier PDF sur le Web. Vous pouvez y inclure des éléments interactifs,
tels que des séquences vidéo et audio, des boutons et des transitions de page (voir la section Documents PDF dynamiques).
Flash (SWF) Exportez le document au format SWF afin qu’il soit directement lisible dans Flash Player ou sur le Web. Un fichier SWF peut
comporter des boutons, des hyperliens et des transitions de page (balayage, fondu et coin de page, par exemple) (voir la section Création de
fichiers SWF (Flash) interactifs pour le Web).
Flash (FLA) Exportez le document au format FLA afin de pouvoir l’éditer dans Adobe Flash Professional. (voir la section Création de fichiers FLA
pour le Web).
Digital Editions (EPUB) Exportez un document ou un livre sous forme d’eBook XHTML au contenu redistribuable, compatible avec le logiciel
Adobe Digital Editions (voir la section Exportation de contenu pour EPUB (CS5)).
XML Pour une meilleure réutilisation de vos flux de production, exportez le contenu à partir du format XML d’InDesign, que vous pouvez ensuite
importer dans un éditeur HTML tel que Dreamweaver (voir la section Utilisation de XML).

Exportation de contenu au format Dreamweaver (CS5)
L’exportation au format XHTML constitue un moyen simple de mettre en forme vos contenus InDesign pour le Web. Lorsque vous exportez des
contenus au format XHTML, vous pouvez contrôler la manière dont le texte et les images sont exportés. InDesign conserve les noms des styles de
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paragraphe, caractère, objet, tableau et cellule appliqués aux contenus exportés en marquant les contenus XHTML avec les classes de styles CSS
du même nom. Grâce à Adobe Dreamweaver ou tout autre éditeur HTML compatible avec les feuilles de style en cascade (CSS), vous pouvez
sans difficulté appliquer des mises en forme et des mises en page aux contenus.

Eléments exportés InDesign exporte tous les articles, les graphiques liés et incorporés, les séquences vidéo SWF, les notes de bas de page, les
variables de texte (au format texte), les listes à puces et numérotées, les références croisées internes, ainsi que les hyperliens renvoyant à du
texte ou à des pages Web. Les tableaux sont également exportés ; toutefois, certaines mises en forme, telles que les contours de tableau et de
cellule, ne le sont pas. Des identifiants uniques sont attribués aux tableaux afin que ces derniers puissent être référencés comme jeux de
données Spry dans Dreamweaver.
Eléments non exportés InDesign n’exporte pas les objets que vous avez dessinés (rectangles, ellipses et polygones), les séquences vidéo (à
l’exception des fichiers SWF), les hyperliens (à part les liens renvoyant à des pages Web et ceux appliqués à du texte renvoyant à des points
d’ancrage de texte au sein du même document), les objets collés (notamment les images copiées d’Illustrator), le texte vectorisé, les balises XML,
les livres, les signets, les glyphlets SING, les transitions de page, les marques d’index, les objets de la table de montage qui ne sont pas
sélectionnés et qui ne touchent pas la page ni les éléments du gabarit (sauf s’ils ont été remplacés ou sélectionnés avant l’exportation).

1. Si vous n’exportez pas le document dans sa totalité, sélectionnez les blocs de texte, les plages de texte, les cellules de
tableau ou les graphiques que vous voulez exporter.

2. Choisissez la commande Fichier > Exporter pour > Dreamweaver.
3. Spécifiez le nom et l’emplacement du document HTML, puis cliquez sur le bouton Enregistrer.
4. Dans la boîte de dialogue Options d’exportation XHTML, spécifiez les options désirées dans les zones Général, Images et

Avancé, puis cliquez sur le bouton Exporter.

Un document portant le nom spécifié et une extension .html (« bulletin.html », par exemple) est créé ; le cas échéant, un sous-dossier d’images
Web (« images-bulletins-Web ») est enregistré au même endroit.

Options d’exportation XHTML
Dans la boîte de dialogue XHTML (Fichier > Exporter pour > Dreamweaver), spécifiez les options suivantes :

Options générales
La zone Général inclut les options suivantes.

Exporter Vous pouvez choisir d’exporter le document entier ou seulement certains éléments sélectionnés. Si un bloc de texte est sélectionné, la
totalité de l’article (y compris l’éventuel texte en excès) est exportée.
Si le document est sélectionné, tous les éléments de page de toutes les planches sont exportés, sauf les éléments de gabarit qui n’ont pas été
substitués et les éléments de page sur des calques invisibles. Les balises XML, ainsi que les index et tables des matières générés sont également
ignorés.

Puces Sélectionnez Faire correspondre à une liste non triée pour convertir les paragraphes à puces en éléments de liste, qui sont mis en forme
en HTML à l’aide de la balise <ul>. Sélectionnez Convertir en texte pour mettre en forme à l’aide de la balise <p>, avec les puces au format texte.
Ordre Indiquez si l’ordre de lecture des objets de page doit s’appuyer sur l’ordre des pages ou la structure XML.
Si vous choisissez l’option D’après la mise en page, InDesign détermine l’ordre de lecture des objets de page en analysant celle-ci de gauche à
droite et de haut en bas. Dans certains cas, et spécialement dans les documents complexes comprenant plusieurs colonnes, les éléments de
conception sont susceptibles de ne pas apparaître dans l’ordre de lecture souhaité. Réorganisez et mettez en forme le contenu à l’aide de
Dreamweaver.

Si vous choisissez l’option Identique à la structure XML, l’ordre du contenu exporté, ainsi que les éléments exportés, sont gérés au moyen du
panneau Structure XML. Si le contenu est déjà balisé, il vous suffit de faire glisser les balises dans le panneau Structure XML pour définir l’ordre
d’exportation XHTML. Dans le cas d’un contenu sans balises, vous pouvez choisir la commande Ajouter les éléments sans balise dans le menu du
panneau Structure afin de générer des balises que vous pourrez ensuite réorganiser. Si vous voulez exclure un élément de l’exportation, il vous
suffit de supprimer la balise correspondante dans le panneau Structure XML. (La suppression d’une balise n’entraîne pas la suppression du
contenu du fichier INDD.) Voir la section Balisage d’éléments de page.

Nombres Détermine la façon dont les nombres sont convertis dans le fichier HTML.
Faire correspondre à une liste triée  Convertit les listes numérotées en éléments de liste, mis au format HTML à l’aide de la balise <ol>.
Faire correspondre à une liste triée statique  Convertit les listes numérotées en éléments de liste et affecte un attribut <value> basé sur le
numéro en cours du paragraphe dans InDesign.
Convertir en texte  Convertit les listes numérotées en paragraphes commençant par le numéro en cours du paragraphe au format texte.

Options d’image
Dans le menu Copier images, déterminez comment les images sont exportées en HTML.

Original Exporte l’image originale vers le sous-dossier d’images Web. Lorsque cette option est sélectionnée, toutes les autres options sont
grisées.
Optimisées Vous permet de modifier les paramètres pour déterminer comment l’image est exportée.
Mis en forme  Conserve la mise en forme InDesign, telle que la rotation ou la mise à l’échelle, autant que possible pour les images Web.
Conversion d’image  Choisissez GIF ou JPEG pour la conversion des images optimisées dans votre document. Choisissez Automatique pour
laisser InDesign décider quel format utiliser dans chaque instance.
Options GIF (Palette)  Cette option vous permet de contrôler la façon dont InDesign gère les couleurs lors de l’optimisation des fichiers GIF. Le
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format GIF utilise une palette de couleurs limitée, qui ne doit pas contenir plus de 256 couleurs.
Choisissez l’option Adaptative (sans simulation) pour créer une palette utilisant un échantillon représentatif de couleurs dans l’illustration sans
aucun tramage (mélange de petits points de couleurs pour simuler des couleurs supplémentaires). Choisissez l’option Web pour créer une palette
de couleurs Web (ces couleurs sont un sous-ensemble des couleurs système Windows et Mac OS). Choisissez l’option Système (Win) ou
Système (Mac) pour créer une palette à partir de la palette de couleurs intégrée de Windows ou de Mac OS. Ce choix peut donner des résultats
inattendus.

Options JPEG (Qualité d’image)  Permet de choisir entre une compression (et une taille de fichier réduite) et une haute qualité d’image pour
chaque image JPEG. L’option Faible génère le plus petit fichier et la qualité d’image la plus faible.
Options JPEG (Méthode de mise en forme)  Permet de déterminer la vitesse d’affichage des images JPEG à l’ouverture du fichier contenant
l’image sur le Web. Choisissez Progressive pour que les images JPEG s’affichent graduellement avec de plus en plus de détails à mesure qu’elles
sont téléchargées. Les fichiers créés avec cette option sont légèrement plus volumineux et utilisent davantage de RAM à l’affichage. Choisissez
Ligne de base pour que le fichier JPEG s’affiche une fois téléchargé seulement ; une marque de réservation apparaît à la place de l’image avant
son affichage.
Lier au chemin du serveur Plutôt que d’exporter des images vers un sous-dossier, cette option vous permet de saisir une URL locale (telle que
« images/ ») qui apparaît devant le fichier image. Dans le code HTML, l’attribut de lien affiche le chemin et l’extension que vous avez spécifiés.
Cette option est particulièrement efficace lorsque vous convertissez vous-même des images en images compatibles Web.
Remarque : InDesign ne vérifie pas le chemin spécifié pour les scripts Java™, les styles CSS externes ou les dossiers d’images. Il est par
conséquent préférable d’utiliser Dreamweaver pour vérifier les chemins d’accès.

Options avancées
Utilisez la zone Avancé pour définir les options CSS et JavaScript.

Options CSS Les feuilles de style CSS (Cascading Style Sheets) regroupent des règles de mise en forme qui définissent l’apparence du contenu
dans une page Web. Lorsque vous utilisez CSS pour mettre en forme une page, vous séparez le contenu de sa présentation. Le contenu de votre
page (c’est-à-dire le code HTML) réside dans le fichier HTML, tandis que les règles CSS définissant la présentation du code résident dans un
autre fichier (fichier CSS externe) ou dans le document HTML (généralement dans la section de titre). Par exemple, vous pouvez spécifier
différentes tailles de polices pour le texte sélectionné et vous pouvez utiliser CSS pour contrôler la mise en forme et le positionnement des
éléments de niveau bloc dans une page Web.
CSS incorporées  Lorsque vous exportez au format XHTML, vous pouvez créer une liste de styles CSS apparaissant dans la section de titre du
fichier HTML avec des déclarations (attributs).
Si l’option Inclure les définitions de style est sélectionnée, InDesign tente de faire correspondre les attributs de mise en forme de texte InDesign à
leurs équivalents CSS. Si cette option est désélectionnée, le fichier HTML comporte des déclarations vides. Vous pouvez modifier ces déclarations
ultérieurement dans Dreamweaver.

Si l’option Conserver les remplacements locaux est sélectionnée, la mise en forme locale (italique ou gras, par exemple) est incluse.

Sans CSS  Cette option permet d’omettre la section CSS dans un fichier HTML.
CSS externe  Spécifiez l’URL de la feuille de style CSS existante, qui est généralement une URL relative, telle que « /styles/style.css ». InDesign
ne vérifie ni l’existence ni la validité de la feuille de style CSS. Il est donc recommandé d’utiliser Dreamweaver pour confirmer la définition d’une
feuille de style CSS externe.
Options JavaScript Sélectionnez Lier au JavaScript externe pour exécuter un script JavaScript lorsque la page HTML est ouverte. Spécifiez
l’URL du script JavaScript, qui est généralement une URL parente. InDesign ne vérifie ni l’existence ni la validité du script JavaScript.

Exportation de contenu pour EPUB (CS5)
Vous pouvez exporter un document ou un livre sous forme d’eBook EPUB au contenu redistribuable, compatible avec le logiciel
Adobe Digital Editions.

1. Pour exporter un document, ouvrez-le, puis choisissez la commande Fichier > Exporter pour > EPUB.
2. Précisez un nom de fichier et un emplacement, puis cliquez sur le bouton Enregistrer.
3. Dans la boîte de dialogue Options d’exportation Digital Editions, spécifiez les options désirées dans les zones Général,

Images et Contenu, puis cliquez sur le bouton Exporter.

InDesign crée un seul fichier .epub incluant le contenu XHTML. Le fichier exporté comprend une image miniature JPEG de la première page du
document spécifié (ou du document de source des styles si un livre a été sélectionné). Cette miniature est utilisée pour décrire le livre dans la
bibliothèque du logiciel Digital Editions Reader. Pour visualiser le fichier, vous devez disposer de l’application Digital Editions que vous pouvez
télécharger gratuitement à partir du site Web d’Adobe.

En fait, le fichier .epub s’apparente à un fichier .zip. Pour visualiser et modifier le contenu du fichier .epub, remplacez son extension .epub par
l’extension .zip, puis extrayez-en le contenu. Ceci est particulièrement utile pour modifier le fichier CSS.

Ressources EPUB
Pour obtenir une liste des articles et ressources EPUB, rendez-vous à l’adresse www.adobe.com/go/learn_id_epub_fr.

Pour plus d’informations sur le format EPUB, rendez-vous à l’adresse www.idpf.org.

Téléchargez une version gratuite de Digital Editions Reader sur le site www.adobe.com/fr/products/digitaleditions.
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Consultez le blog Digital Editions pour plus d’informations sur Digital Editions.

Pour plus d’informations sur l’exportation vers Kindle, consultez l’article intitulé InDesign to Kindle white paper.

Options d’exportation générales Digital Editions
La section Général de la boîte de dialogue Options d’exportation Digital Editions comprend les options suivantes :

Inclure les métadonnées du document Les métadonnées du document (ou le document de source des styles si un livre a été sélectionné) sont
incluses dans le fichier exporté.
Ajouter une entrée pour l’éditeur Spécifiez les détails concernant l’éditeur qui doivent figurer dans les métadonnées eBook. Pensez
éventuellement à indiquer une adresse URL où les personnes qui recevront l’eBook peuvent consulter le site Web de l’éditeur et effectuer des
achats.
Identifiant unique Chaque document EPUB doit comporter un identifiant unique. Vous avez la possibilité de définir cet attribut. Si vous ne
renseignez pas le champ correspondant, un identifiant unique est créé automatiquement.
Ordre de lecture Si vous sélectionnez l’option D’après la mise en page, l’ordre de lecture des éléments de page dans le document EPUB est
fonction de leur emplacement sur la page. InDesign effectue la lecture de gauche à droite et de haut en bas. Pour un contrôle plus précis de
l’ordre de lecture, utilisez le panneau Balises XML afin de baliser les éléments de page. Si vous choisissez l’option Identique à la structure XML,
l’ordre des balises dans la vue Structure détermine l’ordre de lecture. Voir la section Balisage d’éléments de page.
Puces Sélectionnez Faire correspondre à une liste non triée pour convertir les paragraphes à puces en éléments de liste, qui sont mis en forme
en HTML à l’aide de la balise <ul>. Sélectionnez Convertir en texte pour mettre en forme à l’aide de la balise <p>, avec les puces au format texte.
Nombres Détermine la façon dont les nombres sont convertis dans le fichier HTML.
Faire correspondre à une liste triée  Convertit les listes numérotées en éléments de liste, mis au format HTML à l’aide de la balise <ol>.
Faire correspondre à une liste triée statique  Convertit les listes numérotées en éléments de liste et affecte un attribut <value> basé sur le
numéro en cours du paragraphe dans InDesign.
Convertir en texte  Convertit les listes numérotées en paragraphes commençant par le numéro en cours du paragraphe au format texte.
Afficher l’eBook après l’exportation Lance le logiciel Adobe Digital Editions Reader s’il est installé. Un message d’avertissement s’affiche si
votre système ne dispose pas d’un logiciel configuré pour visualiser des documents .epub.

Options d’exportation d’image Digital Editions
La section Images de la boîte de dialogue Options d’exportation Digital Editions comprend les options suivantes : Dans le menu Conversion
d’image, déterminez comment les images sont exportées en HTML.

Mis en forme Conserve la mise en forme InDesign, telle que la rotation ou la mise à l’échelle, autant que possible pour les images Web.
Conversion d’image Choisissez GIF ou JPEG pour la conversion des images optimisées dans votre document. Choisissez Automatique pour
laisser InDesign décider quel format utiliser dans chaque instance.
Options GIF (Palette) Cette option vous permet de contrôler la façon dont InDesign gère les couleurs lors de l’optimisation des fichiers GIF. Le
format GIF utilise une palette de couleurs limitée, qui ne doit pas contenir plus de 256 couleurs.
Choisissez Adaptative pour créer une palette utilisant un échantillon représentatif de couleurs dans l’illustration sans aucun tramage (mélange de
quelques tons de couleurs pour simuler des couleurs supplémentaires). Choisissez l’option Web pour créer une palette de couleurs Web (ces
couleurs sont un sous-ensemble des couleurs système Windows et Mac OS). Choisissez Système (Win) ou Système (Mac) pour créer une palette
utilisant la palette de couleurs intégrée de Windows ou de Mac OS. Ce choix peut donner des résultats inattendus.

Sélectionnez l’option Entrelacement pour afficher progressivement une image lente à charger en complétant les lignes manquantes. Lorsque cette
option est désélectionnée, l’image paraît floue, puis elle devient plus nette au fur à et mesure qu’elle approche de sa résolution maximale.

Options JPEG (Qualité d’image) Permet de choisir entre une compression (et une taille de fichier réduite) et une haute qualité d’image pour
chaque image JPEG. L’option Faible génère le plus petit fichier et la qualité d’image la plus faible.
Options JPEG (Méthode de mise en forme) Permet de déterminer la vitesse d’affichage des images JPEG à l’ouverture du fichier contenant
l’image sur le Web. Choisissez Progressive pour que les images JPEG s’affichent graduellement avec de plus en plus de détails à mesure qu’elles
sont téléchargées. Les fichiers créés avec cette option sont légèrement plus volumineux et utilisent davantage de RAM à l’affichage. Choisissez
Ligne de base pour que le fichier JPEG s’affiche une fois téléchargé seulement ; une marque de réservation apparaît à la place de l’image avant
son affichage.

Options d’exportation du contenu Digital Editions
La section Contenu de la boîte de dialogue Options d’exportation Digital Editions comprend les options suivantes :

Format pour le contenu EPUB Précisez si vous voulez utiliser le format XHTML ou DTBook.
Inclure les entrées de table des matières InDesign Sélectionnez cette option si vous désirez générer une table des matières sur le côté gauche
de l’eBook. Dans le menu Style de table des matières, choisissez l’option appropriée pour l’eBook. Vous pouvez également choisir la
commande Page > Styles de tables des matières pour créer un style spécial pour l’eBook.
Supprimer les entrées automatiques des documents Sélectionnez cette option si vous voulez éviter que les noms des documents
n’apparaissent dans la table des matières de l’eBook. Cette option est particulièrement utile si vous créez un eBook à partir d’un livre.
Utiliser les entrées de premier niveau comme sauts de chapitre Sélectionnez cette option pour scinder l’ebook en plusieurs fichiers, chacun
débutant par une entrée de table des matières de premier niveau. Si un fichier de contenu pèse plus de 260 Ko, un nouveau chapitre commence
au début d’un paragraphe figurant entre des entrées de premier niveau afin d’éviter la limite de 300 Ko.
Générer des CSS Les feuilles de style CSS (Cascading Style Sheets) regroupent des règles de mise en forme qui définissent l’apparence du

http://blogs.adobe.com/digitaleditions/
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Haut de la page

Haut de la page

contenu dans une page Web. Lorsque vous utilisez des CSS pour mettre en forme une page, vous séparez le contenu de sa présentation.
Inclure les définitions de style  Lors de l’exportation au format EPUB, vous pouvez créer une liste de styles CSS modifiables.
Conserver les remplacements locaux  Lorsque cette option est sélectionnée, la mise en forme locale (style italique ou gras, par exemple) est
incluse.
Inclure les polices incorporables  Inclut dans l’eBook toutes les polices qui peuvent être incorporées. Les polices contiennent en effet des bits
d’incorporation qui déterminent s’il est possible ou non de les incorporer.
Noms de style uniquement Cette option permet d’inclure uniquement les noms de style non définis dans la feuille de style EPUB.
Utiliser le fichier CSS existant Spécifiez l’URL de la feuille de style CSS existante, qui est généralement une URL relative, telle que
« /styles/style.css ». InDesign ne vérifie ni l’existence ni la validité de la feuille de style CSS. Il est donc recommandé de confirmer la définition de
la feuille de style CSS.

Exportation de contenu vers Buzzword
Buzzword est un éditeur de texte en ligne qui permet aux utilisateurs de créer et de stocker des fichiers texte sur un serveur Web. Lorsque vous
exportez un article vers Buzzword, vous créez un fichier texte sur le serveur Buzzword.

1. Sélectionnez le texte ou placez le point d’insertion dans un bloc de texte inclus dans l’article à exporter.

2. Utilisez l’une des méthodes suivantes :

Dans InDesign, choisissez Fichier > Exporter pour > Buzzword.

Dans InCopy, choisissez Fichier > Exporter pour Buzzword.

3. Si vous n’êtes pas déjà connecté à CS Live, cliquez sur Inscription, indiquez votre adresse électronique et votre mot de
passe, puis cliquez de nouveau sur Inscription.

4. Dans la boîte de dialogue d’exportation d’article pour Buzzword, indiquez le nom du document Buzzword à créer, puis cliquez
sur OK.

Le document Buzzword s’ouvre sur Acrobat.com. Vous pouvez ensuite déplacer le document dans un autre espace de travail et le partager avec
d’autres personnes.

Utilisation de la bibliothèque de nuances Web
InDesign inclut une bibliothèque de nuances appelée Web, qui contient les couleurs utilisées par la plupart des navigateurs pour afficher du texte
et des images dans des pages Web. Les 216 couleurs de la bibliothèque, généralement appelées couleurs Web sécurisées, sont reproduites à
l’identique quel que soit l’environnement, car elles font partie de la palette de couleurs utilisée par les navigateurs sous Windows et Mac OS. Les
couleurs Web sécurisées d’InDesign sont les mêmes que celles de la palette Web d’Adobe Photoshop et d’Adobe Illustrator.

Toutes les couleurs de la bibliothèque sont désignées par leurs valeurs RVB. Le langage HTML utilise leur code hexadécimal pour les reproduire ;
ce code est stocké dans la bibliothèque de nuances.

1. Dans le menu du panneau Nuancier, choisissez Nouvelle couleur.
2. Dans la zone Mode, choisissez Web.
3. Sélectionnez une couleur, puis cliquez sur OK.

Voir aussi
  Ajout de contenu dans les pages

  Création de pages avec CSS

Informations juridiques   |   Politique de confidentialité en ligne
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Remarque :

Présentation
Exporter au format EPUB
Options d’exportation EPUB

Options générales EPUB
Options d’image EPUB
Options avancées EPUB

Ressources EPUB

Présentation

Avant de pouvoir exporter votre mise en page au format EPUB, vous pouvez effectuer des réglage pour vous assurer qu’elle s’exporte
correctement.

Ajouter des graphiques ancrés - ancrage des graphiques dans enchaînements de texte, afin que vous puissiez contrôler leur
position par rapport au texte exporté. Voir Objets ancrés.
Options d’exportation d’objet - Spécifiez des options d’exportation pour les objets placés. Voir Options d’exportation d’objet.
Mise en correspondance des styles et des balises d’exportation - Faire correspondre les styles de caractère et de
paragraphe aux classes et balises HTML. Voir Mise en correspondance des styles et des balises d’exportation.
Choisir le contenu et l’ordre - Utilisez le panneau Articles pour choisir le contenu à exporter et l’ordre dans lequel il doit
apparaître. Voir Articles. Vous pouvez également commander le contenu basé sur une mise en page ou une structure XML.

Exporter au format EPUB

Vous pouvez exporter un document ou un livre sous forme d’eBook EPUB au contenu redistribuable, compatible avec le logiciel
Adobe Digital Editions et d’autres lecteurs d’eBooks.

1. Utilisez l’une des méthodes suivantes :

Ouvrez le document, puis choisissez Fichier > Exporter.

Ouvrez un livre, puis choisissez Exporter le livre au format EPUB dans le menu du panneau Livre.

2. Spécifiez le nom et le dossier du fichier.

3. Dans la liste Type, choisissez EPUB, puis cliquez sur le bouton Enregistrer.

4. Dans la boîte de dialogue Options d’exportation EPUB, spécifiez les options désirées dans les zones Général, Image
et Avancé.

InDesign crée un seul fichier .epub incluant le contenu XHTML. Si cela est spécifié, le fichier exporté peut inclure une image de couverture. Si
cela est spécifié, le fichier exporté peut inclure une image de couverture provenant d’un fichier image ou créée à partir de la pixellisation de la
première page du document spécifié (ou du document source des styles si un livre a été sélectionné). Cette miniature est utilisée pour décrire le
livre dans les lecteurs ePUB ou dans la bibliothèque du logiciel Digital Editions Reader. L’affichage du fichier nécessite un lecteur ePUB. Mais
vous pouvez également utiliser le logiciel Adobe Digital Editions, disponible gratuitement sur le site Web d’Adobe.

En fait, le fichier .epub s’apparente à un fichier .zip. Pour afficher et modifier le contenu d’un fichier EPUB file, remplacez l’extension .epub par
.zip, puis extrayez le contenu. Ceci est particulièrement utile pour modifier le fichier CSS.

les objets InDesign, tels que les blocs de texte et les objets contenant des images importées, sont systématiquement exportés
lorsque vous sélectionnez l’option d’ordre D’après la mise en page. Les objets vides ne sont pas exportés, sauf si vous appliquez à l’objet
InDesign un paramètre via les options d’exportation d’objet pour l’exporter dans le format JPEG, GIF ou PNG.

http://help.adobe.com/fr_FR/indesign/cs/using/WSa285fff53dea4f8617383751001ea8cb3f-6c43a.html
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Version

EPUB 2.0.1

EPUB 3.0

EPUB 3.0 avec mise en page

Couverture

Sans

Pixelliser la première page

Sélectionner une image

Style de table des matières

Marges

Ordre du contenu

D’après la mise en page

Identique à la structure XML

Options d’exportation EPUB

Options générales EPUB

La section Général de la boîte de dialogue Options d’exportation EPUB comprend les options suivantes :

Spécifiez une version pour EPUB.

EPUB 2.0.1 est une norme qui a été approuvée par l’IDPF (International Digital Publishing Forum) en 2007. Ce format est
pris en charge sur de nombreux périphériques.

EPUB 3.0 est une norme qui a été approuvée par l’IDPF (International Digital Publishing Forum) en 2011. Ce format prend
également en charge l’audio, la vidéo, le javascript, le texte vertical en japonais. Les nouvelles fonctions toutefois ne fonctionneront pas
sur les lecteurs et les périphériques qui ne prennent pas en charge EPUB 3.0 standard.

Il s’agit d’un format expérimental créé par Adobe Systems. Il prend en charge plusieurs colonnes,
l’habillage de texte et d’autres contrôles pour que vos mises en page s’adaptent à toutes les mises en page. Cette fonction ne fonctionne
qu’avec les technologies spécifiques de la visionneuse.

Il s’agit de l’image de couverture de l’eBook. Choisissez l’une des options suivantes :

Si cette option est sélectionnée, aucune image de couverture n’est ajoutée à l’eBook.

Si cette option est sélectionnée, la première page de l’eBook est pixellisée et sert à créer un fichier image
qui fera office de couverture.

Si cette option est sélectionnée, vous pouvez spécifier une image se trouvant sur votre ordinateur comme
couverture.

Sélectionnez cette option si vous souhaitez générer une table des matières en réutilisant le style sélectionné. Dans
le menu Style de table des matières, choisissez le style à utiliser pour générer la table des matières de l’eBook. Vous pouvez également choisir la
commande Page > Styles de tables des matières pour créer un style spécial pour l’eBook.

Définissez les marges supérieure, inférieure, de gauche et de droite en pixels. Pour utiliser la même valeur pour chaque marge, cliquez
sur l’icône Conserver. 

Définissez l’ordre dans lequel les éléments de la page sont exportés.

La position des éléments sur la page détermine l’ordre de lecture.
Si vous choisissez l’option D’après la mise en page, InDesign détermine l’ordre de lecture des objets de page en analysant celle-ci de
gauche à droite et de haut en bas. Dans certains cas, et spécialement dans les documents complexes comprenant plusieurs colonnes, les
éléments de conception sont susceptibles de ne pas apparaître dans l’ordre de lecture souhaité. Réorganisez et mettez en forme le
contenu à l’aide de Dreamweaver.
(Versions asiatiques uniquement) Si vous sélectionnez D’après la mise en page, InDesign détermine l’ordre de lecture des objets de la
page en fonction de la reliure du document (gauche à droite ou droite à gauche). Dans certains cas, et spécialement dans les documents
complexes comprenant plusieurs colonnes, les éléments de conception exportés sont susceptibles de ne pas apparaître dans l’ordre de
lecture souhaité. Réorganisez et mettez en forme le contenu à l’aide de Dreamweaver.

L’ordre des balises dans la vue Structure détermine l’ordre de lecture. Voir Balisage d’éléments de page.

http://help.adobe.com/fr_FR/indesign/cs/using/WSa285fff53dea4f8617383751001ea8cb3f-70aba.html


Identique au panneau Articles

Importer une note de bas de page après le paragraphe

Supprimer les sauts de ligne forcés

Puces

Nombres

Faire correspondre à une liste triée

Faire correspondre à une liste triée statique

Convertir en texte

Afficher le fichier EPUB après l’exportation

Conserver l’aspect de la mise en page

Résolution (ppp)

Taille de l’image

Alignement et espacement des images

Insérer un saut de page

Les paramètres s’appliquent aux objets ancrés

Conversion d’image

Options GIF (Palette)

L’ordre des éléments dans le panneau Articles détermine l’ordre de lecture. Seuls les articles cochés sont
exportés. Voir Inclusion d’articles pour l’exportation.

Cochez cette case pour positionner les notes de bas de page à la suite du
paragraphe. Si cette case reste désélectionnée, les notes de bas de page sont converties en notes de fin de page.

Cochez cette case pour retirer tous les retours à la ligne automatiques de l’eBook exporté.

Sélectionnez Faire correspondre à une liste non triée pour convertir les paragraphes à puces en éléments de liste, qui sont mis en forme
en HTML à l’aide de la balise <ul>. Sélectionnez Convertir en texte pour mettre en forme à l’aide de la balise <p>, avec les puces au format texte.
Si vous avez utilisé les puces automatiques InDesign natives, les puces de deuxième niveau (ou sous-puces) sont également incluses.

Détermine la façon dont les nombres sont convertis dans le fichier HTML. Si vous avez utilisé la numérotation automatique InDesign
native, les puces de deuxième niveau (ou sous-puces) sont également incluses.

Convertit les listes numérotées en éléments de liste, mis au format HTML à l’aide de la balise <ol>.

Convertit les listes numérotées en éléments de liste et affecte un attribut <value> basé sur
le numéro en cours du paragraphe dans InDesign.

Convertit les listes numérotées en paragraphes commençant par le numéro en cours du paragraphe au format texte.

Ouvre le fichier EPUB dans l’application par défaut sélectionnée pour lire ce format, si elle est
présente.

Options d’image EPUB

La section Images de la boîte de dialogue des options d’exportation EPUB contient les options suivantes. Dans le menu Conversion d’image,
déterminez comment les images sont exportées en HTML.

Cochez cette case pour réutiliser les attributs des objets d’image de la mise en page.

Choisissez la résolution des images en pixels par pouce (ppp). Tandis que les systèmes d’exploitation ont adopté une
résolution standard de 72 ppp ou 96 ppp, la résolution des terminaux mobiles varie de 132 ppp (iPad) à 172 ppp (Sony Reader), voire même plus
de 300 ppp (iPhone 4). Vous pouvez choisir une valeur ppp pour chaque objet sélectionné, parmi lesquelles 72, 96, 150 (moyenne pour tous les
lecteurs électroniques du moment) et 300.

Indiquez si l’image doit conserver une taille fixe ou être redimensionnée par rapport à la page. Si vous optez pour une taille
adaptée au format de page, une valeur relative exprimée en pourcentage est définie en fonction de la taille de l’image par rapport à la largeur de
page InDesign. Les images sont ainsi redimensionnées proportionnellement, par rapport à la largeur de la surface de lecture.

Spécifiez l’alignement de l’image à gauche, au centre et à droite, ainsi que l’espace avant et après.

Cochez cette case pour insérer des sauts de page avec les images. Vous pouvez insérer des sauts de page avant
et/ou après l’image.

Cochez cette case pour appliquer ces paramètres à tous les objets ancrés.

Choisissez GIF, JPEG ou PNG pour la conversion des images optimisées dans votre document. Choisissez Automatique
pour laisser InDesign décider quel format utiliser dans chaque instance. L’option PNG désactive les paramètres de compression d’image ; utilisez
PNG pour les images sans perte de données ou qui contiennent des objets transparents.

Cette option vous permet de contrôler la façon dont InDesign gère les couleurs lors de l’optimisation des fichiers GIF. Le

http://idiom-q-win-1/fr/indesign/urlpointers/help.adobe.com/using/WS8c5bc4f64c7a4a3d78b7a8b312dbccaf5b2-8000.html


Options JPEG (Qualité d’image)

Options JPEG (Méthode de mise en forme)

Ignorer les paramètres de conversion d’objet

Fractionner le document

Inclure les métadonnées du document

Editeur

ID unique

Options CSS

Inclure les définitions de style

Conserver les remplacements locaux

Inclure les polices incorporables

Ajouter une feuille de style

Ajouter un script

format GIF utilise une palette de couleurs limitée, qui ne doit pas contenir plus de 256 couleurs.
Choisissez Adaptative pour créer une palette utilisant un échantillon représentatif de couleurs dans l’illustration sans aucun tramage (mélange de
quelques tons de couleurs pour simuler des couleurs supplémentaires). Choisissez l’option Web pour créer une palette de couleurs Web (ces
couleurs sont un sous-ensemble des couleurs système Windows et Mac OS). Choisissez Système (Win) ou Système (Mac) pour créer une palette
utilisant la palette de couleurs intégrée de Windows ou de Mac OS. Ce choix peut donner des résultats inattendus.
Sélectionnez Entrelacement pour charger progressivement les images par remplissage des lignes manquantes. Lorsque cette option est
désélectionnée, l’image paraît floue, puis elle devient plus nette au fur à et mesure qu’elle approche de sa résolution maximale.

Permet de choisir entre une compression (et une taille de fichier réduite) et une haute qualité d’image pour
chaque image JPEG. L’option Faible génère le plus petit fichier et la qualité d’image la plus faible.

Permet de déterminer la vitesse d’affichage des images JPEG à l’ouverture du fichier contenant
l’image sur le Web. Choisissez Progressive pour que les images JPEG s’affichent graduellement avec de plus en plus de détails à mesure qu’elles
sont téléchargées. Les fichiers créés avec cette option sont légèrement plus volumineux et utilisent davantage de RAM à l’affichage. Choisissez
Ligne de base pour que le fichier JPEG s’affiche uniquement après qu’il a été téléchargé ; une marque de réservation apparaît à la place de
l’image avant son affichage.

Cette option permet de passer outre les options d’exportation d’objet appliquées individuellement
aux images. Voir Application d’options d’exportation d’objet.

Options avancées EPUB

La section Contenu de la boîte de dialogue Options d’exportation EPUB comprend les options suivantes :

Vous pouvez scinder l’eBook selon le style de paragraphe spécifié. Ce fractionnement a pour effet d’accroître le
nombre de fichiers HTML dans l’assemblage d’EPUB. Il peut toutefois s’avérer utile, notamment pour scinder des fichiers longs et améliorer les
performances des lecteurs EPUB.

Les métadonnées du document (ou le document de source des styles si un livre a été sélectionné) sont
incluses dans le fichier exporté.

Spécifiez les détails concernant l’éditeur qui doivent figurer dans les métadonnées eBook. Vous pouvez indiquer l’URL du
site Web de l’éditeur afin que le destinataire de l’eBook puisse s’y référer.

Chaque document EPUB doit comporter un identifiant unique. Un identifiant unique est créé automatiquement et s’affiche.
Vous pouvez le supprimer et spécifier un identificateur unique.

Les feuilles de style CSS (Cascading Style Sheets) regroupent des règles de mise en forme qui définissent l’apparence du contenu
dans une page Web. Lorsque vous utilisez des CSS pour mettre en forme une page, vous séparez le contenu de sa présentation.

Lors de l’exportation au format EPUB, vous pouvez créer une liste de styles CSS modifiables.

Lorsque cette option est sélectionnée, la mise en forme locale (style italique ou gras, par
exemple) est incluse.

Cette option permet d’inclure toutes les polices qui sont incorporables, dans l’eBook. Les polices
contiennent des bits d’incorporation qui déterminent s’il est possible de les incorporer.

Spécifiez l’URL de la feuille de style CSS existante, qui est généralement une URL relative, telle que
« /styles/style.css ». InDesign ne vérifie ni l’existence ni la validité de la feuille de style CSS. Il est donc recommandé de confirmer la
définition de la feuille de style CSS.

Indiquez l’URL d’un JavaScript existant. InDesign ne vérifie ni l’existence ni la validité du JavaScript. Il est donc recommandé
de confirmer la configuration de votre JavaScript.

http://help.adobe.com/fr_FR/InDesign/CS5/Using/WS8c5bc4f64c7a4a3d-7cbbfcee12dbd4ad69f-7fff.html
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Ressources EPUB

Les liens suivants vous permettront d’en savoir plus le format EPUB.

Pour plus d’informations sur la spécification EPUB, consultez le site www.idpf.org.

Téléchargez une version gratuite de Digital Editions Reader sur le site www.adobe.com/fr/products/digitaleditions.

Consultez le blog Digital Editions pour plus d’informations sur Digital Editions.

Pour plus d’informations sur l’exportation vers Kindle, consultez le livre blanc sur l’exportation d’InDesign vers Kindle (PDF).

Découvrez comment convertir vos fichiers InDesign au format EPUB et commencez à vendre vos eBooks pour l’iPad d’Apple.
Consultez le livre blanc sur la conversion d’InDesign vers iPad.
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Eléments exportés

Eléments non exportés

Exporter

Ordre du contenu / Ordre

L’exportation au format HTML constitue un moyen simple de mettre en forme votre contenu InDesign pour le Web. Lorsque vous exportez du
contenu au format HTML, vous pouvez contrôler la manière dont le texte et les images sont exportés. InDesign conserve les noms des styles de
paragraphe, caractère, objet, tableau et cellule appliqués aux contenus exportés en marquant les contenus HTML avec les classes de styles CSS
du même nom. Grâce à Adobe Dreamweaver ou tout autre éditeur HTML compatible avec les feuilles de style en cascade (CSS), vous pouvez
sans difficulté appliquer des mises en forme et des mises en page aux contenus.

InDesign exporte tous les articles, les graphiques liés et incorporés, les séquences vidéo SWF, les notes de bas de page, les
variables de texte (au format texte), les listes à puces et numérotées, les références croisées internes, ainsi que les hyperliens renvoyant à du
texte ou à des pages Web. Les tableaux sont également exportés ; toutefois, certaines mises en forme, telles que les contours de tableau et de
cellule, ne le sont pas. Des identifiants uniques sont attribués aux tableaux afin que ces derniers puissent être référencés comme jeux de
données Spry dans Dreamweaver. Les fichiers audio et vidéo h.264 importés sont placés à l’intérieur de balises HTML5 <audio> et <video>.

InDesign n’exporte pas les objets que vous avez dessinés (rectangles, ellipses et polygones), les hyperliens (à part les
liens renvoyant à des pages Web et ceux appliqués à du texte renvoyant à des points d’ancrage de texte au sein du même document), les objets
collés (notamment les images copiées d’Illustrator), le texte vectorisé, les balises XML, les livres, les signets, les glyphlets SING, les transitions de
page, les marques d’index, les objets de la table de montage qui ne sont pas sélectionnés et qui ne touchent pas la page ni les éléments du
gabarit (sauf s’ils ont été remplacés ou sélectionnés avant l’exportation).

1. Si vous n’exportez pas le document dans sa totalité, sélectionnez les blocs de texte, les plages de texte, les cellules de
tableau ou les graphiques que vous voulez exporter.

2. Choisissez Fichier > Exporter, puis sélectionnez HTML dans le menu Type.

3. Spécifiez le nom et l’emplacement du document HTML, puis cliquez sur le bouton Enregistrer.

4. Dans la boîte de dialogue Options d’exportation HTML, spécifiez les options désirées dans les zones Général, Image et
Avancé, puis cliquez sur le bouton OK.

Un document portant le nom spécifié et une extension .html (« bulletin.html », par exemple) est créé ; le cas échéant, un sous-dossier d’images
Web (« images-bulletins-Web ») est enregistré au même endroit.

Options d’exportation HTML

Dans la boîte de dialogue HTML, spécifiez les options suivantes.

Options générales

La zone Général contient les options suivantes.

Vous pouvez choisir d’exporter le document entier ou seulement certains éléments sélectionnés. Si un bloc de texte est sélectionné, la
totalité de l’article (y compris l’éventuel texte en excès) est exportée.
Si le document est sélectionné, tous les éléments de page de toutes les planches sont exportés, sauf les éléments de gabarit qui n’ont pas été
substitués et les éléments de page sur des calques invisibles. Les balises XML, ainsi que les index et tables des matières générés sont également
ignorés.

Vous pouvez spécifier l’ordre de lecture des objets de la page.
D’après la mise en page
La position des éléments sur la page détermine l’ordre de lecture.
Si vous choisissez l’option D’après la mise en page, InDesign détermine l’ordre de lecture des objets de page en analysant celle-ci de
gauche à droite et de haut en bas. Dans certains cas, et spécialement dans les documents complexes comprenant plusieurs colonnes, les



Marge

Puces

Nombres

Faire correspondre à une liste triée

Faire correspondre à une liste triée statique

Convertir en texte

Afficher le fichier HTML après l’exportation

Copier les images

Original

Optimisées

Lier au chemin du serveur

Conserver l’aspect de la mise en page

Résolution (ppp)

éléments de conception sont susceptibles de ne pas apparaître dans l’ordre de lecture souhaité. Réorganisez et mettez en forme le contenu
à l’aide de Dreamweaver.
(versions asiatiques seulement) Si vous choisissez l’option D’après la mise en page, InDesign détermine l’ordre de lecture des objets de
page en fonction de la liaison du document (de gauche à droite ou de droite à gauche). Dans certains cas, et spécialement dans les
documents complexes comprenant plusieurs colonnes, les éléments de conception exportés sont susceptibles de ne pas apparaître dans
l’ordre de lecture souhaité. Réorganisez et mettez en forme le contenu à l’aide de Dreamweaver.
Identique à la structure XML
Si vous choisissez l’option Identique à la structure XML, l’ordre du contenu exporté, ainsi que les éléments exportés, sont gérés au moyen
du panneau Structure XML. Si le contenu est déjà balisé, il vous suffit de faire glisser les balises dans le panneau Structure XML pour
définir l’ordre d’exportation XHTML. Dans le cas d’un contenu sans balises, vous pouvez choisir la commande Ajouter les éléments sans
balise dans le menu du panneau Structure afin de générer des balises que vous pourrez ensuite réorganiser. Si vous voulez exclure un
élément de l’exportation, il vous suffit de supprimer la balise correspondante dans le panneau Structure XML. (La suppression d’une balise
n’entraîne pas la suppression du contenu du fichier INDD.) Voir Balisage d’éléments de page.
Identique au panneau Articles
L’ordre des éléments dans le panneau Articles détermine l’ordre de lecture. Seuls les articles cochés sont exportés. Voir Inclusion d’articles
pour l’exportation.

Définissez une marge simple en ems ou en pixels. Les marges exprimées en ems sont particulièrement indiquées pour la compatibilité
multiécran. La même valeur est appliquée à toutes les marges : supérieure, inférieure, gauche et droite.

Sélectionnez Faire correspondre à une liste non triée pour convertir les paragraphes à puces en éléments de liste, qui sont mis en forme
en HTML à l’aide de la balise <ul>. Sélectionnez Convertir en texte pour mettre en forme à l’aide de la balise <p>, avec les puces au format texte.
Si vous avez utilisé les puces automatiques InDesign natives, les puces de deuxième niveau (ou sous-puces) sont également incluses.

Détermine la façon dont les nombres sont convertis dans le fichier HTML. Si vous avez utilisé la numérotation automatique InDesign
native, les puces de deuxième niveau (ou sous-puces) sont également incluses.

Convertit les listes numérotées en éléments de liste, mis au format HTML à l’aide de la balise <ol>.

Convertit les listes numérotées en éléments de liste et affecte un attribut <value> basé sur
le numéro en cours du paragraphe dans InDesign.

Convertit les listes numérotées en paragraphes commençant par le numéro en cours du paragraphe au format texte.

Démarre le navigateur, si celui-ci est présent.

Options d’image

Spécifie la manière dont les images sont exportées au format HTML.

Exporte l’image d’origine vers le sous-dossier « <nom_document>-web-images ». Lorsque cette option est sélectionnée, toutes
les autres options sont grisées.

Vous permet de modifier les paramètres pour déterminer comment l’image est exportée.

Plutôt que d’exporter des images vers un sous-dossier, cette option vous permet de saisir une URL locale
(telle que « images/ ») qui apparaît devant le fichier image. Dans le code HTML, l’attribut de lien affiche le chemin et l’extension que vous
avez spécifiés. Cette option est particulièrement efficace lorsque vous convertissez vous-même des images en images compatibles Web.

Cochez cette case pour réutiliser les attributs des objets d’image de la mise en page.

Spécifiez la résolution des images en pixels par pouce (ppp). Tandis que les systèmes d’exploitation ont adopté une résolution
standard de 72 ppp ou 96 ppp, la résolution des terminaux mobiles varie de 132 ppp (iPad) à 172 ppp (Sony Reader), voire même plus de
300 ppp (iPhone 4). Vous pouvez spécifier une valeur exprimée en ppp pour chaque objet sélectionné, parmi lesquelles 72, 96, 150 (moyenne
pour tous les lecteurs électroniques du moment) et 300.

http://help.adobe.com/fr_FR/InDesign/CS5/Using/WSB747587E-C65A-471e-BAE2-755698BE6351a.html
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Taille de l’image

Alignement et espacement des images

Les paramètres s’appliquent aux objets ancrés

Conversion d’image

Options GIF (Palette)

Options JPEG (Qualité d’image)

Options JPEG (Méthode de mise en forme)

Ignorer les paramètres de conversion d’objet

Options CSS

CSS incorporées

Sans CSS

CSS externe (CS5.5)

Indiquez si l’image doit conserver une taille fixe ou être redimensionnée par rapport à la page. Si vous optez pour une taille
adaptée au format de page, une valeur relative exprimée en pourcentage est définie en fonction de la taille de l’image par rapport à la largeur de
page InDesign. Les images sont ainsi redimensionnées proportionnellement, par rapport à la largeur de la surface de lecture.

Spécifiez l’alignement de l’image à gauche, au centre et à droite, ainsi que l’espace avant et après.

Cochez cette case pour appliquer ces paramètres à tous les objets ancrés.

Choisissez GIF, JPEG ou PNG pour la conversion des images optimisées dans votre document. Choisissez Automatique
pour laisser InDesign décider quel format utiliser dans chaque instance. L’option PNG désactive les paramètres de compression de l’image.
L’option PNG convient aux images sans perte de données et aux images contenant des objets transparents.

Cette option vous permet de contrôler la façon dont InDesign gère les couleurs lors de l’optimisation des fichiers GIF. Le
format GIF utilise une palette de couleurs limitée, qui ne doit pas contenir plus de 256 couleurs.
Choisissez Adaptative pour créer une palette utilisant un échantillon représentatif de couleurs dans l’illustration sans aucun tramage (mélange de
quelques tons de couleurs pour simuler des couleurs supplémentaires). Choisissez l’option Web pour créer une palette de couleurs Web (ces
couleurs sont un sous-ensemble des couleurs système Windows et Mac OS). Choisissez Système (Win) ou Système (Mac) pour créer une palette
utilisant la palette de couleurs intégrée de Windows ou de Mac OS. Ce choix peut donner des résultats inattendus.
Sélectionnez Entrelacement pour charger progressivement les images par remplissage des lignes manquantes. Lorsque cette option est
désélectionnée, l’image paraît floue, puis elle devient plus nette au fur à et mesure qu’elle approche de sa résolution maximale.

Permet de choisir entre une compression (et une taille de fichier réduite) et une haute qualité d’image pour
chaque image JPEG. L’option Faible génère le plus petit fichier et la qualité d’image la plus faible.

Permet de déterminer la vitesse d’affichage des images JPEG à l’ouverture du fichier contenant
l’image sur le Web. Choisissez Progressive pour que les images JPEG s’affichent graduellement avec de plus en plus de détails à mesure qu’elles
sont téléchargées. Les fichiers créés avec cette option sont légèrement plus volumineux et utilisent davantage de RAM à l’affichage. Choisissez
Ligne de base pour que le fichier JPEG s’affiche une fois téléchargé seulement ; une marque de réservation apparaît à la place de l’image avant
son affichage.

Cette option permet de passer outre les options d’exportation d’objet appliquées individuellement
aux images. Voir Application d’options d’exportation d’objet.

Options avancées

Utilisez la zone Avancé pour définir des options de feuille de style CSS et JavaScript.

Les feuilles de style CSS (Cascading Style Sheets) regroupent des règles de mise en forme qui définissent l’apparence du contenu
dans une page Web. Lorsque vous utilisez CSS pour mettre en forme une page, vous séparez le contenu de sa présentation. Le contenu de votre
page (c’est-à-dire le code HTML) réside dans le fichier HTML, tandis que les règles CSS définissant la présentation du code résident dans un
autre fichier (fichier CSS externe) ou dans le document HTML (généralement dans la section de titre). Par exemple, vous pouvez spécifier
différentes tailles de polices pour le texte sélectionné et vous pouvez utiliser CSS pour contrôler la mise en forme et le positionnement des
éléments de niveau bloc dans une page Web.

Lorsque vous exportez au format XHTML, vous pouvez créer une liste de styles CSS apparaissant dans la section de
titre du fichier HTML avec des déclarations (attributs).
Si l’option Inclure les définitions de style est sélectionnée, InDesign tente de faire correspondre les attributs de mise en forme de texte
InDesign à leurs équivalents CSS. Si cette option est désélectionnée, le fichier HTML comporte des déclarations vides. Vous pouvez
modifier ces déclarations ultérieurement dans Dreamweaver.
Si l’option Conserver les remplacements locaux est sélectionnée, la mise en forme locale (italique ou gras, par exemple) est incluse.

Cette option permet d’omettre la section CSS dans un fichier HTML.

Spécifiez l’URL de la feuille de style CSS existante, qui est généralement une URL relative, telle que
« /styles/style.css ». InDesign ne vérifie ni l’existence ni la validité de la feuille de style CSS. Il est donc recommandé d’utiliser
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Autres CSS (CS6 )

Options JavaScript

Dreamweaver pour confirmer la définition d’une feuille de style CSS externe.

Spécifiez la CSS à l’aide du bouton Ajouter une feuille de style.

Sélectionnez Lier au JavaScript externe pour exécuter un script JavaScript lorsque la page HTML est ouverte. Spécifiez
l’URL du script JavaScript, qui est généralement une URL parente. InDesign ne vérifie ni l’existence ni la validité du script JavaScript.
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Exportation de contenu XML

Haut de la page

Exportation d’un document au format XML
Options d’exportation des images optimisées
Enregistrement des balises uniquement au format XML
Modification d’un fichier XML exporté

Exportation d’un document au format XML
Avant de pouvoir exporter du contenu d’un document InDesign au format XML, vous devez effectuer les opérations suivantes :

Création ou chargement de balises d’élément

Application de balises aux éléments des pages du document

Ajustement de la hiérarchie des éléments balisés dans le volet Structure, si nécessaire

Vous pouvez exporter tout ou partie du contenu XML dans votre document. Seul le contenu balisé peut être exporté.

Important : si vous exportez un document contenant des tableaux, vous devez baliser les tableaux. Autrement, InDesign ne les exporte pas.
1. Si vous ne souhaitez exporter qu’une partie du document, sélectionnez l’élément dans le volet Structure à partir duquel

commencer l’exportation.
2. Choisissez Fichier > Exporter.
3. Dans Type (Windows) ou Format (Mac OS), choisissez XML.
4. Spécifiez un nom et un emplacement pour le fichier XML, puis cliquez sur Enregistrer.
5. Dans l’onglet Général de la boîte de dialogue Exportation XML, choisissez l’une des options suivantes :

Inclure la déclaration DTD Exporte les références au fichier DTD avec le fichier XML. Cette option est disponible uniquement
si un élément DOCTYPE est présent dans le volet Structure.

Afficher XML avec Ouvre le fichier exporté dans un navigateur, un éditeur XML ou un éditeur de texte. Choisissez un
navigateur ou une application dans la liste.

Exporter depuis l’élément sélectionné Lance l’exportation depuis l’élément sélectionné dans le volet Structure. Cette option
est disponible uniquement si vous avez sélectionné un élément avant de choisir Fichier > Exporter.

Exporter des tableaux non balisés en tant que CALS XML Exporte les tableaux non balisés au format CALS XML. Un
tableau doit se trouver dans un bloc balisé et ne comporter aucune balise pour pouvoir être exporté.

Réassocier saut, espace et caractères spéciaux Exporte les sauts, les espaces et les caractères spéciaux comme entités
de caractère décimal plutôt que comme caractères droits.

Appliquer XSLT Applique une feuille de style afin de définir la transformation du contenu XML exporté, par exemple une
arborescence XML modifiée ou un fichier HTML. Sélectionnez Parcourir (Windows) ou Choisir (Mac OS) pour sélectionner un
fichier XSLT dans le système de fichiers. L’option par défaut, Utiliser la feuille de style XML, utilise une instruction de
transformation XSLT s’il en existe une dans le fichier XML appliqué lors de l’exportation.

6. Dans le menu Codage, choisissez un type de codage.
7. Pour définir les options d’exportation pour les images, cliquez sur l’onglet Images, puis sélectionnez une ou plusieurs des

options suivantes :
Images originales Place une copie des fichiers d’images d’origine dans un sous-dossier Images.

Images originales optimisées Optimise et compresse les fichiers d’images originales et place leurs copies dans un sous-
dossier Images.

Images optimisées mises en forme Optimise les fichiers d’images d’origine contenant une transformation appliquée (comme
une rotation ou une mise à l’échelle) et les place dans un sous-dossier Images. Par exemple, si le document contient deux
images, une recadrée et une normale, seule l’image recadrée sera optimisée et copiée dans le sous-dossier Images.

8. Si vous avez sélectionné Images originales optimisées ou Images optimisées mises en forme à l’étape précédente, choisissez
les options d’optimisation des images.

9. Cliquez sur Exporter.

Remarque : tous les caractères spéciaux ne sont pas pris en charge dans XML (par exemple, le caractère de numéro de page automatique).
InDesign vous avertit si un caractère ne peut pas être inclus dans le fichier XML exporté. Cet avertissement apparaît également si vous n’avez
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pas balisé un tableau.

Options d’exportation des images optimisées
Les options suivantes sont disponibles lorsque vous choisissez la commande Images originales optimisées ou Images optimisées mises en forme
dans l’onglet Images de la boîte de dialogue Exportation XML :

Conversion des images Précise le format de fichier à utiliser pour l’image convertie. Si vous choisissez Automatique, InDesign choisit le type de
fichier le mieux adapté à l’image. Vous pouvez choisir Options GIF et Options JPEG.
Options GIF Indiquez la mise en forme des images converties au format GIF lorsque vous les exportez au format XML. Vous pouvez définir les
options suivantes :
Palette  Indique le panneau Couleurs s’appliquant à l’image lors de la conversion. Choisissez le panneau pour le format d’affichage final du
contenu XML. L’option Adaptative (sans simulation) fonctionne bien pour les images ayant des couleurs principalement pleines et peut être utilisée
lorsque le résultat final sera exporté sous plusieurs formats.
Entrelacement  Télécharge une ligne sur deux à chaque passage, au lieu de télécharger l’image en entier en un seul passage. L’entrelacement
vous permet de télécharger rapidement un aperçu de l’image : chaque passage ajoute de la résolution jusqu’à ce que la qualité finale soit
obtenue.
Options JPEG Indiquez la mise en forme des images converties au format JPEG lorsque vous les exportez au format XML. Vous pouvez définir
les options suivantes :
Qualité d’image  Indique la qualité de l’image convertie. Plus la qualité est bonne, plus le fichier est volumineux et plus le téléchargement est
long.
Méthode de mise en forme  Indique la manière dont l’image JPEG est mise en forme pour le téléchargement. L’option Ligne de base télécharge
l’image de qualité finale en un seul passage pour que le fichier s’affiche directement à sa qualité finale. Cette mise en forme peut être plus longue
à télécharger qu’une image mise en forme progressivement. L’option Progressive télécharge l’image au cours d’une série de passage. Le premier
passage se fait à basse résolution, et la résolution augmente à chaque passage jusqu’à ce que la qualité finale soit obtenue.

Enregistrement des balises uniquement au format XML
Enregistre uniquement les balises pour vous permettre de les charger et de les utiliser dans un document InDesign.

1. Dans le menu du panneau Balises, choisissez Enregistrer les balises.
2. Indiquez un nom et un emplacement, puis cliquez sur Enregistrer.

Les balises contenues dans le document, ainsi que leur couleur respective, sont enregistrées dans un fichier au format XML.

Modification d’un fichier XML exporté
Utilisez l’une des méthodes suivantes pour modifier un fichier XML créé et exporté avec InDesign.

Pour effectuer les modifications directement dans le fichier XML, ouvrez le fichier dans un éditeur de texte ou XML.
Pour effectuer les modifications dans le document source, ouvrez le fichier InDesign à partir duquel le contenu XML a été
exporté. Après avoir modifié le contenu dans InDesign, vous pouvez le réexporter au format XML. Spécifiez le nom du fichier
d’origine si vous souhaitez remplacer ce fichier.

Voir aussi
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Impression

Impression de livrets avec votre imprimante de bureau
Jeff Witchel  (15 octobre 2012)
Didacticiel - vidéo
Découvrez comment créer un livret et l’imprimer sur votre imprimante de bureau

Guide d’impression Adobe Creative Suite 5/5.5 (PDF, 21 Mo)
Référence  (01er janvier 2011)
Téléchargez ce guide pour savoir comment configurer des documents Adobe pour l’impression. Toutes les informations dont vous avez besoin
pour l’impression professionnelle à un seul endroit.
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Impression de cahiers
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Remarque :

Remarque :

Imposition d’un document pour l’impression de livrets
Utilisation de la compensation
Aperçu ou affichage d’une synthèse d’impression de cahier
Résolution des problèmes d’impression de cahiers

Imposition d’un document pour l’impression de livrets

La fonction Imprimer le cahier vous permet de créer des planches d’imprimante destinées à une impression professionnelle. Ainsi, si vous éditez
une brochure de 8 pages, les pages apparaissent en ordre séquentiel dans la fenêtre de mise en page. Toutefois, sur des planches d’imprimante,
la page 2 peut se trouver à côté de la page 7 pour que, une fois le document imprimé, plié et assemblé, les pages se trouvent dans le bon ordre.

Les pages apparaissent en séquence dans la fenêtre de mise en page, mais sont imprimées dans un ordre différent. Dans le document final relié,
elles apparaîtront dans l’ordre.

Le processus de création de planches d’imprimante à partir de planches de présentation s’appelle l’imposition. Lors de l’imposition de pages, vous
pouvez modifier les paramètres pour ajuster l’espacement entre les pages, les marges, le fond perdu et la compensation. La mise en page du
document InDesign ne change pas, l’imposition étant entièrement traitée lors de l’impression. Aucune page n’est réorganisée ni pivotée dans le
document.

Jeff Witchel d’Infiniteskills.com explique comment imprimer des brochures avec votre imprimante de bureau.

vous ne pouvez pas créer un document basé sur les pages imposées. De plus, si le document comporte des pages de différents
formats, vous ne pouvez pas utiliser l’option Imprimer le cahier pour procéder à son imposition.

1. Choisissez Fichier > Imprimer le cahier.

2. Si les paramètres prédéfinis d’impression vous conviennent, choisissez-les dans le menu Impression prédéfinie.

Pour utiliser les paramètres d’impression (tels qu’ils apparaissent dans la boîte de dialogue d’impression) du document actuel,
choisissez l’option Paramètres du document actuel dans le menu Impression prédéfinie.

3. Si vous ne voulez pas imposer l’intégralité du document, activez l’option Etendue dans la zone Format et spécifiez les pages à
inclure dans l’imposition.

Séparez les pages consécutives par un tiret et les pages non consécutives par des virgules. Par exemple, si vous saisissez
3-7, 16, les pages 3 à 7 et 16 sont imposées.

si vous avez divisé le document en sections, entrez les numéros des pages de la section (par exemple Sec2:11)
dans la zone Groupe.

4. Pour modifier des paramètres tels que les repères de l’imprimante et la sortie couleur, cliquez sur Paramètres d’impression. A
l’aide des options proposées à gauche, modifiez les paramètres, puis cliquez sur OK.

5. Dans la boîte de dialogue Imprimer le cahier, définissez si besoin d’autres options de paramétrage de livret, puis cliquez

http://www.infiniteskills.com/demos/movie-player.php?h=565&w=970&sku=01710&movie=http://infiniteskills.bc.cdn.bitgravity.com/iskills-media/indesigncs6-demo/1505.mp4


Remarque :

2-haut piqûre à cheval

2-haut reliure sans couture

sur Imprimer.

dans un cahier, le nombre de pages est toujours un multiple de 4. Si vous imprimez sur une imprimante PDF, les pages vides sont
insérées dans le fichier PDF pour créer le cahier.

Types de cahier

Vous pouvez choisir parmi trois types d’imposition : 2-haut piqûre à cheval, 2-haut reliure sans couture et Consécutif.

Crée des planches d’imprimante (deux pages côte-à-côte). Ce type de planche peut être utilisé pour l’impression en
recto-verso, l’assemblage de pages, le pliage et l’agrafage. InDesign ajoute des planches blanches si nécessaire à la fin du document fini. Les
options Espace entre les pages, Fond perdu entre les pages et Format de signature sont grisées lorsque l’option 2-haut piqûre à cheval est
activée.
La fonction Imprimer le cahier impose la configuration des pages en fonction du paramètre Reliure. Si le paramètre de reliure du document est
défini de droite à gauche, la fonction Imprimer le cahier impose la configuration des pages en conséquence. Choisissez Fichier > Format de
document pour afficher le paramètre de reliure du document.

Création d’un bulletin de 24 pages en noir et blanc en utilisant le style 2-haut piqûre à cheval, avec 12 planches.

Crée des planches d’imprimante (deux pages côte-à-côté) entrant dans le format de signature spécifiée. Ce type de
planche peut être utilisé pour l’impression en recto-verso, le découpage et la reliure sur une couverture collée. Si le nombre de pages à imposer
n’est pas divisible par la taille de la signature, InDesign ajoute des pages blanches au document fini.

2-haut reliure sans couture divisé en quatre signatures



Consécutif

Espace entre les pages

Si une brochure a une couverture en couleurs et l’intérieur en noir et blanc, vous pouvez créer deux impositions différentes à partir du même
document, une pour la couverture, la seconde de couverture, la troisième de couverture et la quatrième de couverture, et une pour les 24 pages
intérieures. Pour produire la signature en couleurs, cliquez sur Etendue dans la zone Pages de la section Format, et entrez 1-2, 27-28 ou
n’importe quels autres numéros de pages de section. Pour produire l’intérieur en noir et blanc, entrez 3-26 dans la zone de texte Etendue.

Brochure de 28 pages avec couverture en couleurs

A. Signature en couleurs pour la couverture B. Page intérieure en noir et blanc 

Crée un panneau de deux, trois ou quatre pages pouvant être utilisé pour créer une brochure ou un livret. Les options Fond perdu
entre les pages, Compensation et Format de signature sont grisées lorsqu’une option Consécutif est activée.
Ainsi, pour créer des planches pour une brochure traditionnelle à trois pliures composée de six panneaux, choisissez l’option 3-haut Consécutif.
Peut-être avez-vous l’habitude de créer des documents à trois pliures avec trois colonnes. Avec l’imposition d’InDesign, vous pouvez tout
simplement créer des pages au format de chaque panneau.

3-haut consécutif

Options d’espacement, de fond et de marge pour l’impression de cahiers

Vous pouvez modifier les options de la zone Format de la boîte de dialogue Imprimer le cahier.

Spécifie l’espace entre les pages (entre le côté droit de la page de gauche et le côté gauche de la page de droite). Vous



Fond perdu entre les pages

Compensation

Format de signature

Ajuster automatiquement aux repères et fonds perdus

Marges

Imprimer les planches blanches

Haut de la page
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pouvez définir une valeur d’espace entre les pages pour tous les types de cahier à l’exception du type Piqûre à cheval.
Pour les documents à reliure sans couture, si vous définissez une compensation (avec une valeur négative), l’espace minimal entre les pages
correspond à la valeur de la compensation. Si vous créez des signatures manuellement (par exemple s’il y a différents stocks dans le même
document), vous pouvez entrer une valeur d’espace entre les pages pour spécifier une compensation de départ pour les planches avec
différentes signatures.

Spécifie l’espace utilisé pour permettre aux éléments de la page d’empiéter sur l’espace dans les planches à reliure
sans couture. Cette option est parfois appelée croisement. Ce champ accepte des valeurs comprises entre 0 et la moitié de la valeur d’espace
entre les pages. Vous pouvez définir cette option uniquement lorsque le type 2-haut reliure sans couture est sélectionné.

Spécifie l’espace nécessaire pour prendre en charge l’épaisseur du papier et le pliage sur chaque signature. La plupart du temps,
vous devrez spécifier une valeur négative pour créer un effet de décalage vers l’avant. Vous pouvez définir une valeur de compensation pour les
types de cahier 2-haut piqûre à cheval et 2-haut reliure sans couture (voir Utilisation de la compensation).

Spécifie le nombre de pages de chaque signature des documents 2-haut reliure sans couture. Si le nombre de pages à
imposer n’est pas divisible par la valeur du format de la signature, des pages blanches sont ajoutées à la fin du document.

InDesign calcule la valeur des marges de manière à prendre en charge le fond perdu
et les autres options de repères d’imprimante définies. Les champs situés sous Marges sont grisés lorsque cette option est activée, mais ils
reprennent les valeurs qui seront utilisées pour prendre en charge les repères et fons perdus. Si vous désactivez cette option, vous pouvez ajuster
manuellement les valeurs des marges.

Spécifie l’espace laissé autour de la planche d’imprimante après rognage. Pour définir des valeurs individuelles pour les marges du haut,
du bas, de gauche ou de droite, désactivez l’option Ajuster automatiquement aux repères et fonds perdus, puis augmentez les valeurs pour inclure
de l’espace supplémentaire au-delà des repères et fonds perdus par défaut (le fait de réduire ces valeurs peut rogner les repères et fonds perdus).
Vous pouvez définir des valeurs de marges pour tous les types d’impression de cahier.

Si le nombre de pages à imposer n’est pas divisible par la valeur du format de la signature, des pages ou
planches blanches sont ajoutées à la fin du document. Cette option vous permet de choisir d’imprimer ou non ces planches blanches à la fin du
document. L’option Imprimer les pages vides de la boîte de dialogue d’impression contrôle l’impression d’autres pages blanches du document.

Utilisation de la compensation

L’option Compensation définit la distance dont les pages s’écartent de la reliure afin de prendre en compte l’épaisseur du papier et le pliage pour
les documents à piqûre à cheval et à reliure sans couture. InDesign considère la couverture du document final comme la planche extérieure, alors
que les pages centrales sont considérées comme planche du milieu. Le terme feuille représente deux planches : le recto et le verso de la feuille.
L’incrément de compensation est calculé en divisant la valeur de la compensation spécifiée par le nombre total de feuilles, moins une.

Lorsque vous indiquez une valeur positive de compensation, les pages centrales ne sont pas ajustées, mais les pages sur les feuilles extérieures
s’écartent du dos. Lorsque vous définissez une compensation négative, la couverture n’est pas ajustée, mais les pages sur les feuilles intérieures
se rapprochent du dos.

Par exemple, un document InDesign de 16 pages peut compter huit planches, ou quatre feuilles. Le recto de la première feuille constituera la
première planche (pages 16 et 1), tandis que le verso contiendra la seconde planche (pages 2 et 15).

Si dans cet exemple la valeur de compensation est de 24 points (valeur exagérée par souci de clarté), l’incrément de compensation sera
de 8 points par feuille (24 divisé par 3). La compensation appliquée à la feuille interne sera de 24 points, la compensation appliquée à la troisième
feuille sera de 16 points et la compensation appliquée à la deuxième feuille sera de 8 points. Aucune compensation ne sera appliquée à la
première feuille externe.

Pour chaque feuille successive, la compensation sera diminuée de l’incrément de compensation. Pour résumer, chaque page de la feuille
intérieure est déplacée de 12 points (la moitié de la valeur de compensation de 24 points pour cette feuille) par rapport à la reliure, chaque page
de la troisième feuille est déplacée de 8 points (la moitié de la valeur de compensation de 16 points de cette feuille) par rapport à la reliure, et
chaque page de la deuxième feuille est déplacée de 4 points (la moitié de la valeur de compensation de 8 points pour cette feuille) par rapport à la
reliure.

Aperçu ou affichage d’une synthèse d’impression de cahier
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Impossible de créer un document

Les pages blanches ne sont pas incluses

Impression de pages recto verso sans imprimante recto verso

La zone Aperçu de la boîte de dialogue Imprimer le cahier permet d’afficher des vignettes en couleurs des planches créées par le style
d’imposition choisi. Vous pouvez consulter également les repères d’impression que vous avez définis dans la boîte de dialogue d’impression.

1. Choisissez Fichier > Imprimer le cahier.

2. Utilisez l’une des méthodes suivantes :

Cliquez sur Aperçu dans la partie gauche de la boîte de dialogue. Pour faire défiler les planches, cliquez sur les flèches de
défilement. Cliquez sur la flèche de défilement vers la gauche pour réafficher les planches précédentes. Vous pouvez
également faire glisser la boîte de défilement pour changer les planches.

Cliquez sur Synthèse dans la partie gauche de la boîte de dialogue Imprimer le cahier pour consulter un résumé des
paramètres du livret actuel. Les informations sur des conflits éventuels entre des paramètres s’affichent au bas de la
zone Synthèse.

Si vous cliquez sur Paramètres d’impression et que vous modifiez les paramètres dans la boîte de dialogue d’impression, vous pouvez
observer l’effet des modifications dans la zone d’aperçu.

Résolution des problèmes d’impression de cahiers

Vous serez peut-être confronté aux problèmes suivants lors de l’impression de cahiers.

Malheureusement, il est impossible de créer un nouveau document InDesign avec les pages imposées. Vous
pouvez imprimer le document imposé ou créer un document au format PDF.

Vous pouvez ajouter des pages blanches au milieu d’un document pour vous assurer qu’il y aura
assez de pages pour chaque planche. Néanmoins, si ces pages ne contiennent ni texte ni objets, il se peut qu’elles ne soient pas reconnues,
auquel cas des pages blanches supplémentaires seront ajoutées à la fin du document. Pour vous assurer que les pages blanches que vous avez
ajoutées seront incluses dans le document imposé, cliquez sur l’option Paramètres d’impression dans la boîte de dialogue Imprimer le cahier, puis
sélectionnez l’option Imprimer les pages vides et cliquez sur le bouton OK.

Utilisez les options Pages impaires et Pages paires dans Adobe Acrobat
ou InDesign. Après avoir imprimé un jeu de pages, retournez ces dernières, chargez-les dans l’imprimante, puis imprimez les autres pages. Pour
obtenir de meilleurs résultats, imprimez un document test afin de vérifier le sens et l’ordre d’insertion des pages dans l’imprimante.

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
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Impression de vignettes
Impression de documents grand format
Juxtaposition d’un document
Mise à l’échelle de documents

Pour plus d’informations et d’instructions, cliquez sur les liens ci-dessous.

Impression de vignettes
Pour faire tenir plusieurs pages sur une seule page, créez des vignettes (petites versions de prévisualisation de votre document) que vous pouvez
utiliser pour vérifier le contenu et la présentation. Si nécessaire, InDesign modifie automatiquement l’orientation du papier afin d’ajuster au mieux la
page au papier. Cependant, vous devrez réinitialiser l’orientation d’origine si vous désélectionnez l’option Vignettes.

Remarque : lorsque vous imprimez des vignettes, les repères d’impression et autres éléments des zones de fond perdu ou de ligne-bloc sont
exclus.

1. Dans la zone Format de la boîte de dialogue Imprimer, sélectionnez Vignettes.
2. Dans le menu, choisissez le nombre de vignettes par page.

Impression de documents grand format
Les documents créés dans InDesign peuvent atteindre des dimensions de 5 mètres de côté ; or, la plupart des imprimantes de bureau ne peuvent
pas imprimer des pages d’une telle dimension.

Pour imprimer un document de grande taille sur une imprimante de bureau, vous devez imprimer les éléments (ou mosaïques) de chacune des
pages du document un par un, puis les rogner et les réassembler. Vous pouvez également mettre à l’échelle le document pour l’adapter au format
du papier utilisé.

Juxtaposition d’un document
Etant donné que les dimensions d’un document ne correspondent pas toujours au format de papier utilisé pour l’impression, InDesign divise le
document de grande taille en un ou plusieurs rectangles (ou mosaïques) adaptés au format de page de l’imprimante. Vous pouvez ensuite
réassembler les sections juxtaposées.

La juxtaposition d’un document dans InDesign peut être manuelle ou automatique. La juxtaposition vous permet de contrôler manuellement le point
d’origine du coin supérieur gauche de la mosaïque et de déterminer l’étendue de la page sur le papier.

Pour juxtaposer un document automatiquement
1. Choisissez Fichier > Imprimer.
2. Dans la zone Format de la boîte de dialogue Imprimer, sélectionnez Mosaïque.
3. Dans le menu Mosaïque, choisissez l’une des options suivantes : Automatique  Calcule automatique le nombre de

mosaïques nécessaires, chevauchement inclus. Justification automatique  Augmente le chevauchement (le cas échéant)
de sorte que le côté droit des mosaïques les plus à droite s’alignent sur le bord droit de la page du document, et que le bas
des mosaïques situées le plus en bas s’aligne sur le bas de la page du document.

4. Dans Chevauchement, entrez les informations minimales en double que vous souhaitez imprimer sur chaque mosaïque pour
faciliter l’assemblage. L’option Chevauchement utilise l’unité de mesure spécifiée dans le document. La valeur doit être
supérieure à celle des marges minimales non imprimables. Vous pouvez spécifier jusqu’à la moitié de la hauteur du plus petit
côté de la page de document à chevaucher. Par exemple, le chevauchement de mosaïques d’une page mesurant environ
2,5 par 4,5 cm peut atteindre 14 cm.

Pour juxtaposer un document manuellement
Contrairement à la juxtaposition automatique d’un document, qui imprime toutes les mosaïques à la fois, la juxtaposition manuelle requiert que
vous imprimiez chaque mosaïque séparément.

1. Si nécessaire, choisissez Affichage > Afficher les règles.
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2. Faites glisser l’intersection des règles pour restaurer l’origine dans le coin supérieur gauche de la mosaïque à imprimer.
N’oubliez pas de prévoir un espace pour les repères d’impression.

La taille et le format de la zone imprimée dans InDesign sont déterminés par l’orientation et le format du papier.

3. Choisissez Fichier > Imprimer, puis cliquez sur Format à gauche.
4. Dans la zone Format, sélectionnez Mosaïque, puis choisissez Manuelle dans le menu Mosaïque.

Mise à l’échelle de documents
Pour ajuster un document de grande taille sur une feuille de papier plus petite, vous pouvez mettre à l’échelle la largeur et la hauteur du
document, de manière symétrique ou asymétrique. La mise à l’échelle asymétrique est utile lorsque, par exemple, vous imprimez un film destiné à
être utilisé sur une presse flexographique : si vous savez quel côté de la plaque sera monté sur la table, la mise à l’échelle peut compenser
l’allongement de la plaque de 2 à 3 %. La mise à l’échelle n’a aucun effet sur le format des pages du document.

Remarque : lorsque vous imprimez des planches, chacune d’entre elles est mise à l’échelle séparément.

Pour mettre un document à l’échelle manuellement
1. Choisissez Fichier > Imprimer.
2. Pour activer les cases Largeur et Hauteur, dans la zone Format de la boîte de dialogue Imprimer, sélectionnez Largeur.
3. Pour conserver les dimensions actuelles du document, sélectionnez Conserver les proportions. Dans le cas contraire, vérifiez

que cette option n’est pas sélectionnée.
4. Dans les zones Largeur et Hauteur, entrez des pourcentages compris entre 1 et 1 000. Si vous sélectionnez l’option

Conserver les proportions, entrez une seule valeur et l’autre est automatiquement mise à jour.

Pour mettre un document à l’échelle automatiquement
1. Dans la zone Format de la boîte de dialogue Imprimer, vérifiez que les options Mosaïque et Vignettes sont désélectionnées.

L’option Ajuster n’est pas disponible si ces options sont sélectionnées.
2. Sélectionnez l’option Ajuster. Le pourcentage de mise à l’échelle s’affiche en regard de l’option Ajuster. Il est déterminé par la

zone imprimable, elle-même définie par le PPD sélectionné.

Voir aussi
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A propos des outils de publication traditionnels PDF

Dans certains flux de production de publication traditionnels, les documents sont distribués dans le format de l’application ayant servi à les créer
(appelé format natif). Une fois approuvés, les fichiers sont enregistrés en PostScript ou dans un format propriétaire pour les travaux de prépresse
et l’impression finale. Etant donné que le mode de création des fichiers PostScript varie considérablement d’une application à l’autre, les fichiers
PostScript obtenus peuvent être excessivement volumineux et complexes. De plus, des problèmes de fiabilité (polices manquantes, fichiers
corrompus, éléments graphiques manquants et fonctions non prises en charge) peuvent se produire au moment de la sortie. En réponse à cela,
Adobe et ses partenaires continuent de créer des solutions de flux de production de publication fiables basées sur le format PDF.

InDesign vous permet d’exporter un document sous la forme d’un fichier Adobe PDF composite appelé gabarit numérique. Ces gabarits
numériques sont des fichiers fiables et de taille réduite que vous (ou votre prestataire de services prépresse) pouvez visualiser, modifier, organiser
et utiliser en tant qu’épreuve. Par la suite, au stade approprié du flux de production, le prestataire de services de prépresse peut soit créer le PDF
directement, soit l’ouvrir dans différents outils pour réaliser des opérations de post-traitement telles que le contrôle en amont, le recouvrement,
l’imposition et la séparation de couleurs.

Fichiers PDF dans le flux de production

La plupart des grands imprimeurs utilisent le format PDF pour rationaliser les tâches de révision et de production. De nombreux magazines et
journaux, par exemple, ont adopté PDF comme format standard pour communiquer les encarts publicitaires aux imprimeurs locaux par satellite ou
ligne RNIS. Grâce à ce format, les imprimeurs peuvent visualiser instantanément l’encart publicitaire tel qu’il a été conçu, effectuer des corrections
de texte de dernière minute et imprimer en toute fiabilité à partir de n’importe quel ordinateur.

Technologies de flux de production PDF et conditions requises

Adobe s’efforce de répondre aux besoins des prestataires de services en matière de flux de production de publication et vous invite à consulter
régulièrement le site Web d’Adobe, à l’adresse www.adobe.com/fr/ pour connaître les dernières évolutions. Adobe propose actuellement une
solution reposant sur un système qui intègre plusieurs technologies :

Adobe Acrobat 9, compatible avec le format Adobe PDF version 1.7.

La technologie d’impression Adobe PostScript 3, pour la compatibilité interplate-forme, le recouvrement Adobe In-RIP, les
séparations de couleurs in-RIP et les dégradés lissés.

Adobe InDesign CS4, intégrant des fonctionnalités de mise en page haute résolution et un traitement direct au format PDF.

PDF/X, norme ISO d’échange de contenus graphiques qui permet d’éliminer de nombreuses variables de couleur, de police et
de recouvrement pouvant entraîner des problèmes d’impression.

Un flux de production composite haute résolution PDF comprend généralement un périphérique d’impression PostScript 3 dont le processeur RIP
prend en charge les séparations in-RIP. Par conséquent, si vous utilisez un périphérique d’impression PostScript Niveau 2 ou qui ne prend pas en
charge les séparations in-RIP, utilisez un flux de production d’impression PostScript préséparé.

Vérification du document avant l’exportation

http://www.adobe.com/fr/
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Avant de créer un PDF pour un prestataire de services, assurez-vous que le document InDesign est conforme aux spécifications de ce dernier.
Suivez les recommandations ci-dessous :

Utilisez la fonction Contrôle en amont d’InDesign pour vous assurer que la résolution d’image et les espaces colorimétriques
sont corrects, que les polices sont disponibles et peuvent être incorporées, que les graphiques sont à jour, etc.

Affichez les paramètres d’exportation Adobe PDF avant de lancer l’exportation et modifiez-les si nécessaire. La zone Synthèse
comprend une section dans laquelle un message d’avertissement s’affiche lorsqu’un paramètre prédéfini ne peut pas être mis
en œuvre.

Si vos illustrations contiennent des transparences, des surimpressions et des ombres portées et que vous voulez une sortie
haute résolution, il est conseillé de prévisualiser les effets de l’aplatissement à l’aide du panneau Aperçu de l’aplatissement
avant d’enregistrer le fichier.

Si votre illustration comprend des transparences, demandez au prestataire de services prépresse s’il souhaite que celles-ci
soient aplaties ou non dans les fichiers PDF. Il est recommandé que l’aplatissement soit effectué le plus tard possible dans le
flux de production, de préférence par le prestataire de services. Toutefois, si votre prestataire de services souhaite que vous
procédiez vous-même à l’aplatissement de la transparence, fournissez-lui un fichier compatible PDF/X-1a.

Si votre document contient des séparations de couleurs, vous pouvez les prévisualiser, ainsi que les limites de couverture
d’encre, à l’aide du panneau Aperçu des séparations.

Utilisez exclusivement des images haute résolution dans votre document.

Pour obtenir de meilleurs résultats, utilisez uniquement des images CMJN en quadrichromie. Vous pouvez également choisir
de convertir les images RVB en CMJN dans la boîte de dialogue Exporter au format Adobe PDF (catégorie Sortie).

Vous pouvez exclure les calques masqués ou non imprimables du document PDF exporté (voir Choix des calques à imprimer
ou à exporter au format PDF).

Pour plus d'informations sur la préparation de documents InDesign pour obtenir des PDF haute résolution, consultez le Guide d’impression Adobe
InDesign CS pour prestataires de services prépresse.

Impression directe de fichier PDF

Les fabricants d’imprimante de moteur d’impression PDF produisent de nouveaux pilotes basés sur Adobe PDFDriver SDK ayant des
fonctionnalités de gestion du format PDF en mode direct. Lorsqu’une telle imprimante est sélectionnée via InDesign, son PPD peut indiquer qu’il
s’agit d’une imprimante PDF (selon le fabricant d’imprimante).

Etant donné qu’InDesign peut générer un fichier PDF de haute qualité via l’exportation PDF, l'impression sur une imprimante PDF tire parti de
cette fonctionnalité, et ce PDF de haute qualité est transmis à l’imprimante sans passer par l’itinéraire PostScript intermédiaire.
Généralement, la qualité d’impression des applications via le pilote PDF est semblable (ou supérieure) à celle de l’impression PostScript.
L’impression de fichiers PDF via l’imprimante Adobe PDF prend également en charge la gestion des transparents dynamiques et des
couleurs ICC. Dans la boîte de dialogue d’impression d’InDesign, les options associées à la gestion des couleurs, la séparation des couleurs et les
options d’images sont désactivées puisque toutes les opérations de gestion des couleurs sont effectuées sur le périphérique pour une impression
de meilleure qualité.

Boîte de dialogue d’impression

http://idiom-q-win-1/fr/indesign/using/printing-documents.html#choose_which_layers_are_printed_or_exported_to_pdf
http://idiom-q-win-1/fr/indesign/using/printing-documents.html#choose_which_layers_are_printed_or_exported_to_pdf
http://partners.adobe.com/public/asn/en/print_resource_center/IDCS_PrintGuide.pdf
http://partners.adobe.com/public/asn/en/print_resource_center/IDCS_PrintGuide.pdf


  Les publications Twitter™ et Facebook ne sont pas couvertes par les dispositions Creative Commons.

Mentions légales   |   Politique de confidentialité en ligne

Haut de la page

Remarque :

L’option Composite (ne pas modifier) est sélectionnée par défaut et ne peut pas être modifiée.

Génération d’un fichier PDF prêt pour l’impression

Un prestataire de services peut utiliser Acrobat 7.0 Professional ou version ultérieure pour réaliser les tâches de contrôle en amont et de
séparation des couleurs. Acrobat Professional contient des outils avancés supplémentaires de contrôle en amont, notamment la capacité
d’effectuer certaines corrections de façon automatique. Diverses applications de prépresse et technologies in-RIP permettent également de réaliser
les tâches de contrôle en amont, de recouvrement et d’imposition, ainsi que les séparations de couleurs des pages dans le gabarit.

Si vous choisissez d’omettre les images au moment de créer le fichier Adobe PDF, assurez-vous que le prestataire de services prépresse peut
accéder aux images haute résolution requises pour l’impression. Vérifiez également que le prestataire de services de prépresse dispose d’Acrobat
Reader 7.0 ou version ultérieure pour pouvoir visualiser avec précision le texte et les images en couleur. Pour une qualité de visualisation
optimale, Acrobat 8 Professional (ou une version ultérieure) est recommandé.

Si vous utilisez la gestion des couleurs dans votre flux de production, vous pouvez tirer parti de la précision des profils colorimétriques pour
réaliser une prévisualisation à l’écran (vérification à l’écran). Vous pouvez ainsi visualiser l’aspect des couleurs lorsqu’elles sont reproduites sur un
périphérique d’impression particulier.

à moins d’utiliser un système de gestion des couleurs (SGC) avec des profils ICC précis et un moniteur étalonné avec exactitude, les
couleurs à l’écran risquent de ne pas être fiables.

1. Préparez le document à exporter au format Adobe PDF.

2. Procédez à l’exportation en vous appuyant sur le fichier .joboptions que vous a fourni le prestataires de services. Si vous ne
disposez pas de fichier .joboptions spécifique, utilisez un paramètre prédéfini PDF/X.

3. Effectuez un contrôle en amont du PDF dans Adobe Acrobat 7.0 Professional ou version ultérieure.

4. Lancez une épreuve et corrigez le fichier PDF.

5. Remettez le fichier optimisé à votre prestataire de services de prépresse.

Adobe recommande également

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr
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Présentation du panneau Contrôle en amont
Définition de profils de contrôle en amont
Affichage et résolution des erreurs de contrôle en amont
Contrôle en amont de livres
Assemblage de fichiers

Pour plus d’informations et d’instructions, cliquez sur les liens ci-dessous.

Présentation du panneau Contrôle en amont

Avant d’imprimer ou de remettre un document à un prestataire de services, vérifiez-en la qualité. On appelle ce processus contrôle en amont. Lors
de la modification d’un document, le panneau Contrôle en amont indique les problèmes susceptibles d’empêcher l’impression ou la sortie d’un
document ou d’un livre selon les résultats escomptés. Parmi ces problèmes, citons les polices ou fichiers manquants, les images basse résolution,
le texte en excès et un certain nombre d’autres conditions.

Vous pouvez configurer des paramètres de contrôle en amont pour définir les conditions détectées. Ces paramètres sont stockés dans des profils
de contrôle en amont, facilitant ainsi leur réutilisation. Libre à vous de créer vos propres profils de contrôle en amont ou d’importer ceux émanant
de votre imprimeur ou d’une autre source.

Pour bénéficier des avantages du contrôle en amont dynamique, il est recommandé de créer ou de définir un profil de contrôle en amont dès les
premières étapes du processus de création d’un document. Si la fonction de contrôle en amont est activée, une icône de cercle rouge s’affiche
dans la barre d’état dès qu’InDesign détecte un problème quelconque. Vous pouvez alors ouvrir le panneau Contrôle en amont et consulter la
section Informations afin d’obtenir des conseils de base qui vous permettront de résoudre les problèmes.

Panneau Contrôle en amont

A. Erreur sélectionnée B. Numéro de page sur lequel cliquer pour afficher l’élément de page C. Section Informations contenant des suggestions
pour résoudre l’erreur sélectionnée D. Zone permettant de définir une étendue de pages pour limiter la recherche d’erreurs 

Ouverture du panneau Contrôle en amont

Choisissez la commande Fenêtre > Sortie > Contrôle en amont.

Cliquez deux fois sur l’icône de contrôle en amont au bas de la fenêtre du document. Si aucun problème n’est détecté, l’icône
de contrôle en amont est verte ; dans le cas contraire, elle devient rouge.
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Définition de profils de contrôle en amont

Par défaut, le profil [Standard] est appliqué aux nouveaux documents et à ceux qui ont été convertis. Ce profil signale les liens manquants ou
modifiés, le texte en excès et les polices manquantes. Il est impossible de modifier ou de supprimer le profil [Standard] ; vous avez néanmoins
toute latitude pour créer et utiliser divers profils. Vous pouvez par exemple basculer d’un profil à un autre lorsque vous travaillez sur des
documents différents, lorsque vous faites appel à divers prestataires de services d’impression ou encore, lorsque le processus de production d’un
document comprend différentes phases.

Adressez-vous à votre prestataire de services prépresse pour obtenir un profil ou pour déterminer les paramètres du profil de contrôle en amont. 

Pour définir un profil de contrôle en amont

1. Choisissez la commande Définir les profils dans le menu du panneau Contrôle en amont ou dans le menu Contrôle en amont
disponible au bas de la fenêtre du document.

2. Cliquez sur l’icône Nouveau profil de contrôle en amont , puis attribuez un nom au profil.

3. Définissez les paramètres de contrôle en amont pour chaque catégorie. La présence d’une coche dans une case indique que
tous les paramètres sont inclus. Une case vide indique qu’aucun paramètre n’est inclus.

Indiquez si les liens manquants et modifiés doivent faire partie des erreurs signalées.

Indiquez quel espace de fusion des transparences utiliser et si les éléments tels que les plaques CMJ, les espaces
colorimétriques et la surimpression sont autorisés.

Indiquez les conditions requises en matière de résolution d’image, transparence et épaisseur du contour.

La catégorie Texte permet de signaler les erreurs relatives aux polices manquantes et au texte en
excès.

Définissez les exigences relatives au format et à l’orientation des pages, au nombre de pages, aux pages vierges
et au format de fond perdu et de ligne-bloc.

4. Choisissez l’option Enregistrer pour conserver les modifications apportées à un profil avant de passer à un autre profil. Vous
pouvez également cliquer sur le bouton OK pour fermer la boîte de dialogue et enregistrer toutes les modifications.

Pour incorporer des profils et annuler l’incorporation de profils

Lorsque vous incorporez un profil, il devient un élément à part entière du document. Il est utile d’incorporer un profil, en particulier lorsque le fichier
en question est envoyé à une autre personne. Le fait qu’un profil soit incorporé n’implique pas nécessairement son utilisation. Par exemple, si
vous envoyez un document avec profil incorporé à un service d’impression, l’imprimeur peut décider d’utiliser un profil différent de celui fourni avec
le document.

Vous pouvez incorporer un seul profil dans un document, à l’exception du profil [Standard].

1. Pour incorporer un profil, sélectionnez-le dans la liste Profil, puis cliquez sur l’icône Incorporer  à droite de cette liste.

Vous pouvez également incorporer un profil depuis la boîte de dialogue Définir les profils.

2. Pour annuler l’incorporation d’un profil, choisissez la commande Définir les profils dans le menu du panneau Contrôle en
amont, sélectionnez le profil, puis choisissez la commande Annuler l’incorporation du profil dans le menu de profil de contrôle
en amont, visible à gauche dans la boîte de dialogue.

Pour exporter et charger des profils

Vous pouvez exporter un profil afin de le mettre à la disposition d’autres utilisateurs. Les profils exportés sont enregistrés avec l’extension .idpp.



Haut de la page

L’exportation d’un profil est un bon moyen de sauvegarder les paramètres de profil. Lorsque vous restaurez les préférences, les informations de
profil sont réinitialisées. Pour rétablir les préférences, vous pouvez charger votre profil exporté.

Vous pouvez également charger un profil qui vous a été fourni par une autre personne. Le profil chargé peut correspondre à un fichier *.idpp ou
au profil incorporé dans le document que vous définissez.

Pour exporter un profil, choisissez la commande Définir les profils dans le menu Contrôle en amont. Choisissez la commande
Exporter le profil dans le Menu du profil de contrôle en amont, précisez le nom et l’emplacement, puis cliquez sur le
bouton Enregistrer.
Pour charger (importer) un profil, choisissez la commande Définir les profils dans le menu Contrôle en amont. Choisissez la
commande Charger le profil dans le menu du profil de contrôle en amont, sélectionnez le fichier *.idpp ou le document
contenant le profil incorporé à utiliser, puis cliquez sur le bouton Ouvrir.

Pour supprimer un profil

1. Choisissez la commande Définir les profils dans le menu Contrôle en amont.

2. Sélectionnez le profil à supprimer, puis cliquez sur l’icône Supprimer le profil de contrôle en amont .

3. Cliquez sur le bouton OK pour supprimer le profil.

Affichage et résolution des erreurs de contrôle en amont

La liste d’erreurs inclut uniquement les catégories pour lesquelles des erreurs sont signalées. Pour développer ou réduire un élément, il vous suffit
de cliquer sur la flèche qui le précède.

Lorsque vous consultez la liste d’erreurs, tenez compte des points suivants :

Dans certains cas, le problème est dû à un élément de composition, tel qu’une nuance ou un style de paragraphe. Or, ce n’est
pas l’élément de composition lui-même qui est signalé en tant qu’erreur mais plutôt le ou les éléments de page auxquels est
appliqué cet élément de composition. Dans ce cas, veillez à résoudre le problème au niveau de l’élément de composition.

Les erreurs au niveau du texte en excès, des conditions masquées ou des notes ne sont pas recensées. Le texte supprimé
qui demeure disponible dans le suivi des modifications est également ignoré.

Un élément de gabarit présentant un problème n’est pas répertorié si le gabarit n’est appliqué à aucune page ou si les pages
auxquelles ce gabarit est appliqué ne figurent pas dans l’étendue définie. Par ailleurs, si un élément de gabarit est à l’origine
d’une erreur, il est répertorié une seule fois dans le panneau Contrôle en amont, même si l’erreur figure sur toutes les pages
auxquelles le gabarit est appliqué.

Les erreurs affectant les éléments de page non imprimables, les éléments de page placés sur la table de montage ou ceux
figurant dans des calques masqués ou non imprimables sont répertoriées dans la liste d’erreurs uniquement si les options
correspondantes sont définies dans la boîte de dialogue Options de contrôle en amont.

Pour imprimer uniquement certaines pages, vous pouvez limiter le contrôle en amont à une étendue de pages définie. Il vous
suffit de définir l’étendue voulue au bas du panneau Contrôle en amont.

Pour activer ou désactiver le contrôle en amont dynamique

Par défaut, le contrôle en amont est activé pour tous les documents.

1. Pour activer ou désactiver le contrôle en amont du document actif, sélectionnez l’option Activé dans le coin supérieur gauche
du panneau Contrôle en amont ou choisissez la commande Contrôler le document en amont dans le menu Contrôle en amont,
au bas de la fenêtre du document.

2. Pour activer ou désactiver le contrôle en amont de tous les documents, sélectionnez la commande Activer le contrôle en
amont pour tous les documents dans le menu du panneau Contrôle en amont.
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Pour résoudre des erreurs

1. Dans la liste d’erreurs, cliquez deux fois sur une ligne ou cliquez sur le numéro de page dans la colonne Page pour afficher
l’élément de page correspondant.

2. Cliquez sur la flèche à gauche de l’intitulé Informations pour afficher les informations concernant la ligne sélectionnée.

Le panneau Informations fournit une description du problème et suggère des actions correctives.

3. Corrigez l’erreur.

Pour sélectionner un autre profil

Dans nombre de flux de production, l’utilisation de profils différents peut se révéler judicieuse. Vous pouvez par exemple sélectionner des profils
différents pour les documents que vous modifiez simultanément ou choisir un nouveau profil dans le cadre d’une nouvelle phase de production. Le
document est soumis à un nouveau contrôle lorsque vous sélectionnez un autre profil.

1. Ouvrez le document.

2. Dans le menu Profil du panneau Contrôle en amont, sélectionnez un profil.

Si vous souhaitez utiliser ce profil chaque fois que vous travaillez sur ce document, incorporez-le, faute de quoi le profil de travail par défaut sera
utilisé.

Pour spécifier une série de pages pour le contrôle en amont

Indiquez une étendue de pages (1-8, par exemple) au bas du panneau Contrôle en amont.

La définition d’une étendue de pages obéit aux mêmes règles que celles applicables dans la boîte de dialogue d’impression. Les erreurs figurant
sur les pages qui ne sont pas comprises dans cette étendue sont omises de la liste d’erreurs.

Pour définir les options de contrôle en amont

1. Choisissez la commande Options de contrôle en amont dans le menu du panneau Contrôle en amont.

2. Définissez les options suivantes, puis cliquez sur le bouton OK.

Sélectionnez le profil à utiliser par défaut pour les nouveaux documents. Si vous souhaitez que le profil de
travail soit incorporé dans les nouveaux documents, sélectionnez l’option Incorporer le profil de travail dans les nouveaux
documents (voir Définition de profils de contrôle en amont).

Lorsque vous ouvrez un document, indiquez si le contrôle en amont
doit être effectué au moyen du profil de travail ou de celui incorporé dans le document.

Indiquez si les éléments figurant sur tous les calques, les calques visibles ou les calques visibles et imprimables
doivent être inclus dans le contrôle en amont. Par exemple, si un élément se trouve sur un calque masqué, vous pouvez faire
en sorte que les erreurs relatives à cet élément ne soient pas signalées.

Sélectionnez cette option pour afficher les erreurs relatives aux objets identifiés comme non
imprimables dans le panneau Options d’objet ou aux objets de gabarit figurant sur des pages auxquelles la commande
Masquer les éléments du gabarit a été appliquée.

Sélectionnez cette option pour afficher les erreurs relatives aux objets placés sur la table de
montage.

http://idiom-q-win-1/fr/indesign/using/preflighting-files-handoff.html#main-pars_heading_3
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Pour limiter le nombre de lignes par erreur

Vous pouvez faire en sorte que les listes d’erreurs demeurent faciles à gérer en limitant le nombre de lignes par erreur. Par exemple, l’utilisation
répétée d’une seule police TrueType dans un document qui est censé faire appel à plusieurs polices de ce type peut être à l’origine de centaines
d’erreurs. Dans ce cas, un nombre de lignes par erreur limité à 25 permettrait de recenser uniquement les 25 premières erreurs, accompagnées
du chiffre (25+).

Choisissez l’option Nombre limite de lignes par erreur dans le menu du panneau Contrôle en amont, puis indiquez un nombre.

Pour enregistrer un rapport d’erreur

Vous pouvez générer un fichier texte ou PDF répertoriant les erreurs affichées dans le panneau Contrôle en amont. Ce rapport indique également
d’autres informations, telles que l’heure, le nom du document et le nom du profil.

Pour obtenir un inventaire complet des éléments utilisés dans le document, notamment les polices, encres et liens, générez un rapport à l’aide
de la fonction Assemblage.

1. Choisissez la commande Enregistrer le rapport dans le menu du panneau Contrôle en amont.

2. Indiquez si le fichier doit être enregistré au format texte ou PDF dans le menu Type (Windows) ou Format (Mac OS).

3. Précisez le nom et l’emplacement du rapport, puis cliquez sur le bouton Enregistrer.

Contrôle en amont de livres

La commande Contrôler le livre en amont disponible dans le menu du panneau Livre permet de rechercher les erreurs dans tous les documents
(ou tous les documents sélectionnés). Vous pouvez effectuer le contrôle à l’aide du profil incorporé dans chacun des documents ou d’un profil
particulier que vous définissez. L’état du contrôle de chacun des documents est indiqué au moyen d’une icône verte, rouge ou en forme de point
d’interrogation. La couleur verte indique que le document ne contient aucune erreur. La couleur rouge signale la présence d’erreurs. Le point
d’interrogation signale un état inconnu. Par exemple, il s’affiche lorsque le document est fermé, le contrôle en amont est désactivé ou le profil de
contrôle en amont a été modifié.

Pour définir les options de contrôle en amont dans un livre

1. Choisissez la commande Contrôler le livre en amont dans le menu du panneau Livre.

2. Dans la boîte de dialogue Options de contrôle en amont du livre, précisez si les options de contrôle en amont doivent
s’appliquer à l’ensemble du livre ou uniquement aux documents sélectionnés.

3. Dans la section Profil de contrôle en amont, indiquez si vous souhaitez utiliser le profil indiqué dans le menu Utiliser le profil
ou celui incorporé dans chacun des documents.

Le profil que vous définissez est utilisé temporairement pour chacun des documents. Lorsque vous fermez un document
individuel, le profil utilisé à la prochaine ouverture de ce document est fonction de l’option sélectionnée dans la boîte de
dialogue Options de contrôle en amont (profil incorporé ou profil de travail).

4. Dans la section Inclure, déterminez les éléments à inclure dans la liste d’erreurs.

Indiquez si les éléments figurant sur tous les calques, les calques visibles ou les calques visibles et imprimables
doivent être inclus dans le contrôle en amont. Par exemple, si un élément se trouve sur un calque masqué, vous pouvez
décider de ne pas afficher les erreurs le concernant.

Sélectionnez cette option pour afficher les erreurs relatives aux objets placés sur la table de
montage.

Sélectionnez cette option pour afficher les erreurs relatives aux objets identifiés comme non
imprimables sur le panneau Options d’objets.
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5. Sélectionnez l’option Générer le rapport pour obtenir un fichier texte ou PDF contenant une liste d’erreurs. Le rapport ainsi
obtenu recense toutes les erreurs détectées dans le livre.

6. Cliquez sur l’option Contrôle en amont.

Pour résoudre les erreurs de contrôle en amont dans un livre

Un point rouge s’affiche à droite du nom du document dans le panneau Livre lorsque ce document contient des erreurs de contrôle en amont.

1. Dans le panneau Livre, cliquez deux fois sur le document contenant des erreurs.

2. Utilisez le panneau Contrôle en amont pour vérifier les erreurs détectées dans chacun des documents, puis effectuez les
modifications requises pour les résoudre.

Les éléments de composition tels que les styles ou les nuances peuvent être à l’origine d’erreurs. Dans ce cas, veillez à résoudre les erreurs au
niveau des styles ou des nuances dans le document de source des styles, puis synchronisez le livre.

Si vous avez défini un profil autre que celui incorporé dans le document pour le contrôle en amont du livre, pensez que le profil sélectionné à la
prochaine ouverture du document peut être différent. et entraîner la détection d’erreurs de contrôle en amont différentes.

Assemblage de fichiers

Rassemblez les fichiers utilisés, y compris les polices et les images liées, pour les remettre plus facilement au prestataire de services. Lorsque
vous assemblez un fichier, vous créez un dossier contenant le document InDesign (ou les documents d’un livre), les polices requises, les images
liées, les fichiers texte et un rapport personnalisé. Ce rapport, enregistré au format texte, contient les informations de la boîte de dialogue
Instructions d’impression, la liste de toutes les polices utilisées, les lien et les encres nécessaires pour imprimer le document, ainsi que les
paramètres d’impression.

InDesign effectue un contrôle en amont à jour. La boîte de dialogue Inventaire d’assemblage indique les éléments au niveau desquels un
problème a été détecté. Vous pouvez également envoyer à votre prestataire de services un fichier PDF composite créé à partir de votre document
ou d’un fichier PostScript.

1. Pour ouvrir la boîte de dialogue Assemblage, utilisez l’une des méthodes suivantes :

Choisissez Fichier > Assemblage. Si la commande Assemblage ne figure pas dans le menu Fichier, essayez de choisir un
autre espace de travail, par le biais de la commande Fenêtre > Espace de travail > Avancé, par exemple.

Dans le menu du panneau Livre, choisissez Assemblage > Livre ou Assemblage > Documents sélectionnés en fonction
du nombre de documents sélectionnés dans le panneau Livre.

Une icône d’alerte 

2. Dans la boîte de dialogue Assemblage, utilisez l’une des méthodes suivantes :

Si des erreurs sont signalées, cliquez sur l’option Annuler, puis utilisez le panneau Contrôle en amont pour les résoudre.

Cliquez sur l’erreur (Polices, par exemple), puis corrigez-la. Une fois que vous êtes satisfait du document obtenu, relancez
l’assemblage.

Cliquez sur l’option Assemblage pour relancer l’opération.

3. Complétez les instructions d’impression. Le nom du rapport qui accompagne tous les autres fichiers assemblés correspond au
nom du fichier saisi.

4. Cliquez sur Continuer, puis spécifiez un emplacement d’enregistrement pour l’ensemble des fichiers d’assemblage.

5. Si nécessaire, sélectionnez les options suivantes :

Copie tous les fichiers de polices nécessaires et non l’ensemble des caractères.

Copie les fichiers graphiques liés à l’emplacement du dossier de l’assemblage.



Actualiser les liens graphiques dans l’assemblage

Utiliser seulement les exceptions de césure du document

Inclure les polices et les liens du contenu masqué et non imprimable

Inclure le fichier IDML

Inclure le fichier PDF(copie)

Remarque :

Afficher le rapport

Polices manquantes

Modifie les liens graphiques à l’emplacement du dossier de
l’assemblage.

Si cette option est sélectionnée, InDesign marque ce document
afin que son contenu ne soit pas redistribué lorsqu’un autre utilisateur l’ouvre ou le modifie sur un ordinateur configuré avec
des paramètres de césure et de dictionnaire différents. Vous pouvez activer cette option lorsque vous envoyez le fichier à un
prestataire de services.

Assemble les objets situés sur les calques
masqués, sur les conditions masquées et sur les calques pour lesquels l’option Imprimer le calque est désactivée. Lorsque
cette option n’est pas activée, l’assemblage inclut uniquement le contenu visible et imprimable du document lors de la création
de l’assemblage.

Sélectionner les options d’IDML

Rassemble le fichier IDML avec l’assemblage. Ceci permet d’ouvrir un document/livre InDesign dans
les versions précédentes d’InDesign.

Sélectionnez cette option pour assembler un fichier pdf(copie). Tous les paramètres
prédéfinis pdf actuellement actifs peuvent être utilisés dans l’assemblage. Le paramètre prédéfini pdf utilisé en dernier est le
paramètre prédéfini pdf par défaut dans la liste déroulante de ces paramètres.

 

Dans le cas d’un avertissement lors de la création d’un fichier pdf, celui-ci est créé avec succès. Cependant, un message
d’avertissement s’affiche. 
En cas de toute erreur lors de la création ou l’assemblage de fichiers pdf/idml, une restauration complète a lieu et rien
n’est créé.
Le nom du fichier idml et pdf créé est identique à celui du document .indd.

Ouvre le rapport d’instructions d’impression dans un éditeur de texte immédiatement après l’assemblage.
Pour modifier les instructions d’impression avant de terminer l’assemblage, cliquez sur le bouton Instructions.

6. Cliquez sur Assemblage pour continuer l’assemblage.

Correction des erreurs de police

La zone Polices de la boîte de dialogue Inventaire de l’assemblage recense toutes les polices utilisées dans le document, y compris les polices
appliquées au texte en excès ou au texte de la table de montage, ainsi que les polices incorporées dans les fichiers EPS, les fichiers
Adobe Illustrator natifs et les pages PDF importées. Elle indique les polices installées et disponibles sur l’ordinateur. Choisissez Afficher les
problèmes seulement pour afficher uniquement les polices entrant dans les catégories suivantes :

Recense les polices utilisées dans le document mais qui ne sont ni installées sur l’ordinateur actuel ni disponibles en tant
que polices de document installées.
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Polices incomplètes

Polices protégées

Remarque :

Recense les polices affichables à l’écran par l’ordinateur, mais non prises en charge par l’imprimante.

Recense les polices qui ne peuvent être ni incorporées aux fichiers PDF ou EPS ni utilisées en tant que polices de document
installées en raison de restrictions de licence.

Utilisez l’une des méthodes suivantes :

Fermez la boîte de dialogue Contrôle en amont et installez les polices sur votre ordinateur.

Cliquez sur Rechercher la police dans la zone Polices de la boîte de dialogue Contrôle en amont, puis recherchez, affichez
et remplacez les polices utilisées dans votre document.

Vérifiez que les polices utilisées dans le document sont accompagnées d’une licence, installées et activées, sur l’ordinateur ou sur le périphérique
de sortie.

Réparation de liens et d’images

La zone Liens et images de la boîte de dialogue Inventaire de l’assemblage affiche tous les liens, les images incorporées et les fichiers InDesign
du document, notamment les liens DCS et OPI des images EPS liées. La synthèse de contrôle en amont ne considère pas les images incorporées
dans les fichiers graphiques EPS et InDesign importés comme des liens. L’utilitaire de contrôle en amont indique les liens manquants ou
obsolètes, ainsi que les images RVB dont les couleurs ne sont pas bien séparées à moins que la gestion des couleurs soit activée et configurée
correctement.

La boîte de dialogue Inventaire de l’assemblage ne permet pas la détection des images RVB incorporées dans les fichiers EPS,
Adobe Illustrator, Adobe PDF, FreeHand et .INDD importés. Pour éviter les surprises, vérifiez les données couleur des graphiques importés au
moyen du panneau Contrôle en amont ou dans leur application d’origine.

1. Pour afficher uniquement les images présentant un problème, sélectionnez Afficher les problèmes seulement dans la zone
Liens et images de la boîte de dialogue Inventaire de l’assemblage.

2. Pour réparer un lien, utilisez l’une des méthodes suivantes :

Sélectionnez l’image présentant un problème et cliquez sur Mettre à jour ou Rééditer le lien.

Cliquez sur Tout réparer.

3. Sélectionnez les fichiers d’image et cliquez sur Ouvrir.

Adobe recommande également

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr


Repères d’impression et fonds perdus

Haut de la page

Haut de la page

Spécification des repères de l’imprimante
Impression des zones de fond perdu ou de ligne-bloc
Modification de la position de la page sur le support

Spécification des repères de l’imprimante
Lors de la préparation d’un document pour l’impression, l’imprimante a besoin de repères qui l’aideront entre autres à déterminer où rogner le
papier, à aligner les films de séparation lors de la production d’épreuves, mesurer le film pour un étalonnage et une densité de points corrects. En
sélectionnant une option de repère de page, vous agrandissez les limites de la page de façon à prendre en compte les repères de l’imprimante, le
fond perdu (les parties du texte ou les objets qui s’étendent au-delà des limites de la page après le rognage) ou les lignes-bloc (zone hors page et
fonds perdus contenant les instructions de l’imprimante ou les informations du projet).

Si vous définissez les traits de coupe et que vous voulez ajouter un fond perdu ou une ligne-bloc à l’illustration, veillez à étendre cette dernière au-
delà des traits de coupe pour accueillir le fond perdu ou la ligne-bloc. Veillez également à ce que le support soit suffisamment grand pour contenir
la page et les repères de l’imprimante, les fonds perdus et les lignes-bloc. Si ce n’est pas le cas, utilisez l’option Position de la page de la zone
Format de la boîte de dialogue d’impression pour contrôler l’emplacement d’écrêtage des éléments.

Si vous sélectionnez l’option Traits de coupe, les repères de pliage sont visibles sous forme de lignes pleines sur les planches imprimées.

Repères d’impression
A.  Traits de coupe B.  Repères de montage C.  Informations sur la page D.  Gammes de couleurs E.  Repères de fond perdu F.  Ligne-
bloc

1. Choisissez Fichier > Imprimer.
2. Cliquez sur Repères et fonds perdus dans la partie gauche de la boîte de dialogue Imprimer.
3. Sélectionnez l’option Tous les repères d’impression ou sélectionnez des repères individuels.

Impression des zones de fond perdu ou de ligne-bloc
Spécifiez les fonds perdus et les lignes-bloc dans la boîte de dialogue Format de document. Les fonds perdus et les lignes-bloc ne sont pas pris
en compte lors du rognage du document à son format final. Les objets situés hors du fond perdu ou de la ligne-bloc (selon la zone qui s’étend le
plus loin) ne sont pas imprimés.

Au moment de l’impression, vous pouvez ignorer l’emplacement par défaut des repères de fond perdu dans la zone Fond perdu et ligne-bloc de la
zone Repères et fond perdu.

Les fichiers enregistrés au format PostScript permettent aux programmes de traitement d’images de mettre en place leur propre variable de fond
perdu.

1. Choisissez Fichier > Imprimer.
2. Cliquez sur l’option Repères et fonds perdus dans la partie gauche de la boîte de dialogue Imprimer.
3. Sélectionnez l’option Tous les repères d’impression ou sélectionnez des repères individuels.
4. Pour remplacer les paramètres de fond perdu dans la boîte de dialogue Format de document, désactivez la case Utiliser les
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paramètres de fond perdu du document et saisissez des valeurs comprises entre 0 et 6 pouces (ou équivalent) dans les
champs De tête, De pied, Gauche et Droite (pour les documents recto) ou De tête, De pied, Petit fond et Grand fond (pour les
documents recto-verso avec des pages en vis-à-vis). Pour étendre le décalage de façon égale sur tous les côtés de la page,
cliquez sur l’icône Uniformiser tous les paramètres .

5. Cliquez sur Inclure la zone de ligne-bloc pour imprimer les objets à l’aide de la zone de ligne-bloc définie dans la boîte de
dialogue Format de document.

Pour prévisualiser les zones de fond perdu et de ligne-bloc avant l’impression, cliquez sur l’icône Mode Fond perdu  ou Mode Ligne-bloc 
au bas du panneau Outils. Ces icônes peuvent être masquées par l’icône de mode d’aperçu .

Options Repères et fond perdu
La zone Repères et fond perdu inclut les options suivantes :

Tous les repères d’impression Sélectionne tous les repères d’impression, y compris les traits de coupe, les repères de fond perdu, les repères
de montage, les gammes de couleurs et les informations de page.
Traits de coupe Ajoute des repères fins horizontaux et verticaux (filets) qui définissent l’emplacement où la page doit être rognée. Les traits de
coupe peuvent aussi être utiles pour effectuer le repérage (alignement) des différentes séparations. Si vous les utilisez avec les repères de fond
perdu, vous pouvez sélectionner des repères qui se chevauchent.
Repères de fond perdu Ajoute des repères fins (filets) qui définissent la quantité de zone supplémentaire pour l’image en dehors de la taille de
page définie.
Repères de montage Ajoute des petites « cibles » en dehors de la page pour aligner les différentes séparations d’un document en couleur.
Gammes de couleurs Ajoute des petits carrés de couleur représentant les encres CMJN et les niveaux de gris (par incrément de 10 %). Votre
prestataire de services utilise ces repères pour ajuster la densité d’encre sur la presse d’impression.
Informations sur la page Imprime le nom du fichier, le numéro de la page, la date et l’heure actuelles, ainsi que le nom des séparations des
couleurs en police Helvetica de taille 6 dans le coin inférieur gauche de chaque feuille de papier ou de film. Un espace de 13 mm le long du bord
horizontal est nécessaire pour afficher correctement les informations sur la page.
Type Permet de choisir les repères d’impression par défaut ou les repères personnalisés (pour les pages en japonais, par exemple). Vous pouvez
créer des repères d’impression personnalisés ou utiliser ceux créés par une autre société.
Epaisseur Affiche les épaisseurs possibles des lignes de traits de coupe et de repères de fond perdu.
Décalage Spécifie la distance qui sépare les repères d’impression du bord de la page (et non du fond perdu). Par défaut, cette distance est de
6 points. Pour éviter d’inscrire les repères d’impression sur le fond perdu, la valeur de décalage doit être supérieure à la valeur du fond perdu.

Modification de la position de la page sur le support
Si vous imprimez un document avec un format de support de feuille supérieur au format de document, utilisez l’option Position de la page de la
zone Format de la boîte de dialogue Imprimer pour contrôler l’emplacement des fonds perdus, des lignes-bloc, des repères de l’imprimante et de
l’étendue de la page sur le support. Si le document n’est pas adapté au support et doit subir un rognage, définissez la partie du document à
rogner. Le résultat s’affiche dans l’aperçu de la boîte de dialogue d’impression.

Remarque : pour afficher les fonds perdus, les lignes-bloc et les repères de l’imprimante, il est préférable d’utiliser l’option Ajuster au lieu de
l’option Position de la page. En outre, les pages mises à l’échelle sont toujours centrées. L’option Position de la page n’est pas disponible si
l’option Ajuster, Vignettes ou Mosaïque est sélectionnée.

 Choisissez une option dans le menu Position de la page de la zone Format de la boîte de dialogue Imprimer.
Voir aussi

Informations juridiques   |   Politique de confidentialité en ligne

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://helpx.adobe.com/fr/legal/legal-notices.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr


Préparation à l’impression des séparations

Haut de la page

Haut de la page

Création des séparations
Préparation d’un document aux séparations des couleurs
Impression des tons directs
Affichage des équivalents quadri d’un ton direct
Impression d’un objet sur toutes les plaques de couleur
Impression de dégradés sous forme de séparations
Impression d’une épreuve composite
Affichage d’un aperçu des séparations de couleurs

Pour plus d’informations et d’instructions, cliquez sur les liens ci-dessous.

Création des séparations
Pour reproduire une image en couleurs ou à tons continus, les imprimeurs séparent les couleurs de cette image en quatre [cyan (C), magenta (M),
jaune (J) et noir (N)], sur quatre plaques différentes. Après application des encres de couleur et impression en repérage, les couleurs obtenues
reproduisent fidèlement l’illustration originale. Le processus de décomposition d’une image en deux ou plusieurs couleurs s’appelle séparation des
couleurs et on appelle séparations les films créés à partir des plaques.

Composite (à gauche) et séparations (à droite)

Flux de production de séparations
Adobe InDesign CS4 propose deux flux de production PostScript standard pour les séparations de couleurs : dans le premier, elles sont effectuées
sur l’ordinateur hôte (à l’aide d’InDesign et du pilote d’imprimante) et dans le second, depuis le processeur d’images pixellisées ou processeur RIP
(raster image processor) du périphérique de sortie. Il existe également un flux de production PDF.

Séparations basées sur un ordinateur hôte Pour ce type de flux de production préséparé traditionnel, InDesign crée des informations
PostScript pour chacune des séparations du document et les envoie au périphérique de sortie.
Séparations In-RIP Dans un flux de production reposant sur un processeur RIP PostScript, des processeurs RIP de nouvelle génération
effectuent, indépendamment de l’ordinateur hôte, les séparations de couleurs, le recouvrement et même la gestion des couleurs au niveau du RIP.
InDesign génère alors le fichier plus rapidement et réduit la quantité de données à transmettre dans le cadre d’une impression. Par exemple, au
lieu d’envoyer des informations PostScript pour l’impression de quatre pages ou plus avec des séparations de couleurs basées sur l’ordinateur
hôte, InDesign envoie les informations PostScript d’un seul fichier PostScript composite pour un traitement RIP.
Pour consulter un didacticiel vidéo sur la préparation des fichiers pour leur sortie, rendez-vous à l’adresse www.adobe.com/go/vid0089. Pour
consulter un guide d’impression à l’intention des prestataires de services prépresse (PDF), rendez-vous à l’adresse
www.adobe.com/go/learn_id_prepress_wp_fr.

Préparation d’un document aux séparations des couleurs
1. Corrigez les éventuels problèmes colorimétriques des illustrations.
2. Définissez les options de surimpression.
3. Créez des instructions de recouvrement pour compenser toute erreur de mise en registre sur la presse.
4. Effectuez un aperçu des séparations des couleurs à l’écran.

http://www.adobe.com/go/vid0089
http://www.adobe.com/go/learn_id_prepress_wp_fr
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Remarque : pour la séparation des couleurs, les étapes 1 à 4 sont recommandées, mais pas obligatoires.
5. Choisissez Fichier > Imprimer pour afficher la boîte de dialogue d’impression.
6. Si vous avez créé un style d’impression prédéfini avec les paramètres de séparation appropriés, sélectionnez-le dans le

menu Impression prédéfinie, en haut de la boîte de dialogue Imprimer.
7. Dans le menu Imprimante, choisissez une imprimante ou un fichier PostScript.
8. Pour une impression PostScript, choisissez le fichier PPD du périphérique de sortie des séparations.
9. Pour afficher ou modifier les options d’impression actives, cliquez sur un nom de section, dans la partie gauche de la boîte de

dialogue Imprimer.
10. Avant de livrer votre document à un prestataire de services, vérifiez les séparations.
11. Imprimez ou enregistrez les séparations.

Impression des tons directs
Il est possible de remplacer ou de compléter des couleurs quadri par des teintes personnalisées appelées tons directs. Par exemple, pour
reproduire une illustration contenant du texte noir et des dessins au trait utilisant un vert particulier, deux tons directs suffisent : le noir et un ton
correspondant au vert souhaité. En outre, les encres de tons directs sont utilisées pour obtenir des couleurs qui ne sont pas reproductibles avec
les encres CMJN, notamment des vernis ou des couleurs fluorescentes et métalliques. Vous pouvez également obtenir des encres mélangées en
combinant plusieurs tons directs ou des tons directs avec des couleurs quadri.

Vous pouvez colorer une illustration avec des couleurs quadri, des tons directs ou une combinaison des deux. Lors de l’impression des
séparations, vous pouvez convertir les tons directs en leurs équivalents quadri de sorte qu’ils s’impriment sur des plaques CMJN.

Affichage des équivalents quadri d’un ton direct
1. Dans le panneau Nuancier, sélectionnez un ton direct.
2. Dans le menu du panneau Couleur, choisissez CMJN.

Les équivalents CMJN du ton direct s’affichent dans le panneau Couleur.

Vous pouvez également placer le pointeur sur le ton direct dans le panneau Nuancier. La formule de la couleur apparaît dans l’info-bulle.

Impression d’un objet sur toutes les plaques de couleur
Pour imprimer un objet sur toutes les plaques, y compris sur des plaques de tons directs, appliquez une couleur de repérage à l’objet. La couleur
de repérage s’utilise pour les repères de cadrage et de coupe. Dans le cas d’une sortie composite, les objets auxquels une couleur de repérage a
été appliquée s’impriment sous la forme suivante : C 100, M 100, J 100 et N 100. Dans le cas de séparations, chaque plaque présente une valeur
de 100 %.

1. Sélectionnez les objets auxquels vous souhaitez appliquer la couleur de repérage.
2. Choisissez Fenêtre > Nuancier.
3. Dans le panneau Nuancier, cliquez sur la couleur de repérage .

Impression de dégradés sous forme de séparations
Tenez compte des points suivants lors de la production de séparations pour des documents avec dégradés :

La séparation des couleurs d’un dégradé créé dans InDesign et contenant une association de couleurs quadri et de tons
directs est effectuée à l’aide d’une plaque de couleurs quadri et d’une plaque de tons directs.

La séparation d’un dégradé présentant des couleurs quadri s’effectue sur différentes plaques de couleurs quadri.

Dans le cas d’un dégradé contenant deux teintes d’un même ton direct, la séparation se fait sur une seule plaque de tons
directs.

Pour obtenir un dégradé séparé sur un seul film entre un ton direct et du blanc, créez un fond de dégradé se situant entre le
ton direct et la nuance Papier du panneau Nuancier.

Si vous créez un dégradé de deux tons directs, affectez-leur différents angles de trames. Si deux tons directs présentent le
même angle de trame, ils se superposent, provoquant une surimpression. Si vous n’êtes pas sûr des angles, consultez votre
prestataire de services prépresse.

Impression d’une épreuve composite
Vous pouvez imprimer une épreuve composite en couleurs ou en niveaux de gris pour vérifier les couleurs de votre document. Les images
composites permettent de concevoir et de vérifier la mise en page des séparations avant leur impression finale, généralement coûteuse.
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Lorsque vous imprimez un fichier composite dans InDesign, toutes les couleurs du fichier sont imprimées sur une seule plaque, même si des
couleurs individuelles sont sélectionnées.

Tenez compte des points suivants lorsque vous imprimez des épreuves composites :

une épreuve ne permet pas d’obtenir une représentation exacte de la sortie finale ; toutefois, il est possible d’accroître le degré
de précision d’une épreuve en étalonnant tous les périphériques utilisés lors de la création du document (tels que les scanners,
les moniteurs et les imprimantes). Lorsque les périphériques sont correctement étalonnés, le système de gestion des couleurs
peut être exploité pour obtenir des couleurs fiables et homogènes.

Les options de surimpression sélectionnées dans le document s’impriment correctement sur une imprimante prenant en charge
la surimpression. Etant donné que la plupart des imprimantes de bureau ne prennent pas en charge la surimpression, simulez
les effets de surimpression en sélectionnant l’option Simuler la surimpression du volet Sortie de la boîte de dialogue Imprimer.

Important : sélectionnez l’option Simuler la surimpression pour convertir les tons directs en couleurs quadri pour l’impression.
Si vous envisagez d’utiliser un fichier pour des séparations RIP ou pour une sortie finale, ne sélectionnez pas cette option.

Lors de l’impression sur une imprimante en noir et blanc, InDesign génère une version composite des pages en niveaux de
gris. S’il s’agit d’un document en couleur, InDesign imprime les gris visuellement équivalents afin de simuler une couleur. Par
exemple, le gris utilisé pour simuler une teinte avec 20 % de jaune sera plus clair que le gris utilisé pour simuler une teinte
avec 20 % de noir, car le jaune apparaît plus clair que le noir.

Lorsque vous imprimez les chapitres d’un livre contenant des encres de tons directs ou des styles de recouvrement en conflit,
configurez InDesign de façon à harmoniser les paramètres avec le document type.

Si vous utilisez la gestion des couleurs avec la fonction Livre, vérifiez que les paramètres de gestion des couleurs de la boîte
de dialogue Couleurs sont les mêmes pour chaque document du livre.

Remarque : n’oubliez pas que, tout comme pour les moniteurs, la qualité de reproduction des couleurs varie sensiblement d’une imprimante à
l’autre ; les épreuves fournies par votre prestataire de services sont la meilleure façon de vérifier l’aspect final de votre travail.

Affichage d’un aperçu des séparations de couleurs
Pour obtenir un aperçu des séparations de couleurs, des limites de couverture d’encre et de la surimpression, utilisez le panneau Aperçu des
séparations. L’affichage de l’aperçu des séparations sur votre moniteur vous permet de procéder aux vérifications suivantes :

Vernis et autres pellicules L’affichage de l’aperçu des vernis à l’écran peut se révéler difficile dans la mesure où ils sont transparents. Lorsque
vous affichez de façon isolée un aperçu de la séparation d’un vernis, les zones vernies apparaissent en noir.
Noir riche L’aperçu des séparations vous permet d’identifier les zones qui s’imprimeront en noir riche ou en encre noire quadri (N) mélangée à
des encres de couleur pour une plus grande opacité et une meilleure intensité des couleurs.
Couverture d’encre Une trop grande quantité d’encre déposée sur le papier risque de poser des problèmes de séchage. Vérifiez auprès de votre
imprimeur la couverture d’encre maximale de la presse qui sera utilisée. Vous pourrez ainsi identifier sur l’aperçu du document les zones où la
couverture d’encre dépasse les limites de la presse.
Surimpression Vous pouvez afficher un aperçu de la reproduction de la fusion, de la transparence et de la surimpression sur une impression en
séparations des couleurs.
Remarque : vous pouvez également voir les effets de surimpression lorsque vous imprimez sur un périphérique d’impression composite. Ceci est
utile pour vérifier la séparation des couleurs.
Bien que l’aperçu des séparations sur votre moniteur permette d’identifier des problèmes sans subir le coût de l’impression des séparations, il ne
vous permet pas de prévisualiser le recouvrement, les options d’émulsion, les repères d’impression, les trames de demi-teinte ou la résolution.
Vérifiez ces paramètres auprès de votre imprimeur au moyen d’épreuves par superposition ou intégrales.

Remarque : les objets répartis sur des calques masqués n’apparaissent pas dans l’aperçu à l’écran.

Aperçu des plaques de séparation
1. Sélectionnez Fenêtre > Sortie > Aperçu des séparations.
2. Choisissez Séparations dans le menu déroulant Affichage.
3. Utilisez l’une des méthodes suivantes :

Pour afficher une seule séparation et masquer toutes les autres, cliquez sur le nom de la séparation à afficher. Par défaut,
les zones de couverture apparaissent en noir. Si ce paramètre par défaut ne vous convient pas, désélectionnez
l’option Afficher chaque plaque en noir dans le menu du panneau.

Pour afficher une ou plusieurs séparations, cliquez sur la case vide située à gauche du nom de chaque séparation.
Chacune des séparations apparaît dans la couleur qui lui a été assignée.

Pour masquer une ou plusieurs séparations, cliquez sur l’icône en forme d’œil  située à gauche du nom de chaque
séparation.

Pour afficher simultanément toutes les plaques quadri, cliquez sur l’icône CMJN .

Pour afficher simultanément toutes les séparations, cliquez, puis faites glisser le pointeur sur toutes les icônes en forme
d’œil (ou toutes les cases vides) en regard du nom des séparations.



 

Vous pouvez également commander le panneau Aperçu des séparations au moyen des raccourcis clavier.

Aperçu d’une seule séparation (à gauche) et de plusieurs séparations (à droite)

Aperçu de la couverture d’encre
1. Sélectionnez Fenêtre > Sortie > Aperçu des séparations.
2. Choisissez Limite d’encre dans le menu déroulant Affichage. Entrez une valeur de couverture d’encre maximale dans la case

qui apparaît en regard du menu déroulant Affichage (demandez à votre imprimeur la valeur appropriée à spécifier).
3. Vérifiez la couverture d’encre sur l’aperçu du document. Les zones dont la couverture d’encre est excessive sont représentées

dans les tons rouge (les zones rouge foncé dépassant davantage la limite de couverture d’encre que les zones rouge clair).
Toutes les autres zones apparaissent en niveaux de gris.

Les zones de couverture d’encre excessive sont représentées en rouge.

4. Pour vérifier la couverture d’encre d’une zone particulière, survolez-la avec le pointeur dans la fenêtre de document. Les
pourcentages de couverture d’encre apparaissent dans le panneau en regard du nom de l’encre.

Vous pouvez régler la couverture d’encre en convertissant certains tons directs en couleurs quadri. Pour régler la couverture d’encre dans des
images importées, modifiez ces images dans leur application source respective.

Rétablissement du mode d’affichage standard
1. Sélectionnez Fenêtre > Sortie > Aperçu des séparations.
2. Choisissez Désactivé dans le menu déroulant Affichage.

Voir aussi
Vidéo Préparation des fichiers pour la sortie
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A propos de l’impression
Impression d’un document ou d’un livre

Impression depuis le panneau Pages
Options d’impression de pages
Options d’impression pour les objets imprimables

Impression de documents comportant plusieurs formats de page
Spécification des pages à imprimer
Spécification de la taille de papier et de l’orientation de la page

Pour spécifier la taille de papier et l’orientation de la page
Pour choisir un format de papier personnalisé

Choix des calques à imprimer ou à exporter au format PDF
Impression sur des imprimantes non PostScript
Impression sous forme d’images bitmap
Aperçu des documents
Configuration d’une imprimante

A propos des pilotes d’impression
Accès aux fonctions du pilote d’impression
Sélection d’un fichier PPD

Utilisation d’impressions prédéfinies
Création de paramètres d’impression prédéfinis
Application d’impressions prédéfinies
Edition d’impressions prédéfinies
Suppression d’impressions prédéfinies

A propos de l’impression

Qu’il s’agisse de fournir des documents en couleurs à un prestataire de services externe ou d’envoyer une
version d’épreuve sur une imprimante laser ou à jet d’encre, il est préférable d’acquérir quelques notions de
base sur l’impression qui faciliteront la sortie de documents et vous permettront d’obtenir à coup sûr le
résultat escompté.

Types d’impression

Lors de l’impression d’un fichier, Adobe InDesign l’envoie vers un périphérique d’impression soit pour
l’imprimer directement sur papier ou sur une presse d’impression numérique, soit pour le convertir sur film en
image positive ou négative. Le film permet alors de créer une planche maîtresse pour l’impression du
document sur presse commerciale.

Types d’images

Les types d’images les plus simples, comme le texte, n’utilisent qu’une seule couleur dans un seul niveau de
gris. Les images plus complexes présentent des variations de teintes. On parle alors d’images à tons
continus. Une photographie est un exemple d’image à tons continus.
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Simili

Pour simuler des tons continus, les images sont décomposées en une série de points. Ce processus
s’appelle le simili. Les variations de taille et de densité des points d’une trame de simili donnent l’illusion
optique de différents niveaux de gris ou de différents tons continus au sein de l’image imprimée.

Séparation des couleurs

Les illustrations destinées à la diffusion commerciale et contenant plusieurs couleurs doivent être imprimées
sur des plaques distinctes, une pour chaque couleur. Ce processus s’appelle la séparation des couleurs.

Précision du détail

Le détail d’une image imprimée est le fruit d’un équilibre entre la résolution et la linéature. Plus la résolution
du périphérique de sortie est élevée, et plus la linéature est fine (élevée).

Impression recto-verso

Pour accéder aux fonctionnalités spécifiques à une imprimante (comme l’impression recto-verso), cliquez sur
le bouton Imprimante de la boîte de dialogue d’impression. L’impression recto-verso est disponible
uniquement si l’imprimante prend en charge cette fonctionnalité. Pour plus de détails sur l’impression recto-
verso, reportez-vous à la documentation de l’imprimante.

Objets transparents

Si l’illustration contient des objets dotés d’effets de transparence ajoutés à l’aide du panneau Effets ou des
commandes Ombre portée ou Contour progressif, elle est aplatie en fonction des valeurs du paramètre
prédéfini d’aplatissement sélectionné. Il est possible de modifier le taux d’images pixellisées par rapport aux
images vectorielles de l’illustration imprimée.

Pour plus de détails sur l’impression, rendez-vous sur le site Adobe Print Resource Center à l’adresse
suivante : www.adobe.com/go/print_resource_fr. Pour obtenir des solutions à vos problèmes d’impression,
rendez-vous à l’adresse www.adobe.com/go/learn_id_printtrouble_fr.

Impression d’un document ou d’un livre

1. Vérifiez que le pilote d’impression et le fichier PPD appropriés sont installés sur votre
ordinateur.

2. Ouvrez la boîte de dialogue Imprimer :

Si des documents individuels sont ouverts, choisissez Fichier > Imprimer pour ouvrir
la boîte de dialogue d’impression correspondant au document actif.

Si aucun document ou l’ensemble des documents est sélectionné dans le panneau
Livre, choisissez l’option Imprimer Livre dans le menu de ce panneau pour imprimer
tous les documents d’un livre.

Si vous avez sélectionné des documents dans le panneau Livre, choisissez l’option
Imprimer les documents sélectionnés dans le menu du panneau Livre.

3. Spécifiez l’imprimante que vous utilisez dans le menu Imprimante. Si les paramètres
prédéfinis d’impression vous conviennent, choisissez-les dans le menu Impression
prédéfinie.

http://www.adobe.com/go/print_resource_fr
http://www.adobe.com/go/learn_id_printtrouble_fr
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Séquence

4. Dans la zone Général, saisissez le nombre de copies à imprimer, choisissez l’impression
de copies assemblées ou dans l’ordre inverse et indiquez quelles pages vous voulez
imprimer.

L’option Etendue n’est pas disponible si vous imprimez un livre.

Si vous imprimez un document comportant des pages de divers formats, utilisez les
commandes visibles au-dessus du champ Etendue pour sélectionner toutes les pages
de même format (voir Impression de documents comportant plusieurs formats de page).

5. Indiquez si vous voulez imprimer les objets non imprimables, les pages vides, les grilles
de ligne de base et les repères visibles.

6. Modifiez les paramètres de chaque zone de la boîte de dialogue Imprimer selon vos
besoins.

7. Cliquez sur Imprimer.

Les paramètres spécifiés dans la boîte de dialogue Imprimer sont enregistrés avec le document.

Impression depuis le panneau Pages

Vous pouvez également utiliser les options d’impression disponibles dans le panneau Pages.

1. Dans le panneau Pages, effectuez l’une des opérations suivantes :

Sélection d’une seule page
Sélection de plusieurs pages
Sélection d’un gabarit
Sélection d’une planche de pages

2. Cliquez avec le bouton droit de la souris sur la sélection et choisissez Imprimer la page ou Imprimer la
planche (selon votre sélection).

Ou choisissez Imprimer la page ou Imprimer la planche depuis le menu rapide du panneau Pages.

La boîte de dialogue d’impression s’affiche et indique la page ou la plage sélectionnée.

3. Cliquez sur Imprimer.

Options d’impression de pages

Vous pouvez imprimer toutes les pages, les pages paires ou impaires uniquement, une page plusieurs fois
ou un groupe de pages.

Spécifie le groupe de pages à imprimer dans le document actif. Séparez les numéros de pages
d’une étendue de pages à l’aide d’un trait d’union et plusieurs pages ou étendues de pages à l’aide de
virgules ou d’espaces (voir Spécification des pages à imprimer).
Si le document comporte des pages de différents formats, vous pouvez utiliser les options disponibles au-
dessus du champ Etendue pour sélectionner toutes les pages de même format (voir Impression de
documents comportant plusieurs formats de page).

Imprime la page active dans le document actif.

le numéro de la page active est spécifié au format suivant : Page active : de la mise
en page>:

Choisissez Toutes les pages pour imprimer l’ensemble des pages d’un document. Choisissez
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Imprimer les gabarits

Imprimer les calques

Pages paires ou Pages impaires pour imprimer uniquement les pages d’un groupe spécifique. Ces options ne
sont pas disponibles lorsque vous utilisez les options Planches ou Imprimer les gabarits.

Imprime les pages de manière solidaire comme si elles étaient liées ou imprimées sur la même
feuille. Vous ne pouvez pas imprimer plus d’une planche par feuille. Si les dimensions de la nouvelle page
dépassent celles du format de papier sélectionné, InDesign imprime le maximum de surface, mais ne met pas
automatiquement la page à l’échelle de la zone imprimable, à moins que l’option Ajuster de la zone Format
ne soit sélectionnée dans la boîte de dialogue Imprimer. Vous pouvez également spécifier une orientation
paysage.

si des styles de recouvrement différents sont appliqués aux pages de la planche, InDesign
résout les problèmes de différences.

Imprime tous les gabarits et non les pages du document. Sélectionnez cette option
pour rendre l’option Pages non disponible.

Exemples d’étendues de pages

Etendue Pages imprimées

11- De la page 11 à la dernière page du document.

-11 Toutes les pages jusqu’à la page 11 comprise.

+11 Page 11 uniquement.

-+11 Toutes les pages jusqu’à la page 11 comprise.

+11- Toutes les pages de la onzième page à la fin du document.

1, 3-8, Page 1, plus pages 3 à 8.

+1, +3-+8, Page 1, plus pages 3 à 8.

Sec1 Toutes les pages de la section intitulée « Sec1 »

Sec2:7 Page numérotée 7 (pas nécessairement la septième page de cette
section) dans la section intitulée « Sec2 ».

PartB:7- Page numérotée 7 dans la section intitulée « PartB » jusqu’à la
dernière page de la section.

Chap2:7-
Chap3

Page numérotée 7 dans la section intitulée « Chap2 » jusqu’à la fin de
la section intitulée « Chap3 ».

Sec4:3-
Sec4:6,
Sec3:7

Pages 3 à 6 de « Sec4 » et page 7 de « Sec3 ».

Options d’impression pour les objets imprimables

La zone Général de la boîte de dialogue Imprimer contient des options permettant d’imprimer des éléments
qui ne sont généralement visibles qu’à l’écran, comme les grilles et les repères. Utilisez l’une des méthodes
suivantes :

Déterminez les calques à imprimer (voir la section Choix des calques à imprimer ou à



Imprimer les objets non imprimables

Imprimer les pages vides

Imprimer les grilles de ligne de base et repères visibles
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exporter au format PDF).

Imprime tous les objets, quels que soient les paramètres définis
individuellement pour empêcher l’impression d’objets de manière sélective.

Imprime toutes les pages d’un groupe de pages spécifié même si cette page ne
contient aucun texte ou objet. Cette option n’est pas disponible lorsque vous imprimez des séparations. Si
vous utilisez l’option Imprimer le livret pour l’impression d’une épreuve composite, utilisez l’option Imprimer
les planches vides pour imprimer les planches vides ajoutées de façon à remplir les signatures de l’épreuve
composite.

Imprime les grilles de ligne et les repères visibles
dans la même couleur que celle affichée dans le document. Utilisez le menu Affichage pour contrôler les
repères et les grilles visibles. Cette option n’est pas disponible lorsque vous imprimez des séparations.

Impression de documents comportant plusieurs formats de page

Vous pouvez décider d’imprimer séparément les pages qui se présentent dans des formats différents. La
boîte de dialogue Imprimer contient une option qui facilite la sélection de toutes les pages de même format
dans un document.

Avant d’envoyer un document comportant divers formats de page à l’impression, demandez conseil à votre
imprimeur en ce qui concerne les spécifications d’impression particulières. Si l’impression d’un document
faisant appel à divers formats de page se révèle difficile, envisagez de diviser ce document en sections de
document distinctes.

1. Sélectionnez Fichier > Imprimer.

2. Dans le panneau Général, sélectionnez ou désélectionnez l’option Planches pour
indiquer si vous imprimez des planches ou des pages.

Le format d’une planche comportant des pages de formats différents est fonction de la
largeur et de la hauteur maximales figurant sur cette planche.

3. Pour imprimer uniquement des pages de même format, sélectionnez l’une des pages ou
planches à l’aide des options visibles au-dessus du champ Etendue, puis cliquez sur
l’icône de pages .

Le champ Etendue affiche toutes les pages ou planches se présentant dans ce format.

4. Après avoir imprimé une série de pages dans un format donné, reprenez ces étapes
pour imprimer d’autres formats de page.

Spécification des pages à imprimer

Vous pouvez spécifier une étendue de pages à l’aide d’une numérotation absolue (la position de la page
dans le document) ou d’une numérotation de page ou de section (les numéros de section et de page
attribués à la page). Par défaut, les boîtes de dialogue d’InDesign respectent le format spécifié pour la
numérotation des pages dans la boîte de dialogue Préférences.

Lorsque l’option Numérotation absolue est sélectionnée, les numéros spécifiés
correspondent à la position absolue des pages du document. Par exemple, pour imprimer
la troisième page du document, entrez « 3 » dans la zone Etendue de la boîte de
dialogue Imprimer.

Lorsque l’option Numérotation des sections est sélectionnée dans la boîte de dialogue
Préférences, vous pouvez entrer les pages ou étendues telles qu’elles s’affichent dans
votre mise en page ou à l’aide de la numérotation absolue. Par exemple, si la page
intitulée SecA:5 correspond à la quinzième page du document, vous pouvez l’imprimer en
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entrant « SecA:5 » dans la boîte de dialogue Imprimer ou en entrant « +15 ». Le signe
« + » indique que vous voulez utiliser la numérotation de section et de page plutôt que la
numérotation absolue.

Si vous ne savez pas quel format utiliser pour indiquer les numéros de pages, copiez le format qui
s’affiche au bas de la fenêtre du document.

Spécification de la taille de papier et de l’orientation de la page

Il est important de bien distinguer le format de page (défini dans la boîte de dialogue Format de document) et
le format du papier (qui est la feuille de papier, la partie du film ou la zone de la plaque d’impression utilisée).
Il se peut que le format de page soit Lettre US (216 par 279 millimètres), mais que vous ayez besoin
d’imprimer sur une surface de papier ou de film plus grande pour accueillir les repères de l’imprimante ou les
zones de fond perdu ou de ligne-bloc.

La liste des formats de papier disponibles dans InDesign est fournie dans le fichier PPD (imprimantes
PostScript) ou dans le pilote d’impression (imprimantes non PostScript). Si l’imprimante et le PPD choisis
pour l’impression PostScript prennent en charge les formats de papier personnalisés, l’option Personnalisé
dans le menu Format du papier s’affiche.

La plupart des photocomposeuses peuvent accueillir des formats de papier normaux, comme les formats
lettre ou tabloïd, ainsi que les orientations transversales, pour lesquelles le format de page normal est pivoté
de 90° lors de l’impression. Avec une photocomposeuse, l’orientation transversale est souvent plus efficace.

Format de page et orientations pour photocomposeuses

A. Lettre (portrait) B. Format de page personnalisé (portrait) C. Lettre (orientation transversale) 

Les formats de page sont répertoriés selon leur nom usuel (par exemple, A4). Les dimensions définissent les
limites de la zone imprimable, c’est-à-dire la surface totale de papier moins la bordure de non impression
utilisée par l’imprimante ou la photocomposeuse. La plupart des imprimantes laser ne sont pas conçues pour
imprimer à partir du bord de la feuille.

Si vous changez le format de page (de A4 à B5, par exemple), le document est automatiquement remis à
l’échelle dans la fenêtre d’aperçu. Cette fenêtre affiche l’intégralité de la surface imprimable de la page
sélectionnée ; toute modification de format d’aperçu entraîne une remise à l’échelle de la surface afin
d’inclure la zone imprimable.

pour un même format de papier (A4, par exemple), la zone imprimable varie selon le
fichier PPD, car chaque imprimante ou photocomposeuse gère différemment le format de la zone imprimable.
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Impression d’une page au format lettre sur du papier Letter, Letter.extra ou Tabloid

l’aperçu situé dans la zone inférieure gauche de la boîte de dialogue Imprimer indique si
l’espace disponible est suffisant pour inclure l’ensemble des repères de l’imprimante, ainsi que les fonds
perdus et les lignes-bloc.

Pour spécifier la taille de papier et l’orientation de la page

1. Choisissez Fichier > Imprimer.

2. Dans la boîte de dialogue Imprimer, choisissez une option dans le menu Format du
papier de la zone Format.

Vérifiez que le format de papier spécifié est suffisamment grand pour contenir le
document, les fonds perdus, les lignes-bloc (le cas échéant) et les repères de
l’imprimante. Pour conserver le papier ou le film de la photocomposeuse, sélectionnez le
format de papier le plus petit permettant de contenir le document et les informations
d’impression nécessaires.

3. Cliquez sur le bouton Orientation pour faire pivoter le document sur le support.

Dans la plupart des cas, l’orientation de la page spécifiée dans Format de document
(Fichier > Format de document) et l’orientation de sortie spécifiée dans la zone Format
de la boîte de dialogue Imprimer doivent être les mêmes (toutes deux portrait ou
paysage), qu’il s’agisse d’une impression normale ou transversale. Si vous imprimez des
planches, choisissez une orientation et un format de papier différents pour ajuster toutes
les pages d’une planche sur une feuille unique. Si vous avez appliqué une rotation à la
planche, vous devrez sans doute changer l’orientation de façon à l’imprimer dans le bon
sens.

Boutons d’orientation

A. Portrait B. Paysage C. Portrait inversé D. Paysage inversé 
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Pour choisir un format de papier personnalisé

Si vous utilisez un périphérique d’impression qui prend en charge différents formats de papier, comme c’est le
cas par exemple des photocomposeuses haute résolution, vous pouvez spécifier un format personnalisé pour
l’impression. L’option de personnalisation est uniquement disponible dans InDesign si le PPD choisi prend en
charge les formats de papier personnalisés.

Le plus grand format de papier personnalisé que vous puissiez spécifier dépend de la zone imprimable
maximale de votre photocomposeuse. Pour plus de détails, consultez la documentation de votre imprimante.

les options de formats de papier personnalisés pour les imprimantes non PostScript ne sont pas
accessibles dans la boîte de dialogue d’impression d’InDesign. Pour définir les fonctionnalités spécifiques à
une imprimante, cliquez sur Configurer (Windows), Imprimante ou Format d’impression (Mac OS), dans la
boîte de dialogue Imprimer d’InDesign. Pour plus de détails, consultez la documentation du pilote de votre
imprimante non PostScript.

1. Choisissez Fichier > Imprimer.

2. Si vous imprimez un fichier PostScript, choisissez PostScript comme option d’imprimante
dans la zone Général de la boîte de dialogue Imprimer. Sélectionnez ensuite le
fichier PPD qui prend en charge les formats de papier personnalisées.

3. Dans le menu Format du papier de la zone Format de la boîte de dialogue Imprimer,
choisissez Personnalisé.

si cette option n’est pas disponible, cela signifie que le PPD que vous avez
sélectionné lors de la configuration de l’imprimante ne prend pas en charge les formats
de papier personnalisés.

4. Pour spécifier la hauteur et la largeur, utilisez l’une des méthodes suivantes :

Sélectionnez Automatique pour Largeur et Hauteur afin de laisser InDesign
déterminer le format de papier le plus petit adapté au contenu de votre document,
pour les fonds perdus, les lignes-bloc et les repères de l’imprimante. L’option par
défaut, Automatique, est également utile si le livre contient des pages de différents
formats et si vous imprimez sur un support continu, comme une bobine de film ou du
papier photosensible.

Pour spécifier un format de papier supérieur au format par défaut, entrez de
nouvelles dimensions dans les zones de texte Largeur et Hauteur. Veillez à ce que
les valeurs choisies soient supérieures aux valeurs par défaut, sans quoi le
document risquerait d’être tronqué.

5. Pour modifier le positionnement de la page sur le film, entrez une valeur dans Décalage.

Cette valeur correspond à l’espace supplémentaire situé à gauche de la zone
imprimable. Par exemple, un décalage de 30 points déplace la surface imprimable de
30 points vers la droite.

6. Pour faire pivoter le contenu de la page et du support, sélectionnez Transversal, puis
cliquez sur Imprimer.

Vous pouvez économiser une quantité importante de film ou de papier en associant les
options Transversal et Décalage. Comparez les exemples suivants d’une image
imprimée dans InDesign avec l’option Transversal sélectionnée et désélectionnée.
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Tous les calques

Calques visibles

Calques visibles et imprimables
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Option Transversal non sélectionnée (à gauche) et sélectionnée (à droite)

A. Valeur de décalage B. Espace C. Economie réalisée 

7. L’option Espace spécifie la distance séparant chaque page lors de l’impression sur des
supports continus.

Choix des calques à imprimer ou à exporter au format PDF

1. Pour vérifier ou modifier les paramètres Afficher le calque et Imprimer le calque du
document, sélectionnez un calque dans le panneau Calques, puis choisissez
l’option Options de calque dans le menu du panneau. Définissez les options de calque,
puis cliquez sur OK.

2. Utilisez l’une des méthodes suivantes :

Choisissez Fichier > Imprimer, puis cliquez sur Général dans la partie gauche de la
boîte de dialogue Imprimer.

Choisissez Fichier > Exporter, activez l’option Adobe PDF et cliquez sur Enregistrer.
Dans la partie gauche de la boîte de dialogue Exporter au format Adobe PDF, cliquez
sur Général.

3. Dans le menu Imprimer les calques ou Exporter les calques, choisissez les calques à
imprimer ou à inclure dans le PDF :

Imprime tous les calques du document, même s’ils sont masqués ou
définis comme non imprimables.

Imprime tous les calques visibles, même s’ils sont définis comme non
imprimables dans Options de calque.

Imprime uniquement les calques définis comme
visibles et imprimables.

Impression sur des imprimantes non PostScript

Vous pouvez imprimer un document sur une imprimante non PostScript. Cependant, PostScript étant le
langage standard de description de pages pour la publication professionnelle, de nombreuses fonctionnalités
graphiques et couleurs haut de gamme, telles que les linéatures ou les séparations de couleurs, ne sont pas
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Standard

reproduites sur des imprimantes non PostScript. La plupart des formats de fichiers graphiques importés
offrent une impression de qualité acceptable. En général, l’aspect d’un document imprimé sur un périphérique
de sortie non PostScript est semblable à l’aspect du document affiché en mode Aperçu.

Certains distributeurs de logiciels ajoutent des fonctionnalités de langage PostScript à des imprimantes
non PostScript. Vérifiez auprès de votre distributeur la disponibilité et la compatibilité de ces
fonctionnalités.

Impression sous forme d’images bitmap

Lorsque vous imprimez sur une imprimante non PostScript, vous pouvez choisir de pixelliser toutes les
illustrations pendant l’impression. Cette option est utile lors de l’impression de documents contenant des
objets complexes (tels que des objets avec des ombres lissées ou des dégradés) car elle diminue le risque
d’erreur.

1. Choisissez Fichier > Imprimer.

2. Sélectionnez l’option Avancé dans la partie gauche de la boîte de dialogue Imprimer.

3. Sélectionnez l’option Bitmap.

Cette option est disponible uniquement si le pilote d’impression identifie l’imprimante
comme non PostScript. Si vous activez cette option pour des imprimantes non PostScript
sous Mac OS 10.3 ou une version ultérieure, InDesign imprime au format PostScript,
utilisé par Mac OS et le pilote pour obtenir le rendu des images de la page. Sous
Windows, les fonctionnalités graphiques et couleurs haut de gamme peuvent ne pas être
converties correctement si cette option n’est pas activée.

4. Indiquez la résolution de l’impression au format bitmap.

La résolution du pilote d’impression peut restreindre la résolution de l’impression. Pour
obtenir une qualité d’impression optimale, la résolution du pilote d’impression
non PostScript doit être égale ou supérieure à la résolution d’impression spécifiée dans
la boîte de dialogue Imprimer d’InDesign.

Aperçu des documents

Il est possible de visualiser les proportions des pages d’un document sur un format de papier défini avant
l’impression sur une imprimante PostScript. La zone inférieure gauche de la boîte de dialogue d’impression
offre un aperçu et permet de confirmer les paramètres d’orientation et de format de papier. Lorsque vous
sélectionnez différentes options dans la boîte de dialogue Imprimer, l’aperçu se met instantanément à jour
ainsi que les effets associés aux paramètres d’impression.

1. Choisissez Fichier > Imprimer.

2. Cliquez sur la zone d’aperçu dans la zone inférieure gauche de la boîte de dialogue
d’impression.

Il existe trois types d’aperçus :

Affiche le rapport entre une page de document et le support. L’aperçu montre également les effets
de différentes options telles que le format du papier sur la zone imprimable, les fonds perdus, les lignes-bloc,
les repères de page, ainsi que les effets de mosaïque et de vignettes.
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Quatre formats de page en aperçu Standard

A. Par défaut B. Planches C. Orientation D. Vignettes 2x2 

Répertorie les valeurs numériques de certains paramètres d’impression.

Affiche les effets des différents paramètres
d’impression en fonction du format de la page. En ce qui concerne les formats de page, l’aperçu affiche les
proportions du support en fonction du périphérique de sortie personnalisé, les dimensions maximales du
support prises en charge par le périphérique de sortie et les paramètres de décalage, d’espacement et de
transversale. En ce qui concerne les feuilles séparées, comme les lettres et les tabloïds, l’aperçu présente le
rapport entre la zone imprimable et le format du support.
Dans les aperçus de pages personnalisées et de feuilles séparées, le mode de sortie est également précisé
à l’aide d’une des icônes suivantes : Séparations , Gris composite , CMJN composite  ou RVB
composite .

Aperçu de page personnalisée (gauche) et aperçu de feuille séparée (droite)

A. Direction de déplacement du support B. Option Transversal non sélectionnée C. Format du papier D.
Support E. Zone imprimable F. Support 

Configuration d’une imprimante
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InDesign prend en charge l’impression sur imprimantes PostScript® (Niveaux 2 et 3) et non PostScript, à
l’aide des pilotes d’impression les plus répandus. Lorsque vous imprimez un document sur une imprimante
PostScript, InDesign utilise les informations fournies à partir d’un fichier PPD (PostScript Printer Description)
pour déterminer les paramètres à afficher dans la boîte de dialogue Imprimer.

Pour configurer une imprimante, procédez comme suit :

Installez le pilote d’impression le plus récent adapté à votre périphérique de sortie (voir la
documentation de votre système d’exploitation).

Pour une impression PostScript, sélectionnez un fichier PPD pour configurer l’imprimante.

A propos des pilotes d’impression

Un pilote d’impression permet d’accéder aux fonctions de l’imprimante depuis les applications installées sur
votre ordinateur. L’installation du pilote approprié garantit votre accès à toutes les fonctions de l’imprimante.

Adobe recommande d’installer la version la plus récente adaptée à votre système d’exploitation.

Accès aux fonctions du pilote d’impression

Les pilotes d’impression peuvent prendre en charge des fonctions non incluses dans InDesign, telles que
l’impression double-ton. Ces fonctions ne sont pas prises en charge par tous les pilotes d’impression.
Contactez le fabricant de votre imprimante pour de plus amples informations.

Pour spécifier les paramètres d’une imprimante particulière, utilisez les boutons suivants de la boîte de
dialogue Imprimer d’InDesign (si vous choisissez d’imprimer vers un fichier PostScript, ces options ne sont
pas disponibles).

Sous Windows, ce bouton ouvre la boîte de dialogue Imprimer de Windows.

Sous Mac OS, ce bouton affiche la boîte de dialogue Format d’impression standard de
Mac OS.

Sous Mac OS, ce bouton permet d’afficher la boîte de dialogue d’impression standard du
système.

certaines fonctions d’impression d’InDesign existent aussi bien dans les boîtes de dialogue du
pilote d’impression que dans la boîte de dialogue d’impression d’InDesign. Il est toutefois préférable de définir
les paramètres dans la boîte de dialogue d’impression d’InDesign. En cas de conflit des paramètres, InDesign
tente de les harmoniser ou d’ignorer les paramètres du pilote. Certaines fonctions du pilote d’impression
(comme l’option de disposition utilisée pour imprimer la même illustration plusieurs fois sur une même page)
génèrent des résultats d’impression inattendus lorsqu’elles sont utilisées avec des fonctions d’InDesign, telles
que les séparations.

Sélection d’un fichier PPD

Un fichier PPD (acronyme de l’anglais PostScript Printer Description) permet de personnaliser le pilote
spécialement pour votre imprimante PostScript. Il contient des informations sur le périphérique de sortie,
notamment les polices installées sur l’imprimante, la taille et l’orientation des supports disponibles, les
possibilités optimales en matière de linéature de trame, d’angles de trame, de résolution et de sortie couleur.
Il est important de configurer le fichier PPD correct avant d’imprimer. La sélection du fichier PPD
correspondant à l’imprimante PostScript ou à la photocomposeuse utilisée indique les paramètres disponibles
pour le périphérique de sortie dans la boîte de dialogue Imprimer. Vous pouvez en choisir un différent selon
vos besoins. Les applications utilisent les informations du fichier PPD pour déterminer les informations
PostScript à envoyer à l’imprimante lors de l’impression d’un document.
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Remarque :

Pour obtenir les meilleurs résultats d’impression, Adobe vous conseille d’obtenir la dernière version du fichier
PPD pour votre périphérique de sortie auprès du fabricant. De nombreux prestataires de services
d’impression et imprimeurs disposent des fichiers PPD pour les photocomposeuses dont ils se servent.
Veillez à stocker les fichiers PPD à l’emplacement spécifié par le système d’exploitation. Pour plus de détails,
consultez la documentation de votre système.

Sous Windows et Mac OS, la sélection d’un fichier PPD est similaire à l’ajout d’une
imprimante. Les étapes permettant de sélectionner un fichier PPD sont différentes pour
chaque plate-forme. Pour plus de détails, reportez-vous à la documentation de votre
système d’exploitation.

Utilisation d’impressions prédéfinies

Si vous utilisez régulièrement différents types de travaux ou imprimantes, vous pouvez automatiser les
travaux d’impression en enregistrant tous les paramètres de sortie comme impressions prédéfinies.
L’utilisation d’impressions prédéfinies est une manière fiable et rapide d’imprimer des travaux nécessitant des
paramètres précis et constants pour de nombreuses options de la boîte de dialogue Imprimer.

Vous pouvez enregistrer et charger des impressions prédéfinies, ce qui facilite leur sauvegarde ou leur mise
à disposition à vos prestataires de services, vos clients ou d’autres personnes de votre groupe de travail.

Vous pouvez créer et réviser les impressions prédéfinies dans la boîte de dialogue Impressions prédéfinies.

Création de paramètres d’impression prédéfinis

Utilisez l’une des méthodes suivantes :

Sélectionnez Fichier > Imprimer, ajustez les paramètres d’impression et cliquez sur
Enregistrer le paramètre prédéfini. Saisissez un nom ou utilisez le nom par défaut,
puis cliquez sur OK. Avec cette méthode, le paramètre prédéfini est enregistré dans
le fichier des préférences.

Choisissez la commande Fichier > Impressions prédéfinies > Définir, puis cliquez sur
le bouton Nouveau. Dans la boîte de dialogue qui s’affiche, saisissez un nouveau nom
ou utilisez le nom par défaut, ajustez les paramètres d’impression et cliquez sur OK
pour revenir à la boîte de dialogue Impressions prédéfinies. Cliquez de nouveau
sur OK.

Application d’impressions prédéfinies

1. Choisissez Fichier > Imprimer.

2. Sélectionnez une impression prédéfinie dans le menu Impression prédéfinie. Si vous le
souhaitez, confirmez les paramètres d’impression dans la boîte de dialogue Imprimer.

3. Cliquez sur Imprimer.

dans InDesign, vous pouvez également imprimer à l’aide d’une impression prédéfinie
sélectionnée dans le menu Fichier > Impressions prédéfinies.

Edition d’impressions prédéfinies

Utilisez l’une des méthodes suivantes :

Sélectionnez Fichier > Imprimer, ajustez les paramètres d’impression et cliquez sur
Enregistrer le paramètre prédéfini. Dans la boîte de dialogue Enregistrer le paramètre
prédéfini qui s’affiche, saisissez un nom dans la zone de texte ou utilisez le nom
actuel (si le nom actuel est un paramètre prédéfini existant, l’enregistrement écrase
les paramètres correspondants). Cliquez sur le bouton OK.
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Choisissez la commande Fichier > Impressions prédéfinies > Définir, sélectionnez un
paramètre prédéfini dans la liste, puis cliquez sur le bouton Modifier. Ajustez les
paramètres d’impression et cliquez sur OK pour revenir à la boîte de dialogue
Impressions prédéfinies. Cliquez de nouveau sur OK.

Vous pouvez modifier le paramètre prédéfini par défaut comme tout autre paramètre à
l’aide des étapes décrites ci-dessus.

Suppression d’impressions prédéfinies

1. Choisissez la commande Fichier > Impressions prédéfinies > Définir.

2. Sélectionnez un ou plusieurs paramètres prédéfinis dans la liste et cliquez sur
Supprimer. Cliquez en maintenant la touche Maj enfoncée afin de sélectionner des
paramètres prédéfinis adjacents. Maintenez la touche Ctrl (Windows) ou Commande
(Mac OS) enfoncée et sélectionnez des paramètres prédéfinis non adjacents.

Adobe recommande également
Spécification de la résolution et de la linéature des trames de demi-teintes
Adobe Print Resource Center
Exportation des pages au format EPS
Spécification des repères de l’imprimante
Exportation au format PDF pour l’impression

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr
http://www.adobe.com/go/print_resource_fr
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Création de fichiers PostScript ou EPS
Choix de la méthode de création d’un fichier PostScript
A propos des fichiers PostScript dépendants du périphérique et du pilote
Création d’un fichier PostScript indépendant du périphérique
Création d’un fichier PostScript dépendant du périphérique dans InDesign
Création d’un fichier PostScript à l’aide d’un pilote d’impression PostScript (Windows)
Création d’un fichier PostScript à l’aide d’un pilote d’impression PostScript (Mac OS)
Exportation des pages au format EPS

Pour plus d’informations et d’instructions, cliquez sur les liens ci-dessous.

Création de fichiers PostScript ou EPS
Si vous ne souhaitez pas imprimer un document sur une imprimante, enregistrez-en une description en langage PostScript au format PS et
imprimez-la sur un périphérique de sortie distant, chez un prestataire de services par exemple. Ce dernier peut envoyer un fichier PS directement
à une photocomposeuse. La taille d’un fichierPostScript est généralement supérieure à celle d’un document InDesign d’origine, car les images et
les polices sont incorporées.

Vous pouvez également exporter une page ou une planche d’un document vers un fichier EPS (Encapsulated PostScript) et l’importer dans
d’autres applications.

Choix de la méthode de création d’un fichier PostScript
Enregistrez le livre ou le document InDesign dans l’un des trois formats de fichiers PostScript suivants : indépendant du périphérique, dépendant
du périphérique ou dépendant du périphérique et du pilote.

Les tableaux suivants recensent les pilotes d’impression et les méthodes de sortie recommandés pour optimiser les résultats avec des applications
de post-traitement et avec InDesign. Si, avant une impression RIP, votre document doit être traité par un serveur OPI, par imposition, par
recouvrement ou par une autre application de prépresse, choisissez Fichier PostScript® dans le menu Imprimante de la boîte de dialogue
Imprimer d’InDesign. InDesign garde le contrôle total de la sortie DSC. Pour une impression de bureau, utilisez un pilote d’imprimante PostScript
pris en charge.

Dans les tableaux, les astérisques indiquent le degré de pertinence de chaque méthode pour les travaux de prépresse :

*** Le fichier PostScript est entièrement conforme aux normes DCS et tout à fait adapté à une utilisation avec un grand nombre d’applications
post-traitement, de RIP et de flux de production. Cette méthode constitue le choix optimal pour les applications qui utilisent beaucoup les
normes DCS.
** Le fichier PostScript est généralement conforme aux normes DCS et adapté à une utilisation avec un grand nombre d’applications post-
traitement, de RIP et de flux de production. Certains types d’applications qui utilisent beaucoup les normes DCS peuvent faire l’objet de problèmes
de compatibilité.

Choix de l’imprimante : fichier PostScript®

Système d’exploitation PPD Adapté à l’impression prépresse

Toutes les plates-formes Indépendant du périphérique ***

 Dépendant du périphérique ***

Le pilote d’imprimante n’est pas utilisé si l’option sélectionnée est Fichier PostScript®.

Choix de l’imprimante : <imprimante installée>

Système d’exploitation Pilote d’impression Adapté à l’impression prépresse

Mac OS 10.2 Pilote PS intégré pour Mac OS X **
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Windows 2000/XP Pscript 5 **

Le fichier PPD utilisé par l’imprimante sélectionnée s’affiche dans la zone PPD en haut de la boîte de dialogue Imprimer.

A propos des fichiers PostScript dépendants du périphérique et du pilote
Sélectionnez une imprimante et un pilote pris en charge dans le menu Imprimante. Un fichier PostScript dépendant du périphérique et du pilote
présente les caractéristiques suivantes :

Il est dépendant du pilote. Le fichier PostScript contient un code généré par InDesign et le pilote. Le code InDesign est à
l’origine du contenu de la page, notamment du téléchargement des polices, et il définit certaines informations relatives au
périphérique, telles que le format du support, la résolution et le tramage. Le pilote définit ses propres fonctionnalités
spécifiques, telles que les filigranes, et il active ou contrôle les fonctionnalités spécifiques du périphérique. Etant donné
qu’InDesign ne contrôle pas totalement la création de fichiers PostScript, le niveau de conformité avec les normes DSC n’est
pas aussi élevé qu’avec des fichiers PostScript indépendants du pilote. Le niveau de conformité avec les normes DSC et par
conséquent l’adéquation du fichier PostScript aux tâches de prépresse dépendent du pilote d’impression utilisé.

Il est dépendant du périphérique. Il contient un code d’activation et de contrôle des fonctionnalités spécifiques du périphérique,
ce qui réduit sa compatibilité avec des périphériques autres que le périphérique cible.

Il peut être composite ou séparé (toutes les méthodes de sortie en couleurs prises en charge par InDesign sont disponibles).

InDesign peut procéder au recouvrement (par le biais du recouvrement Adobe In-RIP ou Intégré à l’application).

Il peut s’imprimer directement sur le périphérique ou le fichier.

Un fichier PostScript dépendant du périphérique et du pilote est adapté à l’épreuvage (par le concepteur) sur des imprimantes PostScript de
bureau. Les prestataires de services peuvent également l’utiliser s’ils n’envisagent pas d’effectuer un travail de prépresse sans InDesign ou un
système RIP. En d’autres termes, le recouvrement doit s’effectuer dans InDesign ou au niveau du RIP.

Création d’un fichier PostScript indépendant du périphérique
Sélectionnez Fichier PostScript dans le menu Imprimante, puis sélectionnez Indépendant du périphérique dans le menu PPD. Un fichier PostScript
indépendant du périphérique présente les caractéristiques suivantes :

Il répond totalement aux normes DSC et il est donc idéal pour la réalisation de tâches de post-traitement comme le
recouvrement et l’imposition.

Toutes les dépendances aux pilotes et aux périphériques sont supprimées de sorte que le fichier s’imprime sur quasiment tous
les périphériques de sortie. Cependant, certaines fonctionnalités d’impression spécifiques de fichiers PPD, comme l’exposition
de l’image, la disponibilité de certains formats de supports et les linéatures optimisées, ne sont pas disponibles dans le cas
d’une sortie indépendante du périphérique.

La sortie en couleurs est toujours une sortie CMJN composite mais présente également des tons directs. Ses couleurs doivent
donc être séparées par un logiciel de post-traitement ou au niveau du RIP au moyen d’une séparation In-RIP.

Le recouvrement par InDesign est impossible : celui-ci doit avoir lieu au niveau du RIP ou du logiciel de post-traitement.

L’impression peut uniquement s’effectuer vers un fichier (et non directement vers un périphérique ou une application) depuis
InDesign.

Un fichier PostScript indépendant du périphérique est adapté aux flux de production de prépresse composites durant lesquels
le fichier fait l’objet d’un recouvrement et d’une séparation des couleurs par exemple lors de l’imposition, du recouvrement ou
au niveau du RIP (si le périphérique de sortie prend en charge les séparations In-RIP).

1. Choisissez Fichier > Imprimer.
2. Dans la boîte de dialogue d’impression, dans Imprimante, choisissez Fichier PostScript.
3. Dans PPD, choisissez Indépendant du périphérique.
4. Affichez ou modifiez les paramètres d’impression. InDesign utilise le groupe de pages actif lors de la création du fichier

PostScript.
5. Cliquez sur Save.
6. Spécifiez un nom et un emplacement, puis cliquez sur Enregistrer.

Création d’un fichier PostScript dépendant du périphérique dans InDesign
Sélectionnez Fichier PostScript dans le menu Imprimante, puis sélectionnez un fichier PPD. Un fichier PostScript dépendant du périphérique
présente les caractéristiques suivantes :

Il répond totalement aux normes DSC et il est donc idéal pour la réalisation de tâches de post-traitement comme le
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recouvrement et l’imposition.

Il contient une description intégrale du document, y compris des informations relatives aux fichiers liés, aux linéatures
optimisées, à la résolution et aux formats de supports disponibles adaptés au périphérique de sortie actuellement sélectionné.

Toutes les dépendances au pilote sont supprimées.

Il peut être composite ou séparé. Toutes les méthodes de sortie en couleurs prises en charge par InDesign sont disponibles (y
compris les séparations In-RIP dans la mesure où le PPD et le périphérique de sortie les prennent en charge).

InDesign peut procéder au recouvrement (par le biais du recouvrement Adobe In-RIP ou Intégré à l’application).

L’impression peut uniquement s’effectuer vers un fichier (et non directement vers un périphérique ou une application) depuis
InDesign.

Un fichier PostScript dépendant du périphérique est adapté aux processus de préséparation et de recouvrement durant lesquels les fichiers
subissent un recouvrement à l’aide des fonctions automatiques ou de recouvrement Adobe In-RIP d’InDesign.

1. Choisissez Fichier > Imprimer.
2. Dans la boîte de dialogue d’impression, dans Imprimante, choisissez Fichier PostScript.
3. Choisissez le PPD du périphérique de sortie final.
4. Affichez ou modifiez les paramètres d’impression. InDesign utilise le groupe de pages actif lors de la création du fichier

PostScript.
5. Cliquez sur Save.
6. Spécifiez un nom et un emplacement, puis cliquez sur Enregistrer.

Création d’un fichier PostScript à l’aide d’un pilote d’impression PostScript (Windows)
1. Choisissez Fichier > Imprimer.
2. Dans la partie inférieure de la boîte de dialogue d’impression d’InDesign, cliquez sur le bouton Configurer.
3. Dans la boîte de dialogue du pilote d’impression, sélectionnez Fichier d’impression.
4. Cliquez sur l’onglet de mise en page, puis sur le bouton Avancé.
5. Choisissez la commande Options du document > Options PostScript > Optimiser la portabilité dans le menu des options de

sortie PostScript. Cliquez sur le bouton OK.
6. Cliquez sur OK ou Imprimer pour revenir à la boîte de dialogue Imprimer d’InDesign.
7. Dans la boîte de dialogue Imprimer d’InDesign, cliquez sur Imprimer.
8. Spécifiez un nom et un emplacement, puis cliquez sur Enregistrer.

Création d’un fichier PostScript à l’aide d’un pilote d’impression PostScript (Mac OS)
1. Choisissez Fichier > Imprimer.
2. Dans la boîte de dialogue Imprimer, choisissez Fichier PostScript dans le menu Imprimante, puis cliquez sur Enregistrer.
3. Dans la boîte de dialogue Enregistrer le fichier PostScript, spécifiez un nom et un emplacement pour le fichier PostScript (.ps),

puis cliquez sur Enregistrer.

Exportation des pages au format EPS
Utilisez la commande d’exportation pour exporter des pages InDesign au format EPS, que vous pouvez ensuite importer vers un autre
programme. Si vous exportez plusieurs pages, chacune d’elle est exportée en tant que fichier séparé avec un numéro ajouté à la fin du nom du
fichier. Par exemple, si vous exportez les pages 3, 6 et 12, puis spécifiez que le nom du fichier est News.eps, InDesign va créer trois fichiers
nommés News_3.eps, News_6.eps et News_12.eps.

Pour ouvrir des pages InDesign dans Illustrator ou Adobe Photoshop, exportez les pages au format PDF ou EPS.

1. Choisissez Fichier > Exporter.
2. Spécifiez un emplacement et un nom de fichier. Vérifiez que vous avez bien inclus l’extension .eps.
3. Dans la zone Type (Windows) ou Format (Mac OS) de la boîte de dialogue Enregistrer sous, choisissez l’option EPS, puis

cliquez sur  Enregistrer.
4. Dans la zone Pages de la boîte de dialogue Exportation EPS, utilisez l’une des méthodes suivantes :

Sélectionnez Toutes les pages pour exporter l’ensemble des pages du document.

Sélectionnez Pages et saisissez un groupe de pages. Entrez un groupe de pages en utilisant un tiret, et séparez les
pages ou les groupes de pages par des virgules.

Sélectionnez Planches pour exporter des pages en vis-à-vis en tant que fichier EPS unique (une planche par



 

fichier EPS).

5. Définissez d’autres options.
6. Dans la zone Fond perdu, entrez une valeur comprise entre 0 p0 et 36 p0 pour spécifier l’espacement supplémentaire des

images positionnées au-delà du bord de la page ou de la zone de coupe.
7. Cliquez sur Exporter.

Options d’exportation EPS
Lorsque vous exportez au format EPS, vous pouvez spécifier les options suivantes :

PostScript® Spécifie le niveau de compatibilité avec les interprètes de périphériques de sortie PostScript. Niveau 2 permet souvent d’optimiser la
rapidité d’impression et la qualité de sortie des images imprimées uniquement sur des périphériques de sortie PostScript Niveau 2 ou ultérieur.
Niveau 3 fournit une vitesse et une qualité de sortie optimales mais requiert un périphérique PostScript 3.
Couleur Spécifie la représentation des couleurs dans les fichiers exportés. Les options ci-dessous sont similaires aux paramètres Couleur de la
boîte de dialogue Imprimer.
Ne pas modifier  Conserve pour chaque image l’espace colorimétrique d’origine. Par exemple, si le document contient trois images RVB et quatre
images CMJN, le fichier EPS obtenu contient les mêmes images RVB et CMJN.
CMJN Crée un fichier séparable en représentant toutes les couleurs à l’aide de la gamme d’encres de couleurs quadri cyan, magenta, jaune et
noire.
Gris Convertit toutes les valeurs colorimétriques en images noir et blanc de haute qualité. Les niveaux de gris (tons) des objets convertis
représentent la luminosité des objets d’origine.
RVB  Représente toutes les couleurs en utilisant le rouge, le vert et le bleu. Un fichier EPS avec une définition de couleurs RVB convient mieux à
un affichage écran.
Gestion des couleurs PostScript®  Utilise les données chromatiques du document dans une version étalonnée de leur espace colorimétrique
d’origine.
Aperçu Détermine les caractéristiques de l’image d’aperçu enregistrée dans le fichier. Cette image apparaît dans les applications ne pouvant pas
afficher les illustrations EPS directement. Si vous ne souhaitez pas créer une image d’aperçu, choisissez Aucun dans le menu Aperçu.
Incorporer les polices Spécifie la manière dont les polices utilisées dans les pages exportées doivent être incorporées.
Aucune  Inclut une référence à la police dans le fichier PostScript indiquant au processeur RIP ou au processeur de post-traitement
l’emplacement de la police.
Complet  Télécharge toutes les polices nécessaires au document au début du travail d’impression. Tous les glyphes et caractères d’une police
sont téléchargés même s’ils n’apparaissent pas dans le document. InDesign organise automatiquement en jeux partiels les polices contenant plus
de glyphes (caractères) que le nombre maximum spécifié dans la boîte de dialogue Préférences.
Jeu partiel Télécharge uniquement les caractères (glyphes) utilisés dans le document.
Format des données Spécifie le mode d’envoi des données d’image de votre ordinateur à une imprimante : sous forme de données ASCII ou
binaires.
Images Spécifie la quantité de données d’image des images bitmap importées à incorporer dans le fichier exporté.
Toutes  Inclut toutes les données d’image haute résolution disponibles dans le fichier exporté et utilise un espace important sur le disque.
Choisissez cette option si le fichier est destiné à une impression sur un périphérique de sortie haute résolution.
Doublures  Inclut uniquement des versions avec une résolution d’écran (72 ppp) des images bitmap importées dans le fichier exporté. Choisissez
cette option en association avec l’option Substitution d’image OPI ou si le fichier PDF obtenu est destiné à un affichage à l’écran.
Substitution d’images OPI Active le remplacement par InDesign de doublures EPS basse résolution par des images haute résolution au
moment de la sortie.
Ignorer pour OPI Ignore, de manière sélective, des images importées lors de l’envoi de données d’image vers une imprimante ou un fichier,
laissant ensuite un serveur OPI se charger des liens (commentaires) OPI.
Aplatissement des transparences Sélectionnez un aplatissement prédéfini dans le menu Impression prédéfinie pour spécifier l’apparence des
objets transparents dans le fichier exporté. Cette option est la même que l’option Aplatissement des transparences qui s’affiche dans la zone
Avancé de la boîte de dialogue Imprimer.
Gestionnaire d’encres Corrige les options d’encre sans modifier la conception du document.
Voir aussi
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Présentation du panneau Recouvrements prédéfinis
Création ou modification d’un recouvrement prédéfini
Gestion des recouvrements prédéfinis
Attribution d’un recouvrement prédéfini aux pages
Définition de groupes de pages de recouvrement
Options de recouvrements prédéfinis
Définition de recouvrements ajustables
A propos du recouvrement du noir
Définition de la largeur de recouvrement de couleurs adjacentes au noir
Impression de livres contenant des recouvrements prédéfinis en conflit

Présentation du panneau Recouvrements prédéfinis
Un recouvrement prédéfini est un ensemble de paramètres de recouvrement que vous pouvez appliquer à une page ou à un groupe de pages
dans un document. Le panneau Recouvrements prédéfinis fournit une interface permettant de définir des paramètres de recouvrement et
d’enregistrer des paramètres de recouvrement prédéfinis. Vous pouvez appliquer des recouvrements prédéfinis à n’importe quelle page d’un
document (ou à toutes les pages) ou importer les recouvrements prédéfinis à partir d’un autre document InDesign. Si vous n’appliquez pas un
recouvrement prédéfini à un groupe de pages de recouvrement, celui-ci utilisera le recouvrement prédéfini par défaut.

Pour afficher des paramètres de recouvrements prédéfinis
1. Si le panneau Recouvrements prédéfinis n’est pas affiché, sélectionnez Fenêtre > Sortie > Recouvrements prédéfinis.
2. Utilisez l’une des méthodes suivantes dans le panneau Recouvrements prédéfinis :

Cliquez deux fois sur le recouvrement prédéfini.

Sélectionnez le recouvrement prédéfini et choisissez Options de recouvrement prédéfini dans le menu du panneau.

Pour réduire la liste des recouvrements prédéfinis
 Dans le menu du panneau Recouvrements prédéfinis, choisissez Petites rangées de panneau.

Pour identifier des recouvrements prédéfinis inutilisés
 Dans le menu du panneau Recouvrements prédéfinis, choisissez Sélectionner tous les styles inutilisés. Le moteur de recouvrement met en

surbrillance tous les recouvrements prédéfinis (sauf [Par défaut] et [Aucun recouvrement prédéfini]) qui n’ont pas été appliqués au document en
cours. Vous pouvez facilement les supprimer.

Création ou modification d’un recouvrement prédéfini
1. Si le panneau Recouvrements prédéfinis n’est pas affiché, sélectionnez Fenêtre > Sortie > Recouvrements prédéfinis.
2. Choisissez Nouveau recouvrement prédéfini dans le menu du panneau pour créer un recouvrement prédéfini ou cliquez deux

fois sur un recouvrement prédéfini pour le modifier.
Remarque : le bouton Nouveau recouvrement prédéfini situé en bas du panneau Recouvrements prédéfinis permet de créer
un recouvrement prédéfini fondé sur les paramètres du recouvrement prédéfini [Par défaut].

3. Spécifiez les options suivantes, puis cliquez sur OK :
Nom Attribuez un nom au recouvrement prédéfini. Vous ne pouvez pas renommer le recouvrement prédéfini [Par défaut].

Largeur de recouvrement Entrez des valeurs pour spécifier la largeur de chevauchement des encres.

Aspect de recouvrement Spécifiez les options qui déterminent la forme des recouvrements.

Image Spécifiez les paramètres déterminant le recouvrement des images bitmap importées.

Seuils de recouvrement Entrez des valeurs pour définir les conditions d’application du recouvrement. De nombreuses
variables affectent ces valeurs. Pour plus de détails, renseignez-vous auprès de votre prestataire de services prépresse.

Gestion des recouvrements prédéfinis
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Vous pouvez dupliquer, supprimer, importer et personnaliser des recouvrements prédéfinis.

Duplication d’un recouvrement prédéfini
 Utilisez l’une des méthodes suivantes :

Dans le panneau Recouvrements prédéfinis, sélectionnez un recouvrement prédéfini, puis choisissez Dupliquer le
recouvrement prédéfini.

Faites glisser le recouvrement prédéfini vers le bouton Nouveau recouvrement prédéfini en bas du panneau.

Suppression d’un recouvrement prédéfini
1. Dans le panneau Recouvrements prédéfinis, sélectionnez un ou plusieurs recouvrements prédéfinis, puis utilisez l’une des

méthodes suivantes :

Cliquez sur le bouton Supprimer.

Choisissez Supprimer les recouvrements prédéfinis dans le menu du panneau.

2. Si un message vous invite à remplacer un recouvrement prédéfini, choisissez-en un dans la boîte de dialogue Supprimer le
recouvrement prédéfini. Cette boîte de dialogue s’affiche si au moins l’un des recouvrements prédéfinis sélectionnés a été
attribué à une page.

3. Cliquez sur le bouton Oui pour confirmer la suppression.

Remarque : vous ne pouvez pas supprimer les recouvrements prédéfinis intégrés [Par défaut] et [Aucun recouvrement prédéfini].

Importation de recouvrements prédéfinis d’un autre document InDesign
1. Dans le menu du panneau Recouvrements prédéfinis, choisissez Charger des recouvrements prédéfinis.
2. Sélectionnez le fichier InDesign et cliquez sur Ouvrir.

Attribution d’un recouvrement prédéfini aux pages
Vous pouvez attribuer un recouvrement prédéfini à un document ou à un groupe de pages dans un document. Si vous désactivez le recouvrement
pour les pages ne contenant pas de couleurs contiguës, celles-ci s’impriment plus rapidement. Le recouvrement ne se produit réellement qu’au
moment de l’impression du document.

Les attributions de recouvrement prédéfini répertorient les recouvrements prédéfinis appliqués sur plusieurs pages ; elles sont mises à jour chaque
fois que vous cliquez sur Attribuer.

1. Dans le menu du panneau Recouvrements prédéfinis, choisissez Attribuer un recouvrement prédéfini.
2. Dans la zone Recouvrement prédéfini, choisissez le recouvrement prédéfini à appliquer.
3. Sélectionnez les pages auxquelles appliquer le recouvrement prédéfini.
4. Cliquez sur Attribuer, puis sur Terminer.

Remarque : si vous cliquez sur Terminer sans avoir préalablement cliqué sur Attribuer, la boîte de dialogue se ferme sans apporter aucun
changement aux recouvrements. En revanche, les recouvrements que vous aviez attribués précédemment à l’aide du bouton Attribuer sont
conservés.

Définition de groupes de pages de recouvrement
1. Dans le menu du panneau Recouvrements prédéfinis, choisissez Attribuer un recouvrement prédéfini.
2. Dans la zone Recouvrement prédéfini, choisissez le recouvrement prédéfini à appliquer aux groupes de pages.
3. Sélectionnez Etendue, puis entrez un ou plusieurs groupes de pages par ordre croissant, en insérant un tiret entre la première

et la dernière page d’un groupe et en séparant les groupes de pages par des virgules ou des virgules et des espaces. Par
exemple, 2-4, 6, 9-10, 12 sont des étendues valides.

4. Cliquez sur Attribuer, puis sur Terminer.
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Pour désactiver un groupe de pages de recouvrement, choisissez l’option Attribuer un recouvrement prédéfini dans le menu du panneau, indiquez
un groupe de pages, puis choisissez l’option [Aucun recouvrement prédéfini] dans le menu Recouvrement prédéfini. Cliquez sur Attribuer, puis sur
Terminer.

Options de recouvrements prédéfinis
Vous pouvez modifier les options de recouvrements prédéfinis chaque fois que vous créez ou modifiez un recouvrement prédéfini. Les mêmes
options de recouvrements prédéfinis sont disponibles dans Acrobat et InDesign. Dans Acrobat, vous pouvez afficher les recouvrements prédéfinis
en choisissant Outils > Impression > Recouvrements prédéfinis. Dans InDesign, sélectionnez Fenêtre > Sortie > Recouvrements prédéfinis.

Largeurs de recouvrement
La largeur de recouvrement correspond à la largeur du chevauchement de chaque recouvrement. En raison des différences de caractéristiques de
papier, de linéature et de conditions d’impression, les largeurs de recouvrement varient. Pour déterminer les largeurs de recouvrement convenant à
chaque travail d’impression, consultez votre imprimeur.

Par défaut Indique la largeur de recouvrement en points pour le recouvrement de toutes les couleurs, excepté celles contenant du noir. La valeur
par défaut est 0,25 pt.
Noir Indique la distance d’étalement de l’encre sur le noir ou le niveau de retenue (distance entre les bords noirs et les encres sous-jacentes pour
le recouvrement de noirs intenses). La valeur par défaut est 0,5 pt. Cette valeur est souvent 1,5 à 2 fois supérieure à la largeur de recouvrement
par défaut.
Dans InDesign, la valeur définie pour l’option Couleur noire détermine la valeur pour un noir ou un noir intense, noir quadrichromique (N) mélangé
avec des encres de couleur pour augmenter l’opacité et l’intensité de la couleur.

Remarque : (InDesign) si vous sélectionnez le recouvrement intégré de l’application et que vous spécifiez une largeur de recouvrement Par défaut
ou une largeur de recouvrement Noir supérieure à 4 points, la largeur de recouvrement obtenue se limite à 4 points. Toutefois, la valeur spécifiée
reste affichée, car, si vous passez au recouvrement Adobe In-RIP, les recouvrements supérieurs à 4 points s’appliquent comme indiqué.

Aspect de recouvrement
Un sommet représente la jonction de deux bords de recouvrement en une extrémité commune. Vous pouvez contrôler la forme d’un sommet
extérieur formé par deux segments de recouvrement et de l’intersection entre trois recouvrements.

Style de sommet Définit la forme du sommet extérieur constitué par deux segments de recouvrement. Choisissez un sommet en pointe, en
arrondi ou en biseau. La valeur par défaut est Pointe. Elle correspond aux résultats de recouvrement de versions précédentes du logiciel et
permet que la compatibilité avec des versions antérieures du logiciel de recouvrement Adobe soit conservée.

Exemples de sommets de recouvrement, de gauche à droite : en pointe, en arrondi, en biseau

Style d’extrémité Définit l’intersection de trois recouvrements. La valeur par défaut Pointe rend l’extrémité du recouvrement pointue de sorte
qu’elle ne se trouve pas à l’intersection. La valeur Chevauchement affecte la forme du recouvrement généré par l’objet dont la densité neutre est la
plus faible et qui coupe au moins deux objets plus foncés. L’extrémité du recouvrement le plus clair est chevauchée au point d’intersection des
trois objets.

Exemples d’extrémités de recouvrement : en pointe (à gauche) et chevauchement (à droite)

Seuils de recouvrement
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Etape Spécifie le seuil de changement de couleur à partir duquel le logiciel crée un recouvrement. Pour certains travaux d’impression, seuls les
changements de couleur les plus extrêmes doivent être recouverts. Dans d’autres cas, ce sont les changements de couleur subtils qui requièrent
un recouvrement. La valeur Tolérance indique le niveau de variation des composants (tels que les valeurs CMJN) des couleurs aboutées avant
l’exécution d’un recouvrement.
Pour modifier le degré de variation que peuvent subir les encres composant les couleurs contiguës avant qu’un recouvrement de ces couleurs
n’intervienne, ajustez la valeur de l’option Tolérance dans les boîtes de dialogue Nouveau recouvrement prédéfini ou Modifier les options de
recouvrement prédéfini. La valeur par défaut de cet attribut est 10 %. Pour des résultats optimaux, choisissez une valeur entre 8 % et 20 %. Les
pourcentages inférieurs augmentent la sensibilité aux différences de couleur et donc le nombre de recouvrements.

Couleur noire Spécifie la quantité minimale d’encre noire requise avant que la valeur de l’option de largeur de recouvrement Noir ne soit
appliquée. La valeur par défaut est 100%. Pour des résultats optimaux, choisissez une valeur supérieure ou égale à 70 %.
Densité du noir Indique la valeur de densité neutre à partir de laquelle InDesign considère que l’encre est noire. Par exemple, si vous souhaitez
que la valeur de la largeur de recouvrement Noir soit appliquée à une encre de ton direct foncé, entrez une valeur de densité neutre ici. Cette
valeur est en général définie sur un chiffre proche de la valeur par défaut (1,6).
Variation  Détermine lorsque le moteur de recouvrement commence à chevaucher la ligne médiane de la zone de couleurs. La valeur fait
référence à la proportion de la valeur de densité neutre de la couleur la plus claire par rapport à la valeur de densité neutre d’une couleur contiguë
plus foncée. Par exemple, une valeur Variation de 70 % a pour effet de déplacer le positionnement du recouvrement afin qu’il commence à
chevaucher la ligne médiane lorsque la couleur la plus claire dépasse 70 % de la couleur la plus foncée en densité neutre (la densité neutre de la
couleur la plus claire divisée par la densité neutre de la couleur la plus foncée > 0,70). Les couleurs de densités neutres identiques chevauchent
toujours exactement la ligne centrale, à moins que l’option Variation ne soit définie sur 100 %.
Réduction de la couleur de recouvrement Indique le pourcentage d’utilisation de composants de couleurs aboutées pour la réduction de la
couleur de recouvrement. Cette option permet d’éviter que certaines couleurs aboutées (les pastels, par exemple) ne créent un recouvrement
disgracieux plus foncé que chacune de ces couleurs. Si vous choisissez une réduction de couleur inférieure à 100 %, la couleur du recouvrement
s’éclaircit. Si vous saisissez une réduction de couleur de 0 %, la densité neutre du recouvrement créé est égale à celle de la couleur foncée.

Recouvrement d’une image importée
Vous pouvez créer un recouvrement prédéfini pour gérer les recouvrements d’images, ainsi que les recouvrements entre images bitmap
(photographies et images enregistrées dans des fichiers PDF pixellisés, par exemple) et objets vectoriels (objets de programme d’illustration et
fichiers PDF vectoriels, par exemple). Chaque logiciel de recouvrement traite différemment les images importées. Il est important de connaître ces
différences lors de la configuration des options de recouvrement.

Application Propose des options indiquant l’emplacement du recouvrement lorsque des images bitmap sont recouvertes par des objets vectoriels
(notamment les objets dessinés dans InDesign). Toutes les options, excepté Densité neutre, créent un bord cohérent. L’option Bande centrale
crée un recouvrement à cheval sur la limite entre les objets et les images. Quand l’option Maigri est activée, les objets chevauchent l’image
aboutée. L’option Densité neutre applique les règles de recouvrement utilisées pour le reste du document. Lorsque cette option est sélectionnée et
qu’un objet recouvre une photographie, les bords risquent d’être visiblement irréguliers, car le recouvrement passe d’un bord à un autre. Quand
l’option Grossi est sélectionnée, l’image bitmap chevauche l’objet abouté.
Recouvrement d’objets sur images Associée à une option de la liste Application, permet le recouvrement des images par des objets vectoriels
(tels que les cadres utilisés comme lignes clés). Si les objets vectoriels ne chevauchent pas les images lors du recouvrement d’un intervalle de
pages, désactivez cette option pour accélérer la procédure de recouvrement.
Recouvrement d’images sur images Active le recouvrement le long de la limite entre les images bitmap aboutées ou se chevauchant. Cette
fonction est activée par défaut.
Intérieur des images Active le recouvrement au sein des couleurs de chaque image bitmap (et non uniquement à la jonction entre les illustrations
vectorielles et le texte). Utilisez cette option uniquement pour des intervalles de pages contenant des images simples à contraste élevé, telles que
des captures d’écran ou des dessins. Désactivez-la pour les images complexes en tons continus, car elle créerait des recouvrements de mauvaise
qualité. La procédure de recouvrement est plus rapide lorsque cette option n’est pas sélectionnée.
Images de 1 bit Permet le recouvrement d’objets aboutés par des images de 1 bit. Cette option n’utilise pas les paramètres d’application car les
images de 1 bit ne contiennent qu’une seule couleur. En règle générale, sélectionnez cette option. Dans certains cas, notamment lorsque les
pixels d’images de 1 bit sont très espacés, cette option risque d’obscurcir l’image et de ralentir la procédure de recouvrement.

Définition de recouvrements ajustables
1. Choisissez Nouveau recouvrement prédéfini dans le menu du panneau pour créer un recouvrement prédéfini ou cliquez deux

fois sur un recouvrement prédéfini pour le modifier.
2. Dans le champ Variation de la zone Seuils de recouvrement, entrez un pourcentage compris entre 0 et 100 ou utilisez la

valeur par défaut de 70 %. A 0 %, tous les recouvrements prennent par défaut la valeur de la ligne médiane. A 100 %, les
recouvrements ajustables sont désactivés, ce qui impose l’étalage complet d’une couleur sur une autre, quelle que soit la
relation de densité neutre des couleurs contiguës.

A propos du recouvrement du noir
Lorsque vous créez ou modifiez des recouvrements prédéfinis, la valeur saisie pour l’option Couleur noire détermine ce qui est considéré comme
noir et noir intense. La couleur noir intense correspond à n’importe quelle couleur noire utilisant un tramage (ajout d’une ou plusieurs encres
quadrichromiques pour intensifier la couleur noire).
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L’option Couleur noire permet de compenser un engraissement extrême (quand vous utilisez un papier de faible qualité, par exemple). Dans ce
cas, les zones dont le pourcentage de noir est inférieur à 100 % s’impriment sous forme de zones unies. Pour compenser l’engraissement et
garantir que le logiciel de recouvrement utilise la largeur et l’application de recouvrement correctes pour les objets noirs, tramez le noir et le noir
intense (à l’aide de teintes de noir uni) et diminuez la valeur de l’option Couleur noire (définie par défaut sur 100 %).

Lorsqu’une couleur atteint la valeur de l’option Couleur noire, la valeur de la largeur de recouvrement Noir est appliquée à toutes les couleurs
aboutées et des recouvrements réservés sont créés pour les zones de noir intense à l’aide de l’option de largeur de recouvrement Noir.

Si le tramage s’étend jusqu’au bord d’une zone noire, tout problème de repérage des encres rend les bords du tramage visibles et crée un flou
imprévu ou une distorsion des bords des objets. Le logiciel de recouvrement utilise un recouvrement réservé (retenu), pour le noir intense afin que
le tramage reste éloigné des bords d’éléments inversés ou clairs du premier plan. Les éléments clairs conservent ainsi leur netteté. Vous pouvez
contrôler la distance entre le tramage et les bords des zones noires en spécifiant une valeur dans le champ de largeur de recouvrement Noir.

Remarque : si l’élément que vous recouvrez est un élément fin, comme un contour noir autour de graphiques, le moteur de recouvrement
remplace le paramètre de largeur de recouvrement Noir et limite le recouvrement à la moitié de la largeur de l’élément fin.

Définition de la largeur de recouvrement de couleurs adjacentes au noir
1. Choisissez Nouveau recouvrement prédéfini dans le menu du panneau pour créer un recouvrement prédéfini ou cliquez deux

fois sur un recouvrement prédéfini pour le modifier.
2. Dans le champ Noir de la zone Largeur de recouvrement, entrez la distance (en points) suivant laquelle les autres couleurs

doivent s’étaler sur le noir ou la distance de refoulement des masques de support sous le noir. Cette valeur est souvent réglée
pour être entre une fois et demie à deux fois plus grande que la valeur de la largeur de recouvrement par défaut.

3. Définissez les valeurs pour les paramètres Couleur noire et Densité du noir.

Remarque : pour utiliser les fonctions de recouvrement du noir, une zone de couleur doit utiliser une encre de densité neutre supérieure ou égale
au paramètre Densité du noir et l’encre doit se trouver en pourcentages égaux ou supérieurs au paramètre Couleur noire.

Impression de livres contenant des recouvrements prédéfinis en conflit
Vous pouvez normalement appliquer un recouvrement prédéfini à une feuille de sortie telle qu’une page. Mais si vous imprimez plusieurs
documents d’un livre et que chaque document ou chaque page possède son propre recouvrement prédéfini, InDesign peut résoudre certains
conflits de recouvrement prédéfinis en synchronisant les paramètres entre les documents :

Si les documents d’un livre utilisent des recouvrements prédéfinis différents, mais portant le même nom, InDesign attribue le
recouvrement prédéfini utilisé dans le document type, à condition que vous ayez sélectionné l’option Recouvrement prédéfini
dans la boîte de dialogue Options de synchronisation.

La fonction de synchronisation permet de rendre tous les paramètres prédéfinis du document type disponibles pour les autres
documents du livre, sans les attribuer. L’attribution se fait document par document. Vous pouvez également utiliser le
recouvrement prédéfini [Par défaut]. Les paramètres apparaissent dans le menu Recouvrement prédéfini de la boîte de
dialogue Attribuer des recouvrements prédéfinis.

Remarque : si plusieurs recouvrements prédéfinis sont appliqués aux pages de planches, InDesign les applique individuellement.
Voir aussi
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A propos du recouvrement de l’encre
Méthodes de recouvrement
A propos du recouvrement automatique
Conditions requises pour le recouvrement automatique
Différences entre le recouvrement intégré et le recouvrement Adobe In-RIP
Recouvrement des images bitmap importées
Recouvrement des images vectorielles
Recouvrement de texte
Optimisation des performances de recouvrement
Allocation d’espace disque pour le recouvrement intégré
Recouvrement d’un document ou d’un livre

A propos du recouvrement de l’encre
Lorsqu’un document destiné à l’impression offset utilise plusieurs encres sur une même page, chaque encre doit être imprimée par impression
superposée (alignement parfait) de toutes les encres aboutées afin qu’il n’existe aucun blanc à la jointure entre les différentes encres. Toutefois, il
est impossible de garantir une impression superposée parfaite pour chaque objet de chaque page imprimée. Des problèmes de repérage des
encres risquent donc de se produire. Ces problèmes créent des blancs indésirables entre les encres.

Pour masquer ces blancs, vous pouvez agrandir légèrement l’un des objets afin qu’il chevauche un autre objet de couleur différente : cette
procédure est appelée recouvrement. Par défaut, lorsqu’une encre est placée sur une autre, l’encre sous-jacente est défoncée ou supprimée afin
d’éviter les mélanges imprévus de couleurs. Cependant, la procédure de recouvrement requiert une impression superposée, ou l’impression d’une
encre sur une autre, afin d’obtenir un chevauchement ou un chevauchement partiel.

Problèmes de repérage des encres sans recouvrement (à gauche) et avec recouvrement (à droite)

La plupart des recouvrements utilisent la technique de l’étalement : un objet clair est étalé sur un objet foncé. Comme la couleur foncée définit la
limite visible d’un objet ou d’un texte, l’étalement de la couleur claire sur la couleur foncée fait apparaître cette limite.

Méthodes de recouvrement
Pour appliquer un recouvrement à un document, plusieurs méthodes existent, que vous pouvez combiner :

Utilisation de couleurs quadri ne nécessitant pas de recouvrement

Surimpression du noir

Surimpression manuelle des contours ou des fonds

Utilisation du recouvrement intégré d’Adobe InDesign CS4 ou du recouvrement Adobe In-RIP

Recouvrement des images importées, à l’aide des fonctions de recouvrement des logiciels d’illustration dans lesquels elles ont
été créées Reportez-vous à la documentation fournie avec ces logiciels.

Choisissez une solution de recouvrement adaptée au flux de production de sortie en couleurs que vous utilisez, par exemple
Adobe PostScript ou PDF.

Vous pouvez éviter de recourir au recouvrement en éliminant le risque d’erreur de mise en registre dans votre utilisation des couleurs. Pour ce
faire, vérifiez que les couleurs quadri aboutées disposent d’encres communes. Par exemple, un contour violet foncé et un fond rouge vif présentent
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tous deux une quantité importante de magenta. Le magenta commun aux deux couleurs s’imprime sur une seule zone de telle sorte que si des
erreurs de mise en registre se produisent avec d’autres encres de couleur quadri, la plaque d’impression magenta dissimulera les zones vides.

A propos du recouvrement automatique
InDesign peut effectuer un recouvrement automatique des documents en couleurs à l’aide d’un moteur de recouvrement intégré. InDesign utilise
également le moteur de recouvrement des couleurs Adobe In-RIP, disponible sur les périphériques de sortie Adobe PostScript qui le prennent en
charge.

Les deux moteurs de recouvrement calculent les réglages jusqu’aux bords du texte et des graphiques. Ils appliquent des techniques de
recouvrement sur différentes parties d’un seul objet, même si du texte ou des objets InDesign chevauchent plusieurs couleurs d’arrière-plan. Les
réglages de recouvrement s’effectuent automatiquement et vous pouvez définir des recouvrements prédéfinis répondant aux exigences d’un
groupe de pages spécifiques. Les effets du recouvrement sont uniquement visibles sur les séparations de couleur générées par un moteur de
recouvrement ; ils ne sont pas visibles à l’écran dans InDesign.

Le moteur de recouvrement détecte les bords de couleurs différentes. Il crée ensuite des recouvrements d’après les densités neutres (aspect clair
ou foncé) des couleurs contiguës, en étalant les couleurs les plus claires sur les couleurs plus foncées adjacentes. Les paramètres de
recouvrement spécifiés dans le panneau Recouvrements prédéfinis modifient les résultats obtenus par l’utilisation du moteur de recouvrement.

Conditions requises pour le recouvrement automatique
Pour effectuer des recouvrements dans des documents à l’aide du moteur intégré InDesign, il vous faut un fichier PPD qui prenne en charge les
séparations.

Pour effectuer des recouvrements dans des documents à l’aide du moteur Adobe In-RIP, vous devez disposer des logiciels et du matériel
suivants :

Un périphérique d’impression Adobe PostScript Niveau 2 ou ultérieur dont le processeur RIP prend en charge le recouvrement
Adobe In-RIP. Pour vérifier que votre périphérique de sortie PostScript répond à ces critères, contactez le fabricant ou votre
prestataire de services prépresse.

Un fichier de description d’imprimante PostScript (PPD - PostScript Printer Description) pour une imprimante prenant en
charge le recouvrement Adobe In-RIP. Vous devez sélectionner le PPD lorsque vous installez l’imprimante.

Différences entre le recouvrement intégré et le recouvrement Adobe In-RIP
Flux de production en couleurs composites Avec le recouvrement intégré, vous pouvez séparer les couleurs d’un document à l’aide d’InDesign
ou des séparations In-RIP. Pour utiliser le recouvrement Adobe In-RIP, vous devez utiliser les séparations In-RIP.
Largeurs de recouvrement Les limites du recouvrement intégré permettent un recouvrement d’une largeur de 4 points, quelles que soient les
valeurs entrées pour les largeurs de recouvrement. Pour une largeur plus élevée, utilisez le recouvrement Adobe In-RIP.
Images vectorielles au format EPS Le moteur de recouvrement intégré ne permet pas de recouvrir les images vectorielles EPS importées ; le
recouvrement Adobe In-RIP permet de recouvrir toutes les images importées.

Recouvrement des images bitmap importées
Le recouvrement intégré permet de recouvrir du texte et des images par des images bitmap telles que des photographies. Les images bitmap
doivent être enregistrées à l’aide d’un format de fichier pixels prenant en charge les exigences de couleurs de l’impression professionnelle. Les
formats PSD (Photoshop) et TIFF sont les plus appropriés pour les travaux d’impression professionnels ; avant d’utiliser d’autres formats,
consultez votre service de prépresse.

Si vous utilisez un serveur OPI (Open Prepress Interface), vérifiez qu’il crée des images FPO (For-Position-Only) à l’aide des formats TIFF ou
PSD. Si les images sont au format TIFF ou PSD, il est éventuellement possible d’utiliser le recouvrement intégré si vous ne sélectionnez aucune
option Ignorer pour OPI pour la sortie. (Les options Ignorer pour OPI se trouvent dans le panneau Avancés de la boîte de dialogue Imprimer
lorsqu’une imprimante PostScript est ciblée.)

Remarque : le comportement et la précision du recouvrement dans le cadre d’un flux de travail OPI dépendent de plusieurs facteurs, tels que la
méthode de sous-échantillonnage utilisée par le serveur OPI pour générer des images FPO. Pour des résultats optimaux, consultez votre
revendeur OPI afin d’obtenir des informations sur l’intégration de solutions de recouvrement Adobe dans le serveur OPI du revendeur.

Recouvrement des images vectorielles
Le recouvrement Adobe In-RIP et le recouvrement intégré peuvent tous deux recouvrir du texte et des images créés à l’aide des outils InDesign,
ainsi que des fichiers vectoriels PDF importés. Cependant, le recouvrement intégré ne permet pas de recouvrir les images vectorielles EPS
importées.

Le texte, les tracés et les blocs créés dans InDesign ne sont pas recouverts correctement s’ils chevauchent un bloc contenant une image importée
ne pouvant pas bénéficier du recouvrement intégré, comme les images vectorielle EPS. Ces objets sont toutefois correctement recouverts lorsque
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vous utilisez le recouvrement Adobe In-RIP. Il se peut que vous puissiez utiliser le recouvrement intégré sur des documents contenant une image
vectorielle EPS si vous réglez le bloc de l’image. Si l’image EPS importée n’est pas rectangulaire, modifiez la forme du bloc pour qu’elle se
rapproche le plus possible de l’élément graphique et qu’elle s’éloigne des autres objets. Par exemple, utilisez la commande Objet > Masque pour
ajuster le bloc à la taille de l’élément graphique.

Le texte et les images InDesign chevauchant les images EPS importées (à gauche) ne sont pas recouverts correctement ; pour obtenir un bon
recouvrement, ajustez le bloc pour qu’il ne touche pas les autres objets (à droite).

Recouvrement de texte
Les moteurs de recouvrement intégré et Adobe In-RIP peuvent tous deux recouvrir les caractères d’un autre texte ou d’autres images. Le
recouvrement intégré s’applique à du texte et des images générés dans InDesign, mais non contenus dans des images importées. Un caractère
chevauchant plusieurs couleurs d’arrière-plan recouvre précisément toutes ces couleurs.

Le recouvrement Adobe In-RIP permet de recouvrir tous les types de polices. En revanche, le recouvrement intégré fonctionne mieux avec les
polices Type 1, Open Type et Multiple Master ; l’utilisation des polices TrueType risque d’entraîner des recouvrements irréguliers. Si vous devez
utiliser des polices TrueType avec le recouvrement intégré, vectorisez l’ensemble des caractères TrueType. Pour cela, sélectionnez le texte, puis
choisissez Texte > Vectoriser. Le texte se transforme en objets InDesign pouvant être recouverts de façon fiable. Vous ne pouvez plus modifier le
texte après vectorisation.

Optimisation des performances de recouvrement
Que vous utilisiez le recouvrement Adobe In-RIP ou le recouvrement intégré, vous gagnerez du temps en excluant les pages ne nécessitant pas
de recouvrement, telles que celles contenant uniquement du texte en noir. Vous pouvez utiliser des recouvrements prédéfinis afin d’activer le
recouvrement uniquement pour les intervalles de pages qui en ont besoin.

La vitesse du recouvrement intégré dépend de celle de votre ordinateur. Si vous procédez au recouvrement de chaque page d’un long document,
utilisez le plus rapide des ordinateurs disponibles. Le disque dur de votre ordinateur étant sollicité de façon intensive, le moteur de recouvrement
intégré est plus performant avec un disque dur et un bus de données rapides.

Pour optimiser le temps pendant lequel vos ordinateurs sont disponibles pour d’autres tâches, pensez à utiliser le recouvrement Adobe In-RIP qui
traite tous les recouvrements au niveau du module de pixellisation (RIP, Raster Image Processor), et non au niveau de votre ordinateur.

Allocation d’espace disque pour le recouvrement intégré
Afin d’effectuer le recouvrement des contours de chaque couleur pour laquelle cette opération est nécessaire, le logiciel de recouvrement crée de
nombreux chemins utilisés uniquement par le périphérique de sortie (les chemins ne sont pas stockés dans votre document). Par opposition à la
méthode In-RIP qui traite et stocke ces tracés supplémentaires au niveau du RIP, le recouvrement intégré les stocke temporairement sur le disque
dur de l’ordinateur. Avant d’utiliser le recouvrement intégré, libérez autant d’espace que possible sur votre disque dur.

La quantité d’espace disque nécessaire dépend de nombreux facteurs et il est impossible de prévoir avec exactitude les besoins d’une tâche de
recouvrement spécifique. Toutefois, plus les caractéristiques suivantes de votre document seront importantes, plus les besoins en espace disque
seront susceptibles d’augmenter :

nombre de pages inclus dans le recouvrement des intervalles de pages ;

nombre d’objets en couleurs se chevauchant ;

nombre d’images nécessitant un recouvrement ;

texte nécessitant un recouvrement ;

résolution de la sortie finale.

Si le traitement d’un travail d’impression utilisant le recouvrement intégré est interrompu ou manque d’espace disque, les
données de recouvrement risquent de rester stockées sur votre disque dur. Si nécessaire, vous pouvez quitter l’application,
puis rechercher et supprimer les données temporaires du dossier C:\Temp (Windows). Sous Mac OS, redémarrez votre
ordinateur.



 

Haut de la pageRecouvrement d’un document ou d’un livre
Avant de modifier les paramètres de recouvrement par défaut, consultez votre prestataire de services prépresse ; il est également recommandé
d’avoir une bonne compréhension du fonctionnement des options de recouvrement dans le contexte de votre document et de vos conditions
d’impression spécifiques.

Si vous effectuez un recouvrement sur plusieurs documents d’un livre, assurez-vous d’avoir attribué, si nécessaire, des recouvrements prédéfinis
aux groupes de pages dans les différents documents du livre. Vous ne pouvez pas appliquer des paramètres de recouvrement à tous les
documents d’un livre à la fois. Vous pouvez cependant résoudre les recouvrements prédéfinis conflictuels d’un document.

1. Créez si nécessaire un recouvrement prédéfini pour définir des paramètres spécifiques au document et aux conditions de
presse.

2. Attribuez le recouvrement prédéfini à un groupe de pages.
3. Choisissez Fichier > Imprimer pour ouvrir la boîte de dialogue Impression.
4. Sélectionnez Sortie dans la liste située à gauche.
5. Dans Couleur, choisissez Séparations ou Séparations In-RIP, selon que vous créez des séparations sur un ordinateur hôte ou

des séparations In-RIP.
6. Dans Recouvrement, sélectionnez l’une des options suivantes :

Intégré à l’application, pour utiliser le moteur de recouvrement inclus dans InDesign.

Adobe In-RIP. Cette option fonctionne uniquement si le périphérique de sortie prend en charge le recouvrement In-RIP.

7. Si votre prestataire de services prépresse recommande de changer les paramètres d’encre, cliquez sur l’option Gestionnaire
d’encres. Sélectionnez une encre, définissez les options spécifiées par votre prestataire de services prépresse, puis cliquez
sur OK :

8. Spécifiez les autres options d’impression, puis cliquez sur Imprimer pour lancer l’impression du document.

Voir aussi
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Options d’impression des graphiques
Options de téléchargement des polices vers une imprimante
Options d’impression PostScript
Options d’omission d’images

Options d’impression des graphiques
Dans la zone Graphiques de la boîte de dialogue Imprimer, choisissez l’une des options suivantes pour spécifier la méthode de gestion des
graphiques lors de l’impression.

Envoi des données Contrôle la quantité de données des images bitmap importées à envoyer vers l’imprimante ou le fichier.
Toutes Envoie les données de résolution maximale. Utilisez cette option pour une impression haute résolution ou un impression d’images en
niveaux de gris ou en couleurs présentant un niveau de contraste élevé, comme c’est le cas du texte noir et blanc avec un ton direct. Cette option
exige un espace disque important.
Echantillonnage optimisé Envoie la quantité optimale de données d’image pour imprimer l’image à une résolution idéale pour le périphérique de
sortie. Une imprimante haute résolution utilise plus de données qu’un modèle de bureau basse résolution. Sélectionnez cette option lorsque vous
travaillez sur des images haute résolution tout en imprimant des épreuves sur une imprimante de bureau.
Remarque : InDesign ne sous-échantillonne pas les éléments graphiques EPS ou PDF, même si l’option Echantillonnage optimisé est
sélectionnée.
Doublures Envoie des versions avec une résolution d’écran des images bitmap importées (72 ppp), réduisant ainsi le temps d’impression.
Aucune Supprime temporairement toutes les images lors de l’impression et les remplace par des blocs d’image barrés, réduisant ainsi le temps
d’impression. Les dimensions des blocs d’image étant les mêmes que celles des images ou des masques importés, vous pouvez toujours vérifier
le positionnement et le format. Le fait de ne pas imprimer les images importées se révèle utile lorsque vous devez distribuer des épreuves de texte
aux préparateurs de texte ou aux correcteurs d’épreuves. L’impression sans image est également utile lorsque vous tentez d’isoler la cause d’un
problème d’impression.

Options de téléchargement des polices vers une imprimante
Les polices résidant sur l’imprimante sont stockées dans la mémoire de l’imprimante ou sur le disque dur connecté à celle-ci. Contrairement aux
polices bitmap qui sont uniquement stockées dans l’ordinateur, les polices Type 1 et TrueType peuvent l’être soit sur l’imprimante, soit sur
l’ordinateur. InDesign télécharge les polices si nécessaire, à condition qu’elles soient installées sur le disque dur de votre ordinateur.

Pour déterminer la façon dont les polices sont téléchargées sur l’imprimante, choisissez l’une des options suivantes dans la zone Graphiques de la
boîte de dialogue Imprimer.

Aucune Inclut une référence à la police dans le fichier PostScript indiquant au processeur RIP ou au processeur de post-traitement l’emplacement
d’intégration de la police. Utilisez cette option si les polices résident sur l’imprimante. Cependant, pour garantir une interprétation correcte des
polices, utilisez l’une des options de téléchargement de polices alternatives, telles que Jeu partiel ou Télécharger les polices PPD.
Complet Télécharge toutes les polices nécessaires au document au début du travail d’impression. Tous les glyphes et caractères de la police
sont inclus, même s’ils ne sont pas utilisés dans le document. InDesign organise automatiquement en jeux partiels les polices contenant plus de
glyphes (caractères) que le nombre maximum spécifié dans la boîte de dialogue Préférences.
Jeu partiel Télécharge uniquement les caractères (glyphes) utilisés dans le document. Les glyphes sont téléchargés une fois par page. Cette
option permet généralement d’obtenir des fichiers plus petits et plus rapides si elle est utilisée avec des documents page simple ou avec des
documents contenant peu de texte.
Télécharger les polices PPD Télécharge toutes les polices du document, même si celles-ci résident sur l’imprimante. Utilisez cette option pour
garantir qu’InDesign utilise les contours de polices de votre ordinateur pour imprimer des polices usuelles, telles que Helvetica et Times. Cette
option permet également de résoudre des problèmes de versions de polices, comme les discordances de jeux de caractères entre l’ordinateur et
l’imprimante ou les variations de contours dans le recouvrement. Cependant, à moins d’utiliser des jeux de caractères étendus, il n’est pas
nécessaire de sélectionner cette option pour imprimer des brouillons sur une imprimante de bureau.

Options d’impression PostScript
Pour définir la façon dont les informations PostScript sont envoyées à l’imprimante, choisissez l’une des options suivantes dans la zone
Graphiques de la boîte de dialogue Imprimer.

Postscript Spécifie le niveau de compatibilité avec les interprètes de périphériques de sortie PostScript.
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Format des données Spécifie le mode d’envoi des données d’image par InDesign de l’ordinateur vers l’imprimante. ASCII est envoyé en tant que
texte ASCII ; celui-ci est compatible avec les réseaux plus anciens et les imprimantes parallèles et constitue généralement le meilleur choix pour
les images utilisées sur plusieurs plates-formes. Binaire exporte au format de code binaire qui est plus compact que le format ASCII, mais pas
toujours compatible avec tous les systèmes.
Remarque : InDesign est parfois incapable de modifier le format de données utilisé par les fichiers graphiques EPS ou DCS. Si l’envoi de données
en mode binaire pose problème, essayez de modifier le format des données des graphiques EPS ou DCS dans l’application source.

Options d’omission d’images
Les options OPI de la zone Avancé permettent d’ignorer de manière sélective plusieurs types d’images importées lors de l’envoi de données
d’image vers une imprimante ou un fichier, laissant ensuite un serveur OPI se charger des liens (commentaires) OPI.

Substitution d’images OPI Active le remplacement par InDesign de doublures EPS basse résolution par des images haute résolution au
moment de la sortie. Pour que le remplacement d’images OPI fonctionne, les fichiers EPS doivent contenir des commentaires OPI reliant la
doublure basse résolution à l’image haute résolution. InDesign doit avoir accès aux images liées aux commentaires OPI. Si les versions haute
résolution ne sont pas disponibles, InDesign conserve les liens OPI et inclut des doublures basse résolution dans les fichiers exportés. Désactivez
cette option pour qu’un serveur OPI remplace les images présentant des liens OPI ultérieurement dans le flux de production.
Ignorer pour OPI Permet d’ignorer de manière sélective différents types d’images importées (EPS, PDF et bitmap) lors de l’envoi des données
d’image vers un fichier ou une imprimante, laissant un serveur OPI se charger ultérieurement des liens OPI (commentaires) uniquement. Les
commentaires contiennent les informations requises pour localiser une image haute-résolution sur un serveur OPI. InDesign inclut uniquement les
commentaires. Le prestataire de services doit avoir accès aux images haute résolution d’origine placées sur un serveur au moment du
remplacement. L’option Ignorer pour OPI ne s’applique pas aux images incorporées.
Voir aussi
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A propos de la surimpression
Utilisation de la surimpression manuelle
Surimpression d’éléments de page
Modification du paramètre de surimpression du noir

Pour plus d’informations et d’instructions, cliquez sur les liens ci-dessous.

A propos de la surimpression
Si vous n’avez pas modifié la transparence de l’illustration à partir du panneau Transparence, les fonds et les contours de l’illustration apparaîtront
opaques car la couleur de premier plan crée un effet de perçage, c’est-à-dire masque la zone située en dessous. Pour empêcher cet effet, utilisez
les options de surimpression du panneau Options d’objet. Définissez ces options, puis prévisualisez les effets de surimpression à l’écran.

Trois cercles superposés sans surimpression (à gauche) comparés à trois cercles superposés en surimpression (à droite)

InDesign permet également de simuler la surimpression pour tester les effets de surimpression des encres de tons directs sur un périphérique
d’impression composite.

L’encre noire appliquée au texte ou à des objets InDesign natifs est traitée par défaut en surimpression pour empêcher tout défaut de repérage
des petits caractères noirâtres recouvrant des zones de couleur ou des zones colorées avec des contours noirs. Vous pouvez modifier les
paramètres d’encre noire à l’aide des préférences Aspect du noir.

Pour votre flux de production, il se peut que vous deviez définir une certaine couleur à surimprimer. Par exemple, vous pouvez imprimer tout le
texte de votre publication dans une couleur spécifique. Utilisez les méthodes suivantes :

Créez un style d’objet qui utilise l’encre de ton direct comme couleur de fond ou de contour avec une couleur de fond ou de
contour surimprimée correspondante.

Créez un calque séparé pour les objets contenant votre ton direct et attribuez-leur la couleur noire.

Créez un PDF composite et modifiez les paramètres de surimpression dans le PDF.

Définissez des paramètres de surimpression dans votre processeur RIP.

Appliquez des paramètres de surimpression à une image ou un objet avant de l’ajouter à votre bibliothèque, ou modifiez un
fichier importé dans son application d’origine.

Utilisation de la surimpression manuelle
Le recouvrement automatique dans InDesign (recouvrement intégré ou recouvrement Adobe In-RIP) permet quasiment de se passer de
surimpression manuelle. Cependant, la surimpression manuelle peut être utile dans les rares cas où le recouvrement automatique est impossible.

Suivez les indications suivantes pour savoir si vous pouvez utiliser la surimpression :

Consultez votre prestataire de services prépresse pour savoir si ses périphériques de sortie sont compatibles avec la
surimpression manuelle.

Effectuez une surimpression si l’illustration ne présente pas deux fois la même couleur d’encre et si vous souhaitez créer un
recouvrement ou une superposition d’effets d’encres. La couleur de surimpression est ajoutée à la couleur d’arrière-plan s’il
s’agit d’une surimpression de mélanges de couleurs quadri ou de couleurs personnalisées ne partageant pas les mêmes
couleurs d’encres. Par exemple, si vous imprimez un fond avec 100 % de magenta sur un fond avec 100 % de cyan, les fonds
se chevauchant apparaissent en violet et non en magenta.
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Ne faites pas de surimpression si vous utilisez un contour pour un recouvrement de deux couleurs quadri. Spécifiez plutôt une
couleur de contour CMJN avec la valeur d’encre correspondante la plus élevée pour chaque couleur d’origine.

Accordez-vous avec votre prestataire de services sur une méthode de surimpression manuelle et ses conditions d’utilisation,
car les options de recouvrement spécifiées dans la boîte de dialogue d’impression s’en trouveront affectées. La surimpression
est prise en charge pas la plupart des périphériques PostScript niveau 2 et PostScript 3, mais pas par tous.

Surimpression d’éléments de page
Vous pouvez surimprimer les contours ou les fonds, les filets de paragraphe et les filets situés au-dessus des notes de bas de page. Vous pouvez
également simuler la surimpression des tons directs.

Surimpression d’un contour ou d’un fond
Le panneau Options d’objet permet de surimprimer les fonds et les contours d’un tracé sélectionné. Un fond ou un contour surimprimé n’a pas
besoin d’un recouvrement car la surimpression comble toute zone vide entre les couleurs adjacentes. Vous pouvez également surimprimer un
contour pour simuler un recouvrement (en surimprimant une couleur déterminée manuellement comme une association correcte de deux couleurs
adjacentes).

Gardez les instructions suivantes à l’esprit lors d’une surimpression manuelle :

Si vous utilisez l’option Surimpression du fond sur un fond ou un contour à 100 % de noir, il se peut que l’encre noire ne soit
pas assez opaque pour masquer les couleurs d’encres sous-jacentes. Pour éliminer ce problème de traversement, utilisez un
noir en quadrichromie (riche) au lieu d’un noir à 100 %. Consultez votre prestataire de services pour connaître les
pourcentages exacts de couleur à ajouter au noir.

Lorsque vous utilisez un contour pour recouvrir des objets (mais pas des caractères de texte), réglez l’alignement du contour
de telle sorte que celui-ci se positionne en dehors du tracé ou de l’objet, et non à l’intérieur ou au centre du tracé.

Lorsque vous utilisez un contour pour recouvrir deux tons directs ou un ton direct et une couleur quadri, vous devez en général
appliquer la couleur la plus claire au contour et surimprimer celui-ci.

Utilisez le panneau Aperçu des séparations pour prévisualiser les couleurs en surimpression.

1. Sélectionnez un ou plusieurs tracés à l’aide de l’outil Sélection ou Sélection directe , ou bien sélectionnez des caractères
de texte à l’aide de l’outil Texte. Pour surimprimer le contour d’un tracé collé dans un bloc, commencez par sélectionner le
tracé imbriqué (intérieur) à l’aide de l’outil Sélection directe.

Surimpression des contours et des fonds
A.  Cyan (couche inférieure) B.  Magenta (couche intermédiaire) C.  Jaune (couche supérieure)

2. Choisissez la commande Fenêtre > Sortie > Options d’objet.
3. Dans le panneau Options d’objet, utilisez l’une des méthodes suivantes :

Pour surimprimer le fond d’objets sélectionnés ou du texte non barré, sélectionnez Surimpression du fond.

Pour surimprimer le contour d’objets sélectionnés, sélectionnez Surimpression du contour.

Pour surimprimer une couleur appliquée aux espaces d’une ligne en pointillé, en traits tiretés ou à dessins, sélectionnez
Surimpression de l’espace.

Surimpression d’un filet de paragraphe
1. Assurez-vous qu’il existe une nuance pour la couleur de surimpression.
2. A l’aide de l’outil Texte, cliquez sur un point d’insertion dans un paragraphe.
3. Dans le panneau Paragraphe, choisissez Filets de paragraphe.
4. Dans le menu déroulant en haut de la boîte de dialogue, choisissez le filet de paragraphe à afficher en surimpression.
5. Sélectionnez l’une des options suivantes, puis cliquez sur OK.

Pour surimprimer le contour du filet, sélectionnez Surimpression du contour.
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Pour surimprimer une couleur appliquée aux espaces d’une ligne en pointillé, en traits tiretés ou à dessins, sélectionnez
Surimpression de l’espace.

Remarque : vous pouvez enregistrer les options Surimpression du contour ou Surimpression de l’espace de la boîte de dialogue Filets de
paragraphe dans un style de paragraphes.

Surimpression des filets situés au-dessus des notes de bas de page
Il est possible de configurer InDesign pour qu’un filet soit automatiquement inséré en vue de séparer les notes de bas de page du corps du
document. Vous pouvez décider de surimprimer ce filet.

1. Assurez-vous qu’il existe une nuance pour la couleur de surimpression.
2. Sélectionnez Texte > Options de note de bas de page du document.
3. Activez l’onglet Mise en page de la boîte de dialogue Options de note de bas de page.
4. Sélectionnez Surimpression du contour, puis cliquez sur OK.

Simulation de la surimpression des encres de tons directs
La simulation de la surimpression est utile pour contrôler les effets de surimpression des encres de tons directs avec différentes valeurs de
densité neutre (par exemple, rouge et bleu). La simulation de la surimpression dans le cas d’une impression vers un périphérique de sortie
composite permet de déterminer si vous souhaitez surimprimer ou masquer la couleur finale.

1. Dans la zone Sortie de la boîte de dialogue Imprimer, choisissez une option composite dans le menu Couleur.
Remarque : il est impossible de simuler la surimpression lorsque l’option Composite (ne pas modifier) est sélectionnée.

2. Sélectionnez Simuler la surimpression.

Modification du paramètre de surimpression du noir
Pour masquer les objets noirs dans InDesign, vous devez empêcher la surimpression de la nuance noire. Contrairement à la plupart des nuances
de couleur, qui se masquent automatiquement, la nuance noire se surimprime naturellement, notamment tous les contours, fonds et caractères
noirs. Le noir quadri 100 % apparaît avec la mention [Noir] dans le panneau Nuancier. Masquez les objets noirs soit en désélectionnant la
surimpression par défaut dans les Préférences, soit en dupliquant la nuance noire par défaut et en appliquant la nuance dupliquée aux objets de
couleur masqués. Si vous désactivez le paramètre de surimpression dans la boîte de dialogue Préférences, toutes les occurrences du noir sont
alors masquées (les encres sous-jacentes sont supprimées).

Il est parfois plus simple et plus économique de laisser l’imprimeur surimprimer le noir quadri sur la presse.

1. Choisissez Edition > Préférences > Aspect du noir (Windows) ou InDesign > Préférences > Aspect du noir (Mac OS).
2. Sélectionnez ou désélectionnez l’option Surimprimer la nuance [Noir] à 100 %.

Remarque : l’option Surimprimer la nuance [Noir] à 100% n’a aucun effet sur les teintes [Noir], les couleurs noires sans nom ou les objets qui
paraissent noirs en raison de leurs paramètres ou styles de transparence. Cette option agit exclusivement sur les objets ou le texte de couleur
caractérisés par la nuance [Noir].
Voir aussi

  Modification de l’aspect du noir CMJN (Illustrator, InDesign)
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Utilisation de la gestion des couleurs lors de l’impression
Options de sortie en couleurs pour les documents composites
Impression d’une épreuve papier
Amélioration de l’impression des dégradés de couleurs
A propos des points de demi-teintes et des points d’impression

Pour plus d’informations et d’instructions, cliquez sur les liens ci-dessous.

Utilisation de la gestion des couleurs lors de l’impression
Lorsque vous imprimez un document avec gestion des couleurs, vous pouvez spécifier des options supplémentaires pour faire en sorte que les
couleurs soient correctes à l’impression. Supposons, par exemple, que votre document contienne un profil adapté à un travail de prépresse et que
vous vouliez contrôler les couleurs du document sur une imprimante de bureau. Dans la boîte de dialogue Imprimer, convertissez les couleurs du
document selon l’espace colorimétrique de l’imprimante de bureau. Le profil de l’imprimante sera utilisé au lieu du profil du document actuel. Si
vous sélectionnez l’espace colorimétrique Epreuve et ciblez une imprimante RVB, InDesign convertit les données chromatiques en valeurs RVB à
l’aide des profils colorimétriques sélectionnés.

Lorsque vous imprimez sur une imprimante PostScript, vous avez également la possibilité d’utiliser la gestion des couleurs PostScript. Dans ce cas
de figure, InDesign envoie, avec le profil du document, des données chromatiques du document dans une version étalonnée de leur espace
colorimétrique d’origine, directement vers l’imprimante PostScript. Celle-ci se charge ensuite de convertir le document selon son propre espace
colorimétrique. L’espace colorimétrique de l’imprimante est stocké au niveau du périphérique, sous la forme d’un dictionnaire de rendu des
couleurs (CRD - Color Rendering Dictionary), rendant ainsi possible une sortie indépendante du périphérique. Les CRD sont des équivalents
PostScript des profils colorimétriques. Les résultats de cette conversion des couleurs peuvent varier d’une imprimante à l’autre. Pour utiliser la
gestion des couleurs PostScript, vous devez disposer d’une imprimante PostScript Niveau 2 ou supérieur. L’installation d’un profil ICC sur votre
système n’est pas nécessaire.

Remarque : dans le cas de documents avec gestion des couleurs, vous pouvez faire appel au panneau Contrôle en amont pour vous assurer que
les couleurs sont conformes à vos spécifications.

1. Vérifiez que le pilote d’impression et le fichier PPD appropriés sont installés sur votre ordinateur.
2. Choisissez Fichier > Imprimer.
3. Si les paramètres d’impression prédéfinie vous conviennent, choisissez-les dans le menu Impression prédéfinie situé dans la

partie supérieure de la boîte de dialogue Imprimer.
4. Modifiez les paramètres en fonction du document.
5. Cliquez sur Gestion des couleurs dans la partie gauche de la boîte de dialogue Imprimer.
6. Sous Imprimer, choisissez Document.
7. Dans la zone Traitement des couleurs, choisissez Laisser InDesign déterminer les couleurs.
8. Dans la zone Profil de l’imprimante, choisissez le profil correspondant à votre périphérique de sortie.

Plus le profil décrit précisément le comportement d’un périphérique de sortie et les conditions d’impression (par exemple le
type de papier), plus le système de gestion des couleurs peut traduire précisément les valeurs numériques des couleurs
réelles du document.

9. Choisissez Conserver les numéros RVB ou Conserver les numéros CMJN.

Cette option détermine la façon dont InDesign traite les couleurs qui n’ont pas de profil de couleur associé, comme les images
importées sans profil incorporé. Si cette option est sélectionnée, InDesign envoie les numéros des couleurs directement au
périphérique de sortie. Si cette option n’est pas sélectionnée, InDesign commence par convertir les numéros des couleurs
selon l’espace colorimétrique du périphérique de sortie.

Il est conseillé de conserver les numéros si vous suivez un flux de production CMJN sûr. La conservation des numéros n’est
pas conseillée pour l’impression de documents RVB.

10. Cliquez sur Configurer (Windows) ou sur Imprimante (Mac OS) pour accéder à la boîte de dialogue du pilote d’impression.
11. Désactivez la gestion des couleurs pour l’imprimante et cliquez sur Impression pour revenir à la boîte de dialogue

d’impression d’InDesign.

Les pilotes d’impression disposent tous d’options différentes pour la gestion des couleurs. Si vous ne savez pas comment
désactiver la gestion des couleurs, consultez la documentation de l’imprimante.
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12. Cliquez sur Imprimer.

Options de sortie en couleurs pour les documents composites
Utilisez la zone Sortie de la boîte de dialogue Imprimer pour déterminer la façon dont les couleurs composites du document sont envoyées à
l’imprimante. Lorsque la gestion des couleurs est activée (par défaut), les valeurs de couleur par défaut permettent d’obtenir une sortie couleur
étalonnée. Les informations de tons directs sont préservées lors de la conversion des couleurs ; seuls les équivalents quadri sont convertis vers
l’espace colorimétrique désigné. Si vous n’êtes pas sûr des couleurs à utiliser, consultez votre prestataires de services prépresse.

Les modes composites agissent uniquement sur les images et les objets pixellisés créés dans InDesign. Les images importées (comme les
fichiers EPS et PDF) ne sont pas concernées sauf si elles chevauchent des objets transparents.

Pour plus de détails sur l’impression composite, rendez-vous sur le site Adobe Print Resource Center à l’adresse suivante :
www.adobe.com/go/print_resource_fr.

Remarque : les options disponibles pour l’impression non PostScript dépendent du modèle colorimétrique utilisé par l’imprimante, généralement
défini sur RVB.
Lorsque vous imprimez en composite, le recouvrement automatique est désactivé. Vous pouvez sélectionner l’option Simuler la surimpression
pour vérifier la surimpression de texte, des contours ou des fonds.

La zone Sortie de la boîte de dialogue Imprimer inclut les options Couleur suivantes. En fonction de votre imprimante, des options
supplémentaires peuvent être disponibles.

Composite (ne pas modifier) Envoie les versions en couleurs des pages spécifiées vers l’imprimante, préservant ainsi toutes les valeurs
chromatiques du document d’origine. Lorsque cette option est sélectionnée, l’option Simuler la surimpression est désactivée.
Gris composite Envoie les versions en niveaux de gris des pages spécifiées vers l’imprimante. Vous pouvez utiliser cette option pour une
impression vers un périphérique de sortie monochrome sans effectuer de séparations des couleurs.
RVB composite Envoie les versions en couleurs des pages spécifiées vers l’imprimante. Vous pouvez utiliser cette option lorsque vous imprimez
vers un périphérique de sortie RVB sans effectuer de séparations des couleurs.
CMJN composite Envoie les versions en couleurs des pages spécifiées vers l’imprimante. Vous pouvez utiliser cette option lorsque vous
imprimez vers un périphérique de sortie CMJN sans effectuer de séparations des couleurs (cette option est uniquement disponible avec les
imprimantes PostScript).
Séparations Crée des informations PostScript pour chacune des séparations du document et les envoie au périphérique de sortie (cette option
est uniquement disponible avec les imprimantes PostScript).
Séparations In-RIP Envoie des informations sur les séparations au processeur RIP du périphérique de sortie (cette option est uniquement
disponible avec les imprimantes PostScript).
Texte en noir Sélectionnez cette option pour imprimer tout le texte créé dans InDesign en noir à moins que vous n’ayez sélectionné l’option de
couleur Aucun ou Papier ou une valeur chromatique équivalente au blanc. Cette option est utile lorsque vous créez un contenu destiné à
l’impression et à la distribution au format PDF. Par exemple, des hyperliens qui apparaissent en bleu dans un document PDF s’impriment en noir
et non en demi-teintes sur une imprimante à niveaux de gris, rendant la lecture plus difficile.

Impression d’une épreuve papier
Une épreuve papier (également appelée épreuve couleur) est l’impression du document en simulant son aspect final une fois imprimé sur la
presse. Elle est produite sur un périphérique de sortie moins coûteux qu’une presse à imprimer. Depuis quelques années, certaines imprimantes
de bureau offrent une résolution suffisante pour imprimer des épreuves à moindre coût.

1. Choisissez Affichage > Format d’épreuve > Personnalisé.
2. Dans la boîte de dialogue Personnaliser les conditions d’épreuvage, choisissez le périphérique de simulation, puis cliquez sur

OK.
3. Choisissez Conserver les numéros RVB ou Conserver les numéros CMJN, puis cliquez sur OK.

Cette option détermine la façon dont InDesign traite les couleurs qui n’ont pas de profil de couleur associé, comme les images
importées sans profil incorporé. Si cette option est sélectionnée, InDesign envoie les numéros des couleurs directement au
périphérique de sortie. Si cette option n’est pas sélectionnée, InDesign commence par convertir les numéros des couleurs
selon l’espace colorimétrique du périphérique de sortie.

Il est conseillé de conserver les numéros si vous suivez un flux de production CMJN sûr. La conservation des numéros n’est
pas conseillée pour l’impression de documents RVB.

4. Choisissez Fichier > Imprimer.
5. Si les paramètres d’impression prédéfinie vous conviennent, choisissez-les dans le menu Impression prédéfinie situé dans la

partie supérieure de la boîte de dialogue Imprimer.
6. Modifiez les paramètres en fonction du document.
7. Cliquez sur Gestion des couleurs dans la partie gauche de la boîte de dialogue Imprimer.
8. Sous Imprimer, choisissez Epreuve. Le profil doit correspondre au paramètre d’épreuve spécifié.
9. Dans la zone Traitement des couleurs, choisissez Laisser InDesign déterminer les couleurs.

http://www.adobe.com/go/print_resource_fr
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10. Choisissez Simuler la teinte du papier pour simuler le niveau de blanc du support d’impression tel qu’il est défini par le profil
du document (mode de rendu appelé colorimétrie absolue). Cette option n’est pas disponible pour tous les profils.

11. Cliquez sur Configurer (Windows) ou sur Imprimante (Mac OS) pour accéder à la boîte de dialogue du pilote d’impression.
12. Désactivez la gestion des couleurs pour l’imprimante et cliquez sur Impression pour revenir à la boîte de dialogue

d’impression d’InDesign.

Les pilotes d’impression disposent tous d’options différentes pour la gestion des couleurs. Si vous ne savez pas comment
désactiver la gestion des couleurs, consultez la documentation de l’imprimante.

13. Cliquez sur Imprimer.

Amélioration de l’impression des dégradés de couleurs
Les périphériques de sortie PostScript Niveau 2 et PostScript 3 peuvent imprimer jusqu’à 256 tons de gris. La plupart des imprimantes PostScript
laser de bureau impriment de 32 à 64 tons, selon la résolution du périphérique, la linéature spécifiée et le simili. Les effets de bande se produisent
lorsque chaque ton disponible recouvre une zone assez grande pour que vous puissiez le déceler à l’œil nu. De même, si vous spécifiez un
dégradé à l’aide de deux pourcentages présentant un écart inférieur à 50 %, l’intervalle spécifié sera plus étroit et les effets de bande seront plus
susceptibles de se produire. Si vous avez des difficultés à imprimer des dégradés lissés sans effets de bandes, essayez les techniques suivantes :

Choisissez un dégradé avec une amplitude de couleur d’au moins 50 % entre deux ou plusieurs composantes de couleurs
quadri.

Spécifiez des couleurs plus claires ou réduisez la longueur des dégradés foncés. Les effets de bande sont davantage
susceptibles de se produire entre des couleurs très foncées et du blanc.

Augmentez l’amplitude du dégradé.

Réduisez la linéature du document dans le cas de périphériques de sortie PostScript uniquement.

Si des effets de bandes se produisent avec une image importée, comme une image Adobe Illustrator®, essayez d’ajuster
l’image d’origine.

Imprimez vers un périphérique de sortie PostScript® 3 capable de produire des dégradés plus lisses.

Utilisez des dégradés plus courts. Leur longueur optimale dépend du nombre de couleurs utilisées. Essayez toutefois de ne
pas dépasser 20 cm de longueur.

A propos des points de demi-teintes et des points d’impression
La plupart des imprimantes simulent les gris en utilisant des points de demi-teintes imprimés sur une grille formée de cellules (appelées cellules
de demi-teintes) et de rangées (appelées lignes ou trames lignées). Chaque point de demi-teintes est constitué de points d’impression. Si les
cellules de demi-teintes se remplissent de points d’impression, le point de demi-teinte s’agrandit et l’ombre grisée devient plus foncée.

La résolution de l’imprimante détermine le nombre de points disponibles pour créer le point de demi-teintes. Une imprimante capable d’imprimer
des petits points peut produire une plus grande variété de tailles de points de demi-teintes et donc un plus grand nombre de nuances de gris. La
linéature entre aussi en jeu : lorsqu’elle augmente, la cellule de demi-teintes se réduit et contient moins de points. Les nuances de gris possibles
sont alors moins nombreuses. Il en résulte une relation entre le nombre de niveaux de gris possibles et la grossièreté de l’image.

Simulation de ton continu avec points d’impression
A.  Ton continu simulé par trame lignée B.  Trame lignée composée de points de demi-teintes en rangées C.  Points de demi-teintes composés
de points d’impression

Voir aussi
  Gestion des couleurs

  Utilisation des profils colorimétriques
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Réglage des valeurs de densité neutre des encres
Personnalisation du recouvrement pour les encres spécialisées
Ajustement de la séquence de recouvrement

Réglage des valeurs de densité neutre des encres
Vous pouvez régler les valeurs de densité neutre des encres utilisées par le logiciel de recouvrement pour déterminer l’application exacte des
recouvrements. Les valeurs de densité neutre par défaut des encres quadrichromiques se basent sur les lectures de densité neutre des
échantillons des encres quadrichromiques conformes aux normes reconnues dans différents pays. La langue détermine cette norme. Par exemple,
les valeurs de densité neutre des versions anglaise (Etats-Unis) et canadienne sont conformes aux valeurs de la norme SWOP (Specifications for
Web Offset Publications) publiée par la fondation Graphic Arts Technical Foundation of North America. Vous pouvez adapter les densités neutres
des encres quadrichromiques afin qu’elles correspondent aux normes reconnues dans d’autres pays.

Le logiciel de recouvrement déduit les valeurs de densité neutre d’un ton direct de son équivalent CMJN. Pour la plupart des tons directs, les
valeurs de densité neutre des équivalents CMJN sont suffisamment précises pour créer des recouvrements corrects. Vous devrez peut-être
adapter les valeurs de densité neutre des tons directs qui ne sont pas aisément simulés à l’aide d’encres quadrichromiques, comme les encres
métalliques ou les vernis, afin que le logiciel les recouvre correctement. Ainsi, vous garantissez que le logiciel de recouvrement reconnaît les
encres foncées et claires en tant que telles. Les options d’application appropriées sont alors automatiquement utilisées.

Pour obtenir la valeur de densité neutre convenant à une encre spécifique, contactez votre imprimeur. Pour déterminer la valeur de densité neutre
d’une encre de façon précise, mesurez un échantillon de l’encre concernée avec un densitomètre. Lisez la valeur de densité de l’encre (n’utilisez
pas de filtre). Si cette valeur diffère de la valeur par défaut, saisissez-la dans la zone de texte Densité neutre.

Remarque : la modification de la densité neutre d’un ton direct affecte uniquement le recouvrement de cette couleur. Elle n’a aucune incidence sur
l’aspect de la couleur dans le document.
Suivez ces instructions lorsque vous ajustez des valeurs de densité neutre :

Encres métalliques et opaques Les encres métalliques sont souvent plus foncées que leurs équivalents CMJN. Les encres opaques
obscurcissent les encres sous-jacentes. En général, vous devez définir la densité neutre des encres métalliques et des tons directs opaques sur
des valeurs beaucoup plus élevées que les valeurs par défaut afin que les tons directs ne s’étalent pas.
Remarque : attribuez l’option Opaque ou Ignorer Opaque du menu Type du Gestionnaire d’encres à une encre opaque pour éviter que cette
dernière ne s’étale sur d’autres couleurs, à moins qu’une autre encre opaque soit définie sur une valeur de densité neutre plus élevée.
Encres pastels Ces encres sont en général plus claires que leurs équivalents quadrichromiques. Vous pouvez donc définir la densité neutre de
ces encres sur des valeurs inférieures aux valeurs par défaut afin qu’elles s’étalent sur les couleurs foncées adjacentes.
Autres tons directs Certains tons directs, turquoise ou orange néon par exemple, sont beaucoup plus foncés ou clairs que leurs
équivalents CMJN. Pour savoir si c’est le cas, comparez des échantillons imprimés des tons directs et des équivalents CMJN. Vous pouvez régler
la densité neutre de ces tons directs sur des valeurs plus élevées ou plus faibles, selon les besoins.

Personnalisation du recouvrement pour les encres spécialisées
Vous devez tenir compte de certains éléments lorsque vous utilisez certaines encres pour le recouvrement. Par exemple, si vous vous servez d’un
vernis sur un document, ce vernis ne doit pas affecter le recouvrement. Toutefois, quand vous surimprimez certaines zones avec une encre
entièrement opaque, vous n’avez pas besoin de créer de recouvrement pour les éléments sous-jacents. Des options d’encre sont disponibles pour
ces cas de figure. En règle générale, il est préférable de ne pas modifier les paramètres par défaut, à moins que votre service de prépresse ne
vous l’ait recommandé.

Remarque : il se peut que les encres spécialisées et les vernis utilisés dans le document aient été créés en mélangeant deux tons directs ou en
mélangeant un ton direct et une ou plusieurs encres quadrichromiques.

1. Ouvrez le Gestionnaire d’encres, puis sélectionnez une encre requérant un traitement particulier.
2. Choisissez l’une des options suivantes dans le menu Type, puis cliquez sur le bouton OK :

Normal A utiliser pour des encres quadrichromiques classiques et la plupart des tons directs.

Transparent A utiliser pour les encres claires afin de garantir le recouvrement des éléments sous-jacents. Utilisez cette
option pour les vernis et les encres de diazocopie.

Opaque A utiliser pour les encres fortes non transparentes afin d’empêcher le recouvrement des couleurs sous-jacentes et
de permettre le recouvrement le long des bords des encres. Utilisez cette option pour les encres métalliques.

Ignorer Opaque A utiliser pour les encres fortes non transparentes afin d’empêcher le recouvrement des couleurs sous-
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jacentes et le long des bords des encres. Utilisez cette option pour des encres comme les encres métalliques et les vernis car
leur interaction avec d’autre encres crée des effets indésirables.

Ajustement de la séquence de recouvrement
La séquence de recouvrement (également appelée ordre de recouvrement) reflète l’ordre d’impression des encres sur la presse, et non celui des
séparations sur le périphérique de sortie.

La séquence de recouvrement est particulièrement importante lorsque vous imprimez plusieurs couleurs opaques, comme des encres métalliques.
Les encres opaques dont la séquence de recouvrement est faible s’étalent sous les encres opaques dont la séquence est plus élevée. Grâce à ce
processus, la dernière encre appliquée n’est pas étalée et les recouvrements sont de bonne qualité.

Remarque : ne modifiez pas la séquence de recouvrement par défaut sans consulter votre service de prépresse.
1. Ouvrez le Gestionnaire d’encres. La séquence de recouvrement actuelle s’affiche dans la colonne Séquence de la liste des

encres.
2. Sélectionnez une encre, saisissez une nouvelle valeur dans le champ Séquence de recouvrement, puis appuyez sur la touche

de tabulation. Cela modifie le numéro de séquence de l’encre sélectionnée, ainsi que les autres numéros de séquence.
3. Recommencez cette étape pour toutes les encres nécessaires, puis cliquez sur OK.

Voir aussi
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Présentation du gestionnaire d’encres
Spécification des couleurs à séparer
Séparation des tons directs en tant que couleurs quadri
Création d’un pseudonyme d’encre pour un ton direct
Affichage ou sortie de tons directs à l’aide de valeurs Lab
A propos de la linéature des trames de demi-teintes
Spécification de la résolution et de la linéature des trames de demi-teintes
A propos de l’émulsion et de l’exposition de l’image
Spécification de l’émulsion
Spécification de l’exposition de l’image
Vérification de la séparation et des paramètres du document
Vérification de la séparation des couleurs
Production de séparations In-RIP
Impression ou enregistrement des séparations

Pour plus d’informations et d’instructions, cliquez sur les liens ci-dessous.

Présentation du gestionnaire d’encres
Le Gestionnaire d’encres permet de gérer les encres pour la sortie. Les modifications effectuées à l’aide du Gestionnaire d’encres affectent la
sortie, pas la définition des couleurs dans le document.

Les options du Gestionnaire d’encres sont particulièrement pratiques pour les prestataires de services d’impression. Par exemple, si un travail
comprend un ton direct, un prestataire de services peut ouvrir le document et convertir ce ton direct en équivalent quadrichromique (CMJN).
Lorsqu’un document contient deux tons directs similaires alors qu’il n’en a besoin que d’un seul ou qu’un ton direct porte deux noms différents, un
prestataire de services a la possibilité d’attribuer un seul pseudonyme aux deux noms.

Dans un flux de production de recouvrement, le Gestionnaire d’encres vous permet de définir la densité d’encre pour contrôler le recouvrement,
ainsi que la séquence et le nombre corrects des encres.

Remarque : InDesign et Acrobat présentent la même technologie de Gestionnaire d’encres. Cependant, seul InDesign comporte l’option Utilise des
valeurs Lab standard pour les tons directs.

Gestionnaire d’encres
A.  Encre quadrichromique B.  Pseudonyme de ton direct C.  Ton direct

Pour ouvrir le Gestionnaire d’encres
Utilisez l’une des méthodes suivantes :
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Dans le menu du panneau Aperçu des séparations (Windows > Sortie > Aperçu des séparations), choisissez la
commande Gestionnaire d’encres.
Choisissez la commande Fichier > Imprimer et cliquez sur l’option Sorties. Dans la section Sortie, cliquez sur le bouton
Gestionnaire d’encres.

Spécification des couleurs à séparer
Chaque séparation porte un nom de couleur attribué par InDesign. Si l’icône d’une imprimante s’affiche en regard du nom de la couleur, InDesign
crée une séparation pour cette couleur. Les encres de tons directs (notamment celles définies et utilisées dans les fichiers aux formats PDF
ou EPS) s’affichent également dans la liste des encres.

1. Dans la zone Sortie de la boîte de dialogue d’impression, sélectionnez Séparations ou Séparations In-RIP si vous utilisez un
fichier PPD prenant en charge les séparations In-RIP.

2. Utilisez l’une des méthodes suivantes :

Pour créer une séparation, assurez-vous que l’icône d’imprimante s’affiche en regard du nom de la couleur dans la liste
des encres.

Si vous ne souhaitez pas créer de séparation, cliquez sur l’icône d’imprimante en regard du nom de la couleur. L’icône de
l’imprimante disparaît.

Séparation des tons directs en tant que couleurs quadri
Grâce au Gestionnaire d’encres, vous pouvez convertir les tons directs en couleurs quadrichromiques. Lorsque les tons directs sont convertis en
équivalents quadrichromiques, ils sont imprimés en tant que séparations plutôt que sur une plaque unique. La conversion d’un ton direct est utile
si vous avez ajouté par inadvertance un ton direct à un document de couleur quadrichromique ou si le document contient trop de tons directs pour
l’impression.

1. Dans le Gestionnaire d’encres, utilisez l’une des méthodes suivantes :

Pour séparer les tons directs individuels, cliquez sur l’icône de type d’encre en regard du ton direct ou du pseudonyme de
ton direct. Une icône de couleur quadrichromique s’affiche. Pour remplacer la couleur quadrichromique par un ton direct,
cliquez de nouveau sur l’icône.

Pour séparer tous les tons directs, cochez la case Quadrichromie. Les icônes en regard des tons directs sont remplacées
par les icônes de couleurs quadrichromiques. Pour restaurer les tons directs, désélectionnez l’option Quadrichromie.

Remarque : lorsque l’option Quadrichromie est sélectionnée, tous les pseudonymes d’encre définis dans le Gestionnaire
d’encres sont supprimés et les paramètres de surimpression et de recouvrement du document sont modifiés.

2. (InDesign uniquement) Pour utiliser les valeurs Lab d’un ton direct plutôt que les définitions CMJN, sélectionnez l’option
Utiliser des valeurs Lab standard pour les tons directs.

Création d’un pseudonyme d’encre pour un ton direct
Vous pouvez mapper un ton direct à un autre ton direct ou à une autre couleur quadrichromique en créant un pseudonyme. Ce dernier est utile si
un document contient deux tons directs similaires alors qu’un seul ton est requis ou si le document contient trop de tons directs. Le mode Aperçu
de la surimpression vous permet d’observer les effets (à l’écran) du pseudonyme d’encre sur la sortie imprimée.

1. Dans le Gestionnaire d’encres, sélectionnez l’encre du ton direct pour laquelle vous souhaitez créer un pseudonyme.
2. Choisissez une option dans le menu Pseudonyme de l’encre. L’icône de type d’encre et la description de l’encre sont

modifiées en conséquence.

Affichage ou sortie de tons directs à l’aide de valeurs Lab
Certains tons directs prédéfinis, tels que les couleurs issues des bibliothèques TOYO, PANTONE, DIC et HKS sont définies au moyen de valeurs
Lab. Pour garantir une comptabilité descendante avec les versions précédentes d’InDesign, les couleurs issues de ces bibliothèques comportent
également des définitions CMJN. Lorsqu’elles sont utilisées avec les profils de périphérique adéquats, les valeurs Lab permettent d’obtenir le
résultat le plus précis possible en sortie sur tous les périphériques. Si la gestion des couleurs est un aspect essentiel du projet, il peut être
préférable d’afficher, d’exporter et d’imprimer les tons directs selon leurs valeurs Lab. L’option Utilise des valeurs Lab standard pour les tons
directs du Gestionnaire d’encres permet de sélectionner le mode couleur devant être utilisé dans InDesign pour le traitement des tons directs
prédéfinis : Lab ou CMJN. Si la sortie doit correspondre à celles obtenues dans les versions précédentes d’InDesign, utilisez les valeurs CMJN
équivalentes.

Remarque : lorsque l’option Aperçu de la surimpression est activée, les valeurs Lab sont systématiquement utilisées afin d’améliorer le niveau de
précision à l’écran. Les valeurs Lab sont également utilisées en cas d’impression ou d’exportation lorsque l’option Simuler la surimpression est
activée dans la boîte de dialogue Imprimer ou Exporter au format Adobe PDF.

1. Choisissez Gestionnaire d’encres dans le menu du panneau Aperçu des séparations.
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2. Utilisez l’une des méthodes suivantes :

Pour utiliser les valeurs Lab, sélectionnez Utilise des valeurs Lab standard pour les tons directs.

Pour utiliser les valeurs CMJN, désélectionnez Utilise des valeurs Lab standard pour les tons directs.

A propos de la linéature des trames de demi-teintes
Chez les imprimeurs, les tons continus sont simulés par des points (appelés points de trame) imprimés sur des rangées (nommées lignes ou
linéatures). Les lignes sont imprimées selon des angles différents afin d’en atténuer l’effet. Le menu Tramage du panneau Sortie de la boîte de
dialogue Impression affiche les linéatures recommandées en lignes par pouce (lpp) et la résolution en points par pouce (ppp), en fonction du
fichier PPD sélectionné. Lorsque vous sélectionnez des encres dans la liste, les champs de linéature de trame et d’angle reflètent les valeurs
correspondant à l’encre sélectionnée.

Une linéature élevée (par exemple, 150 lpp) réunit étroitement les points pour créer une image précise sur la presse ; une linéature faible (de
60 lpp à 85 lpp) espace considérablement les points pour créer une image moins fine. La taille des points est également déterminée par la
linéature. Une linéature élevée utilise des points de petite taille ; une linéature faible utilise des points de grande taille. Le facteur le plus important
lors du choix de la linéature est le type de presse utilisé pour votre tâche. Demandez à votre prestataire de services la linéature de sa presse et
faites vos choix en conséquence.

Linéatures
A.  65 lpp : linéature moins fine destinée à l’impression de publicités et de bons de réduction B.  85 lpp : linéature moyenne destinée à
l’impression de journaux C.  133 lpp : linéature de qualité supérieure destinée à l’impression de magazines en quadrichromie D.  177 lpp :
linéature très précise destinée à l’impression de rapports annuels et d’images de livres d’art

Les fichiers PPD de photocomposeuses haute résolution offrent une large gamme de linéatures possibles associées à diverses résolutions de
photocomposeuses. Pour les imprimantes basse résolution, les fichiers PPD proposent un moindre choix de linéatures de trame, moins fines
(généralement comprises entre 53 et 85 lpp). Ces linéatures donnent néanmoins les meilleurs résultats sur les imprimantes basse résolution. La
définition d’une linéature plus fine, de 100 lpp par exemple, affaiblit la qualité de l’image si vous utilisez une imprimante basse résolution pour la
sortie finale.

Spécification de la résolution et de la linéature des trames de demi-teintes
 Dans le volet Sortie de la boîte de dialogue Imprimer, choisissez une des options suivantes :

Pour sélectionner une des linéatures prédéfinies et une résolution d’imprimante associée, choisissez une option du menu
Tramage.

Pour spécifier une linéature personnalisée pour des trames de demi-teintes, sélectionnez la plaque à personnaliser, puis
entrez une valeur exprimée en lpp dans la zone Linéature et une valeur d’angle dans la zone Angle.

Remarque : avant de créer vos propres trames de demi-teintes, vérifiez les angles et linéatures recommandées auprès de votre prestataire de
services. Sachez que certains périphériques de sortie effacent les angles et linéatures par défaut.

A propos de l’émulsion et de l’exposition de l’image
Selon le type de presse utilisé et le mode de transfert des informations entre le film et les plaques d’impression, votre prestataire de services peut
vous demander des films négatifs ou positifs, avec l’émulsion sur la face supérieure ou inférieure. L’émulsion correspond à la couche
photosensible d’un support d’impression (film ou papier). De manière générale, les imprimeurs exigent des films négatifs aux Etats-Unis et positifs
en Europe et au Japon. Vérifiez auprès de votre prestataire quel sens d’émulsion il utilise.
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Pour distinguer la face de l’émulsion de l’autre (ou base), examinez le film final sous un bon éclairage. L’une des faces est plus brillante que
l’autre. La face mate est celle de l’émulsion tandis que la face brillante constitue la base.

Options d’émulsion
A.  Image positive B.  Négatif C.  Négatif avec émulsion sur la face inférieure

Important : les paramètres d’émulsion et d’exposition de la boîte de dialogue Imprimer écrasent toute configuration conflictuelle du pilote
d’imprimante. Spécifiez toujours les paramètres d’impression à l’aide de la boîte de dialogue d’impression.

Spécification de l’émulsion
1. Choisissez Gris composite ou une option de séparation dans le menu déroulant Couleur du volet Sortie de la boîte de

dialogue Imprimer.
2. Dans Symétrie, sélectionnez l’une des options suivantes :

Aucune (par défaut) N’applique aucune modification à l’orientation de la zone imprimable. Le texte de l’image est lisible
(c’est-à-dire, le sens de lecture est normal) lorsque la couche photosensible est face à vous.

Horizontale Permet de refléter la zone imprimable le long d’un axe vertical pour une lecture inversée.

Verticale Permet de refléter la zone imprimable le long d’un axe horizontal de sorte qu’elle soit sens dessus-dessous.

Horizontale et verticale Permet de refléter la zone imprimable le long des axes horizontal et vertical pour une lecture
inversée. Le texte est lisible lorsque la couche photosensible n’est pas face à vous. Les images imprimées sur film le sont
souvent avec l’option Horizontale et verticale.

Spécification de l’exposition de l’image
1. Choisissez Gris composite ou une option de séparation dans le menu déroulant Couleur du volet Sortie de la boîte de

dialogue Imprimer.
2. Sélectionnez ou désélectionnez l’option Négatif.

Vérification de la séparation et des paramètres du document
La zone Synthèse de la boîte de dialogue Imprimer affiche une synthèse des informations de gestion des couleurs, des dimensions des repères
d’impression et des fonds perdus du document. Elle indique également si le recouvrement est activé.

De même, vous pouvez effectuer un contrôle qualité avant impression ou avant de remettre le document à votre prestataire de services.

Vérification de la séparation des couleurs
Créez une épreuve papier pour vérifier que les séparations sont correctes à l’impression ou une épreuve à l’écran pour prévisualiser l’aspect des
couleurs du document sur un périphérique de sortie particulier.

Remarque : une épreuve ne permet pas d’obtenir une représentation exacte de la sortie finale ; toutefois, il est possible d’accroître le degré de
précision d’une épreuve en étalonnant tous les périphériques utilisés lors de la création du document (tels que les scanners, les moniteurs et les
imprimantes). Lorsque les périphériques sont correctement étalonnés, le système de gestion des couleurs peut être exploité pour obtenir des
couleurs fiables et homogènes.
L’épreuve papier représente les séparations finales que vous attendez et aide votre prestataire de services à vérifier que l’impression est correcte.
Assurez-vous d’utiliser une imprimante PostScript pour les épreuves, car une imprimante non PostScript ne permet pas de vérifier la séparation
des couleurs de manière fiable.

Pour garantir une impression correcte du fichier, enregistrez les séparations en tant que fichier PostScript et convertissez ce dernier au format
Acrobat 8 PDF à l’aide d’Acrobat Distiller. Vous obtenez un fichier PDF que vous pouvez visualiser dans Acrobat. Vous pouvez ainsi contrôler
en détail les impressions PostScript de haute qualité à l’écran.

Production de séparations In-RIP
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Pour cette méthode, les éléments suivants sont nécessaires :

un fichier PPD prenant en charge les séparations In-RIP ;

un périphérique PostScript 3 ou PostScript niveau 2 avec un processeur RIP prenant en charge les séparations In-RIP. Si le
document contient des images bichromes de Photoshop 5.0 ou version ultérieure, un périphérique PostScript 3 est requis pour
générer les séparations In-RIP.

Remarque : en fonction du logiciel de prépresse utilisé, un prestataire de services peut éventuellement effectuer des tâches de prépresse telles
que le recouvrement, l’imposition, la séparation et le remplacement OPI au niveau du processeur RIP du périphérique de sortie. Votre prestataire
de services préférera donc dans certains cas recevoir un fichier PostScript composite correspondant au document optimisé pour des séparations
In-RIP, plutôt qu’un fichier PostScript préséparé.

Impression ou enregistrement des séparations
1. Dans la partie supérieure de la boîte de dialogue Imprimer, choisissez un paramètre prédéfini dans le menu Impression

prédéfinie, s’il en existe un présentant les paramètres de séparation appropriés.
2. Utilisez l’une des méthodes suivantes :

Pour imprimer sur un périphérique de sortie, choisissez-le dans le menu Imprimante.

Pour imprimer dans un fichier, choisissez Fichier PostScript® dans le menu Imprimante. Choisissez un fichier PPD
prenant en charge le périphérique de sortie.

3. Cliquez sur Général, puis spécifiez les pages à séparer.
4. Cliquez sur Sortie et utilisez l’une des méthodes suivantes :

Pour imprimer sur un périphérique de sortie, choisissez Séparations pour créer les séparations dans InDesign.

Pour imprimer vers un fichier, choisissez soit Séparations, soit Séparations In-RIP pour enregistrer les paramètres de
séparation dans un fichier PostScript composite pour un traitement RIP.

Remarque : pour utiliser le recouvrement Adobe In-RIP, vous devez recourir aux séparations In-RIP plutôt qu’à des
séparations basées sur un ordinateur hôte, sinon la fonction de recouvrement n’aurait pas accès à toutes les couleurs en
même temps et le recouvrement n’aurait pas lieu.

5. Cliquez sur Graphiques et procédez comme suit :

Dans la zone Envoi des données, choisissez l’option Toutes.

Dans la zone Téléchargement, choisissez l’option Complet ou Jeu partiel, à moins que les polices ne soient insérées
ultérieurement (par exemple, au niveau du RIP ou par une application de traitement d’images).

Dans la zone PostScript®, sélectionnez le niveau PostScript du périphérique de sortie : Niveau 2 ou Niveau 3.

6. Cliquez sur Avancé et utilisez l’une des méthodes suivantes :

Pour remplacer des graphiques basse résolution incorporés dans des fichiers EPS par leurs version haute résolution au
moment de l’impression, assurez-vous que l’option Lire les liens d’images incorporés OPI est sélectionnée lors de
l’importation du fichier EPS vers le document InDesign, puis sélectionnez Substitution d’image OPI dans la zone Avancé
de la boîte de dialogue d’impression.

Pour ignorer les différents types d’images importées afin qu’elles soient remplacées ultérieurement par un serveur OPI,
sélectionnez une option Ignorer pour OPI.

Dans la section Aplatissement prédéfini des transparences, choisissez [Haute résolution] ou un style personnalisé
disponible avec des paramètres haute résolution.

7. Choisissez d’autres options d’impression le cas échéant.
8. Utilisez l’une des méthodes suivantes :

Pour imprimer sur un périphérique de sortie, cliquez sur Imprimer.

Pour imprimer vers un fichier, cliquez sur Enregistrer et acceptez le nom de fichier par défaut ou entrez un autre nom de
fichier, puis cliquez de nouveau sur Enregistrer.

Remarque : après avoir créé la séparation des couleurs dans le document InDesign, les paramètres de la boîte de dialogue d’impression sont
enregistrés avec le fichier séparé. Les paramètres de séparation, les informations du fichier PPD et les conversions de couleurs spécifiées dans la
boîte de dialogue d’impression sont enregistrés dans le fichier.
Voir aussi

  Epreuvage des couleurs

Informations juridiques   |   Politique de confidentialité en ligne

http://help.adobe.com/fr_FR/CreativeSuite/CS5/Using/WS3F71DA01-0962-4b2e-B7FD-C956F8659BB3.html
http://creativecommons.org/licenses/by-nc-sa/3.0/
http://helpx.adobe.com/fr/legal/legal-notices.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr


 



Publications numériques

Appliquer des règles de mise en page basée sur le repère
Anne-Marie Concepcion  (15 mai 2012)
Didacticiel - vidéo
En savoir plus sur le fonctionnement des règles de mise en page liquide basées sur le repère et comment créer des repères liquides et des
repères de règle.

Appliquer des règles de mise en page basée sur l’objet
Anne-Marie Concepcion  (15 mai 2012)
Didacticiel - vidéo
Découvrez le fonctionnement des règles de mise en page liquide basées sur l’objet, aussi bien sur l’objet que via le panneau Mise en page
liquide.

Comprendre les règles de mise en page liquide
Anne-Marie Concepcion  (15 mai 2012)
Didacticiel - vidéo
Ce didacticiel définit et explique la mise en page liquide, et présente l’emplacement des commandes et des boîtes de dialogue relatives à la
mise en page liquide.

Utilisation des règles de mise en page liquide de base : Mise à l’échelle, Recentrer et Basé sur le gabarit
Anne-Marie Concepcion  (15 mai 2012)
Didacticiel - vidéo
Apprenez à appliquer les règles Aucune, Mise à l’échelle et Recentrer lors du redimensionnement d’une mise en page. Apprenez aussi la
signification de « Basé sur le gabarit ».

Travailler avec des variantes de mise en page
Anne-Marie Concepcion  (15 mai 2012)
Didacticiel - vidéo
Apprenez à utiliser les mises en page alternatives pour l’impression et la publication numérique.

Modification de l’adresse électronique associée à l’ID Adobe
WHB III  (24 avril 2012)
Résolution des problèmes
Changer l’adresse électronique d’un ID Adobe : DPS

Gestion de l’ordre d’exportation du contenu à partir d’InDesign vers EPUB sans changer votre mise en page
(vidéo 04:54)
Colin Fleming  (01er janvier 2011)
Didacticiel - vidéo
Apprenez à créer et organiser les articles dans le panneau Articles pour l’exportation au format EPUB, sans modifier la mise en page ou écrire
du code.

Création de couvertures et de pages de titre pour EPUB (vidéo 05:50)
Colin Fleming  (01er janvier 2011)
Didacticiel - vidéo
Apprenez à créer des couvertures et pages de titre pour vos titres EPUB.

Exportation de documents au format EPUB (PDF, 265 Ko)
Référence  (01er janvier 2011)
Un petit aperçu rapide sur la façon d’exporter vos mises en page au format EPUB dans InDesign CS5.

Exportation au format EPUB pour l’Apple iBookstore (PDF, 2,5 Mo)
Référence  (01er janvier 2011)

http://tv.adobe.com/watch/learn-indesign-cs6/applying-guide-based-liquid-layout-rules/
http://tv.adobe.com/watch/learn-indesign-cs6/applying-object-based-liquid-layout-rules/
http://tv.adobe.com/watch/learn-indesign-cs6/understanding-liquid-layout-rules/
http://tv.adobe.com/watch/learn-indesign-cs6/using-basic-liquid-layout-rules-scale-recenter-and-based-on-master/
http://tv.adobe.com/watch/learn-indesign-cs6/working-with-alternate-layouts/
http://tv.adobe.com/watch/cs55-design-standard-feature-tour/controlling-order-of-content-export-from-indesign-cs55-to-epub-without-changing-your-layout-and-without-writing-code/
http://tv.adobe.com/watch/cs55-design-standard-feature-tour/controlling-order-of-content-export-from-indesign-cs55-to-epub-without-changing-your-layout-and-without-writing-code/
http://tv.adobe.com/watch/cs55-design-standard-feature-tour/creating-covers-and-title-pages-for-epub-in-indesign-cs55/
http://www.adobe.com/support/indesign/gettingstarted/pdfs/id_dyk_epub_production_v4.pdf
http://www.adobe.com/content/dam/Adobe/en/devnet/indesign/pdfs/indesign-to-ipad.pdf


Apprenez à créer un EPUB pour l’App Store Apple d’iBook

Outils Folio Producer (vidéo 01:04)
Didacticiel - vidéo  (01er janvier 2011)
Une présentation très courte des outils Folio Producer pour la publication numérique.

http://www.adobe.com/feature/indesign/folio-producer-tools.modaldisplay.0.html


Exportation de contenu pour EPUB
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Présentation
Prise en charge du texte
Prise en charge d’hyperliens
Prise en charge de la navigation
Génération de feuille de style CSS pour un livre
Exporter au format EPUB
Options d’exportation de mise en page fixe
Options d’exportation au format redistribuable
Options d'exportation d'objet
Ressources EPUB

Présentation

Vous pouvez exporter un document InDesign au format EPUB pour permettre aux utilisateurs d’afficher la sortie dans un lecteur EPUB.

Vous pouvez choisir d’exporter le document au format EPUB redistribuable. Un document EPUB redistribuable permet au lecteur EPUB
d’optimiser le contenu selon le périphérique d’affichage.

Le format redistribuable est plus adapté pour les documents destinés aux utilisateurs de périphériques eInk. De plus, le format redistribuable est
recommandé si vous souhaitez fournir des options permettant de modifier la police et la taille du texte dans le lecteur.

Vous pouvez choisir d’exporter vos documents au format de mise en page fixe. Le format de mise en page fixe permet d’inclure du contenu audio,
vidéo et Edge dans vos documents.

Vous pouvez également exporter des documents interactifs qui comportent des contrôles tels que des boutons de navigation, des transitions de
page, des animations et des hyperliens au format de mise en page fixe.

Le format de mise en page fixe est plus adapté aux documents comprenant un grand nombre de graphiques, ainsi que du contenu audio et vidéo
volumineux. Ce format convient mieux aux livres pour enfants, aux livres de cuisine, aux manuels et aux bandes dessinées.

Prise en charge du texte

Les options de texte suivantes sont prises en charge lors de la création de documents pour l’exportation au format de mise en page fixe :

Le texte ne subit pas de pixellisation. Ceci implique que le texte dynamique est indexable et sélectionnable.

Le texte dynamique peut être redimensionné horizontalement et verticalement.

Des points de conduite peuvent être inclus.

Les attributs de langue sont marqués sur des balises.

Les balises sont identifiées par des classes CSS.

Les hyperliens et les références croisées du texte sont pris en charge pour les adresses URL, les ancres de texte et les pages.

Notez également les restrictions suivantes lors de l’insertion de texte dans vos documents pour l’exportation au format EPUB :

Le crénage n’est pas pris en charge sur un glyphe individuel et est distribué sous forme d’interlettrage sur toutes les lettres d’un mot.

Les variantes de glyphes générées par des fonctions OpenType, notamment Petites capitales, Tout en capitales et Fractions, ne sont pas prises en
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charge en raison de la prise en charge de périphérique limitée.

Les blocs de texte lu de droite à gauche du Moyen-Orient ne sont toujours pas correctement pris en charge.

Prise en charge de texte en japonais

Les options suivantes de fonction pour le japonais sont disponibles pour l’exportation au format de mise en page fixe :

Le texte Ruby est dynamique et non pixellisé à la sortie.
Warichu est pris en charge en tant que texte dynamique.
La rotation de caractères est prise en charge dans le texte dynamique.
Les polices composites sont prises en charge.
Les blocs de texte verticaux sont pris en charge, y compris les glyphes pivotés.

Notez également les restrictions suivantes lors de l’insertion de texte en japonais dans vos documents destinés à l’exportation au format EPUB :

Le bloc de texte en japonais Tate-Chu-Yoko n’est pas pris en charge dans les blocs de texte verticaux.

Les caractères idéographiques japonais perdent leur positionnement lors de l’utilisation de polices True Type.

La police japonaise Kenten est pixellisée dans du texte dynamique.

Prise en charge d’hyperliens

Les options suivantes d’hyperliens sont prises en charge lors de la création de documents destinés à l’exportation au format de mise en page fixe :

Hyperliens et références croisées textuels

Hyperliens d’objets

Hyperliens vers les pages pour les hyperliens textuels et d’objets

Prise en charge de la navigation

Le processus d’exportation offre les fonctionnalités suivantes de navigation dans la sortie EPUB :

Les points de repère NAV sont générés à la fois pour la mise en page fixe et pour les formats redistribuables basés sur
les valeurs pour le type epub:type spécifiées dans la boîte de dialogue Options d’exportation d’objet.

Seule la première occurrence de la valeur est ajoutée aux points de repère.

InDesign prend en charge la section EPUB 2 dans le fichier OPF. InDesign détecte automatiquement la couverture et l’option
d’impression de la table des matières. Pour déterminer le type de texte, InDesign utilise les valeurs epub:type spécifiées dans la boîte de
dialogue Options d’exportation d’objet.

(Format de mise en page fixe). InDesign génère une liste de pages en mappant les chaînes de numéro de la page sur les
fichiers XHTML générés à partir de cette page.

Génération de feuille de style CSS pour un livre

Lorsque vous exportez un livre au format EPUB, le processus d’exportation génère une feuille de style CSS pour chaque document du livre.
Chaque feuille de style CSS de document définit les styles propres au document. Le processus crée également une feuille de style CSS de gabarit
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Couverture

Sans

Pixelliser la première page

Sélectionner une image

Table des matières de navigation

qui inclut les styles communs utilisés dans l’ensemble des documents du livre.

Exporter au format EPUB

Vous pouvez exporter un document ou un livre au format EPUB redistribuable ou de mise en page fixe.

1. Utilisez l’une des méthodes suivantes :

Ouvrez le document et choisissez Fichier > Exporter.

Ouvrez un livre, puis dans le menu du panneau Livre, choisissez Exporter le livre au format EPUB.

2. Spécifiez le nom et le dossier du fichier.

3. Dans la liste Format, sélectionnez EPUB (mise en page fixe) ou EPUB (redistribuable), puis cliquez sur Enregistrer.

4. Dans la boîte de dialogue Options d’exportation EPUB, spécifiez les options désirées, puis cliquez sur OK.

Pour plus d’informations, voir les Options d’exportation de mise en page fixe ou les Options d’exportation au format
redistribuable.

InDesign crée un seul fichier .epub incluant le contenu XHTML. L’affichage du fichier nécessite un lecteur ePUB. Vous pouvez également utiliser
le lecteur Adobe Digital Editions, qui peut être téléchargé gratuitement à partir du site Web d’Adobe.

Le fichier .epub s'apparente à un fichier .zip. Pour afficher et modifier le contenu d’un fichier EPUB, remplacez l’extension .epub par .zip, puis
extrayez le contenu. Ceci est particulièrement utile pour modifier un fichier CSS.

Le fichier .epub exporté peut inclure une image de couverture. Vous pouvez sélectionner une image à utiliser comme couverture. Vous pouvez
aussi autoriser InDesign à pixelliser la première page du document exporté, le document source des styles ou le livre exporté. La miniature
apparaît dans les lecteurs EPUB ou dans l’affichage de bibliothèque du logiciel Digital Editions Reader.

Options d’exportation de mise en page fixe

Section générale

Version du fichier EPUB. 

Prend en charge le contenu audio, vidéo, JavaScript et le texte vertical en japonais.
Ce n'est pas le cas sur les périphériques qui ne prennent pas en charge la norme EPUB 3.0.
EPUB 3.0 est une norme approuvée (IDPF, 2011).

Image de couverture pour l’eBook. Choisissez l’une des options suivantes :

Aucune image de couverture n’est ajoutée.

Sélectionnez cette option pour permettre à InDesign de créer une image en pixellisant la première page de
l’eBook à utiliser comme couverture.

Sélectionnez un fichier image sur votre ordinateur pour l’utiliser comme couverture.

Spécifiez l’option de navigation pour la Table des matières du visualiseur EPUB.
Utilisez l'option Niveaux multiples (style de table des matières) pour créer la barre latérale de navigation ou utiliser le nom de fichier.

http://idiom-q-win-1/fr/indesign/using/export-content-epub-cc.html#main-pars_header_3
http://idiom-q-win-1/fr/indesign/using/export-content-epub-cc.html#main-pars_header_1
http://idiom-q-win-1/fr/indesign/using/export-content-epub-cc.html#main-pars_header_1
http://www.adobe.com/fr/solutions/ebook/digital-editions.html


Nom de fichier

Niveaux multiples (style de table des matières)

Signets

Options

En fonction du format de document

Convertir la planche au format paysage

Activer les planches synthétiques

Désactiver les planches

Format

Automatique

PNG

Résolution (ppp)

Options GIF (Palette)

Adaptative (sans simulation)

Web

Système (Windows) ou Système (Mac)

Entrelacement

Générez une table des matières en réutilisant les noms de fichiers.

Générez une table des matières en réutilisant le style de table des matières
sélectionné.
Dans le menu Style de table des matières, définissez le style de la table des matières à utiliser pour créer la table des matières de
l’eBook.
Vous pouvez choisir Mise en page > Styles de tables des matières pour créer un style spécial de table des matières pour l’eBook.

(EPUB 3) Générez une table des matières en réutilisant les signets créés dans un document InDesign.
InDesign prend en charge les ancres de texte et des pages locales ou externes (du livre). Ces dernières peuvent être générées en créant
une table des matières dans InDesign et en spécifiant Créer des signets PDF.
Pour plus d’informations, voir la rubrique Signets.

Définissez l’ordre dans lequel les éléments de la page sont exportés.

InDesign détermine le contrôle de planche à partir des paramètres définis dans la boîte de dialogue
Configuration du document (Fichier > Format de document).

Convertir la planche au format paysage.

Autoriser l’exportation des planches synthétiques dans le document.

Aucune des planches n’est exportée vers la sortie EPUB.

Section Paramètres de conversion

Dans le menu Conversion d’image, déterminez le mode d'exportation des images au format EPUB.

Indiquez si les images optimisées dans le document sont converties au format GIF, JPEG ou PNG.

Laissez InDesign définir le format à utiliser dans chaque cas.

Désactivez les paramètres de compression de l’image. Utilisez le format PNG pour les images sans perte de données ou pour celles
qui contiennent des objets transparents.

Choisissez la résolution des images en pixels par pouce (ppp). Tandis que les systèmes d’exploitation ont adopté une
résolution standard de 72 ppp ou 96 ppp, la résolution des terminaux mobiles varie de 132 ppp (iPad) à 172 ppp (Sony Reader), voire même plus
de 300 ppp (iPhone 4).
Vous pouvez choisir une valeur ppp pour chaque objet sélectionné, parmi lesquelles 72, 96, 150 (moyenne pour tous les lecteurs électroniques du
moment) et 300.

Cette option vous permet de contrôler la façon dont InDesign gère les couleurs lors de l’optimisation des fichiers GIF. Le
format GIF utilise une palette de couleurs limitée, qui ne doit pas contenir plus de 256 couleurs.

Créez une palette à l’aide d’un échantillon représentatif de couleurs dans l’illustration sans aucun tramage
(mélange de petits points de couleurs permettant de simuler des couleurs supplémentaires).

Créez une palette de couleurs Web qui sont un sous-ensemble des couleurs système Windows et Mac OS.

Créez une palette à l’aide de la palette de couleurs système intégrée. Cette option peut
entraîner des résultats inattendus.

Chargez progressivement les images en remplissant les lignes manquantes. Lorsque cette option est désélectionnée,

http://idiom-q-win-1/fr/indesign/using/bookmarks.html#bookmarks


Options JPEG > Méthode de mise en forme

Progressive

Ligne de base

Options JPEG > Qualité d’image

Afficher le fichier EPUB après l’exportation

Identifiant

l’image paraît floue, puis elle devient plus nette au fur à et mesure qu’elle approche de sa résolution maximale.

Déterminez la vitesse d’affichage des images JPEG à l’ouverture du fichier contenant l’image dans
un navigateur Web.

Affichez les images JPEG graduellement avec un nombre croissant de détails lors de leur téléchargement.
Les fichiers créés avec cette option sont légèrement plus volumineux et utilisent davantage de RAM à l’affichage.
Choisissez l'option Ligne de base pour afficher chaque fichier JPEG uniquement après son téléchargement. Un espace réservé s’affiche
tant que l’image n’est pas téléchargée.

Affichez chaque fichier JPEG uniquement après son téléchargement.
Un espace réservé s’affiche tant que l’image n’est pas téléchargée.

Sélectionnez la qualité d’image requise pour chaque image JPEG créée à la sortie.
Sélectionnez l'option Faible pour générer le plus petit fichier et la qualité d’image la plus faible.

La section Affichage des applications de la boîte de dialogue EPUB - Options d’exportation de mise en page fixe contient les options suivantes :

Ouvre le fichier EPUB dans l’application par défaut sélectionnée pour lire ce format, si elle est
disponible.
S’applique aux deux boîtes de dialogue des options d’exportation de mise en page fixe et reformatable.

Section Métadonnées

Les métadonnées du document (ou le document de source des styles, si un livre a été sélectionné) sont incluses dans le fichier exporté.

(Lecture seule) Chaque document EPUB doit comporter un identifiant unique. Un identifiant unique est créé automatiquement
et s’affiche.

Application EPUB  Version  Pris en charge Non pris en charge

Mac

iBooks d’Apple 1.0.1 Oui  

Oxygen 14.1 Oui  

Previewer de Kindle 2.92 Oui  

Sigil 0.7.4 Oui  

Kindle 1.10.6  Non

VitalSource Bookshelf 6.2  Non

Book Proofer d’Apple 1.0.1 N’accepte pas les fichiers EPUB avec polices incorporées.

Windows

Sigil 0.7.4 Oui  

Previewer de Kindle 2.92 Oui  

Adobe Digital Editions 3.0.86137 Oui  

Calibre 1.26 Oui  

Oxygen 15 Oui  

Azardi 2.0 Oui  

Kobo 3.6.0  Non



Titre

Créateur

Date

Description

Editeur

Droits

Sujet

Ajouter une feuille de style

Supprimer

JavaScript

Haut de la page

Version

EPUB 2.0.1

EPUB 3.0

Couverture

Sans

Pixelliser la première page

Sélectionner une image

Saisissez le titre du fichier EPUB.

Saisissez le nom de l’auteur du fichier EPUB.

Spécifiez la date à laquelle le fichier EPUB a été créé.

Saisissez une description du fichier EPUB.

Spécifiez les détails concernant l’éditeur qui doivent figurer dans les métadonnées eBook. Par exemple, vous pouvez spécifier
l’adresse URL de l’éditeur.

Saisissez les informations de copyright ici.

Saisissez le sujet du EPUB.

Section CSS

Indiquez l’adresse URL d’une feuille de style CSS existante qui va être utilisée dans l’exportation EPUB.
InDesign ne vérifie pas si la feuille de style CSS existe ou est valide. Vous pouvez utiliser Dreamweaver pour confirmer la configuration
CSS externe.

Supprimer la feuille de style sélectionnée

Section JavaScript

Indiquez l’URL d’un JavaScript existant. InDesign ne vérifie ni l’existence ni la validité du JavaScript. Il est donc recommandé de
confirmer la configuration de votre JavaScript.

Options d’exportation au format redistribuable

Section générale

Spécifiez une version pour EPUB.

EPUB 2.0.1 est une norme approuvée par l’IDPF en 2007. Ce format est pris en charge sur de nombreux périphériques.

EPUB 3.0est une norme approuvée par l’IDPF en 2011. Ce format prend également en charge l’audio, la vidéo, le JavaScript,
le texte vertical en japonais. Ce format ne fonctionne pas sur les lecteurs et les périphériques qui ne prennent pas en charge la norme
EPUB 3.0.

Il s’agit de l’image de couverture de l’eBook. Choisissez l’une des options suivantes :

Aucune image de couverture n’est ajoutée.

Sélectionnez cette option pour permettre à InDesign de créer une image en pixellisant la première page de
l’eBook à utiliser comme couverture.

Sélectionnez un fichier image sur votre ordinateur pour l’utiliser comme couverture.



Table des matières de navigation

Nom de fichier

Niveaux multiples (style de table des matières)

Ordre

D’après la mise en page

Identique à la structure XML

Identique au panneau Articles

Notes de bas de page

Options > Supprimer les sauts de ligne forcés

Listes > Puces

Listes > Numéros

Faire correspondre à des listes triées

Spécifiez l’option de navigation pour la Table des matières du visualiseur EPUB.
Utilisez l'option Niveaux multiples (style de table des matières) pour créer la barre latérale de navigation ou utiliser le nom de fichier.

Générez une table des matières en réutilisant les noms de fichiers.

Générez une table des matières en réutilisant le style de table des matières
sélectionné. Dans le menu Style de table des matières, définissez le style de la table des matières à utiliser pour créer la table des
matières de l’eBook. Vous pouvez choisir Mise en page > Styles de tables des matières pour créer un style spécial de table des matières
pour l’eBook.

Définissez l’ordre dans lequel les éléments de la page sont exportés.

La position des éléments sur la page détermine l’ordre de lecture.
Si vous sélectionnez D’après la mise en page, InDesign détermine l’ordre de lecture des objets de la page en les balayant de la gauche
vers la droite et de haut en bas. Dans certains cas, et spécialement dans les documents complexes comprenant plusieurs colonnes, les
éléments de conception n’apparaissent pas dans l’ordre de lecture souhaité. Réorganisez et mettez en forme le contenu à l’aide de
Dreamweaver.
(Versions asiatiques uniquement) Si vous sélectionnez D’après la mise en page, InDesign détermine l’ordre de lecture des objets de la
page en fonction de la reliure du document (gauche à droite ou droite à gauche). Dans certains cas, et spécialement dans les documents
complexes comprenant plusieurs colonnes, les éléments de conception exportés sont susceptibles de ne pas apparaître dans l’ordre de
lecture souhaité. Réorganisez et mettez en forme le contenu à l’aide de Dreamweaver.

L’ordre des balises dans la vue Structure détermine l’ordre de lecture. Voir Balisage d’éléments de page.

L’ordre des éléments dans le panneau Articles détermine l’ordre de lecture. Seuls les articles cochés sont
exportés. Voir Inclusion d’articles pour l’exportation.

Zone de texte

Sélectionnez l’une des options suivantes pour définir l’emplacement des notes de bas de page.
Après le paragraphe : pour définir des notes de bas de page après le paragraphe.
Fin de la section (notes finales) : pour convertir les notes de bas de page en notes finales.
Dans une info-bulle (EPUB3) : pour placer une note de bas de page dans une info-bulle.

Si vous ajoutez une note de bas de page à l’aide de l’option de note de bas de page du document et que vous spécifiez une règle (par exemple,
épaisseur de 10 points), cette barre horizontale est prise en charge dans le document EPUB redistribuable à l’exportation.

Retirez tous les retours à la ligne automatiques de l’eBook exporté.

Sélectionnez l'option Faire correspondre à une liste non triée pour convertir les paragraphes à puces en éléments de liste HTML
à l’aide de la balise 

.
Sélectionnez l'option Convertir en texte pour mettre en forme en utilisant la balise
avec des puces de format texte. Si vous avez utilisé les puces automatiques natives d’InDesign, les puces de deuxième
niveau (ou sous-puces) sont également incluses.

Détermine la façon dont les nombres sont convertis dans le fichier HTML. Si vous avez utilisé la numérotation automatique
InDesign native, les puces de deuxième niveau (ou sous-puces) sont également incluses.

Convertissez les listes numérotées en éléments de liste, mis au format HTML à l’aide de la
balise 

.

http://idiom-q-win-1/fr/indesign/using/structuring-pdfs.html#tag_page_items
http://idiom-q-win-1/fr/indesign/urlpointers/help.adobe.com/using/WS8c5bc4f64c7a4a3d78b7a8b312dbccaf5b2-8000.html


Convertir en texte

Conserver l’aspect de la mise en page

Paramètres de conversion > Résolution (ppp)

CSS > Mise en page

CSS > Insérer un saut de page

Format

Options GIF (Palette)

Adaptative (sans simulation)

Web

Système (Windows) ou Système (Mac)

Entrelacement

Options JPEG > Méthode de mise en forme

Progressive

Ligne de base

Options JPEG > Qualité d’image

Convertissez les listes numérotées en paragraphes commençant par le numéro en cours du paragraphe au format
texte.

Section Objet

Dans le menu Conversion d’image, déterminez le mode d'exportation des images au format HTML.

Cochez cette case pour réutiliser les attributs des objets d’image de la mise en page.

Choisissez la résolution des images en pixels par pouce (ppp). Tandis que les systèmes
d’exploitation ont adopté une résolution standard de 72 ppp ou 96 ppp, la résolution des terminaux mobiles varie de 132 ppp (iPad) à 172 ppp
(Sony Reader), voire même plus de 300 ppp (iPhone 4). Vous pouvez choisir une valeur ppp pour chaque objet sélectionné, parmi lesquelles 72,
96, 150 (moyenne pour tous les lecteurs électroniques du moment) et 300.

Spécifiez l’alignement d’image : gauche, centre et droite. Vous pouvez également spécifier le remplissage en haut et en
bas.

Insérez des sauts de page avec les images. Vous pouvez insérer des sauts de page avant l’image, après
l’image ou avant et après l’image.

Paramètres de conversion section

Permet d’indiquer si les images optimisées dans le document sont converties dans le format GIF, JPEG ou PNG. Choisissez Automatique
pour laisser InDesign définir le format à utiliser dans chaque cas. L’option PNG désactive les paramètres de compression d’image ; utilisez PNG
pour les images sans perte de données ou qui contiennent des objets transparents.

Cette option vous permet de contrôler la façon dont InDesign gère les couleurs lors de l’optimisation des fichiers GIF. Le
format GIF utilise une palette de couleurs limitée, qui ne doit pas contenir plus de 256 couleurs.

Créez une palette à l’aide d’un échantillon représentatif de couleurs dans l’illustration sans aucun tramage
(mélange de petits points de couleurs permettant de simuler des couleurs supplémentaires).

Créez une palette de couleurs Web qui sont un sous-ensemble des couleurs système Windows et Mac OS.

Créez une palette à l’aide de la palette de couleurs système intégrée. Cette option peut
entraîner des résultats inattendus.

Chargez progressivement les images en remplissant les lignes manquantes. Lorsque cette option est désélectionnée,
l’image paraît floue, puis elle devient plus nette au fur à et mesure qu’elle approche de sa résolution maximale.

Déterminez la vitesse d’affichage des images JPEG à l’ouverture du fichier contenant l’image dans
un navigateur Web.

Affichez les images JPEG graduellement avec un nombre croissant de détails lors de leur téléchargement.
Les fichiers créés avec cette option sont légèrement plus volumineux et utilisent davantage de RAM à l’affichage.
Choisissez l'option Ligne de base pour afficher chaque fichier JPEG uniquement après son téléchargement. Un espace réservé s’affiche
tant que l’image n’est pas téléchargée.

Affichez chaque fichier JPEG uniquement après son téléchargement.
Un espace réservé s’affiche tant que l’image n’est pas téléchargée.

Sélectionnez la qualité d’image requise pour chaque image JPEG créée à la sortie.
Sélectionnez l'option Faible pour générer le plus petit fichier et la qualité d’image la plus faible.



Paramètres Ignorer l’exportation d’objet

Identifiant

Titre

Créateur

Date

Description

Editeur

Droits

Sujet

Générer des CSS

Conserver les remplacements locaux

Inclure les polices incorporables

Ajouter une feuille de style

JavaScript

Paramètres Ignorer l’exportation d’objet appliqués à chaque images. Voir Options Appliquer le style
d’objet.

Section Métadonnées

Les métadonnées du document (ou le document de source des styles si un livre a été sélectionné) sont incluses dans le fichier exporté. La section
Métadonnées de la boîte de dialogue EPUB - Options d’exportation de la mise en page redistribuable comprend les options suivantes :

(Lecture seule) Chaque document EPUB doit comporter un identifiant unique. Un identifiant unique est créé automatiquement
et s’affiche.

Saisissez le titre du fichier EPUB.

Saisissez le nom de l’auteur du fichier EPUB à mise en page fixe.

Spécifiez la date à laquelle le fichier EPUB a été créé.

Saisissez une description du fichier EPUB.

Entrez les détails concernant l’éditeur, comme son adresse URL.

Saisissez des informations connexes de copyright du fichier EPUB.

Saisissez le sujet du EPUB.

Section CSS

Les feuilles de style CSS (Cascading Style Sheets) regroupent des règles de mise en forme qui définissent l’apparence du contenu dans une
page Web. Lorsque vous utilisez des CSS pour mettre en forme une page, vous séparez le contenu de sa présentation. La section CSS de la
boîte de dialogue EPUB - Options d’exportation de la mise en page redistribuable contient les options suivantes :

Indiquez si vous souhaitez qu’InDesign génère un fichier CSS externe pour le fichier exporté. Si vous voulez exporter
le document/livre vers EPUB sans générer une feuille de style CSS, seules les classes associées aux styles sont marquées dans les
balises HTML. Aucune classe de remplacement n’est créée.

Incluez la mise en forme locale (italique ou gras par exemple).

Incluez toutes les polices qui sont incorporables, dans l’eBook. Les polices contiennent des bits
d’incorporation qui déterminent s’il est possible de les incorporer.

Indiquez l’adresse URL d’une feuille de style CSS existante. InDesign ne vérifie pas si la feuille de style CSS
existe ou est valide. Vous pouvez utiliser Dreamweaver pour confirmer la configuration CSS externe.

JavaScript section

Indiquez l’URL d’un JavaScript existant. InDesign ne vérifie ni l’existence ni la validité du JavaScript. Il est donc recommandé de
confirmer la configuration de votre JavaScript.

http://idiom-q-win-1/fr/indesign/using/frames-objects.html#object_export_options_cc_cs6_cs5_5
http://idiom-q-win-1/fr/indesign/using/frames-objects.html#object_export_options_cc_cs6_cs5_5


Haut de la page

Par défaut

Utiliser une image existante pour les objets graphiques

Pixelliser le conteneur

Pixelliser le contenu

Sans

Par défaut

Fixe

Selon la répartition du texte

Selon la taille du texte

Personnalisation de la largeur et de la hauteur dans un fichier

Remarque :

Remarque :

Haut de la page

Options d'exportation d'objet

Utilisez les options de la boîte de dialogue Options d’exportation d’objet pour indiquer comment les objets d’un document sont traités pendant
l’exportation au format EPUB.

1. Ouvrez la boîte de dialogue Options d’exportation d’objet (Objet > Options d’exportation) et accédez à la section EPUB et
HTML.

2. Choisissez l’une des options suivantes dans la liste Conserver l’aspect de la mise en page :

Le traitement de l’objet est déterminé par les paramètres de la boîte de dialogue d’exportation.
Pour le format redistribuable, le traitement est contrôlé par les paramètres de l’onglet Conversion.

Si l’objet contient une image, et que celle-ci est compatible avec
l’exportation EPUB (formats JPG, PNG et GIF), le conteneur est défini à l’aide d'une feuille de style CSS et l’image n’est pas
traitée.

Cette option équivaut à l’option Conserver l’aspect de la mise en page dans la section
d’exportation/de conversion au format redistribuable. L’objet entier est pixellisé afin de préserver l’aspect.
Si l’objet est un bloc de texte, le texte n’est plus dynamique.

Le contenu de l’objet est pixellisé. Le style de l’objet ou du conteneur est ainsi contrôlé par feuille de
style CSS et peut ne pas s’afficher entièrement tel que dans InDesign.

3. (Format EPUB redistribuable) Sélectionnez les options suivantes dans la liste Taille afin de conserver les proportions d’un objet (une image par
exemple), qui ne comporte pas de contenu fixe interne :

Aucune largeur ou hauteur CSS n’est générée pour la balise mappée à partir de l’objet. La taille de l’objet est
déterminée par le contenu interne, le cas échéant, conformément aux règles CSS, et les proportions ne sont pas conservées.

La taille CSS est déterminée par les paramètres de la boîte de dialogue d'exportation/l'onglet Objet.

La taille CSS est déterminée par le calcul de la dimension de l’objet en points et en définissant ces mêmes dimensions
dans la feuille de styleCSS en tant que pixels. Les proportions de l’objet sont conservées.

La largeur CSS est déterminée en prenant la largeur de l’objet et en l’exprimant en
pourcentage par rapport à la largeur du bloc contenant le texte. Les proportions de l’objet sont conservées.

La hauteur CSS est déterminée en prenant la hauteur de l’objet en points et en la convertissant en
ems à 12 pts par em. Les proportions de l’objet sont conservées.

Les unités CSS valides sont cm, mm, po, pt, %, px, vh,
vW, vmin et vmax. Les proportions de l’objet sont conservées.

ces options ne s’appliquent pas aux blocs de texte principaux.

les objets incluant du contenu Edge Animate ne prennent pas en charge les mesures associées.

Ressources EPUB

Les liens suivants vous permettront d’en savoir plus le format EPUB.
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Pour plus d’informations sur la spécification EPUB, consultez le site www.idpf.org.

Téléchargez une version gratuite de Digital Editions Reader sur le site www.adobe.com/fr/products/digital-editions.html.

Consultez le blog Digital Editions pour plus d’informations sur Digital Editions.

Pour plus d’informations sur l’exportation vers Kindle, consultez le livre blanc sur l’exportation d’InDesign vers Kindle (PDF).

Découvrez comment convertir vos fichiers InDesign au format EPUB et commencez à vendre vos eBooks pour l’iPad d’Apple. Consultez le livre
blanc sur la conversion d’InDesign vers iPad.

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr
http://www.idpf.org/
http://www.adobe.com/fr/products/digital-editions.html
http://blogs.adobe.com/digitaleditions/
http://wwwimages.adobe.com/www.adobe.com/content/dam/Adobe/en/devnet/digitalpublishing/pdfs/indesigntokindle_wp_ue1.pdf
http://wwwimages.adobe.com/www.adobe.com/content/dam/Adobe/en/devnet/indesign/pdfs/indesign-to-ipad.pdf
http://wwwimages.adobe.com/www.adobe.com/content/dam/Adobe/en/devnet/indesign/pdfs/indesign-to-ipad.pdf


Mises en page liquides et variantes de mises en page | CC, CS6

Remarque :

En haut
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Règles de mises en page liquides
Variantes de mises en page

Créer des variantes de mises en page

Les variantes de mises en page et les règles de mises en page liquides permettent de disposer d’une plus grande souplesse pour concevoir vos
publications en fonction des formats de page, orientations ou proportions qui vous intéressent.

Si votre publication est prévue pour différents formats et différentes tailles, vous pouvez choisir la stratégie qui répond le mieux à votre projet :
manuelle, semi-automatique ou entièrement automatisée. Plus le flux de production est automatisé, moins votre marge de contrôle est grande en
terme de conception. InDesign propose plusieurs améliorations, à ce titre, pour que vous puissiez trouver le meilleur compromis entre coût et
contrôle.

la création automatique de publications basées sur une mise en page liquide n’est pas possible pour le moment, en raison de
l’absence de technologie de visualisation compatible. 

Flux de production recommandé

 
A. Flux de production pour les variantes de mise en page B. Variantes de mise en page et règles de mises en page liquides

ETAPE 1 : choisissez un périphérique cible et la dimension et l’orientation correspondantes. Créez ensuite la mise en page principale pour toutes
les pages.

ETAPE 2 : si vous le souhaitez, ajoutez des règles de mises en page liquides pour adapter le contenu en cas de modification des dimensions ou
des proportions. Les règles de mises en page liquides sont particulièrement pratiques si vous ciblez plusieurs périphériques. En l’absence de
telles règles, vous devez créer manuellement une mise en page unique pour chaque taille et orientation possible. Voir la section Mises en page
liquides.

ETAPE 3 : utilisez la fonction Créer une variante de mise en page pour créer de nouvelles pages dans le même document. En fonction de votre
mise en page principale et des règles de mises en page liquides, il peut être nécessaire d’ajuster manuellement la mise en page. Répétez cette
étape pour chaque nouvelle taille et orientation. Voir la section Variantes de mise en page.



En hautMises en page liquides

 
Mises en page liquides

Les mises en page liquides permettent de réorganiser facilement le contenu d’une publication dès que vous changez de format de page,
d’orientation ou de périphérique. Prévoyez des règles de mises en page liquides pour déterminer la façon dont vous souhaitez adapter les objets
d’une page aux variantes de mises en page ou aux nouvelles tailles, orientations ou proportions choisies.

Vous n’êtes pas obligé d’utiliser les mêmes règles pour chacune des pages. Tout dépend de la mise en page et du but visés. Vous ne pouvez
pas, en revanche, appliquer plusieurs règles au sein d’une même page. La mise en page liquide est un terme général qui couvre un ensemble de
règles spécifiques de mise en page liquide : mise à l’échelle, recentrage, règles basées sur le repère et basées sur l’objet.

Utilisez les règles de mises en page liquides pour adapter le contenu aux formats de sortie,

pour adapter les mises en page chaque fois que vous créez de nouvelles pages dans le même document en utilisant des
variantes de mises en page ou
pour adapter les mises en page en cas de modification des formats de page existants. Cette technique est plus efficace que la
fonction de modification de la mise en page précédemment utilisée.

Pour appliquer une règle de mise en page liquide, sélectionnez l’outil Page  et cliquez sur une page. Choisissez ensuite une règle de mise en
page liquide à partir de la barre de contrôle. Vous pouvez également choisir Mise en page > Mises en page liquides.

Pour prévisualiser les effets de la règle appliquée, sélectionnez l’outil Page et redimensionnez la page en faisant glisser ses poignées. La page
reprend sa taille d’origine dès que vous relâchez le pointeur.

Pour redimensionner la page, appuyez sur la touche Alt (Windows) ou Option (Mac OS) et faites glisser le pointeur. Avec la souris, vous
risquez toutefois de ne pas obtenir tout à fait le résultat voulu. Les widgets Hauteur et Largeur de la barre de contrôle permettent de
redimensionner la page avec une plus grande précision.

 
Règles de mises en page liquides 
A. Outil Page B. Règles de mises en page liquides de la barre de contrôle C. Poignées de redimensionnement de la page D. Coins pour les règles
basées sur l’objet E. Panneau Mise en page liquide 

Règles de mises en page liquides
Vous pouvez appliquer des règles différentes à chacune des pages, mais une seule règle de mise en page liquide peut être appliquée par page.

Regardez cette vidéo pour découvrir comment appliquer les règles Aucune, Mise à l’échelle et Recentrer lors du redimensionnement d’une mise



Mise à l’échelle

Recentrer

Basé sur le repère

en page. Apprenez aussi la signification de « Basé sur le gabarit ». Utilisation des règles de mise en page liquide de base : Mise à l’échelle,
Recentrer et Basé sur le gabarit.

Tout le contenu de la page est traité comme un groupe, et en cas de redimensionnement de la page, tous les éléments sont mis
à l’échelle de façon proportionnelle. Le résultat est similaire à celui des bandes noires horizontales et verticales sur les écrans de télévision HD.

 
Règles de mises en page liquides : Mise à l’échelle

Tout le contenu de la page est automatiquement recentré quelle que soit la largeur. Contrairement à la fonction de mise à l’échelle, le
contenu conserve sa taille d’origine. Vous pouvez obtenir un résultat similaire aux zones de sécurité des productions vidéo en combinant la règle
Recentrer à une mise en page soignée et bien planifiée.

 
Règles de mises en page liquides : Recentrer

Les repères définissent une ligne droite sur toute la page à l’endroit où le contenu peut s’adapter.
Il est possible d’ajouter des espaces blancs.
Les blocs de texte sont redimensionnés et le texte est redistribué (mais n’est pas mis à l’échelle).
Les images importées sont redimensionnées et les limites de recadrage des blocs contenant les images sont ajustées en
conséquence.

Pour ajouter un repère de mise en page liquide, sélectionnez l’outil Page, puis faites glisser les repères à l’extérieur de la règle.
Les règles basées sur des repères sont similaires aux mises à l’échelle en 3 tranches et en 9 tranches dans Illustrator, Fireworks et Flash.
Regardez cette vidéo sur Application des règles de mise en page liquide basée sur le repère.

Pour transformer un repère de règle en repère de mise en page liquide, sélectionnez l’outil Page et cliquez sur l’icône Convertir en repère de
mise en page liquide. Le repère de mise en page liquide est matérialisé par une ligne en pointillés alors que le repère de la règle se présente
sous la forme d’une ligne continue.

http://tv.adobe.com/watch/learn-indesign-cs6/using-basic-liquid-layout-rules-scale-recenter-and-based-on-master/
http://tv.adobe.com/watch/learn-indesign-cs6/using-basic-liquid-layout-rules-scale-recenter-and-based-on-master/
http://tv.adobe.com/watch/learn-indesign-cs6/applying-guide-based-liquid-layout-rules/


Basé sur l’objet

En haut

 
Règles de mises en page liquides : basé sur le repère

Vous pouvez définir le comportement de la mise en page liquide pour la taille et l’emplacement par rapport au bord de la page
pour chaque objet (en mode absolu ou relatif).

Chaque côté du cadre de délimitation de l’objet ou du bloc peut être fixe ou relatif au bord correspondant de la page. Par
exemple, le côté gauche du cadre ou du bloc peut être solidaire uniquement avec le bord gauche de la page.
La hauteur et la largeur peuvent être fixes ou redimensionnables par rapport à la page. 

Regardez cette vidéo sur Application des règles de mise en page liquide basée sur l’objet.

 
Règles de mises en page liquides : Basé sur l’objet

Variantes de mise en page
Utilisez les variantes de mise en page si vous souhaitez prévoir plusieurs formats de page pour l’impression ou la publication numérique d’un
même document. Cela est très pratique pour créer différentes tailles d’une même affiche ou pour concevoir les mises en page horizontale et
verticale destinées aux périphériques mobiles (iPad d’Apple ou tablettes Android, par exemple). 

 
Variantes de mise en page et panneau Pages

Lorsque vous les utilisez en association avec les mises en page liquides, vous pouvez réduire considérablement la quantité de travail manuel
nécessaire à la redisposition du contenu pour chaque nouveau format ou orientation de page.

Pour avoir un aperçu, regardez la vidéo sur les variantes de mises en page par Lynda.com.

Créer des variantes de mises en page

http://tv.adobe.com/watch/learn-indesign-cs6/applying-object-based-liquid-layout-rules/
http://www.adobe.com/go/CHLvid60107_id_fr
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Nom

Depuis les pages sources

Format de page

Largeur et Hauteur

Orientation

Règle de page liquide

Lier les articles

Copier les styles de texte dans le nouveau groupe de styles

Redistribution intelligente du texte

Pour créer une variante de mise en page, utilisez l’une des méthodes suivantes :

Choisissez Mise en page > Créer une variante de mise en page.
Choisissez Créer une variante de mise en page dans le menu du panneau Pages.

 
Créer des variantes de mises en page

Dans la boîte de dialogue Créer des variantes de mises en page, spécifiez les options suivantes :

Entrez le nom de la variante de mise en page.

Sélectionnez la mise en page source où se trouve votre contenu.

Sélectionnez une taille de page ou saisissez une taille personnalisée pour la variante de mise en page.

Ces champs indiquent la taille de la variante de mise en page. Vous pouvez entrer vos propres valeurs, mais dans ce cas, le
format de page prend la valeur Personnalisé.

Choisissez une orientation pour la variante de mise en page. Si vous basculez entre Portrait et Paysage, la hauteur et la largeur sont
mises à jour en conséquence.

Choisissez la règle de mise en page liquide que vous avez l’intention d’appliquer à la variante de mise en page.
Sélectionnez l’option Conserver les éléments existants afin d’hériter les règles de mises en page liquides appliquées aux pages sources.
Sélectionnez une autre règle si vous comptez appliquer de nouvelles règles de mises en page liquides.

Activez cette option pour importer les objets et les lier aux objets originaux de la mise en page source. Lorsque vous mettez à
jour l’objet d’origine, il est plus facile de gérer les mises à jour des objets liés. Voir la page Contenu lié.

Activez cette option pour copier tous les styles de texte et les importer dans un
nouveau groupe. Cette option est utile si vous avez besoin de faire varier les styles de texte d’une mise en page à une autre.

Activez cette option pour supprimer les sauts de ligne forcés et tout autre remplacement de style au texte.  

http://creativecommons.org/licenses/by-nc-sa/3.0/deed.fr
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr


Présentation de Digital Publishing Suite
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Haut de la page

Overlay Creator

Folio Builder

Présentation de Digital Publishing Suite

Présentation de Digital Publishing Suite

Adobe Digital Publishing Suite est un ensemble d’outils et de services hébergés permettant aux éditeurs de créer et de distribuer des compositions
sur des tablettes électroniques telles que l’iPad d’Apple. Ces compositions numériques portent le nom de folios.

Grâce à InDesign, vous pouvez créer des folios et les visualiser sous forme d’aperçus sur une tablette et sur un générateur d’aperçu de bureau.
Cependant, un abonnement à Digital Publishing Suite est nécessaire pour créer un logiciel de visualisation personnalisé. Les éditeurs peuvent
distribuer leurs compositions numériques en les soumettant sur l’Apple Store ou l’Android Market. Vous pouvez également mettre des folios à la
disposition d’un éditeur possédant un abonnement à Digital Publishing Suite.

Les modules d’extension Folio Builder et Overlay Creator vous permettent de créer des compositions numériques destinées aux tablettes
électroniques.

Pour accéder à ces modules d’extension :

Choisissez Fenêtre > Extensions > Overlay Creator.

Choisissez Fenêtre > Extensions > Folio Builder.

Pour plus d’informations sur la création de compositions numériques pour tablettes électroniques, voir www.adobe.com/go/learn_dps_help_fr.

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr
http://www.adobe.com/go/learn_dps_help_fr
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Haut de la page

Ressources EPUB
Options d’exportation générales EPUB
Options d’image EPUB
Options de contenu EPUB

Vous pouvez exporter un document ou un livre sous forme d’eBook EPUB au contenu redistribuable, compatible avec le logiciel
Adobe Digital Editions et d’autres lecteurs d’eBooks.

1. Utilisez l’une des méthodes suivantes :

Ouvrez le document, puis choisissez Fichier > Exporter.

Ouvrez un livre, puis choisissez Exporter le livre au format EPUB dans le menu du panneau Livre.

2. Spécifiez le nom et le dossier du fichier.

3. Dans la liste Type, choisissez EPUB, puis cliquez sur le bouton Enregistrer.

4. Dans la boîte de dialogue Options d’exportation EPUB, spécifiez les options désirées dans les zones Général, Image
et Contenu.

InDesign crée un seul fichier .epub incluant le contenu XHTML. Si cela est spécifié, le fichier exporté peut inclure une image de couverture. Si
cela est spécifié, le fichier exporté peut inclure une image de couverture provenant d’un fichier image ou créée à partir de la pixellisation de la
première page du document spécifié (ou du document source des styles si un livre a été sélectionné). Cette miniature est utilisée pour décrire le
livre dans les lecteurs ePUB ou dans la bibliothèque du logiciel Digital Editions Reader. L’affichage du fichier nécessite un lecteur ePUB. Mais
vous pouvez également utiliser le logiciel Adobe Digital Editions, disponible gratuitement sur le site Web d’Adobe.

En fait, le fichier .epub s’apparente à un fichier .zip. Pour visualiser et modifier le contenu du fichier .epub, remplacez son extension .epub par
l’extension .zip, puis extrayez-en le contenu. Ceci est particulièrement utile pour modifier le fichier CSS.

les objets InDesign, tels que les blocs de texte et les objets contenant des images importées, sont systématiquement exportés
lorsque vous sélectionnez l’option d’ordre D’après la mise en page. Les objets InDesign vides sont exportés uniquement si vous leur avez appliqué
un paramètre d’exportation au format JPEG, GIF ou PNG, parmi les options d’exportation d’objet.

Ressources EPUB

Les liens suivants vous permettront d’en savoir plus le format EPUB.

Pour plus d’informations sur le format EPUB, rendez-vous à l’adresse www.idpf.org.

Téléchargez une version gratuite de Digital Editions Reader sur le site www.adobe.com/fr/products/digitaleditions.

Consultez le blog Digital Editions pour plus d’informations sur Digital Editions.

Pour plus d’informations sur l’exportation vers Kindle, consultez le document InDesign to Kindle white paper (PDF).

Découvrez comment convertir vos fichiers InDesign au format EPUB et commencez à vendre vos eBooks pour l’iPad d’Apple.
Consultez le livre blanc InDesign to iPad white paper.

Options d’exportation générales EPUB

La section Général de la boîte de dialogue Options d’exportation EPUB contient les options suivantes.

http://www.idpf.org/
http://www.adobe.com/fr/products/digitaleditions
http://blogs.adobe.com/digitaleditions/
http://www.adobe.com/content/dam/Adobe/en/devnet/digitalpublishing/pdfs/indesigntokindle_wp_ue1.
http://wwwimages.adobe.com/www.adobe.com/content/dam/Adobe/en/devnet/indesign/pdfs/indesign-to-ipad.pdf


Inclure les métadonnées du document

Ajouter une entrée pour l’éditeur

Identifiant unique

Couverture de l’eBook

Pas d’image de couverture

Pixelliser la première page

Utiliser le fichier d’image existant

Ordre

Marge du livre

Puces

Nombres

Faire correspondre à une liste triée

Faire correspondre à une liste triée statique

Convertir en texte

Les métadonnées du document (ou le document de source des styles si un livre a été sélectionné) sont
incluses dans le fichier exporté.

Spécifiez les détails concernant l’éditeur qui doivent figurer dans les métadonnées eBook. Vous pouvez
indiquer l’URL du site Web de l’éditeur afin que le destinataire de l’eBook puisse s’y référer.

Chaque document EPUB doit comporter un identifiant unique. Vous avez la possibilité de définir cet attribut. Si vous ne
renseignez pas le champ correspondant, un identifiant unique est créé automatiquement.

Il s’agit de l’image de couverture de l’eBook. Choisissez l’une des options suivantes :

Si cette option est sélectionnée, aucune image de couverture n’est ajoutée à l’eBook.

Si cette option est sélectionnée, la première page de l’eBook est pixellisée et sert à créer un fichier image
qui fera office de couverture.

Si cette option est sélectionnée, vous pouvez spécifier une image se trouvant sur votre ordinateur
comme couverture.

Vous pouvez définir l’ordre d’exportation des éléments de page.
D’après la mise en page
La position des éléments sur la page détermine l’ordre de lecture.
Si vous choisissez l’option D’après la mise en page, InDesign détermine l’ordre de lecture des objets de page en analysant celle-ci de gauche à
droite et de haut en bas. Dans certains cas, et spécialement dans les documents complexes comprenant plusieurs colonnes, les éléments de
conception sont susceptibles de ne pas apparaître dans l’ordre de lecture souhaité. Réorganisez et mettez en forme le contenu à l’aide de
Dreamweaver.
(versions asiatiques seulement) Si vous choisissez l’option D’après la mise en page, InDesign détermine l’ordre de lecture des objets de page en
fonction de la liaison du document (de gauche à droite ou de droite à gauche). Dans certains cas, et spécialement dans les documents complexes
comprenant plusieurs colonnes, les éléments de conception exportés sont susceptibles de ne pas apparaître dans l’ordre de lecture souhaité.
Réorganisez et mettez en forme le contenu à l’aide de Dreamweaver.
Identique à la structure XML
L’ordre des balises dans la vue Structure détermine l’ordre de lecture. Voir Balisage d’éléments de page.
Identique au panneau Articles
L’ordre des éléments dans le panneau Articles détermine l’ordre de lecture. Seuls les articles cochés sont exportés. Voir Inclusion d’articles pour
l’exportation.

Définissez une marge simple en ems ou en pixels. Les marges exprimées en ems sont particulièrement indiquées pour la
compatibilité multiécran. La même valeur est appliquée à toutes les marges : supérieure, inférieure, gauche et droite.

Sélectionnez Faire correspondre à une liste non triée pour convertir les paragraphes à puces en éléments de liste, qui sont mis en forme
en HTML à l’aide de la balise <ul>. Sélectionnez Convertir en texte pour mettre en forme à l’aide de la balise <p>, avec les puces au format texte.
Si vous avez utilisé les puces automatiques InDesign natives, les puces de deuxième niveau (ou sous-puces) sont également incluses.

Détermine la façon dont les nombres sont convertis dans le fichier HTML. Si vous avez utilisé la numérotation automatique InDesign
native, les puces de deuxième niveau (ou sous-puces) sont également incluses.

Convertit les listes numérotées en éléments de liste, mis au format HTML à l’aide de la balise <ol>.

Convertit les listes numérotées en éléments de liste et affecte un attribut <value> basé sur
le numéro en cours du paragraphe dans InDesign.

Convertit les listes numérotées en paragraphes commençant par le numéro en cours du paragraphe au format texte.

http://help.adobe.com/fr_FR/indesign/cs/using/WSa285fff53dea4f8617383751001ea8cb3f-70aba.html
http://idiom-q-win-1/indesign/urlpointers/help.adobe.com/using/WS8c5bc4f64c7a4a3d78b7a8b312dbccaf5b2-8000.html
http://idiom-q-win-1/indesign/urlpointers/help.adobe.com/using/WS8c5bc4f64c7a4a3d78b7a8b312dbccaf5b2-8000.html


Afficher le fichier EPUB après l’exportation

Haut de la page

Conserver l’aspect de la mise en page

Résolution (ppp)

Taille de l’image

Alignement et espacement des images

Insérer un saut de page

Les paramètres s’appliquent aux objets ancrés

Conversion d’image

Options GIF (Palette)

Options JPEG (Qualité d’image)

Options JPEG (Méthode de mise en forme)

Ignorer les paramètres de conversion d’objet

Haut de la page

Lance le logiciel Adobe Digital Editions Reader s’il est installé.

Options d’image EPUB

La section Images de la boîte de dialogue Options d’exportation Digital Editions comprend les options suivantes : Dans le menu Conversion
d’image, déterminez comment les images sont exportées en HTML.

Cochez cette case pour réutiliser les attributs des objets d’image de la mise en page.

Spécifiez la résolution des images en pixels par pouce (ppp). Tandis que les systèmes d’exploitation ont adopté une résolution
standard de 72 ppp ou 96 ppp, la résolution des terminaux mobiles varie de 132 ppp (iPad) à 172 ppp (Sony Reader), voire même plus de
300 ppp (iPhone 4). Vous pouvez spécifier une valeur exprimée en ppp pour chaque objet sélectionné, parmi lesquelles 72, 96, 150 (moyenne
pour tous les lecteurs électroniques du moment) et 300.

Indiquez si l’image doit conserver une taille fixe ou être redimensionnée par rapport à la page. Si vous optez pour une taille
adaptée au format de page, une valeur relative exprimée en pourcentage est définie en fonction de la taille de l’image par rapport à la largeur de
page InDesign. Les images sont ainsi redimensionnées proportionnellement, par rapport à la largeur de la surface de lecture.

Spécifiez l’alignement, à gauche, au centre ou à droite, et le remplissage, en haut et en bas, de l’image.

Cochez cette case pour insérer des sauts de page avec les images. Vous pouvez insérer des sauts de page avant
et/ou après l’image.

Cochez cette case pour appliquer ces paramètres à tous les objets ancrés.

Choisissez GIF, JPEG ou PNG pour la conversion des images optimisées dans votre document. Choisissez Automatique
pour laisser InDesign décider quel format utiliser dans chaque instance. L’option PNG désactive les paramètres de compression de l’image. ;
utilisez PNG pour les images sans perte de données ou qui contiennent des objets transparents.

Cette option vous permet de contrôler la façon dont InDesign gère les couleurs lors de l’optimisation des fichiers GIF. Le
format GIF utilise une palette de couleurs limitée, qui ne doit pas contenir plus de 256 couleurs.
Choisissez Adaptative pour créer une palette utilisant un échantillon représentatif de couleurs dans l’illustration sans aucun tramage (mélange de
quelques tons de couleurs pour simuler des couleurs supplémentaires). Choisissez l’option Web pour créer une palette de couleurs Web (ces
couleurs sont un sous-ensemble des couleurs système Windows et Mac OS). Choisissez Système (Win) ou Système (Mac) pour créer une palette
utilisant la palette de couleurs intégrée de Windows ou de Mac OS. Ce choix peut donner des résultats inattendus.
Sélectionnez Entrelacement pour charger progressivement les images par remplissage des lignes manquantes. Lorsque cette option est
désélectionnée, l’image paraît floue, puis elle devient plus nette au fur à et mesure qu’elle approche de sa résolution maximale.

Permet de choisir entre une compression (et une taille de fichier réduite) et une haute qualité d’image pour
chaque image JPEG. L’option Faible génère le plus petit fichier et la qualité d’image la plus faible.

Permet de déterminer la vitesse d’affichage des images JPEG à l’ouverture du fichier contenant
l’image sur le Web. Choisissez Progressive pour que les images JPEG s’affichent graduellement avec de plus en plus de détails à mesure qu’elles
sont téléchargées. Les fichiers créés avec cette option sont légèrement plus volumineux et utilisent davantage de RAM à l’affichage. Choisissez
Ligne de base pour que le fichier JPEG s’affiche une fois téléchargé seulement ; une marque de réservation apparaît à la place de l’image avant
son affichage.

Cette option permet de passer outre les options d’exportation d’objet appliquées individuellement
aux images. Voir Application d’options d’exportation d’objet.

Options de contenu EPUB
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Formatpour le contenu EPUB

Utiliser le style de table des matières d’InDesign

Diviser le document en fonction du style de paragraphe

Importer une note de bas de page après le paragraphe

Supprimer les sauts de ligne forcés

Générer des CSS

Inclure les définitions de style

Conserver les remplacements locaux

Inclure les polices incorporables

Noms de style uniquement

Utiliser le fichier CSS existant

La section Contenu de la boîte de dialogue Options EPUB contient les options suivantes.

Précisez si vous voulez utiliser le format XHTML ou DTBook. Le format spécialisé DTBook est destiné aux
lecteurs finaux présentant une déficience visuelle.

Sélectionnez cette option si vous souhaitez générer une table des matières en réutilisant le
style sélectionné. Dans le menu Style de table des matières, choisissez le style à utiliser pour générer la table des matières de l’eBook. Vous
pouvez également choisir la commande Page > Styles de tables des matières pour créer un style spécial pour l’eBook.

Vous pouvez scinder l’eBook selon le style de paragraphe spécifié. Ce fractionnement
a pour effet d’accroître le nombre de fichiers HTML dans l’assemblage d’EPUB. Il peut toutefois s’avérer utile, notamment pour scinder des fichiers
longs et améliorer les performances des lecteurs EPUB.

Cochez cette case pour positionner les notes de bas de page à la suite du
paragraphe. Si cette case reste désélectionnée, les notes de bas de page sont converties en notes de fin de page.

Cochez cette case pour retirer tous les retours à la ligne automatiques de l’eBook exporté.

Les feuilles de style CSS (Cascading Style Sheets) regroupent des règles de mise en forme qui définissent l’apparence du
contenu dans une page Web. Lorsque vous utilisez des CSS pour mettre en forme une page, vous séparez le contenu de sa présentation.

Lors de l’exportation au format EPUB, vous pouvez créer une liste de styles CSS modifiables.

Lorsque cette option est sélectionnée, la mise en forme locale (style italique ou gras, par
exemple) est incluse.

Cette option permet d’inclure toutes les polices qui sont incorporables, dans l’eBook. Les polices
contiennent des bits d’incorporation qui déterminent s’il est possible ou non de les incorporer.

Cette option permet d’inclure uniquement les noms de style non définis dans la feuille de style EPUB.

Spécifiez l’URL de la feuille de style CSS existante, qui est généralement une URL relative, telle que
« /styles/style.css ». InDesign ne vérifie ni l’existence ni la validité de la feuille de style CSS. Il est donc recommandé de confirmer la définition de
la feuille de style CSS.

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr
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Haut de la page

Haut de la page

Remarque :

Présentation
Exporter au format EPUB
Options d’exportation EPUB

Options générales EPUB
Options d’image EPUB
Options avancées EPUB

Ressources EPUB

Présentation

Avant de pouvoir exporter votre mise en page au format EPUB, vous pouvez effectuer des réglage pour vous assurer qu’elle s’exporte
correctement.

Ajouter des graphiques ancrés - ancrage des graphiques dans enchaînements de texte, afin que vous puissiez contrôler leur
position par rapport au texte exporté. Voir Objets ancrés.
Options d’exportation d’objet - Spécifiez des options d’exportation pour les objets placés. Voir Options d’exportation d’objet.
Mise en correspondance des styles et des balises d’exportation - Faire correspondre les styles de caractère et de
paragraphe aux classes et balises HTML. Voir Mise en correspondance des styles et des balises d’exportation.
Choisir le contenu et l’ordre - Utilisez le panneau Articles pour choisir le contenu à exporter et l’ordre dans lequel il doit
apparaître. Voir Articles. Vous pouvez également commander le contenu basé sur une mise en page ou une structure XML.

Exporter au format EPUB

Vous pouvez exporter un document ou un livre sous forme d’eBook EPUB au contenu redistribuable, compatible avec le logiciel
Adobe Digital Editions et d’autres lecteurs d’eBooks.

1. Utilisez l’une des méthodes suivantes :

Ouvrez le document, puis choisissez Fichier > Exporter.

Ouvrez un livre, puis choisissez Exporter le livre au format EPUB dans le menu du panneau Livre.

2. Spécifiez le nom et le dossier du fichier.

3. Dans la liste Type, choisissez EPUB, puis cliquez sur le bouton Enregistrer.

4. Dans la boîte de dialogue Options d’exportation EPUB, spécifiez les options désirées dans les zones Général, Image
et Avancé.

InDesign crée un seul fichier .epub incluant le contenu XHTML. Si cela est spécifié, le fichier exporté peut inclure une image de couverture. Si
cela est spécifié, le fichier exporté peut inclure une image de couverture provenant d’un fichier image ou créée à partir de la pixellisation de la
première page du document spécifié (ou du document source des styles si un livre a été sélectionné). Cette miniature est utilisée pour décrire le
livre dans les lecteurs ePUB ou dans la bibliothèque du logiciel Digital Editions Reader. L’affichage du fichier nécessite un lecteur ePUB. Mais
vous pouvez également utiliser le logiciel Adobe Digital Editions, disponible gratuitement sur le site Web d’Adobe.

En fait, le fichier .epub s’apparente à un fichier .zip. Pour afficher et modifier le contenu d’un fichier EPUB file, remplacez l’extension .epub par
.zip, puis extrayez le contenu. Ceci est particulièrement utile pour modifier le fichier CSS.

les objets InDesign, tels que les blocs de texte et les objets contenant des images importées, sont systématiquement exportés
lorsque vous sélectionnez l’option d’ordre D’après la mise en page. Les objets vides ne sont pas exportés, sauf si vous appliquez à l’objet
InDesign un paramètre via les options d’exportation d’objet pour l’exporter dans le format JPEG, GIF ou PNG.

http://help.adobe.com/fr_FR/indesign/cs/using/WSa285fff53dea4f8617383751001ea8cb3f-6c43a.html
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Version

EPUB 2.0.1

EPUB 3.0

EPUB 3.0 avec mise en page

Couverture

Sans

Pixelliser la première page

Sélectionner une image

Style de table des matières

Marges

Ordre du contenu

D’après la mise en page

Identique à la structure XML

Options d’exportation EPUB

Options générales EPUB

La section Général de la boîte de dialogue Options d’exportation EPUB comprend les options suivantes :

Spécifiez une version pour EPUB.

EPUB 2.0.1 est une norme qui a été approuvée par l’IDPF (International Digital Publishing Forum) en 2007. Ce format est
pris en charge sur de nombreux périphériques.

EPUB 3.0 est une norme qui a été approuvée par l’IDPF (International Digital Publishing Forum) en 2011. Ce format prend
également en charge l’audio, la vidéo, le javascript, le texte vertical en japonais. Les nouvelles fonctions toutefois ne fonctionneront pas
sur les lecteurs et les périphériques qui ne prennent pas en charge EPUB 3.0 standard.

Il s’agit d’un format expérimental créé par Adobe Systems. Il prend en charge plusieurs colonnes,
l’habillage de texte et d’autres contrôles pour que vos mises en page s’adaptent à toutes les mises en page. Cette fonction ne fonctionne
qu’avec les technologies spécifiques de la visionneuse.

Il s’agit de l’image de couverture de l’eBook. Choisissez l’une des options suivantes :

Si cette option est sélectionnée, aucune image de couverture n’est ajoutée à l’eBook.

Si cette option est sélectionnée, la première page de l’eBook est pixellisée et sert à créer un fichier image
qui fera office de couverture.

Si cette option est sélectionnée, vous pouvez spécifier une image se trouvant sur votre ordinateur comme
couverture.

Sélectionnez cette option si vous souhaitez générer une table des matières en réutilisant le style sélectionné. Dans
le menu Style de table des matières, choisissez le style à utiliser pour générer la table des matières de l’eBook. Vous pouvez également choisir la
commande Page > Styles de tables des matières pour créer un style spécial pour l’eBook.

Définissez les marges supérieure, inférieure, de gauche et de droite en pixels. Pour utiliser la même valeur pour chaque marge, cliquez
sur l’icône Conserver. 

Définissez l’ordre dans lequel les éléments de la page sont exportés.

La position des éléments sur la page détermine l’ordre de lecture.
Si vous choisissez l’option D’après la mise en page, InDesign détermine l’ordre de lecture des objets de page en analysant celle-ci de
gauche à droite et de haut en bas. Dans certains cas, et spécialement dans les documents complexes comprenant plusieurs colonnes, les
éléments de conception sont susceptibles de ne pas apparaître dans l’ordre de lecture souhaité. Réorganisez et mettez en forme le
contenu à l’aide de Dreamweaver.
(Versions asiatiques uniquement) Si vous sélectionnez D’après la mise en page, InDesign détermine l’ordre de lecture des objets de la
page en fonction de la reliure du document (gauche à droite ou droite à gauche). Dans certains cas, et spécialement dans les documents
complexes comprenant plusieurs colonnes, les éléments de conception exportés sont susceptibles de ne pas apparaître dans l’ordre de
lecture souhaité. Réorganisez et mettez en forme le contenu à l’aide de Dreamweaver.

L’ordre des balises dans la vue Structure détermine l’ordre de lecture. Voir Balisage d’éléments de page.
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Identique au panneau Articles

Importer une note de bas de page après le paragraphe

Supprimer les sauts de ligne forcés

Puces

Nombres

Faire correspondre à une liste triée

Faire correspondre à une liste triée statique

Convertir en texte

Afficher le fichier EPUB après l’exportation

Conserver l’aspect de la mise en page

Résolution (ppp)

Taille de l’image

Alignement et espacement des images

Insérer un saut de page

Les paramètres s’appliquent aux objets ancrés

Conversion d’image

Options GIF (Palette)

L’ordre des éléments dans le panneau Articles détermine l’ordre de lecture. Seuls les articles cochés sont
exportés. Voir Inclusion d’articles pour l’exportation.

Cochez cette case pour positionner les notes de bas de page à la suite du
paragraphe. Si cette case reste désélectionnée, les notes de bas de page sont converties en notes de fin de page.

Cochez cette case pour retirer tous les retours à la ligne automatiques de l’eBook exporté.

Sélectionnez Faire correspondre à une liste non triée pour convertir les paragraphes à puces en éléments de liste, qui sont mis en forme
en HTML à l’aide de la balise <ul>. Sélectionnez Convertir en texte pour mettre en forme à l’aide de la balise <p>, avec les puces au format texte.
Si vous avez utilisé les puces automatiques InDesign natives, les puces de deuxième niveau (ou sous-puces) sont également incluses.

Détermine la façon dont les nombres sont convertis dans le fichier HTML. Si vous avez utilisé la numérotation automatique InDesign
native, les puces de deuxième niveau (ou sous-puces) sont également incluses.

Convertit les listes numérotées en éléments de liste, mis au format HTML à l’aide de la balise <ol>.

Convertit les listes numérotées en éléments de liste et affecte un attribut <value> basé sur
le numéro en cours du paragraphe dans InDesign.

Convertit les listes numérotées en paragraphes commençant par le numéro en cours du paragraphe au format texte.

Ouvre le fichier EPUB dans l’application par défaut sélectionnée pour lire ce format, si elle est
présente.

Options d’image EPUB

La section Images de la boîte de dialogue des options d’exportation EPUB contient les options suivantes. Dans le menu Conversion d’image,
déterminez comment les images sont exportées en HTML.

Cochez cette case pour réutiliser les attributs des objets d’image de la mise en page.

Choisissez la résolution des images en pixels par pouce (ppp). Tandis que les systèmes d’exploitation ont adopté une
résolution standard de 72 ppp ou 96 ppp, la résolution des terminaux mobiles varie de 132 ppp (iPad) à 172 ppp (Sony Reader), voire même plus
de 300 ppp (iPhone 4). Vous pouvez choisir une valeur ppp pour chaque objet sélectionné, parmi lesquelles 72, 96, 150 (moyenne pour tous les
lecteurs électroniques du moment) et 300.

Indiquez si l’image doit conserver une taille fixe ou être redimensionnée par rapport à la page. Si vous optez pour une taille
adaptée au format de page, une valeur relative exprimée en pourcentage est définie en fonction de la taille de l’image par rapport à la largeur de
page InDesign. Les images sont ainsi redimensionnées proportionnellement, par rapport à la largeur de la surface de lecture.

Spécifiez l’alignement de l’image à gauche, au centre et à droite, ainsi que l’espace avant et après.

Cochez cette case pour insérer des sauts de page avec les images. Vous pouvez insérer des sauts de page avant
et/ou après l’image.

Cochez cette case pour appliquer ces paramètres à tous les objets ancrés.

Choisissez GIF, JPEG ou PNG pour la conversion des images optimisées dans votre document. Choisissez Automatique
pour laisser InDesign décider quel format utiliser dans chaque instance. L’option PNG désactive les paramètres de compression d’image ; utilisez
PNG pour les images sans perte de données ou qui contiennent des objets transparents.

Cette option vous permet de contrôler la façon dont InDesign gère les couleurs lors de l’optimisation des fichiers GIF. Le
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Options JPEG (Qualité d’image)

Options JPEG (Méthode de mise en forme)

Ignorer les paramètres de conversion d’objet

Fractionner le document

Inclure les métadonnées du document

Editeur

ID unique

Options CSS

Inclure les définitions de style

Conserver les remplacements locaux

Inclure les polices incorporables

Ajouter une feuille de style

Ajouter un script

format GIF utilise une palette de couleurs limitée, qui ne doit pas contenir plus de 256 couleurs.
Choisissez Adaptative pour créer une palette utilisant un échantillon représentatif de couleurs dans l’illustration sans aucun tramage (mélange de
quelques tons de couleurs pour simuler des couleurs supplémentaires). Choisissez l’option Web pour créer une palette de couleurs Web (ces
couleurs sont un sous-ensemble des couleurs système Windows et Mac OS). Choisissez Système (Win) ou Système (Mac) pour créer une palette
utilisant la palette de couleurs intégrée de Windows ou de Mac OS. Ce choix peut donner des résultats inattendus.
Sélectionnez Entrelacement pour charger progressivement les images par remplissage des lignes manquantes. Lorsque cette option est
désélectionnée, l’image paraît floue, puis elle devient plus nette au fur à et mesure qu’elle approche de sa résolution maximale.

Permet de choisir entre une compression (et une taille de fichier réduite) et une haute qualité d’image pour
chaque image JPEG. L’option Faible génère le plus petit fichier et la qualité d’image la plus faible.

Permet de déterminer la vitesse d’affichage des images JPEG à l’ouverture du fichier contenant
l’image sur le Web. Choisissez Progressive pour que les images JPEG s’affichent graduellement avec de plus en plus de détails à mesure qu’elles
sont téléchargées. Les fichiers créés avec cette option sont légèrement plus volumineux et utilisent davantage de RAM à l’affichage. Choisissez
Ligne de base pour que le fichier JPEG s’affiche uniquement après qu’il a été téléchargé ; une marque de réservation apparaît à la place de
l’image avant son affichage.

Cette option permet de passer outre les options d’exportation d’objet appliquées individuellement
aux images. Voir Application d’options d’exportation d’objet.

Options avancées EPUB

La section Contenu de la boîte de dialogue Options d’exportation EPUB comprend les options suivantes :

Vous pouvez scinder l’eBook selon le style de paragraphe spécifié. Ce fractionnement a pour effet d’accroître le
nombre de fichiers HTML dans l’assemblage d’EPUB. Il peut toutefois s’avérer utile, notamment pour scinder des fichiers longs et améliorer les
performances des lecteurs EPUB.

Les métadonnées du document (ou le document de source des styles si un livre a été sélectionné) sont
incluses dans le fichier exporté.

Spécifiez les détails concernant l’éditeur qui doivent figurer dans les métadonnées eBook. Vous pouvez indiquer l’URL du
site Web de l’éditeur afin que le destinataire de l’eBook puisse s’y référer.

Chaque document EPUB doit comporter un identifiant unique. Un identifiant unique est créé automatiquement et s’affiche.
Vous pouvez le supprimer et spécifier un identificateur unique.

Les feuilles de style CSS (Cascading Style Sheets) regroupent des règles de mise en forme qui définissent l’apparence du contenu
dans une page Web. Lorsque vous utilisez des CSS pour mettre en forme une page, vous séparez le contenu de sa présentation.

Lors de l’exportation au format EPUB, vous pouvez créer une liste de styles CSS modifiables.

Lorsque cette option est sélectionnée, la mise en forme locale (style italique ou gras, par
exemple) est incluse.

Cette option permet d’inclure toutes les polices qui sont incorporables, dans l’eBook. Les polices
contiennent des bits d’incorporation qui déterminent s’il est possible de les incorporer.

Spécifiez l’URL de la feuille de style CSS existante, qui est généralement une URL relative, telle que
« /styles/style.css ». InDesign ne vérifie ni l’existence ni la validité de la feuille de style CSS. Il est donc recommandé de confirmer la
définition de la feuille de style CSS.

Indiquez l’URL d’un JavaScript existant. InDesign ne vérifie ni l’existence ni la validité du JavaScript. Il est donc recommandé
de confirmer la configuration de votre JavaScript.
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Ressources EPUB

Les liens suivants vous permettront d’en savoir plus le format EPUB.

Pour plus d’informations sur la spécification EPUB, consultez le site www.idpf.org.

Téléchargez une version gratuite de Digital Editions Reader sur le site www.adobe.com/fr/products/digitaleditions.

Consultez le blog Digital Editions pour plus d’informations sur Digital Editions.

Pour plus d’informations sur l’exportation vers Kindle, consultez le livre blanc sur l’exportation d’InDesign vers Kindle (PDF).

Découvrez comment convertir vos fichiers InDesign au format EPUB et commencez à vendre vos eBooks pour l’iPad d’Apple.
Consultez le livre blanc sur la conversion d’InDesign vers iPad.
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A propos de la fusion des données
Procédure de fusion des données
A propos des fichiers de source de données
Ajout de champs d’image au fichier de source de données
A propos des documents cibles
Sélection d’une source de données
Insertion de champs de données
Ajout de balises d'emplacement de champs de données aux gabarits
Mise à jour, suppression et remplacement de fichiers de source de données
Affichage d’un aperçu des enregistrements dans le document cible
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A propos de la fusion des données

Vous pouvez fusionner un fichier de source de données avec un document cible pour créer des lettres types, des enveloppes ou des étiquettes
d’adresses. La fusion de données est également appelée publipostage.

Le fichier de source de données contient des informations qui varient à chaque réédition du document cible, par exemple les noms et adresses
des destinataires d’une lettre type. Un fichier de source de données se compose de champs et d’enregistrements. Les champs sont des groupes
d’informations spécifiques, comme des noms de sociétés ou des codes postaux, tandis que les enregistrements sont des lignes d’informations,
comme le nom, l’adresse, la ville et le code postal. Un fichier de source de données peut être un fichier délimité par des virgules (.csv) ou par des
tabulations (.txt) dans lequel chaque donnée est séparée respectivement par une virgule ou par une tabulation.

Le document cible est un document InDesign contenant les balises d’emplacement des champs de données et tout le matériel, le texte et d’autres
éléments types utilisés fréquemment, qui restent les mêmes dans chaque nouvelle édition du document fusionné.

Le document fusionné est le document InDesign obtenu contenant les informations types du document cible, répétées autant de fois que
nécessaire pour contenir chaque entrée issue de la source de données.

Fusion des données

A. Fichier de source de données B. Document cible C. Document fusionné 
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Procédure de fusion des données

1. Déterminez à l’avance les champs de données que vous voulez utiliser dans vos documents source et cible.

Décidez à l’avance de l’aspect du document final afin de déterminer les champs nécessaires à la fusion des données. Par exemple, si vous créez
une carte postale destinée à être envoyée par courrier à des clients, vous pouvez utiliser les champs de données suivants :

<<Nom de la société>><<Adresse>><<Ville>>, <<Pays>><<Code postal>>

Votre feuille de calcul ou base de données peut prendre l’apparence suivante :

Exemple de fichier de données

2. Enregistrez le fichier de source de données (en général, il s’agit d’une feuille de calcul ou d’un fichier de base de données) au format
texte délimité par des virgules (.csv) ou par des tabulations (.txt)

Vérifiez que votre fichier de source de données est structuré de sorte que vous puissiez inclure les champs adéquats dans votre document cible.
Par exemple, la ligne supérieure d’une feuille de calcul doit contenir le nom des champs utilisés dans le document cible, comme « Société » et
« Adresse ».

Pour plus d’informations, voirA propos des fichiers de source de données.

3. Créez un document cible contenant le texte et les autres éléments devant rester inchangés dans chaque version du document cible.

Pour plus d’informations, voir A propos des documents cibles.

4. Sélectionnez la source de données à l’aide du panneau Fusion des données.

Pour plus d’informations, voir Sélection d’une source de données.

5. Insérez des champs dans le document cible à partir du panneau Fusion des données.

Vous pouvez ajouter des champs de données soit à une page de document, soit à un gabarit. Si vous ajoutez des champs de données à un
gabarit, vous disposez alors d’options supplémentaires.

Pour plus d’informations, voir Insertion de champs de données et Ajout de balises d'emplacement de champs de données aux gabarits.

6. Affichez un aperçu des enregistrements pour vérifier que l’aspect du document cible répond à vos attentes.

Pour plus d’informations, voir Aperçu des enregistrements dans le document cible.

7. Fusionnez le document cible avec le fichier de source de données ou exportez-le au format PDF.

Pour plus d’informations, voir Fusion d’enregistrements.

A propos des fichiers de source de données
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La source de données provient généralement d’une application de base de données ou d'une feuille de calcul, mais vous pouvez aussi créer votre
propre fichier de source de données à l’aide d’InDesign ou d’un éditeur de texte. Les fichiers de source de données doivent être enregistrés au
format .csv ou .txt. Pour plus de détails sur l’exportation dans ces formats, reportez-vous au guide de l’utilisateur de votre application source.

Dans un fichier .txt ou .csv, les enregistrements sont séparés par des sauts de paragraphe et les champs par des virgules ou tabulations. Le
fichier de source de données peut aussi contenir du texte ou des chemins faisant référence à des images sur votre disque dur.

Exemple de fichier de source de données délimité par des virgules

Si vous souhaitez inclure une virgule ou des guillemets dans un fichier .csv, placez le texte entre guillemets, par exemple, "Martin, Beaumont et
associés". Si vous n’ajoutez pas les guillemets, chaque nom sera traité comme un champ distinct.

Il est impossible d’insérer un saut de ligne dans un champ du fichier de source de données. Si vous devez présenter un champ sur plusieurs
lignes, créez deux champs distincts, par exemple, <<Adresse1>> et <<Adresse2>>.

Pour éviter les lignes blanches, vous pouvez choisir l’option Supprimer les lignes vides des champs vides lors de la fusion du document.
Néanmoins, si un caractère quelconque, notamment une espace, figure sur la ligne, celle-ci n’est pas supprimée.

Ajout de champs d’image au fichier de source de données

En ajoutant des champs d’image au fichier de source de données, vous pouvez afficher une image différente sur chaque enregistrement fusionné.
Par exemple, lorsque vous fusionnez des documents incluant des informations provenant de différentes sociétés, vous avez la possibilité d’inclure
dans la fusion le logo de la société correspondante.

1. Ouvrez le fichier de source de données.

2. Entrez le symbole « arobase » (@) avant le nom du champ de données pour insérer du texte ou des chemins d’accès aux
fichiers image.

Seule la première ligne requiert le symbole @. Les lignes suivantes doivent inclure les chemins d’accès aux images. Les
chemins, qui sont sensibles à la casse, doivent être conformes aux conventions de nom de fichier du système d’exploitation
sur lequel ils sont stockés.

Si un message d’erreur s’affiche lorsque vous insérez le symbole @ au début du champ, insérez une apostrophe (’) avant
le symbole @ (exemple : ’@Photos) pour valider la fonction. Certaines applications telles que Microsoft Excel réservent le
symbole @ pour des fonctions précises.

(Windows) Exemple de référence d’image dans un fichier de source de données

Nom Age @Photos

Benoît Tournier 36 C:\Photos\BenoitTournier.jpg

Daniel Petit 53 C:\MyDocuments\daniel.gif

Marielle Lefaure 26 C:\Photos\Lefaure.psd

(Mac OS) Exemple de référence d’image dans un fichier de source de données

Nom Age @Photos

Benoît Tournier 36 MacHD:Photos:BenoitTournier.jpg

Daniel Petit 53 Bureau:Famille:daniel.gif

Marielle Lefaure 26 Mac HD:Photos:Lefaure.psd

1 Nom,Nom de la société,Etat Bill Tucker,CoreVent Labs,Nevada Dat Nguyen,"Brady, Hunt et Baxter, Inc",Delaware 
Maria Ruiz,"Brinquist Enterprises, Inc.",Californie
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Vous pouvez utiliser InDesign pour afficher le chemin d’une image sur votre système d’exploitation. Insérez une image dans un document
InDesign, puis utilisez le panneau Liens pour afficher l’emplacement de l’image. Sélectionnez l’image, puis choisissez la commande Copier les
informations > Copier le chemin complet dans le menu du panneau Liens. Vous devrez éventuellement modifier le chemin une fois que vous
l’aurez copié dans votre source de données. Cette méthode est particulièrement utile pour les images situées sur un serveur.

A propos des documents cibles

Après avoir créé le fichier de source de données, vous devez créer le document cible et y insérer les champs provenant du fichier de source de
données. Le document cible contient des balises d’emplacement de texte et de graphiques pour les champs de données, tels que l’illustration que
vous souhaitez faire figurer sur toutes les cartes postales. Ces champs sont accessibles après avoir sélectionné une source de données.

Le document cible contient les champs issus de la source de données ; il affiche le texte de la balise d’emplacement du champ.

Lors de la fusion des données, InDesign crée un nouveau document dans lequel il remplace les champs par les données spécifiées dans le fichier
de source de données. Vous pouvez insérer des champs de données soit dans un gabarit, soit dans une page de document.

Sélection d’une source de données

Avant d’insérer les champs dans votre document cible, sélectionnez une source de données dans le panneau Fusion des données. Vous ne
pouvez sélectionner qu’un seul fichier de source de données par document cible.

1. Créez ou ouvrez le document à utiliser comme document cible.

2. Choisissez la commande Fenêtre > Utilitaires > Fusion des données.

3. Choisissez Source de données dans le menu du panneau Fusion des données.

4. Pour modifier les options de délimitation du texte, sélectionnez Afficher les options d’importation.

InDesign détecte automatiquement le type de délimiteur et le codage utilisés dans le fichier de source de données ; il n’est
donc généralement pas nécessaire d’afficher les options d’importation. Vous pouvez toutefois spécifier des options de codage
et de délimitation différentes si les options identifiées ne vous conviennent pas.

5. Recherchez le fichier de source de données, puis cliquez sur Ouvrir.

6. Si vous avez sélectionné Afficher les options d’importation, modifiez les options de délimitation et de codage selon vos
besoins, puis cliquez sur OK. Les champs de données apparaissent dans le panneau Fusion des données.

si un avertissement s’affiche pour indiquer une erreur d’ouverture du fichier ou si des champs incorrects apparaissent dans la zone
de liste, il peut être nécessaire de modifier le fichier de feuille de calcul ou de base de données et de l’enregistrer au format .txt ou .csv.

Une fois que la source de données est sélectionnée et que les champs sont chargés dans le panneau Fusion des données, aucun changement
apporté à la source de données n’est reflété dans le document cible tant que vous ne mettez pas à jour la source de données.

Insertion de champs de données

Lors de la sélection de la source de données, une liste de noms de champs de données s’affiche dans le panneau Fusion des données. Ces
noms correspondent à ceux des en-têtes de colonnes du fichier de source de données. Des icônes indiquent le type de champ (texte ou image).
Lorsque des champs de données sont ajoutés au document, ils se transforment en balises d’emplacement de champ (par exemple,
<< Société >>) que vous pouvez sélectionner et mettre en forme comme vous le feriez avec du texte ou des images.
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Vous pouvez également attribuer un champ d’image à un bloc existant pour créer une image flottante. Si le point d’insertion se situe dans un bloc
de texte ou que le texte est sélectionné lorsque vous insérez un champ d’image, une petite balise d’emplacement est insérée en tant qu’objet
texte. Vous pouvez redimensionner la balise d’emplacement d’image pour déterminer la taille des images fusionnées.

Dès que vous insérez un champ de données, InDesign mémorise sa source de données. Toute erreur dans la liste des champs, telle que fautes
de frappe, champs vides et types de champs incorrects, doit être corrigée dans l’application source avant de procéder à nouveau à la mise à jour
à l’aide du panneau Fusion des données.

Pour insérer un champ de données textuelles dans le document cible

1. Créez un bloc de texte sur une page de document ou un gabarit.

Si vous ajoutez des champs de données à un gabarit, voir Ajout de balises d'emplacement de champs de données aux
gabarits.

2. Placez le point d’insertion dans le bloc de texte dans lequel vous voulez afficher la balise d’emplacement de champ ou
sélectionnez le texte à remplacer.

3. Pour insérer une balise d'emplacement de champ, effectuez l’une des opérations suivantes :

Cliquez sur un champ dans la liste du panneau Fusion des données.

Faites glisser un nom de champ hors de la liste du panneau Fusion des données et déplacez-le jusqu’au bloc de texte
pour ajouter la balise d'emplacement. Si vous faites glisser un champ textuel vers un bloc vide, ce bloc vide devient un
bloc de texte.

Les balises d'emplacement des champs textuels s’affichent dans l’application cible entre doubles chevrons (par exemple, <<Nom>>) et utilisent les
attributs de format courants (comme la police et le corps).

pour créer un champ valide, vous ne pouvez pas simplement entrer le nom du champ ou modifier un champ existant ; vous devez
l’insérer à partir du panneau Fusion des données.

Pour insérer un champ de données d’image dans le document cible

Pour insérer une nouvelle balise d’emplacement d’image texte, faites glisser un champ d’image vers un bloc de texte ou
placez le point d’insertion dans un bloc de texte et cliquez sur le champ d’image.
Pour insérer une nouvelle image flottante, faites glisser un champ d’image vers un bloc vide ou un bloc graphique existant. Si
vous faites glisser un champ d’image vers un bloc vide, ce bloc vide devient un bloc graphique.
Pour insérer un champ au milieu d’éléments regroupés, de cellules de tableau ou d’éléments imbriqués, faites glisser le champ
d’image vers sa cible.

Les balises d’emplacement de champs d’image s’affichent sous forme de blocs portant le nom du champ.

Ajout de balises d'emplacement de champs de données aux gabarits

L’insertion de marques de réservation de champs de données dans des gabarits présente plus d’avantages que l’insertion de balises
d'emplacement sur des pages de document :

Le document fusionné ainsi obtenu contient sur ses gabarits les balises d’emplacement d’origine et inclut les résultats
fusionnés sur les pages de document en tant qu’éléments de gabarit supprimés.

Le document fusionné conserve une liaison avec la source de données, ce qui signifie que si les enregistrements de la source
de données sont modifiés, il est possible de mettre à jour le contenu du document fusionné en choisissant Mettre à jour le
contenu des champs de données. Cette option est particulièrement utile si vous modifiez la mise en page du document
fusionné et que vous avez par la suite besoin d’ajouter de nouvelles données provenant de la source de données.

Les paramètres de la boîte de dialogue Créer le document fusionné sont identiques à ceux utilisés dans le document cible, ce
qui vous permet de redonner rapidement la même apparence au document actif. Vous pouvez également utiliser ces
paramètres partagés pour créer un document identique utilisant une source de données différente, ou créer un nouveau
document avec une mise en page légèrement différente.
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si vous ajoutez des champs de données à un gabarit, vérifiez que le bloc de texte contenant les champs de données autorise le
remplacement des éléments du gabarit. Sélectionnez le bloc de texte sur le gabarit et choisissez l’option Autoriser les remplacements des
éléments du gabarit sur la sélection dans le menu du panneau Pages. Si cette option n’est pas sélectionnée, les données ne seront pas
fusionnées (Voir Création de gabarits.)

Vous ne pouvez pas importer des champs de données à la fois sur des gabarits et des pages de document. Pour effectuer une fusion correcte,
vous devez appliquer à la première page du document un gabarit contenant des champs de données.

si un message d’erreur indique qu’InDesign ne peut pas fusionner le document du fait de l’absence de balises d’emplacement, il est
probable que vous avez ajouté les balises d’emplacement sur le gabarit de gauche dans un document à une seule page. La page 1 est basée sur
le gabarit de droite ; vous devez donc ajouter les balises d’emplacement sur le gabarit de droite.

Mise à jour, suppression et remplacement de fichiers de source de données

Pour mettre à jour des fichiers de source de données, modifiez le fichier de source de données et enregistrez-le au format .txt
ou .csv, puis choisissez Mettre à jour la source de données dans le panneau Fusion des données.

Les modifications seront répercutées dans le panneau Fusion des données. Si les modifications ne sont pas répercutées dans
le document après la mise à jour, désélectionnez l’option Aperçu, puis sélectionnez-la à nouveau pour l’activer.

Pour supprimer la liaison avec le fichier de source de données, choisissez Supprimer la source de données dans le menu du
panneau Fusion des données.
Pour sélectionner un nouveau fichier de source de données, choisissez Sélectionner la source de données dans le menu du
panneau Fusion des données, puis spécifiez le nouveau fichier de source de données. Il est possible qu’InDesign ne
reconnaisse pas certains des champs. Si c’est le cas, la meilleure solution consiste à supprimer, puis à réinsérer les champs
de balises d’emplacement.

Si vous générez un document fusionné à partir d’un document cible dans lequel les champs de données apparaissaient sur des gabarits, vous
pouvez mettre à jour les champs de données dans le document fusionné.

Affichage d’un aperçu des enregistrements dans le document cible

Avant de fusionner le document cible et le fichier de source de données, il est conseillé de prévisualiser les enregistrements pour vous assurer
que les données des champs s’afficheront correctement au moment de la fusion des informations. Lorsque vous prévisualisez des
enregistrements, le panneau Fusion des données affiche les données réelles du fichier de source de données et non les balises d'emplacement
des champs. Par exemple, au lieu d’avoir <<Société>>, vous pouvez avoir Adobe Systems, Inc. Vous pouvez utiliser les boutons de navigation du
panneau Fusion des données pour passer d’un enregistrement à l’autre.

Si les enregistrements comportent des erreurs (fautes de frappe, doubles espaces ou autres), il est conseillé de modifier le fichier source dans
l’application d’origine (Voir A propos des fichiers de source de données.)

1. Cliquez sur Aperçu en bas du panneau Fusion des données ou choisissez Aperçu dans le menu du panneau Fusion des
données.

2. Cliquez sur les boutons de navigation pour passer en revue les différents enregistrements.

Pour atteindre un enregistrement spécifique, cliquez sur les boutons de navigation en bas du panneau. Vous pouvez également entrer le
numéro de l’enregistrement que vous souhaitez prévisualiser dans la zone de texte de navigation en bas du panneau, puis appuyer sur la
touche Entrée ou Retour.

Affichage ou masquage de l’aperçu

Certains problèmes peuvent apparaître ou au contraire se corriger d’eux-mêmes lorsque vous changez de mode d’affichage. Gardez les points
suivants à l’esprit :

Le contenu prévisualisé est remplacé par des balises d’emplacement lorsque l’option Aperçu n’est pas sélectionnée. Si vous
supprimez une image en même temps que le bloc qui la contient ou si vous supprimez une chaîne de texte entière et que

http://idiom-q-win-1/fr/indesign/using/master-pages.html#create_masters
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vous désélectionnez l’option Aperçu, les balises d’emplacement ne s’affichent pas, car elles ont également été supprimées.

Les modifications apportées dans la boîte de dialogue Options de positionnement du contenu s’appliquent lorsque vous cliquez
sur OK. Par ailleurs, si l’option Aperçu est sélectionnée, les données ne refléteront pas les paramètres d’importation mis à jour
tant que vous n’aurez pas désélectionné puis sélectionné à nouveau l’option.

Si vous tentez d’enregistrer le document en mode Aperçu, vous recevez un message vous invitant à désactiver l’aperçu avant
d’enregistrer le document.

Modification des balises d'emplacement de champs de données

Lorsque vous ajoutez un champ de données textuelles à un document, le texte de la balise d’emplacement du champ utilise les attributs de mise
en forme (police et corps) actifs au point d’insertion. Vous pouvez ensuite modifier les attributs du texte de la balise d’emplacement et choisir
l’aspect des données qui vous convient.

Utilisez l’une des méthodes suivantes :

Pour modifier les attributs des marques de réservation, sélectionnez le texte de la balise d'emplacement, puis modifiez les
attributs de mise en forme, comme pour tout autre texte.

Pour modifier une balise d'emplacement, sélectionnez celle-ci ou les données réelles, puis sélectionnez un autre nom de
champ dans le panneau Fusion des données.

Pour supprimer une balise d’emplacement, sélectionnez-la, puis appuyez sur la touche Retour arrière ou Suppr.

en mode éditeur, les balises d’emplacement de texte ont la même apparence que les hyperliens. Certaines des options du panneau
Fusion des données ne sont pas disponibles en mode éditeur.

Définition des options d’importation du contenu

Utilisez la boîte de dialogue Options de positionnement du contenu pour spécifier les paramètres par défaut du document actif ou de l’ensemble
des futurs projets de fusion des données. Vous pouvez spécifier la méthode d’importation de l’image et le nombre maximal d’enregistrements par
document fusionné et indiquer si les images sont liées ou incorporées et si les lignes vides des champs vides sont supprimées.

1. Utilisez l’une des méthodes suivantes :

Pour appliquer les paramètres au document actif uniquement, ouvrez le document cible.

Pour appliquer les paramètres à tous les futurs documents, fermez tous les documents.

2. Choisissez la commande Fenêtre > Utilitaires > Fusion des données.

3. Choisissez Options d’importation du contenu dans le menu du panneau Fusion des données.

4. Modifiez les options de positionnement du contenu (Voir Options d’importation de contenu.)

5. Cliquez sur le bouton OK.

Fusion des enregistrements

Après avoir procédé à la mise en forme du document cible et inséré des champs issus du fichier de source de données, vous êtes prêt à fusionner
les informations de la source de données et du document cible. Vous pouvez fusionner les enregistrements dans un autre document InDesign ou
directement dans un fichier PDF. Lors de la fusion des données, InDesign crée un nouveau document ou un fichier PDF basé sur le document
cible et remplace les champs du document cible par les données que vous avez spécifiées dans le fichier de source de données.

Lors de la fusion d’un document incluant des balises d’emplacement de champs de données sur des gabarits, ces éléments de gabarit sont copiés
dans les gabarits du nouveau document créé.

Pour fusionner des enregistrements uniques ou multiples



1. Ouvrez le document cible, puis procédez de l’une des manières suivantes :

Choisissez la commande Créer un document fusionné dans le menu du panneau Fusion des données ou cliquez sur le
bouton Créer un document fusionné .

Dans le menu du panneau Fusion des données, choisissez la commande Exporter au format PDF.

2. Dans l’onglet Enregistrements, pour le paramètre Enregistrements à fusionner, sélectionnez l’option Tous les enregistrements
pour traiter tous les enregistrements du fichier de source de données, choisissez l’option Enregistrement unique pour
fusionner un enregistrement spécifique ou spécifiez un groupe d’enregistrements à fusionner.

3. Pour l’option Enregistrements par page de document, utilisez l’une des méthodes suivantes :

Choisissez l’option Enregistrement unique pour faire commencer chaque enregistrement en haut de la page suivante.

Choisissez l’option Enregistrements multiples pour créer plusieurs enregistrements par page (par exemple, pour imprimer
des étiquettes d’adresses).

Vous ne pouvez pas fusionner plusieurs enregistrements si les champs de données apparaissent sur une page de
document dans un document à plusieurs pages ou s’ils apparaissent sur plusieurs gabarits.

4. Sélectionnez l’option Générer un rapport sur le texte en excès lors de la création de documents pour ouvrir automatiquement
un rapport sur le texte en excès produit par la fusion des données dans le document InDesign (voir Rapports de texte en
excès).

5. Sélectionnez l’option Avertir si des images sont manquantes pour afficher un avertissement de lien manquant si des images
sont indisponibles.

6. Si vous avez sélectionné l’option Enregistrements multiples dans l’onglet Enregistrements, cliquez sur l’onglet Mise en page
d’enregistrements multiples, puis spécifiez les options suivantes :

Pour l’option Marges, spécifiez l’espacement entre les repères de marge et les bords de la page.

Pour l’option Mise en page des enregistrements, sélectionnez l’option Rangées en premier ou Colonnes en premier, puis
spécifiez l’espacement entre les colonnes et les rangées.

7. Si vous avez sélectionné Enregistrements multiples, sélectionnez Aperçu de la mise en page des enregistrements multiples
pour vérifier les corrections effectuées dans la boîte de dialogue Créer un document fusionné. Vous pouvez cliquer sur les
boutons de page pour passer d’un enregistrement à un autre.

8. Cliquez sur l’onglet Options et spécifiez les options d’importation (voir Options d’importation de contenu).

9. Lorsque vous avez terminé, cliquez sur OK.

10. Si vous préférez exporter directement au format PDF, spécifiez les options PDF et cliquez sur le bouton Exporter. Précisez
ensuite un nom de fichier et un emplacement, puis cliquez sur le bouton Enregistrer (voir Options PDF d’Adobe).

Si le fichier de source de données renvoie à des formats de fichier non pris en charge ou des images non disponibles, vous devrez peut-être le
corriger pour qu’il renvoie à un fichier pris en charge, modifier le chemin de base de tout fichier manquant ou simplement déplacer le fichier dans
le dossier approprié de manière à ce qu’InDesign puisse le trouver et l’importer.

Restrictions concernant la fusion d’enregistrements multiples

Choisissez Plusieurs pour créer plusieurs enregistrements par page. Par exemple, si vous imprimez des étiquettes d’adresses, vous en imprimez
certainement plusieurs par page. L’aspect des enregistrements dans la composition fusionnée dépend principalement des options de mise en
page. Les restrictions que vous risquez de rencontrer lors de l’utilisation de l’option Enregistrements multiples sont les suivantes :

Vous ne pouvez pas fusionner plusieurs enregistrements si les champs de données apparaissent sur une page de document
dans un document à plusieurs pages ou s’ils apparaissent sur plusieurs gabarits.

Le panneau Fusion des données autorise une seule taille de marque de réservation.

La suppression d’un enregistrement dans la composition fusionnée ne signifie pas que les enregistrements restants sont
redistribués dans la balise d'emplacement vide.

Pour fusionner dans un fichier PDF

http://idiom-q-win-1/fr/indesign/using/pdf-options.html#adobe_pdf_options
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Pour la fusion dans un fichier PDF, vous disposez des mêmes options que lors de la création d’un document fusionné InDesign. Le fichier PDF
final tire parti des XObjects PDF pour les portions statiques de la page, ce qui réduit sensiblement sa taille et améliore ses prestations.

Mise à jour des champs de données

Après avoir fusionné un document avec des balises d’emplacement sur des gabarits, vous pouvez modifier la mise en page du document fusionné
et mettre à jour les valeurs des champs de données dans la source de données. Utilisez l’option Mettre à jour les champs de données pour mettre
à jour les champs de données tout en conservant la mise en page du document. Cette option n’est disponible que pour les documents fusionnés
dans lesquels des balises d’emplacement de données apparaissent sur des gabarits.

1. Procédez aux modifications souhaitées dans le fichier de source de données, puis enregistrez-le et fermez-le.

2. Dans le document fusionné, choisissez Mettre à jour les champs de données.

Les modifications effectuées lors de la mise à jour des champs de données s’affichent dans un fichier journal.

Cette option fonctionne de façon optimale lors de la modification ou de l’ajout d’enregistrements dans le fichier de source de données. En cas
d’ajout de champs de balise d’emplacement, de nouveaux champs dans la source de données ou de modification des paramètres dans la boîte
de dialogue Créer un document fusionné, utilisez l’option Créer un document fusionné pour générer un nouveau document fusionné.

Rapports de texte en excès

Un rapport de texte en excès est créé si l’option Générer le rapport de texte en excès à la création du document est sélectionnée dans la boîte de
dialogue Créer un document fusionné et si un ou plusieurs champs contiennent du texte en excès après la fusion des données.

Le rapport indique chaque occurrence de texte en excès sous forme de liste numérotée indiquant le numéro de la page dans laquelle le texte
apparaît, le nombre de caractères ou de mots en excès, ainsi qu’un extrait du texte.

Si le rapport apparaît lors de la création d’un document fusionné, il peut vous aider à corriger le problème. Vous pouvez, par exemple, agrandir le
bloc de texte, réduire le corps de la police ou modifier le texte.

Options de positionnement du contenu

Les options suivantes apparaissent dans la boîte de dialogue Options de positionnement du contenu :

Conserve les proportions de l’image tout en l’ajustant aux dimensions du bloc (par défaut).

Redimensionne l’image pour que ses proportions soient identiques à celles du bloc.

Conserve la taille de l’image et ajuste la taille du bloc par rapport à celle-ci.

Importe dans le bloc l’image à sa taille d’origine en l’alignant sur le coin supérieur gauche du bloc.
L’image est tronquée si elle est trop grande pour le bloc.

Importe l’image de telle sorte que sa hauteur ou sa largeur remplisse le bloc, le reste de l’image étant
tronqué.

Aligne le centre de l’image sur le centre du bloc.

Crée un lien ou un chemin de fichier vers le fichier graphique d'origine. Si cette option n’est pas sélectionnée, toutes les données
d’image sont incorporées dans le document InDesign.
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Supprimer les lignes vides des champs vides

Maximum d’enregistrements par document

Maximum de pages par document
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Supprime les retours chariot insérés pour les champs vides. Cette option est particulièrement
pratique pour les publipostages incluant un champ d’adresse facultatif. Cette option ignore les retours chariot. Si un caractère quelconque, y
compris une espace, figure sur la ligne, celle-ci n’est pas supprimée.

Spécifie le nombre maximal d’enregistrements par document fusionné. Dès que ce seuil est atteint,
un nouveau document est créé. Ce document contient le nombre de pages nécessaire pour accueillir le reste des enregistrements en cours de
fusion (jusqu’à la limite définie par enregistrement). Cette option est uniquement disponible lorsque l’option Enregistrement unique est
sélectionnée.

Spécifie le nombre maximal de pages par document. Une fois le seuil atteint, un nouveau document est créé
avec le nombre de pages nécessaire pour accueillir le reste des enregistrements en cours de fusion (jusqu’à la limite définie par page). Cette
option n’est disponible que lorsque l’option Enregistrements multiples est activée dans le menu Enregistrements par page de document au
moment de la fusion.

Fusion de données améliorée

Vous pouvez intégrer un code QR dans le document fusionné. Voici la liste des différents types de champs de code QR qui peuvent être ajoutés
aux flux de la fusion de données :

Texte brut
Hyperlien Web
Message texte
Courrier électronique
Carte de visite

Pour générer les codes QR, les entrées de données dans les fichiers .txt ou .csv qui sont utilisées comme source de données, sont au format
suivant :

Texte brut : dans la colonne de code QR saisissez le texte tel quel.
Hyperlien Web : URL:<url> (exemple « URL:http://www.google.com »)
Message : SMSTO:<Téléphone>:<Message> (exemple : « SMSTO:9818143551:Salut »)
Adresse électronique : MATMSG:\nTo:<adresse électronique> (exemple :
« MATMSG:\nTO:johndoe@adobe.com\nSUB:Bonjour;\nBODY:;; »)
Carte de visite : BEGIN:VCARD\nVERSION:2.1\nN:Smith;John\nFN:John Smith\nORG:Adobe
Systems\nTITLE:Engineer\nTEL;CELL:+919876543210\nTEL;WORK;VOICE:123456789\nADR;WORK:;;Street
ABC;Seattle;Washington;98101;US\nEMAIL;WORK;INTERNET:abc@adobe.com\nURL:www.adobe.com\nEND:VCARD

Les entrées de données peuvent toutefois être une combinaison de l’adresse, des sms, de l’hyperlien ou du type de texte brut. Saisissez-les dans
le fichier .csv et le champ .txt au format mentionné ci-dessus avec un signe # dans leur nom de colonne.Pour générer des codes QR, suivez les
instructions suivantes :

1. Choisissez Fenêtre > Utilitaires > Fusion des données.

2. Dans le menu rapide, sélectionnez Sélectionner la source de données.

3. Sélectionnez le fichier de données avec les informations de champ QR. Cliquez sur Ouvrir.

4. Sélectionnez la balise d'emplacement dans le document.

5. Cliquez sur l’icône Créer un document fusionné pour créer un document fusionné.

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr
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Installation de modules externes

Les modules externes InDesign sont des logiciels développés par Adobe Systems ou par d’autres éditeurs de logiciels, en partenariat avec Adobe,
pour ajouter des fonctions aux logiciels Adobe. Plusieurs modules d’importation, d’exportation, d’automatisation et de création d’effets spéciaux
sont fournis avec le programme et sont automatiquement installés dans le dossier des modules externes. La plupart des fonctions disponibles
dans InDesign proviennent de modules externes.

Une fois installés, les modules externes se présentent sous la forme d’options dans les menus, boîtes de dialogue ou panneaux.

1. Si un programme d’installation est fourni, utilisez-le pour installer le module externe. Dans le cas contraire, faites glisser une
copie du module vers le dossier Plug-Ins situé dans le dossier d’application InDesign.

2. Suivez les instructions d’installation fournies avec le module.

vous pouvez installer différents modules externes conçus pour InDesign et disponibles dans le commerce. Le service d’assistance
technique peut vous aider à identifier les problèmes liés aux modules externes. Toutefois, s’il s’avère que le problème est directement lié à un
module créé par une société tierce, vous devez prendre contact avec cette société pour obtenir de l’aide.

Configuration des modules externes avec Extension Manager

Utilisez l’application Extension Manager pour consulter et personnaliser l’ensemble des modules externes installés. Cette boîte de dialogue permet
notamment d’obtenir des informations détaillées sur les modules externes installés, de créer des ensembles de modules pour les regrouper par
tâche ou par groupe de travail et de localiser un module lors d’une procédure de dépannage. Vous pouvez également désactiver les modules
externes.

Choisissez la commande Aide > Gérer les extensions (Windows) ou InDesign > Gérer les extensions (Mac OS).

Pour plus de détails sur l’utilisation d’Extension Manager, affichez l’aide de cette application.

Intégration avec les modules complémentaires Creative Cloud via le menu Parcourir les
modules complémentaires 

Vous pouvez rechercher et installer des modules externes, des extensions et bien plus encore pour Adobe InDesign et d’autres produits à partir du
site Web Modules complémentaires Adobe.

Pour ajouter des modules à InDesign avec les modules externes complémentaires, sélectionnez Fenêtre > Parcourir les
modules complémentaires. Ces modules complémentaires peuvent être gratuits ou payants. Tous les modules externes
installés/acquis à partir de l’application de Creative Cloud pour InDesign sont synchronisés à InDesign à partir de ce flux de
production. Celui-ci vous conduit à la page Web des modules complémentaires de navigation.
Ces modules complémentaires seront ultérieurement visibles dans Fenêtre > Extensions, téléchargements ou l’emplacement
mentionné dans la zone de description de recherche du module complémentaire. Pour afficher les modules complémentaires
téléchargés, affichez la page Web des modules complémentaires de navigation et utilisez l’option d’affichage des modules qui
existe dans le volet de gauche. Cette page indique également par quels produits et quelles versions respectives ces modules
complémentaires sont pris en charge.

https://creative.adobe.com/addons
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Lorsque la synchronisation des fichiers est activée, les modules complémentaires de navigation sont synchronisés au compte Creative Cloud.
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Création de scripts dans InDesign

La création de scripts est une méthode qui permet d’effectuer un grand nombre de tâches. Un script peut permettre d’automatiser aussi bien une
tâche courante qu’une nouvelle fonction entière. Vous pouvez créer vos propres scripts ou exécuter des scripts créés par d’autres utilisateurs.
Pour plus d'informations sur les scripts, consultez le Guide de scripts, les exigences de création de scripts, ainsi que d'autres ressources de
développement sur la page suivante : http://www.adobe.com/devnet/indesign/documentation.html.

Le Guide de scripts contient une introduction aux scripts ainsi que des didacticiels. Vous trouverez également un certain nombre de scripts utiles
que vous pouvez utiliser, notamment un script qui trace des repères autour d’un objet sélectionné. Certains de ces scripts s’affichent par défaut
dans le panneau Scripts.

Présentation des panneaux Scripts et Intitulé de script

InDesign comprend deux panneaux pour la création de scripts : Scripts et Intitulé de script.

Le panneau Scripts vous permet d’exécuter des scripts sans quitter InDesign. Le panneau Scripts affiche les scripts situés dans les dossiers
Scripts du dossier de l’application InDesign et dans vos dossiers Préférences. Lorsque vous créez ou recevez un script, vous pouvez le placer
dans le dossier du panneau Scripts. Il sera ainsi visible dans le panneau Scripts.

Users/[nom d’utilisateur]/Bibliothèque/Preferences/Adobe InDesign/[version][langue]/Scripts/Panneau Scripts

Documents and Settings\[nom d'utilisateur]\Application Data\Adobe\InDesign\[version]\[langue]\Scripts\Scripts Panel

Users\[nom d’utilisateur]\AppData\Roaming\Adobe\InDesign\[version][langue]\Scripts\Scripts Panel
Pour déterminer rapidement l’emplacement du dossier du panneau Script, cliquez sur un script avec le bouton droit de la souris (Windows) ou
en maintenant la touche Ctrl enfoncée (Mac OS) dans le panneau Script et sélectionnez l’option Faire apparaître dans l’Explorateur (Windows)
ou Faire apparaître dans le Finder (Mac OS).

Vous pouvez ensuite cliquer deux fois sur un script du panneau Scripts pour l’exécuter ou vous pouvez exécuter des scripts à l’aide de la
commande Application rapide.

Le panneau Intitulé de script vous permet de définir l’intitulé d’un élément de page, tel qu’un bloc de texte ou une forme. La création d’intitulés
d’éléments de page est particulièrement utile pour la création de scripts dans lesquels vous souhaitez identifier un objet.

Pour plus d'informations sur l'ajout, l'exécution et la modification de scripts, consultez le Guide de scripts sur le site Web d'Adobe à l'adresse
suivante : http://www.adobe.com/devnet/indesign/documentation.html.

Pour ouvrir le panneau Scripts

Choisissez la commande Fenêtre > Utilitaires > Scripts.

Pour ouvrir le panneau Intitulé de script

http://www.adobe.com/devnet/indesign/documentation.html
http://www.adobe.com/devnet/indesign/documentation.html


Haut de la page

AddGuides

AddPoints

AdjustLayout

AlignToPage

AnimationEncyclopedia

BreakFrame

CornerEffects

CreateCharacterStyles

CropMarks

ExportAllStories

FindChangeByList

ImageCatalog

MakeGrid

Neon

PathEffects

PlaceMultipagePDF

SelectObjects

SortParagraphs

SplitStory

TabUtilities

Choisissez la commande Fenêtre > Utilitaires > Intitulé de script.

Exécution de scripts d’exemple

Vous pouvez exécuter les scripts suivants dans InDesign :

Ajoute des repères autour des objets sélectionnés.

Ajoute des points aux tracés des objets sélectionnés.

Déplace les objets sur une distance définie sur les pages droite et gauche.

Aligne les objets sur des positions définies dans une page.

Crée automatiquement des boutons avec différentes propriétés d’animation.

Supprime un bloc de texte sélectionné et son contenu d’un article.

Redessine le tracé des éléments sélectionnés au moyen d’effets d’arrondi divers. Il est possible d’appliquer des effets d’arrondi à
des points sélectionnés sur un tracé.

Définit un style de caractère complet d’après le texte sélectionné.

Ajoute des traits de coupe et/ou des repères de montage autour des objets sélectionnés.

Exporte tous les articles d’un document dans une série de fichiers texte.

Exécute une série d’opérations courantes de recherche/remplacement de texte par une simple lecture d’un fichier texte dont
le contenu est séparé par des tabulations.

Place tous les graphiques d’un dossier donné selon une disposition de type planche-contact.

Crée une grille par subdivision ou duplication des objets sélectionnés.

Applique un effet de fusion aux objets sélectionnés.

Modifie la position des points de tracé sur les objets sélectionnés afin de produire un effet créatif.

Importe toutes les pages d’un fichier PDF.

Sélectionne les objets de la planche active par type.

Trie par ordre alphabétique les paragraphes de la sélection.

Scinde les blocs de texte de l’article sélectionné en blocs de texte distincts sans lien.

Applique des taquets de tabulation et des retraits au texte sélectionné.
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Pour plus de détails sur l’installation et l’utilisation de ces scripts d’exemple, consultez le fichier
www.adobe.com/go/learn_id_scripting_readme_cs5_fr (PDF).

Adobe recommande également
Création de scripts dans InDesign

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr
http://www.adobe.com/go/learn_id_scripting_readme_cs5_fr
http://www.adobe.com/go/scripting_id_fr
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Flux de production de formulaires

Vous pouvez concevoir des formulaires dans InDesign et les exporter directement au format PDF. InDesign prend désormais en charge les
champs de formulaire et des actions supplémentaires liées aux formulaires. La bibliothèque Boutons et formulaires (Fenêtre > Objet interactif >
Boutons et formulaires) contient des éléments que vous pouvez utiliser pour concevoir des formulaires interactifs.

InDesign permet de créer des formulaires simples dans InDesign, sans avoir à retoucher le document PDF dans Acrobat après publication. Vous
pouvez ajouter des éléments de formulaire simples dans les pages du document. Les types de champ courants tels que les zones de texte, les
cases d’option, les cases à cocher ou les signatures sont pris en charge. Vous pouvez également ajouter des actions permettant d’imprimer le
formulaire ou de l’envoyer par e-mail.

Après avoir défini les éléments de base du formulaire, vous pouvez tirer parti des fonctions de créativité d’InDesign pour ajouter une touche
personnelle à votre formulaire.

Ajoutez des contours unis et des fonds aux champs de formulaire PDF.
Ajoutez les états Activé, Désactivé et Survol pour les boutons, des cases à cocher et des cases d’option.
Définissez la taille de police utilisée pour les champs de saisie de texte.

Par exemple, pour recueillir les informations relatives à une carte de crédit, vous pouvez utiliser les icônes de carte de crédit sous forme de cases
d’option, en prévoyant une image différente pour l’état sélectionné.

Pour les flux de production de formulaire avancés, vous avez la possibilité d’exporter le formulaire de base et de poursuivre l’édition dans Adobe
Acrobat.

Ajout d’un champ de formulaire

Utilisez le panneau Boutons et formulaires pour ajouter des champs de formulaire à la mise en page. Les procédures à suivre pour ajouter des
champs de formulaire interactifs sont les mêmes que pour ajouter des boutons. Vous pouvez créer un formulaire exploitable avec Adobe Reader
ou Adobe Acrobat. InDesign permet de concevoir des formulaires originaux impossibles à obtenir avec Acrobat.

Panneau Boutons et formulaires
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1. Placez un bloc à l’endroit où vous souhaitez insérer le champ de formulaire.
2. Ouvrez le panneau Boutons et formulaires (Fenêtre > Objet interactif > Boutons et formulaires).
3. Sélectionnez le cadre et choisissez un type d’élément de formulaire dans la liste Type. Vous pouvez également cliquer avec le

bouton droit de la souris sur un cadre et choisir Objet interactif > Convertir en [...].
4. Donnez un nom au champ de formulaire. Pour créer un groupe de cases d’option, veillez à ce qu’elles aient toutes le même

nom.
5. Sélectionnez un événement et ajoutez les actions que vous souhaitez lui associer. Les actions, telles que Effacer le

formulaire, Imprimer le formulaire et Soumettre le formulaire ont été ajoutées. Dans l’action Soumettre le formulaire, spécifiez
l’URL sous la forme mailto:xyz@example.com.

6. Dans le cas d’une case d’option, d’une case à cocher ou de boutons : définissez les attributs d’aspect pour les différents états.
InDesign ajoute des graphiques par défaut pour les différents états, mais vous êtes libre d’ajouter vos propres graphiques.

7. Spécifiez les options PDF :
Description - la valeur entrée est affichée sous forme d’info-bulle et sert à créer des formulaires accessibles.
Valeur de bouton : cette valeur correspond à la valeur d’exportation dans Acrobat et peut également être utilisé pour
identifier une case d’option d’un groupe dans un formulaire accessible. 

Définition de l’ordre des tabulations

Pour créer des formulaires conviviaux et simples à compléter, il est nécessaire de définir l’ordre des tabulations. Les utilisateurs pourront ainsi
passer facilement d’un champ à l’autre sans avoir besoin de dispositif de pointage. Une simple pression sur la touche Tabulation permet d’activer
le champ logique suivant.

Il existe deux méthodes pour définir l’ordre des tabulations dans un document PDF balisé :

Utilisez le panneau Articles (Fenêtre > Articles) pour spécifier un ordre des tabulations personnalisé.
Choisissez Objet > Objet interactif > Définir l’ordre des tabulations.

Définition de l’ordre des tabulations au moyen du panneau Articles

Utilisation du panneau Articles pour spécifier l’ordre des tabulations

1. Ouvrez le panneau Articles (Fenêtre > Articles).

2. Faites glisser les champs de formulaire vers le panneau Articles.

3. Dans le panneau Articles, réorganisez les champs dans l’ordre approprié en les faisant glisser.

Pour que les lecteurs d’écran respectent l’ordre spécifié, activez l’option Utiliser pour l’ordre de lecture dans les PDF balisés dans le menu du
panneau Articles. N’oubliez pas d’activer l’option Créer un PDF balisé lors de l’exportation du fichier PDF.

Définition de l’ordre des tabulations au moyen de la structure

1. Choisissez Objet > Objet interactif > Définir l’ordre des tabulations.
2. Cliquez sur Déplacer vers le haut ou Déplacer vers le bas pour réorganiser les éléments selon l’ordre des tabulations

souhaité.

Lors de l’exportation au format PDF interactif, activez l’option Utiliser la structure pour l’ordre des tabulations dans la boîte de dialogue Exportation
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PDF.

Voir aussi

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr


Articles (CS 5.5)

Haut de la page

Remarque :

Haut de la page

Haut de la page

Introduction aux articles
Création d’un article et ajout d’un contenu
Ajout de tous les éléments de page d’un document à un article
Gestion des articles
Inclusion d’articles pour l’exportation

Introduction aux articles

Les articles permettent aisément de mettre en relation les divers éléments d’une page. Les liens ainsi établis sont pratiques pour définir le contenu
à exporter au format EPUB, HTML ou PDF accessible et pour définir l’ordre du contenu. Vous pouvez créer des articles à partir d’une variété
d’éléments de page déjà présents dans une mise en page, notamment des images, des graphiques ou du texte. Une fois l’article créé, vous
pouvez ajouter des éléments de page, en supprimer ou les réorganiser. Il est possible de créer manuellement des articles en faisant glisser un ou
plusieurs éléments de page vers un article du panneau Articles.

Vous pouvez également ajouter du contenu volumineux à un article. L’ajout de contenu sélectionné à un article sélectionné et l’ajout d’un
document entier à un article sont pris en charge.

le panneau Structure XML permet, par un autre moyen, de choisir l’ordre du contenu à exporter vers des flux de travail d’exportation
ePub, HTML et PDF accessibles. Le panneau Articles se veut plus simple, plus facile d’utilisation et plus accessible, à l’attention des utilisateurs
sans compétences particulières en langage XML. Le panneau Structure XML reste cependant utilisable, parallèlement au panneau Articles
pendant le processus d’exportation Voir Structuration des documents au format XML.

Création d’un article et ajout d’un contenu

1. Choisissez Fenêtre > Articles, pour ouvrir le panneau Articles.

2. Sélectionnez les éléments de page à ajouter à l’article.

Pour créer un article vide, ne sélectionnez aucun élément de page dans la mise en page.

3. Utilisez l’une des méthodes suivantes :

Dans le menu du panneau Articles, choisissez Nouvel article.

Cliquez sur Créer un nouvel article  en bas du panneau Articles.

Faites glisser un article ou un élément de page jusqu’au panneau Articles.

4. Dans la boîte de dialogue Nouvel article, nommez l’article.

5. Sélectionnez Inclure lors de l’exportation, pour ajouter l’article à la sortie d’exportation au format EPUB/HTML.

Ajout de tous les éléments de page d’un document à un article

Pour ajouter tous les éléments de page à un article :

1. Choisissez Fenêtre > Articles, pour ouvrir le panneau Articles.

2. Sélectionnez l’article auquel ajouter les éléments. Si vous ne sélectionnez pas d’article, un nouvel article est créé.

3. Appuyez sur la touche Commande (Mac OS) ou Ctrl (Windows) et cliquez sur le signe  dans le panneau Articles.

4. Si la boîte de dialogue Nouvel article s’affiche, nommez l’article.

http://idiom-q-win-1/fr/indesign/using/structuring-documents-xml.html#structuring_documents_for_xml
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5. Sélectionnez Inclure lors de l’exportation, pour ajouter l’article à l’exportation au format EPUB/HTML.

Si vous avez sélectionné un article, choisissez Ajouter le contenu du document aux articles sélectionnés dans le menu du panneau Articles.

Gestion des articles

Vous pouvez gérer les articles à l’aide du panneau Articles. Vous pouvez faire glisser des éléments de page vers le panneau Articles pour les
ajouter à un article. Vous pouvez également faire glisser des éléments dans le panneau Articles pour les réordonner ou les déplacer d’un article à
un autre.

Le menu contextuel du panneau Articles comporte également des options de gestion de contenu.

Inclusion d’articles pour l’exportation

Vous pouvez créer des articles et sélectionner ceux que vous souhaitez inclure à l’exportation au format EPUB ou HTML. Par défaut, tous les
articles sont sélectionnés en vue de leur exportation.

Pour inclure un article lors de l’exportation, dans le panneau Articles, sélectionnez l’article, puis utilisez l’une des méthodes suivantes :

Cochez la case située en regard de l’article.

Choisissez Options de l’article dans le menu contextuel du panneau Articles, puis sélectionnez Inclure lors de l’exportation.

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr
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Ajout d’une structure aux PDF
Importance des balises en termes de réutilisation et d’accessibilité
Principes de base et méthodes d’optimisation de la redistribution
Balisage d’éléments de page
Ajout d’un libellé aux graphiques pour une prise en charge par un lecteur d’écran
Regroupement d’éléments de page en un élément Article

Ajout d’une structure aux PDF
Lorsque vous exportez un fichier au format Adobe PDF et que vous activez l’option Créer PDF balisé dans la zone Général de la boîte de dialogue
Exporter au format Adobe PDF, InDesign ajoute automatiquement aux pages exportées un ensemble de balises de structure fournissant une
description du contenu et permettant d’identifier les différents éléments de page, tels que les titres, les articles et les images. Pour ajouter des
balises supplémentaires ou régler les balises existantes avant l’exportation, utilisez le panneau Balises d’InDesign. Le volet Structure (Affichage >
Structure > Afficher la structure) permet de visualiser le résultat obtenu suite aux modifications effectuées.

Vous pouvez améliorer l’accessibilité et les possibilités de réutilisation des documents Adobe PDF en ajoutant des balises aux documents
InDesign avant de les exporter. Si le document PDF ne contient pas de balises, il se peut qu’Adobe Reader ou Adobe Acrobat tente de le baliser
lorsque l’utilisateur essaie de le lire ou de le redistribuer, mais les résultats risquent d’être décevants. Si le fichier Adobe PDF ne donne pas les
résultats escomptés, vous pouvez utiliser les outils disponibles dans Acrobat 6.0 Professional ou version ultérieure, pour modifier la structure du
document PDF balisé. Utilisez Acrobat 9 Professional pour bénéficier des outils les plus avancés.

Lorsque vous appliquez des balises à un document à exporter au format PDF, ces balises ne déterminent pas quel est le contenu à exporter,
comme c’est le cas avec l’exportation XML. Elles fournissent simplement à Acrobat des informations supplémentaires sur la structure du
document.

Avantages de l’utilisation des balises
En appliquant des balises à un document avant de l’exporter au format PDF, vous pouvez :

Mettre en correspondance les styles de paragraphe InDesign et les balises Adobe PDF afin de créer un fichier PDF dont le
contenu peut être redistribué en vue de l’adapter à des appareils de poche et à d’autres supports.

Baliser et masquer les artefacts d’impression, le texte et les images pour qu’ils n’apparaissent pas une fois le contenu
redistribué au format Acrobat. Par exemple, si vous attribuez une balise de type Artefact à un élément dans un document, puis
que vous créez un fichier Adobe PDF balisé à partir de ce document, l’élément en question ne s’affichera pas une fois le
contenu du PDF redistribué sur un appareil de poche, sur un petit écran ou sur un moniteur standard à un niveau de zoom
élevé.

Associer à une image un texte de remplacement destiné à être lu à voix haute par un logiciel de lecture d’écran pour
malvoyants.

Remplacer les lettres graphiques, telles que les lettrines ornées, par des lettres pouvant être lues à voix haute.

Donner un titre à un ensemble d’articles ou regrouper vos articles et illustrations sous forme de reportages.

Classer vos articles et illustrations afin de définir un ordre de lecture.

Permettre l’identification des tableaux, des listes mises en forme et des tables des matières. Associer les différents blocs de
contenu aux articles dont ils dépendent.

Intégrer d’autres informations de mise en forme de texte, notamment les valeurs Unicode des caractères, l’intermots et la
distinction entre les traits d’union et les tirets conditionnels.

Importance des balises en termes de réutilisation et d’accessibilité
Le contenu d’un document Adobe PDF peut être réutilisé de différentes manières suivant les besoins. Vous pouvez, par exemple, créer un fichier
Adobe PDF d’un rapport comportant du texte, des tableaux et des images et le diffuser sous différents formats : impression ou affichage sur un
moniteur de bureau, affichage sur un appareil de poche, lecture à voix haute à l’aide d’un lecteur d’écran et accès direct, sous forme de pages
HTML, au moyen d’un navigateur Web. Lorsque l’on tente de réutiliser du contenu, on obtient des résultats plus ou moins satisfaisants suivant la
qualité de la structure logique sous-jacente du document.

Pour vous assurer que les documents Adobe PDF pourront être correctement réutilisés, vous devez leur ajouter des balises. L’ajout de balises
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permet de définir la structure logique, ou structure organisationnelle sous-jacente, du document. La structure logique correspond à l’organisation
du contenu du document (page de titre, chapitres, sections, sous-sections, etc.). Elle peut être utilisée pour définir un ordre de lecture précis et
faciliter la navigation, notamment si le document est long et complexe, sans pour autant modifier l’aspect du PDF.

Les personnes souffrant de déficiences visuelles qui éprouvent des difficultés à lire les documents peuvent avoir recours à des dispositifs
d’assistance destinés à rendre le contenu accessible. La plupart des dispositifs d’assistance s’appuient sur la structure logique d’un document
pour faire passer le sens du texte ou d’une image sous une forme alternative, par exemple sous forme audio. Dans un document non balisé, une
telle structure n’existe pas : Acrobat doit déterminer comment le document est agencé sur la base des paramètres d’ordre de lecture définis dans
les préférences. Cette méthode n’est pas fiable et, dans de nombreux cas, les différents éléments de page sont lus dans un ordre incorrect ou ne
peuvent tout simplement pas être lus.

Les balises s’affichent au niveau de l’onglet Balises d’Acrobat 6.0 ou version ultérieure et sont imbriquées suivant les paramètres de liaison définis
pour chacun des éléments balisés. Il est impossible de modifier les balises dans Acrobat Standard. Si vous devez travailler directement avec des
balises, utilisez Adobe Acrobat 9 Professional. Pour plus de détails, reportez-vous à l’Aide d’Acrobat.

Structure logique affichée sur l’onglet Balises dans Acrobat 9

Remarque : les balises utilisées dans les fichiers Adobe PDF peuvent être comparées à celles utilisées dans les fichiers HTML et XML. Pour en
savoir plus sur les concepts fondamentaux du balisage de documents, consultez les nombreux ouvrages de référence disponibles en librairie,
dans les bibliothèques et sur Internet.

Principes de base et méthodes d’optimisation de la redistribution
Vous pouvez redistribuer le contenu d’un document PDF de sorte que celui-ci puisse être lu sur un appareil de poche, sur un écran de petite taille
ou sur un moniteur standard à un niveau de zoom élevé, sans qu’il soit nécessaire de faire défiler les lignes dans le sens horizontal.

Lorsque vous redistribuez le contenu d’un document Adobe PDF, certains éléments du contenu sont réagencés et d’autres non. Dans la plupart
des cas, seul le texte « exploitable » est réagencé dans un document redistribué. Le texte exploitable inclut les articles, les paragraphes, les
tableaux, les images et les listes mises en forme. En revanche, les éléments suivants ne sont pas réagencés : numéros de page, en-têtes et pieds
de page (artefacts), mais aussi champs de formulaire, de commentaire et de signature numérique. Les pages contenant à la fois du texte
exploitable et des champs de formulaire ou de signature numérique ne sont pas redistribuées. Le texte vertical est redistribué horizontalement.

En tant qu’auteur, vous pouvez optimiser les documents PDF pour la redistribution en y insérant des balises. L’insertion de balises permet de
s’assurer que les blocs de texte sont correctement réagencés et que le contenu se présente dans l’ordre prévu, de sorte que les lecteurs puissent
suivre le fil d’un article qui s’étend sur plusieurs pages et plusieurs colonnes sans que le cours de la lecture soit interrompu pas d’autres articles.
L’ordre de lecture est défini au niveau de la structure du document ; il est possible de modifier cette structure par le biais du volet Structure.
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Les titres et les colonnes (en haut) sont redistribués suivant l’ordre de lecture logique (en bas).

Balisage d’éléments de page
Vous pouvez baliser des blocs de texte et des blocs graphiques automatiquement ou manuellement. Après avoir balisé des éléments de page,
vous pouvez utiliser le volet Structure pour modifier l’ordre de votre page en faisant glisser les éléments vers un nouvel emplacement dans la
hiérarchie. Si vous modifiez l’ordre des éléments dans le volet Structure, ces modifications seront prises en compte dans le fichier Adobe PDF.
L’ordre des éléments est utile lorsque le fichier PDF est enregistré en tant que fichier HTML ou XML à partir d’Acrobat. Il l’est également lors de
l’exportation d’un document InDesign pour Dreamweaver (XHTML) ou Digital Editions (EPUB).

Pour baliser des éléments de page automatiquement
Lorsque vous choisissez la commande Ajouter les éléments sans balise, InDesign ajoute des balises au panneau Balises et applique les balises
Article et Image à certains éléments de page sans balise. La balise Article est appliquée à tout bloc de texte non balisé et la balise Image est
appliquée à tout graphique non balisé. Vous pouvez ensuite appliquer manuellement d’autres balises à des sections de texte. Néanmoins, le
balisage automatique des éléments de page ne garantit pas que les éléments seront structurés en conséquence dans le fichier PDF exporté.

1. Choisissez la commande Fenêtre > Utilitaires > Balises pour afficher le panneau Balises.
2. Pour afficher le volet Structure, choisissez Affichage > Structure > Afficher la structure (le volet apparaît sur le côté gauche de

la fenêtre Document).
3. Choisissez Ajouter les éléments sans balise dans le menu du volet Structure.
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Balises répertoriées dans le volet Structure et le panneau Balises

Pour baliser des éléments de page manuellement
1. Choisissez la commande Fenêtre > Utilitaires > Balises pour afficher le panneau Balises.
2. Pour afficher le volet Structure, choisissez Affichage > Structure > Afficher la structure (le volet apparaît sur le côté gauche de

la fenêtre Document).
3. Choisissez Ajouter les éléments sans balise dans le menu du volet Structure.
4. Sélectionnez un élément de page dans le document.
5. Sélectionnez une balise dans le panneau Balises. Tenez compte des suggestions d’usage suivantes pour certains types de

balises importées :
Artefact Cette balise permet de masquer les éléments de page, tels que les numéros de page ou les objets de moindre
importance, lorsque vous affichez le fichier PDF exporté dans une vue redistribuée ; seuls les éléments balisés sont visibles
(voir la documentation d’Adobe Acrobat). Elle est particulièrement pratique pour consulter les fichiers PDF sur un appareil de
poche ou d’autres lecteurs PDF.

Cellule Utilisez cette balise pour l’identification des cellules de tableau.

Image Cette balise convient aux graphiques importés. La balise Image est appliquée à tous les blocs graphiques sans balise
figurant dans le document lorsque vous sélectionnez l’option Ajouter les éléments sans balise.

Balises Paragraphe (P, H, H1-H6) Ces balises n’ont aucun effet sur le texte PDF exporté affiché dans une vue redistribuée.
Néanmoins, elles peuvent parfois être utiles lors de l’exportation d’un fichier PDF au format HTML.

Article Cette balise convient aux articles. La balise Article est appliquée à tous les blocs de texte sans balise lorsque vous
sélectionnez l’option Ajouter les éléments sans balise. Supposons, par exemple, que votre document InDesign comporte trois
styles de paragraphe : Head1, Head2 et Body. Commencez par associer les styles de paragraphe aux balises H1, H2 et P
respectivement. Exportez ensuite le document au format PDF. Lorsque vous aurez exporté le document PDF au format HTML
ou XML dans Acrobat, les paragraphes dotés des balises H1, H2 et P seront affichés de la façon appropriée (caractères gras
de grande taille pour H1, par exemple) dans un navigateur Web. Pour plus de détails sur l’exportation du document PDF au
format HTML ou XML, reportez-vous à la documentation d’Adobe Acrobat.

Ajout d’un libellé aux graphiques pour une prise en charge par un lecteur d’écran
Pour faire en sorte qu’un lecteur d’écran puisse décrire les éléments graphiques illustrant les aspects importants du document, vous devez fournir
les descriptions correspondantes. Les images et les séquences multimédias ne seront pas reconnues ou ne pourront pas être décrites par un
lecteur d’écran si le texte de remplacement n’a pas été fourni au niveau des propriétés de la balise.

L’attribut Alt text vous permet de créer un texte destiné à se substituer à une image. L’attribut ActualText est similaire à l’attribut Alt text dans le
sens où le texte défini apparaît également à la place d’une image, mais ce texte se substitue à une image faisant partie d’un mot, comme c’est le
cas pour les lettrines. Dans cet exemple, l’attribut ActualText fait en sorte que la lettrine soit lue comme faisant partie du mot.

Lorsque vous exportez un fichier au format Adobe PDF, les valeurs des attributs Alt text et ActualText sont enregistrées dans le fichier PDF et
peuvent être consultées dans Acrobat 6.0 ou toute version ultérieure. Ces informations textuelles peuvent alors être utilisées lorsque le fichier PDF
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est enregistré en tant que fichier HTML ou XML à partir d’Acrobat. Pour plus de détails, reportez-vous à la documentation d’Adobe Acrobat.

1. Au besoin, choisissez la commande Affichage > Structure > Afficher la structure pour afficher le volet Structure, puis
sélectionnez la commande Fenêtre > Utilitaires > Balises pour afficher le panneau Balises.

2. Choisissez Ajouter les éléments sans balise dans le menu du volet Structure.
3. Pour vous assurer que l’image porte la balise Image, sélectionnez l’image, puis sélectionnez Image dans le panneau Balises.
4. Sélectionnez l’élément Image dans le volet Structure, puis choisissez Nouvel attribut dans le menu du volet Structure.
5. Dans le champ Nom, tapez soit Alt, soit ActualText (cette fonction est sensible à la casse).
6. Dans le champ Valeur, saisissez le texte qui s’affichera à la place de l’image.

Regroupement d’éléments de page en un élément Article
Utilisez le volet Structure pour regrouper logiquement des éléments de page en un élément Article. Par exemple, si un ensemble d’articles occupe
plusieurs pages, vous pouvez créer un élément parent qui réunira ces articles en un seul groupe. Ces éléments sont appelés éléments structurels.
Vous pouvez également nommer vos articles groupés.
Remarque : il est impossible de baliser un groupe d’éléments de page.

Pour grouper des éléments de page, sélectionnez Nouvel élément dans le menu du volet Structure, sélectionnez l’élément
Article dans le panneau Balises, puis faites glisser des éléments de page pour les positionner sous cet élément dans le volet
Structure.
Pour attribuer un nom à un groupe d’éléments, cliquez avec le bouton droit sur l’élément Article dans le volet Structure, puis
sélectionnez Nouvel attribut. Dans le champ Nom, saisissez Titre. Dans le champ Valeur, saisissez le nom à attribuer à
l’article.

Voir aussi

Informations juridiques   |   Politique de confidentialité en ligne

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://helpx.adobe.com/fr/legal/legal-notices.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr


Configuration requise


	Nouveautés
	Liste des nouvelles fonctionnalités

	Démarrage
	Creative Cloud
	Application de bureau Creative Cloud
	Exploration, synchronisation et gestion d’actifs
	Ajout de polices depuis Typekit
	Creative Cloud Market
	Creative Cloud Extract
	Bibliothèques Creative Cloud

	Espace de travail et flux de travaux
	Création de nouveaux documents
	Synchronisation des paramètres à l’aide d’Adobe Creative Cloud
	Panneau Outils
	Partage de contenu
	Enregistrement de documents
	Présentation d’un flux de production élémentaire avec gestion des fichiers
	Espace de travail - Principes de base
	Définition des préférences
	Utilisation de fichiers et modèles
	Personnalisation des menus et des raccourcis clavier
	Récupération et annulation
	Conversion de documents QuarkXPress et PageMaker
	Commandes des menus PageMaker
	Assemblages d’affectation
	Réglage de votre flux de production
	Utilisation des fichiers gérés
	Affichage de l’espace de travail
	Définition des préférences
	Panneau Outils

	Mise en page et conception
	Création de nouveaux documents
	Génération de codes QR | CC
	Numérotation de base des pages
	Création d’une table des matières
	Notes de bas de page
	Variables de texte
	Création d’un index
	Création de texte curviligne
	Contenu lié | CC, CS6
	A propos des pages et des planches
	Mises en page liquides et variantes de mises en page | CC, CS6
	Alignement et répartition des objets
	Création de nouveaux documents (chinois, japonais et coréen uniquement)
	Formatting grids
	Création de texte et de blocs de texte
	Création de livres
	Création de documents
	Masques
	Formatting grids
	Frame grid properties
	Grids
	Grouping, locking, and duplicating objects
	Importing files from other applications
	Layers
	Laying out frames and pages
	Layout grids
	Managing graphics links
	Managing pages and spreads
	Gabarits
	Numbering pages, chapters, and sections
	Placing graphics
	Reusing graphics and text
	Ruler guides
	Règles et unités de mesure
	Transforming objects
	Understanding graphics formats
	Working with files and templates
	Working with frames and objects

	Texte
	Liaison de texte
	Habillage d’objets avec du texte
	Utilisation des fonctionnalités pour l’arabe et l’hébreu | CC, CS6
	Objets ancrés
	Articles (CS 5.5)
	Listes à puces et numérotées
	Recherche et remplacement
	Notes de bas de page
	Glyphes et caractères spéciaux
	Mise en forme des caractères CJC
	Création de texte curviligne
	Contenu lié | CC, CS6
	Vérification orthographique et dictionnaires de langue
	Options d’ajustement du bloc de texte | CC, CS6
	Ajout de texte dans les blocs
	Edition de texte
	Création de texte et de blocs de texte
	Légendes
	Suivi et révision des corrections
	Ajout de notes éditoriales dans InDesign
	Articles liés
	Working with markers

	Styles
	Styles d’objet
	Styles de paragraphe et de caractère
	Lettrines et styles imbriqués
	Utilisation des styles

	Typographie
	Utilisation des polices
	Listes à puces et numérotées
	Mise en forme des caractères CJC
	Utilisation des fonctionnalités pour l’arabe et l’hébreu | CC, CS6
	Formatage de texte
	Composition de texte
	Mise en forme des caractères
	Alignement du texte
	Mise en forme des paragraphes
	Interligne
	Tabulations et retraits
	Crénage et approche

	Tableaux
	Mise en forme de tableaux
	Création de tableaux
	Styles de tableau et de cellule
	Sélection et modification de tableaux
	Contours et fond des tableaux

	Interactivité
	Formes | CC, CS6
	Hyperliens
	Boutons
	Références croisées
	Documents Web interactifs pour Flash
	Animation
	Documents PDF dynamiques
	Agencement des PDF
	Films et sons
	Signets

	Dessiner et peindre
	Drawing with the line or shape tools
	Application des paramètres de contour
	Dessin avec l’outil Plume
	Présentation des tracés et des formes
	Dessin avec l'outil Crayon
	Tracés transparents et formes composées
	Modification de l’aspect des arrondis

	Couleur
	Application des couleurs
	Présentation des tons directs et des couleurs quadri
	Teintes
	Mélange des encres
	Dégradés
	Utilisation de couleurs provenant de graphiques importés

	Transparence
	Ajout d’effets de transparence
	Aplatissement d’une illustration avec transparence

	Exportation et publication
	Publish Online (aperçu)
	Exportation de contenu pour EPUB
	Options Adobe PDF
	Exportation de contenu au format HTML
	Exportation au format Adobe PDF
	Exportation de pages au format JPEG
	Exportation de contenu pour EPUB | CS5.5
	Exportation
	Exportation de contenu pour EPUB | CS6
	Exportation de contenu au format HTML | CS6 et CS5.5
	Exportation de contenu XML

	Impression
	Impression de cahiers
	Impression de vignettes et de documents grand format
	Préparation de PDF destinés à des prestataires de services
	Contrôle en amont de fichiers avant envoi
	Repères d’impression et fonds perdus
	Préparation à l’impression des séparations
	Impression de documents
	Création de fichiers PostScript et EPS
	Recouvrements prédéfinis
	Recouvrement dans des documents et des livres
	Impression des images et des polices
	Surimpression
	Gestion des couleurs
	Réglage des options d’encre pour le recouvrement
	Encres, séparations et linéature

	Publications numériques
	Exportation de contenu pour EPUB
	Mises en page liquides et variantes de mises en page | CC, CS6
	Présentation de Digital Publishing Suite
	Exportation de contenu pour EPUB | CS5.5
	Exportation de contenu pour EPUB | CS6

	Automatisation
	Fusion des données
	Modules externes
	Script

	Accessibilité
	Formes | CC, CS6
	Articles (CS 5.5)
	Agencement des PDF

	Configuration requise

	h0bWwvZ2V0LXN0YXJ0ZWQuaHRtbAA=: 
	input1: on

	UtY2xvdWQtZGVza3RvcC5odG1sAA==: 
	feedback: Off
	input1: on
	searchform: 
	searchterm: 
	input3: 




